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New features

New Features in Version 4.3.0

Splitting notes by duration
● You can now split notes into multiple, shorter notes. See Splitting notes by duration.

Repeat barlines
● When you add start repeat barlines to a range of selected items, Dorico Pro now 

automatically adds end repeat barlines at the end of the selection. See Inputting barlines 
with the popover and Inputting barlines with the panel.

Restorative clefs
● When you add clefs to a range of selected items, Dorico Pro now automatically adds 

restorative clefs at the end of the selection. See Inputting clefs with the popover and 
Inputting clefs with the panel.

Chord symbol improvements
● You can now generate notes based on selected chord symbols and influence many related 

variables, such as which instruments play bass notes. See Generating notes from chord 
symbols.

Engrave mode view options
● System and frame fullness indicators are now both shown in Engrave mode when either 

Graphic Editing , Staff Spacing , or Note Spacing  is selected in the Engrave 
toolbox. See System fullness indicators and Frame fullness indicators.

Layout transposition token
● A new token that displays whether layouts are concert or transposed pitch is available. It 

uses your instrument language setting by default, but you can override the text in each 
layout independently. See Tokens and Editing layout transposition text.

Condensing improvements
● Trill intervals are now correctly shown on condensed staves, and you can prevent notes 

with different trilled-to pitches from sharing stems on condensed staves, as Dorico Pro can 
only show a single auxiliary note per voice.

● Lines are now included on condensed staves, and you can amalgamate identical barline-/
rhythmic position-attached horizontal lines. See Per-flow notation options for condensing.

Key Editor improvements
● You can now show multiple instruments in the Key Editor simultaneously, allowing you 

to input data, such as MIDI CC points, for all selected instruments simultaneously. See 
Showing instruments in the Key Editor.

● You can now copy MIDI CC and dynamic points from the primary instrument in the Key 
Editor to all secondary instruments, making it easy to sync data across tracks. See Copying 
dynamic points to other instruments and Copying MIDI points to other instruments.

● The Histogram and Transform tools are now available in the MIDI CC editor, in addition to 
the Velocity editor. See Histogram tool and Transform tool.

● You can now save configurations of editors in the Key Editor, allowing you to open those 
editors again quickly. See Key Editor configurations.
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Text improvements
● Dorico Pro now shows borders of the required size around text in text frames whose 

paragraph style is set to show a border, independently of adding borders to text frames. 
See Paragraph Styles dialog.

● You can now select different border styles for text items and paragraph styles. See 
Changing the style of text item borders.

Chord diagram fingering improvements
● You can now allow chord diagrams to use thumb fingerings on the lowest string. See 

Allowing/Disallowing thumb fingerings in chord diagrams.
● When editing chord diagram fingerings, you can now enter 0 to show no fingering and T 

for thumb fingerings on the lowest string. See Edit Chord Diagrams dialog and Edit Chord 
Diagram dialog.

Lyric improvements
● It is now possible to export all lyrics in the project as plain text. See Exporting lyrics.
● You can now change the default alignment of all lyrics project-wide according to their 

syllable type. See Changing the alignment of lyrics relative to notes.

Hiding noteheads
● You can now hide the noteheads of individual notes, while maintaining appropriate note 

spacing. See Hiding/Showing noteheads.

Note grouping in slash regions
● You can now change the grouping and duration of rhythm slashes in slash regions; for 

example, if you want to show six slashes in 6/8 instead of two dotted slashes. See Note 
grouping in slash regions.

Tremolos in tie chains
● You can now specify that single-note tremolos should not appear on the first or last note in 

tie chains when inputting tremolos. See Tremolos in tie chains, Inputting tremolos with the 
popover, and Inputting tremolos with the panel.

New Features in Version 4.2.0

Key Editor improvements
● MIDI CC, MIDI pitch bend, and dynamic points are now copied automatically when you 

copy the notes to which they apply. However, you can disable this behavior if required. See 
Disabling automatic copying of MIDI data when pasting.

● The percussion editor has been returned to the Key Editor. You can also now use the 
Drumstick tool to input notes with a different rhythmic duration for each unpitched 
percussion instrument independently. See Inputting notes using the Drumstick tool.

New Features in Version 4.1.0

Color improvements
● A new Colors page has been added to Preferences. It includes new options that allow 

you to control colors used for various purposes in the music area, including the first eight 
voices on each staff, and to invert music/page colors, which by default shows white music 
on a black background. See Changing music area colors and Inverting colors.

Printing/Exporting flows
● You can now specify the flows that you want to print or export. Dorico Pro then prints/

exports all pages on which the selected flows appear. See Print Flows dialog.

New features
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Properties panel
● You can now activate properties in the Properties panel by clicking their name in addition to 

their activation switch. See Properties panel.

Library export
● You can now export all visual items and options in the current project as a .doricolib file. 

You can then import the .doricolib file into other projects and share it with other users. 
See Exporting libraries.

Lyrics improvements
● Lyrics now use paragraph styles instead of font styles. This allows you to format lyrics in 

more detail, including adjusting their font stretch. See Lyrics paragraph styles.
● You can override the paragraph style used for individual lyrics. For example, if you want to 

use a paragraph style with less stretch for lyrics on tightly spaced systems. See Changing 
the paragraph style used for lyrics.

● You can now edit the formatting of individual lyrics, such as making single characters 
underlined. See Edit Lyric dialog.

New Features in Version 4.0.0

Highlights

Jump bar
● The new jump bar allows you to perform commands and go to locations using only your 

computer keyboard. See Jump bar.
● You can assign jump bar aliases to specific commands; for example, so you can use shorter 

entries for your favorite commands. See Assigning jump bar aliases.

Project templates
● You can now save existing projects as custom project templates, allowing you to create 

future projects containing the same players, page templates, and default settings. See 
Saving custom project templates.

MIDI improvements
● The handling of imported/opened MIDI files has been extensively improved. You can now 

map tracks to specific voices, players, and playing techniques, and save your settings for 
reuse in subsequent imports. See MIDI Import Options dialog.

● During MIDI recording, Dorico Pro now automatically transcribes multiple simultaneous 
parts into separate voices, such as in contrapuntal piano music. Depending on your 
settings for MIDI recording and quantization, Dorico Pro can also detect slurs, tremolos, 
trills, pedal lines, tuplets, and grace notes. See MIDI recording.

Player sorting
● By default, players are now automatically sorted in orchestral order, regardless of the order 

in which you add them to the project. You can change the player sorting setting in the 
Players panel in Setup mode. See Players panel.

● You can now designate players as soloists, such as in a concerto for solo violin and 
orchestra. Soloists are treated differently, such as their instruments not being numbered 
with other instruments of the same type and being automatically positioned in the 
conventional score position; that is, above the strings. See Designating players as soloists.

Capos
● You can now define capos for individual fretted instruments. You can then control how 

capos affect notated pitches and chord symbols/diagrams independently of each other to 
suit a range of requirements. See Capos.

New features
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Lower zone
● The lower zone, formerly known as the “bottom panel”, now contains multiple different 

panels, including Keyboard, Fretboard, and Drum Pads panels that you can use to input 
notes and the Mixer and Key Editor panels that you can use to adjust playback. See Lower 
zone (Write mode).

Instrument filters
● Instrument filters allow you to show only the staves of selected instruments in galley view. 

You can easily switch between showing only staves in the filter and all staves in the layout. 
See Instrument filters.

Insert mode scope
● Insert mode has been given additional functionality, allowing you to change the scope of 

its impact. For example, you can now set Insert mode to affect all players in flows and also 
change the duration of the current bar. See Insert mode scopes.

● You can also now set a stop position in each flow, which prevents any material beyond the 
stop point being affected by inserted notes. See Setting Insert mode stop positions.

Musical transformations
● Dorico Pro now provides multiple tools for transforming pitches and rhythms, including 

reversing and inverting pitches. See Musical transformations.
● The functionality of the note tools popover has been expanded to include the new musical 

transformations. You can also transform notes using new, dedicated dialogs. See Note 
tools popover.

Play mode
● Play mode has had a complete refresh in both appearance and functionality. Tracks now 

appear in a track overview, with editing options available in the Track Inspector and Key 
Editor. See Project window in Play mode.

● The piano roll now appears in the Key Editor, rather than in the track overview (previously 
known as the “event display”). See Key Editor.

● Powerful histogram controls have been introduced as part of the new Key Editor, allowing 
you to perform various editing operations, including for non-consecutive notes. See 
Histogram tool.

● The Mixer has also been completely refreshed in appearance and functionality. In addition 
to the Mixer window, it can also appear as a panel in the lower zone in Write, Engrave, and 
Play modes. See Mixer.

Library
● Dialogs for visual items and options in the library are now accessible on a new Library 

menu. This also allows you to access these dialogs from all modes. See Library.
● There is a new Library Manager that gives you an overview of all visual items and options 

in the current project and allows you to compare these against another project, your user 
library, or Dorico’s factory library. The Library Manager makes it easy to import options 
from any of these locations into the current project, from all options down to a granular 
per-option level if required. See Library Manager.

Numbered bar regions
● Numbered bar regions allow you to show bar counts in specific regions without additional 

notations. This can help performers keep track of how many bars have passed when 
playing repetitive music. See Numbered bar regions.

More New Features

Language improvements
● Changing the application language now takes effect immediately, without the need to 

restart Dorico Pro. See Changing the application language.

New features
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● You can now automatically reset all existing instrument names and customize the 
appearance of accidentals and note names when changing the language for instrument 
names. See Changing the language for instrument names.

● You can now change the language used for date and time tokens. See Changing the 
language for date and time tokens.

Hub redesign
● The Hub has been redesigned, and now includes a Create New page where you can set up 

basic project information, including adding the project title, selecting a time signature, and 
specifying a starting number of bars. See Hub.

Ensemble picker
● When adding ensembles, you can now build custom ensembles and save them for future 

projects. The ensemble picker has also been given a default key command. See Ensemble 
picker and Building and saving custom ensembles.

Duplicating layouts
● You can now duplicate existing layouts, which copies everything in the original, including 

page template and staff spacing overrides. See Duplicating layouts.

Write mode toolboxes
● Some functions in the Notes toolbox now have additional options available when you click 

and hold their button, including allowing you to open the tuplets popover. See Notes 
toolbox.

● You can now switch between accessing panels and popovers from the Notations toolbox in 
Write mode. See Notations toolbox.

Chord symbol improvements
● You can now generate chord symbols based on the harmony of selected notes. See 

Generating chord symbols from notes.
● You can change the arrangement of polychord and altered bass note chord symbols. See 

Changing the arrangement of compound chord symbols.
● You can also now erase the background of chord symbols. See Erasing the background of 

chord symbols.
● You can now show parentheses around chord symbols, including showing only a single 

left or right bracket on individual parenthesized chord symbols. See Parenthesized chord 
symbols.

● For players set to show chord diagrams, you can now show only the chord symbol or chord 
diagram for individual chord symbols. See Showing only chord symbols or chord diagrams.

Insert Music Text dialog
● The new Insert Music Text dialog makes it easier to add music symbols, such as note 

glyphs and accidentals, to text items and in text frames. See Insert Music Text dialog.

Figured bass improvements
● You can now input tasto solo indications and bracketed figures, including only showing a 

single bracket on each figure. See Figured bass popover and Showing single brackets on 
figured bass. See also Changing figured bass bracket styles.

Note spelling
● A new automatic note respelling dialog has been added, allowing you to specify the notes 

you want to respell and apply general preferences to the selection. See Respell Notes 
Automatically dialog.

● You can now copy note spellings to other layouts, for example, if you originally respelled 
notes in a part layout but want those spellings to appear in the full score layout as well. See 
Copying note spellings to other layouts.

● Additionally, you can reset changes to note spellings in either the current layout only or in 
all layouts. See Resetting note spellings.

New features
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Casting off improvements
● There are new options to make casting off layouts easier, including moving bars to next/

previous systems and locking/resetting entire layouts. See Moving bars to other systems, 
Locking layouts, and Resetting casting off.

● Additionally, there is now a preference for whether system/frame breaks are allowed within 
bars. Disallowing breaks within bars lets you select anything in the bar at the start of which 
you want a system/frame break. See Allowing/Disallowing breaks within bars.

Pasting articulations
● You can now copy phrases and paste only their articulations and jazz articulations to other 

phrases. See Copying and pasting articulations.

Chord diagram fingerings
● You can now show fingerings in chord diagrams, either inside dots or at the ends of 

strings. You can change individual fingerings when editing chord diagram shapes. See 
Hiding/Showing fingerings in chord diagrams and Edit Chord Diagram dialog.

● There are now separate font styles for fingerings and starting fret numbers in chord 
diagrams. See Chord diagram font styles.

Percussion improvements
● You can now interact with rests belonging to unpitched percussion instruments, including 

moving rests vertically and deleting rests. See Moving rests vertically and Deleting rests.

Staff label improvements
● You can now show player names instead of instrument names for each player in each 

layout independently, and set both full and short player names for each player. For 
example, in works with multiple percussionists, showing “Percussion 1” in staff labels 
regardless of their current instrument is sometimes preferred. See Showing instrument/
player names in staff labels and Renaming players.

● Additional options have been added for the appearance and position of instrument 
transpositions in staff labels, including parenthesizing instrument transpositions and 
showing them after the instrument number. See Changing the appearance/position of 
instrument transpositions in staff labels.

● You can now both group the instrument names of adjacent section players in staff labels, 
and align grouped instrument names with the first staff rather than centered between 
staves. See Grouping the staff labels of adjacent identical instruments.

● You can now show vertical labels for player groups to the left of staff labels, as is 
sometimes used in large-scale works. See Player group labels.

Last but Not Least

Saving, resetting, and removing defaults in options dialogs
● A Reset to Factory option has been added to the Preferences dialog, allowing you to 

restore the factory defaults for application preferences if necessary. See Preferences dialog.
● All four ways of saving, resetting, and removing defaults in options dialogs are now always 

shown. Previously, it was necessary to hold a modifier key to access other options if you 
had existing saved defaults. See Layout Options dialog, Note Input Options dialog, Notation 
Options dialog, Engraving Options dialog, and Playback Options dialog.

Project preview
● When you save projects, Dorico now generates preview images of the layout open in the 

music area. PNG files are used on the Open Recent page in the Hub. See Project Info 
dialog.

Pedal line improvements
● You can now add retakes and pedal level changes to, and remove them from, multiple 

rhythmic positions simultaneously. See Adding retakes and pedal level changes with the 
popover, Adding retakes and pedal level changes with the panel, and Removing retakes 
and pedal level changes.

New features
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Changing voices
● You can now change the voice of existing notes using the same methods as creating and 

switching between voices during note input. See Changing the voice of existing notes.

Page templates
● The templates for achieving consistent page formatting that used to be known as “master 

pages” have been renamed, and are now known as “page templates” throughout Dorico. 
See Page templates.

Crosshairs
● You can now show crosshairs when selecting and/or dragging items in Engrave mode, 

which can help you align items more easily. See Hiding/Showing crosshairs.

Font style improvements
● The Edit Font Styles and Paragraph Styles dialogs now show a preview of the selected 

font/paragraph style. See Edit Font Styles dialog and Paragraph Styles dialog.

Accidental scale size
● You can now change the size of accidentals independently of noteheads. See Changing the 

size of accidentals.

Bar number improvements
● You can now set minimum gaps between bar numbers and different clefs shown at the 

start of systems. See Project-wide engraving options for bar numbers.
● You can now hide numbers in subordinate bar number sequences and only show 

alphabetical letters, such as “a”, “b”, and “c”. See Adding subordinate bar numbers.

Beaming improvements
● You can now change the gaps between, and thickness of, beam lines for individual beams. 

See Changing the gaps between beam lines and Changing the thickness of beams.
● You can now force centered beams for beams that include notes only on one side of the 

middle staff line using the new Custom Centered Beam dialog. See Creating centered 
beams.

Hiding clefs and key signatures after the first system
● You can now hide/show clefs and key signatures at the start of single-staff systems from 

the second system onwards in each flow independently. This is a convention commonly 
used in hand-copied lead sheets. See Hiding/Showing clefs at the start of systems and 
Hiding/Showing key signatures at the start of systems.

Grace notes
● You can now turn existing notes into grace notes and vice versa. See Turning existing notes 

into grace notes and Turning grace notes into normal notes.

New features
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Introduction

Thank you very much for purchasing Dorico Pro.

We are delighted that you have chosen Steinberg's scoring application and hope that you will 
enjoy using it for years to come.

Dorico is a next-generation application for producing beautiful sheet music, whether you are 
a composer, arranger, music engraver, publisher, instrumentalist, teacher, or student. Whether 
you want to print your music or share it in a digital format, Dorico is the most sophisticated 
program available.

Like all of Steinberg's products, Dorico has been designed from the ground up by a team of 
musicians who understand your needs and who are dedicated to producing a tool that is both 
easy to learn and use, but also capable of results of the highest quality. Dorico also integrates 
with your existing workflow and can import and export files in a variety of formats.

Dorico thinks about music the same way a human musician does and has a deeper 
understanding of the elements of music and musical performance than other scoring 
applications. Its unique design allows an unprecedented degree of flexibility, in music input and 
editing, in score layout, in rhythmic freedom, and many other areas besides.

Most sincerely yours,

The Steinberg Dorico Team

Platform-independent documentation
This documentation applies to the operating systems Windows and macOS.

Features and settings that are specific to one of these platforms are clearly indicated. In all other 
cases, the descriptions and procedures in the documentation are valid for Windows and macOS.

Some points to consider:

● The screenshots are taken from macOS and use the dark theme in Dorico Pro.

● Some functions that are available on the File menu on Windows can be found in the 
program name menu on macOS.

Usage of musical terms
This documentation uses American terminology for musical items.

The following table lists all the notes and notations that have different names in American and 
British English:

American name British name

Double whole note Breve

Whole note Semibreve
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American name British name

Half note Minim

Quarter note Crotchet

Eighth note Quaver

Sixteenth note Semiquaver

Thirty-second note Demisemiquaver

Sixty-fourth note Hemidemisemiquaver

Hundred twenty-eighth note Semihemidemisemiquaver

Two hundred fifty-sixth note Demisemihemidemisemiquaver

Half-step Semitone

Whole step Whole tone

Staff Stave

Bar/Measure

NOTE

This documentation only uses “bar”.

Bar

Documentation structure
In our documentation, we divide information into three different types of topics, according to 
their content.

Descriptions of the user interface
Topics that describe the functionality of user interface items and list the options and 
settings of dialogs, panels, or other items.

Descriptions of basic concepts
Topics that describe concepts and explain the functionality of a specific software 
feature.

Descriptions of procedures
Topics that provide step-by-step instructions for how to perform a specific task. These 
topics often provide an example for why you might want to follow the steps and a brief 
summary of the result, including consequences to be aware of.

Because of this division of information, our documentation structure functions as a reference 
you can consult for specific information or instructions as required, rather than a guide you must 
read from start to finish.

Introduction
Documentation structure 
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TIP

Descriptive topics do not describe how to perform a task, and procedural topics do not explain 
what something is. To find general information about items or concepts, we recommend 
searching for them by name, such as “dynamics”. To find instructions for performing particular 
actions, we recommend including a relevant verb in your search, such as “moving”.

Links at the bottom of topics guide you to further relevant content. You can also check the 
sidebar for nearby, related topics in the documentation structure.

Typographical conventions
In our documentation, we use structural and markup elements to present information according 
to its purpose.

Structural elements

Prerequisite
Describes any actions or conditions you must have fulfilled before starting a 
procedure.

Procedure
Lists the steps that you must take to achieve a specific result.

Important
Informs you about serious issues; for example, issues that affect the system, the 
connected hardware, or that risk data loss.

Note
Informs you about issues or other relevant information.

Tip
Adds further information or useful suggestions.

Example
Provides you with an example.

Result
Describes the result of the procedure.

After Completing This Task
Informs you about actions or tasks that you can perform after completing the 
procedure.

Related Links
Lists related topics that you can find in this documentation.

Markup

Bold text indicates the name of a menu, option, function, dialog, window, and so on.

EXAMPLE
To open the Project Info dialog, choose File > Project Info.

Introduction
Typographical conventions 
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If bold text is separated by a greater-than symbol, this indicates either a sequence of different 
menus to open, or directions to follow for navigation inside the dialog named at the start of the 
sequence.

EXAMPLE
Choose Edit > Notations > Voices > Change Voice > [Voice].

You can change this option in Preferences > Note Input and Editing > Editing.

File names and folder paths are shown in a different font.

EXAMPLE
example_file.txt

Key commands
Key commands are sets of keys that perform defined tasks when pressed together. They are 
also known as “keyboard shortcuts” or “hotkeys”. Many key commands are the same on different 
operating systems but some are not, and this guide distinguishes them.

When key commands use equivalent modifier keys depending on the operating system, the 
modifier keys are indicated separated by a slash, with the Windows modifier key first and the 
macOS modifier key second.

EXAMPLE
Ctrl/Cmd-Alt/Opt-Down Arrow  means: press Ctrl - Alt - Down Arrow  on Windows, Cmd - Opt -
Down Arrow  on macOS.

When key commands require entirely different keys depending on the operating system, they are 
indicated with the Windows key command first, followed by the macOS key command.

EXAMPLE
# (Windows) or \ (macOS)  means: press #  on Windows, \  on macOS.

In this documentation, we use key commands that match the language of the documentation. 
For example, key commands in the English documentation correspond to the English keyboard 
language.

RELATED LINKS
Key commands in Dorico on page 29
Key Commands page in the Preferences dialog on page 63
Changing the keyboard language on page 67
Changing the application language on page 59

How you can reach us
You can access additional information from the Help menu.

The menu contains links to various Steinberg web pages. Selecting one of these menu items 
automatically launches your web browser and opens the page. On these pages, you can find 
support and compatibility information, answers to frequently asked questions, information 
about updates and other Steinberg products, and so on.

Introduction
Key commands 
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Dorico concepts

Dorico is based on a number of key concepts that come from its design philosophy.

We recommend familiarizing yourself with these concepts, as this will greatly enhance your 
ability to work efficiently with Dorico and to navigate more easily through this documentation.

Design philosophy and higher-level concepts
Deep design considerations are required to create a notation software like Dorico, which might 
be of particular interest to users familiar with scoring applications. Dorico has a forward-thinking 
design that is led by musical concepts rather than computational convenience, and this provides 
many benefits.

In most other graphically-orientated scoring applications, the highest-level concept is the staff or 
the instrument definition that creates a staff or staves. When setting up your full score in such 
programs, you start by adding the correct number of staves, and you are immediately forced 
into making decisions about the layout. This means that you must know in advance whether two 
flutes share a staff or have their own individual staves, or whether there should be two trumpets 
or three. Many of these decisions have significant effects throughout the process of inputting, 
editing, and producing individual instrumental parts.

Typically, every system of a score must contain the same number of staves, even if some 
are hidden on particular systems. This requires the user to manage common conventions for 
themselves, such as multiple players of the same instrument sharing staves. This can be time-
consuming and is naturally error-prone.

By contrast, Dorico is designed to conform more closely to how music is performed in the real 
world and to make the score a flexible expression of the practical choices that go into a musical 
performance, rather than to make the musical performance subservient to the way the score was 
initially prepared.

To that end, the highest-level concept of Dorico is the group of human musicians that performs 
a score. A score can be written for one or more groups; for example, a double choir, or an 
orchestra plus off-stage chamber ensemble, and so on. Each group includes one or more players 
which correspond to the humans who play one or more instruments. Players may either be 
individuals who play more than one instrument, such as an oboist doubling cor anglais, or 
groups in which everyone plays only one instrument, such as eight desks of violinists.

One crucial difference between Dorico and other scoring applications is that the musical content 
exists independently of the score layout in which it is viewed.

The actual music played by the group in your score belongs to one or more flows. A flow is 
any span of music that stands alone; for example, a whole song, a movement of a sonata or 
symphony, a number in a musical show, or even a short scale or exercise. Players might or might 
not have any music to play in a given flow. For example, all the brass players might be omitted 
from the slow movement of a classical symphony, or certain players might have nothing to play 
in some cues in a movie score. This is no problem as you can combine players in flows in any 
combination.

Dorico’s design philosophy provides several benefits. Chief among them is its ability to produce 
multiple layouts that share the same musical content, but each having customized appearances 
to suit different requirements. For example, in the same project you can create a conductor’s 
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score with as many instruments as possible condensed onto a smaller number of staves, a full 
score with each player’s music on separate staves, a custom score layout containing just the 
piano and vocal staves for choral rehearsals, and an instrumental part for each player that only 
contains the music belonging to them.

This means it is not necessary to extract flows or parts as separate files: all this information can 
co-exist in the same Dorico project file.

RELATED LINKS
Condensing on page 743
Assigning players to layouts on page 171

Projects in Dorico
A project is an individual file that you create within Dorico. It can contain multiple separate pieces 
of music of any duration, written for any combination of instruments, and use as many layouts as 
required.

For example, you can create a single project that contains all the preludes and fugues in Bach’s 
“The Well-Tempered Clavier” as separate flows. You could then have one layout that contains only 
the flows for Book 1 and another layout that contains the flows for Book 2.

In addition to the notated music, projects save other relevant information, such as the playback 
template applied, its page templates, and settings in options dialogs.

Dorico projects are saved as .dorico files.

RELATED LINKS
Flows in Dorico on page 23
Layouts in Dorico on page 27
Options dialogs in Dorico Pro on page 30
Page templates in Dorico on page 28
Playback templates on page 651

Modes in Dorico
Modes in Dorico represent a logical sequence of the workflow phases of preparing music, but 
you can switch between them at any time as required for your own workflow.

Dorico Pro contains the following modes:

Setup
In Setup mode, you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how 
they interact with each other; for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and 
layouts, but you cannot select or interact with anything in the music area in Setup 
mode.

Write
In Write mode, you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. The 
available toolboxes and panels allow you to input all the notes and notation items that 
are most commonly used.

Dorico concepts
Projects in Dorico 
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By design, you cannot move notes and items graphically on the page in Write mode. 
Graphical adjustments are only possible in Engrave mode.

Engrave
In Engrave mode, you can make fine adjustments to the position, size, and appearance 
notes and items and determine how the pages of your project are laid out, including 
editing and creating page templates.

By design, you cannot delete any notes or items, change their rhythmic positions, or 
change the pitch of notes in Engrave mode; this prevents mistakes when engraving.

Play
In Play mode, you can change how your music sounds in playback. You can do this by 
changing the playback template and assigning VST instruments, inputting automation, 
adjusting the mix, and changing the sounding duration of notes in playback without 
affecting their notated duration.

Print
In Print mode, you can print your layouts or export them as graphics files. When 
printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing. When exporting layouts, you can specify different graphics file types, 
such as PDF or PNG, and the information you want to include in their exported file 
names.

RELATED LINKS
Setup mode on page 110
Write mode on page 196
Engrave mode on page 513
Print mode on page 666
Play mode on page 614

Flows in Dorico
Flows are separate spans of music that are completely independent in musical content; for 
example, a single song in an album, a movement in a sonata or symphony, a number in a stage 
musical, or a short scale or sight-reading exercise of only a few bars in length. A single project 
can contain any number of flows.

Each flow can contain music for any combination of players, independently of other flows. For 
example, brass players are often tacet in the second movements of Classical-period symphonies, 
so you can remove brass players from the flow for the second movement but leave them in the 
flows for other movements. In a set of cues for a movie, for example, specific players might not 
be required in some cues, so the corresponding flows can contain only those players who have 
anything to play.

The correct assignment of players to flows allows Dorico, for example, to generate tacet sheets 
automatically for individual instrumental parts.

RELATED LINKS
Players, layouts, and flows on page 122
Flows on page 166
Tacets on page 739
Flow headings on page 554

Dorico concepts
Flows in Dorico 
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Players in Dorico
In Dorico, a player can represent an individual musician or multiple musicians in the same 
section. Players hold instruments, so you must add at least one player to your project before you 
can add instruments.

● A single player represents one person who can play one or more instruments. For example, 
a clarinettist who doubles on alto saxophone or a percussionist who plays bass drum, clash 
cymbals, and triangle.

● A section player represents multiple people who all play the same instrument. For example, 
a violin section player might represent all eight desks of the Violin I section in an orchestra, 
or a soprano section player might represent the whole soprano section in a mixed voice 
choir.

NOTE

Section players can only hold one instrument, but they can play divisi. This means that they 
can be divided into smaller units, which is commonly required for strings.

By using the concept of players, Dorico makes it much easier to handle, for example, instrument 
changes, divisi, and condensing music for multiple players onto a smaller number of staves.

You can also group players together; for example, to separate off-stage players from on-stage 
players in a large-scale work. Grouping players together means they are positioned together in 
the score, numbered independently of players outside the group, and are bracketed together 
according to the ensemble type set for each layout.

Players can be assigned to any combination of layouts and flows.

RELATED LINKS
Players, layouts, and flows on page 122
Players on page 124
Player groups on page 162
Divisi on page 1567
Condensing on page 743
Brackets according to ensemble type on page 1026

Instruments in Dorico
In Dorico, an instrument is an individual musical instrument, such as a piano, a flute, or a violin. 
Human voices, such as soprano or tenor, are also considered instruments.

In Dorico, instruments are held by players, just as real instruments are held by human players. 
Section players can only hold one instrument but single players can hold multiple instruments. 
This allows you to handle instrument changes easily, such as when an oboist doubling the cor 
anglais switches from one instrument to the other.

Each instrument automatically gets its own staff, but when instrument changes are allowed, the 
music for multiple instruments held by the same single player can appear on the same staff as 
long as no notes overlap.

Dorico has a database of information about the properties of each instrument. These include 
the playable range, common and uncommon playing techniques, notational conventions, 
transposition properties, tunings, clef, number of staves, type of staff, and so on. Having these 
properties predetermined makes it easier and quicker to set up projects correctly. For example, 
selecting the horn instrument with the appropriate transposition and clef setting for its part 

Dorico concepts
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layout means you do not have to input a layout-specific clef. Similarly, there is a timpani 
instrument that automatically hides all key signatures.

RELATED LINKS
Instruments on page 131
Instrument changes on page 134
Transposing instruments on page 137

Popovers
Popovers allow you to input different notations and perform tasks, such as transposing a 
selection of notes, using only your computer keyboard. They are temporary value fields that use 
text entries for different items and tasks, and there are specific popovers for different purposes.

The dynamics popover with an example entry

One of the key benefits of popovers is that you can use them as you input notes: for example, 
once you reach the position where you want to input a new time signature, you can open the 
time signatures popover, input the time signature you want, and then continue inputting notes.

Although specific entries are required for many notations, the correct entries for different 
notations are consistently and logically structured. For example, tuplets are always expressed as 
a ratio, such as 3:2 or 5:4. Key signatures are expressed using capital letters for major keys and 
lowercase letters for minor keys. Time signatures are expressed as a pair of separated numbers; 
common time signatures use a slash, such as 3/4 or 6/8.

During note input, and depending on the notation you are inputting with the respective popover, 
notations are input either on the currently selected note, which is usually the last note you input, 
or at the current rhythmic position, indicated by the caret.

You can always identify popovers by the icon on their left-hand side, which are the same icons 
used in the Notations toolbox on the right of the window. The Notations toolbox allows you to 
hide/show the corresponding notation’s panel, which is another way you can input notations.

You can only use popovers in Write mode, as that is the only mode where you can input notes 
and items together and change the pitch of notes. Popovers open above the top staff on which 
the caret is active or an item is selected, and at the caret position or the rhythmic position of the 
earliest selected item.

RELATED LINKS
Caret on page 215
Note input on page 220
Notations input on page 271
Notations toolbox on page 202
Right zone (Write mode) on page 205
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Notes and rests in Dorico
In Dorico, the notation and division of notes and rests is determined semantically by rules based 
on convention. This means that note and rest durations can change and appear differently later 
than when you first input them.

Dorico is able to update how notes and rests are notated depending on their context because of 
the following key concepts:

1. Notes are treated as a single unit, even if they appear as a tie chain that contains multiple 
notes tied together.

2. Implicit rests automatically fill the gaps between the notes you input.

In combination with time signatures and Dorico’s understanding of their corresponding meters, 
this allows you to input only the notes you want with the duration required. It is not necessary 
to input rests between notes or input ties for notes that cross the half-bar, for example. If you 
subsequently change the time signature or move notes rhythmically to start earlier or later, 
Dorico updates how notes and rests are notated, such as by notating a quarter note as two tied 
eighth notes if it now straddles a barline or consolidating two eighth note rests into a single 
quarter note rest if they are now in the same bar.

If you tie existing notes together, you might find that they turn into a single note, such as a 
half note instead of two tied quarter notes, or into a tie chain containing more notes. This is 
because tie chains are treated as single notes in Dorico, and Dorico automatically notates and 
beams notes appropriately depending on their duration, the prevailing time signature, and their 
position in the bar. Similarly, notes can change after you input notes immediately following them 
as this changes the context, such as a quarter note tied to an eighth note becoming a dotted 
quarter note when it is followed by an eighth note rather than a rest.

TIP

In Write mode, selecting any part of a tie chain selects the whole tie chain because it is a single 
note. However, you can still input notations, such as dynamics, in the middle of tie chains by 
activating the caret and moving it to the required rhythmic position within the tie chain.

You can change default settings for note and rest grouping, and also beam grouping, on a 
per-flow basis. You can force the duration of individual notes and rests; for example, if you want 
to specify subdivisions within a tie chain that are different than the prevailing meter.

RELATED LINKS
Notes on page 1246
Ties on page 1620
Implicit vs. explicit rests on page 1488
Note and rest grouping on page 1021
Beam grouping according to meters on page 999
Per-flow notation options for beam grouping on page 998
Caret on page 215
Inputting notes on page 221
Forcing the duration of notes/rests on page 262
Inputting ties on page 248

Dorico concepts
Notes and rests in Dorico 

26
Dorico Pro 4.3.30



Rhythmic position
In Dorico, notes and items exist at rhythmic positions, which are calculated using their place in 
musical time in the flow rather than their position in a specific bar that has a particular time 
signature.

In Dorico, musical time is the number of beats starting from the beginning of each flow. For 
example, instead of a note existing on beat 3 in bar 4 in a 4/4 time signature, Dorico considers 
that note to exist at beat 15, regardless of the time signature and its position in a bar.

This approach allows for a lot of flexibility. For example, because notes and items exist 
independently of bars and time signatures in Dorico, you can change the time signature without 
changing when notes happen in relation to each other or adding rests at the end of each 
bar. Instead, the barlines simply move to different positions and note grouping is updated as 
required, such as notating a quarter note as two tied eighth notes if it now straddles a barline or 
crosses the half-bar. You can even start writing notes without inputting a time signature at all.

Similarly, you can easily push notes to later rhythmic positions or pull them in to earlier ones 
using Insert mode without the risk of them being incorrectly notated. It also means you can 
think of items existing in the music independently of notes, because items exist at a particular 
rhythmic position, rather than being attached to notes. To input items at rhythmic positions that 
do not coincide with the start of notes, such as dynamics in the middle of tie chains, you can 
either select any other item at that position, or activate the caret and input items at the caret 
position.

In Dorico, the rhythmic position of notes and items is separate from their graphical position on 
the page. The benefit of this is that you can input items at the position in the music where they 
must apply and then move them graphically without causing them to apply to different notes or 
inadvertently split multi-bar rests. For example, if you want strings to play pizzicato from the start 
of a bar, but because of tight vertical spacing you want to move the pizz. indication slightly to 
the side. Attachment lines link items to the rhythmic positions to which they apply, so it is always 
clear where they belong, but are not printed.

RELATED LINKS
Note and rest grouping on page 1021
Beaming on page 998
Time signatures on page 1639
Inputting notes in Insert mode on page 237
Notes on page 1246
Caret on page 215
Insert mode on page 454
Rhythmic grid on page 214
Annotations on page 687

Layouts in Dorico
Layouts combine musical content, as represented by flows and players, with rules for page 
formatting and music engraving, and allow you to produce paginated music notation that can be 
printed or exported in various formats. For example, part layouts typically only show the music 
for one player, whereas full score layouts show the music of all players in the project.

A typical project for an ensemble contains several layouts. By default, Dorico projects contain a 
single full score layout that contains the music for all players, and a part layout for each player 
that only contains their music. However, you can also create as many layouts as required.
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When you add the first player to a project, Dorico automatically creates a full score layout and 
a part layout. For all subsequent players you add to the project, Dorico creates a part layout for 
each player and assigns them all to the existing full score layout.

Layouts can contain any combination of players and flows. They share the musical content of 
these players and flows, such as the notes each instrument plays. For example, when you change 
the pitch of a note in the full score, that note’s pitch is also updated in the corresponding part 
layout.

You can control practically every aspect of page formatting in each layout independently, 
including note spacing, staff size, page size, margins, and casting off; that is, the positions of 
system breaks and page turns. Changing these aspects in one layout does not affect other 
layouts. For example, inserting systems breaks in a part layout does not change the casting off in 
the full score.

Similarly, you can change the visual appearance of many items only in one layout, without 
affecting other layouts, using local properties. For example, you can hide text items in the full 
score layout but show them in part layouts.

The default formatting of pages in layouts is determined by page templates. By default, full score 
layouts use a different page template set to part layouts; however, you can apply a different page 
template set to each layout. For example, if some part layouts need a different running header, 
or consistently shorter music frames.

Deleting layouts does not delete any music from the project.

RELATED LINKS
Layouts on page 169
Players, layouts, and flows on page 122
Page formatting on page 689
Casting off on page 728
Condensing on page 743
Properties on page 769
Local vs. global properties on page 770
Page templates on page 527
Page template sets on page 529
Types of page templates on page 532
Applying page template sets to layouts on page 692
Printing layouts on page 671
Exporting layouts as graphics files on page 675

Page templates in Dorico
Page templates in Dorico Pro allow you to achieve consistent page formatting by applying the 
same arrangements of frames to multiple pages and in different layouts.

Frames are boxes in which you can display text, music, and graphics. The default page templates 
contain a large music frame that takes up most of the page and text frames at the top and 
bottom. On the first page of music, text frames display the project title, lyricist, and composer. 
On the second page of music onwards, text frames display the page number and flow title for the 
top flow on that page in scores, and the layout name in parts.

All pages in your scores and parts inherit their default formatting from page templates. 
Whenever you change anything on page templates, such as inserting new frames, this is 
automatically reflected on all pages that use these page templates, provided those pages do 
not have page template overrides.
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Dorico Pro provides different types of page templates so that there is appropriate page 
formatting for first pages independently of subsequent pages, as the first page typically includes 
additional information, such as the title, composer, and copyright. Dorico Pro uses tokens to 
display this additional information.

Page templates are contained in page template sets. By default, Dorico Pro provides separate 
page template sets for full score and part layouts. Page template sets are automatically applied 
to every layout that you create.

NOTE

Changing individual pages in layouts is considered a page template override in Dorico Pro, which 
is a type of page format change. This includes, for example, editing the title or running header 
on one page, rather than in the page template editor. Pages with page template overrides no 
longer get updated if you edit the page template and are not automatically deleted, even if they 
are empty because the layout became shorter.

RELATED LINKS
Page template sets on page 529
Page templates on page 527
Types of page templates on page 532
Frames on page 560
Page format changes on page 542
Tokens on page 576

Key commands in Dorico
Dorico’s key commands have been designed to be logical, consistent, and accessible using a 
standard computer keyboard, without needing a number pad.

EXAMPLE

● The arrow keys on their own navigate the selection around the music area.

● Alt/Opt  modifies selected items.

For example, in Write mode, adding Alt/Opt  to the up/down arrow keys transposes notes by 
staff position; adding Alt/Opt  to the right/left arrow keys moves notes/items rhythmically. 
In Engrave mode, adding Alt/Opt  to any arrow key moves items a small amount graphically.

● Shift - Alt/Opt  changes the duration of notes/items in Write mode.

For example, Shift-Alt/Opt-Right Arrow  lengthens notes/items by the current rhythmic 
grid resolution.

● Ctrl/Cmd  increases the amount by which selected items are modified.

For example, in Write mode, adding Ctrl/Cmd - Alt/Opt  to the up/down arrow keys 
transposes notes by an octave; Ctrl/Cmd-Shift-Alt/Opt-Right Arrow  doubles the duration 
of notes. In Engrave mode, adding Ctrl/Cmd - Alt/Opt  to any arrow key moves items a large 
amount graphically.

● Shift  plus letter keys opens popovers in Write mode.

For example, Shift-D  opens the dynamics popover; Shift-O  opens the ornaments popover.

● Ctrl/Cmd - Shift  plus specific letter keys opens options dialogs.

For example, Ctrl/Cmd-Shift-L  opens Layout Options; Ctrl/Cmd-Shift-N  opens Notation 
Options.
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The default key commands in Dorico depend on your keyboard language setting, which follows 
your application language setting by default.

You can view available key commands in the following ways:

● Choose Help > Key Commands to open the Dorico Key Commands window, which provides 
an overview of all available key commands.

● Search for key commands of specific functions or menu items in Preferences > Key 
Commands. In this dialog, you can also assign new key commands or change default key 
commands.

● When you move the mouse over a tool or a function that has a key command, a tooltip with 
the corresponding key command in brackets is shown.

RELATED LINKS
Interactive Dorico key commands map on page 64
Preferences dialog on page 61
Key Commands page in the Preferences dialog on page 63
Searching for the key commands of functions on page 65
Assigning key commands on page 66
Changing the keyboard language on page 67
Changing the application language on page 59

Options dialogs in Dorico Pro
Options to control the default appearance of music and functionality of Dorico Pro are available 
in different dialogs according to their type and purpose.

We recommend becoming familiar with the available options in these dialogs, as finding the 
most appropriate settings for each project reduces the requirement for manual intervention and 
graphical tweaks.

Dorico Pro contains the following dialogs for global settings:

Layout Options
Contains options that are likely to vary from layout to layout, such as page size, staff 
size, and the appearance and position of bar numbers. Options in Layout Options 
affect only the selected layouts but apply to all flows in those layouts.

Notation Options
Contains options that are likely to vary from flow to flow, such as beam grouping and 
accidental duration rules. Options in Notation Options affect only the selected flows 
but apply to all layouts in which those flows appear.

Note Input Options
Contains options relating to how you want Dorico Pro to interpret what you input, 
such as creating chord symbols from a MIDI keyboard. Options in Note Input Options 
affect the whole project but do not affect any other projects unless you save your 
settings as default.

Engraving Options
Contains options that control the appearance and position of notes and items to a high 
level of precision. For example, you can set whether crescendos appear as hairpins or 
text and set the slant of beams according to the interval distance within the beam. 
Options in Engraving Options affect the whole project but do not affect any other 
projects unless you save your settings as default.
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Playback Options
Contains options that control what you hear in playback and how notation items affect 
playback, including setting a dynamic curve for how much different dynamics affect 
the volume, whether repeats are included in playback, and whether you want a gap 
between flows. Options in Playback Options affect the whole project but do not affect 
any other projects unless you save your settings as default.

TIP

Many options have equivalent properties, which you can change for individual notes and items.

RELATED LINKS
Layout Options dialog on page 834
Notation Options dialog on page 837
Note Input Options dialog on page 839
Engraving Options dialog on page 840
Playback Options dialog on page 842
Preferences dialog on page 61
Library Manager on page 831
Properties on page 769
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User interface

The user interface of Dorico Pro is designed to keep all of the important tools at your fingertips. 
This chapter introduces you to key aspects of the user interface.

Project window
Dorico Pro’s main project window allows you to access all the options and tools you need to 
work on a project. You can open multiple project windows for the same project or for different 
projects.

The project window comprises the following areas:

1 Toolbar

Allows you to access the modes, the workspace options, the Mixer, the Video window, and 
the main transport options.

2 Tab bar

Displays all open tabs. If you split the music area and open several tabs, tab groups are 
shown. Available in Setup, Write, and Engrave modes.

3 Project start area/Music area/Track overview/Print preview area

The central part of the project window where you work on your project. When you start a 
new empty project, this area shows the project start area that allows you to add your first 
players. Once you have added a player or an ensemble, this area becomes the music area 
that shows the music notation of the currently selected layout.

In Play mode, this area contains a track overview that displays your music in a similar way to 
that used in a digital audio workstation, or “DAW”, such as Cubase.
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In Print mode, the print preview area shows a preview of how your project will appear when 
printed onto paper or exported into a graphics file format.

4 Zones

Zones on the left, right, and lower edges of the project window contain panels that provide 
the notes, notations, and functions that you need to create and edit your music. Different 
panels are available in each zone according to the mode.

5 Toolboxes

Toolboxes provide access to items and tools that you can use to input and edit your music. 
Different toolboxes contain different items and tools according to the mode.

6 Status bar

Allows you to choose a different view and page arrangement of the music area. It also 
contains zoom options and a summary of your current selection in the music area.

RELATED LINKS
Starting new projects on page 74
Opening multiple project windows on page 52
Showing multiple tabs in the same project window on page 51
Switching between layouts on page 46
Project window in Setup mode on page 110
Project window in Write mode on page 196
Project window in Engrave mode on page 513
Project window in Play mode on page 614
Project window in Print mode on page 666

Toolbar
The toolbar allows you to access modes and workspace options as well as the Mixer and main 
transport options. It is located at the top of the project window and is available in all modes.

You can hide/show the toolbar in any of the following ways:

● Press Ctrl/Cmd-6 .

● Choose Window > Show Toolbar.

The toolbar contains the following:

1 Modes

Selectable workspaces in the project window that represent different phases in the workflow 
of preparing a score. If the width of the main project window becomes sufficiently small, the 
mode buttons become a menu.

2 Workspace options

Provide options that allow you to select different layouts to open in the music area and to 
change the working environment.

3 Show Video

Hides/Shows the Video window.

4 Show Mixer

Hides/Shows the Mixer window.

5 Mini transport

User interface
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Allows you quick access to the main transport functions, including Play, Record, and Click.

6 Show Transport Bar

Hides/Shows the Transport window, which contains playback and MIDI recording functions.

7 Undo

Allows you to undo previous actions.

8 Redo

Allows you to restore previous actions that were undone using Undo.

RELATED LINKS
Hub on page 72
Modes in Dorico on page 22
Mini transport on page 35
Transport window on page 649
Videos on page 190
Mixer window on page 822

Workspace options
The workspace options in the middle of the toolbar provide options that allow you to select 
different layouts and to change the working environment.

Layout selector

Allows you to select other layouts to show in the current tab.

Show Tabs
Shows/Hides the tab bar above the music area.

Show Tabs when the tab bar is hidden Show Tabs when the tab bar is shown

Hide/Restore Zones
Shows/Hides all open zones.

Hide/Restore Zones when zones are shown Hide/Restore Zones when all zones were 
previously shown but are now all hidden

RELATED LINKS
Layouts on page 169
Switching between layouts on page 46
Zones and panels on page 40
Hiding/Showing zones on page 47
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Mini transport
The mini transport on the right of the toolbar provides quick access to the main transport 
functions of Dorico Pro.

Activate Project

Activates/Deactivates playback in the project. When playback is deactivated, transport 
and playback functions are disabled.

Time display
Shows the position of the playhead in one of the following formats:

● Bars, beats, and ticks

● Elapsed time in the following order of units: hours, minutes, seconds, milliseconds

● Timecode in the following order of units: hours, minutes, seconds, frames

Time display showing bars 
and beats

Time display showing 
elapsed time

Time display showing the 
timecode

You can change the content shown in the time display by clicking it.

Rewind to Beginning of Flow

Moves the playhead back to the beginning of the flow.

Play
Starts/Stops playback, either from the playhead position or the earliest selected item, 
depending on your setting on the Play page in Preferences.

Play when playback is stopped Play during playback

Record
Starts/Stops MIDI recording.

Record outside of MIDI recording Record during MIDI recording

Click

Plays/Mutes the metronome click during playback and recording.

Tempo Mode
Displays the tempo used for both playback and recording. The value changes 
according to the playhead position, and its appearance changes according to its mode.
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● You can change the tempo mode by clicking the beat unit.

● You can change the metronome mark value used in fixed tempo mode by clicking 
the number to show a slider, then dragging the slider to the right/left.

Fixed Tempo Mode Follow Tempo Mode

TIP

The Transport window contains additional transport functions.

RELATED LINKS
Transport window on page 649
Playing back music on page 632
Moving the playhead on page 631
Changing the tempo mode on page 634
Changing the content shown in the transport display on page 651
Changing the click settings on page 267
Changing the sound used for the click on page 625
MIDI recording on page 263
Mixer window on page 822
Preferences dialog on page 61
Timecodes on page 1435

Tab bar
The tab bar in Dorico Pro allows you to display different layouts within the same project window. 
It is located between the toolbar and the music area.

● You can hide/show the tab bar by clicking Show Tabs  in the toolbar.

The tab bar contains the following:

1 Tabs

Displays all open tabs, with their position from left to right reflecting the order in which you 
opened them. Each tab is labeled with the name of the selected layout. The tab currently in 
view in the music area is highlighted.

When you hover over an individual tab, an x appears that allows you to close the tab.

2 New Tab

Allows you to open a new tab. Tabs can contain a different layout, or an additional view of a 
layout that is already open in another tab or window.
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TIP

You can change whether the tab bar is hidden or shown in new projects by default in 
Preferences > General > View.

RELATED LINKS
Preferences dialog on page 61

Project start area
The project start area is displayed in the middle of the project window in Setup, Write, and 
Engrave modes when you set up a new empty project. When you add at least one player, the 
view changes into the music area.

The project start area shows cards that allow you to add players to the project.

Project start area

RELATED LINKS
Adding players on page 125

Music area
In Setup, Write, and Engrave modes, the music area shows the music notation of the currently 
selected layout. It is the central part of the project window where you work on your project.
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Music area showing a new choir piece in page view

The music area displays layouts in either galley view or page view. In Engrave mode, layouts 
always appear in page view. The tab bar above the music area allows you to open multiple 
layouts in the project simultaneously and switch between them. The scroll bars to the right and 
to the bottom of the music area allow you to scroll within the layout.

You can use the layout selector in the toolbar to show other layouts in the music area.

When zones are open on the right, left, and lower edges of the window, the size of the music 
area can be reduced. You can hide/show zones when necessary.

RELATED LINKS
Toolbar on page 33
Switching to galley/page view on page 53
Switching between layouts on page 46
Hiding/Showing zones on page 47
Navigation on page 444
Layouts on page 169
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Print preview area
The print preview area is the central part of the project window in Print mode that shows a 
preview of what will be printed or exported as a graphic.

Print preview area displaying a score set to print 2-up

The print preview area shows a preview of the first layout selected in the Layouts panel. You 
can scroll through the pages that are shown, but you cannot edit layouts. If you want to make 
changes, you must switch to Setup, Write, or Engrave mode.

TIP

You can go directly to the first page in the layout by pressing Home , and to the last page 
by pressing End . You can change these key commands on the Key Commands page in 
Preferences.

If you select multiple layouts to be printed as part of the same print job, the print preview area 
only displays the first layout. If you want to show the expected page arrangement for each layout 
in the print preview, you must check each layout individually before you start printing.

RELATED LINKS
Project window in Print mode on page 666
Layouts panel (Print mode) on page 667
Key Commands page in the Preferences dialog on page 63
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Zones and panels
Zones on the left, right, and lower edges of the project window contain panels that provide 
the notes, notations, and functions that you need to set up, write, edit, and format your music. 
Different panels are available in each zone according to the mode.

You can hide/show each zone individually or all of them at the same time.

1 Left zone. In Write mode, this contains the Notes panel.

2 Right zone. In Write mode, this can display different panels, according to the current 
selection in the Notations toolbox.

3 Lower zone. In Write mode, this can display different panels, including the Properties panel 
and Mixer.

The zones contain different panels in each mode in Dorico Pro.

Modes and their panels

Mode Left Zone Right Zone Lower Zone

Setup Players panel Layouts panel Flows panel

Write Notes panel Notations panels Properties, Keyboard, 
Fretboard, Drum Pads, 
Mixer, and Key Editor 
panels

Engrave Formatting, Frames, 
and Graphic Slices 
panels

Pages panel Properties and Mixer 
panels

Play Track Inspector and 
VST and MIDI panel

n/a Mixer and Key Editor 
panels
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Mode Left Zone Right Zone Lower Zone

Print Layouts panel Print Options panel n/a

RELATED LINKS
Modes in Dorico on page 22
Hiding/Showing zones on page 47
Project window in Setup mode on page 110
Project window in Write mode on page 196
Project window in Engrave mode on page 513
Project window in Play mode on page 614
Project window in Print mode on page 666
Players panel on page 111
Layouts panel (Setup mode) on page 118
Flows panel on page 121
Notes panel on page 201
Right zone (Write mode) on page 205
Lower zone (Write mode) on page 206
Left zone (Engrave mode) on page 515
Pages panel on page 522
Properties panel on page 769
Track Inspector on page 617
Key Editor panel on page 773
Mixer panel on page 821
Layouts panel (Print mode) on page 667
Print Options panel on page 668

Toolboxes
Toolboxes are located on the right and left edges of the project window in some modes. They 
contain different tools and options according to the current mode, but in general they allow you 
to input and modify notes/items and to show different panels in the corresponding zone.

The following toolboxes are available in the different modes:

Write mode

● Notes toolbox on the left of the project window

● Notations toolbox on the right of the project window

Engrave mode

● Engrave toolbox on the left of the project window

RELATED LINKS
Project window on page 32
Notes toolbox on page 197
Notations toolbox on page 202
Engrave toolbox on page 514
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Status bar
The status bar at the bottom of the project window allows you to choose different views and 
page arrangements for the music area.

NOTE

Not all options in the status bar are available in all modes.

Status bar in Write mode

1 Rhythmic Grid selector

Allows you to change the rhythmic grid resolution, which affects certain aspects of inputting 
and editing, such as the amount by which items move.

2 Status display

Displays information about the current layout and selection, divided in up to three sections, 
which are, from left to right:

● Transposition of the current layout

● The bar/range of bars of the current selection

● Summary of the selection; for example, the pitch and voice of a single selected note, or 
the implied chord of multiple selected notes

3 Disclosure arrow

Allows you to show/hide the lower zone in Setup, Write, and Engrave modes.

4 Selection tools

Allow you to switch between using the Marquee Tool and the Hand Tool in Write mode and 
Engrave mode.

5 View type selector

Allows you to select one of the provided view types for the music area in Setup and Write 
mode.

6 Page arrangement options

Allow you to choose between different horizontal and vertical arrangements of either 
individual pages or pairs of pages, which are called spreads.

7 Zoom options

Allow you to change the zoom factor of the music area and its musical contents. There are 
preset zoom levels but you can also use a custom zoom level.

8 MIDI activity indicator/Audio engine connection warning

Indicates that there might be MIDI or audio problems that require your attention.

● A brief green light  indicates that Dorico Pro is receiving MIDI input from a connected 
device. If the green light is persistent, a connected MIDI device is sending lots of data, 
which can cause problems.

● A warning icon  indicates that Dorico Pro is unable to send MIDI events to the audio 
engine; for example, if no device is chosen or the sample rate is wrong. You can click the 
warning icon to open the Device Setup dialog, where you can fix the problem in most 
cases.
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RELATED LINKS
Rhythmic grid on page 214
View types on page 43
Page arrangements for page view on page 44
Zoom options on page 45
MIDI recording on page 263
Playing back music on page 632
Enabling/Disabling MIDI input devices on page 271

Selection tools
The status bar in Dorico Pro contains selection tools that you can use to select items and change 
the music shown within the music area.

Marquee Tool

Allows you to drag a rectangle to select multiple notes and notations.

Hand Tool

Allows you to move the view within the music area.

TIP

● You can press Alt/Opt-H  to switch between selection tools.

● To use the other tool briefly without selecting it, Shift -drag with the mouse.

● You can change the default selection tool for all future projects on the Note Input and 
Editing page in Preferences.

RELATED LINKS
Selecting notes/items on page 426
Selecting multiple items using marquee selections on page 428
Moving the view in the music area on page 447
Preferences dialog on page 61

View types
In Dorico Pro there are different ways to view your layouts.

The following view types are available:

Galley View
Lays out all the staves in the current layout and flow on a single continuous system.

This view type is most useful during the process of inputting the music as it allows 
you to focus on the musical content of your project. Because it shows all staves, galley 
view is particularly useful when inputting notes for single players holding multiple 
instruments and in layouts with condensing enabled.

By default, bar numbers are shown every bar above every staff. Staff labels are also 
shown above every staff, and follow the view as you scroll so they are always visible.
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NOTE

Note spacing is unjustified in galley view and there is no automatic vertical collision 
avoidance, so notes and items might overlap. You can change the default gaps 
between staves in galley view for each layout independently.

Page View
Displays your layout paginated exactly as it appears when you print or export it.

This view type is useful for determining appropriate page turns, for example.

NOTE

● The view type is reset to your default setting when you switch layouts.

● You can change the default view type used for all future projects in the View section of the 
General page in Preferences.

RELATED LINKS
Preferences dialog on page 61
Switching to galley/page view on page 53
Changing the staff spacing in galley view on page 723
Page formatting on page 689
Condensing on page 743
Players on page 124
Instruments on page 131

Page arrangements for page view
Page arrangement options in the status bar allow you to change the way pages are arranged in 
the music area, for layouts shown in page view.

Spreads Horizontally

Displays pages in pairs as two-page spreads, with each pair laid out from left to right in 
a row.

Spreads Vertically

Displays pages in pairs as two-page spreads, with each pair laid out from top to bottom 
in a column.

Single Pages Horizontally

Displays individual pages laid out from left to right.

Single Pages Vertically

Displays individual pages laid out from top to bottom.

RELATED LINKS
Status bar on page 42
Switching to galley/page view on page 53
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Zoom options
Zoom options in the status bar allow you to change the displayed size of pages in the music area.

Custom Zoom

Opens a dialog that allows you to set a custom zoom percentage.

Set Zoom

Allows you to select one of the preset zoom scaling factors. You can set a permanent 
zoom factor for all future projects on the General page in Preferences.

Zoom Out

Decreases the size of notes and notations in the music area.

Zoom In

Increases the size of notes and notations in the music area.

RELATED LINKS
Status bar on page 42
Preferences dialog on page 61
Zooming in/out of the music area on page 448

Disclosure arrows
Disclosure arrows indicate that objects, areas, and menus can be expanded/collapsed, either 
vertically or horizontally.

In Dorico Pro, disclosure arrows are commonly used to expand/collapse sections in panels, 
advanced options, and cards, such as player cards in the Players panel in Setup mode.

Disclosure arrow for a player card
Disclosure arrows for sections in the Tempo panel

RELATED LINKS
Players panel on page 111
Instruments on page 131
Options dialogs in Dorico Pro on page 30

Workspace setup
Dorico Pro enables you to set up your workspace according to your working style. For example, 
you can open multiple tabs to display multiple layouts in the same window. You can also open 
the same project in multiple project windows.
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RELATED LINKS
Navigation on page 444
Hiding/Showing zones on page 47
Starting new projects on page 74

Switching between layouts
You can change which layout is displayed in the current tab in the music area in Setup, Write, 
and Engrave modes, or in the track overview in Play mode. For example, if you want to check 
individual part layouts.

NOTE

You can only switch between layouts to which players are assigned.

PROCEDURE

● Switch to another layout in any of the following ways:

● To switch to the next layout, press Shift-Alt/Opt-] .

● To switch to the previous layout, press Shift-Alt/Opt-[ .

● Select an item on a staff or in the piano roll of the player whose layout you want to open 
and press W .

● In the toolbar, click the layout selector and select a layout from the menu.

RESULT
The selected layout is opened in the music area. It replaces the layout previously open in the tab.

TIP

You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Layouts on page 169
Implicit vs. explicit rests on page 1488
Players, layouts, and flows on page 122
Assigning players to layouts on page 171
Switching to galley/page view on page 53
Switching between flows in the track overview on page 616
Piano roll editor on page 784
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Hiding/Showing zones
You can hide/show individual zones or all zones simultaneously; for example, to increase the 
space available for displaying music in the music area, or to access options in a specific panel.

NOTE

In some modes, not all methods are available.

PROCEDURE

1. Hide/Show the left zone in any of the following ways:

● Press Ctrl/Cmd-7 .

● In the toolbox on the left, click Show Left Zone .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.

2. Hide/Show the right zone in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● In the Notations toolbox, click the button for any panel you want to show, or the active 
button for the panel you want to hide.

● Choose Window > Show Right Zone.

3. Hide/Show the lower zone in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

4. Hide/Show all zones in any of the following ways:

● Press Ctrl/Cmd-0 .

● In the toolbar, click Hide/Restore Zones .

● Choose Window > Hide/Restore Zones.

RESULT
The corresponding zones are hidden/shown.

If you hide all active zones, the Hide/Restore Zones button in the toolbar indicates which zones 
were previously active but are now hidden.

TIP

● You can assign key commands for showing specific panels in the lower zone on the Key 
Commands page in Preferences.

● You can choose to hide the right/left zones when the lower zone is shown, and vice versa, 
automatically in all future projects in Preferences > General > Window.
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EXAMPLE

Hide/Restore Zones button when zones are shown Hide/Restore Zones button when all zones were 
previously shown but are now all hidden

RELATED LINKS
Zones and panels on page 40
Toolbar on page 33
Disclosure arrows on page 45
Properties panel on page 769
Preferences dialog on page 61
Key Commands page in the Preferences dialog on page 63

Opening new tabs
You can open multiple tabs in the same project window, which you can use to display multiple 
layouts or different views of the same layout. For example, you can show your full score layout in 
page view in one tab and in galley view in another tab.

Each tab can contain a separate layout or a different view of a layout already open in another tab 
or window. Whenever you open a new tab, you are prompted to select a layout that you want to 
display in the tab.

You can find tabs in the tab bar, located at the top of the music area, below the toolbar. If no tabs 
are shown, click Show Tabs  in the toolbar.

PROCEDURE

1. Open a new tab in any of the following ways:

● Press Ctrl/Cmd-T .

● At the right end of the tab bar, click New Tab .

● Choose Window > New Tab.

A new tab opens that shows recent layouts at the top and a list of other layouts in the project 
at the bottom. If the tab bar was hidden, it is now shown.
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2. Select a layout to open in the new tab in any of the following ways:

● Click one of the icons.

● In the list at the bottom, select a layout.

● In the toolbar, click the layout selector and select a layout.

RESULT
The layout that you choose opens in the active tab.

TIP

You can also switch between different layouts within the same tab.

RELATED LINKS
Tab bar on page 36
Toolbar on page 33
Switching between layouts on page 46

Closing tabs
You can close individual tabs of layouts that you no longer need, and you can close multiple tabs 
at the same time.

PROCEDURE

● Close tabs in any of the following ways:

● Select the tab you want to close and press Ctrl/Cmd-W .

● Hover over the tab you want to close and click x.
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● Right-click the single tab you want to close and choose Close Tab from the context 
menu.

● Right-click the tab you do not want to close and choose Close Other Tabs from the 
context menu.

NOTE

You cannot close the last tab in a window. If only one tab is open and you no longer want to 
see the tabs, deactivate Show Tabs in the main toolbar. The tab is no longer displayed, but 
the corresponding layout is still shown.

RESULT
If you selected a single tab and closed it, the selected tab and its corresponding layout are 
closed.

If you selected a single tab and closed other tabs, all open tabs except for the selected tab are 
closed.

Switching between tabs
You can switch between different open tabs to show different layouts in the music area.

PROCEDURE

● Switch tabs in any of the following ways:

● To cycle forwards through all open tabs, press Ctrl-Tab .

● To cycle backwards through all open tabs, press Ctrl-Shift-Tab .

● Click the tab to which you want to switch.

TIP

● You can choose to keep selected items in view automatically when switching between 
tabs and windows on the General page in Preferences.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Preferences dialog on page 61

Changing the order of tabs
You can move tabs to a different position on the tab bar.

PROCEDURE

● Click and drag a tab to the new position.

The other tabs move to show where the dragged tab will be positioned.

User interface
Workspace setup 

50
Dorico Pro 4.3.30



Showing multiple tabs in the same project window
You can split your project window to display two tabs at the same time. The split can be either 
vertical or horizontal, allowing you to display different layouts either side by side or above one 
another.

PROCEDURE

1. Select the tab of the layout that you want to move to a new tab group.

2. Split the view in one of the following ways:

● To show layouts side by side, choose Window > Vertical Split.

● To show layouts above one another, choose Window > Horizontal Split.

RESULT
The project window is split to display two tabs at the same time. The selected tab is moved to the 
new tab group.

Moving tabs to another tab group
You can move tabs to other tab groups. For example, if you want to compare different layouts or 
two views of the same layout.

PREREQUISITE
You have opened at least two tabs, and they are both shown in the same project window.

PROCEDURE

● Click and drag the tab into the target tab group.

Moving tabs to other windows
You can move tabs to another open window of the same project to show the corresponding 
layouts in a new window. For example, if you want to compare two layouts on two displays.

NOTE

● The layouts must belong to the same project. If you attempt to move a tab to a window of a 
different project, a new window is created for the project to which the layout belongs.

● You can only move tabs to other windows if you have opened at least two tabs.

PROCEDURE

● Do one of the following:

● To create a new project window with the tab inserted, either click and drag the tab away 
from the tab bar and release it, or choose Window > Move Tab To New Window. You 
can also right-click tabs and choose this option from the context menu.

● To move the tab to an existing project window, click and drag the tab onto the tab bar in 
the corresponding project window.
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Opening multiple project windows
You can open multiple project windows for the same project; for example, if you want to work 
on multiple layouts at the same time. You can also show a different mode of the same project in 
each window, such as having one window show Write mode and another show Play mode.

During playback, all windows that belong to the same project show the playhead and move the 
view to follow the music.

PROCEDURE

● Open a new project window in any of the following ways:

● Press Ctrl/Cmd-Shift-T .

● Choose Window > New Window.

RESULT
A duplicate of the window opens. It contains the same tabs and the same view options as the 
original window.

TIP

You can choose to keep selected items in view automatically when switching between tabs and 
windows on the General page in Preferences.

RELATED LINKS
Playhead on page 630
Switching between tabs on page 50

Switching to full screen view
You can maximize the amount of screen space available for your music by making any project 
window cover the whole screen.

You can also hide the desktop elements provided by your operating system; for example, the 
task bar in Windows or the system menu bar and Dock in macOS.

Within Dorico Pro, you can also hide/show the zones on the edges of the window.

PROCEDURE

● Choose View > Full Screen.

AFTER COMPLETING THIS TASK
To return to the default view, choose View > Full Screen again.

RELATED LINKS
Hiding/Showing zones on page 47
Zooming in/out of the music area on page 448
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Switching to galley/page view
You can switch between different view types in the music area in Setup mode and Write mode. 
For example, if a flute player in your project is doubling piccolo, you can switch to galley view to 
see the piccolo staff in addition to the flute staff.

NOTE

In Engrave mode, layouts always appear in page view.

PROCEDURE

1. Switch to galley or page view in any of the following ways:

● To switch to galley view, press Ctrl/Cmd-Alt/Opt-2 .

● To switch to page view, press Ctrl/Cmd-Alt/Opt-1 .

● In the status bar, select Galley View or Page View from the view selector.

2. Optional: If you selected Page View, choose one of the available page arrangements in the 
status bar.

● To show display pages in pairs as two-page spreads, with each pair laid out from left to 
right in a row, choose Spreads Horizontally .

● To display pages in pairs as two-page spreads, with each pair laid out from top to 
bottom in a column, choose Spreads Vertically .

● To display individual pages laid out from left to right, choose Single Pages Horizontally 

● To display individual pages laid out from top to bottom, choose Single Pages Vertically 
.

RESULT
The view type in the music area is changed. In page view, only staves containing notes or items 
are shown by default. For players holding multiple empty instruments, only the top instrument is 
shown in full scores.

In galley view, all staves in the project are shown. By default, guide bar numbers are shown 
above each staff and guide instrument labels are shown above each instrument. For players 
holding multiple instruments, the player name is also shown in guide instrument labels.

NOTE

● Note spacing is unjustified in galley view and there is no automatic vertical collision 
avoidance, so notes and items might overlap. You can change the default gaps between 
staves in galley view for each layout independently.

● The view type is reset to your default setting when you switch layouts.

● You can change the default view type used for all projects in Preferences > General > View.

● You can assign a key command for Toggle View Type on the Key Commands page in 
Preferences. This command switches between galley view and page view.
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● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

AFTER COMPLETING THIS TASK
In galley view, you can use instrument filters to show only specific staves.

RELATED LINKS
Music area on page 37
View types on page 43
Switching between layouts on page 46
Status bar on page 42
Page arrangements for page view on page 44
Changing the staff spacing in galley view on page 723
Per-layout vertical spacing options on page 721
Preferences dialog on page 61
Key Commands page in the Preferences dialog on page 63
Moving the view in the music area on page 447
Hiding/Showing guide bar numbers on page 984
Renaming players on page 182
Instrument filters on page 449

Changing your preferred unit of measurement
You can change your default preferred unit of measurement to be used throughout Dorico 
Pro for options that use absolute measurements, such as the size of page margins in Layout 
Options. It does not affect options that are relative to the size of staves, such as options in 
Engraving Options or Notation Options.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the General section, select one of the following options from the Preferred unit of 
measurement menu:

● Points (pt)

● Millimeters (mm)

● Inches (in)

● Centimeters (cm)

4. Click Apply, then Close.

Color setup
Dorico Pro allows you to change the colors used in different contexts, including for project 
windows and pages in each type of layout.

RELATED LINKS
Annotations on page 687
Viewing options for notes and rests on page 1261
Hiding/Showing voice colors on page 1705
Hiding/Showing colors for notes out of range on page 1261
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Changing the window color theme
You can change the color theme used throughout Dorico Pro; for example, you might switch to 
the light theme if you prefer to read dark text on a light background. By default, Dorico Pro uses 
the dark theme, which shows light text on a dark background.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Window section, select one of the following options from the Theme menu:

● Dark

● Light

4. Click Apply, then Close.

RESULT
The color theme used in Dorico Pro is changed. This affects the current project immediately and 
all future projects you open, until you next change your setting.

EXAMPLE

Dark theme Light theme

Changing the page color
You can change the color of pages in each of the different layout types; for example, to help you 
identify whether you are in a part layout or full score layout, or to make reading the music easier 
or more comfortable.

By default, full score and custom score layouts have white pages, while part layouts have cream 
pages.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Page Colors section, change the page color for Full score layouts, Part layouts, 
and/or Custom score layouts in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.
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4. Click Apply, then Close.

RESULT
The page color in layouts of the corresponding type is changed in the current project and 
all future projects you open. This does not affect the resulting page color when exporting or 
printing layouts.

TIP

You can reset page colors back to the default factory settings by clicking Reset  for each layout 
type.

RELATED LINKS
Layouts on page 169
Printing layouts on page 671
Exporting layouts as graphics files on page 675

Changing the background color
You can change the background color of the music area. The background can be a gradient of up 
to four colors or a single block color. You can also change the background color for Write mode 
and Engrave mode independently of each other; for example, to help you identify which mode 
you are in.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Background Colors section, choose one of the following options for Use for Write 
mode and/or Engrave mode:

● Gradient

● Single Color

4. Change the background color for Write mode and/or Engrave mode in one of the following 
ways:

● If you chose Gradient and want to use a preset selection of colors, select it from the 
Preset menu.

● If you chose Gradient and want to use a custom selection of colors, either click each 
color preview and select a color in the dialog that opens, or enter color codes into the 
value fields.

● If you chose Single Color, either click the Stop 1 color preview and select a color in the 
dialog that opens, or enter a color code into the value field.

RESULT
The background color is changed in the current project and all future projects you open.

TIP

● The background color set for Write mode is also used in Setup mode.

● You can reset background colors back to the default factory settings by clicking Reset .
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Changing music area colors
You can change the colors used for various purposes in the music area, including the first eight 
voice colors on each staff and the color of selected items. For example, if you find specific color 
combinations easier to read than others.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Voice Colors section, change the color for each voice in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

4. In the Other Colors section, change the color for each item in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

5. Click Apply, then Close.

RESULT
The color of the corresponding voices and items is changed in the current project and all future 
projects you open.

TIP

You can reset colors back to the default factory settings by clicking Reset  for each voice or 
item.

RELATED LINKS
Preferences dialog on page 61
Annotations on page 687
Viewing options for notes and rests on page 1261
Hiding/Showing voice colors on page 1705
Hiding/Showing colors for notes out of range on page 1261
Selecting notes/items on page 426
Caret on page 215
MIDI recording on page 263
Playhead on page 630
Tablature on page 1580
Linked dynamics on page 1133
Linked slurs on page 1519

Inverting colors
You can invert the colors used for music and pages in Dorico Pro, which by default shows white 
music on black pages. You can then customize the inverted page color; for example, to show 
white music on a blue background.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.
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3. In the Page Colors section, activate Invert colors for music (white on black).

4. Change the inverted page color in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

5. Click Apply, then Close.

RESULT
The colors for music and pages are inverted in the current project and all future projects you 
open. Music always appears white, while pages use the inverted page color you set. This does 
not affect the resulting colors when exporting or printing layouts.

Deactivating Invert colors for music (white on black) returns music/page colors to their non-
inverted configuration.

TIP

You can reset the inverted page color back to the default factory setting by clicking Reset .

Changing the color of items
You can change the color of individual notes and items; for example, to distinguish specific items 
when creating educational worksheets. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items whose color you want to change. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Color in the Common group.

3. Click the color preview to open the Select Color (Windows)/Colors (macOS) dialog.

4. Select or create the color you want.

5. Click OK to save your changes and close the dialog.

RESULT
The color of the selected items is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

TIP

You can change the default color of many items, such as by editing the paragraph style of 
text-based notations.

RELATED LINKS
Engrave toolbox on page 514

User interface
Color setup 

58
Dorico Pro 4.3.30



Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Paragraph Styles dialog on page 848
Lyrics paragraph styles on page 1235
Staff label paragraph styles on page 1544
Custom notehead sets on page 868
Custom chord symbols on page 856
Custom lines on page 884
Custom playing techniques on page 876

Language setup
Dorico Pro allows you to change the language used in different contexts, including for the 
application itself and for instrument names in staff labels.

RELATED LINKS
Changing the language for repeat counts on page 1458
Instrument transpositions in staff labels on page 1536
Changing the keyboard language on page 67

Changing the application language
You can change the language used for the user interface in the current project and all future 
projects you open; for example, if your operating system language is different to the language 
you want to use in Dorico Pro.

NOTE

Changing the application language does not affect the language used for instrument names or 
date and time tokens.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the General section, select the language you want to use from the Language menu.

4. Click Apply, then Close.

RESULT
The language used for the user interface in the current project and all future projects is changed. 
If your keyboard language is set to Default, the keyboard language is also changed.

RELATED LINKS
Preferences dialog on page 61
Changing the keyboard language on page 67
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Changing the language for instrument names
You can change the language used for instrument names; for example, if you want to recreate a 
French score. This affects staff labels and instrument change labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Language.

3. Select the language you want to use from the Instrument names language menu.

4. Activate/Deactivate Reset instrument names.

5. Choose one of the following options for Case for note names:

● Upper case

● Lower case

6. Optional: If you selected German, choose one of the following options for Note names in 
German instrument names:

● English (B flat/B)

● German (B/H)

7. Optional: If you selected German, choose one of the following options for Accidentals in 
German instrument names:

● Use music symbol

● Use names

8. Optional: If you selected French, choose one of the following options for Note name for C 
in French:

● Do

● Ut

9. Click Apply, then Close.

RESULT
The language for all instrument names and prefixes for instrument change labels is changed 
project-wide. Future instruments you add to the project use your new language setting.

● If you activated Reset instrument names, the names of existing instruments in the project 
are reset to follow your new language setting.

● If you deactivated Reset instrument names, the names of existing instruments in the 
project are not reset and continue to use their existing language.

TIP

You can change the default language used for instrument names in all future projects on the 
General page in Preferences.

RELATED LINKS
Adding players on page 125
Adding instruments to players on page 138
Instrument changes on page 134
Staff labels on page 1531
Showing instrument/player names in staff labels on page 1536
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Instrument transpositions in staff labels on page 1536
Changing the default font family on page 853

Changing the language for date and time tokens
You can change the language used for all date and time tokens project-wide; for example, if 
you want to display the date and time using a different language convention to your operating 
system.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Language.

3. Select the language you want to use from the Date and time tokens language menu.

4. Click Apply, then Close.

RELATED LINKS
Tokens on page 576
Engraving Options dialog on page 840

Preferences dialog
The Preferences dialog allows you to change how Dorico Pro functions by default across all 
projects.

You can open Preferences in any of the following ways:

● Press Ctrl/Cmd-, .

● Choose Edit > Preferences (Windows) or Dorico > Preferences (macOS).

The Preferences dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.
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TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

NOTE

The arrangement of options on the Key Commands page is significantly different to other 
pages in the Preferences dialog. This page is described separately in further detail.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Reset to Factory

Resets all the options in the dialog back to the default factory settings.

RELATED LINKS
View types on page 43
Zoom options on page 45
Selection tools on page 43
Layout Options dialog on page 834
Key commands on page 20
Changing values in numeric value fields on page 772
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Key Commands page in the Preferences dialog
The Key Commands page in the Preferences dialog allows you to view all the functions to which 
you can assign key commands, change existing key commands, and assign new key commands 
to functions that have no key command assigned by default.

Assigning your own key commands can be helpful for items or actions that you find yourself 
performing regularly, such as setting specific rhythmic grid resolutions or exporting all layouts to 
PDF.

● You can find the Key Commands page by opening the Preferences dialog and clicking Key 
Commands in the category list.

The Key Commands page comprises the following:

1 Search field

Allows you to search for functions to view, change, or add key commands. Because there 
are multiple levels of disclosure arrows before you reach many functions, this is often the 
quickest way to find what you are looking for.

2 Functions

Displays the functions that can be assigned key commands. The list can be filtered using 
the Search field. Disclosure arrows beside options indicate that further options are available 
when the option is expanded.

Hovering over functions shows a tool tip, which is helpful for some functions with 
particularly long names.

3 Key Commands section

Displays any existing key commands set in the current keyboard language for the function 
selected in the list of assigned key commands, and allows you to assign new key commands.

● Keyboard language: Allows you to change the keyboard language used for key 
commands.

● Add Key Command: Adds the key command you pressed to the selected function.

NOTE

● You can assign multiple key commands to the same function.
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● If you enter a key command that is already assigned to another function, a warning 
is shown.

● Remove Key Command: Removes the selected key command from the selected 
function.

● Print Summary: Directs you to an offline page in a web browser that displays your key 
commands on an interactive keyboard.

● Reset Key Commands: Resets all of your key commands to their defaults.

4 MIDI Learn section

Allows you to assign MIDI controllers, notes, and combinations of notes to control functions.

● MIDI Learn : Prepares Dorico Pro to receive the MIDI input data that you want to save 
as a command.

● Add MIDI Command: Adds the MIDI controllers or notes you changed or pressed to the 
selected function.

● Remove MIDI Command: Removes the MIDI command from the selected function.

5 Jump Bar Alias section

Allows you to assign aliases that you can enter into the jump bar to perform the 
corresponding function.

● Alias field: Allows you to enter a jump bar alias for the selected function.

● Add Alias: Adds the characters you entered as the jump bar alias for the selected 
function.

● Remove Alias: Removes the existing jump bar alias from the selected function.

RELATED LINKS
Key commands in Dorico on page 29
Assigning key commands on page 66
Assigning MIDI commands on page 66
Jump bar on page 68

Interactive Dorico key commands map
The interactive Dorico Key Commands map shows a virtual computer keyboard, with keys that 
have been assigned key commands highlighted in different colors according to the modifier 
keys they contain. All key commands for the selected keyboard language layout are listed below, 
divided into global and mode-specific groups.

You can open the Dorico Key Commands map in any of the following ways:

● Choose Help > Key Commands.

● In the Preferences dialog, click Key Commands in the category list, then click Print 
Summary in the Key Commands section.
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The interactive key commands map as it appears when US English is selected

The Dorico Key Commands map opens in a web browser. It allows you to do any of the 
following:

● To see the available key commands, select a context. The context of a key command is the 
mode in which it can be used. Key commands that have a global context work in all modes.

● To highlight the keys that you can press in combination with modifier keys to form a key 
command, press one or more modifier keys on your computer keyboard, such as Shift  or 
Ctrl/Cmd - Alt/Opt , or click a modifier key on the virtual keyboard. The virtual computer 
keyboard highlights the pressed/clicked keys and displays the assigned functions on each 
key.

● To search for a specific key command, enter one or multiple words in the search field.

● To get an overview of all available key commands, browse the key commands that are listed 
below the virtual keyboard. The key commands are listed according to the context in which 
they can be used.

RELATED LINKS
Changing the keyboard language on page 67

Searching for the key commands of functions
You can search for key commands that are assigned to functions or menu items in Dorico Pro.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Enter the name of a function in the Search field.

The entries that are listed below are filtered according to the words that you enter.

4. Expand an entry and select the function for which you want to see the key command.
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For particularly long names, you can hover over them to see a tool tip.

RESULT
If the function has a key command, it is shown in the list of assigned key commands.

TIP

You can also search for functions in the interactive key commands map.

Assigning key commands
You can assign key commands to many functions; for example, for functions you use frequently 
but that do not have a key command assigned by default. You can also change existing key 
commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

For particularly long names, you can hover over them to see a tool tip.

4. Optional: If the function already has an assigned key command, click Remove Key 
Command in the Key Commands section.

If you assign a new key command without removing an existing one, you can use either key 
command.

5. Click the Press shortcut input field.

6. Press the key command that you want to assign on your computer keyboard.

7. Click Add Key Command.

8. Click Apply, then Close.

RESULT
The key command you pressed is added to the list of assigned key commands for the selected 
menu item or function. You can use it immediately.

RELATED LINKS
Resetting key commands on page 68

Assigning MIDI commands
You can assign specific keys or buttons on your MIDI keyboard to perform functions and access 
menu items. For example, if you want to navigate using MIDI keys during chord symbol input.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Select the menu item or function to which you want to assign MIDI commands.

For particularly long names, you can hover over them to see a tool tip.

4. In the MIDI Learn section, click MIDI Learn .
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5. Press the key or button on your MIDI keyboard that you want to assign to the selected 
parameter.

6. Click Add MIDI Command.

7. Click Apply, then Close.

Changing the keyboard language
You can change the keyboard language used for key commands in Dorico Pro; for example, if the 
application language is set to German, but you are using an English keyboard and want to use 
English key commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Select the keyboard language you want to use for key commands from the Keyboard 
language menu.

NOTE

Default follows the application language.

4. Click Apply, then Close.

RESULT
The keyboard language used for key commands in the current project and all future projects is 
changed.

RELATED LINKS
Changing the application language on page 59

Removing key commands
You can remove individual key commands from a function.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

4. In the Key Commands section, click Remove Key Command.

5. Click Apply, then Close.

RESULT
The key command is removed from the selected function.

RELATED LINKS
Searching for the key commands of functions on page 65
Removing jump bar aliases on page 71

User interface
Key Commands page in the Preferences dialog 

67
Dorico Pro 4.3.30



Resetting key commands
You can reset all the key commands in your project to their defaults.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. In the Key Commands section, click Reset Key Commands.

4. Click Apply, then Close.

RESULT
All custom key commands are deleted and the default key commands are reinstated.

Jump bar
The jump bar is a temporary value field that allows you to perform commands and go to 
locations in the current layout using only your computer keyboard.

● You can show the jump bar in Setup, Write, Engrave, and Play modes by pressing J .

Jump bar in Commands mode with an example entry

Commands

In Commands mode, you can use the jump bar to perform commands, such as opening the 
Layout Options dialog with the specified page already selected.

● You can switch the jump bar to Commands mode by pressing Alt-C (Windows) or 
Ctrl-1 (macOS) .

When you start entering text into the jump bar in Commands mode, a menu appears that shows 
valid commands containing the letters/words you enter.

If you show the jump bar in Commands mode after performing a command, your previous entry 
is shown with its text selected.

You can press Down Arrow  to show a list of up to five commands that you perform most 
frequently.
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NOTE

● You can only perform commands using the jump bar in the same contexts as you can 
perform the corresponding action. For example, you can only perform Setup mode-specific 
actions in Setup mode.

● You can assign jump bar aliases to specific commands; for example, so you can use shorter 
entries for your favorite commands.

● If commands have a corresponding key command or jump bar alias, they are shown in the 
menu of valid commands.

Go To

In Go To mode, you can use the jump bar to go to bars, rehearsal marks, pages, and flows.

● You can switch the jump bar to Go To mode by pressing Alt-G (Windows) or Ctrl-2 (macOS) .

Example move Jump bar entry

Go to bar number [n]; for example, bar 
number 32

b[n]; for example, b32 or b+32

Go to rehearsal mark [n]; for example, 
rehearsal mark K

r[n]; for example, rK or rk

Go to page number [n]; for example, page 6 p[n]; for example, p6 or p+6

Go to flow number [n]; for example, flow 3 f[n]; for example, f3 or f+3

Go to the next flow fn

Go to the previous flow fp

EXAMPLE
To go to bar 20 in flow 3, enter f3b20.

RELATED LINKS
Navigation on page 444
Key commands in Dorico on page 29
Key Commands page in the Preferences dialog on page 63
Properties panel on page 769
Popovers on page 25
Notations input on page 271
Layout Options dialog on page 834
Notation Options dialog on page 837
Note Input Options dialog on page 839
Engraving Options dialog on page 840
Playback Options dialog on page 842
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Going to locations with the jump bar
You can use the jump bar to go to bars, rehearsal marks, pages, and flows in Setup, Write, 
Engrave, and Play modes.

PROCEDURE

1. Press J  to show the jump bar.

2. Optional: Press Alt-G (Windows) or Ctrl-2 (macOS)  to switch to Go To mode.

3. Enter the appropriate entry for the location to which you want to go.

For example, enter f3b20 to go to bar 20 in flow 3.

4. Press Return .

Performing commands with the jump bar
You can use the jump bar to perform commands, such as opening the Layout Options dialog 
with the specified page already selected, in Setup, Write, Engrave, and Play modes.

PREREQUISITE
If you want to perform mode-specific commands, you are in the corresponding mode.

PROCEDURE

1. Press J  to show the jump bar.

2. Optional: Press Alt-C (Windows) or Ctrl-1 (macOS)  to switch to Commands mode.

3. Select the command you want to perform in any of the following ways:

● Enter relevant text into the jump bar.

When you start entering text into the jump bar in Commands mode, a menu appears 
that shows valid commands containing the letters/words you enter, which you can select 
by pressing Up Arrow / Down Arrow .

● Enter the appropriate jump bar alias into the jump bar.

● To show a list of up to five commands that you perform most frequently, press 
Down Arrow , then press Up Arrow / Down Arrow  to select a command.

4. Press Return .

Assigning jump bar aliases
You can assign jump bar aliases to specific commands; for example, so you can use shorter 
entries for your favorite commands.

PROCEDURE

1. Press J  to show the jump bar.

2. Optional: Press Alt-C (Windows) or Ctrl-1 (macOS)  to switch to Commands mode.

3. Enter the command to which you want to assign an alias into the jump bar.

TIP

To ensure the command is entered correctly, select it from the menu of valid commands by 
pressing Up Arrow / Down Arrow .
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4. Immediately after the command, enter = followed by the characters you want to use as the 
jump bar alias.

For example, to assign the jump bar alias rr to the Remove Rests command, enter Remove 
Rests=rr.

5. Do one of the following:

● To perform the command and assign the jump bar alias, press Return .

● To assign the jump bar alias only, without performing the command, press Alt/Opt-
Return .

RESULT
The characters you entered after the = are assigned as the jump bar alias for the specified 
command.

TIP

You can also assign jump bar aliases on the Key Commands page in Preferences.

RELATED LINKS
Jump bar on page 68
Key Commands page in the Preferences dialog on page 63

Removing jump bar aliases
You can remove jump bar aliases you have assigned to specific commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

4. In the Jump Bar Alias section, click Remove Alias.

5. Click Apply, then Close.

RESULT
The jump bar alias is removed from the selected function.
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Project and file handling

In addition to opening and importing/exporting projects and other file formats, project and file 
handling also includes auto-save and project backups.

RELATED LINKS
Starting new projects on page 74
Opening projects/files on page 75
File import and export on page 82
Auto-save on page 106
Project backups on page 108
Library Manager on page 831

Hub
The Hub allows you to access recent projects, start new projects, and keep up-to-date with 
learning materials including tutorials, videos, and blog updates. The Hub opens automatically 
when you start Dorico Pro.

● You can also open the Hub by choosing Window > Hub.

The Hub contains the following pages:

Open Recent
Allows you quick access to the projects that you worked on last. You can scroll through 
the list to access recent projects out of view. You can navigate through recent projects 
by pressing Up Arrow / Down Arrow .

Double-clicking a recent project, or selecting it and pressing Return , opens the 
project.

You can choose one of the following view types for recent projects:
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● Grid view 

● List view 

When recent projects are shown in the grid view, you can click the menu button  for 
each project to access the following options:

● Remove from Recent Projects: Removes the project from the Recent Projects 
page.

● Open Enclosing Folder: Opens the File Explorer/macOS Finder and shows the 
folder where the project is saved.

Create New
Allows you to start new projects from project templates or choose an empty project.

The Choose a template list on the left allows you to select a project template category, 
with available project templates in the selected category listed in the middle. The 
Empty project template creates a project with no players or flows.

You can click the menu button  for each custom project template to delete them.

On the right, the Project Options section provides the following options:

● Project title: Allows you to enter the project title.

● Composer: Allows you to enter the project composer.

● Page size: Allows you to select the page size for the full score layout.

● Page orientation: Allows you to choose whether the page orientation in the full 
score layout is Portrait  or Landscape .

● Rastral size: Allows you to select the staff size for the full score layout.

● Project will use multiple flows: When activated, flow headings are shown in 
all layouts, and flow titles are shown in running headers in score layouts. When 
deactivated, flow headings are hidden in all layouts, and the project title is shown 
in running headers in score layouts.

● Music font: Allows you to select the music font used in the project.

● Text font: Allows you to select the font family used throughout the project by 
default.

● Time signature: Allows you to specify a time signature for the project. When 
deactivated, the project starts with no time signature, which is treated as open.

● Bars: Allows you to set the number of bars you want the project to contain.

● Key signature: Allows you to specify a key signature for the project. When 
deactivated, the project starts with no key signature, which is treated as atonal.

At the bottom of the Hub, Create project creates a new project using the selected 
project template and project options. You can also double-click project templates to 
start a new project.

Learn
Provides access to learning materials. Dorico Pro displays a notification when new 
materials are available.

● Hands-on tutorials: Displays available practical tutorials that introduce you to 
common operations directly in Dorico demo projects.

● Videos: Displays recent Dorico video tutorials. Double-clicking a video tutorial, or 
selecting it and clicking Watch Now, opens it in a web browser.

You can find more tutorial videos and information about new features on the 
Dorico YouTube channel.
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● Forum: Links you to the Steinberg user forum.

● Manual: Links you to the online documentation. A PDF version is also available on 
steinberg.help.

● Dorico Blog: Displays recent entries in the Dorico blog. Clicking a blog entry opens 
it in a web browser.

At the bottom of the Hub, Open or Import File allows you to search for and open MusicXML, 
MIDI, and Dorico project files.

RELATED LINKS
Toolbar on page 33
Opening recent projects from the Hub on page 76
Project templates on page 80
Project Info dialog on page 78
Types of page templates on page 532
Editing running headers in page templates on page 1190
Staff size on page 716

Starting new projects
You can start new projects from project templates, such as for orchestra or a vocal ensemble. 
You can also start empty projects.

PROCEDURE

1. Optional: If the Hub is not open, choose Window > Hub to open the Hub.

2. In the Hub, click Create New to show the Create New page.

3. Choose a project template category.

By default, Dorico Pro provides the following project template categories:

● Band

● Chamber

● Choral

● Empty

● Jazz

● Orchestral

● Solo

4. Choose a project template.

5. In the Project Options section, add or change information and settings as required.

NOTE

The Project Options section does not affect Empty project templates.

6. Create a new project in any of the following ways:

● Click Create project.

● Double-click the project template.

RESULT
A new project is created using the selected project template.
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TIP

● You can start a new, empty project at any time by pressing Ctrl/Cmd-N  or choosing File > 
New.

● You can also start a new project from a project template by choosing File > New From 
Project Template > [Project template category] > [Project template].

AFTER COMPLETING THIS TASK
You can customize your project, such as by adding or deleting players/instruments.

RELATED LINKS
Hub on page 72
Project templates on page 80
Brackets according to ensemble type on page 1026
Adding players on page 125
Adding instruments to players on page 138
Deleting players on page 129
Deleting instruments on page 141
Library Manager on page 831

Opening projects/files
You can open Dorico projects at any time and in addition to other open projects; for example, if 
the project you want to open is not listed as a recent project in the list in the Hub. You can also 
open MusicXML and MIDI files.

PROCEDURE

1. Open the File Explorer/macOS Finder in any of the following ways:

● In the Hub, click Open or Import File.

● Choose File > Open.

● Choose File > Open Recent > [Project file name].

2. Locate and select the files you want to open.

3. Click Open.

4. Optional: If you opened a MIDI file, change the settings as required in the MIDI Import 
Options dialog that opens.

RESULT
The selected files are opened.

If you opened MusicXML or MIDI files, Dorico Pro creates new project files from the MusicXML or 
MIDI content, which you can save as default Dorico projects.

If MusicXML files include page size, margin, and staff size settings, Dorico Pro imports those 
values. If they are not included, Dorico Pro creates suitable settings according to the number of 
instruments in the file.

TIP

You can also import MusicXML and MIDI files as new flows in existing projects, rather than 
opening them as separate projects.
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RELATED LINKS
Hub on page 72
Importing MusicXML files on page 86
Importing MIDI on page 89
MIDI Import Options dialog on page 90

Opening recent projects from the Hub
You can open projects you have recently worked on from the Hub.

PROCEDURE

1. Optional: If the Hub is not open, choose Window > Hub to open the Hub.

2. In the Hub, click Open Recent to show the Open Recent page.

3. Double-click the recent project you want to open.

RESULT
The selected Dorico project is opened.

Projects from different versions of Dorico
You can open projects that were last saved in other versions of Dorico than the one you have. In 
such cases, Dorico Pro shows a warning message to make you aware of any implications.

The contents of the warning message vary according to the version of Dorico in which the project 
was last saved:

● When opening a project last saved in an older version, it shows the version number the 
project was last saved in and informs you that the project will be updated to your current 
version.

● When opening a project last saved in a newer version, it shows only that the project is from 
a newer version. It also informs you that items and notations from that version might not 
appear and will be deleted if you save the project in your current version.

In both cases, opening the project is non-destructive. This means that its contents and 
formatting are unaffected if you do not save it.

You can prevent Dorico Pro from showing you warnings about projects from different versions 
in the Files section of the General page in Preferences. In the same section, you can also tell 
Dorico Pro to prompt you to choose a new location for projects from different versions when you 
save them. This reduces the risk of you overwriting them by mistake.

RELATED LINKS
Preferences dialog on page 61

Missing Fonts dialog
The Missing Fonts dialog appears when you open a project that contains a font that you do not 
have installed on your computer. It allows you to select replacement fonts that are installed on 
your computer as substitutes.

The Missing Fonts dialog displays a table with multiple columns that identify the specific font 
families and styles that are missing for font, character, and paragraph styles and text items. 
Every place in the project where a font is missing has its own row. For example, if the bold style 
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of a font family is used in three different paragraph styles, three rows are shown in the dialog, 
one for each paragraph style.

The Missing Fonts dialog comprises the following:

1 Missing Family

Contains a list of font families included in the project but missing on your computer.

2 Missing Style

Contains a list of the specific styles within the corresponding font families that are included 
in the project but missing on your computer.

3 Used By

Contains a list of the places in the project where the corresponding font is used.

4 Replacement Family

Allows you to select replacement font families. You can select replacement font families by 
double-clicking entries, then either entering the font family you want or clicking the arrow 
and selecting a font family from the menu. Once selected, their names are displayed in the 
corresponding entry.

5 Replacement Style

Allows you to select any of the available styles within the corresponding replacement font 
families. You can select replacement font styles by double-clicking entries, then either 
entering the font style you want or clicking the arrow  and selecting a font style from 
the menu. Once selected, the styles are displayed in the corresponding entry.

6 Fonts

Contains a list of all the available fonts installed on your computer. You can access the menu 
in the Replacement Family and Replacement Style columns by double-clicking any entry.

TIP

● You can choose whether or not the Missing Fonts dialog appears when you open a project 
containing fonts not installed on your computer on the General page in Preferences.
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● You can change the width of columns in the Missing Fonts dialog. Their widths are 
remembered in future projects.

RELATED LINKS
Preferences dialog on page 61
Edit Font Styles dialog on page 846
Character Styles dialog on page 851
Paragraph Styles dialog on page 848
Text editor options in Write mode on page 389
Text editor options in Engrave mode on page 584

Project Info dialog
The Project Info dialog allows you to specify information about the whole project and each 
flow within it separately, such as the title, composer, and lyricist, as these might be different for 
different flows. You can then refer to these entries using tokens in text frames.

You can open the Project Info dialog in any mode in any of the following ways:

● Press Ctrl/Cmd-I .

● Choose File > Project Info.

The Project Info dialog comprises the following:

1 Flows list

Contains all the flows in the project, with a separate entry for the project as a whole at the 
top. You can select individual or multiple flows in the flows list.
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NOTE

The flows list uses the names of flows as shown in the Flows panel in Setup mode, which can 
be different to their entry in the Title field if you have changed their flow title.

The action bar at the bottom of the list contains the following options:

● New Flow : Creates a new flow with no information. Its default name is New Flow.

● Duplicate Flow : Creates a new flow with all the information of the selected flow. Its 
default name is Copy of [selected flow].

● Rename Flow : Opens the Rename Flow dialog, which allows you to change the name 
of the flow.

NOTE

If you have already manually changed the flow title, changing the name of the flow does 
not automatically change the flow title.

● Move Down : Moves the selected flows down the flows list, which changes their order 
in the project.

● Move Up : Moves the selected flows up the flows list, which changes their order in the 
project.

● Delete Flow : Deletes the selected flows.

2 Information fields

Allow you to enter information about the currently selected flows or the whole project in 
the corresponding field, such as Composer and Lyricist. If you have selected multiple flows 
with different entries in the same fields, such as flows with different composers, those fields 
display Mixed.

3 Generate preview thumbnails when saving

When activated, Dorico Pro generates the following preview images of the layout open in the 
music area when you save the project:

● PNG file of the first page. This is displayed on the Open Recent page in the Hub.

● PDF file of the whole layout.

When deactivated, Dorico Pro does not generate preview images. This reduces the file size 
and can make saving large projects quicker.

4 Copy info from menu

Allows you to select another flow or the whole project whose information you want to copy; 
for example, for a project containing multiple flows that all have the same composer and 
lyricist.

5 Copy

Copies all the information from the specified flow/project to the selected flows/project.

NOTE

● The information you add in Project Info only appears on pages where the corresponding 
tokens exist. For example, if you want to display a dedication above the project title, you 
must add the dedication token to the First page template.

● You cannot specify line breaks in single-line fields. However, you can enter line breaks in 
larger fields, namely Copyright and Other information, which you can then copy into 
single-line fields.
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● By default, First page templates have tokens that refer to project information. If you only 
enter information for individual flows in the Project Info dialog, that information does not 
automatically appear on pages that use the First page template. You can change the tokens 
in the default page templates to refer to specific flows if required.

RELATED LINKS
Tokens on page 576
Flows on page 166
Flow names and flow titles on page 188
Reordering flows on page 168
Starting new projects on page 74
Opening projects/files on page 75
Front matter on page 1188
Page templates on page 527
Types of page templates on page 532
Hub on page 72

Project templates
Project templates allow you to start new projects that already contain a particular set of players 
and project library settings. For example, full score layouts in orchestral project templates have 
larger page sizes than in chamber ensemble project templates.

The project library settings included in project templates include custom items, page templates, 
font and paragraph styles, and options for bracketing and bracing, large time signatures, page 
size, and playback. Project templates can also contain project information and flows.

Dorico Pro provides the following default project template categories:

Band
Ensembles containing mostly woodwind and brass instruments, such as brass band or 
pit band.

Chamber
Typically small ensembles containing only a few players, such as string quartet.

Choral
Ensembles containing voices, including popular choir arrangements, such as SATB 
unaccompanied.

Empty
An empty project template.

Jazz
Popular ensembles commonly used to perform jazz, such as big band or jazz trio.

Orchestral
Large ensembles containing most Western instruments, including strings, woodwinds, 
brass, and percussion.

Solo
Ensembles containing only a single player/instrument, such as a solo organ, guitar with 
tablature, or lead sheet.
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TIP

You can save custom project templates in any project template category, including new 
categories.

RELATED LINKS
Brackets according to ensemble type on page 1026
Starting new projects on page 74
System objects on page 1563
Page formatting on page 689
Page templates on page 527
Library on page 831
Hub on page 72

Saving custom project templates
You can save the current project as a project template from which you can start future projects. 
For example, if you regularly create projects that require the same players, page templates, and 
default settings.

PREREQUISITE
The current project contains all the players, flows, project information, and project library 
settings that you want in your custom project template.

PROCEDURE

1. Choose File > Save As Project Template to open the Save As Project Template dialog.

2. In the Category field, enter the project template category in which you want to save your 
new project template.

When you start entering a project template category, a menu appears that shows existing 
project template categories containing the letters/words you enter. You can select one of 
these or you can enter a new project template category.

3. In the Name field, enter a name for your new project template.

If you enter the same name as an existing project template, Dorico Pro shows a warning icon 
 and message.

4. Activate/Deactivate Preserve existing flows.

5. Activate/Deactivate Preserve Project Info.

RESULT
The current project is saved as a project template in the selected project template category and 
becomes available for starting new projects. If you entered the same name as an existing project 
template, the new project template replaces the existing one.

● If you activated Preserve existing flows, flows in the current project, including the music in 
them, are included in the project template.

● If you activated Preserve Project Info, all information entered in the Project Info dialog is 
included in the project template.

RELATED LINKS
Page templates on page 527
Project Info dialog on page 78
Flows on page 166
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Deleting project templates
You can delete custom project templates that you no longer need.

NOTE

You cannot delete factory default project templates.

PROCEDURE

1. Optional: If the Hub is not open, choose Window > Hub to open the Hub.

2. In the Hub, click Create New to show the Create New page.

3. Choose the project template category that contains the project template you want to delete.

4. Click the menu button  for the project template you want to delete and choose Remove 
Project Template.

5. In the dialog that opens, click OK.

RESULT
The project template is deleted. If it was the last project template in its category, the category is 
also deleted.

RELATED LINKS
Hub on page 72

File import and export
External files are files in different formats than Dorico projects, such as MIDI, MusicXML, or 
tempo tracks. It is possible in Dorico Pro both to import and export different types of files.

This can be useful if, for example, you want to share your project with others who use a different 
notation software, or to convert the notes, audio, or time signatures and tempo information in 
your project into other formats.

RELATED LINKS
Exporting lyrics on page 1227
Exporting layouts as graphics files on page 675
Exporting graphic slices on page 598
Library Manager on page 831

Importing flows
You can import individual flows into existing projects; for example, if you want to bring together 
multiple existing pieces into one project for publishing, or if you have an empty project file with 
your preferred settings saved and want to reuse those settings.

PROCEDURE

1. Choose File > Import > Flows to open the File Explorer/macOS Finder.

2. Locate and select the project files of the flows you want to import.

3. Click Open to open the Flow Import Options dialog for the first selected project.

4. In the Flow Import Options dialog, choose one of the following options for Player 
handling:
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● Create All New Players

● Merge with Existing Players Where Possible

5. In the Import flows list, activate the checkbox for each flow you want to import.

You can also click Select All or Select None at the bottom of the list.

6. Click OK to import the selected flows and close the dialog.

7. Optional: If you selected multiple projects from which to import flows, repeat steps 4 to 6 for 
each project. The Flow Import Options dialog reopens automatically for each project.

RESULT
The selected flows are imported into the project.

● If you chose Create All New Players, new players are added as required for each flow.

● If you chose Merge with Existing Players Where Possible, any players that the imported 
flows and existing project have in common are merged; for example, if you imported a flow 
containing one piano into a project containing a piano and viola, the imported flow is added 
to the existing piano player.

NOTE

● Players are not automatically added to flows that you imported into the project.

● You can also open flows directly if you want them to be separate projects, rather than new 
flows in existing projects.

RELATED LINKS
Opening projects/files on page 75
Flows on page 166
Adding flows on page 166
Duplicating flows on page 167
Reordering flows on page 168
Deleting flows on page 169
Library Manager on page 831
Importing libraries on page 833

Flow Import Options dialog
The Flow Import Options dialog allows you to determine whether players in imported flows are 
merged with existing players in the project and which flows from within other projects you want 
to import.

● You can open the Flow Import Options dialog by choosing File > Import > Flows and 
opening a Dorico project from the File Explorer/macOS Finder.

Project and file handling
File import and export 

83
Dorico Pro 4.3.30



The Flow Import Options dialog comprises the following:

1 Player handling

Allows you to determine how imported flows are assigned to players.

● Create All New Players adds separate players for each imported flow.

● Merge with Existing Players Where Possible merges players from imported flows with 
any existing compatible players in the project.

2 Import flows

Contains a list of all the flows in the selected project. Flows are included in the import when 
their checkbox is activated.

3 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to import.

Exporting flows
You can export individual flows from projects; for example, to save small excerpts of large 
projects separately.

NOTE

These steps export flows as separate Dorico projects. If you want to export flows as other file 
formats, such as MusicXML or MP3, there are different methods.

PREREQUISITE
If you want the exported flows to include all players and layouts in the project, including players 
with no music, you have deactivated Omit excluded players and layouts when exporting flows 
in Preferences > General > Files.

PROCEDURE

1. Choose File > Export > Flows to open the Export Flows dialog.

2. Activate/Deactivate Export each selected flow as a separate file.

3. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.
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4. Activate/Deactivate Export layouts as separate files.

5. Optional: If you activated Export layouts as separate files, activate the checkbox for each 
layout you want to export in the Select layouts to export list.

You can also click Select All or Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. Activate/Deactivate Create folder for exported files.

10. Click OK to export the selected flows and layouts and close the dialog.

RELATED LINKS
Flows on page 166
Exporting MusicXML files on page 88
Exporting MIDI on page 99
Exporting tempo tracks on page 102
Exporting audio on page 103

Export Flows dialog
The Export Flows dialog allows you to save individual flows and layouts as separate Dorico files.

● You can open the Export Flows dialog by choosing File > Export > Flows.

The Export Flows dialog contains the following options and lists:

1 Export each selected flow as a separate file

Allows you to export each flow as a separate file instead of all the selected flows as a single 
file.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.
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3 Export layouts as separate files

Allows you to export each layout in the project as a separate file instead of as a single file.

4 Select layouts to export

Contains a list of all the layouts in the project. Layouts are included in the export when their 
checkbox is activated. Only available if you have activated Export layouts as separate files.

5 Selection options

Allow you to select/deselect all the flows/layouts in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Create folder for exported files

Controls whether or not Dorico Pro generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name; for example, “Flows from Smyth - String Quintet”.

7 Export to field

Displays the export path where exported flows will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing MusicXML files
You can import MusicXML files into existing Dorico Pro projects as separate flows; for example, to 
continue work on a piece started in a different notation software.

PREREQUISITE
You have set your preferences for importing MusicXML files as appropriate for the file on the 
MusicXML Import page in Preferences.

PROCEDURE

1. Choose File > Import > MusicXML to open the File Explorer/macOS Finder.

2. Locate and select the MusicXML files you want to import.

3. Click Open to open the Flow Import Options dialog for the first selected MusicXML file.

4. In the Flow Import Options dialog, choose one of the following options for Player 
handling:

● Create All New Players

● Merge with Existing Players Where Possible

5. Click OK to import the selected flows and close the dialog.

6. Optional: If you selected multiple MusicXML files, repeat steps 4 and 5 for each file. The Flow 
Import Options dialog reopens automatically for each file.

RESULT
The selected MusicXML files are imported into the project as new flows.

● If MusicXML files include page size, margin, and staff size settings, Dorico Pro imports those 
values. If they are not included, Dorico Pro creates suitable settings according to the number 
of instruments in the file.

● If you chose Create All New Players, new players are added as required for each MusicXML 
file.
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● If you chose Merge with Existing Players Where Possible, any players that the imported 
MusicXML files and existing project have in common are merged; for example, if you 
imported a MusicXML file containing one piano into a project containing a piano and viola, 
the imported MusicXML file is added to the existing piano player.

TIP

You can also open MusicXML files directly if you want them to be separate projects, rather than 
new flows in existing projects.

RELATED LINKS
Flow Import Options dialog on page 83
Opening projects/files on page 75
Preferences dialog on page 61

Unpitched percussion imported from MusicXML files
Unpitched percussion music can be expressed in a number of ways in MusicXML. Scoring 
applications take different approaches to what data is exported and how it is encoded. Therefore, 
the results of importing MusicXML into Dorico Pro vary considerably.

Dorico Pro identifies each instrument in kits explicitly and then combines them dynamically onto 
five-line staves. Other scoring applications and MusicXML have a different approach to how 
unpitched percussion music is represented. For example, a drum set may be effectively notated 
as pitched notes on a five-line staff and annotated with additional information to help identify 
which instrument corresponds to each staff position.

Because of these different approaches, mapping information between the MusicXML 
representation and the Dorico Pro representation can be challenging, so Dorico Pro employs 
heuristics to improve the quality of results.

Typically, drum set instruments in MusicXML files exported from both Sibelius and Finale are 
imported quite cleanly into Dorico Pro.

Results are particularly good, and more likely to be imported correctly, if the voicing of the drum 
set is consistent, such as consistently notating the snare drum in a down-stem voice. If the 
voicing changes from bar to bar, it is possible that some notes are either identified incorrectly or 
not imported at all.

Other kinds of percussion that are notated on five-line staves produce more variable results. 
In most cases, Finale includes information about which percussion instrument maps onto each 
staff position, but Sibelius does not. As a result, you might find that Dorico Pro chooses different 
instruments than you expected, but you can change instruments using the Edit Percussion Kit 
dialog.

RELATED LINKS
Edit Percussion Kit dialog on page 155
Changing instruments in percussion kits on page 157
Adding instruments to percussion kits on page 157
Percussion editor on page 785
Importing MIDI on page 89
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Exporting MusicXML files
You can export flows and layouts as separate MusicXML files; for example, if you want to export 
just the soloist’s layout containing the first flow.

PROCEDURE

1. Choose File > Export > MusicXML to open the Export MusicXML dialog.

2. Choose one of the following file format options:

● Export compressed XML (.mxl)

● Export uncompressed XML (.xml)

3. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export layouts as separate files.

5. Optional: If you activated Export layouts as separate files, activate the checkbox for each 
layout you want to export in the Select layouts to export list.

You can also click Select All or Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. Activate/Deactivate Create folder for exported files.

10. Click OK to export the selected flows/layouts as MusicXML files and close the dialog.

Export MusicXML dialog
The Export MusicXML dialog allows you to save individual flows and layouts as separate 
MusicXML files.

● You can open the Export MusicXML dialog by choosing File > Export > MusicXML.
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The Export MusicXML dialog contains the following options and lists:

1 File format options

Allows you to choose the MusicXML file format you want to export. Compressed MusicXML 
files contain the same information as uncompressed MusicXML files but have a smaller file 
size.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export layouts as separate files

Allows you to export each layout in the project as a separate file instead of as a single file.

4 Select layouts to export

Contains a list of all the layouts in the project. Layouts are included in the export when their 
checkbox is activated. Only available if you have activated Export layouts as separate files.

5 Selection options

Allow you to select/deselect all the flows/layouts in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Create folder for exported files

Controls whether or not Dorico Pro generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name; for example, “Flows from Smyth - String Quintet”.

7 Export to field

Displays the export path where exported files will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing MIDI
You can import MIDI files into existing Dorico Pro projects, as either separate flows or into 
existing flows; for example, to work on a different version of a section of a piece.

PROCEDURE

1. Choose File > Import > MIDI to open the File Explorer/macOS Finder.

2. Locate and select the MIDI files you want to import.

3. Click Open to open the MIDI Import Options dialog for the first selected MIDI file.

4. Change the settings as required.

For example, you can change the playing techniques of tracks, assign tracks to specific 
players, and customize quantization options.

5. Click OK to close the MIDI Import Options dialog and import the first selected MIDI file.

6. Optional: If you selected multiple MIDI files, repeat steps 4 to 5 for each file. The MIDI 
Import Options dialog reopens automatically for each file.

RESULT
The selected MIDI files are imported into the project according to your settings. Dorico Pro uses 
an algorithm on imported MIDI notes to produce the correct enharmonic spelling.

If the MIDI files contained markers, they are also imported. If they have SMPTE offset values 
defined, Dorico Pro uses them to set the timecode position for the start of the flow.
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TIP

You can also open MIDI files directly if you want them to be separate projects, rather than new 
flows in existing projects.

RELATED LINKS
Opening projects/files on page 75
Requantizing notes on page 266
Changing the sustain pedal controller settings for MIDI recording/import on page 270
Importing tempo tracks on page 100
Exporting tempo tracks on page 102

MIDI Import Options dialog
The MIDI Import Options dialog allows you to customize the settings Dorico Pro uses to 
translate MIDI data into a Dorico project when importing and opening MIDI files.

Your MIDI import settings are stored to the track memory, allowing you to reuse settings 
automatically the next time you open or import MIDI files with similar tracks.

You can open the MIDI Import Options dialog in any of the following ways:

● Choose File > Import > MIDI and import a MIDI file from the File Explorer/macOS Finder.

● Choose File > Open and open a MIDI file from the File Explorer/macOS Finder.
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At the top of the MIDI Import Options dialog, there are the following options:

Importing MIDI File
Displays the file name of the MIDI file you are importing or opening.

Use track memory
Allows you both to apply settings from the track memory to the current MIDI file, and 
to save the settings for the current MIDI file to the track memory for reuse in future 
when importing or opening MIDI files with identical track names.

Interpret as General MIDI
Allows Dorico Pro to use MIDI program changes at the start of tracks to determine 
instrument types, including identifying tracks using channel 10 as containing 
unpitched percussion using the General MIDI drum set.

We recommend deactivating this option for MIDI files that do not conform to General 
MIDI conventions.

Destination
Allows you to select the flow into which you want to import the MIDI file. You can 
import MIDI as a new flow or into an existing flow in the project; for example, if you 
want to overwrite specific tracks in an existing flow. Only available when importing 
MIDI files.
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Re-use existing players
Allows you to determine the players to which tracks in the MIDI file are assigned. Only 
available when importing MIDI files.

● When activated, tracks from the imported MIDI file are either merged with existing 
players in the project or overwrite them, depending on your setting for Overwrite 
all track contents when importing into existing flow/player in the Import 
Options section.

● When deactivated, tracks are imported as new players.

Tracks from the MIDI file

Displays all the tracks from the imported or opened MIDI file in a table. Allows you to enable/
disable tracks for import and change their player type, instrument, and playing techniques.

At the top of the table, there are the following filter controls:

● Filter field: Allows you to filter tracks by name, instrument, or family.

● Track visibility: Allows you to show either all tracks or only tracks enabled for import.

The table contains the following columns:

● #: Displays the number of the track.

● Enable: Allows you to enable/disable the track for import.

● MIDI track name: Displays the name of the track in the MIDI file.

● Player type: Displays the player type for the track. You can change the player type by 
double-clicking the icon. Icons show the current player type from the following options:

● Single player 

● Section player 

● Instrument(s) in track: Displays the instruments identified for the track. You can change 
the instrument by double-clicking the field and selecting an instrument in the instrument 
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picker that opens. If a single track requires multiple instruments, you must use the advanced 
editor options.

● Technique(s): Displays the playing techniques identified for the track. You can change the 
playing technique by double-clicking the field and selecting a playing technique from the 
menu. If a single track requires multiple playing techniques, you must use the advanced 
editor options.

TIP

● It is not necessary to specify natural or legato playing techniques, as Dorico Pro 
automatically creates slurs if Detect slurs is activated in the Import Options section.

● Dorico Pro inputs the corresponding playing techniques at the required positions in the 
music if Create playing techniques is activated in the Import Options section.

● Family: Displays the instrument family of the track. For tracks with multiple instruments, the 
family of the first instrument is displayed.

● Destination Instrument: Displays the instrument in the project to which the track will 
be assigned. You can change the destination instrument by double-clicking the field and 
selecting an instrument from the menu. For example, if you want to assign multiple tracks to 
the same destination instrument.

● Max. sim. notes: Displays the number of notes played simultaneously in the track. This can 
help you identify whether tracks represent single, multiple, or grand staff instruments.

● Total no. of notes: Displays the total number of notes in the track. Tracks containing no 
notes might be unnecessary to import.

TIP

You can click each column’s header to change its sort order.

The action bar at the bottom of the table contains the following options:

● Enable Selected: Enables the selected tracks for import.

● Disable Selected: Disables the selected tracks for import.

● Invert Selection: Switches your selection to include all tracks not previously selected.

● Select All: Selects all tracks.

Advanced editor options

Contains advanced options that allow you to control how the selected track is mapped to players 
in the project.
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The Advanced editor options are divided into the following sections:

Track settings
Contains a list of instruments in the track selected in the Tracks from the MIDI file 
table and allows you to view and change details of how Dorico Pro will interpret the 
track.

● Instruments in track list: Contains all the instruments in the selected track and 
allows you to change them. For example, you might add enough horn instruments 
to match the Max. sim. notes in a horn ensemble track, and therefore ensure each 
instrument only plays a single note at a time.

Chords are split between instruments in tracks in pitch order; for example, piccolos 
receive higher notes than flutes.

The action bar at the bottom of the list contains the following options:

● Add Instrument : Opens the instrument picker and allows you to add a new 
instrument to the track.

● Duplicate Instrument : Duplicates the selected instrument.

● Change Instrument : Opens the instrument picker and allows you to 
change the selected instrument.

● Delete Instrument : Deletes the selected instrument.

● Player type: Allows you to choose the player type for the track.

● Transpose: Allows you to transpose the track by the specified number of half-steps 
(semitones).

● Playing tech.: Allows you to select the playing techniques for the track; 
for example, when assigning multiple tracks that represent different playing 
techniques to the same player.
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● Start: The playing technique used at the start of the track.

● End: The playing technique used at the end of the track.

For example, for a violin part that switches between pizzicato and arco, using two 
tracks in the MIDI file, selecting Pizzicato/Arco instructs Dorico Pro to input pizz. 
and arco playing techniques at the appropriate positions.

● Percussion map: Allows you to select a percussion map for the track. Only 
available for percussion kits.

● Articulations: Allows you to select articulations you want to input on all notes in 
the track.

● Voice separation mode: Allows you to select a voice approach for chords. Only 
available when mapping a track to a single instrument. When mapping one track 
to multiple instruments or multiple tracks to one player, Dorico Pro automatically 
distributes notes to voices.

● 1 voice: All music in the track is assigned to the same voice.

● 2 voice (auto): Music in the track is assigned to two voices on the same staff.

● 2 voice (fixed split point): Music in the track is assigned to two voices, each 
on its own staff, using the split point set in the Import Options section.

● 2 voice (explode): Music in the track is assigned to two voices, each on its own 
staff. This option can be useful for fretted instruments.

● 4 voice keyboard (auto): Music in the track is assigned to four voices, 
spread across two staves. We recommend using this option for grand staff 
instruments, as it can automatically detect common keyboard textures, such 
as bass and melody with inner chords.

Players in Dorico project
Contains a list of the players in the project to which tracks will be assigned, including 
existing players in the project and any new players required by the imported MIDI file. 
Icons for each player indicate if it is new and its type from the following options:

● Single player 

● Section player 

When you select an instrument in the Instruments in track list in the Track settings 
section, its current assigned player appears highlighted in the Players in Dorico 
project list.

You can assign instruments to other players by clicking an available player in the 
list. Only players of the same type and with the same instrument are available. 
For example, if multiple tracks represent different techniques played by the same 
instrument, you can assign them all to the same player.

If no instruments are assigned to a new player, it is automatically deleted.

● Use MIDI track names allows you to use MIDI track names for player names.

● Add new player for track  allows you to assign the selected instrument to a new 
player. Only available when you have assigned more than one instrument to the 
same player.
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Import Options

The Import Options section contains the following subsections:

Instruments
Contains options that determine how Dorico Pro identifies and handles instruments 
from the imported MIDI file.

● Use GM program changes to identify instruments: Allows you to set whether 
Dorico Pro uses MIDI program changes or track names to identify instruments.

● Interpret channel 10 as General MIDI percussion: Allows you to set whether 
Dorico Pro interprets tracks using channel 10 as conforming to the General MIDI 
drum set standard.

● Overwrite all track contents when importing into existing flow/player: When 
activated, imported tracks overwrite all existing music belonging to destination 
players. When deactivated, imported tracks merge with existing music belonging 
to destination players. Only applies when importing MIDI into an existing flow.

Interpretation
Contains options that determine how Dorico Pro interprets key switches and keyboard 
music from the imported MIDI file.

● Split point for grand staff instruments: Allows you to change how notes are 
assigned to each staff for grand staff instruments.

● Auto: Dorico Pro automatically determines split points according to the 
musical context.

● Fixed: Dorico Pro uses the set split point.

● Split at MIDI note number: Allows you set a MIDI note number at which notes are 
split between staves. Only available when Fixed is chosen for Split point for grand 
staff instruments.

● Filter out key switches outside range: Allows you to set the range of pitches 
used for notes in the MIDI file. Notes higher/lower than the set range are omitted.

● Quantize Options: Opens the MIDI Quantize Options dialog, which allows you to 
customize the quantization options.
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NOTE

Quantization options are linked between Preferences > Play > Quantization and the 
MIDI Import Options dialog.

Notations
Contains options that determine the handling and detection of notations from the 
imported MIDI file, such as pedal lines and slurs.

NOTE

● Notation settings are linked between Preferences > Play > Recording and the 
MIDI Import Options dialog.

● When Detect key signature if missing is activated, Dorico Pro creates a single key 
signature at the start of the flow. This option works best for music with a strong 
tonal center that does not modulate.

Performance
Contains options that determine how much of the original performance in the MIDI file 
is preserved for playback purposes. They do not affect how the imported MIDI notes 
are notated, as this is controlled by quantization options.

NOTE

Performance settings are linked between Preferences > Play > Recording and the 
MIDI Import Options dialog.

Players
Contains options that determine the handling of players and layouts.

For example, if you are importing a MIDI file into an existing project in order to 
orchestrate, you might want to import players into their own player group without 
creating any extra part layouts for them.

RELATED LINKS
Opening projects/files on page 75
Changing the sustain pedal controller settings for MIDI recording/import on page 270
Unpitched percussion imported from MusicXML files on page 87
Types of actions on page 925
Preferences dialog on page 61
Player groups on page 162
Players on page 124
Instruments on page 131
Layouts on page 169
Instrument picker on page 113
Playing techniques on page 1387
Pedal lines on page 1367
Key signatures on page 1210
Slurs on page 1502
Tremolos on page 1659
Trills on page 1295
Tuplets on page 1669
Grace notes on page 1193
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Quantization options
Quantization options allow you to customize the quantization you want to apply to notes when 
importing MIDI files, inputting notes using MIDI recording, or requantizing notes.

You can access the available quantization options in any of the following ways:

● In Preferences > Play > Quantization.

● In the MIDI Import Options dialog, click Quantize Options in the Import Options section.

● When at least one note is selected in the music area, choose Edit > Requantize.

NOTE

Quantization options are linked between Preferences > Play > Quantization and the MIDI 
Import Options dialog.

The following quantization options are available:

Quantization unit
Allows you to set the smallest beat unit to which you want notes to be quantized. For 
example, if the smallest intentional note duration in your imported file is an eighth 
note, set Quantization unit to eighth notes.

Detect tuplets
Allows you to control whether off-beat notes can be considered tuplets. If you know 
there are no intentional tuplets in your imported MIDI file, deactivating Detect tuplets 
ensures no notes are imported as tuplets.

Quantization unit for tuplets
Allows you to set the smallest beat unit to which you want tuplet notes to be quantized. 
For example, if the smallest intentional tuplet note duration in your imported file is a 
quarter note, set Quantization unit for tuplets to quarter notes.

Fill gaps
Allows you to determine whether Dorico Pro fills in gaps between short notes. If you 
are importing already precisely quantized music, we recommend that you deactivate 
Fill gaps to ensure that note and rest durations are notated exactly as quantized.
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Detect grace notes
Allows you to determine whether Dorico Pro interprets grace notes. When deactivated, 
Dorico Pro turns grace notes into normal notes.

RELATED LINKS
MIDI recording on page 263
Requantizing notes on page 266
Tuplets on page 1669
Grace notes on page 1193

Exporting MIDI
You can export flows as separate MIDI files; for example, if you want to edit the audio in further 
detail in a DAW. MIDI files exported from Dorico Pro contain any markers in the project by 
default.

PREREQUISITE
You have opened a layout in the music area that contains the players whose MIDI you want to 
export.

PROCEDURE

1. Choose File > Export > MIDI to open the Export MIDI dialog.

2. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.

3. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

4. Locate and select the destination folder you want.

5. Click Choose to insert the new path in the Export to field.

6. Activate/Deactivate Create folder for exported files.

7. Click OK to export the selected flows as MIDI files and close the dialog.

RESULT
The selected flows are exported as MIDI files. They contain the MIDI of all the players assigned to 
the layout open in the music area.

RELATED LINKS
Switching between layouts on page 46
Opening new tabs on page 48
Assigning players to layouts on page 171
Importing tempo tracks on page 100
Exporting tempo tracks on page 102

Export MIDI dialog
The Export MIDI dialog allows you to save individual flows as separate MIDI files.

● You can open the Export MIDI dialog by choosing File > Export > MIDI.
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The Export MIDI dialog comprises the following:

1 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

2 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to export.

3 Create folder for exported files

Controls whether or not Dorico Pro generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name; for example, “Flows from Smyth - String Quintet”.

4 Export to field

Displays the export path where exported files will be saved.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing tempo tracks
You can import tempo tracks into individual flows and new flows in existing projects; for 
example, if you are writing music for a film and changes to the footage require tempo and 
time signature changes. This does not overwrite the notes and notations in the flow.

PROCEDURE

1. Choose File > Import > Tempo Track to open the File Explorer/macOS Finder.

2. Locate and select the MIDI file whose tempo track you want to import.

3. Click Open to open the Import Tempo Track dialog.

4. In the Import into flow list, select the flow into which you want to import the tempo track.

5. In the Import and replace section, activate the checkbox for each tempo track aspect you 
want to include.

6. Optional: If you activated the checkbox for Markers as, choose one of the following options:
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● Markers

● System-attached Text

7. Optional: If you chose System Text for Markers as, activate/deactivate Show border 
around system-attached text markers.

8. Click OK to import the tempo track and close the dialog.

RESULT
The tempo track is imported into the selected flow. If you selected New Flow in the Import into 
flow list, a new flow is added to the project. All selected aspects are applied to the existing music 
or the new flow, and notes and tempo marks are adjusted as required.

RELATED LINKS
Flows on page 166
Exporting tempo tracks on page 102
Importing MIDI on page 89
Exporting MIDI on page 99

Import Tempo Track dialog
The Import Tempo Track dialog allows you to import tempo tracks to individual flows within 
projects and to control which aspects of the tempo track you want to apply to the flow.

● You can open the Import Tempo Track dialog by choosing File > Import > Tempo Track 
and opening a MIDI file from the File Explorer/macOS Finder.

The Import Tempo Track dialog comprises the following:

1 Import into flow

Contains a list of all the flows in the project. The currently selected flow is highlighted.

NOTE

You can only import tempo tracks into a single flow at a time.

2 Import and replace

Allows you to control which tempo track aspects you want to include in your import and 
apply to the selected flow.
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● Timecode display offset sets the initial timecode position at the start of the flow.

● Tempo changes replaces all immediate and gradual tempo changes in the flow with the 
tempo changes from the MIDI file.

● Time signatures replaces all time signatures in the flow with time signatures from the 
MIDI file.

● Markers as adds any markers from the MIDI file to the flow as either Markers or 
System-attached Text.

Importing markers as Markers replaces any existing markers in the flow with markers 
from the MIDI file, while importing markers as System-attached Text does not replace 
any existing markers or system-attached text items.

● Show border around system-attached text markers adds borders to markers 
imported as system-attached text items when activated. Only available if you have 
chosen System-attached Text for Markers as.

Exporting tempo tracks
You can export flows as separate tempo tracks; for example, if you want to apply the tempo 
marks and time signatures of one flow to a different flow, which can be in the same project.

PROCEDURE

1. Choose File > Export > Tempo Track to open the Export Tempo Track dialog.

2. Activate the checkbox for each flow you want to export as a tempo track.

You can also click Select All or Select None at the bottom of the list.

3. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

4. Locate and select the destination folder you want.

5. Click Choose to insert the new path in the Export to field.

6. Activate/Deactivate Create folder for exported files.

7. Click OK to export the selected flows as tempo tracks and close the dialog.

RELATED LINKS
Importing tempo tracks on page 100
Importing MIDI on page 89
Exporting MIDI on page 99

Export Tempo Track dialog
The Export Tempo Track dialog allows you to save individual flows as separate tempo tracks in 
the format of MIDI files.

● You can open the Export Tempo Track dialog by choosing File > Export > Tempo Track.
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The Export Tempo Track dialog comprises the following:

1 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

2 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to export.

3 Create folder for exported files

Controls whether or not Dorico Pro generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name; for example, “Flows from Smyth - String Quintet”.

4 Export to field

Displays the export path where exported files will be saved.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Exporting audio
You can export projects as audio files in MP3, FLAC, or WAV formats, including exporting flows 
and players as separate files. For example, if you want to share an audio mock-up of only the 
soloist’s part in the second flow.

PREREQUISITE
You have opened a layout in the music area that contains the players whose audio you want to 
export.

PROCEDURE

1. Choose File > Export > Audio to open the Export Audio dialog.

2. Activate/Deactivate Export each selected flow as a separate file.

3. In the Select flows to export list, activate the checkbox for each flow you want to export as 
audio.
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You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export players as separate files.

5. Optional: If you activated Export players as separate files, activate the checkbox for each 
player you want to export in the Select players to export list.

You can also click Select All or Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. In the Audio Export Options section, choose one of the following audio file formats:

● MP3 (.mp3)

● FLAC (.flac)

● WAV (.wav)

10. Optional: If you chose FLAC (.flac) or WAV (.wav), choose one of the following bit depths:

● 16-bit

● 24-bit

● 32-bit (WAV files only)

11. Optional: If you chose WAV (.wav), activate/deactivate Broadcast WAVE.

12. Change the reverb tail duration by changing the value in the Reverb tail (s) value field.

13. Click OK to export the selected flows/players with the set audio export options and close the 
dialog.

RELATED LINKS
Reordering layouts on page 175
Layouts panel (Setup mode) on page 118
Assigning players to layouts on page 171

Export Audio dialog
The Export Audio dialog allows you to export projects as audio files in MP3, FLAC, or WAV 
formats, including exporting flows and players as separate files.

● You can open the Export Audio dialog by choosing File > Export > Audio.
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The Export Audio dialog contains the following options and lists:

1 Export each selected flow as a separate file

Allows you to export each flow in the project as a separate audio file instead of as a single 
audio file.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export players as separate files

Allows you to export each player in the project as a separate audio file instead of all players 
in a single audio file.

4 Select players to export

Contains a list of all the players in the project. Players are included in the export when their 
checkbox is activated. Only available if you have activated Export players as separate files.

5 Selection options

Allow you to select/deselect all the flows/players in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Export to field

Displays the export path where exported audio files will be saved.

7 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

8 Audio Export Options
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Contains the following options that allow you to control the audio file format and export:

● File format: Allows you to export audio as an MP3 (.mp3), FLAC (.flac) or WAV (.wav) 
file.

● Bit depth: Allows you to export FLAC files as 16-bit or 24-bit, and WAV files as 16-bit, 
24-bit, or 32-bit.

● Broadcast WAVE: Allows you to export audio in Broadcast WAVE format, which includes 
start timecodes and markers.

● Reverb tail (s): Allows you to change the duration of time added to the end of the 
exported audio to accommodate reverb effects.

Auto-save
The auto-save function stores a version of the currently active project at regular intervals, 
including new projects you have not explicitly saved yet. This reduces the chances of losing 
significant amounts of work if you accidentally close a project without saving or in the unlikely 
event that Dorico Pro or your computer crashes.

Dorico Pro saves auto-saved projects in an AutoSave folder inside the application data folder for 
your user account. You cannot change this location.

NOTE

● Dorico Pro might become less responsive briefly in order to perform auto-saves, particularly 
for larger projects.

● Dorico Pro does not generate preview images when auto-saving.

Auto-save with multiple projects open

Only the currently activated project is auto-saved at each auto-save interval if you have multiple 
projects open. This is because only a single project at a time can be activated for playback. If 
you are switching between multiple projects frequently, we recommend that you set a smaller 
auto-save interval.

Removal of auto-save files

All files in the AutoSave folder are automatically deleted when you close their corresponding 
projects and also when you quit Dorico Pro. You can find deleted auto-saved projects in the bin 
on your computer. Dorico Pro automatically adds “[AutoSave]” to the end of auto-saved project 
file names so you can identify them.

IMPORTANT

When Dorico Pro deletes files from the AutoSave folder, this includes any files in the folder, not 
just auto-saved Dorico projects. Therefore, it is important that you do not manually save anything 
in the AutoSave folder.

TIP

If you want to access earlier versions of projects, you can use project backups.

RELATED LINKS
Project backups on page 108
Toolbar on page 33
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Recover Auto-saved Projects dialog
The Recover Auto-saved Projects dialog allows you to recover individual auto-saved projects; 
for example, if you accidentally closed a project without saving, or if Dorico Pro or your computer 
crashed.

The Recover Auto-saved Projects dialog contains the following:

Auto-saved projects list
Contains all the auto-saved projects that are available for recovery. Displays the file 
name of each project and the date and time of the auto-save.

You can activate the checkbox for each project you want to recover.

Discard All
Deletes all auto-saved projects in the list and moves them to the bin on your computer.

Recover Selected Projects
Recovers the selected auto-saved projects and opens them in separate project 
windows.

RELATED LINKS
Changing the auto-save frequency on page 108

Recovering auto-saved projects
If Dorico Pro crashes, you can recover the most recent auto-saved version of each project that 
was open.

PROCEDURE

1. Reopen Dorico Pro.

2. In the Recover Auto-saved Projects dialog that opens after the Dorico Pro splash screen, 
activate the checkbox for each auto-saved project you want to recover.

NOTE

Any auto-saved projects you do not recover are permanently deleted once you close the 
dialog.

3. Click Recover Selected Projects to recover the selected auto-saved projects and close the 
dialog.

RESULT
The selected auto-saved projects are recovered and opened in separate project windows.
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AFTER COMPLETING THIS TASK
You can save auto-saved projects permanently in any folder location and with new file names if 
required.

Changing the auto-save frequency
You can change how frequently Dorico Pro auto-saves projects. By default, the auto-save interval 
is five minutes for the currently active project.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, change the value for Auto-save every [n] minutes.

4. Click Apply, then Close.

Disabling auto-save
You can disable auto-save completely; for example, if it is significantly affecting the performance 
of a large project.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, deactivate Auto-save every [n] minutes.

4. Click Apply, then Close.

Project backups
Dorico Pro stores backup versions of your projects each time you save them explicitly. By default, 
the previous five saves are stored as backups.

Their default location is in a folder named after the corresponding project file name in 
the Backup Projects folder in the Dorico Projects folder, whose default location is in the 
Documents folder for your user account.

You can find deleted project backups in the bin on your computer.

Changing the number of backups per project
You can change the number of backups that Dorico Pro stores for each project; for example, if 
you want to store a greater range of changes.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, change the value for Number of backups per project.

4. Click Apply, then Close.
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Changing the backup location
You can change the folder that Dorico Pro uses to store project backups. By default, Dorico Pro 
uses the Backup Projects folder inside your Dorico Projects folder, whose default location is in 
the Documents folder for your user account.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, click Choose beside the Project backup folder field to open the File 
Explorer/macOS Finder.

4. Locate and select the folder where you want to save project backups.

5. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Project backup 
folder field.

6. Click Apply, then Close.

RESULT
The default folder for project backups is changed. If the folder specified does not exist, Dorico 
Pro creates it.
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Setup mode

Setup mode allows you to set up the fundamental elements of the project: instruments and the 
players that hold them, flows, layouts, and videos. You can also determine how they interact with 
each other; for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and layouts, but 
you cannot select or interact with anything in the music area in Setup mode.

Project window in Setup mode
The project window in Setup mode contains panels with all the tools and functions that allow you 
to add players and instruments as well as to create layouts and flows for your project.

You can switch to Setup mode in any of the following ways:

● Press Ctrl/Cmd-1 .

● In the toolbar, click Setup.

● Choose Window > Setup.

The following panels are available in Setup mode:

1 Players

Lists the players, instruments, and groups in your project. By default, players are assigned to 
all flows, all full score layouts, and their own part layout.

2 Layouts

Lists the layouts in your project. A single full score layout and a part layout for each player 
are created automatically, but you can create and delete layouts as required. By default, 
layouts contain all flows and full score layouts contain all players.

3 Flows

110
Dorico Pro 4.3.30



Shows the flows in your project, ordered left to right. By default, flows contain all players and 
are assigned to all layouts.

The three panels work together to allow you to control how and where the players, layouts, and 
flows in your project are used. When you select an item in one of the panels, that panel and the 
selected item are highlighted in a different color and checkboxes appear in cards in the other 
panels. You can activate/deactivate these checkboxes independently to change how material is 
distributed across players, layouts, and flows.

RELATED LINKS
Players, layouts, and flows on page 122
Project window on page 32
Layouts panel (Setup mode) on page 118
Flows panel on page 121
Starting new projects on page 74

Players panel
The Players panel contains all the players and groups in the project, shown in a list. It is located 
on the left of the window in Setup mode.

You can hide/show the Players panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.
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The order in which players are listed in the Players panel sets the default player order used in all 
layouts. You can also set a custom player order in each layout independently.

In the Players panel, each player is shown as a card that contains the instruments held by that 
player. Each player card shows the following:

1 Disclosure arrow

Expands/Collapses the player card.

2 Player type

Shows the type of player from the following options:

● Single player 

● Section player 

3 Player name

Shows the name of the player. By default, player names contain the names of all instruments 
held by the player. You can also rename players manually.

4 Add instruments icon

Opens the instrument picker from which you can select an instrument for the player.

5 Instrument labels

Each instrument assigned to a player has its own instrument label. The instrument menu 
in each instrument label opens a menu with further options that allow you to, for example, 
change the instrument names or move the instrument to another player.

Instrument labels appear blue. Kit instrument labels appear green.

The action bar at the bottom of the panel contains the following options:

Add Single Player

Adds a single player to your project. Dorico Pro also automatically adds a part layout 
for the player in the Layouts panel.

Add Section Player

Adds a section player to your project. Dorico Pro also automatically adds a part layout 
for the player in the Layouts panel.

Add Ensemble

Adds multiple players to your project. Dorico Pro also automatically adds part layouts 
for each player in the Layouts panel.
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Add Group

Adds a player group to your project. If no players were selected, an empty player group 
is added. If existing players were selected, they are grouped together.

Sort Players

Sorts all players in the Players panel according to the current player sorting setting.

You can click and hold or right-click Sort Players to change the setting to one of the 
following options:

● None: New players are added at the bottom of the players list, regardless of their 
instrument.

● Orchestral: New players are sorted according to the accepted orchestral order 
convention. For example, woodwinds positioned above brass and strings.

● Band: New players are sorted according to the accepted wind/concert band 
convention. For example, strings positioned between brass and percussion.

Player Settings

Allows you to access settings and controls for the selected player; for example, to 
rename them or show chord symbols above their staves.

You can also access player settings by right-clicking players.

Delete Player

Deletes selected players or groups from the project. When you delete a player, a 
warning message appears that allows you to delete only the player but leave their part 
layouts in the project, delete both the player and their part layouts, or cancel.

RELATED LINKS
Players on page 124
Ensembles on page 129
Layouts panel (Setup mode) on page 118
Layout Options dialog on page 834
Changing the default player order on page 127
Setting custom player orders on page 127
Renaming players on page 182
Player groups on page 162

Instrument picker
The instrument picker allows you to find and add instruments to your project. It contains 
multiple versions of some instruments that have specific formatting and tuning requirements, 
such as French Horn, which has a version whose part layouts are always in treble clef.

The instrument picker uses the application language.

You can open the instrument picker in Setup mode in any of the following ways:

● Add a new player.

● In the Players panel, click Add Instrument to Player  in player cards.
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● In the Players panel, select a player and press Shift-I .

● In the Players panel, select a player, then click Player Settings  in the action bar and 
choose Add Instrument to Player. You can also right-click players and choose this option 
from the context menu.

The instrument picker contains the following sections and options:

1 Search field

Allows you to enter the instrument you are searching for directly. You can enter only part of 
the instrument name, such as cello for Violoncello.

2 Instrument family column

Contains instrument families to help you focus your search.

3 Instrument column

Contains the instruments available in the selected instrument family.

4 Instrument type column

Contains options for multiple possible transpositions, tunings, key signature options, or 
different behavior in part layouts for the selected instrument. This column is not populated 
for instruments that do not have further options.

5 Create Empty Kit

Adds an empty percussion kit to the player.

6 Import Kit

Imports an existing percussion kit previously exported as a library file.

7 Add

Adds the selected instrument to the project.

In addition to entering the instrument you want directly into the Search field, you can click 
options in the instrument picker to select them, and you can also select other items in the same 
column by pressing Up Arrow / Down Arrow .
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You can cycle forwards through the instrument picker by pressing Tab , which navigates in the 
following order: Search field, Instrument, Instrument type, Instrument family. You can also 
cycle backwards by pressing Shift-Tab , which navigates in the opposite direction.

An enclosure line shows which instrument family or instrument is selected when using the 
keyboard to navigate.

RELATED LINKS
Players on page 124
Instruments on page 131
Transposing instruments on page 137
Fretted instrument tuning on page 142
Capos on page 146
Adding players on page 125
Adding instruments to players on page 138
Changing instruments on page 140
Adding ensembles on page 130
Adding empty percussion kits to players on page 139
Importing percussion kits on page 1691
Changing the application language on page 59

Ensemble picker
The ensemble picker allows you to find and add ensembles containing multiple players to your 
project. You can select existing ensembles and build new ones.

The ensemble picker uses the application language.

You can open the ensemble picker in Setup mode in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In empty projects, click Add Ensemble  in the project start area.

The ensemble picker contains Build and Choose tabs. You can switch between them using the 
options in the top left of the ensemble picker.
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Build tab

The Build tab contains the following:

1 Search field

Allows you to specify the instruments you want to include in the ensemble in the following 
ways:

● Enter the name of an existing ensemble, such as String Section.

● Enter the names or abbreviations of instruments, with each name/abbreviation 
separated by a comma. You can prefix instruments with a number followed by a space. 
For example, enter 2 vln, 3 cl,bsn,tuba,marim to build an ensemble containing two 
violins, three clarinets, a bassoon, a tuba, and a marimba.

● Enter the corresponding orchestral shorthand, with or without separators. For example, 
enter 2picc.2.2.2 / 4.3.3.1 to add two flutes, one piccolo, two oboes, two clarinets, and 
two bassoons followed by four horns, three trumpets, three trombones, and one tuba.

To specify only brass instruments, prefix orchestral shorthand entries with br, such as 
br4331.

NOTE

You can only use single digit numbers for each instrument type.

2 Player list

Contains the instruments currently in the ensemble based on your entries in the Search 
field.

By default, instruments are held by single players. You can change the player type by double-
clicking players in the list. Icons show the current player type from the following options:

● Single player 

● Section player 

3 Save

Opens the Save Custom Ensemble dialog, which allows you to name and save your 
ensemble for reuse in future projects.

4 Add
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Adds the players in the custom ensemble to the project.

Choose tab

The Choose tab contains the following:

1 Search field

Allows you to enter the ensemble you are searching for directly.

2 Ensemble category column

Contains ensemble categories to help you focus your ensemble search.

3 Ensemble column

Contains the ensembles available in the selected instrument family.

4 Ensemble contents column

Displays the instruments included in the selected ensemble.

5 Add

Adds the players in the selected ensemble to the project.

RELATED LINKS
Ensembles on page 129
Adding ensembles on page 130
Players on page 124
Adding players on page 125
Project templates on page 80
Changing the application language on page 59
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Save Custom Ensemble dialog

The Save Custom Ensemble dialog allows you to name and save custom ensembles for reuse in 
future projects.

● You can open the Save Custom Ensemble dialog in Setup mode from inside the ensemble 
picker by building a custom ensemble and clicking Save.

The Save Custom Ensemble dialog contains the following options:

Category
Allows you to select an ensemble category for the custom ensemble.

Name
Allows you to enter a name for the custom ensemble.

RELATED LINKS
Adding ensembles on page 130
Building and saving custom ensembles on page 130

Layouts panel (Setup mode)
The Layouts panel contains all the layouts in the project, shown in a list. In Setup mode, it is 
located on the right of the window.

You can hide/show the Layouts panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Zone.

Setup mode
Project window in Setup mode 

118
Dorico Pro 4.3.30



In the Layouts panel, each layout is shown as a card. Each layout card shows the following:

1 Disclosure arrow

Expands/Collapses the layout card.

2 Layout type

Shows the type of layout from the following options:

● Full score layout 

● Instrumental part layout 

● Custom score layout 

3 Layout name

Shows the name of the layout. Dorico Pro automatically adds default names depending 
on the name of the instrument that is assigned to a player and on the type of layout 
that is added. For example, if you assign a flute to a player, the instrumental part layout 
automatically gets the same name. If you add an empty instrumental part layout, the layout 
name shows Empty part and an incremental number if you add multiple empty part layouts.

4 Page size and orientation
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Shows the size and orientation of the layout as set on the Page Setup page in Layout 
Options.

5 Space size

Shows the space size between two staff lines in points, as set on the Page Setup page in 
Layout Options. This indicates the size of staves in the layout.

6 Layout number

Allows you to set a unique number for the layout that can be used as part of its file name 
when exported as a graphic. This can be useful to ensure exported part layout files are 
organized in their orchestral order, as this is usually different to their alphabetical order.

There is a different layout number sequence for each layout type. For example, full score 
layouts are numbered independently of part layouts.

The action bar at the bottom of the panel contains the following options:

Add Full Score Layout

Adds a full score layout to your project. By default, every player and flow is included in 
the layout.

Add Instrumental Part Layout

Adds an empty instrumental part layout to your project. You can then assign one or 
multiple players to the layout. By default, part layouts contain all flows that originated 
in the project.

Add Custom Score Layout

Adds an empty custom score layout to your project. You can then assign players and 
flows to the layout.

Sort Layouts

Sorts all layouts in the Layouts panel according to their type in the following order: full 
score layouts, instrumental part layouts, custom score layouts.

You can click and hold or right-click Sort Layouts to change the setting to one of the 
following options:

● Layout Number: Sorts layouts within each category according to their current 
layout number.

● Instrument Score Order: Sorts layouts within each category according to the 
corresponding player order in the Players panel.

Layout Options

Opens the Layout Options dialog for the selected layouts.

Layout Settings

Allows you to access settings and controls for the selected layout; for example, to 
rename the layout.
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You can also access layout settings by right-clicking layouts.

Delete Layout

Deletes selected layouts from the project.

RELATED LINKS
Project window in Setup mode on page 110
Layouts on page 169
Layout Options dialog on page 834
Layouts panel (Print mode) on page 667
File import and export on page 82
Assigning players to layouts on page 171
Assigning flows to layouts on page 172

Flows panel
The Flows panel contains all the flows in the project, shown in a horizontal list. It is located at the 
bottom of the window in Setup mode.

You can hide/show the Flows panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

In the Flows panel, each flow is shown as a card. Each flow card shows the following:

1 Flow name

Shows the name of the flow. If you create multiple flows without renaming them, each flow 
name shows a number that increments with each new flow that you create.

2 Film reel icon

Indicates the flow has an attached video.

3 Flow timecode

Shows the start timecode for the flow.

4 Flow number
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Shows the number of the flow. The number increments with each new flow that you create 
or import. The number also indicates the position of the flow in a layout.

The Flows panel contains the following options:

Add Flow

Adds a new flow to your project. By default, every new flow is included in all layouts, 
and every player is added to the new flow.

Notation Options

Opens the Notation Options dialog that provides multiple options that allow you to 
make changes that affect the way music is notated for each flow.

Delete Flow

Deletes the selected flows from the project.

RELATED LINKS
Project window in Setup mode on page 110
Flows on page 166
Videos on page 190
Notation Options dialog on page 837

Players, layouts, and flows
In Dorico Pro, players, layouts, and flows are all connected to each other. Because they exist in 
the project rather than in a single score, you can, for example, have players and flows saved in 
the project without showing them in the full score.

● Players can be assigned to any combination of layouts and flows. For example, you can 
assign a single player to both the full score layout and their own part layout, and remove 
them from flows in which they do not play. By default, players are assigned to all flows that 
originated in the project, all full score layouts, and their own part layout.

● Layouts can contain any combination of players and flows. For example, you can assign all 
the singers to a single part layout, then remove the flows in which they do not sing from the 
layout. By default, layouts contain all flows and full score layouts contain all players.

● Flows can contain any combination of players and be assigned to/removed from layouts. By 
default, flows contain all players and are assigned to all layouts.

NOTE

● If you remove a player from a flow, any notes you have already input for that player in that 
flow are deleted.

● Removing a flow from a layout automatically removes that layout from the flow, and vice 
versa. The same is true for players and layouts, and players and flows.

When you select a card in one of the panels in Setup mode, each card in the other panels 
shows a checkbox. Connected cards appear highlighted and have activated checkboxes, while 
unconnected cards are not highlighted and have deactivated checkboxes. For example, if you 
select a player card in the Players panel, all the flows to which the player is assigned are 
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highlighted and activated in the Flows panel, and all layouts to which the player is assigned are 
highlighted and activated in the Layouts panel.

A piano player selected in the Players panel with connected flows and layouts highlighted in the Flows and 
Layouts panels

EXAMPLE
A work for string quartet and choir is divided into three movements. The string quartet is tacet 
for the third movement, which the choir sings a cappella.

The Dorico project contains three flows (one for each movement), four single players for the 
string quartet, four section players for the choir, and another single player for a piano reduction. 
It uses the following layouts to produce the required performance materials:

● Four instrumental part layouts, one for each string quartet player. Each part layout contains 
all three flows but because the string players are not assigned to the third flow, automatic 
tacets are shown for it.

● One full score layout containing all three flows, the string quartet players, and the choir 
players but omitting the piano reduction player.

● One custom score layout for the vocal score. It contains all three flows, the choir players, and 
the piano reduction player.

RELATED LINKS
Project window in Setup mode on page 110
Project Info dialog on page 78
Flows on page 166
Layouts on page 169
Assigning flows to layouts on page 172
Assigning players to layouts on page 171
Assigning players to flows on page 167
File import and export on page 82
Tacets on page 739
Flow headings on page 554
Condensing on page 743
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Players
In Dorico Pro, a player can represent an individual musician or multiple musicians in the same 
section. Players hold instruments, so you must add at least one player to your project before you 
can add instruments.

In Dorico Pro, there are the following types of players:

Single player
Represents an individual person who can play one or more instruments. For example, 
a clarinettist who doubles on alto saxophone or a percussionist who plays bass drum, 
clash cymbals, and triangle.

Instruments belonging to single players can have extra staves.

Section player
Represents multiple people who all play the same instrument. For example, a violin 
section player might represent all eight desks of the Violin I section in an orchestra, or 
a soprano section player might represent the whole soprano section in a mixed voice 
choir.

NOTE

Section players can only hold one instrument, but they can play divisi. This means that 
they can be divided into smaller units, which is commonly required for strings.

You can designate both single and section players as soloists, such as in a concerto for solo violin 
and orchestra.

When you add a player in Dorico Pro, the following happens automatically:

● A part layout is created and the new player is assigned to it.

● The player is added to any full score layouts that already exist. If no full score layouts exist, a 
new full score layout is created.

● The player is assigned to all existing flows that originated in the project. It is not added to 
any flows that you imported into the project.

RELATED LINKS
Players, layouts, and flows on page 122
Flows on page 166
Layouts on page 169
Instruments on page 131
Adding players on page 125
Adding ensembles on page 130
Designating players as soloists on page 128
Changing the default player order on page 127
Setting custom player orders on page 127
Player, layout, and instrument names on page 181
Staff labels on page 1531
Showing instrument/player names in staff labels on page 1536
Condensing on page 743
Divisi on page 1567
Brackets according to ensemble type on page 1026
Instrument numbering on page 132
Instrument changes on page 134
Extra staves on page 1552
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Adding players
You can add both single and section players to your project. Single players can hold multiple 
instruments, while section players can only hold one instrument.

PROCEDURE

1. In Setup mode, add an empty-handed player and open the instrument picker in any of the 
following ways:

● To add a single player, press Shift-P .

● To add a section player, press Shift-Alt/Opt-P .

● In the Players panel, click Add Single Player .

● In the Players panel, click Add Section Player .

● In an empty project, click Add Single Player  in the project start area.

● In an empty project, click Add Section Player  in the project start area.

TIP

You can also open the instrument picker by selecting an existing empty-handed or single 
player in the Players panel and pressing Shift-I .

2. Select the instrument you want in the instrument picker.

3. Press Return  to add the selected instrument.

RESULT
The single/section player is added and is automatically named after the selected instrument. The 
player’s order in the Players panel depends on your current player sorting setting.

The player is assigned to its own new part layout, all full score layouts, and all flows that 
originated in the project.

Dorico Pro automatically loads sounds for the instrument according to the current playback 
template.

NOTE

● Players are not automatically added to flows that you imported into the project.

● If you want to add multiple instruments to your project at the same time, you can add 
ensembles or use a project template.

AFTER COMPLETING THIS TASK

● If you added a single player and you want them to hold multiple instruments, you can add 
other instruments to the single player.

● You can designate the player as a soloist.

● You can change the default order of players in all layouts and set custom player orders in 
each layout independently.

RELATED LINKS
Players panel on page 111
Instrument picker on page 113
Players, layouts, and flows on page 122
Player, layout, and instrument names on page 181
Staff labels on page 1531
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Showing instrument/player names in staff labels on page 1536
Instrument numbering on page 132
Designating players as soloists on page 128
Changing the default player order on page 127
Adding instruments to players on page 138
Adding ensembles on page 130
Changing the language for instrument names on page 60
Renaming players on page 182
Changing instrument names on page 184
Condensing on page 743
Divisi on page 1567
Layouts on page 169
Layouts with clef/transposition overrides on page 176
Project start area on page 37
Project templates on page 80
Playback templates on page 651
File import and export on page 82

Duplicating players
You can duplicate existing players. This adds another player of the same type holding the same 
instruments as the original.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to duplicate.

2. In the action bar, click Player Settings  and choose Duplicate Player.

RESULT
A new player is added, with the same instruments as the original player and is named after those 
instruments. By default, the player appears below the original player in the Players panel. The 
original and new players are automatically numbered to ensure their names are unique.

The new player is assigned to its own new part layout, all full score layouts, and all flows that 
originated in the project.

NOTE

● Any existing music belonging to the original player is not duplicated.

● You can also duplicate players by right-clicking them in the Players panel and choosing 
Duplicate Player from the context menu.

RELATED LINKS
Players panel on page 111
Renaming players on page 182
Players, layouts, and flows on page 122
Arranging tools on page 459
Copying and pasting notes/items on page 461
Setting custom player orders on page 127
Duplicating flows on page 167
Duplicating layouts on page 174
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Changing the default player order
You can change the default order in which players’ staves appear in all layouts; for example, if 
your project requires an unconventional instrument order.

PROCEDURE

1. In Setup mode, in the Players panel, select the players whose default position you want to 
change.

2. Click and drag the selected players upwards/downwards.

An insertion line indicates where the players will be positioned.

RESULT
The default player order is changed. This does not change the player order in layouts with 
custom player orders.

TIP

You can also automatically sort players according to their type by clicking Sort Players  in the 
Players panel.

You can click and hold or right-click Sort Players  to change the setting to one of the following 
options:

● None

● Orchestral

● Band

We recommend changing the setting to None when using an unconventional default player 
order.

RELATED LINKS
Players panel on page 111
Adding players on page 125

Setting custom player orders
You can change the order in which players’ staves appear in each layout independently; for 
example, if you want to have a different player order in a custom score layout than the default 
player order for your other layouts, as set by the order of players in the Players panel.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layout in which you want to set a custom player order.

NOTE

You can only set custom player orders in one layout at a time. By default, the layout currently 
open in the music area is selected when you open the dialog.

3. In the category list, click Players.

4. In the Players section, activate Uses custom player order.

5. In the list, select a player whose position you want to change.
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6. Change its position relative to other players in one of the following ways:

● Click Move up.

● Click Move down.

7. Optional: Repeat steps 5 to 6 for other players in the selected layout whose position you 
want to change.

8. Click Apply, then Close.

RESULT
The player order in the selected layout is changed. This overrides the default player order. Any 
subsequent changes you make to the default player order in the Players panel are not reflected 
in layouts with custom player orders.

RELATED LINKS
Layouts on page 169
Layout Options dialog on page 834

Designating players as soloists
You can designate both single and section players as soloists, such as in a concerto for solo violin 
and orchestra. You can have multiple soloists in a single project.

PREREQUISITE
You have added the players you want to designate as soloists.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to designate as a soloist.

2. In the action bar, click Player Settings  and choose Soloist.

RESULT
The selected player is designated as a soloist.

Instruments held by players designated as soloists are not automatically numbered. Provided 
they have default instrument names, they are automatically given the prefix “Solo” as 
appropriate for the current instrument language setting, which appears in staff labels.

Soloists are automatically positioned in the conventional score position; that is, above the strings, 
and are bracketed separately from other players.

Choosing Soloist again, so that no tick appears beside it in the menu, returns soloists to being a 
normal player of their type.

TIP

You can also designate players as soloists by right-clicking them in the Players panel and 
choosing Soloist from the context menu.

RELATED LINKS
Players panel on page 111
Adding players on page 125
Instrument numbering on page 132
Brackets according to ensemble type on page 1026
Changing the default player order on page 127
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Changing the language for instrument names on page 60
Staff labels on page 1531
Staff label contents on page 1535

Deleting players
You can delete players from your project, which also deletes all instruments held by those 
players.

IMPORTANT

Deleting instruments permanently deletes any music that you have input on their staves.

PROCEDURE

1. In Setup mode, in the Players panel, select the players that you want to delete.

2. Delete the selected players in any of the following ways:

● Press Backspace or Delete .

● In the Players panel, click Delete Player .

3. Choose one of the following options in the warning message that appears:

● Delete Player Only: Deletes the player and the music that you created for the 
instruments belonging to that player.

● Delete Player and Part Layouts: Deletes the player, the music, and all part layouts to 
which the player is assigned.

NOTE

The part layout cannot be deleted if it also contains other players.

RELATED LINKS
Players panel on page 111
Deleting instruments on page 141
Deleting layouts on page 176
Restoring default layouts on page 176

Ensembles
Ensembles are sets of multiple players that are commonly used together, such as a double 
woodwind section that contains two flutes, two oboes, two clarinets, and two bassoons. Dorico 
Pro provides predefined ensembles, but you can also build custom ensembles.

Ensembles can contain single and/or section players, depending on the ensemble. For example, 
woodwind ensembles contain single players whereas string ensembles contain section players.

You can use ensembles to add multiple players to your project simultaneously and build up the 
instrumentation quickly.

RELATED LINKS
Players on page 124
Ensemble picker on page 115
Save Custom Ensemble dialog on page 118
Project templates on page 80
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Adding ensembles
You can add multiple players simultaneously by adding ensembles, such as a complete string 
section or four-part choir. You can select existing ensembles and build new ones.

PROCEDURE

1. In Setup mode, open the ensemble picker in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In an empty project, click Add Ensemble  in the project start area.

2. Select or build the ensemble you want in the ensemble picker.

3. Optional: If you built a new ensemble that you want to reuse in future projects, click Save to 
open the Save Custom Ensemble dialog and save your ensemble.

4. Click Add.

RESULT
The players in the selected ensemble are added to the Players panel, as either single or section 
players depending on the ensemble type. They are assigned to all flows that originated in the 
project.

TIP

You can use project templates to start projects with multiple players.

RELATED LINKS
Players panel on page 111
Ensemble picker on page 115
Save Custom Ensemble dialog on page 118
Changing the language for instrument names on page 60
Renaming players on page 182
Project start area on page 37
Starting new projects on page 74
Project templates on page 80
Opening projects/files on page 75
Players, layouts, and flows on page 122
File import and export on page 82
Key Commands page in the Preferences dialog on page 63

Building and saving custom ensembles
You can build custom ensembles in the ensemble picker and save them for reuse in 
future projects; for example, if you frequently write music for an ensemble with unusual 
instrumentation.

PROCEDURE

1. In Setup mode, open the ensemble picker in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In an empty project, click Add Ensemble  in the project start area.
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2. Click Build to switch to the Build tab.

3. Enter the instruments you want into the Search field.

For example, enter 2 vln, 3 cl,bsn,tuba,marim to build an ensemble containing two violins, 
three clarinets, a bassoon, a tuba, and a marimba.

TIP

You can also use orchestral shorthand to specify instruments.

4. Optional: To confirm the instruments identified by your current entry and clear the Search 
field, press Tab .

5. Optional: To change the player type, double-click players in the list.

The icons for each player show whether they are single players  or section players .

6. Click Save to open the Save Custom Ensemble dialog.

7. Select an ensemble category from the Category menu.

8. Enter a name for your ensemble in the Name field.

9. Click Save to save your ensemble and close the Save Custom Ensemble dialog.

10. Optional: Click Add to add the ensemble to the project and close the ensemble picker.

RESULT
Your ensemble is saved, allowing you to add it to future projects. If you clicked Add in the 
ensemble picker, the players in the ensemble are added to the project.

RELATED LINKS
Ensemble picker on page 115
Save Custom Ensemble dialog on page 118
Players on page 124
Adding players on page 125

Instruments
In Dorico Pro, an instrument is an individual musical instrument, such as a piano, a flute, or a 
violin. Human voices, such as soprano or tenor, are also considered instruments.

In Dorico Pro, instruments are held by players, just as real instruments are held by human 
players. Section players can only hold one instrument but single players can hold multiple 
instruments, which allows you to handle instrument changes easily, such as when an oboist 
doubling the cor anglais switches from one instrument to the other.

This means that before you can add instruments to a project, you must first add players or 
ensembles, which may in turn also be assigned to groups if needed. If you add ensembles, the 
appropriate instruments for the ensemble are automatically added to the players.

Each instrument automatically gets its own staff, but when instrument changes are allowed, the 
music for multiple instruments held by the same single player can appear on the same staff as 
long as no notes overlap. By default, Dorico Pro allows instrument changes in all layouts and 
automatically shows instrument change labels. This means that only the top instrument held by 
players is shown automatically in the music area. You can see staves for all instruments in galley 
view, and you can allow/disallow instrument changes in each layout independently. You can also 
hide/show empty staves in each layout independently.
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Instruments in Dorico Pro do not have limited ranges; it is possible to notate any pitch in any 
register on every instrument. However, in the piano roll editor, only pitches that fall in the MIDI 
note range 0-127 can be represented. Similarly, if you input a pitch beyond the range of samples 
in the assigned VST instrument, the pitch does not sound in playback.

There are multiple versions of some instruments that have specific formatting and tuning 
requirements, such as French Horn, which has a version whose part layouts are always in treble 
clef.

You can change instruments at any time, add/delete them from players, and move them 
between players. You can also change the language for instrument names; for example, to 
recreate a French score.

RELATED LINKS
Players on page 124
Piano roll editor on page 784
Track Inspector on page 617
Unpitched percussion on page 1682
Instrument picker on page 113
Inputting notes on page 221
Adding players on page 125
Adding instruments to players on page 138
Player, layout, and instrument names on page 181
Changing the language for instrument names on page 60
Staff labels on page 1531
Brackets according to ensemble type on page 1026
Changing the open pitches of fretted instrument strings on page 144
Changing instruments on page 140
Moving instruments on page 141
Designating players as soloists on page 128
Changing the default player order on page 127
Deleting instruments on page 141
Switching to galley/page view on page 53
Allowing/Disallowing instrument changes on page 134
Hiding/Showing empty staves on page 696
Edit Percussion Kit dialog on page 155

Instrument numbering
It is customary to number instruments when there is more than one in a piece so that they can 
be easily identified, such as Horn 1 and Horn 2. Dorico Pro automatically numbers instruments 
where there are multiple instruments of the same type in the same project.

For example, if there is only one flute in a project, it is called Flute, but if there are three flutes, 
they are automatically called Flute 1, Flute 2, and Flute 3.
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One violin with no number Adding a second violin automatically generates 
numbers for both violins

Instrument numbering applies to individual instruments, rather than players. For example, if an 
ensemble contains two flute players and a piccolo player, but the second flute is also holding a 
piccolo, then the instruments are numbered in the following way:

● Flute 1

● Flute 2 & Piccolo 1

● Piccolo 2

TIP

You can move individual instruments to different players if you want to change which numbered 
instruments are held by each player. For example, if you want the second flute to double second 
piccolo rather than first piccolo, you can swap the piccolo instruments between the players.

Dorico Pro automatically generates instrument numbers for players if the following criteria are 
met:

● The project contains multiple instruments with identical instrument names.

● The instruments have the same transposition.

● The players holding them are the same type, either single or section.

● The players are in the same group.

For example, if you have two flutes in your project, but one flute is a section player and the other 
flute is a single player, they are not numbered automatically. Similarly, if the two flutes are in 
different player groups, they are not numbered automatically.

NOTE

● Instruments held by players designated as soloists are not automatically numbered.

● You can change whether instruments of the same type but with different transpositions are 
numbered together; for example, if you have two Horns in F and two Horns in D and want 
them to be numbered 1-4. They are numbered separately by default.

RELATED LINKS
Player, layout, and instrument names on page 181
Changing instrument names on page 184
Player groups on page 162
Instrument transpositions in staff labels on page 1536
Moving instruments on page 141
Designating players as soloists on page 128
Numbering instruments with different transpositions separately/together on page 1539
Changing the staff label numbering style on page 1540
Staff label contents on page 1535
Player labels on page 760
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Transposing instruments on page 137

Instrument changes
Instruments changes are when a player holding multiple instruments switches from playing one 
instrument to a different instrument. They are usually indicated in full scores and parts with text 
indications both after the last note before the change and at the first note after the change.

An instrument change from Oboe to Cor Anglais

Dorico Pro handles instrument changes automatically, including showing the appropriate 
instrument change labels, when the following criteria are met:

● You have added a single player holding at least two instruments.

● You have input notes on at least two instrument staves held by the single player, such as 
inputting oboe notes on the Oboe staff and cor anglais notes on the Cor Anglais staff.

● Notes for different instruments held by the same single player do not overlap.

● Instrument changes are allowed in the layout.

You can see staves for all instruments in galley view, and you can allow/disallow instrument 
changes in each layout independently.

Instrument change labels use the appropriate prefix for the current instrument name language 
setting.

TIP

Instrument change labels use the Instrument Change Labels paragraph style, which you can 
edit in the Paragraph Styles dialog. For example, if you want to show borders on instrument 
change labels.

RELATED LINKS
Allowing/Disallowing instrument changes on page 134
Adding players on page 125
Adding instruments to players on page 138
Switching to galley/page view on page 53
Inputting notes on page 221
Hiding/Showing instrument change labels at the start of flows on page 1539
Changing the language for instrument names on page 60
Changing instruments on page 140
Paragraph Styles dialog on page 848

Allowing/Disallowing instrument changes
You can allow/disallow instrument changes in each layout independently; for example, if you 
want to show multiple percussion instruments on as few staves as possible in the score, but on 
separate staves for each percussion instrument in the percussion part.

Disallowing instrument changes shows all instrument staves in the selected layouts, including 
multiple instruments held by one single player.
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TIP

If you want to input notes for other instruments held by single players but keep instrument 
changes in the layout, you can switch to galley view to see all staves in the project.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to allow/disallow instrument 
changes.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, activate/deactivate Allow instrument changes.

5. Click Apply, then Close.

RESULT
Instrument changes are allowed in the selected layouts when Allow instrument changes is 
activated, and disallowed when it is deactivated.

NOTE

Multiple instruments can only appear on the same staff with an instrument change if none of 
their notes overlap. If any of their notes do overlap, multiple staves are shown.

RELATED LINKS
Instruments on page 131
Inputting notes on page 221
Hiding/Showing empty staves on page 696
Hiding/Showing instrument change labels at the start of flows on page 1539
Changing instruments on page 140

Editing the default instrument change label text
You can change the default instrument change label prefix and whether instrument change 
labels show full or short instrument names by default in each layout independently; for example, 
if you want to show full instrument names in part layouts but short instrument names in full 
score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default content in 
instrument change labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.
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4. In the Instrument Changes section, choose one of the following options for Instrument 
names to use in change labels:

● Full Names

● Short Names

5. Choose one of the following options for Prefix for instrument change warnings:

● To

● Take

● Custom

NOTE

To and Take prefixes appear as appropriate for the current instrument name language 
setting.

6. Optional: If you chose Custom, enter the text you want in the following fields, individually or 
together:

● Custom prefix

● Custom suffix

7. Click Apply, then Close.

RESULT
The length of instrument names and prefixes/suffixes in all instrument change labels in the 
selected layouts is changed.

RELATED LINKS
Hiding/Showing instrument change labels at the start of flows on page 1539
Changing the language for instrument names on page 60
Staff labels on page 1531

Editing instrument change label text individually
You can override the text shown in instrument change labels individually; for example, if you 
want to show the full instrument name in the first instrument change label in the flow.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the instrument change labels whose text you want to edit.

2. In the Properties panel, activate Custom text in the Instrument Changes group.

3. Enter the text you want to appear in the instrument change labels into the value field.

4. Press Return .

5. Optional: Activate/Deactivate Hide prefix.
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RESULT
The selected instrument change labels are changed to show the text you entered. If you 
activated Hide prefix, the prefix is hidden.

Deactivating Custom text returns the corresponding instrument change labels to their default 
text.

NOTE

● Deactivating properties permanently deletes any custom text entered.

● You can change the default instrument change label prefix and whether instrument change 
labels show full or short instrument names by default in each layout independently.

RELATED LINKS
Engrave toolbox on page 514
Changing the language for instrument names on page 60

Transposing instruments
While most instruments produce notes at concert pitch, transposing instruments produce a note 
that is different to the one that is written. For example, two common orchestral transposing 
instruments are clarinet in B♭ and horn in F.

When a clarinet in B♭ plays a C, the sound produced is a B♭, one whole step (tone) below. 
When a horn in F plays a C, the sound produced is an F, a fifth below. Other instruments 
that conventionally produce a pitch different to the one notated include the piccolo (sounding 
an octave above written), double bass (sounding an octave below written), and glockenspiel 
(sounding two octaves above written).

Dorico Pro stores all note information in concert pitch and automatically transposes notes as 
appropriate for the transposition of the instrument. This means notes, key signatures, and chord 
symbols are automatically changed in transposing layouts compared to non-transposing layouts. 
You can also change instruments at any time, and the music is adjusted automatically to ensure 
the correct pitches are shown.

You can also change the octave of individual clefs and whether Dorico Pro respects or ignores 
clef octave indicators in each flow independently.

Additionally, you can override the clef and/or transposition in each layout independently.

RELATED LINKS
Instrument picker on page 113
Instrument numbering on page 132
Instrument transpositions in staff labels on page 1536
Concert vs. transposed pitch on page 174
Making layouts transposing/concert pitch on page 173
Editing layout transposition text on page 1191
Changing fretted instrument transpositions on page 149
Setting different clefs for concert/transposed pitch on page 1074
Enharmonic equivalent key signatures on page 1217
Changing instruments on page 140
Hiding/Showing clefs according to layout transpositions on page 1075
Layouts with clef/transposition overrides on page 176
Clefs with octave indicators on page 1077
Fretted instrument tuning on page 142
Capos on page 146
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Adding instruments to players
You can add instruments to both single and section players. Single players can hold multiple 
instruments, while section players can only hold one instrument.

PREREQUISITE
You have added at least one player.

PROCEDURE

1. In Setup mode, in the Players panel, select the player to which you want to add instruments.

NOTE

● You can only add instruments to one player at a time.

● You cannot add instruments to section players who are already holding one instrument.

2. Open the instrument picker in any of the following ways:

● Press Shift-I .

● Click the plus symbol  in the player card.

3. Select the instrument you want in the instrument picker.

4. Press Return  to add the selected instrument.

RESULT
The selected instrument is added to the selected player. Dorico Pro automatically loads sounds 
for the instrument according to the current playback template.

NOTE

● Before you have input any notes, only the first instrument held by single players is shown in 
full scores in page view. All instrument staves are shown in galley view, so we recommend 
switching to galley view to input notes for any other instruments held by single players; for 
example, to create instrument changes.

● If you want to add multiple players to your project at the same time, you can add ensembles 
or use a project template.

RELATED LINKS
Players on page 124
Players panel on page 111
Instrument picker on page 113
Adding players on page 125
Adding ensembles on page 130
Designating players as soloists on page 128
Starting new projects on page 74
Switching to galley/page view on page 53
Playback templates on page 651
Instrument changes on page 134
Player, layout, and instrument names on page 181
Changing the language for instrument names on page 60
Changing instrument names on page 184
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Adding empty percussion kits to players
You can add empty percussion kits to players, to which you can then add unpitched percussion 
instruments.

NOTE

You cannot add percussion kits to section players that are already holding one instrument.

PREREQUISITE
You have added at least one player.

PROCEDURE

1. In Setup mode, in the Players panel, open the Edit Percussion Kit dialog in any of the 
following ways:

● Select a player, press Shift-I , and click Create Empty Kit in the instrument picker.

● Click the plus symbol  in a player card and click Create Empty Kit in the instrument 
picker.

● Select a player, then click Player Settings  in the action bar and choose Create Empty 
Kit. You can also right-click players and choose this option from the context menu.

2. Add the percussion instruments you want to the kit in the Edit Percussion Kit dialog.

RELATED LINKS
Players panel on page 111
Percussion kits vs. individual percussion instruments on page 1689
Edit Percussion Kit dialog on page 155
Instrument picker on page 113
Percussion kit presentation types on page 1694
Changing the language for instrument names on page 60

Combining individual percussion instruments into kits
If a player is holding one or more individual percussion instruments, you can combine them into 
a percussion kit.

PROCEDURE

1. In Setup mode, in the Players panel, select the player whose percussion instruments you 
want to combine into a kit.

2. In the action bar, click Player Settings  and choose Combine Instruments into Kit to 
open the Edit Percussion Kit dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Edit the new percussion kit.

For example, you can change the order in which the instruments appear in a grid or on a 
five-line staff.
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RESULT
A new kit is created containing all the instruments held by the player.

NOTE

If the player was already holding one or more kit instruments, all individual instruments and any 
other kits are combined into the first kit.

Changing instruments
You can change the type of instruments without affecting any music already entered onto their 
staves; for example, if your Clarinet part is very low and you want to change it to a Bass Clarinet, 
or you want to change the tuning of a guitar.

NOTE

● You cannot change percussion kits into other instruments, you can only change individual 
unpitched percussion instruments.

● You cannot change a pitched instrument into an unpitched instrument, and vice versa.

● These steps describe changing the instrument type, not an instrument change where a 
performer switches from one instrument to another partway through a flow.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player whose instrument you 
want to change.

The card lists the instruments held by the player.

2. In the instrument label, click the instrument menu  and choose Change Instrument to 
open the instrument picker.

3. Select the instrument you want in the instrument picker.

4. Press Return  to change to the selected instrument.

RESULT
The selected instrument is changed without affecting any music on its staff.

Where appropriate, different clefs are used by default. This means that notes can appear 
differently so that they are notated correctly according to the new clef.

AFTER COMPLETING THIS TASK
You can change the player order; for example, if the new instrument requires a different position 
according to orchestral convention.

RELATED LINKS
Players panel on page 111
Instrument picker on page 113
Fretted instrument tuning on page 142
Transposing instruments on page 137
Edit Strings and Tuning dialog on page 142
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Instrument changes on page 134
Changing the language for instrument names on page 60
Hiding/Showing instrument transpositions in staff labels on page 1537
Changing the default player order on page 127

Moving instruments
You can move individual instruments without affecting any music already input for those 
instruments. You can move instruments between players, or to a different position in the 
instrument list for a single player; for example, if you want to change the order of staves in 
the score.

Changing the order of instruments held by a single player also affects its player name, if you 
have not already renamed the player.

PREREQUISITE
You have added the players to which you want to move instruments.

PROCEDURE

1. In Setup mode, in the Players panel, expand the cards of the players holding the 
instruments you want to move.

2. Move instruments in any of the following ways:

● To change the order of instruments for a single player, click and drag a single 
instrument to the required position, then release the mouse.

● To move instruments to another player, click and drag a single instrument to the 
required player card, then release the mouse.

● To move instruments to another player, click the instrument menu  in the instrument 
label and choose Move Instrument to Player > [Player].

RELATED LINKS
Players panel on page 111
Adding players on page 125
Changing the default player order on page 127
Renaming players on page 182
Resetting player names on page 183

Deleting instruments
You can delete individual instruments without deleting the player holding them or other 
instruments held by the same player.

IMPORTANT

Deleting instruments permanently deletes any music that you have input on their staves.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the instrument 
you want to delete.

2. In the instrument label, click the instrument menu  and choose Delete Instrument.

3. Click OK.
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RESULT
The instrument is deleted from the player.

TIP

If you want to delete all instruments held by a single player, you can also delete the player.

RELATED LINKS
Players panel on page 111
Deleting players on page 129

Fretted instrument tuning
Fretted instruments can have different numbers of strings and frets. In order to display tablature 
for fretted instruments in Dorico Pro, you must specify information about the tuning of fretted 
instruments.

Dorico Pro requires the following information to display tablature:

● The number of strings the instrument has

● The open pitch of each string

● The number of frets

● The fret number at which each string starts, such as for the fifth string on a banjo

● The pitch intervals between frets

● The fret number of the capo, if applicable

When you add a fretted instrument or change an existing instrument, any available tunings for 
that instrument are shown in the instrument picker.

You can also customize all aspects of fretted instruments in the Edit Strings and Tuning dialog, 
including adding capos.

RELATED LINKS
Instrument picker on page 113
Changing instruments on page 140
Capos on page 146

Edit Strings and Tuning dialog
The Edit Strings and Tuning dialog allows you to customize the tuning of individual fretted 
instruments by changing the number of strings and frets they have, the pitches of their open 
strings, and the spacing of their frets. It also allows you to add/remove capos and change the 
fretted instrument transposition.

● You can open the Edit Strings and Tuning dialog in Setup mode by expanding the card of 
the player holding the fretted instrument in the Players panel, then clicking the instrument 
menu  in its instrument label and choosing Edit Strings and Tuning.
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The Edit Strings and Tuning dialog comprises the following:

1 Instrument

Displays the name of the selected fretted instrument.

2 Compatible preset tunings

Allows you to select preset fretted instrument tunings with the same number of strings as 
the selected fretted instrument. If your changes in the dialog match a preset tuning, it is 
automatically selected.

3 String editor

Allows you to select and edit individual or all strings of the fretted instrument. The 
arrangement of strings in the editor matches that of the real instrument. The pitch and 
total number of frets of each string is shown to the left of the vertical line that represents the 
nut.

You can navigate through strings by pressing Up Arrow / Down Arrow , and to top/bottom 
strings by pressing Page Up/Page Down.

4 Capo representation

Indicates the fret position and extent of the capo added to the fretted instrument.

5 Controls

Allow you to edit individual or multiple strings. The following controls are available when at 
least one string is selected in the string editor:

● Open pitch: Allows you to set the open pitch of the string using the note name and 
octave, such as C4 for middle C. If necessary, you can add # for sharp and b for flat.

● No. of frets: Allows you to set the number of frets for the selected strings.

● Starting fret: Allows you to set the number of the first fret on the selected strings. For 
example, the fifth string on the banjo starts at fret 5.

● Tune Up Half-Step: Allows you to raise the open pitch of the selected strings by a 
half-step (semitone).

● Tune Down Half-Step: Allows you to lower the open pitch of the selected strings by a 
half-step (semitone).

● Irregular fret spacing: Allows you to set non-chromatic fret arrangements for 
instruments with fretboards that correspond to other scales, such as the dulcimer. Enter 
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1 for a half-step and 2 for a whole step, with each step separated by a comma. For 
example, enter 2,2,1,2,2,2,1 to set the pattern for a major scale.

6 Action bar

Contains options that allow you to change the number and arrangement of strings.

● Add String : Adds a new string below the lowest currently selected string. The new 
string is a duplicate of the lowest currently selected string.

● Add String at Top : Adds a new string at the top of the fretboard. The new string is a 
duplicate of the previous top string.

● Select all: Selects all strings at once.

● Move string buttons: Allow you to move the currently selected strings up/down the 
fretboard.

● Reset to Default: Returns all strings and corresponding tunings to the factory default 
settings for the fretted instrument.

● Delete String : Deletes the selected strings.

7 Capo section

Contains options that allow you to change the capo and fretted instrument transposition.

● Capo: Opens the Capo Definition dialog, which allows you to add full and partial capos 
to fretted instruments.

● In staff notation, written C4 sounds as: Allows you to change the transposition of 
the selected fretted instrument. The pitch determines the spelling of notes and chord 
symbols for the corresponding number of half-steps.

8 Import Tuning

Opens the File Explorer/macOS Finder, where you can select the .doricotuning file that 
you want to import and apply to the fretted instrument.

9 Export Tuning

Opens the File Explorer/macOS Finder, where you can select the location to which you want 
to export the strings and tuning settings of the fretted instrument as a .doricotuning file. 
You can then import the .doricotuning file into other instruments/projects and share it 
with other users.

RELATED LINKS
Players panel on page 111
Chord diagrams on page 1056
Tablature on page 1580
Fretted instrument tuning on page 142
Capos on page 146

Changing the open pitches of fretted instrument strings
You can change the open pitch of each fretted instrument string independently; for example, if 
your project requires an unconventional tuning that is not available as an instrument type in the 
instrument picker.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose open pitches you want to change.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.
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3. Select the string whose open pitch you want to change.

4. Change the Open pitch value; for example, to G2.

5. Optional: Repeat steps 3 and 4 to change the open pitch of other strings.

6. Click OK to save your changes and close the dialog.

RESULT
The open pitches of the selected strings are changed. This affects the tuning of the instrument 
and the pitch of all fret positions on those strings.

The new tuning becomes available for chord diagrams.

RELATED LINKS
Players panel on page 111
Chord diagrams on page 1056
Hiding/Showing chord diagrams on page 1058

Importing fretted instrument tunings
You can import custom fretted instrument tunings that you have already created and apply them 
to instruments. This allows you to reuse tunings without having to create them from scratch.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument to which you want to apply an imported tuning.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. Click Import Tuning at the bottom of the dialog to open the File Explorer/macOS Finder.

4. Locate and select the .doricotuning library file you want to import.

5. Click Open.

RESULT
The selected .doricotuning file is applied to the fretted instrument. The imported tuning 
becomes available for chord diagrams.

Exporting fretted instrument tunings
You can export fretted instrument tunings so you can reuse them for other instruments and in 
other projects. Fretted instrument tunings are exported as .doricotuning library files.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose tuning you want to export.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. Click Export Tuning at the bottom of the dialog to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.
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RESULT
The tuning of the selected fretted instrument is exported and saved as a .doricotuning library 
file.

AFTER COMPLETING THIS TASK
You can import the library file into other projects to reuse the fretted instrument tuning.

Capos
Capos are devices that performers clamp onto the necks of fretted instruments to depress 
strings at a single fret position. This raises the sounding pitch of open strings affected by the 
capo, allowing performers to use the same fingerings and chord shapes but produce higher 
pitches.

In Dorico Pro, you can allow capos to affect your notated music in the following ways, 
independently of each other:

● You can change the pitches shown on tablature by adding capos to fretted instruments. 
Dorico Pro treats capos as fret 0 for fret numbers on tablature. Capos added to individual 
fretted instruments appear at the corresponding fret position and crossing the specified 
strings in the Edit Strings and Tuning dialog and in the Fretboard panel.

● You can change fretted instrument transpositions to reflect capos or detuned fretted 
instruments, and optionally allow fretted instrument transpositions to affect pitches on 
notation staves and in main chord symbols.

● You can define capos for chord symbols/diagrams in the music and/or used chord diagrams 
grids, and show only main chords, only capo chords, or both.

For example, you can show capo pitches on tablature but show sounding pitches on notation 
staves. You can also show both main and capo chords in chord symbols in layouts that do not 
contain a fretted instrument, such as when creating lead sheets in vocal part layouts.

RELATED LINKS
Edit Strings and Tuning dialog on page 142
Fretboard panel on page 209
Chord symbols on page 1036
Chord diagrams on page 1056
Fretted instrument tuning on page 142
Defining capos for chord symbols/diagrams on page 151
Defining capos for used chord diagrams grids on page 153
Layouts on page 169
Making layouts transposing/concert pitch on page 173
Assigning players to layouts on page 171

Capo vs. main chords
For the same chord symbol, Dorico Pro can show its original pitch only, its sounding pitch based 
on the defined capo only, or both with capo chords above or below main chords.

Main chord
The original chord symbol you input. Its displayed pitches depend on whether the 
layout is transposing or concert pitch, and whether the layout uses fretted instrument 
transpositions for main chord symbols. For example, in the transposed pitch part 
layout for a trumpet in B♭, a C7 chord symbol appears as D7.
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Capo chord
The chord that the fretted instrument must play in order to produce the desired main 
chord, according to the fret position of the capo. For example, if a guitarist with a capo 
on the second fret plays Gm7, the chord that sounds is Am7.

By default, capo chords appear in italics when shown alongside main chords.

TIP

You can choose to show capo chords in parentheses instead and change the vertical gap 
between capo and main chord symbols in Engraving Options > Chord Symbols > Capo.

RELATED LINKS
Concert vs. transposed pitch on page 174
Layouts with clef/transposition overrides on page 176
Changing fretted instrument transpositions on page 149
Hiding/Showing capo chord symbols on page 151
Hiding/Showing capo chord symbols in used chord diagrams grids on page 154
Respelling chord symbols on page 1045
Project-wide engraving options for chord symbols on page 1037
Chord symbol appearance presets on page 1038
Chord symbol font styles on page 1039

Adding capos to fretted instruments
You can add capos to individual fretted instruments. This affects the pitches shown on tablature 
for the corresponding instruments, as Dorico Pro treats capos as fret 0. For example, if each flow 
in a project for guitar requires a capo at a different fret, you might add multiple players, each 
holding a guitar instrument with the required capo.

NOTE

These steps do not affect pitches on notation staves, chord symbols/diagrams in the music, or 
used chord diagram grids.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument to which you want to add a capo.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo section, click Capo to open the Capo Definition dialog.

4. Choose one of the following options for Capo:

● Full Capo

● Partial Capo

5. Change the fret position of the capo by changing the value for Fret.

6. Optional: If you chose Partial Capo, change the strings across which the capo extends.

7. Click OK to save your changes and close the Capo Definition dialog.

8. Click OK to save your changes and close the Edit Strings and Tuning dialog.
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RESULT
A capo is added to the selected instrument according to your settings. The capo appears at the 
corresponding fret position and crossing the specified strings in the Edit Strings and Tuning 
dialog and in the Fretboard panel for the selected instrument.

EXAMPLE

No capo Capo added to the third fret

RELATED LINKS
Players panel on page 111
Edit Strings and Tuning dialog on page 142
Fretboard panel on page 209
Changing fretted instrument transpositions on page 149
Defining capos for chord symbols/diagrams on page 151
Defining capos for used chord diagrams grids on page 153

Capo Definition dialog

The Capo Definition dialog allows you to add full and partial capos to fretted instruments.

● You can open the Capo Definition dialog from inside the Edit Strings and Tuning dialog by 
clicking Capo in the Capo section.

The Capo Definition dialog contains the following options:

Capo
Allows you to choose one of the following capo types:

● None

● Full Capo

● Partial Capo

Fret
Allows you to change the fret position of the capo.
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From string [n] to [n]
Allows you to set the first and last strings across which the capo extends. Only available 
when Partial Capo is chosen for Capo.

Removing capos from fretted instruments

You can remove capos from individual fretted instruments. This affects the pitches shown on 
tablature for the corresponding instruments.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose capo you want to remove.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo section, click Capo to open the Capo Definition dialog.

4. Choose None for Capo.

5. Click OK to save your changes and close the Capo Definition dialog.

6. Click OK to save your changes and close the Edit Strings and Tuning dialog.

Changing fretted instrument transpositions
You can change the transposition of individual fretted instruments; for example, to reflect capos 
added to them, or for a fretted instrument whose strings have all been detuned. This can affect 
the pitches shown on notation staves and in main chord symbols in the music, depending on 
your per-layout setting for using fretted instrument transpositions.

NOTE

● You can find different tunings for each fretted instrument in the instrument picker.

● You can also change the open pitch of individual fretted instrument strings.

● Fretted instrument transpositions do not affect pitches shown on tablature, which use the 
instrument’s capo, or used chord diagram grids.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose transposition you want to change.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo section, change the pitch for In staff notation, written C4 sounds as.

The pitch determines the spelling of notes and chord symbols for the corresponding number 
of half-steps.

4. Click OK to save your changes and close the dialog.

RELATED LINKS
Players panel on page 111
Edit Strings and Tuning dialog on page 142
Instrument picker on page 113
Changing the open pitches of fretted instrument strings on page 144
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Making layouts transposing/concert pitch on page 173

Using fretted instrument transpositions

You can show transposed pitches on notation staves and in main chord symbols, according to 
the corresponding fretted instrument’s transposition, in each layout independently and for each 
player holding at least one fretted instrument independently.

For example, if you have added a capo to a fretted instrument and want notation staves and 
main chord symbols to show the pitches the performer must play in order to produce the desired 
sounding pitch.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to use fretted instrument 
transpositions for notation staves and main chord symbols.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fretted Instruments section, activate Use fretted instrument transposition for 
each player holding at least one fretted instrument in your project.

5. Choose one of the following options:

● For notation

● For notation and main chord symbols

6. Click Apply, then Close.

RESULT
Transpositions set for the corresponding fretted instruments are used for either notation staves 
only or both notation staves and main chord symbols in the selected layouts.

For example, you might choose For notation for fretted instruments with capos that are set 
to show capo chord symbols, and For notation and main chord symbols for detuned fretted 
instruments.

EXAMPLE

Fretted instrument transposition 
(reflecting capo at fret 3) not used 
for notation staff or main chord 
symbols

Fretted instrument transposition 
used for notation staff only

Fretted instrument transposition 
used for notation staff and main 
chord symbols
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RELATED LINKS
Layout Options dialog on page 834
Players on page 124
Capo vs. main chords on page 146
Chord symbols on page 1036
Hiding/Showing notation staves and tablature on page 1582
Hiding/Showing capo chord symbols on page 151

Defining capos for chord symbols/diagrams
You can define capos for chord symbols and chord diagrams on a per-player basis. This affects 
chord diagram shapes and the transposition of capo chord symbols. For example, you might 
show both main and capo chord symbols for the voice player when creating a lead sheet.

NOTE

These steps do not affect used chord diagram grids or pitches on notation staves/tablature.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to define a capo for 
chord symbols/diagrams.

2. In the action bar, click Player Settings  and choose Chord Symbols > Capo Chord Symbol 
Definition to open the Capo Chord Symbol Definition dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Change the pitch for In capo chord symbols, written C4 sounds as.

The pitch determines the spelling of capo chord symbols for the corresponding number of 
half-steps.

4. Click OK to save your changes and close the dialog.

RESULT
A capo with the set transposition and spelling is set for the selected player.

Hiding/Showing capo chord symbols

You can show only main chords, only capo chords, or both in chord symbols on a per-player 
basis. For example, if you want to show both for the guitar player but only main chords for the 
singer.

NOTE

Chord diagrams always reflect the capo set for the player.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to hide/show capo 
chords in chord symbols.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show only main chords, choose Chord Symbols > Show Main Chord Symbol for 
Capo.
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● To show only capo chords, choose Chord Symbols > Show Transposed Chord Symbol 
for Capo.

● To show capo chords above main chords, choose Chord Symbols > Show Capo Chord 
Symbol Above Main.

● To show capo chords below main chords, choose Chord Symbols > Show Capo Chord 
Symbol Below Main.

TIP

You can also right-click players and choose these options from the context menu.

RESULT
Main and/or capo chords are shown in chord symbols, according to the instrument staves and 
layouts set to show chord symbols for the selected player. By default, capo chords appear in 
italics when shown alongside main chords.

In layouts where chord symbols are only shown above the top staff in each system, the visibility 
of main/capo chords in chord symbols is determined by the setting for the player at the top of 
each system.

EXAMPLE

Main chords shown only Capo chords shown only Capo chords shown 
above main chords

Capo chords shown 
below main chords

RELATED LINKS
Capo vs. main chords on page 146
Positions of chord symbols on page 1039
Hiding/Showing chord symbols on page 1040
Hiding/Showing chord symbols in layouts on page 1041
Showing chord symbols above one/multiple staves on page 1041
Hiding/Showing empty staves on page 696
Showing only chord symbols or chord diagrams on page 1059
Hiding/Showing chord diagrams on page 1058
Project-wide engraving options for chord symbols on page 1037
Chord symbol appearance presets on page 1038
Chord symbol font styles on page 1039
Inputting chord symbols on page 318

Showing only main or capo chord symbols

You can show only the main or capo chord in individual chord symbols on staves set to show 
both. For example, if you want to show both the first time each chord symbol appears but only 
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show main chords for subsequent instances. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The players on whose staves you want to show only main or capo chords are set to show 
both.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose shown chords you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Show only in the Chord Symbols group.

3. Choose one of the following options:

● Main Chord

● Capo Chord

RESULT
The selected chord symbols show only main or capo chords. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Both main and capo chords shown in all chord 
symbols

Only main chords shown in some chord symbols

Defining capos for used chord diagrams grids
You can define capos for used chord diagrams grids in each layout independently. This affects 
chord diagram shapes and the transposition of capo chord symbols. For example, you might 
show both main and capo chord symbols in used chord diagrams grids in the voice part layout 
when creating a lead sheet.

NOTE

These steps do not affect chord symbols/diagrams in the music or pitches on notation staves/
tablature.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts for which you want to define capos for used chord 
diagrams grids.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, change the pitch for Use capo with transposition.

The pitch determines the spelling of capo chord symbols for the corresponding number of 
half-steps.

5. Click Apply, then Close.

RELATED LINKS
Hiding/Showing used chord diagrams grids on page 1060
Capo vs. main chords on page 146
Adding capos to fretted instruments on page 147
Inputting chord symbols on page 318

Hiding/Showing capo chord symbols in used chord diagrams grids

You can show only main chords, only capo chords, or both in used chord symbol grids in each 
layout independently. For example, if you want to show both in the guitar part layout but only 
main chords in the vocal part layout.

NOTE

Chord diagrams in used chord diagrams grids always reflect the capo set for the layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show capo chord symbols in 
used chord diagrams grids.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, select one of the following options from the Capo chord 
symbols menu:

● To show only main chords, select Show Only Main Chord Symbol.

● To show only capo chords, select Show Only Transposed Chord Symbol.

● To show capo chords above main chords, select Show Above Main Chord Symbol.

● To show capo chords below main chords, select Show Below Main Chord Symbol.

5. Click Apply, then Close.

RESULT
Main and/or capo chords are shown in used chord diagrams grids in the selected layouts. By 
default, capo chords appear in italics when shown alongside main chords.
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Edit Percussion Kit dialog
The Edit Percussion Kit dialog allows you to make changes to percussion kits, including which 
instruments are included in them and how instruments are arranged in the different available kit 
presentations.

● The Edit Percussion Kit dialog opens automatically when you create empty kits or combine 
existing instruments into a kit.

● You can also open the Edit Percussion Kit dialog manually for existing percussion kit 
instruments by expanding the card of the player holding the percussion kit in the Players 
panel in Setup mode, then clicking the instrument menu  in its kit instrument label and 
choosing Edit Percussion Kit.

NOTE

Percussion kit instrument labels are green in the Players panel in Setup mode.

1 Name

Allows you to enter or change the full name for the percussion kit. This is used in Full staff 
labels for percussion kits that use the five-line staff presentation type.

2 Short name

Allows you to enter or change the abbreviated name for the percussion kit. This is used in 
Abbreviated staff labels for percussion kits that use the five-line staff presentation type.

3 Drum set

Percussion kits are defined as drum sets when the checkbox is activated. Percussion kits 
that are defined as drum sets follow your settings for drum sets on the Percussion page in 
Notation Options, including for voicing and default stem directions.

4 Presentation types
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Allows you to select a percussion kit presentation type in order to edit how the selected 
percussion kit appears in that presentation type.

● 5-line Staff: Kit instruments are shown on a five-line staff. You can determine which 
instruments are shown on each line and in each space of the staff. A single staff label 
containing the name of the kit is shown.

● Grid: Kit instruments are shown on a grid, with each instrument on its own line. You can 
customize how large the gaps between each line are. Staff labels are shown for each 
instrument in a smaller font than normal staff labels.

● Single-line Instruments: Kit instruments are shown as individual instruments with their 
own lines. Normal-sized staff labels are shown for each instrument.

5 Editor

Displays the current arrangement of instruments in the selected percussion kit presentation 
type. You can change the order of instruments and the layout of lines and spaces in the grid 
presentation type by using the controls.

6 Controls

Allows you to change the order and stem direction of instruments in the selected percussion 
kit presentation type. It also allows you to add slash voices to the kit.

● Edit Names: Opens the Edit Instrument Names dialog, which allows you to change the 
names of the currently selected instrument.

NOTE

This changes the appearance of percussion instrument names in all presentations. 
Depending on the percussion kit presentation type, staff labels might use different 
information than these instrument names.

● Edit Percussion Playing Techniques: Opens the Percussion Instrument Playing 
Techniques dialog, which allows you to change how combinations of noteheads, 
articulations, and tremolos affect playback for the currently selected instrument.

● Edit Noteheads: Opens the Override Percussion Noteheads dialog, which allows you 
to override the noteheads used by the currently selected instrument in five-line staff kit 
presentations.

7 Action bar

Contains options that apply to all presentation types.

● Add New Instrument : Opens the instrument picker, which allows you to choose a 
new unpitched percussion instrument to be added to the kit.

● Add Existing Instrument From Player : Shows a menu listing the other players in 
your project that are holding individual percussion instruments not in kits. You can 
select a percussion instrument from another player to move to this kit, bringing its 
music with it.

● Remove Instrument From Kit : Removes the selected instrument from the kit, so 
it appears as an individual instrument. You can move individual instruments to other 
players or into other kit instruments.

● Change Instrument : Opens the instrument picker, which allows you to choose a new 
unpitched instrument to replace the selected instrument while retaining its music.

● Delete Instrument : Deletes the instrument from the kit, including its music.

8 Export Kit

Allows you to export the percussion kit as a library file so you can use it in other projects.
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RELATED LINKS
Percussion kits and drum sets on page 1690
Voices in percussion kits on page 1701
Staff labels for percussion kits on page 1545
Percussion kit presentation types on page 1694
Edit Instrument Names dialog on page 185
Percussion Instrument Playing Techniques dialog on page 1683
Override Percussion Noteheads dialog on page 1685
Playing techniques for unpitched percussion instruments on page 1682
Playing technique-specific noteheads on page 1683
Specifying the stem direction/voice of instruments in percussion kits on page 1702

Adding instruments to percussion kits
You can add new instruments to percussion kits within the Edit Percussion Kit dialog.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit to which 
you want to add instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Add New Instrument  to open the instrument picker.

4. Select the percussion instrument you want in the instrument picker.

5. Press Return  to add the selected instrument.

6. Click Close.

RESULT
The selected instrument is added to the percussion kit.

RELATED LINKS
Players panel on page 111
Changing the language for instrument names on page 60
Percussion kit presentation types on page 1694

Changing instruments in percussion kits
You can change existing instruments in percussion kits while retaining any existing music for that 
instrument.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to change instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the instrument you want to change.

4. Click Change Instrument  in the action bar to open the instrument picker.

5. Select the percussion instrument you want in the instrument picker.

6. Press Return  to change to the selected instrument.
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7. Click Close.

RESULT
The instrument is changed to the one selected in the instrument picker. Any music input for the 
previous instrument is retained.

NOTE

Playing techniques expressed using playing technique-specific noteheads are not retained.

Defining percussion kits as drum sets
You can define individual percussion kits as drum sets. Drum sets follow your per-flow notation 
options for voicing in drum sets with five-line staff presentations.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit you want 
to define as a drum set.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Activate Drum set in the top right of the dialog.

4. Click Apply, then Close.

RESULT
The selected percussion kit is defined as a drum set. The arrangement of voices for instruments 
in the kit when using the five-line staff presentation type follows your per-flow setting on the 
Percussion page in Notation Options.

NOTE

If you no longer want a percussion kit to be defined as a drum set, you can deactivate Drum set 
in the Edit Percussion Kit dialog for that kit.

RELATED LINKS
Players panel on page 111
Notation Options dialog on page 837
Percussion Instrument Playing Techniques dialog on page 1683

Creating groups of instruments within grid presentation percussion kits
You can create groups of instruments within percussion kits that use the grid presentation type 
in order to have a better overview of the instruments in the kit.

In grid presentation percussion kits, the name of each individual instrument is shown in the staff 
label. You can simplify the staff label of grid presentation percussion kits by creating groups; for 
example, to show “Wood Blocks” instead of “Wood Block (High)”, “Wood Block (Medium)”, and 
“Wood Block (Low)”.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to create groups in the grid presentation.
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2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the first instrument you want to include in the group.

5. Shift -click the last instrument you want to include in the group.

NOTE

You can only include adjacent instruments in groups.

6. Click Add .

RESULT
A group is created containing the selected instruments. The group is given a default name that 
you can change.

RELATED LINKS
Players panel on page 111
Percussion kit presentation types on page 1694

Renaming groups in grid presentation percussion kits
Group names are shown as instrument labels. You can change the names of groups in 
percussion kits using the grid presentation type.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
grid presentation groups you want to rename.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Double-click the group you want to rename to open the Edit Percussion Grid Group Names 
dialog.

Groups are shown as colored blocks in the column to the left of the list of percussion kit 
instruments.

5. Enter the names you want to give the group in the corresponding fields in the Edit 
Percussion Grid Group Names dialog:

● Full Name

● Short Name

6. Click OK to save your changes and close the dialog.

RESULT
The name of the group is changed. This also changes the staff label for the group.

NOTE

Staff labels for groups in grid presentation percussion kits use a different paragraph style to the 
staff labels for non-grouped instruments in grid presentation percussion kits.
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EXAMPLE

Ungrouped grid presentation percussion kit Grid presentation percussion kit with wood blocks 
grouped

RELATED LINKS
Staff labels for percussion kits on page 1545

Deleting groups within grid presentation percussion kits
You can delete groups in percussion kits using the grid presentation type without deleting the 
instruments within the group.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit from 
whose grid presentation you want to delete groups.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the group you want to delete.

Groups are shown as colored blocks in the column to the left of the list of percussion kit 
instruments.

5. Click Delete .

RESULT
The group is deleted. The individual staff labels for each instrument in the group are restored.

Changing the positions of instruments within percussion kits
You can change the positions of instruments within percussion kits of all presentation types 
to change the order in which the instruments appear in the score and parts. In five-line staff 
presentation types, you can also change the staff position of slash voices.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to change the positions of instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the kit presentation type in which you want to change the order of instruments.

For example, click Grid to change the order of instruments when the kit uses the grid 
presentation type.
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4. Click the percussion instruments and/or slash voices whose position you want to change.

NOTE

When using the mouse, you can only move one instrument or slash voice at a time.

5. Change the position of the selected instruments/slash voices in any of the following ways:

● Click Move up arrow to move them upwards.

● Click Move down arrow to move them downwards.

● Click and drag a single instrument upwards/downwards (five-line staff presentation 
only).

6. Optional: Repeat these steps for other instruments in the percussion kit, and for other kit 
presentation types for the same percussion kit.

7. Click Apply, then Close.

RESULT
The positions of the selected instruments and/or slash voices within the kit is changed. Multiple 
instruments can share the same staff position, but we recommend that they use different 
noteheads so that the player can tell them apart.

RELATED LINKS
Players panel on page 111
Moving notes to different instruments in percussion kits on page 1692

Changing the size of gaps between lines in percussion grids
You can change the size of gaps between lines in percussion kits using the grid presentation 
type.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player in whose percussion kit 
you want to change the size of gaps in the grid presentation.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the instruments below which you want to change the gap size.

5. Change the value for Gap.

6. Click Apply, then Close.

RESULT
The size of the gaps below the selected instruments is changed.
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Removing individual instruments from percussion kits
You can remove individual instruments from percussion kits without affecting other instruments 
in the kit. For example, if you want to move an instrument from one percussion kit to another 
player.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit from 
which you want to remove instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the instruments you want to remove from the kit.

4. Click Remove Instrument From Kit  in the action bar.

5. Click Close.

RESULT
The selected instruments are removed from the percussion kit. They appear as individual 
instruments belonging to the same player.

AFTER COMPLETING THIS TASK
You can move the instruments to other players if required.

RELATED LINKS
Players panel on page 111
Moving instruments on page 141

Player groups
A player group represents a collection of musicians that are considered together, such as one 
choir in a work for double choir or an off-stage ensemble. Player groups can have their own 
brackets, depending on the bracket grouping set for each layout.

Grouping players together means they are positioned together in the default player order, 
numbered independently of players outside the group, and are bracketed together according 
to the ensemble type set for each layout.

For example, if your project is for double choir (SATB/SATB), all voices are joined by a single 
bracket by default because they are in the same family. However, if you add each choir to its own 
group, they are bracketed separately. This is useful in works containing multiple groups, such as 
in Britten's “War Requiem”, which has three distinct groups, or in Walton's “Belshazzar's Feast” 
which requires two separate off-stage brass groups.

You can add as many player groups as required; for example, to allow easy separation of 
forces, or to prevent automatic instrument numbering for percussion instruments when multiple 
percussion players hold the same instrument to accommodate instrument changes.

You can also show player group labels for player groups in each layout independently.

RELATED LINKS
Instrument numbering on page 132
Brackets and braces on page 1023
Brackets according to ensemble type on page 1026
Changing the default player order on page 127
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Setting custom player orders on page 127
Player group labels on page 1542
Player, layout, and instrument names on page 181

Adding player groups
You can organize players into groups; for example, if you want to bracket them together. Players 
in different groups are also numbered separately.

PROCEDURE

1. Optional: If you want to add a group that includes existing players, select those players in 
the Players panel in Setup mode.

2. In the Players panel, click Add Group .

RESULT
A new player group is added to the Players panel. If you selected players, those players are 
added to the group. If you did not select players, the new group is empty.

AFTER COMPLETING THIS TASK

● You can add players to groups and move them between groups.

● You can rename player groups and show player group labels.

RELATED LINKS
Players panel on page 111
Adding players to groups on page 163
Moving players between groups on page 165
Renaming player groups on page 164
Player group labels on page 1542

Adding players to groups
You can add new players to existing player groups.

PROCEDURE

1. In Setup mode, in the Players panel, select the group to which you want to add new players.

2. Add new players in one of the following ways:

● To add a single player, click Add Single Player  in the action bar.

● To add a section player, click Add Section Player  in the action bar.

The instrument picker opens.

TIP

You can also open the instrument picker by selecting an existing player in the Players panel 
and pressing Shift-I .

3. Select the instrument you want in the instrument picker.

4. Press Return  to add the selected instrument.

RESULT
The corresponding type of player is added to the selected group.
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TIP

You can also move existing players to, from, or between groups.

RELATED LINKS
Players panel on page 111
Instrument picker on page 113
Adding players on page 125
Moving players between groups on page 165
Player group labels on page 1542
Changing the language for instrument names on page 60

Renaming player groups
You can change the name of player groups after you have added them. This changes the name 
shown in player group labels.

PROCEDURE

1. In Setup mode, in the Players panel, select the player group you want to rename.

2. In the action bar, click Player Settings  and choose Rename Player Group to open the 
Rename Player Group dialog.

TIP

You can also right-click player groups and choose this option from the context menu.

3. Enter new names or edit the existing names in the following fields:

● Full name

● Short name

4. Click OK to save your changes and close the dialog.

RESULT
The corresponding names for the selected player group are changed.

Player group labels show full player group names by default. Short player group names are used 
when the full player group name is longer than the bracket.

RELATED LINKS
Players panel on page 111
Player group labels on page 1542
Player, layout, and instrument names on page 181

Deleting player groups
You can delete groups of players; for example, if you no longer need a group of players that you 
created when importing a MIDI file. When deleting player groups, you can choose to keep the 
players within the group or delete them as well.

PROCEDURE

1. In Setup mode, in the Players panel, select the groups that you want to delete.

2. Delete the selected groups in any of the following ways:
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● Press Backspace or Delete .

● In the Players panel, click Delete Player .

3. Choose one of the following options in the warning message that opens:

● Keep Players: Deletes the group but keeps the players.

● Delete Players: Deletes the group and the players it contains.

Moving players between groups
You can move players to, from, or between player groups. For example, you can move 
ungrouped players into existing groups and move players from one group to another.

PROCEDURE

1. In Setup mode, in the Players panel, select the players that you want to move.

2. Click and drag the selected players to the position you want.

An insertion line indicates where the players will be positioned.

RESULT
The players are moved to the new position.

TIP

● You can also add existing players to existing groups by right-clicking them in the Players 
panel and choosing Add Player to Group > [Group] from the context menu.

● You can also add new players to player groups.

RELATED LINKS
Adding players to groups on page 163

Removing players from groups
You can remove players from groups.

PROCEDURE

● In Setup mode, in the Players panel, remove players from groups in any of the following 
ways:

● Select multiple players, then click and drag them out of the group.

● Select one player, then click Player Settings  in the action bar and choose Remove 
Player from Group. You can also right-click players and choose this option from the 
context menu.

RESULT
The players are removed from their groups but remain in the project as individual players.
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Flows
Flows are separate spans of music that are completely independent in musical content, meaning 
they can contain completely different players from each other and have different time signatures 
and key signatures. A single project can contain any number of flows.

Depending on the purpose of each project, a flow could be, for example, a single song in an 
album, a movement in a sonata or symphony, a number in a stage musical, or a short scale or 
sight-reading exercise of only a few bars in length.

Dorico Pro automatically adds a flow to projects once you have added at least one player. You 
cannot add flows until you have added at least one player to the project.

When you add a flow in Dorico Pro, the following happens automatically:

● The flow is assigned to all full score and part layouts in the project.

● All players are assigned to the new flow.

By default, all layouts include all flows in the project. If necessary, you can change the layouts to 
which flows are assigned and which players are assigned to flows.

IMPORTANT

If you exclude a player from a flow, any notes that you have already input for that player in that 
flow are deleted.

You can change notation options, such as beam grouping and accidental duration rules, for each 
flow independently in the Notation Options dialog.

RELATED LINKS
Flows panel on page 121
Notation Options dialog on page 837
Players on page 124
Layouts on page 169
Tacets on page 739
Players, layouts, and flows on page 122
Importing flows on page 82
Exporting flows on page 84
Starting new projects on page 74
Opening projects/files on page 75
Changing the gap between flows in playback on page 635
Flow headings on page 554

Adding flows
You can add any number of new flows to your project; for example, when engraving a large work 
that comprises multiple movements.

PROCEDURE

● In Setup mode, add a flow in any of the following ways:

● Press Shift-F .

● In the Flows panel, click Add Flow .
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RESULT
A new flow is added to your project. All existing players are assigned to new flows, and new flows 
are automatically assigned to all existing full score and part layouts.

AFTER COMPLETING THIS TASK

● You can rename the flow.

● You can change the players assigned to the flow and the layouts to which the flow is 
assigned.

RELATED LINKS
Flows panel on page 121
Importing flows on page 82
Exporting flows on page 84
Starting new projects on page 74
Opening projects/files on page 75
Renaming flows on page 189
Adding players on page 125
Assigning players to flows on page 167
Assigning flows to layouts on page 172

Duplicating flows
You can duplicate flows; for example, if you want to experiment with some ideas without 
affecting the original flow, or if you want to copy material with any barlines you have added.

PROCEDURE

● In Setup mode, in the Flows panel, right-click the flow you want to duplicate and choose 
Duplicate Flow from the context menu.

RESULT
A new flow is added, containing all the music and players of the original flow. It is automatically 
added to all full score and part layouts.

Assigning players to flows
By default, all players in your project are added to all flows that originated in the project. You can 
assign players to and remove players from flows manually; for example, if the soloists in a choral 
work do not sing for an entire flow.

NOTE

If you remove a player from a flow, any notes you have already input for that player in that flow 
are deleted.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flow whose assigned players you want to 
change.

2. In the Players panel, activate the checkbox in the card of each player you want to assign to 
the flow.
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TIP

You can Shift -click to activate/deactivate the checkboxes in multiple player cards at once.

RESULT
Players are assigned to the selected flow when the checkbox in their player card is activated, and 
removed from the flow when the checkbox is deactivated.

RELATED LINKS
Flows panel on page 121
Tacets on page 739
Assigning flows to layouts on page 172
Assigning players to layouts on page 171

Reordering flows
You can change the order of flows; for example, if you want an imported flow to be the first flow 
rather than the last.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flows whose order you want to change.

2. Click and drag the selected flows to the right/left.

RESULT
The selected flows are moved to the specified position. Their flow numbers are automatically 
updated, as is their order in the Project Info dialog and in layouts by default.

TIP

You can also reorder flows in the Project Info dialog by selecting them in the flows list and 
clicking Move Down  or Move Up  in the action bar. This can be an easier method of 
reordering flows in projects that contain many flows.

RELATED LINKS
Project Info dialog on page 78
Flow names and flow titles on page 188
Importing flows on page 82
Flow headings on page 554
Music frame chains on page 569
Tokens on page 576
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Deleting flows
You can delete flows that you no longer need. This deletes all music for all instruments and 
players in the flows.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flows you want to delete.

2. Delete the selected flows in any of the following ways:

● Press Backspace or Delete .

● In the Flows panel, click Delete Flow .

RELATED LINKS
Importing flows on page 82
Exporting flows on page 84

Layouts
Layouts combine musical content, as represented by flows and players, with rules for page 
formatting and music engraving, and allow you to produce paginated music notation that can be 
printed or exported in various formats. For example, part layouts typically only show the music 
for one player, whereas full score layouts show the music of all players in the project.

Layouts can contain any combination of players and flows. They share the musical content of 
these players and flows, such as the notes each instrument plays. For example, when you change 
the pitch of a note in the full score, that note’s pitch is also updated in the corresponding part 
layout.

You can control practically every aspect of page formatting in each layout independently, 
including note spacing, staff size, page size, margins, and casting off; that is, the positions of 
system breaks and page turns. Changing these aspects in one layout does not affect other 
layouts. For example, inserting systems breaks in a part layout does not change the casting off in 
the full score.

Similarly, you can change the visual appearance of many items only in one layout, without 
affecting other layouts, using local properties. For example, you can hide text items in the full 
score layout but show them in part layouts.

The default formatting of pages in layouts is determined by page templates. By default, full score 
layouts use a different page template set to part layouts; however, you can apply a different page 
template set to each layout. For example, if some part layouts need a different running header, 
or consistently shorter music frames.

Dorico Pro provides the following layout types:

Full score
A full score layout includes all players and all flows in your project by default. Full score 
layouts are concert pitch by default.

Dorico Pro automatically creates a single full score layout in every project.

Part
A part layout is automatically created when you add a player to your project. You can 
also create empty part layouts and assign players to them manually.

By default, instrumental part layouts contain all flows. They are also transposed pitch 
by default.
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You can propagate the formatting of part layouts.

Custom score
A custom score layout initially does not contain any players or flows. This allows you 
to create your score manually and, for example, assign only one flow instead of all 
flows or only vocal and piano players to create a vocal score. Custom score layouts are 
concert pitch by default.

TIP

● You can create as many layouts of each type in each project as required.

● You can duplicate layouts of any type.

● You can combine players, layouts, and flows together in any combination. For example, 
you might add all percussion players to a single part layout so that the performers can 
manage instrument changes themselves. In a large-scale work, you might also create a 
piano reduction for choir rehearsals, but only assign that piano player to the vocal score, 
meaning it does not appear in the orchestral full score at all.

● By default, respelling notes in score layouts also affects their spelling in all other layouts, but 
respelling notes in part layouts only affects their spelling in the current part layout.

● You can save options set in Layout Options as the default for score and part layouts 
independently. For example, full scores and part layouts often require different page and 
staff sizes.

● Deleting layouts does not delete any music from the project.

RELATED LINKS
Page formatting on page 689
Part formatting propagation on page 765
Flows on page 166
Players on page 124
Players, layouts, and flows on page 122
Page templates on page 527
Page template sets on page 529
Types of page templates on page 532
Applying page template sets to layouts on page 692
Properties on page 769
Local vs. global properties on page 770
Layout Options dialog on page 834
Player, layout, and instrument names on page 181
Duplicating layouts on page 174
Renumbering layouts on page 175
Renaming layouts on page 184
Hiding/Showing borders on layout names on page 1192
Switching between layouts on page 46
Switching to galley/page view on page 53
Hiding/Showing staff labels on page 1532
Brackets according to ensemble type on page 1026
Casting off on page 728
Condensing on page 743
Divisi on page 1567
Layouts with clef/transposition overrides on page 176
Editing layout transposition text on page 1191
Respelling notes on page 484
Hiding/Showing text items on page 1618
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Creating layouts
You can create any number of full score, custom score, and part layouts in each project. By 
default, Dorico Pro creates a single full score layout and a part layout for each player.

PROCEDURE

● In Setup mode, in the Layouts panel, click one of the following layout types:

● Add Full Score Layout 

● Add Instrumental Part Layout 

● Add Custom Score Layout 

RESULT
The layout is added to the list of layouts in the Layouts panel.

NOTE

● Layouts are not available in the layout selector until you have assigned at least one player to 
them.

● You can also add new custom score layouts by pressing Shift-L .

AFTER COMPLETING THIS TASK

● You can assign players and flows to the layout.

● If you want to change the position of the new layout in the layouts list, you can reorder and 
renumber layouts.

● You can override the clef and/or transposition for the layout; for example, to show the music 
of the same player with different clefs/transpositions in different layouts.

RELATED LINKS
Layouts panel (Setup mode) on page 118
Workspace options on page 34
Duplicating layouts on page 174
Reordering layouts on page 175
Renumbering layouts on page 175
Switching between layouts on page 46
Switching to galley/page view on page 53
Opening new tabs on page 48
Layouts with clef/transposition overrides on page 176

Assigning players to layouts
By default, all players are included in full score layouts and each player is automatically assigned 
its own part layout. You can assign players to and exclude players from layouts manually; for 
example, if you want to remove unnecessary players from the full score, or you want to add the 
soloists’ music to the part for the accompanist.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout whose assigned players you want to 
change.

2. In the Players panel, activate the checkbox in the card of each player you want to assign to 
the layout.
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TIP

You can Shift -click to activate/deactivate the checkboxes in multiple player cards at once.

RESULT
Players are assigned to the selected layout when the checkbox in their player card is activated, 
and removed from the layout when the checkbox is deactivated. If you have not changed the 
name of the layout, it is automatically updated to reflect the players included in the layout.

RELATED LINKS
Players panel on page 111
Layouts panel (Setup mode) on page 118
Player, layout, and instrument names on page 181
Renaming layouts on page 184
Assigning players to flows on page 167
Layouts with clef/transposition overrides on page 176

Assigning flows to layouts
By default, all flows in your project are added to all layouts. You can exclude flows that you do not 
want to show in a layout. You can assign flows to and remove flows from layouts manually; for 
example, if a flow in your project contains specific performance instructions for strings that you 
want to show in string part layouts but not in other part layouts.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout whose assigned flows you want to 
change.

2. In the Flows panel, activate the checkbox in the flow card of each flow you want to assign to 
the layout.

TIP

You can Shift -click to activate/deactivate the checkboxes in multiple flow cards at once.

RESULT
Flows are assigned to the selected layout when the checkbox in their flow card is activated, and 
removed from the layout when the checkbox is deactivated.

Dorico Pro automatically creates enough pages and frames to display the flows assigned to both 
the layout and the layout’s page template frame chain.

RELATED LINKS
Layouts panel (Setup mode) on page 118
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Flows panel on page 121
Assigning flows to frame chains on page 573
Music frame chains on page 569
Applying page template sets to layouts on page 692
Layouts with clef/transposition overrides on page 176

Making layouts transposing/concert pitch
You can change whether each layout in your project is transposing or concert pitch. In Dorico 
Pro, full score layouts are concert pitch and part layouts are transposing by default.

For example, full scores are often concert pitch, to show notes at their sounding pitch, but part 
layouts are transposing so the player can read the notes they must play in order to achieve the 
desired sounding pitch.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts you want to make transposing/non-transposing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Players section, activate/deactivate Transposing layout.

5. Click Apply, then Close.

RESULT
The selected layouts are transposed pitch when Transposing layout is activated, and concert 
pitch when it is deactivated.

TIP

You can also make layouts transposing by choosing Edit > Transposed Pitch, and concert pitch 
by choosing Edit > Concert Pitch. This automatically updates the layout option but only for the 
layout currently open in the music area.

RELATED LINKS
Transposing instruments on page 137
Fretted instrument tuning on page 142
Transposing selections on page 480
Changing the input pitch setting on page 228
Setting different clefs for concert/transposed pitch on page 1074
Hiding/Showing clefs according to layout transpositions on page 1075
Layouts with clef/transposition overrides on page 176
Editing layout transposition text on page 1191
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Concert vs. transposed pitch
Layouts in Dorico Pro can use concert or transposed pitch. This affects the pitches and key 
signatures on staves belonging to transposing instruments.

Concert pitch
When music is in concert pitch, all notes are written as they sound. This means that 
players with transposing instruments reading music in concert pitch must transpose 
the music themselves. For example, if a clarinet in B♭ reads a C in concert pitch, they 
must play the note D on their instrument to produce the sounding note C.

Transposed pitch
When music is in transposed pitch, the notes written are the ones each instrument 
must play in order to produce the desired sounding pitch. For example, if a clarinet in 
B♭ reads a D in transposed pitch, the pitch that sounds from the instrument is C.

Transposing layouts automatically transpose key signatures and chord symbols according to the 
transposition of the instrument or layout. Transposing and concert pitch layouts can also use 
different clefs.

RELATED LINKS
Transposing selections on page 480
Enharmonic equivalent key signatures on page 1217
Clefs with octave indicators on page 1077
Layouts with clef/transposition overrides on page 176
Capo vs. main chords on page 146
Editing layout transposition text on page 1191

Duplicating layouts
You can duplicate existing layouts. This creates another layout of the same type, containing the 
same players and flows, layout options, and customization, including overrides for clefs, page 
templates, and staff spacing.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout you want to duplicate.

2. In the action bar, click Layout Settings  and choose Duplicate Layout.

TIP

You can also right-click layouts and choose this option from the context menu.

RESULT
A new layout is created that is an exact copy of the original layout, containing the same players 
and flows, layout options, and customization. By default, the layout appears at the bottom of the 
layouts list.

RELATED LINKS
Layouts on page 169
Layouts panel (Setup mode) on page 118
Renumbering layouts on page 175
Players, layouts, and flows on page 122
Layouts with clef/transposition overrides on page 176
Page format changes on page 542
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Staff spacing on page 720
Duplicating players on page 126
Duplicating flows on page 167

Reordering layouts
You can change the order in which layouts appear in the Layouts panel and the layout selector; 
for example, if you added a custom score layout and want it to be positioned at the top next to 
the full score layout.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layouts whose order you want to change.

2. Click and drag the selected layouts upwards/downwards.

RESULT
The selected layouts are moved to the specified position. This does not affect their layout 
numbers.

TIP

You can also automatically sort layouts according to their type by clicking Sort Layouts  in the 
Layouts panel, which positions all full score layouts at the top, all part layouts in the middle, and 
all custom score layouts at the bottom.

You can click and hold or right-click Sort Layouts  to change the setting to one of the following 
options:

● Layout Number

● Instrument Score Order

RELATED LINKS
Layouts panel (Setup mode) on page 118

Renumbering layouts
You can renumber all layouts according to their current position in the Layouts panel in Setup 
mode; for example, after you have dragged layouts to different positions.

PROCEDURE

1. In Setup mode, in the Layouts panel, select any layout.

2. In the action bar, click Layout Settings  and choose Renumber Layouts.

TIP

You can also right-click layouts and choose this option from the context menu.

RESULT
All layouts are renumbered according to their current position in the panel. Full score layouts, 
custom score layouts, and part layouts are all numbered separately.
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Deleting layouts
You can delete layouts without removing the corresponding music from the project. For example, 
if you only want to use a combined Violin I and II part layout, you can delete their separate part 
layouts.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layouts that you want to delete.

2. Delete the selected layouts in any of the following ways:

● Press Backspace or Delete .

● In the Layouts panel, click Delete Layout .

RESULT
The selected layouts are deleted without removing any music from the project.

AFTER COMPLETING THIS TASK
You can later restore all the part layouts that Dorico Pro provides by default.

RELATED LINKS
Layouts panel (Setup mode) on page 118
Players, layouts, and flows on page 122

Restoring default layouts
You can recreate all the part layouts that Dorico Pro provides by default; for example, if you 
accidentally deleted some part layouts.

PROCEDURE

● In Setup mode, choose Setup > Create Default Part Layouts.

RESULT
The default set of part layouts is restored, recreating a single part layout for each player that 
contains all flows in the project. Any part layouts that were recreated are added at the bottom 
of the Layouts list. Their order matches the order of the corresponding players in the Players 
panel.

Layouts with clef/transposition overrides
Default clef and transposition overrides allow you to assign the same player to multiple layouts 
and have its music appear with a different clef and/or transposition in each layout. Any changes 
you make to the player’s music are automatically updated in all layouts.

It is a common requirement in pieces for wind/concert bands and ensembles with flexible 
instrumentation to produce multiple versions of the same part, each using a different 
transposition, such as B♭, A, and F. This allows performers playing instruments with different 
transpositions to play together.

NOTE

It is not necessary to specify clef and/or transposition overrides for single transposing 
instruments. Dorico Pro automatically transposes notes as appropriate for the instrument 
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transposition, and you can select instruments with different transpositions and clefs by default in 
the instrument picker.

RELATED LINKS
Layouts on page 169
Players on page 124
Transposing instruments on page 137
Instrument picker on page 113
Creating layouts on page 171
Assigning players to layouts on page 171
Assigning flows to layouts on page 172
Duplicating layouts on page 174
Copying part formatting to other layouts on page 765
Adding players on page 125
Overriding the default clef for layouts on page 179
Overriding the transposition for layouts on page 180
Setting different clefs for concert/transposed pitch on page 1074
Hiding/Showing clefs according to layout transpositions on page 1075
Making layouts transposing/concert pitch on page 173

Clef and Transposition Overrides dialog
The Clef and Transposition Overrides dialog allows you to change the transposition and default 
clefs in individual layouts. This allows you to show the music of the same player with different 
clefs and/or transpositions in different layouts.

● You can open the Clef and Transposition Overrides dialog in Setup mode by selecting a 
layout in the Layouts panel, then clicking Layout Settings  in the action bar and choosing 
Clef and Transposition Overrides.

TIP

● You can also right-click layouts and choose this option from the context menu.

● You can assign a key command for opening the Clef and Transposition Overrides 
dialog on the Key Commands page in Preferences.
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The Clef and Transposition Overrides dialog contains the following:

1 Clef/Transposition overrides table

Displays each instrument in the layout in its own row. The first column displays the 
instrument name. The other columns indicate whether or not each instrument has the 
corresponding type of override.

Remove Overrides  in the action bar at the bottom of the table allows you to remove all 
overrides from the selected instrument.

2 Transposed pitch section

Contains overrides for the default clef and/or transposition used when the layout is set to 
transposed pitch.

● Clef for [n] staff: Allows you to override the default clef for the corresponding staff. 
The number of clef overrides available depends on the number of staves the instrument 
normally has.

● Written middle C sounds as: Allows you to override the transposition by changing the 
sounding pitch that results from a notated middle C.

3 Concert pitch section

Contains overrides for the default clef and/or transposition used when the layout is set to 
concert pitch.

● Clef for [n] staff: Allows you to override the default clef for the corresponding staff. 
The number of clef overrides available depends on the number of staves the instrument 
normally has.

NOTE

In order to override clefs for concert pitch, you must first override the corresponding 
clef for transposed pitch.

● Written middle C sounds as: Allows you to override the octave of the sounding pitch 
that results from a notated middle C.

RELATED LINKS
Overriding the transposition for layouts on page 180
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Making layouts transposing/concert pitch on page 173
Key Commands page in the Preferences dialog on page 63

Overriding the default clef for layouts
You can override the default clef shown for each instrument in each layout independently; for 
example, to have multiple layouts with different clefs for the same player in pieces for flexible 
instrumentation.

NOTE

Overriding the default clef does not change any clefs you have input explicitly.

PREREQUISITE
You have created the layouts whose default clef you want to override, and assigned the required 
players and flows to them.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout whose default clef you want to 
override.

2. In the action bar, click Layout Settings  and choose Clef and Transposition Overrides to 
open the Clef and Transposition Overrides dialog.

TIP

You can also right-click layouts and choose this option from the context menu.

3. In the table, select the instrument whose default clef you want to override.

4. In the Transposed pitch section, activate each staff whose default clef you want to override.

5. Select the clef you want from each menu.

6. In the Concert pitch section, activate each staff whose default clef you want to override.

7. Select the clef you want from each menu.

8. Optional: Repeat steps 3 to 7 for other instruments in the layout whose default clef you want 
to override.

9. Click OK to save your changes and close the dialog.

RESULT
The default clef for the corresponding staves of the selected instruments is changed in the 
selected layout.

RELATED LINKS
Transposing instruments on page 137
Layouts panel (Setup mode) on page 118
Creating layouts on page 171
Duplicating layouts on page 174
Assigning players to layouts on page 171
Assigning flows to layouts on page 172
Copying part formatting to other layouts on page 765
Adding players on page 125
Making layouts transposing/concert pitch on page 173
Removing layout clef/transposition overrides on page 181
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Input methods for clefs and octave lines on page 329
Setting different clefs for concert/transposed pitch on page 1074
Hiding/Showing clefs according to layout transpositions on page 1075

Overriding the transposition for layouts
You can override the transposition of each instrument in each layout independently; for example, 
to have multiple layouts with different transpositions for the same player in pieces for flexible 
instrumentation.

PREREQUISITE
You have created the layouts whose transposition you want to override, and assigned the 
required players and flows to them.

PROCEDURE

1. In Setup mode, in the Layouts panel, right-click the layout whose transposition you want to 
override.

2. In the action bar, click Layout Settings  and choose Clef and Transposition Overrides to 
open the Clef and Transposition Overrides dialog.

TIP

You can also right-click layouts and choose this option from the context menu.

3. In the table, select the instrument whose transposition you want to override.

4. Activate Written middle C sounds as in the following sections, individually or together:

● Transposed pitch

● Concert pitch

5. Change the pitch in the value fields.

NOTE

For Transposed pitch, you can specify any pitch. For Concert pitch, you can only specify the 
sounding octave of middle C.

6. Optional: Repeat steps 3 to 5 for other instruments in the layout whose transposition you 
want to override.

7. Click OK to save your changes and close the dialog.

RESULT
The transposition for the selected instruments is changed in the selected layout. Key signatures 
are automatically updated when the layout is set to transposed pitch.

AFTER COMPLETING THIS TASK
You can rename the selected layouts; for example, to ensure the correct transposition is 
included.

RELATED LINKS
Layouts panel (Setup mode) on page 118
Creating layouts on page 171
Duplicating layouts on page 174
Assigning players to layouts on page 171
Assigning flows to layouts on page 172
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Copying part formatting to other layouts on page 765
Adding players on page 125
Renaming layouts on page 184
Key signatures on page 1210

Removing layout clef/transposition overrides
You can remove all clef/transposition overrides from individual instruments in each layout 
independently.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout whose clef/transposition overrides 
you want to remove.

2. In the action bar, click Layout Settings  and choose Clef and Transposition Overrides to 
open the Clef and Transposition Overrides dialog.

TIP

You can also right-click layouts and choose this option from the context menu.

3. In the table, select the instrument whose clef/transposition overrides you want to remove.

4. Click Remove Overrides  in the action bar.

5. Optional: Repeat steps 3 and 4 for other instruments in the layout whose clef/transposition 
overrides you want to remove.

6. Click OK to save your changes and close the dialog.

RESULT
All clef/transposition overrides are removed from the selected instruments in the selected layout.

Player, layout, and instrument names
In Dorico Pro, you can use three different names to refer to the same player in different contexts. 
This allows you to show relevant information in different places, such as in staff labels and at the 
top of part layouts.

The following names relate to players and instruments:

Player name
The name of each player in the Players panel. They can be used in staff labels 
instead of instrument names. You can refer to player names in text frames using the 
{@playernames@} token.

Player names are automatically generated when you add instruments, and are linked 
to the corresponding instrument names until you rename the player.

Layout name
The name for each layout in the Layouts panel. By default, layout names appear with 
borders at the top of pages in part layouts that use the First page template. You can 
refer to the layout name in text frames using the {@layoutname@} token.

Layout names for part layouts are automatically generated when you add instruments 
to the corresponding players, and are linked to the corresponding players’ names until 
you rename the layout.
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Instrument names
Used in staff labels by default. This means that the instrument label on each 
staff is relevant to the instrument or percussion kit currently being played by that 
player, rather than listing all instruments that player is playing in the flow. You 
can refer to instrument names in text frames using the {@stafflabelsfull@} and 
{@stafflabelsshort@} tokens.

For example, if a clarinettist is doubling bass clarinet, the staff label where the player 
plays clarinet automatically shows Clarinet, and the staff label automatically shows 
Bass Clarinet where the player plays bass clarinet.

All instruments in Dorico Pro come with a set of instrument names that you can change 
for individual instruments, independently of other players in the project holding the 
same instrument. You can change the language used for instrument names. You can 
also save changes to instrument names as default, which are then used whenever you 
add that instrument again in the current project and all future projects.

NOTE

● Changing the default instrument names does not change the instrument names of 
existing instruments of that type in your project.

● You can change various aspects of how instrument names appear in staff labels 
without changing instrument names, such as whether instrument transpositions 
are shown before or after instrument names.

● Abbreviated instrument names are used in player labels on condensed staves 
containing instruments with different instrument names.

RELATED LINKS
Instrument numbering on page 132
Page templates on page 527
Types of page templates on page 532
Tokens on page 576
Staff labels on page 1531
Instrument transpositions in staff labels on page 1536
Numbering instruments with different transpositions separately/together on page 1539
Showing instrument/player names in staff labels on page 1536
Hiding/Showing borders on layout names on page 1192
Percussion legends on page 1696
Players on page 124
Layouts on page 169
Assigning players to layouts on page 171
Changing instrument names on page 184
Renaming player groups on page 164
Changing the language for instrument names on page 60
Adding player lists on page 1190
Player labels on page 760

Renaming players
You can change the player names of players, and reset renamed players to their default names. 
Player names appear in guide instrument labels in galley view for players holding multiple 
instruments and can appear in staff labels. Player names also appear in player lists.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to rename.
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2. In the action bar, click Player Settings  and choose Rename Player to open the Rename 
Player dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Enter new names or edit the existing names in the following fields:

● Full name

● Short name

4. Click OK to save your changes and close the dialog.

RESULT
The corresponding names for the selected player are changed. If you have not already renamed 
the corresponding part layout, its layout name is updated.

NOTE

● This does not affect staff labels that show instrument names, or the name at the top of 
part layouts if you have already renamed the layout. You can change instrument and layout 
names separately.

● Player names you have changed no longer get updated when you change the instruments or 
names of instruments held by the player.

RELATED LINKS
Players panel on page 111
Tokens on page 576
Changing instrument names on page 184
Renaming player groups on page 164
Moving instruments on page 141
Staff labels on page 1531
Showing instrument/player names in staff labels on page 1536
Switching to galley/page view on page 53
Adding player lists on page 1190

Resetting player names
You can reset both full and short player names to their defaults simultaneously. Default player 
names automatically update when you change the instruments or names of instruments held by 
the player.

PROCEDURE

1. In Setup mode, in the Players panel, select the player whose names you want to reset.

2. Press Return  to open the player name text field.

3. Click Reset to Default .

RESULT
Both the full and short names for the corresponding player are reset to their defaults.
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Renaming layouts
You can rename layouts and reset renamed layouts to their default name. For example, to 
include the appropriate instrument transposition for layouts with transposition overrides. By 
default, layout names appear with borders at the top of pages in part layouts that use the First 
page template.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout you want to rename.

2. Press Return  to open the layout name text field.

3. Rename the layout in any of the following ways:

● Enter a new layout name or edit the existing name.

● To revert the layout name to the player name, click Reset to Default .

TIP

If you want to include an accidental in the instrument transposition, you can enter the 
appropriate token, such as {@flat@} for ♭.

4. Press Return .

RESULT
The selected layout is renamed, or reverted to its default name.

NOTE

● Renaming layouts does not affect staff labels, which show either instrument or player 
names.

● Part layout names you have changed no longer get updated when you rename the 
corresponding players.

RELATED LINKS
Player, layout, and instrument names on page 181
Layouts panel (Setup mode) on page 118
Tokens on page 576
Page templates on page 527
Types of page templates on page 532
Hiding/Showing borders on layout names on page 1192
Layouts with clef/transposition overrides on page 176
Overriding the transposition for layouts on page 180
Staff labels on page 1531
Staff label contents on page 1535

Changing instrument names
By default, instrument names are used in staff labels and instrument change labels shown above 
the staff. You can change the different instrument names used for each instrument.

NOTE

● If you want to change instrument names because you want them to appear in a different 
language, you can instead change the default language for all instrument names.
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● You can change various aspects of how instrument names appear in staff labels without 
changing instrument names, such as whether instrument transpositions are shown before 
or after instrument names.

● Changing instrument names does not change the name shown at the top of part layouts if 
you have already renamed the layout. You can rename layouts separately.

PROCEDURE

1. In Setup mode, in the Players panel, click the disclosure arrow in the card of the player 
holding the instrument whose names you want to change.

This expands the card to show the instruments held by the player.

2. In the instrument label, click the instrument menu  and choose Edit Names to open the 
Edit Instrument Names dialog.

3. Enter new names in any of the name fields.

4. Optional: Activate Save as default for instrument.

5. Click OK to save your changes and close the dialog.

RESULT
The instrument names for the selected instrument are changed. If you have not already renamed 
the corresponding player, its player name is updated.

● If you did not save your changes as default, only the names of the selected instrument are 
changed. Any instruments of the same type added later or in future projects use the original 
default names.

● If you saved your changes as default, any instruments of the same type added later 
or in future projects use your new instrument names. This does not affect any existing 
instruments of that type unless you reset their names.

RELATED LINKS
Players panel on page 111
Instruments on page 131
Instrument changes on page 134
Instrument numbering on page 132
Player, layout, and instrument names on page 181
Staff labels on page 1531
Showing instrument/player names in staff labels on page 1536
Changing the appearance/position of instrument transpositions in staff labels on page 1538
Changing the language for instrument names on page 60
Editing the default instrument change label text on page 135

Edit Instrument Names dialog
The Edit Instrument Names dialog allows you to change the content and formatting of each 
instrument’s names, which are used in staff labels and instrument change labels shown above 
the staff. You can edit both singular/plural full instrument names and singular/plural short 
instrument names.

● You can open the Edit Instrument Names dialog in Setup mode by clicking the instrument 
menu  in an instrument label in the Players panel and choosing Edit Names.
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The Edit Instrument Names dialog contains the following options and sections:

1 Editing instrument

Displays the permanent underlying name of the instrument.

2 Editing

Allows you to switch between editing the Singular names and Plural names of the selected 
instrument.

Singular names are used when the staff contains one player, Plural names are used when 
the staff contains multiple players.

3 Full name section

Contains options that allow you to edit the appearance of the full instrument name.

4 Full name text editor options

Allows you to customize the font, size, and formatting of the selected part of the full 
instrument name.

5 Full name text editing area

Shows the current long name for the selected instrument, as it appears in Full staff labels. 
You can select any part of the instrument name and edit it independently of other parts; for 
example, if you want to add additional information on a new line and in italics. However, 
instrument names in instrument change labels are always shown on a single line.

Staff labels are right-aligned by default, so appear at the right edge of the text editing area.

6 Short name section

Contains options that allow you to edit the appearance of the short instrument name.

7 Short name text editor options
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Allows you to customize the font, size, and formatting of the selected part of the short 
instrument name.

8 Short name text editing area

Shows the current short staff label for the selected instrument, as it appears in Abbreviated 
staff labels. You can select any part of the instrument name and edit it independently of 
other parts; for example, if you want to add additional information on a new line and in 
italics. However, instrument names in instrument change labels are always shown on a 
single line.

Staff labels are right-aligned by default, so appear at the right edge of the text editing area.

9 Show transposition

Allows you to choose when the transposition is shown in the instrument name for the 
selected instrument. It is common to see the transposition included in the name of 
transposing instruments, such as Clarinet in B♭.
You can choose when the transposition is shown from the following options:

● Always: Instrument transpositions are shown even if you have chosen to hide them on 
the Staves and Systems page in Layout Options.

● Follow Layout Options: Instrument transpositions can be hidden and shown, 
depending on your per-layout settings in Layout Options.

● Never: Instrument transpositions are never shown, even if you have chosen to show 
them in Layout Options.

10 Save as default for instrument

Activating the checkbox saves your changes in the dialog as the default. This affects all new 
instruments of that type that you add to the project and all future projects. It does not affect 
any existing instruments of that type unless you reset their names.

11 Reset to Default

Removes all your changes to the names of the selected instrument type and reverts them to 
the current default settings. If you changed the default name for an instrument type or the 
instrument name language setting after adding an instrument, resetting its names changes 
them to your new default names and language setting.

NOTE

Staff labels always use the horizontal alignment set for the paragraph style, they do not use the 
alignment set in the Edit Instrument Names dialog. This ensures consistent alignment across 
the whole system.

RELATED LINKS
Layout Options dialog on page 834
Paragraph Styles dialog on page 848
Changing the language for instrument names on page 60
Resetting instrument names on page 188
Staff labels on page 1531
Staff label paragraph styles on page 1544
Hiding/Showing staff labels on page 1532
Text editor options in Write mode on page 389
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Resetting instrument names
You can reset all your changes to the names of individual instruments and revert them to the 
current default settings for their instrument type.

NOTE

Resetting instrument names does not change the name shown at the top of part layouts. If you 
want to change the name used at the top of part layouts, rename the layout.

PROCEDURE

1. In Setup mode, in the Players panel, click the disclosure arrow in the card of the player 
holding the instrument whose names you want to reset.

This expands the card to show the instruments held by the player.

2. In the instrument label, click the instrument menu  and choose Edit Names to open the 
Edit Instrument Names dialog.

3. Click Reset to Default.

4. Click OK to save your changes and close the dialog.

RESULT
The instrument names for the selected instrument are reset to the current default settings for 
its instrument type. If you changed the default name for the instrument type or the instrument 
name language setting after adding the instrument, resetting its names changes them to your 
new default names and language setting.

TIP

You can assign a key command for Reset Instrument Names on the Key Commands page in 
Preferences, which resets all instrument names in the project to their default settings.

RELATED LINKS
Players panel on page 111
Key Commands page in the Preferences dialog on page 63
Renaming layouts on page 184
Changing the language for instrument names on page 60

Flow names and flow titles
Whenever you add a flow to a project, the default name of a flow is Flow plus an incremental 
number. In Dorico Pro, flows have both a flow name and a flow title, which are the same by 
default but can be different if, for example, you want to organize sketch versions of flows without 
affecting their displayed titles in the music.

Flow names
Set either in the Flows panel in Setup mode or in the flows list in the Project Info 
dialog.

Flow titles
Set in the Title field for each flow in the Project Info dialog.

Flow titles automatically match the flow name until you change the flow title independently. 
Changing flow titles removes the link between their flow title and flow name.
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Titles shown in layouts are linked to the Title fields in the Project Info dialog, using the 
{@projectTitle@} and {@flowTitle@} tokens. This allows you to organize flows with different 
names to their displayed title in the music.

TIP

You can change both flow names and flow titles in the Project Info dialog, and you can also 
change flow names in the Flows panel in Setup mode.

RELATED LINKS
Tokens on page 576
Project Info dialog on page 78
Flows panel on page 121

Renaming flows
You can change the names of flows in Setup mode. This automatically updates the title of the 
corresponding flow until you change the title in the Project Info dialog.

PROCEDURE

1. In Setup mode, in the Flows panel, double-click the card of the flow you want to rename to 
open the flow name text field.

2. Enter a new name for the flow or edit the existing name.

3. Press Return .

RESULT
The name of the flow is changed. If you have not entered a different title for the flow in the 
Project Info dialog, the title shown in the music area is updated to match the new flow name.

TIP

You can also rename flows in the Project Info dialog.

RELATED LINKS
Flows panel on page 121

Changing flow titles
You can change flow titles in the Project Info dialog. Once you have done so, flow titles are no 
longer automatically changed if you change their flow name.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

2. Select the flow whose title you want to change in the flows list.

3. Enter a new title in the Title field.

4. Optional: Repeat steps 2 and 3 for other flows in your project.

5. Click OK to save your changes and close the dialog.

RESULT
The titles of the selected flows are changed.
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NOTE

This breaks the link between flow names and the title shown in the music area.

RELATED LINKS
Project Info dialog on page 78

Videos
Dorico Pro supports the use of videos within the program as well as the associated notations, 
such as markers and timecodes, and allows you to find appropriate tempos based on where 
important markers occur.

Videos are a fast sequence of images that create the impression of a moving image. They can be 
any length, from only a few seconds up to several hours for feature-length films.

Videos in Dorico Pro are shown in a separate Video window and play back in sync with the music. 
Any existing audio in the video is also played back, and you can control the volume of this audio 
independently of the volume of the music.

TIP

You can use these features, including setting a project frame rate, without having a video 
attached.

RELATED LINKS
Adding videos on page 192
Frame rates on page 195
Timecodes on page 1435
Markers on page 1430
Changing the volume of video audio on page 194

Supported video formats
Dorico Pro uses the same video engine that was introduced in Cubase and Nuendo in 2017. It 
supports the most commonly-used video formats.

The following video formats are supported:

● MOV: Including H263, H264, Apple ProRes, DV/DVCPro and Avid DNxHR codecs

● MP4: Including H263 and H264

● AVI: Including DV/DVCPro and MJPEG/PhotoJPEG

All the common frame rates, such as 23.976, 24, 24.975, 25, 29.97, and 30 frames per second, are 
fully supported in Dorico Pro.

NOTE

● Videos with variable frame rates are not supported.

● Support for more formats is planned for future versions.

You can consult the Steinberg support site for more information about the supported formats as 
well as how to identify and change video formats.
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RELATED LINKS
Frame rates on page 195

Video Properties dialog
The Video Properties dialog allows you to change video-related settings, including their frame 
rate and start position.

● You can open the Video Properties dialog in Setup mode by right-clicking a flow in the 
Flows panel and choosing Video > Properties from the context menu.

It also opens automatically when you add a new video.

The Video Properties dialog contains the following fields and options:

Video file
Shows the location of the video file on your computer. This field is read-only.

Video frame rate
Shows the frame rate of the video file. This field is read-only.

Project frame rate
Allows you to select a frame rate for your project from the menu. You can only have a 
single frame rate across the project.

Use video frame rate
Sets the project frame rate to be the same as the video file.

Flow attachment position
Allows you to set the rhythmic position at which the video attaches. This is set using 
the Beat count and Beat unit settings in combination, such as eight dotted quarter 
notes.

Video start offset
Allows you to set a position within the video that syncs with the flow attachment 
position; for example, you can set the fifth second of the video to attach to the start of 
the third bar.

Timecode start
Allows you to set the timecode at the start of the video. This also affects the timecode 
of the flow, but the initial timecode of the flow adjusts to accommodate the video. For 
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example, if the initial timecode of the video is 02:00:00:00 but the video does not start 
until the start of the third bar in 4/4, the initial timecode of the flow is eight beats of 
time less than 02:00:00:00; if the tempo is 60 bpm, this makes the initial flow timecode 
01:59:52:00.

NOTE

Flow timecodes are shown in their flow cards in the Flows panel.

RELATED LINKS
Timecodes on page 1435
Flows panel on page 121

Adding videos
You can add a video to each flow in your project. You can also follow these steps to reload videos 
previously added to the project that Dorico Pro can no longer locate.

Flows with missing videos show a warning icon  instead of the video icon in the flow card in the 
Flows panel. This can happen if you send a project to someone else without the video file.

PREREQUISITE
You have added at least one player to the project.

PROCEDURE

1. In Setup mode, in the Flows panel, right-click the flow to which you want to add/reload a 
video and choose Video > Attach from the context menu to open the File Explorer/macOS 
Finder.

2. Locate and select the video file you want to add.

3. Click Open to open the Video Properties dialog.

4. Change the settings as required.

5. Click OK to save your changes and close the dialog.

RESULT
The selected video file is added to the flow and is shown in the Video window. A video reel icon 
appears in the flow card in the Flows panel, beside a timecode indicating the combination of the 
Video start offset and Timecode start.

If you reloaded a video, all your previous settings are retained.

RELATED LINKS
Flows panel on page 121
Adding players on page 125
Timecodes on page 1435
Changing the initial timecode value on page 1436
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Changing the start position of videos
You can change both the rhythmic position in the music at which videos start, and the position in 
the video that coincides with that rhythmic position; for example, if you want the fifth second of a 
video to sync with the start of the third bar of music.

PROCEDURE

1. In Setup mode, open the Video Properties dialog in one of the following ways:

● Add a video to a flow.

● In the Flows panel, right-click a flow and choose Video > Properties from the context 
menu.

2. Change the values for the following options, individually or together:

● Flow attachment position

● Video start offset

3. Click OK to save your changes and close the dialog.

RESULT
Changing the value for Flow attachment position changes the rhythmic position in the music at 
which the video starts.

Changing the value for Video start offset changes the position in the video that occurs at the 
Flow attachment position.

For example, if you change the Video start offset to 00:00:05:00 and the Flow attachment 
position to 8, then the fifth second in the video happens on the eighth beat in the music.

NOTE

● The initial rhythmic position is 0. Therefore, if the Flow attachment position is set to 8 and 
the time signature is 4/4, the flow attachment occurs on the first beat in the third bar.

● Changing the Video start offset changes what part of the video coincides with the Flow 
attachment position, but this does not cut the video before this point. Any preceding video 
material is shown as long as it happens within the flow.

Hiding/Showing the Video window
You can hide and show the Video window at any time and in any mode; for example, if you do 
not want it in view when working on the music in the music area.

PROCEDURE

● Hide/Show the Video window in any of the following ways:

● Press F4 .

● In the toolbar, click Show Video .

● Choose Window > Video.

RELATED LINKS
Toolbar on page 33
Markers track on page 626
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Changing the size of the Video window
You can change the size of the Video window at any time.

PREREQUISITE
The Video window is shown.

PROCEDURE

● Change the size of the Video window in any of the following ways:

● Click and drag the corners/edges in any direction.

● Shift -click and drag a corner/edge to change the size without changing the shape.

RESULT
The size of the Video window is changed. Dorico Pro saves the new size and shape and uses this 
for all projects until you change the size again.

Removing videos
You can remove videos from each flow independently.

PROCEDURE

● In Setup mode, in the Flows panel, right-click the flow from which you want to remove a 
video and choose Video > Detach from the context menu.

RESULT
The video is removed from the selected flow.

RELATED LINKS
Flows panel on page 121

Changing the volume of video audio
Any audio that is part of a video you have added is played back in sync with the music in the 
project. You can change the video volume manually.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. Optional: If the Video channel is not shown in the Mixer, click Video in the Mixer toolbar.

2. Do one of the following:

● To change the volume of video audio, click and drag the Video channel fader upwards/
downwards.

● To mute video audio, click Mute  in the Video channel.

RESULT
The volume of audio from videos in your project is changed.
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RELATED LINKS
Mixer panel on page 821
Mixer window on page 822
Muting/Soloing tracks on page 638
Deactivating mute/solo instrument states on page 639

Frame rates
The frame rate of a video is the number of still images that are used per unit of time in order to 
create the impression of a moving image, commonly measured in frames per second, or “fps”.

The number of frames per second required to create the impression of a moving image is 
determined by how fast the human eye processes movement, and so the most common frame 
rate is around 24 fps. However, recent major films have been released at 48 fps, which results in 
sharper images.

Dorico Pro supports frame rates from 23.976 fps to 60 fps. For example, the US and Canadian 
broadcast standard NTSC uses 29.97 fps.

Frame rates are closely linked to timecodes, as timecodes include both the time and the current 
frame position.

All the common frame rates, such as 23.976, 24, 24.975, 25, 29.97, and 30 frames per second, are 
fully supported in Dorico Pro.

By default, Dorico Pro uses the same frame rate for the project as the video file, but you can 
manually choose a different frame rate.

RELATED LINKS
Timecodes on page 1435

Changing the project frame rate
By default, Dorico Pro uses the video frame rate as the project frame rate. You can change the 
project frame rate if you want it to be different; for example, if your project contains multiple 
videos with different frame rates.

TIP

You can change the frame rate even if there are no videos in the project.

PROCEDURE

1. In Setup mode, open the Video Properties dialog in one of the following ways:

● Add a video to a flow.

● In the Flows panel, right-click a flow and choose Video > Properties from the context 
menu.

2. Select the frame rate you want to use for the project from the Project frame rate menu.

3. Click OK to save your changes and close the dialog.

RESULT
The project frame rate is changed.
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Write mode

Write mode allows you to input and edit your music, including changing the rhythmic positions 
of items, changing the pitch of notes, and deleting notes and items. The available toolboxes and 
panels allow you to input all the notes and notation items that are most commonly used.

By design, you cannot move notes and items graphically in Write mode. Graphical adjustments 
are only possible in Engrave mode.

Project window in Write mode
The project window in Write mode contains toolboxes and panels with the tools and functions 
required to write your music.

You can switch to Write mode in any of the following ways:

● Press Ctrl/Cmd-2 .

● In the toolbar, click Write.

● Choose Window > Write.

The following zones and toolboxes are available in Write mode:

1 Notes toolbox

Contains tools that affect note input and editing.

2 Left zone

Contains the Notes panel. The Notes panel provides the note durations, accidentals, and 
articulations that are most commonly used during note input.

3 Right zone
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Can display different panels, according to the current selection in the Notations toolbox. 
Panels in the right zone contain notation items that you can add to your music, such as 
dynamics and playing techniques, divided into separate categories.

4 Notations toolbox

Contains either panel or popover buttons, depending on whether Panels  or Popovers 
is active.

Allows you to show panels for different notations in the right zone, open popovers, and input 
certain items directly, such as rehearsal marks and text.

5 Lower zone

Can display different panels, according to the current selection in the lower zone toolbar. 
Panels in the lower zone include the Properties panel, which allows you to make individual 
modifications to the currently selected notes and notations, and the Keyboard panel, which 
allows you to input notes.

RELATED LINKS
Lower zone (Write mode) on page 206
Properties panel on page 769
Mixer panel on page 821
Copying property settings to other layouts/frame chains on page 768

Notes toolbox
The tools in the Notes toolbox allow you to start note input, modify notes, and change the type 
and scope of notes you input. The Notes toolbox is located on the left of the window in Write 
mode.

Show Left Zone

Hides/Shows the left zone.

Select

Activates/Deactivates mouse input. When Select is activated, mouse input is 
deactivated and you cannot input notes by clicking on the staff.

TIP

You can assign a key command for Disable Mouse Input on the Key Commands page 
in Preferences.

Start Note Input

Starts/Stops note input by showing/hiding the caret. If a note, rest, or item is selected 
in the music area, note input starts at the selected rhythmic position. If nothing is 
selected in the music area, note input starts at the earliest rhythmic position on the top 
staff in view.

Pitch Before Duration
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When this option is activated, you can select the pitch before specifying the duration 
during note input. This allows you to experiment with pitches without having to stop 
note input because you only input the note when you specify the duration.

You can also activate/deactivate Pitch Before Duration by pressing K .

Chords

Allows you to add multiple notes at the same rhythmic position in order to build a 
chord during note input. This function prevents the caret from advancing automatically 
after inputting a note. Chord mode also affects some edits outside of note input, such 
as copying/pasting notes and items without overwriting existing material.

You can also start/stop chord input by pressing Q .

Insert

Allows you to insert notes before existing notes in the current voice ahead of the caret, 
instead of overwriting them, during note input. Insert mode also affects some edits 
outside of note input, such as deleting notes or changing their duration. For example, 
reducing the duration of notes with Insert mode activated pulls them closer together 
without leaving rests between the notes.

When inputting or changing time signatures, Insert mode instructs Dorico Pro to add 
any extra beats required to fill bars.

You can click and hold or right-click Insert to access the following options:

● Voice : Insert mode only affects the selected voices.

● Player : Insert mode affects all voices and instruments belonging to the selected 
players.

● Global : Insert mode affects all players in the flow.

● Global Adjustment of Current Bar : Insert mode affects all players in the flow, 
changes the duration of the current bar, and updates its time signature to reflect 
its new duration.

You can also activate/deactivate Insert mode by pressing I . You can cycle through the 
different Insert mode scopes by pressing Alt/Opt-I .

Lock to Duration

Allows you to maintain the duration of notes while you change their pitches. Only 
available during note input.

You can also activate/deactivate Lock to Duration by pressing L .

Force Duration

Allows you to input notes/rests with the explicit duration you have selected during note 
input, and fixes the current notated duration of existing notes outside of note input. 
For example, you can activate Force Duration to force the input of a dotted quarter 
note on the second quarter beat of 4/4, where Dorico Pro splits the note with a tie by 
default.
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IMPORTANT

You can get unexpected results if you force the duration of notes and later change the 
time signature or move barlines, for example.

You can remove Force Duration from selected notes by resetting their appearance.

You can also activate/deactivate Force Duration by pressing O .

Create Voice

Allows you to create a new voice on the current staff into which you can input notes 
during note input. Outside of note input, Create Voice allows you to change the voice 
of existing notes.

You can click and hold or right-click Create Voice to access the following options:

● Create Voice : Creates a new voice on the current staff. You can also use the key 
command Shift-V .

● Create Slash Voice : Creates a new slash voice with each click. For example, 
the third new slash voice is stemless. You can also use the key command Shift-Alt/
Opt-V .

● Next Voice : Cycles through active voices on the staff. You can also use the key 
command V .

Dotted Notes

Allows you to input dotted notes/rests based on the currently selected duration during 
note input. Outside of note input, Dotted Notes allows you to add rhythm dots to, and 
remove rhythm dots from, existing notes/rests.

You can click and hold or right-click Dotted Notes to access the following options:

● One Rhythm Dot : Inputs notes/rests with one rhythm dot during note input. 
Adds one rhythm dot to selected existing notes/rests outside of note input.

● Two Rhythm Dots : Inputs notes/rests with two rhythm dots during note input. 
Adds two rhythm dots to selected existing notes/rests outside of note input.

● Three Rhythm Dots : Inputs notes/rests with three rhythm dots during note 
input. Adds three rhythm dots to selected existing notes/rests outside of note 
input.

● Four Rhythm Dots : Inputs notes/rests with four rhythm dots during note input. 
Adds four rhythm dots to selected existing notes/rests outside of note input.

You can also activate/deactivate Dotted Notes by pressing . . You can cycle through 
the different numbers of rhythm dots by pressing Alt/Opt-. .

Rests

Allows you to input rests of the currently selected duration instead of notes.

You can also start/stop rest input by pressing , .
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NOTE

If Force Duration is not activated, Dorico Pro automatically combines adjacent rests as 
appropriate for their position in relation to notes and according to the current meter.

Tuplets

Inputs a triplet based on the currently selected note duration at the caret position or at 
the selected rhythmic position.

You can click and hold or right-click Tuplets to access the following options:

● 2:3 : Inputs a duplet; that is, two notes in the space of three.

● 3:2 : Inputs a triplet; that is, three notes in the space of two.

● 4:3 : Inputs a quadruplet; that is, four notes in the space of three.

● 5:4 : Inputs a quintuplet; that is, five notes in the space of four.

● 6:4 : Inputs a sextuplet; that is, six notes in the space of four.

● 7:8 : Inputs a septuplet; that is, seven notes in the space of eight.

● x:y : Opens the tuplets popover, into which you can enter any tuplet ratio.

Grace Notes

Allows you to input grace notes instead of normal notes at the caret position. Only 
available during note input.

You can click and hold or right-click Grace Notes to access the following options:

● Unslashed Grace Notes : Selects unslashed grace notes.

● Slashed Grace Notes : Selects slashed grace notes.

You can also start/stop grace note input by pressing / . You can switch between 
slashed/unslashed grace notes by pressing Alt/Opt-/ .

Tie

During note input, this ties the next note you input to the previous note of the same 
pitch, in the same voice, and on the same staff. Outside of note input, you can use this 
tool to tie together notes of the same pitch in different voices or to tie grace notes to 
rhythmic notes.

You can also activate Tie by pressing T .

NOTE

You cannot deactivate Tie. If you want to delete ties, you must use Scissors.

Scissors

Splits notes and explicit rests in two at the caret position during note input. Outside of 
note input, it deletes all ties in tie chains.

You can also activate Scissors by pressing U .

Write mode
Project window in Write mode 

200
Dorico Pro 4.3.30



RELATED LINKS
Key Commands page in the Preferences dialog on page 63
Activating/Deactivating mouse input on page 229
Inputting notes with rhythm dots on page 229
Inputting chords on page 251
Inputting grace notes on page 250
Inputting tuplets on page 254
Tuplets popover on page 256
Input methods for time signatures and pick-up bars on page 284
Resetting the appearance of items on page 442

Notes panel
The Notes panel contains buttons that allow you to select note and rest durations, and to input 
accidentals, slurs, and articulations. It is located on the left of the window in Write mode.

You can hide/show the Notes panel in any of the following ways:

● Press Ctrl/Cmd-7 .

● In the toolbox on the left, click Show Left Zone .

● Choose Window > Show Left Zone.

The upper part of the Notes panel contains note durations that you can select for input or to 
change the duration of existing notes. By default, only the most common note durations are 
shown. You can see all note durations by clicking the Show/Hide All Notes disclosure arrows at 
the top and bottom of the section.

In the middle part of the Notes panel, you can activate/deactivate accidentals and activate slurs.

In the bottom part of the Notes panel, you can activate/deactivate articulations.

RELATED LINKS
Inputting notes on page 221
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Inputting accidentals on page 244
Inputting articulations on page 271
Inputting slurs on page 273
Inputting nested slurs on page 1517
Deleting notes/items on page 459
Deleting accidentals on page 943
Deleting articulations on page 955

Notations toolbox
The Notations toolbox allows you to access panels and popovers, which you can use to input the 
different notations available. It is located on the right of the window in Write mode.

Panels

Allows you to access panels from the Notations toolbox. Panels allow you to input 
notations by clicking them in the panel.

Popovers

Allows you to access popovers from the Notations toolbox. Popovers allow you to input 
notations by typing entries on your computer keyboard. Popovers open above the top 
staff on which the caret is active or an item is selected, and at the caret position or the 
rhythmic position of the earliest selected item.

NOTE

Popovers are only available during note input or when at least one note/item is 
selected in the music area.

Panel buttons

Clefs

Hides/Shows the Clefs panel, which contains sections for clefs and octave lines.

Key Signatures, Tonality Systems, and Accidentals

Hides/Shows the Key Signatures, Tonality Systems, and Accidentals panel, which 
contains sections for key signatures, tonality systems, and accidentals. You can also 
create and edit custom tonality systems from this panel.

Time Signatures (Meter)

Hides/Shows the Time Signatures (Meter) panel, which contains sections for the 
different types of time signatures, including a section where you can create custom 
time signatures, such as interchangeable time signatures and time signatures with 
pick-up bars.

Tempo
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Hides/Shows the Tempo panel, which contains sections for the different types of tempo 
changes, including gradual tempo changes, metronome marks, and tempo equations.

Dynamics

Hides/Shows the Dynamics panel, which contains sections for the different types of 
dynamics, including immediate, gradual, and custom combined dynamics.

Ornaments

Hides/Shows the Ornaments panel, which contains sections for ornaments, arpeggio 
signs, glissando lines, and guitar techniques.

Repeat Structures

Hides/Shows the Repeat Structures panel, which contains sections for the different 
types of repeat structures, including repeat endings and segments, repeat markers, 
single-note and multi-note tremolos, bar repeats, and slash regions.

Bars and Barlines

Hides/Shows the Bars and Barlines panel, which contains sections for bars, bar rests, 
and barlines.

Holds and Pauses

Hides/Shows the Holds and Pauses panel, which contains sections for fermatas, breath 
marks, and caesuras.

Playing Techniques

Hides/Shows the Playing Techniques panel, which contains sections for the various 
instrument family groups. Each section contains playing techniques for the 
corresponding instrument family.

Lines

Hides/Shows the Lines panel, which contains sections for horizontal and vertical lines.

Cues

Hides/Shows the Cues panel, which allows you to find suitable places for cues and 
input cues.

Video

Hides/Shows the Video panel, which allows you to open the Video Properties dialog, 
view and edit markers in the current flow, and to calculate suitable tempos for 
important markers.

Write mode
Project window in Write mode 

203
Dorico Pro 4.3.30



Comments

Hides/Shows the Comments panel, which allows you to view, edit, and export 
comments in the current flow.

Popover and direct input buttons

Clefs

Opens the clefs and octave lines popover.

Key Signatures, Tonality Systems, and Accidentals

Opens the key signatures popover.

Time Signatures (Meter)

Opens the time signatures popover.

Tempo

Opens the tempo popover.

Dynamics

Opens the dynamics popover.

Ornaments

Opens the ornaments popover.

Repeat Structures

Opens the repeats popover.

Bars and Barlines

Opens the bars and barlines popover.

Holds and Pauses

Opens the holds and pauses popover.

Playing Techniques

Opens the playing techniques popover.
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Cues

Opens the cues popover.

Rehearsal Marks

Inputs a rehearsal mark.

Text

Opens the text editor for inputting text items.

Lyrics

Opens the lyrics popover.

Chord Symbols

Opens the chord symbols popover.

Note Tools

Opens the note tools popover.

Fingering

Opens the fingerings popover.

Figured Bass

Opens the figured bass popover.

RELATED LINKS
Project window in Write mode on page 196
Notations input on page 271
Note tools popover on page 498
Text editor options in Write mode on page 389
Video Properties dialog on page 191
Comment dialog on page 507

Right zone (Write mode)
The right zone in Write mode can display different panels for the available notation items, 
according to your selection in the Notations toolbox. You can use panels in the right zone to 
input notations. The right zone is located on the right of the window in Write mode.

You can hide/show the right zone in any of the following ways; for example, if you want to find a 
notation to input but then want to increase the size of the music area after inputting it:

● Press Ctrl/Cmd-9 .
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● In the Notations toolbox, click the button for any panel you want to show, or the active 
button for the panel you want to hide.

● Choose Window > Show Right Zone.

RELATED LINKS
Hiding/Showing zones on page 47
Clefs panel on page 332
Key Signatures, Tonality Systems, and Accidentals panel on page 280
Time Signatures (Meter) panel on page 287
Tempo panel on page 297
Dynamics panel on page 313
Ornaments panel on page 346
Repeat Structures panel on page 410
Bars and Barlines panel on page 305
Holds and Pauses panel on page 339
Playing Techniques panel on page 372
Lines panel on page 385
Cues panel on page 423
Video panel on page 403
Comments panel on page 507

Lower zone (Write mode)
The lower zone in Write mode can display different panels for inputting notes and editing notes/
items.

You can hide/show the lower zone in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

You can use the panel selectors in the top left of the lower zone to display the corresponding 
panel:

Properties

Shows the Properties panel, which allows you to edit individual notes and notations, 
such as by changing their appearance or position.

Keyboard

Shows the Keyboard panel, which allows you to input notes using a piano keyboard 
layout and displays the pitches of selected notes as depressed keys.

Fretboard

Shows the Fretboard panel, which allows you to input notes for fretted instruments 
using the corresponding fretboard layout for the selected instrument type.

Drum Pads
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Shows the Drum Pads panel, which allows you to input notes for unpitched percussion 
instruments using a drum pads layout.

Mixer

Shows the Mixer panel, which allows you to control the sounds produced in playback 
by instruments in the project, both for the master output and each individual 
instrument’s channel.

Key Editor

Shows the Key Editor panel, which allows you to view and edit notes belonging to the 
selected instrument in a continuous piano roll.

RELATED LINKS
Hiding/Showing zones on page 47
Properties panel on page 769
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Mixer panel on page 821
Key Editor panel on page 773
Note input on page 220
Notations input on page 271

Keyboard panel
The Keyboard panel allows you to input notes using a piano keyboard layout, and displays 
selected notes and sounding notes in playback as depressed keys with blue dots. It is located in 
the lower zone at the bottom of the window in Write mode.

During note input, the notes you press in the Keyboard panel are input. Outside of note input, 
Dorico Pro plays the notes you press using the instrument sounds of your most recent selection 
but does not input them.

● You can show the Keyboard panel by showing the lower zone, then clicking Keyboard  in 
the lower zone toolbar.

Between the toolbar and the keyboard, there is a keyboard range selector. The brighter keys 
indicate the keys shown in the panel. The shaded keys at each end of the range allow you to 
change the keys shown in the panel; for example, if you want to show fewer, wider keys.

The Keyboard panel toolbar contains the following options:

Advance Caret
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Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.

You can also advance the caret by pressing Space .

Delete Left

Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .

TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration

Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

Slur

Inputs a slur, starting from the currently selected note or spanning the selected notes. 
During note input, slurs extend automatically as you input notes.

You can also input slurs by pressing S .

Set Articulation

Allows you to activate/deactivate articulations, both for the next notes you input during 
note input and to add articulations to existing notes.

You can also activate/deactivate articulations by pressing the corresponding key 
command.

NOTE

Notes cannot have both accent and marcato articulations, or both staccato and tenuto 
articulations.

Respell Using Note Name Above

Respells the selected notes upwards to show the enharmonic equivalent using the note 
name above; for example, respelling F♯ as G♭.

Respell Using Note Name Below
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Respells the selected notes downwards to show the enharmonic equivalent using the 
note name below, such as respelling G♭ as F♯.

Resize Lower Zone

Allows you to change the height of the lower zone.

RELATED LINKS
Caret on page 215
Notes panel on page 201
Hiding/Showing zones on page 47
Inputting notes on page 221
Inputting chords on page 251
Deleting notes/items on page 459
Selecting note/rest durations on page 259
Inputting slurs on page 273
Inputting articulations on page 271
Respelling notes on page 484

Fretboard panel
The Fretboard panel allows you to input notes for fretted instruments using the corresponding 
fretboard layout for the selected instrument type, and displays the pitches of the earliest 
selected notes as stopped strings with blue dots. It is located in the lower zone at the bottom of 
the window in Write mode.

During note input, the notes you press in the Fretboard panel are input. Outside of note input, 
Dorico Pro plays the notes you press using the instrument sounds of your most recent selection 
but does not input them.

● You can show the Fretboard panel by showing the lower zone, then clicking Fretboard  in 
the lower zone toolbar.

The Fretboard panel toolbar contains the following options:

Advance Caret

Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.

You can also advance the caret by pressing Space .
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NOTE

When inputting notes using the Fretboard panel, the caret never advances 
automatically.

Delete Left

Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .

TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration

Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

RELATED LINKS
Caret on page 215
Notes panel on page 201
Hiding/Showing zones on page 47
Inputting notes on page 221
Inputting notes on tablature on page 242
Inputting chords on page 251
Deleting notes/items on page 459
Selecting note/rest durations on page 259
Fretted instrument tuning on page 142
Tablature on page 1580
Hiding/Showing notation staves and tablature on page 1582

Drum Pads panel
The Drum Pads panel allows you to input notes for unpitched percussion instruments using a 
drum pads layout. It is located in the lower zone at the bottom of the window in Write mode.

During note input, the notes you press in the Drum Pads panel are input. Outside of note input, 
Dorico Pro plays sounds for the instruments and techniques you press but does not input them.

● You can show the Drum Pads panel by showing the lower zone, then clicking Drum Pads 
in the lower zone toolbar.
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The Drum Pads panel toolbar contains the following options:

Advance Caret

Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.

You can also advance the caret by pressing Space .

Delete Left

Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .

TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration

Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

Reorder Drum Pads

Allows you to move drum pads in relation to each other; for example, to create a 
different arrangement for easier input in different circumstances.

Resize Lower Zone

Allows you to change the height of the lower zone.

RELATED LINKS
Caret on page 215
Notes panel on page 201
Hiding/Showing zones on page 47
Inputting notes for unpitched percussion on page 238
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Deleting notes/items on page 459
Selecting note/rest durations on page 259
Unpitched percussion on page 1682
Percussion kits and drum sets on page 1690
Percussion kit presentation types on page 1694
Voices in percussion kits on page 1701

Inputting vs. editing
Dorico Pro distinguishes the processes for inputting and editing music.

Inputting

If you can see the caret, you are inputting new music. The caret must be activated in order to 
input notes and notations. If the caret is activated, selecting tools or items in the Notes toolbox 
and the Notes panel affects the note or chord that you are about to input, as you can specify 
the duration, rhythm dot, accidentals, and articulations. Then you specify the pitch by clicking the 
note into the score, by pressing the letter name of the note on your computer keyboard, or by 
playing the note or chord on your MIDI keyboard.

When the caret is activated, notes and notations are input at the caret position.

If no notes or chords are selected in the music area and you select a duration, either by pressing 
its key command or by clicking it in the Notes panel, mouse input is activated. If you move the 
mouse pointer over the staff, a shadow note is displayed to indicate where the note will be input 
if you click.

NOTE

Deactivating mouse input prevents Dorico Pro from starting mouse input in this circumstance.

Editing

If you cannot see the caret, you can edit existing music. Editing music includes deleting notes 
and notations, which you can only do in Write mode, although you can also delete notes in the 
Key Editor. You can switch back and forth between inputting and editing at any time.

When the caret is not activated, new items are input at the position of the first selected item in 
the music area. If there is no selection, the mouse pointer is loaded with the new item. The item 
is then created at the location where you click.

To edit existing notes and notations, you must select them in the music area. This allows 
you to update the selected notes or items when you select, for example, new note durations, 
accidentals, or articulations in the Notes panel.

We recommend that you spend a moment to understand the difference between how Dorico Pro 
behaves if the caret is shown and if it is not. In the latter case, all editing functions operate on the 
items that you have selected in the music area.

NOTE

The results of some edits outside of note input, including copying/pasting notes, can be affected 
by Insert mode and Chord mode.

RELATED LINKS
Editing items on page 436
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Selecting notes/items on page 426
Caret on page 215
Note input on page 220
Notations input on page 271
Rhythmic grid on page 214
Insert mode on page 454
Chord mode on page 254
Key Editor on page 773

Mouse input settings
There are a number of different settings that you can choose from to determine how mouse 
input functions in Dorico Pro.

You can set your preferences for mouse input in the Editing section of the Note Input and 
Editing page in Preferences.

You can choose between the following options for mouse input:

● Create item at selection: Items are input at the position of selected items or notes in the 
music area.

● Load pointer with item: Items are loaded onto the mouse pointer so you can click in the 
music area where you want to input the item.

You can also activate/deactivate Allow multiple items to be created with the mouse. When 
this option is activated, you can load an item onto your mouse pointer and input the same item 
in the music area multiple times without having to reselect the item each time you input it. When 
this option is deactivated, you can only input an item loaded onto your mouse pointer once. If 
you want to input the item at multiple positions, you must reselect it each time.

NOTE

Changing your preferences permanently changes the functionality for the current project and all 
new projects.

RELATED LINKS
Preferences dialog on page 61

Changing your mouse input settings
You can change your mouse input settings; for example, if you want to load a playing technique 
on the pointer once and input it in multiple places without having to reselect the playing 
technique each time.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Editing section, choose one of the following options for Creating items with the 
mouse:

● Create item at selection

● Load pointer with item

4. Optional: If you chose Load pointer with item, activate/deactivate Allow multiple items to 
be created with the mouse.
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5. Click Apply, then Close.

RESULT
Your mouse input settings are changed in the current project and for all future projects.

RELATED LINKS
Notations input on page 271

Rhythmic grid
The rhythmic grid is a unit of rhythmic duration whose value affects certain aspects of inputting 
and editing, such as the amount by which items move. However, it does not control the duration 
of notes and items that you input.

Rhythmic grid set to eighth notes (quavers) shown above the staff

The current rhythmic grid resolution is shown by the note value in the status bar, and by ruler 
markings above the staff on which the caret is active. Longer lines in the rhythmic grid indicate 
beat divisions, while shorter lines indicate beat subdivisions.

The rhythmic grid controls the following:

● The possible input positions when using the caret or the mouse, and when copying and 
pasting. For example, setting the rhythmic grid resolution to 32nd notes allows you to input 
notes and items at a greater number of possible rhythmic positions than when the rhythmic 
grid is set to quarter notes.

● The amount by which the caret moves when using Right Arrow / Left Arrow .

● The amount by which notes and items are lengthened/shortened.

● The amount by which notes and items move.

● The duration by which notes are split.

RELATED LINKS
Rhythmic position on page 27
Caret on page 215
Moving the caret manually on page 220
Changing the Key Editor rhythmic grid resolution on page 780
Inputting notes on page 221
Splitting notes by duration on page 261
Changing music area colors on page 57

Changing the rhythmic grid resolution
You can change the resolution of the rhythmic grid; for example, you might decrease the 
rhythmic grid resolution so you can shorten notes by smaller increments. The resolution is 
indicated by the note value symbol in the status bar and by the beat divisions/subdivisions in the 
ruler markings above the caret.

The rhythmic grid resolution is set to eighth notes (quavers) by default.
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PROCEDURE

● Change the resolution of the rhythmic grid in any of the following ways:

● To decrease the rhythmic grid resolution, press Alt/Opt-] .

● To increase the rhythmic grid resolution, press Alt/Opt-[ .

● Choose Write > Rhythmic Grid > Decrease Grid Resolution.

● Choose Write > Rhythmic Grid > Increase Grid Resolution.

● Choose Write > Rhythmic Grid > [Beat division].

● Select a value from the Rhythmic Grid selector in the status bar.

RESULT
Decreasing the rhythmic grid resolution makes it finer by making the note value shorter. 
Increasing the rhythmic grid resolution makes it coarser by making the note value longer.

RELATED LINKS
Status bar on page 42
Changing the Key Editor rhythmic grid resolution on page 780
Changing the duration of notes on page 259
Lengthening/Shortening items on page 436
Moving notes/items rhythmically on page 465

Caret
In Dorico Pro, the caret is a vertical line that extends above and below five-line staves but 
appears shorter on percussion staves and tablature. It shows the rhythmic position at which 
notes, chords, or notation items are input, which can be partway through tie chains.

A caret is a mark that is commonly used when proofreading published text to denote the position 
at which something should be inserted or added; for example, a missing letter or a word. In 
software, the caret shows where something is inserted. The caret is also known as an “insertion 
point” or “cursor”. In this documentation, we use “caret” to refer to the line that appears during 
note input, and “cursor” to refer to the line that appears during text input.

If you are inputting notes, the caret advances to the next rhythmic position automatically. If you 
are inputting chords or notes on tablature, the caret does not move automatically, and you must 
move it to the next rhythmic position manually.

The caret has a note symbol beside it, which indicates the stem direction and type of the 
currently selected voice. It is accompanied by a + symbol if the voice is new.

The caret

The appearance of the caret changes depending on the input mode and the currently selected 
voice number.

Multiple staves
The caret extends vertically across all the staves onto which notes and notations will be 
input. This allows you to input, for example, the same dynamics or playing techniques 
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on multiple staves simultaneously or play in chords on a MIDI keyboard and distribute 
the notes in those chords onto multiple staves. The note symbol and rhythmic grid also 
appear for each included staff.

Caret when inputting notes onto multiple staves

Insert
The caret shows V and inverted V shapes at the top and bottom. Dotted lines are 
shown on staves affected by the Insert mode scope across which the caret does not 
already extend. In Insert mode, inserted notes shift existing notes after the caret along 
by the input duration instead of overwriting them.

Caret when Insert (Voice) is 
active

Caret when Insert (Player) 
is active

Caret when either Insert 
(Global) or Insert (Global 
Adjustment of Current Bar) 
is active

NOTE

Insert mode also affects some edits outside of note input, such as copying/pasting, 
deleting, and lengthening/shortening notes.

Chords
The caret shows a plus symbol at the top left. During chord input, you can input 
multiple notes at the same rhythmic position.
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Caret when inputting chords

NOTE

Chord mode also affects some edits outside of note input, such as copying/pasting and 
lengthening/shortening notes and items.

Lock to Duration
The caret is dashed. Lock to Duration allows you to repitch notes without changing 
their duration or rhythm.

Caret when Lock to Duration is activated

Grace Notes
The caret is shorter than the default caret. It allows you to input grace notes at the 
caret position.

Caret when inputting grace notes

Voices
To identify voices, the caret shows the following:

● An up-stem or down-stem note symbol to indicate the stem direction of the voice

● The voice number into which you are about to input notes, for second voices and 
above

● A plus symbol at the bottom left, if the voice is new

Caret when inputting notes 
into the first up-stem voice

Caret when inputting notes 
into a new down-stem voice

Caret when inputting notes 
into a new, second up-stem 
voice
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Slash voices
To identify slash voices, the caret shows the following:

● An up-stem or down-stem slash note symbol, indicating the stem direction of the 
slash voice, and whether it has stems or is stemless

● The number of the slash voice into which you are about to input notes, for second 
voices and above

● A plus symbol on the left at the bottom, if the slash voice is new

Caret when inputting notes 
into an up-stem slash voice

Caret when inputting notes 
into a new, second up-stem 
slash voice

Caret when inputting notes 
into a new, stemless slash 
voice

Percussion kits
The caret appears significantly smaller than usual when inputting notes into 
percussion kits. The name of the kit instrument into which you are currently inputting 
notes is shown above the rhythmic grid.

Caret when inputting notes into percussion kits

Tablature
The caret appears significantly smaller than usual when inputting notes into tablature. 
On tablature, the caret behaves as if chord input is always active, meaning you must 
advance the caret and move it to other string lines manually.

Caret when inputting notes on tablature

RELATED LINKS
Chord mode on page 254
Insert mode on page 454
Inputting chords on page 251
Inputting notes in Insert mode on page 237
Repitching notes without changing their rhythm on page 483
Inputting grace notes on page 250
Inputting notes into multiple voices on page 231
Inputting notes for unpitched percussion on page 238
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Inputting notes on tablature on page 242
Changing music area colors on page 57
Ties on page 1620
Splitting tie chains on page 1631
Splitting notes by duration on page 261

Activating/Deactivating the caret
When the caret is activated, you can input notes and notations at the caret position; for example, 
if you want to input a dynamic in the middle of a tie chain. When the caret is deactivated, you 
cannot input notes, instead you can select and edit items in the music area.

PROCEDURE

1. In Write mode, activate the caret and start note input in any of the following ways:

● Select an item and press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click a rhythmic position on a staff.

2. Deactivate the caret and stop note input in any of the following ways:

● Press Shift-N , Return , or Esc .

● If you have deactivated mouse input, click any selectable item in the music area.

● In the Notes toolbox, click Start Note Input .

● Switch to another mode.

RELATED LINKS
Moving the caret manually on page 220
Activating/Deactivating mouse input on page 229
Inputting notes on page 221
Notations input on page 271

Extending the caret to multiple staves
You can extend the caret so it spans multiple staves. This allows you to input notes and notations 
onto multiple staves simultaneously, including automatically exploding the notes in chords that 
you play on a MIDI keyboard onto the appropriate staves.

PROCEDURE

1. In Write mode, activate the caret in any of the following ways:

● Select an item and press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click a rhythmic position on a staff.

2. Extend the caret to other staves in any of the following ways:

● To extend to the staff above, press Shift-Up Arrow .

● To extend to the staff below, press Shift-Down Arrow .

3. Optional: Repeat step 2 as many times as you require.
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RELATED LINKS
Notes toolbox on page 197
Inputting notes and notations onto multiple staves on page 235

Moving the caret manually
During normal note input, the caret moves automatically as you input notes, but you can also 
move it manually. For example, the caret does not move automatically when inputting chords or 
when using the Fretboard panel.

PROCEDURE

● In Write mode, move the caret in any of the following ways:

● To move the caret according to the current rhythmic grid resolution or to the next/
previous note/rest, whichever is closest, press Right Arrow / Left Arrow .

● To advance the caret according to the note value currently selected, press Space  or click 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

● To move the caret to the staff above/below, press Up Arrow / Down Arrow .

● To move the caret to the top/bottom staff in the system, press Ctrl/Cmd-Up Arrow /
Ctrl/Cmd-Down Arrow .

RELATED LINKS
Inputting chords on page 251
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Rhythmic grid on page 214

Note input
In Dorico Pro, you can only input notes during note input, which is when the caret is activated. 
This reduces the risk of you adding notes to staves accidentally.

You can also input notations at the same time as inputting notes. Notations are input at the caret 
position or on the selected note.

You can input notes in different ways and using any of the following devices, including switching 
between them at any time:

● MIDI keyboard

● Computer keyboard

● Mouse or touchpad

● Keyboard, Fretboard, and Drum Pads panels

TIP

A MIDI keyboard can be the fastest way to input notes.

RELATED LINKS
Notes on page 1246
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Inputting notes on page 221
Accidental selection during MIDI input on page 245
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Notations input on page 271
Arranging tools on page 459

Inputting notes
You can input notes into your project during note input, which is when the caret is activated. You 
can input notes with a computer keyboard, with the mouse, using panels in the lower zone, or by 
playing notes with a MIDI keyboard.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● These steps describe selecting rhythm dots, articulations, and accidentals not in the 
prevailing key signature before inputting notes. However, you can also select them after 
inputting notes. If you change this setting, you must perform step 7 before steps 4 to 6.

● You do not have to input rests between notes, as Dorico Pro automatically shows implicit 
rests of the appropriate duration between the notes you input. Similarly, you do not have to 
input ties, as Dorico Pro shows notes as tie chains if necessary.

● You can also input notations alongside notes without deactivating note input.

PREREQUISITE

● You have chosen the appropriate input pitch setting.

● You have chosen the appropriate note-based notation input setting.

● You have connected any MIDI devices you want to use for note input.

● If you want to select note durations using the Notes panel, the left zone is shown.

● If you want to input notes into multiple instruments held by a single player or instruments 
not visible in the score in page view, you are in galley view.

● If your music requires a key signature, you have input that key signature.

PROCEDURE

1. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.

2. Optional: If you want to input notes onto multiple staves at once, extend the caret to those 
staves.

3. Select a note duration in any of the following ways:
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● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

4. Optional: Select any required rhythm dots.

5. Optional: If you want to input a pitch whose accidental is not in the prevailing key signature, 
select the appropriate accidental.

6. Optional: Select any required articulations.

7. Input the pitches you want in any of the following ways:

● Press the corresponding letters on your computer keyboard.

TIP

Dorico Pro automatically selects the note whose register is the smallest interval away 
from the previously input note. However, you can force a different register.

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the 
letter for the note; for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or 
Ctrl (macOS)  as well as the letter for the note; for example, Ctrl-Alt-A (Windows) 
or Ctrl-A (macOS) .

● Click the staff at the rhythmic position of each note you want to input.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.

● Play the notes on a MIDI keyboard.

8. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

TIP

You can also move the caret in different ways and by different increments.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input with the selected duration at the caret position or where you click and are played 
back as you input them by default. Their pitch follows the prevailing key signature. For example, 
if you press F  in G major, an F♯ is input automatically.
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If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them. However, accidentals not in the prevailing key signature are only added to the 
first note you input after selecting them.

Dorico Pro notates and beams notes appropriately according to their duration, the prevailing 
time signature, and their position in the bar. This includes showing notes as tie chains if required.

If you advance the caret without inputting notes, Dorico Pro fills the gaps between notes with 
implicit rests of the appropriate duration.

If you input notes on notation staves belonging to fretted instruments, Dorico Pro automatically 
allocates these notes to the strings on which they can be played closest to the nut. Because this 
calculation is done for each note separately, multiple notes can be allocated to the same string. 
In such cases, the notes are shown next to each other on tablature and are colored green. You 
can then select them individually and make your own string allocation.

NOTE

● The notes you input overwrite existing notes at the caret position in the voice indicated by 
the quarter note symbol beside the caret. If you want to add notes to an existing voice, you 
can input chords. You can also input notes into new voices.

● You can change the default beam, note, and rest grouping settings for each flow 
independently in Notation Options. You can also specify custom beat groupings within 
individual time signatures.

AFTER COMPLETING THIS TASK

● You can move notes to different rhythmic positions and other staves after they have been 
input.

● You can also show brackets on noteheads individually.

RELATED LINKS
Notes toolbox on page 197
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Inputting notes using pitch before duration on page 224
Changing the note-based notation input setting on page 228
Changing the input pitch setting on page 228
Hiding/Showing zones on page 47
Switching to galley/page view on page 53
Accidental selection during MIDI input on page 245
Respelling notes on page 484
Notation Options dialog on page 837
Notes panel on page 201
Rhythmic grid on page 214
Caret on page 215
Selecting note/rest durations on page 259
Inputting notes with rhythm dots on page 229
Inputting accidentals on page 244
Inputting articulations on page 271
Inputting chords on page 251
Inputting notes into multiple voices on page 231
Inputting rests on page 246
Inputting tuplets on page 254
Adding notes above/below existing notes on page 258
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Moving notes/items rhythmically on page 465
Creating cross-staff beams/tremolos on page 1009
Rhythm dot consolidation on page 1258
Note and rest grouping on page 1021
Beam grouping according to meters on page 999
Notations input on page 271
Playing/Muting notes during note input/selection on page 435
Changing the allocated string for notes on tablature on page 1583
Enabling/Disabling MIDI input devices on page 271
Implicit vs. explicit rests on page 1488
Ties on page 1620
Key signatures on page 1210
Arranging tools on page 459
Bracketed noteheads on page 1263

Register selection during note input
Dorico Pro automatically selects the register of pitches during note input, but you can override 
this and select the register manually.

During note input, Dorico Pro automatically selects the note whose register is the smallest 
interval away from the previously input note. For example, if you input an F and then press A , an 
A is input a third above the F, rather than a sixth below.

You can override this automatic register selection in the following ways:

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the letter for 
the note; for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or Ctrl (macOS) 
as well as the letter for the note; for example, Ctrl-Alt-A (Windows) or Ctrl-A (macOS) .

Register selection when inputting chords

During chord input, Dorico Pro automatically inputs notes above the highest note at the caret 
position. For example, if you press A  then E  then A , a chord of A-E-A is input at the caret 
position.

You can input notes below the lowest note at the caret position instead by pressing Ctrl-
Alt (Windows) or Ctrl (macOS)  as well as the letter for the note name; for example, Ctrl-Alt-
A (Windows) or Ctrl-A (macOS) .

RELATED LINKS
Changing the pitch of individual notes on page 479
Accidental selection during MIDI input on page 245
Respelling notes on page 484

Inputting notes using pitch before duration
You can input notes into your project by specifying their pitch before their duration, meaning you 
can test pitches before inputting them without leaving note input. You can input notes with a 
computer keyboard, with the mouse, using panels in the lower zone, or by playing notes with a 
MIDI keyboard.

By default in Dorico Pro, you must specify the duration before the pitch of notes.
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NOTE

● These steps describe selecting the pitch before the duration when inputting notes. However, 
you can also specify the duration before the pitch instead, which is the default note input 
behavior in Dorico Pro.

● These steps describe selecting rhythm dots, articulations, and accidentals not in the 
prevailing key signature before inputting notes. However, you can also select them after 
inputting notes. If you change this setting, you must perform steps 7 and 8 before steps 4 to 
6.

● When inputting notes on tablature using pitch before duration, you must select note 
durations by clicking them in the Notes panel.

● You do not have to input rests between notes, as Dorico Pro automatically shows implicit 
rests of the appropriate duration between the notes you input. Similarly, you do not have to 
input ties, as Dorico Pro shows notes as tie chains if necessary.

● You can also input notations alongside notes without deactivating note input.

PREREQUISITE

● You have chosen the appropriate input pitch setting.

● You have chosen the appropriate note-based notation input setting.

● You have connected any MIDI devices you want to use for note input.

● If you want to select note durations using the Notes panel, the left zone is shown.

● If you want to input notes into multiple instruments held by a single player or instruments 
not visible in the score in page view, you are in galley view.

● If your music requires a key signature, you have input that key signature.

PROCEDURE

1. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.

2. Activate Pitch Before Duration in any of the following ways:

● Press K .

● In the Notes toolbox, click Pitch Before Duration .

3. Optional: If you want to input notes onto multiple staves at once, extend the caret to those 
staves.

4. Optional: If you want to input a pitch whose accidental is not in the prevailing key signature, 
select the appropriate accidental.

5. Optional: Select any required articulations.

6. Optional: Select any required rhythm dots.

7. Select a pitch in any of the following ways:
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● Press the corresponding letters on your computer keyboard.

TIP

Dorico Pro automatically selects the note whose register is the smallest interval away 
from the previously input note. However, you can force a different register.

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the 
letter for the note; for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or 
Ctrl (macOS)  as well as the letter for the note; for example, Ctrl-Alt-A (Windows) 
or Ctrl-A (macOS) .

When inputting notes using pitch before duration, you can press these key commands 
multiple times to select higher/lower octaves.

● Click the staff at the rhythmic position of each note you want to input.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.

● Play the notes on a MIDI keyboard.

Once you have selected a pitch, a shadow note of the corresponding pitch appears at the 
caret position. You can release the pitch after selecting it.

8. Select a note duration and input the note in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

NOTE

When inputting notes on tablature, you must click durations in the Notes panel.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

9. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

TIP

You can also move the caret in different ways and by different increments.

10. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .
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RESULT
Notes are input with the selected duration at the caret position or where you click and are played 
back as you input them by default. Their pitch follows the prevailing key signature. For example, 
if you press F  in G major, an F♯ is input automatically.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them. However, accidentals not in the prevailing key signature are only added to the 
first note you input after selecting them.

Dorico Pro notates and beams notes appropriately according to their duration, the prevailing 
time signature, and their position in the bar. This includes showing notes as tie chains if required.

If you advance the caret without inputting notes, Dorico Pro fills the gaps between notes with 
implicit rests of the appropriate duration.

If you input notes on notation staves belonging to fretted instruments, Dorico Pro automatically 
allocates these notes to the strings on which they can be played closest to the nut. Because this 
calculation is done for each note separately, multiple notes can be allocated to the same string. 
Similarly, when you input chords on tablature using pitch before duration with a MIDI keyboard, 
all notes in the chord are allocated to the same string. In such cases, the notes are shown next to 
each other on tablature and are colored green. You can then select them individually and make 
your own string allocation.

NOTE

● The notes you input overwrite existing notes at the caret position in the voice indicated by 
the quarter note symbol beside the caret. If you want to add notes to an existing voice, you 
can input chords. You can also input notes into new voices.

● You can switch between using pitch before duration and duration before pitch note input at 
any time by pressing K  or clicking Pitch Before Duration . For example, duration before 
pitch can be easier when inputting a sequence of notes with the same duration.

● You can change the default beam, note, and rest grouping settings for each flow 
independently in Notation Options. You can also specify custom beat groupings within 
individual time signatures.

● You can change whether note input uses pitch before duration or duration before pitch by 
default on the Note Input and Editing page in Preferences.

AFTER COMPLETING THIS TASK
You can move notes to different rhythmic positions and other staves after they have been input.

You can also show brackets on noteheads individually.

RELATED LINKS
Changing the note-based notation input setting on page 228
Changing the input pitch setting on page 228
Notes toolbox on page 197
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Inputting notes on page 221
Register selection during note input on page 224
Accidental selection during MIDI input on page 245
Hiding/Showing zones on page 47
Switching to galley/page view on page 53
Notes panel on page 201
Rhythmic grid on page 214
Caret on page 215
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Inputting chords on page 251
Inputting notes into multiple voices on page 231
Adding notes above/below existing notes on page 258
Notations input on page 271
Enabling/Disabling MIDI input devices on page 271

Changing the input pitch setting
You can input and record notes at either sounding pitch or written pitch; for example, if you want 
to record notes at their sounding pitch in transposing part layouts.

In concert pitch layouts, written pitch and sounding pitch are the same.

PROCEDURE

● In Write mode, choose one of the following input pitch settings:

● To input/record notes at their written pitch, choose Write > Input Pitch > Written Pitch.

● To input/record notes at their sounding pitch, choose Write > Input Pitch > Sounding 
Pitch.

RESULT
The resulting pitch notated or recorded is changed. For example, if you input a C in a Horn in F 
transposing part layout with the input pitch set to Sounding Pitch, the note is written as a G.

RELATED LINKS
Inputting notes on page 221
Inputting notes using MIDI recording on page 264
Concert vs. transposed pitch on page 174

Changing the note-based notation input setting
You can change your default setting for whether rhythm dots, accidentals, and articulations 
apply to the last input note or the next note you input during note input. This setting also affects 
whether or not the last input note remains selected after entry when using pitch before duration 
for inputting notes.

For example, changing the setting to After inputting note when using pitch before duration 
for notes ensures the last input note remains selected after you input it, making it easier to 
change its enharmonic spelling when inputting notes using a MIDI keyboard. The last input note 
is always selected when using duration before pitch for notes, regardless of your note-based 
notation input setting.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, choose one of the following options for Specify accidental, 
rhythm dot and articulations in the Pitch and Duration subsection:

● After inputting note

● Before inputting note

4. Click Apply, then Close.
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RESULT
The setting is changed in the current project and for all future projects. If you chose Before 
inputting note, notes do not remain selected after you input them during pitch before duration 
note input.

RELATED LINKS
Inputting notes on page 221
Inputting notes using pitch before duration on page 224
Inputting accidentals on page 244
Inputting notes with rhythm dots on page 229
Inputting articulations on page 271

Activating/Deactivating mouse input
You can activate/deactivate mouse input; for example, if you only want to input notes using your 
computer keyboard or MIDI device. Deactivating mouse input also allows you to click other items 
to stop note input.

PROCEDURE

● In Write mode, in the Notes toolbox, activate/deactivate Select .

RESULT
Mouse input is activated in the current project when Select  is deactivated. Mouse input is 
deactivated in the current project when Select  is activated.

TIP

You can change the default setting for whether mouse input is activated/deactivated by 
activating/deactivating Enable note input using the mouse on the Note Input and Editing 
page in Preferences.

RELATED LINKS
Notes toolbox on page 197
Preferences dialog on page 61

Inputting notes with rhythm dots
The Dotted Notes tool allows you to input notes with rhythm dots and add rhythm dots to 
existing notes. You can input notes with up to four rhythm dots.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● These steps describe selecting rhythm dots before inputting notes. However, you can 
change this setting if you prefer to specify rhythm dots after inputting notes.

● You cannot add rhythm dots to grace notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select existing notes to which you want to add rhythm dots.

2. Optional: If you want to input notes with rhythm dots onto multiple staves at once, extend 
the caret to those staves.

3. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

4. Activate Dotted Notes in any of the following ways:

● Press . .

● In the Notes toolbox, click Dotted Notes .

5. Optional: Change the number of rhythm dots in any of the following ways:

● Press Alt/Opt-.  to cycle through different numbers of rhythm dots.

● In the Notes toolbox, click and hold Dotted Notes , then click the number of rhythm 
dots you want.

Dotted Notes  in the Notes toolbox updates to indicate the current number of rhythm 
dots. You can input notes with up to four rhythm dots.

6. Optional: Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

If Force Duration  is not activated, the notes you input might be shown as tied notes 
rather than dotted notes, depending on their position in the bar and the prevailing meter.

7. Input the dotted notes you want.

Dotted Notes  remains activated until you either select a different note duration or 
deactivate it.

8. Press .  or click Dotted Notes  again to deactivate Dotted Notes.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
During note input, notes are input as dotted notes until you deactivate Dotted Notes or change 
the note duration.

When you add rhythm dots to multiple existing notes that would then overlap, Dorico Pro adjusts 
the duration of notes in the selection to avoid deleting notes at the end of the selection.
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EXAMPLE

A phrase containing eighth notes After adding rhythm dots to the whole selection

RELATED LINKS
Note and rest grouping on page 1021
Notes toolbox on page 197
Notes panel on page 201
Caret on page 215
Insert mode on page 454
Chord mode on page 254
Selecting note/rest durations on page 259
Activating/Deactivating the caret on page 219
Extending the caret to multiple staves on page 219
Inputting notes in Insert mode on page 237
Changing the note-based notation input setting on page 228

Inputting notes into multiple voices
By default, notes are input into the first up-stem voice, as indicated by the symbol of an up-stem 
quarter note beside the caret. You can input notes directly into other voices during note input, 
and switch between voices as required.

You can also create new voices on staves with existing notes and input notes into those voices 
anywhere else on those staves.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input multiple voices.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select the voice into which you want to input notes in one of the following ways:

● To create a new voice, press Shift-V  or click Create Voice  in the Notes toolbox.

When a new voice is added, a + sign appears beside the symbol of a quarter note beside 
the caret. The quarter note symbol indicates the stem direction, and the number beside 
the quarter note indicates the voice number if applicable.
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Caret when adding the first down-stem voice

TIP

You can press Shift-V  as many times as you require. For example, on a staff containing 
no notes, creating one new voice allows you to input notes into the first down-stem 
voice, but you can also create another new voice immediately if you want to input notes 
into the second up-stem voice.

Only voices that contain notes are preserved.

● To select an existing voice, press V  or click Next Voice  in the Notes toolbox to cycle 
through active voices on the staff.

NOTE

● You can switch between voices as often as you like.

● If you have three or more voices on a single staff, you can only cycle through all 
the voices in a set order. For example, if you have two up-stem voices and two 
down-stem voices, the order is: first up-stem voice, first down-stem voice, second 
down-stem voice, second up-stem voice.

4. Input the notes you want.

5. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input into the voice indicated by the quarter note symbol beside the caret.

If you are inputting notes into a new voice on a staff that already contains notes in another 
voice, the stem directions of existing notes at the same rhythmic position change automatically 
as necessary. Rests appear as required around notes in different voices.

NOTE

● Any voices that you created, but did not input notes into, are deleted.

● You can show voice colors to check which notes are in which voice. Additionally, when you 
select single notes or multiple notes in the same voice at the same rhythmic position, their 
pitches are shown in the status bar and as depressed keys in the Keyboard panel.
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EXAMPLE

Caret when inputting notes into 
the first up-stem voice

Caret when inputting notes into 
the first down-stem voice

Caret when inputting notes into a 
new, second up-stem voice

RELATED LINKS
Caret on page 215
Notes toolbox on page 197
Notes panel on page 201
Rhythmic grid on page 214
Inputting notes on page 221
Inputting notes using pitch before duration on page 224
Inputting bar rests into specific voices on page 247
Adding notes above/below existing notes on page 258
Changing the voice of existing notes on page 477
Voices on page 1704
Stem direction on page 1274
Implicit rests in multiple-voice contexts on page 1489
Unused voices on page 1710
Per-flow notation options for voices on page 1705
Divisi on page 1567
Condensing on page 743
Status bar on page 42
Keyboard panel on page 207
Allowing/Disallowing noteheads in opposing voices to overlap on page 1706
Hiding/Showing bar rests in additional voices on page 1495
Hiding/Showing notes alongside slash regions on page 1477
Hiding/Showing voice colors on page 1705

Inputting notes into slash voices
You can input notes into multiple slash voices; for example, if you want to indicate a precise 
rhythm without specifying pitches. By default, the first slash voice is up-stem, but you can add 
extra slash voices both with and without stems, and switch between them as often as you want.

You can also input notes into new slash voices on a staff with existing notes. Once you have 
created a slash voice somewhere on a staff, you can input notes into that slash voice anywhere 
else on the same staff.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input slash voices.

2. Start note input in any of the following ways:

● Press Shift-N .
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● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select the slash voice into which you want to input notes in one of the following ways:

● To create a new slash voice, press Shift-Alt/Opt-V . You can also click and hold Create 
Voice  in the Notes toolbox, then click Create Slash Voice .

When a new slash voice is added, a + sign appears beside the symbol of a note beside 
the caret, which now appears as a slash note. The slash note symbol indicates the stem 
direction, and the number beside the slash note symbol indicates the voice number if 
applicable.

Caret when adding the first down-stem slash voice

TIP

You can press Shift-Alt/Opt-V  as many times as you require. For example, on a staff 
containing no notes in slash voices, creating one new slash voice allows you to input 
notes into the first up-stem slash voice.

You can also create a second new slash voice immediately if you want to input notes 
into a down-stem slash voice, or a third new slash voice if you want to input notes into a 
stemless slash voice.

Only voices that contain notes are preserved.

● To select an existing slash voice, press V  or click Next Voice  in the Notes toolbox to 
cycle through active voices on the staff.

4. Input the notes you want.

Notes in slash voices appear at the same staff position, regardless of their pitch. By default, 
this is the middle line of the staff, but this changes in multiple-slash-voice contexts.

NOTE

By default, notes in slash voices are not played back. However, if you include slash voices in 
playback, notes in slash voices play back with their input pitch.

5. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input into new slash voices, as indicated by the caret indicator. The slash note symbol 
beside the caret changes to indicate which voice is currently selected and into which notes are 
input.

You can switch between voices as often as you like.
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NOTE

● If you are inputting notes into a new slash voice on a staff that already contains notes in 
other voices/slash voices, the stem directions of existing notes and the staff positions of 
slash voices at the same rhythmic position change automatically as necessary. Rests appear 
as required around notes in different voices.

● If you have three or more voices of any type on a single staff, you must cycle through all the 
voices in a set order. For example, if you have two up-stem voices, two down-stem voices, 
and a slash voice, the order is: first up-stem voice, first down-stem voice, second down-stem 
voice, second up-stem voice, slash voice.

● Any voices that you created, but did not input notes into, are deleted.

EXAMPLE

Caret when inputting 
notes into the first up-
stem slash voice

Caret when inputting 
notes into the first down-
stem slash voice

Caret when inputting 
notes into a new 
stemless slash voice

Caret when inputting 
notes into a new, second 
up-stem slash voice

RELATED LINKS
Notes toolbox on page 197
Slash voices on page 1483
Rhythm slashes on page 1473
Inputting slash regions on page 418
Changing the voice of existing notes on page 477
Including/Excluding slash voices in playback on page 1485
Stem direction on page 1274
Implicit rests in multiple-voice contexts on page 1489
Unused voices on page 1710

Inputting notes and notations onto multiple staves
You can input notes and notations onto multiple staves simultaneously, including automatically 
exploding the notes in chords that you play on a MIDI keyboard onto the appropriate staves. 
For example, if you want to input notes onto both piano staves or input the same dynamics for 
multiple instruments.

Inputting notes and notations onto multiple staves is most useful for multiple adjacent pitched 
instruments whose music is only a single voice.

PREREQUISITE
If you want to explode individual notes in chords onto multiple staves during note input, you 
have connected a MIDI keyboard. You can only input the different notes in chords onto separate 
staves when using a MIDI keyboard.
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PROCEDURE

1. In Write mode, select an item at the rhythmic position where you want to input notes/
notations onto multiple staves.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Extend the caret to another staff in any of the following ways:

● To extend to the staff above, press Shift-Up Arrow .

● To extend to the staff below, press Shift-Down Arrow .

4. Optional: Repeat step 3 for as many staves as you require.

5. Input the notes and notations you want.

NOTE

You must input notes using a computer keyboard or MIDI keyboard. If you use the mouse, 
notes are only input on the staff you click. Similarly, you must use the corresponding 
popover to input notations on multiple staves. When inputting notations using the 
corresponding panel, they are only input on the top staff.

6. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The notes and notations you input are input at the caret position on all staves across which the 
caret extends. If the caret extends across both staves of a grand staff instrument, notes are input 
on either the top or bottom staff according to their pitch. However, this does not apply to grand 
staff instruments with extra staves.

When inputting notes using a MIDI keyboard, the individual notes in any chords you input are 
automatically exploded across the staves.

TIP

You can change whether notes in chords are exploded onto multiple staves or all notes are input 
onto all staves on the MIDI Input page in Note Input Options.

RELATED LINKS
Caret on page 215
Notes panel on page 201
Inputting notes on page 221
Inputting chords on page 251
Inputting notes using pitch before duration on page 224
Notations input on page 271
Preferences dialog on page 61
Note Input Options dialog on page 839
Exploding music onto multiple staves on page 470
MIDI Import Options dialog on page 90
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Inputting notes in Insert mode
In Insert mode, you can input notes before existing notes in a single voice without overriding 
them. This allows you to push existing notes ahead at the same time as inputting new notes at 
their previous positions.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● You can only input chords in Insert mode when using a MIDI keyboard.

PROCEDURE

1. In Write mode, start note input.

2. Activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

In Insert mode, the caret shows V and inverted V shapes at the top and bottom. Dotted 
lines are shown on staves affected by the Insert mode scope across which the caret does not 
already extend.

3. Choose the appropriate Insert mode scope.

4. Optional: If the Insert mode scope is set to Voice , press V  until the voice you want is 
selected.

5. Optional: If the Insert mode scope is set to Player  or Voice  and you want to input notes 
in Insert mode onto multiple staves at once, extend the caret to those staves.

6. Input the notes you want.

7. Optional: Press I  or click Insert  again to deactivate Insert mode and return to normal 
note input.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are inserted at the caret position or where you click without overwriting any existing notes 
at rhythmic positions after the caret. Instead, existing notes after the caret are pushed ahead to 
subsequent rhythmic positions.

The voices and staves affected by Insert mode depend on the Insert mode scope.

RELATED LINKS
Caret on page 215
Insert mode on page 454
Insert mode scopes on page 455
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Changing the Insert mode scope on page 456
Notes toolbox on page 197
Rhythmic grid on page 214
Inputting notes on page 221
Inputting chords on page 251
Moving the caret manually on page 220

Inputting notes for unpitched percussion
You can input notes for individual unpitched percussion instruments and on all percussion 
instruments in percussion kits using any presentation type, including selecting playing 
technique-specific noteheads for individual instruments.

When inputting notes in percussion kits, the caret is smaller than when inputting notes on 
pitched instrument or individual percussion instrument staves. Instead of occupying the whole 
height of the staff, the caret in percussion kits is positioned at a particular staff position.

The name of the percussion instrument or slash voice currently selected by the caret, and any 
applicable playing technique, is shown directly above the rhythmic grid display.

NOTE

● You can only input notes into slash voices in percussion kits when using the five-line staff 
presentation type.

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

Inputting notes on instruments with five-line staff kit presentation

PREREQUISITE
If you want to use additional playing technique-specific noteheads for percussion instruments, 
you have defined these in the Percussion Instrument Playing Techniques dialog for each 
instrument.

PROCEDURE

1. In Write mode, select an item on the unpitched percussion instrument/kit staff and at the 
rhythmic position where you want to input notes.

2. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.
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3. Optional: When inputting into percussion kits, move the caret up/down to other instruments 
in the kit in any of the following ways:

● To move it up, press Up Arrow .

● To move it down, press Down Arrow .

4. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

5. Select an appropriate playing technique for the instrument currently selected by the caret 
before inputting notes.

● To cycle upwards through playing techniques, press Alt/Opt-Up Arrow .

● To cycle downwards through playing techniques, press Alt/Opt-Down Arrow .

● Play the pitch for the playing technique you want on a MIDI keyboard.

NOTE

You can define MIDI pitches for playing techniques on the Note Input and Editing page 
in Preferences.

6. Input notes in one of the following ways:

● Any kit presentation type/Individual instruments: Press Y  to input notes for the 
instrument and playing technique shown above the rhythmic grid.

● Any kit presentation type/Individual instruments: Click on the staff where you want to 
input notes, and at the rhythmic positions where you want them.

● Five-line staff presentation type: Press letters on a computer keyboard or play notes on 
a MIDI keyboard, corresponding to staff positions for the clef set in Preferences. For 
example, press B  to input notes for the instrument assigned to the middle line of a 
five-line staff when Treble G clef is set.

● Grid and single-line instruments presentation types/Individual instruments: Press the 
letter of any note name A  to G  on a computer keyboard or play any note on a 
MIDI keyboard to input notes for the instrument on whose line the caret is currently 
positioned.

NOTE

Notes played on MIDI keyboards are interpreted differently, depending on whether Use 
percussion map or Use staff position is set for the different kit presentation types in 
the Note Input section of the Note Input and Editing page in Preferences.

7. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .
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TIP

You can also move the caret in different ways and by different increments.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input at the caret position or where you click with the selected duration and are 
played back as you input them by default. If you selected playing techniques, their noteheads 
appear as set in the Percussion Instrument Playing Techniques dialog for the corresponding 
instrument and playing technique, or in the Override Percussion Noteheads dialog for five-line 
staff presentations only.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them.

Dorico Pro notates and beams notes appropriately according to their duration, the prevailing 
time signature, and their position in the bar. This includes showing notes as tie chains if required.

If you advance the caret without inputting notes, Dorico Pro fills the gaps between notes with 
implicit rests of the appropriate duration.

TIP

You can change the default beam, note, and rest grouping settings for each flow independently 
in Notation Options. You can also specify custom beat groupings within individual time 
signatures.

RELATED LINKS
Notes toolbox on page 197
Notes panel on page 201
Caret on page 215
Percussion kits vs. individual percussion instruments on page 1689
Percussion kits and drum sets on page 1690
Playing techniques for unpitched percussion instruments on page 1682
Playing technique-specific noteheads on page 1683
Percussion Instrument Playing Techniques dialog on page 1683
Changing playing technique-specific noteheads on page 1686
Inputting notes using pitch before duration on page 224
Note and rest grouping on page 1021
Beam grouping according to meters on page 999
Notation Options dialog on page 837
Deleting rests on page 1493
Inputting notes on page 221

Note input setup for percussion kits
Inputting music for unpitched percussion instruments works differently than for pitched 
instruments. You can use any of the usual methods for unpitched percussion input, but using 
a MIDI keyboard or a computer keyboard is most efficient.

● You can find options relating to note input for percussion in the Note Input section of the 
Note Input and Editing page in Preferences.
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There is one set of options for input onto five-line staves, and another set of options for input 
onto grids and individual instruments.

The main choice affects input via MIDI keyboards and computer keyboards.

Use percussion map
A percussion map defines which MIDI notes produce which sound for a particular 
patch in a sound library. For example, in General MIDI percussion, C2 (note 36) 
produces bass drum, and D2 (note 38) produces snare drum, and so on.

If you know a particular mapping well, you may find it helpful to use the mapping 
directly for input.

Use staff position
This option uses the staff position defined in the Edit Percussion Kit dialog. For 
example, on a drum set, the bass drum is normally positioned in the bottom space 
of the staff, while the snare drum is positioned in the third space from the bottom.

You can think of staff positions relative to what they would be when using a treble G 
clef (F4 and C5 respectively) or using a bass F clef (A2 and E3 respectively).

You can choose which clef is used to interpret staff positions for five-line staves:

● Treble G clef

● Bass F clef

When you select Use staff position, you can designate one octave of your MIDI keyboard to 
input playing techniques.

By default, the Input techniques from MIDI key option is set to MIDI note 48, which is C3, the 
C one octave below middle C (C4 = MIDI note 60). You can click the MIDI learn button and then 
play a note on your MIDI keyboard to change the starting pitch. Assuming a starting pitch of C3, 
ascending notes operate as follows:

● C3 (48): Previous playing technique

● C♯3 (49): Next playing technique

● D3 (50): First mapped playing technique

● E♭3 (51): Second mapped playing technique

● E3 (52): Third mapped playing technique

And so on, up to:

● B3 (59): Tenth mapped playing technique

In general, we recommend that you set Use staff position for percussion input. Use percussion 
map is normally only useful when you are inputting notes onto a drum set and you have already 
memorized the General MIDI percussion map.

RELATED LINKS
Preferences dialog on page 61
Edit Percussion Kit dialog on page 155
Inputting notes for unpitched percussion on page 238
Changing playing technique-specific noteheads on page 1686

Write mode
Note input 

241
Dorico Pro 4.3.30



Default note selection during note input for percussion kits
During note input in percussion kits, you can press the letters on a computer keyboard that 
correspond to staff positions for kits using the five-line staff presentation type. For example, you 
can press F  to input a note on the F space or line.

In Preferences, you can set options for inputting notes into percussion kits in the Note Input 
section of the Note Input and Editing page. For example, if you want to use staff positions to 
determine notes, choose Use staff position for Input onto kit or grid.

If you have the staff positions set relative to Treble G clef, then F could mean either the bottom 
space on the staff or the top line on the staff. In a standard drum set, this means either the kick 
drum in the bottom space, or the ride cymbal on the top line.

When inputting notes in pitched instruments, Dorico Pro chooses the lower or upper possible 
staff position based on which is closer to the current position of the caret.

However, when inputting notes in percussion kits, Dorico Pro chooses the staff position of the 
note with the same stem direction as the last input note, rather than the staff position that is 
closest to the current position of the caret. This makes it easier to input common note patterns 
used in percussion kits.

For example, inputting kick drum and snare drum notes on a standard drum set is a common 
pattern. The kick drum is in the bottom space, and the snare drum is two spaces above: five staff 
positions away from the bottom space, and four staff positions away from the top line.

You can press F  for the kick drum and C  for the snare drum.

The default stem direction behavior for inputting notes in kits in Dorico Pro means that you can 
alternate pressing F  and C , and the notes are input at the positions of the kick drum and snare 
drum, even though the top line is the closer position after inputting a snare drum note.

This is because the kick drum uses the same stem direction, and therefore voice, as the snare 
drum.

NOTE

Dorico Pro automatically changes the directions of stems according to the positions of notes on 
the staff when only one voice on the staff contains notes, regardless of their voice.

RELATED LINKS
Stem direction on page 1274

Inputting notes on tablature
You can input notes directly into tablature in the same ways as inputting normal notes. When 
inputting notes on tablature, the caret is smaller than when inputting notes on standard five-line 
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staves and behaves as if chord input is always active, meaning you must advance the caret 
manually to input notes at other rhythmic positions.

NOTE

These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting notes on tablature using pitch before duration, you must select note durations 
by clicking them in the Notes panel.

PROCEDURE

1. In Write mode, select an item on the tablature and at the rhythmic position where you want 
to input notes.

NOTE

If both notation staves and tablature are shown in the current layout, you must select an 
item on the notation staff and then move the caret to the tablature after starting note input.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select a note duration in any of the following ways:

● To select the next longer duration, press = .

● To select the next shorter duration, press - .

● In the Notes panel, click the duration you want.

● In the Fretboard panel toolbar, click the duration you want.

4. Input the pitch you want for the current string in any of the following ways:

● Press the number on your computer keyboard or numeric keypad that corresponds to 
the fret number you want. For example, press 6  for fret 6.

For fret numbers 10 and above, press the two digits quickly.

● Press the corresponding letters on your computer keyboard.

NOTE

When using letters, Dorico Pro automatically chooses the octave closest to the nut on 
the corresponding string.

● In the Fretboard panel, click the corresponding string and fret position.

● Play the note on a MIDI keyboard.

5. Move the caret up/down to input notes on different strings at the same rhythmic position in 
any of the following ways:

● To move it up, press Up Arrow .

● To move it down, press Down Arrow .

6. Move the caret to other rhythmic positions in any of the following ways:

● To move the caret according to the current rhythmic grid resolution, press 
Right Arrow / Left Arrow .
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● To advance the caret according to the note duration currently selected, press Space  or 
click Advance Caret  in the Fretboard panel toolbar.

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

RESULT
Notes are input at the caret position with the selected duration on the string indicated by the 
caret and are played back as you input them by default. Notes continue to be input at the caret 
position until you move the caret manually and overwrite any previous note on the same string. 
If you attempt to input a note that is impossible on the current string, it is input on the closest 
available string in addition to any existing notes.

If you have input two or more notes on the same string at the same rhythmic position, they 
are shown next to each other on tablature and are colored green. Similarly, when you input 
chords on tablature using pitch before duration with a MIDI keyboard, all notes in the chord 
are allocated to the same string. You can then select them individually and change their string 
allocation.

RELATED LINKS
Caret on page 215
Moving the caret manually on page 220
Fretboard panel on page 209
Tablature on page 1580
Hiding/Showing notation staves and tablature on page 1582
Hiding/Showing enclosures around notes on tablature on page 1584
Changing the allocated string for notes on tablature on page 1583
Inputting notes using pitch before duration on page 224

Inputting accidentals
You can input accidentals during note input and by adding them to existing notes. You can also 
change the accidentals of existing notes.

NOTE

● Accidentals that are part of the prevailing key signature are input automatically. For example, 
if you press F  in G major, an F♯ is input automatically. You would only need to specify an 
accidental if you want to input an F♮, for example.

This also applies if you are using a MIDI keyboard, though you can respell notes if the 
accidentals chosen automatically are not the ones that you expected.

● These steps describe selecting accidentals before inputting each note. However, you can 
change this setting if you prefer to specify accidentals after inputting notes.

PREREQUISITE
You have created any custom accidentals, in custom tonality systems if required, that you want to 
input.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the existing notes to which you want to add accidentals or whose accidentals you 
want to change.
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2. Select the accidental you want to input in one of the following ways:

● For a flat accidental, press - .

● For a sharp accidental, press = .

● For a natural accidental, press 0 .

● In the Notes panel, click the accidental you want.

TIP

You can find more accidentals, such as double sharps/flats or microtonal accidentals, in the 
Accidentals section of the Key Signatures, Tonality Systems, and Accidentals panel on the 
right of the window.

3. Optional: During note input, input the note you want with your selected accidental.

RESULT
The accidental is added to the selected existing notes. If you selected existing notes with 
different accidentals, they are changed to have the accidental you selected.

During note input, the selected accidental is only input on the next note you input. You must 
reselect the accidental for each subsequent note.

NOTE

● Depending on the accidental duration rule in place, subsequent accidentals for the same 
note in the same register might not appear in the same bar.

● If you input notes using a MIDI device, Dorico Pro automatically shows an accidental if 
necessary. It selects a sharp, flat, or natural based on key signature and context. You 
can later respell notes so they are shown as their enharmonic equivalents with different 
accidentals.

RELATED LINKS
Notes panel on page 201
Hiding/Showing zones on page 47
Accidentals on page 942
Inputting notes on page 221
Changing the note-based notation input setting on page 228
Respelling notes on page 484
Changing the pitch of individual notes on page 479
Changing the size of accidentals on page 945
Accidental duration rules on page 951
Changing the tonality system on page 1220
Custom tonality systems on page 902
Creating/Editing custom accidentals on page 904
Creating custom tonality systems on page 902

Accidental selection during MIDI input
Dorico Pro interprets MIDI data to create accidentals, and automatically determines the spelling 
of notes according to preset rules.

Dorico Pro automatically displays an accidental if one is required. It selects a sharp or flat based 
on key signature and context.
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The algorithm for this takes into account the key signature and the intervals between successive 
notes and chords. Therefore Dorico Pro prefers sharp accidentals in a key with sharps, and flats 
in a key with flats. If you change the spelling of an accidental, Dorico Pro follows your spelling 
preference whenever that note is used again in the score.

If you input notes with accidentals outside the key signature, Dorico Pro uses sharps if the figure 
is rising, and flats if it is falling. The spelling is also calculated vertically, meaning a simpler 
interval is produced where possible, such as a major third rather than a diminished fourth.

By default, Dorico Pro makes retrospective changes to how it has spelled accidentals, depending 
on how your music develops. For example, in C major, if you input a sequence of pitches C-E-G♯, 
but then input a G♭, the G♯ is respelled as an A♭.
You can disable this setting.

Disabling automatic accidental respelling
You can turn off the automatic respelling of accidentals to prevent Dorico Pro from making 
retrospective changes to accidentals.

PROCEDURE

1. Press Ctrl/Cmd-Shift-I  to open Note Input Options.

2. In the category list, click MIDI Input.

3. Deactivate Allow spelling of notes to be adjusted retrospectively.

4. Click Apply, then Close.

Inputting rests
Dorico Pro automatically shows rests as appropriate in the gaps between the notes you input. 
However, you can also input rests manually; for example, to show fermatas on specific beats for 
players without notes in that bar.

NOTE

These steps describe selecting the duration before inputting rests. However, you can also input 
rests when Pitch Before Duration is active, in which case step 7 is unnecessary.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input rests.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to input rests onto multiple staves at once, extend the caret to those 
staves.

4. Start rest input in any of the following ways:

● Press , .

● In the Notes toolbox, click Rests .
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5. Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

6. Select the rest duration you want.

7. Input rests in any of the following ways:

● Press Y  or any of the letters from A  to G .

● Click the staff at the rhythmic position of each rest you want to input.

A shadow rest appears when inputting with the mouse to indicate where the rest will be 
input.

● Play notes on a MIDI keyboard.

8. Optional: Press ,  or click Rests  again to stop rest input.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Rests of the selected duration are input. If Force Duration is not activated, Dorico Pro 
automatically combines adjacent rests as appropriate for their position in relation to notes and 
according to the current meter.

RELATED LINKS
Rests on page 1487
Implicit vs. explicit rests on page 1488
Note and rest grouping on page 1021
Notes toolbox on page 197
Notes panel on page 201
Caret on page 215
Extending the caret to multiple staves on page 219
Selecting note/rest durations on page 259
Forcing the duration of notes/rests on page 262
Inputting notes on page 221
Inputting notes using pitch before duration on page 224

Inputting bar rests into specific voices
When inputting music in multiple voices, rests are normally created automatically when there is a 
gap in the secondary voice. However, if you want secondary voices to begin with explicit bar rests 
in strict contrapuntal music, you can input a bar rest into those voices.

For music in a single voice, you do not have to input bar rests as they appear in each new bar 
automatically when you advance the caret. You can also hide/show bar rests in all empty bars in 
each layout independently.

PROCEDURE

1. In Write mode, start note input.

2. Select the appropriate secondary voice by pressing V  until the voice direction indicator 
shows the correct voice.
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Alternatively, if you want to input bar rests into a new voice, press Shift-V  until the voice 
direction indicator shows the correct voice.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter rest into the popover to add a bar rest.

5. Press Return  to close the popover.

6. Press Ctrl/Cmd-Right Arrow  to advance the caret to the start of the next bar after the bar 
rest.

7. Optional: If you want to show bar rests in multiple bars for the selected voice, repeat steps 3 
to 6 as many times as required.

TIP

If your notation options are set to show bar rests in additional voices, bar rests appear in all 
subsequent empty bars for the selected voice after you have input one bar rest.

RESULT
Bar rests are input into the selected voice at the caret position. If the caret position is within a bar 
that contains notes for the selected voice, these notes are replaced by the bar rest.

NOTE

Alternatively, you can click Insert Bar Rest in the Insert Bar Rest section of the Bars and 
Barlines panel to input bar rests during note input.

RELATED LINKS
Bars on page 962
Bars and barlines popover on page 302
Hiding/Showing bar rests in empty bars on page 1494
Hiding/Showing bar rests in additional voices on page 1495
Per-flow notation options for rests on page 1490
Inputting notes into multiple voices on page 231
Caret on page 215

Inputting ties
You can input ties manually to join two notes of the same pitch, both during note input and by 
joining two existing notes with a tie. You can tie existing notes in different voices or on different 
staves belonging to the same instrument, or that are not rhythmically adjacent.

For example, you might have input a melody across multiple voices in order to accommodate 
passing notes, but want to tie two notes together even though they are in different voices. 
Similarly, you might have written multiple notes before a chord that are all held down and want 
to reduce the number of tied notes.

TIP

Dorico Pro automatically creates ties as required for note durations in each meter. For example, 
if you want to input a tie between two quarter notes across a barline, you can input a half note 
at the rhythmic position where you want to input the first quarter note. Dorico Pro automatically 
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splits the half note into two quarter notes, one on each side of the barline, and joins them with a 
tie.

PREREQUISITE
If you want to preserve the durations of existing notes, you have forced their duration. For 
example, if you want to specify subdivisions within a tie chain that are different than the 
prevailing meter.

We also recommend starting ties from the first note in the tie chain, as tied notes become a 
single note whose settings, including forced durations, come from the first note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the note from which you want the tie to start. If you want to input a tie between 
two specific notes or between a grace note and a normal note, select those two notes.

NOTE

The two notes must be the same pitch, but can be in different voices or on different 
staves belonging to the same instrument.

2. Optional: During note input, input the note that you want at the start of the tie.

3. Input a tie in any of the following ways:

● Press T .

● In the Notes toolbox, click Tie .

4. Optional: During note input, input the note that you want at the end of the tie.

NOTE

The second note must be the same pitch as the first note.

RESULT
During note input, the two notes input are joined by a tie.

If you selected a single existing note, it is joined by a tie to the next note of the same pitch in the 
same voice and staff. If you selected two existing notes, they are tied together, provided they are 
the same pitch and belong to the same instrument.

NOTE

● During note input, Dorico Pro ties the first note you input after inputting the tie to the 
previous note of the same pitch in the same voice and staff, even if there are other notes of 
other pitches between them.

● Depending on the prevailing time signature, the position of the start of the note in the bar, 
and your settings on the Note Grouping page in Notation Options, inputting a tie between 
two notes can instead create a single note of a different duration, such as a half note instead 
of two tied quarter notes. You can override your note grouping settings and fix your notated 
rhythm by forcing their duration. Dorico Pro then notates your input notes with the rhythmic 
durations specified, as long as they can fit inside the bar.

Write mode
Note input 

249
Dorico Pro 4.3.30



EXAMPLE

Ties between adjacent notes Ties between non-adjacent notes Ties between grace notes 
and normal notes

RELATED LINKS
Inputting notes on page 221
Forcing the duration of notes/rests on page 262
Notation Options dialog on page 837
Notes toolbox on page 197
Ties on page 1620
Ties vs. slurs on page 1622
Note and rest grouping on page 1021
Beam grouping according to meters on page 999

Inputting grace notes
You input grace notes in the same ways as normal notes, and they can have any rhythmic note 
value, accidental, and articulation.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● You cannot add rhythm dots to grace notes.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input grace notes.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to input grace notes onto multiple staves at once, extend the caret to 
those staves.

4. Start grace note input in any of the following ways:

● Press / .

● In the Notes toolbox, click Grace Notes .

5. Press the number for the note duration you want. For example, press 5  for eighth grace 
notes.

6. Optional: Switch between inputting slashed/unslashed grace notes in any of the following 
ways:
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● Press Alt/Opt-/ .

● In the Notes toolbox, click and hold Grace Notes , then click Unslashed Grace Notes 
 or Slashed Grace Notes .

Grace Notes  in the Notes toolbox updates to indicate the current grace note type.

7. Input the grace notes you want.

TIP

There is no limit to the number of grace notes that can exist at the same rhythmic position.

8. Press /  or click Grace Notes  again to stop grace note input and return to normal note 
input.

RESULT
The pitches you enter are input as grace notes at the caret position.

TIP

● You can also change the type of grace notes after they have been input.

● Slashed and unslashed grace notes are handled differently in playback.

RELATED LINKS
Grace notes on page 1193
Grace notes in playback on page 1201
Notes toolbox on page 197
Notes panel on page 201
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Caret on page 215
Extending the caret to multiple staves on page 219
Inputting notes on page 221
Selecting note/rest durations on page 259
Inputting ties on page 248
Inputting accidentals on page 244
Inputting articulations on page 271
Changing the type of grace notes on page 1197
Turning existing notes into grace notes on page 1195
Turning grace notes into normal notes on page 1196
Inputting notes using pitch before duration on page 224

Inputting chords
You can input chords during note input when both note input and Chords are activated. You can 
input notes with a computer keyboard, with the mouse, using panels in the lower zone, or by 
playing notes with a MIDI keyboard.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting chords using pitch before duration, you must use your computer keyboard 
or a MIDI keyboard and complete step 6 before step 5.
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● You can only input chords in Insert mode when using a MIDI keyboard.

● You can input chords without activating Chords when using the Keyboard panel, Fretboard 
panel, or a MIDI keyboard.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input chords.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Start chord input in any of the following ways:

● Press Q .

● In the Notes toolbox, click Chords .

In chord input, a + sign appears at the top of the caret. This allows you to input multiple 
notes at the caret position.

4. Optional: If you want to input chords onto multiple staves at once, extend the caret to those 
staves.

5. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

6. Input the pitches you want in any of the following ways:

● Press the corresponding letters on your keyboard.

TIP

Dorico Pro automatically inputs notes above the highest note at the caret position when 
Chords  is activated.

You can input notes below the lowest note at the caret position instead by pressing Ctrl-
Alt (Windows) or Ctrl (macOS)  as well as the letter for the note name; for example, 
Ctrl-Alt-A (Windows) or Ctrl-A (macOS) .

● Click the staff at the rhythmic positions where you want to input notes.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.
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● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.

● Play the notes on a MIDI keyboard.

7. Optional: Advance the caret to input chords at other rhythmic positions in any of the 
following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

During chord input, notes are input at the same rhythmic position and above the previous 
note until you advance the caret manually.

TIP

You can also move the caret in different ways and by different increments.

8. Press Q  or click Chords  again to stop chord input.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Multiple notes are input at the caret position.

● If entering pitches by clicking with the mouse, you can put the same pitch into the chord 
twice by clicking again on the same line.

● If entering pitches with the keyboard, repeated notes are automatically input an octave 
above. You can change the register of notes by forcing the register selection during note 
input, or by transposing them after they have been input.

NOTE

● You can stop chord input and immediately continue inputting notes as before, with a single 
note at each rhythmic position and the caret advancing automatically to the next rhythmic 
position.

● When chords contain two pitches in the same register but with different accidentals, that is 
known as an altered unison. Altered unisons are shown with either single stems or with split 
stems, depending on your settings on the Accidentals page in Notation Options.

● When you input chords on tablature using pitch before duration with a MIDI keyboard, all 
notes in the chord are allocated to the same string. In such cases, the notes are shown next 
to each other on tablature and are colored green. You can then select them individually and 
make your own string allocation.

RELATED LINKS
Notation Options dialog on page 837
Notes toolbox on page 197
Notes panel on page 201
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Register selection during note input on page 224
Caret on page 215
Extending the caret to multiple staves on page 219
Moving the caret manually on page 220
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Altered unisons on page 948
Inputting notes using pitch before duration on page 224
Changing the note-based notation input setting on page 228

Chord mode
Chord mode changes how notes are input and how edits you make outside of note input affect 
the music. When Chord mode is activated, notes can overlap or stack on top of each other to 
create chords rather than overwriting existing notes. During chord input, the caret does not 
advance automatically.

Edits outside of chord input that are affected by Chord mode include copying/pasting notes or 
changing their duration. For example, if you copy four notes and paste them to a staff that 
already has notes with Chord mode activated, the existing notes are not overwritten but instead 
combine with the new notes to make chords.

● You can activate/deactivate Chord mode in Write mode by pressing Q  or clicking Chords 
in the Notes toolbox.

NOTE

You cannot have both Insert mode and Chord mode activated simultaneously.

RELATED LINKS
Insert mode on page 454
Caret on page 215
Copying and pasting notes/items on page 461
Exploding music onto multiple staves on page 470
Changing the duration of notes on page 259
Inputting notes with rhythm dots on page 229

Inputting tuplets
You can input all types of tuplets using the tuplets popover. Tuplets can contain notes of any 
duration, such as a quarter note at the start of an eighth note triplet.

NOTE

These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting tuplets using pitch before duration, Dorico Pro determines the base value of the 
tuplet on either the first note you input after specifying the tuplet or the note value included in 
your tuplet ratio.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input tuplets.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.
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3. Optional: If you want to input tuplets onto multiple staves at once, extend the caret to those 
staves.

4. Open the tuplets popover in any of the following ways:

● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

When inputting tuplets with the keyboard, Dorico Pro automatically continues inputting 
notes as the specified tuplet.

5. Enter the tuplet you want into the popover as a ratio followed by the beat unit.

For example, enter 3:2e to input eighth note triplets or 5:4x to input sixteenth note 
quintuplets.

NOTE

If you do not specify the beat unit, the tuplet is based on the note value currently selected in 
the Notes panel.

6. Press Return  to close the popover.

The tuplet is entered.

7. Optional: Change the selected note duration.

For example, you can input a tuplet based on eighth notes but input a quarter note within 
that tuplet.

8. Enter or play in the pitches you want.

When inputting tuplets with the keyboard, Dorico Pro automatically continues inputting 
notes as the specified tuplet.

9. Optional: Advance the caret to continue inputting tuplets of the same ratio at later rhythmic 
positions in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

10. Stop tuplet input in one of the following ways:

● To return to inputting normal notes, press :  or move the caret with the arrow keys.

● To stop note input completely, press Esc .

RESULT
The pitches you enter or play in are input as tuplets, starting from the caret position.

If you want to input a different type of tuplet immediately after inputting tuplets, you must stop 
the first type of tuplet before inputting the second type. If you do not stop the first type, the 
second type is input as a nested tuplet.

TIP

You can also input tuplets by clicking and holding Tuplets  in the Notes toolbox, then clicking 
the tuplet you want.

RELATED LINKS
Tuplets on page 1669
Nested tuplets on page 1670
Turning existing notes into tuplets on page 1671
Turning tuplets into normal notes on page 1672
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Notes toolbox on page 197
Notes panel on page 201
Notations toolbox on page 202
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Caret on page 215
Inputting notes on page 221
Extending the caret to multiple staves on page 219
Inputting notes using pitch before duration on page 224

Tuplets popover
The tuplets popover allows you to input tuplets of any ratio and based on any note duration. The 
table contains examples of what you can enter into the tuplets popover to input different types 
of tuplets.

You can open the tuplets popover in Write mode during note input or when notes are selected in 
any of the following ways:

● Press ; .

As tuplets are often described in ratios, such as 3:2, the tuplets popover uses the semicolon 
key to be memorable.

● In the Notes toolbox, click and hold Tuplets , then click x:y .

● Choose Write > Create Tuplet.

The icon on the left-hand side of the popover matches the corresponding button in the Notes 
toolbox on the right of the window.

Tuplets popover with an example entry
Tuplets button in the Notes toolbox

When inputting tuplets with the keyboard, Dorico Pro continues to input notes as the specified 
tuplet until any of the following happens:

● You press :  to return to inputting normal notes.

● You move the caret with the arrow keys.

● You stop note input.

Type of tuplet Popover entry

Triplet, three notes in the space of two 3, 3:2, 3/2, or 3 2

Triplet, three notes in the space of four 3:4, 3/4, or 3 4

Quadruplet, four notes in the space of three 4:3, 4/3, or 4 3

Quintuplet, five notes in the space of two 5:2, 5/2, or 5 2

Quintuplet, five notes in the space of four 5:4, 5/4, or 5 4
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Type of tuplet Popover entry

Sextuplet, six notes in the space of four 6:4, 6/4, or 6 4

Septuplet, seven notes in the space of four 7:4, 7/4, or 7 4

Nonuplet, nine notes in the space of eight 9:8, 9/8, or 9 8

Duplet, two notes in the space of three. Often 
used in compound meters.

2:3, 2/3, or 2 3

Quintuplet, five notes in the space of six. Often 
used in compound meters.

5:6, 5/6, or 5 6

Quintuplet, five dotted quarter notes in the 
space of four

NOTE

When using a number to specify the beat unit, 
you must separate the tuplet ratio from the 
beat unit using a space or hyphen.

5:4q., 5/4q., 5 4q., or 5:4-6.

This list is not comprehensive. It is intended to illustrate how you can structure your entry to 
input different tuplets.

NOTE

Unless you specify a beat unit in your entry, the total duration of the tuplet depends on the note 
value selected when you open the popover. For example, if a quarter note is selected when you 
input a triplet, the triplet input is three quarter notes in the space of two.

Tuplet beat units

Tuplet beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8
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Tuplet beat unit Popover entry

Double whole note 2w or 9

Rhythm dot . (period)

RELATED LINKS
Turning existing notes into tuplets on page 1671
Selecting note/rest durations on page 259

Adding notes above/below existing notes
You can add notes above/below existing notes. You can add multiple notes at the same time, 
according to their intervals relative to the existing notes.

PROCEDURE

1. In Write mode, select the notes to which you want to add notes.

2. Open the note tools popover in any of the following ways:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

3. Enter the intervals of the notes you want, relative to your selected notes.

For example, enter -m3,4 to add notes a minor third below and a fourth above the selected 
notes.

4. Press Return  to close the popover.

RESULT
Notes are added to the selected notes according to the intervals specified.

RELATED LINKS
Notations toolbox on page 202
Note tools popover on page 498

Note durations
In Dorico Pro, you can change note durations both during note input and for existing notes.

RELATED LINKS
Notes and rests in Dorico on page 26
Note and rest grouping on page 1021
Played vs. notated note durations on page 793
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Selecting note/rest durations
You can select different durations for notes/rests, both during note input and for existing notes/
rests.

PROCEDURE

1. Optional: If you want to select a note duration not shown in the Notes panel, click the Show/
Hide All Notes disclosure arrows at the top and bottom of the notes list to show more note 
durations.

2. Select a note/rest duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

3. Optional: Add rhythm dots to the duration in one of the following ways:

● For a single rhythm dot, press . .

● For multiple rhythm dots, press Alt/Opt-.  to cycle through different numbers of rhythm 
dots. You can specify up to four rhythm dots.

● In the Notes toolbox, click Dotted Notes  to add the displayed number of rhythm 
dots.

● In the Notes toolbox, click and hold Dotted Notes  to access different numbers of 
rhythm dots.

NOTE

You cannot add rhythm dots to grace notes.

RELATED LINKS
Notes toolbox on page 197
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Notes panel on page 201
Caret on page 215
Key commands in Dorico on page 29
Inputting notes on page 221

Changing the duration of notes
You can lengthen/shorten the duration of notes after they have been input.

PROCEDURE

1. In Write mode, select the notes whose duration you want to change.
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NOTE

If you want to extend a note to the end of the current selection, select both that note and an 
item at the rhythmic position to which you want to extend the note.

2. Change the duration in any of the following ways:

● Press the key command of the duration you want. For example, press 4  for a 16th note 
(semiquaver).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

● To lengthen notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To double the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To halve the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● To lengthen notes by the current rhythmic grid resolution, choose Write > Edit 
Duration > Lengthen Duration by Grid Value.

● To shorten notes by the current rhythmic grid resolution, choose Write > Edit 
Duration > Shorten Duration by Grid Value.

● To double the length of notes, choose Write > Edit Duration > Double Note Duration.

● To halve the length of notes, choose Write > Edit Duration > Halve Note Duration.

● To lengthen notes up to the next existing note in their voice, choose Write > Edit 
Duration > Extend to Next Note.

NOTE

This does not apply to grace notes.

● To lengthen a single note up to the rhythmic position of the end of the current selection, 
choose Write > Edit Duration > Extend to End of Selection.

● To shorten overlapping notes in the same voice so that they no longer overlap, choose 
Write > Edit Duration > Shorten to Next Note.

RESULT
The duration of the selected notes is changed. Dorico Pro automatically notates and beams the 
notes appropriately according to their new duration, the prevailing time signature, and their 
position in the bar.

When extending notes, their duration fills in any intervening rests. Extending notes to the end 
of the current selection does not delete any intervening notes, instead they combine with the 
extended note to create chords where necessary.

TIP

You can assign your own key commands to lengthen/shorten notes by specific durations and to 
extend them. You can find these by searching for Shorten duration by, Lengthen duration by, 
and Extend to on the Key Commands page in Preferences.

RELATED LINKS
Notes panel on page 201
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Notes toolbox on page 197
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Rhythmic grid on page 214
Key Commands page in the Preferences dialog on page 63
Insert mode on page 454
Chord mode on page 254
Lengthening/Shortening items on page 436
Played vs. notated note durations on page 793

Splitting notes by duration
You can split notes by either a specific duration, the current rhythmic grid resolution, or the 
duration between the start of the note and the caret position; for example, to turn a long tie 
chain into a sequence of eighth notes.

PROCEDURE

1. In Write mode, select the notes you want to split.

2. Split the selected notes in any of the following ways:

● To split them by the current rhythmic grid resolution, press Alt/Opt-U  or choose 
Write > Edit Duration > Split by Rhythmic Grid Resolution.

● To split them by the duration between the start of the note and the caret position, 
activate the caret, extend it across the required staves, move the caret to the required 
position, then press Alt/Opt-U .

● To split them by a specific duration, choose Write > Edit Duration > Split by Note 
Duration > [Note duration].

RESULT
The selected notes, or notes across which the caret extends, are split into multiple, shorter notes 
of the corresponding duration. If multiples of the selected duration do not fit exactly into the 
original notes, the final note is shortened.

EXAMPLE

A phrase containing long notes Up-stem notes split into eighth notes

RELATED LINKS
Rhythmic grid on page 214
Caret on page 215
Activating/Deactivating the caret on page 219
Moving the caret manually on page 220
Extending the caret to multiple staves on page 219
Deleting ties on page 1630
Splitting tie chains on page 1631
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Forcing the duration of notes/rests
Dorico Pro automatically notates and beams notes/rests appropriately according to the 
prevailing time signature and their position in the bar. You can force the duration of notes/rests 
to specify their notation.

For example, if you input a half note at the start of a 6/8 bar, it is notated as a dotted quarter 
note (crotchet) tied to an eighth note (quaver). This is because, according to convention, 6/8 bars 
are subdivided into two groups of three eighth notes. To reflect this for a half note (four eighth 
notes), Dorico Pro automatically divides the note to show the correct grouping, but you can force 
the note duration to show a half note instead.

TIP

If you want to force the duration of all notes on a staff to imply a different meter, for example, 
to show three quarter note groups in 6/8 to indicate a hemiola, you can also input a time 
signature only on those staves to group notes according to that meter. You can then hide the 
time signatures if required.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select existing notes whose duration you want to force.

TIP

If you later want to tie notes together, we recommend forcing the duration of all notes 
you want in the tie chain.

2. Optional: If you want input rests with forced durations, start rest input in any of the following 
ways:

● Press , .

● In the Notes toolbox, click Rests .

3. Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

4. Select the note/rest duration you want.

TIP

If you want tie chains to appear as single noteheads with the same total duration, you must 
first reduce their duration, then change it to the duration you want.

5. Optional: During note or rest input, input the notes or rests you want.

RESULT
During note or rest input, any notes you input are notated with their whole rhythmic value, 
whatever their position in the bar. If you move them later, they keep the same notation. Rests are 
input as explicit rests. Notes that cross barlines are notated as tied notes.

Forcing the duration of existing notes or rests preserves their current duration or any duration to 
which you subsequently change them.
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TIP

● Force position and duration in the Notes and Rests group of the Properties panel is 
activated automatically for rests input with forced durations. You can also use this property 
to force the duration and position of rests.

● You can choose whether or not Force Duration retains its previous state when you stop and 
restart note input in Preferences > Note Input and Editing > Note Input.

● You can change how notes are grouped in different contexts project-wide on the Note 
Grouping page in Notation Options.

EXAMPLE

Default notation of notes in 6/8 Notes in the down-stem voice input with forced 
durations

RELATED LINKS
Implicit vs. explicit rests on page 1488
Notes toolbox on page 197
Notes panel on page 201
Caret on page 215
Inputting notes on page 221
Inputting rests on page 246
Inputting ties on page 248
Selecting note/rest durations on page 259
Changing the duration of notes on page 259
Notation Options dialog on page 837
Beam grouping according to meters on page 999
Note and rest grouping on page 1021
Creating custom beat groupings for meters on page 1021
Turning explicit rests into implicit rests on page 1490

MIDI recording
MIDI recording is a way of inputting notes into Dorico Pro by playing them in real time on a MIDI 
device. This can be particularly useful if, for example, you prefer to improvise your music rather 
than plan pitches and note durations in advance.

In Dorico Pro, you can record MIDI notes using any MIDI device.

Dorico Pro automatically transcribes multiple simultaneous parts into separate voices, such as 
in contrapuntal piano music. Depending on your settings for MIDI recording and quantization, 
Dorico Pro can also detect slurs, tremolos, trills, pedal lines, tuplets, and grace notes.

Outside of note input, Dorico Pro uses the instrument sounds of your most recent selection for 
the notes you play on your MIDI device. In Play mode, this is the most recent track header you 
clicked, while in Write mode, this is the last instrument staff on which you selected an item, 
started note input, or into which you recorded MIDI. During note input, Dorico Pro always uses 
the instrument sounds of the instrument into which you are recording notes.
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TIP

You can enable/disable MIDI thru on the Play page in Preferences. For example, if you do not 
want to hear sounds in Dorico Pro when playing on your MIDI keyboard.

As you play notes on your MIDI device, Dorico Pro uses an algorithm to produce the correct 
enharmonic spelling for those notes.

RELATED LINKS
Optimization for MIDI recording on page 268
Preferences dialog on page 61
Quantization options on page 98
MIDI Import Options dialog on page 90
Voices on page 1704
Pedal lines on page 1367
Slurs on page 1502
Tremolos on page 1659
Trills on page 1295
Tuplets on page 1669
Grace notes on page 1193

Inputting notes using MIDI recording
You can input notes by recording what you play on a MIDI device in real time. You can record 
notes in both concert and transposed pitch.

PREREQUISITE

● You have connected the MIDI device you want to use.

● You have set the quantization and recording options on the Play page in Preferences as 
required for the music you intend to record.

● You have input enough bars or empty rhythmic space for the amount of music you want to 
record. Dorico Pro does not automatically add extra bars or rhythmic space.

● If you want to hear a click during your recording, you have input a time signature. There is 
no click in open meter or when there is no time signature.

● You have chosen the appropriate input pitch setting.

PROCEDURE

1. Select a note or rest on the staff/instrument track into which you want to record notes, at the 
position from which you want to record. You can do this in Write mode and Play mode.

NOTE

● In Play mode you cannot select rests, meaning you can only record into instrument 
tracks that already contain at least one note.

● You can also record MIDI during note input, but this prevents Dorico Pro from using 
both staves in grand staff instruments.

2. Optional: If you want to record notes without overwriting any existing notes on the staff, 
activate Chord mode in any of the following ways:

● Press Q .

● In the Notes toolbox, click Chords .
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3. Optional: If you want to record into a specific voice on the staff, in Write mode, press Shift-N 
to start note input, then do one of the following:

● If the voice you want already exists on the staff, press V  until the note symbol beside 
the caret indicates the correct voice.

● If the voice you want does not exist on the staff yet, press Shift-V  until the note symbol 
beside the caret indicates the correct voice.

4. Press Ctrl/Cmd-R  to start recording.

During recording, the playhead appears red and moves along in time. By default, there is 
one bar of count-in before the playhead reaches the rhythmic position of either your original 
selection or the caret.

5. Play the notes you want on your MIDI device.

NOTE

Notes do not appear until you stop recording.

6. Press Space or Enter  or Ctrl/Cmd-R  to stop recording.

RESULT
The notes you played on the MIDI device are input onto the selected staff.

If you did not specify the voice, notes are recorded into voices according to what you played. 
For example, if you played notes in rhythmic unison, they are recorded into a single voice. If you 
played notes with different rhythms, they are recorded into separate voices, up to two voices per 
staff.

If you activated Chords, the notes you played are merged into the first available voice on the 
staff without overwriting any existing notes.

The notated duration of the notes follows your quantization options, but their played durations 
are retained for playback.

AFTER COMPLETING THIS TASK

● If the notes you played in are not notated as you intended, you can requantize them.

● If you do not want to retain played durations for playback, you can reset playback overrides.

RELATED LINKS
Quantization options on page 98
Optimization for MIDI recording on page 268
Enabling/Disabling MIDI input devices on page 271
Changing the count-in duration on page 268
Changing the input pitch setting on page 228
Changing the sustain pedal controller settings for MIDI recording/import on page 270
Repeats in MIDI recording on page 266
Input methods for bars, beats, and barlines on page 302
Input methods for time signatures and pick-up bars on page 284
Inputting notes into multiple voices on page 231
Turning existing notes into grace notes on page 1195
Resetting playback overrides on page 794
Preferences dialog on page 61
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Retrieving played notes that you did not record
During playback, you can play notes on your MIDI keyboard and hear them without recording 
them into the score. You can use retrospective recording to retrieve these notes and input them 
into the project without previously explicitly recording them. For example, if you only intended to 
experiment with ideas, but afterwards decided you wanted to keep them.

PREREQUISITE
You have started playback, played notes on a MIDI device alongside playback, then stopped 
playback.

PROCEDURE

1. In Write mode, select a note or rest on the staff where you want to input the retrieved notes.

2. Optional: If you want to input retrieved notes without overwriting any existing notes on the 
staff, press Q  to activate Chords.

3. Retrieve the notes you played in any of the following ways:

● Press Ctrl/Cmd-Alt/Opt-R .

● In the Transport window, click Retrospective Record .

RESULT
All the notes you played on your MIDI device during the previous playback are input on the 
selected staff, starting from the selected rhythmic position. They are input into the first available 
voice on the staff and overwrite any existing notes in that voice by default. If you activated 
Chords, the retrieved notes are merged into the first available voice on the staff without 
overwriting any existing notes.

NOTE

The retrospective recording buffer is cleared each time you start playback, meaning you cannot 
retrieve music you played before the most recent playback.

RELATED LINKS
Playing back music on page 632
Transport window on page 649

Repeats in MIDI recording
When recording MIDI into flows that contain repeat structures, such as repeat barlines, Dorico 
Pro records the notes you play during each playthrough and merges them together into the 
same voice.

Any differences in rhythms between the recordings are notated according to the current meter.

Requantizing notes
You can requantize notes using different quantization options. For example, if you want to 
change notated rhythms after importing MIDI or recording notes using a MIDI device. This does 
not affect the played duration of notes in playback.

PROCEDURE

1. Select all the notes you want to requantize. You can do this in Write mode and Play mode.

2. Choose Edit > Requantize to open the Requantize dialog.
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3. Change the quantization options as required.

4. Click OK to save your changes and close the dialog.

RESULT
The notated durations of all selected notes are changed according to the quantization options. 
This does not affect their played duration in playback.

RELATED LINKS
Quantization options on page 98
Resetting playback overrides on page 794
Large selections on page 428
Selecting/Deselecting notes and items individually on page 426

Changing the click settings
You can change the sound, volume, and subdivision of the metronome click, which is always used 
during MIDI recording. During playback, the click only sounds if the metronome is activated.

By default, Dorico Pro only subdivides the beat in the metronome click in compound time 
signatures, and uses a click for the metronome click sound. The click uses different tones for 
the first beat in each bar, subsequent beats, and further beat subdivisions.

NOTE

● There is no click in open meter or when there is no time signature.

● The click is produced by a tone generator called DoricoBeep. You can use the Tempo track in 
Play mode to change the device used for the click.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Click.

3. In the Metronome Click section, activate/deactivate the following options for Beat 
subdivisions:

● Subdivide beats in simple time signatures

● Subdivide beats in compound time signatures

4. Choose one of the following options for Click sound:

● Click (unpitched)

● Beep (pitched)

● Wood Block

5. For Pitch and velocity, change the MIDI pitch and/or Velocity values for any of the 
following types of beat:

● First beat

● Subsequent beats

● Beat subdivisions

6. Click Apply, then Close.
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RESULT
The sound, volume, and subdivision settings for the metronome click in the current project are 
changed.

RELATED LINKS
Types of time signatures on page 1641
Input methods for time signatures and pick-up bars on page 284
Playback templates on page 651
Playing back music on page 632
MIDI recording on page 263
Tempo track on page 625
Changing the sound used for the click on page 625

Changing the count-in duration
For each project, you can change the default number of bars used in the count-in before you 
start recording. By default, Dorico Pro provides a one bar count-in.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Click.

3. In the Count-in section, change the value for Number of bars count-in.

4. Click Apply, then Close.

RESULT
The default duration of the count-in is changed in the current project.

Optimization for MIDI recording
Depending on your operating system and the MIDI devices you use for recording, you might find 
that the notes you record are not notated with the durations or at the rhythmic positions you 
expected. Optimizing the settings related to MIDI recording can help you achieve better results.

● You can find options that affect MIDI recording on the Play page in Preferences.

Because there can be a time latency between you pressing keys on a MIDI device and the notes 
being picked up by Dorico Pro, we recommend that you check the latency by inputting a simple 
rhythm against the click; for example, recording quarter notes in a 4/4 time signature.

Depending on the results, there are different settings you can change:

● If your notes are notated with incorrect durations, such as sixteenth notes notated as eighth 
notes, we recommend that you change the quantization options.

● If notes are input with missing or incorrect notations, we recommend that you change the 
detected notations in Preferences > Play > Recording.

NOTE

Notation settings are linked between Preferences and the MIDI Import Options dialog.

● If your notes are notated ahead of the beat, we recommend that you increase the latency 
compensation value.
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● If your notes are notated behind the beat, we recommend that you reduce the buffer size 
for your audio device to the lowest possible value that still produces stable playback with no 
drop-outs.

NOTE

The built-in audio device on Windows computers cannot always achieve a low enough 
latency for reliable input in real time. In such cases, we recommend that you use an external 
USB audio interface with ASIO support.

RELATED LINKS
Quantization options on page 98
MIDI Import Options dialog on page 90
Changing the sustain pedal controller settings for MIDI recording/import on page 270
Turning existing notes into grace notes on page 1195
Changing the sound used for the click on page 625
Preferences dialog on page 61
Pedal lines on page 1367
Slurs on page 1502
Tremolos on page 1659
Trills on page 1295
Tuplets on page 1669
Grace notes on page 1193

Changing the MIDI latency compensation value
You can change the MIDI latency compensation value to correct any discrepancy between when 
you press keys during MIDI recording and where the corresponding notes are notated relative to 
the beat.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Recording subsection, change the value for MIDI input latency compensation.

4. Click Apply, then Close.

RESULT
Increasing the latency compensation value increases the time between pressing the key and the 
note being notated. This is useful if the notes you record were previously notated ahead of the 
beat.

Decreasing the latency compensation value decreases the time between pressing the key and 
the note being notated. This is useful if the notes you record were previously notated behind the 
beat.
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Changing the audio device buffer size
You can change the audio buffer size; for example, if the current buffer size is causing notes 
input using MIDI recording appear significantly after the beat.

NOTE

● If the notes you play when recording MIDI are notated behind the beat, we recommend 
that you reduce the buffer size for your audio device to the lowest possible value that still 
produces stable playback with no drop-outs.

● The built-in audio device on Windows computers cannot always achieve a low enough 
latency for reliable input in real time. In such cases, we recommend that you use an external 
USB audio interface with ASIO support.

PROCEDURE

1. Choose Edit > Device Setup to open the Device Setup dialog.

2. Select the audio device whose buffer size you want to change from the ASIO Driver menu.

3. Click Device Control Panel to open the device settings dialog for the selected audio device.

4. In the audio device settings dialog, change the buffer size in one of the following ways, as 
appropriate for your operating system:

● For Windows systems, in the Audio buffer size section, either drag the slider to a 
different position or activate User definable and change the value in the Selected 
buffer size field.

● For macOS systems, select a sample rate from the Buffer Size menu.

5. Click OK (Windows)/Close (macOS) to close the audio device settings dialog.

6. Click Close to close the Device Setup dialog.

Changing the sustain pedal controller settings for MIDI recording/
import

You can change your default setting for whether Dorico Pro interprets sustain pedal controllers 
as pedal lines when recording MIDI and importing or opening MIDI files.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Recording subsection, activate/deactivate Import CC64 as pedal lines.

4. Optional: If you activated Import CC64 as pedal lines, activate/deactivate Snap pedal lines 
to previous beat.

5. Click Apply, then Close.

RESULT
When Import CC64 as pedal lines is activated, the MIDI controller CC64 is interpreted as pedal 
lines.

When Snap pedal lines to previous beat is activated, the start of pedal lines is automatically 
moved back to the start of the beat.
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NOTE

These options are also available in the MIDI Import Options dialog, and your settings are linked 
between this dialog and Preferences.

RELATED LINKS
Preferences dialog on page 61
MIDI Import Options dialog on page 90

Enabling/Disabling MIDI input devices
By default, Dorico Pro accepts MIDI input from all connected MIDI devices, including virtual 
MIDI cables and inter-application buses. You can enable/disable MIDI devices individually; for 
example, if you are using devices that continuously output MIDI data or if you want particular 
devices to remain routed exclusively to another application.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the MIDI Input Devices subsection, activate/deactivate the checkbox for each MIDI input 
device.

4. Click Apply, then Close.

Notations input
You can input many types of notations, both during note input and by adding them to existing 
notes and music. In Dorico Pro, “notation” is a broad term that includes many different items, 
including articulations, slurs, dynamics, and more.

In Dorico Pro, you can input most notations with the keyboard by using popovers and with the 
mouse by using panels.

Inputting articulations
You can input notes with articulations during note input, and you can add articulations to notes 
after they have been input.

NOTE

These steps describe selecting articulations before inputting notes. However, you can change 
this setting if you prefer to specify articulations after inputting notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the existing notes to which you want to add articulations.

2. Optional: If you want to input notes with articulations onto multiple staves at once, extend 
the caret to those staves.

3. Select the articulations you want to input in any of the following ways:
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● Press the key commands for the articulations you want.

● In the Notes panel, click the articulations you want.

● In the Keyboard panel toolbar, click the articulations you want.

4. Optional: During note input, input the notes or chords you want with your selected 
articulations.

RESULT
The selected articulations are added to the selected notes. They are positioned between 
noteheads or stems and tuplet brackets, so they are closer to the notes than tuplet brackets 
or tuplet numbers/ratios.

During note input, the selected articulations are added to all notes that are input until the 
articulations are deactivated.

NOTE

Some combinations of articulations on the same notes are not possible. For example, you cannot 
have both staccato and staccatissimo marks on the same notes, as both articulations indicate 
that notes are played shorter.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have slurs in one voice and staccatos in 
another voice.

RELATED LINKS
Articulations on page 954
Note input on page 220
Notes panel on page 201
Keyboard panel on page 207
Copying and pasting articulations on page 955
Extending the caret to multiple staves on page 219
Hiding/Showing zones on page 47
Enabling independent voice playback on page 636

Key commands for articulations
In addition to clicking them in the Notes panel, you can input common articulations by pressing 
key commands on your computer keyboard.

You can use the following key commands to input articulations with the keyboard:

Type of articulation Key command

Accent:  [

Marcato:  '

Stressed:  {

Unstressed:  @ (Windows) or " (macOS)
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Type of articulation Key command

Staccato:  ]

Tenuto:  # (Windows) or \ (macOS)

Staccatissimo: , , or  }

Combined tenuto and staccato:  ~ (Windows) or | (macOS)

Inputting slurs
You can input slurs, both during note input and by adding them to existing notes. You can also 
add slurs to existing notes on multiple staves at the same time, and to notes in different voices 
or on different staves belonging to the same instrument; for example, when phrases span both 
staves of grand staff instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add slurs.

TIP

● If you only select a single note, the slur connects that note to the next note in the 
same voice on the staff. To input slurs between notes in different voices, you must 
select both notes; for example, by selecting the first note then Ctrl/Cmd -clicking 
the second note.

● For instruments with multiple staves, such as piano and harp, you can select two 
existing notes, each on a different staff, to create cross-staff slurs. However, you 
cannot create cross-staff slurs between different instruments.

● You can select notes on multiple staves to input slurs on those staves 
simultaneously.

2. Optional: If you want to input notes and slurs onto multiple staves at once, extend the caret 
to those staves.

3. Input a slur in any of the following ways:

● Press S .

● In the Notes panel, click Slur .

● In the Keyboard panel toolbar, click Slur .

NOTE

If you added slurs to existing notes, stop here.

4. During note input, input the notes you want.

The slur extends automatically, even if there are rests between the notes you input.

5. During note input, end the slur on the currently selected note in any of the following ways:

● Press Shift-S .
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● In the Keyboard panel toolbar, click Slur .

RESULT
During note input, slurs begin from the currently selected note on all staves across which the 
caret extends, not from the caret position. Slurs extend automatically as you input notes, and 
end on the currently selected note.

When adding slurs to existing notes, the selected notes are connected by slurs. For example, if 
you select two notes belonging to one instrument and two notes belonging to another, two slurs 
are input connecting the notes on each selected staff. If you selected notes on different staves 
belonging to the same instrument, a cross-staff slur is input.

Slurs are placed either above or below the notes, depending on the stem direction of the notes 
within the selection.

TIP

When nothing is selected, you can also click Slur  in the Notes panel or Keyboard panel 
toolbar, and then click and drag to input a slur and extend it to your preferred length.

AFTER COMPLETING THIS TASK

● You can enable independent voice playback for individual instruments to hear different 
sounds in different voices simultaneously; for example, if you have slurs in one voice and 
staccatos in another voice.

● You can change the curvature direction of individual slurs.

RELATED LINKS
Notes panel on page 201
Keyboard panel on page 207
Hiding/Showing zones on page 47
Slurs on page 1502
Inputting nested slurs on page 1517
Inputting notes on page 221
Extending the caret to multiple staves on page 219
Slurs in playback on page 1530
Enabling independent voice playback on page 636
Cross-staff and cross-voice slurs on page 1516
Changing the curvature direction of slurs on page 1515
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436

Inputting fingerings
You can input fingerings on existing notes using the fingerings popover, both during note input 
and by adding them to existing notes.

NOTE

● You can only add fingerings to notes at one rhythmic position at a time, and you can only 
input as many fingerings as there are notes at each rhythmic position. For example, you can 
input three fingerings at the rhythmic position of a chord containing three notes, but only 
one fingering at the rhythmic position of a single note.

● If you select notes in multiple voices, fingerings are only input into the top voice.
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● Although they contain two numbers, substitution fingerings are considered one fingering, 
meaning you can add substitution fingerings to single notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an existing note on a single staff to which you want to add fingering.

If you want to add fingerings to all notes in a chord, select all the notes in the chord.

2. Optional: During note input, input at least one note.

3. Open the fingerings popover in any of the following ways:

● Press Shift-F .

● In the Notations toolbox, click Popovers , then Fingerings .

4. Optional: If you are inputting fingerings for fretted instruments, change the hand in one of 
the following ways:

● To switch to the right hand, press Down Arrow .

● To switch to the left hand, press Up Arrow .

The popover icon updates to show the current hand.

Fingerings popover when inputting right-hand 
fingerings

Fingerings popover when inputting left-hand 
fingerings

5. Enter the fingerings you want into the popover.

For example, enter:

● 3-2 for a substitution fingering from the third finger to the second finger.

● 1,3,5 for a chord.

● 12 to show the first two valves should be depressed on a valved brass instrument.

● p for a right-hand thumb fingering or t for a left-hand thumb fingering.

● 2/ for a fingering with a shift indicator.

6. Optional: When adding fingerings to existing notes, move the popover in one of the 
following ways:

● To advance the popover to the next note/chord in the current voice, press Space .

● To move the popover back to the previous note/chord in the current voice, press Shift-
Space .

● To advance the popover to the first note/chord in the current voice in the next bar, press 
Tab .

● To move the popover back to the first note/chord in the current voice in the previous 
bar, press Shift-Tab .

● To move the cursor and popover to the right/left and to the next/previous note/fingering 
in the current voice, press Right Arrow / Left Arrow .

7. Press Return  to close the popover.
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RESULT
The fingerings are input on the selected notes, including during note input. The popover 
advances through notes in the voice as indicated by the caret or in the same voice as your 
initial selection.

RELATED LINKS
Fingering on page 1157
Changing the rhythmic position of substitution fingerings on page 1159
Fingerings for valved brass instruments on page 1179
Deleting fingerings on page 1165
Hiding/Showing fingerings in chord diagrams on page 1062
Allowing/Disallowing thumb fingerings in chord diagrams on page 1063

Fingerings popover
The following tables contain examples of what you can enter into the fingerings popover to input 
the different types of fingerings available. The fingerings popover behaves differently for fretted 
instruments compared to other instruments, so there is a separate table for fretted instrument 
fingerings.

You can open the fingerings popover in Write mode in any of the following ways when either a 
note is selected or the caret is active:

● Press Shift-F .

● In the Notations toolbox, click Popovers , then Fingerings .

● Choose Write > Create Fingerings.

When inputting fingerings for non-fretted instruments, the icon on the left-hand side of the 
popover matches the corresponding button in the Notations toolbox. When inputting fingerings 
for fretted instruments, the icon on the left-hand side of the popover indicates whether you are 
inputting left-hand or right-hand fingerings.

Fingerings popover with an 
example entry for inputting a non-
fretted instrument fingering

Fingerings popover with an 
example entry for a left-hand 
fretted instrument fingering

Fingering button in the Notations 
toolbox

Fingerings popover with an 
example entry for a right-hand 
fretted instrument fingering

Non-fretted instruments

Type of fingering Example popover entry

Single fingerings for individual notes, including 
for brass valve numbers and trombone slide 
positions

1, 2, 3, and so on
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Type of fingering Example popover entry

Valved brass instruments 12

Single fingerings for each note in chords

For keyboard instruments, Dorico Pro 
automatically orders numbers appropriately 
according to the hand playing the notes. The 
default is:

● Right hand for the upper staff

● Left hand for the lower staff

1,3,5

Left-hand fingerings (non-fretted instruments) L2, G2, S5, I2, or H2

Right-hand fingerings (non-fretted 
instruments)

R5, D5, or M5

Thumb indicator (non-fretted instruments) T

Multiple fingerings for individual notes; for 
example, for ornaments such as mordents or 
turns

2343

Single fingerings for multiple notes: enter 
the same fingering number for two adjacent 
notes.

For example, in keyboard music the thumb 
may depress two keys simultaneously.

1,1

Alternative fingerings

NOTE

You must use parentheses in the popover, 
even if you choose to show alternative 
fingerings in square brackets.

2(3)

Editorial fingerings

NOTE

You must use square brackets in the popover, 
even if you choose to show editorial fingerings 
in parentheses.

[4]

Finger substitutions 1-3

Fingering shift indicator (string instruments) 2/
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Fretted instruments

Type of fingering Example popover entries

Left-hand fingerings 0, 1, 2, 3, 4, 5

Left-hand thumb t

Right-hand fingerings 1, 2, 3, 4, 5

p, i, m, a, e

Right-hand thumb p, t, or 1

Right-hand pinky finger e, x, c, o, or 5

These lists are not comprehensive as there are many possible fingerings. It is intended to 
illustrate how you can structure your entries to input different types of fingerings.

NOTE

Finger substitutions are shown as immediate by default, but you can change the rhythmic 
position of the substitution by changing the deferral duration.

You can change the appearance and position of each type of fingering on the Fingering page in 
Engraving Options.

RELATED LINKS
Notations toolbox on page 202
Fingering on page 1157
Project-wide engraving options for fingerings on page 1158
Engraving Options dialog on page 840
Changing the rhythmic position of substitution fingerings on page 1159
Fingerings for valved brass instruments on page 1179
Hiding/Showing fingerings in chord diagrams on page 1062
Allowing/Disallowing thumb fingerings in chord diagrams on page 1063

Input methods for key signatures
You can input key signatures with the keyboard by using the key signatures popover, and with 
the mouse by using the Key Signatures, Tonality Systems, and Accidentals panel.

NOTE

You can only input custom key signatures using the panel, you cannot input them using the 
popover.

RELATED LINKS
Key signatures on page 1210
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Key signatures popover
The table contains the entries for the key signatures popover that you can use to input the 
different key signatures available.

You can open the key signatures popover in Write mode in any of the following ways when either 
an item is selected or the caret is active:

● Press Shift-K .

● In the Notations toolbox, click Popovers , then Key Signatures .

● Select an existing key signature and press Return .

● Choose Write > Create Key Signature.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Key signatures popover with an example entry
Key Signatures, Tonality Systems, and Accidentals 
button in the Notations toolbox

Type of key signature Popover entry

Open or atonal key signature open or atonal

Major keys (capital letters) C, D, G#, Ab, and so on

Minor keys (lowercase letters) g, d, f#, bb, and so on

Number of sharps

NOTE

Assumes the major key for that many sharps.

3s, 2#, and so on

Number of flats

NOTE

Assumes the major key for that many flats.

4f, 5b, and so on

This list is not comprehensive as you can input every possible key signature. It is intended to 
illustrate how you can structure your entry to input different types of key signatures.

RELATED LINKS
Notations toolbox on page 202
Key signatures on page 1210
Types of key signatures on page 1212
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Key Signatures, Tonality Systems, and Accidentals panel
The Key Signatures, Tonality Systems, and Accidentals panel allows you to create and input 
common key signatures and your own custom key signatures. It is located in the right zone in 
Write mode.

● You can hide/show the Key Signatures, Tonality Systems, and Accidentals panel by clicking 
Panels , then Key Signatures, Tonality Systems, and Accidentals  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Key Signatures, Tonality Systems, and Accidentals panel contains the following sections:

Tonality System
Contains a menu that allows you to select tonality systems to use and provides options 
that open the Edit Tonality System dialog.

The action bar at the bottom of the section contains the following options:

● New Tonality System : Creates a new custom tonality system and opens the 
Edit Tonality System dialog.

● Duplicate Tonality System : Creates a copy of an existing tonality system that 
you can edit separately from the original and opens the Edit Tonality System 
dialog.

● Edit Tonality System : Opens the Edit Tonality System dialog and allows you to 
edit the selected existing tonality system.

● Import Tonality System : Opens the File Explorer/macOS Finder, where you can 
select the tonality system .doricolib file that you want to import into the current 
project.

● Export Tonality System : Opens the File Explorer/macOS Finder, where you can 
select the location to which you want to export the selected tonality system as 
a .doricolib file. You can then import the .doricolib file into other projects 
and share it with other users.

● Delete Tonality System : Deletes the selected tonality system.

NOTE

You cannot delete predefined tonality systems or any tonality system that is 
currently used in your project.

Used in This Flow
Contains all the key signatures currently used in the flow.

Key Signatures
Allows you to create key signatures.
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The Key Signatures section contains the following parts:

1 Major/Minor

Allow you to choose whether your key signature is Major or Minor.

2 More Sharps/Fewer Flats

Each time you click, you add one sharp accidental to the key signature, or remove 
one flat accidental from the key signature.

3 Fewer Sharps/More Flats

Each time you click, you remove one sharp accidental from the key signature, or 
add one flat accidental to the key signature.

4 Input key signature

Shows how the key signature looks on a staff. Clicking this button inputs the 
displayed key signature. If nothing in the project is selected, the key signature is 
loaded onto the mouse pointer.

Custom Key Signatures
Contains any custom key signatures you have created for the currently selected 
tonality system.

Accidentals
Contains all accidentals available in the currently selected tonality system.

RELATED LINKS
Notations toolbox on page 202
Key signatures on page 1210
Tonality systems on page 1219
Custom tonality systems on page 902
Edit Tonality System dialog on page 905
Creating custom tonality systems on page 902

Inputting key signatures with the popover
You can input key signatures using the key signatures popover, both during note input and by 
adding them to existing music. You can also input key signatures only on single staves.

NOTE

● You cannot input custom key signatures using the popover, you can only input them using 
the panel.

● It is not necessary to input different key signatures for transposing instruments, as Dorico 
Pro automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a key signature. If you 
want to input a key signature on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want to input key signatures onto multiple specific staves at once, extend the 
caret to those staves.

3. Open the key signatures popover in any of the following ways:

● Press Shift-K .

● In the Notations toolbox, click Popovers , then Key Signatures .

4. Enter the key signature you want into the popover.

For example, enter:

● G or 1s for G major.

● g for G minor.

● open for an atonal key signature.

5. Input the key signature and close the popover in one of the following ways:

● To input a key signature on all staves, press Return .

● To input a key signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, key signatures are input at the caret position, even if this is in the middle of a 
bar. However, it is preferable to input key signature changes at barlines.

When adding key signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines and clefs, and to the left of other 
items, even if this is in the middle of an existing bar. If you selected an existing key signature, the 
new key signature directly replaces the existing one.

All subsequently input notes follow the input key signature, until the next existing key signature 
or the end of the flow, whichever comes first. If playing in notes using a MIDI keyboard, 
accidentals are spelled according to the key signature.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

NOTE

An individual key signature on a single staff is not intended for transposing instruments. 
Transpositions of notes and key signatures are done automatically for transposing instruments.

RELATED LINKS
Key signatures popover on page 279
Extending the caret to multiple staves on page 219
Accidental selection during MIDI input on page 245
Key signatures on page 1210
Moving notes/items rhythmically on page 465
Transposing instruments on page 137
Making layouts transposing/concert pitch on page 173
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Respelling notes on page 484
Changing the pitch of individual notes on page 479
Transposing selections on page 480
Mapping notes to scales on page 495
Changing the tonality system on page 1220
Signposts on page 453

Inputting key signatures with the panel
You can input key signatures using the Key Signatures, Tonality Systems, and Accidentals panel, 
both during note input and by adding them to existing music. You can also input key signatures 
only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● It is not necessary to input different key signatures for transposing instruments, as Dorico 
Pro automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.

PREREQUISITE
You have created any custom key signatures, in custom tonality systems if required, that you 
want to input.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a key signature. If you 
want to input a key signature on a single staff, select an item that belongs to that staff 
only.

2. In the Notations toolbox, click Panels , then Key Signatures, Tonality Systems, and 
Accidentals  to show the Key Signatures, Tonality Systems, and Accidentals panel.

3. Optional: If you have not already used the key signature you want in the current flow, create 
the key signature you want using the Key Signatures editor in the Key Signatures, Tonality 
Systems, and Accidentals panel.

4. Input the key signature you want in one of the following ways:

● To input a key signature on all staves, click it in the Key Signatures, Tonality Systems, and 
Accidentals panel.

● To input a key signature on the selected staff only, Alt/Opt -click it in the Key Signatures, 
Tonality Systems, and Accidentals panel.

RESULT
During note input, key signatures are input at the caret position, even if this is in the middle of a 
bar. However, it is preferable to input key signature changes at barlines.

When adding key signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines and clefs, and to the left of other 
items, even if this is in the middle of an existing bar. If you selected an existing key signature, the 
new key signature directly replaces the existing one.
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All subsequently input notes follow the input key signature, until the next existing key signature 
or the end of the flow, whichever comes first. If playing in notes using a MIDI keyboard, 
accidentals are spelled according to the key signature.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

NOTE

An individual key signature on a single staff is not intended for transposing instruments. 
Transpositions of notes and key signatures are done automatically for transposing instruments.

RELATED LINKS
Notations toolbox on page 202
Key Signatures, Tonality Systems, and Accidentals panel on page 280
Key signatures on page 1210
Accidental selection during MIDI input on page 245
Moving notes/items rhythmically on page 465
Changing your mouse input settings on page 213
Transposing instruments on page 137
Making layouts transposing/concert pitch on page 173
Respelling notes on page 484
Changing the pitch of individual notes on page 479
Transposing selections on page 480
Mapping notes to scales on page 495
Custom tonality systems on page 902
Custom key signatures on page 910
Creating custom tonality systems on page 902
Creating/Editing custom key signatures on page 905
Changing the tonality system on page 1220
Signposts on page 453

Input methods for time signatures and pick-up bars
You can input time signatures, including time signatures with pick-up bars, with the keyboard 
by using the time signatures popover, and with the mouse by using the Time Signatures (Meter) 
panel.

NOTE

You can create most types of custom time signatures using the Create Time Signature section 
of the Time Signatures (Meter) panel, but certain time signatures are only possible using the time 
signatures popover. For example, you can only specify beat subdivisions with the time signatures 
popover.

RELATED LINKS
Preferences dialog on page 61
Time signatures on page 1639
Types of time signatures on page 1641
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Time signatures popover
The table contains the entries for the time signatures popover that you can use to input the 
different types of time signatures available.

You can open the time signatures popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

● Select an existing time signature and press Return .

● Choose Write > Create Time Signature.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Time signatures popover with an example entry
Time Signatures (Meter) button in the Notations 
toolbox

Time signatures

Type of time signature Popover entry

Simple time signatures

For example, 2/2 (two half notes per bar), 2/4 
(two quarter notes per bar), 6/8 (six eighth 
notes per bar), 3/4, 5/4, and so on

2/2, 2/4, 6/8, 3/4, 5/4, and so on

Alternating time signatures, such as 6/8+3/4 6/8 + 3/4

NOTE

You must include spaces either side of the plus 
sign.

Common time, the equivalent of 4/4 c

Cut common time, the equivalent of 2/2 cutc, cut, or ¢

Open meter indicated by X X or x

Open meter with no indication

NOTE

A time signature signpost is shown at the 
position of the open meter.

open
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Type of time signature Popover entry

Additive time signature with explicit beat 
grouping

3+2+2/8, 3+2/4, and so on

Beat grouping specified but not shown in the 
time signature

For example, a time signature of 7/8 is shown 
but beams are subdivided into 2+3+2 eighth 
notes.

[2+3+2]/8

Aggregate time signature with dashed barlines 
shown in each bar, indicating the divisions 
between the different meters

2/4|6/8

Aggregate time signature without dashed 
barlines shown in each bar

2/4:6/8

Interchangeable time signature with different 
styles: parenthesized, slash, equals sign, and 
dashed

2/4 (6/8), 2/4 / 6/8, 2/4 = 6/8, or 2/4 – 6/8

NOTE

You must include spaces either side of the 
slashes, equals signs, or dashes, and before 
opening parentheses.

Pick-up bars

Example time signature with pick-up bar Popover entry

4/4 time signature with a dotted quarter note 
pick-up

4/4,1.5

6/8 time signature with a pick-up of two eighth 
notes

6/8,2

2/2 time signature with a quarter note pick-up 2/2,0.5

TIP

The number after the comma indicates multiples of the rhythmic unit specified by the 
denominator of the time signature.

These lists are not comprehensive, as there are many possible time signatures and pick-up 
bars. They are intended to illustrate how you can structure your entry to input different time 
signatures and pick-up bars.

RELATED LINKS
Notations toolbox on page 202
Time signatures on page 1639
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Types of time signatures on page 1641
Time signature styles on page 1647
Inputting time signatures with the popover on page 288
Inputting pick-up bars with the popover on page 291
Creating custom beat groupings for meters on page 1021
Ending interchangeable time signatures on page 1655

Time Signatures (Meter) panel
The Time Signatures (Meter) panel allows you to input different time signatures. In the Create 
Time Signature section of the panel, you can create uncommon time signatures. It is located in 
the right zone in Write mode.

● You can hide/show the Time Signatures (Meter) panel by clicking Panels , then Time 
Signatures (Meter)  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Time Signatures (Meter) panel contains the following sections:

Used in This Flow
Contains any time signatures already used in the current flow.

Common
Contains common time signatures, such as 4/4, 3/4, 6/8, and 7/8.

Create Time Signature
Allows you to design your own time signatures, including alternating time signatures 
and aggregate time signatures.

The Create Time Signature section contains the following parts:

1 Time signature type menu

Allows you to select one of the following types of time signatures:

● Regular

● Additive

● Interchangeable
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● Aggregate

● Alternating

2 Time signature spaces

Allows you to combine up to four time signatures. For example, you can specify 
only one time signature for a regular time signature, but for an alternating time 
signature, you might want to include three time signatures.

3 Pick-up bar of

Allows you to include a pick-up bar before the time signature. A pick-up bar is 
not a complete bar, and so allows you to include only a few beats before the first 
complete bar.

You can select one of the following options for the number of beats in a pick-up 
bar:

● 1/2 beat

● 1 beat

● 2 beats

● 3 beats

4 Input time signature button

Click the button that displays the time signature to input it. If nothing in the project 
is selected, the time signature is loaded onto the mouse pointer.

RELATED LINKS
Notations toolbox on page 202
Time signatures on page 1639
Types of time signatures on page 1641
Time signature styles on page 1647
Inputting time signatures with the panel on page 290
Inputting pick-up bars with the panel on page 292

Inputting time signatures with the popover
You can input time signatures using the time signatures popover, both during note input and by 
adding them to existing music. You can also input time signatures only on single staves.

NOTE

Dorico Pro does not automatically add beats to fill bars according to the new time signature at 
the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature. If you 
want to input a time signature on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want to input time signatures onto multiple specific staves at once, extend 
the caret to those staves.

3. Optional: If you want Dorico Pro to add beats at the end of the region affected by the new 
time signature if required, activate Insert mode in any of the following ways:
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● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the time signature you want into the popover.

For example, enter 4/4 for a 4/4 time signature or [2+2+3]/8 for a 7/8 time signature with a 
custom beat grouping.

6. Input the time signature and close the popover in one of the following ways:

● To input a time signature on all staves, press Return .

● To input a time signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, time signatures are added at the caret position, even if this is in the middle of 
an existing bar.

When adding time signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines, key signatures, and clefs, and to the 
left of other items, even if this is in the middle of an existing bar. If you selected an existing time 
signature, the new time signature directly replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico Pro automatically inputs and moves barlines as 
required so that subsequent music is barred correctly. However, in open meters, you must input 
barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

RELATED LINKS
Time signatures popover on page 285
Extending the caret to multiple staves on page 219
Time signatures on page 1639
Pick-up bars on page 1643
Time signature styles on page 1647
Changing the separator style of interchangeable time signatures on page 1651
Changing the design of time signatures on page 1656
Inputting pick-up bars with the popover on page 291
Inputting barlines with the popover on page 308
Inputting bars/beats with the popover on page 305
Insert mode on page 454
Ending interchangeable time signatures on page 1655
Rhythmic position on page 27
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Inputting time signatures with the panel
You can input time signatures using the Time Signatures (Meter) panel, both during note input 
and by adding them to existing music. You can also input time signatures only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Dorico Pro does not automatically add beats to fill bars according to the new time signature 
at the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature. If you 
want to input a time signature on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want Dorico Pro to add beats at the end of the region affected by the new 
time signature if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

3. In the Notations toolbox, click Panels , then Time Signatures (Meter)  to show the Time 
Signatures (Meter) panel.

4. Optional: If you want to input a time signature that is not available in the Used in This Flow 
or Common sections, select the type of time signature you want to input from the menu in 
the Create Time Signature section.

5. Optional: Enter the time signatures you want into the available spaces.

6. Input the time signature you want in one of the following ways:

● To input a time signature on all staves, click it in the Time Signatures (Meter) panel.

● To input a time signature on the selected staff only, Alt/Opt -click it in the Time 
Signatures (Meter) panel.

RESULT
During note input, time signatures are added at the caret position, even if this is in the middle of 
an existing bar.

When adding time signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines, key signatures, and clefs, and to the 
left of other items, even if this is in the middle of an existing bar. If you selected an existing time 
signature, the new time signature directly replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico Pro automatically inputs and moves barlines as 
required so that subsequent music is barred correctly. However, in open meters, you must input 
barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.
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RELATED LINKS
Notations toolbox on page 202
Time Signatures (Meter) panel on page 287
Changing your mouse input settings on page 213
Time signatures on page 1639
Pick-up bars on page 1643
Time signature styles on page 1647
Changing the separator style of interchangeable time signatures on page 1651
Inputting pick-up bars with the panel on page 292
Inputting barlines with the panel on page 309
Inputting bars/beats with the popover on page 305
Insert mode on page 454
Ending interchangeable time signatures on page 1655
Rhythmic position on page 27

Inputting pick-up bars with the popover
You can input pick-up bars as part of time signatures using the time signatures popover, both 
during note input and by adding them to existing music. You can also input time signatures with 
pick-up bars only on single staves.

NOTE

Dorico Pro does not automatically add beats to fill bars according to the new time signature at 
the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a pick-up bar. If you 
want to input a pick-up bar on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want to input a pick-up bar onto multiple specific staves at once, extend the 
caret to those staves.

3. Optional: If you want Dorico Pro to add beats at the end of the region affected by the pick-up 
bar if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the time signature and the number of pick-up beats you want into the popover.

For example, enter 3/4,0.75 for a 3/4 time signature with a dotted eighth note (dotted 
quaver) upbeat or 4/4,1 for a 4/4 time signature with one quarter note upbeat. The number 
after the comma indicates multiples of the rhythmic unit specified by the denominator of the 
time signature.

6. Input the pick-up bar and close the popover in one of the following ways:

● To input a pick-up bar on all staves, press Return .
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● To input a pick-up bar only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, pick-up bars are added at the caret position as part of the specified time 
signature, even if this is in the middle of an existing bar.

When adding pick-up bars to existing music, they are added at the rhythmic position of the 
earliest selected item as part of the specified time signature. They appear to the right of barlines, 
key signatures, and clefs, and to the left of other items, even if this is in the middle of an existing 
bar. If you selected an existing time signature, the new time signature with pick-up bar directly 
replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico Pro automatically inputs and moves barlines as 
required so that subsequent music is barred correctly. However, in open meters, you must input 
barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

NOTE

● Dorico Pro does not automatically insert beats at the start of existing music to which you add 
time signatures with pick-up bars. If you add a pick-up bar at the start of a flow, that flow 
now begins in the pick-up bar, not in the first full bar. You can insert beats at the start to 
push existing music to later rhythmic positions.

● You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten 
the last bar in flows that start with a pick-up bar.

RELATED LINKS
Time signatures popover on page 285
Pick-up bars on page 1643
Defining partial bars as pick-up bars or irregular bars on page 1644
Inputting time signatures with the popover on page 288
Inputting bars/beats with the popover on page 305
Inputting barlines with the popover on page 308
Rhythmic position on page 27
Inputting notes in Insert mode on page 237
Insert mode on page 454
Insert mode scopes on page 455
Ending interchangeable time signatures on page 1655

Inputting pick-up bars with the panel
You can input pick-up bars as part of time signatures using the Time Signatures (Meter) panel, 
both during note input and by adding them to existing music. You can also input time signatures 
only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Dorico Pro does not automatically add beats to fill bars according to the new time signature 
at the end of the affected region unless Insert mode is activated.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a pick-up bar. If you 
want to input a pick-up bar on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want Dorico Pro to add beats at the end of the region affected by the pick-up 
bar if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

3. In the Notations toolbox, click Panels , then Time Signatures (Meter)  to show the Time 
Signatures (Meter) panel.

4. In the Create Time Signature section, select the type of time signature you want from the 
menu.

5. Enter the time signatures you want into the available spaces.

6. Activate Pick-up bar of and select one of the following options:

● 1/2 beat

● 1 beat

● 2 beats

● 3 beats

NOTE

Not all pick-up bar lengths are possible when using the panel. For example, you cannot 
produce a single eighth note upbeat in 6/8 with the available options. In such cases, you 
must use the time signatures popover.

7. Input the pick-up bar in one of the following ways:

● To input a pick-up bar on all staves, click the input time signature button in the Create 
Time Signature section.

● To input a pick-up bar on the selected staff only, Alt/Opt -click the input time signature 
button in the Create Time Signature section.

RESULT
During note input, pick-up bars are added at the caret position as part of the specified time 
signature, even if this is in the middle of an existing bar.

When adding pick-up bars to existing music, they are added at the rhythmic position of the 
earliest selected item as part of the specified time signature. They appear to the right of barlines, 
key signatures, and clefs, and to the left of other items, even if this is in the middle of an existing 
bar. If you selected an existing time signature, the new time signature with pick-up bar directly 
replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico Pro automatically inputs and moves barlines as 
required so that subsequent music is barred correctly. However, in open meters, you must input 
barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.
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NOTE

● Dorico Pro does not automatically insert beats at the start of existing music to which you add 
time signatures with pick-up bars. If you add a pick-up bar at the start of a flow, that flow 
now begins in the pick-up bar, not in the first full bar. You can insert beats at the start to 
push existing music to later rhythmic positions.

● You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten 
the last bar in flows that start with a pick-up bar.

RELATED LINKS
Notations toolbox on page 202
Time Signatures (Meter) panel on page 287
Pick-up bars on page 1643
Inputting pick-up bars with the popover on page 291
Defining partial bars as pick-up bars or irregular bars on page 1644
Inputting bars/beats with the popover on page 305
Inputting barlines with the panel on page 309
Rhythmic position on page 27
Inputting notes in Insert mode on page 237
Insert mode on page 454
Insert mode scopes on page 455
Ending interchangeable time signatures on page 1655
Changing your mouse input settings on page 213

Input methods for tempo marks
You can input tempo marks with the keyboard by using the tempo popover, with the mouse by 
using the Tempo panel, and in the Tempo editor. You can input a tempo mark containing just a 
text instruction, just a metronome mark, or a combination of the two.

RELATED LINKS
Tempo marks on page 1587
Tempo editor on page 810
Inputting tempo changes in the Tempo editor on page 811

Tempo popover
The following tables contain examples of what you can enter into the tempo popover to input 
tempo marks, tempo equations, and rhythmic feels for swing playback.

When you start entering a tempo into the tempo popover, a menu appears with suggestions 
containing the letters/words you enter. You can select one of these suggestions to input, or enter 
your own tempo into the popover.

You can open the tempo popover in Write mode in any of the following ways when either an item 
is selected or the caret is active:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

● Select an existing tempo mark and press Return .

● Choose Write > Create Tempo.
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The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Tempo popover with an example entry

Tempo button in the Notations toolbox

Tempo marks

Example tempo mark Popover entry

Adagio Adagio

Presto  = 176 Presto q = 176 or Presto q=176

Largo ( = 52) Largo (q = 52) or Largo (q=52)

 = 96-112 q = 96-112, q=96-112, 6 = 96-112, or 6=96-112

  = 84 q. = 84, q.=84, 6. = 84, or 6.=84

 = 60 h = 60, h=60, 7 = 60, or 7=60

 = 120 e = 120, e=120, 5 = 120, or 5=120

rit. rit. or rit

ritardando ritardando

accel. accel. or accel

accelerando accelerando

più più

meno meno

Rubato Rubato

Faster, with energy Faster, with energy

This list is not comprehensive as you can enter tempos freely and there are many possible 
metronome marks and tempo marks. It is intended to illustrate how you can structure your entry 
to input different types of tempo marks and metronome marks.

Write mode
Notations input 

295
Dorico Pro 4.3.30



NOTE

The tempo popover is case-sensitive. If you want your tempo mark to start with a capital letter, 
you must enter a capital letter into the popover.

Metronome mark beat units

Metronome mark beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

Tempo equations

Example tempo equation Popover entry

 =   e = e. or e=e.

 =  q = e or q=e

 =  q. = h or q.=h

This list is not comprehensive as there are many possible tempo equations. It is intended to 
illustrate how you can structure your entry to input different tempo equations.

NOTE

Tempo equations do not yet include tuplet durations. This is planned for future versions.
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Rhythmic feels for swing playback

Rhythmic feel Popover entry

Light 16th note swing rhythmic feel light swing 16ths

Light eighth note swing rhythmic feel light swing 8ths

Medium 16th note swing rhythmic feel medium swing 16ths

Medium eighth note swing rhythmic feel medium swing 8ths

Heavy 16th note swing rhythmic feel heavy swing 16ths

Heavy eighth note swing rhythmic feel heavy swing 8ths

Straight rhythmic feel straight (no swing)

Triplet 16th fixed rhythmic feel 2:1 swing 16ths (fixed)

Triplet 8th fixed rhythmic feel 2:1 swing 8ths (fixed)

Dotted 16th-32nd fixed rhythmic feel 3:1 swing 16ths (fixed)

Dotted 8th-16th fixed rhythmic feel 3:1 swing 8ths (fixed)

TIP

For rhythmic feels, the popover uses the name of the rhythmic feel as set in the Rhythmic Feel 
dialog. If you have created custom rhythmic feels, you can enter the name of these into the 
tempo popover.

RELATED LINKS
Notations toolbox on page 202
Tempo marks on page 1587
Types of tempo marks on page 1588
Tempo mark components on page 1589
Swing playback on page 643
Enabling swing playback for specific sections/instruments on page 645
Rhythmic Feel dialog on page 647
Changing the order of metronome marks on page 1599

Tempo panel
The Tempo panel contains the different types of tempo marks available in Dorico Pro, organized 
into sections. It is located in the right zone in Write mode.

● You can hide/show the Tempo panel by clicking Panels , then Tempo  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .
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Used in This Flow
Contains any tempo marks already used in the flow, including custom tempo marks 
added using the tempo popover.

Tap Tempo
Allows you to create an absolute tempo change based on the speed with which you 
click the Tap button. It appears as a metronome mark with no text by default. The 
metronome mark value is always rounded to the nearest integer.

You can use the available options to set the beat unit on which you want to base the 
tempo.

Absolute Tempo Change
Contains a range of tempos with both an Italian tempo indication and a metronome 
mark. You can later choose to show or hide the metronome mark for individual tempo 
marks.

You can change the range shown in the list by adjusting the slider at the top.

Gradual Tempo Change
Contains tempo marks that indicate a change in tempo over a defined period of time, 
such as rallentando or accelerando.

You can add modifiers to gradual tempo changes. Available modifiers are shown at the 
top of the section.
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Relative Tempo Change
Contains tempo marks that indicate a change in tempo that is relative to the previous 
tempo, such as mosso (movement, or with movement). They often include modifiers 
that qualify the change, such as poco meno mosso (a little less movement), and are not 
defined by a metronome mark.

You can add modifiers to relative tempo changes. Available modifiers are shown at the 
top of the section.

You can later set a relative metronome mark change as a percentage of the previous 
metronome mark for individual tempo marks.

Reset Tempo
Contains tempo marks that indicate a return to the previous tempo, such as A tempo, 
or a previously defined tempo, such as Tempo primo.

Tempo Equation
Allows you to input a tempo equation, using beat units from 16th notes to whole notes 
and up to two rhythm dots.

RELATED LINKS
Notations toolbox on page 202
Tempo marks on page 1587
Types of tempo marks on page 1588
Tempo mark components on page 1589
Changing the metronome mark value on page 1596
Hiding/Showing decimal places for metronome marks on page 1599

Inputting tempo marks with the popover
You can input tempo marks using the tempo popover, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a tempo mark. If you 
want to input a gradual tempo change across a duration, select items that span that 
duration.
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2. Open the tempo popover in any of the following ways:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

3. Enter the tempo you want into the popover.

For example, enter q=72 or Allegretto.

When you start entering a tempo into the tempo popover, a menu appears that shows 
suggested tempos containing the letters/words you enter. You can select one of these 
suggestions or you can enter your own tempo into the popover.

NOTE

If you want to show gradual tempo changes separated into syllables spread across their 
duration, such as rit-e-nu-to, we recommend selecting a suggested entry from the menu. 
Only gradual tempo changes with valid full text appear separated into syllables.

4. Press Return  to close the popover.

RESULT
During note input, tempo marks are input at the caret position. Gradual tempo changes, such as 
rallentando, are also input at the caret position with a default duration of a quarter note. Gradual 
tempo changes do not extend as you input notes.

When adding tempo marks to existing music, they are added at the rhythmic position of the 
earliest selected item. Gradual tempo changes span the duration of the selected items.

NOTE

Metronome mark values appear as integers without decimal places by default, even if you input 
decimal places. However, the exact metronome mark value you input is always reflected in 
playback.

AFTER COMPLETING THIS TASK
You can lengthen/shorten gradual tempo changes.

RELATED LINKS
Tempo marks on page 1587
Tempo track on page 625
Tempo editor on page 810
Tempo mark components on page 1589
Gradual tempo changes on page 1600
Metronome marks on page 1596
Tempo equations on page 1604
Lengthening/Shortening items on page 436
Hiding/Showing decimal places for metronome marks on page 1599
Changing the style of gradual tempo changes on page 1601
Changing the order of metronome marks on page 1599
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Inputting tempo marks with the panel
You can input tempo marks using the Tempo panel, both during note input and by adding them 
to existing music.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● You cannot specify decimal places for metronome marks using the panel. You can specify 
decimal places using the popover or by changing the metronome mark value of existing 
tempo marks.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a tempo mark. If you 
want to input a gradual tempo change across a duration, select items that span that 
duration.

2. In the Notations toolbox, click Panels , then Tempo  to show the Tempo panel.

3. In the Tempo panel, click the tempo mark you want.

TIP

If you want Dorico Pro to calculate the metronome mark for you, you can click Tap in the Tap 
Tempo section multiple times at the required speed.

4. Optional: Select a modifier from the available options.

NOTE

You can only add modifiers to a Gradual Tempo Change or a Relative Tempo Change.

RESULT
During note input, tempo marks are input at the caret position. Gradual tempo changes, such as 
rallentando, are also input at the caret position with a default duration of a quarter note. Gradual 
tempo changes do not extend as you input notes.

When adding tempo marks to existing music, they are added at the rhythmic position of the 
earliest selected item. Gradual tempo changes span the duration of the selected items.

AFTER COMPLETING THIS TASK
You can lengthen/shorten gradual tempo changes.

RELATED LINKS
Notations toolbox on page 202
Changing your mouse input settings on page 213
Tempo marks on page 1587
Tempo mark components on page 1589
Gradual tempo changes on page 1600
Metronome marks on page 1596
Tempo equations on page 1604
Hiding/Showing decimal places for metronome marks on page 1599
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Changing the metronome mark value on page 1596
Changing the style of gradual tempo changes on page 1601
Changing the order of metronome marks on page 1599

Input methods for bars, beats, and barlines
You can input both bars and barlines with the keyboard by using the bars and barlines popover, 
and also with the mouse by using the available options in the Bars and Barlines panel. The bars 
and barlines popover also allows you to input beats. Additionally, you can input bars and beats 
using the system track.

Normally you do not need to create bars in Dorico Pro, as they are created automatically as 
needed when you input music. However, you can add bars in advance if, for example, you are 
copying or arranging an existing piece of music.

RELATED LINKS
Bars on page 962
Barlines on page 967
System track on page 430
Inputting bar rests into specific voices on page 247
Repeats in playback on page 640

Bars and barlines popover
The following tables contain examples of what you can enter into the bars and barlines popover 
to add and delete bars and beats, and the entries you can use to input the different barlines 
available.

You can open the bars and barlines popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

● Choose Write > Create Bar or Barline.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Bars and barlines popover with an 
example entry for inputting bars

Bars and barlines popover with an 
example entry for a barline

Bars and Barlines button in the 
Notations toolbox

Bars

Example action Popover entry

Add two bars 2 or +2

Add fourteen bars 14 or +14

Delete one bar –1
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Example action Popover entry

Delete six bars –6

Add a bar rest rest

Delete empty bars at the end of the flow trim

This list is not comprehensive, as you can add and delete any number of bars using the popover. 
This table is intended to illustrate how you can structure your entry to input and delete bars, and 
input bar rests.

Beats

You can specify a number of beats that you want to add/delete by entering the number of beats 
you want followed by either the number that corresponds to the beat unit, such as 5 for eighth 
notes, or the letter that corresponds to the beat unit, such as h for half notes. When using 
numbers for both the number of beats and the beat unit, you must separate them with a space 
or hyphen. You can also specify beats in the form of a time signature, such as 3/4 for three 
quarter note beats.

Example action Popover entry

Add one whole note beat 1w, 1-8, 1 8, or 4/4

Add two quarter note beats 2q, 2-6, 2 6, or 2/4

Add four eighth note beats 4e, 4-5, 4 5, 4/8, or 2/4

Delete two quarter note beats –2q, -2-6, -2 6, or -2/4

Delete empty beats at the end of the flow trim

This list is not comprehensive, as you can add and delete any number of beats using the 
popover. This table is intended to illustrate how you can structure your entry to input and delete 
beats.

Beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6
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Beat unit Popover entry

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

Barlines

Type of barline Popover entry

Normal (Single) |, single, or normal

Double || or double

Final |] or final

Dashed :, dash, or dashed

Tick (top) ‘ or tick

Tick (bottom) tickbottom

Short (center) , or short

Short (top) shorttop

Thick thick

Triple ||| or triple

Start repeat |: or start

End repeat :| or end

End/Start repeat :|:, :||:, end-start, or endstart

RELATED LINKS
Notations toolbox on page 202
Inputting bar rests into specific voices on page 247
Bars on page 962
Barlines on page 967
Deleting bars/beats on page 962
Repeats in playback on page 640
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Bars and Barlines panel
The Bars and Barlines panel allows you to input bars, bar rests, and different types of barlines. It 
is located in the right zone in Write mode.

● You can hide/show the Bars and Barlines panel by clicking Panels , then Bars and Barlines 
 in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Bars and Barlines panel contains the following sections:

Insert Bars
Allows you to determine how many bars you want to insert and where to insert them, 
such as at the end of the flow.

Insert Bar Rest
Allows you to insert a bar rest.

Create Barline
Contains the different barlines you can input.

RELATED LINKS
Notations toolbox on page 202
Repeats in playback on page 640
Hiding/Showing zones on page 47

Inputting bars/beats with the popover
You can input bars/beats using the bars and barlines popover, both during note input and by 
adding them to or inserting them into existing music. For example, if you want to extend a 
cadenza in an open meter.

PREREQUISITE
If you want to input bars, you have input a time signature.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to add bars/beats. If you want to 
add bars/beats to a single staff, select an item that belongs to that staff only.

Bars/Beats are added after selected barlines and before other selected items, including 
time signatures.

2. Optional: If you want to input bars/beats onto multiple specific staves at once, extend the 
caret to those staves.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter the number of bars/beats you want to input.

For example, enter 2 to input two bars or 2q to input two quarter note beats.

5. Input the bars/beats and close the popover in one of the following ways:

● To input bars/beats for all staves, press Return .
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● To input bars/beats only on the selected staff or staves across which the caret extends, 
press Alt/Opt-Return .

RESULT
The number of bars or beats specified is input.

During note input, bars/beats are input from the caret position. If the caret is in the middle of 
the bar when inputting bars, sufficient beats are added to ensure that the final bar created has 
the correct number of beats. The caret position stays at its previous position so you can continue 
inputting music from the same position.

When you add bars/beats to existing music, they are added after selected barlines and before 
other selected items, including time signatures.

TIP

Another way to add bars is by choosing a note duration, such as a whole note when in a 4/4 time 
signature, and pressing Space  repeatedly during note input.

RELATED LINKS
Bars and barlines popover on page 302
Bars on page 962
Inputting time signatures with the popover on page 288
Types of time signatures on page 1641

Inputting bars with the panel
You can input bars using the Bars and Barlines panel, both during note input and by inserting 
them into existing music.

PREREQUISITE
You have input a time signature.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an existing barline after which you want to input bars.

● Select an existing item before which you want to input bars.

2. In the Notations toolbox, click Panels , then Bars and Barlines  to show the Bars and 
Barlines panel.

3. In the Insert Bars section of the Bars and Barlines panel, change the number of bars you 
want to input by changing the value in the value field.

4. Select one of the following options for where you want to input bars:

● Start of Flow: Bars are input at the beginning of the flow.

● Start of Selection: Bars are input from the selected note or rest.

● End of Flow: Bars are input at the end of the flow.

NOTE

If you want to input bars from the caret position, make sure that you have selected Start 
of Selection from the menu.
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5. Click Insert Bars.

RESULT
The number of bars specified is input. During note input, bars are input from the caret position.

If you selected Start of Selection, bars are input directly after a selected barline, and directly 
before a selected note, bar, or time signature.

TIP

Another way to add bars is by choosing a note duration, such as a whole note when in a 4/4 time 
signature, and pressing Space  repeatedly during note input.

RELATED LINKS
Notations toolbox on page 202
Bars on page 962
Inputting time signatures with the panel on page 290

Inputting bars/beats with the system track
You can insert bars/beats into existing music using the system track; for example, if you decide 
you want to repeat several bars before the next section. You can insert whole bars and just a few 
beats.

NOTE

You cannot use the system track during note input.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In the system track, select the region whose duration you want to insert.

For example, if you want to insert two bars, select two bars in the system track immediately 
before where you want the two new bars to be input.

2. Click Add above the system track.

Add button above the system track The Add button is highlighted when you hover 
over it

RESULT
The rhythmic duration selected in the system track is added immediately after the end of the 
selection. Existing music after the selection is pushed back after the inserted bars/beats.

RELATED LINKS
System track on page 430
Hiding/Showing the system track on page 431
Selecting bars with the system track on page 431
Selecting beats with the system track on page 432
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Inputting barlines with the popover
You can input barlines using the bars and barlines popover, both during note input and by 
adding them to existing music. You can also change the type of existing barlines.

PREREQUISITE
If you want to input barlines onto single staves only, you have input an independent time 
signature on those staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a barline. If you want to 
input a barline on a single staff, select an item that belongs to that staff only.

TIP

If you want to add repeat barlines at the start/end of a region simultaneously, select 
items that span the required duration.

2. Optional: If you want to input barlines onto multiple specific staves at once, extend the caret 
to those staves.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter the barline you want into the popover.

For example, enter || for a double barline, or |: for a start repeat barline.

5. Input the barline and close the popover in one of the following ways:

● To input a barline on all staves, press Return .

● To input a barline only on the selected staff or staves across which the caret extends, 
press Alt/Opt-Return .

NOTE

You can only input barlines onto single staves that already have an independent time 
signature.

RESULT
During note input, barlines are input at the caret position.

When you add barlines to existing music, they are added at the rhythmic position of the earliest 
selected item. They appear to the right of clefs and to the left of other items. If you selected an 
existing barline, the new barline directly replaces the existing one.

When you add start repeat barlines with a range of items selected, end repeat barlines are also 
added at the end of the selection.

Surrounding music automatically adjusts to accommodate the barline. For example, note 
grouping, rests, and tied notes all adjust if necessary. Inputting final barlines at the end of the 
last bar of flows can automatically trim the flow if there is no further music and depending on the 
time signature.
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NOTE

Normal barlines that you have input directly, such as to replace an existing double barline, 
are still considered explicit barlines and break multi-bar rests. Deleting barlines resets them 
completely.

RELATED LINKS
Bars and barlines popover on page 302
Barlines on page 967
Inputting notes on page 221
Inputting time signatures with the popover on page 288
Extending the caret to multiple staves on page 219
Deleting notes/items on page 459
Deleting bars/beats on page 962
Repeats in playback on page 640
Changing the number of playthroughs at repeat barlines on page 641

Inputting barlines with the panel
You can input barlines using the Bars and Barlines panel, both during note input and by adding 
them to existing music. You can also change the type of existing barlines.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PREREQUISITE
If you want to input barlines onto single staves only, you have input an independent time 
signature on those staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a barline. If you want to 
input a barline on a single staff, select an item that belongs to that staff only.

TIP

If you want to add repeat barlines at the start/end of a region simultaneously, select 
items that span the required duration.

2. In the Notations toolbox, click Panels , then Bars and Barlines  to show the Bars and 
Barlines panel.

3. Input the barline you want in one of the following ways:

● To input a barline on all staves, click it in the Create Barline section.

● To input a barline on the selected staff only, Alt/Opt -click it in the Create Barline 
section.
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NOTE

You can only input barlines onto single staves that already have an independent time 
signature.

RESULT
During note input, barlines are input at the caret position.

When you add barlines to existing music, they are added at the rhythmic position of the earliest 
selected item. They appear to the right of clefs and to the left of other items. If you selected an 
existing barline, the new barline directly replaces the existing one.

When you add start repeat barlines with a range of items selected, end repeat barlines are also 
added at the end of the selection.

Surrounding music automatically adjusts to accommodate the barline. For example, note 
grouping, rests, and tied notes all adjust if necessary. Inputting final barlines at the end of the 
last bar of flows can automatically trim the flow if there is no further music and depending on the 
time signature.

NOTE

Normal barlines that you have input directly, such as to replace an existing double barline, 
are still considered explicit barlines and break multi-bar rests. Deleting barlines resets them 
completely.

RELATED LINKS
Notations toolbox on page 202
Barlines on page 967
Bars and barlines popover on page 302
Inputting notes on page 221
Inputting time signatures with the panel on page 290
Changing your mouse input settings on page 213
Repeats in playback on page 640
Changing the number of playthroughs at repeat barlines on page 641

Input methods for dynamics
You can input dynamics with the keyboard by using the dynamics popover, and with the mouse 
by using the Dynamics panel.

You can also input dynamic points that affect playback, but do not appear in the music, in the 
Dynamics editor.

RELATED LINKS
Dynamics on page 1104
Inputting dynamics with the popover on page 314
Inputting dynamics with the panel on page 316
Niente markings on page 1129
Adding modifiers to existing dynamics on page 1117
Dynamics editor on page 799
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Dynamics popover
The table contains examples of what you can enter into the dynamics popover to input the 
different dynamics available.

You can open the dynamics popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-D .

● In the Notations toolbox, click Popovers , then Dynamics .

● Select an existing dynamic and press Return .

● Choose Write > Create Dynamic.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Dynamics popover with an example entry
Dynamics button in the Notations toolbox

Dynamics popover entries

Dynamic or modifier Popover entry

pianissimo:  pp

piano:  p

mezzo piano:  mp

mezzo forte:  mf

forte:  f

fortissimo:  ff

fortepiano without separator:  fp

fortepiano with separator, such as - f-p, f:p, or f/p

subito subito, sub, or sub.

possibile possibile, poss, or poss.

poco poco

molto molto

più piu or più
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Dynamic or modifier Popover entry

meno meno

mosso mosso

crescendo:  <

cresc. (text) cresc

diminuendo:  >

dim. (text) dim

messa di voce hairpin:  (crescendo then 
diminuendo)

<>

messa di voce hairpin:  (diminuendo then 
crescendo)

><

A pair of grouped hairpins that looks like a 
messa di voce hairpin

NOTE

You must separate hairpins with a space.

< > or > <

niente hairpins that start/end with a small circle o< or >o

niente hairpins that start/end with the letter “n” n< or >n

sforzando:  sfz

rinforzando:  rfz

This list is not comprehensive as you can enter anything as a dynamic modifier. It is intended to 
illustrate how you can structure your entry to input different types of dynamics.

NOTE

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can input hairpins and messa di voce hairpins directly, without using the popover.

● For a crescendo hairpin, press < .

● For a diminuendo hairpin, press > .

● For a crescendo/diminuendo messa di voce hairpin, press Shift-Alt/Opt-, .

● For a diminuendo/crescendo messa di voce hairpin, press Shift-Alt/Opt-. .
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● You can change the appearance of all gradual dynamics project-wide on the Dynamics page 
in Engraving Options. You can also change the appearance of individual gradual dynamics.

Inputting modifiers into the dynamics popover

You can enter modifiers into the dynamics popover, such as poco, molto, subito, espressivo, or 
dolce. It appears in the correct italic font beside the dynamic. However, you must also enter 
an accompanying immediate dynamic, such as p or f, and separate the two with a space; for 
example, f molto or p espressivo.

You can hide immediate dynamics if you only want to show the modifier.

RELATED LINKS
Notations toolbox on page 202
Dynamics on page 1104
Dynamic modifiers on page 1116
Gradual dynamics on page 1120
Messa di voce hairpins on page 1127
Niente markings on page 1129
Groups of dynamics on page 1132
Hiding/Showing immediate dynamics on page 1113
Changing the appearance of gradual dynamics on page 1122
Hiding/Showing combined dynamic separators on page 1114
Changing the appearance of sforzando/rinforzando dynamics on page 1115
Changing the appearance/position of subito modifiers on page 1118

Dynamics panel
The Dynamics panel contains the different dynamics available in Dorico Pro, including gradual 
dynamics and dynamic modifiers, such as poco and possibile. It is located in the right zone in 
Write mode.

● You can hide/show the Dynamics panel by clicking Panels , then Dynamics  in the 
Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Dynamics panel contains the following sections:

Immediate Dynamics
Contains dynamics such as  and , and modifiers, such as subito and possibile. 
Available modifiers are shown at the top of the section in boxes.

You can only input modifiers alongside a dynamic.

Gradual Dynamics
Contains dynamics such as  and , and modifiers, such as poco and niente. Available 
modifiers are shown at the top of the section in boxes.

You can only input modifiers alongside a dynamic.

NOTE

Pairs of separate hairpins are treated differently than messa di voce hairpins. For 
example, separate hairpins each have start and end handles in Write mode, whereas 
messa di voce hairpins share a single center handle.
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Force/Intensity of Attack
Contains dynamics such as  and .

Combined Dynamics
Allows you to create custom combinations of dynamics, such as . The controls 
allow you to increase and decrease the dynamic on each side, and to swap their order.

RELATED LINKS
Notations toolbox on page 202
Dynamics on page 1104
Dynamic modifiers on page 1116
Gradual dynamics on page 1120
Messa di voce hairpins on page 1127
Niente markings on page 1129
Hiding/Showing combined dynamic separators on page 1114

Inputting dynamics with the popover
You can input dynamics and modifiers using the dynamics popover, both during note input 
and by adding them to existing music. You can also input different dynamics into each voice 
independently in multiple-voice contexts; for example, to give the separate staves of grand staff 
instruments different dynamics.

TIP

● If you want to input dynamics in the middle of tie chains, start note input, then move the 
caret to the required rhythmic position.

● You can also change dynamics during note input by following these steps when the caret is 
at the rhythmic position of the dynamic you want to change.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

NOTE

If you want to input voice-specific dynamics, the caret must be active.

● Select an item on each staff and at the rhythmic position where you want to input 
dynamics. If you want to input dynamics across a duration, select items on the staff that 
span that duration.
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2. Optional: If you want to input notes and dynamics onto multiple staves at once, extend the 
caret to those staves.

3. Open the dynamics popover in any of the following ways:

● Press Shift-D .

● In the Notations toolbox, click Popovers , then Dynamics .

4. Enter the dynamic you want into the popover.

For example, p, p<f>p, or f>.

5. Input the dynamics and close the popover in one of the following ways:

● To input the dynamics for all voices/staves belonging to the instrument, press Return .

● During note input, input the dynamics only into the voice indicated by the caret indicator 
by pressing Alt/Opt-Return .

6. Optional: During note input, advance the caret and extend open-ended gradual dynamics, 
such as p<, in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

Open-ended gradual dynamics also extend automatically as you continue inputting notes.

7. Optional: During note input, stop open-ended dynamics in any of the following ways:

● Press ? .

● Open the dynamics popover and input an immediate dynamic, such as f.

RESULT
The specified dynamics are input. Unless you input voice-specific dynamics, dynamics apply to 
all voices on all staves belonging to a single instrument, including grand staff instruments.They 
are positioned according to your settings on the Dynamics page in Engraving Options. Voice-
specific dynamics are placed on the default side of the staff for the instrument type, regardless of 
the voice’s stem direction.

Adjoining dynamics, or dynamics that were input together or in sequence, are automatically 
grouped together, both during note input and when adding dynamics to existing music.

During note input, dynamics are input at the caret position, and extend automatically if 
you included an open-ended gradual dynamic. Voice-specific dynamics are input in the voice 
indicated by the quarter note symbol beside the caret.

Outside of note input, immediate dynamics are added to the first selected item on each selected 
staff, while gradual dynamics are added across each selection on each selected staff.

NOTE

● If you entered a dynamic phrase into the popover during note input, such as p<f>p, each 
gradual dynamic lasts a quarter note (crotchet). You can lengthen/shorten gradual dynamics 
and groups of dynamics later.

● Some modifiers, such as molto, appear before immediate dynamics rather than after them, 
even if you do not enter them in that order. This follows the generally accepted practice for 
the placement of that text.

You can add modifiers before and after existing dynamics. You can also hide immediate 
dynamics later if you only want to show the modifier.

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.
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● You can input hairpins and messa di voce hairpins directly, without using the popover.

● For a crescendo hairpin, press < .

● For a diminuendo hairpin, press > .

● For a crescendo/diminuendo messa di voce hairpin, press Shift-Alt/Opt-, .

● For a diminuendo/crescendo messa di voce hairpin, press Shift-Alt/Opt-. .

AFTER COMPLETING THIS TASK
You can move dynamics within dynamic phrases and change the placement of dynamics relative 
to the staff.

RELATED LINKS
Caret on page 215
Moving the caret manually on page 220
Extending the caret to multiple staves on page 219
Dynamics on page 1104
Voice-specific dynamics on page 1115
Notations toolbox on page 202
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210
Dynamics editor on page 799
Gradual dynamics on page 1120
Messa di voce hairpins on page 1127
Niente markings on page 1129
Gradual dynamics in Engrave mode on page 1121
Changing the appearance of gradual dynamics on page 1122
Adding niente markings to existing gradual dynamics on page 1130
Groups of dynamics on page 1132
Dynamic modifiers on page 1116
Changing the appearance/position of subito modifiers on page 1118
Hiding/Showing combined dynamic separators on page 1114
Changing dynamic levels on page 1112
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436
Showing consecutive hairpins as continuous on page 1123
Hiding/Showing immediate dynamics on page 1113
Changing the staff-relative placement of items on page 441

Inputting dynamics with the panel
You can input dynamics and modifiers using the Dynamics panel, both during note input 
and by adding them to existing music. You can also input different dynamics into each voice 
independently in multiple-voice contexts; for example, to give the separate staves of grand staff 
instruments different dynamics.

NOTE

● If you want to input dynamics in the middle of tie chains, start note input, then move the 
caret to the required rhythmic position.

● You can also change dynamics during note input by following these steps when the caret is 
at the rhythmic position of the dynamic you want to change.
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● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

NOTE

If you want to input voice-specific dynamics, the caret must be active.

● Select an item on each staff and at the rhythmic position where you want to input 
dynamics. If you want to input dynamics across a duration, select items on the staff that 
span that duration.

2. In the Notations toolbox, click Panels , then Dynamics  to show the Dynamics panel.

3. Input the dynamics you want in one of the following ways:

● To input dynamics for all voices/staves belonging to the instrument, click them in the 
Dynamics panel.

● During note input, input the dynamics only into the voice indicated by the caret indicator 
by Alt/Opt -clicking them in the Dynamics panel.

NOTE

● If you want to add expressive or qualifying text to the dynamics, do not deselect them.

● When inputting voice-specific dynamics, you can release Alt/Opt  once you have input 
the dynamic level, such as .

● Gradual dynamics have a default duration of a quarter note. You can lengthen/shorten 
gradual dynamics later.

4. Optional: In the Dynamics panel, click the expressive/qualifying texts you want in the 
Immediate Dynamics and Gradual Dynamics sections.

RESULT
The specified dynamics are input. Unless you input voice-specific dynamics, dynamics apply to 
all voices on all staves belonging to a single instrument, including grand staff instruments.They 
are positioned according to your settings on the Dynamics page in Engraving Options. Voice-
specific dynamics are placed on the default side of the staff for the instrument type, regardless of 
the voice’s stem direction.

Adjoining dynamics, or dynamics that were input together or in sequence, are automatically 
grouped together, both during note input and when adding dynamics to existing music.

During note input, dynamics are input at the caret position. Gradual dynamics are input with a 
default duration of a quarter note. Voice-specific dynamics are input in the voice indicated by the 
quarter note symbol beside the caret.

Outside of note input, immediate dynamics are added to the first selected item on each selected 
staff, while gradual dynamics are added across each selection on each selected staff.

NOTE

● Some modifiers, such as molto, appear before immediate dynamics rather than after them, 
even if you do not enter them in that order. This follows the generally accepted practice for 
the placement of that text.
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You can add modifiers before and after existing dynamics. You can also hide immediate 
dynamics later if you only want to show the modifier.

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can also input gradual dynamics by clicking the gradual dynamic you want in the 
Dynamics panel when nothing is selected in the music area. Then click and drag to input 
the gradual dynamic and extend it to the length you want.

AFTER COMPLETING THIS TASK
You can move dynamics within dynamic phrases and change the placement of dynamics relative 
to the staff.

RELATED LINKS
Notations toolbox on page 202
Caret on page 215
Moving the caret manually on page 220
Dynamics on page 1104
Voices on page 1704
Gradual dynamics in Engrave mode on page 1121
Changing the appearance of sforzando/rinforzando dynamics on page 1115
Hiding/Showing combined dynamic separators on page 1114
Changing dynamic levels on page 1112
Hiding/Showing immediate dynamics on page 1113
Changing your mouse input settings on page 213

Inputting chord symbols
You can input chord symbols using the chord symbols popover with the computer keyboard and 
any connected MIDI keyboard, both for all instruments or only for individual instruments. You 
can also open the chord symbols popover during note input; however, inputting a chord symbol 
stops note input.

PREREQUISITE
If you want to input chord symbols using a MIDI device, you have connected the MIDI device you 
want to use.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input a chord symbol.

2. Open the chord symbols popover in any of the following ways:

● Press Shift-Q .

● In the Notations toolbox, click Popovers , then Chord Symbols .

NOTE

If you selected an item on a staff that has local chord symbols at earlier rhythmic positions, 
the chord symbols popover is automatically set to input local chord symbols when it opens.

3. Optional: Change the type of chord symbol you want to enter in one of the following ways:

● To input local chord symbols, press Alt/Opt-L .
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● To input global chord symbols, press Alt/Opt-G .

The popover icon updates to show the current type.

Chord symbols popover when inputting a global 
chord symbol

Chord symbols popover when inputting a local 
chord symbol

4. Enter the chord symbol you want into the chord symbols popover in any of the following 
ways:

● Enter the appropriate letters and numbers using the computer keyboard. For example, 
enter D#sus4 for a D#sus4 chord symbol or CM7|D for a Cmaj7/D polychord chord 
symbol.

● Play the chord in the Keyboard panel.

● Play the chord using a MIDI keyboard.

TIP

● To input a polychord chord symbol, play the first chord and keep the keys 
depressed, then play the second chord.

● To input a chord symbol that consists only of the root note, just play a single note.

● You can indicate root notes in any of the following ways:

● First play the root with one finger, and then play the remaining notes of the 
chord while still holding down the root.

● Play all the notes of the chord together, then release them all, then replay the 
root note.

● You can indicate altered bass notes in any of the following ways:

● Play all notes of the chord together with the altered bass note at the bottom.

● Play the chord and its altered bass note separately: Hold down the keys for the 
chord, then play the altered bass note while keeping the rest of the keys of the 
chord depressed.

5. Optional: Press Space  to advance the popover to the next beat according to the prevailing 
time signature.

TIP

You can also navigate the popover forwards and backwards by different amounts.

6. Optional: To input an individual local chord symbol when the popover is set to global, and 
vice versa, press Alt/Opt-Return  to input the chord symbol.

7. Press Return  to close the popover.

RESULT
The chord symbol specified is input. If you selected an item belonging to an instrument that 
was not already set to show chord symbols in the current layout, the corresponding player is 
automatically updated to show chord symbols for all instruments.
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Global chord symbols apply to all instruments in the project and appear on all staves set to show 
chord symbols. Local chord symbols only apply to the selected instrument. Local chord symbols 
always appear, even if global chord symbols exist at the same rhythmic positions.

NOTE

● The chord symbol may look different to what you entered into the popover. For example, 
entering D|C7 may result in two chords placed directly above each other or two chords 
placed beside each other, depending on your settings on the Chord Symbols page in 
Engraving Options.

● When you input chord symbols using a MIDI keyboard, the voicing you used is retained 
for chord symbol playback. You can reset the voicing of chord symbols input using MIDI 
keyboards.

AFTER COMPLETING THIS TASK
You can hide/show chord symbols above specific staves and hide/show chord diagrams 
alongside them.

RELATED LINKS
Notations toolbox on page 202
Keyboard panel on page 207
Chord symbols on page 1036
Generating chord symbols from notes on page 327
Generating notes from chord symbols on page 471
Hiding/Showing chord symbols on page 1040
Hiding/Showing chord symbols in layouts on page 1041
Hiding/Showing chord diagrams on page 1058
Inputting chord symbol regions on page 326
Inputting slash regions on page 418
Enabling/Disabling MIDI input devices on page 271
Chords track on page 627
Enabling chord symbol playback on page 628
Resetting the voicing of chord symbols on page 629
Engraving Options dialog on page 840

Chord symbols popover
The following tables contain examples of what you can enter into the chord symbols popover to 
input the different possible chord symbol components. You can enter them in any combination.

You can open the chord symbols popover in Write mode in any of the following ways when either 
an item is selected or the caret is active:

● Press Shift-Q .

● In the Notations toolbox, click Popovers , then Chord Symbols .

● Select an existing chord symbol and press Return .

● Choose Write > Create Chord Symbol.

When inputting global chord symbols, the icon on the left-hand side of the popover matches the 
corresponding button in the Notations toolbox. When inputting local chord symbols, the icon on 
the left-hand side of the popover appears smaller and includes the icon for a single player.
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Chord symbols popover with an 
example entry for a global chord 
symbol

Chord symbols popover with an 
example entry for a local chord 
symbol

Chord Symbols button in the 
Notations toolbox

NOTE

You can combine multiple types of entries to create more complex chord symbols if you enter 
them one after another into the chord symbols popover without spaces between them. For 
example, enter Eblocrian for the following chord symbol:

Chord symbol roots

Type of chord symbol root Popover entry

English note names

C, D♭, F♯, B, and so on

C, Db, F#, B, and so on

German note names

C, D♭, F♯, H, and so on

C, Des, Fis, H, and so on

Fixed-do solfège

C, D♭, F, F♯, B, and so on

do, reb, fa, fa#, ti, and so on

Nashville numbers representing scale degrees

Assuming C major:

C, D♭, F♯, B, and so on

1, 2b, 4#, 7, and so on

TIP

When using a MIDI keyboard, you can also indicate root notes in any of the following ways:

● First play the root with one finger, and then play the remaining notes of the chord while still 
holding down the root.

● Play all the notes of the chord together, then release them all, then replay the root note.

Chord symbol qualities

Chord symbol quality Popover entry

Major maj, M, ma, or nothing after entering the root.

Minor m, min, or mi
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Chord symbol quality Popover entry

Diminished dim, di, or o

Augmented aug, au, ag, or +

Half-diminished half-dim, halfdim, or hd

6/9 6/9, 69, or %

NOTE

M and m entries for major and minor are case-sensitive.

Chord symbol intervals

Interval Popover entry

Major 7th ^7 or ^

Major 9th ^9, maj9, or 9maj7

Chord symbol alterations

Type of chord symbol alteration Popover entry

Alterations b5, -5, #9, +9, b10, and so on

Added notes add#11, add+11, addb9, add-9, addF#, 
addBb, and so on

Suspensions sus4, sus9, and so on

Omissions omit3, no7, and so on

Chord symbols with altered bass notes

Example altered bass note chord symbols Popover entry

G7/D G7/D, G7,D, Gmaj7/D or Gmaj7,D

C(♭5)/E♭ CMb5/Eb, CMb5,Eb, Cmajb5/Eb, or Cmajb5,Eb

Fm/D♯ Fm/D#, Fm,D#, Fmi/D#, or Fmi,D#
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TIP

When using a MIDI keyboard, you can also indicate altered bass notes in any of the following 
ways:

● Play all notes of the chord together with the altered bass note at the bottom.

● Play the chord and its altered bass note separately: Hold down the keys for the chord, then 
play the altered bass note while keeping the rest of the keys of the chord depressed.

Polychord chord symbols

Example polychord chord symbols Popover entry

G/E G|E, G;E, Gmaj|E, or Gmaj;E

Cmaj7/D CM7|D, CM7;D, Cmaj7|D, or Cmaj7;D

Fm/D♯ Fm|D#, Fm;D#, Fmi|D#, or Fmi;D#

TIP

When using a MIDI keyboard, you can also input polychord symbols by playing the first chord 
and keeping the keys depressed, then playing the second chord.

No chord symbols

No chord symbol Popover entry

No chord N.C., NC, no chord, or none

Modal chord symbols

Modal chord symbol Popover entry

Ionian ionian

Dorian dorian

Phrygian phrygian

Lydian lydian

Mixolydian mixolydian

Aeolian aeolian

Locrian locrian
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Modal chord symbol Popover entry

Melodic minor melodicminor

Harmonic minor harmonicminor

Whole tone wholetone

Half-whole diminished or octatonic diminishedhalfwhole, 
diminishedsemitonetone, 
octatonichalfwhole, or 
octatonicsemitonetone

Whole-half diminished or octatonic diminishedwholehalf, 
diminishedtonesemitone, 
octatonicwholehalf, or 
octatonictonesemitone

This list is not comprehensive, as there are many possible chord symbols. It is intended to 
illustrate the different components you can use to input different chord symbols.

NOTE

The appearance of the resulting chord symbols depends on the options you have set on the 
Chord Symbols page in Engraving Options. The structure of your entry in the chord symbols 
popover is not considered. For example, entering a C major chord as C, Cmaj, or CM results in 
the same chord symbol.

Parenthesized chord symbols

Example parenthesized chord symbol Popover entry

(Cmaj7) (Cmaj7)

Chord symbol regions

Chord symbol region Popover entry

New chord symbol region reg

RELATED LINKS
Notations toolbox on page 202
Chord symbols on page 1036
Parenthesized chord symbols on page 1050
Engraving Options dialog on page 840
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Navigation during chord symbol input

You can move the chord symbols popover manually by different amounts to input chord symbols 
at other positions without closing and reopening the popover each time.

Navigating with a computer keyboard

Popover navigation Key command

Advance the popover to the next beat, 
according to the prevailing time signature.

Space

Move the popover back to the previous beat, 
according to the prevailing time signature.

Shift-Space

Advance the popover to the start of the next 
bar.

Tab

Move the popover back to the start of the 
previous bar.

Shift-Tab

Move the cursor and popover to one of the 
following positions, whichever is closest:

● Next/Previous note or rest

● Next/Previous rhythmic grid position

● Next/Previous character in existing chord 
symbol’s entry

Right Arrow / Left Arrow

Move the popover to the next/previous chord 
symbol.

Ctrl/Cmd-Right Arrow / Ctrl/Cmd-Left Arrow

Navigating with a MIDI keyboard

When inputting chord symbols using a MIDI keyboard, by default the popover advances 
automatically to the next beat after you play a chord. You can change this behavior using the 
Advance during chord symbol input via MIDI keyboard options on the MIDI Input page in 
Note Input Options.

You can define specific keys or buttons on your MIDI keyboard to trigger different navigation 
behaviors. Use the MIDI Learn button on the Key Commands page in Preferences to assign 
specific keys to the Note Input > Advance Chord Symbol Input commands.

RELATED LINKS
Inputting chord symbols on page 318
Key Commands page in the Preferences dialog on page 63
Assigning MIDI commands on page 66
Assigning key commands on page 66
Note Input Options dialog on page 839
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Chord symbol input options for MIDI keyboards
There are different possible settings for how Dorico Pro interprets the notes you press on your 
MIDI keyboard when inputting chord symbols.

On the Chord Symbols page in Note Input Options, the available options include:

● Whether you want Dorico Pro to consider the inversion in which you play a given chord, or 
write the chord symbol as if it had been played in root position

● Whether you want Dorico Pro to notate omissions. For example, if you play C and E, it could 
be notated as “C” or “C(omit5)”

● How you want Dorico Pro to notate added notes and suspensions

● How you want Dorico Pro to handle complex enharmonic relationships between roots and 
altered bass notes

On the MIDI Input page in Note Input Options, the available options include disabling chord 
symbol input from MIDI keyboards and the default navigation behavior.

RELATED LINKS
Note Input Options dialog on page 839
Resetting the voicing of chord symbols on page 629

Inputting chord symbol regions
You can input specific regions in which you want to show chord symbols; for example, if an 
instrument that does not need chord symbols for most of the project has an improvisation 
section that requires chord symbols to be shown.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the region on the staff where you want to show chord symbols.

2. Open the chord symbols popover in any of the following ways:

● Press Shift-Q .

● In the Notations toolbox, click Popovers , then Chord Symbols .

3. Enter reg into the popover.

4. Press Return  to close the popover.

RESULT
During note input, chord symbol regions are input spanning the duration of the selected note or 
item, which is usually the last input note. When adding chord symbol regions to existing music, 
they span the selected duration.

The player holding the corresponding instrument is automatically set to show chord symbols in 
chord symbol regions and slash regions, even if it was set to hide all chord symbols before.

TIP

You can also input chord symbol regions by choosing Write > Create Chord Symbol Region. You 
can assign a key command for this option on the Key Commands page in Preferences.
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RELATED LINKS
Chord symbols popover on page 320
Chord symbol regions on page 1044
Hiding/Showing chord symbols on page 1040
Inputting slash regions on page 418
Key Commands page in the Preferences dialog on page 63

Generating chord symbols from notes
You can automatically generate chord symbols based on the harmony of notes you have already 
input. You can specify the musical context you want to consider in the calculation, such as which 
note durations and inversions to include.

PROCEDURE

1. In Write mode, select the notes from which you want to generate chord symbols.

TIP

You can select notes on multiple staves.

2. Choose Edit > Notations > Chord Symbols and Diagrams > Generate Chord Symbols from 
Selection to open the Generate Chord Symbols From Notes dialog. You can also choose 
this option from the context menu.

3. Change the settings as required.

For example, you can change the minimum note duration you want to include in chord 
symbols, and disallow the creation of open fifth chord symbols.

4. Click OK to save your changes and close the dialog.

RESULT
Chord symbols are generated based on the selected notes and your settings. Chord symbols are 
input at the rhythmic positions of chords comprising at least two or three notes, depending on 
your settings.

All instruments included in your selection are set to show chord symbols.

RELATED LINKS
Hiding/Showing chord symbols on page 1040
Generating notes from chord symbols on page 471
Calculating harp pedal diagrams based on existing music on page 381

Generate Chord Symbols From Selection dialog

The Generate Chord Symbols From Selection dialog allows you to generate chord symbols 
based on the harmony of notes you have already input, and specify the musical context you want 
to consider in the calculation.

● You can open the Generate Chord Symbols From Selection dialog in Write mode when at 
least one chord is selected in the music area by choosing Edit > Notations > Chord Symbols 
and Diagrams > Generate Chord Symbols from Selection. You can also choose this option 
from the context menu.
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The Generate Chord Symbols From Selection dialog contains the following options:

Harmonic rhythm
Allows you to set the minimum rhythmic interval between generated chord symbols.

● Every bar: Chord symbols are created at least every bar.

● Every beat: Chord symbols are created at least every beat, according to the 
prevailing time signature.

● Fixed: Chord symbols are created at the specified interval.

Minimum duration of single notes following chords to include in analysis
Allows you to set the shortest note value for single notes that you want to include in 
the chord symbol calculation. This allows you to exclude passing notes shorter than the 
set duration.

Minimum duration of chords eligible for chord symbols
Allows you to set the shortest note value for chords that you want to include in the 
chord symbol calculation. This allows you to exclude transitory chords shorter than the 
set duration.

Only use downbeats when creating chord symbols from notes at multiple positions
When activated, only notes that start on strong beats in each bar are included in the 
chord symbol calculation.

Detect inversions
Allows you to change how inversions are handled in the chord symbol calculation.

● Always: Inversions are always considered.

● Never: Inversions are never considered. This is particularly useful when calculating 
chord symbols from notes belonging to multiple instruments.

● Below specific pitch: Inversions are only considered for notes below the specified 
pitch.
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Only create chord symbols from horizontal passages when unambiguous
When activated, chord symbols are only created from notes at multiple rhythmic 
positions if the resulting chord is simple.

Try to detect and handle passing notes
When activated, Dorico Pro detects passing notes where possible and excludes them 
from the chord symbol calculation.

Use vamp detection
When activated, Dorico Pro detects rhythmic patterns and textures often used when 
vamping and considers them in the chord symbol calculation.

Minimum length for chords in vamp
Allows you to change the minimum note value for chords in vamp sections.

Maximum rhythmic separation between chords in vamp
Allows you to change the maximum gap between chords in vamp sections.

Allow creation of open fifths
When activated, Dorico Pro creates chord symbols from chords comprising only two 
notes, a fifth apart.

Allow creation of major and minor thirds
When activated, Dorico Pro creates chord symbols from chords comprising only two 
notes, a third apart.

Ignore omitted fifths
Allows you to change how chords with omitted fifths are handled.

● Never: Omitted fifths are never ignored, meaning chords are considered 
according to the notes available.

● In major/minor triads: Omitted fifths are only ignored in chords comprising only 
two notes, a third apart.

● In major/minor triads and chords with 7th: Omitted fifths are ignored in chords 
comprising only two notes, a third apart, and chords with a seventh.

● Always: Omitted fifths are always ignored, meaning chord symbols are created as 
if the fifth were present.

RELATED LINKS
Chord symbols on page 1036
Inputting chord symbols on page 318
Hiding/Showing chord symbols on page 1040
Calculating harp pedal diagrams based on existing music on page 381
Types of time signatures on page 1641
Generate Notes From Chord Symbols dialog on page 472

Input methods for clefs and octave lines
You can input clefs and octave lines with the keyboard by using the clefs and octave lines 
popover, and also with the mouse by using the Clefs panel.

Clefs and octave lines share the same popover and panel as both affect the pitch and register of 
notes.

RELATED LINKS
Clefs on page 1070
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Octave lines on page 1079

Clefs and octave lines popover
The following tables contain the entries for the clefs and octave lines popover that you can use to 
input the different clefs and octave lines available.

You can open the clefs and octave lines popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

● Select an existing clef or octave line and press Return .

● Choose Write > Create Clef.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Clefs and octave lines popover 
with an example entry for a clef

Clefs and octave lines popover 
with an example entry for an 
octave line

Clefs button in the Notations 
toolbox

Clefs

Type of clef Popover entry

Treble G clef g, G, g2, sol, or treble

Bass F clef f, F, f4, fa, or bass

Tenor C clef ct, CT, c4, ut4, or tenor

Alto C clef ca, CA, c3, ut3, or alto

Treble G clef, octave below g8ba, G8ba, g8d, G8d, treble8ba, or treble8d

Treble G clef, two octaves below g15ba, G15ba, g15d, G15d, treble15ba, or 
treble15d

Treble G clef, octave above g8va, G8va, g8u, G8u, treble8va, or treble8u

Treble G clef, two octaves above g15ma, G15ma, g15u, G15u, treble15ma, or 
treble15u

French violin clef g1

Alto C clef, octave below ca8ba, CA8ba, ca8d, CA8d, alto8ba, or alto8d
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Type of clef Popover entry

Tenor C clef, octave below ct8ba, CT8ba, ct8d, CT8d, tenor8ba, or 
tenor8d

Bass F clef, octave below f8ba, F8ba, f8d, F8d, bass8ba, or bass8d

Bass F clef, two octaves below f15ba, F15ba, f15d, F15d, bass15ba, or 
bass15d

Bass F clef, octave above f8va, F8va, f8u, F8u, bass8va, or bass8u

Bass F clef, two octaves above f15ma, F15ma, f15u, F15u, bass15ma, or 
bass15u

Unpitched percussion perc

4-string tablature tab4

6-string tablature tab6

Baritone bass clef baritonebass

Baritone clef baritone, c5, or ut5

Mezzo-soprano clef mezzo, c2, or ut2

Soprano C clef soprano, c1, or ut1

Sub-bass clef subbass

Invisible clef invisible

TIP

More clefs are available in the Clefs panel, including the Indian drum clef and rectangular 
percussion clef.

Octave shifts for clefs

Function of octave shifts Popover entry

Shift notes up by one octave +1

Shift notes up by two octaves +2

Shift notes down by one octave -1

Shift notes down by two octaves -2
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Function of octave shifts Popover entry

Set octave shift for concert pitch c

Set octave shift for transposed pitch t

For example, enter treble+1t for a treble clef shifted up one octave in transposed pitch layouts, 
causing notes after the clef in transposed pitch layouts to appear an octave lower than they 
appear with a normal treble clef.

Octave lines

Function of octave line Popover entry

Shift notes up by one octave 8va, 8, 8u, or 1u

Shift notes up by two octaves 15ma, 15, 15u, or 2u

Shift notes up by three octaves 22ma, 22, 22u, or 3u

Shift notes down by one octave 8ba, 8vb, 8d, or 1d

Shift notes down by two octaves 15ba, 15vb, 15d, or 2d

Shift notes down by three octaves 22ba, 22vb, 22d, or 3d

Loco indication loco

End of octave line

For example, enter stop to specify where an 
octave line ends during note input.

| or stop

RELATED LINKS
Notations toolbox on page 202
Clefs on page 1070
Octave lines on page 1079
Changing the octave of clefs on page 1076
Respecting/Ignoring clef octave indicators on page 1078

Clefs panel
The Clefs panel contains the different types of clefs and octave lines available in Dorico Pro, 
including uncommon and archaic clefs. It is located in the right zone in Write mode.

● You can hide/show the Clefs panel by clicking Panels , then Clefs  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Clefs panel contains the following sections:
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Common Clefs
Contains the clefs you are most likely to need, including treble clef and bass clef.

Uncommon Clefs
Contains less frequently used clefs, such as an invisible clef, treble clef octave above/
below, Indian drum clef, and French violin clef.

Archaic Clefs
Contains clefs that are rarely used any more, such as the mezzo-soprano clef, baritone 
bass clef, and sub-bass clef.

Octave Lines
Contains octave lines, indicating up to three octaves above and below, and a loco line.

RELATED LINKS
Notations toolbox on page 202
Clefs on page 1070
Octave lines on page 1079
Inputting clefs with the panel on page 334
Inputting octave lines with the panel on page 336

Inputting clefs with the popover
You can input clefs using the clefs and octave lines popover, both during note input and by 
adding them to existing music. You can also use the popover to change the type of existing clefs.

NOTE

● If you do not want to show any clef in any layout, you must input an invisible clef. You can 
also hide/show clefs according to the layout transposition.

● Many instruments in Dorico Pro have different types that show alternative clefs by default. 
You can select the appropriate instrument type from the instrument picker when adding or 
changing instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a clef. If 
you want to add a restorative clef at a later position, select items on the staff that span 
the required duration.

2. Optional: If you want to input clefs onto multiple staves at once, extend the caret to those 
staves.

3. Open the clefs and octave lines popover in any of the following ways:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

4. Enter the appropriate entry for the clef you want into the popover.

For example, enter bass for a bass clef, alto for an alto clef, or treble+1t for a treble clef 
shifted up one octave in transposed pitch layouts.

5. Press Return  to close the popover.
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RESULT
During note input, clefs are input at the caret position. Note input continues after inputting the 
clef, so you can continue inputting notes and clefs as required.

When you add clefs to existing music, clefs are added directly before a selected notehead, and 
apply to all notes on that staff until the next clef, or the end of the flow. When you add clefs to a 
range of selected items, restorative clefs are also added at the end of the selection.

Clefs apply to all notes on the staff until the next clef or the end of the flow, whichever comes 
first.

RELATED LINKS
Clefs on page 1070
Extending the caret to multiple staves on page 219
Setting different clefs for concert/transposed pitch on page 1074
Hiding/Showing clefs according to layout transpositions on page 1075
Changing the octave of clefs on page 1076
Respecting/Ignoring clef octave indicators on page 1078
Changing instruments on page 140
Adding instruments to players on page 138

Inputting clefs with the panel
You can input clefs using the Clefs panel, both during note input and by adding them to existing 
music.

NOTE

● If you do not want to show any clef in any layout, you must input an invisible clef. You can 
also hide/show clefs according to the layout transposition.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Many instruments in Dorico Pro have different types that show alternative clefs by default. 
You can select the appropriate instrument type from the instrument picker when adding or 
changing instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a clef. If 
you want to add a restorative clef at a later position, select items on the staff that span 
the required duration.

2. In the Notations toolbox, click Panels , then Clefs  to show the Clefs panel.

3. In the Clefs panel, click the clef you want.

RESULT
During note input, clefs are input at the caret position. Note input continues after inputting the 
clef, so you can continue inputting notes and clefs as required.

When you add clefs to existing music, clefs are added directly before a selected notehead, and 
apply to all notes on that staff until the next clef, or the end of the flow. When you add clefs to a 
range of selected items, restorative clefs are also added at the end of the selection.
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Clefs apply to all notes on the staff until the next clef or the end of the flow, whichever comes 
first.

RELATED LINKS
Notations toolbox on page 202
Clefs on page 1070
Changing your mouse input settings on page 213
Universal Indian Drum Notation on page 1703

Inputting octave lines with the popover
You can input octave lines using the clefs and octave lines popover, both during note input and 
by adding them to existing music. You can also input octave lines only into specific voices in 
multiple-voice contexts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add an octave line. If you want to add an octave 
line for a single voice, only select notes in that voice.

2. Optional: If you want to input octave lines onto multiple staves at once, extend the caret to 
those staves.

3. Open the clefs and octave lines popover in any of the following ways:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

4. Enter the appropriate entry for the octave line you want into the popover.

For example, enter 8va for an octave line that shifts notes up one octave.

5. Input the octave line and close the popover in one of the following ways:

● To input an octave line for all voices on the staff, press Return .

● To input an octave line only for the currently selected voice, press Alt/Opt-Return .

6. Optional: During note input, advance the caret and extend the octave line in any of the 
following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

The octave line also extends automatically as you continue inputting notes.

7. Optional: During note input, stop any octave line by opening the clefs and octave lines 
popover again and entering | or stop.

RESULT
During note input, octave lines are input from the caret position. When you stop octave lines, 
they end at the caret position.

When adding octave lines to existing music, they are input either above or below your selection, 
depending on whether the octave line indicates that notes are played higher or lower than 
notated.

The pitches of notes within octave lines are adjusted automatically. For example, notes within 
octave above lines appear an octave lower than they do without the octave above line.
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TIP

You can also lengthen/shorten octave lines after they have been input.

RELATED LINKS
Clefs and octave lines popover on page 330
Octave lines on page 1079
Lengthening/Shortening items on page 436
Changing the pitch of individual notes on page 479
Extending the caret to multiple staves on page 219
Notations toolbox on page 202
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210

Inputting octave lines with the panel
You can input octave lines using the Clefs panel, both during note input and by adding them to 
existing music. You can also input octave lines only into specific voices in multiple-voice contexts.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add an octave line. If you want to add an octave 
line for a single voice, only select notes in that voice.

2. In the Notations toolbox, click Panels , then Clefs  to show the Clefs panel.

3. Input the octave line you want in one of the following ways:

● To input an octave line for all voices on the staff, click it in the Octave Lines section.

● To input an octave line only for the currently selected voice, Alt/Opt -click it in the 
Octave Lines section.

Alternatively, when adding octave lines to existing music, you can click the octave line you 
want in the Clefs panel first, and then click and drag it to the length you want.

RESULT
During note input, octave lines are input at the caret position. They are input with a default 
duration of a quarter note.

When adding octave lines to existing music, they are input either above or below your selection, 
depending on whether the octave line indicates that notes are played higher or lower than 
notated.

The pitches of notes within octave lines are adjusted automatically. For example, notes within 
octave above lines appear an octave lower than they do without the octave above line.
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TIP

You can also lengthen/shorten octave lines after they have been input.

RELATED LINKS
Notations toolbox on page 202
Octave lines on page 1079
Lengthening/Shortening items on page 436
Changing the pitch of individual notes on page 479
Changing your mouse input settings on page 213

Input methods for holds and pauses
You can input holds and pauses with the keyboard by using the holds and pauses popover in 
Write mode, and with the mouse by using the Holds and Pauses panel.

RELATED LINKS
Holds and pauses on page 1202
Correct positioning for caesura input on page 341

Holds and pauses popover
The table contains the entries for the holds and pauses popover that you can use to input the 
different holds and pauses available.

You can open the holds and pauses popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-H .

● In the Notations toolbox, click Popovers , then Holds and Pauses .

● Select an existing hold or pause and press Return .

● Choose Write > Create Hold or Pause.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Holds and pauses popover with an example entry
Holds and Pauses button in the Notations toolbox

Fermatas

Type of fermata Popover entry

Fermata fer or fermata

Very long fermata fermataverylong

Long fermata fermatalong
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Type of fermata Popover entry

Short fermata fermatashort

Very short fermata fermataveryshort

Short fermata (Henze) fermatashorthenze

Long fermata (Henze) fermatalonghenze

Curlew (Britten) curlew

NOTE

The Curlew mark was originally devised by Benjamin Britten for “Curlew River”, a parable for 
church performance inspired by Japanese Noh theater. It indicates that a player should hold a 
note or a rest until a synchronization point in asynchronous music.

Caesuras

Type of caesura Popover entry

Caesura caes, caesura, or //

Thick caesura caesurathick, thickcaesura, or thick//

Curved caesura caesuracurved, curvedcaesura, or curved//

Short caesura caesurashort, shortcaesura, or short//

Single-stroke caesura caesurasingle, singlecaesura, or single//

Breath marks

Type of breath mark Popover entry

Breath mark (Comma-like) breathmarkcomma, comma, or , (comma)

Breath mark (Tick-like) breathmarktick

Breath mark (Upbow-like) breathmarkupbow

Breath mark (Salzedo) breathmarksalzedo

RELATED LINKS
Notations toolbox on page 202
Holds and pauses on page 1202
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Types of fermatas on page 1203
Types of caesuras on page 1204
Types of breath marks on page 1204

Holds and Pauses panel
The Holds and Pauses panel allows you to input all the different types of holds and pauses 
available in Dorico Pro, including alternative versions of fermatas. It is located in the right zone in 
Write mode.

● You can hide/show the Holds and Pauses panel by clicking Panels , then Holds and 
Pauses  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Holds and Pauses panel contains the following sections:

● Fermatas

● Breath Marks

● Caesuras

NOTE

Holds and pauses do not currently have an effect in playback, but this is planned for future 
versions.

RELATED LINKS
Notations toolbox on page 202
Inputting holds and pauses with the panel on page 340
Holds and pauses on page 1202
Types of fermatas on page 1203
Types of caesuras on page 1204
Types of breath marks on page 1204

Inputting holds and pauses with the popover
You can input holds and pauses using the holds and pauses popover, both during note input and 
by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a hold or pause. If you 
want to input a breath mark on a specific staff, select an item that belongs to that staff 
only.

NOTE

You can only input one hold or pause at a time.

2. Optional: If you want to input breath marks onto multiple staves at once, extend the caret to 
those staves.

3. Open the holds and pauses popover in any of the following ways:

● Press Shift-H .
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● In the Notations toolbox, click Popovers , then Holds and Pauses .

4. Enter the hold or pause you want into the popover.

For example, enter fermata for a pause or caesura for a caesura.

5. Press Return  to close the popover.

RESULT
During note input, the specified hold or pause is input at the caret position. When adding holds 
or pauses to existing music, they are input at the rhythmic position of the earliest selected item.

● Fermatas appear on all staves at the rhythmic position of the note, chord, or rest that 
corresponds with the end of the fermata.

● Breath marks appear to the right of the caret or selected note.

● Caesuras appear on all staves to the left of the caret or selected note.

RELATED LINKS
Extending the caret to multiple staves on page 219
Holds and pauses on page 1202
Types of fermatas on page 1203
Types of breath marks on page 1204
Types of caesuras on page 1204
Positions of holds and pauses on page 1205

Inputting holds and pauses with the panel
You can input holds and pauses using the Holds and Pauses panel, both during note input and 
by adding them to existing music.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a hold or pause. If you 
want to input a breath mark on a specific staff, select an item that belongs to that staff 
only.

NOTE

You can only input one hold or pause at a time.

2. In the Notations toolbox, click Panels , then Holds and Pauses  to show the Holds and 
Pauses panel.

3. In the Holds and Pauses panel, click the hold or pause you want.

RESULT
During note input, the specified hold or pause is input at the caret position. When adding holds 
or pauses to existing music, they are input at the rhythmic position of the earliest selected item.
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● Fermatas appear on all staves at the rhythmic position of the note, chord, or rest that 
corresponds with the end of the fermata.

● Breath marks appear to the right of the caret or selected note.

● Caesuras appear on all staves to the left of the caret or selected note.

RELATED LINKS
Notations toolbox on page 202
Holds and pauses on page 1202
Positions of holds and pauses on page 1205
Changing your mouse input settings on page 213

Correct positioning for caesura input
Caesuras are commonly placed at the end of a bar, before a barline. In Dorico Pro, caesuras 
must be attached to the note immediately after the position where you want it to appear, as then 
Dorico Pro can automatically position them correctly.

If you input caesuras with your mouse input preference set to Load pointer with item, you must 
click the first note in the next bar for a caesura to appear to the left of the barline. You can also 
click directly on the barline.

A correctly input caesura. The dotted attachment 
lines are attached to the notehead after the barline, 
meaning the caesura is correctly positioned before 
the barline.

An incorrectly input caesura. By clicking to the left of 
the barline, the caesura is attached to the last eighth 
note in the bar.

When input correctly, the dotted attachment lines link the caesura to the notehead immediately 
after the barline.

If your dotted attachment lines do not link the caesura to the notehead immediately after 
the barline, delete the caesura and re-input it. Caesuras can cause spacing issues when input 
incorrectly.

RELATED LINKS
Holds and pauses on page 1202
Types of caesuras on page 1204

Input methods for ornaments, arpeggio signs, glissando lines, and 
jazz articulations

You can input ornaments, including arpeggio signs, glissando lines, and jazz articulations with 
the keyboard by using the ornaments popover, and with the mouse by using the Ornaments 
panel.

You can input ornaments and arpeggio signs during note input and by adding them to existing 
notes, but you cannot input glissando lines during note input. You can only input glissando lines 
by adding them to existing notes.

You can specify the type/length of jazz articulations when using the Ornaments panel but not 
when using the ornaments popover.
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RELATED LINKS
Ornaments on page 1291
Arpeggio signs on page 1310
Glissando lines on page 1317
Jazz articulations on page 1348
Jazz ornaments on page 1349
Lines on page 1402
Input methods for lines on page 384

Ornaments popover
The following tables contain the entries for the ornaments popover that you can use to input the 
different ornaments, arpeggio signs, glissando lines, and jazz articulations available.

You can open the ornaments popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

● Select an existing ornament and press Return .

● Choose Write > Create Ornament.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Ornaments popover with an example entry
Ornaments button in the Notations toolbox

Ornaments

Type of ornament Popover entry

Trill:  tr or trill

Short trill:  shorttr

Mordent:  mor or mordent

Turn:  turn

Inverted turn:  invturn or invertedturn
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Trill intervals

Trill interval or quality Popover entry

Interval degree

Unison, second, third, fourth, fifth, sixth, 
seventh, octave

1, 2, 3, 4, 5, 6, 7, 8

Major M, maj, or major

Minor m, min, or minor

Perfect p, per, or perf

Diminished d, dim, or diminished

Augmented a, aug, or augmented

EXAMPLE
To input a trill with a perfect fifth interval, enter tr p5.

Jazz ornaments

Type of jazz ornament Popover entry

Bend brassbend

Flip flip

Jazz turn jazz or shake

Smear smear

Jazz articulations

Type of jazz articulation Popover entry

Plop (bend) plop

Plop (smooth) plopsmooth

Scoop scoop

Doit (bend) doit

Doit (smooth) doitsmooth
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Type of jazz articulation Popover entry

Fall (bend) fall

Fall (smooth) fallsmooth

TIP

Other ornaments are available in the Ornaments panel. You can specify the type/length of jazz 
articulations when using the Ornaments panel but not when using the ornaments popover.

Arpeggio signs

Type of arpeggio sign Popover entry

Up arpeggio sign arp, arpup, or arpeggioup

Down arpeggio sign arpdown or arpeggiodown

Non arpeggio sign nonarp or nonarpeggio

Curved arpeggio sign slurarp

Glissando lines

Type of glissando line Popover entry

Default style glissando line gliss

Straight glissando line glissstraight

Wavy glissando line glisswavy

Guitar techniques

Type of guitar technique Popover entry

Guitar bend bend

Vibrato bar dive and return vibbend

Vibrato bar scoop vibscoop

Vibrato bar dip vibdip
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Type of guitar technique Popover entry

Vibrato bar line

NOTE

Must have duration to show its line.

wbar or w/bar

Hammer-on

NOTE

You must select at least two notes assigned 
to the same string with ascending pitch 
directions, such as C-D.

ho or hammer

Pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

po or pull

Hammer-on then pull-off or pull-off then 
hammer-on (ligado)

NOTE

You must select at least three notes assigned 
to the same string with alternating pitch 
directions, such as C-D-C or D-C-D.

hp, hopo, hammerpull, lig, or ligado

Right-hand tapping tap

Right-hand tapping with pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

tappull

Left-hand tapping lhtap
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Type of guitar technique Popover entry

Left-hand tapping with pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

lhtappull

RELATED LINKS
Notations toolbox on page 202
Inputting arpeggio signs with the popover on page 349
Inputting glissando lines with the popover on page 350
Inputting jazz articulations with the popover on page 352
Inputting guitar bends with the popover on page 355
Inputting vibrato bar dives on page 358
Inputting vibrato bar dives and returns with the popover on page 359
Inputting vibrato bar scoops with the popover on page 361
Inputting vibrato bar dips with the popover on page 363
Inputting hammer-ons/pull-offs on page 366
Inputting tapping on page 367
Assigning notes to strings on page 1255
Changing the allocated string for notes on tablature on page 1583
Ornaments on page 1291
Trill intervals on page 1298
Arpeggio signs on page 1310
Glissando lines on page 1317
Guitar bends on page 1323
Guitar techniques on page 1339
Jazz articulations on page 1348
Jazz ornaments on page 1349
Playing technique duration on page 1394

Ornaments panel
The Ornaments panel allows you to input all the different types of ornaments available, including 
jazz articulations, as well as arpeggio signs, glissando lines, guitar bends, and vibrato bar 
techniques. It is located in the right zone in Write mode.

● You can hide/show the Ornaments panel by clicking Panels , then Ornaments  in the 
Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Ornaments panel contains the following sections:

Jazz
Contains ornaments and pitch alterations commonly used in jazz music, such as bends, 
scoops, and falls.

Baroque and Classical
Contains ornaments commonly used in Baroque and Classical music, such as 
mordents, turns, and trills.
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Arpeggiation
Contains the different types of arpeggio signs.

NOTE

You cannot input arpeggio signs with the mouse during note input.

Glissandi
Contains the different types of glissando lines.

Guitar
Contains techniques and pitch alterations commonly associated with guitars, such as 
guitar bends and vibrato bar scoops.

RELATED LINKS
Notations toolbox on page 202
Inputting ornaments/trills with the panel on page 348
Inputting arpeggio signs with the panel on page 350
Inputting glissando lines with the panel on page 351
Inputting jazz articulations with the panel on page 354
Input methods for guitar bends and guitar techniques on page 354

Inputting ornaments/trills with the popover
You can input ornaments, trills, and jazz ornaments using the ornaments popover, both during 
note input and by adding them to existing notes. When inputting trills, you can specify the trill 
interval, such as a minor third.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input an 
ornament. If you want to input a trill with a specific duration, select items on the staff 
that span that duration.

2. Optional: If you want to input ornaments onto multiple staves at once, extend the caret to 
those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter the appropriate entry for the ornament you want into the popover.

For example, enter tr m3 for a trill with a minor third interval or mor for a mordent.

5. Press Return  to close the popover.

6. Optional: When inputting trills during note input, input a note or press Space  to advance 
the caret and input the trill.

RESULT
During note input, ornaments are input at the caret position. Trills last the duration of the 
rhythmic value of the note input at the caret position or the duration by which the caret 
advanced. Trills have a default interval of a second, either major or minor depending on the 
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context. If you specified an interval for your trill, the interval applies only to the first note in the 
selection, but you can also change the interval partway through trills.

When adding ornaments to existing music, they are input at the rhythmic position of the earliest 
selected item. Trills are input at the rhythmic position of the earliest selected item, with an 
extender line across the rest of the selection.

RELATED LINKS
Ornaments on page 1291
Trills on page 1295
Trill intervals on page 1298
Changing trill intervals on page 1300
Changing trill intervals partway through trills on page 1301
Trill interval appearance on page 1303
Jazz ornaments on page 1349
Inputting notes on page 221
Inputting jazz articulations with the popover on page 352
Extending the caret to multiple staves on page 219

Inputting ornaments/trills with the panel
You can input ornaments, trills, and jazz ornaments using the Ornaments panel, both during 
note input and by adding them to existing notes.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input an 
ornament. If you want to input a trill with a specific duration, select items on the staff 
that span that duration.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Ornaments panel, click the ornament you want.

RESULT
During note input, ornaments are input at the caret position. Trills are input with a default 
duration of a quarter note.

When adding ornaments to existing music, they are input at the rhythmic position of the earliest 
selected item. Trills are input at the rhythmic position of the earliest selected item, with an 
extender line across the rest of the selection.

TIP

You can specify trill intervals when inputting trills using the popover.

RELATED LINKS
Notations toolbox on page 202
Ornaments panel on page 346
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Inputting jazz articulations with the panel on page 354
Changing your mouse input settings on page 213

Inputting arpeggio signs with the popover
You can input arpeggio signs using the ornaments popover, both during note input and by 
adding them to existing notes. You can also input arpeggio signs across notes in multiple voices 
and on different staves that belong to the same instrument, such as piano or harp.

NOTE

You can only input one arpeggio sign at a time.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select at least one note in each voice to which you want to add an arpeggio sign.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff arpeggio signs. However, you cannot 
create cross-staff arpeggio signs between different instruments.

● Arpeggio signs are added to all notes in the selected voices at the selected rhythmic 
position.

2. Optional: If you started note input, press Q  to start chord input.

NOTE

You can only input arpeggio signs during chord input.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter the appropriate entry for the arpeggio sign you want into the popover.

For example, enter arpup for an up arpeggio sign or arpdown for a down arpeggio sign.

5. Press Return  to close the popover.

6. Optional: During chord input, input the notes you want.

RESULT
During chord input, arpeggio signs are input at the caret position.

When adding arpeggio signs to existing notes, they are input to the left of the selected notes.

Arpeggio signs automatically span the pitch range of all notes at that rhythmic position in 
the current voice during chord input, and all notes in the selected voices/staves when adding 
arpeggio signs to existing notes.

RELATED LINKS
Ornaments popover on page 342
Arpeggio signs on page 1310
Arpeggios in playback on page 1314
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Inputting notes on page 221
Inputting chords on page 251

Inputting arpeggio signs with the panel
You can input arpeggio signs on existing notes using the Ornaments panel. You can also input 
arpeggio signs across notes in multiple voices and on different staves that belong to the same 
instrument, such as piano or harp.

NOTE

● You can only input one arpeggio sign at a time, and you cannot input arpeggio signs with 
the mouse during note input.

● These steps describe inputting with the default mouse input preference Create item at 
selection. You cannot create cross-staff and cross-voice arpeggio signs if your preference is 
set to Load pointer with item.

PROCEDURE

1. In Write mode, select at least one note in each voice to which you want to add an arpeggio 
sign.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff arpeggio signs. However, you cannot 
create cross-staff arpeggio signs between different instruments.

● Arpeggio signs are added to all notes in the selected voices at the selected rhythmic 
position.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Arpeggiation section, click the arpeggio sign you want.

RESULT
The arpeggio sign specified is input to the left of the selected note or chord. Arpeggio signs 
automatically span the pitch range of all notes in the selected voices/staves at that rhythmic 
position.

RELATED LINKS
Notations toolbox on page 202
Ornaments panel on page 346
Arpeggio signs on page 1310
Arpeggios in playback on page 1314
Changing your mouse input settings on page 213

Inputting glissando lines with the popover
You can input glissando lines between existing notes using the ornaments popover. You can 
input glissando lines between both adjacent and non-adjacent notes.

NOTE

You cannot input glissando lines during note input or on the last note on a staff. Instead, you can 
input a jazz articulation.
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PREREQUISITE
You have input at least two notes that you want to join with a glissando.

PROCEDURE

1. In Write mode, select the two notes you want to join with a glissando line.

For example, select a grace note and a normal note, two notes in different voices, or two 
notes on different staves belonging to the same instrument.

2. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

3. Enter the appropriate entry for the glissando line you want into the popover.

● For a default style glissando line, enter gliss.

● For a straight glissando line, enter glissstraight.

● For a wavy glissando line, enter glisswavy.

4. Press Return  to close the popover.

RESULT
The glissando line specified is input between the selected notes.

NOTE

● If you select a single note and input a glissando line, the glissando line specified starts from 
the selected note and ends at the next note in the same voice on the staff, even if this 
crosses rests.

● Glissando lines do not automatically adjust around any notes or rests between the selected 
notes. If glissando text is shown, the text can collide with notes or rests, in which case we 
recommend that you make further adjustments, such as not showing glissando text for that 
glissando line.

● By default, glissando line text is hidden on staves belonging to fretted instruments. However, 
you can show glissando line text manually.

RELATED LINKS
Ornaments popover on page 342
Glissando lines on page 1317
Changing glissando line text on page 1319
Changing when glissando line text is shown on page 1320
Changing the style of glissando lines on page 1318
Inputting jazz articulations with the panel on page 354

Inputting glissando lines with the panel
You can input glissando lines between existing notes using the Ornaments panel. You can input 
glissando lines between both adjacent and non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input glissando 
lines between the note you click on and the note immediately following it.
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● You cannot input glissando lines during note input or on the last note on a staff. Instead, you 
can input a jazz articulation.

PREREQUISITE
You have input at least two notes that you want to join with a glissando.

PROCEDURE

1. In Write mode, select the two notes you want to join with a glissando line.

For example, select a grace note and a normal note, two notes in different voices, or two 
notes on different staves belonging to the same instrument.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Glissandi section, click the style of glissando line you want.

● Glissando (Straight) 

● Glissando (Wavy) 

RESULT
The glissando line specified is input between the selected notes.

NOTE

● If you select a single note and input a glissando line, the glissando line specified starts from 
the selected note and ends at the next note in the same voice on the staff, even if this 
crosses rests.

● Glissando lines do not automatically adjust around any notes or rests between the selected 
notes. If glissando text is shown, the text can collide with notes or rests, in which case we 
recommend that you make further adjustments, such as not showing glissando text for that 
glissando line.

● By default, glissando line text is hidden on staves belonging to fretted instruments. However, 
you can show glissando line text manually.

RELATED LINKS
Notations toolbox on page 202
Ornaments panel on page 346
Glissando lines on page 1317
Changing glissando line text on page 1319
Changing when glissando line text is shown on page 1320
Inputting jazz articulations with the panel on page 354
Changing your mouse input settings on page 213

Inputting jazz articulations with the popover
You can input jazz articulations using the ornaments popover, both during note input and by 
adding them to existing notes.

NOTE

You can input jazz ornaments, such as flips or jazz turns, in the same ways as inputting 
ornaments.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add jazz articulations.

2. Optional: If you want to input jazz articulations onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the jazz articulation you want into the popover.

For example, enter scoop for a scoop or fall for a fall.

6. Press Return  to close the popover.

RESULT
The jazz articulation you specify is input on all selected notes. During note input, this is usually 
the last note you input.

NOTE

When using the popover, all jazz articulations follow your project-wide settings for their line style. 
You can change their type/length after they have been input.

When using the panel, you can specify the line style of jazz articulations when you input them.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different jazz 
articulations in different voices simultaneously.

RELATED LINKS
Ornaments popover on page 342
Inputting ornaments/trills with the popover on page 347
Extending the caret to multiple staves on page 219
Jazz articulations on page 1348
Changing the type/length of existing jazz articulations on page 1351
Changing the line style of smooth jazz articulations on page 1351
Enabling independent voice playback on page 636
Playback techniques on page 936
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Inputting jazz articulations with the panel
You can input jazz articulations using the Ornaments panel, both during note input and by 
adding them to existing notes.

NOTE

● You can input jazz ornaments, such as flips or jazz turns, in the same ways as inputting 
ornaments.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add jazz articulations.

2. Optional: If you want to input jazz articulations onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

5. In the Jazz section, click the jazz articulation you want.

RESULT
The jazz articulation you specify is input on all selected notes. During note input, this is usually 
the last note you input.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different jazz 
articulations in different voices simultaneously.

RELATED LINKS
Notations toolbox on page 202
Ornaments panel on page 346
Inputting ornaments/trills with the panel on page 348
Extending the caret to multiple staves on page 219
Changing your mouse input settings on page 213
Enabling independent voice playback on page 636
Playback techniques on page 936

Input methods for guitar bends and guitar techniques
You can input guitar bends (including pre-bends and post-bends), vibrato bar techniques 
(including dips, dives, scoops, and dives and returns) and tapping, hammer-on, and pull-off 
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indications with the keyboard by using the ornaments popover, and with the mouse by using the 
Ornaments panel.

You can also input guitar pre-bends, post-bends, and vibrato bar pre-dives using properties in 
the Properties panel.

You can input guitar techniques during note input and by adding them to existing notes, but you 
cannot input guitar bends during note input. You can only input guitar bends by adding them to 
existing notes.

RELATED LINKS
Ornaments popover on page 342
Ornaments panel on page 346
Guitar bends on page 1323
Guitar pre-bends and pre-dives on page 1326
Guitar post-bends on page 1327
Vibrato bar dives and returns on page 1328
Vibrato bar techniques on page 1339
Tapping on page 1340
Hammer-ons and pull-offs on page 1342

Inputting guitar bends with the popover
You can input guitar bends between existing notes, including between grace notes and normal 
notes, using the ornaments popover. You can input guitar bends between both adjacent and 
non-adjacent notes.

NOTE

You cannot input guitar bends during note input or on the last note on a staff.

PREREQUISITE
You have input at least two notes that you want to join with a guitar bend.

PROCEDURE

1. In Write mode, select the two notes you want to join with a guitar bend.

For example, select a grace note and a normal note or two notes in different voices.

2. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

3. Enter bend into the popover.

4. Press Return  to close the popover.

RESULT
The guitar bend is input between the selected notes.

Guitar bends automatically appear as guitar bends or returns on tablature according to the pitch 
direction of the notes they join.

TIP

● If you select a single note and input a guitar bend, the guitar bend starts from the selected 
note and ends at the next note in the same voice on the staff, even if this crosses rests.
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● You can assign a key command for Create Guitar Bend on the Key Commands page in 
Preferences.

RELATED LINKS
Ornaments popover on page 342
Guitar bends on page 1323
Inputting guitar pre-bends/pre-dives on page 357
Inputting guitar post-bends on page 357
Key Commands page in the Preferences dialog on page 63

Inputting guitar bends with the panel
You can input guitar bends between existing notes, including between grace notes and normal 
notes, using the Ornaments panel. You can input guitar bends between both adjacent and 
non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input guitar 
bends between the note you click on and the note immediately following it.

● You cannot input guitar bends during note input or on the last note on a staff.

PREREQUISITE
You have input at least two notes that you want to join with a guitar bend.

PROCEDURE

1. In Write mode, select the two notes you want to join with a guitar bend.

For example, select a grace note and a normal note or two notes in different voices.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Guitar Bend .

RESULT
The guitar bend is input between the selected notes.

Guitar bends automatically appear as guitar bends or returns on tablature according to the pitch 
direction of the notes they join.

TIP

● If you select a single note and input a guitar bend, the guitar bend starts from the selected 
note and ends at the next note in the same voice on the staff, even if this crosses rests.

● You can assign a key command for Create Guitar Bend on the Key Commands page in 
Preferences.

RELATED LINKS
Notations toolbox on page 202
Ornaments panel on page 346
Guitar bends on page 1323
Changing your mouse input settings on page 213
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Inputting guitar pre-bends/pre-dives
You can input guitar pre-bends on any existing notes belonging to fretted instruments. You can 
also specify that pre-bends should be played using the vibrato bar, a technique that is known as 
a “pre-dive”.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes before which you want to input guitar pre-bends/pre-dives. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Pre-bend interval in the Guitar Pre-bends group.

3. Change the interval as required.

4. Optional: To turn the guitar pre-bends into guitar pre-dives, activate Vibrato bar pre-bend 
and the corresponding checkbox in the Guitar Pre-bends group.

RESULT
Guitar pre-bends of the specified interval are input before the selected notes. They are shown as 
guitar pre-dives when Vibrato bar pre-bend and the corresponding checkbox are both activated.

RELATED LINKS
Guitar pre-bends and pre-dives on page 1326
Vibrato bar techniques on page 1339
Properties panel on page 769
Engrave toolbox on page 514

Inputting guitar post-bends
You can input guitar post-bends on any existing notes belonging to fretted instruments. You can 
also specify that post-bends are microtonal.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes after which you want to input guitar post-bends. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Post-bend interval in the Guitar Post-bends group.

3. Do one of the following:

● Change the interval as required.

● To turn the guitar post-bends into microtonal post-bends, activate Microtone bend in 
the Guitar Post-bends group.
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RESULT
Guitar post-bends of the specified interval are input after the selected notes. They are shown as 
microtonal when Microtone bend is activated.

RELATED LINKS
Guitar post-bends on page 1327
Properties panel on page 769
Inputting guitar bends with the popover on page 355
Engrave toolbox on page 514

Inputting vibrato bar dives
You can input vibrato bar dives, both during note input and by adding them to existing notes.

Vibrato bar dives are notated using a smooth fall jazz articulation combined with a vibrato bar 
indication.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar dives.

2. Optional: If you want to input vibrato bar dives onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter fallsmooth into the popover to input a smooth fall jazz articulation.

6. Press Return  to close the popover.

7. Optional: During note input, move the caret back to the position of the note with the smooth 
fall.

8. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

9. Enter wbar into the popover to input a vibrato bar indication.

10. Press Return  to close the popover.

11. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar indication.

RESULT
The smooth fall jazz articulation is input on all selected notes. During note input, this is usually 
the last note you input.
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During note input, vibrato bar indications are input at the caret position. When adding vibrato 
bar indications to existing music, they are added at the rhythmic position of the earliest selected 
item.

NOTE

When using the popover, all jazz articulations follow your project-wide settings for their line style. 
You can change their type/length after they have been input.

You can also input both smooth fall jazz articulations and vibrato bar indications using the 
Ornaments panel. When using the panel, you can specify the line style of jazz articulations when 
you input them.

AFTER COMPLETING THIS TASK
If you want vibrato bar indications to show a line, you can lengthen them to give them duration.

RELATED LINKS
Vibrato bar techniques on page 1339
Notations toolbox on page 202
Ornaments popover on page 342
Ornaments panel on page 346
Extending the caret to multiple staves on page 219
Moving the caret manually on page 220
Jazz articulations on page 1348
Inputting jazz articulations with the popover on page 352
Inputting jazz articulations with the panel on page 354
Changing the type/length of existing jazz articulations on page 1351
Changing the line style of smooth jazz articulations on page 1351
Deleting jazz articulations on page 1352
Lengthening/Shortening items on page 436
Playing technique duration on page 1394

Inputting vibrato bar dives and returns with the popover
You can input vibrato bar dives and returns between existing notes using the ornaments 
popover. You can input vibrato bar dives and returns between both adjacent and non-adjacent 
notes.

NOTE

You cannot input vibrato bar dives and returns during note input or on the last note on a staff.

PREREQUISITE
You have input at least three notes with alternating pitch directions, such as D-C-D, that you want 
to join with a vibrato bar dive and return.

PROCEDURE

1. In Write mode, select the two notes you want to join with a vibrato bar dive.

NOTE

The notes must be on the same staff and have a descending pitch direction, such as D-C.

2. Open the ornaments popover in any of the following ways:
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● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

3. Enter vibbend into the popover to input the dive.

4. Press Return  to close the popover.

5. Select the two notes you want to join with a vibrato bar return.

NOTE

The notes must be on the same staff and have an ascending pitch direction, such as C-D.

6. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

7. Enter vibbend into the popover to input the return.

8. Press Return  to close the popover.

RESULT
Vibrato bar dives are input between notes with descending pitch directions, and vibrato bar 
returns are input between notes with ascending pitch directions. If a vibrato bar dive ends on 
the same note that a vibrato bar return starts on, they appear as a V on tablature with the bend 
interval shown at the point. If you input vibrato bar dives on consecutive notes with the same 
pitch direction, such as E-D-C, they are notated on tablature with an additional line protrusion 
beyond the staff and bend interval for each vibrato bar dive.

Vibrato bar dives and returns automatically point upwards or downwards on tablature according 
to the pitch direction of the notes they join.

RELATED LINKS
Ornaments popover on page 342
Vibrato bar dives and returns on page 1328
Vibrato bar techniques on page 1339
Guitar bends on page 1323
Inputting guitar bends with the popover on page 355

Inputting vibrato bar dives and returns with the panel
You can input vibrato bar dives and returns between existing notes using the Ornaments panel. 
You can input vibrato bar dives and returns between both adjacent and non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input vibrato 
bar dives and returns between the note you click on and the note immediately following it.

● You cannot input vibrato bar dives and returns during note input or on the last note on a 
staff.

PREREQUISITE
You have input at least three notes with alternating pitch directions, such as D-C-D, that you want 
to join with a vibrato bar dive and return.
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PROCEDURE

1. In Write mode, select the two notes you want to join with a vibrato bar dive.

NOTE

The notes must be on the same staff and have a descending pitch direction, such as D-C.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Guitar Bend with Vibrato Bar  to input the vibrato bar dive.

4. Select the two notes you want to join with a vibrato bar return.

NOTE

The notes must be on the same staff and have an ascending pitch direction, such as C-D.

5. Click Guitar Bend with Vibrato Bar  to input the vibrato bar return.

RESULT
Vibrato bar dives are input between notes with descending pitch directions, and vibrato bar 
returns are input between notes with ascending pitch directions. If a vibrato bar dive ends on 
the same note that a vibrato bar return starts on, they appear as a V on tablature with the bend 
interval shown at the point. If you input vibrato bar dives on consecutive notes with the same 
pitch direction, such as E-D-C, they are notated on tablature with an additional line protrusion 
beyond the staff and bend interval for each vibrato bar dive.

Vibrato bar dives and returns automatically point upwards or downwards on tablature according 
to the pitch direction of the notes they join.

RELATED LINKS
Notations toolbox on page 202
Ornaments panel on page 346
Vibrato bar dives and returns on page 1328
Vibrato bar techniques on page 1339
Guitar bends on page 1323
Inputting vibrato bar dives on page 358
Changing your mouse input settings on page 213

Inputting vibrato bar scoops with the popover
You can input vibrato bar scoops using the ornaments popover, both during note input and by 
adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar scoops.

2. Optional: If you want to input vibrato bar scoops onto multiple staves at once, extend the 
caret to those staves.
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3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter vibscoop into the popover.

6. Press Return  to close the popover.

RESULT
Vibrato bar scoops are input on the selected notes. During note input, this is usually the last note 
you input.

By default, vibrato bar scoops only appear on notation staves, not tablature. They are positioned 
to the left of notes.

AFTER COMPLETING THIS TASK
You can input vibrato bar indications to clarify the vibrato bar scoops should be played using the 
vibrato bar.

RELATED LINKS
Ornaments popover on page 342
Vibrato bar techniques on page 1339
Hiding/Showing guitar techniques on notation staves and tablature on page 1345
Inputting vibrato bar indications/lines with the popover on page 364
Deleting guitar techniques on page 1347

Inputting vibrato bar scoops with the panel
You can input vibrato bar scoops using the Ornaments panel, both during note input and by 
adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar scoops.

2. Optional: If you want to input vibrato bar scoops onto multiple staves at once, extend the 
caret to those staves.

3. Optional: During note input, input at least one note.

4. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

5. In the Guitar section, click Vibrato Bar Scoop .

RESULT
Vibrato bar scoops are input on the selected notes. During note input, this is usually the last note 
you input.
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By default, vibrato bar scoops only appear on notation staves, not tablature. They are positioned 
to the left of notes.

AFTER COMPLETING THIS TASK
You can input vibrato bar indications to clarify the vibrato bar scoops should be played using the 
vibrato bar.

RELATED LINKS
Notations toolbox on page 202
Ornaments panel on page 346
Vibrato bar techniques on page 1339
Hiding/Showing guitar techniques on notation staves and tablature on page 1345
Inputting vibrato bar indications/lines with the panel on page 365
Deleting guitar techniques on page 1347

Inputting vibrato bar dips with the popover
You can input vibrato bar dips using the ornaments popover, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff at the rhythmic position where you want to input a vibrato 
bar dip.

2. Optional: If you want to input vibrato bar dips onto multiple staves at once, extend the caret 
to those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter vibdip into the popover.

5. Press Return  to close the popover.

6. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar dip.

RESULT
During note input, vibrato bar dips are input at the caret position. When adding vibrato bar dips 
to existing music, they are input at the position of the earliest selected item.

By default, vibrato bar dips have half step intervals, are placed above the staff, and only appear 
on notation staves, not tablature.

RELATED LINKS
Ornaments popover on page 342
Vibrato bar techniques on page 1339
Changing vibrato bar dip intervals on page 1344
Hiding/Showing guitar techniques on notation staves and tablature on page 1345
Inputting vibrato bar indications/lines with the popover on page 364
Changing the staff-relative placement of items on page 441
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Inputting vibrato bar dips with the panel
You can input vibrato bar dips using the Ornaments panel, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff at the rhythmic position where you want to input a vibrato 
bar dip.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Vibrato Bar Dip .

RESULT
During note input, vibrato bar dips are input at the caret position. When adding vibrato bar dips 
to existing music, they are input at the position of the earliest selected item.

By default, vibrato bar dips have half step intervals, are placed above the staff, and only appear 
on notation staves, not tablature.

RELATED LINKS
Notations toolbox on page 202
Ornaments panel on page 346
Vibrato bar techniques on page 1339
Changing vibrato bar dip intervals on page 1344
Hiding/Showing guitar techniques on notation staves and tablature on page 1345
Inputting vibrato bar indications/lines with the panel on page 365
Changing the staff-relative placement of items on page 441

Inputting vibrato bar indications/lines with the popover
You can input vibrato bar indications/lines using the ornaments popover, both during note input 
and by adding them to existing music. When vibrato bar indications are input across a range of 
items, they are input with duration and show a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
vibrato bar indication. If you want to input a vibrato bar line, select items on the staff 
that span the required duration.

2. Optional: If you want to input vibrato bar indications onto multiple staves at once, extend the 
caret to those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter wbar into the popover to input the vibrato bar indication.

5. Press Return  to close the popover.
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6. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar indication.

RESULT
During note input, vibrato bar indications are input at the caret position.

When adding vibrato bar indications to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding vibrato bar indications to a range of selected 
items, they are input at the rhythmic position of the earliest selected item and have duration, 
which applies until the end of the selection. Vibrato bar indications with duration show a duration 
line, which is dashed by default.

By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.

RELATED LINKS
Ornaments popover on page 342
Vibrato bar techniques on page 1339
Extending the caret to multiple staves on page 219
Lengthening/Shortening items on page 436
Playing technique duration on page 1394

Inputting vibrato bar indications/lines with the panel
You can input vibrato bar indications/lines using the Ornaments panel, both during note input 
and by adding them to existing music. When vibrato bar indications are input across a range of 
items, they are input with duration and show a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
vibrato bar indication. If you want to input a vibrato bar line, select items on the staff 
that span the required duration.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Vibrato Bar Line .

RESULT
During note input, vibrato bar indications are input at the caret position.

When adding vibrato bar indications to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding vibrato bar indications to a range of selected 
items, they are input at the rhythmic position of the earliest selected item and have duration, 
which applies until the end of the selection. Vibrato bar indications with duration show a duration 
line, which is dashed by default.

By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.

RELATED LINKS
Ornaments panel on page 346
Vibrato bar techniques on page 1339
Lengthening/Shortening items on page 436
Playing technique duration on page 1394
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Inputting hammer-ons/pull-offs
You can input hammer-ons/pull-offs on any notes belonging to fretted instruments using the 
ornaments popover, both during note input and by adding them to existing notes. If you select 
multiple notes, Dorico Pro automatically inputs the appropriate slurs. You can also add tapping 
with hammer-ons/pull-offs to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add hammer-ons/pull-offs.

NOTE

● If you want to input hammer-ons, you must select at least two notes assigned to the 
same string with ascending pitch directions, such as C-D.

● If you want to input pull-offs or tapping with pull-offs, you must select at least two 
notes assigned to the same string with descending pitch directions, such as D-C.

● If you want to input ligados, you must select at least three notes assigned to the 
same string with alternating pitch directions, such as C-D-C for a hammer-on then 
pull-off or D-C-D for a pull-off then hammer-on.

2. Optional: If you want to input hammer-ons/pull-offs onto multiple fretted instrument staves 
at once, extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the hammer-on/pull-off you want into the popover.

For example, enter ho for a hammer-on or hopo for a hammer-on then pull-off.

6. Press Return  to close the popover.

RESULT
The hammer-on/pull-off you specify is input on the selected notes. During note input, this is 
usually the last note you input.

If you selected multiple adjacent notes assigned to the same string, Dorico Pro automatically 
inputs slurs spanning the selected notes and centers hammer-on/pull-off indications on the 
slurs. For slurs with multiple hammer-on/pull-off indications, each indication is centered over 
the range of notes in the corresponding direction. You can choose to show hammer-on/pull-off 
indications on each note on the Guitar Techniques page in Engraving Options.

By default, hammer-ons/pull-offs appear on both notation staves and tablature and are placed 
above the staff.
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TIP

You can also add hammer-ons/pull-offs to existing notes by selecting them, activating Technique 
in the Guitar Techniques group of the Properties panel, and selecting the appropriate indication 
from the menu. To show hammer-on/pull-off indications centered on slurs, select all notes except 
the first note under each slur.

RELATED LINKS
Ornaments popover on page 342
Hammer-ons and pull-offs on page 1342
Changing the staff-relative placement of guitar techniques on page 1346
Hiding/Showing guitar techniques on notation staves and tablature on page 1345
Project-wide engraving options for guitar techniques on page 1343
Engraving Options dialog on page 840
Assigning notes to strings on page 1255
Changing the allocated string for notes on tablature on page 1583
Deleting guitar techniques on page 1347

Inputting tapping
You can input right-hand and left-hand tapping indications on any notes belonging to fretted 
instruments using the ornaments popover, both during note input and by adding them to 
existing notes. You can also add tapping with hammer-ons/pull-offs to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tapping indications.

NOTE

If you want to input tapping with pull-offs, you must select at least two notes assigned to 
the same string with descending pitch directions, such as D-C.

2. Optional: If you want to input tapping onto multiple fretted instrument staves at once, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the tapping indication you want into the popover.

For example, enter tap for right-hand tapping or lhtappull for left-hand tapping with pull-
off.

6. Press Return  to close the popover.
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RESULT
The tapping indication you specify is input on the selected notes. During note input, this is 
usually the last note you input.

By default, tapping indications appear on both notation staves and tablature and are placed 
above the staff.

TIP

You can also add tapping indications to existing notes by selecting them, activating Technique 
in the Guitar Techniques group of the Properties panel, and selecting the appropriate indication 
from the menu.

RELATED LINKS
Ornaments popover on page 342
Tapping on page 1340
Changing the staff-relative placement of guitar techniques on page 1346
Hiding/Showing guitar techniques on notation staves and tablature on page 1345
Project-wide engraving options for guitar techniques on page 1343
Assigning notes to strings on page 1255
Changing the allocated string for notes on tablature on page 1583
Extending the caret to multiple staves on page 219
Deleting guitar techniques on page 1347

Input methods for playing techniques, pedal lines, string indicators, 
and harp pedal diagrams

You can input playing techniques with the keyboard by using the playing techniques popover, 
and with the mouse by using the Playing Techniques panel. Pedal lines are considered playing 
techniques in Dorico Pro because both affect the sound that the instrument produces.

You can input string indicators outside the staff in the same ways, using either the playing 
techniques popover or Playing Techniques panel. However, you can only input harp pedal 
diagrams using the playing techniques popover.

You can input string indicators inside the staff using a property in the String Indicators group of 
the Properties panel.

RELATED LINKS
Playing techniques on page 1387
Pedal lines on page 1367
Harp pedaling on page 1358
String indicators on page 1183
Inputting playing techniques with the popover on page 373
Inputting playing techniques with the panel on page 375
Inputting pedal lines with the popover on page 376
Inputting pedal lines with the panel on page 378
Inputting harp pedal diagrams on page 380
Inputting string indicators outside the staff with the popover on page 381
Inputting string indicators outside the staff with the panel on page 382
Inputting string indicators inside the staff on page 383
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Playing techniques popover
The following tables contain the entries for the playing techniques popover that you can use to 
input playing techniques, pedal lines, retakes, and pedal level changes.

When you start entering a playing technique into the playing techniques popover, a menu 
appears that shows valid playing techniques containing the letters/words you enter. You can 
then select one of these playing techniques to input.

You can open the playing techniques popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

● Select an existing playing technique and press Return .

● Choose Write > Create Playing Technique.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Playing techniques popover with 
an example entry for inputting a 
playing technique

Playing techniques popover with 
an example entry for inputting a 
pedal line

Playing Techniques button in the 
Notations toolbox

Playing techniques

Playing technique Popover entry

Vibrato vibrato

Senza vibrato senza vibrato

Naturale (nat.) nat

Con sord. con sord

Strong air pressure strong air pressure

Double-tongue double-tongue

Down bow downbow

Up bow upbow

Sul ponticello sul pont

Sul tasto sul tasto
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Playing technique Popover entry

Poco sul tasto pst

Pizzicato pizz

Spiccato spicc

Arco arco

Tongue click (Stockhausen) tongue click

Finger click (Stockhausen) finger click

Vibraphone motor on motor on

Vibraphone motor off motor off

Open open

Damp damp

Damp (large) damp large

Full barré full barre

Half barré half barre

Strum up strum up

Strum down strum down

Left hand lh

Right hand rh

This list is not comprehensive as there are many valid playing techniques. It is intended 
to illustrate how you can structure your entry to input different types of common playing 
techniques.

If you do not know the correct entry for a playing technique, start entering part of the playing 
technique and see if it becomes available in the popover menu.

NOTE

● To give playing techniques duration, add -> at the end of your entry, such as vibrato->. 
During note input, the duration of the playing technique extends as you continue inputting 
notes or advance the caret. When adding playing techniques to existing music, they are 
added as a group.

● As playing techniques correspond to specific samples, they must be input as described or 
selected from the popover menu.
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Pedal lines

Type of pedal line, retake, or pedal level 
change

Popover entry

Sustain pedal line ped

Set sustain pedal level to 1/4 1/4

Set sustain pedal level to 1/2 r

Set sustain pedal level to 3/4 3/4

Fully depress sustain pedal 1

Retake in sustain pedal line ^, notch, or retake

Remove retake in sustain pedal line nonotch

Stop sustain pedal line *

Sostenuto pedal line sost

Stop sostenuto pedal line s*

Una corda pedal line unacorda

Stop una corda pedal line u*

Harp pedaling

Example harp pedaling Popover entry

D, C, B♭, E♭, F, G, A DCBbEbFGA, BbEb, or --^|^---

D, C♯, B, E, F♯, G♯, A DC#BEF#G#A, C#F#G#, or -v-|-vv-

TIP

The pipe character is optional.

String indicators outside the staff

Example string indicator Popover entry

1 string1
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Example string indicator Popover entry

3 string3

RELATED LINKS
Notations toolbox on page 202
Playing techniques on page 1387
Groups of playing techniques on page 1399
Pedal lines on page 1367
Sustain pedal retakes and pedal level changes on page 1368
Harp pedaling on page 1358
String indicators on page 1183
Adding retakes and pedal level changes with the popover on page 377
Inputting harp pedal diagrams on page 380
Inputting string indicators outside the staff with the popover on page 381

Playing Techniques panel
The Playing Techniques panel contains the different playing techniques available in Dorico Pro, 
divided into instrument families. It is located in the right zone in Write mode. Pedal lines are 
included in the Keyboard section.

● You can hide/show the Playing Techniques panel by clicking Panels , then Playing 
Techniques  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Playing Techniques panel contains the following sections:

Common
Contains commonly used playing techniques that also apply to multiple different 
instrument families, such as “mute” and “legato”.

Wind
Contains playing techniques typically only used for wind instruments, such as “key 
clicks” and “whistle tones”.

Brass
Contains playing techniques typically only used for brass instruments, such as “cup 
mute” and “stopped”.

Unpitched Percussion
Contains playing techniques typically only used for unpitched percussion instruments, 
such as “rim” and “scrape”.

Pitched Percussion
Contains playing techniques typically only used for pitched percussion instruments, 
such as “motor on” and “½ Ped.” for vibraphones.

Keyboard
Contains playing techniques typically only used for keyboard instruments, such as 
“Ped.” and different pedal depression levels.

Choral
Contains playing techniques typically only used for the voice, such as “mouth open” 
and “tongue click”.
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Strings
Contains playing techniques typically only used for string instruments, such as “col 
legno battuto” and “down bow”.

Guitar
Contains playing techniques typically only used for guitars and fretted instruments, 
such as string indicators, “half barré”, and “strum up”.

TIP

● You can hover your mouse pointer over the options in each section to show the name of 
each playing technique.

● You can use the action bars at the bottom of each section to access the Edit Playing 
Techniques dialog. Edit Playing Technique  buttons are available when a playing 
technique is selected in the music area.

RELATED LINKS
Notations toolbox on page 202
Edit Playing Techniques dialog on page 877
Inputting string indicators outside the staff with the panel on page 382
Playing techniques on page 1387
Pedal lines on page 1367
String indicators on page 1183

Inputting playing techniques with the popover
You can input playing techniques using the playing techniques popover, both during note input 
and by adding them to existing music.

NOTE

● You can only enter one playing technique into the popover during note input. You can 
enter two playing techniques when adding playing techniques to existing music if they are 
separated by ->.

● If you want to input playing techniques in the middle of tie chains, start note input, then 
move the caret to the required rhythmic position.

PREREQUISITE
You have created any custom playing techniques you want to input.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
playing technique. If you want to input playing techniques with duration, select items on 
the staff that span that duration.

2. Optional: If you want to input playing techniques onto multiple staves at once, extend the 
caret to those staves.

3. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .
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4. Enter the appropriate entry for the playing technique you want into the popover.

For example, enter pizz or non vibrato->.

When you start entering a playing technique into the playing techniques popover, a menu 
appears that shows valid playing techniques containing the letters/words you enter, which 
you can select. If you want the playing technique to have duration, you can add -> at the end.

5. Press Return  to close the popover.

Open-ended playing techniques, such as non vibrato->, automatically extend during note 
input as you continue inputting notes, or if you advance the caret by pressing Space  or 
clicking Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

6. Optional: During note input, stop open-ended playing techniques by opening the playing 
techniques popover again and entering one of the following entries:

● To end the current playing technique with another playing technique, enter that playing 
technique. For example, enter vibrato. This joins the current playing technique to the 
following one with a continuation line.

● To end the current playing technique with another open-ended playing technique, enter 
that playing technique followed by ->. For example, enter vibrato->. This joins the 
current playing technique to the following one with a continuation line.

● To end the current playing technique without inputting another playing technique, 
enter ? into the popover. This leaves the current playing technique with a duration line 
rather than a continuation line.

RESULT
The specified playing techniques are input. They are considered voice-specific by default, 
meaning they only apply to the voice indicated by the caret indicator during step input or the 
selected voice when adding playing techniques to existing notes. They are automatically placed 
above the staff for up-stem voices and below the staff for down-stem voices.

Adjoining playing techniques, or playing techniques that were input together or in sequence, are 
automatically grouped together, both during note input and when adding playing techniques to 
existing notes.

During note input, playing techniques are input at the caret position and extend automatically if 
you included an open-ended playing technique with duration.

When adding playing techniques to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding playing techniques to a range of selected 
items, they are input at the rhythmic position of the earliest select item and have duration, which 
applies until the end of the selection. For playing techniques whose continuation type is set to 
show lines, the appropriate continuation line is shown.

AFTER COMPLETING THIS TASK

● You can move playing techniques within playing technique groups, lengthen/shorten playing 
techniques, and hide/show playing technique duration lines.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques in different voices simultaneously.

RELATED LINKS
Groups of playing techniques on page 1399
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Playing technique continuation lines on page 1393
Hiding/Showing playing technique duration lines on page 1396
Lengthening/Shortening items on page 436
Moving notes/items rhythmically on page 465
Caret on page 215
Moving the caret manually on page 220
Extending the caret to multiple staves on page 219
Enabling independent voice playback on page 636
Playback techniques on page 936
Creating custom playing techniques on page 882

Inputting playing techniques with the panel
You can input playing techniques using the Playing Techniques panel, both during note input and 
by adding them to existing music.

NOTE

● You cannot input playing techniques with duration in sequence, which automatically groups 
them, when using the panel. If you want to input playing techniques with duration in 
sequence, you can use the popover.

● If you want to input playing techniques in the middle of tie chains, start note input, then 
move the caret to the required rhythmic position.

● These steps describe inputting with the default mouse input preference Create item at 
selection. If you want to input the same playing technique in multiple places, change your 
mouse input preference to Load pointer with item so that you do not have to reselect the 
playing technique for each note.

PREREQUISITE
You have created any custom playing techniques you want to input.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
playing technique. If you want to input playing techniques with duration, select items on 
the staff that span that duration.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, click the playing technique you want.

RESULT
The specified playing technique is input. It is considered voice-specific by default, meaning it only 
applies to the voice indicated by the caret indicator during step input or the selected voice when 
adding playing techniques to existing notes. It is automatically placed above the staff for up-stem 
voices and below the staff for down-stem voices.

During note input, playing techniques are input at the caret position, even if your preference is 
set to Load pointer with item.

When adding playing techniques to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding playing techniques to a range of selected 
items, they are input at the rhythmic position of the earliest select item and have duration, which 

Write mode
Notations input 

375
Dorico Pro 4.3.30



applies until the end of the selection. For playing techniques whose continuation type is set to 
show lines, the appropriate continuation line is shown.

AFTER COMPLETING THIS TASK

● If you want to show transition lines between playing techniques, you can group them 
together.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques in different voices simultaneously.

RELATED LINKS
Notations toolbox on page 202
Changing your mouse input settings on page 213
Caret on page 215
Moving the caret manually on page 220
Lengthening/Shortening items on page 436
Grouping playing techniques together on page 1400
Enabling independent voice playback on page 636
Playback techniques on page 936
Creating custom playing techniques on page 882

Inputting pedal lines with the popover
You can input pedal lines using the playing techniques popover, both during note input and 
by adding them to existing music. Because pedal lines extend automatically as you input notes 
during note input, you can also input retakes and pedal level changes when you reach the 
appropriate rhythmic position.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On the staff where you want to input a pedal line, select items that span the required 
duration.

2. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

3. Enter the appropriate entry for the pedal line you want into the popover.

For example, enter ped for a sustain pedal line.

When you start entering a pedal line into the playing techniques popover, a menu appears 
that shows valid pedal lines containing the letters/words you enter, which you can select.

4. Press Return  to close the popover.

The pedal line is input.

5. Optional: During note input, advance the caret and extend the pedal line in any of the 
following ways:

● Press Space .
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● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

The pedal line also extends automatically as you continue inputting notes.

6. Optional: During note input, input retakes or pedal level changes by opening the playing 
techniques popover again at the appropriate rhythmic position and enter the entry for the 
retake or pedal level change you want into the popover.

For example, enter ^ or retake for a retake.

7. Optional: During note input, stop the pedal line by opening the playing techniques popover 
again and enter the appropriate entry into the popover.

For example, enter * to stop a sustain pedal line.

8. Press Return  to close the popover.

RESULT
During note input, pedal lines start at the caret position, and end at the caret position.

When you add pedal lines to existing music, pedal lines are added across the selected items.

NOTE

Retakes and level changes only appear for sustain pedal lines with the Line continuation type.

AFTER COMPLETING THIS TASK
You can change the continuation type used for individual pedal lines; for example, to show a sign 
at the end.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 1368
Positions of pedal lines on page 1374
Changing the pedal line continuation type on page 1380
Inputting notes on page 221
Notations toolbox on page 202
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210

Adding retakes and pedal level changes with the popover

You can add retakes and pedal level changes to sustain pedal lines using the playing techniques 
popover, both during note input and by adding them to existing music.

NOTE

You cannot add retakes and pedal level changes to sostenuto or una corda pedal lines. Retakes 
and pedal level changes only appear for sustain pedal lines with the Line continuation type.

PREREQUISITE
You have input a sustain pedal line.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select an item on each staff and at each rhythmic position where you want to input 
retakes or pedal level changes.

2. Optional: If you want to input notes and retakes or pedal level changes onto multiple staves 
with sustain pedal lines at once, extend the caret to those staves.

3. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

4. Enter the appropriate entry for the retake or pedal level change you want into the popover.

For example, enter ^ or retake for a retake, or 1/2 to change the pedal level to 1/2.

5. Press Return  to close the popover.

RESULT
During note input, retakes and pedal level changes are input at the caret position.

Outside of note input, retakes and pedal level changes are input at each selected rhythmic 
position on each selected staff.

TIP

You can also input retakes and pedal level changes by selecting notes within the ranges of 
sustain pedal lines and choosing Edit > Notations > Pedal Lines > [Retake or pedal level 
change]. You can also choose these options from the context menu.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 1368
Playing techniques popover on page 369
Changing the pedal line continuation type on page 1380
Moving the caret manually on page 220
Removing retakes and pedal level changes on page 1373

Inputting pedal lines with the panel
You can input pedal lines using the Playing Techniques panel.

NOTE

● When using the panel, you cannot input pedal lines during note input.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, select items on the staff where you want to input a pedal line that span the 
required duration.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Keyboard section.

4. Click the pedal line you want.
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RESULT
The pedal line is input across the selected range.

TIP

Alternatively, when nothing is selected, you can click the pedal line you want in the Keyboard 
section of the Playing Techniques panel, then click and drag in the music area to input a pedal 
line and extend it to the duration you want.

AFTER COMPLETING THIS TASK

● You can change the continuation type used for individual pedal lines; for example, to show a 
sign at the end.

● You can add retakes and pedal level changes within the ranges of sustain pedal lines.

NOTE

Retakes and level changes only appear for sustain pedal lines with the Line continuation 
type.

RELATED LINKS
Playing Techniques panel on page 372
Sustain pedal retakes and pedal level changes on page 1368
Changing the pedal line continuation type on page 1380
Changing your mouse input settings on page 213

Adding retakes and pedal level changes with the panel

You can add retakes and pedal level changes to existing sustain pedal lines using the Playing 
Techniques panel.

NOTE

You cannot add retakes and pedal level changes to sostenuto or una corda pedal lines. Retakes 
and pedal level changes only appear for sustain pedal lines with the Line continuation type.

PREREQUISITE
You have input a sustain pedal line.

PROCEDURE

1. In Write mode, select an item on each staff and at each rhythmic position where you want to 
input retakes or pedal level changes.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Keyboard section.

4. Click the retake or pedal level change you want.

RESULT
The retake or pedal level change is input at each selected rhythmic position on each selected 
staff.
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TIP

● Alternatively, when nothing is selected in the music area, you can click a retake or pedal 
level change in the Keyboard section of the Playing Techniques panel, and then click at each 
rhythmic position where you want to input the retake or pedal level change.

● You can also input retakes and pedal level changes by selecting notes within the ranges of 
sustain pedal lines and choosing Edit > Notations > Pedal Lines > [Retake or pedal level 
change]. You can also choose these options from the context menu.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 1368
Playing Techniques panel on page 372
Changing the pedal line continuation type on page 1380
Removing retakes and pedal level changes on page 1373

Inputting harp pedal diagrams
You can input harp pedal diagrams using the playing techniques popover, both during note input 
and by adding them to existing music.

If you do not input any harp pedaling, Dorico Pro assumes all harp pedals are in their natural 
setting, as they would be for C major. Any pitches that do not fit with the current harp pedaling, 
excluding the two lowest harp strings, appear red when colors for notes out of range are shown.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input on a harp staff.

● Select an item on a harp staff at the rhythmic position where you want to input a harp 
pedal diagram.

2. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

3. Enter the appropriate entry for the harp pedals you want.

For example, enter C#F#G# for C♯, F♯, and G♯ pedals, such as in A major, or BbEb for B♭ and E♭ 
pedals, such as in B♭ major.

4. Press Return  to close the popover.

RESULT
The corresponding harp pedal diagram is input at the selected rhythmic position. Depending on 
your per-layout settings, it is either displayed as a diagram, using note names, or not shown and 
instead indicated by a signpost.

During note input, harp pedal diagrams are input at the caret position.

RELATED LINKS
Playing techniques popover on page 369
Harp pedaling on page 1358
Hiding/Showing harp pedaling in layouts on page 1361
Changing the appearance of harp pedal diagrams on page 1360
Hiding/Showing colors for notes out of range on page 1261
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Calculating harp pedal diagrams based on existing music

You can automatically calculate suitable harp pedal diagrams based on the notes you have 
already input, either from a single point onwards or within a selected region.

If you do not input any harp pedaling, Dorico Pro assumes all harp pedals are in their natural 
setting, as they would be for C major. Any pitches that do not fit with the current harp pedaling, 
excluding the two lowest harp strings, appear red when colors for notes out of range are shown.

PROCEDURE

1. In Write mode, select the region you want to use to calculate harp pedaling in one of the 
following ways:

● Select an existing single note from which you want to calculate harp pedaling.

● Select a range of notes for which you want to calculate harp pedaling.

NOTE

Dorico Pro ignores the lowest two harp strings, C and D, when calculating harp pedals.

2. Choose Write > Calculate Harp Pedals.

RESULT
A harp pedal diagram is input at the start of your selection. Depending on your per-layout 
settings, it is either displayed as a diagram, using note names, or not shown and instead 
indicated by a signpost.

RELATED LINKS
Generating chord symbols from notes on page 327

Inputting string indicators outside the staff with the popover
You can input string indicators outside the staff using the playing techniques popover, both 
during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a string 
indicator outside the staff. If you want to input a string indicator with a duration line, 
select items on the staff that span that duration.

2. Optional: If you want to input string indicators onto multiple staves at once, extend the caret 
to those staves.

3. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

4. Enter the appropriate entry for the string indicator you want into the popover.

For example, enter string1 for just a string 1 indicator or string3-> for a string 3 indicator 
with duration.

5. Press Return  to close the popover.
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Open-ended string indicators, such as string3->, automatically extend during note input as 
you continue inputting notes, or if you advance the caret by pressing Space  or clicking 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

6. Optional: During note input, stop open-ended string indicators by opening the playing 
techniques popover again and entering ?  into the popover.

This leaves the current string indicator with a duration line. You can also enter another string 
indicator into the popover, but this joins the current string indicator to the following one 
with a continuation line rather than a duration line, which is a less common notation.

RESULT
The specified string indicators are input. They are considered voice-specific by default, meaning 
they only apply to the voice indicated by the caret indicator during step input or the selected 
voice when adding string indicators to existing notes. They are automatically placed above the 
staff for up-stem voices and below the staff for down-stem voices.

During note input, string indicators are input at the caret position, and extend automatically if 
you included an open-ended string indicator with duration.

When adding string indicators to a single existing note, they are added to the selected note only 
and have no duration. When adding string indicators to a range of notes, they are added to the 
first note in the selection and have duration, which applies until the end of the selection.

By default, string indicators have dashed duration lines with a hook cap at the end.

AFTER COMPLETING THIS TASK

● If you input string indicators without duration but want to show dashed duration lines, you 
can add them.

● You can change the staff-relative placement of string indicators.

RELATED LINKS
Playing techniques popover on page 369
String indicators on page 1183
Lengthening/Shortening items on page 436
Extending the caret to multiple staves on page 219
Changing the staff-relative placement of items on page 441
Notations toolbox on page 202
Keyboard panel on page 207
Fretboard panel on page 209
Drum Pads panel on page 210

Inputting string indicators outside the staff with the panel
You can input string indicators outside the staff using the Playing Techniques panel, both during 
note input and by adding them to existing music.

NOTE

● You cannot input string indicators with duration during note input when using the panel. 
You can only do so when using the popover.

● These steps describe inputting with the default mouse input preference Create item at 
selection. If you want to input the same string indicator in multiple places, change your 
mouse input preference to Load pointer with item so that you do not have to reselect the 
string indicator for each note.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a string 
indicator outside the staff. If you want to input a string indicator with a duration line, 
select items on the staff that span that duration.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Guitar section.

4. Click the string indicator you want.

RESULT
The specified string indicator is input. It is considered voice-specific by default, meaning it only 
applies to the voice indicated by the caret indicator during step input or the selected voice when 
adding string indicators to existing notes. It is automatically placed above the staff for up-stem 
voices and below the staff for down-stem voices.

During note input, string indicators are input at the caret position, even if your preference is set 
to Load pointer with item.

When adding string indicators to a single existing note, they are added to the selected note only 
and have no duration. When adding string indicators to a range of notes, they are added to the 
first note in the selection and have duration, which applies until the end of the selection.

By default, string indicators have dashed duration lines with a hook cap at the end.

AFTER COMPLETING THIS TASK

● If you input string indicators without duration but want to show dashed duration lines, you 
can add them.

● You can change the staff-relative placement of string indicators.

RELATED LINKS
Playing Techniques panel on page 372
Changing your mouse input settings on page 213

Inputting string indicators inside the staff
You can show a string indicator inside the staff for each fretted instrument note. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains. Dorico Pro 
automatically detects a string that each pitch could be played on, but you can also specify the 
string manually.

NOTE

These steps only apply to notes belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the notes belonging to fretted instruments beside which you want to show string 
indicators. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Show in the String Indicators group.

RESULT
String indicators are shown in the staff beside each selected note. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

Unless you have specified a string for each note, the string number shown in the string 
indicators is calculated automatically. String indicators inside the staff for open strings appear 
as a bold number zero without a circle enclosure.

By default, string indicators appear on the left of noteheads without left-hand fingerings and on 
the right of noteheads with left-hand fingerings.

AFTER COMPLETING THIS TASK

● You can specify the string on which notes are played, which affects the number shown in 
their corresponding string indicators.

● You can change the notehead-relative position of string indicators.

● You can change the default appearance of open string indicators.

RELATED LINKS
String indicators on page 1183
Fingerings for fretted instruments on page 1169
Fretted instrument tuning on page 142
Assigning notes to strings on page 1255
Changing the notehead-relative position of string indicators on page 1187
Changing the appearance of open string indicators on page 1185
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Input methods for lines
You can input both horizontal and vertical lines by using the Lines panel. There is no popover for 
lines.

TIP

If you want lines to represent specific notations that affect playback if applicable, you can instead 
input these notations directly. For example, dynamics, arpeggios, glissandi, and trills all have 
dedicated features in Dorico Pro.

RELATED LINKS
Lines on page 1402
Input methods for dynamics on page 310
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Input methods for clefs and octave lines on page 329
Input methods for tempo marks on page 294
Input methods for repeats and tremolos on page 406
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Lines panel
The Lines panel contains the different types of lines available in Dorico Pro. It is located in the 
right zone in Write mode.

● You can hide/show the Lines panel by clicking Panels , then Lines  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Lines panel contains the following sections:

Horizontal
Contains the different horizontal lines available. The options at the top of the section 
allow you to determine the attachment type for the start and end of horizontal lines 
you subsequently input. Horizontal lines can be attached to noteheads, barlines, or 
rhythmic positions, and the start and end can have different attachment types.

Vertical
Contains the different vertical lines available.

RELATED LINKS
Notations toolbox on page 202
Lines on page 1402
Line components on page 1404
Custom lines on page 884

Inputting horizontal lines
You can input horizontal lines between existing notes or spanning a specified duration using the 
Lines panel. Horizontal lines can be attached to noteheads, barlines, or rhythmic positions, and 
can have different attachment types at their start and end.

You can also input barline-/rhythmic position-attached lines that apply to all staves.

NOTE

● You cannot change the attachment type of horizontal lines after they have been input.

● If you want to input notehead-attached horizontal lines to represent glissandi, you can 
instead input glissando lines directly.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PREREQUISITE
You have created any custom horizontal lines you want to input.

PROCEDURE

1. In Write mode, select one of the following:

● If you want to input a notehead-attached line, select the notes you want to join with a 
line.
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TIP

The notes can be in different voices, on different staves, and belong to any instruments 
held by the same player.

● If you want to input a barline-/rhythmic position-attached line, select items that span the 
required duration of the line.

● If you want to input a horizontal line that is attached to noteheads at one end but 
barlines/rhythmic positions at the other end, select the required note and any item at 
the required rhythmic position of the other end.

2. In the Notations toolbox, click Panels , then Lines  to show the Lines panel.

3. In the Horizontal section, choose one of the following options for both Start and End:

● Attach to notehead 

● Attach to barline (where available) 

● Attach to rhythmic position 

4. Input a line with the specified attachments in one of the following ways:

● To input a notehead-attached line or barline-/rhythmic position-attached line on the 
selected staff only, click it in the Horizontal section.

● To input a barline-/rhythmic position-attached line that applies to all staves, Alt/Opt -
click it in the Horizontal section.

RESULT
A horizontal line with the specified attachments is input. They are positioned according to their 
attachment types and their rhythmic positions.

Horizontal lines that apply to all staves are categorized as system objects. Therefore, they follow 
your per-layout settings for the visibility and positioning of system objects.

AFTER COMPLETING THIS TASK

● You can change the placement and staff position of barline-/rhythmic position-attached 
lines.

● You can add text to lines.

RELATED LINKS
Notations toolbox on page 202
Lines on page 1402
Creating custom lines on page 884
Positions of lines on page 1405
Length of lines on page 1410
System objects on page 1563
Changing the positions of system objects on page 1564
Adding text to lines on page 1415
Changing the placement of horizontal lines on page 1408
Inputting glissando lines with the popover on page 350
Mouse input settings on page 213
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Inputting vertical lines
You can input vertical lines on existing notes using the Lines panel, including across notes in 
multiple voices and on different staves that belong to the same instrument, such as piano or 
harp.

NOTE

● If you want to input vertical lines to represent arpeggios, you can instead input arpeggio 
signs directly.

● You can only input one vertical line at a time.

● These steps describe inputting with the default mouse input preference Create item at 
selection. You cannot create cross-staff and cross-voice vertical lines if your preference is set 
to Load pointer with item.

PREREQUISITE
You have created any custom vertical lines you want to input.

PROCEDURE

1. In Write mode, select at least one note at the same rhythmic position in each voice to which 
you want to add a vertical line.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff vertical lines. However, you cannot create 
cross-staff vertical lines between different instruments, even if they are held by the same 
player.

● Vertical lines are added to all notes in the selected voices at the selected rhythmic 
position.

2. In the Notations toolbox, click Panels , then Lines  to show the Lines panel.

3. In the Vertical section, click the line you want.

RESULT
The vertical line specified is input to the left of the selected notes. Its length is adjusted 
automatically so that it spans the range of all notes in the selected voices/staves at that rhythmic 
position.

AFTER COMPLETING THIS TASK

● You can change the order of lines when multiple exist at the same rhythmic position and 
show vertical lines on the right of notes.

● You can lengthen/shorten vertical lines.

● You can add text to lines.

RELATED LINKS
Notations toolbox on page 202
Lines on page 1402
Creating custom lines on page 884
Length of lines on page 1410
Lengthening/Shortening vertical lines on page 1411
Adding text to lines on page 1415
Showing vertical lines on the right/left of notes on page 1406
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Changing the horizontal order of vertical lines on page 1407
Inputting arpeggio signs with the popover on page 349
Changing your mouse input settings on page 213

Inputting text items
You can input text at specific rhythmic positions in the score using text items. You can input 
staff-attached text for single staves or input system-attached text that applies to all staves and 
appears in all applicable layouts.

TIP

If you want to insert text that is independent of rhythmic positions and attached to a particular 
page, you can use text frames.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input text.

2. Open the text editor in any of the following ways:

● To input staff-attached text, press Shift-X  or click Popovers , then Text  in the 
Notations toolbox.

● To input staff-attached text with a specific paragraph style, choose Write > Create 
Text > [Paragraph style].

● To input system-attached text, press Shift-Alt/Opt-X .

● To input system-attached text with a specific paragraph style, choose Write > Create 
System Text > [Paragraph style].

3. Enter the text you want.

● To insert a music symbol, right-click in the text item and choose Insert Music Text from 
the context menu to open the Insert Music Text dialog. Select the music symbol you 
want to insert, then click OK.

● To insert a line break, press Return .

4. Optional: Format the text using the text editor options.

5. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
During note input, the text you entered into the text editor is input at the caret position. When 
adding text to existing music, it is input at the position of the earliest selected item.

If you did not change or specify the paragraph style, the text item uses the Default Text 
paragraph style.

Text items are automatically placed above the staves to which they apply and follow your project-
wide settings for the vertical position of text.

NOTE

● In Dorico Pro, system-attached text is categorized as a system object. Therefore, system-
attached text follows your per-layout settings for the visibility and positioning of system 
objects.
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● If you override the paragraph style of text in an individual text item or text frame, such 
as by making text bold, any changes you later make to corresponding parameters of the 
paragraph style are not applied to the overridden text. However, font size overrides are 
combined with the font size in the paragraph style.

● You can change the default position of all text items outside of the staff and other items, and 
whether text items avoid collisions by default, on the Text page in Engraving Options.

● You can assign key commands for inputting text with specific paragraph styles, for both 
Create Text and Create System Text, on the Key Commands page in Preferences.

RELATED LINKS
Notations toolbox on page 202
Changing the staff-relative placement of items on page 441
Types of text on page 1607
Text items on page 1606
System objects on page 1563
Text formatting on page 845
Text frames on page 575
Paragraph Styles dialog on page 848
Engraving Options dialog on page 840
Key Commands page in the Preferences dialog on page 63

Text editor options in Write mode
The text editor allows you to add and format text. In Write mode, it opens when you add or edit 
text items.

The text editor provides the following options:

1 Character Style

Allows you to change the appearance of selected text within paragraphs. This overrides the 
paragraph style applied to the corresponding paragraph.

2 Paragraph Style

Allows you to change the paragraph style applied to the whole text item. Depending on the 
paragraph style, this can change the appearance, formatting, and alignment of the text.

3 Font

Allows you to change the font family of selected text.

4 Font Style

Allows you to change the font style of selected text.

NOTE

● Depending on the font selected, some font styles might not be available.

● You can also change the font style using the following standard key commands:

● Ctrl/Cmd-B  for bold

● Ctrl/Cmd-I  for italic
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5 Font Size

Allows you to change the size of selected text.

TIP

You can also change the font size using the following key commands:

● Ctrl/Cmd-Shift-.  to increase the font size

● Ctrl/Cmd-Shift-,  to decrease the font size

6 Font Stretch

Allows you to make selected text wider or narrower.

7 Baseline Shift

Allows you to shift the baseline of selected text gradually up or down.

8 Letter Spacing

Allows you to increase/decrease the space between the characters of selected text.

9 Word Spacing

Allows you to increase/decrease the space between the words of selected text.

10 Alignment

Allows you to choose one of the following alignments for the text item relative to its rhythmic 
position:

● Align Left

● Align Center

● Align Right

11 Line Types

Allows you to show any of the following types of lines, in any combination, on selected text:

● Underline

● Overline

● Strikethrough

TIP

You can also make selected text underlined by pressing Ctrl/Cmd-U .

12 Script Types

Allows you to position selected text in one of the following positions relative to the text on 
the baseline:

● Superscript

● Subscript

13 Foreground Color

Allows you to change the color of selected text.

14 Background Color

Allows you to change the background color of selected text.

NOTE

If you override the paragraph style of text in an individual text item or text frame, such as by 
making text bold, any changes you later make to corresponding parameters of the paragraph 
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style are not applied to the overridden text. However, font size overrides are combined with the 
font size in the paragraph style.

RELATED LINKS
Types of text on page 1607
Text items on page 1606
Changing the default font family on page 853
Entering text in text frames on page 583
Text formatting on page 845
Paragraph Styles dialog on page 848
Character Styles dialog on page 851
Missing Fonts dialog on page 76

Insert Music Text dialog
The Insert Music Text dialog allows you to add music symbols, such as accidentals and note 
symbols, to text items and text frames.

● You can open the Insert Music Text dialog when inputting or editing text in a text item or 
text frame by right-clicking and choosing Insert Music Text from the context menu.

The Insert Music Text dialog comprises the following:

1 Search field

Allows you to search for music symbols by their SMuFL name. When you start entering text, a 
menu appears that shows valid music symbols containing the letters/words you enter, which 
you can select.

2 Range menu

Allows you to select which SMuFL glyph range is available in the music symbol selector. By 
default, Recently used is selected, which contains common accidentals and note symbols in 
addition to music symbols you have used in recent projects.

3 Music symbol selector

Contains the available music symbols in the selected range or that match your entry.

4 Name

Displays the SMuFL name and description, where available, of the selected music symbol.

5 OK

Inserts the selected music symbol at the cursor position with the Music Text character style 
applied to them automatically.
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You can also insert music symbols by pressing Return .

Editing text in text items
You can edit the text shown in text items; for example, to replace individual words or to change 
their formatting.

PROCEDURE

1. Open the text editor for an existing text item in any of the following ways:

● Select the text item and press Return .

● Double-click the text item.

2. Edit the text in the text item.

For example, you can format the text using the text editor options.

NOTE

If you override the paragraph style of text in an individual text item or text frame, such 
as by making text bold, any changes you later make to corresponding parameters of the 
paragraph style are not applied to the overridden text. However, font size overrides are 
combined with the font size in the paragraph style.

3. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

Inputting lyrics
You can input lyrics by entering text into the lyrics popover, and you can advance the lyrics 
popover to the next note on the staff without closing and reopening it for every note.

PROCEDURE

1. In Write mode, select the note on the staff from which you want to start inputting lyrics.

2. Open the lyrics popover in any of the following ways:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

3. Optional: Change the type of lyric in one of the following ways:

● To change the lyric line number, press Down Arrow .

● To input lyrics above the staff, press Shift - Up Arrow .

● To input chorus lines, press Up Arrow .

● To input lyric line translations, press Alt/Opt - Down Arrow .

4. Enter the word or syllable you want to add to the selected note into the popover.

● To enter multiple words on a single note, press Shift-Alt/Opt-Space .

● To include a hyphen within a single word or syllable, press Alt/Opt--  (hyphen).

● To include an elision in a lyric, press _  (underscore).

5. Advance the popover to the next note in one of the following ways:

● If you entered a complete word, or the final syllable in a multi-syllabic word, press 
Space .

● If you entered one syllable of a multi-syllabic word that is not the final syllable, press - 
(hyphen).
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● If you do not want the syllable to be followed by an extension line or hyphen, press 
Right Arrow .

TIP

For lyrics sung over multiple notes, you can press these key commands multiple times until 
the lyrics popover reaches the note where you want to input the next lyric.

6. Continue entering words and syllables into the popover for the rest of the notes to which 
you want to add lyrics.

7. Press Return  or Esc  to close the popover.

The popover closes automatically when you reach the last note on the staff.

RESULT
The text you entered into the popover is input as lyrics of the type indicated by the icon on the 
left-hand side of the popover.

When you advance the popover to the next note by pressing - , a hyphen appears after the last 
entered lyric. This is used for multi-syllabic words across multiple notes.

When you advance the popover by pressing Space , a gap appears after the last entered lyric. 
This is used for single-syllable words or for the final syllable in multi-syllabic words.

TIP

● You can later change whether a gap or a hyphen appears between lyrics by changing their 
syllable type.

● You can also input lyrics by copying and pasting them; for example, from an external text 
editor.

RELATED LINKS
Notations toolbox on page 202
Copying and pasting lyrics on page 1225
Lyrics on page 1222
Navigation during lyric input on page 394
Types of lyrics on page 1223
Types of syllables in lyrics on page 1224
Lyric line numbers on page 1241
Lyric hyphens and lyric extender lines on page 1240
Elision slurs on page 1244
Lyric text editing on page 1237

Lyrics popover
You can input lyrics, including chorus lines and lyric line translations, using the lyrics popover. 
You can use key commands to change the type of lyric being input at any time.

You can open the lyrics popover in Write mode in any of the following ways when either an item 
is selected or the caret is active:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

● Select an existing lyric and press Return .

● Choose Write > Create Lyrics.
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Lyric lines
The popover automatically opens ready to input lyrics into Line 1, except if you are 
changing an existing lyric.

The number shown on the left-hand side of the lyrics popover indicates the lyric line 
into which the lyric is input.

The lyrics popover with an example entry for Line 1

You can change the lyric line number by pressing Up Arrow  and Down Arrow  when 
the lyrics popover is open.

The lyrics popover with an example entry for Line 2

Lyric lines above the staff
You can input lyrics into lines above the staff by pressing Shift - Up Arrow  when the 
lyrics popover is open.

You can then press Up Arrow  and Down Arrow  to change the lyric line number 
above the staff.

Chorus lines
You can input chorus lines by pressing Up Arrow  when the lyrics popover is open. You 
can do this when inputting lyrics below the staff and above the staff.

A c, for “chorus lines”, is shown on the left-hand side of the popover.

The lyrics popover with an example entry for a chorus line

Lyric line translations
You can input lyric line translations by pressing Alt/Opt - Down Arrow  when the lyrics 
popover is open.

An asterisk (*) is shown beside the lyric line number for which you are inputting a lyric 
line translation on the left-hand side of the popover.

The lyrics popover with an example entry for a lyric line translation

Navigation during lyric input
You can move the lyrics popover to input new lyrics and edit existing lyrics without having to 
close and reopen the lyrics popover.

Popover navigation Key command

Finish the current word and advance the 
popover to the next note or chord.

Space
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Popover navigation Key command

Finish the current syllable and advance the 
popover to the next note or chord.

-  (hyphen)

Advance the popover to the next note without 
showing an extension line or hyphen.

Right Arrow

Move the cursor to the next/previous letter. If 
the next/previous letter is in another lyric, the 
popover advances to that lyric.

Right Arrow / Left Arrow

Move the popover forwards/backwards from 
syllable to syllable within lines of lyrics.

Alt/Opt-Right Arrow / Alt/Opt-Left Arrow

Add spaces within a word or syllable without 
advancing the popover.

Shift-Alt/Opt-Space

Add a hyphen within a single word or syllable 
without advancing the popover.

Alt/Opt--  (hyphen)

Add an elision slur within a word or syllable. _  (underscore)

Inputting figured bass
You can input figured bass using the figured bass popover, both for all instruments or only for 
individual instruments. You can also open the figured bass popover during note input; however, 
inputting a figure stops note input.

PREREQUISITE
You have chosen the appropriate figured bass input setting.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
start inputting figured bass.

2. Open the figured bass popover in any of the following ways:

● Press Shift-G .

● In the Notations toolbox, click Popovers , then Figured Bass .

NOTE

If you selected an item on a staff that has local figures at earlier rhythmic positions, the 
figured bass popover is automatically set to input local figures when it opens.

3. Optional: Change the type of figure you want to enter in one of the following ways:

● To input local figures, press Alt/Opt-L .

● To input global figures, press Alt/Opt-G .

The popover icon updates to show the current type.
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Figured bass popover when inputting a global 
figure

Figured bass popover when inputting a local 
figure

4. Enter the figure you want into the figured bass popover.

For example, enter 4->3d=4r=2 for a 4-3 suspension that lasts a whole note, with the 
resolution to the third after a half note. For bracketed figures, include parentheses around 
the required figures or accidentals, such as (#)64(3).

5. Optional: Press Space  to advance the popover to the next beat according to the prevailing 
time signature.

TIP

You can also navigate the popover forwards and backwards by different amounts.

6. Optional: To input an individual local figure when the popover is set to global, and vice versa, 
press Alt/Opt-Return  to input the figure.

7. Press Return  to close the popover.

RESULT
The figured bass specified is input. If you selected an item belonging to an instrument that was 
not already set to show figured bass in the current layout, its player is automatically updated to 
show them. If Dorico Pro cannot identify the bass note at the position of a figure, such as if you 
input a figure on a rest, it appears as a signpost.

Dorico Pro calculates and saves the pitches implied by the figures you enter in relation to the 
lowest note at that rhythmic position. This semantic understanding of the harmony implied by 
figures allows Dorico Pro to update the displayed figures on different staves and if you transpose 
or change the pitch of notes.

Global figures apply to all instruments in the project and appear on all staves whose players are 
set to show figured bass. Local figures only apply to the selected instrument, and by default refer 
to its lowest staff. Local figures always appear, even if global figures exist at the same rhythmic 
positions.

NOTE

● Unless you included an entry for Follow input literally at the start of your popover entry 
or changed your figured bass input setting to Follow input literally, the appearance of 
the resulting figure depends on the options you have set on the Figured Bass page in 
Engraving Options.

● The appearance of tasto solo indications depends on your setting in Engraving Options > 
Figured Bass > Design > Tasto Solo and the formatting of the Figured Bass Tasto Solo 
paragraph style.

● You can move figures graphically in Engrave mode, including changing the graphical length 
of hold lines.

EXAMPLE
Entering 4->3d=4r=2 into the figured bass popover produces a 4-3 suspension that lasts a whole 
note, with the resolution to the third after a half note.
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AFTER COMPLETING THIS TASK

● You can hide/show figured bass above specific players in each layout independently.

● You can simplify compound figures; that is, figures 9 and above.

● You can show figures on individual rests.

RELATED LINKS
Figured bass on page 1139
Figured bass hold lines on page 1144
Changing the figured bass input setting on page 401
Navigation during figured bass input on page 400
Hiding/Showing figured bass in layouts on page 1141
Hiding/Showing figured bass hold/suspension lines on page 1144
Lengthening/Shortening figured bass hold lines on page 1145
Moving figured bass resolutions on page 1150
Engraving Options dialog on page 840
Paragraph Styles dialog on page 848
Showing single brackets on figured bass on page 1143
Showing brackets on figured bass hold lines on page 1147
Simplifying figured bass compound intervals on page 1154
Showing figured bass on rests on page 1142
Fixing the current appearance of figured bass on page 1155

Figured bass popover
The following tables contain examples of what you can enter into the figured bass popover to 
input the different possible figured bass figures, including alterations and suspensions.

You can open the figured bass popover in Write mode in any of the following ways when either a 
note is selected or the caret is active:

● Press Shift-G .

● In the Notations toolbox, click Popovers , then Figured Bass .

● Choose Write > Create Figured Bass.

When inputting global figured bass, the icon on the left-hand side of the popover matches the 
corresponding button in the Notations toolbox. When inputting local figured bass, the icon on 
the left-hand side of the popover appears smaller and includes the icon for a single player.

Figured bass popover with an 
example entry for a global figure

Figured bass popover with an 
example entry for a local figure

Figured Bass button in the 
Notations toolbox
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Figures and suspensions

Type of figure Example popover entry

Figures (1-19) 1, 2, 3, and so on, up to 19

Bracketed figures or accidentals (#643), #64(3), (#)643, and so on

Figures determined by chord symbols

Dorico Pro automatically converts chord 
symbols, as you would enter into the chord 
symbols popover, into correct figured bass.

Em7, Amaj7, or G/B, and so on

tasto solo ts or tasto

Hold duration d=2 (number of quarter notes) or d=1/2n 
(fraction of bass note duration)

Multiple figures

TIP

You can separate figures with commas to 
remove ambiguity.

6#42 or 6,#4,2

Hide figures <3> or {3}

Suspensions 4->3, 4_3, or 4~3

Suspension duration; that is, the duration 
between suspension and resolution figures

r=2 (number of quarter notes) or r=1/2n 
(fraction of bass note duration)

Hold and suspension durations both specified

For example, a 4-3 suspension that lasts a 
whole note, with the resolution to the third 
after a half note.

4->3d=4r=2 or 4->3d=1nr=1/2n

Follow Engraving Options for this figure only

NOTE

Must be at the start of the popover entry.

R, r, V, v, or ?

Follow input literally for this figure only

NOTE

Must be at the start of the popover entry.

O, o, or !
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This list is not comprehensive. It is intended to illustrate how you can structure your entry to 
input different figures.

NOTE

● Unless you include an entry for Follow input literally at the start of your popover entry 
or have changed your figured bass input setting to Follow input literally, the appearance 
of resulting figures depends on the options you have set on the Figured Bass page in 
Engraving Options.

● The appearance of tasto solo indications depends on your setting in Engraving Options > 
Figured Bass > Design > Tasto Solo and the formatting of the Figured Bass Tasto Solo 
paragraph style.

EXAMPLE
Entering 4->3d=4r=2 into the figured bass popover produces a 4-3 suspension that lasts a whole 
note, with the resolution to the third after a half note.

Accidentals and alterations

Type of accidental/alteration Popover entry

Sharp

TIP

For raised thirds, you can enter just without 
the number.

# or s

Flat b or f

Natural N or n

Double sharp x, ##, or ds

Triple sharp x#, #x, ###, or ts

Double flat bb or db

Triple flat bbb or tb

Raise figure by a half-step (semitone) +

Lower figure by a half-step (semitone) -

Diminished figure d
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Type of accidental/alteration Popover entry

Unaltered figure u

RELATED LINKS
Notations toolbox on page 202
Figured bass on page 1139
Figured bass hold lines on page 1144
Hiding/Showing figured bass hold/suspension lines on page 1144
Lengthening/Shortening figured bass hold lines on page 1145
Showing brackets on figured bass hold lines on page 1147
Showing single brackets on figured bass on page 1143
Chord symbols popover on page 320
Engraving Options dialog on page 840
Paragraph Styles dialog on page 848

Navigation during figured bass input
You can move the figured bass popover manually by different amounts to input figured bass 
figures at other positions without closing and reopening the popover each time.

Popover navigation Key command

Advance the popover to the next beat, 
according to the prevailing time signature.

Space

Move the popover back to the previous beat, 
according to the prevailing time signature.

Shift-Space

Advance the popover to the start of the next 
bar.

Tab

Move the popover back to the start of the 
previous bar.

Shift-Tab

Move the cursor and popover to one of the 
following positions, whichever is closest:

● Next/Previous note or rest

● Next/Previous rhythmic grid position

● Next/Previous character in existing figure’s 
entry

Right Arrow / Left Arrow

Move the popover to the next/previous figure. Ctrl/Cmd-Right Arrow / Ctrl/Cmd-Left Arrow

RELATED LINKS
Key Commands page in the Preferences dialog on page 63
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Changing the figured bass input setting
By default, figured bass input follows your settings in Engraving Options. Therefore, the 
resulting figures may look different to what you entered into the popover. You can change the 
input setting for figured bass; for example, if you are reproducing a specific edition and know 
exactly how you want figures to appear.

Allowing figured bass to follow your engraving options is useful if you are unsure how to 
represent figures exactly or if you expect to make changes to the music later.

PROCEDURE

1. Press Ctrl/Cmd-Shift-I  to open Note Input Options.

2. In the category list, click Figured Bass.

3. Choose one of the following options for When inputting via the popover:

● Follow Engraving Options

● Follow input literally

4. Click Apply, then Close.

RESULT
The figured bass input setting is changed in the current project. This affects all subsequent 
figured bass you input, but does not affect any existing figured bass in the project.

AFTER COMPLETING THIS TASK

● You can input figured bass using your chosen setting.

● You can reset existing figured bass so it follows your engraving options, regardless of the 
input setting when you input them.

RELATED LINKS
Project-wide engraving options for figured bass on page 1140
Fixing the current appearance of figured bass on page 1155
Resetting figured bass on page 1155
Note Input Options dialog on page 839

Inputting rehearsal marks
You can input rehearsal marks with the mouse and the keyboard. You can input rehearsal marks 
during note input and later by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a rehearsal mark. For 
example, a barline or a note.

NOTE

You can only input one rehearsal mark at a time, even if multiple items are selected.

2. Input a rehearsal mark in any of the following ways:

● Press Shift-A .
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● In the Notations toolbox, click Popovers , then Rehearsal Marks .

RESULT
A rehearsal mark is input at the selected barline, or at the rhythmic position of other selected 
items.

The order of rehearsal marks is updated automatically, meaning you can input them in any 
order, including before and between existing rehearsal marks.

AFTER COMPLETING THIS TASK
If you want to change the letter/number displayed in the rehearsal mark, you can change its 
index and/or sequence type.

RELATED LINKS
Notations toolbox on page 202
Rehearsal marks on page 1424
Changing the index of rehearsal marks on page 1426
Changing the rehearsal mark sequence type on page 1427
Adding prefixes/suffixes to rehearsal marks on page 1428
Changing the rehearsal mark enclosure type on page 1425
Going to rehearsal marks on page 447
Mouse input settings on page 213

Inputting markers/timecodes
You can input markers at specific positions in time. Depending on your project-wide settings, 
timecodes can also be shown alongside markers.

PROCEDURE

1. In Write mode, move the playhead to the time position where you want to input a marker.

2. Press Shift-Alt/Opt-M  to open the Add Marker dialog.

3. Enter the marker text you want into the Text field.

4. Optional: Change the timecode in the Timecode field.

5. Click OK to input the marker and close the dialog.

RESULT
A marker is input at the timecode position set in the Add Marker dialog, which by default is the 
position of the playhead. It shows the text you entered, or the default text “Marker” if you did not 
change the marker text, and a timecode reflecting its position.

TIP

You can also input markers by clicking Add Marker  in the Markers section of the Video panel, 
or by using the Markers track in Play mode.

RELATED LINKS
Markers on page 1430
Timecodes on page 1435
Moving the playhead on page 631
Hiding/Showing timecodes in markers on page 1437
Editing marker text on page 1432
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Changing the timecodes of markers on page 1433
Video panel on page 403
Markers track on page 626

Add Marker dialog
The Add Marker dialog allows you to input markers with custom text at specific timecodes.

● The Add Marker dialog opens automatically when you input markers in Write mode, either 
by pressing Shift-Alt/Opt-M  or by clicking Add Marker  in the Markers section of the 
Video panel.

The Add Marker dialog contains the following options:

Text
Allows you to enter custom text that is shown in the marker.

Timecode
Allows you to specify the timecode at which you want to input the marker. For example, 
if you already know the timecodes for each marker, you can enter them directly rather 
than positioning the playhead at the position of each marker.

Valid range
Displays the timecode range of the flow.

Video panel
The Video panel in Write mode allows you to access the Video Properties dialog, and to input 
and edit markers and timecodes. You can also define markers as important and calculate suitable 
tempos for them. It is located in the right zone in Write mode.

● You can hide/show the Video panel by clicking Panels , then Video  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

In the Video section of the Video panel, you can click Properties to open the Video Properties 
dialog.

The Markers section of the Video panel contains a table of markers, divided into the following 
columns:

Timecode
Shows the timecode of the marker. You can edit the timecode by double-clicking in the 
field.
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Text
Shows the text of the marker. You can edit the text by double-clicking in the field.

Imp.
Stands for “important”. Allows you to define markers as important by activating their 
checkbox in this column.

When markers are defined as important, their entry uses a bold font in the table and 
they are considered when finding a suitable tempo in the Find Tempo dialog.

The action bar at the bottom of the table contains the following options:

● Add Marker : Adds a marker at the playhead position.

● Delete Marker : Deletes the selected marker.

NOTE

You can only delete one marker at a time.

RELATED LINKS
Notations toolbox on page 202
Video Properties dialog on page 191

Find Tempo dialog
The Find Tempo dialog allows you to calculate tempos that best accommodate your important 
markers; for example, by identifying which tempos cause markers to coincide as closely as 
possible with strong beats.

● You can open the Find Tempo dialog in Write mode by clicking Find Tempo in the Markers 
section of the Video panel.

NOTE

● The Find Tempo dialog only considers markers in a single flow. You can change which flow 
by selecting an item in the corresponding flow and then opening the dialog.

● The Find Tempo dialog is only available if you have input at least one marker in the flow and 
defined at least one marker as important.
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The Find Tempo dialog contains the following options and sections:

Flow
Shows the name of the flow whose tempo you are determining. This field is read-only.

Beat unit
Allows you to change the beat unit considered for the tempo. For example, if the time 
signature for the flow is 6/8, you might want to change the beat unit to a dotted 
quarter note.

Tempo range
Allows you to set the minimum/maximum tempos you want to consider.

Tempo increments
Allows you to filter the suggested tempos according to their precision.

● Integral only: Only whole number tempos, that is, tempos without decimal places, 
are suggested.

● Allow increment by 0.25: Allows tempos with decimal places of .25, .5, and .75 to 
be suggested.

Tempos found
Contains a list of possible tempos that you can select to see how they affect the 
position of your markers relative to beats. The list is updated automatically when you 
change options such as Tempo range and Beat unit.

The list contains columns for the following information:

● BPM: Stands for “beats per minute”. Lists different possible tempos according to 
their metronome mark value.

● IFO: Stands for “important frames off”. Indicates the average number of frames by 
which important markers miss significant beats, either before or after.

● NFO: Stands for “non-important frames off”. Indicates the average number of 
frames by which non-important markers miss significant beats, either before or 
after.

● AFO: Stands for “all frames off”. Indicates the average number of frames by which 
all markers in the flow miss significant beats, either before or after.
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Found tempos are listed in descending order of average frames off for important 
markers.

Markers
Shows the impact that the tempo currently selected in the Tempos found list would 
have on each marker in the flow in more detail.

● Timecode: Shows the exact timecode of each marker.

● Text: Shows the marker text of each marker to help you identify them.

● Imp.: Indicates whether a marker has been defined as important.

● Fr. Off: Stands for “frames off”. Shows the average number of frames by which 
each marker misses being aligned to beats.

● Time Diff.: Stands for “time difference”. Shows the time difference between the 
position of the marker and the position of the nearest beat, expressed in fractions 
of a second.

● Not. Diff.: Stands for “notated difference”. Shows the notated difference between 
the position of the marker and the position of the nearest beat, expressed in 
fractions of a whole note.

Selected tempo
Displays the currently selected tempo for the flow.

Apply
Applies the selected tempo to the flow by inputting it as a tempo mark at the 
beginning of the flow. Any other tempo marks in the flow are automatically deleted.

RELATED LINKS
Defining markers as important on page 1434
Metronome marks on page 1596

Input methods for repeats and tremolos
You can input repeats and tremolos, including repeat endings, repeat markers, and rhythm 
slashes, with the keyboard by using the repeats popover, and with the mouse by using the 
Repeat Structures panel.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

TIP

To indicate repeats using repeat barlines, you can input repeat barlines using the available input 
methods for barlines.

RELATED LINKS
Input methods for bars, beats, and barlines on page 302
Barlines on page 967
Types of barlines on page 968
Repeat endings on page 1440
Repeat markers on page 1447
Tremolos on page 1659
Rhythm slashes on page 1473
Bar repeats on page 1459
Numbered bar regions on page 1467
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Repeats in playback on page 640

Repeats popover
The following tables contain the entries for the repeats popover that you can use to input the 
different tremolos, repeat markers, repeat endings, and bar repeat, slash, and numbered bar 
regions available.

You can open the repeats popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

● Select an existing repeat marker, slash region, or bar repeat and press Return .

● Choose Write > Create Repeat.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Repeats popover with an example entry
Repeat Structures button in the Notations toolbox

Repeat endings

Part of repeat ending Popover entry

Whole repeat ending end or ending

Additional repeat ending segment add

Repeat markers

Type of repeat marker Popover entry

D.C. dc, D.C., da capo, and so on

D.C. al Fine dcalf, DC al Fine, D.C. al Fine, and so on

D.C. al Coda dcalc, DC al Coda, D.C. al Coda, and so on

D.S. ds, D.S., dal segno, and so on

D.S. al Fine dsalf, DS al Fine, D.S. al Fine, and so on

D.S. al Coda dsalc, DS al Coda, D.S. al Coda, and so on

to Coda toc, tc, to coda, To Coda, and so on

Write mode
Notations input 

407
Dorico Pro 4.3.30



Type of repeat marker Popover entry

Segno s, seg, segno, and so on

Fine f, fin, fine, and so on

Coda c, co, coda, and so on

The list of entries for repeat markers is not comprehensive, as the flexibility of the popover 
means you can enter any reasonable version or abbreviation of the type of repeat marker you 
want, and the popover recognizes it in most cases.

Single-note tremolos

Type of tremolo Popover entry

One stroke /, \, or 1

Two strokes //, \\, or 2

Three strokes ///, \\\, or 3

Four strokes ////, \\\\, or 4

Z on stem (buzz roll) z or zonstem

Tremolo with release; for example, two-strokes 
with release

rel; for example, //rel or 2rel

Tremolo with attack; for example, two-strokes 
with attack

att; for example, //att or 2att

Remove all tremolos 0 or clear

Multi-note tremolos

Type of tremolo Popover entry

One stroke /2, \2, or 12

Two strokes //2, \\2, or 22

Three strokes ///2, \\\2, or 32

Four strokes ////2, \\\\2, or 42

Remove all tremolos 0 or clear
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Slash regions

Slash region Popover entry

New slash region slash

Numbered bar regions

Numbered bar region Popover entry

New numbered bar region nb, num, numbars, or number bars

Bar repeats

Type of bar repeat Popover entry

Repeat last bar % or %1

Repeat last 2 bars %2

Repeat last 4 bars %4

Repeat last bar, group in 2 %1,2

Repeat last bar, group in 4 %1,4

Repeat last 2 bars, group in 4 %2,4

RELATED LINKS
Notations toolbox on page 202
Inputting repeat endings with the popover on page 410
Inputting repeat markers with the popover on page 414
Inputting tremolos with the popover on page 415
Inputting slash regions on page 418
Inputting bar repeats on page 419
Inputting numbered bar regions on page 420
Bars and barlines popover on page 302
Repeat endings on page 1440
Repeat markers on page 1447
Tremolos on page 1659
Rhythm slashes on page 1473
Bar repeats on page 1459
Numbered bar regions on page 1467
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Repeat Structures panel
The Repeat Structures panel contains the different types of repeat notations available in Dorico 
Pro, including repeat endings, tremolos, and bar repeats. It is located in the right zone in Write 
mode.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

● You can hide/show the Repeat Structures panel by clicking Panels , then Repeat 
Structures  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Repeat Structures panel contains the following sections:

Repeat Endings
Contains options that allow you to input new repeat endings and add additional 
endings to existing repeat endings.

Repeat Jumps
Contains different types of repeat markers that instruct players to jump to a specific 
point in the piece, such as “D.S. al Coda”.

Repeat Sections
Contains different sections used in conjunction with repeat jumps, such as “Coda”.

Tremolos
Contains different types of single-note and multi-note tremolos.

Rhythm Slashes
Allows you to input a region that displays rhythm slashes that are automatically 
formatted to be compatible with the prevailing time signature.

Bar Repeats
Allows you to input a region that indicates that the preceding bar is repeated without 
re-notating the bar.

TIP

You can input bar repeat regions with different bar groupings when using the repeats 
popover.

Numbered Bars
Allows you to input a region that displays bar counts without additional notations.

RELATED LINKS
Notations toolbox on page 202
Repeats popover on page 407

Inputting repeat endings with the popover
You can input repeat endings using the repeats popover, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select at least one item in each bar that you want to include in the first ending.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter end or ending into the popover.

4. Press Return  to close the popover.

RESULT
The repeat ending is input, with the first ending segment covering the bars in which you selected 
items, and a second ending segment created automatically in the following bar.

An end repeat barline is created at the end of the first ending if none exists already.

RELATED LINKS
Repeats popover on page 407
Repeat endings on page 1440

Adding additional repeat endings with the popover

You can have more than two possible endings in each repeat ending structure by adding 
additional segments using the repeats popover. You can add repeat ending segments both 
during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the bars that you want to include in the additional ending.

NOTE

Your selection must start from the first bar following the previous repeat ending 
segment.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter add into the popover.

4. Press Return  to close the popover.

5. Optional: Repeat these steps as many times as required for the number of additional 
endings you want.
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RESULT
A new repeat ending segment is added. The existing previous repeat ending segment now ends 
with a closed line, with an end repeat barline created if necessary.

TIP

You can also add additional repeat ending segments by selecting the repeat ending and 
changing the value for No. endings in the Repeat Endings group of the Properties panel.

However, No. endings only adds additional repeat ending segments that contain one bar, and 
does not automatically input or reposition repeat barlines. You must input repeat barlines as 
appropriate manually.

EXAMPLE

Default repeat ending structure with two 
endings

Repeat ending structure with additional third ending

Inputting repeat endings with the panel
You can input repeat endings using the Repeat Structures panel, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select at least one item in each bar that you want to include in the first ending.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Repeat Endings section, click Create Repeat Ending .

RESULT
The repeat ending is input, with the first ending segment covering the bars in which you selected 
items, and a second ending segment created automatically in the following bar.

An end repeat barline is created at the end of the first ending if none exists already.

RELATED LINKS
Repeat Structures panel on page 410
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Adding additional repeat endings with the panel

You can have more than two possible endings in each repeat ending structure by adding 
additional segments using the Repeat Structures panel. You can add repeat ending segments 
both during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the bars that you want to include in the additional ending.

NOTE

Your selection must start from the first bar following the previous repeat ending 
segment.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Repeat Endings section, click Add Section To Repeat Ending .

NOTE

If increasing the number of endings makes the repeat ending collide with any part of 
another repeat ending, the other repeat ending is deleted. However, its repeat barlines are 
not deleted.

4. Optional: Repeat these steps as many times as required for the number of additional 
endings you want.

RESULT
A new repeat ending segment is added. The existing previous repeat ending segment now ends 
with a closed line, with an end repeat barline created if necessary.

TIP

You can also add additional repeat ending segments by selecting the repeat ending and 
changing the value for No. endings in the Repeat Endings group of the Properties panel.

However, No. endings only adds additional repeat ending segments that contain one bar, and 
does not automatically input or reposition repeat barlines. You must input repeat barlines as 
appropriate manually.
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EXAMPLE

Default repeat ending structure with two 
endings

Repeat ending structure with additional third ending

Inputting repeat markers with the popover
You can input repeat markers, including repeat jumps and repeat sections, using the repeats 
popover, both during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select an item at the rhythmic position where you want to input a repeat marker.

For repeat jumps, we recommend that you select the barline with which you want the 
end of the jump instruction to align. For repeat sections, we recommend that you select 
the barline with which you want the start of the section marker to align.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of repeat marker you want into the popover.

For example, enter coda to input a coda section or enter $ to input a segno.

4. Press Return  to close the popover.

RESULT
During note input, repeat markers are input at the caret position. Coda sections are 
automatically formatted so that there is a gap between the coda and the preceding material.

When adding repeat markers to existing music, they are input at the rhythmic position of the 
earliest selected item.

Repeat markers that indicate the end of a section, such as Fine and D.C. al Coda, are right-aligned 
with the selected rhythmic position.

RELATED LINKS
Repeats popover on page 407
Repeat markers on page 1447
Repeats in playback on page 640
Changing the gap before codas on page 1455
Hiding/Showing repeat markers on page 1453
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Inputting repeat markers with the panel
You can input repeat markers using the Repeat Structures panel, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select an item at the rhythmic position where you want to input a repeat marker.

For repeat jumps, we recommend that you select the barline with which you want the 
end of the jump instruction to align. For repeat sections, we recommend that you select 
the barline with which you want the start of the section marker to align.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. Click the repeat marker you want to input in any of the following sections:

● Repeat Jumps

● Repeat Sections

RESULT
During note input, repeat markers are input at the caret position. Coda sections are 
automatically formatted so that there is a gap between the coda and the preceding material.

When adding repeat markers to existing music, they are input at the rhythmic position of the 
earliest selected item.

Repeat markers that indicate the end of a section, such as Fine and D.C. al Coda, are right-aligned 
with the selected rhythmic position.

Inputting tremolos with the popover
You can input both single-note and multi-note tremolos using the repeats popover, both during 
note input and by adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tremolos.
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NOTE

If you want to input multi-note tremolos, you must select at least two notes that are in 
the same voice, have the same duration, and are notated using a single notehead. The 
notes can also be tuplets and cross-staff notes.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of tremolo you want into the popover.

For example, enter:

● // for single-note tremolos with two strokes.

● ///2 for multi-note tremolos with three strokes.

● //rel for two-stroke single-note tremolos with release.

4. Press Return  to close the popover.

RESULT
Single-note tremolos are input on the selected notes with the number of tremolo strokes 
specified. They appear on all notes in tie chains.

Tremolos with release show single-note tremolo strokes on all notes in tie chains apart from the 
last note. Tremolos with attack show single-note tremolo strokes on all notes in tie chains apart 
from the first note.

Multi-note tremolos with the number of tremolo strokes specified are input between selected 
individual notes and the notes immediately after them, or between selected pairs of notes. The 
notated duration of notes in multi-note tremolos is automatically updated. For example, two 
quarter notes joined by a multi-note tremolo both appear as half notes.

When tuplets are selected, multi-note tremolos are input across the selected tuplets, with the 
tremolo strokes positioned in the center of all notes in the tuplet. The tuplet bracket is hidden, 
and a signpost is shown at the start of each tuplet indicating its ratio.

NOTE

The appearance of stems in multi-note half note tremolos depends on your setting on the 
Tremolos page in Engraving Options.

EXAMPLE

Multi-note tremolos with three tremolo strokes 
across tuplets

Tremolo with release added to tie chain
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AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have tremolos in one voice and slurs in 
another voice.

RELATED LINKS
Repeats popover on page 407
Tremolos on page 1659
Tremolos in playback on page 1667
Tremolos in tie chains on page 1661
Deleting tremolos on page 1664
Changing the appearance of multi-note half note tremolos on page 1664
Enabling independent voice playback on page 636
Forcing the duration of notes/rests on page 262
Creating cross-staff beams/tremolos on page 1009
Tuplets on page 1669

Inputting tremolos with the panel
You can input both single-note and multi-note tremolos using the Repeat Structures panel, both 
during note input and by adding them to existing notes.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tremolos.

NOTE

If you want to input multi-note tremolos, you must select at least two notes that are in 
the same voice, have the same duration, and are notated using a single notehead. The 
notes can also be tuplets and cross-staff notes.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Tremolos section, click the tremolo you want to input.

For example, click:

● Two Strokes Single-note Tremolo  for single-note tremolos with two strokes.

● Three Strokes Multi-note Tremolo  for multi-note tremolos with three strokes.

● Tremolo With Release  for three-stroke single-note tremolos with release.
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RESULT
Single-note tremolos are input on the selected notes with the number of tremolo strokes 
specified. They appear on all notes in tie chains.

Tremolos with release show single-note tremolo strokes on all notes in tie chains apart from the 
last note. Tremolos with attack show single-note tremolo strokes on all notes in tie chains apart 
from the first note.

Multi-note tremolos with the number of tremolo strokes specified are input between selected 
individual notes and the notes immediately after them, or between selected pairs of notes. The 
notated duration of notes in multi-note tremolos is automatically updated. For example, two 
quarter notes joined by a multi-note tremolo both appear as half notes.

When tuplets are selected, multi-note tremolos are input across the selected tuplets, with the 
tremolo strokes positioned in the center of all notes in the tuplet. The tuplet bracket is hidden, 
and a signpost is shown at the start of each tuplet indicating its ratio.

NOTE

The appearance of stems in multi-note half note tremolos depends on your setting on the 
Tremolos page in Engraving Options.

EXAMPLE

Multi-note tremolos with three tremolo strokes 
across tuplets

Tremolo with release added to tie chain

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have tremolos in one voice and slurs in 
another voice.

RELATED LINKS
Repeat Structures panel on page 410
Enabling independent voice playback on page 636
Forcing the duration of notes/rests on page 262
Creating cross-staff beams/tremolos on page 1009
Tuplets on page 1669

Inputting slash regions
You can input slash regions using the repeats popover.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On the staff where you want to input a slash region, select items that span the required 
duration.
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2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter slash into the popover.

4. Press Return  to close the popover.

RESULT
During note input, slash regions are input spanning the duration of the selected note or item, 
which is usually the last input note. When adding slash regions to existing music, they span the 
selected duration.

Slash regions are automatically formatted as appropriate for the meter. If you later change the 
time signature, slash regions retain their duration but the appearance of slashes within them 
automatically updates.

TIP

You can also input slash regions by clicking Create Slash Region in the Rhythm Slashes section 
of the Repeat Structures panel, or by choosing Write > Create Slash Region. You can assign a 
key command for this option on the Key Commands page in Preferences.

RELATED LINKS
Repeats popover on page 407
Repeat Structures panel on page 410
Rhythm slashes on page 1473
Slash regions on page 1474
Slash voices on page 1483
Inputting chord symbol regions on page 326
Hiding/Showing chord symbols on page 1040
Lengthening/Shortening items on page 436
Key Commands page in the Preferences dialog on page 63

Inputting bar repeats
You can input bar repeat regions when at least one bar before the region contains notes.

PROCEDURE

1. In Write mode, on the staff where you want to input a bar repeat region, select items that 
span the required duration.

NOTE

You cannot input bar repeat regions in the first bar of a flow.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of bar repeat region you want into the popover.

For example, enter %2,4 to repeat the previous two bars, grouped in four.

4. Press Return  to close the popover.
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RESULT
A region of the selected duration is input, in which the specified type of bar repeat symbol is 
shown in the staff at the intervals specified.

NOTE

● You can also input bar repeat regions during note input; however, this inputs bar repeat 
regions from the bar containing the currently selected note. As bar repeats are mostly 
shown in empty bars, this is likely to produce unintended results.

● You can also input one-bar repeat regions by clicking Create Bar Repeat Region in the Bar 
Repeats section of the Repeat Structures panel, or by choosing Write > Create Bar Repeat 
Region. You can assign a key command for this option on the Key Commands page in 
Preferences.

AFTER COMPLETING THIS TASK
You can change how bar repeats are grouped.

RELATED LINKS
Bar repeats on page 1459
Bar repeat grouping on page 1465
Changing bar repeat grouping on page 1466

Inputting numbered bar regions
You can input numbered bar regions using the repeats popover.

PROCEDURE

1. In Write mode, on the staff where you want to number bars, select items that span the 
required duration.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter numbars into the popover.

4. Press Return  to close the popover.

RESULT
A numbered bar region spanning the selected duration is input.

By default, bar counts are shown on every bar in the region. If the numbered bar region lasts 
four or more bars, Dorico Pro adds the total range in parentheses to the count on the first bar, 
such as showing “1 (-8)” on the first bar in a numbered bar region lasting eight bars.

NOTE

● You can also input numbered bar regions during note input; however, this only inputs a 
numbered bar region in the bar containing the currently selected note.

● You can also input numbered bar regions by clicking Create Numbered Bar Region in 
the Numbered Bars section of the Repeat Structures panel, or by choosing Write > 
Create Numbered Bar Region. You can assign a key command for this option on the Key 
Commands page in Preferences.

Write mode
Notations input 

420
Dorico Pro 4.3.30



● Numbered bar regions are hidden in full score layouts and shown in part layouts by default, 
but you can choose to hide/show numbered bar regions in any layout.

RELATED LINKS
Repeats popover on page 407
Repeat Structures panel on page 410
Numbered bar regions on page 1467
Numbered bar region counts on page 1468
Hiding/Showing numbered bar regions on page 1468
Lengthening/Shortening items on page 436

Inputting cues
You can input cues by using the cues popover.

PREREQUISITE
We recommend that you have opened a full score layout in the music area, so you can access all 
source instruments.

PROCEDURE

1. In Write mode, on the staff where you want to input a cue, select items that span the 
duration in which you want to show a cue.

NOTE

You cannot input multiple cues at the same rhythmic position. If you input a cue at the same 
position as an existing cue, the new cue replaces the existing cue. However, you can input 
cues at different rhythmic positions, then move or lengthen/shorten them so they overlap.

2. Open the cues popover in any of the following ways:

● Press Shift-U .

● In the Notations toolbox, click Popovers , then Cues .

3. Start entering the name of the instrument whose music you want to show in the cue.

The candidate instrument menu appears below the popover and shows possible source 
instruments, including section player divisions and individual grand staff instrument staves, 
extra staves, and ossia staves.

4. Select the instrument/staff whose music you want to show in the cue from the candidate 
instrument menu.

NOTE

● If you do not enter the name of an instrument that exists in your project, no cue is 
created.

● If you enter the full name of an instrument into the popover yourself, you must press 
Return  twice to input a cue using that instrument.

Write mode
Notations input 

421
Dorico Pro 4.3.30



● If multiple instruments of the same type exist in your project, music from the first player 
is input as the cue if you do not specify the number you want. For example, if you have 
Violin I and Violin II in your project and enter violin into the cues popover, music from 
the Violin I staff is shown in the cue.

RESULT
A cue is input on the selected staff, showing the music of the instrument/staff selected in the 
cues popover. Cues from pitched source instruments on unpitched percussion instrument staves 
are input as rhythmic cues.

If you are inputting cues in a full score layout in page view, the cue appears as a signpost by 
default, showing the name of the source instrument. This is because cues are hidden in full 
score layouts and shown in part layouts by default, but you can choose to hide/show cues in any 
layout.

RELATED LINKS
Notations toolbox on page 202
Cues on page 1085
Rhythmic cues on page 1086
Hiding/Showing cues in layouts on page 1089
Overlapping cues on page 1096
Lengthening/Shortening items on page 436
Moving notes/items rhythmically on page 465
Switching between layouts on page 46

Cues popover
The cues popover allows you to input cues that refer to other instruments in the project, using 
the names of instruments as they are set in your project and language.

You can open the cues popover in Write mode in any of the following ways when either an item is 
selected or the caret is active:

● Press Shift-U .

● In the Notations toolbox, click Popovers , then Cues .

● In the Cues panel, click Create Cue.

● Select an existing cue and press Return .

● Choose Write > Create Cue.

When you start entering the name of an instrument that exists in your project into the cues 
popover, a candidate menu appears that shows source instruments that you can select to show 
in the cue, excluding the destination instrument.

The cues popover with an example entry showing the menu of candidate instruments.

Each staff of grand staff and multi-staff instruments is listed separately; for example, Piano (a) 
and Piano (b).
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Each unpitched percussion instrument is listed separately. If you have a drum set in your project, 
each individual instrument in the drum set appears as a candidate for cueing. For example, you 
can show just the kick drum in a cue.

NOTE

● You cannot use entire percussion kits in cues, you must select an individual instrument from 
the kit.

● If you directly input a cue at the same position as an existing cue, the new cue overrides the 
existing cue, which is deleted. However, you can have multiple cues at the same rhythmic 
position if you create them in separate bars and move them or lengthen/shorten them later.

Cues panel
The Cues panel allows you to input cues and find suitable places to input cues. It is located in the 
right zone in Write mode.

● You can hide/show the Cues panel by clicking Panels , then Cues  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Cues panel contains the following sections:

Create Cue
Contains the Create Cue button which you can click to open the cues popover with the 
mouse.

Suggest Cues
Allows you to generate suggested locations for cues based on how long players have 
been resting.

Cue suggestions
Cue suggestions are places in the current flow that Dorico Pro has identified as useful locations 
to input cues, based on a set span of time during which players have not played.

The Suggest Cues section of the Cues panel is divided into the following sections that help you 
find useful places to input cues:

Resting for
Allows you to specify the resting period for players after which you want to input cues.

The resting period is specified in absolute time rather than in bars or beats. This is 
because meters and tempos can change many times throughout a flow, and music 
can be partially or completely meterless, whereas one second always has the same 
duration. Dorico Pro calculates time using metronome marks in the project.

Specifying an absolute time ensures consistency in the approach to finding places 
where cues might be appropriate.

Rehearsal marks
Allows you to consider/ignore rehearsal marks when determining the resting period.

Rehearsal marks often coincide with new sections or other landmarks in the music, 
which can be obvious to players without needing extra cues. By default, rehearsal 
marks are ignored as they do not always act as signposts for the musical structure.
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Cues
Allows you to consider/ignore cues that already exist between notes played by the 
destination player when determining the resting period.

A cue that occurs immediately before an entry in the destination instrument is always 
ignored and is never included as a suggested location, even if you choose to consider 
cues.

However, orientation cues which serve to help the player keep their place during 
extended rests, but do not immediately precede an entry, reset the timer if you choose 
to consider cues.

Update
Allows you to recalculate cue suggestions based on your Resting for duration and 
inclusion choices for rehearsal marks and cues after you have changed values.

The names of the flow and layout that were active when you last updated the list of cue 
suggestions are shown below the Update button. This allows you to see at a glance to 
which flow and layout the suggestions shown in the table apply.

Cue suggestions table
Suggested cues are presented in a table, which contains the following columns:

● Instr.: The destination instrument that has been resting for more than your 
minimum specified duration. Click to show instruments with suggested cues in 
the order in which they appear in the score.

● Bar: The bar containing the first entry of the destination instrument after its rest 
period. Click to show entries in ascending order, earlier bars down to later bars.

● Sec.: The length of time in seconds the destination instrument has been resting 
before the entry shown in the Bar column. Click to show the length of resting 
period in descending order, longest period down to shortest period.

Click rows in the cue suggestions table to navigate directly to that location. By default, 
an area with an equivalent rhythmic duration of 5 to 10 seconds prior to the entry 
in the destination instrument is highlighted. The highlighted area is not a specific 
recommendation for cue length, but it can be a good indication depending on the 
musical context.

If you create a cue at a location suggested in the cue suggestions table, that 
suggestion is automatically removed from the list.

You can click Ignore in the action bar at the bottom of the table to hide suggestions 
where you do not think a cue is appropriate.

NOTE

If you later click Update and regenerate the list, hidden suggestions can reappear.

Highlight suggestions
Highlighted areas before entries in source instruments are shown when Highlight 
suggestions is activated, and are hidden when it is deactivated.

Playing instruments list
Contains the instruments that are playing in the 5 to 10 seconds prior to the entry in 
the destination instrument currently selected in the cue suggestions table, to help you 
determine which instrument to use as the source instrument of cues.

RELATED LINKS
Viewing options for cues on page 1101
Hiding/Showing cue suggestion highlights on page 1102
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Inputting cues using cue suggestions
You can use the Suggest Cues section of the Cues panel in Write mode to find suitable places to 
input cues. You can then input cues using the cues popover.

PROCEDURE

1. In Write mode, open the layout in the music area in which you want to find suitable locations 
for cues.

For example, suitable locations for cues are suggested for all instruments when the full score 
layout is open in the music area, but only suitable locations for individual instruments are 
suggested when a single part layout is open.

2. In the Notations toolbox, click Panels , then Cues  to show the Cues panel.

3. In the Suggest Cues section, specify the resting period after which you want to input cues by 
changing the value for Resting for.

4. Choose one of the following options for Rehearsal marks:

● Consider

● Ignore

5. Choose one of the following options for Cues:

● Consider

● Ignore

6. Click Update.

7. Optional: To check the context of the cue suggestion, click a row in the cue suggestions table 
to navigate directly to that position in the layout.

Cue suggestions are highlighted for the equivalent rhythmic duration of 5-10 seconds. You 
can choose not to see highlighted areas by deactivating Highlight suggestions.

8. On the staff where you want to input a cue, select items that span the duration in which you 
want to show a cue.

9. Open the cues popover in any of the following ways:

● Press Shift-U .

● In the Notations toolbox, click Popovers , then Cues .

10. In the popover, start entering the name of the instrument whose music you want to show in 
the cue.

The candidate instrument menu appears below the popover. You can use the Playing 
instruments list in the Cues panel to help select an appropriate source instrument for your 
cue.

11. Select the instrument whose music you want to show in the cue from the candidate 
instrument menu.

NOTE

● If you do not enter the name of an instrument that exists in your project, no cue is 
created.

● If you enter the full name of an instrument into the popover yourself, you must press 
Return  twice to input a cue using that instrument.

● If multiple instruments of the same type exist in your project, music from the first player 
is input as the cue if you do not specify the number you want. For example, if you have 
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Violin I and Violin II in your project and enter violin into the cues popover, music from 
the Violin I staff is shown in the cue.

RESULT
A cue is input in the selected staff, showing the music of the instrument selected in the cues 
popover.

If you are inputting cues in a full score layout in page view, the cue appears as a signpost by 
default, showing the name of the source instrument. This is because cues are hidden in full 
score layouts and shown in part layouts by default, but you can choose to hide/show cues in any 
layout.

RELATED LINKS
Cues on page 1085
Switching between layouts on page 46
Hiding/Showing cue suggestion highlights on page 1102

Selecting notes/items
In Dorico Pro, there are multiple different ways you can select notes and items in your project, 
from selecting items individually to making large selections covering multiple staves. You can 
also change whether notes play back during note input/selection.

RELATED LINKS
Large selections on page 428
System track on page 430
Filters on page 433
Selection tools on page 43
Playing/Muting notes during note input/selection on page 435
Playing all/individual notes in chords during note input/selection on page 436
Selecting items in the Key Editor on page 781

Selecting/Deselecting notes and items individually
You can select/deselect existing notes and other notation items individually in the music area; 
for example, if you want to add articulations to a selection of notes or delete a short passage of 
music.

TIP

If you want to select a large number of notes/items, we recommend that you use one of the 
larger selection methods.

PROCEDURE

1. Select individual notes/items in the music area in any of the following ways:

● Click a single note/item.

TIP

If the item you want to select is behind another item, Shift - Alt/Opt -click it.

● Ctrl/Cmd -click individual notes/items.
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● Shift -click adjacent notes/items.

● To select all notes in a beam group, click the beam.

● To select all notes in a chord, click the stem.

● To select everything in a bar, click on the staff in that bar, but not on any notes, stems, or 
items.

● Make a marquee selection around multiple notes/items.

● Navigate to other items from an existing selection.

● If nothing is selected in the music area, press any arrow key on your computer keyboard 
to select the first note, rest, or other item on the top staff in the current layout.

2. Deselect all currently selected items in any of the following ways:

● Press Ctrl/Cmd-D .

● Choose Edit > Select None.

● Click outside of the staves within the music area.

RELATED LINKS
Selecting multiple items using marquee selections on page 428
Selecting items in the Key Editor on page 781
Playing/Muting notes during note input/selection on page 435
Navigating to other items in the music area on page 445
Filters on page 433

Selecting more items of the same type
You can incrementally extend your current selection to more items of the same type and notes 
in the same voices, which is particularly helpful if you want to select multiple different items at 
once, such as dynamics and lyrics.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes and items you want to select more of. You can do this in Write mode and 
Engrave mode.

TIP

You can select notes and items on multiple staves and in specific voices; for example, if you 
only want to select notes in up-stem voices on four staves.

2. Press Ctrl/Cmd-Shift-A  to expand your selection.

3. Optional: Continue pressing Ctrl/Cmd-Shift-A  to extend your selection further.

RESULT
More of the same types of items and notes in the same voices as your original selection are 
selected, with the range of selected items expanding each time you press the key command: 
firstly to the boundaries of the bar, secondly to the boundaries of the system, and finally to 
the rest of the flow. If there are no other items available in the bar, Dorico Pro automatically 
advances to the second expansion. In galley view, the second expansion is to the entire flow 
directly as there is only a single system in galley view.
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For items that span multiple bars and systems, they are selected in the earliest bar/system in 
which they exist.

NOTE

Dorico Pro selects the following items differently if you select only a single one of them:

● Lyrics: The selection expands only to other lyrics with the same line number, placement, and 
line type as the originally selected lyric.

● Dynamics: The first expansion is to all other dynamics in the same group and on the same 
staves as the original selection, with further expansions selecting other dynamics in other 
groups.

● Playing techniques: The selection expands only to playing techniques of the same category, 
such as Strings or Choral. Additionally, if you select either an up bow or down bow playing 
technique, the selection expands only to other up bow and down bow playing techniques. It 
does not select any other playing techniques.

Selecting multiple items using marquee selections
You can use a marquee selection to select multiple notes and notations at the same time within a 
specific area in Write, Engrave, and Play modes.

PROCEDURE

1. In the status bar, click Marquee Tool .

2. In the music area, click and drag across the area where you want to select everything.

A gray rectangle indicates which notes and notations will be selected. We recommend that 
you click in one corner of the area you want to select and drag diagonally across to the other 
corner.

RESULT
When you release the mouse, all notes and notations in the area within the gray rectangle are 
selected.

NOTE

Only items completely within the area are selected. However, if any part of a note/tie chain is 
within the area, the whole note/tie chain is selected.

RELATED LINKS
Status bar on page 42
Selection tools on page 43
Selecting items in the Key Editor on page 781
Changing values using the Transform tool on page 818

Large selections
You can make large selections, including selecting the contents of whole staves or the whole 
flow.

Select everything in a specific area
You can use the Marquee Tool  to specify an area in which you want to select 
everything.

Write mode
Selecting notes/items 

428
Dorico Pro 4.3.30



Select everything in the whole flow

● Press Ctrl/Cmd-A .

● Choose Edit > Select All.

Select everything on a single staff

● Select the first note on the staff, hold down Shift , then select the last note on the 
staff.

● Select the first note on the staff and choose Edit > Select To End Of System or 
Edit > Select To End Of Flow.

Select everything on multiple adjacent staves

● Select one whole staff at the top/bottom of the range of staves you want to select 
and press Shift-Up Arrow  or Shift-Down Arrow  until all the staves you want are 
selected.

● Select one whole staff at the top/bottom of the range of staves you want to select 
and Shift -click the staff at the other end of the range of staves you want to select.

Select more of the currently selected types of items
You can use Edit > Select More (key command Ctrl/Cmd-Shift-A ) to expand your 
current selection horizontally and incrementally to other items of the same types and 
in the selected voices and staves in both Write mode and Engrave mode. For items that 
span multiple bars and systems, they are selected in the earliest bar/system in which 
they exist.

1. The first expansion is to the boundaries of the current bar, both to the left and 
right. If there is nothing to select within the bar, such as if you selected a whole 
note in a 4/4 bar, Dorico Pro automatically advances to the second expansion.

2. The second expansion in page view is to the boundaries of the current system, 
both to the left and right. In galley view, the second expansion is to the rest of the 
flow, as there is only a single system in galley view.

3. In page view, the third expansion is to the entire flow.

Select everything in the system within a range of beats/bars
You can use the system track to select a region of beats/bars and then select 
everything on all staves in the system within that region.

TIP

If you want to select only a certain type of item, such as lyrics or dynamics, you can then use the 
corresponding filters.

RELATED LINKS
Filters on page 433
Selecting/Deselecting notes and items individually on page 426
Selecting items in the Key Editor on page 781
Selecting more items of the same type on page 427
Histogram tool on page 813
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System track
The system track is a translucent line above the top of each system in Write mode. It allows you 
to add and delete bars and beats, and to select everything on all staves in the system.

The system track above a staff, showing bars The system track above a staff, showing beat 
units reflecting the current rhythmic grid resolution 
(available when you hold Alt/Opt )

The color of the system track changes depending on how you are interacting with it.

● When you hover the mouse over it, it becomes more opaque.

● When you select a region in the system track, it appears highlighted.

The system track when the mouse pointer hovers 
over it

The system track with a region selected

When you have selected a region in the system track, the following options are available:

1 Set Edit Stop Position

Allows you to set and delete Insert mode stop positions.

2 Delete

Allows you to delete the selected region.

NOTE

When you hover over Delete, the highlight color of the selected region changes.

3 System Track Select

Allows you to select all items, including system objects, on all staves in the system across the 
selected region.

4 Add
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Allows you to add bars or beats of the same duration as the selection in the system track. 
The extra time is inserted immediately after the end of the selection.

NOTE

Selections on the system track are cleared whenever you make any other kind of selection, or 
when you switch layouts. However, selections on the system track are retained when switching 
between page and galley view.

RELATED LINKS
Inputting bars/beats with the system track on page 307
Deleting bars/beats with the system track on page 963
System objects on page 1563
Rhythmic grid on page 214
Insert mode on page 454

Hiding/Showing the system track
The system track is shown by default in new projects, but you can hide/show it in Write mode at 
any time.

PROCEDURE

● Hide/Show the system track in any of the following ways:

● Press Alt/Opt-T .

● Choose View > System Track.

RESULT
The system track is hidden/shown.

TIP

If you do not want the system track to be shown in all future projects by default, deactivate Show 
system track in new projects in the View section of the General page in Preferences.

RELATED LINKS
Preferences dialog on page 61

Selecting bars with the system track
The system track allows you to select all items, including system objects, on all staves in the 
system across the selected bars.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In Write mode, click a bar in the system track.

2. Optional: Select additional bars in any of the following ways:

● Shift -click bars to the right/left along the system track.

● Click and drag to the right/left along the system track.

Write mode
Selecting notes/items 

431
Dorico Pro 4.3.30



3. Click System Track Select  in the system track. It can also appear above the system track if 
your selection is narrow.

System Track Select  appears filled in when you hover your mouse pointer over it.

RESULT
Everything on all staves in the selected bars is selected and highlighted, including system objects, 
notations, and signposts.

NOTE

If you then delete your selection, any signposts included are also deleted. This can affect the 
page layout; for example, by removing ossia staves whose signposts were included in the 
selection.

Selecting beats with the system track
The system track allows you to select all items, including system objects, on all staves in the 
system across the selected beats.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In Write mode, press and hold Alt/Opt .

Grid lines that match the current rhythmic grid resolution appear in the system track.

2. Without releasing Alt/Opt , click and drag to the right/left along the system track.

NOTE

You cannot Shift -click when selecting beats.

3. Click System Track Select  in the system track. It can also appear above the system track if 
your selection is narrow.

System Track Select  appears filled in when you hover your mouse pointer over it.

RESULT
Everything on all staves in the selected beats is selected and highlighted, including system 
objects, notations, and signposts.

NOTE

If you then delete your selection, any signposts included are also deleted. This can affect the 
page layout; for example, by removing ossia staves whose signposts were included in the 
selection.

RELATED LINKS
Deleting the contents of bars on page 964
Deleting bars/beats with the system track on page 963
System objects on page 1563
Rhythmic grid on page 214
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Filters
Filters in Dorico Pro allow you to select only a specific type of item from a larger selection. Dorico 
Pro includes a filter for every notation item.

● You can find the available filters by choosing Edit > Filter > [Item] > [Item type]. You can 
also choose filters from the context menu.

All significant notation items have their own filter; for example, arpeggio signs, chord symbols, 
key signatures, and playing techniques. You can also filter for note spacing changes.

The following items have multiple filters because they have multiple types:

Notes
Allows you to filter notes, grace notes, and chords. You can also filter notes according 
to their accidental, pitch, and position in chords.

Voices
Allows you to filter voices according to their stem direction. You can also filter slash 
voices.

Dynamics
Allows you to filter all dynamics, or just gradual or immediate dynamics.

Tempos
Allows you to filter all tempo marks, or just absolute, relative, or gradual tempo 
changes.

Lyrics
Allows you to filter all lyrics, or just lyrics with a specific line number, type, or staff-
relative placement.

NOTE

There is no filter for barlines. You also cannot filter notations that are considered part of the 
notes to which they apply, including fingerings, beams, articulations, and tremolos.

RELATED LINKS
Filters for lyrics on page 1227
Selecting more items of the same type on page 427
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Filter Notes by Pitch dialog
The Filter Notes by Pitch dialog allows you to specify notes that you want to filter from a larger 
selection by their pitch. You can specify pitches in only a single octave or in all octaves.

The Filter Notes by Pitch dialog comprises the following:

Written/Sounding pitches to filter
Allows you to choose whether to filter the notes according to their Written pitch or 
their Sounding pitch.

Pitch filters list
Contains the different pitch filters that will be applied to the selection.

Remove Selected
Deletes only the selected pitch filters.

Clear
Deletes all pitch filters in the list.

Note name menu
Allows you to select the note name you want to filter, such as E or G.

Accidental menu
Allows you to select an accidental to specify the pitch, such as E♭ or G♯.

in octave
Allows you to choose the octaves in which you want to filter the pitch.

● When in octave is activated, the filter applies only to a single octave. You can use 
the value field to specify the octave.

● When in octave is deactivated, the filter applies to all octaves.

Add
Adds the currently set parameters as a filter.

RELATED LINKS
Large selections on page 428
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Changing filters to select/deselect
You can change whether the available filter options select or deselect the specified items. By 
default, filters select items, meaning that the resulting selection only includes the item being 
filtered.

When filters are set to deselect, the resulting selection includes everything except the item being 
filtered.

PROCEDURE

● Change the filter behavior in one of the following ways:

● To change filters to select, choose Edit > Filter > Select Only.

● To change filters to deselect, choose Edit > Filter > Deselect Only.

TIP

You can also choose these options from the context menu.

Playing/Muting notes during note input/selection
You can change your default setting for whether notes are played back as you input them or not. 
By default, notes are played back with the prevailing dynamic but you can set a fixed volume 
instead.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Play notes during note input and selection 
in the Auditioning subsection.

4. Optional: If you want notes to play back with a fixed volume instead of the prevailing 
dynamic, activate Use fixed volume to play selected notes and change the value in the 
value field.

5. Click Apply, then Close.

RESULT
When the option is activated, notes play back as you input them during note input and when you 
select them. When it is deactivated, notes do not play back.

When Use fixed volume to play selected notes is activated, notes play back with the set 
volume. When it is deactivated, notes play back with the prevailing dynamic.

RELATED LINKS
Inputting notes on page 221
Selecting/Deselecting notes and items individually on page 426
Playing back music on page 632
Changing the click settings on page 267
Mixer panel on page 821
Input methods for dynamics on page 310
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Playing all/individual notes in chords during note input/selection
You can change your default setting for whether all notes in chords are played when you select 
any note in the chord or whether only the selected notes are played.

PREREQUISITE
Notes are played during note input/selection.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Play all notes in chord when any is selected 
in the Auditioning subsection.

4. Click Apply, then Close.

RESULT
When the option is activated, all notes in chords are played when any note in the chord is 
selected. When it is deactivated, only the selected notes are played.

Editing items
In Dorico Pro, there are editing methods that are common to most notations, including 
lengthening/shortening items and changing their staff-relative placement.

RELATED LINKS
Selecting notes/items on page 426
Arranging tools on page 459
Moving notes/items rhythmically on page 465

Lengthening/Shortening items
You can lengthen/shorten items with duration rhythmically after they have been input; for 
example, if you want an octave line to cover more/fewer notes.

Lengthening figured bass or playing techniques, including string indicators outside the staff and 
vibrato bar indications, that were input without a specified duration gives them duration and 
shows duration or hold lines if required.

Lengthening/Shortening cues changes the material shown in cues to reflect the material at the 
corresponding rhythmic positions in the source instrument.

PREREQUISITE
You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In Write mode, select the items you want to lengthen/shorten.

NOTE

● When multiple items are selected, you can only lengthen/shorten them by the current 
rhythmic grid resolution.
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● You can only lengthen/shorten one of the following items at a time: slurs, gradual 
dynamics, groups of gradual dynamics, and bar repeat regions.

● When using the mouse, you can only lengthen/shorten a single item at a time. Figured 
bass and playing techniques, including string indicators and vibrato bar lines, must have 
duration already.

● When lengthening/shortening multiple figured bass or playing techniques using the 
keyboard, they must all have duration already.

● You can only lengthen/shorten non-grouped playing techniques or the last playing 
technique in a group.

● You can only lengthen/shorten cross-staff slurs to notes on the same staff as the 
corresponding endpoint, and you can only lengthen/shorten cross-voice slurs to notes in 
the same voice as the corresponding endpoint.

2. Lengthen/Shorten the selected items in any of the following ways:

● To lengthen them by the current rhythmic grid resolution or to the next notehead, 
whichever is closer, press Shift-Alt/Opt-Right Arrow .

● To shorten them by the current rhythmic grid resolution or to the previous notehead, 
whichever is closer, press Shift-Alt/Opt-Left Arrow .

NOTE

Bar repeat regions are lengthened/shortened by the duration of their grouping.

● To lengthen a single item to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Right Arrow .

● To shorten a single item to the previous notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Left Arrow .

● Click and drag the circular handle at the start/end to the right/left.

NOTE

Playing technique groups only have a single handle at their start and end, not individual 
handles for each playing technique within the group.

RESULT
The selected items are lengthened/shortened by moving their end rhythmically to the right/left. 
Most items are lengthened/shortened either by the current rhythmic grid resolution or to the 
next/previous notehead, whichever is closer, or directly to the next/previous notehead.

Bar repeat regions are lengthened/shortened by the duration of their grouping. Numbered bar 
regions are lengthened/shortened by bars. Slurs are lengthened/shortened to notes.

If figured bass or playing techniques previously had no duration, they now have duration and 
show duration or hold lines if required.

If any part of slash regions now overlap rhythmic positions with other slash regions, the staff 
positions of slashes are automatically adjusted to accommodate multiple slash regions at the 
same positions.

Dynamic groups are lengthened/shortened proportionally by lengthening/shortening the 
gradual dynamics and moving any other type of dynamic in the group. This retains the relative 
durations of the gradual dynamics in the group.
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NOTE

● The minimum length of a bar repeat region is one bar. If you shorten regions with longer 
groupings, such as every four bars, the length of the region is halved until a one-bar repeat 
region remains.

● The stem directions of overlapping cues are not automatically adjusted. You might have to 
change them manually.

● Only a single bar repeat region or chord symbol region can exist at each rhythmic position 
on each staff. If a bar repeat region or chord symbol region collides with another item of 
the same type when it is lengthened/shortened, the existing item is deleted or shortened 
accordingly. For bar repeat regions, this can mean the grouping of other bar repeat regions 
is changed.

You can undo this action and restore the previous lengths of the other regions. However, if 
you lengthened/shortened a bar repeat region or chord symbol region using the mouse and 
it overwrote another region of the same type completely, the other region is permanently 
deleted.

● You can move items graphically in Engrave mode, including changing their graphical length.

EXAMPLE
In the example, lengthening the phrase moves the  at the end two quarter notes to the right, 
but moves the  in the middle only one quarter note to the right. This keeps the lengths of the 
gradual dynamics equal.

Original dynamic phrase Lengthened dynamic phrase

RELATED LINKS
Rhythmic grid on page 214
Changing the duration of notes on page 259
Lengthening/Shortening segments in repeat endings on page 1442
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Hiding/Showing playing technique duration lines on page 1396
Notations input on page 271
Bar repeat grouping on page 1465
Playing technique continuation lines on page 1393
Playing technique duration on page 1394
Pedal line start signs, hooks, and continuation lines on page 1377
Sustain pedal retakes and pedal level changes on page 1368
Overlapping cues on page 1096
Slashes in multiple-voice contexts on page 1475
Octave lines in Engrave mode on page 1083
Slurs in Engrave mode on page 1522
Cross-staff and cross-voice slurs on page 1516
Groups of dynamics on page 1132
Showing consecutive hairpins as continuous on page 1123
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Hiding/Showing figured bass hold/suspension lines on page 1144

Changing existing items
You can change all items that have an associated popover, rather than deleting them and 
inputting new ones. For example, if you want to change an 8va octave line into a 15va octave line 
or change a short fermata into a long fermata.

PROCEDURE

1. Select the item or the signpost of the item you want to change.

2. Open the popover for that item in any of the following ways:

● Press Return .

● Double-click the item.

3. Change the existing entry in the popover.

For chord symbols, you can also play the new chord on your MIDI keyboard.

4. Press Return  to close the popover.

RESULT
The selected item is changed according to the new entry in the popover. This changes different 
parameters for different items, such as the duration of a hold or pause or the volume of a 
dynamic.

NOTE

● Any properties previously set on the item are reset.

● If you change a fermata to a breath mark, only the fermata on the top staff is changed to 
a breath mark. If you change a caesura to a breath mark, a breath mark is input on the top 
staff at the end of the bar to which the caesura is attached. However, the existing caesura 
also remains on all staves.

● If you open the playing techniques popover in this way, Dorico Pro inputs your new entry as 
a separate playing technique and does not delete the previous one.

● If you change an immediate dynamic to a combined dynamic, such as  to , or vice versa, 
Dorico Pro inputs your new entry as a separate dynamic and does not delete the previous 
one.

RELATED LINKS
Popovers on page 25
Properties panel on page 769
Changing the text of existing lyrics on page 1237
Assigning key commands on page 66
Changing dynamic levels on page 1112
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Changing the size of notes/items
You can change the size of individual notes and items using the default scale sizes for cues, grace 
notes, a custom scale size, or a custom scale size in addition to a default scale size. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

TIP

● If you want to change the size of notes because you want them to be grace notes or cues, 
you can input them as either grace notes or cues instead.

● You can change the size of all notes project-wide by changing the notehead design on 
the Notes page in Engraving Options. However, these options offer less flexibility than 
changing the size of notes individually.

● You can change the default size of many text-based notations, such as rehearsal marks and 
chord symbols, project-wide by editing the corresponding font style or paragraph style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/items whose size you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate any of the following properties in the Common group:

● If you want to use a default scale size, activate Scale.

● If you want to use a custom scale size, activate Custom scale.

● If you want to use a custom scale size based on a default scale size, activate both Scale 
and Custom scale.

3. Optional: If you activated Scale, select one of the following options from the menu:

● Normal

● Grace

● Cue

● Cue grace

4. Optional: If you activated Custom scale, change the value in the value field.

RESULT
The size of the selected notes/items is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

● If you activated Scale, the selected notes/items are changed to the selected default scale 
size.

● If you activated Custom Scale, the selected notes/items are changed to the custom 
percentage scale size you set.

● If you activated both Scale and Custom Scale, the selected notes/items are changed to the 
custom percentage scale size of the selected default scale size. For example, if you selected 
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Grace for Scale then set Custom Scale to 50, the size of the selected notes/items is half the 
size of grace notes.

RELATED LINKS
Grace notes on page 1193
Inputting grace notes on page 250
Cues on page 1085
Inputting cues on page 421
Notehead set designs on page 1247
Text formatting on page 845
Engraving Options dialog on page 840
Changing the size of chord diagrams on page 1069
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Changing the size of accidentals on page 945
Changing the size of fingerings on page 1163
Changing the size of string indicators on page 1185
Changing the size of coda/segno symbols on page 1449
Changing the size of dashes/dots in slurs on page 1512
Changing the size of dashes/dots in ties on page 1624
Changing the size of ossia staves on page 1557

Changing the staff-relative placement of items
You can flip any item that can be placed both above/below the staff to change their staff-relative 
placement; for example, if you want to change the stem direction of notes quickly. For many 
items, you can do this for the current layout and frame chain only or for all layouts and frame 
chains.

NOTE

These steps do not apply to text in text frames or pedal lines.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items you want to flip. You can do this in Write mode and Engrave mode.

NOTE

● You cannot flip items during note input. You cannot flip text items when the text editor is 
open.

● If you want to select parts of items, such as articulations, a single notehead within a tie 
chain, or a single fermata, you must be in Engrave mode.

● To select multiple items of the same type, you can use large selections and/or filters.

2. Press F .
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RESULT
The staff-relative placement of the selected items is changed by setting Placement, Position, or 
Direction properties appropriately in the corresponding groups of the Properties panel. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain for items whose staff-relative placement properties are local.

Deactivating these properties resets items to their default placement.

NOTE

● If you flipped multiple multi-segment slurs or tuplet brackets with different hook directions 
at the same time, all selected items are set to either above or below the staff, unless they all 
originally had compatible directions set.

● You can change the default staff-relative placement of many items on the corresponding 
pages in Engraving Options.

AFTER COMPLETING THIS TASK
If you need to move items to different graphical positions, you can move them graphically in 
Engrave mode.

RELATED LINKS
Filters on page 433
Large selections on page 428
Local vs. global properties on page 770
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Tucking index properties on page 1083
Changing the stem direction of notes on page 1277
Changing the staff-relative placement of beams on page 1004
Changing the staff-relative placement of fingerings on page 1161
Changing the staff-relative placement of tuplet brackets on page 1675
Changing the vertical alignment of text in text frames on page 587
Moving items graphically on page 609
Positions of lyrics on page 1229
Engraving Options dialog on page 840

Resetting the appearance of items
You can reset all changes you have made to the appearance of individual items, which returns 
them to the default settings. For some items, you can do this for the current layout and frame 
chain only or for all layouts and frame chains.

Properties relating to the appearance of items include those that change their style, type, and 
some additions, such as poco a poco text for dynamics.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items whose appearance you want to reset. You can do this in Write mode and 
Engrave mode.
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TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Choose Edit > Reset Appearance.

RESULT
All properties that affect the appearance of the selected items are reset to their default settings. 
If the property scope was set to Locally, any properties that are layout-specific and frame 
chain-specific are only reset in the current layout and frame chain.

RELATED LINKS
Engraving Options dialog on page 840
Notation Options dialog on page 837
Engrave toolbox on page 514
Local vs. global properties on page 770
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Filters on page 433
Large selections on page 428

Resetting the position of items
You can reset the position of individual items you have moved graphically, which returns them 
to their default position. For some items, you can do this for the current layout and frame chain 
only or for all layouts and frame chains.

Properties relating to the position of items include horizontal and vertical offsets, beat-relative 
position, and staff-relative placement.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items whose position you want to reset. You can do this in Write mode and 
Engrave mode.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Choose Edit > Reset Position.

RESULT
All properties that affect the position of the selected items are reset to their default settings. 
If the property scope was set to Locally, any properties that are layout-specific and frame 
chain-specific are only reset in the current layout and frame chain.
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Hiding non-printing elements
You can temporarily hide all visible elements that do not print, such as signposts, selection 
highlights, and frames. This allows you to view the current layout as it will appear when printed/
exported without switching to Print mode.

PROCEDURE

● Press and hold \ (Windows) or ` (macOS) .

RESULT
All non-printing elements in the current layout are hidden until you release the key command. 
Printing elements appear as they will when printed/exported.

TIP

You can also hide/show individual non-printing elements permanently.

RELATED LINKS
Annotations on page 687
Printing layouts on page 671
Exporting layouts as graphics files on page 675
Signposts on page 453
Hiding/Showing signposts on page 454
Hiding/Showing the system track on page 431
Viewing options for cues on page 1101
Hiding/Showing guide bar numbers on page 984
Hiding/Showing colors for notes out of range on page 1261
Hiding/Showing voice colors on page 1705
Hiding/Showing region highlights on page 1461
Hiding/Showing slash region highlights on page 1475
Hiding/Showing unison range colors on page 1573

Navigation
There are different ways you can navigate around the layout currently open in the music area, 
such as moving the selection to different items or bringing specific bar numbers or pages into 
view. Many navigation methods function in multiple modes.

If you have an item selected, you can navigate to other notes/items, which moves the selection to 
those notes/items.

RELATED LINKS
Workspace setup on page 45
Going to locations with the jump bar on page 70
Jump bar on page 68
Moving the caret manually on page 220
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Navigating to other items in the music area
You can navigate to other notes and items in the music area after you have selected a note/item; 
for example, if you want to move the selection to other notes along the staff without using the 
mouse.

NOTE

In Engrave mode, navigating to other items always moves the selection to the closest item 
graphically, rather than the next/previous item of the same type.

PROCEDURE

1. Select an item in the music area.

● If you want to navigate through notes, select a note.

● If you want to navigate through a particular type of item, such as rehearsal marks, select 
an item of that type.

NOTE

You can only navigate forwards/backwards through items on the same staff. You cannot 
navigate to other items of the same type on other staves.

2. Navigate to other notes or items in any of the following ways:

● To navigate to the next item or note in the same voice, press Right Arrow .

● To navigate to the previous item or note in the same voice, press Left Arrow .

● To navigate to the closest note above the current selection, press Up Arrow .

This navigates to any existing notes on the same staff first, then to the lowest note/rest 
on the staff above. If a whole chord was selected, this leaves the bottom note in the 
chord selected.

● To navigate to the closest note below the current selection, press Down Arrow .

This navigates to any existing notes on the same staff first, then to the highest note/rest 
on the staff below. If a whole chord was selected, this leaves the top note in the chord 
selected.

● To navigate forwards to the note/rest at the start of the next bar, press Ctrl/Cmd-
Right Arrow .

● To navigate backwards to the note/rest at the start of the previous bar, press Ctrl/Cmd-
Left Arrow .

● To navigate to the top staff in the system, press Ctrl/Cmd-Up Arrow .

● To navigate to the bottom staff in the system, press Ctrl/Cmd-Down Arrow .

3. Optional: Switch the selection to another type of item at the same rhythmic position in one 
of the following ways:

● To cycle forwards through items, press Tab .

● To cycle backwards through items, press Shift-Tab .

NOTE

You cannot switch the selection to system objects, such as system-attached text or rehearsal 
marks. However, you can select system objects directly and navigate through them.
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4. Optional: After switching the selection to another type of item, navigate to other items of 
that type.

RELATED LINKS
System objects on page 1563

Going to flows
You can go to the next/previous flow in the current layout, which automatically brings the start of 
that flow into view in the music area. This is particularly useful when navigating around layouts 
that contain many flows.

These steps function in Setup, Write, and Engrave modes.

PROCEDURE

● Go to a different flow in one of the following ways:

● To go to the previous flow in the layout, choose Edit > Go To > Go To Previous Flow.

● To go to the next flow in the layout, choose Edit > Go To > Go To Next Flow.

RESULT
The music area updates to show the start of the corresponding flow. Dorico Pro automatically 
positions the top staff towards the top left of the music area.

TIP

You can assign key commands to both Go To Previous Flow and Go To Next Flow on the Key 
Commands page in Preferences.

Going to pages
You can go to any specified page in the current layout using its page number; for example, to 
jump quickly to the exact page that requires changes when editing music.

These steps function in Setup, Write, and Engrave modes.

PROCEDURE

1. Choose Edit > Go To > Go To Page to open the Go To Page dialog.

2. Enter the page number to which you want to go into the Page field.

3. Click OK.

RESULT
The music area updates to show the start of the corresponding page. Dorico Pro automatically 
centers the top of the page in the music area.

TIP

● You can assign a key command for Go To Page on the Key Commands page in Preferences.

● You can also move the view and navigate to other pages in the layout in other ways.
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RELATED LINKS
Key Commands page in the Preferences dialog on page 63
Page arrangements for page view on page 44
Moving the view in the music area on page 447
Zooming in/out of the music area on page 448

Going to bars
You can go to any specific bar in any flow in the current layout; for example, to jump quickly to 
the exact bar that requires changes when editing music.

These steps function in Setup, Write, Engrave, and Play modes.

PROCEDURE

1. Press Ctrl/Cmd-G  to open the Go To Bar dialog.

2. Select the flow containing the bar to which you want to go from the Flow menu.

3. Enter the bar number to which you want to go into the Bar field.

4. Click OK.

RESULT
The music area updates to show the corresponding bar. Dorico Pro automatically positions the 
top staff towards the top left of the music area.

In Play mode, the playhead moves to the start of the corresponding bar. Dorico Pro automatically 
positions the playhead at the start of the ruler.

Going to rehearsal marks
You can go to any specific rehearsal mark in any flow in the current layout; for example, to jump 
quickly to passages that require changes when editing music.

These steps function in Setup, Write, and Engrave modes.

PROCEDURE

1. Choose Edit > Go To > Go To Rehearsal Mark to open the Go To Rehearsal Mark dialog.

2. Select the flow containing the rehearsal mark to which you want to go from the Flow menu.

3. Enter the rehearsal mark to which you want to go into the Rehearsal mark field.

4. Click OK.

RESULT
The music area updates to show the corresponding rehearsal mark.

TIP

You can assign a key command for Go To Rehearsal Mark on the Key Commands page in 
Preferences.

Moving the view in the music area
You can move the view in the music area to show different parts of layouts. For example, you can 
scroll through a layout to view each page in sequence.
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PROCEDURE

● Move the view in any of the following ways:

● To move the view upwards/downwards, scroll upwards/downwards on a mouse wheel or 
swipe upwards/downwards on a touchpad.

● To move the view to the right/left, Shift -scroll upwards/downwards on a mouse wheel 
or swipe to the right/left on a touchpad.

● To navigate to the next page, press End (horizontal page arrangements) or Page 
Down (vertical page arrangements) .

● To navigate to the previous page, press Home (horizontal page arrangements) or 
Page Up (vertical page arrangements) .

● To navigate to the first page, press Ctrl/Cmd-Home .

● To navigate to the last page, press Ctrl/Cmd-End .

● In the status bar, click Hand Tool , then click and drag in any empty space within the 
page boundaries in the music area.

The mouse pointer changes into a hand symbol during the move.

RESULT
The view in the music area is moved.

TIP

● You change the maximum overscroll amount, that is, how far beyond the edges of pages you 
can move the view, on the General page in Preferences.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Status bar on page 42
Selection tools on page 43

Zooming in/out of the music area
You can change the zoom level in the music area; for example, if you want a larger overview 
when inputting notes, but want to see notes and notations more closely when making detailed 
graphical amendments.

PREREQUISITE
If you want to keep a specific item in the center of the music area when you zoom in/out, you 
have selected that item.

PROCEDURE

1. Zoom in in any of the following ways:

● Press Ctrl/Cmd-= or Z .

● Spread two fingers outwards on a touchpad.

● Ctrl/Cmd -scroll upwards on a mouse wheel.

● Use the zoom options  in the status bar.

2. Zoom out in any of the following ways:
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● Press Ctrl/Cmd-- or X .

● Pinch two fingers together on a touchpad.

● Ctrl/Cmd -scroll downwards on a mouse wheel.

● Use the zoom options  in the status bar.

RESULT
The zoom level in the music area is changed. If you had anything selected, Dorico Pro uses your 
selection as the focal point of the zoom. If you had nothing selected, Dorico Pro focuses on the 
area previously in the center of the view.

RELATED LINKS
Zoom options on page 45
Zooming in/out of tracks on page 630
Workspace setup on page 45

Instrument filters
Instrument filters allow you to show only the staves of selected instruments in galley view in 
Write mode. This can be useful in large projects when you want to focus on a specific set of 
instruments, such as only the woodwinds or strings.

When instrument filters are active, dashed lines are shown at the vertical positions of hidden 
staves, and you can only select and edit music on visible staves.

Instrument filters are layout-specific.

Instrument filter containing flute and violin instruments active in galley view

TIP

You can assign key commands for up to ten instrument filter presets on the Key Commands 
page in Preferences. The instruments filtered by these commands vary in each layout and 
project.
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RELATED LINKS
Switching to galley/page view on page 53
Selecting notes/items on page 426
Editing items on page 436
Arranging tools on page 459
Hiding/Showing empty staves on page 696

Instrument filter overlay
The instrument filter overlay allows you to apply instrument filters to layouts and add new 
instrument filters. It only appears in galley view in Write mode.

● You can hide/show the instrument filter overlay in Write mode by choosing View > 
Instrument Filter Overlay.

The instrument filter overlay contains the following options:

Filter
Activates/Deactivates the selected instrument filter. Only available when the layout 
contains at least one instrument filter.

Filter when deactivated Filter when activated

Instrument filter menu

Allows you to select the instrument filter you want to apply to the current layout. Only 
available when Filter is activated.

Add Instrument Filter

Adds an instrument filter containing the instruments on which you have selected 
items. Only available when at least one item is selected in the music area.

Manage Instrument Filters

Opens the Manage Instrument Filters dialog, which allows you to add, edit, and 
delete instrument filters for the current layout.

Manage Instrument Filters dialog
The Manage Instrument Filters dialog allows you to add, edit, and delete instrument filters for 
the current layout.

You can open the Manage Instrument Filters dialog in Write mode in any of the following ways:

● In the instrument filter overlay, click Manage Instrument Filters .

● Choose Write > Instrument Visibility > Edit Instrument Filter Presets.
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The Manage Instrument Filters dialog comprises the following:

1 Managing instrument presets for

Displays the name of the layout whose instrument filters are listed in the dialog.

2 Instrument filters list

Contains the instrument filters set for the layout. Each instrument filter displays its name 
and the instruments it contains. If multiple instrument filters contain the same instruments, 
Dorico Pro displays a warning.

The first ten instrument filters show a number corresponding to their order in the list. 
This denotes the instrument filters for which you can assign key commands on the Key 
Commands page in Preferences.

Rename Instrument Filter  allows you to rename each instrument filter.

The action bar at the bottom of the list contains the following options:

● Add Filter Preset : Adds a new empty instrument filter.

● Duplicate Filter Preset : Creates a copy of an existing instrument filter that you can 
edit separately from the original.

● Add Presets From Instrument Families : Generates an instrument filter for each 
instrument family in the layout automatically, such as woodwind and brass.

● Move Up : Moves the selected instrument filter up the list, which can change its key 
command.

● Move Down : Moves the selected instrument filter down the list, which can change its 
key command.

3 Instruments in filter list

Contains the instruments in the layout. Allows you to change the instruments included in the 
selected instrument filter by activating/deactivating instrument checkboxes.
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Activating/Deactivating instrument filters
You can activate/deactivate instrument filters at any time in each layout independently. For 
example, if you want to show only woodwind staves whilst working on the woodwind section.

PREREQUISITE

● You are in galley view.

● The instrument filter overlay is shown.

● You have added the instrument filters you want to use.

PROCEDURE

1. In Write mode, open the layout in which you want to activate/deactivate instrument filters.

2. In the instrument filter overlay, click Filter .

Filter when activated Filter when deactivated

3. Optional: If you activated instrument filters, select the instrument filter you want to use from 
the menu.

RESULT
Instrument filters are activated/deactivated. When instrument filters are active, dashed lines are 
shown at the vertical positions of hidden staves and you can only select and edit music on visible 
staves.

TIP

● You can also activate/deactivate and select instrument filters from the Write > Instrument 
Visibility menu.

● You can assign a key command for Use Instrument Filter on the Key Commands page in 
Preferences.

● You can assign key commands for up to ten instrument filter presets on the Key Commands 
page in Preferences. The instruments filtered by these commands vary in each layout and 
project.

RELATED LINKS
Switching to galley/page view on page 53
Switching between layouts on page 46
Selecting notes/items on page 426
Editing items on page 436
Arranging tools on page 459
Hiding/Showing empty staves on page 696
Key Commands page in the Preferences dialog on page 63

Write mode
Instrument filters 

452
Dorico Pro 4.3.30



Adding instrument filters
You can add any number of instrument filters to each layout independently.

PREREQUISITE

● You are in galley view.

● The instrument filter overlay is shown.

PROCEDURE

1. In Write mode, open the layout to which you want to add instrument filters.

2. Select at least one item belonging to each instrument you want to include in the instrument 
filter.

3. In the instrument filter overlay, click Add Instrument Filter .

RESULT
A new instrument filter containing the selected instruments is added to the layout open in the 
music area. Dorico Pro automatically activates instrument filters in the layout and selects the new 
instrument filter.

TIP

● You can also add, edit, and delete instrument filters in the Manage Instrument Filters 
dialog.

● You can assign key commands for up to ten instrument filter presets on the Key Commands 
page in Preferences. The instruments filtered by these commands vary in each layout and 
project.

Deleting instrument filters
You can delete instrument filters you no longer need from each layout independently.

PROCEDURE

1. In Write mode, open the layout from which you want to delete instrument filters.

2. Choose Write > Instrument Visibility > Edit Instrument Filter Presets to open the 
Manage Instrument Filters dialog.

3. Select the instrument filter you want to delete.

4. In the action bar, click Delete Filter Preset .

RESULT
The selected instrument filter is deleted from the layout open in the music area.

Signposts
In Dorico Pro, signposts indicate the positions of important items or changes that cannot be 
seen in the score, such as key signatures with no accidentals, hidden items, and rhythmic feel 
changes.

Signposts have different colors depending on the item they mark because many items can 
show signposts, such as hidden bar numbers and time signatures. They are selectable, meaning 
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you can use signposts to change properties of hidden/invisible items; for example, by selecting 
system break signposts in order to change the staff size from that position. Selected signposts 
appear solid, while unselected signposts appear translucent.

Signposts include a text summary of the hidden/invisible item to help you identify it. For 
example, time signature signposts include the time signature, expressed as a fraction, and its 
beat subdivision.

When multiple signposts exist at the same rhythmic position or in close proximity to each other, 
they stack vertically so that they do not overlap and remain legible.

Multiple signposts for different items above the staff, with time signature signposts selected

NOTE

By default, signposts are not printed or included when you export graphics files.

RELATED LINKS
Annotations on page 687

Hiding/Showing signposts
You can hide/show all signposts or only hide/show signposts for specific items at any time in 
Setup, Write, and Engrave modes.

PROCEDURE

● Hide/Show signposts in any of the following ways:

● To hide/show all signposts, choose View > Signposts > Hide Signposts.

● To hide/show signposts for specific items, choose View > Signposts > [Type of item].

Insert mode
Insert mode changes how notes are input and how edits you make outside of note input affect 
the music. When Insert mode is activated, notes are pushed to subsequent rhythmic positions 
instead of being overwritten if you input new notes or lengthen existing notes. Similarly, deleting 
notes or reducing their duration with Insert mode activated pulls surrounding notes closer 
together without leaving rests between them.

For example, if you input four quarter notes with Insert mode activated, all subsequent notes are 
pushed four quarter note beats back to accommodate the new notes.
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Edits outside of note input that are affected by Insert mode include copying/pasting notes, 
deleting notes, changing the duration of notes including by adding/removing rhythm dots, or 
inputting time signatures.

The voices and staves affected by Insert mode depend on the Insert mode scope. The current 
Insert mode scope is indicated in the Notes toolbox and by the caret during note input.

You can set a single rhythmic position in each flow as an Insert mode stop position, which 
prevents any material beyond the stop point being affected by inserted notes. For example, if 
you want to insert notes at the start of a flow but want to preserve material from a specific 
position later in the flow. Stop positions appear as a vertical translucent line that spans all staves.

● You can activate/deactivate Insert mode in Write mode by pressing I  or clicking Insert  in 
the Notes toolbox.

NOTE

You cannot have both Insert mode and Chord mode activated simultaneously.

When Insert mode is not activated, Dorico Pro does not add extra beats before an existing time 
signature if you change a previous time signature. When Insert mode is activated, Dorico Pro 
inserts beats before existing time signatures to fill the final bar.

3/4 time signature input without Insert mode 
activated

3/4 time signature input with Insert mode activated

RELATED LINKS
Inputting notes in Insert mode on page 237
Rhythmic position on page 27
Chord mode on page 254
Caret on page 215
System track on page 430
Inputting notes on page 221
Copying and pasting notes/items on page 461
Exploding music onto multiple staves on page 470
Changing the duration of notes on page 259
Inputting notes with rhythm dots on page 229
Deleting notes/items on page 459

Insert mode scopes
Insert mode has different scopes, from affecting only selected voices to affecting all players and 
changing the duration of the current bar. All scopes apply until the Insert mode stop position or 
the end of the flow, whichever comes first.

You can change the Insert mode scope in Write mode in any of the following ways:

● Press Alt/Opt-I  to cycle through the different Insert mode scopes.

● In the Notes toolbox, click and hold Insert , then click the scope you want.

● Choose Write > Insert Scope > [Scope].

In Dorico Pro, there are the following Insert mode scopes:
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Voice

Insert mode only affects the selected voices. During note input, this is the voice 
indicated by the caret indicator. Outside of note input, this includes all selected voices, 
such as when you copy and paste material across multiple staves.

Player

Insert mode affects all voices and instruments belonging to the selected players. 
During note input, dotted lines are shown on staves affected by the Insert mode scope 
across which the caret does not already extend.

Global

Insert mode affects all players in the flow. During note input, dotted lines are shown 
on staves affected by the Insert mode scope across which the caret does not already 
extend.

Global Adjustment of Current Bar

Insert mode affects all players in the flow, changes the duration of the current bar, 
and updates its time signature to reflect its new duration. For example, inputting notes 
extends the duration of bars while deleting notes shortens the duration of bars.

During note input, dotted lines are shown on staves affected by the Insert mode scope 
across which the caret does not already extend.

TIP

● You can use the Global Adjustment of Current Bar Insert mode scope to create 
and delete pick-up bars by deleting notes/rests in the first bar in the flow. You can 
also use it to shorten the last bar in flows that start with a pick-up bar.

● You can change how Insert mode affects time signatures on the Insert Mode page 
in Note Input Options.

RELATED LINKS
Caret on page 215
Deleting notes/items on page 459
Arranging tools on page 459
Players on page 124
Voices on page 1704
Time signatures on page 1639
Pick-up bars on page 1643
Note Input Options dialog on page 839

Changing the Insert mode scope
You can change the Insert mode scope; for example, if you want to switch from inserting notes 
into the selected voice only to inserting rhythmic time for all players.

The current Insert mode scope is indicated in the Notes toolbox and by the caret during note 
input.
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PROCEDURE

● In Write mode, change the Insert mode scope in any of the following ways:

● Press Alt/Opt-I  to cycle through the different Insert mode scopes.

● In the Notes toolbox, click and hold Insert , then click the scope you want.

● Choose Write > Insert Scope > [Scope].

RELATED LINKS
Notes toolbox on page 197
Caret on page 215
Inputting notes in Insert mode on page 237

Setting Insert mode stop positions
You can set a single rhythmic position in each flow as an Insert mode stop position, which 
prevents any material beyond the stop point being affected by inserted notes. For example, if 
you want to insert notes at the start of a flow but want to preserve material from a specific 
position later in the flow.

PROCEDURE

1. In Write mode, select the rhythmic position that you want to be the Insert mode stop 
position in any of the following ways:

● Select an item in the music area.

● In the system track, select the bar whose start barline you want to set as the stop 
position.

2. Set the Insert mode stop position in any of the following ways:

● Press Shift-Alt/Opt-I .

● In the system track, click Set Edit Stop Position .

● Choose Write > Insert Scope > Set Edit Stop Position.

RESULT
The Insert mode stop position for the flow is set at the selected rhythmic position. It appears as a 
vertical translucent line that spans all staves.

Because each flow can only have a single stop position, any existing stop position elsewhere in 
the flow is deleted.

When Insert mode is activated, existing notes that would otherwise be pushed beyond the stop 
position are deleted.

TIP

You can also move stop positions to barlines by clicking the top handle and dragging to the 
right/left.
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EXAMPLE

Insert mode stop position across two piano staves

RELATED LINKS
System track on page 430

Deleting Insert mode stop positions
You can delete Insert mode stop positions after they have been set.

PROCEDURE

● In Write mode, delete Insert mode stop positions in any of the following ways:

● Select an item at the rhythmic position of the Insert mode stop position and press 
Shift-Alt/Opt-I .

● In the system track, click Set Edit Stop Position  above existing stop positions.

● Click the stop position top handle and drag it in any direction until the mouse pointer is 
outside the music, then release the mouse.

TIP

When the mouse pointer is in the correct position, the stop position appears as a dotted 
line.
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Arranging tools
Arranging tools in Dorico Pro allow you to allocate notes to different staves and voices quickly 
and efficiently.

These tools include copying notes and items to multiple staves at the same time, and multiple 
times within a selected range, moving notes between staves, and changing the voices of notes. 
You can also explode notes onto more staves and reduce notes onto fewer staves.

RELATED LINKS
Filters on page 433
Transposing tools on page 479
Selecting notes/items on page 426
Copying and pasting articulations on page 955
Changing the duration of notes on page 259
Repitching notes without changing their rhythm on page 483
Splitting notes by duration on page 261
Rhythmic grid on page 214
Insert mode on page 454
Chord mode on page 254
Condensing on page 743
Musical transformations on page 488

Deleting notes/items
You can delete any notes/items you have input into your project independently of each other, 
such as deleting repeat endings without deleting the notes in them. However, you must be in 
Write mode. You cannot delete notes and items in Setup, Engrave, or Print modes.

You can also delete notes in the Key Editor, but not other notation items.

NOTE

You cannot delete initial clefs at the start of flows or clefs shown automatically at the start of 
each system. If you do not want any clef to appear on a staff, you can input an invisible clef.

PROCEDURE

1. In Write mode, select the notes, items, and/or the signposts of items you want to delete.

NOTE

● You must select barlines directly, not their signposts.

● If you delete some but not all dynamics from a dynamics group that is linked to other 
staves, the selected dynamics are also deleted from all linked staves.

● Deleting only tuplets does not delete the notes within them, and vice versa.

● To select multiple items of the same type, you can use large selections and/or filters.

2. Press Backspace or Delete .

RESULT
All selected notes/items are deleted from your project. Dorico Pro moves your selection to the 
most logical and nearby item to the deleted items. For example, if you deleted a note, Dorico 
Pro’s first choice is the nearest note in the same voice.
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If Insert mode was activated, notes following deleted notes move up to fill the gap. If Insert 
mode was deactivated, deleted notes are replaced by implicit rests as appropriate.

TIP

You can also delete markers by selecting them in the Markers section of the Video panel and 
clicking Delete in the action bar.

If a slur began or ended on a deleted note, the slur is automatically repositioned to the next/
previous notehead. If only one note is left under a slur, the slur is automatically deleted.

Holds and pauses are not automatically deleted if they are not selected when you delete notes. 
They are positioned above the note/rest closest to their rhythmic position, or over whole bar 
rests if you delete all notes in a bar.

Any repeat barlines input as part of repeat endings are not deleted automatically when you 
delete repeat endings.

When you delete barlines, the two bars on either side combine into one bar, containing the same 
number of beats but without changing the time signature. This might cause note, rest, and beam 
groupings to change.

When you delete time signatures, subsequent bars are re-barred according to the previous time 
signature in the score, up until the next time signature or the end of the flow, whichever comes 
first. Flows without time signatures are notated in an open meter, but notes and items retain 
their duration and positions.

When you delete clefs and key signatures, the pitches of notes are not changed but they are 
automatically notated according to the previous clef and key signature on the staff, such as 
with additional accidentals, up to the next existing one or the end of the flow, whichever comes 
first. Flows without any key signatures are treated as if there were an open/atonal key signature 
rather than A minor or C major.

When you delete octave lines, any notes to which the deleted octave lines previously applied are 
shown at either concert pitch or transposed pitch, depending on your current setting for the 
layout.

If you delete some but not all dynamics in a dynamics group that is linked to other staves, the 
selected dynamics are also deleted from all linked staves. However, if you select and delete the 
whole group of dynamics from a single staff, those dynamics are not deleted from other linked 
staves. Deleting immediate dynamics immediately before/after hairpins can automatically adjust 
the length of hairpins, depending on the context.

When you delete rehearsal marks, any subsequent rehearsal marks are adjusted until the next 
change in the sequence or the end of the flow, whichever comes first. For example, if you delete 
the first rehearsal mark, the second rehearsal mark shows either the letter A, the number 1, or 
the bar number, depending on your choice of sequence type.

Deleting tempo marks also removes them from the Tempo editor and the Tempo track in Play 
mode. The tempo in playback follows the previous tempo mark, or the default tempo of 120 bpm 
if there is no previous tempo mark.

AFTER COMPLETING THIS TASK
If you deleted notes/items because you want to change where they occur, you can input new 
notes/items at the new positions.

RELATED LINKS
Signposts on page 453
Editing items on page 436
Selecting notes/items on page 426
Filters on page 433

Write mode
Arranging tools 

460
Dorico Pro 4.3.30



Selecting lyrics using filters on page 1228
Deleting rests on page 1493
Deleting notes in the Key Editor on page 792
Note and rest grouping on page 1021
Turning existing notes into tuplets on page 1671
Turning tuplets into normal notes on page 1672
Insert mode on page 454
Insert mode scopes on page 455
Groups of dynamics on page 1132
Linked dynamics on page 1133
Accidental duration rules on page 951
Changing the rehearsal mark sequence type on page 1427
Inputting notes on page 221
Notations input on page 271

Copying and pasting notes/items
You can copy and paste items, including notes and notations, to other rhythmic positions and 
staves in different ways.

PROCEDURE

1. In Write mode, select the notes/items you want to copy.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Copy the selected notes/items to other rhythmic positions in any of the following ways:

● Alt/Opt -click each position to which you want to paste them.

● Press Ctrl/Cmd-C , select the position to which you want to paste them, then press Ctrl/
Cmd-V .

● To repeat the material directly after itself, press R .

● To copy notes/items to the staff above, select them and choose Edit > Paste Special > 
Duplicate to Staff Above.

● To copy notes/items to the staff below, select them and choose Edit > Paste Special > 
Duplicate to Staff Below.

RESULT
The selected notes/items are copied without deleting them from their original positions. By 
default, any MIDI CC points in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.

TIP

You can assign key commands for Duplicate to Staff Above and Duplicate to Staff Below on 
the Key Commands page in Preferences.

RELATED LINKS
Disabling automatic copying of MIDI data when pasting on page 464
Copying and pasting articulations on page 955
Copying and pasting lyrics on page 1225
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Copying and pasting notes in the Key Editor on page 791
Copying and pasting points in the Key Editor on page 782
Copying dynamic points to other instruments on page 803
Copying MIDI points to other instruments on page 809
Filters on page 433
Large selections on page 428
Selecting/Deselecting notes and items individually on page 426
Exploding music onto multiple staves on page 470
Generating notes from chord symbols on page 471
Moving notes/items to other staves on page 468
Resetting notes crossed to other staves on page 1012
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436
Changing the duration of notes on page 259
Splitting notes by duration on page 261
Disabling automatic linking of dynamics and slurs when pasting on page 464
Repitching notes without changing their rhythm on page 483
Key Commands page in the Preferences dialog on page 63
Linked dynamics on page 1133
Linked slurs on page 1519
Musical transformations on page 488
Numbered bar regions on page 1467
Insert mode on page 454
Chord mode on page 254

Copying and pasting notes into different voices
You can copy and paste notes into voices that are different to their original voices, including 
into slash voices. For example, you can copy notes from an up-stem voice on one staff into a 
down-stem voice on another staff.

PROCEDURE

1. In Write mode, select the notes you want to copy.

2. Press Ctrl/Cmd-C  to copy the selected notes.

3. Select the staff to which you want to paste the notes, at the position where you want the 
selection to start.

4. Choose Edit > Paste Special > Paste Into Voice > [Existing or new voice]. You can also 
choose this option from the context menu.

RESULT
The selected notes are copied to the selected staff and into the selected voice. By default, any 
MIDI CC points in the copied range are also pasted.

Copying and pasting notes/items to multiple staves
You can copy and paste notes and other items to multiple staves at once; for example, to copy a 
single phrase to all the woodwind staves when they are playing in unison.

PROCEDURE

1. In Write mode, select the notes/items you want to copy to multiple staves.
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TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Press Ctrl/Cmd-C  to copy the selected notes/items.

3. Select an item on each staff to which you want to paste the selected items.

NOTE

The earliest selected item on the top selected staff determines the rhythmic position for 
pasted items on all staves.

4. Press Ctrl/Cmd-V  to paste the selected notes/items.

RESULT
The selected notes/items are copied to all of the selected staves. By default, any MIDI CC points 
in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.

TIP

If you selected a range of notes/items on each staff, the selected notes/items are also pasted 
multiple times to fill the selected range.

RELATED LINKS
Filters on page 433
Large selections on page 428
Disabling automatic copying of MIDI data when pasting on page 464
Linked dynamics on page 1133
Linked slurs on page 1519
Resetting notes crossed to other staves on page 1012

Copying and pasting notes/items to fill a selected range
You can copy and paste items, including notes and notations, multiple times within a selected 
range at once; for example, if you want to fill multiple bars with the same phrase.

NOTE

You can only copy and paste items that have a duration to fill a selection. For example, you can 
copy and paste gradual dynamics to fill a selection but not immediate dynamics.

PROCEDURE

1. In Write mode, select the notes/items you want to copy throughout a range.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Press Ctrl/Cmd-C  to copy the selected notes/items.

3. Select the range throughout which you want to paste the selected notes/items.
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4. Press Ctrl/Cmd-V  to paste the selected notes/items.

RESULT
The selected notes/items are copied as many times as will fit within the selected range without 
extending beyond it. By default, any MIDI CC points in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.

TIP

If you selected a range on multiple staves, the selected items are also pasted to multiple staves.

RELATED LINKS
Filters on page 433
Large selections on page 428
Splitting notes by duration on page 261

Disabling automatic linking of dynamics and slurs when pasting
By default, dynamics and slurs are automatically linked when you copy them to other staves at 
the same rhythmic position. You can disable this behavior so dynamics and slurs are not linked 
by default.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Editing section, deactivate Link dynamics and slurs to existing items when 
pasting.

4. Click Apply, then Close.

RELATED LINKS
Preferences dialog on page 61
Linked dynamics on page 1133
Linked slurs on page 1519

Disabling automatic copying of MIDI data when pasting
By default, all MIDI CC, MIDI pitch bend, and dynamic points are copied when you copy the notes 
to which they apply. You can disable this behavior for all future projects on your computer.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, deactivate Include MIDI CC, pitch bend and dynamics from Key 
Editor when copying music.

4. Click Apply, then Close.
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RELATED LINKS
Preferences dialog on page 61
Copying and pasting notes/items on page 461
Copying and pasting notes in the Key Editor on page 791

Moving notes/items rhythmically
You can move notes and items to new rhythmic positions to the right/left along staves after 
they have been input. For example, if you want a cresc. dynamic to start a beat later or to show 
different material in a cue. You can also move individual dynamics and playing techniques within 
a group.

Divisi passages, extra staves, and ossia staves have separate signposts at their start and end that 
you can move independently, allowing you to lengthen/shorten them.

NOTE

● These steps do not apply to the following items: barlines, notehead brackets, glissando lines, 
notehead-attached horizontal lines, fingerings and fingering slides, jazz articulations, guitar 
bends, vibrato bar dives/returns, pedal retakes or level changes, and tremolo strokes. If you 
want to change the rhythmic positions of these items, you must delete them from their 
original positions and input new ones at the new positions.

We recommend deleting and inputting new arpeggio signs and vertical lines rather than 
moving them. If you move arpeggio signs and vertical lines to the rhythmic position of a rest, 
they are deleted.

● Because markers have a fixed position in time, moving markers relative to the notated music 
automatically changes the tempo on either side of the marker. If you want to move a marker 
to a new time position, you must change the timecode of the marker; for example, if you 
want to move it from 25 seconds to 28 seconds.

PREREQUISITE
You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In Write mode, select the notes, items, or signposts that you want to move.

NOTE

● If you want tuplet notes to remain tuplets, you must also select their tuplet numbers/
ratios, brackets, or tuplet signposts, otherwise notes become normal notes of their 
rhythmic value when you move them beyond the boundaries of tuplets.

● You can only move a single slur, marker, repeat ending, or bar repeat region at a time.

● When using the mouse, you can only move a single item at a time. You cannot 
move notes or the following items using the mouse: tuplets, lyrics, slash regions, time 
signatures, arpeggio signs, and vertical lines.

● You can only select clefs that you have input. You cannot select initial clefs at the start of 
flows or clefs shown automatically at the start of each system.

● To move a single dynamic within a group, you must click and drag it with the mouse. If 
you use the key commands, the whole group is moved.

● Moving multiple playing techniques or dynamics in the same group at the same time 
ungroups them.
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2. Optional: If you selected notes and do not want them to overwrite existing notes they pass 
over as part of their move, activate one of the following:

● If you want the selected notes to overlap with existing notes, activate Chord mode by 
pressing Q  or clicking Chords  in the Notes toolbox.

● If you want the selected notes to move through existing notes, activate Insert mode in 
Write mode by pressing I  or clicking Insert  in the Notes toolbox.

NOTE

Moving notes rhythmically with Insert mode activated can affect the durations of 
existing notes the selected notes move through.

3. Move the notes, items, and/or signposts in any of the following ways:

● To move them to the right, press Alt/Opt-Right Arrow .

● To move them to the left, press Alt/Opt-Left Arrow .

NOTE

Most items move according to the current rhythmic grid resolution. A single selection 
of the following items moves to adjacent noteheads, bars, or barlines: cues, dynamics, 
ornaments, slurs, lines, octave lines, pedal lines, playing techniques, rehearsal marks, 
repeat endings, and bar repeat regions.

● To move items to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move items to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

● Click and drag the selected item to the right/left.

NOTE

The following items move to adjacent noteheads, bars, or barlines: cues, dynamics, 
ornaments, slurs, horizontal lines, octave lines, pedal lines, playing techniques, rehearsal 
marks, repeat endings, and bar repeat regions.

RESULT
The selected notes, items, and/or signposts are moved to new rhythmic positions. Attachment 
lines link items to the rhythmic positions to which they apply.

Most items move according to the current rhythmic grid resolution. However, a single selection 
of some items automatically moves to adjacent noteheads, bars, or barlines. Single cues are 
moved according to the rhythm in the source instrument. When multiple items are selected, they 
move as a block according to the current rhythmic grid resolution.

NOTE

Only a single instance of many items, such as tempo marks and clefs, can exist at each rhythmic 
position on each staff. If an item passes over another item of the same type as part of its move, 
the existing item is deleted or shortened accordingly.

You can undo this action, but any items deleted in the process are only restored if you moved 
items using the keyboard.

Items that can have multiple instances at the same rhythmic position on the same staff include 
dynamics, octave lines, cues, playing techniques, horizontal lines, slash regions, and text items. 
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However, if you move multiple items together, any existing items of the same type between the 
selected items or that they pass over as part of the move are deleted or shortened accordingly 
unless Insert mode is activated.

Notes are automatically positioned according to their rhythmic duration and position relative to 
other notes.

If a tuplet number/ratio or tuplet bracket is included in the selection, the whole tuplet is moved 
along the staff. If it crosses a barline, the tuplet is automatically adjusted to compensate. 
However, tuplets are not automatically adjusted at the mid-point of bars, where it is convention 
to split tuplets to show the beat division. You must enter two tuplets manually to show the beat 
division at the mid-point of bars.

Items such as clefs, key signatures, and time signatures take effect from their new positions until 
the next item of the same type or the end of the flow, whichever comes first. Barlines on either 
side of a moved time signature are automatically updated up to the previous/next existing time 
signature, or the start/end of the flow.

If you moved divisi change signposts, any music on divisi staves outside of divisi passages 
is automatically hidden, and any unison ranges before/after divisi passages are automatically 
updated.

If you moved harp pedal diagrams and colors are shown for notes out of range, any notes that 
no longer fit with the prevailing harp pedal diagram appear red.

The position of holds and pauses you have moved might not appear to change. For example, if 
one staff has a bar rest and you move a fermata rhythmically within the bar, the fermata still 
appears above the bar rest.

The rhythmic duration of slurs is usually maintained. However, depending on the rhythms they 
cross as they move, slurs may cover longer/shorter durations than before the move.

Moving repeat endings does not automatically input, delete, or move repeat barlines.

When you move markers, their fixed position in time is not changed. Therefore, the tempo 
immediately preceding the marker automatically updates so that the marker occurs at the 
correct time. For example, moving a marker to the right increases the preceding tempo. Any 
gradual tempo changes between the preceding tempo change or the start of the flow and the 
marker are removed. The tempo change affects the positions of all other markers in the flow 
relative to the notated music.

EXAMPLE

An ossia staff with signposts shown The same ossia staff after moving the start signpost 
to the right and end signpost to the left

RELATED LINKS
Rhythmic grid on page 214
Notes toolbox on page 197
Note spacing on page 599
Chord mode on page 254
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Insert mode on page 454
Note and rest grouping on page 1021
Tuplet brackets on page 1674
Tuplet numbers/ratios on page 1678
Changing the duration of notes on page 259
Lengthening/Shortening items on page 436
Changing the staff-relative placement of items on page 441
Moving notes/items to other staves on page 468
Creating cross-staff beams/tremolos on page 1009
Moving figured bass resolutions on page 1150
Moving the center of messa di voce hairpins on page 1128
Splitting pedal lines on page 1375
Moving items graphically on page 609
Overlapping cues on page 1096
Hiding/Showing colors for notes out of range on page 1261
Groups of dynamics on page 1132
Groups of playing techniques on page 1399
Showing extra staves across whole systems on page 1555
Deleting notes/items on page 459
Input methods for lines on page 384
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Input methods for guitar bends and guitar techniques on page 354
Input methods for clefs and octave lines on page 329
Input methods for repeats and tremolos on page 406
Adding retakes and pedal level changes with the popover on page 377
Adding retakes and pedal level changes with the panel on page 379
Inputting fingerings on page 274
Hiding/Showing fingering slides on page 1177
Showing brackets on noteheads on page 1265
Changing the timecodes of markers on page 1433

Moving notes/items to other staves
You can move notes and items to other staves of any type; for example, if you want to move 
individual notes from one keyboard staff to another after importing a keyboard part from a MIDI 
file.

NOTE

● These steps do not apply to pedal lines or system objects.

● If you want notes to appear on a different staff but remain attached to their original staff, 
such as to create a cross-staff beam, you can cross notes to other staves instead.

PROCEDURE

1. In Write mode, select the notes and/or items you want to move to another staff.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Move the selected notes/items another staff in one of the following ways:

● To move them to the staff above, press Alt/Opt-N .

● To move them to the staff below, press Alt/Opt-M .
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● Choose Edit > Paste Special > Move to Staff Above.

● Choose Edit > Paste Special > Move to Staff Below.

TIP

You can also choose these options from the context menu.

RESULT
The selected notes and/or items are moved to another staff by cutting them from their original 
staff and pasting them to the new staff. By default, notes are pasted into the first voice active on 
that staff.

Notes within tuplets remain tuplets even if you did not select the tuplet bracket, tuplet number/
ratio, or tuplet signpost.

RELATED LINKS
Filters on page 433
Large selections on page 428
Creating cross-staff beams/tremolos on page 1009
Moving notes/items rhythmically on page 465
Copying and pasting notes/items to multiple staves on page 462
Changing the duration of notes on page 259
Changing the pitch of individual notes on page 479
Changing the positions of system objects on page 1564
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Swapping the contents of staves
You can swap the contents of two staves for a selected range; for example, if you want to change 
quickly the default voicing in two particular bars that was achieved by exploding a chord, or if 
you change your mind about which players have each line in an arrangement.

PROCEDURE

1. In Write mode, select the range of music on two staves that you want to swap.

2. Choose Edit > Paste Special > Swap. You can also choose this option from the context 
menu.

RESULT
The contents of the selected staves for the selected duration are swapped.

RELATED LINKS
Swapping the contents of voices on page 478

Reducing music onto fewer staves
You can reduce music onto fewer staves than it was originally notated across; for example, to 
create a piano reduction of a choral piece.

PREREQUISITE
You have chosen the appropriate voicing approach on the Paste Special page in Note Input 
Options.
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PROCEDURE

1. In Write mode, select the music you want to reduce.

TIP

We recommend reducing sections in rhythmic unison separately from sections with different 
rhythms.

2. Press Ctrl/Cmd-C  to copy the music.

3. Select the staves onto which you want to reduce the selected music.

4. Choose Edit > Paste Special > Reduce. You can also choose this option from the context 
menu.

RESULT
The selected music is reduced onto the selected staves.

If the rhythms match throughout the selection, Dorico Pro merges the music into a single voice 
by default. Unison notes are removed so that only a single note of the same pitch is pasted at a 
single rhythmic position, and clef changes, octave lines, and cues are also deleted. If the rhythms 
are different at any point in the selection, Dorico Pro uses as many voices as needed to preserve 
the rhythms.

Each destination staff receives the music of at least one instrument, and the division of the music 
to be reduced is calculated from the top selected staff downwards. For example, if you copy 
material from five instruments and reduce it to three, the top selected staff is assigned the music 
from the first and second instruments, the second selected staff is assigned music from the third 
and fourth instruments, and the third selected staff is assigned music from the fifth instrument.

RELATED LINKS
Note Input Options dialog on page 839
Moving notes/items to other staves on page 468
Changing the voice of existing notes on page 477
Condensing on page 743

Exploding music onto multiple staves
You can explode music onto more staves than it was originally notated for; for example, to get 
notes in dense piano chords onto all the woodwind staves quickly.

PREREQUISITE

● You have chosen the appropriate settings for the music you want to explode on the Paste 
Special page in Note Input Options.

● You have reset any cross-staff notes to their default staves.

PROCEDURE

1. In Write mode, select the music you want to explode.

2. Press Ctrl/Cmd-C  to copy the music.

3. Select the staves onto which you want to explode the selected music.

4. Choose Edit > Paste Special > Explode. You can also choose this option from the context 
menu.
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RESULT
The selected music is exploded onto the selected staves. By default, each destination staff 
receives at least one of the notes in the source chords, allocated from the top selected 
instrument staff downwards.

● If the number of notes in the chord matches the number of destination staves, each 
instrument receives one note.

● If the number of notes in the chord is less than the number of destination staves, then 
the same note is allocated to multiple staves. Notations, such as slurs and dynamics, are 
duplicated to each destination staff.

● If the number of notes in the chord is more than the number of destination staves, then the 
notes are spread as equally as possible across the destination staves. If the chord contained 
an odd number of notes, Dorico Pro prefers to allocate extra notes to the upper staves.

RELATED LINKS
Note Input Options dialog on page 839
Creating cross-staff beams/tremolos on page 1009
Insert mode on page 454
Chord mode on page 254

Generating notes from chord symbols
You can automatically generate notes based on chord symbols you have already input. You can 
influence many related variables, such as which instruments play bass notes.

PREREQUISITE
You have chosen the appropriate settings for the notes you want to generate on the Notes from 
Chord Symbols page in Note Input Options.

PROCEDURE

1. In Write mode, on the staves onto which you want to generate notes from chord symbols, 
select items that span the required duration.

2. Choose Edit > Notations > Chord Symbols and Diagrams > Generate Notes from Chord 
Symbols in Selection to open the Generate Notes From Chord Symbols dialog. You can 
also choose this option from the context menu.

3. Change the settings as required.

For example, you can change the rhythm of generated notes, and the order in which pitches 
are distributed to instruments in each group.

4. Click OK to save your changes and close the dialog.

RESULT
Notes are generated based on chord symbols in the selected range and your settings. Notes are 
distributed to the selected staves, with voicings determined by the instrument order you set.

TIP

You can assign a key command for Generate Notes from Chord Symbols in Selection on the 
Key Commands page in Preferences.

RELATED LINKS
Note Input Options dialog on page 839
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Project-wide note input options for generating notes from chord symbols on page 476
Pasting chord symbols as notes on page 476
Selecting notes/items on page 426
System track on page 430
Generating chord symbols from notes on page 327
Key Commands page in the Preferences dialog on page 63

Generate Notes From Chord Symbols dialog
The Generate Notes From Chord Symbols dialog allows you to generate notes based on the 
harmony of chord symbols you have already input, and influence many related variables, such as 
voice leading and which instruments play bass notes.

● You can open the Generate Notes From Chord Symbols dialog in Write mode by choosing 
Edit > Notations > Chord Symbols and Diagrams > Generate Notes from Chord Symbols 
in Selection. You can also choose this option from the context menu.

You can hide/show each section by clicking the corresponding section header.

Notate Rhythm

The Notate Rhythm section allows you to influence the rhythm of generated notes, and whether 
you want to use rhythms from an instrument with existing notes.

The Notate Rhythm section contains the following options:

Rhythm frequency
Allows you to change the rhythmic interval between generated notes.

● Note per beat: Notes are created every beat, according to the prevailing time 
signature.

● Note per bar or chord change: Notes are created every bar or at every chord 
symbol change, whichever comes first.

Use existing rhythm where possible
Allows you to select an instrument with existing notes from the Source instrument for 
rhythm menu, whose rhythm you want to use for generated notes. Shorter existing 
rhythms are repeated to fill the selected duration. Only available when at least one 
instrument has existing notes that start and end within your selected duration.

Override rhythm for polyphonic fretted instruments
Allows you to override the generated rhythms for fretted instruments, and simplify 
their rhythms to one of the available options. For example, if you want to generate 
complex rhythms for most of the ensemble, but want the guitar only to play quarter 
notes. Only available when your selection includes at least one fretted instrument.
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● On the beat: Notes are created every beat, according to the prevailing time 
signature.

● On the bar: Notes are created at the start of each bar.

Fretted Instruments

The Fretted Instruments section allows you to influence the notes, and the resulting chord 
shapes, generated on staves belonging to fretted instruments. Only available when your 
selection includes at least one fretted instrument.

The Fretted Instruments section contains the following options:

Source for chord shapes
Allows you to change the primary source for chord shapes.

● Prefer shapes from library: Dorico Pro prefers common shapes that are easier to 
play.

● Prefer auto-generated shapes: Dorico Pro prefers shapes with stronger voice-
leading.

Minimum number of notes in each chord
Allows you to set the minimum number of notes for each chord.

Constrain maximum number of notes in each chord
Allows you to limit each chord to the number of notes set in the Maximum number of 
notes in each chord value field.

Allow pitches outside preferred range for fretted instruments
Allows you to override your settings for restricting pitch ranges in Note Input 
Options > Notes from Chord Symbols > Chord Degrees.

Allow parallel movement on fretted instruments
Allows you to override your settings for restricting parallel movement in Note Input 
Options > Notes from Chord Symbols > Parallelism and Contrary Motion.

Miscellaneous Polyphonic Instruments (e.g. keyboard instruments, harp 
etc.)

The Miscellaneous Polyphonic Instruments (e.g. keyboard instruments, harp etc.) section 
allows you to set the minimum and maximum number of notes you want to generate in each 
chord for polyphonic instruments. For example, if the polyphonic instrument in your selection 
is a marimba, and you know the performer can only hold two sticks per hand, you can set the 
maximum number of notes to 4.
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Only available when your selection includes at least one polyphonic instrument, such as a piano.

Blending and Bass Notes

The Blending and Bass Notes section allows you to specify the order in which pitches are 
distributed to instruments, and change which instruments are assigned the lowest notes. For 
example, you might want Clarinet 1 to receive higher pitches than Flute 2, and the Bass 
Trombone to play bass notes.

The Blending and Bass Notes section contains the following columns:

Groups
Contains groups of instruments, typically instrument families, corresponding to the 
staves you selected before opening the dialog.

Instruments
Contains instruments in the selected group. The order of instruments in the list reflects 
the order in which pitches are distributed; that is, the top instrument receives the 
highest pitch in each chord, and the bottom instrument receives the lowest pitch in 
each chord.

The action bar at the bottom of the column contains the following options:

● Move Up : Moves the selected instrument up the list.

● Move Down : Moves the selected instrument down the list.

● Plays bass notes: Moves the selected instrument across to the Bass note 
instruments column.

Bass note instruments
Contains the instruments in the selected instrument family that are assigned to play 
bass notes; that is, either the root note or altered bass note, if specified.

Does not play bass notes in the action bar allows you to move the selected, unlocked 
instrument across to the Instruments column.

Voicing Hints

The Voicing Hints section allows you to select an instrument to use as a reference for the 
highest part; that is, generated notes should not be higher in pitch than notes belonging to the 
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selected instrument. Only available when at least one instrument has existing notes within your 
selected duration, and at least some of their pitches match the corresponding chord symbols.

Intra-chord Vertical Spacing

The Intra-chord Vertical Spacing section allows you to set the maximum intervals you want to 
allow between notes in each chord, excluding bass notes.

Options

The Options section allows you to specify how to handle situations where chord symbols and 
existing notes occur at different rhythmic positions.

The Options section contains the following options:

Anticipate chord symbol change
Allows you to change the circumstances in which Dorico Pro can use pitches at earlier 
rhythmic positions than their chord symbols.

● Never: Pitches never precede their chord symbols.

● When note overlaps change: Pitches can precede their chord symbols, for notes 
that start before and end after those chord symbols. For example, an offbeat note 
that is tied into the next bar, at the start of which is a new chord symbol.

● When note overlaps or abuts change: Pitches can precede their chord symbols, 
for notes that either start before and end after, or end at the same rhythmic 
position as, those chord symbols. For example, an offbeat note that ends at the 
end of a bar, with a new chord symbol at the start of the next bar.
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Maximum distance between start of note and chord symbol to allow anticipation
Allows you to set the maximum duration between chord symbols and abutting 
anticipated notes.

When chord changes do not coincide with notes
Allows you to specify how to resolve situations where chord symbols occur in the 
middle of generated notes.

● Allow changes to be missed: Pitch changes are deferred to the next available 
note where possible, or skipped entirely where not possible.

● Amend rhythm if not deferred: If the next note to which a pitch change can be 
deferred is at or beyond the next chord symbol, the rhythm is amended so that the 
pitch change comes before the next chord symbol.

● Always amend rhythm for changes on the beat: For chord symbols at beat 
positions, the rhythm is always amended. For chord symbols at non-beat positions, 
the rhythm is only amended if the next note to which a pitch change can be 
deferred is at or beyond the next chord symbol.

● Always amend rhythm: Notes are always split and may have their pitches 
changed at each chord symbol.

TIP

You can find further options that influence the results of generating notes from chord symbols 
on the Notes from Chord Symbols page in Note Input Options.

Project-wide note input options for generating notes from chord symbols
You can find options for the project-wide handling of notes generated from chord symbols on 
the Notes from Chord Symbols page in Note Input Options.

The options on the Notes from Chord Symbols page include whether or not to allow various 
parallel intervals and types of motion, how far to adjust pitches to avoid specific situations, and 
your preferred scale degrees and intervals in chords.

RELATED LINKS
Note Input Options dialog on page 839
Generating notes from chord symbols on page 471
Generating chord symbols from notes on page 327

Pasting chord symbols as notes
You can generate notes based on chord symbols you have already input, at different rhythmic 
positions to the original chord symbols.

PROCEDURE

1. In Write mode, select the chord symbols you want to paste as notes.

2. Copy the selected chord symbols.

3. Select an item on each staff and at the rhythmic position from which you want to paste chord 
symbols as notes.

4. Choose Edit > Notations > Chord Symbols and Diagrams > Paste Chord Symbols as Notes 
to open the Generate Notes From Chord Symbols dialog. You can also choose this option 
from the context menu.

5. Change the settings as required.
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For example, you can change the rhythm of generated notes, and the order in which pitches 
are distributed to instruments in each group.

6. Click OK to save your changes and close the dialog.

RESULT
Notes are generated based on the copied chord symbols and your settings. Notes are distributed 
to the selected staves, with voicings determined by the instrument order you set.

RELATED LINKS
Large selections on page 428
System track on page 430
Filters on page 433
Generate Notes From Chord Symbols dialog on page 472
Project-wide note input options for generating notes from chord symbols on page 476
Generating notes from chord symbols on page 471
Copying and pasting notes/items on page 461

Changing the voice of existing notes
You can change the voice of notes after they have been input, including notes in slash voices. For 
example, you can change notes in an up-stem voice to a down-stem voice or a slash voice.

PROCEDURE

1. In Write mode, select the notes whose voice you want to change.

TIP

You can use large selections and filters to select many notes in the same voice quickly.

2. Change the voice in any of the following ways:

● To change the selected notes to a new normal voice, press Shift-V  or click Create Voice 
 in the Notes toolbox.

● To change the selected notes to a new slash voice, press Shift-Alt/Opt-V . You can also 
click and hold Create Voice  in the Notes toolbox, then click Create Slash Voice .

● To change the selected notes to an existing voice, press V  or click Next Voice  in the 
Notes toolbox to cycle through active voices on the staff.

RESULT
The voice of the selected notes is changed, which might cause Dorico Pro to change the stem 
directions of the selected notes and other notes on the staff. Rests appear as required around 
notes in different voices.

If you changed notes to a slash voice, they no longer play back.

TIP

You can also change the voice of selected notes by choosing Edit > Notations > Voices > Change 
Voice > [Voice]. You can also choose these options from the context menu. If there is only one 
voice on the staff, you can create a new voice for your selected notes.

AFTER COMPLETING THIS TASK

● You can later delete or hide rests and change the stem direction of notes manually.
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● You can also change whole voices into slash voices.

RELATED LINKS
Notes toolbox on page 197
Hiding/Showing voice colors on page 1705
Inputting notes into multiple voices on page 231
Inputting notes into slash voices on page 233
Large selections on page 428
Filters on page 433
Implicit rests in multiple-voice contexts on page 1489
Deleting rests on page 1493
Changing the stem direction of notes on page 1277
Changing the slash voice type on page 1484
Changing the duration of notes on page 259
Tuplets on page 1669
Signposts on page 453

Swapping the contents of voices
You can swap the contents of two voices that contain musical material.

PROCEDURE

1. In Write mode, select the notes in two voices that you want to swap.

2. Choose Edit > Notations > Voices > Swap Voice Contents. You can also choose this option 
from the context menu.

RESULT
The contents of the voices are swapped. For example, the notes previously in an up-stem voice 
are now in a down-stem voice, and the notes previously in a down-stem voice are now in an 
up-stem voice.

NOTE

Depending on the pitches involved in the swap and their stem directions, the notes might 
overlap. Dorico Pro automatically positions notes with the noteheads partially overlapping, in 
order to minimize the horizontal space they occupy and maintain the clarity of the rhythm. 
However, if you want to change this arrangement, you can change the order of voices or change 
the voice column index.

EXAMPLE

An E is in the up-stem voice, an F in the down-stem 
voice.

After swapping their voice contents, the E is in the 
down-stem voice, and the F is in the up-stem voice.

RELATED LINKS
Swapping the order of voices on page 1708
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Voice column index on page 1708

Transposing tools
In Dorico Pro, you can change the pitches of existing notes in a variety of ways.

RELATED LINKS
Arranging tools on page 459
Transposing instruments on page 137
Concert vs. transposed pitch on page 174
Transposing notes in the piano roll editor on page 790

Changing the pitch of individual notes
You can raise/lower the pitch and register of individual notes, including grace notes, after they 
have been input by octave divisions, staff position, and octaves.

PROCEDURE

1. In Write mode, select the notes whose pitches you want to change.

2. Raise/Lower the pitches of the selected notes in any of the following ways:

● To move notes up one staff position, such as from C to D, press Alt/Opt-Up Arrow .

● To move notes down one staff position, such as from D to C, press Alt/Opt-
Down Arrow .

● To transpose notes up a single octave division, such as a half-step (semitone) in 12-EDO 
or a quarter tone in 24-EDO, press Shift-Alt/Opt-Up Arrow .

● To transpose notes down a single octave division, such as a half-step (semitone) in 
12-EDO or a quarter tone in 24-EDO, press Shift-Alt/Opt-Down Arrow .

● To transpose notes up an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To transpose notes down an octave, press Ctrl/Cmd-Alt/Opt-Down Arrow .

RESULT
The pitch or register of the selected notes is changed. Any figured bass shown on the affected 
staves is updated automatically.

If the pitch is now impossible to play on a fretted instrument, such as if a note would have to be 
played below the nut on the lowest string, it appears on tablature as a question mark.

NOTE

You can press Alt/Opt-Up Arrow  and Alt/Opt-Down Arrow  to change the staff positions of 
notes in percussion kits using grid and five-line staff presentation types. However, this also 
changes the instrument playing the note.

RELATED LINKS
Equal Division of the Octave (EDO) on page 1219
Adding notes above/below existing notes on page 258
Respelling notes on page 484
Inputting accidentals on page 244
Transposing notes in the piano roll editor on page 790
Figured bass on page 1139
Arranging tools on page 459
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Musical transformations on page 488
Inverting pitches on page 489
Reversing pitches/rhythms on page 489
Rotating pitches/rhythms on page 491
Mapping notes to pitches on page 493
Mapping notes to scales on page 495

Transposing selections
You can transpose whole flows or specific selections, including selected key signatures, using the 
Transpose dialog.

TIP

Dorico Pro automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.

PROCEDURE

1. Optional: In Write mode, select the region you want to transpose.

NOTE

● If you want to transpose key signatures, you must include them in your selection.

● If nothing is selected, the whole flow in which you last selected a note/item is 
transposed.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.

TIP

● We recommend using the Calculate interval section to determine your required 
settings; for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Optional: If you want to transpose any key signatures in the flow or included in your 
selection, activate Transpose key signatures.

5. Click OK to save your changes and close the dialog.

RESULT
All notes in your selection, or all notes in the flow if nothing was selected, are transposed 
according to the interval or number of divisions of the octave specified in the Transpose dialog. 
If your selection included key signatures and you activated Transpose key signatures, all key 
signatures in the selection are also transposed.

Any figured bass shown on the affected staves is also transposed accordingly.

Key signatures that apply to all staves are transposed on all staves in the layout, even if your 
selection did not include all staves. Key signatures that apply only to single staves are transposed 
if they are included in a selection, but this does not affect any other staff in the layout.

RELATED LINKS
Large selections on page 428
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Selecting/Deselecting notes and items individually on page 426
Figured bass on page 1139
Enharmonic equivalent key signatures on page 1217
Concert vs. transposed pitch on page 174
Making layouts transposing/concert pitch on page 173

Transpose dialog
The Transpose dialog allows you to transpose whole flows or selections of notes, including key 
signatures. You can transpose according to an interval and quality or by a set number of octave 
divisions.

● You can open the Transpose dialog in Write mode by choosing Write > Transpose.

The Transpose dialog contains the following sections:

1 Transposition options

Contains options that allow you to specify the transposition you want. For example, you can 
choose to transpose by an interval quality, such as a major third, or by a set number of 
divisions of the octave. You can choose the direction of the transposition, whether it includes 
octaves, and the interval and quality or number of divisions by which you want to transpose 
your selection.

According to convention, different intervals have different possible qualities. For example, 
you can specify a major third but not a major octave. Therefore, we recommend selecting 
the interval before the quality.

Additional options also allow you to transpose any key signatures included in your selection, 
keep relative respelled notes and chord symbols where possible, and avoid double and triple 
accidentals.

NOTE

You can only use Respell to avoid double and triple sharps and flats when transposing 
music in tonality systems that are compatible with 12-EDO.

2 Calculate interval
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Allows you to set transposition options according to a starting note and the resulting note 
you want. For example, if you want to transpose a selection relative to a C♮ becoming a G♯ 
but you are not certain of the interval and quality required, you can enter those two notes 
in the Calculate interval section, click Apply, and Dorico Pro automatically sets the required 
transposition options for you.

NOTE

The Transpose dialog does not allow transpositions that would result in impossible notations, 
such as sharper than a triple sharp, or that require a microtonal accidental that does not exist in 
the tonality system in place at the position of your selection.

RELATED LINKS
Note tools popover on page 498
Equal Division of the Octave (EDO) on page 1219
Tonality systems on page 1219
Arranging tools on page 459
Musical transformations on page 488
Mapping notes to pitches on page 493
Mapping notes to scales on page 495

Transposing existing notes with the note tools popover
You can change the pitch of notes after they have been input using the note tools popover.

PROCEDURE

1. In Write mode, select the notes you want to transpose.

2. Open the note tools popover in any of the following ways:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

3. Enter the transposition interval you want into the popover.

For example, enter t3 to transpose the notes up a third, or t-min6 to transpose the notes 
down a minor sixth.

4. Press Return  to close the popover.

RESULT
The selected notes are transposed by the degree specified. Any figured bass shown on the 
affected staves is also transposed accordingly.

RELATED LINKS
Notations toolbox on page 202
Note tools popover on page 498
Figured bass on page 1139
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Repitching notes without changing their rhythm
You can repitch notes after you have input them while keeping their durations the same. For 
example, if you want to duplicate the rhythm but have different pitches.

PROCEDURE

1. In Write mode, select the first note you want to repitch.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to repitch notes on multiple staves at once, extend the caret to those 
staves.

4. Activate Lock to Duration in any of the following ways:

● Press L .

● In the Notes toolbox, click Lock to Duration .

5. Enter the pitches you want.

6. Optional: Press L  or click Lock to Duration  again to deactivate Lock to Duration.

NOTE

Lock to Duration automatically deactivates when you reach the last existing note on the 
staff. By default, normal note input continues using the previous note value selected before 
you activated Lock to Duration.

RESULT
Existing notes on the selected staff are repitched without their rhythms being changed. The caret 
automatically advances from note to note, even if there are large rests between notes on the 
staff.

TIP

You can set a maximum number of rests over which you want to advance when repitching notes 
in Preferences > Note Input and Editing > Note Input > Lock Duration.

RELATED LINKS
Caret on page 215
Extending the caret to multiple staves on page 219
Arranging tools on page 459
Musical transformations on page 488
Mapping notes to pitches on page 493
Mapping notes to scales on page 495
Copying and pasting articulations on page 955
Preferences dialog on page 61
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Respelling notes
You can change the enharmonic spelling of notes so they are shown as their enharmonic 
equivalents; for example, to show the stepwise movement in a phrase clearly, or to avoid altered 
unisons in a chord. You can do this for all layouts or only in the current part layout.

By default, Dorico Pro uses an algorithm that automatically decides the spelling of pitches, based 
on key signature and context.

There are always at least three options for every pitch, as Dorico Pro allows enharmonic spellings 
to show up to two accidental glyphs. This means the same note can be spelled four ways if the 
original pitch can be spelled with the note name either two notes below or two notes above, 
using a maximum of two accidental glyphs. For example, B is a possible enharmonic spelling of 
G♯ because a triple-flat uses a single accidental glyph, whereas an F♯ uses two accidental glyphs.

PROCEDURE

1. In the music area, open the layout in which you want to respell accidentals. You can do this 
in Write mode and Engrave mode.

NOTE

By default, respelling notes in score layouts also affects their spelling in all other layouts, but 
respelling notes in part layouts only affects their spelling in the current part layout.

2. Select the notes you want to respell.

NOTE

If you want to respell individual noteheads in tie chains, you must be in Engrave mode.

3. Respell the selected notes in any of the following ways:

● To respell them upwards, press Alt/Opt-=  or click Respell Using Note Name Above 
in the Keyboard panel toolbar.

● To respell them downwards, press Alt/Opt--  or click Respell Using Note Name Below 
 in the Keyboard panel toolbar.

● To respell them automatically, choose Write > Respell > Respell Notes Automatically 
to open the Respell Notes Automatically dialog.

4. Optional: If you opened the Respell Notes Automatically dialog, change the settings for 
respelling as required, then click OK to close the dialog and respell the selected notes.

RESULT
The enharmonic spelling of the selected notes is changed.

TIP

You can change the default spelling of notes in atonal key signatures in Note Input Options > 
MIDI Input > Note Spelling.
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EXAMPLE

A G sharp When respelled 
downwards, the G sharp 
becomes an F triple-
sharp

When respelled upwards, 
the G sharp becomes an 
A flat

When respelled upwards 
again, the G sharp 
becomes a B triple-flat

AFTER COMPLETING THIS TASK
You can copy note spellings to other layouts, such as if you respelled notes in a part layout but 
want the same spelling to appear in the full score layout.

RELATED LINKS
Keyboard panel on page 207
Switching between layouts on page 46
Selecting notes/items on page 426
Accidentals on page 942
Accidental selection during MIDI input on page 245
Key signatures on page 1210
Tonality systems on page 1219
Custom tonality systems on page 902
Input methods for key signatures on page 278
Copying note spellings to other layouts on page 487
Resetting note spellings on page 487
Mapping notes to pitches on page 493
Mapping notes to scales on page 495

Respell Notes Automatically dialog
The Respell Notes Automatically dialog allows you to simplify the note spelling of all notes in 
specific selections based on the musical context, including respelling some notes upwards and 
other notes downwards.

● You can open the Respell Notes Automatically dialog in Write mode when at least one note 
is selected in the music area by choosing Write > Respell > Respell Notes Automatically.
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The Respell Notes Automatically dialog contains the following options:

Additional context at start
Allows you to specify additional musical context before the selected notes that you 
want Dorico Pro to consider when calculating automatic note spellings.

● None: Only notes in the selection.

● To start of bar: Includes notes back to the start of the earliest selected bar.

● Previous bar: Includes notes back to the start of the previous bar.

● Previous notes: Includes a specified number of notes before the selection.

● Number of additional notes: Allows you to specify the number of additional notes 
you want to consider. Only available if you have activated Previous notes.

Additional context at end
Allows you to specify additional musical context after the selected notes that you want 
Dorico Pro to consider when calculating automatic note spellings.

● None: Only notes in the selection.

● To end of bar: Includes notes up to the end of the last selected bar.

● Next bar: Includes notes up to the end of the next bar.

● Following notes: Includes a specified number of notes after the selection.

● Number of additional notes: Allows you to specify the number of additional notes 
you want to consider. Only available if you have activated Following notes.

Prefer accidentals used most in this flow
Allows you to specify whether to choose accidentals based on how frequently they are 
used in the flow or the default accidental for the corresponding pitch delta. Useful in 
tonality systems that contain multiple accidentals with the same pitch delta.

Preserve accidentals on unchanged pitches
Allows you to specify whether existing accidentals on notes that are not respelled are 
retained or chosen according to your setting for Prefer accidentals used most in this 
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flow. Useful in tonality systems that contain multiple accidentals with the same pitch 
delta.

RELATED LINKS
Selecting notes/items on page 426
Respelling notes on page 484
Changing the pitch of individual notes on page 479
Inputting accidentals on page 244
Accidental selection during MIDI input on page 245
Tonality systems on page 1219
Custom tonality systems on page 902
Custom accidentals on page 907

Copying note spellings to other layouts
You can copy note spellings to other layouts; for example, if you originally respelled notes in a 
part layout but want those spellings to appear in the full score layout as well.

PROCEDURE

1. In Write mode, open the layout containing the note spellings you want to copy.

2. Select the notes you want to respell.

3. Choose Write > Respell > Propagate Note Spellings.

RESULT
The spellings of the selected notes in the current layout are copied to all other layouts in which 
those notes appear.

RELATED LINKS
Switching between layouts on page 46
Part formatting propagation on page 765

Resetting note spellings
You can reset changes to note spellings so they follow the spelling in score layouts; for example, 
if you want future revisions to note spellings you make in the full score layout to affect notes 
whose spelling you previously overrode in a part layout. You can do this in either one part layout 
only or in all layouts.

PROCEDURE

1. Optional: If you want to reset note spellings in one part layout only, open that layout in the 
music area.

2. In Write mode, select the notes whose spellings you want to reset.

3. Reset their note spellings in one of the following ways:

● Choose Write > Respell > Reset Note Spellings in Current Layout.

● Choose Write > Respell > Reset Note Spellings in All Layouts.

RESULT
The spellings of the selected notes are reset either in the current part layout only or in all layouts. 
Their link to the score note spelling is restored, meaning all future changes you make to the 
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spelling of the selected notes in score layouts also affect their spelling in either the current part 
layout or all layouts.

RELATED LINKS
Switching between layouts on page 46
Respelling notes on page 484
Transposing selections on page 480

Musical transformations
Dorico Pro provides multiple tools for transforming pitches and rhythms, including reversing and 
inverting pitches and rotating rhythms.

In Dorico Pro, the term “musical transformations” covers the following methods of changing the 
pitch and/or rhythm of notes:

Inversion
The melodic contours of phrases are switched upside-down by forcing pitch intervals 
between notes in the opposite direction, such as a note originally a fifth above the 
previous note becoming a fifth below the previous note.

Reversal
The order of notes, including pitches and/or rhythms, and items is reversed so they are 
played backwards; for example, the first note of a phrase becoming the last note. Also 
known as “retrograde”.

Rotation
Notes, including pitches and/or rhythms, and items are shifted along by a specified 
number of steps either forwards or backwards, so that, for example, the first note in a 
phrase’s original pitch is given to the second note, the second note’s pitch to the third 
note, and so on.

Repetition
The pitches of the specified number of notes at the start of a phrase is repeated across 
all subsequent notes in the selection.

Pitch mapping
Specified pitches are transposed to become other specified pitches, such as mapping 
all C♯s to D♭s.

Scale mapping
All notes in the specified source scale are transposed to become the equivalent notes 
in the destination scale according to their scale degree.

TIP

You can change the default behavior of musical transformations on the Musical 
Transformations page in Note Input Options. For example, you can set whether or not to 
allow transformations that would shorten the duration of the original selection.

RELATED LINKS
Arranging tools on page 459
Note tools popover on page 498
Note Input Options dialog on page 839
Adding notes above/below existing notes on page 258
Transposing existing notes with the note tools popover on page 482
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Inverting pitches
You can invert the pitches of selected notes, which switches the melodic contour of phrases 
upside-down by forcing pitch intervals between notes in the opposite direction, such as a 
note originally a fifth above the previous note becoming a fifth below the previous note. This 
transformation is also known as “inversion”.

PROCEDURE

1. In Write mode, select the notes you want to invert.

2. Do one of the following:

● To invert pitches only, choose Write > Transform > Pitches > Invert Pitches to open the 
Invert Pitches dialog.

● To invert and reverse pitches, choose Write > Transform > Pitches > Reverse and 
Invert Pitches to open the Reverse and Invert Pitches dialog.

● To invert and reverse pitches and reverse rhythms, choose Write > Transform > All > 
Reverse and Invert Pitches and Reverse Rhythms to open the Reverse and Invert 
Pitches and Reverse Rhythms dialog.

3. Change the settings as required for your inversion.

4. Click OK to save your changes and close the dialog.

RESULT
The selected notes are transformed according to your initial menu selection and your settings in 
the dialog.

TIP

● You can also invert pitches using the note tools popover.

● You can change the default behavior of inversions on the Musical Transformations page in 
Note Input Options.

RELATED LINKS
Reverse and Invert Pitches and Reverse Rhythms dialogs on page 490
Note tools popover on page 498
Note Input Options dialog on page 839
Large selections on page 428
Arranging tools on page 459
Inputting notes on page 221

Reversing pitches/rhythms
You can reverse notes, including pitches and/or rhythms, and staff-attached items so that 
selections are played backwards; for example, the first note of a phrase becomes the last note. 
This transformation is also known as “retrograde”.

PROCEDURE

1. In Write mode, select the notes and staff-attached items whose pitches and/or rhythms you 
want to reverse.

For example, to reverse dynamics alongside notes, include dynamics in your selection.

2. Do one of the following:

● To reverse pitches only, choose Write > Transform > Pitches > Reverse Pitches.
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● To reverse rhythms only, choose Write > Transform > Rhythm > Reverse Rhythms.

● To reverse pitches and rhythms, choose Write > Transform > All > Reverse Pitches and 
Rhythms.

● To reverse and invert pitches, choose Write > Transform > Pitches > Reverse and 
Invert Pitches to open the Reverse and Invert Pitches dialog.

● To reverse and invert pitches and reverse rhythms, choose Write > Transform > All > 
Reverse and Invert Pitches and Reverse Rhythms to open the Reverse and Invert 
Pitches and Reverse Rhythms dialog.

3. Optional: If you chose to reverse and invert pitches, change the settings as required for your 
inversion.

4. Click OK to save your changes and close the dialog.

RESULT
The selected notes and staff-attached items are transformed according to your initial menu 
selection and optionally your settings in the dialog.

TIP

You can also reverse pitches/rhythms using the note tools popover.

Reverse and Invert Pitches and Reverse Rhythms dialogs
The Invert Pitches, Reverse and Invert Pitches, and Reverse and Invert Pitches and Reverse 
Rhythms dialogs allow you to invert and reverse the pitches and reverse the rhythms of selected 
notes. These transformations are also known as “inversion” and “retrograde inversion”.

You can open these dialogs in Write mode when at least one note is selected in the music area in 
the following ways:

● To open the Invert Pitches dialog, choose Write > Transform > Pitches > Invert Pitches.

● To open the Reverse and Invert Pitches dialog, choose Write > Transform > Pitches > 
Reverse and Invert Pitches.

● To open the Reverse and Invert Pitches and Reverse Rhythms dialog, choose Write > 
Transform > All > Reverse and Invert Pitches and Reverse Rhythms.

The dialogs contain the following options:

Invert using
Allows you to change the inversion behavior.
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● Outermost pitches: Inverts pitches within the range of the highest and lowest 
notes in the selection.

● Specific pitch: Inverts pitches around the specified pitch.

● Root: Inverts pitches around the root of the prevailing key. In open keys or music 
without key signatures, C is used.

● First note: Inverts pitches around the first note in the selection.

Inversion type
Allows you to change how intervals are handled in the inversion.

● Diatonic: Inversions use the interval degree, according to the scale degrees in 
the prevailing key signature. Diatonic inversions preserve the interval relationship 
between pitches, which can result in, for example, a minor second interval below 
becoming a major second interval above.

● Chromatic: Inversions use the specified number of half-steps (semitones), 
regardless of the prevailing key signature.

Not available when Outermost pitches is chosen for Invert using.

Specific pitch
Allows you to specify the central pitch for inversion. You can select the note name, 
accidental, and octave. The available accidentals depend on the prevailing tonality 
system.

Only available when Specific pitch is chosen for Invert using.

When first note is a chord, use
Allows you to specify which pitch to use as the central pitch for inversion when the first 
note is part of a chord.

● Top note of chord: The highest note in the chord is used.

● Bottom note of chord: The lowest note in the chord is used.

Only available when First note is chosen for Invert using.

RELATED LINKS
Tonality systems on page 1219
Changing the tonality system on page 1220

Rotating pitches/rhythms
You can rotate notes, including pitches and/or rhythms, and staff-attached items by a specified 
number of steps either forwards or backwards, so that, for example, the first note in a phrase’s 
original pitch is given to the second note, the second note’s pitch to the third note, and so on.

PROCEDURE

1. In Write mode, select the notes and staff-attached items whose pitches and/or rhythms you 
want to rotate.

For example, to rotate dynamics alongside notes, include dynamics in your selection.

2. Do one of the following:

● To rotate pitches only, choose Write > Transform > Pitches > Rotate Pitches to open 
the Rotate Pitches dialog.

● To rotate rhythms only, choose Write > Transform > Rhythm > Rotate Rhythms to 
open the Rotate Rhythms dialog.
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● To rotate pitches and rhythms, choose Write > Transform > All > Rotate Pitches and 
Rhythms to open the Rotate Pitches and Rhythms dialog.

3. Change the settings as required for your rotation.

4. Click OK to save your changes and close the dialog.

RESULT
The selected notes and staff-attached items are rotated according to your settings in the dialog.

TIP

You can also rotate pitches/rhythms using the note tools popover.

RELATED LINKS
Note tools popover on page 498
Large selections on page 428
Arranging tools on page 459
Inputting notes on page 221

Rotate Pitches/Rhythms dialogs
The Rotate Pitches, Rotate Rhythms, and Rotate Pitches and Rhythms dialogs allow you to 
rotate the pitches and/or rhythms of selected notes.

You can open these dialogs in Write mode when at least one note is selected in the music area in 
the following ways:

● To open the Rotate Pitches dialog, choose Write > Transform > Pitches > Rotate Pitches.

● To open the Rotate Rhythms dialog, choose Write > Transform > Rhythm > Rotate 
Rhythms.

● To open the Rotate Pitches and Rhythms dialog, choose Write > Transform > All > Rotate 
Pitches and Rhythms.

The dialogs contain the following options:

Number of steps
Allows you to set the number of steps in the rotation.

Direction
Allows you to set the rotation direction.

● Forwards: Rotates forwards; that is, pitches/rhythms shift to the right.

● Backwards: Rotates backwards; that is, pitches/rhythms shift to the left.
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Repeating pitches across notes
You can repeat a specified number of pitches across all subsequent notes in the selection; for 
example, if you want to change the harmonic pattern for a passage.

PROCEDURE

1. In Write mode, make a selection that includes both of the following:

● The notes whose pitches you want to repeat

● The notes across which you want to repeat pitches

2. Choose Write > Transform > Pitches > Repeat Pitches to open the Repeat Pitches dialog.

3. Change the value in the value field.

4. Click OK to save your changes and close the dialog.

RESULT
The specified number of pitches at the start of the selection is repeated across the following 
notes in the selection.

TIP

You can also repeat pitches using the note tools popover.

Repeat Pitches dialog
The Repeat Pitches dialog allows you to set the number of pitches you want to repeat across all 
subsequent notes in the selection.

● You can open the Repeat Pitches dialog in Write mode when at least one note is selected in 
the music area by choosing Write > Transform > Pitches > Repeat Pitches.

The Repeat Pitches dialog contains the following option:

Number of pitches to repeat
Allows you to set the number of pitches you want to repeat across the selection, 
starting from the first selected note.

Mapping notes to pitches
You can map multiple source pitches to destination pitches in a single transformation; for 
example, if you want to transform all C♯s, F♯s, and A♯s into D♭s, G♭s, and B♭s.

PROCEDURE

1. In Write mode, select the notes whose pitches you want to map.

2. Choose Write > Transform > Pitches > Map Pitches to open the Map Pitches dialog.

3. Change the settings for Map pitch to specify the source pitch.
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4. Activate/Deactivate Include enharmonic equivalents.

5. Change the settings for To to specify the destination pitch.

6. Click Add mapping.

7. Optional: Repeat steps 3 to 6 for each pitch you want to map.

8. Click OK to save your changes and close the dialog.

RESULT
The specified source pitches are mapped to the specified destination pitches according to your 
settings.

TIP

You can also map pitches using the note tools popover.

RELATED LINKS
Note tools popover on page 498
Large selections on page 428
Respelling notes on page 484
Arranging tools on page 459
Inputting notes on page 221

Map Pitches dialog
The Map Pitches dialog allows you to set multiple pitch mappings in a single transformation; for 
example, if you want to transform all C♯s, F♯s, and A♯s into D♭s, G♭s, and B♭s.

● You can open the Map Pitches dialog in Write mode when at least one note is selected in the 
music area by choosing Write > Transform > Pitches > Map Pitches.

The Map Pitches dialog contains the following options:
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Map pitch
Allows you to specify the source pitch you want to map to the destination pitch. You 
can select a note name and accidental, and you can also optionally specify the octave. 
The available accidentals depend on the prevailing tonality system.

Include enharmonic equivalents
When activated, enharmonic equivalents to the specified source pitch are included in 
the mapping. For example, if you want to map A♯s and B♭s to Gs.

When deactivated, enharmonic equivalents to the specified source pitch are excluded 
from the mapping.

To
Allows you to specify the destination pitch to which you want to map the source pitch. 
You can select a note name and accidental. The available accidentals depend on the 
prevailing tonality system.

Transform
Allows you to specify the octave selection for the mapping.

● Up: Destination pitches are higher than the source pitch.

● Down: Destination pitches are lower than the source pitch.

● Closest: Destination pitches use the octave the smallest interval from the source 
pitch.

● Specific octave: Destination pitches use the octave specified in the value field.

Add mapping
Adds the set mapping to the mapping list.

Delete mapping
Removes the selected mapping from the mapping list.

Mapping list
Contains the set mappings for the transformation.

Mapping notes to scales
You can map all notes in a specified source scale to equivalent degrees of a destination scale; for 
example, if you want to transform a passage from major to minor with the same root.

PROCEDURE

1. In Write mode, select the notes whose pitches you want to map.

2. Choose Write > Transform > Pitches > Map Scale to open the Map Scale dialog.

3. Adjust the parameters required for your scale mapping, such as scale roots and scale 
patterns.

4. Click OK to save your changes and close the dialog.

RESULT
The specified pitches in the source scale are mapped to the specified pitches in the destination 
scale according to your settings.

TIP

● You can also map scales using the note tools popover.
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● You can change the default behavior of inversions on the Musical Transformations page in 
Note Input Options.

RELATED LINKS
Note tools popover on page 498
Note Input Options dialog on page 839
Large selections on page 428
Respelling notes on page 484
Arranging tools on page 459
Inputting notes on page 221

Map Scale dialog
The Map Scale dialog allows you to map all notes in the specified source scale to equivalent 
degrees of the destination scale; for example, if you want to transform a passage from major to 
minor with the same root.

● You can open the Map Scale dialog in Write mode when at least one note is selected in the 
music area by choosing Write > Transform > Pitches > Map Scale.

The Map Scale dialog contains the following options:

Use source root
When activated, allows you to specify the source scale root you want to map to 
the destination scale root. You can select a note name and accidental. The available 
accidentals depend on the prevailing tonality system.
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When deactivated, Dorico Pro uses the scale root implied by the prevailing key 
signature.

Use destination root
When activated, allows you to specify the destination scale root to which you want to 
map the source scale root. You can select a note name and accidental. The available 
accidentals depend on the prevailing tonality system.

When deactivated, Dorico Pro uses the scale root implied by the prevailing key 
signature.

Source scale pattern
Allows you to select the scale type of the source scale.

Destination scale pattern
Allows you to select the scale type of the destination scale.

Source scale overrides
Allows you to customize the source scale by specifying pitches that deviate from 
its preset pattern. Notes are mapped relative to the customized scale pattern. For 
example, if you add a sharp sixth source scale override when mapping C major to C 
harmonic minor, A♮s are treated as flattened sixths and become As.

● To specify flat scale degrees, enter b[n], such as b2.

● To specify sharp scale degrees, enter #[n], such as #6.

Destination scale overrides
Allows you to customize the destination scale by specifying pitches that deviate from 
its preset pattern. Notes are mapped relative to the customized scale pattern. For 
example, if you add a flattened second destination scale override when mapping C 
major to C harmonic minor, D♮s become D♭s.

● To specify flat scale degrees, enter b[n], such as b2.

● To specify sharp scale degrees, enter #[n], such as #6.

Direction
Allows you to specify the octave selection for the mapping.

● Closest: Destination pitches use the octave the smallest interval from the source 
pitch.

● Up: Destination pitches are higher than the source pitch.

● Down: Destination pitches are lower than the source pitch.

Snap all pitches to destination scale
When activated, all notes are snapped to the nearest pitch in the destination scale, 
including notes outside the source scale. When deactivated, only notes in the source 
scale are mapped to the destination scale.

Treat enharmonic equivalents as matching source scale
When activated, notes that are enharmonic equivalents to notes in the source scale are 
included in the mapping. When deactivated, only notes whose enharmonic spelling is 
in the source scale are mapped to the destination scale.

Respell enharmonic equivalents to fit destination scale
When activated, enharmonic equivalent notes included in the mapping are respelled 
to fit the destination scale. When deactivated, enharmonic equivalent notes are 
transposed according to the scale mapping without being respelled.
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Only available when Treat enharmonic equivalents as matching source scale is 
activated.

Keep relative offsets from source scale
When activated, Dorico Pro preserves the relative offsets between notes in the source 
scale. For example, if you map C major to D Aeolian, a B♭ would be mapped to C♭.
When deactivated, Dorico Pro changes the relative offsets between notes in the source 
scale if different intervals are more appropriate in the destination scale. For example, if 
you map C major to D Aeolian, a B♭ would be mapped to C♮.

Note tools popover
The note tools popover allows you to add notes above and below existing notes, transpose 
existing notes, and transform the pitches and rhythms of selected notes.

It makes much of the functionality provided by the Add Notes Above or Below, Transpose, 
Reverse and Invert Pitches/Rhythms, Rotate Pitches/Rhythms, Map Pitches, Map Scale, and 
Repeat Pitches dialogs accessible directly via the keyboard.

You can open the note tools popover in Write mode in any of the following ways when notes are 
selected, including during note input:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

● Choose Write > Add Intervals.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Note tools popover with an example entry
Note Tools button in the Notations toolbox

The following tables contain examples of what you can enter into the note tools popover to 
transform selections, transpose notes, or add notes above/below existing notes.

Intervals

Interval or quality Popover entry

Interval degree

Unison, second, third, fourth, fifth, and so on, 
up to two octaves

1, 2, 3, 4, 5, and so on, up to 15

Major M, maj, or major

Minor m, min, or minor

Perfect p, per, or perf

Diminished d, dim, or diminished
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Interval or quality Popover entry

Augmented a, aug, or augmented

Diatonic diat or diatonic

[n] octave divisions in any tonality system [n] d, [n] div, or [n] divisions

[n] half-steps (semitones) in 12-EDO [n] s, [n] st, [n] semi, or [n] semitones

[n] quarter tones in 24-EDO [n] q, [n] qt, or [n] quartertones

NOTE

● You must include an interval degree before a specified total number of octave divisions, such 
as 5 8 div. Together, they specify the desired note name and accidental.

● M and m entries for major and minor are case-sensitive.

Note additions

Type of addition Popover entry

Add notes a third above 3 or 3rd

Add notes a fourth below -4 or -4th

Add notes [n] octave divisions above, using the 
note name a fifth above

5 8 div in any tonality system

5 8 st in 12-EDO

5 16 qt in 24-EDO

Add notes [n] octave divisions below, using the 
note name a sixth below

-6 9 div in any tonality system

-6 9 st in 12-EDO

-6 18 qt in 24-EDO

Add chords containing multiple notes 3,6 or -3,3,4

Add notes only to the top notes in chords top

Add notes only to the bottom notes in chords bottom

NOTE

● When adding multiple notes, you must separate notes with commas, not spaces.

● If you do not specify the interval quality, the interval degree follows the prevailing key 
signature. For example, in C major, if you enter 3 to add a third above a D♮, the added note 
is an F♮. You can specify the interval quality by including it before the interval degree, such as 
maj3.
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EXAMPLE

● To add notes a major second below and minor third above the bottom notes in the selected 
chords, enter -M2,m3 bottom.

● To add G♯s above C♮s in 24-EDO, enter 5 16 qt.

Transposition

Example transposition Popover entry

Transpose notes upwards by a third t3

Transpose notes downwards by a sixth t-6

Transpose notes upwards by [n] octave 
divisions, using the note name a fifth above

t 5 8 div in any tonality system

t 5 8 st in 12-EDO

t 5 16 qt in 24-EDO

Transpose notes downwards by [n] octave 
divisions, using the note name a sixth below

t -6 9 div in any tonality system

t -6 9 st in 12-EDO

t -6 18 qt in 24-EDO

EXAMPLE
To transpose C♮ upwards by nine quarter tones in 24-EDO, you can enter t 3 9 qt for E or t 4 9 qt 
for F.

Inversion

Type of inversion Popover entry

Invert pitches within the range of the highest 
and lowest notes in the selection

inv, invert, inversion, or mirror

Specify the central pitch for inversion

For example, C4, E♭4, F5, G♯6, and so on

C4, eb4, F5, g#6, and so on

Specify the central octave division for inversion

For example, D4 or A5 in 24-EDO

d1/24 4 or A-3/24 5
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Type of inversion Popover entry

Specify root of prevailing key as central pitch 
for inversion

NOTE

In open keys or music without key signatures, 
C is used.

root

Specify first note as central pitch for inversion first

Specify top note in first chord as central pitch 
for inversion

top

Specify bottom note in first chord as central 
pitch for inversion

bottom

Diatonic inversion diatonic or diat

Chromatic inversion chromatic or chrom

EXAMPLE
To invert pitches around E♭4, enter inveb4.

Reversal

Type of reversal Popover entry

Reverse the selection, including pitches and 
rhythms

retrograde, ret, reverse, or rev

Specify pitches only pitch or pt

Specify rhythms only rhythm or rm

Reverse and invert pitches

TIP

You can also include additional specifications 
for the inversion.

ret invert, rev inv, and so on

Include additional items belonging to the 
same player as the selection

player

Include only items belonging to the same voice 
as the selection

voice
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EXAMPLE
To reverse the pitches and items in the selected voice only, enter rev pt voice.

Rotation

Type of rotation Popover entry

Rotate the selection, including pitches and 
rhythms

rotate or rot

Specify pitches only pitch or pit

Specify rhythms only rhythm, rhy, or rm

Specify number of steps forwards 1, 2, 3, 4, and so on

Specify number of steps backwards -1, backwards 2, bw 3, prev 4, and so on

EXAMPLE
To rotate only the rhythms of the selected notes backwards three steps, enter rot rm bw 3.

Repetition

Type of repetition Popover entry

Repeat the first two pitches in the selection 
across the selection

repeat 2 pitches

Repeat the first eight pitches in the selection 
across the selection

repeat 8 pitches

This list is not comprehensive as you can repeat any number of pitches. It is intended to illustrate 
how you can structure your entry.
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Pitch mapping

Type of pitch mapping Popover entry

Specify source and destination pitches

For example, to map C4 to E♭4, F4 to G4, and 
A4 to B♭4.

NOTE

● Separate source and destination pitches 
with equals signs, and pairs of pitches with 
commas.

● The octave number is optional.

c4=eb4,f4=g4,a4=bb5

Include enharmonic equivalents of specified 
notes

* after note name and octave, if specified

Specify that destination pitch is higher than 
source pitch

up

Specify that destination pitch is lower than 
source pitch

down

EXAMPLE
To map A♯s and enharmonic equivalents, including B♭s, to the G below, enter a#*=Gdown.

Scale mapping

Type of scale mapping or scale Popover entry

Scale mapping structure [source scale] to [destination scale], such as 
c M to c m or Fmin to Dmaj

Snap pitches outside the source scale to the 
nearest pitch by interval in the destination 
scale

snap

Specify snapped pitches should be raised up or higher

Specify snapped pitches should be lowered down or lower

Respell notes to the specified scale spell [scale], such as spell Cmaj

Snap notes to the specified scale snap [scale], such as snap cmin

Scale roots c, Db, e, f#, g, and so on
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Type of scale mapping or scale Popover entry

Alterations #4, b6, and so on

Major maj or M

Minor min or m

Ionian major ion maj or ion M

Harmonic minor harm m or hmc min

Melodic minor (ascending) me m or mdc min

Dorian dor or drn

Phrygian phryg, phry, or phr

Lydian lyd

Mixolydian mixlyd, mlyd, mixo, mix, or ml

Aeolian or natural minor aeol m, aeo m, aln min, or nat min

Locrian loc

Super Locrian (altered scale) super loc, sup loc, or spr loc

Major pentatonic pent maj, 5tonic M, or 5ton M

Minor pentatonic pent min, 5tonic m, 5ton m

Major blues blue maj or bls M

Minor blues blue min or bls m

Whole tone wholetone, whole-tone, wtone, wton, whole, 
or wt

Half-whole diminished half whole dimin, halfwhole dimin, hw dim, 
half-tone dimin, half tone dimin, halftone 
dimin, htone dim, hton dim, half dim, or ht 
dim

Half-whole octatonic half whole octa, halfwhole octa, hw oct, 
half-tone octa, half tone octa, halftone octa, 
htone oct, hton oct, half oct, or ht oct
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Type of scale mapping or scale Popover entry

Whole-half diminished whole half dimin, wholehalf dimin, wh 
dim, whole tone dimin, whole-tone dimin, 
wholetone dimin, wtone dim, wton dim, 
whole dim, or wt dim

Whole-half octatonic whole half octa, wholehalf octa, wh 
oct, whole tone octa, whole-tone octa, 
wholetone octa, wtone oct, wton oct, whole 
oct, or wt oct

Locrian 7 or harmonic major mode 7 loc maj mode7 or harm M mod7

Super locrian 7 or harmonic minor mode 7 sup loc min mode7 or spr loc m mod7

NOTE

● You can use scale type entries in any combination, such as me min, me m, mdc min, and 
mdc m.

● M and m entries for major and minor are case-sensitive.

● You must separate roots from M and m with a space, such as c M.

EXAMPLE
To respell all F♭s in a selection as E♮s, and snap A♭s to A♮s, enter spell snap Cmaj.

RELATED LINKS
Notations toolbox on page 202
Large selections on page 428
Equal Division of the Octave (EDO) on page 1219
Adding notes above/below existing notes on page 258
Transposing existing notes with the note tools popover on page 482
Inverting pitches on page 489
Reversing pitches/rhythms on page 489
Reverse and Invert Pitches and Reverse Rhythms dialogs on page 490
Rotating pitches/rhythms on page 491
Rotate Pitches/Rhythms dialogs on page 492
Mapping notes to pitches on page 493
Map Pitches dialog on page 494
Mapping notes to scales on page 495
Map Scale dialog on page 496
Repeating pitches across notes on page 493
Arranging tools on page 459
Inputting notes on page 221
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Splitting flows
You can split flows at specific rhythmic positions. For example, if you want the music from a 
specific bar onwards to be a new flow, separate from the preceding music.

PROCEDURE

1. In Write mode, select a note or item at the position where you want to split the flow.

2. Choose Write > Split Flow.

RESULT
The flow is split into two flows: the existing flow, and a new flow that begins from the position 
of the item you selected. By default, new flows in full score layouts start on a new page in page 
view, and are shown on a separate background in galley view.

AFTER COMPLETING THIS TASK
You can set options for each flow independently in the Notation Options dialog.

RELATED LINKS
Flows on page 166
Adding flows on page 166
Duplicating flows on page 167
Deleting flows on page 169
Notation Options dialog on page 837
Deleting empty bars/beats at the end of flows on page 964
Allowing/Disallowing multiple flows on the same page on page 706
Switching between layouts on page 46
Switching to galley/page view on page 53

Comments
Comments allow you to add notes or instructions at precise positions in your project without 
affecting the music. They are considered annotations in Dorico Pro, meaning they are not printed 
by default.

Comments exist outside of the music, so they do not affect note spacing, vertical spacing, or 
casting off. However, you can attach them to specific items and staves in order to show the 
precise subject of each comment.

A passage with comments and replies

By default, comments are shown in the music area. They appear as speech bubble symbols as 
close as possible to their attached position. Comments that are replies are stacked vertically 
below the original comment.
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All comments in the current layout are listed in the Comments panel in Write mode. Clicking a 
comment, either in the Comments panel or in the music area, automatically moves the view to 
bring that rhythmic position into focus.

In addition to its content, each comment identifies the following:

● Author of the comment, using either the current user account name or a custom name

On macOS, the user account name uses the long account name; on Windows, it uses the 
full name associated with the account. If Dorico Pro cannot determine your account name, a 
dialog appears into which you can add the name and initials you want to use for comments. 
You can also change these in Preferences.

● Date the comment was added

● Instrument to which the comment applies

● Bars to which the comment applies

NOTE

In the music area, only the initials of the author are shown. In the Comments panel, all 
information is shown.

You can hide/show comments at any time, and you can choose to include them, alongside other 
view options, when printing/exporting layouts.

RELATED LINKS
Deleting notes/items on page 459
Changing the author name used for comments on page 511
Annotations on page 687

Comment dialog
The Comment dialog allows you to enter and edit text as comments.

● You can open the Comment dialog by adding a comment, replying to a comment, or double-
clicking an existing comment, either in the music area or in the Comments panel.

Comments panel
The Comments panel shows all the comments in the current layout as a list. Replies to comments 
are indented to indicate their relationship to the original comment. The Comments panel is 
located in the right zone in Write mode.

● You can hide/show the Comments panel by clicking Panels , then Comments  in the 
Notations toolbox.

Write mode
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You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

Comments panel

Each comment in the panel shows the following:

1 Author name: This uses either the current user account or a custom name, depending on 
the preference that was set when the comment was added.

2 Comment content

3 Date the comment was added to the project

4 Instrument to which the comment applies

5 Bars to which the comment applies

The action bar at the bottom of the panel contains the following options:

Create Comment

Adds a comment to the selected rhythmic position and staff.

Edit Comment
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Opens the selected comment in the Comment dialog and allows you to change its 
content.

Reply to Comment

Adds a comment that is a reply to the selected comment. Replies are shown indented 
in the Comments panel and stacked in the music area.

Export Comments

Exports all the comments in the project as an HTML file, which opens automatically in 
your default web browser. The HTML file is automatically saved in the same location as 
the project.

Delete Comment

Deletes the selected comments.

RELATED LINKS
Notations toolbox on page 202
Changing the author name used for comments on page 511
Exporting comments on page 511

Adding comments
You can add comments at any rhythmic position in your project, including adding different 
comments to multiple staves at the same rhythmic position.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
add a comment. If you want your comment to apply to a range, select multiple items.

2. Press Alt/Opt-C  to open the Comment dialog.

3. Enter your comment into the dialog.

4. Click OK to close the dialog and add the comment.

RESULT
The text you entered into the dialog is saved as a comment. In the music area, it is indicated by a 
speech bubble symbol that contains your initials. In the Comments panel, the text you entered is 
shown alongside your full username, the date, and the instrument and bar number to which you 
added the comment.

TIP

You can also add comments by clicking Create Comment  in the Comments panel, or by 
choosing Write > Create Comment.
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EXAMPLE

A comment in the music area

Replying to comments
You can add replies to existing comments, which is useful when co-ordinating with others as this 
organizes the list of comments in the Comments panel into clear sections.

PROCEDURE

1. In Write mode, select the comment to which you want to reply. You can do this in the music 
area and in the Comments panel.

2. Press Alt/Opt-R  to open the Comment dialog.

3. Enter your reply into the dialog.

4. Click OK to close the dialog and add the reply.

RESULT
The text you entered into the dialog is saved as a reply to the selected comment. In the music 
area, it is indicated by a speech bubble symbol that contains your initials and is positioned 
immediately below the selected comment.

In the Comments panel, the reply is indented below the selected comment.

TIP

You can also reply to comments by clicking Reply to Comment  in the Comments panel, or by 
choosing Write > Reply to Comment.

EXAMPLE

A reply to a comment
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Editing existing comments
You can change the contents of existing comments after you have added them; for example, to 
correct misspellings or add further information.

PROCEDURE

1. Double-click the comment you want to edit to open the Comment dialog. You can do this in 
the music area and in the Comments panel.

2. Change the text in the dialog.

3. Click OK to save your changes and close the dialog.

Changing the author name used for comments
You can change the author name used for comments to either your user account name or a 
custom name. This affects subsequent comments you add to the project without changing the 
author name used for existing comments.

For the custom name, you can specify both the full name that is shown in the Comments panel 
and the initials shown in the music area.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Comments subsection, choose one of the following options for Author name for 
comments:

● User Name

● Custom Name

4. Optional: If you chose Custom Name, enter the full name you want to use into the Full 
name field.

5. Optional: If you chose Custom Name, enter the initials you want to use into the Initials 
field.

6. Click Apply, then Close.

Exporting comments
You can export all comments from all flows in the layout currently open in the music area to an 
HTML file. For example, if you want to view them all in a single place.

PROCEDURE

1. In Write mode, open the layout whose comments you want to export.

2. In the Notations toolbox, click Panels , then Comments  to show the Comments panel.

3. In the Comments section action bar, click Export Comments .

RESULT
All comments in the layout currently open in the music area are saved as an HTML file, which 
opens automatically in your default web browser. The comments are displayed in a table.
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The HTML file is automatically saved in the same location as the project. Its file name includes the 
layout name.

RELATED LINKS
Switching between layouts on page 46
Annotations on page 687
Printing layouts on page 671
Exporting layouts as graphics files on page 675
Exporting lyrics on page 1227

Hiding/Showing comments
You can hide/show comments at their positions in the music; for example, if you want to hide 
them when inputting music but show them when engraving.

Comments are considered annotations in Dorico Pro, meaning they are not printed by default.

PROCEDURE

● Choose View > Comments.

RESULT
Comments are hidden/shown. When shown, comments appear in the music as speech bubbles.
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Engrave mode

Engrave mode allows you to manipulate and modify every item in your project, but without 
deleting them, moving them rhythmically, or changing the pitch of notes. You can also determine 
how the pages in each layout of your project are formatted for printing or exporting.

Project window in Engrave mode
The project window in Engrave mode contains a toolbox and panels with all the tools and 
functions that allow you to format the pages, systems, and properties of individual notations in 
your score.

You can switch to Engrave mode in any of the following ways:

● Press Ctrl/Cmd-3 .

● In the toolbar, click Engrave.

● Choose Window > Engrave.

The project window in Engrave mode contains the following:

1 Engrave toolbox

Contains options that allow you to determine which panels are shown in the left zone, and to 
activate Note Spacing  and Staff Spacing .

2 Left zone

Can display different panels, according to the current selection in the Engrave toolbox. 
Panels in the left zone contain formatting options that allow you to control how music is 
arranged into systems and frames, to insert frames, and edit frame constraints.

The left zone is hidden automatically when either Note Spacing  or Staff Spacing  is 
activated in the Engrave toolbox.

513
Dorico Pro 4.3.30



3 Music area

Displays layouts in page view. Additional engraving aids are shown on pages, according to 
the current selection in the Engrave toolbox.

● Frame outlines are always shown, except when Graphic Slices  is selected.

● System and frame fullness indicators are shown when either Graphic Editing , Staff 
Spacing , or Note Spacing  is selected.

● When Frames  is selected, frames are shown in full, including music frame selectors.

● When Staff Spacing  is selected, staff/system spacing handles, gap measurements, 
and music frame margin highlights are shown.

● When Note Spacing  is selected, note spacing handles, system handles, and dashed 
lines that represent spacing columns are shown.

● When Graphic Slices  is selected, graphic slices are shown and all other engraving 
aids are hidden.

4 Pages panel

Allows you to control how pages are formatted, such as by adding and customizing page 
templates and flow headings.

5 Lower zone

Can display either the Properties panel or Mixer panel, according to the current selection in 
the lower zone toolbar.

RELATED LINKS
Project window on page 32
Music area on page 37
Properties panel on page 769
Mixer panel on page 821
Frames on page 560
Music frame selectors on page 570
Graphic slices on page 592
System fullness indicators on page 526
Frame fullness indicators on page 526
Moving individual staves/systems vertically on page 723
Adjusting note spacing at individual rhythmic positions on page 604
Hiding/Showing crosshairs on page 612

Engrave toolbox
The Engrave toolbox allows you to change the panel shown in the left zone and to activate note 
and staff spacing. The Engrave toolbox is located on the left of the window in Engrave mode.

Show Left Zone

Hides/Shows the left zone.

Graphic Editing

Allows you to select and edit items in the music area or page template editor. Shows 
the Formatting panel in the left zone, which contains options for formatting systems, 
frames, brackets, braces, and barline joins.

Engrave mode
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Frames

Allows you to select and edit frames in the music area or page template editor. Shows 
the Frames panel in the left zone, which allows you to insert frames and edit their 
constraints.

Staff Spacing

Allows you to move individual staves and systems vertically.

Note Spacing

Allows you to edit the graphical horizontal positions of individual notes and other 
items, such as clefs and key signatures.

Graphic Slices

Shows the Graphic Slices panel in the left zone, which allows you to view, create, and 
export graphic slices, and change their graphics file format, color mode, resolution, 
and export path.

TIP

By default when you switch to Engrave mode, Dorico Pro remembers the tool you last selected. 
You can choose always to select Graphic Editing  when you switch to Engrave mode instead on 
the General page in Preferences.

RELATED LINKS
Frames panel on page 519
Graphic Slices panel on page 520
Frames on page 560
Frame constraints on page 590
Staff spacing on page 720
Note spacing on page 599
Graphic slices on page 592
Moving items graphically on page 609
Hiding/Showing zones on page 47
Preferences dialog on page 61

Left zone (Engrave mode)
The left zone in Engrave mode can display different panels, according to the current selection in 
the Engrave toolbox. Panels in the left zone contain formatting options that allow you to control 
how music is arranged into systems and frames, to insert frames, and edit frame constraints.

You can hide/show the left zone in any of the following ways:

● Press Ctrl/Cmd-7 .

● In the toolbox on the left, click Show Left Zone .

● Choose Window > Show Left Zone.

The left zone can display the following panels in Engrave mode:

Engrave mode
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Formatting
Shown when Graphic Editing  is selected in the Engrave toolbox.

Frames
Shown when Frames  is selected in the Engrave toolbox.

Graphic Slices
Shown when Graphic Slices  is selected in the Engrave toolbox.

RELATED LINKS
Frames panel on page 519
Graphic Slices panel on page 520
Hiding/Showing zones on page 47

Formatting panel
The Formatting panel allows you to change how systems and frames are formatted on pages, 
including inserting system/frame breaks and manually adding brackets and braces. It is located 
in the left zone in Engrave mode.

● You can show the Formatting panel by showing the left zone, then clicking Graphic Editing 
 in the Engrave toolbox.

The Formatting panel contains the following sections:

Moving Bars Between Systems

The Moving Bars Between Systems allows you to move selected bars to other systems.

Move to Previous System

Moves the selected bars to the previous system. Inserts system breaks at the start and 
end of the system to which the bars were moved.

You can also move bars to the previous system by pressing , .

Move to Next System

Moves the selected bars to the next system. Inserts system breaks at the start and end 
of the system to which the bars were moved.

You can also move bars to the next system by pressing . .

Format Systems

The Format Systems section allows you to change how the music in the layout currently open in 
the music area is arranged into systems.

Insert System Break

Forces music from the selected item onwards onto the next system. Depending on 
your staff size and other settings, this may mean the music is forced onto the next 
page.

You can insert system breaks by pressing Shift-F .

Engrave mode
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Lock System

Fixes the formatting of the selected systems, even if you change the formatting of 
surrounding musical material and other systems.

Make into System

Forces all music between the selected items into the same system.

Format Music Frames

The Format Music Frames section allows you to change how the music in the layout currently 
open in the music area is arranged into frames.

Insert Frame Break

Forces music from the selected item onwards onto the next frame, which is often on 
the next page. This allows you to control what music appears on each page.

You can insert frame breaks by pressing Shift-F .

Lock Frame

Fixes the formatting of the selected frames, even if you change the formatting of 
surrounding frames.

Make into Frame

Forces all music between the selected items into the same frame. You can use this 
option to force music onto a single page.

Lock Layout

The Lock Layout section allows you to fix and reset all systems and pages in the current layout.

Lock Layout

Inserts system and frame breaks on all systems in the current layout as required to fix 
its current casting off.

Reset Layout

Removes all system and frame breaks from the current layout.

Bracketing

The Bracketing section allows you to change how the staves in the layout currently open in the 
music area are bracketed and braced together, and change which staves are joined by barlines.

Engrave mode
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Insert bracket

Joins the staves on which you have selected items with a bracket. By default, this also 
causes barlines to be drawn across the bracketed group.

Insert sub-bracket

Joins the staves on which you have selected items with a sub-bracket.

NOTE

The selected staves must be within a bracket.

Insert sub-sub-bracket

Joins the staves on which you have selected items with a sub-sub-bracket.

NOTE

The selected staves must be within a bracket and sub-bracket.

Insert brace

Joins the staves on which you have selected items with a brace.

NOTE

Staves cannot be joined by both a brace and a sub-bracket or sub-sub-bracket 
simultaneously.

Change barline joins

Joins the barlines across the staves on which you have selected items.

Engrave mode
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RELATED LINKS
Hiding/Showing zones on page 47
Project window in Engrave mode on page 513
Brackets and braces on page 1023
Custom staff grouping on page 1030
Inputting custom bracket/brace groups on page 1032
Inputting custom barline joins on page 978
Frame breaks on page 736
System breaks on page 733
Page templates on page 527
Page formatting on page 689
Casting off on page 728

Frames panel
The Frames panel allows you to insert different types of frames onto pages and edit their 
constraints. It is located in the left zone in Engrave mode.

● You can show the Frames panel by showing the left zone, then clicking Frames  in the 
Engrave toolbox.

The Frames panel contains the following sections:

Insert Frames

The Insert Frames section allows you to create new frames on pages in layouts as well as on 
page templates.

Insert Music Frame

Allows you to insert a music frame. On pages in layouts, this inserts a music frame that 
belongs to a layout frame chain. On page templates in the page template editor, this 
inserts a frame that belongs to a page template frame chain.

Insert Text Frame

Allows you to insert a frame into which you can enter text and tokens.

Insert Graphics Frame

Allows you to insert a frame that can contain an image or an illustration.

Constraints

The Constraints section allows you to specify which sides of frames you want to lock to the 
corresponding page margins. Locked frame constraints retain their positions relative to the 
corresponding page margin, even if the page size, orientation, and/or page margins change.

Engrave mode
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The Constraints section of the Frames panel, showing the constraints of a header frame

RELATED LINKS
Hiding/Showing zones on page 47
Engrave toolbox on page 514
Frames on page 560
Frame constraints on page 590
Music frames on page 568
Music frame chains on page 569
Text frames on page 575
Graphics frames on page 589
Page templates on page 527

Graphic Slices panel
The Graphic Slices panel allows you to create graphic slices, export them, and change their 
graphics file format, color mode, resolution, and export path. It is located in the left zone in 
Engrave mode.

● You can show the Graphic Slices panel by showing the left zone, then clicking Graphic Slices 
 in the Engrave toolbox.

Engrave mode
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The Graphic Slices panel contains the following:

1 Create Slice

Allows you to draw a graphic slice.

2 Graphic slices table

Contains all the graphic slices in the current flow. The table contains the following columns:

● Slice name: Displays the current name for the corresponding graphic slice, which is 
used for its file name when exported. Allows you to enter a new name or edit the 
existing name.

● Page: Displays the page number in the layout on which the corresponding graphic slice 
exists.

The action bar at the bottom of the table contains the following options:

● Rename Graphic Slice : Allows you to rename the selected graphic slice.

● Delete Graphic Slice : Deletes the selected graphic slice.

3 Image settings

Engrave mode
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Allow you to change the graphics file format, color mode, and image resolution of the 
selected graphic slices.

4 Destination folder field

Displays the export path where exported graphic slices will be saved. By default, this is the 
same folder as the Dorico project. If you change the export path, subsequent graphic slices 
you create use your most recently specified export path.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

6 Export All/Export Selected

Allows you to export either all graphic slices when no graphic slice is selected or only the 
currently selected graphic slices, each using their current export settings.

RELATED LINKS
Engrave toolbox on page 514
Graphic slices on page 592
Creating graphic slices on page 593
Renaming graphic slices on page 596
Changing the image settings for graphic slices on page 596
Exporting graphic slices on page 598
Deleting graphic slices on page 598
Graphics file formats on page 685
Monochrome and color graphics processing on page 686
Image resolution on page 685
File import and export on page 82

Pages panel
The Pages panel in Engrave mode allows you to control how pages are formatted, such as by 
adding and customizing page templates and flow headings. It is located in the right zone in 
Engrave mode.

You can hide/show the Pages panel in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Zone.

The Pages panel contains the following sections:

Pages
Shows the pages in the layout open in the music with their page number in the middle. 
Selected pages appear with highlighted borders. Markings in page corners or on page 
edges indicate page format changes.
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The action bar at the bottom of the section contains the following options:

● Insert Pages : Allows you to insert pages before/after specified pages. Inserted 
pages can be empty or can use a page template as a starting point.

● Insert Page Number Change : Allows you to change page numbers from the 
selected page onwards.

● Insert Page Template Change : Allows you to assign a different page template 
to the selected page or from the selected page onwards.

● Insert Flow Heading Change : Allows you to assign a different flow heading to 
the selected page or from the selected page onwards.

● Swap with Previous Page : Swaps all page format changes on the selected 
pages with the previous pages.

● Swap with Next Page : Swaps all page format changes on the selected pages 
with the next pages.

● Remove Overrides : Removes page template overrides from the selected pages.

Page Templates
Shows the page templates contained in the page template set applied to the layout 
open in the music area. Selected page templates appear with highlighted borders. 
When you select a page in the Pages section, the page template used for that page 
appears highlighted in the Page Templates section.

The Current set menu allows you to view and change the page template set applied to 
the layout open in the music area.
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The action bar at the bottom of the section contains the following options:

● New Page Template : Allows you to add a new page template to the current 
page template set.

● Edit Page Template : Opens the page template editor in which you can change 
the formatting of the selected page template. You can also open the page 
template editor by double-clicking a page template in the Page Templates section.

● Rename Page Template : Allows you to rename the selected page template.

● Import Page Template : Allows you to import individual page templates from 
any of the other page template sets in the project.

● Delete Page Template : Deletes the selected page template from the page 
template set.

Flow Headings
Shows the flow headings available in the page template set applied to the layout open 
in the music area. Selected flow headings appear with highlighted borders.
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The action bar at the bottom of the section contains the following options:

● New Flow Heading : Allows you to add a new flow heading to the current page 
template set.

● Edit Flow Heading : Opens the flow heading editor in which you can change the 
formatting of the selected flow heading. You can also open the flow heading editor 
by double-clicking a flow heading in the Flow Headings section.

● Rename Flow Heading : Allows you to rename the selected flow heading.

● Delete Flow Heading : Deletes the selected flow heading from the page 
template set.

Page Template Sets
Contains a list of available page template sets in the project.

The action bar at the bottom of the section contains the following options:

● New Page Template Set : Creates a new page template set based on the page 
template set selected in the list. New page template sets are also automatically 
added to the Current set menu in the Page Templates section.

● Rename Page Template Set : Allows you to rename the selected page template 
set.

● Import Page Template Set : Opens the File Explorer/macOS Finder, where you 
can select the page template set .doricolib file that you want to import into the 
project.

● Export Page Template Set : Opens the File Explorer/macOS Finder, where you 
can select the location to which you want to export the selected page template set 
as a .doricolib file. You can then import the .doricolib file into other projects 
and share it with other users.

● Delete Page Template Set : Deletes the selected page template set from the 
project.

RELATED LINKS
Project window in Engrave mode on page 513
Page templates on page 527
Page template sets on page 529
Page template editor on page 540
Flow headings on page 554
Flow heading editor on page 555
Copying frames on page 566
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Page format changes on page 542

System fullness indicators
System fullness indicators are highlighted regions that are shown to the right of systems in 
Engrave mode when either Graphic Editing , Staff Spacing , or Note Spacing  is selected 
in the Engrave toolbox. They use colors and percentages to indicate the horizontal fullness of the 
corresponding system.

The following colors are used in the system fullness indicator:

● Green: the system is comfortably full. Notes have enough horizontal space to be legible but 
are not too far apart. Systems that are 60-100% full are considered comfortably full.

● Purple: the system is under-full, meaning notes might appear overly stretched. Systems that 
are less than 60% full are considered under-full.

● Red: the system is over-full, meaning notes might appear squashed with not enough 
horizontal space between them. Systems that are more than 100% full are considered over-
full.

The fullness of systems is also expressed using a percentage. The percentage indicated is 
calculated by dividing the number of spaces occupied in the system by the total number of 
available spaces in the system, which is measured from the start of the rhythmic space to the 
right of the initial clef/time signature/key signature up to the final barline in the system.

Both the color of the system fullness indicator and the fullness percentage are updated in real 
time as you adjust note spacing in the system.

System comfortably full System under-full System over-full

RELATED LINKS
Project window in Engrave mode on page 513
Frame fullness indicators on page 526
Margins on page 712

Frame fullness indicators
Frame fullness indicators are highlighted regions that are shown outside the bottom right 
corners of music frames in Engrave mode when either Graphic Editing , Staff Spacing , or 
Note Spacing  is selected in the Engrave toolbox. They use colors and percentages to indicate 
the vertical fullness of the corresponding music frame, which in most cases represents a full 
page.

The following colors are used in the frame fullness indicator:

● Green: the frame is comfortably full. Staves and systems have enough vertical space to be 
legible but are not too far apart. Frames that are 60-100% full are considered comfortably 
full.

● Red: the frame is over-full, meaning staves and systems might appear squashed with not 
enough vertical space between them. Frames that are more than 100% full are considered 
over-full.
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The fullness of frames is also expressed using a percentage. The percentage indicated is 
calculated by dividing the number of spaces occupied in the frame by the total number of 
available spaces in the frame, which is measured using the vertical distance between the top and 
bottom music frame padding margins.

Frame comfortably full Frame over-full

RELATED LINKS
Engrave toolbox on page 514
Per-layout vertical spacing options on page 721
Changing the default staff/system spacing on page 694
Changing the vertical justification of staves/systems on page 695
Project window in Engrave mode on page 513
System fullness indicators on page 526
Margins on page 712

Page templates
Page templates in Dorico Pro allow you to achieve consistent page formatting by applying the 
same arrangements of frames to multiple pages and in different layouts.

NOTE

You can set the page size, margins, page orientation, and staff size for each layout in Layout 
Options.

All pages in your scores and parts inherit their default formatting from page templates. 
Whenever you change anything on page templates, such as inserting new frames, this is 
automatically reflected on all pages that use these page templates, provided those pages do 
not have page template overrides.

In Dorico Pro, each page template consists of a page pair: one left page and one right page. 
Pages that fall on the left, typically even-numbered pages, use the formatting of the left page 
in the page template; pages that fall on the right, typically odd-numbered pages, use the 
formatting of the right page in the page template. In both the Page Templates section of 
the Pages panel and the page template editor, page pairs in the same page template appear 
side-by-side.

Dorico Pro provides different types of page templates so that there is appropriate page 
formatting for first pages independently of subsequent pages, as the first page typically includes 
additional information, such as the title, composer, and copyright. Dorico Pro uses tokens to 
display this additional information.

Page templates are contained in page template sets. By default, Dorico Pro provides separate 
page template sets for full score and part layouts. Page template sets are automatically applied 
to every layout that you create.
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The Page Templates section of the Pages panel in Engrave mode, showing the First and Default page 
templates in the Default Full Score page template set.

You can customize the default page templates in the page template editor as required for the 
current project. You can also create new, custom page templates in each page template set. For 
example, for title pages and performance instructions.

NOTE

Changing individual pages in layouts is considered a page template override in Dorico Pro, which 
is a type of page format change. This includes, for example, editing the title or running header 
on one page, rather than in the page template editor. Pages with page template overrides no 
longer get updated if you edit the page template and are not automatically deleted, even if they 
are empty because the layout became shorter.

RELATED LINKS
Pages panel on page 522
Types of page templates on page 532
Page template editor on page 540
Page format changes on page 542
Removing page template overrides on page 545
Layout Options dialog on page 834
Flow headings on page 554
Project Info dialog on page 78
Tokens on page 576
Assigning page templates to pages on page 549
Applying page template sets to layouts on page 692
Creating page templates on page 535
Customizing page templates on page 541
Importing page templates on page 537
Page formatting on page 689
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Project templates on page 80

Page template sets
In Dorico Pro, page templates are provided as parts of page template sets. Page template sets 
group page templates and flow headings together, so there is suitable page formatting available 
for all possible situations in your project.

New projects contain the following page template sets by default:

● Default Full Score: Used for full score and custom score layouts by default.

● Default Part: Used for part layouts by default.

The default page template sets contain page templates for first (First) and subsequent (Default) 
pages. Each page template set can contain a single First, a single Default, and multiple Custom 
page templates. They must contain at least a Default page template.

Page template sets also contain flow headings that allow you to show flow titles above the start 
of each flow automatically, including when they start on the same page as a previous flow. The 
default page template sets each contain a single flow heading. You can customize the default 
flow headings and add new ones. Each page template set can contain a single Default and 
multiple Custom flow headings. They must contain at least a Default flow heading.

The default page template sets are applied automatically to the appropriate layouts in each new 
project. You can apply different page template sets to each layout independently. You can also 
create new page template sets and customize their page templates, and edit the default page 
template sets as required for the current project.

TIP

You can share page templates between page template sets by importing page templates. For 
example, if you created a new title page template in the Default Full Score page template set, 
you can then import it into the Default Part page template set to use it in part layouts as well.

You can also share page template sets between different projects by exporting and importing 
them.

RELATED LINKS
Types of page templates on page 532
Flow headings on page 554
Importing page template sets on page 530
Exporting page template sets on page 531
Importing page templates on page 537
Applying page template sets to layouts on page 692

Creating page template sets
You can create new page template sets by duplicating any existing page template set in the 
project.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In the Page Template Sets section of the Pages panel, click the page template set you want 
to duplicate.

Engrave mode
Page templates 

529
Dorico Pro 4.3.30



2. In the action bar, click New Page Template Set .

RESULT
A new page template set that is a duplicate of the selected page template set is created. It 
appears immediately in the list of page template sets.

AFTER COMPLETING THIS TASK

● You can rename the page template set and add new page templates to it.

● You can apply the page template set to layouts.

● You can export the page template set if you want to use it in other projects.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Creating page templates on page 535
Applying page template sets to layouts on page 692
Exporting page template sets on page 531

Importing page template sets
You can import page template sets into projects; for example, if you want to use a page template 
set you created on a different computer or that contains a specific page template you want to 
use. Page template sets are saved as .doricolib files.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In the Pages panel, click Import Page Template Set  in the Page Template Sets action 
bar to open the File Explorer/macOS Finder.

2. Locate and select the page template set file you want to import.

3. Click Open.

RESULT
The selected page template set is imported, including all page templates and flow headings 
included in the page template set. It becomes available in the current project only.

AFTER COMPLETING THIS TASK

● You can import individual page templates from the page template set into other page 
template sets in your project.

● You can apply the page template set to layouts.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Applying page template sets to layouts on page 692
Importing page templates on page 537
Assigning page templates to pages on page 549
Types of page templates on page 532
Flow headings on page 554
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Exporting page template sets
You can export page template sets so you can send them to other users or use them in other 
projects. By default, any page template sets you create or edit are available in the current project 
only.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In the Page Template Sets section of the Pages panel, select the page template set you 
want to export.

2. Click Export Page Template Set  to open the File Explorer/macOS Finder.

3. Specify a name and location for the page template set file.

4. Click Save.

RESULT
The selected page template set is exported and saved in the selected location as a .doricolib 
file. It includes all flow headings in the page template set.

NOTE

Graphics files loaded into graphics frames are not included when exporting page templates.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Importing page templates on page 537
Graphics frames on page 589
Loading images into graphics frames on page 589
Project templates on page 80

Renaming page template sets
You can edit the names of page template sets that you have created. You cannot rename the 
default page template sets.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In the Page Template Sets section of the Pages panel, double-click the page template set 
that you want to rename.

Alternatively, you can select the page template set and click Rename Page Template Set 
in the action bar.

2. Enter the new name you want.

3. Press Return .
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Deleting page template sets
You can delete page template sets that you no longer need, including the default page template 
sets.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In the Page Template Sets section of the Pages panel, click the page template set that you 
want to delete.

2. In the action bar, click Delete Page Template Set .

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47

Types of page templates
Page template sets contain different types of page templates, which are used in different 
circumstances. For example, First page templates are usually used for the first page of music 
in a layout.

TIP

When you select a page in the Pages section of the Pages panel, the page template used for that 
page appears highlighted in the Page Templates section.

In Dorico Pro, there are the following types of page templates:

First

A page template that is usually used for the first page of music in a layout. It contains a single 
large music frame and multiple text frames to display information, such as the project title and 
composer.

NOTE

Each page template set can only contain a single First page template.

Engrave mode
Page templates 

532
Dorico Pro 4.3.30



First page template open in the page template editor

The First page template contains the following tokens in text frames:

1 Layout name (Default Part page template set only)

2 Project title

3 Project lyricist

4 Project composer

5 Project copyright

TIP

You can edit the formatting of the paragraph styles used for tokens on page templates in the 
Paragraph Styles dialog. For example, layout names on First page templates use the Layout 
name paragraph style by default.

Default

A page template that is usually used for the second page of music onwards. It contains a single 
large music frame and text frames to show the running header and page number.

NOTE

● Each page template set can only contain a single Default page template.

● All pages use the Default page template in any of the following circumstances:

● The page template set applied to the layout does not contain a First page template.

● The First page template does not contain a music frame assigned to the same frame 
chain as the Default page template.
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Default page template open in the page template editor

The Default page template contains the following tokens in text frames:

1 Page number

2 Default Full Score page template set: Flow title (optionally Project title for projects created 
from the Hub with Project will use multiple flows deactivated)

Default Part page template set: Layout name

TIP

You can edit the formatting of the paragraph styles used for tokens on page templates in the 
Paragraph Styles dialog. For example, flow titles and layout names on Default page templates 
use the Header paragraph style by default.

Custom

A page template that can have any formatting. Custom page templates allow you to create page 
formats that you want to apply to multiple pages but not all pages; for example, if you want to 
use the same title page in all part layouts, or show an image at the same position on only the 
final pages in each part layout.

RELATED LINKS
Project Info dialog on page 78
Tokens on page 576
Pages panel on page 522
Page template sets on page 529
Changing when the First page template is used on page 706
Hiding/Showing borders on layout names on page 1192
Changing flow titles on page 189
Inserting pages on page 702
Music frame selectors on page 570
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Page format changes on page 542
Flow headings on page 554
Hub on page 72

Creating page templates
You can create new page templates within page template sets. For example, you can create a title 
page template in the Default Part page template set, then assign it to the first page of each part 
layout. Each page template set can contain a single First, a single Default, and multiple Custom 
page templates.

TIP

You can share page templates between page template sets by importing page templates. For 
example, if you created a new title page template in the Default Full Score page template set, 
you can then import it into the Default Part page template set to use it in part layouts as well.

PREREQUISITE

● The right zone is shown.

● You have created or imported any page template sets to which you want to add new page 
templates.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set to which you want to add 
page templates.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Pages panel, click New Page Template  in the Page Templates action bar to open 
the New Page Template dialog.

3. Enter a name for the new page template into the Name field.

4. Select the existing page template on which you want to base the new page template from 
the Based on menu.

NOTE

● Page templates based on existing page templates are linked to the Based on page 
template. Any changes you make to frames shared between the page templates affect 
both page templates; for example, changing the text in an existing text frame. Deleting 
frames and inputting new ones breaks this link.

● Selecting (None) always creates a page template without any formatting.

5. Choose one of the following page template types for your new page template:

● First

● Default

● Custom
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NOTE

If you select First or Default, the new page template replaces that existing page template, 
as each page template set can only have a single First and Default page template.

If you want to create a new page template without replacing any existing page templates, 
choose Custom.

6. Click OK to save your changes and close the dialog.

RESULT
A new page template of the selected type is added to the page template set applied to the layout 
open in the music area.

AFTER COMPLETING THIS TASK

● You can customize your new page template.

● You can assign page templates to individual pages.

● You can import your new page template into other page template sets in the current project.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Page template sets on page 529
Creating page template sets on page 529
Importing page template sets on page 530
Customizing page templates on page 541
Applying page template sets to layouts on page 692
Assigning page templates to pages on page 549

New Page Template dialog

The New Page Template dialog allows you to add new page templates to page template sets.

● You can open the New Page Template dialog in Engrave mode by clicking New Page 
Template   in the Page Templates section of the Pages panel.

The New Page Template dialog contains the following options:

Name
Allows you to enter a name for the new page template, such as Title page.
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Based on
Allows you to select an existing page template on which you want to base the new 
page template. This creates a new page template with the same frames and formatting 
as the Based on page template.

NOTE

Page templates based on existing page templates are linked to the Based on page 
template. Any changes you make to frames shared between the page templates affect 
both page templates; for example, changing the text in an existing text frame. Deleting 
frames and inputting new ones breaks this link.

Type
Allows you to choose the type of the new page template.

NOTE

If you select First or Default, the new page template replaces that existing page 
template, as each page template set can only have a single First and Default page 
template.

RELATED LINKS
Types of page templates on page 532
Pages panel on page 522

Importing page templates
You can import individual page templates into the current page template set from other page 
template sets in the project; for example, if you created a custom title page template for your full 
score and also want to use it in the part layouts.

PREREQUISITE

● The right zone is shown.

● If you want to import a page template from or to a page template set not currently in the 
project, you have imported that page template set.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set into which you want to 
import page templates.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Pages panel, click Import Page Template  in the Page Templates action bar to 
open the Import Page Template dialog.

3. Select the page template set that contains the page template you want to import from the 
Page template set menu.

4. Select the page template you want to import in the Page template to import list.
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NOTE

You can only select and import a single page template at a time.

5. Click OK to import the selected page template and close the dialog.

RESULT
The selected page template is imported into the page template set applied to the layout open in 
the music area. It becomes available in all layouts using that page template set.

If you import a First or Default page template, the imported page template replaces the 
corresponding page template in the destination page template set, as each page template set 
can only have a single First and Default page template.

Music frames on imported page templates are automatically assigned to their own frame chain, 
regardless of the frame chain to which they were originally assigned in their source page 
template set.

NOTE

Any subsequent changes you make to the page template are not automatically reflected in other 
page template sets into which you imported it. You can reimport page templates if you made 
changes in one page template set that you want to appear in all page template sets that include 
the page template.

AFTER COMPLETING THIS TASK

● You can change the frame chains to which music frames are assigned on imported page 
templates.

● You can assign page templates to individual pages in layouts that use their page template 
set.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Page templates on page 527
Types of page templates on page 532
Assigning page templates to pages on page 549
Page template sets on page 529
Importing page template sets on page 530
Applying page template sets to layouts on page 692
Music frame chains on page 569
Assigning music frames to frame chains on page 571
Customizing page templates on page 541

Import Page Template dialog

The Import Page Template dialog allows you to import individual page templates into the 
current page template set from other page template sets in the project.

● You can open the Import Page Template dialog in Engrave mode by clicking Import Page 
Template  in the Page Templates section of the Pages panel.
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The Import Page Template dialog comprises the following:

Page template set menu
Allows you to select the page template set from which you want to import a page 
template. You can only select page template sets already in the current project.

Page template to import
Contains the page templates in the selected page template set, displayed in a list. You 
can only select and import a single page template at a time.

RELATED LINKS
Pages panel on page 522
Page templates on page 527
Types of page templates on page 532
Page template sets on page 529
Importing page template sets on page 530

Renaming page templates
You can change the names of page templates, including the default page templates and your 
own custom page templates.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set containing the page 
template you want to rename.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Page Templates section of the Pages panel, click the page template you want to 
rename.

3. In the action bar, click Rename Page Template  to open the Rename Page Template 
dialog.

4. Enter the name you want in the Name field.
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5. Click OK to save your changes and close the dialog.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46

Deleting page templates
You can delete page templates from page template sets.

NOTE

You cannot delete Default page templates. Each page template set must contain at least a 
Default page template. You can replace Default page templates by adding a page template and 
setting its type to Default.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set containing the page 
template you want to delete.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Page Templates section of the Pages panel, click the page template you want to 
delete.

3. In the action bar, click Delete Page Template .

RESULT
The selected page template is deleted.

Page template editor
The page template editor allows you to view and change the format of page templates, such as 
by inputting, deleting, and changing the contents of frames.

You can open the page template editor in Engrave mode in any of the following ways:

● Double-click a page template in the Page Templates section of the Pages panel.

● Select a page template in the Page Templates section of the Pages panel and click Edit Page 
Template .

You can customize page templates in the page template editor to suit your requirements, 
including inserting extra frames and editing/moving existing frames. You can also change the 
frame chains to which music frames are assigned, and change which flows and players are 
assigned to frames.
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NOTE

Tokens in text frames and music in music frames are automatically updated as appropriate for 
each layout. However, graphics frames can only show a single image in all layouts. If you change 
the image in a graphics frame in one layout, this updates the page template and affects all 
layouts.

A page template open in the page template editor, showing its left and right pages

RELATED LINKS
Pages panel on page 522
Tokens on page 576
Frames on page 560

Customizing page templates
You can customize page templates according to your needs in the page template editor. 
Changing a page template affects the appearance of all pages in all layouts that use that page 
template.

NOTE

Page templates based on existing page templates are linked to the Based on page template. Any 
changes you make to frames shared between the page templates affect both page templates; for 
example, changing the text in an existing text frame. Deleting frames and inputting new ones 
breaks this link.

PREREQUISITE

● The right zone is shown.

● You have created any new page templates you want to customize.
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PROCEDURE

1. In Engrave mode, open a layout that uses the page template set containing the page 
template you want to customize.

2. In the Page Templates section of the Pages panel, double-click the page template you want 
to customize to open the page template editor.

3. Change the layout of one of the pages of the selected page template.

For example, you can change the size and shape of frames.

4. Optional: If you want both the left and right pages to be the same, click one of the following 
Copy Page Layout buttons at the top of the music area, depending on which page you 
changed:

● Left to Right 

● Right to Left 

NOTE

● This copies the page template layout exactly from one page to the other, not as a 
mirror. For example, text frames for page numbers are not kept on the outside edge 
automatically.

● Frames copied between right/left pages are linked, including the contents of text 
frames. Deleting frames and inputting new ones breaks this link.

5. Click Apply, then Close.

RESULT
The selected page template is changed. If you customized an existing page template, all existing 
pages without page template overrides that use the page template are automatically updated 
accordingly.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Page template editor on page 540
Page template sets on page 529
Applying page template sets to layouts on page 692
Assigning page templates to pages on page 549
Inputting frames on page 562
Entering text in text frames on page 583
Moving frames on page 563
Changing the size/shape of frames on page 564
Creating page templates on page 535
Assigning music frames to frame chains on page 571
Assigning flows to frame chains on page 573
Assigning players to frame chains on page 574
Layout Options dialog on page 834

Page format changes
Page format changes are changes to the format or design of specific pages in individual layouts, 
as determined by the page template set, that do not affect the underlying page templates. 
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For example, making a frame smaller on a single page in a part layout, or changing the page 
numbers from a selected page onwards.

You can identify the different types of page format changes by the markings shown on individual 
pages in the Pages section of the Pages panel in Engrave mode.

Page template overrides
A change to the format of individual pages made directly in the music area, rather 
than in the page template editor. For example, changing the size of a music frame, 
adding a text frame for footnotes, or inserting empty pages all result in page template 
overrides.

Pages with page template overrides no longer automatically inherit changes that are 
made to the page template. To return overridden pages to following the page template 
format, you must remove page template overrides.

Pages with page template overrides are shown with a red marking in their top left 
corner.

Page template override

Page number changes
A change to the default page number sequence, such as numbering prefatory pages 
with Roman numerals.

Pages with page number changes inherit any subsequent changes you make to the 
page template. They are shown with a purple marking in their bottom right corner.

Page number change

Page template changes
A change to the page template assigned to individual pages or all pages from a specific 
point. For example, you might have a page template for title pages that you assign to 
the first page in every part layout.

Pages with page template changes inherit any subsequent changes you make to the 
corresponding page template. They are shown with green markings in the following 
places:

● Page template changes on the current page only: along top edge.

● Page template changes from the page onwards: along left and top edges.
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Page template change to single page only Page template change from selected page 
onwards

Flow heading changes
A change to the flow heading assigned to individual pages or all pages from a specific 
point. For example, if you want the margins above and below flow headings to be 
smaller on pages with more staves.

Pages with flow heading changes inherit any subsequent changes you make to the 
page template. They are shown with yellow markings in the following places:

● Flow heading changes on the current page only: along bottom edge.

● Flow heading changes from the page onwards: along left and bottom edges.

Flow heading change to single page only Flow heading change from selected page 
onwards

NOTE

● If you inserted a page in the middle or at the end of your layout using a custom page 
template and remove the override, that page is automatically assigned the Default page 
template of the page template set.

● You cannot save overrides you have made to individual pages as a page template. If you 
know you want to use the same formatting on multiple pages, we recommend creating a 
new page template.

RELATED LINKS
Pages panel on page 522
Inserting pages on page 702
Page numbers on page 1353
Page templates on page 527
Page template editor on page 540
Creating page templates on page 535
Customizing page templates on page 541
Flow headings on page 554
Swapping pages on page 553
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Removing page template overrides
You can remove overrides that you have made to individual pages and return them to following 
the page template format.

Any pages in your layout that contain overrides are shown with a colored triangle in their top left 
corner in the Pages section of the Pages panel. Page template overrides include changing the 
size/shape of frames inherited from the page template or flow heading format, inputting extra 
frames on the page, and inputting a new empty page.

Removing overrides from empty pages deletes them from the layout.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open the layout whose page template overrides you want to remove.

2. Optional: If you want to remove overrides from individual pages, select those pages in the 
Pages section of the Pages panel.

You can Shift -click adjacent pages and Ctrl/Cmd -click individual pages.

3. Remove page template overrides in one of the following ways:

● To remove overrides from selected pages only, click Remove Overrides  in the Pages 
section action bar.

● To remove overrides from all pages, right-click in the Pages section of the Pages panel 
and choose Remove All Page Overrides from the context menu.

RESULT
Any overrides you made to the page template format are removed from either the selected 
pages only or from all pages in the layout currently open in the music area. Empty pages that are 
considered overrides are deleted.

If you removed overrides from selected pages only, any other pages with overrides in the layout 
are unaffected.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Frames on page 560
Project Info dialog on page 78
Customizing flow headings on page 558

Inserting page number changes
You can change page numbers from individual pages onwards in each layout in your project. 
Inserting page number changes allows you to change the page number shown, the page 
number style, and also affects whether the first page in layouts is a left or right page.

For example, you can use Roman numerals such as ii and iv for front matter pages, and numbers 
such as 1 and 3 for music pages.

NOTE

● If you change the first page in the layout to an even number, it automatically becomes a 
left-hand page. This is because convention dictates that even numbered pages are always on 
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the left-hand page, and odd numbered pages are always on the right-hand page. Similarly, 
if the first page in the layout is on the left-hand page, it cannot show as page 1, it can only 
show as page 2.

● If you want layouts to start on the left-hand page, we recommend using the dedicated 
option for this in Layout Options.

● If you want page numbers to restart at 1 for each flow, you can customize page templates so 
they use the {@flowPage@} token instead of the {@page@} token.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open the layout whose page numbers you want to change.

2. In the Pages section of the Pages panel, select the page from which you want to change 
page numbers.

3. In the action bar, click Insert Page Number Change  to open the Page Number Change 
dialog.

4. In the From page field, enter the number of the page from which you want the page 
number change to start.

For example, if you want to change the page number of your current page 3, enter 3.

5. In the First page number field, enter the new page number that you want the selected page 
to have.

For example, if you want to change your current page 3 to page 5, enter 5.

6. Select one of the following numeral styles for Sequence type:

● Number

● Roman numeral

7. Click OK to save your changes and close the dialog.

RESULT
The page number of the selected page is changed. All subsequent pages are changed 
correspondingly until the next page number change or the end of the project, whichever comes 
first.

TIP

You can also change other aspects of the appearance of page numbers in the Page Number 
Change dialog. For example, you can show subordinate numbers as uppercase or lowercase 
letters.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Starting layouts on left-hand pages on page 705
Layout Options dialog on page 834
Page templates on page 527
Tokens on page 576
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Page Number Change dialog

The Page Number Change dialog allows you to change the page numbers shown on existing 
pages in each layout, including hiding page numbers or showing them with different numbering.

You can open the Page Number Change dialog in Engrave mode when a page is selected in the 
Pages section of the Pages panel in any of the following ways:

● Right-click in the Pages section and choose Insert Page Number Change from the context 
menu.

● Click Insert Page Number Change .

The Page Number Change dialog contains the following options:

From page
Allows you to select the page from which you want to change page numbers. The 
number indicates its position within the layout.

The Displayed preview shows how the page number of the selected page currently 
appears. If you have inserted page number changes in the layout, the displayed page 
number might be different to the underlying page number.

First page number
Allows you to specify the new page number you want for the selected page. 
Subsequent pages follow the new sequence until the next page number change or 
end of the project.

Sequence type
Allows you to select the type of number that the selected page and subsequent pages 
have. The page number sequence type can be Number, such as 5 and 19, or Roman 
numeral, such as iii and iv.

Visibility
Allows you to specify if a page number is hidden or shown. You can additionally specify 
that the page number is also hidden on the page where the page number change 
occurs; for example, to hide page numbers on introductory pages.

Subordinate number type
Allows you to add a subordinate number to the page number and to specify a type.
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Subordinate number
Allows you to specify the number from which you want the subordinate numbers to 
start.

When you insert page number changes, a purple marking is shown in the bottom right corner of 
the page in the Pages section of the Pages panel. The new page number is also shown in each 
page in the Pages section of the Pages panel, in the appropriate numeral style.

RELATED LINKS
Pages panel on page 522
Page numbers on page 1353

Removing page number changes
You can remove page number changes you have made to individual pages, which reverts pages 
to their default page numbers.

Any pages whose page number has been changed are shown with a colored triangle in their 
bottom right corner in the Pages section of the Pages panel.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open the layout whose page number changes you want to remove.

2. Optional: If you want to remove page number changes from individual pages, select those 
pages in the Pages section of the Pages panel.

You can Shift -click adjacent pages and Ctrl/Cmd -click individual pages.

3. Remove page number changes in one of the following ways:

● To remove page number changes from selected pages only, right-click a page and 
choose Remove Page Number Change(s) from the context menu.

● To remove page number changes from all pages, right-click in the Pages section of the 
Pages panel and choose Remove All Page Number Changes from the context menu.

RESULT
Page number changes are removed from either the selected pages only or from all pages in the 
layout currently open in the music area.

If you removed page number changes from all pages, all pages are restored to the default page 
number sequence.

If you removed page number changes from selected pages only, the default page number is 
restored from the selected pages until the next page number change or the end of the project, 
whichever comes first. Any other pages with page number changes in the layout are unaffected.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Page Number Change dialog on page 547
Inserting page number changes on page 545
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Assigning page templates to pages
You can assign different page templates to each page in each layout. You can assign page 
templates to individual pages and to every page after a selected page. For example, if you want 
to show a title page on the first page in each part layout.

PREREQUISITE

● The right zone is shown.

● You have created or imported any custom page templates you want to assign to pages.

PROCEDURE

1. In Engrave mode, open the layout in which you want to change the page templates assigned 
to pages.

2. In the Pages section of the Pages panel, click the page whose page template assignment you 
want to change.

3. In the action bar, click Insert Page Template Change  to open the Insert Page Template 
Change dialog.

4. Optional: Change the start page for the page template change using the From page option.

5. Select the page template that you want to assign from the Use page template menu.

6. Choose one of the following options for Range:

● To assign the selected page template to the selected page only, choose Current Page 
Only.

● To assign the selected page template to the selected page and all subsequent pages, 
choose From This Page Onwards.

7. Click OK to save your changes and close the dialog.

RESULT
The selected page template is assigned to either the selected page only or the selected page 
and all subsequent pages until the next existing page template change or the end of the layout, 
whichever comes first.

AFTER COMPLETING THIS TASK
If any pages in the affected range did not update, it is likely that those pages have page template 
overrides, which is a type of page format change. You can remove page template overrides to 
allow pages to use the assigned page template.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Page template sets on page 529
Creating page templates on page 535
Importing page templates on page 537
Inserting pages on page 702
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Removing page template changes
You can remove page template changes you have assigned to individual pages; for example, 
if changes to a layout’s casting off mean it no longer needs a custom page template with a 
shortened music frame on the last page.

Any pages whose page template has been changed are shown with a green marking along their 
top edge, or along their top and left edges, in the Pages section of the Pages panel.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open the layout whose page template changes you want to remove.

2. Optional: If you want to remove page template changes from individual pages, select those 
pages in the Pages section of the Pages panel.

You can Shift -click adjacent pages and Ctrl/Cmd -click individual pages.

3. Remove page template changes in one of the following ways:

● To remove page template changes from selected pages only, right-click a page and 
choose Remove Page Template Change(s) from the context menu.

● To remove page template changes from all pages, right-click in the Pages section of the 
Pages panel and choose Remove All Page Template Changes from the context menu.

RESULT
All page template changes are removed from either the selected pages only or from all pages 
in the layout currently open in the music area. Pages return to using either the First or Default 
page template, depending on their position in the layout and your per-layout settings.

If you removed page template changes from selected pages only, any other pages with page 
template changes in the layout are unaffected.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Changing when the First page template is used on page 706
Types of page templates on page 532
Page format changes on page 542
Casting off on page 728

Inserting flow heading changes
Inserting flow heading changes allows you to change the flow heading format used on individual 
pages in each layout independently, including only changing the margins above/below the 
default flow heading.

PREREQUISITE

● The right zone is shown.

● You have created any custom flow headings you want to use in flow heading changes.

PROCEDURE

1. In Engrave mode, open the layout whose flow headings you want to change.
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2. In the Pages section of the Pages panel, click the page on/from which you want to insert a 
flow heading change.

3. In the action bar, click Insert Flow Heading Change  to open the Insert Flow Heading 
Change dialog.

4. Optional: Change the start page for the flow heading change using the From page option.

5. Select the flow heading that you want to insert from the Use flow heading menu.

6. Choose one of the following options for Range:

● Current Page Only

● From This Page Onwards

7. Optional: Activate the following options, individually or together, and change their values to 
change the corresponding flow heading margin:

● Heading Top Margin

● Heading Bottom Margin

8. Click OK to save your changes and close the dialog.

RESULT
If you selected Current Page Only, the selected flow heading is applied to all flow headings on 
the selected page only.

If you selected From This Page Onwards, the selected flow heading is applied to all flow 
headings on the selected page and all subsequent pages in the layout or until the next existing 
flow heading change.

RELATED LINKS
Switching between layouts on page 46
Hiding/Showing zones on page 47
Pages panel on page 522
Flow headings on page 554
Creating flow headings on page 556
Hiding/Showing flow headings on page 707
Allowing/Disallowing multiple flows on the same page on page 706
Margins on page 712

Insert Flow Heading Change dialog

The Insert Flow Heading Change dialog allows you to change the formats used for all flow 
headings on specified pages in each layout. You can apply flow heading changes only to 
individual pages or to all subsequent pages.

You can open the Insert Flow Heading Change dialog in Engrave mode when a page is selected 
in the Pages section of the Pages panel in any of the following ways:

● Right-click in the Pages section and choose Insert Flow Heading Change from the context 
menu.

● Click Insert Flow Heading Change .
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The Insert Flow Heading Change dialog contains the following options:

From page
Allows you to select the page from which you want to change the flow heading format. 
The number indicates its position within the layout.

The Displayed preview shows how the page number of the selected page currently 
appears. If you have inserted page number changes in the layout, the displayed page 
number might be different to the underlying page number.

Use flow heading
Allows you to specify the flow heading design you want to apply. The menu contains all 
available flow headings in the current page template set.

Range
Allows you to specify the range to which you want to apply the flow heading change.

● Current Page Only applies the flow heading change only to the selected page.

● From This Page Onwards applies the flow heading change to the selected page 
and all subsequent pages in the layout or until the next existing flow heading 
change.

Heading Top Margin
Allows you to set the gap between the top of affected flow headings and the end of the 
preceding flow, independently of the default setting for the layout.

Heading Bottom Margin
Allows you to set the gap between the bottom of affected flow headings and the start 
of the next flow, independently of the default setting for the layout.

When you insert flow heading changes, a yellow marking is shown on the bottom or bottom and 
left edges of the page in the Pages section of the Pages panel.

RELATED LINKS
Pages panel on page 522
Changing the margins above/below flow headings on page 713
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Removing flow heading changes
You can remove flow heading changes you have assigned to individual pages and return them to 
using the Default flow heading.

Any pages whose flow heading has been changed are shown with a yellow marking along their 
bottom edge, or along their bottom and left edges, in the Pages section of the Pages panel.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open the layout whose flow heading changes you want to remove.

2. Optional: If you want to remove flow heading changes from individual pages, select those 
pages in the Pages section of the Pages panel.

You can Shift -click adjacent pages and Ctrl/Cmd -click individual pages.

3. Remove flow heading changes in one of the following ways:

● To remove flow heading changes from selected pages only, right-click a page and 
choose Remove Flow Heading Change(s) from the context menu.

● To remove flow heading changes from all pages, right-click in the Pages section of the 
Pages panel and choose Remove All Flow Heading Changes from the context menu.

RESULT
All flow heading changes are removed from either the selected pages or from all pages in the 
layout currently open in the music area. Pages return to using the Default flow heading in the 
page template set applied to the layout.

If you removed flow heading changes from selected pages only, any other pages with flow 
heading changes in the layout are unaffected.

RELATED LINKS
Switching between layouts on page 46
Hiding/Showing zones on page 47
Pages panel on page 522
Flow headings on page 554

Swapping pages
You can swap page format changes between adjacent pages; for example, if you have assigned 
page template and flow heading changes to page 4, but due to casting off changes, those page 
format changes need to be on page 5.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open the layout in which you want to swap pages.

2. In the Pages section of the Pages panel, select the pages whose page format changes you 
want to swap with other pages.

3. Swap the page format changes on selected pages with other pages in any of the following 
ways:

● In the action bar, click Swap with Previous Page .
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● In the action bar, click Swap with Next Page .

RESULT
All page format changes on the selected pages are moved to the previous or next pages within 
the sequence of pages in the layout.

RELATED LINKS
Hiding/Showing zones on page 47
Switching between layouts on page 46
Inserting pages on page 702
Casting off on page 728

Flow headings
Flow headings allow you to show the titles of flows immediately above their first system 
automatically. They function like templates, in much the same way as page templates, allowing 
the same flow heading formatting to be applied to multiple flows in different layouts.

Flow headings exist as part of page template sets. By default, Dorico Pro provides one flow 
heading in each page template set, which contains tokens to display the flow number and flow 
title; in a new project, this appears as “1. Flow 1”. This is used automatically for all flow headings.

You can customize the default flow heading, such as changing the tokens it contains or adding 
extra frames, create new flow headings, and insert flow heading changes to individual pages and 
ranges of pages.

Dashed lines showing the edges of a flow heading text frame

Any changes you make to flow headings in the flow heading editor are automatically reflected on 
the pages that use those flow headings. For example, if you delete a token from a flow heading 
in the flow heading editor, that token is removed from all the pages that use that flow heading, 
so long as those pages do not have page template overrides.

Flow headings are automatically inserted inside music frames above the first system of the flow 
to which they apply, meaning they do not have a fixed vertical position on the page like other 
frames and follow the music if it moves. They also occupy vertical space within music frames. You 
can change the margins for the space above and below flow headings on a per-layout and on a 
per-page basis by inserting flow heading changes.

NOTE

Flow headings only appear in page template music frames, they never appear in layout music 
frames.

When Frames  is selected in the Engrave toolbox, frames in flow headings appear with dashed 
lines instead of solid lines to help you identify them. You can move flow heading frames in the 

Engrave mode
Flow headings 

554
Dorico Pro 4.3.30



same ways as moving any other frames, but this creates a page template override, which is a 
type of page format change.

NOTE

Changing individual flow headings in layouts is considered a page template override in Dorico 
Pro, which is a type of page format change. This includes, for example, deleting a token from 
a single flow heading on one page, rather than in the flow heading editor. Pages with page 
template overrides no longer get updated if you edit the page template or flow heading and are 
not automatically deleted, even if they are empty because the layout became shorter.

RELATED LINKS
Tacets on page 739
Hiding/Showing flow headings on page 707
Changing the margins above/below flow headings on page 713
Hiding/Showing information in running headers above flow headings on page 708
Editing running headers in page templates on page 1190
Page template sets on page 529
Page format changes on page 542
Removing page template overrides on page 545
Margins on page 712
Frames on page 560
Text frames on page 575
Tokens on page 576
Inserting flow heading changes on page 550
Music frames on page 568

Flow heading editor
The flow heading editor allows you to view and change the format of flow headings. It functions 
similarly to the page template editor; however, the background of the flow heading editor is a 
different color to help you identify what you are editing.

You can open the flow heading editor in the following ways:

● Double-click a flow heading in the Flow Headings section of the Pages panel.

● Select a flow heading in the Flow Headings section of the Pages panel and click Edit Flow 
Heading .

You can customize flow headings in the flow heading editor, including inputting extra frames, 
changing the contents of text frames, and editing/moving existing text and graphics frames. 
You can also change the vertical alignment of text in text frames and use text editor options to 
format the appearance and horizontal alignment of text in text frames.

NOTE

● You cannot input music frames in flow headings.

● Frames in flow headings can only have right and left edge constraints, they cannot have top 
or bottom constraints. This is because flow headings have no fixed vertical position.

You can position frames anywhere in the flow heading editor, as Dorico Pro always uses the top 
of the highest frame and bottom of the lowest frame on the page in the editor to determine the 
dimensions of the flow heading. However, we recommend that you keep the overall height of 
flow headings as small as possible to reduce the amount of music they consequently displace in 
music frames.
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Unlike page templates, flow headings appear the same whether they are on left-hand or right-
hand pages, so only a single page is shown in the flow heading editor.

A flow heading in the flow heading editor

RELATED LINKS
Pages panel on page 522
Tokens on page 576
Text editor options in Engrave mode on page 584
Changing the horizontal alignment of text in text frames on page 588

Creating flow headings
You can create new flow headings within page template sets. Each page template set can contain 
a single Default and multiple Custom flow headings.

PREREQUISITE

● The right zone is shown.

● You have created or imported any page template sets to which you want to add new flow 
headings.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set to which you want to add 
flow headings.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Pages panel, click New Flow Heading  in the Flow Headings action bar to open the 
New Flow Heading dialog.

3. Enter a name for the new flow heading into the Name field.

4. Select the existing flow heading on which you want to base the new flow heading from the 
Based on menu.
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NOTE

● Flow headings based on existing flow headings are linked to the Based on flow heading. 
Any changes you make to frames shared between the flow headings affect both flow 
headings; for example, changing the text in an existing text frame. Deleting frames and 
inputting new ones breaks this link.

● Selecting (None) always creates a flow heading without any formatting but the page 
margins.

5. Choose one of the following flow heading types for your new flow heading:

● Default

● Custom

NOTE

If you select Default, the new flow heading replaces the existing Default flow heading, as 
each page template set can only have a single Default flow heading.

If you want to create a new flow heading without replacing any existing flow headings, 
choose Custom.

6. Click OK to save your changes and close the dialog.

RESULT
A new flow heading of the selected type is added to the page template set applied to the layout 
open in the music area.

AFTER COMPLETING THIS TASK

● You can customize your new flow heading.

● You can assign flow headings to individual pages.

RELATED LINKS
Switching between layouts on page 46
Hiding/Showing zones on page 47
Pages panel on page 522
Page template sets on page 529
Inserting flow heading changes on page 550
Hiding/Showing flow headings on page 707

New Flow Heading dialog
The New Flow Heading dialog allows you to add new flow headings to the page template sets.

● You can open the New Flow Heading dialog in Engrave mode by clicking New Flow 
Heading   in the Flow Headings section of the Pages panel.
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The New Flow Heading dialog contains the following options:

Name
Allows you to enter a name for the new flow heading, such as Flow title + composer.

Based on
Allows you to select an existing flow heading on which you want to base the new flow 
heading. This creates a new flow heading with the same frames and formatting as the 
Based on flow heading.

NOTE

Flow headings based on existing flow headings are linked to the Based on flow 
heading. Any changes you make to frames shared between the flow headings affect 
both flow headings; for example, changing the text in an existing text frame. Deleting 
frames and inputting new ones breaks this link.

Type
Allows you to choose the type of the new flow heading.

NOTE

If you select Default, the new flow heading replaces the existing Default flow heading, 
as each page template set can only have a single Default flow heading.

Customizing flow headings
You can customize flow headings according to your needs in the flow heading editor, such as 
by inputting a graphics frame or changing the tokens in an existing text frame. Changing a flow 
heading affects the appearance of flow headings in all layouts that use that flow heading.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set containing the flow heading 
you want to customize.

2. In the Flow Headings section of the Pages panel, double-click the flow heading you want to 
customize to open the flow heading editor.

3. Change the layout of the flow heading.
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For example, you can input a graphics frame or change the vertical alignment of text in the 
text frame.

4. Click Apply, then Close.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Page template sets on page 529
Applying page template sets to layouts on page 692
Inserting flow heading changes on page 550
Removing page template overrides on page 545
Inputting frames on page 562
Entering text in text frames on page 583
Moving frames on page 563
Changing the size/shape of frames on page 564
Changing the vertical alignment of text in text frames on page 587
Paragraph Styles dialog on page 848
Project Info dialog on page 78
Tokens on page 576

Renaming flow headings
You can change the names of flow headings, including default flow headings and your own 
custom flow headings.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set containing the flow heading 
you want to rename.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Flow Headings section of the Pages panel, click the flow heading pair that you want to 
rename.

3. In the action bar, click Rename Flow Heading  to open the Rename Flow Heading dialog.

4. Enter the name you want in the Name field.

5. Click OK to save your changes and close the dialog.

RELATED LINKS
Switching between layouts on page 46
Hiding/Showing zones on page 47
Pages panel on page 522
Flow headings on page 554
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Deleting flow headings
You can delete flow headings from page template sets.

NOTE

You cannot delete Default flow headings. Each page template set must contain at least a Default 
flow heading. You can replace Default flow headings by adding a new flow heading and setting 
its type to Default.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set containing the flow heading 
you want to delete.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Flow Headings section of the Pages panel, click the flow heading that you want to 
delete.

3. In the action bar, click Delete Flow Heading .

RESULT
The selected flow heading is deleted. You can undo this action if you deleted a flow heading in 
error.

Frames
Frames are boxes that allow you to position music, additional text, and graphics on pages. 
Frames can be any size and shape, as long as they fit within the page margins.

In Engrave mode, you can adjust frames according to your needs, including defining frame 
constraints that control the relationship between the sides of frames and page margins.

● You can edit frames when Frames  is selected in the Engrave toolbox.

In Dorico Pro, there are the following types of frames:

Music frames
Music frames display the music of selected players and flows or blank staves.

A music frame displaying the start of a piano piece

Text frames
Text frames display text, which you can enter directly or by using tokens.

Engrave mode
Frames 

560
Dorico Pro 4.3.30



A text frame displaying a project title, "Sechs Lieder"

Graphics frames
Graphics frames display the images that you load into them, which can be in a variety 
of formats.

A graphics frame with image loaded

EXAMPLE

The first page of a piano piece. It contains a music frame, text frames for the title, dedication, and composer, 
a flow heading frame inside the top of the music frame, and graphics frames in the top corners.

RELATED LINKS
Engrave toolbox on page 514
Project window in Engrave mode on page 513
Flows in Dorico on page 23
Layouts in Dorico on page 27
Frame constraints on page 590
Music frames on page 568
Text frames on page 575
Graphics frames on page 589
Frame breaks on page 736
Tokens on page 576
Page templates on page 527
Flow headings on page 554
Changing page margins on page 692
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Inputting frames
You can input frames of any size and shape on pages manually, including on both individual 
pages and on page templates in the page template editor. You can input music frames, text 
frames, and graphics frames.

PREREQUISITE

● The left zone is shown.

● Frames  is selected in the Engrave toolbox.

● If you want to input frames on a page template, you have opened the page template in the 
page template editor.

● If you want to input frames on empty pages, you have inserted those pages.

PROCEDURE

1. In Engrave mode, choose one of the following types of frames in the Insert Frames section 
of the Frames panel:

● Insert Music Frame 

● Insert Text Frame 

● Insert Graphics Frame 

2. Click and drag in the music area to input the selected frame type.

You can draw a frame of any size and shape, as long as it fits within the page margins.

RESULT
When you release the mouse, the type of frame you chose is input on the page.

AFTER COMPLETING THIS TASK

● You can change the size/shape of the frame or define its constraints.

● If you inserted a music frame, you can determine the music or blank staves you want to 
display in the frame.

● If you inserted a text frame, you can enter text.

● If you inserted a graphics frame, you can load a graphics file.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Frames panel on page 519
Frame constraints on page 590
Changing the size/shape of frames on page 564
Music frames on page 568
Text frames on page 575
Graphics frames on page 589
Music frame chains on page 569
Music frame selectors on page 570
Entering text in text frames on page 583
Loading images into graphics frames on page 589
Page template editor on page 540
Creating page templates on page 535
Inserting pages on page 702
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Moving frames
You can move individual frames around pages, including page templates, after they have been 
input. For example, if you want the text frames containing page number tokens to appear in the 
middle of pages, rather than the outside corners.

NOTE

You cannot move frames beyond page margins or to other pages. If you want frames to appear 
on different pages, you can either copy them to other pages or delete them from their original 
pages and create new frames on the new pages.

PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● If you want to move frames on a page template, you have opened the page template in the 
page template editor.

PROCEDURE

1. In Engrave mode, select the frames you want to move.

NOTE

When using the mouse, you can only move a single frame at a time.

2. Move the frames in any of the following ways:

● To move frames a standard amount to the right, left, up, or down, press Alt/Opt  plus 
the corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move frames 
to the left.

● To move frames a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move frames a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move frames a small amount, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● Click and drag the frame in any direction.

RESULT
The selected frames are moved to new positions.

TIP

You can also move frames by using properties in the Frames group of the Properties panel.

● Height: Available for frames with unlocked top or bottom constraints.

● Width: Available for frames with unlocked right or left constraints.

● Left/Top/Right/Bottom: Available for frames with the corresponding locked constraints.

RELATED LINKS
Frame constraints on page 590
Copying frames on page 566
Inputting frames on page 562
Deleting frames on page 567
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Creating page templates on page 535
Selecting/Deselecting notes and items individually on page 426
Large selections on page 428
Moving items graphically on page 609
Page numbers on page 1353

Changing the size/shape of frames
You can change the size and shape of individual frames, including on page templates, after they 
have been input.

PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● If you want to change the size/shape of frames on a page template, you have opened the 
page template in the page template editor.

PROCEDURE

1. In Engrave mode, select the middle handle on an edge of the frame whose size or shape you 
want to change.

NOTE

You can only select a single handle on a single frame at a time.

2. Move the handle in any of the following ways:

● To move it a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left.

● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● Click and drag the handle to the right/left or upwards/downwards.

NOTE

You can only move handles on the right/left edges of frames to the right/left. You can only 
move handles on the top/bottom edges of frames upwards/downwards. For example, if you 
want to make a frame wider, you can select the middle handle on the right edge of the frame 
and move it to the right.

3. Optional: Repeat steps 1 and 2 for any other edge of the frame you want to move to achieve 
the size and shape you want.

RESULT
The size and/or shape of the selected frame is changed.

NOTE

● Depending on the constraints defined for the frame, it may appear with a different size/
shape on pages with different page sizes, orientations, and/or page margins.
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● You can also change the size/shape of frames by using properties in the Frames group of 
the Properties panel.

● Height: Available for frames with unlocked top or bottom constraints.

● Width: Available for frames with unlocked right or left constraints.

● Left/Top/Right/Bottom: Available for frames with the corresponding locked constraints.

RELATED LINKS
Page template editor on page 540
Creating page templates on page 535
Frame constraints on page 590
Page template sets on page 529
Changing the page size and/or orientation on page 691
Changing page margins on page 692
Showing blank staves in frames on page 700

Selecting frame handles
You can select an individual handle on a frame, and you can switch between having a handle 
selected and having the whole frame selected.

PREREQUISITE
Frames  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a frame handle in any of the following ways:

● Select any handle on the frame and press Right Arrow / Left Arrow / Up Arrow /
Down Arrow  to select other handles around the edge of the frame.

● Select the frame, press Tab  to switch to having the handle in the top left corner 
selected, then press Right Arrow / Left Arrow / Up Arrow / Down Arrow  to select other 
handles around its edge.

● Click a handle on the frame.

NOTE

You can only select a single handle on a single frame at a time.

2. Optional: To switch back to having the whole frame selected, press Tab .

EXAMPLE

Whole text frame selected Text frame with top middle handle selected

RELATED LINKS
Customizing page templates on page 541
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Copying frames
You can copy individual frames from one page to other pages in the same layout; for example, if 
you want the same frame to appear on multiple pages at exactly the same position. You can also 
copy frames to the same page; for example, if you want to duplicate a frame on a page.

NOTE

● These steps do not apply to frames on page templates. When customizing a page template, 
you can copy frames from the left page to the right page, and vice versa. However, you 
cannot copy frames between different page templates.

● You cannot copy frames to pages in other layouts. If you want the same frames to appear in 
multiple layouts, you can create a custom page template.

PREREQUISITE

● The right zone is shown.

● Frames  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, open the layout in which you want to copy frames to other pages.

2. In the music area, select the frames you want to copy.

TIP

The frames can be on multiple pages.

3. In the Pages section of the Pages panel, select the pages to which you want to copy the 
selected frames.

You can Shift -click adjacent pages and Ctrl/Cmd -click individual pages.

4. Right-click in the Pages section and choose Copy Selected Frames to Selected Pages from 
the context menu.

RESULT
All selected frames are copied to the selected pages at the same positions on the page. If you 
copied frames to their original page, they overlay their original exactly.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Page format changes on page 542
Creating page templates on page 535
Customizing page templates on page 541
Page template editor on page 540
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Deleting frames
You can delete frames from both individual pages and page templates. Deleting music frames 
can change where music appears, depending on their page template frame chain and frame 
order.

PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● If you want to delete frames from a page template, you have opened the page template in 
the page template editor.

PROCEDURE

1. In Engrave mode, select the frames you want to delete.

2. Press Backspace or Delete .

RESULT
The selected frames are deleted. When you delete music frames, the order of other music frames 
in the same music frame chain updates automatically. For example, if you have three music 
frames in the same music frame chain and delete the second frame, the third frame becomes the 
second frame in the music frame chain and the music it displays updates accordingly.

NOTE

● If you delete page template music frames on individual pages, Dorico Pro automatically adds 
extra pages as required to display the flows assigned to the page template frame chain. If 
you want to delete frames because you do not want to show certain flows, you can instead 
remove those flows from the layout or the page template frame chain.

● If you delete all music frames from a First page template, any pages that previously 
automatically used the First page template now use the Default page template in their 
page template set. If you also delete all music frames from the Default page template, no 
music or pages are displayed.

RELATED LINKS
Engrave toolbox on page 514
Page template editor on page 540
Creating page templates on page 535
Music frame chains on page 569
Assigning flows to layouts on page 172
Assigning flows to frame chains on page 573
Changing the order of music frames on page 573
Inputting frames on page 562
Moving frames on page 563
Page templates on page 527
Page template sets on page 529
Applying page template sets to layouts on page 692
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Music frames
Music frames display the music in your project in a specified order. You can control which parts 
of the project are displayed using page template music frames and layout music frames.

Both types of music frames can display the music and notations you have input into the project 
according to their music frame selectors, such as filtering only selected players or flows, or 
simply blank staves.

A page template music frame

Page template music frames

Page template music frames exist only on page templates, meaning you can only input and edit 
page template music frames in the page template editor. They can only be assigned to page 
template frame chains. Therefore, the flow and player selectors of page template music frames 
appear grayed out on individual pages in layouts.

Flow and player selectors grayed out on a page template music frame

By default, the page templates in the page template sets provided by Dorico Pro include page 
template music frames assigned to a single page template frame chain. This frame chain is set to 
display all players in all flows in each layout. These page templates are set to apply to all pages in 
all layouts in your project by default according to the layout type.

You can input multiple page template music frames on a single page template, and change their 
size and shape as required. If you want to connect separate page template music frames on the 
same page, you can assign them to the same frame chain.

Layout music frames

Layout music frames exist only on individual pages in layouts, meaning you can only input and 
edit layout music frames in individual layouts in the music area. Layout music frames can be 
assigned to both page template and layout frame chains. However, assigning a layout frame to a 
page template frame chain does not affect the page template.

You can input multiple layout music frames on a single page, and change their size and shape 
as required. For example, layout music frames allow you to insert small musical excerpts from a 
different flow within footnotes or in an index.

If you want to connect separate layout music frames on the same page, you can assign them to 
the same frame chain.
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IMPORTANT

● Layout music frames are considered overrides to page templates. If you remove all overrides 
on layout pages, all your layout music frames are also removed.

● Layout music frames cannot show flow headings.

RELATED LINKS
Music frame selectors on page 570
Page templates on page 527
Page format changes on page 542
Page template editor on page 540
Inputting frames on page 562
Changing the size/shape of frames on page 564
Flow headings on page 554
Showing blank staves in frames on page 700

Music frame chains
A music frame chain is a collection of music frames that show the same selection of music in 
a set order, often in sequence. Music frame chains are automatically created when you input 
music frames and import page templates, and can include any number of frames, including only 
a single music frame.

You can control the players and flows shown in each music frame chain by using music frame 
selectors.

In Dorico Pro, there are different types of frame chains.

Page template frame chains

Page template frame chains can be created and fully edited only on page templates in the page 
template editor; you cannot change the flow and player filters for page template frame chains 
in individual layouts. Whenever you create a music frame on a page template, you automatically 
start a frame chain.

Frame chains that start with an “M”, such as “MA”, are page template frame chains. You can have 
multiple page template frame chains on each page, such as “MA” and “MH”.

The default page templates contain a single frame chain that is set to display all flows and all 
players in the layout. Therefore, Dorico Pro automatically creates enough pages and frames to 
display all flows in all the layouts that use those page templates.

NOTE

● The Default page template determines the page template frame chains that Dorico Pro uses 
automatically. If the First page template does not contain a music frame assigned to the 
same frame chain as the Default page template, Dorico Pro cannot use it automatically; 
instead, all pages use the Default page template.

● All frames in the same music frame chain must display the same flows and players. For 
example, you cannot have the first frame in a frame chain show just the violin but have the 
second frame show all players.

● Dorico Pro shows flows in layouts as many times as you want, not only once. Therefore, if 
you want to change the formatting of some flows in a particular layout, such as showing 
them in layout frame chains instead of the page template frame chain, but do not want 
those flows to appear more than once, you must remove those flows from the Filter by 
Flows list on the page template frame chain. As this affects which flows are automatically 
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displayed in all layouts that use the same page template, we recommend that in such 
cases you create a separate page template for the layout in which you want to change the 
formatting.

● Music frames on imported page templates are automatically assigned to their own frame 
chain, regardless of the frame chain to which they were originally assigned in their source 
page template set.

Layout frame chains

Layout frame chains can only be created and edited on individual pages in layouts. If you create 
a music frame and assign it to a layout frame chain in a layout, it is only displayed on that page 
in that layout and starts its own frame chain. If you want the music frame to be continued on 
subsequent pages, you must create music frames on all the pages in the layout on which you 
want the chain to appear and assign all of these frames to the same layout frame chain.

Frame chains that start with an “L”, such as “LA”, are layout frame chains. You can have multiple 
layout frame chains on each page, such as “LA” and “LB”.

NOTE

● All frames in the same music frame chain must display the same flows and players. For 
example, you cannot have the first frame in a frame chain show just the violin but have the 
second frame show all players.

● Assigning flows to layout frame chains does not stop those flows also appearing in the page 
template frame chain, if the frame chain in the page template applied to the layout is set to 
include those flows. By default, page template frame chains are set to display all flows in the 
project.

RELATED LINKS
Page templates on page 527
Page template editor on page 540
Layouts in Dorico on page 27
Importing page templates on page 537
Assigning music frames to frame chains on page 571
Assigning flows to frame chains on page 573
Assigning players to frame chains on page 574
Deleting frames on page 567

Music frame selectors
When Frames  is selected in the Engrave toolbox, music frames show selectors that allow 
you to change what music is displayed in the frame; for example, by changing which flows and 
players are assigned to each frame chain.

Selectors on music frames allow you to control which flows and players are displayed in frame 
chains, and the order in which the selected music is shown in frames on the page. Frame chains 
can include any number of frames, including only a single music frame.
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Every music frame shows the following selectors:

1 Frame Chain

Shows the current frame chain of the frame and allows you to change the frame chain to 
which the frame is assigned. Frame chains that start with an “M” are page template frame 
chains, while frame chains that start with an “L” are layout frame chains.

The second letter allows you to identify different frame chains of the same type. It is 
automatically generated and reflects the order in which you created the frame chains; for 
example, “LA” is the first layout frame chain you create in the layout and “LB” is the second.

2 Frame Order

Allows you to specify the order in which music flows through frames when two or more 
music frames on the same page are assigned to the same frame chain. For example, when 
the Frame Order is 1, that frame is the first frame in the frame chain.

3 Filter by Flow

Allows you to change the flows displayed in the frame chain or choose to show blank staves 
in the music frame. For example, if you have multiple flows in your project, you can choose 
to show only a single flow, a selection of flows, or all flows.

4 Filter by Player

Allows you to change the players displayed in the frame chain. For example, if you have 
multiple players in your project, you can choose to show only a single player, multiple 
players, or all players.

NOTE

You can only edit the Filter by Flow and Filter by Player selectors of page template music 
frames on page templates in the page template editor.

RELATED LINKS
Engrave toolbox on page 514
Frame constraints on page 590
Changing the size/shape of frames on page 564
Showing blank staves in frames on page 700

Assigning music frames to frame chains

You can change the frame chains to which music frames belong. For example, if you want to 
control what music appears in specific music frames. This applies to both page template and 
layout music frames.

NOTE

● New music frames on a page always start a new frame chain, regardless of their type.

● If the First page template does not contain a music frame assigned to the same frame chain 
as the Default page template, Dorico Pro cannot use it automatically; instead, all pages use 
the Default page template.
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PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● If you want to assign music frames to frame chains on a page template, you have opened 
the page template in the page template editor.

PROCEDURE

1. In Engrave mode, click Frame Chain  in the music frame whose frame chain you want 
to change.

2. In the Frame Chain list, select the frame chain to which you want to assign the music frame.

NOTE

● You cannot select layout frame chains for frames in the page template editor.

● If you do not want to use any of the available frame chains, click Unlink.

3. Click outside of the selector to close it.

RESULT
The music frame is assigned to the selected frame chain. All settings from the frame chain are 
applied to the frame, such as the players and flows displayed.

RELATED LINKS
Page template editor on page 540
Creating page templates on page 535
Assigning flows to frame chains on page 573
Assigning players to frame chains on page 574
Showing blank staves in frames on page 700
Applying page template sets to layouts on page 692
Changing when the First page template is used on page 706

Unlinking music frames from frame chains

You can unlink music frames from music frame chains; for example, if you want to assign a music 
frame to a new frame chain without deleting it.

PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● If you want to unlink frames from music frame chains on a page template, you have opened 
the page template in the page template editor.

PROCEDURE

1. In Engrave mode, click Frame Chain  in the music frame you want to unlink.

2. At the bottom of the Frame Chain list, click Unlink.

RESULT
The music frame is unlinked from its previous frame chain. A new frame chain is automatically 
created for the unlinked frame.

● Unlinking a layout music frame from a layout frame chain changes it to a new layout frame 
chain.
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● Unlinking a layout music frame from a page template frame chain changes it to a new layout 
frame.

● Unlinking a page template music frame from a page template frame chain changes it to a 
new page template frame chain.

Changing the order of music frames

If you have at least two music frames of the same type in the same frame chain on a page, you 
can change the order in which music is displayed across the frames.

PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● If you want to change the order of music frames on a page template, you have opened the 
page template in the page template editor.

PROCEDURE

1. In Engrave mode, click Frame Order  in one of the music frames whose order you want to 
change.

2. Select the ordinal number for this frame from the Frame Order menu.

3. Click outside of the selector to close it.

RESULT
The position of the selected frame in the frame chain order is changed by exchanging its order 
number with the frame previously assigned that number. For example, changing the number of 
the second frame in a frame chain to 1 causes the frame originally number 1 to become number 
2 in the frame chain order.

Assigning flows to frame chains

You can change which flows are included in each frame chain; for example, if you want to exclude 
some flows from the page template frame chain because you want those flows to appear in 
layout frame chains instead.

NOTE

● You can assign flows to both page template frame chains and layout frame chains. However, 
you can only change the flows assigned to layout frame chains in individual layouts, and you 
can only change the flows assigned to page template frame chains in the page template 
editor.

● Changing the assigned flows affects all frames in the same frame chain.

PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● If you want to change the flows assigned to music frame chains on a page template, you 
have opened the page template in the page template editor.

PROCEDURE

1. In Engrave mode, click Flows  in a music frame belonging to the frame chain 
whose assigned flows you want to change.

2. In the Filter by Flow list, select the flows you want to assign to the frame chain in one of the 
following ways:
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● To assign all flows, click All.

● To assign specific flows, click Selected and activate each required flow.

● To assign no flows, click Blank Staves.

3. Click outside of the selector to close it.

RESULT
All frames in the same frame chain are updated to display all flows, only the selected flows, or 
blank staves.

NOTE

If you changed the flows assigned to a page template music frame, the number of pages in the 
layouts to which the page template set is applied automatically updates and the casting off can 
change. For example, if you assigned an extra flow to the page template frame chain, enough 
extra pages and frames to display that flow are added to the corresponding layouts.

RELATED LINKS
Page template editor on page 540
Creating page templates on page 535
Customizing page templates on page 541
Casting off on page 728
Showing blank staves in frames on page 700
Applying page template sets to layouts on page 692
Assigning flows to layouts on page 172
Deleting pages on page 704

Assigning players to frame chains

You can change which players are included in each frame chain; for example, if you are writing a 
piano duet and only want to show one piano on left pages and the other piano on right pages.

NOTE

● You can assign players to both page template frame chains and layout frame chains. 
However, you can only change the players assigned to layout frame chains in individual 
layouts, and you can only change the players assigned to page template frame chains in the 
page template editor.

● Changing the assigned players affects all frames in the frame chain.

PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● If you want to change the players assigned to music frame chains on a page template, you 
have opened the page template in the page template editor.

PROCEDURE

1. In Engrave mode, click Players  in a music frame belonging to the frame chain 
whose assigned players you want to change.

2. In the Filter by Player list, activate each player you want to assign to the music frame.

3. Click outside of the selector to close it.
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RESULT
All frames in the same frame chain are updated to display the selected players.

NOTE

● If you changed the players assigned to a page template music frame, the number of pages 
in the layouts to which the page template set is applied automatically updates and the 
casting off can change. For example, if you removed a player from the page template frame 
chain, fewer pages and frames might be required in the corresponding layouts.

● The staff size is not changed automatically, meaning staves can overlap in small frames in 
the frame chain.

RELATED LINKS
Staff size on page 716
Applying page template sets to layouts on page 692
Page template editor on page 540
Creating page templates on page 535
Casting off on page 728

Text frames
Text frames allow you to display text, including tokens, on pages independently of rhythmic 
positions in flows.

You can open the text editor for individual frames in any of the following ways:

● Select Frames  in the Engrave toolbox, select the text frame, and press Return .

TIP

You can switch between selecting a frame handle and the whole frame by pressing Tab .

● Double-click within the text frame.

EXAMPLE
By default on the first page in part layouts, there are four text frames at the top of the page. 
These frames display the layout name, the project title, the project lyricist, and the project 
composer.

Text frames on the first page in a piano part layout, with the project title frame selected

NOTE

Adding text frames to pages individually, and not on a page template, is considered a page 
template override, which is a type of page format change.
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RELATED LINKS
Text formatting on page 845
Inputting frames on page 562
Insert Music Text dialog on page 391
Changing the default horizontal alignment of text styles on page 851
Changing the horizontal alignment of text in text frames on page 588
Changing the size/shape of frames on page 564
Page format changes on page 542
Types of text on page 1607
Project Info dialog on page 78
Page templates on page 527

Tokens
Tokens are codes that you can use as substitutes for information stored in your project, such 
as titles, composers, and the time and date. This can reduce the risk of mistakes or outdated 
information appearing in your project. Tokens are also known as “wildcards” or “text codes”.

For example, if you use a token for the title of your project, you can change the project title in the 
Project Info dialog as often as you want, and the project title in every layout in your project is 
updated automatically.

Tokens can refer to information in the Project Info dialog, including for the whole project or 
each flow individually. Tokens can also refer to the current time and date or the time and date 
the project was last saved.

NOTE

● You can only use tokens in text frames. You cannot use tokens in text items.

● Flow tokens refer to the nearest flow below the top edge of their text frame and on the same 
page. When the top edge of a text frame containing a flow token is in line with or above the 
top staff line of the first staff in a system, it then refers to that flow.

You can specify the flow number to which you want flow tokens to refer, such as 
{@flow2title@}. This always shows the specified flow, regardless of the token’s position.

If you want to use tokens that refer to flow information on pages that contain no music, 
such as title pages, you must specify the flow number in the token. For example, if you use 
{@flowtitle@} on a title page containing no music frames, the token does not display any 
information, but {@flow1title@} displays the title of the first flow in your project.

You can see the flow number of each flow in the Flows panel in Setup mode.

● You can access all the available tokens from the context menu when the cursor is inside a 
text frame. In the context menu, tokens are organized into submenus.

The following tokens are available in Dorico Pro:

General tokens

Description Token

Project file name {@projectfilename@}

Path to the project’s save location, including 
the project file name

{@projectfilepath@}
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Player tokens

Description Token

Player list {@playerlist@}

Player names {@playernames@}

Layout tokens

Description Token

Layout name {@layoutname@}

Layout number, as set in the Layouts panel in 
Setup mode

{@layoutnumber@}

Layout transposition

NOTE

Uses your instrument language setting.

{@layouttransposition@}

Staff label tokens

Music symbol Token

Full staff labels of the players in the current 
layout

{@staffLabelsFull@}

Abbreviated staff labels of the players in the 
current layout

{@staffLabelsShort@}

NOTE

● You can use staff label tokens as an alternative way to name part layouts, instead of using 
the default {@layoutName@} token shown at the top left of the first page in part layouts.

● Staff label tokens might not exactly match the appearance of staff labels shown before initial 
barlines; however, staff label tokens respect your per-layout options for how transpositions 
appear in staff labels.

Music symbol tokens

Music symbol Token

Flat accidental: ♭ {@flat@}
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Music symbol Token

Sharp accidental: ♯ {@sharp@}

Natural accidental: ♮ {@natural@}

Treble clef (G clef) {@gClef@}

Bass clef (F clef) {@fClef@}

Alto clef (C clef) {@cClef@}

Fermata above {@U+E4C0@}

TIP

● This list is not comprehensive, as you can enter the code point for any SMuFL symbol within 
a token. You can find the necessary code points in the SMuFL specification online.

● Music symbol tokens in text frames automatically use the Music text character style, which 
is set to Bravura Text by default.

● You can include music symbol tokens in fields in the Project Info dialog. For example, if you 
enter Symphony in B{@flat@} major into the Title field, the title displayed in text frames 
using the corresponding title token is Symphony in B♭ major.

● You can also enter music symbols in text items and text frames using the Insert Music Text 
dialog.

Project/Flow information tokens

Field in the Project Info 
dialog

Token for Project page Token for Flow pages

Title {@projecttitle@} {@flowtitle@}

Subtitle {@projectsubtitle@} {@flowsubtitle@}

Dedication {@projectdedication@} {@flowdedication@}

Composer {@projectcomposer@} {@flowcomposer@}

Arranger {@projectarranger@} {@flowarranger@}

Lyricist {@projectlyricist@} {@flowlyricist@}

Artist {@projectartist@} {@flowartist@}

Copyist {@projectcopyist@} {@flowcopyist@}

Publisher {@projectpublisher@} {@flowpublisher@}
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Field in the Project Info 
dialog

Token for Project page Token for Flow pages

Editor {@projecteditor@} {@floweditor@}

Copyright {@projectcopyright@} {@flowcopyright@}

Work number {@projectworknumber@} {@flowworknumber@}

Composer dates {@projectcomposerdates@} {@flowcomposerdates@}

Composition year {@projectcompositionyear@} {@flowcompositionyear@}

Other information {@projectotherinfo@} {@flowotherinfo@}

Flow tokens

Per-flow token function Token

Flow number of the current flow, according to its 
position in the project

{@flownumber@}

Flow number of the current flow, according to its 
position in the current layout

{@flowInLayoutNumber@}

Flow number of the current flow shown in lower case 
Roman numerals, such as iii or xvi

{@flowNumberRomanLower@}

Flow number of the current flow shown in upper case 
Roman numerals, such as III or XVI

{@flowNumberRomanUpper@}

Duration of the current flow in minutes and seconds, 
using smart quotes

{@flowDuration@}

Duration of the current flow in minutes and seconds, 
using straight quotes

{@flowDurationStraightQuotes@}

Duration of the current flow in minutes and seconds, 
using primes

{@flowDurationPrimes@}

Duration of the specified flow “n” in minutes and 
seconds, such as {@flow3Duration@}

{@flownDuration@}, 
{@flownDurationStraightQuotes@}
, or {@flownDurationPrimes@}
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Page number tokens

Page number token function Token

Page number {@page@}

Total number of pages in the layout {@pageCount@}

Number of this page within the current flow, counting 
from 1 for the first page of the flow and including pages 
with no displayed page number

{@flowPage@}

Total number of pages in the current flow {@flowPageCount@}

The displayed page number on which the specified flow 
“n” begins, such as {@flow3FirstPage@}

{@flownFirstPage@}

NOTE

{@flowPage@} and {@flowPageCount@} tokens only consider the flow that is active at the 
beginning of the first system of the music frame closest to the top left corner of the page on 
which the tokens are used.

Time/Date tokens: project last saved

Time/Date description Time/Date example Token

Standard date and time string 
(locale dependent)

Sun Dec 31 11:10:12 2017 {@projectdate@}

Four-digit year 2017 {@projectdateyear@}

Two-digit year 17 {@projectdateyearshort@}

Full month name (locale 
dependent)

October {@projectdatemonth@}

Short month name (locale 
dependent)

Oct {@projectdatemonthshort@}

Month as a decimal number, 
range 1-12

10 {@projectdatemonthnum@}

Full weekday name (locale 
dependent)

Friday {@projectdateday@}

Abbreviated weekday name 
(locale dependent)

Fri {@projectdatedayshort@}
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Time/Date description Time/Date example Token

Day of month as decimal 
number, range 1-31

24 {@projectdatedaynum@}

ISO 8601 date 2017-12-31 {@projectdateymd@}

Month day, year December 31, 2017 {@projectdatemdy@}

Day month year 31 December 2017 {@projectdatedmy@}

Time representation (locale 
dependent)

11:10:12 {@projectdatetime@}

Hours:minutes, hour in 24-
hour clock range

23:10 {@projectdatetimeHHMM@}

Hours:minutes:seconds, hour 
in 24-hour clock range

13:02:24 {@projectdatetimeHHMMSS@}

Hour in 24-hour clock range 23 {@projectdatetimehour24@}

Hour in 12-hour clock range 11 {@projectdatetimehour12@}

Minute as decimal number, 
range 00-59

10 {@projectdatetimeminute@}

Second as decimal number, 
range 00-59

44 {@projectdatetimesecond@}

Time/Date tokens: current time and date

Time/Date description Time/Date example Token

Standard date and time string 
(locale dependent)

Sun Dec 31 11:10:12 2017 {@date@}

Four-digit year 2017 {@dateyear@}

Two-digit year 17 {@dateyearshort@}

Full month name (locale 
dependent)

October {@datemonth@}

Short month name (locale 
dependent)

Oct {@datemonthshort@}

Month as a decimal number, 
range 1-12

10 {@datemonthnum@}
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Time/Date description Time/Date example Token

Full weekday name (locale 
dependent)

Friday {@dateday@}

Abbreviated weekday name 
(locale dependent)

Fri {@datedayshort@}

Day of month as decimal 
number, range 1-31

24 {@datedaynum@}

ISO 8601 date 2017-12-31 {@dateymd@}

Month day, year December 31, 2017 {@datemdy@}

Day month year 31 December 2017 {@datedmy@}

Time representation (locale 
dependent)

11:10:12 {@datetime@}

Hours:minutes, hour in 24-
hour clock range

23:10 {@datetimeHHMM@}

Hours:minutes:seconds, hour 
in 24-hour clock range

13:02:24 {@datetimeHHMMSS@}

Hour in 24-hour clock range 23 {@datetimehour24@}

Hour in 12-hour clock range 11 {@datetimehour12@}

Minute as decimal number, 
range 00-59

10 {@datetimeminute@}

Second as decimal number, 
range 00-59

44 {@datetimesecond@}

RELATED LINKS
Project Info dialog on page 78
Player, layout, and instrument names on page 181
Flow names and flow titles on page 188
Insert Music Text dialog on page 391
Renumbering layouts on page 175
Reordering flows on page 168
Instrument transpositions in staff labels on page 1536
Changing the language for instrument names on page 60
Concert vs. transposed pitch on page 174
Editing layout transposition text on page 1191

Engrave mode
Frames 

582
Dorico Pro 4.3.30



Entering text in text frames
You can enter text in text frames, format the text, and insert separate paragraphs and line 
breaks. You can also edit existing text in text frames; for example, if you later want text to be 
italic instead of bold.

PREREQUISITE
If you want to enter text in a text frame on a page template, you have opened the page template 
in the page template editor.

PROCEDURE

1. In Engrave mode, double-click the text frame into which you want to enter text to open the 
text editor.

TIP

When Frames  is selected in the Engrave toolbox, you can also select text frames and 
press Return .

2. Enter the text you want.

● To insert a token, right-click in the text frame and choose the required token from the 
context menu.

● To insert a music symbol, right-click in the text frame and choose Insert Music Text 
from the context menu to open the Insert Music Text dialog. Select the music symbol 
you want to insert, then click OK.

● To insert a line break, press Return .

3. Optional: Format the text using the text editor options.

TIP

You can select specific words and paragraphs to format only the selected text.

4. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
Text is entered into the text frame. Tokens and music symbols are inserted at the cursor position.

When you insert line breaks, the cursor jumps to the beginning of the new line.

NOTE

If you override the paragraph style of text in an individual text item or text frame, such as by 
making text bold, any changes you later make to corresponding parameters of the paragraph 
style are not applied to the overridden text. However, font size overrides are combined with the 
font size in the paragraph style.

RELATED LINKS
Insert Music Text dialog on page 391
Paragraph Styles dialog on page 848
Page template editor on page 540
Creating page templates on page 535
Removing page template overrides on page 545
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Text editor options in Engrave mode

The text editor allows you to add and format text. In Engrave mode, it opens when you enter or 
edit text in a text frame.

The text editor provides the following options:

1 Character Style

Allows you to change the appearance of selected text within paragraphs. This overrides the 
paragraph style applied to the corresponding paragraph.

2 Paragraph Style

Allows you to change the paragraph style applied to the selected paragraphs. Depending on 
the paragraph style, this can change the appearance, formatting, and alignment of the text.

3 Font

Allows you to change the font family of selected text.

4 Font Style

Allows you to change the font style of selected text.

NOTE

● Depending on the font selected, some font styles might not be available.

● You can also change the font style using the following standard key commands:

● Ctrl/Cmd-B  for bold

● Ctrl/Cmd-I  for italic

5 Font Size

Allows you to change the size of selected text.

TIP

You can also change the font size using the following key commands:

● Ctrl/Cmd-Shift-.  to increase the font size

● Ctrl/Cmd-Shift-,  to decrease the font size

6 Font Stretch

Allows you to make selected text wider or narrower.

7 Baseline Shift

Allows you to shift the baseline of selected text gradually up or down.

8 Letter Spacing

Allows you to increase/decrease the space between the characters of selected text.

9 Word Spacing

Allows you to increase/decrease the space between the words of selected text.

10 Alignment
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Allows you to choose one of the following alignments for the selected paragraphs relative to 
frame edges:

● Align Left

● Align Center

● Align Right

● Justify

11 Line Types

Allows you to show any of the following types of lines, in any combination, on selected text:

● Underline

● Overline

● Strikethrough

TIP

You can also make selected text underlined by pressing Ctrl/Cmd-U .

12 Script Types

Allows you to position selected text in one of the following positions relative to the text on 
the baseline:

● Superscript

● Subscript

13 Foreground Color

Allows you to change the color of selected text.

14 Background Color

Allows you to change the background color of selected text.

NOTE

If you override the paragraph style of text in an individual text item or text frame, such as by 
making text bold, any changes you later make to corresponding parameters of the paragraph 
style are not applied to the overridden text. However, font size overrides are combined with the 
font size in the paragraph style.

RELATED LINKS
Inputting text items on page 388
Paragraph Styles dialog on page 848
Character Styles dialog on page 851
Missing Fonts dialog on page 76
Text editor options in Write mode on page 389

Adding borders to text frames
You can add borders to individual text frames; for example, if you want to make their boundaries 
clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Frames  is selected in the Engrave toolbox.
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● If you want to add borders to text frames on a page template, you have opened the page 
template in the page template editor.

PROCEDURE

1. In Engrave mode, select the text frames to which you want to add borders.

2. In the Properties panel, activate Show border in the Text group.

RESULT
Borders are added to the selected text frames.

TIP

● You can show borders around text in text frames by using paragraph styles set to show 
borders by default. However, we recommend only doing this for text frames that contain a 
single paragraph.

● You can change the border style used by each paragraph style by default in the Paragraph 
Styles dialog.

AFTER COMPLETING THIS TASK
You can change the thickness of text frame borders and you can change the padding between 
the borders and contents of text frames.

RELATED LINKS
Properties panel on page 769
Hiding/Showing zones on page 47
Page template editor on page 540
Adding borders to text items on page 1614
Changing the style of text item borders on page 1615
Hiding/Showing borders on layout names on page 1192
Paragraph Styles dialog on page 848

Changing the thickness of text frame borders

You can change the thickness of text frame borders individually. There is no default setting for 
the thickness of text frame borders.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Frames  is selected in the Engrave toolbox.

● If you want to change the thickness of text frame borders on a page template, you have 
opened the page template in the page template editor.

PROCEDURE

1. In Engrave mode, select the text frames whose border thickness you want to change.

2. In the Properties panel, change the value for Border thickness in the Text group.

RELATED LINKS
Changing the thickness of text item borders on page 1616
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Changing the padding in text frames

You can change the padding of individual text frames, which affects the distance between the 
edges of frames and the text within them.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Frames  is selected in the Engrave toolbox.

● If you want to change the padding of text frames on a page template, you have opened the 
page template in the page template editor.

PROCEDURE

1. In Engrave mode, select the text frames whose padding you want to change.

2. In the Properties panel, activate Padding in the Text group.

3. Change the value in the value field.

RESULT
The padding between all edges of the selected text frames and the text within them is changed.

Changing the vertical alignment of text in text frames
You can change the vertical alignment of text in text frames. You can do this on page templates, 
which changes the alignment of the selected text frames on all pages that use the page 
template, and on individual pages, which only changes the alignment of the selected text frames 
on that page.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Frames  is selected in the Engrave toolbox.

● If you want to change the vertical alignment of text on a page template, you have opened 
the page template in the page template editor.

PROCEDURE

1. In Engrave mode, select the frames whose text vertical alignment you want to change.

2. In the Properties panel, select one of the following options from the Vertical alignment 
menu in the Text group:

● Top

● Center

● Bottom

RESULT
The vertical alignment of text in the selected text frames is changed.
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NOTE

Changing the vertical alignment of text does not override its paragraph style. Any changes 
you make later to the paragraph styles of text whose vertical alignment has been changed are 
applied to the text.

RELATED LINKS
Properties panel on page 769
Hiding/Showing zones on page 47
Page template editor on page 540
Moving frames on page 563
Changing the size/shape of frames on page 564
Creating page templates on page 535
Text formatting on page 845
Paragraph Styles dialog on page 848
Moving items graphically on page 609
Aligning text items with the start of systems on page 1612

Changing the horizontal alignment of text in text frames
You can change the horizontal alignment of individual paragraphs in text frames, independently 
of the corresponding paragraph style. You can do this on page templates, which changes the 
alignment of the selected text on all pages that use the page template, and on individual pages, 
which only changes the alignment of the selected text on that page.

PREREQUISITE

● Graphic Editing  or Frames  is selected in the Engrave toolbox.

● If you want to change the horizontal alignment of text on a page template, you have opened 
the page template in the page template editor.

PROCEDURE

1. In Engrave mode, double-click a text frame to open the text editor for that frame.

TIP

When Frames  is selected in the Engrave toolbox, you can also select text frames and 
press Return .

2. Select the text in the text frame whose horizontal alignment you want to change.

TIP

Each paragraph in the same text frame can have a different horizontal alignment.

3. Choose the horizontal alignment you want in the text editor.

4. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
The horizontal alignment of the selected text is changed.
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NOTE

Because this overrides the default horizontal alignment of the corresponding paragraph style, 
any changes you later make to the horizontal alignment of the paragraph style are not applied to 
the overridden text.

Graphics frames
Graphics frames allow you to display images alongside your music, such as a logo or a decorative 
header/footer.

You can load the following graphics file formats into graphics frames:

● .jpg or .jpeg

● .png

● .svg

Empty graphics frame Graphics frame with image loaded

NOTE

Graphics frames on page templates can only show a single image in all layouts. If you change the 
image in a graphics frame from a page template in one layout, this updates the page template 
and affects all layouts.

RELATED LINKS
Inputting frames on page 562
Changing the size/shape of frames on page 564

Loading images into graphics frames
You can load images from your computer or server into your score.

PREREQUISITE
You have input a graphics frame, either on a page template or an individual page.

PROCEDURE

1. In Engrave mode, double-click in the graphics frame to open the File Explorer/macOS Finder.

TIP

When Frames  is selected in the Engrave toolbox, you can also select graphics frames and 
press Return .

2. Locate and select the file you want to load into the graphics frame.
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3. Click Open.

RESULT
The selected image is loaded into the graphics frame.

NOTE

Graphics frames on page templates can only show a single image in all layouts. If you change the 
image in a graphics frame from a page template in one layout, this updates the page template 
and affects all layouts.

RELATED LINKS
Inputting frames on page 562
Page templates on page 527

Frame constraints
In Dorico Pro, constraints define the relationship between each of the four sides of a frame and 
the corresponding page margins.

Frame constraints lock each side of frames to the corresponding page margin, meaning you can 
change the page size, orientation, and/or page margins while keeping the frame in proportion. 
For example, a music frame that fills the entire height and width of a page has constraints on all 
four sides. All sides have an inset of zero, which means that the edges of the frames are in line 
with the page margins. If you change the page size and/or orientation, the frame size changes 
accordingly so that it always fills the page.

If you remove a constraint from one side of a frame, that unlocks that side of the frame from 
the page margin, meaning you can determine a fixed width/height that prevents that side of the 
frame from adjusting, even if the page size, orientation, and/or page margins change.

EXAMPLE
You have a header text frame that you want to fill the full width of pages, remain at the top of 
pages, but maintain a fixed frame height even if the page size, orientation, and/or page margins 
change.

To achieve this, you can lock the top, right, and left constraints but unlock the bottom constraint 
to give the frame a fixed height.

The unlocked bottom constraint means, for example, that the frame does not get taller if the 
page size increases, or shorter if the page size decreases.

Constraints set for a header text frame

In the Frames panel, you can define the constraints for all types of frames that are available in 
Dorico Pro. All new frames have four locked constraints by default. You can unlock the top or 
bottom constraint to give frames a fixed height, and unlock the right or left constraint to give 
frames a fixed width.
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NOTE

Frames must have at least one locked constraint from each pair of top/bottom and right/left, 
such as top and right.

RELATED LINKS
Frames panel on page 519
Inputting frames on page 562
Changing the page size and/or orientation on page 691
Changing page margins on page 692

Defining frame constraints
You can lock/unlock constraints on each side of frames independently; for example, if you want 
to unlock the bottom constraint only for frames that you want to have a fixed height.

PREREQUISITE

● The left zone is shown.

● Frames  is selected in the Engrave toolbox.

● If you want to define the constraints of frames on a page template, you have opened the 
page template in the page template editor.

PROCEDURE

1. In Engrave mode, select the frame whose constraints you want to define.

NOTE

You can only define constraints for a single frame at a time.

2. In the Constraints section of the Frames panel, click the constraints that correspond to the 
sides of the frame that you want to lock/unlock.

Locked constraint Unlocked constraint

NOTE

Frames must have at least one locked constraint from each pair of top/bottom and right/left, 
such as top and right.

RESULT
The constraints of the selected frame are changed. This affects which edges are locked to the 
corresponding page margin and whether the size and/or shape of the frame is changed on 
pages with different page sizes, orientations, and/or page margins. For example, frames with an 
unlocked top or bottom constraint have a fixed height. Similarly, frames with an unlocked right 
or left constraint have a fixed width.

AFTER COMPLETING THIS TASK
You can change the size and/or shape of frames.
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RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Frames panel on page 519
Page template editor on page 540
Creating page templates on page 535
Changing the size/shape of frames on page 564

Graphic slices
Graphic slices allow you to export portions of pages as graphics files; for example, to save small 
musical extracts for use in performance instructions. They exist as fixed frames on specific pages, 
and function in a similar way to frames.

● You can view, input, and edit graphic slices when Graphic Slices  is selected in the Engrave 
toolbox.

Once created, graphic slices remain on the page on which they were created. This makes it easy 
to re-export an extract if, for example, you change the music inside the graphic slice.

You can export graphic slices as the following graphics file formats:

● .pdf

● .png

● .svg

● .tiff

A passage with multiple graphic slices positioned around specific notes and gestures to be included in 
performance instructions

NOTE

● Graphic slices are only shown on pages when Graphic Slices  is selected in the Engrave 
toolbox.

● Graphic slices are layout-specific and fixed to pages rather than to music. They may appear 
with different sizes/shapes if you change the page size, orientation, or margins in the layout.
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RELATED LINKS
Graphic Slices panel on page 520
Graphics file formats on page 685
Exporting layouts as graphics files on page 675
Frames on page 560
Changing the page size and/or orientation on page 691
Changing page margins on page 692

Creating graphic slices
You can create graphic slices of any size and shape on pages in each layout independently; for 
example, around a few bars that you want to export as a PNG file. Graphic slices can extend into 
page margins, up to the edges of pages.

PREREQUISITE

● The left zone is shown.

● Graphic Slices  is selected in the Engrave toolbox.

PROCEDURE

1. In the Graphic Slices panel, click Create Slice.

2. Click and drag in the music area to create a graphic slice.

You can draw a graphic slice of any size and shape, as long as it fits within the page.

RESULT
When you release the mouse, a graphic slice is created on the page. It is automatically named 
Slice [n] according to how many graphic slices with default names already exist, such as Slice 2 
for the second slice.

The new slice is added to the graphic slices table in the Graphic Slices panel, ordered by page 
number.

AFTER COMPLETING THIS TASK

● You can move the graphic slice around the page or change its size/shape.

● You can export all or selected graphic slices as graphics files.

RELATED LINKS
Engrave toolbox on page 514
Left zone (Engrave mode) on page 515
Hiding/Showing zones on page 47
Graphic Slices panel on page 520

Moving graphic slices
You can move individual graphic slices around pages after they have been created.

NOTE

You cannot move graphic slices beyond page edges or to other pages. If you want graphic slices 
to appear on different pages, you must delete them from their original pages and create new 
graphic slices on the new pages.
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PREREQUISITE
Graphic Slices  is selected in the Engrave toolbox.

PROCEDURE

1. Select the graphic slices you want to move.

2. Move the graphic slices in any of the following ways:

● To move graphic slices a standard amount to the right, left, up, or down, press Alt/Opt 
plus the corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move 
graphic slices to the left.

● To move graphic slices a large amount, press Ctrl/Cmd  as well as the standard key 
command. For example, press Ctrl/Cmd-Alt/Opt-Left Arrow  to move graphic slices a 
large amount to the left.

● Click and drag them in any direction.

Changing the size/shape of graphic slices
You can change the size and shape of individual graphic slices after they have been created.

PREREQUISITE
Graphic Slices  is selected in the Engrave toolbox.

PROCEDURE

1. Select the middle handle on an edge of the graphic slice whose size or shape you want to 
change.

NOTE

You can only select a single handle on a single graphic slice at a time.

2. Move the handle in any of the following ways:

● To move it a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left.

● To move it a large amount, press Ctrl/Cmd  as well as the standard key command. For 
example, press Ctrl/Cmd-Alt/Opt-Left Arrow  to move handles a large amount to the 
left.

● Click and drag the handle to the right/left or upwards/downwards.

NOTE

You can only move handles on the right/left edges of graphic slices to the right/left. You 
can only move handles on the top/bottom edges of graphic slices upwards/downwards. For 
example, if you want to make a graphic slice wider, you can select the middle handle on the 
right edge of the graphic slice and move it to the right.

3. Optional: Repeat steps 1 and 2 for any other edge of the graphic slice you want to move to 
achieve the size and shape you want.

RESULT
The size and/or shape of the selected graphic slice is changed.
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NOTE

● Graphic slices may appear with different sizes/shapes if you change the page size, 
orientation, or margins in the layout.

● You can also change the size/shape of graphic slices by using the Left, Top, Right, and 
Bottom properties in the Frames group of the Properties panel.

RELATED LINKS
Engrave toolbox on page 514
Graphic Slices panel on page 520
Creating graphic slices on page 593
Exporting graphic slices on page 598
Deleting graphic slices on page 598
Properties panel on page 769
Frame constraints on page 590
Changing the page size and/or orientation on page 691
Changing page margins on page 692

Selecting graphic slice handles
You can select an individual handle on a graphic slice, and you can switch between having a 
handle selected and having the whole graphic slice selected.

PREREQUISITE
Graphic Slices  is selected in the Engrave toolbox.

PROCEDURE

1. Select a graphic slice handle in any of the following ways:

● Select any handle on the graphic slice and press Right Arrow / Left Arrow / Up Arrow /
Down Arrow  to select other handles around its edge.

● Select the graphic slice, press Tab  to switch to having the handle in the top left corner 
selected, then press Right Arrow / Left Arrow / Up Arrow / Down Arrow  to select other 
handles around the edge of the graphic slice.

● Click a handle on the graphic slice.

NOTE

You can only select a single handle on a single graphic slice at a time.

2. Optional: To switch back to having the whole graphic slice selected, press Tab .

EXAMPLE

Whole graphic slice selected Graphic slice with top middle handle selected
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Renaming graphic slices
You can change the names of graphic slices, which are used for their file names when exported.

PREREQUISITE

● The left zone is shown.

● Graphic Slices  is selected in the Engrave toolbox.

PROCEDURE

1. In the Graphic Slices panel, double-click in the Slice name column on the graphic slice you 
want to rename.

2. Enter a new name or edit the existing name in the text field.

3. Press Return .

Changing the image settings for graphic slices
You can change the graphics file format, color mode, and image resolution of graphic slices 
individually; for example, if you want to export some graphic slices as PDF files but others as PNG 
files.

PREREQUISITE

● The left zone is shown.

● Graphic Slices  is selected in the Engrave toolbox.

PROCEDURE

1. In the Graphic Slices panel, select the graphic slices whose image settings you want to 
change.

2. Select a graphics file format from the menu.

3. Optional: If you selected PNG or TIFF, select a resolution from the Resolution menu.

TIP

The Resolution setting does not affect PDF and SVG files as they are vector formats.

4. Choose a color mode.

● Mono exports graphic slices in black and white.

● Color exports graphic slices in full color.

NOTE

● For graphic slices that contain elements with color or opacity set, you must choose 
Color. If you select Mono, such elements appear black in the exported file.

● When exporting graphic slices with a resolution of 72 dpi, we recommend that you select 
Color. If you select Mono, staff lines can disappear.

5. Optional: Repeat steps 1 to 4 for other graphic slices whose image settings you want to 
change.

RESULT
The image settings for the selected graphic slices are changed.
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AFTER COMPLETING THIS TASK
You can export graphic slices, including graphic slices with different image settings and export 
paths simultaneously.

RELATED LINKS
Creating graphic slices on page 593
Renaming graphic slices on page 596
Graphics file formats on page 685
Monochrome and color graphics processing on page 686
Image resolution on page 685

Changing the export path for graphic slices
You can specify an export path to any folder to which you want to export graphic slices. You can 
specify a different export path for each graphic slice and still export them all simultaneously.

By default, Dorico Pro exports graphic slices into the same folder as your project file. If you have 
not saved your project yet, graphic slices are saved in your Dorico Projects folder.

PREREQUISITE

● The left zone is shown.

● Graphic Slices  is selected in the Engrave toolbox.

PROCEDURE

1. In the Graphic Slices panel, select the graphic slices whose export path you want to change.

2. Click Choose Folder  beside the Destination folder field to open the File Explorer/macOS 
Finder.

3. Locate and select the destination folder you want.

4. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Destination 
folder field.

5. Optional: Repeat steps 1 to 4 for other graphic slices whose export path you want to change.

RESULT
The export path for the selected graphic slices is changed. When exported, graphic slices use the 
name in the graphic slices table in the Graphic Slices panel for their file name.

NOTE

If the export path specified is no longer accessible, such as if you receive a project from someone 
who uses a different operating system, Dorico Pro automatically updates the export path to the 
same location as the project file.

AFTER COMPLETING THIS TASK
You can export graphic slices, including graphic slices with different image settings and export 
paths simultaneously.

RELATED LINKS
Engrave toolbox on page 514
Left zone (Engrave mode) on page 515
Hiding/Showing zones on page 47
Graphic Slices panel on page 520
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Exporting graphic slices on page 598
Renaming graphic slices on page 596

Exporting graphic slices
You can export graphic slices as a variety of graphics files, such as PDF or PNG.

TIP

You can export graphic slices with different image settings and export paths simultaneously.

PREREQUISITE

● The left zone is shown.

● Graphic Slices  is selected in the Engrave toolbox.

PROCEDURE

1. In the Graphic Slices panel, select the graphic slices you want to export in one of the 
following ways:

● To export all graphic slices, select no graphic slices.

● To export specific graphic slices only, select those graphic slices.

2. Optional: Change the image settings for the selected graphic slices.

3. Optional: Change the export path for the selected graphic slices.

4. Click Export All/Export Selected.

RESULT
Graphic slices are exported with their current image and export path settings. If you had selected 
no graphic slices, all graphic slices in the table are exported. If you selected individual graphic 
slices, only those graphic slices are exported.

TIP

You can assign a key command for Export Graphic Slices on the Key Commands page in 
Preferences.

RELATED LINKS
Changing the image settings for graphic slices on page 596
Changing the export path for graphic slices on page 597
Renaming graphic slices on page 596
Exporting layouts as graphics files on page 675
File import and export on page 82
Key Commands page in the Preferences dialog on page 63

Deleting graphic slices
You can delete individual graphic slices; for example, if the casting off in the layout has changed 
and the music the slice was originally created for is now on another page.

PREREQUISITE

● The left zone is shown.

● Graphic Slices  is selected in the Engrave toolbox.
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PROCEDURE

1. In the Graphic Slices panel, select the graphic slices you want to delete.

2. In the action bar, click Delete Graphic Slice .

RESULT
The selected graphic slices are deleted.

TIP

You can also delete graphic slices by selecting them in the music area and pressing Backspace 
or Delete .

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Graphic Slices panel on page 520
Creating graphic slices on page 593
Moving graphic slices on page 593
Casting off on page 728

Note spacing
The positions of notes and rests relative to each other, and the automatic gaps between them, 
are known as note spacing.

You can change note spacing in your project at different levels:

● Change the default note spacing in each layout in Layout Options.

● Change the note spacing from a specified point in individual frame chains in individual 
layouts.

● Change the note spacing at individual rhythmic positions and for individual notes.

TIP

● We recommend adjusting the default note spacing values, changing the note spacing for 
specific sections, or changing the staff size before moving individual notes, as in most cases 
Dorico Pro produces suitable results without the need to move individual notes.

● You can find other options that control the gaps between notes and other items, such as 
barlines and time signatures, on the Spacing Gaps page in Engraving Options.

RELATED LINKS
Moving the start/end of systems on page 608
Engraving Options dialog on page 840
Layout Options dialog on page 834
Staff spacing on page 720
Changing the default staff size on page 693
Changing the horizontal justification of final systems on page 709

Changing the default note spacing
You can change the default note spacing in each layout independently. For example, you can 
have tighter note spacing in full score layouts compared to part layouts. The options available 
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include changing the default space for quarter notes and the scale space for grace notes and 
cues.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change note spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.

4. Change the values of the options you want to change.

5. Click Apply, then Close.

RESULT
The default note spacing is changed in the selected layouts.

RELATED LINKS
Changing the horizontal justification of final systems on page 709
Positions of lyrics on page 1229
Casting off on page 728
Locking layouts on page 731

Per-layout note spacing options
Dorico Pro provides multiple options that you can use to control the default note spacing in each 
layout. You can also change how full the final system in flows must be before it is automatically 
justified.

● You can access per-layout note spacing options by opening the Layout Options dialog and 
clicking Note Spacing in the category list.

The Note Spacing page in Layout Options contains the following options:

Default space for crotchet/quarter note
Sets the default note spacing for quarter notes (crotchets). The spacing of other 
durations is scaled proportionally. Increasing the value increases note spacing, 
decreasing the value decreases note spacing. This is reflected in the preview as you 
change the value.

Minimum space for short notes
Sets the minimum note spacing for notes with short durations. This can be 
independent of the default note spacing value.

Custom spacing ratio
Sets the spacing of notes in relation to other notes according to their rhythmic values. 
For example, setting Custom spacing ratio to 2 means half notes (minims) take up 
twice as much space as quarter notes, and eighth notes (quavers) take up half as much 
space as quarter notes.

Scale space for grace notes by
Sets the note spacing for grace notes as a percentage of the note spacing normally 
used for notes of their duration. The value cannot be greater than 100%. Increasing the 
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value increases the note spacing for grace notes, decreasing the value decreases the 
note spacing for grace notes.

Scale space for cue notes by
Sets the note spacing for cues as a percentage of the note spacing normally used for 
notes of their duration. The value cannot be greater than 100%. Increasing the value 
increases the note spacing for cues, decreasing the value decreases the note spacing 
for cues.

Make space for lyrics
Controls whether or not lyrics are included in note spacing calculations. When 
deactivated, lyrics are excluded from note spacing calculations, producing a result 
where notes are spaced as if lyrics were not there.

We recommend using this option with caution and only if you intend to space lyrics 
manually, such as in tightly-spaced hymnals.

Only justify final system in flow when more than [n]% full
Allows you to change how full the final system in each flow must be before it is justified 
to the full width of the frame. By default, final systems that are 50% full or less are not 
justified.

Use optical spacing for beams between staves
When activated, stems in cross-staff beams are evenly spaced, which can mean the 
noteheads are unevenly spaced. When deactivated, noteheads in cross-staff beams are 
evenly spaced, which can mean stems appear unevenly spaced.

RELATED LINKS
Layout Options dialog on page 834
Changing to optical cross-staff beam spacing on page 1010
Creating cross-staff beams/tremolos on page 1009
Changing the paragraph style used for lyrics on page 1236

Changing note spacing from rhythmic positions
You can change note spacing values from selected rhythmic positions onwards in individual 
layouts, including changing the scale factor for grace notes and cues.

PROCEDURE

1. In Engrave mode, open the layout in which you want to change note spacing.

2. Select an item at the rhythmic position from which you want to change note spacing, and in 
the frame chain to which you want the changes to apply.

3. Choose Engrave > Note Spacing Change to open the Note Spacing Change dialog.

4. Activate the note spacing options you want to change.

5. Choose Change for each activated option.

6. Change the value of each note spacing option you want to change.

7. Click OK to save your changes and close the dialog.

RESULT
Note spacing is changed from the selected rhythmic position onwards, until the next existing 
note spacing change or the end of the flow, whichever comes first. This applies to the frame 
chain containing the selected item and the layout currently open in the music area.

A signpost is shown at the position of the note spacing change.
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RELATED LINKS
Switching between layouts on page 46
Changing the default note spacing on page 599
Adjusting note spacing at individual rhythmic positions on page 604
Changing the horizontal justification of final systems on page 709

Note Spacing Change dialog
The Note Spacing Change dialog allows you to change or reset values affecting the spacing and 
scaling of notes from selected rhythmic positions in layouts, including the scale factor for grace 
notes and cues.

● You can open the Note Spacing Change dialog in Engrave mode by choosing Engrave > 
Note Spacing Change when Graphic Editing  is selected in the Engrave toolbox and an 
item is selected in the music area.

The Note Spacing Change dialog contains the following options:

Default space for crotchet/quarter note
Sets the default note spacing for quarter notes (crotchets). The spacing of other 
durations is scaled proportionally. Increasing the value increases note spacing, 
decreasing the value decreases note spacing. This is reflected in the preview as you 
change the value.

Minimum space for short notes
Sets the minimum note spacing for notes with short durations. This can be 
independent of the default note spacing value.

Custom spacing ratio
Sets the spacing of notes in relation to other notes according to their rhythmic values. 
For example, setting Custom spacing ratio to 2 means half notes (minims) take up 
twice as much space as quarter notes, and eighth notes (quavers) take up half as much 
space as quarter notes.
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Scale space for grace notes by
Sets the note spacing for grace notes as a percentage of the note spacing normally 
used for notes of their duration. The value cannot be greater than 100%. Increasing the 
value increases the note spacing for grace notes, decreasing the value decreases the 
note spacing for grace notes.

Scale space for cue notes by
Sets the note spacing for cues as a percentage of the note spacing normally used for 
notes of their duration. The value cannot be greater than 100%. Increasing the value 
increases the note spacing for cues, decreasing the value decreases the note spacing 
for cues.

Make space for lyrics
Controls whether or not lyrics are included in note spacing calculations. When 
deactivated, lyrics are excluded from note spacing calculations, producing a result 
where notes are spaced as if lyrics were not there.

We recommend using this option with caution and only if you intend to space lyrics 
manually, such as in tightly-spaced hymnals.

Each option has an activation switch, meaning you can only change values for options that you 
have chosen to change. You can then choose one of the following options for the note spacing 
change:

Reset
Resets note spacing to the default setting in the layout, as set on the Note Spacing 
page in Layout Options.

Change
Changes note spacing in the layout to the values set.

RELATED LINKS
Per-layout note spacing options on page 600
Changing the paragraph style used for lyrics on page 1236

Resetting note spacing from rhythmic positions
You can reset changes you have made to note spacing values using the Note Spacing Change 
dialog. This applies from a selected rhythmic position onwards in the layout currently open in the 
music area.

PROCEDURE

1. In Engrave mode, open the layout in which you want to reset note spacing from a specific 
rhythmic position.

2. Select an item at the rhythmic position from which you want to reset note spacing, and in the 
frame chain to which you want the changes to apply.

3. Choose Engrave > Note Spacing Change to open the Note Spacing Change dialog.

4. Activate the note spacing options you want to reset.

5. Choose Reset for each activated option.

6. Click OK to save your changes and close the dialog.

RESULT
Note spacing is reset to the default settings in the layout for the activated options from the 
selected rhythmic position onwards, until the next existing note spacing change or the end of the 
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flow, whichever comes first. This applies to the frame chain containing the selected item and the 
layout currently open in the music area.

A signpost is shown at the position of the note spacing change.

Deleting note spacing changes
You can delete note spacing changes you have made using the Note Spacing Change dialog, 
which returns note spacing to either the previous existing note spacing change in the flow or the 
default settings in the layout.

PROCEDURE

1. Select the signposts of the note spacing changes you want to delete. You can do this in Write 
mode and Engrave mode.

2. Press Backspace or Delete .

RESULT
The selected note spacing changes are deleted. Note spacing returns to either the previous 
existing note spacing change in the flow, if one exists, or the default settings in the layout if there 
is no previous existing note spacing change. This applies until the next existing note spacing 
change or until the end of the flow, whichever comes first.

Adjusting note spacing at individual rhythmic positions
You can make adjustments to the note spacing at individual rhythmic positions independently of 
your project-wide settings.

When Note Spacing  is activated in the Engrave toolbox, the following are shown:

● Dashed lines that represent spacing columns.

● Note spacing handles: square handles on every staff for each spacing-significant item, such 
as notes, grace notes, rests, clefs, key signatures, and time signatures.

● System handles: larger square handles at the start/end of each system, which control the 
start/end horizontal position of individual systems. System handles are positioned on the top 
left and bottom right corners of each system.

Handles and dashed lines are shown when Note Spacing is activated.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a square note spacing handle on the dashed line at each rhythmic 
position whose spacing you want to adjust.
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2. Move the handles in any of the following ways:

● To increase the space to the left of selected handles, press Alt/Opt-Right Arrow .

● To decrease the space to the left selected handles, press Alt/Opt-Left Arrow .

NOTE

● To move handles by large increments, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move handles by moderate increments, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Left Arrow .

● To move handles by small increments, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● You cannot move note spacing handles with the mouse, you can only move them 
using the keyboard.

RESULT
The selected note spacing handles are moved, which increases/decreases the spacing to the 
left of their original rhythmic position. This also affects the spacing of each selected rhythmic 
position on all staves in the system. The color of the handles changes to indicate that you have 
moved them.

System breaks are automatically inserted at the start/end of each system in which you adjusted 
note spacing.

NOTE

● Moving notes too far away from their intended rhythmic positions can be misleading for 
players reading the music.

● You can also adjust the spacing of individual notes/items independently of their rhythmic 
positions.

● When Note Spacing  is activated, you cannot select or edit anything other than note 
spacing handles. To resume normal selection and editing, click Graphic Editing  in the 
Engrave toolbox or return to Write mode.
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EXAMPLE

Moving note spacing handles to the left reduces 
spacing to the left of the rhythmic position

Moving note spacing handles to the right increases 
spacing to the left of the rhythmic position

RELATED LINKS
Engrave toolbox on page 514
Changing the default note spacing on page 599
Changing note spacing from rhythmic positions on page 601
System fullness indicators on page 526
Moving the start/end of systems on page 608
Changing the horizontal justification of final systems on page 709
System breaks on page 733
Signposts on page 453

Adjusting the spacing of individual notes/items independently of their rhythmic 
positions

You can change the graphical position of notes according to their voice and some other items, 
such as key signatures, time signatures, and clefs, independently of their rhythmic positions.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the square note spacing handle at the rhythmic position of the 
note/item you want to move graphically.

A circular handle appears beside each voice/item.

2. Press Tab  to select the circular handle.

3. Move the handle in any of the following ways:

● To move it a standard amount to the right or left, press Alt/Opt  plus the corresponding 
arrow key. For example, press Alt/Opt-Left Arrow  to move handles to the left.
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● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.

RESULT
The graphical position of the selected note/item is changed without changing the note spacing of 
its rhythmic position. If other notes exist in the same voice at the same rhythmic position, they 
are also moved.

System breaks are automatically inserted at the start/end of each system in which you adjusted 
the position of individual notes/items.

EXAMPLE

Removing individual changes to note spacing
You can remove changes you have made to the note spacing at individual rhythmic positions and 
reset note spacing handles to their original default positions.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the note spacing handles you want to restore to their original 
positions.

2. Press Backspace or Delete .

RESULT
The selected rhythmic positions are reset to their default positions.

Engrave mode
Note spacing 

607
Dorico Pro 4.3.30



TIP

You can also reset all note spacing changes within selected systems, frames, or all note spacing 
changes in the layout by choosing one of the options in the Engrave > Note Spacing menu.

Moving the start/end of systems
You can change the horizontal start/end position of each system individually; for example, if you 
want to indent a single system or increase the gap before an individual coda section.

NOTE

● If you want to increase the space before staff labels, you can change the minimum indent for 
systems with staff labels.

● If you want to change the end position of systems because they do not fill the entire width of 
the page, you can change the minimum fullness for horizontal justification.

● If you want to change the width of all systems on a page by the same amount, you can 
change the width of the music frame.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the system handle at the start/end of each system whose start/end 
position you want to change.

System handle at the start of a system System handle at the end of a system

2. Move the handles in any of the following ways:

● To move them a standard amount to the right or left, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.
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RESULT
The start/end position of the selected systems is changed. Notes on the selected systems appear 
more/less tightly spaced, depending on whether moving the system handles made their system 
narrower or wider.

Dorico Pro automatically inserts system breaks at the start of the moved and subsequent 
systems.

RELATED LINKS
Engrave toolbox on page 514
System indents on page 1565
Changing the horizontal justification of final systems on page 709
Changing the first system indent on page 1566
Changing the minimum indent for systems with staff labels on page 1534
Positions of repeat markers on page 1454
Music frames on page 568
System breaks on page 733

Moving items graphically
You can move items graphically without changing the rhythmic positions or notes to which they 
are attached; for example, to offset individual items on specific pages without either moving 
other items of the same type or changing their default positions, as set in Engraving Options. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

You can move individual instances of system objects, such as tempo marks or system-attached 
text, independently of other instances shown at different staff positions. You can also move each 
end of items with duration, such as gradual dynamics or octave lines, independently, allowing 
you to adjust their graphical length and angle.

NOTE

● These steps do not apply to the following: text in text frames, accidentals, notes, clefs, 
barlines, key signatures, or time signatures shown on staves.

● You can only move some items and handles in specific directions. For example, you can 
move articulations upwards/downwards but not to the right/left. Similarly, you can only 
move the end handles on octave lines to the right/left. When using the mouse, you can 
only move whole guitar bends and vibrato bar dives/returns upwards/downwards. You 
cannot move individual lyrics upwards/downwards, but you can move lyric lines upwards/
downwards on a per-system basis.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select any of the following that you want to move.

● Whole items or segments of items that cross system/frame breaks

● Lines extending from items, such as figured bass hold lines or lyric extender lines

● Individual handles on items
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TIP

● You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

● You can cycle through handles on a selected item by pressing Tab .

2. Move the selected items in any of the following ways:

● To move items a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move items to the 
left. This moves beams by 1/4 space and all other items by 1/8 space per press.

● To move items a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves items by 1 space per press.

● To move items a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves items by 1/2 space per press.

● To move items a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves items by 1/32 space per 
press.

● Click and drag them in any direction.

NOTE

You cannot move vibrato bar scoops using the mouse.

RESULT
The selected items are moved graphically without changing the rhythmic positions or notes to 
which they are attached. Attachment lines link items to the rhythmic positions to which they 
apply, so it is always clear where they belong. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Moving some items, such as notehead brackets and jazz articulations, causes other nearby items, 
such as ties and slurs, to move automatically to avoid collisions. This might affect note spacing 
and casting off.

If you move dynamics linked to other dynamics, all dynamics linked to the selected dynamics in 
the current layout are also moved.

Moving items with continuation or hold lines, such as playing techniques or figured bass, moves 
them both together. Moving continuation/hold lines or continuation/hold line handles moves the 
continuation/hold lines independently of the item. Dorico Pro automatically lengthens hold lines 
between figured bass suspensions and resolutions when you move resolution figures.

Lengthening/Shortening lyric hyphens does not change the size or shape of the hyphens 
themselves. Instead, you increase/decrease the distance between the handles in which hyphens 
can appear.

By default, player labels erase their backgrounds if positioned in the staff so they do not collide 
with staff lines.

NOTE

● Moving the start handle of hairpins with the keyboard changes the vertical position of whole 
hairpins, not their angles. You must change the end offset position as well to change the 
angle of hairpins. Dragging hairpin handles with the mouse always changes the angle.

● You can change the default positions of most objects on the corresponding page in 
Engraving Options.
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● Properties that control the graphic offsets of items are activated automatically when you 
move items. You can find these properties in the corresponding group of the Properties 
panel for the item, or in the Common group for some items, such as text items and lyrics.

Some offset properties have separate value fields for horizontal offsets on the X axis and 
vertical offsets on the Y axis. Similarly, items with length or duration have separate offset 
properties for each end.

You can also use these properties to move items graphically by changing the values in 
the value fields. Deactivating offset properties resets the selected items to their default 
positions.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Moving notes/items rhythmically on page 465
Moving figured bass resolutions on page 1150
Lengthening/Shortening items on page 436
Changing the vertical order of playing techniques on page 1393
Engraving Options dialog on page 840
Properties panel on page 769
Casting off on page 728
Note spacing on page 599
Adjusting note spacing at individual rhythmic positions on page 604
Moving clefs graphically on page 1072
Moving barlines graphically on page 975
Moving key signatures graphically on page 1215
Moving time signatures graphically on page 1653
Moving accidentals graphically on page 947
Changing the alignment of chord symbols relative to notes on page 1042
Guitar bends in Engrave mode on page 1333
Notehead brackets in Engrave mode on page 1269
Positions of lyrics on page 1229
Lyric hyphens and lyric extender lines on page 1240
Octave lines in Engrave mode on page 1083
Sustain pedal lines in Engrave mode on page 1369
Slurs in Engrave mode on page 1522
Lines in Engrave mode on page 1423
Text frames on page 575
Frames on page 560

Selecting handles on items
In Engrave mode, you can select individual handles on items; for example, if you want to move 
the graphical end of a gradual dynamic without moving its start.

NOTE

These steps do not apply to frame, note spacing, or staff spacing handles.

PROCEDURE

1. Select a handle in any of the following ways:
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● Select the whole item and press Tab  until the handle you want is selected.

● Click the handle you want.

TIP

You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

2. Optional: Select handles on other items as well by Ctrl/Cmd -clicking them.

NOTE

You cannot select subsequent handles on other items by selecting the items and pressing 
Tab .

RELATED LINKS
Gradual dynamics on page 1120
Changing the shape/angle of ties on page 1632

Hiding/Showing crosshairs
You can hide/show crosshairs in Engrave mode for selected items and/or when dragging items 
using the mouse. Crosshairs can make it easier to align items graphically.

PROCEDURE

● In Engrave mode, do one or both of the following:

● To hide/show crosshairs when dragging items, choose Engrave > Crosshairs > Show 
When Dragging.

● To hide/show crosshairs for selected items, choose Engrave > Crosshairs > Show When 
Selected.

RESULT
Crosshairs are hidden/shown in the corresponding context.

EXAMPLE

Crosshairs shown Crosshairs hidden

RELATED LINKS
Moving items graphically on page 609
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Selecting/Deselecting notes and items individually on page 426
Large selections on page 428
Hiding/Showing signposts on page 454
Hiding non-printing elements on page 444
Annotations on page 687
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Play mode

Play mode allows you to change how your music sounds in playback, including by adjusting the 
mix, changing the playback template, and assigning VST instruments.

Project window in Play mode
The project window in Play mode contains all the tools and functions for setting up your project 
for playback. In Play mode, your project appears in a similar way to that used in a digital audio 
workstation, or “DAW”, such as Cubase.

You can switch to Play mode in any of the following ways:

● Press Ctrl/Cmd-4 .

● In the toolbar, click Play.

● Choose Window > Play.

The project window in Play mode comprises the following:

1 Left zone

Can display either the Track Inspector or VST and MIDI panel, according to the current 
selection at the top of the left zone.

2 Track overview

Allows you to view the tracks in the selected flow, mute/solo instrument tracks, and select 
the track whose music you want to show in the Key Editor or whose sounds you want to edit 
in the Track Inspector.

3 Lower zone
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Can display either the Key Editor panel or Mixer panel, according to the current selection in 
the lower zone toolbar.

RELATED LINKS
Project window on page 32
Track overview on page 615
Track Inspector on page 617
VST and MIDI panel on page 620
Key Editor panel on page 773
Mixer panel on page 821
Hiding/Showing zones on page 47

Track overview
The track overview allows you to view the tracks in the selected layout and flow, and to mute and 
solo instrument tracks. It also allows you to select a single track whose music you want to show 
in the Key Editor, if it is unlocked, or whose sounds you want to edit in the Track Inspector. It is 
the central part of the window in Play mode.

The track overview contains the following:

1 Flow selector

Allows you to select the flow you want to show in the track overview. Only a single flow can 
be shown at a time. Only available when nothing is selected in any flow.

2 Track height button

Allows you to cycle through different heights for all tracks in the track overview.

3 Track visibility buttons

Allow you to hide/show the corresponding track.

● Tempo : Hides/Shows the Tempo track.

● Markers : Hides/Shows the Markers track.

● Chords : Hides/Shows the Chords track.

4 Mute /Solo  buttons

Allow you to mute/solo tracks. Shown in track headers when tracks are sufficiently tall, and 
at the top of the track overview when tracks appear short. They apply to the corresponding 
track when shown in track headers, and the selected track when shown at the top of the 
track overview.

5 Ruler

Displays bar numbers and shows beat divisions.

6 Track headers
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Display the name of each track and contain appropriate options for the track type.

7 Tracks

Rows that display an overview of the corresponding musical element, such as notes in 
instrument tracks and chord symbols in the chord symbols track.

8 Playhead

Shows the current rhythmic position in playback.

RELATED LINKS
Tracks on page 623
Instrument tracks on page 624
Tempo track on page 625
Markers track on page 626
Chords track on page 627
Key Editor on page 773
Showing instruments in the Key Editor on page 777
Track Inspector on page 617
Hiding/Showing tracks on page 629
Muting/Soloing tracks on page 638
Playhead on page 630
Changing the height of tracks on page 630
Zooming in/out of tracks on page 630
Hiding/Showing zones on page 47
Switching between layouts on page 46

Switching between flows in the track overview
You can change which flow is displayed in the track overview in Play mode manually. Only a 
single flow can be shown at a time.

PREREQUISITE
You have deselected all notes/items. You cannot switch flows when notes/items are selected.

PROCEDURE

● In Play mode, click the flow selector at the top of the track overview and select a flow from 
the menu.

RELATED LINKS
Selecting/Deselecting notes and items individually on page 426
Switching between layouts on page 46
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Track Inspector
The Track Inspector allows you to edit sounds for the track currently selected in the track 
overview. It is located in the left zone in Play mode.

The Track Inspector contains the following sections:

Routing

Allows you to change the sound routing of the selected track.

The following routing controls are available:

Audio plug-in menu

Allows you to select the VST or MIDI instrument plug-in you want to use for the 
selected track. Only plug-ins already loaded in the project are available.

Port field
Allows you to change the endpoint to which the selected track is assigned by entering 
the port you want to use. Only necessary when using a plug-in that has multiple ports 
of 16 channels.

Channel field
Allows you to change the endpoint to which the selected track is assigned by entering 
the channel you want to use in the loaded VST or MIDI instrument.

NOTE

● You must assign a VST or MIDI instrument and a channel for the Chords track in 
order to hear chords in playback.

● If you manually load sounds into the channel you selected for your Chords 
track and later add more instruments to your project, the sounds for the new 
instruments overwrite the sounds you manually loaded in that channel.

Enable independent voice playback

Allows you to enable independent voice playback for the selected instrument track. 
This shows each voice belonging to the instrument as a separate voice track below the 
instrument track.
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Dorico Pro automatically loads enough additional channels, and additional plug-in 
instances if necessary, to accommodate all voices belonging to the corresponding 
instrument project-wide, according to the current playback template. Voices are 
automatically assigned to endpoints according to their voice order.

Disable independent voice playback

Allows you to disable independent voice playback for the selected instrument track and 
return it to using a single endpoint for all voices.

Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

Edit Instrument

Opens the corresponding VST or MIDI instrument in a window, which allows you to edit 
its settings.

Edits apply to
Allows you to determine whether changing the routing of the selected voice affects the 
current flow only or all flows in the project. Only applies to future changes you make 
immediately after choosing either This flow or All flows. Only available for voice tracks 
belonging to instruments with independent voice playback enabled.

Insert Effects

Allows you to add and manage inserts on the Mixer channel for the selected instrument track. 
Each instrument track’s Mixer channel has four insert slots.

Each slot contains the following:

Activate Insert

Activates/Deactivates the insert slot.

Insert menu

Allows you to select an insert to load into the slot.
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Edit Insert

Opens the corresponding effect in a window, which allows you to edit its settings.

TIP

● You can also access inserts for all channels in the Mixer.

● For more information about the plug-ins included with Dorico Pro, see the separate 
document Plug-in Reference.

Channel

Shows the Mixer channel strip for the selected track and allows you to adjust the channel.

TIP

You can also access all channels in the Mixer.

RELATED LINKS
Track overview on page 615
Instrument tracks on page 624
Endpoint Setup dialog on page 659
Mixer on page 821
Mixer channel strips on page 825
Enabling independent voice playback on page 636
Changing the sound used for chord symbol playback on page 628
Loading VST/MIDI instruments manually on page 622
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VST and MIDI panel
The VST and MIDI panel contains the VST and MIDI instruments available and used in your 
project, and allows you to edit their settings. It is located in the left zone in Play mode.

VST Instruments

The VST Instruments section of the panel contains plug-in instances that each contain a VST 
instrument plug-in. Dorico Pro automatically loads plug-ins and enough plug-in instances for the 
instruments you add to your project according to the current playback template, but you can also 
load VST instruments manually.

NOTE

Dorico Pro only shows VST 3 instruments in the VST Instruments section by default. If you also 
want VST 2 instruments to be available, you must allow them. Only Kontakt and NotePerformer 
are allowed by default.

Each VST plug-in instance contains the following:

1 Activate Instance

Activates/Deactivates the plug-in instance.

2 Name

Displays the number and name of the plug-in instance. Plug-in instances are automatically 
numbered to help you differentiate between instances when you have multiple instances of 
the same plug-in.

3 VST Instruments menu

Displays the VST instrument currently loaded in the plug-in instance and allows you to select 
another available VST instrument from the menu.

4 Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

5 Edit Instrument

Opens/Closes the VST instrument window.

The action bar at the bottom of the section contains the following options:

● Add : Adds a new empty plug-in instance.

● Duplicate : Creates a copy of the selected plug-in instance that you can edit separately 
from the original.

● Save Endpoint Configuration : Opens the Save Endpoint Configuration dialog, which 
allows you to save the current state of all plug-in instances in the section as a custom 
endpoint configuration.

● Delete : Deletes the selected plug-in instance.

Play mode
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MIDI Instruments

The MIDI Instruments section of the panel contains plug-in instances that each contain a MIDI 
device to use for output during playback. Which MIDI devices are available depends on your 
operating system.

● On Windows, you can select any MIDI device that is plugged into your computer.

● On macOS, you can select any MIDI device that is plugged into your computer, and any other 
device set up in the Audio MIDI Setup application. For example, this allows you to use MIDI 
from one application in another application.

TIP

We recommend plugging MIDI devices into your computer before starting Dorico Pro. Similarly, 
if your device is not recognized, we recommend restarting Dorico Pro.

Each MIDI plug-in instance contains the following:

1 Name

Displays the number and name of the plug-in instance. Plug-in instances are automatically 
numbered to help you differentiate between instances when you have multiple instances of 
the same plug-in.

2 MIDI Instruments menu

Displays the MIDI device currently loaded in the plug-in instance and allows you to select 
another available MIDI device from the menu.

3 Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

The action bar at the bottom of the section contains the following options:

● Add : Adds a new empty plug-in instance.

● Save Endpoint Configuration : Opens the Save Endpoint Configuration dialog, which 
allows you to save the current state of all plug-in instances in the section as a custom 
endpoint configuration.

● Delete : Deletes the selected plug-in instance.

RELATED LINKS
Project window in Play mode on page 614
Playback templates on page 651
Endpoints on page 659
Endpoint Setup dialog on page 659
Custom endpoint configurations on page 661
Save Endpoint Configuration dialog on page 663
Allowing/Blocking VST plug-ins on page 636
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Loading VST/MIDI instruments manually
Dorico Pro automatically loads plug-in instances as required, according to the instruments in the 
project and the current playback template. However, you can also load VST/MIDI instruments 
manually, either into new plug-in instances or into existing ones to replace existing VST/MIDI 
instruments.

PREREQUISITE

● Any VST instruments you want to use are saved on your computer.

● You have connected any MIDI devices you want to use.

TIP

We recommend plugging MIDI devices into your computer before starting Dorico Pro. 
Similarly, if your device is not recognized, we recommend restarting Dorico Pro.

PROCEDURE

1. In Play mode, choose VST and MIDI in the left zone to show the VST and MIDI panel.

2. Optional: If you want to load a VST/MIDI instrument into a new plug-in instance, click Add 
in the corresponding section of the VST and MIDI panel.

3. In the plug-in instance into which you want to load a new VST/MIDI instrument, select the 
one you want to load from the menu.

4. Optional: If you loaded a VST instrument, click Edit Instrument  to open the VST/MIDI 
instrument window, where you can load sounds into channels.

AFTER COMPLETING THIS TASK

● You can assign instruments/voices and expression/percussion maps to endpoints in the VST/
MIDI instruments you loaded.

● If you loaded a MIDI instrument, we strongly recommend disabling it for MIDI input to avoid 
feedback loops.

RELATED LINKS
Playback templates on page 651
VST and MIDI panel on page 620
Endpoint Setup dialog on page 659
Assigning instruments/voices to endpoints on page 664
Assigning expression/percussion maps to endpoints on page 665
Enabling/Disabling MIDI input devices on page 271
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Tracks
Tracks are rows that represent a musical element across time, extending from left to right. They 
allow you to control multiple musical elements in a project simultaneously but independently of 
each other.

The term was established when audio mixing was done on tapes, and multitracking allowed 
separate elements of the music to be recorded and edited independently of each other before 
being combined into the final piece of music.

In modern programs, such as Cubase, tracks can contain many types of sounds, including 
audio recordings and software instruments. Tracks containing audio recordings often display the 
waveform of the audio, while tracks containing software instruments often display the pitches as 
rectangular note events positioned horizontally in time and vertically in pitch on a piano roll.

Dorico Pro provides the following types of tracks in Play mode:

Instrument tracks
Display previews of the notes belonging to the corresponding instrument. Each 
instrument in the project has its own instrument track, including when a single player 
holds multiple instruments.

Selecting an instrument track shows its music in the Key Editor, if it is unlocked, and its 
track settings in the Track Inspector.

Tempo track
Displays a preview of any tempo changes in the flow. Each project contains a single 
Tempo track.

Selecting the Tempo track shows the Tempo editor in the Key Editor panel, if it is 
unlocked, and its track settings in the Track Inspector.

Markers track
Displays any markers in the flow, including their text. Each project contains a single 
Markers track.

Chords track
Displays any chord symbols in the flow. Each project contains a single Chords track.

Selecting the Chords track shows its track settings in the Track Inspector.

RELATED LINKS
Track overview on page 615
Track Inspector on page 617
Key Editor on page 773
Showing instruments in the Key Editor on page 777
Tempo track on page 625
Chords track on page 627
Markers track on page 626
Changing the height of tracks on page 630
Hiding/Showing tracks on page 629
Hiding/Showing zones on page 47
Mixer channels on page 823
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Instrument tracks
Instrument tracks allow you to preview notes belonging to the corresponding instrument and 
select the instrument you want to show in the Key Editor.

Each instrument in the project has its own instrument track in Play mode, including when a 
single player holds multiple instruments. Instrument tracks are labeled using the full instrument 
name set for each instrument.

When independent voice playback is enabled, each voice belonging to the corresponding 
instrument appears as a separate voice track below the instrument track.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for the 
corresponding instrument, including in the Mixer and Key Editor.

When an instrument track is selected in the track overview, you can do the following:

● View and edit its notes and data in the Key Editor panel, if it is unlocked.

● Use the Track Inspector to change the routing of the track.

Piano instrument track with two voice tracks below

Each instrument track comprises the following:

1 Track name

Shows the name of the track.

● Instrument tracks display the full instrument name set for the instrument.

● Voice tracks display the stem direction and number of the corresponding voice. For 
instruments with multiple staves, the staff of the corresponding voice is also included.

2 Mute /Solo  buttons

Allow you to mute/solo the track. Shown in track headers when tracks are sufficiently 
tall, and at the top of the track overview when tracks appear short. They apply to the 
corresponding track when shown in track headers, and the selected track when shown at the 
top of the track overview.

3 Track preview

Displays a preview of notes belonging to the instrument.

RELATED LINKS
Key Editor on page 773
Piano roll editor on page 784
Percussion editor on page 785
Showing instruments in the Key Editor on page 777
Velocity editor on page 796
Dynamics editor on page 799
Playing Techniques editor on page 795
MIDI CC editor on page 805
Player, layout, and instrument names on page 181
Changing instrument names on page 184

Play mode
Tracks 

624
Dorico Pro 4.3.30



Inputting notes into multiple voices on page 231
Voices on page 1704
Endpoint Setup dialog on page 659
Muting/Soloing tracks on page 638
Enabling independent voice playback on page 636
Assigning instruments/voices to endpoints on page 664
Changing the default player order on page 127
Setting custom player orders on page 127
Changing the height of tracks on page 630

Tempo track
The Tempo track displays tempo changes in the selected flow. It appears at the top of the track 
overview in Play mode, and is one of the tracks you can hide/show. Each project contains a single 
Tempo track.

Tempo track

When the Tempo track is selected in the track overview, you can do the following:

● Edit and input tempo changes in the Tempo editor in the Key Editor panel, if it is unlocked.

● Use the Track Inspector to change the sound used for the click.

RELATED LINKS
Hiding/Showing tracks on page 629
Track Inspector on page 617
Key Editor on page 773
Tempo editor on page 810
Showing instruments in the Key Editor on page 777
Tempo marks on page 1587
Input methods for tempo marks on page 294
Changing the type and appearance of absolute tempo changes on page 1590
Signposts on page 453
Changing the click settings on page 267
Hiding/Showing tempo marks on page 1595
Hiding/Showing decimal places for metronome marks on page 1599
Exporting MIDI on page 99

Changing the sound used for the click
You can change the sound used for the click in playback by assigning the Tempo track to the 
required endpoint, including loading a new sound manually if required; for example, if you want 
to use a sound that is not provided by default.

TIP

You can choose an available factory default click sound in Playback Options > Click > 
Metronome Click. Click, beep, and wood block sounds are provided by default.

PREREQUISITE

● The Tempo track is shown.

● You have loaded the VST/MIDI instrument you want to use for the click.
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PROCEDURE

1. In Play mode, select the Tempo track in the track overview.

2. In the Track Inspector, in the Routing section, select the VST/MIDI instrument plug-in you 
want to use for the click from the audio plug-in menu.

3. Optional: If the sound you want to use is not already loaded in the plug-in instance, click Edit 
Instrument  to open the corresponding VST or MIDI instrument in a window, then load 
the required sound into an available channel.

4. Select the required endpoint in the plug-in instance using the following value fields, 
individually or together:

● To assign the Tempo track to a different port in the selected plug-in instance, enter the 
required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.

● To assign the Tempo track to a different channel in the selected port, enter the required 
channel in the Ch. field.

RELATED LINKS
Playback Options dialog on page 842
Loading VST/MIDI instruments manually on page 622
Track Inspector on page 617
Endpoints on page 659
Endpoint Setup dialog on page 659

Markers track
The Markers track displays markers in the selected flow and allows you to input new markers. 
It appears at the top of the track overview in Play mode, and is one of the tracks you can hide/
show. Each project contains a single Markers track.

The Markers track comprises the following:

1 Add Marker

Opens the Add Marker dialog, which allows you to input a marker.

2 Markers

Show the position of each marker in the flow, including their text.

RELATED LINKS
Hiding/Showing tracks on page 629
Markers on page 1430
Videos on page 190
Editing marker text on page 1432
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Inputting markers in the Markers track
You can input markers directly into the Markers track in Play mode.

PREREQUISITE
The Markers track is shown.

PROCEDURE

1. In Play mode, move the playhead to the time position where you want to input a marker.

NOTE

You cannot input markers in negative time, such as when a video starts three bars into the 
flow, causing the initial timecode of the flow to be in negative time.

2. In the Markers track header, click Add Marker  to open the Add Marker dialog.

3. Enter the marker text you want into the Text field.

4. Optional: Change the timecode in the Timecode field.

5. Click OK to input the marker and close the dialog.

RESULT
A marker is input at the position of the playhead. It shows the text you entered, or the default 
text “Marker” if you did not change the marker text.

EXAMPLE

Marker in the Markers track

RELATED LINKS
Moving the playhead on page 631
Add Marker dialog on page 403
Editing marker text on page 1432
Changing the start position of videos on page 193

Chords track
The Chords track displays chord symbols in the selected flow and allows you to hear the 
corresponding chords in playback. It appears at the top of the track overview in Play mode, 
and is one of the tracks you can hide/show. Each project contains a single Chords track.

When the Chords track is selected in the track overview, you can use the Track Inspector to 
change its routing.

The Chords track comprises the following:

1 Enable Chords Playback

Allows you to include chords in, or exclude chords from, playback.
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2 Chords

Indicates where chord symbols exist in the flow and shows the chord symbol name.

RELATED LINKS
Chord symbols on page 1036
Track Inspector on page 617
Loading VST/MIDI instruments manually on page 622
Hiding/Showing tracks on page 629

Enabling chord symbol playback
You can include chord symbols in playback. They are played as sustained chords, with their 
duration taken from the gap between one chord symbol and the next. Chord symbols input via 
a MIDI keyboard use the voicing you played when inputting them, whereas chord symbols input 
via a computer keyboard use a default voicing.

PREREQUISITE
The Chords track is shown.

PROCEDURE

● In Play mode, activate Enable Chords Playback  in the Chords track header.

RELATED LINKS
Hiding/Showing tracks on page 629
Track overview on page 615

Changing the sound used for chord symbol playback
You can change the sound used for chord symbol playback by assigning the Chords track to the 
required endpoint, including loading a new sound manually if required; for example, if you want 
to use a sound that is not used by any of the instrument tracks in your project.

PREREQUISITE

● The Chords track is shown.

● You have loaded the VST/MIDI instrument you want to use for chord symbol playback.

PROCEDURE

1. In Play mode, select the Chords track in the track overview.

2. In the Track Inspector, in the Routing section, select the VST/MIDI instrument plug-in you 
want to use for chord symbol playback from the audio plug-in menu.

3. Optional: If the sound you want to use is not already loaded in the plug-in instance, click Edit 
Instrument  to open the corresponding VST or MIDI instrument in a window, then load 
the required sound into an available channel.

4. Select the required endpoint in the plug-in instance using the following value fields, 
individually or together:

● To assign the Chords track to a different port in the selected plug-in instance, enter the 
required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.
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● To assign the Chords track to a different channel in the selected port, enter the required 
channel in the Ch. field.

RELATED LINKS
Loading VST/MIDI instruments manually on page 622
Track Inspector on page 617
Endpoints on page 659
Endpoint Setup dialog on page 659

Resetting the voicing of chord symbols
When you input chord symbols via a MIDI keyboard, the voicing you used is retained for chord 
symbol playback. You can reset the voicing of chord symbols input using MIDI keyboards; for 
example, if you prefer to hear the default voicing for that chord symbol in playback.

PROCEDURE

1. In Write mode, select the chord symbols whose voicing you want to reset.

2. Choose Edit > Notations > Chord Symbols and Diagrams > Clear Chord Symbol Played 
Pitches. You can also choose this option from the context menu.

RELATED LINKS
Inputting chord symbols on page 318

Hiding/Showing tracks
You can hide/show the Tempo, Markers, and Chords tracks at the top of the track overview 
independently of each other.

NOTE

You cannot hide/show player and instrument tracks.

PROCEDURE

● At the top of the track overview, hide/show tracks in the following ways:

● To show/hide the Tempo track, activate/deactivate Tempo .

● To show/hide the Markers track, activate/deactivate Markers .

● To show/hide the Chords track, activate/deactivate Chords .

RELATED LINKS
Track overview on page 615
Tracks on page 623
Key Editor panel on page 773
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Changing the height of tracks
You can change the height of all types of tracks; for example, to preview more tracks 
simultaneously. This does not affect the width of tracks.

PROCEDURE

● In Play mode, click Track height  at the top left of the track overview to cycle through 
different track heights.

NOTE

When tracks appear short, Mute  and Solo  buttons appear at the top of the track 
overview. They only appear in each track header when there is sufficient vertical space.

RELATED LINKS
Changing the height of the Key Editor on page 779
Zooming in/out of the Key Editor on page 779

Zooming in/out of tracks
You can change the width of tracks in the track overview; for example, to preview more bars 
simultaneously. This does not affect the height of tracks.

PROCEDURE

1. Zoom in horizontally in any of the following ways:

● Click in the ruler and drag upwards.

● Ctrl/Cmd -scroll upwards in the ruler.

● Click Zoom In  at the bottom of the track overview.

2. Zoom out horizontally in any of the following ways:

● Click in the ruler and drag downwards.

● Ctrl/Cmd -scroll downwards in the ruler.

● Click Zoom Out  at the bottom of the track overview.

RELATED LINKS
Tracks on page 623
Track overview on page 615
Key Editor panel on page 773
Piano roll editor on page 784
Zooming in/out of the Key Editor on page 779

Playhead
The playhead is a vertical line that moves during playback, showing the current rhythmic 
position. It is also known as a “playback line”.

The playhead appears at all times in Play mode and during playback in other modes, and its 
current position is displayed in both the Transport window and the mini transport in the toolbar. 
You can also choose to show the playhead when playback is stopped in other modes.
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The playhead in the Key Editor

Dorico Pro automatically keeps the playhead in view during playback by moving it along with the 
music, but you can also move the playhead manually. Dorico Pro tries to keep systems in the 
same place on the screen when it scrolls along with the playhead for consistency as you follow 
your music.

NOTE

The playhead never appears in Print mode.

RELATED LINKS
Transport window on page 649
Mini transport on page 35
Hiding/Showing the playhead on page 632
Changing music area colors on page 57

Moving the playhead
The playhead automatically moves along with the music during playback, but you can also move 
the playhead manually in any mode.

You can move the playhead both when it is stopped and during playback, but not all methods of 
moving the playhead work during playback.

By default, the playhead is only shown during playback but you can choose to show the playhead 
at all times.

PROCEDURE

● Move the playhead in any of the following ways:

● To move the playhead forwards, press Num +  (plus on a numeric keypad) or click Fast 
Forward  in the Transport window.

● To move the playhead backwards, press Num -  (minus on a numeric keypad) or click 
Rewind  in the Transport window.

● To move the playhead back to the start of the flow, press Num .  (period on a numeric 
keypad) or click Rewind to Beginning of Flow  in the Transport window or mini 
transport.

● To move the playhead to the start of the earliest selected item, press Alt/Opt-P .

● To move the playhead forwards by frames, press Ctrl/Cmd-Num + or Ctrl/Cmd-F9 .

● To move the playhead backwards by frames, press Ctrl/Cmd-Num - or Ctrl/Cmd-F7 .

● In Play mode or the Key Editor, click the ruler at any position.
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NOTE

You cannot click the ruler to move the playhead during playback.

RELATED LINKS
Transport window on page 649
Mini transport on page 35
Preferences dialog on page 61
Frame rates on page 195

Hiding/Showing the playhead
You can hide/show the playhead when playback is stopped; for example, to help line up your 
music when working with timecodes and video. By default, the playhead is hidden when playback 
is stopped, except in Play mode, where it always appears.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Playhead subsection, activate/deactivate Show playhead when stopped.

4. Click Apply, then Close.

RESULT
The playhead is shown outside of playback when Show playhead when stopped is activated, 
and hidden when it is deactivated.

NOTE

This does not apply to Play mode or Print mode. The playhead always appears in Play mode and 
never appears in Print mode.

Playing back music
You can listen to the music you have written from the beginning of your project or from a specific 
point. You can use playback key commands in any mode.

PREREQUISITE

● You have applied a playback template to the project that includes sounds for the instruments 
in your project.

● If you want to use different sounds for different voices, you have enabled independent voice 
playback for those instruments.

PROCEDURE

1. Start playback in one of the following ways:

● To play back from the earliest selected item, make a selection, then either press P , 
click Play From Selection  in the Transport window, or choose Play > Play From 
Selection.

Play mode
Playing back music 

632
Dorico Pro 4.3.30



TIP

● To play back all instruments, select a single note.

● To play back only a single staff, select multiple items on the staff.

● To play back multiple staves, select items on multiple staves.

This does not affect which channels are soloed or muted in the Mixer.

● To continue playback from the playhead position, either press Space or Enter , click Play 
 in the mini transport, click Play From Playhead Position  in the Transport window, 

or choose Play > Play From Playhead Position.

● To play back from the last playback start position, press Shift-Space  or choose Play > 
Play From Last Start Position. This works even if you have since deselected the item at 
that position.

● To play back from the start of the flow, press Shift-Alt/Opt-Space  or choose Play > Play 
From Start of Flow.

● To play back from the start of the project, choose Play > Play From Start of Project.

2. Optional: Move the playhead during playback to later/earlier positions.

3. Optional: To enable/disable the metronome click, click Click  in the Transport window or 
mini transport.

TIP

You can assign a key command for Enable Click on the Key Commands page in 
Preferences.

4. Stop playback in any of the following ways:

● Press Space or Enter  or P .

● Press Num 0  (0 on a numeric keypad).

● In the mini transport, click Stop .

● In the Transport window, click Stop .

TIP

If you notice a change in sound when stopping playback, you can deactivate Reset 
controllers and send ‘all notes off’ when stopping playback on the Play page in 
Preferences.

RELATED LINKS
Playback templates on page 651
Applying/Resetting playback templates on page 656
Allowing/Blocking VST plug-ins on page 636
Enabling independent voice playback on page 636
Playhead on page 630
Mixer on page 821
Muting/Soloing tracks on page 638
Changing the pre-roll duration on page 635
Changing the gap between flows in playback on page 635
Changing the click settings on page 267
Endpoint Setup dialog on page 659
Transport window on page 649
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Mini transport on page 35
Key Commands page in the Preferences dialog on page 63
Status bar on page 42
Preferences dialog on page 61

Changing the tempo mode
You can switch the tempo mode at any time between using a single fixed tempo and following 
tempo changes; for example, if you have a project with multiple tempo changes but want to use 
a single fixed tempo when recording MIDI.

PROCEDURE

1. Change the tempo mode in any of the following ways:

● Click Tempo Mode  in the toolbar.

● Choose Play > Fixed Tempo Mode.

Fixed Tempo Mode Follow Tempo Mode

2. Optional: When Fixed Tempo Mode  is active, change the metronome mark value by 
clicking the Fixed Tempo Mode number in the toolbar to show a slider, then dragging the 
slider to the right/left.

RESULT
In follow tempo mode, the tempo for playback and recording is set by tempo marks in the 
project.

In fixed tempo mode, the tempo for playback and recording is a single tempo, as determined by 
the Fixed Tempo Mode metronome mark value.

RELATED LINKS
Toolbar on page 33
Tempo marks on page 1587
Tempo track on page 625
Tempo editor on page 810
MIDI recording on page 263
Playing back music on page 632
Transport window on page 649
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Changing the pre-roll duration
In Dorico Pro, pre-roll is the time added to playback before the first beat of the first bar in each 
flow. You can change the pre-roll duration before all flows project-wide; for example, if some 
flows in your project start with grace notes and you want to hear them in playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Timing.

3. In the Flows section, change the value for Pre-roll before flow.

For example, for flows starting with a single grace note, 0.25 seconds is usually sufficient.

4. Click Apply, then Close.

RESULT
The duration of the pre-roll before each flow in playback, measured in seconds, is changed.

RELATED LINKS
Playing back music on page 632

Changing the gap between flows in playback
You can change the gap between all flows in playback, measured in seconds; for example, if the 
flows in your project should be played attacca and you want no gap between them.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Timing.

3. In the Flows section, change the value for Gap between flows during playback.

4. Click Apply, then Close.

Changing the playback tuning
You can change the tuning used for playback, based on the pitch of the A above middle C; for 
example, if you want to hear your music played at the Baroque pitch of A=415 Hz.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Tuning.

3. Change the value for Pitch of A4.

4. Click Apply, then Close.

RESULT
The tuning of all notes in the project is changed, which affects their sounding pitch in playback.

TIP

The sample rate of the current playback device also affects the playback tuning.
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RELATED LINKS
Preferences dialog on page 61
Changing the audio device buffer size on page 270

Allowing/Blocking VST plug-ins
You can allow individual VST 2 instrument plug-ins that you want to use in Dorico Pro and block 
plug-ins you want to prevent Dorico Pro from using. Allowed plug-ins are subsequently available 
in any project.

Dorico Pro automatically blocks plug-ins that crash and plug-ins that Steinberg has not already 
qualified for use with Dorico Pro. Only Kontakt and NotePerformer are allowed by default.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click VST Plug-ins.

3. In the Allowed VST 2 Plug-ins subsection, allow plug-ins in any of the following ways:

● To allow individual blocked plug-ins, select them in the Blocked Plug-ins list and click 
Allow selected plug-ins  in the action bar.

● To allow all blocked plug-ins, click Allow All in the Blocked Plug-ins list action bar.

● To allow a plug-in not included in the Blocked Plug-ins list, click Add plug-in name  in 
the Allowed Plug-ins list action bar, then enter the name of the plug-in in the new entry.

4. Block plug-ins in any of the following ways:

● To block individual allowed plug-ins, select them in the Allowed Plug-ins list and click 
Block selected plug-ins  in the action bar.

● To block all allowed plug-ins, click Block All in the Allowed Plug-ins list action bar.

5. Click Apply, then Close.

6. Quit Dorico Pro.

RESULT
When Dorico Pro next opens, your allowed VST plug-in entries are available for use in the 
program.

RELATED LINKS
Preferences dialog on page 61
Track Inspector on page 617
Playing back music on page 632
Playback templates on page 651

Enabling independent voice playback
By default, all voices belonging to a single instrument, including divisi staves, use the same 
endpoint for playback. You can enable independent voice playback for individual instruments; for 
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example, to hear the different playing techniques in playback for a string divisi where some parts 
are pizzicato and some parts are arco.

NOTE

You cannot enable independent voice playback for unpitched percussion instruments and 
percussion kits.

PROCEDURE

1. In Play mode, in the track overview, select the instrument track for which you want to enable 
independent voice playback.

2. In the Track Inspector, click Enable Independent Voice Playback  in the Routing section.

RESULT
Independent voice playback is enabled for the selected instrument. Each voice belonging to the 
instrument appears as a separate voice track below the instrument track.

Dorico Pro automatically loads enough additional channels, and additional plug-in instances if 
necessary, to accommodate all voices belonging to the corresponding instrument project-wide, 
according to the current playback template. Voices are automatically assigned to endpoints 
according to their voice order.

NOTE

When independent voice playback is enabled, you can only change the routing and effects of 
each voice track.

AFTER COMPLETING THIS TASK
You can change the routing and effects of each voice track, including in each flow independently; 
for example, if some voices in some flows require a solo sound instead of an ensemble one.

RELATED LINKS
Track overview on page 615
Track Inspector on page 617
Playback templates on page 651
Endpoints on page 659
Instrument tracks on page 624
Piano roll editor on page 784
Velocity editor on page 796
Dynamics editor on page 799
MIDI CC editor on page 805
Playing Techniques editor on page 795
Assigning instruments/voices to endpoints on page 664

Disabling independent voice playback
You can disable independent voice playback for individual instrument tracks and return them to 
using a single endpoint for all voices.

PROCEDURE

1. In Play mode, in the track overview, select the instrument track for which you want to disable 
independent voice playback.
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NOTE

You must select the instrument track, not any of its voice tracks.

2. In the Track Inspector, click Disable Independent Voice Playback  in the Routing section.

RESULT
Independent voice playback is disabled for the selected instrument. Its voice tracks disappear 
from the track overview, and all voices belonging to the instrument return to using a single 
endpoint for playback.

Muting/Soloing tracks
You can mute/solo individual tracks, instruments, and voices belonging to instruments with 
independent voice playback enabled. This can be useful if you want to ensure only certain 
instruments are played back while you are working on a specific section of a project.

PROCEDURE

1. Mute tracks in any of the following ways:

● In the Mixer, click Mute  in the corresponding channels.

● In Play mode, click Mute  for the corresponding tracks in the track overview.

2. Solo tracks in any of the following ways:

● In the Mixer, click Solo  in the corresponding channels.

● In Play mode, click Solo  for the corresponding tracks in the track overview.

● To solo selected instruments and mute other instruments, select at least one note 
belonging to each instrument you want to solo, then press Alt/Opt-S  or choose Play > 
Solo Selected Instruments.

RESULT
The corresponding tracks are muted/soloed. This affects playback until you change which tracks 
are muted/soloed, meaning you do not have to reselect the tracks you want to hear each time.

NOTE

● Soloing tracks automatically mutes all other tracks. If you solo a track that was muted, it is 
automatically unmuted.

● You can also play back only specific tracks/staves temporarily by selecting notes/items on 
each track/staff you want to hear, then starting playback.

EXAMPLE

Mute when enabled Solo when enabled

RELATED LINKS
Track overview on page 615
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Mixer on page 821
Playing back music on page 632

Deactivating mute/solo instrument states
You can deactivate the mute and solo states of all instruments in your project; for example, if you 
want to hear all instruments in playback after soloing a small selection.

PROCEDURE

● Deactivate mute/solo instrument states in the following ways:

● To deactivate all mute instrument states, press Alt/Opt-U  or click Deactivate All Mute 
States  in the Mixer.

● To deactivate all solo instrument states, press Shift-Alt/Opt-S  or click Deactivate All 
Solo States  in the Mixer.

RESULT
All instruments in the project have the corresponding state removed. For example, removing 
both mute and solo instrument states reverts all instruments to their default state, causing all 
instruments to be included in playback.

Muting notes/items individually
You can mute individual notes and items to exclude them from playback without deleting them; 
for example, to hear chords without their arpeggios, a passage with multiple dynamics at a 
single volume level, or without tempo changes from specific tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. In Write mode, select the notes/items you want to mute.

2. In the Properties panel, activate Suppress playback in the Common group.

RELATED LINKS
Properties panel on page 769
Hiding/Showing zones on page 47
Changing the tempo mode on page 634

Hiding/Showing colors for muted notes/items
You can hide/show colors for individual notes/items whose playback you have suppressed, which 
causes them to appear gray.

PROCEDURE

● Choose View > Note And Rest Colors > Suppressed Playback.

RELATED LINKS
Viewing options for notes and rests on page 1261
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Hiding/Showing rest colors on page 1491
Hiding/Showing voice colors on page 1705
Hiding/Showing cue note colors on page 1103

Repeats in playback
Dorico Pro supports the playback of repeat structures, including repeat endings, repeat barlines, 
and repeat markers, provided all the correct jumps and sections are in place.

There is no limit to the number of repeat structures you can have in a single flow and still obtain 
correct playback.

By default, Dorico Pro plays sections between repeat barlines twice and includes repeats in 
playback, except after repeat jumps, such as D.S. al Coda.

During playback, the bars/beats and time displays in the mini transport and Transport window 
reflect the playhead position in repeat structures.

Dynamics and tempo marks are reflected in repeats. Repeats are also included in both audio and 
MIDI exports.

NOTE

When repeat structures are unbalanced and would play back infinitely, Dorico Pro automatically 
excludes repeats from playback.

RELATED LINKS
Transport window on page 649
Mini transport on page 35
Repeat endings on page 1440
Repeat markers on page 1447
Types of barlines on page 968
Tremolos on page 1659
Rhythm slashes on page 1473
Bar repeats on page 1459

Including/Excluding repeats in playback
By default, Dorico Pro plays back all playthroughs in all types of repeat structures. You can 
include/exclude all repeats in playback project-wide. For example, you might exclude all repeats 
to listen to your music as a single playthrough.

NOTE

When repeat structures are unbalanced and would play back infinitely, Dorico Pro automatically 
excludes repeats from playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Repeats.

3. In the Repeats section, activate/deactivate Play repeats.

4. Click Apply, then Close.
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RELATED LINKS
Including/Excluding slash voices in playback on page 1485
Barlines on page 967
Repeat endings on page 1440
Repeat markers on page 1447

Including/Excluding repeats in playback after repeat jumps
By default, Dorico Pro plays back all playthroughs in all types of repeat structures. You can 
manually include/exclude repeats indicated by repeat markers, repeat endings, and repeat 
barlines in playback after individual repeat jumps, independently of your project-wide setting.

NOTE

You can only include/exclude repeats after repeat jumps, such as D.C. al Fine and D.S. al Coda.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat jumps after which you want to include/exclude repeats in playback. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Replay repeats in the Repeat Markers group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Repeats are included in playback after the selected repeat jumps when the checkbox is activated, 
and excluded from playback when the checkbox is deactivated.

When the property is deactivated, repeat markers follow your project-wide setting for including 
repeats in playback after repeat jumps.

TIP

You can include/exclude all repeats after all repeat jumps project-wide on the Repeats page in 
Playback Options.

RELATED LINKS
Playback Options dialog on page 842

Changing the number of playthroughs at repeat barlines
End repeat barlines typically indicate that the preceding music is played through twice. You can 
change the number of playthroughs for each end repeat barline individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the end repeat barlines whose number of playthroughs you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Play n times in the Time Signatures group.

3. Change the value in the value field.

NOTE

The minimum value is 2.

RESULT
The number of times the music preceding the selected end repeat barlines is played through is 
changed.

When repeats are included in playback, repeat counts are shown at system object positions for 
end repeat barlines set to have three or more playthroughs.

TIP

You can change the appearance, content, and position of repeat counts in Engraving Options > 
Repeat Markers > Repeat Count.

EXAMPLE

Final repeat barline with the default 2 playthroughs 
set

Final repeat barline with 4 playthroughs set and 
repeat count shown

RELATED LINKS
Repeat counts on page 1456
Types of barlines on page 968
Input methods for bars, beats, and barlines on page 302
Including/Excluding repeats in playback after repeat jumps on page 641
Changing the total number of playthroughs in repeat endings on page 1441
Engraving Options dialog on page 840
Engrave toolbox on page 514
Properties panel on page 769
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Swing playback
Swing is a style of performance where equally-notated notes are played in a regular pattern of 
alternating longer and shorter notes, which commonly entails eighth notes being played as a 
quarter note triplet followed by an eighth note triplet.

A swing phrase with simplified straight notation How the same phrase sounds with a 2:1 swing ratio

Swing playback allows you to hear the uneven rhythms you want whilst retaining their simplified 
notation, including if the second eighth note beat is divided into two 16th notes. In Dorico Pro, 
you can enable swing playback for your whole project, only for certain sections, and only for 
individual instruments. You can also edit the default swing patterns to customize the rhythmic 
feel you want in the Rhythmic Feel dialog. You can swing either eighth notes or 16th notes.

Based on academic research into the rendering of swing by musicians, swing patterns in Dorico 
Pro are tempo-dependent by default. This means that the swing feels more pronounced at lower 
tempos, and straighter at higher tempos. Rhythmic feels that produce the same swing ratio at all 
tempos are also available in the Rhythmic Feel dialog.

RELATED LINKS
Enabling swing playback for specific sections/instruments on page 645
Rhythmic Feel dialog on page 647

Swing ratios and rhythmic feels
Swing ratios express the strength of the swing using beat units. For example, a swing ratio of 2:1 
means the first note in each pair is twice as long as the second, creating a triplet swing.

A swing ratio of 1:1 means the music is played straight, while a swing ratio of 5:1 means each 
pair of notes is played as if they were sextuplets, with the first note in the pair lasting five 
divisions and the second note lasting one.

Swing ratio 1:1 Swing ratio 5:1

The following rhythmic feels and swing ratios are provided by default in Dorico Pro:

2:1 swing 16ths (fixed)
Extends the first note in a pair of 16th notes to be twice as long as the second, creating 
a strict triplet 2:1 ratio. This is also known as a “triplet swing”. This ratio is maintained 
regardless of the tempo by default.
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2:1 swing 8ths (fixed)
Extends the first note in a pair of eighth notes to be twice as long as the second, 
creating a strict triplet 2:1 ratio. This is also known as a “triplet swing”. This ratio is 
maintained regardless of the tempo by default.

3:1 swing 16ths (fixed)
Extends the first note in a pair of 16th notes to be three times as long as the second, 
creating a dotted 16th-32nd ratio (dotted semiquaver-demisemiquaver). This ratio is 
maintained regardless of the tempo by default.

3:1 swing 8ths (fixed)
Extends the first note in a pair of eighth notes to be three times as long as the 
second, creating a dotted eighth-16th ratio (dotted quaver-semiquaver). This ratio is 
maintained regardless of the tempo by default.

Heavy swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 3:1 at low tempos and 
1.5:1 at high tempos.

Heavy swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 3:1 at low tempos 
and 1.5:1 at high tempos.

Light swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 1.5:1 at low tempos 
and 1:1 at high tempos.

Light swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 1.5:1 at low tempos 
and 1:1 at high tempos.

Medium swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 2:1 at low tempos and 
1.5:1 at high tempos.

Medium swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 2:1 at low tempos 
and 1.5:1 at high tempos.

Straight (no swing)
Produces no swing; that is, even eighth notes in the ratio 1:1 at all tempos.

You can change the swing ratio used project-wide, and you can also change the swing ratio used 
for specific sections and for individual players. You can edit these settings and create custom 
swing ratios in the Rhythmic Feel dialog.

Enabling swing playback project-wide
You can enable swing playback project-wide using any of the default swing ratios or custom 
swing ratios you have created in the project.

PREREQUISITE
You have created any custom rhythmic feels you want to use for swing playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Timing.
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3. In the Rhythmic Feel section, select the rhythmic feel you want from the Default rhythmic 
feel menu.

4. Click Apply, then Close.

RESULT
All pairs of either eighth notes or 16th notes in your project are played back with the selected 
swing ratio, depending on the swing unit for the selected ratio. This includes if the second beat is 
divided into two, such as two 16th notes in an eighth note swing.

RELATED LINKS
Playback Options dialog on page 842
Creating custom rhythmic feels for swing playback on page 646
Rhythmic Feel dialog on page 647

Enabling swing playback for specific sections/instruments
You can enable swing playback for specific sections in your project and for individual instruments 
independently; for example, if you want only the trumpet player to swing for a twelve-bar 
section, or if you only want swing playback in one flow.

PREREQUISITE
You have created any custom rhythmic feels you want to use for swing playback.

PROCEDURE

1. In Write mode, select one of the following:

● If you want to enable swing playback from a specific rhythmic position onwards, select 
a single item at the start of the bar where you want swing playback/a different rhythmic 
feel to start.

● If you want to enable swing playback within a section then return to straight playback, 
select multiple items that span the duration where you want swing playback/a different 
rhythmic feel.

NOTE

● If you want to enable swing playback for a single instrument, select items that belong to 
that instrument only.

● If you select an item in the middle of a bar, the rhythmic feel change only takes effect 
from the start of the next bar.

2. Open the tempo popover in any of the following ways:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

3. Enter the appropriate entry for the rhythmic feel you want into the popover.

When you start entering a rhythmic feel into the tempo popover, a menu appears that shows 
valid rhythmic feels containing the letters/words you enter, which you can select.

Play mode
Swing playback 

645
Dorico Pro 4.3.30



NOTE

If you do not enter the name of a rhythmic feel that exists in your project, the text you 
entered into the popover is input as a tempo mark and does not enable swing playback.

4. Input the rhythmic feel change and close the popover in one of the following ways:

● To input a rhythmic feel change for all staves, press Return .

● To input a rhythmic feel change only for the selected instrument, press Alt/Opt-Return .

RESULT
The rhythmic feel used for swing playback is changed from the start of the bar containing the 
earliest selected item, or the start of the next bar if you selected an item in the middle of a bar.

If you selected multiple items, the rhythmic feel is automatically reset at the position of the last 
selected item.

If you pressed Alt/Opt-Return , the rhythmic feel change only applies to the instrument on 
whose staff you selected an item or items. Rhythmic feels added to single instruments apply to 
all staves belonging to those instruments.

A signpost appears showing the name of the rhythmic feel you input. It is shown above the top 
staff in the system for rhythmic feel changes that apply to all staves, and directly above the top 
staff of the instrument for rhythmic feel changes that apply only to single instruments.

RELATED LINKS
Tempo popover on page 294
Signposts on page 453
Hiding/Showing signposts on page 454

Deleting rhythmic feel changes
You can delete rhythmic feel changes you have enabled for specific sections or for individual 
players only.

PREREQUISITE
Rhythmic change signposts are shown.

PROCEDURE

1. In Write mode, select the signposts of the rhythmic changes you want to delete.

2. Press Backspace or Delete .

RESULT
The rhythmic changes are deleted. The playback of the affected staves returns to your project-
wide settings until the next existing rhythmic change signpost, if applicable.

Creating custom rhythmic feels for swing playback
You can create custom rhythmic feels that you can use for swing playback; for example, if you 
want a swing ratio that is not provided by default. You can create entirely new rhythmic feels or 
rhythmic feels based on existing ones.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.
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2. In the category list, click Timing.

3. In the Rhythmic Feel section, click Edit to open the Rhythmic Feel dialog.

4. Create a new rhythmic feel in one of the following ways:

● To create an entirely new rhythmic feel, click New .

● To create a new rhythmic feel based on an existing one, select the existing rhythmic feel 
in the rhythmic feels list and click New from Selection .

5. Enter a name for the rhythmic feel in the Name field.

6. Move the Low tempo slider to the swing ratio you want.

7. Optional: If you want the swing ratio of your custom rhythmic feel to vary according to the 
tempo, activate Depends on tempo.

8. Optional: If you activated Depends on tempo, change the bpm values for the following 
options, individually or together:

● Low tempo

● High tempo

9. Optional: If you activated Depends on tempo, move the High tempo slider to the swing 
ratio you want.

10. Choose one of the following for Swing unit:

● 8th (Quaver) 

● 16th (Semiquaver) 

11. Click OK to save your changes and close the dialog.

12. Click Apply, then Close.

Rhythmic Feel dialog
The Rhythmic Feel dialog allows you to edit the settings of the default rhythmic feels used for 
swing playback and create custom rhythmic feels.

● You can open the Rhythmic Feel dialog by clicking Edit in Playback Options > Timing > 
Rhythmic Feel.
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The Rhythmic Feel dialog contains the following options and sections:

1 Search field

Allows you to filter rhythmic feels according to your entry.

2 Rhythmic feels list

Contains the rhythmic feels available for your project.

The action bar at the bottom of the list contains the following options:

● New : Creates a new rhythmic feel with default values.

● New from Selection : Creates a new rhythmic feel based on the selected one. Initially 
no values are overridden but you can change the options for your new rhythmic feel.

● Save as Default : Saves the selected rhythmic feel to your user library, allowing you to 
use it in multiple projects. Appears as  for rhythmic feels saved as default.

● Revert to Factory : Removes all your changes to the selected rhythmic feel, returning 
it to its saved settings.

● Delete : Deletes the selected rhythmic feel.

NOTE

You cannot delete predefined rhythmic feels or any rhythmic feel that is currently used 
in your project.

3 Name

Allows you to enter a name for new rhythmic feels or edit the name of existing rhythmic 
feels.

4 Depends on tempo

Controls whether the swing pattern uses the same ratio at all tempos or changes according 
to the tempo.

● When Depends on tempo is activated, the swing ratio varies according to the tempo. A 
second slider appears for High tempo, allowing you to change the values for both Low 
tempo and High tempo.

● When Depends on tempo is deactivated, the swing ratio value of the single slider is 
used at all tempos.

5 Low tempo

Sets the tempo at/below which the swing ratio changes, measured in quarter note beats per 
minute. The swing ratio slider to the right controls the swing ratio used.

6 High tempo

Sets the tempo at/above which the swing ratio changes, measured in quarter note beats per 
minute. When Depends on tempo is activated, the swing ratio slider to the right controls the 
swing ratio used.

7 Swing ratio sliders

Allow you to set the swing ratio to be used below the set Low tempo and above the set High 
tempo. Their possible ranges are from 1:1, which is straight, to 5:1, which is a sextuplet with 
the second notated eighth note sounding on the final division.

The current swing ratio and swing percentage values of the sliders are shown to their right.

8 Swing unit

Allows you to choose the rhythmic duration you want to swing in the selected ratio. You can 
swing either eighth notes or 16th notes.
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RELATED LINKS
Playback Options dialog on page 842

Transport window
The Transport window contains playback and MIDI recording functions, such as rewinding 
and fast-forwarding. It contains additional and more precise versions of the playback functions 
available in the toolbar.

You can hide/show the Transport window in any of the following ways:

● Press F2 .

● In the toolbar, click Show Transport Bar .

The Transport window contains the following information and functions:

Bars/Beats display

Shows the position of the playhead relative to bars and beats in the current flow in the 
following order of units: bars, beats, 16th notes, 120ths of a 16th note.

Time display
Shows the position of the playhead in one of the following formats:

● Elapsed time in the following order of units: hours, minutes, seconds, milliseconds

● Timecode in the following order of units: hours, minutes, seconds, frames

Time display showing elapsed time Time display showing the timecode

You can change the content shown in the time display by clicking it.

Activate Project

Activates/Deactivates playback in the project. When playback is deactivated, transport 
and playback functions are disabled.

Rewind to Beginning of Flow

Moves the playhead back to the beginning of the flow.

Rewind

Moves the playhead back by a half note each time you click.
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Fast Forward

Moves the playhead forwards by a half note each time you click.

Stop

Stops playback.

Play From Playhead Position

Plays back from the position of the playhead.

Play From Selection

Plays back from the position of the first selected item in the music area.

If you select items on multiple staves, or multiple items on a single staff, only the 
selected staves are played back.

Record
Starts/Stops MIDI recording.

Record outside of MIDI recording Record during MIDI recording

Retrospective Record

Retrieves any MIDI notes you played during the previous playback and allows you to 
input them on any staff, even if you were not recording them explicitly.

Click

Plays/Mutes the metronome click during playback and recording.

Tempo Mode
Displays the tempo used for both playback and recording. The value changes 
according to the playhead position, and its appearance changes according to its mode.

● You can change the tempo mode by clicking the beat unit.

● You can change the metronome mark value used in fixed tempo mode by clicking 
the number to show a slider, then dragging the slider to the right/left.

Fixed Tempo Mode Follow Tempo Mode

RELATED LINKS
Toolbar on page 33
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Mini transport on page 35
Playing back music on page 632
Changing the tempo mode on page 634
MIDI recording on page 263
Changing the sound used for the click on page 625
Timecodes on page 1435

Changing the content shown in the transport display
You can switch between showing the timecode, the total elapsed time, and the current rhythmic 
position of the playhead expressed in bars, beats, and ticks in both the mini transport in the 
toolbar and the Transport window.

PROCEDURE

● In either the mini transport in the toolbar or the Transport window, click the transport 
display until the content you want appears.

In the Transport window, this is the display on the right.

RESULT
Each time you click in the mini transport display, it cycles through showing the rhythmic position 
of the playhead, elapsed time, and the timecode.

In the Transport window, it only switches between the timecode and elapsed time, as the 
rhythmic position of the playhead is shown permanently on the left of the window.

TIP

You can change what is shown in the mini transport by default for all future projects on the Play 
page in Preferences.

RELATED LINKS
Toolbar on page 33
Mini transport on page 35
Timecodes on page 1435
Preferences dialog on page 61

Playback templates
Dorico Pro uses playback templates to allocate sounds from VST instruments and MIDI devices to 
the instruments in your project.

Playback templates combine the following information in order to obtain correct playback:

● The instrument sounds, articulations, and playback techniques provided by plug-ins, such as 
VST instruments

● The expression/percussion maps required to obtain those sounds

● The endpoint configurations required for the sounds for each instrument

When you add instruments to players in a project, Dorico Pro automatically loads plug-ins for 
them according to the current playback template and sets up expression maps and percussion 
maps as required. Dorico Pro also automatically loads enough plug-in instances, as many plug-
ins can only load a limited number of sounds in each instance.
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You can override playback templates and make your own manual changes to the sounds used 
by instruments in your project, such as by changing the expression maps assigned to endpoints. 
You can then save such changes as custom endpoint configurations, which you can include in 
your own custom playback templates.

You can also export custom playback templates; for example, to share them with other users. 
Playback templates are saved as .dorico_pt files.

NOTE

● Playback templates are available in all projects you open or create on your computer, 
meaning any changes you make to playback templates affect all projects that use those 
playback templates.

● Dorico Pro automatically loads sounds for any new instruments you add to the project, 
using the sounds included in the current playback template. Therefore, we recommend that 
you always include a factory default playback template at the bottom of custom playback 
templates as a fallback to ensure that all instruments are assigned sounds.

● Any changes you make within plug-ins are saved when you save the project but are not 
communicated to Dorico Pro, which can lead to unexpected low notes sounding in playback 
because Dorico Pro is still using the expression and percussion maps for the original sounds. 
If you make changes in plug-ins, you must manually assign the correct expression and 
percussion maps to the appropriate endpoints.

RELATED LINKS
Edit Playback Template dialog on page 654
Applying/Resetting playback templates on page 656
Creating custom playback templates on page 657
Exporting playback templates on page 658
Endpoint Setup dialog on page 659
Assigning expression/percussion maps to endpoints on page 665
Endpoints on page 659
Custom endpoint configurations on page 661
Edit Endpoint Configurations dialog on page 663
Allowing/Blocking VST plug-ins on page 636

Apply Playback Template dialog
The Apply Playback Template dialog allows you to change the playback template applied to the 
current project and to import/export playback templates. It also allows you to access the Edit 
Playback Template dialog.

● You can open the Apply Playback Template dialog by choosing Play > Playback Template.

The Apply Playback Template dialog shows all the playback templates available on your 
computer in a table. Dorico Pro provides the following factory default playback templates:

● HSSE (Elements): Intended for use with HALion Sonic SE.

● HSSE+HSO (Pro): Intended for use with both HALion Sonic SE and HALion Symphonic 
Orchestra.

● Silence: Prevents Dorico Pro from loading sounds.

TIP

Choosing the Silence template makes Dorico Pro project files significantly smaller; for example, if 
you want to send them electronically.
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The Apply Playback Template dialog comprises the following:

1 Search field

Allows you to filter playback templates in the list according to your entry.

2 Name column

Contains a list of the playback templates available on your computer. You can click the 
column header to change the sorting order.

3 Factory column

Contains the factory symbol if the playback template in the corresponding row is a factory 
default playback template. You can click the column header to change the sorting order.

4 Action bar

Contains the following options for playback templates:

● Add Playback Template : Opens the Edit Playback Template dialog and allows you 
to create a new playback template.

● Duplicate Playback Template : Opens the Edit Playback Template dialog and allows 
you to create a new playback template that starts as a duplicate of the selected one.

● Edit Playback Template : Opens the Edit Playback Template dialog and allows you 
to edit the existing selected playback template.

NOTE

You cannot edit factory default playback templates.

● Show Factory : Allows you to hide/show factory default playback templates in the 
table.

● Export: Opens the File Explorer/macOS Finder, where you can select the location to 
which you want to export the currently selected playback templates as .dorico_pt 
files. You can then import the .dorico_pt files into Dorico Pro on other computers and 
share them with other users.

● Import: Opens the File Explorer/macOS Finder, where you can select the .dorico_pt 
files that you want to import as playback templates.
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● Delete : Deletes the selected playback templates.

NOTE

You cannot delete factory default playback templates.

5 Apply and Close

Applies the selected playback template to the project and closes the dialog.

RELATED LINKS
Edit Endpoint Configurations dialog on page 663

Edit Playback Template dialog
The Edit Playback Template dialog allows you to create new custom playback templates and 
edit existing ones. You can use any combination of custom endpoint configurations and existing 
playback templates and specify the order in which they should be used.

Playback templates are available in all projects you open or create on your computer.

● You can open the Edit Playback Template dialog from inside the Apply Playback Template 
dialog by clicking Add Playback Template , Duplicate Playback Template , or Edit 
Playback Template .

The Edit Playback Template dialog contains the following sections and options:

1 Playback template data
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Allows you to specify the following identifying information for the selected custom playback 
template:

● Name: Allows you to set the name of the playback template that appears in the 
program; for example, in the Apply Playback Template dialog.

● ID: Allows you to set the unique ID of the playback template. Dorico Pro automatically 
populates the ID field with the information you enter into the Name field.

● Creator: Allows you to name the creator if you are sharing your playback template with 
other users.

● Version: Allows you to indicate the playback template version so you can identify the 
most recent one; for example, you can increase the Version number each time you 
make changes to the playback template.

● Description: Allows you to add any other information about the playback template.

NOTE

All fields in the playback template data section, except for Name, are locked by the Lock Info 
button. You must click this button in order to change the information in the fields.

2 Entries

Contains a table of all the custom endpoint configurations and existing playback templates 
used by the selected custom playback template. Entries are listed in order of priority, 
meaning that Dorico Pro assigns sounds from the top entry first. We recommend that you 
always include a factory default playback template at the bottom of the list as a fallback to 
ensure that all instruments are assigned sounds.

In most cases, listing entries in your order of preference in the Entries section is sufficient 
to achieve your desired playback. However, if multiple entries in your custom playback 
template provide sounds for the same instrument, you must set family and/or instrument 
overrides; for example, if you only want to use woodwind sounds from the first entry and use 
all other sounds from the second entry.

The column on the right identifies the type of the entry in the corresponding row.

● Manual: Entries that cannot load sounds automatically, including custom endpoint 
configurations

● Auto: Entries that can load sounds automatically; that is, factory default playback 
templates

The action bar at the bottom of the section contains the following options:

● Add Manual: Allows you to add a manual entry to the playback template.

● Add Automatic: Allows you to add an automatic entry to the playback template.

● Move Up : Moves the selected entry up the list.

● Move Down : Moves the selected entry down the list.

● Delete : Removes the selected entry from the playback template.

3 Family Overrides

Contains a list of family overrides applied to the selected entry and allows you to add/
remove overrides. Family overrides allow you to specify the instrument family sounds you 
want to use; for example, if you only want to use the woodwind sounds from an entry that 
also includes brass and string sounds.

The action bar at the bottom of the section contains the following options:

● Add Instrument Family : Allows you to select an instrument family to apply as an 
override to the selected entry.
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● Delete Instrument Family : Removes the selected family override from the selected 
entry.

4 Instrument Overrides

Contains a list of instrument overrides applied to the selected entry and allows you to add/
remove overrides. Instrument overrides allow you to specify individual instrument sounds 
you want to use; for example, if you only want to use a solo violin sound from an entry that 
also includes ensemble string sounds.

The action bar at the bottom of the section contains the following options:

● Add Instrument : Allows you to select an instrument to apply as an override to the 
selected entry.

● Delete Instrument : Removes the selected instrument override from the selected 
entry.

5 Endpoint Configurations

Opens the Edit Endpoint Configurations dialog, which allows you to rename and delete 
custom endpoint configurations, and view the plug-ins and players they contain.

RELATED LINKS
Endpoints on page 659
Edit Endpoint Configurations dialog on page 663
Custom endpoint configurations on page 661

Applying/Resetting playback templates
You can change the playback template applied to the current project; for example, if you want to 
use a different sound library for playback. Re-selecting playback templates resets them to their 
default settings.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback template you want to use.

3. Click Apply and Close.

RESULT
The playback template applied to the current project is changed. If you re-selected the playback 
template already in use, the playback template is reset.

Sounds are loaded into plug-in instances in their score order.

TIP

● You can change the default playback template used for all future projects on the Play page 
in Preferences.

● You can also load sounds just for instruments without assigned sounds by choosing Play > 
Load Sounds for Unassigned Instruments.

RELATED LINKS
Preferences dialog on page 61
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Creating custom playback templates
You can create custom playback templates that can include combinations of factory default 
playback templates, custom endpoint configurations, and other non-factory default playback 
templates that cannot load sounds automatically.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Open the Edit Playback Template dialog to create a new playback template in one of the 
following ways:

● To create an empty playback template, click Add Playback Template  in the action 
bar.

● To create a copy of an existing playback template, select it and click Duplicate Playback 
Template  in the action bar.

3. In the Edit Playback Template dialog, click Lock Info  to unlock the data fields.

4. Enter information for your playback template in the relevant fields.

5. In the Entries section, add the custom endpoint configurations and/or factory default 
playback templates you want.

● To add a custom endpoint configuration or non-factory default playback template, click 
Add Manual and select the one you want from the menu.

● To add a factory default playback template, click Add Automatic and select the one you 
want from the menu.

TIP

We recommend that you always include a factory default playback template at the bottom of 
the list as a fallback to ensure that all instruments are assigned sounds.

6. Optional: To change the order of entries and their order of preference in the playback 
template, select an entry and click one of the following options in the action bar:

● To move the selected entry upwards, click Move Up .

● To move the selected entry downwards, click Move Down .

7. Optional: Repeat step 6 until all the entries are in the correct order of preference.

8. Optional: Select an entry for which you want to specify instrument family overrides.

9. In the Family Overrides section action bar, click Add Instrument Family  and select the 
one you want from the menu.

For example, if you only want to use the woodwind sounds from a sound library that also has 
string sounds, select Woodwinds.

10. Optional: Select an entry for which you want to specify individual instrument overrides.

11. In the Instrument Overrides section action bar, click Add Instrument  and select the one 
you want in the instrument picker.

For example, if you only want to use the piano sound from a sound library that has other 
keyboard instrument sounds, select Piano.

12. Optional: Repeat steps 8 to 11 for other entries for which you want to specify instrument 
family and instrument overrides.

13. Click OK to save your changes and close the dialog.
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RESULT
Your new custom playback template is created. It is available to use in the current project and all 
projects you create/open on your computer.

RELATED LINKS
Apply Playback Template dialog on page 652
Edit Playback Template dialog on page 654
Endpoint Setup dialog on page 659
Custom endpoint configurations on page 661
Allowing/Blocking VST plug-ins on page 636

Importing playback templates
You can import playback templates into projects; for example, if someone you are working 
with exported their custom playback template for you to use. Playback templates are saved 
as .dorico_pt files.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Click Import to open the File Explorer/macOS Finder.

3. Locate and select the playback template file you want to import.

4. Click Open.

RESULT
The selected playback template is imported. It becomes available in the current project and all 
projects you create/open on your computer.

TIP

You can also import playback templates by dragging .dorico_pt files into a Dorico Pro project 
window.

Exporting playback templates
You can export playback templates so you can send them to other users or use them on other 
computers. By default, any playback templates you create are available in all projects on your 
computer.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback templates you want to export.

3. Click Export to open the File Explorer/macOS Finder.

4. Specify a name and location for the playback template files.

5. Click Choose.

RESULT
The selected playback templates are exported and saved in the selected location as 
separate .dorico_pt files.
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Endpoints
“Endpoint” is the term used for the unique combination of inputs and outputs that together allow 
the correct sounds to be played for each instrument.

In Dorico Pro, each endpoint brings together the following:

● A VST instrument or MIDI output device instance

● A specific channel on that VST instrument or MIDI output device

● The patch or program assigned to that channel

● The expression map and/or percussion map that describes the instrument or instruments 
that can be played by that patch or program, and the playback techniques and articulations 
provided

Each instrument in your project is connected to a specific endpoint. Assigning an expression/
percussion map to the same endpoint allows Dorico Pro to translate any playing technique 
changes and articulations you input into the key switches and controller switches necessary to 
produce the required sounds for the instrument in playback.

When you use a factory default playback template, Dorico Pro sets up endpoints and expression/
percussion maps automatically. If you want to load other plug-ins or change the patches within 
HALion Sonic SE, you can do so in the Endpoint Setup dialog.

NOTE

Any changes you make within plug-ins are not communicated to Dorico Pro; for example, 
changing a sound that the expression map expects to use a modulation wheel for dynamics to 
one that uses note velocity instead. This can lead to unexpected low notes sounding in playback 
because Dorico Pro is still using the expression and percussion maps for the original sounds. If 
you make changes in plug-ins, you must manually assign the correct expression and percussion 
maps to the appropriate endpoints.

You can then save your changes as a custom endpoint configuration if you want to reuse them in 
other projects.

RELATED LINKS
Custom endpoint configurations on page 661
Edit Endpoint Configurations dialog on page 663

Endpoint Setup dialog
The Endpoint Setup dialog displays which expression and percussion maps are currently linked 
to each endpoint in the corresponding plug-in instance, and allows you to change these settings. 
It also allows you to save your current settings as custom endpoint configurations, which you can 
then include in custom playback templates.

● You can open the Endpoint Setup dialog by clicking Endpoint Setup  in each plug-in 
instance in the VST and MIDI panel, or in the Routing section of the Track Inspector.
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The Endpoint Setup dialog contains the following options and sections:

1 Name

Allows you to change the name of the selected plug-in instance. This affects the name shown 
in the VST and MIDI panel and in the Mixer.

2 Number of MIDI ports

Displays the number of MIDI ports the corresponding plug-in instance currently uses.

You can change the number of MIDI ports; for example, if you are using a plug-in that uses 
more than one port. Dorico Pro does not load multiple MIDI ports by default.

3 Number of MIDI channels

Displays the number of MIDI channels the corresponding plug-in instance currently uses.

You can change the number of channels; for example, if you have a monotimbral plug-in 
such as a piano sampler which only has one MIDI channel, or a multitimbral plug-in with 16 
MIDI channels and 16 audio outputs.

4 Set

Sets the plug-in instance to have the number of MIDI ports and channels specified in the 
Number of MIDI ports and Number of MIDI channels value fields. This changes the 
number of rows in the table.

5 Endpoint setup table

Contains the settings for the corresponding plug-in instance, arranged into the following 
columns:

● Port: Displays the port used by the instrument in the corresponding row of the table.

NOTE

You cannot change the port from within the Endpoint Setup dialog. You must change 
the port in the Track Inspector.
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● Channel: Displays the channel used by the instrument in the corresponding row of the 
table.

NOTE

You cannot change the channel from within the Endpoint Setup dialog. You must 
change the channel in the Track Inspector.

● Assigned Instruments: Displays the full name of the instrument in the corresponding 
row, as set for that instrument in the Edit Instrument Names dialog, and its instrument 
number, if applicable.

● Expression map: Displays the expression map currently assigned to the instrument in 
the corresponding row. You can change the expression map by double-clicking it and 
selecting another expression map from the menu.

● Percussion map: Displays the percussion map currently assigned to the instrument in 
the corresponding row. You can change the percussion map by double-clicking it and 
selecting another percussion map from the menu.

6 Number of audio outputs to show in Mixer

Allows you to change the number of audio outputs shown in the Mixer; for example, if you 
want to hide unused outputs when using plug-ins that provide more audio outputs than 
Dorico Pro uses.

7 Save Endpoint Configuration

Opens the Save Endpoint Configuration dialog, which allows you to enter a name for the 
current endpoint configuration and save it as a custom endpoint configuration.

RELATED LINKS
Track Inspector on page 617
VST and MIDI panel on page 620
Playback templates on page 651
Expression Maps dialog on page 913
Edit Instrument Names dialog on page 185
Mixer on page 821

Custom endpoint configurations
Custom endpoint configurations save the current state and settings of plug-ins in your project, 
such as the number and type of VST/MIDI instruments loaded and the instruments and 
expression/percussion maps assigned to endpoints.

You can save custom endpoint configurations that include the settings for all plug-ins currently 
loaded or only a single one.
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Custom endpoint configurations are available in all projects you open or create on your 
computer. You can view, rename, and delete the custom endpoint configurations on your 
computer in the Edit Endpoint Configurations dialog.

Saving custom endpoint configurations
You can save any overrides you have made to endpoint configurations, such as changing the 
instruments and expression maps assigned to particular endpoints. This allows you to use these 
overrides in custom playback templates and re-use the same endpoint configurations in other 
projects.

PREREQUISITE

● You have opened a project containing all instruments and plug-ins that are necessary for the 
custom endpoint configuration.

● You have created any necessary expression maps and playback technique combinations.

● You have created any necessary custom playing techniques.

PROCEDURE

1. Load the plug-ins you want.

You can do this by applying a playback template or by adding plug-in instances manually in 
the VST and MIDI panel in Play mode.

2. Change the settings for the endpoints as required.

For example, change the instruments or expression maps assigned to each endpoint.

3. Open the Save Endpoint Configuration dialog in one of the following ways:

● To save a custom endpoint configuration for only a single plug-in instance, open the 
Endpoint Setup dialog for that plug-in instance and click Save Endpoint Configuration.

● To save a custom endpoint configuration that includes all VST instrument or MIDI 
instrument plug-in instances, click Save Endpoint Configuration  in the action bar 
of the corresponding section of the VST and MIDI panel.

4. Enter a name for your custom endpoint configuration in the Name field.

NOTE

If you enter a name that already exists, or select an existing custom endpoint configuration 
from the menu, the existing custom endpoint configuration is overwritten.

5. Click OK to save your changes and close the dialog.

RESULT
The current state of either the selected plug-in instance or all plug-in instances in the 
corresponding section is saved as a custom endpoint configuration. This includes any custom 
playing techniques included in any of the expression/percussion maps.

AFTER COMPLETING THIS TASK
You can include custom endpoint configurations in custom playback templates, which allows you 
to use endpoint configurations in other projects.

RELATED LINKS
Playback templates on page 651
Adding/Editing switches in expression maps on page 927
Custom playing techniques on page 876
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Save Endpoint Configuration dialog
The Save Endpoint Configuration dialog allows you to save the current state and settings of 
plug-ins in your project. Saving custom endpoint configurations allows you to re-use them in 
other projects and include them in custom playback templates.

You can open the Save Endpoint Configuration dialog in Play mode in any of the following 
ways:

● In the VST and MIDI panel, click Save Endpoint Configuration in the VST Instruments 
or MIDI Instruments action bar. This saves the current state of all plug-ins in the 
corresponding section of the panel.

● In the Endpoint Setup dialog, click Save Endpoint Configuration. This saves the current 
state of the selected plug-in only.

The Save Endpoint Configuration dialog contains a Name field that allows you to enter a name 
for the endpoint configuration you are saving. The arrow at the end of the field allows you to 
select an existing custom endpoint configuration to use to populate the field.

If you enter a name that already exists, you can overwrite the existing custom endpoint 
configuration. When you overwrite existing custom endpoint configurations, Dorico Pro moves 
the previous version to your recycle bin.

Edit Endpoint Configurations dialog
The Edit Endpoint Configurations dialog allows you to rename and delete custom endpoint 
configurations, and view the plug-ins and players they contain.

● You can open the Edit Endpoint Configurations dialog by clicking Endpoint Configurations 
in the Edit Playback Template dialog.

The Edit Endpoint Configurations dialog comprises the following:

1 Endpoint configurations list
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Contains all the endpoint configurations on your computer.

Delete Endpoint Configuration  in the action bar at the bottom of the list allows you to 
delete the selected endpoint configuration from your computer.

2 Name

Allows you to set the name of the selected endpoint configuration that appears in the 
program; for example, in the Edit Playback Template dialog.

3 Plug-ins and players list

Contains all the plug-ins and players contained within the selected endpoint configuration. 
If the endpoint configuration contains multiple instances of the same plug-in, each plug-in 
instance is listed separately.

Assigning instruments/voices to endpoints
You can assign instruments to any endpoint; for example, if you have loaded a plug-in with 
multiple ports and want to change the endpoint of an existing instrument to an endpoint on 
one of your new ports. For instruments with independent voice playback enabled, you can assign 
each voice to a different endpoint.

PREREQUISITE

● If you want to assign different voices belonging to the same instrument to different 
endpoints, you have enabled independent voice playback.

● If you want to assign instruments to endpoints in specific plug-in instances, you have loaded 
those plug-in instances. You can do this by applying a suitable playback template or by 
loading VST/MIDI instruments manually.

PROCEDURE

1. In Play mode, in the track overview, select the instrument/voice track whose assigned 
endpoint you want to change.

2. Optional: If you selected a voice track, choose one of the following options for Edits apply to 
in the Routing section of the Track Inspector:

● To change the assigned endpoint for the selected voice in the current flow only, choose 
This flow.

● To change the assigned endpoint for the selected voice in all flows, choose All flows.

3. Optional: To assign the instrument/voice to an endpoint in a different plug-in instance, 
select that plug-in instance from the audio plug-in menu in the Routing section of the Track 
Inspector.

4. Change the endpoint using the following value fields, individually or together:

● To assign the instrument/voice to a different port in the selected plug-in instance, enter 
the required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.

● To assign the instrument/voice to a different channel in the selected port, enter the 
required channel in the Ch. field.

RELATED LINKS
Track overview on page 615
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Track Inspector on page 617
Endpoints on page 659
Expression Maps dialog on page 913
Instrument tracks on page 624
Applying/Resetting playback templates on page 656
Loading VST/MIDI instruments manually on page 622
Enabling independent voice playback on page 636

Assigning expression/percussion maps to endpoints
You can assign expression/percussion maps to the endpoints in your project; for example, if you 
have created a custom percussion map and must link it to the endpoint for the corresponding 
VST patch.

PREREQUISITE
You have made or imported any expression/percussion maps that you require but do not exist 
on your computer.

PROCEDURE

1. In Play mode, in the VST and MIDI panel, click Endpoint Setup  in the plug-in instance in 
which you want to change the expression/percussion maps assigned to endpoints to open 
the Endpoint Setup dialog.

2. Double-click the expression/percussion map you want to change.

3. Click the disclosure arrow to the right of the field.

A menu appears containing all maps of the same type currently loaded in your project.

4. Select the expression/percussion map you want from the menu.

5. Press Return .

6. Optional: Repeat steps 2 to 5 for any other endpoints whose assigned expression/percussion 
maps you want to change.

7. Click OK to save your changes and close the dialog.

RELATED LINKS
VST and MIDI panel on page 620
Expression maps on page 912
Percussion maps on page 930
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Print mode

Print mode allows you to print your layouts or to export them as graphics files, such as PDF and 
SVG.

● When printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing.

● When exporting layouts, you can specify different graphics file types and the information 
you want to include in their exported file names.

Project window in Print mode
The project window in Print mode contains the print preview area and panels that provide all the 
necessary tools and functions for printing and exporting layouts.

You can switch to Print mode in any of the following ways:

● Press Ctrl/Cmd-5 .

● In the toolbar, click Print.

● Choose Window > Print.

The following panels and options are available in Print mode:

1 Layouts panel

Shows a list of all layouts in your project and allows you to select the layouts you want to 
print or export.
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NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2 Print Options panel

Contains options for printing or exporting your layouts.

3 System Dialogs (macOS only)

Contains macOS-specific printing options.

4 View options

Allows you to change the print preview area to show pages in one of the following views:

● Page Width: The page fills the width of the print preview area, which might not show 
the whole page depending on the orientation and format of the page.

● Whole Page: Shows the whole page in the print preview area.

TIP

You can go directly to the first page in the layout by pressing Home , and to the last page 
by pressing End . You can change these key commands on the Key Commands page in 
Preferences.

RELATED LINKS
Project window on page 32
Print Options panel on page 668
Toolbar on page 33
Print preview area on page 39
Key Commands page in the Preferences dialog on page 63

Layouts panel (Print mode)
In Print mode, the Layouts panel shows a list of all layouts in your project and allows you to 
select layouts to preview, print, and export. It is located on the left of the window.

You can hide/show the Layouts panel in Print mode in any of the following ways:

● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.
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The Layouts panel contains all the layouts in your project, displayed as cards. Each layout card 
shows the following:

1 Disclosure arrow

Expands/Collapses the layout card.

2 Layout type

Shows the type of layout from the following options:

● Full score layout 

● Instrumental part layout 

● Custom score layout 

3 Layout name

Shows the name of the layout. Dorico Pro automatically adds default names depending 
on the name of the instrument that is assigned to a player and on the type of layout 
that is added. For example, if you assign a flute to a player, the instrumental part layout 
automatically gets the same name. If you add an empty instrumental part layout, the layout 
name shows Empty part and an incremental number if you add multiple empty part layouts.

4 Page size and orientation

Shows the size and orientation of the layout as set on the Page Setup page in Layout 
Options.

5 Layout length

Shows the number of pages in the layout. You can use this in combination with its page size 
and orientation to determine the best job type for printing/exporting.

TIP

A layout with two pages might best be printed as 2-up, while a layout with five pages might 
best be printed as spreads with the final page printed on a different paper size. A layout with 
12 pages might best be printed as a booklet.

The selected layouts are printed/exported when you click Print or Export in the Print Options 
panel. If you have selected some layouts set to print and some set to export graphics, the button 
reads Print and Export.

RELATED LINKS
Project window in Print mode on page 666
Page arrangements for printing/exporting on page 680
Booklet printing on page 681

Print Options panel
The Print Options panel contains options for printing or exporting your layouts. It is located on 
the right of the window in Print mode.

You can hide/show the Print Options panel in any of the following ways:
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● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Zone.

All the options that you set in the Print Options panel are saved with your project. The options 
are divided into the following sections:

Destination
Allows you to select a physical printer for printing or a file location for exporting a 
graphics file.

● For layouts set to print, you can change the number of copies.

● For layouts set to export as graphics files, you can specify the format, color mode, 
image resolution, file name, and directory of the saved file.

Job Type
Allows you to choose the pages to be printed or exported, and how they are arranged. 
You can choose all pages, a range of pages, or a range of flows.

Page Setup
Allows you to set the paper size and orientation. You can specify the scale factor of the 
image to be printed or exported.
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Duplex Printing
Allows you to specify whether to print on one or on both sides of each sheet of paper. 
Only available when Printer is selected in the Destination section.

Annotations
Allows you to activate options that are often required by publishing houses or printing 
agencies, such as crop marks or a border around the printed image.
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Print button
Allows you to print/export selected layouts according to the settings you have set in 
the Print Options panel.

Depending on your selection, the print button can appear in one of the following ways:

● Print

● Export

● Print and Export

For example, if you selected layouts that are all set to print, Print is shown. If you 
selected some layouts set to export graphics and some layouts set to print, Print and 
Export is shown.

RELATED LINKS
Project window in Print mode on page 666
Exporting layouts as graphics files on page 675
Printers on page 679
Duplex printing on page 682
Page arrangements for printing/exporting on page 680
Page vs. paper size on page 683
Graphics file formats on page 685
Annotations on page 687

Printing layouts
You can print hard copies of individual layouts or multiple layouts together. You can specify print 
settings for each layout independently; for example, you can set different numbers of copies or 
select different printers for layouts in the same project.

Dorico Pro uses settings for layouts to create automatic print settings, so you might find that 
many print options are already appropriate for the layouts you want to print. For example, if you 
are connected to a printer that can print A3 paper and the page size of your full score layout is 
set to A3 in Layout Options, Dorico Pro automatically selects A3 in the Page Setup section of the 
Print Options panel.

TIP

● If you want to save layouts in graphics files formats, such as PDF or PNG, we recommend 
that you export them.

● You can select individual layouts and set up their printing options without printing straight 
away. Once you have set up the printing options you want for different layouts, you can 
then select all the layouts you want to print and click Print. Your existing print settings are 
applied, even if your selection contains layouts with different print settings.

For example, you can set your full score layout to print 3 booklet copies and the part layouts 
to print 1 2-up copy each. You can then select all layouts to print them together and the 
previously set values are followed.

PROCEDURE

1. In the Layouts panel, select the layouts that you want to print.
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NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2. In the Print Options panel, enter the number of copies you want into the Copies field in the 
Destination section.

NOTE

The Copies field appears blank when you have selected layouts with different values.

3. Activate/Deactivate Collate copies.

4. In the Destination section, choose Printer and select a printer from the menu.

5. In the Job Type section, select the page arrangement you want from the menu.

6. Optional: Specify a range of pages/flows.

7. In the Page Setup section, select a paper size from the menu.

8. Choose the paper orientation you want.

9. Optional: If you selected Spreads or 2-up for the job type, activate/deactivate Print odd final 
page on to specify the paper size on which you want to print final pages for layouts with odd 
numbers of pages.

10. Select a paper size and paper orientation for the odd final page.

11. Choose one of the following size options:

● Fit to Paper

● Custom Scale

12. Optional: If you selected Custom Scale, enter the scale factor you want into the Scale factor 
field.

13. In the Duplex Printing section, select one of the printing options from the Print on menu.

14. Optional: If you selected a duplex printing option, use the bottom two menus to select how 
the printed image is flipped when printing on the reverse side of the paper.

15. In the Annotations section, activate each annotation you want to add to the selected 
layouts.

16. Click Print.

RESULT
The selected layouts are printed according to the print settings you have applied.

If your selection included part layouts set to concert pitch that contain transposing instruments, 
Dorico Pro shows a warning and offers to switch them all to transposed pitch before printing/
exporting. You can also select which layouts you want to switch to transposed pitch or proceed 
anyway with no changes.

TIP

● You can choose to show a warning when printing/exporting concert or transposed pitch full 
score and custom score layouts in Preferences > General > Files.

● You can assign key commands to different printing and exporting commands on the Key 
Commands page in Preferences.
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RELATED LINKS
Preferences dialog on page 61
Key Commands page in the Preferences dialog on page 63
Printers on page 679
Paper size and orientation setup on page 684
Export File Names dialog on page 678
Page arrangements for printing/exporting on page 680
Print Options panel on page 668
Duplex printing on page 682
Annotations on page 687
Changing the page size and/or orientation on page 691
Exporting layouts as graphics files on page 675

Specifying ranges of pages/flows
By default, Dorico Pro prints/exports all pages in the selected layouts. You can specify ranges of 
either pages or flows for each layout independently.

NOTE

You can only print booklets using the complete range of pages. You cannot specify page or flow 
ranges.

PROCEDURE

1. In the Layouts panel, select the layouts for which you want to specify ranges of pages/flows.

2. In the Print Options panel, in the Job Type section, choose one of the following options for 
Print range:

● To specify ranges of pages, choose Pages.

● To specify ranges of flows, choose Flows.

3. If you chose Pages, enter the pages you want into the value field.

● To specify a range of pages, enter the first page and last page separated with a dash, 
such as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated with 
commas, such as 1,3,5-8.

NOTE

Separate ranges are exported as separate files.

4. If you chose Flows, click Choose to open the Print Flows dialog. Select the flows you want to 
print/export, then click OK.

RESULT
The pages set to be printed/exported from the selected layouts are changed. Ranges of flows 
include all pages on which those flows appear, in full or in part.

RELATED LINKS
Print Options panel on page 668
Export File Names dialog on page 678
Page arrangements for printing/exporting on page 680
Exporting flows on page 84
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Print Flows dialog
The Print Flows dialog allows you to select the flows you want to print/export from the selected 
layouts. Ranges of flows include all pages on which those flows appear, in full or in part.

● You can open the Print Flows dialog in Print mode by clicking Choose in the Job Type 
section of the Print Options panel. Choose is available when the selected layouts are set to 
print/export a range of flows.

1 Flows to print or export

Contains a list of all the flows in the selected layouts. Flows are included in the page range to 
be printed/exported when their checkbox is activated.

2 Selection options

Allow you to select/deselect flows. The following selection options are available:

● Select All: Selects all flows.

● Select None: Deselects all flows.

● Invert Selection: Switches your selection to include all flows not previously selected.

Specifying printing options (macOS only)
Dorico Pro allows you to access the standard printing options of your operating system.

NOTE

If you use the standard printing options of your operating system, the settings in the Print 
Options panel are ignored. macOS-specific print settings are not saved with your project. These 
must be set each time you want to print, whereas the Dorico Pro print options are always saved 
with your project.

PROCEDURE

1. In the Layouts panel, click Page Setup in the OS X Dialogs section to open the macOS Page 
Setup dialog.

2. In the Page Setup dialog, set the paper size.

3. Click OK.

4. In the OS X Dialogs section, click Print to open the macOS Print.

5. In the Print dialog, set up the printing options you want.
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Exporting layouts as graphics files
You can export layouts as a variety of graphics files, such as PDF or PNG.

TIP

You can export layouts with different image settings and export paths simultaneously.

PROCEDURE

1. In the Layouts panel, select the layouts you want to export.

NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2. In the Print Options panel, choose Graphics in the Destination section.

3. Optional: Change the image settings for the selected layouts.

4. Optional: Change the export path for the selected layouts.

5. Optional: If you want to change the file name recipe, click File Name Options to open the 
Export File Names dialog.

6. Optional: In the Export File Names dialog, change the file name recipe for your selected 
graphics file formats.

TIP

We recommend including the Page number token for PNG, SVG, and TIFF files as each page 
in layouts using these formats is exported as a separate file.

7. Optional: Specify a range of pages/flows.

8. In the Page Setup section, choose the page orientation you want.

9. In the Annotations section, activate each annotation you want to add to the selected 
layouts.

NOTE

Watermarks are only included in layouts exported as Color graphics.

10. Click Export.

RESULT
The selected layouts are exported as the selected graphics format using the file name recipe set 
for their graphics file format in the Export File Names dialog. They are saved in the folder set in 
the Destination folder field, or in the same folder as the project file if the set export path is no 
longer accessible.

Exported layouts use the page size set for the layout on the Page Setup page in Layout Options.

If your selection included part layouts set to concert pitch that contain transposing instruments, 
Dorico Pro shows a warning and offers to switch them all to transposed pitch before printing/
exporting. You can also select which layouts you want to switch to transposed pitch or proceed 
anyway with no changes.
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TIP

● You can choose to show a warning when printing/exporting concert or transposed pitch full 
score and custom score layouts in Preferences > General > Files.

● You can assign key commands to different printing and exporting commands on the Key 
Commands page in Preferences.

RELATED LINKS
Specifying ranges of pages/flows on page 673
Changing the page size and/or orientation on page 691
Export File Names dialog on page 678
Annotations on page 687
Graphics file formats on page 685
Image resolution on page 685
Monochrome and color graphics processing on page 686
Embedding of fonts in PDF and SVG files on page 686
Preferences dialog on page 61
Key Commands page in the Preferences dialog on page 63
Layout Options dialog on page 834
Page vs. paper size on page 683
Graphic slices on page 592
Exporting flows on page 84

Changing the image settings for layouts
You can change the graphics file format, color mode, and image resolution of layouts 
individually; for example, if you want to export some layouts as PDF files but others as PNG 
files.

PROCEDURE

1. In the Layouts list, select the layouts whose export path you want to change.

2. In the Print Options panel, choose Graphics in the Destination section.

3. Select a graphics file format from the menu.

4. Optional: If you selected PNG or TIFF, select a resolution from the Resolution menu.

TIP

The Resolution setting does not affect PDF and SVG files as they are vector formats.

5. Choose a color mode.

● Mono exports the graphic in black and white.

● Color exports the graphic in full color.

NOTE

● For layouts that you want to export with watermarks, or that contain colored or not 
completely transparent elements, you must choose Color. If you select Mono, such 
elements appear black in the exported file.

● When exporting graphics files with a resolution of 72 dpi, we recommend that you select 
Color. If you select Mono, staff lines can disappear.
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RESULT
The image settings for the selected layouts are changed. This also changes the file name recipe 
used for the corresponding layouts when you export them.

RELATED LINKS
Graphics file formats on page 685
Image resolution on page 685
Monochrome and color graphics processing on page 686
Embedding of fonts in PDF and SVG files on page 686
Hiding/Showing noteheads on page 1257

Changing the export path for layouts
You can specify an export path to any folder to which you want to export layouts as 
graphics files. You can specify a different export path for each layout and still export them all 
simultaneously.

By default, Dorico Pro exports graphics files into the same folder as your project file. If you have 
not saved your project yet, graphics files are saved in your Dorico Projects folder.

PROCEDURE

1. In the Layouts list, select the layouts whose export path you want to change.

2. In the Destination section of the Print Options panel, click Choose Folder  beside the 
Destination folder field to open the File Explorer/macOS Finder.

3. Locate and select the destination folder you want.

4. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Destination 
folder field.

5. Optional: Repeat steps 1 to 4 for other layouts whose export path you want to change.

6. Optional: If you want to change the file name recipe, click File Name Options to open the 
Export File Names dialog.

7. Optional: In the Export File Names dialog, change the file name recipe for your selected 
graphics file formats.

TIP

We recommend including the Page number token for PNG, SVG, and TIFF files as each page 
in layouts using these formats is exported as a separate file.

RESULT
The export path for the selected layouts is changed. When exported, the layouts use the file 
name recipe set for their graphics file format in the Export File Names dialog.

NOTE

If the export path specified is no longer accessible, such as if you receive a project from someone 
who uses a different operating system, Dorico Pro automatically updates the export path to the 
same location as the project file.
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Export File Names dialog
The Export File Names dialog allows you to determine the contents of file names for each 
graphics file format independently. You can use universal ingredients that update to show the 
correct information for each layout automatically, and you can enter text that is the same for all 
layouts.

You can open the Export File Names dialog in any of the following ways:

● In Print mode, click File Name Options in the Destination section of the Print Options panel 
when the currently selected layout is set to Graphics.

● In Preferences > General > Exporting Files, click Edit.

NOTE

Your settings are linked between both ways of accessing the dialog and are saved as the default 
for all future projects.

The Export File Names dialog contains the following options:

1 File names for

Allows you to select different graphics file formats. You can set different file name recipes for 
each graphics file format.

2 Preview

Displays an example file name based on the current recipe. The layout used for the preview 
is the one shown in the layout selector in the toolbar.

For example, the preview for a full score PDF file name using the default recipe might be 
01 - Full score - Lieder.pdf.

3 File name recipe

Displays the recipe for the selected graphics file format. You can enter text directly into this 
field, and click ingredients to add them automatically.

For example, the default PDF file name recipe is $n - $l - $t.
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4 Reset to Default

Resets the file name recipe to the default for the selected graphics file format.

5 Copy to All

Copies the file name recipe to all layouts in the project.

6 File name ingredients

Allow you to add ingredients to the file name recipe quickly that are automatically populated 
as appropriate for each layout. For example, the ingredient $l becomes Piano when used to 
export a piano part layout.

The buttons for each ingredient display both the information to which the ingredient refers 
and the characters for it.

When you click file name ingredients, they are added to the end of the file name recipe. They 
are automatically separated from the previous ingredient using the default separator.

NOTE

The page number ingredient is not available for the PDF file name recipe as it is a multi-page 
format.

7 Default separator

Allows you to set the characters used to separate ingredients in the file name recipe by 
default.

RELATED LINKS
Exporting layouts as graphics files on page 675

Printers
You can print layouts from Dorico Pro projects to any printer to which your computer is 
connected.

You can select different printers for each layout in your project. This allows you to send layouts 
to the most appropriate printer for their requirements. You can select a printer when Printer is 
chosen in the Destination section of the Print Options panel.

Dorico Pro uses the same printer as designated by the operating system by default, unless you 
specify another printer. In this case, the settings in the following sections in the Print Options 
panel can change:

● In the Page Setup section, the list of available paper sizes lists only paper sizes that the 
chosen printer provides.

● In the Duplex Printing section, the option for automatic duplex printing is only available if 
the chosen printer has this function.

NOTE

The printer menu in the Destination section only shows the name of a printer if all currently 
selected layouts are set to print to the same printer. If you select a new printer from the menu, 
all selected layouts are set to print to that printer.

RELATED LINKS
Print Options panel on page 668
Printing layouts on page 671

Print mode
Printers 
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Page arrangements for printing/exporting
Dorico Pro provides several page arrangements that you can use for printing/exporting your 
layouts.

In the Job Type section of the Print Options panel, you can specify how you want the layouts to 
be printed/exported. You can select the following job types from the Job Type menu:

Normal
Prints one page on each sheet of paper. This produces single-sided pages; for example, 
for instrumental parts that do not have regular page turns and must be bound in a 
continuous line.

Spreads
Prints two pages on each sheet of paper, with odd-numbered pages on the right-hand 
side and even-numbered pages on the left-hand side.

You can also specify a paper size on which to print odd final pages; for example, if you 
are printing a layout containing five pages.

2-up
Prints two pages on each sheet of paper. The first page in the range is printed on the 
left-hand side of the first sheet of paper. This can be useful for printing instrument 
parts as it reduces the number of edges that must be bound, because pages can also 
be folded in half.

You can also specify a paper size on which to print odd final pages; for example, if you 
are printing a layout containing five pages.

Booklet
Prints two pages on each sheet of paper according to imposition requirements. This 
means that if the paper is folded, the pages are laid out like a book. This can be 
useful for scores and choir parts in particular as they often contain more pages than 
instrumental parts.

NOTE

You can only print booklets using the complete range of pages. You cannot specify 
page or flow ranges.

NOTE

● Depending on the job type that you choose, Dorico Pro switches the page orientation 
automatically. The changed orientation is immediately displayed in the music area. If this 
is not what you want, you can override the orientation in the Page Setup section.

● All of the job types allow printing either onto a single side of each sheet of paper or on both 
sides of the paper.

● It is usual to print booklets, spreads, and 2-up onto paper in landscape orientation. Printing 
one page to each sheet typically uses portrait orientation, unless the layout itself uses 
landscape orientation.

Also in the Job Type section, you can choose which pages you want to print/export.

All
Allows you to print/export all pages in the selected layouts.

Print mode
Page arrangements for printing/exporting 
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Pages
Allows you to set a range of pages to be printed/exported. Choosing Pages makes the 
value field available.

● To specify a range, enter the first page and last page separated with a dash, such 
as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated 
with commas, such as 1,3,5-8.

Flows
Allows you to set a range of flows to be printed/exported. When Flows is chosen, you 
can click Choose to open the Print Flows dialog, which allows you to select the flows 
you want to print/export.

RELATED LINKS
Paper size and orientation setup on page 684
Specifying ranges of pages/flows on page 673
Margins on page 712

Booklet printing
Booklets are documents printed on both sides of the paper and folded to resemble the pages in 
a book. When printed as a booklet, pages are reordered so that you can fold the printed pages 
and read the content in the same order as they were in the project.

Printing layouts as a booklet can be much quicker than printing pages single-sided or double-
sided. For example, if your full score is twenty pages long and you print it on both sides 
automatically, you must then bind one edge of the printed pages in order to keep them together. 
However, if you print the full score as a booklet, you can simply fold the printed pages in the 
middle.

Booklet printing settings reorder pages so that they appear in the correct order on the printed 
page. For example, a layout containing four pages printed as a booklet is laid out as follows:

● First side: page four on the left, page one on the right

● Reverse side: page two on the left, page three on the right

If the layout you are printing as a booklet contains an odd number of pages, Dorico Pro 
automatically places any empty last pages at the end of the booklet. This follows the convention 
of showing odd-numbered pages on the right. For example, if you print a layout containing six 
pages as a booklet, a total of eight pages are printed with the last two pages in the booklet left 
blank. If you want the empty pages to be positioned differently, you can add extra pages to the 
layout; for example, a title page.

NOTE

● You can only print booklets using the complete range of pages. You cannot specify page or 
flow ranges.

● If the order of inward pages is incorrect when you are printing booklets using manual 
duplexing, you can activate Reverse order of outward pages in the Duplex Printing section 
of the Print Options panel, which instructs Dorico Pro to output the first set of pages in the 
opposite order.

RELATED LINKS
Printing layouts on page 671
Duplex printing on page 682

Print mode
Page arrangements for printing/exporting 
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Duplex printing
Dorico Pro allows duplex printing, which means that you can print on both sides of each sheet of 
paper.

If your printer supports automatic duplex printing, you can use this function in Dorico Pro. If 
your printer can only print on one side of each sheet of paper, there is a manual duplex printing 
option.

The Print on menu in the Duplex Printing section of the Print Options panel contains the 
following options:

One side only
Prints on one side of each sheet of paper.

Both sides manually
Prints on both sides of each sheet of paper. Use this option if you printer lacks an 
automatic duplex printing function. After all outward pages have been sent to the 
printer, a message box informs you to turn over the stack of printed pages and put 
them back into the printer. Click OK to continue printing the inward pages.

Both sides automatically
Prints on both sides of each sheet of paper automatically. This option is only available if 
your printer supports this type of printing.

The other menus in the Duplex Printing section allow you to set how the printed image is 
flipped when printing on the reverse side of the paper.

Flip image (portrait)

Determines how the image is flipped for reverse side printing in portrait orientation.

● Flip automatically uses the printer’s default settings for printing on the reverse 
side. If you find that the printer flips on a different edge than expected, use one of 
the other options.

● Flip long side sets the printer to flip the pages on the long edge.

● Flip short side sets the printer to flip the pages on the short edge.

Flip image (landscape)

Determines how the image is flipped for reverse side printing in landscape orientation.

● Flip automatically uses the printer’s default settings for printing on the reverse 
side. If you find that the printer flips on a different edge than expected, use one of 
the other options.

● Flip long side sets the printer to flip the pages on the long edge.

● Flip short side sets the printer to flip the pages on the short edge.

Reverse order of outward pages at the bottom of the section instructs Dorico Pro, when 
activated, to output the first set of pages in the opposite order when printing booklets using 
manual duplexing. This is necessary for some printers so that you do not have to reverse sort the 
pages manually before returning them to the printer to print the other sides.

RELATED LINKS
Printing layouts on page 671

Print mode
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Page vs. paper size
In Dorico Pro, page sizes and paper sizes use different settings. This means that you can print 
layouts with any page size onto paper with a different paper size.

For each layout in your project, you can define a page size on the Page Setup page in Layout 
Options, which sets the dimensions of the layout.

When exporting layouts as graphics files, the layout’s page size is always used. When printing 
layouts, you must usually choose a paper size that is provided by the printer that you are using.

Normally, the layout's page size and the printed paper size match. However, if you define a 
layout with an unusual page size that is not supported by your printer, such as 10" x 13", one of 
the standard page sizes for instrumental parts, you may have to print the layout onto a different 
paper size. You can change the paper size in the Page Setup section of the Print Options panel 
according to your needs. As long as your printer supports sufficiently large paper for your page 
size settings, and they match a standard paper size, your dimensions are included in the menu. 
Changing the paper size has no effect on your layout's page size, and does not, therefore, affect 
the way the music is laid out.

If you do not select a specific paper size, Dorico Pro automatically chooses a paper size that is 
based on your computer's locale settings. For example, if these are set to a European country, 
an international ISO standard might be used, such as A4. If they are set to a North American 
country, one of their typical standards might be used, such as US Letter.

If you have defined a page size for your layout that is larger than a typical standard, Dorico Pro 
automatically chooses the next larger paper size, provided that your printer supports this. For 
example, if the layout's page size is larger than A4/US Letter, A3/Tabloid is used.

If you print to a different paper size than the layout's page size, Dorico Pro automatically scales 
the image to fit the paper. You can change this setting by specifying a custom scale factor in the 
Page Setup section.

RELATED LINKS
Layout Options dialog on page 834
Changing the page size and/or orientation on page 691
Printing layouts on page 671
Exporting layouts as graphics files on page 675
Margins on page 712

Paper orientation
Paper orientation is the direction of rectangular paper for viewing and printing. Paper can have 
either landscape or portrait orientation.

Instrumental parts are most often printed using portrait orientation, as this allows two or three 
pages to be spread out at a time on most music stands.

Full scores for conductors are also commonly printed using portrait orientation, as this allows 
more staves to fit on the page than with landscape orientation. However, full scores for small 
ensembles might use landscape orientation as fewer staves have to fit on the page. Having more 
horizontal room on the page allows more bars to fit on each page, reducing the number of page 
turns required.

In Dorico Pro, you can set the orientation of pages independently of the paper orientation; for 
example, you can print portrait pages on landscape paper. You can also separately set the paper 
orientation of the odd final page in layouts using the Spreads and 2-up page arrangements.

Print mode
Page vs. paper size 
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RELATED LINKS
Changing the page size and/or orientation on page 691

Paper size and orientation setup
Layouts can have different paper sizes and orientation settings.

NOTE

If you have selected Graphics in the Destination section of the Print Options panel, you can only 
change the paper orientation. No other options are available.

The Page Setup section of the Print Options panel contains the following options when you have 
chosen Printer in the Destination section:

Paper size
Allows you to select one of the available paper sizes from the menu. The paper sizes 
available depend on the capabilities of the selected printer.

Paper orientation
Allows you to choose one of the following paper orientation options:

● Portrait 

● Landscape 

Print odd final page on
For Spreads and 2-up job types only: If this is activated, you can select a different 
paper size or orientation for the odd final page.

This setting is useful when printing layouts with an odd number of pages on A3 paper 
in landscape orientation. For example, if your layout contains five pages, the first four 
pages fit onto two sheets of A3, while the fifth page would occupy only the left-hand 
side of a third sheet of A3. This setting allows you to print the odd final page on A4 
paper in portrait orientation instead.

Fit to Paper
The whole page is scaled to fit the paper size selected. For example, if you select a 
layout with a page size of A4 and select a paper size of A3, pages in the layout are 
enlarged to fit the larger paper size.

Custom Scale
The page is scaled to the set percentage of its original size. For example, if you are 
printing a layout with a page size of A3, select a paper size of A4, and set Custom Scale 
to 100, the original page remains at its original size, exceeding the boundaries of the 
A4 paper.

RELATED LINKS
Page arrangements for printing/exporting on page 680
Changing the page size and/or orientation on page 691
Margins on page 712
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Graphics file formats
Dorico Pro supports multiple graphics file formats as which you can export your layouts.

PDF
Stands for Portable Document Format. Exporting layouts to PDF allows you to create 
a platform-independent document that contains a fixed version of each layout; for 
example, to send to someone who does not have access to Dorico Pro.

PNG
Stands for Portable Network Graphics. PNG files are losslessly compressed, meaning 
they produce high-quality images.

SVG
Stands for Scalable Vector Graphics. Because SVG is an XML-based text format, it can 
be scaled to any size without any loss of quality. Dorico Pro renders SVG graphics using 
drawing instructions rather than rasterizing them, resulting in better resolutions and 
smaller file sizes.

TIFF
Stands for Tagged Image File Format. TIFF files are not compressed, which means their 
file sizes can be larger than other formats and the quality of the image is not reduced.

RELATED LINKS
Exporting layouts as graphics files on page 675
Exporting graphic slices on page 598
Changing the image settings for graphic slices on page 596
Monochrome and color graphics processing on page 686
Embedding of fonts in PDF and SVG files on page 686

Image resolution
Image resolution refers to the number of pixels contained in an image. The larger the number of 
pixels, the sharper and clearer the image appears.

In Dorico Pro, you can export PNG and TIFF files with different image resolutions. The image 
resolution is measured in dots per inch, or “dpi”.

● 72

● 150

● 300

● 600

● 1200

NOTE

A resolution of 72 dpi is suitable for display on screen so that you can embed the graphic in an 
e-mail or on a web page. If you choose 300, 600, or 1200 dpi, a high-resolution image is saved 
that you can include as an illustration in a word processing or desktop publishing document.

RELATED LINKS
Exporting layouts as graphics files on page 675
Exporting graphic slices on page 598
Changing the image settings for graphic slices on page 596

Print mode
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Monochrome and color graphics processing
Dorico Pro applies different settings when you export monochrome and color graphics. The most 
appropriate setting depends on your intended purpose for the graphics.

Most musical scores are monochrome, meaning they use only black ink and are normally 
printed on white/near-white paper. Some educational books occasionally use colors to highlight 
particular notations; for example, to identify clefs, or to color notes according to their pitch. If 
you export graphics files and print them with your own printer, you can leave Color selected in 
the Destination section.

However, if you export graphics files in PDF format for direct printing on a platesetter or for 
further production work in a page layout program, select Mono, unless your layout actually 
contains elements with color or opacity set. If you select Mono, Dorico Pro uses a different color 
space for the resulting PDF, ensuring that the printed image only uses black ink. If you choose 
Color, then the black items in your layout are exported as rich black; that is, black produced 
by combining multiple colored inks. This can cause problems in production when making color 
separations at the pre-press stage.

Dorico Pro specifies colors using the RGB color model, rather than the CMYK color model that 
is used by platesetters and other professional printing machines. If you have colored objects in 
your layouts and your layouts are printed professionally, you must post-process the graphics files 
that are exported from Dorico Pro in another graphics application to convert the colors from RGB 
to CMYK.

Embedding of fonts in PDF and SVG files
How fonts are handled in PDF and SVG files mainly depends on the fonts that you use in the 
project.

PDF Files
The music and text fonts, and their sub-sets, that are supplied with Dorico Pro are 
embedded in PDF files during the export. If you open the PDF files on a different 
computer, they look the same, even if that computer does not have the fonts installed 
that are used in the document. If you use different fonts, make sure that these permit 
embedding.

SVG Files
SVG (Scalable Vector Graphics) files do not embed fonts directly. Some font characters, 
such as note heads, articulations, and accidentals, are converted into outlines, so that 
they do not depend on the font from which they are taken. Other font characters, such 
as time signature and tuplet digits, are only encoded using references to the font from 
which they are taken. The latter also applies to regular text, such as staff labels, tempo 
instructions, and dynamics. This means that the SVG file looks incorrect if rendered by 
a web browser on a computer that does not have the fonts installed. The appearance 
of SVG files depends on the browser or the rendering software, and on the fonts that 
are installed on the computer.

To ensure that the SVG file appears correctly if embedded in a web page, you can open 
the SVG file in an illustration program and convert all font characters to outline paths, 
then re-export the SVG file and embed that file. Alternatively, you can use web fonts to 
ensure that the necessary fonts are available on the web server.

SVG graphics that are exported from Dorico Pro conform to the SVG Tiny 1.1 
specification, which defines a subset of features in the full SVG specification.

For information about using web fonts with SVG, refer to the Help Center on the 
Steinberg website.

Print mode
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RELATED LINKS
Exporting layouts as graphics files on page 675
Exporting graphic slices on page 598
Changing the image settings for graphic slices on page 596
Graphics file formats on page 685
Image resolution on page 685
Monochrome and color graphics processing on page 686

Annotations
Annotations provide additional information for printed or exported documents, such as the 
date and time it was printed. Publishers and printing agencies can use these to identify and 
register printed images correctly or to embed exported graphics files into a desktop publishing 
application.

When printing/exporting your layouts for publication, you can include typical annotations. You 
can also allow Dorico Pro to print or export any view options that you have activated in your 
project.

NOTE

Crop marks and the border can only be printed if the page size is smaller than the paper size.

The Annotations section of the Print Options panel contains the following options:

Crop marks
Adds short vertical and horizontal lines at each of the four corners of the page.

Border
Adds an outline around the edge of the page dimensions.

Date and time
Adds the date and time of printing at the bottom of each page.

Watermark
Adds large translucent text across the middle of each page. This is useful for indicating 
that this version is a draft, proof, or perusal score.

In the Watermark field at the bottom of the section, you can enter the text that you 
want to show on each page.

TIP

● Watermarks use the Print Watermark Font font style. You can edit the formatting 
of this font in the Edit Font Styles dialog; for example, to change its font size.

● Watermarks are only included in layouts exported as Color graphics.

View options
Adds all active view options, such as signposts, comments, and note and rest colors, to 
the printout or exported graphic.

RELATED LINKS
Signposts on page 453
Comments on page 506
Edit Font Styles dialog on page 846
Printing layouts on page 671
Exporting layouts as graphics files on page 675

Print mode
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Hiding non-printing elements on page 444

Print mode
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Page formatting

The formatting of pages in Dorico Pro is determined by a number of factors, including the 
layout’s staff size, page margins, the page template applied to them, any casting off values 
applied to them, system and frame breaks, and frame padding.

The most important factors that determine how pages are formatted in Dorico Pro are:

Staff size
Staff size refers to the distance between the top and bottom lines of staves. The most 
appropriate staff size depends on the intended purpose and contents of the layout. In 
many cases, changing the staff size is the quickest way to produce legible layouts.

Staff spacing
Staff spacing mostly involves the height of staves and the necessary gaps between 
staves and systems.

Casting off
“Casting off” is the term used to encompass fixing the layout of pages of music, such as 
setting the number of systems per page.

System and frame breaks
System and frame breaks allow you to adjust layouts at a more granular level, by 
determining which bars are shown on each system and where music is pushed into the 
next frame.

Page margins
Page margins determine the dimensions of pages in layouts. Frames cannot exceed 
the boundaries set by the margins of the layout, which you can change on the Page 
Setup page in Layout Options. You can change the size of margins on each edge of 
each page.

Page templates
All pages in your layouts inherit their layout formats from page templates. Whenever 
you create or change anything on page templates, this is automatically reflected on 
the pages that use these page templates. If you want to show information on pages 
in your project, such as the composer’s name on the first page or the flow title in the 
running header at the top of all subsequent pages, in most cases it is simplest to do 
this by editing the relevant page template.

TIP

For displaying information such as the composer, librettist, or flow or project titles, we 
recommend using tokens to refer to fields in the Project Info dialog.

Flow headings
Flow headings show the number and title of each flow immediately above their first 
system automatically. They have no fixed vertical position and follow the music if it 
moves. The default flow heading contains tokens to display the flow number and flow 
title; in a new project, this appears as “1. Flow 1”.

You can hide/show flow headings on a per-layout basis. You can customize flow 
headings in the flow heading editor, including inputting extra frames, changing 
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the contents of text frames, and editing/moving existing text and graphics frames. 
Deleting or editing individual flow headings is considered a page template override, 
which is a type of page format change.

Music frame margins
Music frames have margins at the top and bottom. Music frame margins provide 
padding to ensure that musical material displayed within the frame remains on the 
page. For example, if music frames have no padding, the top line on the top staff in 
the frame is positioned at the top of the frame. Any notes that require ledger lines 
above the staff might then be positioned off the top of the page. You can change the 
default music frame margins for each layout and change the padding of individual 
music frames in Engrave mode using properties in the Properties panel.

Frame constraints
Frame constraints lock the edges of frames to page margins. This allows a single page 
template to be applied to layouts with different paper sizes and remain consistently 
proportioned.

We recommend familiarizing yourself with these concepts, and how to use them together and in 
different contexts, in order to produce well-formatted layouts.

RELATED LINKS
Library Manager on page 831
Layout Options dialog on page 834
Staff size on page 716
Staff spacing on page 720
Casting off on page 728
System breaks on page 733
Frame breaks on page 736
Frame constraints on page 590
Page templates on page 527
Page template editor on page 540
Flow headings on page 554
Hiding/Showing flow headings on page 707
Flow heading editor on page 555
Page format changes on page 542
Removing page template overrides on page 545
Tacets on page 739
Margins on page 712
Hiding/Showing empty staves on page 696
Hiding/Showing used chord diagrams grids on page 1060
Layouts on page 169
Flows on page 166
Players on page 124
Project Info dialog on page 78
Project templates on page 80
Tokens on page 576
Changing the default font family on page 853

Page formatting
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Changing the page size and/or orientation
You can change the page size and/or orientation of each layout independently. For example, you 
can use a large, landscape page in full score layouts and a small, portrait page for part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the page size and/or 
orientation.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Size section, select a page size from the Size menu.

For example, you can select fixed page sizes, such as A3 or Letter, or select Custom to 
define your own page size.

5. Optional: If you selected Custom, change the Width and Height of the page by changing 
the values in the value fields.

6. Choose one of the following options for Orientation:

● Portrait

● Landscape

7. Optional: Repeat steps 2 to 6 for other layouts whose page size/orientation you want to 
change.

8. Click Apply, then Close.

RESULT
The page size and/or orientation is changed for all the selected layouts.

NOTE

● Changing the page size of layouts might not change the paper size automatically selected for 
those layouts in the Print Options panel in Print mode. For example, if your default printer 
cannot print the page size selected for layouts, the largest paper size the printer can handle 
is selected. Similarly, if you had already set options for printing layouts before changing the 
page size in Layout Options, Dorico Pro attempts to preserve your original print options.

Similarly, the page orientation is independent of the paper orientation. We recommend that 
you check that layouts have the correct paper orientation set for their page orientation in 
the Print Options panel in Print mode before printing/exporting, as it is possible to print 
landscape layouts on portrait paper and vice versa.

● Changing the page size, orientation, and/or page margins can cause frames to appear with 
different sizes/shapes, depending on their frame constraints.

RELATED LINKS
Paper size and orientation setup on page 684
Frame constraints on page 590
Printing layouts on page 671
Exporting layouts as graphics files on page 675

Page formatting
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Changing page margins
You can change the page margins of each layout independently; for example, if you want wider 
margins for layouts in your project that will be spiral bound.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the page margins.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Margins section, choose one of the following options for Page margins:

● Same: All pages in the selected layouts have the same margins.

● Different: Left and right pages in the selected layouts can have completely different 
margins.

● Mirrored: Left and right pages in the selected layouts use the same margin values but 
they correspond to the inside/outside edges of pages.

5. Optional: Change the margins by changing the values in the value fields.

6. Click Apply, then Close.

RESULT
The page margins in the selected layouts are changed. Any frames in the selected layouts with 
fixed constraints are automatically moved or resized as required.

NOTE

Changing the page size, orientation, and/or page margins can cause frames to appear with 
different sizes/shapes, depending on their frame constraints.

RELATED LINKS
Margins on page 712
Changing the first system indent on page 1566
Changing the gap before codas on page 1455
Hiding/Showing staff labels on page 1532
Hiding/Showing used chord diagrams grids on page 1060
Frame constraints on page 590

Applying page template sets to layouts
You can change the page template set used by each layout in your project; for example, if you 
want a custom score layout to use the Default Part page template set because that set shows 
the layout name on the first page.

By default, full score and custom score layouts use the Default Full Score page template set and 
part layouts use the Default Part page template set.

Page formatting
Changing page margins 
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PREREQUISITE
If you want to use a page template set not currently in the project, you have created or imported 
that page template set.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose page template set you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Template section, select the page template set you want from the Page 
template set menu.

5. Click Apply, then Close.

RESULT
The selected page template set is applied to the selected layouts.

TIP

You can also apply page template sets in Engrave mode by selecting them from the Current set 
menu in the Page Templates section of the Pages panel. This automatically updates the layout 
option but only for the layout open in the music area.

AFTER COMPLETING THIS TASK
You can assign page templates to individual pages in layouts that use their page template set.

RELATED LINKS
Page template sets on page 529
Changing when the First page template is used on page 706
Assigning page templates to pages on page 549
Assigning flows to frame chains on page 573
Page format changes on page 542
Allowing/Disallowing multiple flows on the same page on page 706
Hiding/Showing flow headings on page 707
Pages panel on page 522

Changing the default staff size
You can change the default size of staves in each layout independently. For example, you can 
have a small staff size in full score layouts but a larger staff size in part layouts.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top staff in each 
instrument family group affects the size of system objects if they are shown above that bracketed 
group. Font styles that are set to Absolute are unaffected by staff size.
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PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose staff size you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Space Size section, select the staff size you want from the Rastral size menu.

NOTE

If you select Custom, you can set a custom value in the Space size field, expressed in your 
preferred unit of measurement.

You can also set a Custom value by changing the value when any Rastral size is selected.

5. Optional: Repeat steps 2 to 4 for other layouts.

6. Click Apply, then Close.

RESULT
The staff size is changed throughout the selected layouts.

TIP

You can also change the staff size from selected rhythmic positions onwards in layouts, and 
change the size of individual staves.

RELATED LINKS
Staff size on page 716
Edit Font Styles dialog on page 846
Brackets and braces on page 1023
System objects on page 1563

Changing the default staff/system spacing
You can change the default gaps between staves and systems in each layout independently. For 
example, you can have smaller gaps between staves in full score layouts to accommodate more 
staves, and larger gaps between systems in part layouts to give players space to add pencil 
markings.

TIP

● If the staves in a layout are very close together, just decreasing the staff size might be 
sufficient to produce good results.

● We recommend that you set the ideal gaps to the minimum value acceptable to you, as 
Dorico Pro automatically allocates additional space for other items, such as system objects 
and dynamics, and avoids collisions between notes and staves above/below.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts in which you want to change the default staff/system 
spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, change the values for the different contexts as required.

5. Click Apply, then Close.

RESULT
The minimum gaps between staves and systems in the corresponding contexts are changed. This 
affects how much space Dorico Pro allows for staves/systems in its casting off estimations and 
whether frames are considered full enough to justify vertically automatically.

RELATED LINKS
Staff spacing on page 720
Locking layouts on page 731
Note spacing on page 599
Changing the first system indent on page 1566
Changing the gap before codas on page 1455
Hiding/Showing staff labels on page 1532
Hiding/Showing empty staves on page 696
Changing the default player order on page 127

Changing the vertical justification of staves/systems
You can change the minimum fullness threshold above which Dorico Pro automatically vertically 
justifies staves and systems, which means they are evenly distributed to fill the height of frames. 
You can also control whether staves and systems are both vertically justified or only systems are 
vertically justified.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the automatic vertical 
justification of staves/systems.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, choose one of the following options for Gap to use for divisi 
staves:

● Staff to staff

● Braced staff to braced staff

5. In the Vertical Justification section, change the values for the following options, individually 
or together:

● Justify distance between staves and systems when frame is at least [n]% full
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● Justify distance only between systems when frame is at least [n]% full

6. Activate/Deactivate Justify staves when frame with single system is above this threshold.

7. Click Apply, then Close.

RESULT
The automatic vertical justification of staves and systems in the selected layouts is changed. 
Braced staves are never vertically justified.

EXAMPLE

A page with staves and systems both justified The same page with only systems justified

RELATED LINKS
Per-layout vertical spacing options on page 721
Frame fullness indicators on page 526

Hiding/Showing empty staves
You can hide/show empty staves differently in each layout independently. For example, you can 
show all staves, including empty staves, in a full score layout for the conductor but hide empty 
staves in a full score layout intended for reference only.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show empty staves.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.
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3. In the category list, click Vertical Spacing.

4. In the Staff Visibility section, choose one of the following options for Hide empty staves:

● After first system

● All systems

● Never

5. Activate/Deactivate Allow individual staves of multi-staff instruments to be hidden.

6. Optional: For Players excluded from Hide Empty Staves, activate the checkbox for each 
instrument you want to be shown regardless of your choice for Hide empty staves.

7. Click Apply, then Close.

RESULT
Empty staves in the selected layouts are hidden/shown according to your choice. If you activated 
Allow individual staves of multi-staff instruments to be hidden, any single empty staves in 
multi-staff instruments, such as piano or harp, can be hidden in the selected layouts.

NOTE

● Instruments that have extra staves added to them are not affected by Allow individual 
staves of multi-staff instruments to be hidden, even if some of their staves are empty.

● Systems containing divisi changes are always shown, even if their staves are empty.

● You cannot hide one staff of multi-staff instruments if you have chosen to show chord 
symbols between the staves, which you can do in the Position section of the Chord Symbols 
page in Engraving Options.

RELATED LINKS
Extra staves on page 1552
Divisi on page 1567
Condensing on page 743
Per-layout vertical spacing options on page 721
Hiding/Showing blank staves after final flows on page 699
Changing the default player order on page 127
Showing extra staves across whole systems on page 1555
Hiding/Showing system dividers on page 1562
Instrument filters on page 449
Engraving Options dialog on page 840

Hiding/Showing staves from system/frame breaks
You can manually change staff visibility from the rhythmic positions of system/frame breaks 
onwards by hiding, showing, and resetting individual staves. For example, if you have hidden 
empty staves in the layout but want specific empty staves to appear in some sections, or you 
want to hide staves with music on them in some layouts.

PROCEDURE

1. Optional: If you want to change staff visibility manually from a rhythmic position that does 
not yet have a system/frame break, select an item at the position from which you want to 
change staff visibility.

2. Open the Manual Staff Visibility dialog in one of the following ways:
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● If a system/frame break signpost exists at the position where you want to change staff 
visibility, select it and press Return  or double-click it.

● If no system/frame break exists, choose Edit > Notations > Staff > Manual Staff 
Visibility. You can also choose this option from the context menu.

3. Change staff visibility as required.

For example, you can activate and change the setting for individual staves, or use the 
options in the action bar to change the setting for all staves simultaneously.

4. Click OK to save your changes and close the dialog.

RESULT
Staff visibility is changed from the selected rhythmic position or system/frame break signpost 
onwards until the next staff visibility change or the end of the flow, whichever comes first and 
whether the staves are empty or not.

If a system/frame break signpost did not yet exist at the selected rhythmic position, a system 
break with your staff visibility settings is inserted at the selected rhythmic position.

RELATED LINKS
Frame breaks on page 736
System breaks on page 733
Staff spacing on page 720
Showing extra staves across whole systems on page 1555

Manual Staff Visibility dialog
The Manual Staff Visibility dialog allows you to hide, show, and reset individual staves manually 
from system/frame breaks.

You can open the Manual Staff Visibility dialog in Write mode and Engrave mode in any of the 
following ways:

● Choose Edit > Notations > Staff > Manual Staff Visibility when an item is selected in the 
music area. You can also choose this option from the context menu.

● Select a system/frame break signpost and press Return , or double-click a system/frame 
break signpost.

The Manual Staff Visibility dialog comprises the following:

1 Staff list
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Contains all the staves that exist at the selected rhythmic position, including hidden empty 
staves. The staff list includes divisi, condensed, and extra staves. Activating staves includes 
them in the manual staff visibility change.

For each staff, the following staff visibility options are available:

● Reset: Resets the visibility of the staff to the default setting in the layout, as set on the 
Vertical Spacing page in Layout Options.

● Show: Shows the staff from the selected rhythmic position onwards, whether it is empty 
or not.

● Hide: Hides the staff from the selected rhythmic position onwards, whether it is empty 
or not.

NOTE

● You cannot hide/show ossia staves independently of their main staves.

● Any staves you have added in the current flow, such as by adding extra staves or divisi 
changes, appear in the list, even after you have deleted them.

2 Action bar

Contains options that allow you to change the staff visibility setting of all staves 
simultaneously.

● Clear All: Deactivates all staves.

● Reset All: Activates all staves and sets them to Reset.

● Show All: Activates all staves and sets them to Show.

● Hide All: Activates all staves and sets them to Hide.

Hiding/Showing blank staves after final flows
You can hide/show additional blank staves to fill the page after the final flow in each layout 
independently; for example, if you want to emulate the convention of showing additional blank 
staves between the final system and the bottom of the page when formatting part layouts for 
recording sessions.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show blank staves after the 
ends of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, activate/deactivate Fill frame with blank staves.

5. If you activated Fill frame with blank staves, activate/deactivate Show blank staves in 
systems identical to final flow.

6. Customize the appearance of blank staves in one of the following ways:

● If you activated Show blank staves in systems identical to final flow and want to 
show clefs that follow the previous flow on blank staves, choose Include clefs.
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● If you activated Show blank staves in systems identical to final flow and want to hide 
clefs on blank staves, choose Exclude clefs.

● If you deactivated Show blank staves in systems identical to final flow, change the 
number of staff lines in blank staves by changing the value for Number of staff lines 
for blank staves.

RESULT
Blank staves are shown after the final flow in the selected layouts when Fill frame with blank 
staves is activated, and hidden when it is deactivated. When shown, blank staves appear below 
the final system in the final flow and fill the width of the final system if it is not fully horizontally 
justified.

When Show blank staves in systems identical to final flow is activated, blank staves follow the 
staff grouping of the final flow, such as two bracketed staves in a part layout with two players 
assigned to it. When it is deactivated, single blank staves without clefs are shown.

NOTE

You cannot input music or change brackets/braces on blank staves.

RELATED LINKS
Per-layout vertical spacing options on page 721
Changing the horizontal justification of final systems on page 709
Staff labels on page 1531
Brackets and braces on page 1023
Custom staff grouping on page 1030

Showing blank staves in frames
You can show blank staves in individual frame chains; for example, if you are producing 
educational worksheets and want to fill a single page in a layout with blank staves for students to 
write on.

NOTE

● You can show blank staves in both page template music frames and layout music frames. 
However, you can only change layout music frames to show blank staves in individual 
layouts, and you can only change page template music frames to show blank staves in the 
page template editor.

● Showing blank staves in frames affects all frames in the same frame chain.

● You cannot input music on blank staves or show brackets/braces on blank staves shown in 
music frames.

PREREQUISITE

● Frames  is selected in the Engrave toolbox.

● You have input any additional music frames in which you want to show blank staves.

● If you only want to show blank staves in specific music frames, you have assigned those 
frames to separate music frame chains.

● If you want to show blank staves in frames on a page template, you have opened the page 
template in the page template editor.
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PROCEDURE

1. In the music frame in which you want to show blank staves, click Flows .

NOTE

We do not recommend showing blank staves in the default page template frame chain, 
which is usually “MA”.

2. At the bottom of the selector, click Blank Staves.

3. Click outside of the selector to close it.

RESULT
The selected music frame and all music frames in the same frame chain are updated to display 
blank staves. If you showed blank staves in a page template music frame, this affects all pages to 
which page templates using the same music frame chain are applied.

The number of blank staves depends on the height of the frame and the music frame margins, 
staff size, and staff/system spacing in the layout. However, you can also change the number of 
blank staves manually.

The number of staff lines depends on your setting for Number of staff lines for blank staves 
on the Page Setup page in Layout Options.

RELATED LINKS
Layout Options dialog on page 834
Engrave toolbox on page 514
Frames on page 560
Inputting frames on page 562
Assigning music frames to frame chains on page 571
Music frame selectors on page 570
Page template editor on page 540
Creating page templates on page 535
Changing the page size and/or orientation on page 691
Changing the default staff size on page 693
Changing the default staff/system spacing on page 694
Changing the default music frame margins on page 715
Assigning flows to layouts on page 172
Assigning players to layouts on page 171
Brackets and braces on page 1023

Changing the number of blank staves in frames
You can change the number of blank staves shown in individual music frame chains; for example, 
if you want more blank staves than are shown by default without changing the default staff/
spacing in the layout.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Frames  is selected in the Engrave toolbox.
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PROCEDURE

1. In Engrave mode, select at least one music frame in each music frame chain set to show 
blank staves whose number of blank staves you want to change.

2. In the Properties panel, activate Blank staff count in the Music group.

3. Change the value in the value field.

RESULT
The number of blank staves shown in all music frames in the selected music frame chains is 
changed.

RELATED LINKS
Engrave toolbox on page 514
Properties panel on page 769
Showing blank staves in frames on page 700
Hiding/Showing blank staves after final flows on page 699
Changing the default music frame margins on page 715
Changing the padding in music frames individually on page 715
Changing the vertical justification of staves/systems on page 695
Music frame chains on page 569
Inputting frames on page 562
Changing the size/shape of frames on page 564

Inserting pages
You can insert pages into each layout in your project; for example, if you want to add an empty 
page to facilitate page turns. Inserted pages can be empty or can use a page template as a 
starting point.

PREREQUISITE

● The right zone is shown.

● You have created or imported any page templates you want to use as a starting point for 
inserted pages.

PROCEDURE

1. In Engrave mode, in the Pages panel, click Insert Pages  in the Pages section action bar to 
open the Insert Pages dialog.

2. Enter the number of pages you want to insert into the Number of pages to insert field.

3. Select where you want to insert pages from the Page position menu.

For example, to insert pages after page 8, select After page and enter 8. For pages with 
changed page numbers, their displayed page number is also shown.

4. Optional: If you want to use a page template as a starting point for the inserted pages, select 
it from the Use page template menu.

5. Click OK to save your changes and close the dialog.

RESULT
The number of pages specified are added at the selected position. They are considered page 
template overrides and are shown in the Pages panel with a colored triangle in their top left 
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corner. If you did not select a page template to use as a starting point for the inserted pages, 
they are empty.

Any existing page format changes on subsequent pages in the layout move accordingly. For 
example, if you had a flow heading change on page 2 and inserted a single page at the start of 
the layout, the flow heading change is now on page 3.

NOTE

Pages inserted using a page template are still considered page template overrides. If you want 
such pages to get updated if you edit the page template, we recommend assigning page 
template changes to the pages and removing page overrides.

AFTER COMPLETING THIS TASK
If you want to add information to empty pages, you can edit them or assign a page template to 
them; for example, if you have created a title page template that you want to use in all the parts 
in your project.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Page format changes on page 542
Page templates on page 527
Creating page templates on page 535
Importing page templates on page 537
Assigning page templates to pages on page 549
Adding flows on page 166
Frames on page 560

Insert Pages dialog
The Insert Pages dialog allows you to insert pages at any position in layouts. Inserted pages can 
be empty or can use a page template as a starting point.

● You can open the Insert Pages dialog in Engrave mode by clicking Insert Pages  in the 
Pages section action bar in the Pages panel.

The Insert Pages dialog contains the following options:

Number of pages to insert
Allows you to change the number of pages you want to insert.

Page position
Allows you to select where in the layout you want to insert pages.

● Before page: Inserts pages before the selected page.
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● After page: Inserts pages after the selected page.

● At start of layout: Inserts pages before the first page in the layout.

● At end of layout: Inserts pages after the last page in the layout.

The Displayed preview shows how the page number of the selected page currently 
appears. If you have inserted page number changes in the layout, the displayed page 
number might be different to the underlying page number.

Use page template
Allows you to select a page template to use as a starting point for the inserted pages.

NOTE

Pages inserted using a page template are still considered page template overrides. If 
you want such pages to get updated if you edit the page template, we recommend 
assigning page template changes to the pages and removing page overrides.

RELATED LINKS
Pages panel on page 522
Page templates on page 527
Page format changes on page 542
Assigning page templates to pages on page 549
Removing page template overrides on page 545

Deleting pages
You can delete empty pages and any extra pages you have added to layouts.

Dorico Pro automatically creates enough pages and frames to display the flows assigned to both 
the layout and the layout’s page template frame chain. If you want to delete pages because you 
do not want to show certain flows, you can instead remove those flows from the layout or the 
page template frame chain.

You only need to delete pages manually if you inserted them as a blank page or made an 
override to a page in a layout that is no longer required and now appears blank. For example, 
an override on the final page in a layout prevents that page and all previous pages being 
automatically deleted if the layout becomes shorter.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open the layout from which you want to delete pages.

2. In the Pages section of the Pages panel, select the pages you want to delete.

You can Shift -click adjacent pages and Ctrl/Cmd -click individual pages.

NOTE

You can only delete pages that are considered page format changes.

3. Delete the selected pages by removing all their page format changes.

● If any pages in your selection have red triangles in their top left corner, click Remove 
Overrides  in the Pages section action bar.
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● If any pages in your selection have purple triangles in their bottom right corner, right-
click a page and choose Remove Page Number Change(s) from the context menu.

● If any pages in your selection have green markings on their top/top and left edges, 
right-click a page and choose Remove Page Template Change(s) from the context 
menu.

● If any pages in your selection have yellow markings on their bottom/bottom and 
right edges, right-click a page and choose Remove Flow Heading Change(s) from the 
context menu.

RESULT
Once you have removed all overrides from all the pages you want to delete, they are deleted if 
they are empty. If they are not empty, removing all their overrides reverts them back to following 
their default page template.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Deleting flows on page 169
Page format changes on page 542
Page templates on page 527
Assigning flows to layouts on page 172
Assigning flows to frame chains on page 573
Music frame chains on page 569
Applying page template sets to layouts on page 692

Starting layouts on left-hand pages
By default, all layouts start on a right-hand page, as convention dictates that odd numbered 
pages are always on the right-hand page. However, you can set individual layouts to start on a 
left-hand page; for example, to facilitate page turns better in that layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts you want to start on a left-hand page.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Numbers section, change the value for Initial page number to an even 
number.

5. Click Apply, then Close.

RESULT
The first page in the selected layouts is shown on a left-hand page when the initial page number 
is even.

Page formatting
Starting layouts on left-hand pages 

705
Dorico Pro 4.3.30



Allowing/Disallowing multiple flows on the same page
You can allow/disallow new flows to be shown on the same page as previous flows if there is 
space; for example, to reduce the number of pages required for parts in works with multiple 
movements. By default, new flows are allowed on the same page in part layouts and are not 
allowed in full score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to allow multiple flows to be shown 
on each page.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for New flows:

● Always start new page

● Allow on existing page

5. Click Apply, then Close.

RESULT
Always start new page ensures flows in the selected layouts always begin at the start of the 
next page after the end of the previous flow.

Allow on existing page allows flows in the selected layouts to continue immediately after each 
other, including within the same music frame if there is sufficient space. Flow headings are 
automatically shown above the start of flows if you have chosen to show flow headings in the 
selected layouts.

NOTE

Flows are not automatically split into separate music frames. You must insert frame breaks 
manually to divide flows into separate music frames if required.

RELATED LINKS
Tokens on page 576
Inputting frames on page 562
Casting off on page 728
Assigning flows to layouts on page 172
Assigning players to flows on page 167
Hiding/Showing information in running headers above flow headings on page 708
Hiding/Showing blank staves after final flows on page 699

Changing when the First page template is used
You can change the circumstances when the First page template is used in each layout 
independently; for example, if you want to use it for the start of every flow in the full score 
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but only want to use it for the first flow in part layouts, even when subsequent flows start at the 
top of the page.

NOTE

If the First page template does not contain a music frame assigned to the same frame chain 
as the Default page template, Dorico Pro cannot use it automatically; instead, all pages use the 
Default page template.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change when the First page 
template is used.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Use ‘First’ page template:

● Never

● First flow only

● Any flow starting at top of page

5. Click Apply, then Close.

RESULT

● Choosing Never means the First page template is not used for any page in the selected 
layouts.

● Choosing First flow only means the First page template is used for the first page in the 
layout but no other pages, even if some subsequent flows start at the top of a page.

● Choosing Any flow starting at top of page means the First page template is used for all 
pages in the layout that begin with the start of a flow.

RELATED LINKS
Layout Options dialog on page 834
Types of page templates on page 532
Assigning music frames to frame chains on page 571

Hiding/Showing flow headings
You can hide/show flow headings in each layout independently; for example, if your project only 
contains a single flow and you only want to show the project title. You can also hide the heading 
for the first flow but show flow headings for subsequent flows.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show flow headings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Show flow headings:

● Never

● Not for first flow

● For all flows

5. Click Apply, then Close.

RESULT
Flow headings are shown above the first system in each flow in the selected layouts when you 
choose For all flows, hidden when you choose Never, and hidden above the first system in the 
first flow but shown above all other flows when you choose Not for first flow.

They are automatically positioned above each flow and below the preceding flow according to 
the margins set for each layout.

NOTE

● Flow headings only appear in page template music frames, they never appear in layout 
music frames.

● Hiding flow headings does not hide the flow title shown at the top of the second page 
onwards by default. You can change running headers by customizing the Default page 
template in the corresponding page template set.

RELATED LINKS
Flow headings on page 554
Customizing flow headings on page 558
Inserting flow heading changes on page 550
Allowing/Disallowing multiple flows on the same page on page 706
Hiding/Showing information in running headers above flow headings on page 708
Editing running headers in page templates on page 1190
Changing when the First page template is used on page 706
Music frames on page 568
Customizing page templates on page 541

Hiding/Showing information in running headers above flow 
headings

You can hide/show flow titles, page numbers, and flow page numbers separately when they 
appear above flow headings at the top of a new page in each layout independently. Hiding such 
information in running headers is a custom in publishing.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show information in running 
headers above flow headings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Flow title in header:

● Show above flow heading

● Hide above flow heading

5. Choose one of the following options for Page number in header:

● Show above flow heading

● Hide above flow heading

6. Choose one of the following options for Flow page number in header:

● Show above flow heading

● Hide above flow heading

7. Click Apply, then Close.

RESULT
The corresponding information is hidden/shown when they appear above flow headings at the 
top of the page.

NOTE

In order to hide running header information, the top of the music frame containing the 
flow heading frame must be lower than the top of text frames containing the corresponding 
information. If the top of the music frame is the same height as a running header text frame, any 
corresponding information in the text frame is shown, regardless of your setting.

RELATED LINKS
Frames on page 560
Page templates on page 527
Editing running headers in page templates on page 1190
Hiding/Showing page numbers on page 1355

Changing the horizontal justification of final systems
You can change whether the final systems of flows always fill the width of frames or only do so 
above a certain fullness threshold in each layout independently. By default in Dorico Pro, the final 
systems of flows only justify to the full width of the frame when they are more than half full.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the justification of the 
final systems in flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.

4. Change the justification of final systems in flows in one of the following ways:
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● If you always want the final systems in flows to justify fully, deactivate Only justify final 
system in flow when more than [n]% full.

● If you want to change the minimum fullness of final systems before they justify, change 
the value for Only justify final system in flow when more than [n]% full.

5. Click Apply, then Close.

RESULT
The automatic justification of the final systems in flows in the selected layouts is changed.

TIP

You can also change the width of individual systems independently of your default settings by 
changing their start/end positions.

EXAMPLE

Final system below fullness threshold, unjustified Final system justified

RELATED LINKS
Note spacing on page 599
Moving the start/end of systems on page 608
Changing the first system indent on page 1566
Changing the gap before codas on page 1455
Fixing the number of bars per system on page 729
Hiding/Showing blank staves after final flows on page 699
Hiding/Showing bar rests in empty bars on page 1494
Deleting rests on page 1493

Enabling/Disabling condensing
You can enable/disable condensing in each layout independently, with separate options for 
condensing section players and divisi staves. For example, in a large-scale work with orchestra 
and chorus, you might want to condense vocal staves in the full score but show uncondensed 
vocal staves in a custom vocal score.

Similarly, you might want to condense divisi staves in the full score but show separate divisi 
staves in the part layouts.

IMPORTANT

Enabling condensing in any layout in a project can cause Dorico Pro to operate more slowly, 
due to the large number of calculations involved. Therefore, we recommend only enabling 
condensing after you have finished the majority of the required work, such as inputting notes 
and notations or adding flows.
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PREREQUISITE
You have input the notes and notations you want for each instrument onto their separate staves. 
If you have input the music for multiple parts onto the same staff, you can explode it.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to enable/disable condensing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Condensing section, activate/deactivate Enable condensing.

5. Choose one of the following options for Section players:

● Exclude from condensing

● Condense divisi

● Condense divisi and adjacent players

6. Optional: If you chose Condense divisi and adjacent players, activate/deactivate Exclude 
adjacent violin section players from condensing.

7. Click Apply, then Close.

RESULT
Condensing is enabled for single players in the selected layouts when the Enable condensing 
checkbox is activated, and disabled when the checkbox is deactivated. Condensing for section 
players and divisi staves depends on your choice for Section players.

When you click Apply, the list of available condensing groups updates according to your 
changes.

NOTE

● In Write mode, you cannot select anything on condensed staves. In Engrave mode, you can 
select notes and items on condensed staves but you can only edit them graphically.

● Condensed music often requires different rhythmic spacing than uncondensed music; for 
example, to accommodate the width of notes that are a small interval apart. Therefore, 
enabling condensing can cause the casting off in the layout to change.

● Condensing is never enabled in galley view. If you want to see all staves separately without 
disabling condensing in the current layout, you can switch to galley view.

● Solo staves in divisi changes are never condensed.

● You can also enable/disable condensing by choosing Edit > Condensing. You can also assign 
a key command to this on the Key Commands page in Preferences. This automatically 
updates the layout option but only for the layout currently open in the music area.

AFTER COMPLETING THIS TASK

● You can create custom condensing groups for each layout to control which staves condense 
together. You can also include/exclude individual condensing groups.

● If you want more control over the condensing result, you can change condensing from 
selected rhythmic positions manually.
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RELATED LINKS
Condensing on page 743
Condensing groups on page 751
Staff labels on condensed staves on page 1546
Changing condensing options from rhythmic positions on page 753
Key Commands page in the Preferences dialog on page 63
Switching to galley/page view on page 53
Note input on page 220
Notations input on page 271
Exploding music onto multiple staves on page 470
Inputting notes and notations onto multiple staves on page 235
Changing the default player order on page 127
Players on page 124
Divisi on page 1567

Margins
Margins determine the spacing around music on pages, such as on all four edges of each page 
and above/below flow headings.

In Dorico Pro, there are the following types of margins:

1 Page margins

The gaps between the four edges of pages and the boundary of the content on them. For 
example, systems that are horizontally justified span the full width of pages between the left 
and right page margins. You cannot position frames beyond the page margins.

2 Music frame margins

The gaps at the top and bottom of music frames. Also known as “music frame padding”.
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● Top music frame margins set the gap between the top edges of music frames and the 
top staff line of the highest staff in the frame.

● Bottom music frame margins set the gap between the bottom edges of music frames 
and the bottom staff line of the lowest staff in the frame.

3 Flow heading margins

The gaps above and below flow headings. When flow headings are positioned at the top of 
music frames, the flow heading bottom margin sets the gap at the top of the music frame, 
rather than the music frame margin.

● Flow heading top margins set the gap between the top of flow headings and the bottom 
staff line of the preceding flow, if applicable.

● Flow heading bottom margins set the gap between the bottom of flow headings and the 
top staff line of the next flow.

NOTE

Notes and notations above the highest staff and below the lowest staff extend into margins.

RELATED LINKS
Music frames on page 568
Flow headings on page 554
Changing page margins on page 692
Changing the padding in music frames individually on page 715
Changing the margins above/below tacets on page 742
Changing the page size and/or orientation on page 691
Changing the default staff/system spacing on page 694
Changing the vertical justification of staves/systems on page 695
Changing the horizontal justification of final systems on page 709
System fullness indicators on page 526
Frame fullness indicators on page 526

Changing the margins above/below flow headings
You can change the margins both above and below flow headings, which control the gap 
between the preceding flow and the flow heading, and the gap between the flow heading and 
the start of the next flow.

PREREQUISITE
Flow headings are shown in the layouts in which you want to change the margins above/below 
flow headings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the margins above/below 
flow headings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, change the values for the following options, individually or together:
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● Flow heading top margin

● Flow heading bottom margin

5. Click Apply, then Close.

RESULT
The margins above/below flow headings in the selected layouts are changed.

● Flow heading top margin sets the gap between the top of flow headings and the end of the 
preceding flow.

● Flow heading bottom margin sets the gap between the bottom of flow headings and the 
start of the next flow.

For example, when the bottom margin is set to 0, the bottom of the lowest frame in the flow 
heading aligns with the top staff line of the first system in the flow below the flow heading.

NOTE

● If you want to change the margins above/below flow headings on individual pages, you can 
do this by inserting a flow heading change and changing the margins at the change.

● If you want to move individual flow headings upwards/downwards, you can do this by 
moving the system handle of the first system of the flow to which the flow headings apply. 
You can also move the frames in flow headings individually, but this creates a page template 
override, preventing Dorico Pro from updating the page if, for example, you later edit the 
page template.

EXAMPLE

Flow heading with default margins above/below Flow heading with decreased margins above/below

RELATED LINKS
Flow headings on page 554
Per-layout vertical spacing options on page 721
Customizing flow headings on page 558
Inserting flow heading changes on page 550
Moving individual staves/systems vertically on page 723
Page format changes on page 542
Hiding/Showing used chord diagrams grids on page 1060
Changing the margins above/below tacets on page 742
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Changing the default music frame margins
You can change the default margins in all music frames in each layout independently. For 
example, you might want more padding at the top of music frames in part layouts containing lots 
of notes above the staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose music frame margins you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Music Frame Margins section, change the values for the following options, 
individually or together:

● Top

● Bottom

5. Click Apply, then Close.

RESULT
The margins within all music frames in the selected layouts are changed.

● Top sets the gap between the top edges of music frames and the top staff line of the highest 
staff in the frame.

● Bottom sets the gap between the bottom edges of music frames and the bottom staff line of 
the lowest staff in the frame.

For example, when the bottom music frame margin is set to 0, the bottom staff line of the lowest 
staff in the frame aligns with the bottom edge of the music frame.

NOTE

● Notes and notations above the highest staff and below the lowest staff extend into music 
frame margins.

● If you want to change the music frame margins on individual pages, you can do this by 
changing the padding in music frames individually.

RELATED LINKS
Changing page margins on page 692
Changing the default staff/system spacing on page 694
Hiding/Showing used chord diagrams grids on page 1060

Changing the padding in music frames individually
You can change the padding at the top/bottom of individual music frames, independently of your 
setting for music frame margins for the layout.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● Frames  is selected in the Engrave toolbox.

● If you want to change the padding in music frames on a page template, you have opened 
the page template in the page template editor.

PROCEDURE

1. In Engrave mode, select the music frames whose padding you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Music group:

● Top padding

● Bottom padding

3. Change the values in the value fields.

RESULT
The padding at the top/bottom of the selected music frames is changed.

● Top padding sets the gap between the top edge of the selected music frames and the top 
staff line of the highest staff in each frame.

● Bottom padding sets the gap between the bottom edge of the selected music frames and 
the bottom staff line of the lowest staff in each frame.

For example, when the bottom padding is set to 0, the bottom staff line of the lowest staff in the 
frame aligns with the bottom edge of the music frame.

NOTE

● Deactivating the properties returns the selected music frames to your settings for music 
frame margins for the layout.

● If you changed the padding in frames on pages in a layout, this only affects that layout and 
creates a page template override, which is a type of page format change. If you changed the 
padding in frames on a page template, this affects all pages in all layouts that use that page 
template.

● Notes and notations above the highest staff and below the lowest staff extend into music 
frame margins.

RELATED LINKS
Page template editor on page 540
Customizing page templates on page 541
Page format changes on page 542

Staff size
Staff size refers to the distance between the top and bottom lines of staves, and can be 
expressed as a point size or in another supported unit of measurement, such as millimeters. 
For individual staves, you can use a scale size of the default staff size in the layout. The most 
appropriate staff size depends on the intended purpose of the layout.

For example, full orchestral scores that are quite dense need a much smaller staff size than 
individual parts, which require large enough notes so that performers can read them easily. 
Staves can overlap and the music can become illegible if the staff size is too large in dense 
scores.
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In Dorico Pro, you can set the staff size using the rastral size and the space size, depending on 
which measurement is more appropriate for the selected layouts.

1 Rastral size is the size of the full staff, measured from the bottom line to the top line.

2 Space size is the distance between two staff lines.

When changing the staff size of each layout in Layout Options, we recommend that you use one 
of the preset rastral sizes, as these are based on traditional and generally accepted staff sizes 
that are all widely used in music engraving.

NOTE

The size of staves can affect the size of system objects.

RELATED LINKS
System objects on page 1563
Changing your preferred unit of measurement on page 54
Changing the default staff size on page 693
Staff spacing on page 720

Changing the staff size from system/frame breaks
You can change the staff size of all staves from the rhythmic position of system/frame breaks 
onwards in layouts. For example, you can have smaller staves only on pages with more staves, 
and larger staves on other pages with fewer staves.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top staff in each 
instrument family group affects the size of system objects if they are shown above that bracketed 
group. Font styles that are set to Absolute are unaffected by staff size.

PREREQUISITE

● You have inserted system/frame breaks at the positions from which you want to change the 
staff size.

● Signposts are shown for system/frame breaks.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the system/frame break signposts from which you want to change 
the staff size.
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2. In the Properties panel, activate Space size in the Format group.

3. Change the value in the value field.

RESULT
The staff size of all staves in the layout is changed until the next change in staff size or the end 
of the flow, whichever comes first. Increasing Space size increases the staff size. Decreasing the 
value decreases the staff size.

By default, the next flow uses the default staff size in the layout.

RELATED LINKS
Engrave toolbox on page 514
Changing the default staff size on page 693
Inserting system breaks on page 734
Inserting frame breaks on page 737
Hiding/Showing system break signposts on page 736
Hiding/Showing frame break signposts on page 739

Changing the size of staves for individual players
You can change the size of all staves belonging to individual players in each flow, independently 
of other players’ staves and your layout settings. For example, piano accompaniment parts often 
include the solo line of the instrument the piano is accompanying on a smaller staff.

You can change the size of staves to a set scale size, expressed as a percentage of the normal 
staff size in the layout, or set a custom scale.

TIP

If you want to change the staff size to represent an alternative version of a passage, you can 
instead add an ossia staff, which you can show for specific regions.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select an item on the staff whose size you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

You can only change the size of a single staff at a time.

2. Choose Edit > Notations > Staff Size > [Staff size]. You can also choose this option from the 
context menu.

3. Optional: If you chose Custom Staff Size, set the staff size in the Custom Staff Size dialog 
that opens.

RESULT
The size of the selected staff is changed in the current flow. This also works in combination with 
the other ways of changing the staff size, such as changing the size of all staves in the layout or 
changing the size of staves from specific system/frame breaks.
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NOTE

● Changing the size of individual staves affects all staves belonging to the same player and for 
the whole flow.

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

EXAMPLE

A piano part with smaller staff above

RELATED LINKS
Edit Font Styles dialog on page 846
Brackets and braces on page 1023
System objects on page 1563
Adding ossia staves on page 1557
Engrave toolbox on page 514

Custom Staff Size dialog
The Custom Staff Size dialog allows you to change the size of individual staves by a custom scale 
factor.

● You can open the Custom Staff Size dialog by selecting an item on a staff and choosing 
Edit > Notations > Staff Size > Custom Staff Size.

The Custom Staff Size dialog contains the following options:

Default staff size
Displays the default size of staves in the current layout. This size is set on the Page 
Setup page in Layout Options.

The default staff size is expressed as both a point size and in your preferred unit of 
measurement.
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Rastral size
Allows you to select the rastral size on which you want to base your custom staff size.

Scale factor
Sets the custom staff size, expressed as a percentage of the selected rastral size.

New staff size
Displays the new custom staff size for the selected staff as a result of the changes you 
have made in the dialog.

The new staff size is expressed as both a point size and in your preferred unit of 
measurement.

Staff spacing
The vertical positioning of staves and systems within frames is known as staff spacing. Staff 
spacing calculations consider the height of staves and the necessary gaps between staves and 
systems.

You can change staff spacing in your project at different levels:

● Change the default staff spacing in each layout in Layout Options.

● Change the staff spacing between individual staves.

NOTE

● We recommend adjusting the default staff spacing values and/or changing the staff size 
in layouts before moving individual staves, as in most cases Dorico Pro produces suitable 
results without the need to move individual staves.

● We recommend that you add extra pages and finish laying out your pages before moving 
individual staves, as individual staff spacing changes are automatically deleted if the frame in 
which they occur changes. For example, if you move staves individually and then add a blank 
page at the start of the layout, all individual staff spacing changes in the layout are deleted.

● Moving individual staves/systems vertically does not affect the casting off. If you want to 
show more/fewer systems in a frame, you can change the casting off by, for example, using 
frame breaks or setting a fixed number of systems per frame.

RELATED LINKS
Layout Options dialog on page 834
Staff size on page 716
Staves on page 1549
Engrave toolbox on page 514
Frame fullness indicators on page 526
Changing the default staff/system spacing on page 694
Changing the staff spacing in galley view on page 723
Changing the default staff size on page 693
Margins on page 712
Casting off on page 728
Frame breaks on page 736
Making selections into frames on page 738
Moving bars to other systems on page 730
Fixing the number of systems per frame on page 729
Note spacing on page 599

Page formatting
Staff spacing 

720
Dorico Pro 4.3.30



Per-layout vertical spacing options
Dorico Pro provides multiple options that you can use to control the default vertical spacing and 
justification of staves and systems in each layout.

● You can access per-layout vertical spacing options by opening the Layout Options dialog 
and clicking Vertical Spacing in the category list.

The Vertical Spacing page contains the following sections and options:

Ideal Gaps

Contains multiple scenarios that allow you to set the gap you want Dorico Pro to allow between 
staves and systems in the corresponding context, including the default scaling of these gaps in 
galley view, as Dorico Pro does not automatically avoid collisions between staves and items in 
galley view. The options are accompanied by diagrams to help you visualize the contexts to which 
each option applies.

We recommend setting the ideal gaps to the minimum value acceptable to you because Dorico 
Pro never reduces the gap between staves to less than your set values. Setting smaller values 
gives Dorico Pro greater flexibility when determining staff spacing, particularly in very full 
frames, such as reducing the space between staves with no dynamics to allow more space 
between staves with dynamics. Similarly, we recommend setting vertical spacing options after 
you have finished inputting notes and items, as this allows you to consider the entire project 
when setting these options.

Depending on the context, the options are affected by automatic vertical justification in different 
ways:

● Staff to staff, Staff group to staff, Staff to staff group, Staff group to staff group, 
Inter-system gap, and Timecode staff to staff

These gaps do not apply in frames that are automatically justified.

● Braced staff to braced staff and Ossia staff to staff

These gaps always apply, including in frames that are automatically justified, because braced 
and ossia staves are never justified. This includes extra staves.

NOTE

● Divisi staves are vertically justified when they use the Staff to staff gap. When they use the 
Braced staff to braced staff gap, the staves in each divisi section use only the gap set for 
braced staves and are not vertically justified.

● If the staves in a layout are very close together, just decreasing the staff size might be 
sufficient to produce good results.

● When calculating the number of systems that can fit in each frame in a layout, Dorico Pro 
considers the height of staves, the minimum gaps between staves, the maximum distances 
between very high/low notes and staves, and other items that require vertical space, such as 
pedal lines and tempo marks. However, this calculation happens before horizontal spacing 
is finalized, which can result in either more or fewer systems being allocated to frames than 
ideally fit. In such circumstances, you can use fixed casting off settings and system/frame 
breaks to change which systems appear in frames.

Minimum Gaps

Contains options for the minimum gaps you want Dorico Pro to allow for items in addition to the 
staff spacing gaps.
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● Automatically resolve collisions between adjacent staves and systems: When activated, 
Dorico Pro automatically allows extra space between staves and systems to avoid collisions. 
When deactivated, Dorico Pro only uses your set gaps for vertical spacing, which produces 
evenly-spaced staves and systems but with the possibility of collisions between items.

● Minimum inter-staff gap with content: Allows you to set the extra space you want to allow 
between staves when items are present.

● Minimum inter-system gap with content: Allows you to set the extra space you want to 
allow between systems when items are present.

NOTE

Minimum gaps do not affect casting off. For example, increasing the Minimum inter-system 
gap with content value changes the space above/below systems on a page but does not push 
systems to later pages. Instead, you can change the ideal gaps.

Vertical Justification

Contains options that allow you to control the frame fullness thresholds above which you want 
staves and/or systems to justify vertically automatically.

● Justify distance between staves and systems when frame is at least [n]% full: When 
frames are filled above this threshold, the staves and systems they contain are all 
automatically vertically justified, meaning they are evenly distributed to fill the height of 
the frame. Frames filled below this threshold are not automatically justified, instead staves 
follow your ideal gap settings. This can leave gaps between the bottom staff/system and the 
bottom of the frame.

● Justify distance only between systems when frame is at least [n]% full: When frames are 
filled above this threshold, only the distance between systems in the frame is justified. Staves 
follow your per-layout ideal gap settings. This helps keep a clear distance between systems 
on very full pages.

● Justify staves when frame with single system is above this threshold: When activated, 
all the staves in a single system taller than the set threshold are vertically justified, which 
distributes them evenly to fill the height of the frame.

Staff Visibility

Contains options allowing you to control when and which empty staves are hidden in the layout.

● Hide empty staves: Allows you to control when empty staves are hidden. For example, it is a 
common practice to show all staves in the first system even if some are empty, but this is not 
always required.

● Allow individual staves of multi-staff instruments to be hidden: Allows you to control 
whether individual empty staves belonging to multi-staff instruments can be hidden 
independently or all multi-staff instrument staves must always be shown.

● Players excluded from Hide Empty Staves: Allows you to identify specific players whose 
staves you always want to show, even if their staff is empty on systems where you have 
hidden empty staves.

RELATED LINKS
Layout Options dialog on page 834
Changing the default staff/system spacing on page 694
Frame fullness indicators on page 526
Page formatting on page 689
Casting off on page 728
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Margins on page 712
Staff size on page 716
Brackets and braces on page 1023
Staves on page 1549
Ossia staves on page 1556
Tablature on page 1580
Hiding/Showing staves from system/frame breaks on page 697
Making selections into systems on page 734
Making selections into frames on page 738
Changing the vertical position of markers on page 1431
Changing the vertical position of timecodes on page 1436

Changing the staff spacing in galley view
You can change the vertical space between staves in galley view in each layout independently, 
expressed as a percentage of the set ideal gaps. Increasing the gaps between staves in layouts 
with very high/low notes can be useful because Dorico Pro does not perform automatic collision 
avoidance in galley view.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff spacing in galley 
view.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, change the value for In galley view, expand ideal staff gaps to.

5. Click Apply, then Close.

RELATED LINKS
Instrument filters on page 449
Switching to galley/page view on page 53
Switching between layouts on page 46

Moving individual staves/systems vertically
You can change the spacing of individual staves, including ossia staves, by changing the vertical 
position of individual staves and systems independently of your project-wide settings.

IMPORTANT

We recommend that you add extra pages and finish laying out your pages before moving 
individual staves, as individual staff spacing changes are automatically deleted if the frame in 
which they occur changes. For example, if you move staves individually and then add a blank 
page at the start of the layout, all individual staff spacing changes in the layout are deleted.
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NOTE

Moving individual staves/systems vertically does not affect the casting off. If you want to show 
more/fewer systems in a frame, you can change the casting off by, for example, using frame 
breaks or setting a fixed number of systems per frame.

When Staff Spacing  is activated in the Engrave toolbox, the following are shown:

● System spacing handles: Large square handles on the top left corner of the top staff in each 
system. System spacing handles control the vertical position of whole systems.

● Staff spacing handles: Small square staff handles on the bottom left corner of each staff. 
Staff spacing handles control the vertical position of individual staves.

● Gap measurements: Lines and highlighted numbers indicating the distances between staves 
and systems, shown using your preferred unit of measurement.

● Music frame margin highlights: Translucent highlights at the top/bottom of music frames 
indicating the extent of music frame margins.

System spacing handle, staff spacing handle, and gap measurement in Engrave mode when Staff Spacing is 
activated

PREREQUISITE
Staff Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select one of the following on each staff/system you want to move 
vertically:

● Staff spacing handle

● System spacing handle

NOTE

● You can switch between having a staff or system spacing handle selected by pressing 
Tab .

● When using the mouse, you can only move one staff/system at a time.

2. Move the selected staves/systems in any of the following ways:

● To move them a standard amount upwards or downwards, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move handles 
upwards.
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● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Up Arrow .

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Up Arrow .

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow .

● Click and drag a single staff/system spacing handle upwards/downwards.

RESULT
The vertical position of the selected staves/systems is changed. The color of the handles changes 
to indicate that you have moved them. When you move system handles, both the square handle 
and the highlighted strip at the top of the system change color.

NOTE

● When Staff Spacing  is activated, you cannot select or edit anything other than staff/
system spacing handles. To resume normal selection and editing, click Graphic Editing  in 
the Engrave toolbox or return to Write mode.

● You can also click the gap measurement numbers and change the value using any of the 
supported units of measurement, which are points, millimeters, centimeters, and inches.

You can change your preferred unit of measurement to be used throughout Dorico Pro on 
the General page in Preferences.

EXAMPLE

Staff spacing handles at their default positions The second staff has been moved upwards

AFTER COMPLETING THIS TASK
You can copy manual changes you have made to the staff spacing on individual pages to other 
pages in the layout.

RELATED LINKS
Engrave toolbox on page 514
Frame fullness indicators on page 526
Moving multiple systems simultaneously on page 726
Changing the default music frame margins on page 715
Copying staff spacing changes to other pages on page 727
Changing your preferred unit of measurement on page 54
Margins on page 712
Casting off on page 728
Frame breaks on page 736
Making selections into frames on page 738
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Moving bars to other systems on page 730
Fixing the number of systems per frame on page 729

Removing individual changes to staff spacing
You can remove changes you have made to the staff/system spacing and reset staff/system 
spacing handles to their original default positions.

PREREQUISITE
Staff Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the staff/system handles you want to reset to their original 
positions.

2. Press Backspace or Delete .

RESULT
The selected staff/system handles are reset to their original positions.

TIP

You can also reset all staff spacing changes within selected systems, frames, or all staff spacing 
changes in the layout by choosing one of the options in the Engrave > Staff Spacing menu.

Moving multiple systems simultaneously
You can move multiple systems at the same time so that the gaps between each system remain 
equal. This is also known as “concertina dragging”.

IMPORTANT

We recommend that you add extra pages and finish laying out your pages before moving 
individual staves. Individual staff spacing changes are automatically deleted if the frame in which 
they occur changes.

NOTE

● You can only move multiple systems closer together, you cannot use this method to move 
them further apart.

● You cannot follow these steps for staff spacing handles on tacets.

● Moving individual staves/systems vertically does not affect the casting off. If you want to 
show more/fewer systems in a frame, you can change the casting off by, for example, using 
frame breaks or setting a fixed number of systems per frame.

PREREQUISITE
Staff Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the system handle on the highest systems you want to move.
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NOTE

When using the mouse, you can only move systems below a single system at a time.

2. Move the selected systems in any of the following ways:

● To move them downwards a standard amount, press Alt/Opt-J .

● To move them downwards a large amount, press Ctrl/Cmd-Alt/Opt-J .

● Alt/Opt -click and drag the system handle downwards.

RESULT
All systems below the selected system, until the bottom of the music frame, are moved closer 
together. The gaps between each system remain equal.

RELATED LINKS
Engrave toolbox on page 514
Staff spacing on page 720
Tacets on page 739
Casting off on page 728
Frame breaks on page 736
Making selections into frames on page 738
Moving bars to other systems on page 730
Fixing the number of systems per frame on page 729

Copying staff spacing changes to other pages
You can copy manual staff spacing changes you have made on individual pages to other pages in 
the layout.

NOTE

In order to copy staff spacing changes, destination pages must have the same number of staves 
per system and the same number of systems per frame as the source page.

PROCEDURE

1. In the music area, select an item on the page whose staff spacing you want to copy.

2. Choose Engrave > Staff Spacing > Copy Staff Spacing to open the Copy Staff Spacing 
dialog.

3. Optional: Change the page whose staff spacing you want to copy by changing the value for 
From page.

By default, the page on which you selected an item is set in the value field.

4. Change the first page to which you want to copy staff spacing by changing the value for To 
page start.

5. Change the last page in the range to which you want to copy staff spacing by changing the 
value for To page end.

6. Click OK to save your changes and close the dialog.
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RELATED LINKS
Moving individual staves/systems vertically on page 723

Copy Staff Spacing dialog
The Copy Staff Spacing dialog allows you to choose pages whose individual staff spacing 
changes you want to copy and the pages to which you want to copy them.

● You can open the Copy Staff Spacing dialog in Engrave mode by choosing Engrave > Staff 
Spacing > Copy Staff Spacing.

TIP

You can assign a key command for opening the Copy Staff Spacing dialog on the Key 
Commands page in Preferences.

The Copy Staff Spacing dialog contains the following options:

From page
Allows you to change the page whose staff spacing you want to copy by specifying the 
page number. If you have an item selected when you open the dialog, that page is set 
in the value field automatically.

To page start
Allows you to set the first page in the layout to which staff spacing changes are copied.

To page end
Allows you to set the last page in the layout to which staff spacing changes are copied.

For example, if you wanted to copy staff spacing changes you made on the first page to the next 
three pages, meaning pages two, three, and four, but not to page five and onwards, you would 
set From page to 1, To page start to 2, and To page end to 4.

Previews show the displayed page number beside each value field, so that if you have changed 
the displayed page number of pages within the layout you can still identify the page to which you 
are copying staff spacing changes.

RELATED LINKS
Key Commands page in the Preferences dialog on page 63

Casting off
“Casting off” is the term used to encompass fixing the layout of pages of music, such as setting 
the number of systems per page.

When calculating how much music can fit in each system and on each page, Dorico Pro considers 
multiple aspects of the layout, including note spacing and vertical spacing settings. You can 
change these settings to change the default casting off in each layout.

In Dorico Pro, you can set fixed numbers of bars per system and systems per music frame 
throughout each layout independently.

You can control the casting off at a more granular level by moving bars to other systems, 
inserting system/frame breaks, making selections into systems/frames, and locking/resetting the 
casting off in the current layout.

RELATED LINKS
Per-layout note spacing options on page 600
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Per-layout vertical spacing options on page 721
Moving bars to other systems on page 730
Locking layouts on page 731
Resetting casting off on page 732
Margins on page 712
System breaks on page 733
Frame breaks on page 736
Allowing/Disallowing breaks within bars on page 732
Splitting multi-bar rests on page 1500
Hiding/Showing blank staves after final flows on page 699

Fixing the number of bars per system
You can define a fixed number of bars you want included in each system in each layout 
independently; for example, if you want four bars per system in a lead sheet.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to fix the number of bars per 
system.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Casting Off section, activate Fixed number of bars per system.

5. Change the value in the value field.

6. Click Apply, then Close.

RESULT
The number of bars automatically contained in each system in the selected layouts is changed. 
If any of the layouts contain two-bar or four-bar repeat regions, Dorico Pro automatically adjusts 
casting off to ensure phrases are not split across systems.

RELATED LINKS
Bar repeats on page 1459
Inserting system breaks on page 734
Inserting frame breaks on page 737
Making selections into systems on page 734
Changing the horizontal justification of final systems on page 709

Fixing the number of systems per frame
You can define a fixed number of systems you want included in each music frame in each layout 
independently. Because the default page templates have a single music frame per page, fixing 
the number of systems per frame usually fixes the number of systems per page.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts in which you want to fix the number of systems per 
frame.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Casting Off section, activate Fixed number of systems per frame.

5. Change the value in the value field.

6. Activate/Deactivate Scale number of systems by frame height.

7. Click Apply, then Close.

RESULT
The number of systems automatically contained in each music frame in the selected layouts is 
changed.

If you activated Scale number of systems by frame height, the number of systems contained in 
each frame is adjusted according to the size of the music frame. For example, pages with smaller 
frames, such as the first page, contain fewer systems than your casting off setting.

Moving bars to other systems
You can move bars to the next or previous system; for example, if you want specific bars to 
appear in the same system.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item in the bar you want to move to another system.

For example, select an item in the earliest bar you want to move to the next system, or select 
an item in the last bar you want to move to the previous system.

2. Move bars to another system in one of the following ways:

● To move all bars between the start of the current system and the selection to the 
previous system, press ,  or click Move to Previous System  in the Move Bars 
Between Systems section of the Formatting panel.

● To move all bars between the selection and the end of their current system to the next 
system, press .  or click Move to Next System  in the Move Bars Between Systems 
section of the Formatting panel.

RESULT
The selected bars are moved to the previous or next system. System breaks are inserted at the 
start and end of each new system.

NOTE

● System breaks inserted at the start of systems have Wait for next system break activated in 
the Format group of the Properties panel by default. Because this property tells Dorico Pro 
to include all music in the system until the next system break or the end of the flow, if you 
later delete subsequent system breaks, this can create very full, tightly spaced systems.
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● You can change how many systems are locked as a consequence of moving bars to other 
systems in Preferences > Note Input and Editing > Note Input > Breaks.

RELATED LINKS
Making selections into frames on page 738
Making selections into systems on page 734
Properties panel on page 769
Preferences dialog on page 61

Locking layouts
You can lock the current casting off throughout individual layouts.

PREREQUISITE

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, open the layout whose casting off you want to lock.

2. In the Formatting panel, click Lock Layout  in the Lock Layout section.

RESULT
System and frame breaks are inserted at the start of every system as required to lock the current 
casting off in the layout open in the music area.

NOTE

● The system and frame breaks have Wait for next system break and Wait for next frame 
break activated in the Format group of the Properties panel by default. Because this 
property tells Dorico Pro to include all music in the system until the next system break, 
frame break, or the end of the flow, if you later delete subsequent system or frame breaks, 
this can create very full, tightly spaced systems.

● You can assign a key command for Lock Layout on the Key Commands page in 
Preferences.

RELATED LINKS
Engrave toolbox on page 514
Formatting panel on page 516
Hiding/Showing zones on page 47
Switching between layouts on page 46
System breaks on page 733
Frame breaks on page 736
Casting off on page 728
Properties panel on page 769
Key Commands page in the Preferences dialog on page 63
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Resetting casting off
You can delete all system and frame breaks in individual layouts and return the layouts to their 
default casting off and spacing settings.

PREREQUISITE

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, open the layout whose casting off you want to reset.

2. In the Formatting panel, click Reset Layout  in the Lock Layout section.

RESULT
All system and frame breaks in the layout open in the music area are deleted. The layout returns 
to following its default casting off and spacing settings.

NOTE

● The system and frame breaks have Wait for next system break and Wait for next frame 
break activated in the Format group of the Properties panel by default. Because this 
property tells Dorico Pro to include all music in the system until the next system break, 
frame break, or the end of the flow, if you later delete subsequent system or frame breaks, 
this can create very full, tightly spaced systems.

● You can assign a key command for Reset Layout on the Key Commands page in 
Preferences.

Allowing/Disallowing breaks within bars
You can choose whether or not to allow Dorico Pro to insert system/frame breaks within bars. 
For example, you might disallow breaks within bars when formatting lead sheets that only 
require breaks at barlines.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Snap system and frame breaks to barlines 
when creating in the Breaks subsection.

4. Click Apply, then Close.

RESULT
System/Frame breaks are allowed within bars when the option is activated, and disallowed when 
it is deactivated.

When breaks are disallowed within bars, inserted breaks snap to the barline before the earliest 
selected item. When making systems/frames from selections, the first break snaps to the barline 
before the earliest selected item while the second break snaps to the barline after the last 
selected item.

RELATED LINKS
Preferences dialog on page 61
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Frame breaks on page 736
Casting off on page 728

System breaks
System breaks occur when musical material reaches the right page margin and must continue on 
a new system, usually below the previous system on the same page or on a new page. Dorico Pro 
automatically arranges music across systems so that notes are correctly spaced and legible, but 
you can also control system breaks manually.

System breaks that you have inserted manually are indicated by signposts, which you can hide/
show at any time. They are also layout-specific, meaning each layout can have system breaks at 
different rhythmic positions.

System break signpost, selected

NOTE

● By default, system/frame breaks snap to the barline before the earliest selected item. You 
can change whether breaks are allowed at rhythmic positions within bars.

● System breaks at the start of systems that were created using Make into System have Wait 
for next system break activated in the Format group of the Properties panel by default. 
When this property is activated, Dorico Pro creates a system containing all material between 
that system break and the next system break or the end of the flow, whichever comes first. 
If you later delete subsequent system breaks, this creates very full, tightly spaced systems. 
For example, if you delete all subsequent system breaks, all music until the end of the flow is 
forced into a single system.

● You can also control the content of systems by fixing the number of bars per system in each 
layout.

RELATED LINKS
Allowing/Disallowing breaks within bars on page 732
Frame breaks on page 736
Signposts on page 453
Hiding non-printing elements on page 444
Note spacing on page 599
System fullness indicators on page 526
Per-layout note spacing options on page 600
Staff spacing on page 720
Per-layout vertical spacing options on page 721
Splitting multi-bar rests on page 1500
Hiding/Showing staves from system/frame breaks on page 697
Hiding/Showing staff labels at system/frame breaks on page 1534
Changing the staff size from system/frame breaks on page 717
Locking layouts on page 731
Resetting casting off on page 732
Properties panel on page 769
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Inserting system breaks
You can insert system breaks at any rhythmic position; for example, so that musical phrases fit in 
systems for readability.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● Graphic Editing  is selected in the Engrave toolbox.

● If you want to insert system breaks in the middle of multi-bar rests, you have either hidden 
multi-bar rests in the layout or split multi-bar rests at the required positions.

PROCEDURE

1. In Engrave mode, select a note or item at the rhythmic position you want to appear at the 
start of the next system.

2. Insert a system break in any of the following ways:

● Press Shift-S .

● In the Formatting panel, click Create System Break  in the Format Systems section.

RESULT
A system break is inserted at the rhythmic position of the earliest selected item. If breaks are 
disallowed within bars, it snaps to the preceding barline. All notations after the system break are 
moved to the next system.

NOTE

If you insert a system break in the middle of a phrase in a two-bar or four-bar repeat region, 
Dorico Pro does not automatically move the system break to before/after the phrase, causing it 
to be split across the system break.

RELATED LINKS
Engrave toolbox on page 514
Formatting panel on page 516
Allowing/Disallowing breaks within bars on page 732
Per-layout note spacing options on page 600
Per-layout vertical spacing options on page 721
Hiding/Showing multi-bar rests on page 1496
Splitting multi-bar rests on page 1500
Locking layouts on page 731

Making selections into systems
You can force all musical material between two selected rhythmic positions into a single system; 
for example, if you want specific bars to appear in the same system.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. In Engrave mode, select an item at the rhythmic position that you want to be the start of the 
system.

NOTE

We recommend that you select noteheads or barlines. Selecting other items, such as slurs, 
can cause system breaks to be inserted earlier/later than you might have intended.

2. Ctrl/Cmd -click one of the following:

● A notehead that you want to be at the end of the system

● An item that you want to be at the start of the next system

3. In the Format Systems section of the Formatting panel, click Make into System .

RESULT
A fixed system is created by inserting system breaks at the start/end of your selection. The 
system contains all musical material between the two selected items.

If breaks are disallowed within bars, the first break snaps to the barline before the earliest 
selected item, while the second break snaps to the barline after the last selected item.

If breaks are allowed within bars, the content of the system depends on your selections.

● If you selected items, such as barlines or slurs, the start of your first selected item is 
positioned at the start of the system, and the end of your last selected item is positioned 
at the start of the next system.

● If you selected noteheads, the last selected notehead is also included in the system, rather 
than being positioned at the start of the next system.

● If you selected ties, all musical material between the first and last notes tie chains is included 
in the system, regardless of where in the tie chains you made selections.

NOTE

The system break inserted at the start of the selection has Wait for next system break activated 
in the Format group of the Properties panel by default. Because this property tells Dorico Pro 
to include all music in the system until the next system break or the end of the flow, if you later 
delete subsequent system breaks, this can create very full, tightly spaced systems.

Deactivating Wait for next system break allows Dorico Pro to cast off subsequent music as 
normal.

RELATED LINKS
Engrave toolbox on page 514
Formatting panel on page 516
Left zone (Engrave mode) on page 515
Hiding/Showing zones on page 47
Allowing/Disallowing breaks within bars on page 732
System fullness indicators on page 526
Locking layouts on page 731
Properties panel on page 769
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Hiding/Showing system break signposts
You can hide/show system break signposts at any time.

PROCEDURE

● Choose View > Signposts > System Breaks.

RELATED LINKS
Signposts on page 453
System breaks on page 733
Hiding non-printing elements on page 444
Selecting/Deselecting notes and items individually on page 426

Deleting system breaks
You can delete system breaks after you have inserted them.

PREREQUISITE
System break signposts are shown.

PROCEDURE

1. Select the system break signposts of the system breaks you want to delete.

2. Press Backspace or Delete .

RELATED LINKS
Resetting casting off on page 732

Frame breaks
Frame breaks occur when musical material reaches the right page margin at the bottom of a 
frame and must continue on a new system in the next frame in the music frame chain, which 
is usually on the next page. Dorico Pro automatically arranges music in frames so that systems 
are correctly spaced and legible, but you can also control frame breaks manually; for example, to 
insert page turns at specific positions in part layouts.

Frame breaks that you have inserted manually are indicated by signposts, which you can hide/
show at any time. They are also layout-specific, meaning each layout can have frame breaks at 
different rhythmic positions.

Frame break signpost, selected

NOTE

● By default, system/frame breaks snap to the barline before the earliest selected item. You 
can change whether breaks are allowed at rhythmic positions within bars.
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● Frame breaks at the start of frames that were created using Make into Frame have Wait 
for next frame break activated in the Format group of the Properties panel by default. 
When this property is activated, Dorico Pro creates a frame containing all material between 
that frame break and the next frame break. If you later delete subsequent frame breaks, 
this creates very full frames with tightly spaced, or overlapping, systems. For example, if you 
delete all subsequent frame breaks, all music until the end of the flow is forced into a single 
frame.

● You can also control the content of music frames by fixing the number of systems per music 
frame in each layout.

RELATED LINKS
Allowing/Disallowing breaks within bars on page 732
Frames on page 560
Music frame chains on page 569
Signposts on page 453
Hiding non-printing elements on page 444
Note spacing on page 599
Per-layout note spacing options on page 600
Per-layout vertical spacing options on page 721
Frame fullness indicators on page 526
Hiding/Showing staves from system/frame breaks on page 697
Hiding/Showing staff labels at system/frame breaks on page 1534
Changing the staff size from system/frame breaks on page 717
Locking layouts on page 731
Resetting casting off on page 732
Properties panel on page 769

Inserting frame breaks
You can insert frame breaks at any rhythmic position; for example, to create page turns at 
appropriate places in the current layout.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● Graphic Editing  is selected in the Engrave toolbox.

● If you want to insert frame breaks in the middle of multi-bar rests, you have either hidden 
multi-bar rests in the layout or split multi-bar rests at the required positions.

PROCEDURE

1. In Engrave mode, select a note or item at the rhythmic position you want to appear at the 
start of the next frame.

2. Insert a frame break in any of the following ways:

● Press Shift-F .

● In the Formatting panel, click Create Frame Break  in the Format Music Frames 
section.

RESULT
A frame break is inserted at the rhythmic position of the earliest selected item. If breaks are 
disallowed within bars, it snaps to the preceding barline. All notations after the frame break are 
moved to the next music frame.
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NOTE

If you insert a frame break in the middle of a phrase in a two-bar or four-bar repeat region, 
Dorico Pro does not automatically move the frame break to before/after the phrase, causing it to 
be split across the frame break.

RELATED LINKS
Engrave toolbox on page 514
Formatting panel on page 516
Allowing/Disallowing breaks within bars on page 732
Per-layout note spacing options on page 600
Per-layout vertical spacing options on page 721
Hiding/Showing multi-bar rests on page 1496
Splitting multi-bar rests on page 1500
Locking layouts on page 731

Making selections into frames
You can force all musical material between two selected rhythmic positions into a single frame; 
for example, if you want specific bars to appear on the same page.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item at the rhythmic position that you want to be the start of the 
frame.

NOTE

We recommend that you select noteheads or barlines. Selecting other items, such as slurs, 
can cause frame breaks to be inserted earlier/later than you might have intended.

2. Ctrl/Cmd -click one of the following:

● A notehead that you want to be at the end of the frame

● An item that you want to be at the start of the next frame

3. In the Format Music Frames section of the Formatting panel, click Make into Frame .

RESULT
A fixed frame is created by inserting frame breaks at the start/end of your selection. The frame 
contains all musical material between the two selected items.

If breaks are disallowed within bars, the first break snaps to the barline before the earliest 
selected item, while the second break snaps to the barline after the last selected item.

If breaks are allowed within bars, the content of the frame depends on your selections.

● If you selected items, such as barlines or slurs, the beginning your first selected item is 
positioned at the start of the frame, and the end of your last selected item is positioned at 
the start of the next frame.
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● If you selected noteheads, the last selected notehead is also included in the frame, rather 
than being positioned at the start of the next frame.

● If you selected ties, all musical material between the first and last notes tie chains is included 
in the frame, regardless of where in the tie chains you made selections.

NOTE

The frame break inserted at the start of the selection has Wait for next frame break activated 
in the Format group of the Properties panel by default. Because this property tells Dorico Pro to 
include all music in the frame until the next frame break, if you later delete subsequent frame 
breaks, this can create very full frames with tightly spaced, or overlapping, systems.

Deactivating Wait for next frame break allows Dorico Pro to cast off subsequent music as 
normal.

Hiding/Showing frame break signposts
You can hide/show frame break signposts at any time.

PROCEDURE

● Choose View > Signposts > Frame Breaks.

RELATED LINKS
Signposts on page 453
Frame breaks on page 736
Hiding non-printing elements on page 444
Selecting/Deselecting notes and items individually on page 426

Deleting frame breaks
You can delete frame breaks after you have inserted them.

PREREQUISITE
Frame break signposts are shown.

PROCEDURE

1. Select the frame break signposts of the frame breaks you want to delete.

2. Press Backspace or Delete .

RELATED LINKS
Resetting casting off on page 732

Tacets
Tacet is the indication used to show that a player does not play anything in an entire flow, which 
might be a movement in a symphony or cue in a film score. In Dorico Pro, you can generate 
tacets automatically.

Dorico Pro shows tacets for flows in part layouts when the following conditions are met:

● You have removed the player from the flows in which they do not play.
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● The flows are assigned to the part layout.

● The flows are assigned to the page template frame chain in the part layout.

● You have chosen to show tacets in the part layout.

An extract of a part layout where the player is tacet in the second flow

In Engrave mode, tacets behave like systems, meaning they have their own staff spacing handle 
when Staff Spacing  is activated. This allows you to move individual tacets and their flow 
headings upwards/downwards. You can also insert system and frame breaks at the start of 
tacets.

NOTE

We do not recommend that you use Copy Staff Spacing and Lock Frame  on pages where 
tacets are the first or last system in frames. Because tacets do not contain any bars, Dorico Pro 
cannot insert system or frame breaks at the ends of tacets in order to lock the frame contents.

You can change the text shown in tacets and the margin above/below them in each layout 
independently.

You can further customize the project-wide appearance and design of tacets by editing the Tacet 
paragraph style in the Paragraph Styles dialog.

RELATED LINKS
Assigning players to flows on page 167
Assigning flows to frame chains on page 573
Allowing/Disallowing multiple flows on the same page on page 706
Staff spacing on page 720
System breaks on page 733
Frame breaks on page 736
Flow headings on page 554
Paragraph Styles dialog on page 848
Hiding/Showing tacet al fine on multi-bar rests at the end of flows on page 1497
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Hiding/Showing tacets
You can hide/show tacets in each layout independently; for example, if you want to show empty 
bars or multi-bar rests in some layouts to allow those players to add in notes on those staves 
later.

PREREQUISITE

● You have removed the player from the flows in which they do not play.

● The flows are assigned to the part layout.

● The flows are assigned to the page template frame chain in the part layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show tacets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, activate/deactivate Show tacet for flows where no players are 
assigned.

5. Click Apply, then Close.

RESULT
Tacets are shown in the selected layouts when Show tacet for flows where no players are 
assigned is activated and the prerequisite criteria are also met.

When it is deactivated, any flows to which the player is not assigned do not appear in the layout. 
When the player is assigned to those flows, all bars in the flow are shown in the part, split into 
empty bars and multi-bar rests as appropriate for the flow.

TIP

If your project contains many short flows, which appear in part layouts as a single multi-bar rest 
labeled “Tacet”, showing all the bars separately can help make the length of flows clearer. You 
can do this by increasing the value for Minimum number of bars in flow to show ‘Tacet’ on the 
Rests page in Engraving Options.

RELATED LINKS
Multi-bar rests on page 1496
Assigning players to flows on page 167
Hiding/Showing multi-bar rests on page 1496
Engraving Options dialog on page 840

Editing tacet text
You can change the text shown in tacets in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts whose tacet text you want to edit.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, enter the text you want in the Tacet text field.

5. Click Apply, then Close.

RESULT
The text shown in all tacets in the selected layouts is changed.

TIP

You can change the default padding to the right/left of tacets, show them with/without a border, 
and change their border thickness project-wide by editing the Tacet paragraph style.

Changing the margins above/below tacets
You can change the margins both above/below tacets in each layout independently; for example, 
if you want smaller gaps between flow headings and tacets in some layouts to facilitate page 
turns better.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the margins above/below 
tacets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, change the values for the following options, individually or together:

● Margin above tacet

● Margin below tacet

5. Click Apply, then Close.

RESULT
Changing the value for Margin above tacet increases/decreases the minimum gap between 
tacets and whatever precedes them.

Changing the value for Margin below tacet increases/decreases the minimum gap between 
tacets and whatever follows them.

TIP

You can change the default padding to the right/left of tacets, show them with/without a border, 
and change their border thickness project-wide by editing the Tacet paragraph style.
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RELATED LINKS
Flow headings on page 554
Paragraph Styles dialog on page 848
Margins on page 712
Per-layout vertical spacing options on page 721

Condensing
Condensing is the process of showing the music for multiple players on fewer staves than 
normal, usually by allowing multiple instruments of the same type to share a staff, such as Flutes 
1-2 or Horns 1-4. In Dorico Pro, this is an automatic process that allows you to show condensed 
staves in some layouts, such as full score layouts, and uncondensed staves in others, such as the 
part layouts.

Condensing is most commonly used in large orchestral scores because the staff size can be 
larger when there are fewer staves on a page, and larger staff sizes are easier for conductors 
to read. In order to fit all the staves normally required for an orchestra on the paper used for 
conductor scores, the staff size might be as small as 3.5 mm. For reference, the staff size in 
instrumental parts is usually at least 7 mm in order to be legible.

Fitting the music for multiple players onto the same staff and maintaining clarity over which 
notes are played by each player can be difficult. For example, if only a single, unlabeled note 
appears on a condensed staff, it is unclear whether it must be played by one player or all players. 
It is also important that staff labels accurately reflect the players on each condensed staff.

The woodwind section of an orchestral score, including some condensed and some uncondensed staves

The large number of complex calculations and considerations that are required to produce 
condensed music has made this a traditionally difficult and time-consuming task, particularly as, 
in other notation software applications, this has also required the manual duplication of music 
and staves in order to produce separate instrumental parts from a condensed full score.

Because of how Dorico Pro handles players and layouts, you can have separate instrumental 
parts and condensed full scores in the same project without any manual duplication required. 
Staff labels on condensed staves automatically refer to all players on the staff, and player labels 
indicate which notes belong to each player.

In order to ensure unambiguous results when condensing is enabled, in Dorico Pro you must 
input the music for each player separately. This ensures that Dorico Pro always understands 
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exactly how you want the music to be divided and therefore allows Dorico Pro to condense even 
complicated music.

We recommend familiarizing yourself with the calculations and considerations that Dorico Pro 
makes for condensing and the options available to you to customize your condensing results.

NOTE

● In Write mode, you cannot select anything on condensed staves. In Engrave mode, you can 
select notes and items on condensed staves but you can only edit them graphically.

Most graphical edits to condensed staves do not affect the source music, but some 
properties do, such as slur and tie style properties.

● Condensing is never enabled in galley view, so you can switch to galley view to see all staves 
separately. This does not disable condensing in the current layout.

IMPORTANT

Having condensing enabled in any layout in a project can cause Dorico Pro to operate more 
slowly, due to the large number of calculations involved. Therefore, we recommend only 
enabling condensing after you have finished the majority of the required work, such as inputting 
notes and notations or adding flows.

RELATED LINKS
Enabling/Disabling condensing on page 710
Changing condensing options from rhythmic positions on page 753
Player labels on page 760
Staff labels on condensed staves on page 1546
Hiding/Showing condensed music colors on page 764
Switching to galley/page view on page 53
Divisi on page 1567

Per-flow notation options for condensing
You can find options to control condensing in each flow independently on the Condensing page 
in Notation Options.

The Condensing page provides the following options:

Whole-phrase unison approach
Allows you to choose how to present phrases that are completely in unison on 
condensed staves.

● Allow single-stem unison: Unison phrases appear as single noteheads with single 
stems, and can represent any number of players.

● Prevent single-stem unison: Unison phrases appear with separate noteheads and 
stems for each player.

Mid-phrase unison approach
Allows you to choose how to present individual unison notes within phrases that are 
not completely in unison.

● Allow mid-phrase unisons: Mid-phrase unison notes appear with single stems.

● Prevent mid-phrase unisons: Mid-phrase unison notes appear with separate 
stems.
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Pitch crossing approach
Pitch crossing happens when the pitch of notes in the up-stem voice is lower than in 
the down-stem voice. This option allows you to choose whether players can still share 
a staff if some of their pitches cross, or if you never want players to condense if their 
phrases contain any crossed pitches.

● Allow unlimited pitch crossing: Condensing is always allowed, regardless of pitch 
crossing.

● Limit pitch crossing: Condensing is only allowed in regions that contain the set 
number of crossed pitches or fewer.

Maximum number of pitch crosses in region
Allows you to set the maximum number of pitches that can cross in each region and 
still be condensed. This is set to 1 by default.

Accidental visibility overrides
Allows you to choose whether or not your property settings for the visibility of 
accidentals on uncondensed staves can also apply to condensed staves, both for 
existing accidentals and subsequent accidentals whose visibility you change.

● Propagate to condensed staves: Allows the visibility of accidentals to be copied to 
condensed staves.

● Do not propagate to condensed staves: Prevents the visibility of accidentals from 
being copied to condensed staves.

Trill intervals
Allows you to choose whether or not notes with different trill intervals can share a 
stem. Dorico Pro can only show a single trill interval per voice.

● Require identical intervals: Notes with different trill intervals are condensed into 
separate voices.

● Do not require identical intervals: Notes with different trill intervals can share a 
stem.

Amalgamation approach for notes and chords
Allows you to choose whether or not you want to amalgamate notes and chords on 
condensed staves into a single up-stem voice when players are sometimes in rhythmic 
unison but have different rhythms at other times.

● Allow amalgamation: Notes and chords are amalgamated into a single up-stem 
voice when players are in rhythmic unison.

● Prevent amalgamation: Notes and chords are never amalgamated and remain in 
two voices, even when players are in rhythmic unison.

Amalgamation approach for slurs
Allows you to choose whether or not you want to amalgamate slurs when slurs of the 
same duration exist in both voices at the same rhythmic position.

● Allow amalgamation of slurs: Compatible slurs are amalgamated and appear as 
a single slur for both voices.

● Prevent amalgamation for slurs in down-stem voice: Slurs are shown for each 
voice separately.

● Prevent amalgamation for all slurs: Slurs are shown for each voice separately. 
Any notes that were partly amalgamated into the up-stem voice are forced to 
appear in the down-stem voice.
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Amalgamation approach for playing techniques
Allows you to choose whether or not you want to amalgamate playing techniques 
when the same technique exists in both voices at the same rhythmic position.

● Allow amalgamation: A single playing technique is shown for both voices. It 
appears either above or below the staff depending on the default placement for 
the playing technique.

● Prevent amalgamation: Playing techniques are shown both above and below the 
staff.

Amalgamation approach for horizontal lines
Allows you to choose whether or not you want to amalgamate barline-/rhythmic 
position-attached horizontal lines when the same line exists in both voices at the same 
rhythmic position.

● Allow amalgamation: A single horizontal line is shown for both voices.

● Prevent amalgamation: Horizontal lines are shown both above and below the 
staff.

NOTE

Notehead-attached lines are never amalgamated.

Condensing for players inactive for some of the system
Allows you to choose how to condense and represent inactive players when they are 
both active and inactive in the same system and other players in their condensing 
group have notes.

● Hide rests and label active player: Only the music for active players appears 
on condensed staves with player labels for active players shown where rests are 
hidden for inactive players.

● Show rests and omit labels: Shows rests for inactive players on condensed staves 
without additional player labels.

When hiding rests for inactive players
Allows you to choose specific circumstances in which to hide rests for inactive 
players. Only applies when you have chosen Hide rests and label active player for 
Condensing for players inactive for some of the system.

● Hide rests only at the start or end of bars: Only rests whose ranges start or 
end at barlines are hidden. This is a convention for some publishers and results in 
more rests but fewer player labels.

● Hide rests at any position: All rests are hidden. This results in fewer rests but 
more player labels.

Minimum length of range of rests to allow hiding
Allows you to set the duration threshold of inactivity above which you want to hide 
rests. It is a convention for some publishers to show rests that span short durations, 
such as two beats between notes, but hide rests that span longer durations.

Condensing for players inactive for the whole system
Allows you to choose how to condense and represent inactive players when they are 
inactive throughout entire systems and other players in their condensing group have 
notes.

● Pair with active player: Shows inactive players on a condensed staff, alongside at 
least one active player but in a different voice with rests shown as appropriate.
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● Include in staff label: Includes the player numbers of inactive players in staff 
labels on condensed staves, but does not show rests for them. Only the music for 
active players appears on condensed staves.

● Do not condense: Inactive players are excluded from condensing in systems in 
which they are inactive and instead appear on their own uncondensed staves. 
These staves are considered empty and are included in your per-layout settings for 
hiding empty staves.

NOTE

These options apply throughout each selected flow. However, you can override them from 
selected rhythmic positions and only for selected condensing groups using condensing changes.

RELATED LINKS
Notation Options dialog on page 837
Hiding/Showing empty staves on page 696
Changing condensing options from rhythmic positions on page 753
Rests on page 1487
Changing the property scope on page 771
Hiding/Showing or parenthesizing accidentals on page 943

Condensing calculations and considerations
In order to produce clear and legible results, Dorico Pro considers a number of factors in its 
condensing calculations, including the type of instruments and the rhythms and pitches of notes.

IMPORTANT

Having condensing enabled in any layout in a project can cause Dorico Pro to operate more 
slowly, due to the large number of calculations involved. Therefore, we recommend only 
enabling condensing after you have finished the majority of the required work, such as inputting 
notes and notations or adding flows.

Condensing calculations include the following considerations and processes:

Instruments and players
Single and section players in your project are condensed separately. Adjacent players 
holding similar instruments are automatically assigned to condensing groups when 
condensing is enabled.

NOTE

● If a single player holds multiple instruments, only their first instrument is 
considered for condensing. Other instruments always appear on a separate staff.

● Only instruments that normally have a single staff and whose music is in a single 
voice can be condensed, as music already in multiple voices produces ambiguous 
condensing results. Grand staff instruments cannot be condensed. Instruments 
with extra staves or ossia staves cannot be condensed in the systems where the 
extra staves or ossia staves exist.

● Divisi staves can be condensed but only within one player. For example, 
two section violin players can condense together only when both players are 
undivided.
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● Unpitched percussion instruments cannot be condensed. You can change how 
unpitched percussion appears in full scores using the available percussion kit 
presentations.

Condensing groups
Players within a condensing group can be condensed together and can all share a 
single staff, depending on their music and your set notation options.

By default, Dorico Pro assigns adjacent similar instruments to the same condensing 
group; for example, Flutes 1 and 2. You can create custom condensing groups to 
specify which players you want to condense together.

Phrases
Dorico Pro divides each flow into phrases because the required condensing result 
varies depending on the texture and density of the music, which changes over the 
course of a single piece. Each phrase is considered separately when calculating the 
best condensing result.

Dorico Pro considers a sequence of notes between rests as a single phrase. However, 
rests that are spanned by slurs, gradual dynamics, playing techniques with duration, 
and similar items do not break phrases. Condensing can only change within phrases 
where they span system/frame breaks.

Two phrases separated by a rest. They have different condensing results due to the parts in the 
first phrase having different rhythms.

The phrases belonging to all the players on each condensed staff are considered 
together in order to calculate the best condensing result; for example, whether or 
not phrases can share a single stem or require separate voices.

Rhythms and pitches
Within each phrase, the rhythms and pitches of notes are considered. Where they are 
both the same, the condensing result can be unison. Where they are both different, the 
condensing result can be different voices on the same staff or separate, uncondensed 
staves.

Notations
All other notations are considered in addition to notes, including articulations, 
dynamics, slurs, grace notes, playing techniques, lyrics, ornaments, and so on. For 
example, if two parts have the same rhythms and pitches but their slurs apply to 
different notes, they are condensed into a shared staff with separate voices to ensure 
the different slurs are clearly notated. Parts are also condensed into separate voices if 
their articulations are different.

NOTE

● Players with different breath marks cannot condense onto the same staff. Only 
one breath mark appears on condensed staves.

● Clefs and octave lines do not affect the condensing result. Players whose 
instruments have different clefs and octave lines can be condensed together. The 
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resulting condensed staff uses the clefs and octave lines belonging to the first 
player on the staff only.

Properties
The properties of notes and items are considered, such as if notes have forced stem 
directions or slurs have been flipped. When properties are different, parts cannot be 
condensed into the same voice.

Time signatures and key signatures
Players with different time signatures or key signatures cannot be condensed together.

Casting off
Music is condensed each system at a time, from left to right. Condensing is calculated 
for each system in its entirety, meaning that, for example, players cannot appear on 
their own staff at the start of a system and then on a condensed staff later in the same 
system.

Each system can have different condensing to neighboring systems, even if a single 
phrase spans multiple systems. In such circumstances, the separate parts of the phrase 
are considered separately.

Therefore, your casting off settings and system/frame breaks influence which phrases 
are considered together and therefore the condensing result.

NOTE

Condensed music often requires different rhythmic spacing than uncondensed music; 
for example, to accommodate the width of notes that are a small interval apart. 
Therefore, enabling condensing can cause the casting off in the layout to change.

TIP

If the automatic condensing produced by Dorico Pro does not suit your requirements, you can 
change the condensing manually from selected rhythmic positions onwards and for selected 
condensing groups using condensing changes. You might find that using condensing changes 
simply to start new phrases is sufficient to achieve the desired condensing result.

RELATED LINKS
Condensing groups on page 751
Divisi on page 1567
Adding players on page 125
Changing the voice of existing notes on page 477
Moving instruments on page 141
Resetting the appearance of items on page 442
Resetting the position of items on page 443
Casting off on page 728
Arranging tools on page 459
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Condensing results
Depending on the pitches and rhythms of notes in the different parts on condensed staves, 
condensing can result in parts sharing stems, having separate voices, or not condensing and 
remaining on separate staves.

Dorico Pro calculates and considers the condensing of parts for each phrase separately in order 
to produce the best result. Dorico Pro also automatically shows player labels so it is always clear 
which notes belong to each part on condensed staves.

There are the following possible condensing results:

Unison
In phrases where the rhythms and pitches for all players are the same, all parts on the 
condensed staff share the same noteheads on a single stem.

NOTE

Phrases must start at the same rhythmic position to produce a unison condensing 
result.

Shared stem
In phrases where the rhythms are the same, the pitches are different, and the pitches 
do not cross, each part on the condensed staff has a separate notehead but the 
noteheads share a single stem.

NOTE

Phrases must start at the same rhythmic position to produce a shared stem 
condensing result.

Shared staff
In phrases where neither the rhythms nor the pitches for all players are the same, and 
pitch crossing does not exceed your set value, parts on the condensed staff are split 
into up-stem and down-stem voices.

If phrases start at the same rhythmic position, individual notes and entire beams/
tuplets in those phrases that have the same duration can be amalgamated into a 
single voice, depending on any other notations in those phrases and your set notation 
options.
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Not condensed
In phrases where neither the rhythms nor the pitches for all players are the same, 
and pitch crossing exceeds your set value, no condensing occurs and parts remain on 
separate staves.

NOTE

● In addition to rhythms and pitches, Dorico Pro also considers all other notations, such as 
slurs and dynamics, in order to calculate the best condensing result. For example, if two 
parts have the same rhythms and pitches but their slurs apply to different notes, they 
are condensed into a shared staff with separate voices to ensure the different slurs are 
clearly notated. However, clefs and octave lines are not considered and do not affect the 
condensing result.

● Condensed staves always use a maximum of two voices, one up-stem and one down-stem. 
Each voice can include the parts of multiple players.

● If you want to change the automatic condensing results, you can do so from selected 
rhythmic positions onwards using condensing changes. You might find that using 
condensing changes simply to start new phrases is sufficient to achieve the desired 
condensing result.

Condensing groups
Condensing groups contain players whose music can be condensed onto the same staff or fewer 
staves and who are usually adjacent in the score. Condensing groups can contain up to 16 
players.

Typically, players in condensing groups hold the same type of instrument. However, there are 
some common exceptions to this; for example, the trombone and tuba, which are different 
instruments but often share a staff in orchestral scores. Another example is horns, which are 
sometimes paired up in an interlocking fashion; that is, Horns 1 and 3 share a staff and Horns 2 
and 4 share another.

Dorico Pro automatically creates condensing groups for adjacent players holding instruments 
of the same type with the same transposition, according to the current settings for enabling 
condensing in each layout. You can see these groups in Layout Options > Players > 
Condensing.

You can create custom condensing groups; for example, if you want to condense trumpets with 
different transpositions together. You can also specify groups that you do not want to condense; 
that is, groups whose players’ staves must always appear separately.
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The condensing groups set up in each layout are then available in the Condensing Change 
dialog, allowing you to change options for those condensing groups from selected rhythmic 
positions onwards.

NOTE

You can only create condensing groups that contain either all single players or all section players.

RELATED LINKS
Condensing calculations and considerations on page 747
Enabling/Disabling condensing on page 710
Changing condensing options from rhythmic positions on page 753
Layout Options dialog on page 834

Creating custom condensing groups
You can create custom condensing groups for both single and section players in each layout 
independently; for example, if you want Horns 1 and 3 and Horns 2 and 4 to condense together, 
rather than Horns 1-2 and 3-4. Condensing groups can contain up to 16 players.

NOTE

You can only create condensing groups that contain either all single players or all section players.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to create custom condensing 
groups.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Condensing section, click New Group  to open the Edit Custom Condensing Group 
dialog.

5. Select the players you want to include in the custom condensing group.

You can Shift -click adjacent players and Ctrl/Cmd -click individual players.

6. Click OK to save your changes and close the dialog.

7. Optional: Repeat steps 4 to 6 to create other custom condensing groups.

8. Click Apply, then Close.

RESULT
The condensing groups are added to the selected layouts. This affects which players can be 
condensed together in those layouts.

Any players now in custom condensing groups that were previously in default condensing 
groups are removed from the default condensing groups.
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NOTE

Other condensing calculations and considerations and your notation options still affect whether 
or not players condense at specific rhythmic positions.

AFTER COMPLETING THIS TASK
If necessary, you can change options for those condensing groups from selected rhythmic 
positions onwards to change the condensing result.

Including/Excluding condensing groups
You can specify individual condensing groups that you want to include in or exclude from 
condensing calculations; for example, if Dorico Pro automatically puts two horns in a condensing 
group but you always want to show them on separate staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to include condensing groups in, or 
exclude them from, condensing calculations.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Condensing section, activate the checkbox for each condensing group you want to 
exclude from condensing in the Groups to exclude from condensing list.

5. Click Apply, then Close.

RESULT
Condensing groups are excluded from condensing when their checkbox is activated, meaning 
players in those condensing groups are always shown on their own staves. Condensing groups 
are included in condensing when their checkbox is deactivated.

RELATED LINKS
Divisi on page 1567

Changing condensing options from rhythmic positions
You can change the settings of notation options for condensing for individual condensing groups 
from selected rhythmic positions onwards in individual layouts. For example, if you want to 
change the condensing result in specific systems.

TIP

We recommend only changing the minimum condensing options required, and only if changing 
the per-flow default condensing options, creating custom condensing groups, and starting new 
phrases from selected rhythmic positions has not produced the required condensing result.

PREREQUISITE

● You have enabled condensing in the current layout.

● Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. In Engrave mode, open the layout in which you want to change condensing.

2. Select an item at the rhythmic position where you want to change the condensing result.

TIP

The item does not have to be on a condensed staff. Only one condensing change can exist 
at a rhythmic position, but it can change and reset different options for multiple condensing 
groups.

3. Choose Engrave > Condensing Change to open the Condensing Change dialog.

4. In the condensing groups list, activate the checkbox for each condensing group you want to 
include in the condensing change.

Including condensing groups starts new phrases from the selected rhythmic position.

5. Select a condensing group whose condensing options you want to change.

NOTE

You can only change or reset options for a single selected condensing group at a time.

6. In the Notation Options section, activate each option you want to change.

7. Choose Change for each activated option.

8. Change the settings for the activated options as required.

NOTE

The prevailing settings for condensing options come from either previous condensing 
changes, if they exist, or the default settings for the flow in Notation Options.

9. Optional: Repeat steps 5 to 8 for each condensing group whose condensing options you 
want to change from the selected rhythmic position.

10. Click OK to save your changes and close the dialog.

RESULT
The condensing result is changed in the current layout from the selected rhythmic position 
onwards. Dorico Pro recalculates the condensing result both before and after the condensing 
change for each condensing group whose checkbox you activated, as this treats the rhythmic 
position of the condensing change as the start of a new phrase.

The notation options you changed apply to the corresponding condensing groups until the next 
condensing change that changes or resets those options, if one exists, or the end of the flow, 
whichever comes first.

A signpost is shown at the position of the condensing change.

RELATED LINKS
Engrave toolbox on page 514
Switching between layouts on page 46
Per-flow notation options for condensing on page 744
Condensing results on page 750
Condensing groups on page 751
Signposts on page 453
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Condensing Change dialog
The Condensing Change dialog allows you to change and reset notation options for condensing 
from selected rhythmic positions onwards in layouts. It also allows you to assign players in 
condensing groups to specific voices and staves manually.

● You can open the Condensing Change dialog in Engrave mode by choosing Engrave > 
Condensing Change when Graphic Editing  is selected in the Engrave toolbox and an 
item is selected in the music area.

The Condensing Change dialog contains the following sections and options:

1 Condensing groups list

Contains all the condensing groups in the current layout.

Activating condensing groups includes them in the condensing change, which starts new 
phrases from the rhythmic position of the condensing change. This allows Dorico Pro to 
recalculate the condensing result before and after the condensing change separately, even if 
there are no rests at that position.

Condensing groups show a warning icon  if you have activated manual condensing for 
them but not yet assigned all their players to voices/staves.

2 Notation Options section

Contains all the condensing options from the Notation Options dialog and allows you to 
change or reset them for the selected condensing group from the position of the condensing 
change.
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The prevailing settings for condensing options come from either previous condensing 
changes, if they exist, or the default settings for the flow in Notation Options.

NOTE

● Because you do not have to change all options in each condensing change, the 
prevailing settings can cumulatively come from multiple preceding condensing changes.

● In order to be more concise, the exact wording of some notation options is different in 
the Condensing Change dialog than in Notation Options.

3 Manual Condensing section

Allows you to assign players in the selected condensing group to specific voices and staves.

Activating manual condensing for a condensing group shows the players in that group in the 
players list on the left of the Manual Condensing section. You can then allocate the players 
to voices/staves in the list on the right, which removes them from the players list.

The action bar at the bottom of the list on the right contains the following options:

● Add Staff : Adds a staff. Dorico Pro automatically assigns the top player in the players 
list to the up-stem voice on the new staff.

● Remove Staff : Removes the selected staff. Any players assigned to the staff are 
returned to the players list.

● Remove Player : Removes the selected player and returns it to the players list.

● Clear : Removes all your changes to manual condensing and returns all players to the 
players list.

IMPORTANT

We recommend being careful and deliberate about your manual condensing choices. Dorico 
Pro follows your manual condensing settings exactly, even if they produce ambiguous 
results.

NOTE

● You must always have at least one player assigned to the up-stem voice on a staff, you 
cannot only have players in the down-stem voice.

● You cannot have more staves than there are players in the condensing group.

● You can only assign players within a single condensing group, you cannot share players 
between different condensing groups.

● Condensing changes that occur partway through systems and change the number of 
staves required for condensing groups, or include players switching to other staves, do 
not take effect until the next system.

4 OK button

Allows you to confirm your changes and close the dialog. You can only confirm the dialog 
when you have assigned all players in all condensing groups with manual condensing 
activated to voices/staves.

RELATED LINKS
Per-flow notation options for condensing on page 744
Condensing results on page 750
Condensing groups on page 751
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Manually condensing players
You can manually change the allocation of players to voices and staves in each condensing 
group from selected rhythmic positions onwards in individual layouts. For example, if you want 
to change the condensing result in specific systems.

IMPORTANT

We recommend only condensing players manually if changing the per-flow default condensing 
options, creating custom condensing groups, starting new phrases from selected rhythmic 
positions, and overriding selected condensing options has not produced the required 
condensing result.

In such cases, we recommend being careful and deliberate about your manual condensing 
choices. Dorico Pro follows your manual condensing settings exactly, even if they produce 
ambiguous results. For example, if you assign two players with very different rhythms to the 
same voice on the same staff, the resulting notation requires many tied notes and is harder to 
read than if they were in separate voices.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, open the layout in which you want to condense players manually.

2. Select an item at the rhythmic position from which you want to change condensing 
manually.

TIP

The item does not have to be on a condensed staff. Only one condensing change can exist 
at a rhythmic position, but it can change and reset different options for multiple condensing 
groups.

3. Choose Engrave > Condensing Change to open the Condensing Change dialog.

4. In the condensing groups list, activate the checkbox for each condensing group you want to 
include in the condensing change.

Including condensing groups starts new phrases from the selected rhythmic position.

5. Select a condensing group whose condensing you want to change manually.

NOTE

You can only change or reset options for a single selected condensing group at a time.

6. In the Manual Condensing section, activate Condensing Approach.

7. Choose Manual Condensing.

8. Select a player in the players list.

9. Assign the player to a voice and staff in any of the following ways:

● Click and drag it across to the list on the right.

● Click Add to Voice .

By default, the first player is assigned to the up-stem voice on the first staff.

10. Optional: If you want to assign the next player to a different staff, click Add Staff  in the 
action bar at the bottom of the list on the right.
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By default, the top player in the players list is automatically assigned to the up-stem voice on 
the new staff.

11. Optional: Continue assigning players to voices/staves in any of the following ways:

● Click and drag them across to the required voice and staff in the list on the right.

An insertion line indicates where the player will be assigned.

● Select the player in the players list, select the destination voice and staff in the list on the 
right, and click Add to Voice .

NOTE

● You must assign all players in the condensing group to voices/staves before Dorico Pro 
allows you to confirm and close the dialog. Until all players are assigned, a warning icon 

 appears beside the condensing group in the condensing group list.

● You must always have at least one player assigned to the up-stem voice on a staff, you 
cannot only have players in the down-stem voice.

● You cannot condense solo staves in divisi changes.

12. Optional: Repeat steps 5 to 11 for each condensing group you want to condense manually 
from the selected rhythmic position.

13. Click OK to save your changes and close the dialog.

RESULT
The condensing result is changed in the current layout from the selected rhythmic position 
onwards. Dorico Pro recalculates the condensing result both before and after the condensing 
change for each condensing group whose checkbox you activated, as this treats the rhythmic 
position of the condensing change as the start of a new phrase.

The condensing groups whose manual condensing you changed follow your assignments until 
the next condensing change that changes or resets those assignments, if one exists, or the end 
of the flow, whichever comes first. For divisi changes, the condensing result reverts to the default 
in the layout if the number of divisions subsequently changes.

A signpost is shown at the position of the condensing change.

RELATED LINKS
Engrave toolbox on page 514
Switching between layouts on page 46
Per-flow notation options for condensing on page 744
Condensing results on page 750
Condensing groups on page 751
Changing condensing options from rhythmic positions on page 753
Divisi on page 1567
Signposts on page 453

Resetting condensing changes from rhythmic positions
You can reset changes you have made to condensing to your per-flow defaults, including 
resetting only selected notation options, from selected rhythmic positions onwards in individual 
layouts.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. In Engrave mode, open the layout in which you want to reset condensing changes.

2. Select an item at the rhythmic position where you want to reset condensing.

TIP

The item does not have to be on a condensed staff. Only one condensing change can exist 
at a rhythmic position, but it can change and reset different options for multiple condensing 
groups.

3. Choose Engrave > Condensing Change to open the Condensing Change dialog.

4. In the condensing groups list, activate the checkbox for each condensing group you want to 
include in the condensing change.

Including condensing groups starts new phrases from the selected rhythmic position.

5. Select a condensing group whose condensing you want to reset.

NOTE

You can only change or reset options for a single selected condensing group at a time.

6. Reset condensing in one of the following ways:

● To reset a previous change to condensing options: In the Notation Options section, 
activate each option you want to reset and choose Reset.

● To reset a previous manual condensing change: In the Manual Condensing section, 
activate Condensing Approach and choose Reset.

7. Optional: Repeat steps 5 and 6 for each condensing group whose condensing you want to 
reset.

8. Click OK to save your changes and close the dialog.

RESULT
The condensing result is reset to follow your per-flow notation options for the activated options, 
or entirely for manual condensing changes. This applies from the selected rhythmic position 
onwards until the next existing condensing change or the end of the flow, whichever comes first.

A signpost is shown at the position of the condensing change.

Deleting condensing changes
You can delete manual condensing changes, which returns condensing to the previous existing 
condensing change in the flow, if one exists, or the default condensing settings in the layout.

PROCEDURE

1. Select the signposts of the condensing changes you want to delete.

2. Press Backspace or Delete .

RESULT
The selected condensing changes are deleted. The condensing result returns to either the 
previous existing condensing change in the flow, if one exists, or the default settings in the 
layout. This applies until the next existing condensing change or until the end of the flow, 
whichever comes first.
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RELATED LINKS
Filters on page 433

Player labels
Player labels identify the players to which notes on condensed staves belong. They are usually 
used to indicate a change in how music is condensed, such as going from having different parts 
to playing in unison or from all players having separate stems to some players sharing a stem.

Player labels are placed above the staff for up-stem voices and below the staff for down-stem 
voices. They have a small horizontal offset to the left of their rhythmic position by default, which 
reduces pressure on vertical spacing.

Player labels (circled) indicating which music belongs to the first (1) and second (2) players on each staff

In Dorico Pro, player labels are automatically shown at the start of phrases whose condensing is 
different to the previous phrase and at the start of new systems.

● For notes that only belong to a single player, the player label shows instrument numbers on 
condensed staves containing instruments with identical instrument names, and abbreviated 
instrument names on condensed staves containing instruments with different instrument 
names.

● For notes that belong to all single players on the staff, the player label shows the “to” 
indication followed by the number of players on the staff, such as a 3.

● For notes that belong to all section players on the staff, the player labels shows a unison 
indication, such as unis..

● For notes that belong to multiple players, but not all players on the staff, the player label 
shows instrument numbers or abbreviated instrument names followed by the “to” indication, 
such as 1.2 a 2 or Fl. Ob. a2.

TIP

● You can change the default appearance and position of player labels, including their offset, 
separator, and “to” indication, on the Condensing page in Engraving Options.

You can also change the default unison indication for both divisi change and player labels.

● Player labels use the Player Labels paragraph style, which you can edit in the Paragraph 
Styles dialog.
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RELATED LINKS
Paragraph Styles dialog on page 848
Staff labels on condensed staves on page 1546
Divisi change labels on page 1577
Instrument numbering on page 132
Player, layout, and instrument names on page 181

Project-wide engraving options for player labels
You can find options for the project-wide appearance and position of player labels on the 
Condensing page in Engraving Options.

The options on the Condensing page allow you to set precise distances between player labels 
and the staff and other items, choose whether they erase their backgrounds, change whether 
player numbers are separated and appended with periods or commas, and change the text 
shown for “to” and unison indications.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840

Hiding/Showing player labels
You can hide/show player labels individually; for example, if you want to hide the player labels 
automatically shown at the start of systems when multiple systems fit on the same page.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the player labels you want to hide/show.

2. In the Properties panel, activate/deactivate Hide in the Player Labels group.

RESULT
The selected player labels are hidden when Hide is activated, and shown when it is deactivated.

Signposts are shown at the position of each hidden player label. However, signposts are not 
printed by default.

TIP

You can hide/show player label signposts by choosing View > Signposts > Player Labels.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing signposts on page 454
Annotations on page 687
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Editing player label text
You can override the text shown in player labels individually; for example, if you want to describe 
condensing on a staff in a different format than is shown by default.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the player labels whose text you want to edit.

2. In the Properties panel, activate Custom text in the Player Labels group.

3. Enter the text you want to appear in the player labels into the value field.

4. Press Return .

RESULT
The selected player labels are changed to show the text you entered.

Deactivating Custom text returns the corresponding player labels to their default text.

NOTE

● Deactivating properties permanently deletes any custom text entered.

● You can change the default appearance and content of player labels on the Condensing 
page in Engraving Options. For example, you can choose whether or not to include “a3” in 
player labels for unison passages, such as 1.2.3 a3.

RELATED LINKS
Editing divisi change labels on page 1578
Moving items graphically on page 609
Engraving Options dialog on page 840

Changing the default to/unison indications
You can change the default term used for the “to” indication for condensing player labels and the 
unison indication for both divisi change and player labels; for example, if you want to show “tutti” 
for unison indications.

By default, the “to” indication is “a” and the unison indication is “unis.”. Both indications use the 
Player Labels paragraph style.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Condensing.

3. In the Player Labels section, enter the text you want in the following fields, individually or 
together:

● Text for "to" indication

● Text for unison indication for section players
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4. Click Apply, then Close.

RESULT
The “to” and/or unison indications are changed in all divisi change and player labels project-wide.

RELATED LINKS
Player labels on page 760
Divisi change labels on page 1577
Paragraph Styles dialog on page 848

Showing player labels on one/two lines
By default, player labels appear on a single line. You can insert line breaks in individual player 
labels to show instrument numbers and the a2 indication spread across two lines. This can 
reduce the horizontal space required for player labels containing many instrument numbers.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the player labels into which you want to insert a line break.

2. In the Properties panel, activate/deactivate Line break in the Player Labels group.

RESULT
The selected player labels are shown on two lines in the current layout when Line break is 
activated, and on one line when it is deactivated.

EXAMPLE

Player label on one line Player label on two lines

Erasing the background of player labels
By default in Dorico Pro, player labels have erased backgrounds so they do not collide with staff 
lines if they must be positioned within the staff in dense scores. You can change this default 
setting for all player labels, including changing their erasure padding.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Condensing.
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3. In the Player Labels subsection, activate/deactivate Erase background with padding.

4. Optional: If you activated Erase background with padding, change the value in the value 
field to change the erasure padding around player labels.

5. Click Apply, then Close.

RESULT
All player labels project-wide have erased backgrounds when Erase background with padding 
is activated, and do not have erased backgrounds when it is deactivated. When they have erased 
backgrounds, the erasure padding is determined by the set value.

Hiding/Showing condensed music colors
You can show notes and rests on condensed staves in gray to help you identify condensed music. 
Condensed music cannot be selected or edited directly.

Condensed music colors are considered annotations and are not printed by default.

NOTE

Condensed music colors only appear in layouts where condensing is enabled.

PROCEDURE

● Choose View > Note And Rest Colors > Condensed Music.

RESULT
Notes and rests on condensed staves appear gray when a tick appears beside Condensed Music 
in the menu, and black when no tick appears.

EXAMPLE

Condensing colors shown, causing notes and rests to appear black on the uncondensed piccolo staff and 
gray on the condensed Flutes 1-2 staff.

RELATED LINKS
Enabling/Disabling condensing on page 710
Annotations on page 687
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Part formatting propagation
The propagation of part formatting involves copying the layout options and system formatting 
that determine the layouts of pages in specific part layouts and applying them to other part 
layouts. This can save time when formatting similar parts.

System formatting includes the positions of system and frame breaks, but also note spacing 
changes that affect the horizontal space that notes require.

In Dorico Pro, you can copy layout options and system formatting both together and 
independently of each other from a selected source layout to other destination layouts. For 
example, for source layouts whose formatting relies primarily on their Casting Off settings in 
Layout Options, it is likely that copying only their layout options is sufficient to produce the 
required formatting in the destination layouts without adding system/frame breaks on every 
system.

You can also copy the layout-specific property settings from the layout currently open in the 
music area to all other layouts in which those items appear.

NOTE

● Part formatting propagation is only available for part layouts. You cannot propagate part 
formatting from/to full score or custom score layouts.

● We do not recommend using layouts with multiple music frame chains as either source or 
destination layouts as you can get unexpected results.

● Propagating part formatting does not include overrides to individual pages made in Engrave 
mode.

Copying part formatting to other layouts
You can copy all the formatting from one part layout to other part layouts; for example, to save 
time if multiple part layouts in your project require similar formatting. You can include layout 
options, such as page size and margins, and other page formatting, such as system and frame 
breaks.

NOTE

● Part formatting propagation is only available for part layouts. You cannot propagate part 
formatting from/to full score or custom score layouts.

● We do not recommend using layouts with multiple music frame chains as either source or 
destination layouts as you can get unexpected results.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the part layout whose part formatting you want 
to copy.

2. In the action bar, click Layout Settings  and choose Propagate Part Formatting to open 
the Propagate Part Formatting dialog.

TIP

You can also right-click layouts and choose this option from the context menu.

3. In the Copy formatting from list, select the part layout whose part formatting you want to 
copy.

By default, the layout whose card you used to open the dialog is selected.
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4. In the Propagate formatting to list, select the part layouts to which you want to copy part 
formatting.

You can use the selection options in the action bar, click and drag across multiple layouts, 
Shift -click adjacent layouts, and Ctrl/Cmd -click individual layouts.

5. Activate/Deactivate Include layout options.

6. Activate/Deactivate Include system formatting.

7. Click OK to copy part formatting to the selected layouts and close the dialog.

RESULT
Part formatting from the selected source layout is copied to the selected destination layouts. 
However, overrides to individual pages made in Engrave mode are not propagated.

● If you activated Include layout options, layout options are copied from the source layout to 
the destination layouts.

● If you activated Include system formatting, Dorico Pro copies the distribution of bars 
in systems, systems on pages, and note spacing changes from the source layout to the 
destination layouts.

TIP

If the formatting of the source layout relies primarily on its Casting Off settings in Layout 
Options, it is likely that only activating Include layout options is sufficient to produce very 
similar formatting in the destination layouts without adding system/frame breaks on every 
system.

Propagate Part Formatting dialog
The Propagate Part Formatting dialog allows you to copy the page formatting and layout 
options from a source layout to destination layouts.

You can open the Propagate Part Formatting dialog in Setup mode in any of the following 
ways:

● In the Layouts panel, select a part layout, then click Layout Settings  in the action bar 
and choose Propagate Part Formatting. This automatically selects that layout as the source 
layout in the Copy formatting from list.

TIP

You can also right-click layouts and choose this option from the context menu.

● Choose Setup > Propagate Part Formatting.
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The Propagate Part Formatting dialog contains the following sections and options:

1 Copy formatting from list

Contains a list of all the part layouts in the project. You can only select a single part layout as 
the source layout.

2 Propagate formatting to list

Contains a list of all the part layouts in the project. You can select multiple part layouts as 
destination layouts.

3 Selection options

Allow you to select/deselect all the part layouts in the Propagate formatting to list.

4 Include layout options

Allows you to copy layout options relating to part formatting from the source layout to 
the destination layouts. These options include page size, page margins, the default page 
template set, space size, vertical spacing, note spacing, casting off, multi-bar rest settings, 
and staff labels.

5 Include system formatting

Allows you to copy the distribution of bars in systems, systems on pages, and note spacing 
changes from the source layout to the destination layouts. Dorico Pro achieves this by 
copying system breaks, frame breaks, and note spacing changes, inputting additional system 
and frame breaks as required, and deleting any existing system breaks, frame breaks, and 
note spacing changes in the destination layouts.

RELATED LINKS
Layout Options dialog on page 834
Layouts panel (Setup mode) on page 118
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Copying property settings to other layouts/frame chains
Local properties are layout- and frame chain-specific, meaning that by default, changing local 
properties for an item in one layout does not affect the same item in other layouts or other 
frame chains. You can copy the properties set on notes and items to all other layouts and frame 
chains in which they appear; for example, to show gradual dynamics with the same style in part 
layouts after changing their style in the full score layout.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes or items whose properties you want to copy to other layouts. You can do 
this in Write mode and Engrave mode.

NOTE

Only the properties that are available in the current mode are copied.

2. Choose Edit > Propagate Properties.

RESULT
All properties set on the selected notes/items that are available in the current mode are copied 
to all layouts and frame chains in which those notes/items appear. For example, if you selected 
slurs in Write mode, their staff-relative placement and design settings are copied. If you selected 
them in Engrave mode, their slur end and control point positions are also copied.

TIP

If you know in advance that you want your changes to affect all layouts and frame chains, you 
can change the property scope before changing property settings.

RELATED LINKS
Engrave toolbox on page 514
Large selections on page 428
Local vs. global properties on page 770
Resetting the appearance of items on page 442
Resetting the position of items on page 443
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Properties

Properties are settings that apply to individual notes and items and allow you to edit them, such 
as by changing their appearance or position. You can access properties in the Properties panel.

Properties can affect items only in the current layout and frame chain, known as “local 
properties”, or in all layouts and frame chains, known as “global properties”.

Most properties also have equivalent default settings available that control the appearance or 
position of all instances of the corresponding type of note or notation. You can access the 
available default settings in Engraving Options and Notation Options.

RELATED LINKS
Engraving Options dialog on page 840
Notation Options dialog on page 837
Chord symbol appearance presets on page 1038

Properties panel
The Properties panel in Write mode provides options that allow you to edit individual notes and 
notations, such as by changing their appearance or position. It is located in the lower zone at the 
bottom of the window in Write mode and Engrave mode.

● You can show the Properties panel by showing the lower zone, then clicking Properties  in 
the lower zone toolbar.

The Properties panel contains a group of properties for each notation item. When you select a 
note or item in the music area, the Properties panel displays the groups and options that you 
might require to edit the selected note or item. If there are more available groups than can fit in 
the panel simultaneously, you can scroll to the right/left along the displayed groups.

All the properties that are available in the Properties panel in Write mode are also available in 
Engrave mode, but additional properties in Engrave mode allow you to edit items in more detail.

NOTE

● If you select multiple different types of notation items, only the groups that they have in 
common are displayed. For example, if you select a slur, the Common and Slurs groups are 
displayed in the Properties panel. However, if you select a slur and a note, only the Common 
group is displayed.

● If the property scope is set to Locally, changing local properties only affects the current 
layout and frame chain. You can set the property scope to Globally if you want subsequent 
changes to local properties to affect all layouts and frame chains. You can also copy property 
changes to other layouts and frame chains later.

● In Write mode, you can only change the properties of complete notes and items. For 
example, you can only change the line style of whole pedal lines, even if they extend across 
multiple systems. In Engrave mode, you can change individual parts of notes and items 
separately; for example, the curvature direction of a single tie within a tie chain.

● You can activate properties by clicking their activation switch or property name.
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Properties panel in Write mode, filtered by a search term

The Properties panel toolbar contains the following options:

Search
Allows you to filter properties according to your entry.

Show (active status)
Allows you to filter properties according to their activated status.

● Active: Shows only activated properties.

● All: Shows all properties.

Show (property scope)
Allows you to filter properties according to their property scope.

● Local Only: Shows only local properties.

● Global Only: Shows only global properties.

● All: Shows all properties.

Set local properties
Allows you to change the scope of subsequent local properties you change.

● Locally: Local properties only take effect locally.

● Globally: Local properties take effect globally.

RELATED LINKS
Project window in Write mode on page 196
Project window in Engrave mode on page 513
Hiding/Showing zones on page 47
Copying property settings to other layouts/frame chains on page 768
Changing your preferred unit of measurement on page 54
Moving items graphically on page 609
Selecting handles on items on page 611
Resetting the appearance of items on page 442
Resetting the position of items on page 443

Local vs. global properties
Properties can affect items either in the current layout and frame chain only or in all layouts and 
frame chains. This allows you to have the same items appear differently in different layouts, such 
as if you want to show gradual dynamics as hairpins in part layouts but as “cresc.” text in full 
score layouts.

Local properties
Local properties are layout- and frame chain-specific. By default, changing local 
properties for an item in one layout does not affect the same item in other layouts 
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or other frame chains. This is particularly useful for local properties that control the 
graphical position of items, as usually this needs to be different in the part layout 
compared to the full score.

You can force local properties to apply globally by changing the property scope in 
the Properties panel to Globally before changing their setting. Local properties that 
have been set globally appear with a bolder font in the Properties panel than local 
properties that have been set locally. You can also show only local properties in the 
Properties panel by using the property scope filter.

NOTE

Changing local properties with the property scope set to Globally overrides any local 
settings for those properties for the selected notes or items in other layouts.

Global properties
Global properties affect items in all layouts and frame chains, including new layouts 
you subsequently create. They appear with a bolder font in the Properties panel than 
local properties. You can also show only global properties in the Properties panel by 
using the property scope filter.

RELATED LINKS
Layouts on page 169
Music frame chains on page 569
Copying property settings to other layouts/frame chains on page 768

Changing the property scope
You can change the property scope of local properties; for example, if you want the subsequent 
properties you change to affect all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

● In the Properties panel, choose one of the following options for Set local properties:

● Locally

● Globally

RESULT
The property scope is changed. All subsequent local properties you change take effect only in 
the current layout and frame chain if you chose Locally, or in all layouts and frame chains if you 
chose Globally.

NOTE

● The property scope includes local properties that control the graphical position of items. 
Because it is common for items to require different graphical positions in different layouts, 
we recommend that you change the property scope to Globally only when required.

● This only applies to subsequent properties you change. If you want to change the property 
scope of existing properties, you can copy property settings to other layouts and frame 
chains.
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● You can change the default property scope for all future projects on the Note Input and 
Editing page in Preferences.

RELATED LINKS
Copying property settings to other layouts/frame chains on page 768
Preferences dialog on page 61

Changing values in numeric value fields
You can change the values in numeric value fields in multiple different ways, such as doubling or 
halving the existing values. In Dorico Pro, value fields are most commonly used in the Properties 
panel and in options dialogs.

Numeric value fields have up/down buttons. They are also known as “spin boxes”.

A numeric value field in the Properties panel

PREREQUISITE
For value fields that are only accessible when their corresponding property/option is activated, 
you have activated their property/option.

PROCEDURE

● Change the value in numeric value fields in any of the following ways:

● Enter a number directly.

● To increase/decrease the value by 1/8 space, click the up/down buttons.

● To increase/decrease the value by 1/32 space, Ctrl/Cmd - Shift -click the up/down 
buttons.

● To increase/decrease the value by 1/2 space, Shift -click the up/down buttons.

● To increase/decrease the value by 1 space, Ctrl/Cmd -click the up/down buttons.

● To increase the current value by a specific amount, enter += followed by the amount into 
the spin box. For example, enter +=2 to increase the current value by two.

● To decrease the current value by a specific amount, enter -= followed by the amount into 
the spin box. For example, enter -=3.5 to decrease the current value by three and a half.

● To multiply the current value by a specific amount, enter * followed by the amount into 
the spin box. For example, enter *3 to triple the current value.

● To divide the current value by a specific amount, enter / followed by the amount into the 
spin box. For example, enter /2 to halve the current value.

NOTE

You must replace the existing value with your calculation entry.

RELATED LINKS
Options dialogs in Dorico Pro on page 30
Changing your preferred unit of measurement on page 54
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Key Editor

The Key Editor is a MIDI editor that comprises multiple components. It allows you to edit notes 
and other playback items, including note velocity, MIDI CC, and tempo. You can access the Key 
Editor in the Key Editor panel in the lower zone.

The Key Editor contains the following editors, which you can show in different combinations:

● Piano roll editor

● Percussion editor

● Playing Techniques editor

● Velocity editor

● Dynamics editor

● MIDI Pitch Bend editor

● MIDI CC editor

● Tempo editor

The Key Editor also provides different tools and controls, according to the requirements of each 
editor.

RELATED LINKS
Piano roll editor on page 784
Percussion editor on page 785
Playing Techniques editor on page 795
Velocity editor on page 796
Dynamics editor on page 799
MIDI Pitch Bend editor on page 804
MIDI CC editor on page 805
Tempo editor on page 810
Histogram tool on page 813

Key Editor panel
The Key Editor panel allows you to view and edit notes, either in a continuous piano roll for 
pitched instruments or in the percussion editor for unpitched instruments. It is located in the 
lower zone at the bottom of the window in Write mode and Play mode.

● You can show the Key Editor panel by showing the lower zone, then clicking Key Editor  in 
the lower zone toolbar.

By default, the Key Editor displays the instrument on whose staff you have selected an item. 
However, you can also select the instruments you want to show in the Key Editor manually.

773
Dorico Pro 4.3.30



1 Key Editor panel toolbar

Contains tools that allow you to select and edit notes and items in the Key Editor.

2 Key Editor ruler

Displays bar numbers and shows beat divisions that match the current rhythmic grid 
resolution.

3 Playhead

Shows the current rhythmic position in playback.

4 Header

Displays the name of each editor and can contain further options, according to the editor.

5 Primary editor

Contains either the piano roll editor, percussion editor, or Tempo editor, depending on your 
most recent selection and whether the Key Editor is locked.

6 Playing Techniques editor

Displays where playing techniques are in use for the corresponding instrument or voice. 
Only available when a single instrument/voice is shown in the Key Editor.

7 Additional editors

You can add/close multiple additional editors below the piano roll/percussion editor, such 
as the Velocity and MIDI CC editors. You can save configurations of editors for use in other 
projects.

8 Add Editor

Allows you to add additional editors to the Key Editor.

9 Presets

Allows you to save, apply, and delete Key Editor configurations.

10 Zoom controls

Allow you to change the zoom manually, such as making notes wider and/or taller.

11 Scroll bars

Allow you to scroll vertically and horizontally in the Key Editor.

RELATED LINKS
Hiding/Showing zones on page 47
Track overview on page 615
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Voices on page 1704
Rhythmic grid on page 214
Changing the Key Editor rhythmic grid resolution on page 780
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
Key Editor configurations on page 818
Played vs. notated note durations on page 793
Histogram tool on page 813
Transform tool on page 817

Key Editor panel toolbar
The Key Editor panel toolbar contains tools that allow you to select and edit notes and items in 
the Key Editor. It is located at the top of the Key Editor panel in the lower zone.

Select

Allows you to select items in the Key Editor, such as notes in the piano roll editor 
or velocity bars in the Velocity editor, including by clicking and dragging marquee 
selections.

You can also select Select by pressing Shift-Alt/Opt-1 .

Draw

Allows you to input notes in the piano roll and percussion editors. The end positions 
and minimum durations of notes follow the current Key Editor rhythmic grid 
resolution.

You can also select Draw by pressing Shift-Alt/Opt-2 .

Drumstick

Allows you to set a different rhythmic duration for each unpitched percussion 
instrument independently, and input sequences of notes with the corresponding 
duration by clicking and dragging in the percussion editor.

Also allows you to delete notes by clicking them.

Only available in the percussion editor.

You can also select Drumstick by pressing Shift-Alt/Opt-3  when the percussion editor 
is shown.

Line

Allows you to draw straight lines between two points. Not available in the piano roll 
editor or percussion editor.

Transform

Allows you to make Transform selections, and use Transform controls on the selected 
range. Only available in the Velocity and MIDI CC editors.
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Sync Region

Copies data from the primary track to secondary tracks. Only available in the Dynamics 
and MIDI CC editors, and when multiple instruments are shown in the Key Editor.

Delete

Deletes the selected items.

You can also delete selected items by pressing Backspace or Delete .

Played Durations

Allows you to change when notes start/end in playback without affecting their notated 
durations. Displays the played durations of notes as a rectangle, above a thinner line 
that shows their notated duration.

Notated Durations

Allows you to change the rhythmic duration of notes, which affects the position and 
notation of those notes. Displays the full, notated durations of notes as rectangles.

Rhythmic Grid

Allows you to change the rhythmic grid resolution for the Key Editor. The Key Editor 
rhythmic grid resolution affects the minimum duration of the notes you input, the 
number of grid lines, and certain aspects of inputting and editing, such as the amount 
by which you can drag notes to the right/left. The button updates to show the current 
rhythmic grid resolution.

Playing Techniques

Hides/Shows the Playing Techniques editor.

Voice selector

Allows you to select the voice whose notes you want to appear highlighted in the piano 
roll and into which you want to input notes. Automatically updates according to your 
current selection.

When multiple instruments are shown in the Key Editor, only voices belonging to the 
primary instrument are available.

Resize Lower Zone

Allows you to change the height of the lower zone.

TIP

● You can right-click and hold in the Key Editor to access tools in the quick tool selector.
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● You can also select tools by pressing Shift-Alt/Opt-1  to Shift-Alt/Opt-6 . The tool selected 
by each key command depends on the tools currently available in the Key Editor panel 
toolbar, counted from left to right.

RELATED LINKS
Notes in the Key Editor on page 784
Playing Techniques editor on page 795
Velocity editor on page 796
Dynamics editor on page 799
MIDI CC editor on page 805

Showing instruments in the Key Editor
You can show specific instruments in the Key Editor, change the primary instrument, and lock the 
Key Editor to keep those instruments in view. For example, if you want to draw MIDI points for all 
string instruments in your project simultaneously.

By default, the Key Editor is unlocked and follows the current selection in either the music area or 
track overview.

For example, if your most recent selection was a Flute note or the Flute track, that Flute is shown 
in the piano roll editor. If your most recent selection was a tempo mark or the Tempo track, the 
Tempo editor is shown in the Key Editor, provided you had not already added the Tempo editor 
manually.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Your most recently selected item belonged to an instrument, so that either the piano roll or 
percussion editor is shown in the Key Editor.

NOTE

You cannot add editors to the Key Editor when the Tempo editor is the primary editor.

PROCEDURE

1. In the piano roll/percussion editor header, click the instrument menu, then select the 
instrument you want to show as the primary instrument.

2. To lock the Key Editor and keep the selected instrument in view, click Lock Key Editor .
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3. To show multiple instruments in the Key Editor simultaneously, activate View multiple 
instruments.

NOTE

You can only show multiple pitched instruments in the Key Editor. You cannot show multiple 
unpitched percussion instruments, or unpitched percussion instruments in addition to 
pitched instruments.

4. Activate each instrument you want to show in the Key Editor.

5. Optional: Click Make Primary beside the instrument you want to designate as the new 
primary instrument.

RESULT
The Key Editor shows the selected instruments. If you locked the Key Editor, including if you 
optionally selected multiple instruments, it no longer follows your most recent selection.

TIP

You can assign key commands for the following commands on the Key Commands page in 
Preferences:

● Lock Key Editor to Selection automatically shows in the Key Editor the instruments on 
whose staves you have selected notes/items in the music area, and locks the Key Editor to 
that selection.

● Toggle Key Editor Locked View locks/unlocks the Key Editor.

AFTER COMPLETING THIS TASK

● You can view, input, and edit notes, dynamic points, and MIDI points for all the instruments 
shown in the Key Editor.

● You can copy dynamic and MIDI points from the primary instrument to secondary 
instruments.

RELATED LINKS
Hiding/Showing zones on page 47
Adding/Closing editors in the Key Editor on page 781
Piano roll editor on page 784
Percussion editor on page 785
Dynamics editor on page 799
MIDI CC editor on page 805

Key Editor
Key Editor panel 

778
Dorico Pro 4.3.30



MIDI Pitch Bend editor on page 804
Tempo editor on page 810
Track overview on page 615
Enabling independent voice playback on page 636
Copying dynamic points to other instruments on page 803
Copying MIDI points to other instruments on page 809

Changing the height of the Key Editor
You can change the height of the whole Key Editor and each editor within it. For example, you 
can make the piano roll editor taller when inputting notes, and make the Velocity editor taller 
when changing note velocity.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

● Do one of the following:

● To change the height of the whole Key Editor, click and drag Resize Lower Zone  or 
the top edge of the lower zone upwards/downwards.

● To change the height of individual editors, click and drag their splitters 
upwards/downwards. When the mouse pointer is in the correct position, it appears as a 
split arrow.

TIP

You can assign a key command for Cycle Lower Zone Size on the Key Commands page in 
Preferences, which makes the lower zone fill 25%, 50%, then 75% of the project window.

RELATED LINKS
Key Commands page in the Preferences dialog on page 63
Opening multiple project windows on page 52

Zooming in/out of the Key Editor
You can change the zoom level in the Key Editor; for example, you can zoom in vertically and 
horizontally to make notes appear taller and wider in the piano roll editor. This does not affect 
the height of the Key Editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

1. Zoom in horizontally in any of the following ways:

● Press H .

● Click Zoom In  at the bottom of the Key Editor.

● Click in the Key Editor ruler and drag upwards.
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● Ctrl/Cmd -scroll upwards in the Key Editor ruler.

2. Zoom out horizontally in any of the following ways:

● Press G .

● Click Zoom Out  at the bottom of the Key Editor.

● Click in the Key Editor ruler and drag downwards.

● Ctrl/Cmd -scroll downwards in the Key Editor ruler.

3. Zoom in vertically in any of the following ways:

● Press Ctrl/Cmd-Shift-H .

● Click Zoom In  on the right of the Key Editor.

● Ctrl/Cmd -scroll upwards in the area to the left of the piano roll/percussion editor.

4. Zoom out vertically in any of the following ways:

● Press Ctrl/Cmd-Shift-G .

● Click Zoom Out  on the right of the Key Editor.

● Ctrl/Cmd -scroll downwards in the keyboard to the left of the piano roll.

RELATED LINKS
Key Editor panel on page 773
Zooming in/out of tracks on page 630
Hiding/Showing zones on page 47

Scrolling in the Key Editor
You can scroll in any direction in the Key Editor; for example, to view higher/lower notes in the 
piano roll editor, or MIDI points in later bars in the MIDI CC editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

● In the Key Editor, scroll in any of the following ways:

● Click and drag the sliders on the right and bottom edges of the Key Editor.

● Swipe in any direction on a touchpad.

● To scroll vertically when using a mouse wheel, scroll upwards/downwards.

● To scroll horizontally when using a mouse wheel, Shift -scroll upwards/downwards.

Changing the Key Editor rhythmic grid resolution
You can change the rhythmic grid resolution used for the Key Editor, independently of the 
rhythmic grid used outside of the Key Editor. The Key Editor rhythmic grid resolution affects 
the minimum duration of the notes you input, the number of grid lines, and certain aspects of 
inputting and editing, such as the amount by which you can drag notes to the right/left.

PREREQUISITE

● The lower zone is shown.
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● Key Editor  is selected in the lower zone toolbar.

● If you want to use key commands, your most recent selection must have been in the Key 
Editor panel.

PROCEDURE

● Change the Key Editor rhythmic grid resolution in any of the following ways:

● In the Key Editor panel toolbar, click Rhythmic Grid  and choose the resolution you 
want.

● To decrease the rhythmic grid resolution, press Alt/Opt-] .

● To increase the rhythmic grid resolution, press Alt/Opt-[ .

RELATED LINKS
Rhythmic grid on page 214
Notes in the Key Editor on page 784

Adding/Closing editors in the Key Editor
You can add/close all types of editors in the Key Editor, excluding the piano roll and percussion 
editors. You can also change the editor type shown in an existing editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Your most recently selected item belonged to an instrument, so that either the piano roll or 
percussion editor is shown in the Key Editor.

NOTE

You cannot add editors to the Key Editor when the Tempo editor is the primary editor.

PROCEDURE

● Change the editors shown in the Key Editor in one of the following ways:

● To add a new editor, click Add Editor  at the bottom left of the Key Editor.

● To change the editor type shown in an existing editor, click the menu in its header and 
select an editor from the menu.

● To close editors, click Close Editor  in their headers.

AFTER COMPLETING THIS TASK
You can save Key Editor configurations for use in other projects.

Selecting items in the Key Editor
You can select notes and items, such as MIDI or dynamic points, in the Key Editor in the same 
ways.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.
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● You have selected the instruments you want to show in the Key Editor.

● You have added the editors whose points you want to select.

PROCEDURE

1. Select the Select tool in any of the following ways:

● Press Shift-Alt/Opt-1 .

● In the Key Editor panel toolbar, click Select .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Select , then release the mouse.

2. Select notes or items in any of the following ways:

● Click a single note or point.

● Ctrl/Cmd -click or Shift -click multiple notes or points.

● In one editor, click and drag across an area where you want to select everything.

A blue rectangle indicates which notes or points will be selected when you release the 
mouse. We recommend that you click in one corner of the area you want to select and 
drag diagonally across to the other corner.

Copying and pasting points in the Key Editor
You can copy and paste points in the Key Editor, including to other editors and repeating them 
directly after themselves in the same editor. For example, if you want to copy a pattern of MIDI 
points between different MIDI controllers.

NOTE

These steps describe copying/pasting points within/between editors belonging to the same 
instrument. However, you can also copy/paste dynamic and MIDI points between instruments.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the editors whose points you want to copy/paste.

PROCEDURE

1. In one of the open editors, select the points you want to copy.

2. Copy the selected points in any of the following ways:

● Press Ctrl/Cmd-C .

● Choose Edit > Copy.

3. Move the playhead to the position to which you want to paste the selected points.

4. Select the header of the editor into which you want to paste the selected points.

5. Paste the selected points in any of the following ways:

● Press Ctrl/Cmd-V .
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● Choose Edit > Paste.

RESULT
The selected points are copied to the selected position and editor, without deleting them from 
their original positions. They apply to all instruments shown in the Key Editor.

NOTE

● All the points of gradual dynamics and combined/force dynamics input in Write mode are 
copied, even if you only selected a single point.

● You can also repeat points immediately after themselves by selecting them, then pressing R . 
In each repetition, the earliest selected point replaces the last selected point.

● You can also copy points by selecting them, then Alt/Opt -dragging them to the position 
where you want to paste them.

RELATED LINKS
Showing instruments in the Key Editor on page 777
Moving the playhead on page 631
Copying dynamic points to other instruments on page 803
Copying MIDI points to other instruments on page 809

Deleting points in the Key Editor
You can delete selected points from multiple editors simultaneously.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the editors whose points you want to delete.

PROCEDURE

1. In any of the open editors, select the points you want to delete.

TIP

You can select points in multiple editors simultaneously.

2. Delete the selected points in any of the following ways:

● Press Backspace or Delete .

● In the Key Editor panel toolbar, click Delete .

RESULT
The selected points are deleted.

Deleting dynamic points that overrode dynamics input in Write mode reverts those dynamics 
to their default points. Deleting the points of dynamics input in Write mode also deletes the 
corresponding dynamics.

Deleting tempo points also deletes their corresponding tempo marks or tempo mark signposts 
from layouts.
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Notes in the Key Editor
In the Key Editor, notes appear as colored rectangles in either the piano roll editor for pitched 
instruments, or the percussion editor for unpitched percussion instruments and percussion kits.

Piano roll editor
The piano roll editor displays MIDI notes for pitched instruments in a continuous sequence. It is 
located in the Key Editor in the lower zone.

● You can show the piano roll editor by showing a pitched instrument in the Key Editor.

The piano roll editor comprises the following:

1 Instrument menu

Allows you to select the instruments you want to show in the piano roll editor, and to change 
the primary instrument when multiple instruments are shown.

2 Piano keyboard

Provides a reference for pitches.

3 Piano roll

Displays the notes belonging to the instruments shown in the Key Editor. The horizontal 
position of notes indicates their rhythm, and their width indicates their duration. The vertical 
position of notes indicates their pitch. When notes are sufficiently tall and wide, pitches are 
also displayed inside each note.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for the 
corresponding instrument, including in the Mixer and Key Editor.
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When multiple instruments are shown, notes belonging to the primary instrument appear 
solid and bold in the piano roll editor, while notes belonging to secondary instruments 
appear with gray outlines and pastel colors.

4 Tuplets

Bars and ratios at the top of the piano roll editor indicate tuplets in the active voice.

You can input and edit notes in the piano roll editor, including moving and transposing them. 
This also updates their notation in all applicable layouts.

RELATED LINKS
Played vs. notated note durations on page 793
Showing instruments in the Key Editor on page 777
Track overview on page 615
Mixer on page 821
Tuplets on page 1669
Voices on page 1704
Inputting notes into multiple voices on page 231
Changing the voice of existing notes on page 477

Percussion editor
The percussion editor displays MIDI notes for unpitched percussion instruments in a continuous 
sequence. It is located in the Key Editor in the lower zone.

● You can show the percussion editor by showing an unpitched percussion instrument or 
percussion kit in the Key Editor.

The percussion editor comprises the following:

1 Instrument menu

Allows you to select the instrument you want to show in the percussion editor. You can only 
show one percussion kit or individual percussion instrument at a time.
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2 Percussion instrument names and playing techniques

In the percussion editor, each unpitched percussion instrument has its own row, including 
when they are in a percussion kit. Alternative playing techniques are listed beneath the 
corresponding unpitched percussion instrument.

3 Percussion Rhythmic Grid

Allows you to set a different default note duration for each unpitched percussion instrument 
independently. Only available when the Drumstick  tool is selected.

4 Percussion editor

Displays the notes belonging to the instruments shown in the Key Editor. The vertical 
position of notes indicates their instrument and playing technique, where applicable. The 
horizontal position of notes indicates their rhythm, and their width indicates their duration.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for 
the corresponding instrument, including in the Mixer and Key Editor. Percussion kits are 
assigned a single color for the whole kit.

RELATED LINKS
Percussion maps on page 930
Showing instruments in the Key Editor on page 777
Inputting notes using the Drumstick tool on page 787
Track overview on page 615
Playing techniques for unpitched percussion instruments on page 1682

Inputting notes in the Key Editor
You can input notes in the Key Editor, in either the piano roll editor for pitched instruments, or in 
the percussion editor for unpitched percussion instruments and percussion kits. Notes you input 
in the Key Editor also appear in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● If you want to input notes into a specific voice for an instrument, you have created that voice 
in Write mode and input at least one note into it.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. Optional: If you want to input notes into a specific voice, select it from the voice selector in 
the Key Editor panel toolbar.

2. Select the Draw tool in any of the following ways:

● Press Shift-Alt/Opt-2 .

● In the Key Editor panel toolbar, click Draw .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Draw , then release the mouse.

3. Click Rhythmic Grid  and choose the default note duration you want.

4. Input notes in any of the following ways:

Key Editor
Notes in the Key Editor 

786
Dorico Pro 4.3.30



● To input single notes with the default note duration, click in the piano roll/percussion 
editor at each rhythmic position where you want to input a note.

● To input notes with any duration, click and drag horizontally in the piano roll/percussion 
editor at the required pitch position and for the required duration.

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.

RESULT
For pitched instruments, notes are input at the pitches indicated by the piano keyboard on the 
left of the piano roll, and into the active voice indicated by the voice selector in the Key Editor 
panel toolbar.

For unpitched percussion instruments and kits, notes are input into the instrument in the 
corresponding row of the percussion editor.

When you click once, notes are input with the default note duration, set by the Key Editor 
rhythmic grid resolution. When you click and drag, their duration is determined by the width of 
your drag.

AFTER COMPLETING THIS TASK
You can change both the notated and played durations of notes.

RELATED LINKS
Hiding/Showing zones on page 47
Zooming in/out of the Key Editor on page 779
Changing the height of the Key Editor on page 779
Changing the Key Editor rhythmic grid resolution on page 780
Inputting notes into multiple voices on page 231
Changing the voice of existing notes on page 477
Enabling independent voice playback on page 636
Played vs. notated note durations on page 793

Inputting notes using the Drumstick tool
The Drumstick tool allows you to input notes with a different rhythmic duration for each 
unpitched percussion instrument independently.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the unpitched percussion instrument or percussion kit you want to show 
in the Key Editor.
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PROCEDURE

1. Select the Drumstick tool in any of the following ways:

● Press Shift-Alt/Opt-3 .

● In the Key Editor panel toolbar, click Drumstick .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Drumstick , then release the mouse.

2. In the percussion editor header, click Percussion Rhythmic Grid  for each instrument and 
choose its required note duration.

For example, you might set quarter notes for the kick drum, and eighth notes for the hi-hat.

3. Input notes in any of the following ways:

● To input single notes, click in the percussion editor at each rhythmic position where you 
want to input a note.

● To input multiple notes, click and drag horizontally in the percussion editor.

RESULT
Notes are input with the note duration set for the corresponding instrument, either a single note 
per click, or to fill the region in which you clicked and dragged.

TIP

When Drumstick  is selected, you can also delete notes by clicking them.

Moving notes in the Key Editor
You can move notes rhythmically in the Key Editor. This also affects how the selected notes are 
notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In the Key Editor panel toolbar, click Notated Durations  to show notated note durations.

2. In the piano roll/percussion editor, select the notes you want to move rhythmically.

3. Move the selected notes in any of the following ways:

● To move them to the right, press Alt/Opt-Right Arrow .

● To move them to the left, press Alt/Opt-Left Arrow .

● Click and drag them to the right/left.
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TIP

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.

RESULT
The selected notes are moved to new rhythmic positions. If you selected multiple notes, they are 
moved together as a block.

Key commands move notes according to the current rhythmic grid resolution. Clicking and 
dragging moves notes according to the current Key Editor rhythmic grid resolution.

RELATED LINKS
Hiding/Showing zones on page 47
Rhythmic grid on page 214
Changing the Key Editor rhythmic grid resolution on page 780
Moving percussion notes between instruments/playing techniques on page 791

Lengthening/Shortening notes in the Key Editor
You can change the notated duration of notes in the Key Editor. This also affects how the 
selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In the Key Editor panel toolbar, click Notated Durations  to show notated note durations.

2. In the piano roll/percussion editor, select the notes you want to lengthen/shorten.

3. Lengthen/Shorten the selected notes in any of the following ways:

● To lengthen notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To double the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To halve the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● Click and drag the right end of one of the selected notes to the length you want.

TIP

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.
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RESULT
The selected notes are lengthened/shortened.

Key commands lengthen/shorten notes according to the current rhythmic grid resolution. 
Clicking and dragging lengthens/shortens notes according to the current Key Editor rhythmic 
grid resolution.

RELATED LINKS
Selecting items in the Key Editor on page 781
Note durations on page 258
Played vs. notated note durations on page 793
Rhythmic grid on page 214
Changing the Key Editor rhythmic grid resolution on page 780
Enabling independent voice playback on page 636

Transposing notes in the piano roll editor
You can transpose notes in the piano roll editor by moving them vertically to other pitch 
positions. This also affects how the selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

PROCEDURE

1. In the piano roll editor, select the notes you want to transpose.

2. Transpose the notes in any of the following ways:

● To move notes up one staff position, such as from C to D, press Alt/Opt-Up Arrow .

● To move notes down one staff position, such as from D to C, press Alt/Opt-
Down Arrow .

● To transpose notes up a single octave division, such as a half-step (semitone) in 12-EDO 
or a quarter tone in 24-EDO, press Shift-Alt/Opt-Up Arrow .

● To transpose notes down a single octave division, such as a half-step (semitone) in 
12-EDO or a quarter tone in 24-EDO, press Shift-Alt/Opt-Down Arrow .

● To transpose notes up an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To transpose notes down an octave, press Ctrl/Cmd-Alt/Opt-Down Arrow .

● Click and drag them upwards/downwards.

TIP

As you drag, highlights help you to reference durations against the ruler, and pitches 
against the piano keyboard.

RESULT
The selected notes are transposed according to their new pitch positions in the piano roll editor.

RELATED LINKS
Hiding/Showing zones on page 47
Equal Division of the Octave (EDO) on page 1219
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Transposing tools on page 479

Moving percussion notes between instruments/playing techniques
You can move notes to other instruments and playing techniques in the percussion editor; for 
example, if you want hi-hat notes to be played on a cymbal instead. This also affects how the 
selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the unpitched percussion instrument or percussion kit you want to show 
in the Key Editor.

PROCEDURE

1. In the percussion editor, select the notes you want to move to other instruments/playing 
techniques.

2. Move the notes in any of the following ways:

● To move notes to the instrument above, press Alt/Opt-Up Arrow .

● To move notes to the instrument below, press Alt/Opt-Down Arrow .

● To cycle notes upwards through the playing techniques of their current instrument, 
press Shift-Alt/Opt-Up Arrow .

● To cycle notes downwards through the playing techniques of their current instrument, 
press Shift-Alt/Opt-Down Arrow .

● Click and drag them upwards/downwards.

TIP

As you drag, highlights help you to reference durations against the ruler, and notes 
against instruments/playing techniques.

RESULT
The selected notes are moved to the instrument/playing technique in the corresponding row in 
the percussion editor.

RELATED LINKS
Percussion editor on page 785
Playing techniques for unpitched percussion instruments on page 1682

Copying and pasting notes in the Key Editor
You can copy and paste notes in the piano roll and percussion editors, including to other pitched 
instruments and voices, and repeating them directly after themselves.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.
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PROCEDURE

1. In the piano roll/percussion editor, select the notes you want to copy.

2. Copy the selected notes in any of the following ways:

● Press Ctrl/Cmd-C .

● Choose Edit > Copy.

3. Move the playhead to the position to which you want to paste the selected notes.

4. Optional: If you want to paste notes to another instrument, make that instrument the 
primary instrument.

5. Optional: If you want to paste notes into another voice, select that voice from the voice 
selector in the Key Editor toolbar.

6. Paste the selected notes in any of the following ways:

● Press Ctrl/Cmd-V .

● Choose Edit > Paste.

RESULT
The selected notes are copied to the selected position, instrument, and voice, without deleting 
them from their original positions. By default, any MIDI CC points in the copied range are also 
pasted.

TIP

● You can also repeat notes immediately after themselves by selecting them, then pressing R .

● You can also copy notes by selecting them, then Alt/Opt -dragging them to the position 
where you want to paste them.

RELATED LINKS
Moving the playhead on page 631
Disabling automatic copying of MIDI data when pasting on page 464
Copying dynamic points to other instruments on page 803
Copying MIDI points to other instruments on page 809
Copying and pasting notes/items on page 461

Deleting notes in the Key Editor
You can delete notes in the Key Editor. This also removes notes from all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

PROCEDURE

1. Optional: If Select  is selected in the Key Editor panel toolbar, select the notes you want to 
delete in the piano roll/percussion editor.

2. Delete notes in any of the following ways:

● Press Backspace or Delete .

● In the Key Editor panel toolbar, click Delete .
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● In the Key Editor panel toolbar, click Drumstick , then click each note you want to 
delete in the percussion editor.

Played vs. notated note durations
In the Key Editor, you can show notes with their played duration or notated duration.

Played duration

When Played Durations  is selected in the Key Editor panel toolbar, notes in the piano roll/
percussion editor are each shown with two components:

● A filled, light-colored rectangle showing the played duration of the note.

● A thin, darker rod showing the notated duration of the note.

This allows you to change the played, sounding duration of notes. For example, notes with 
staccato articulations are played for less time than their notated duration, whereas notes under 
slurs are played for longer than their notated duration.

Notated duration

When Notated Durations  is selected in the Key Editor panel toolbar, notes in the piano roll/
percussion editor appear as single rectangles whose width corresponds to the notated duration 
of the note. This allows you to change the duration of notes.

EXAMPLE
The following examples all contain the same musical phrase, shown in different ways.

Played duration Notated duration Score

RELATED LINKS
Key Editor panel toolbar on page 775
Slurs in playback on page 1530
Articulations in playback on page 961
Changing the duration of notes on page 259
Lengthening/Shortening notes in the Key Editor on page 789

Changing the played duration of notes
You can change the played duration of notes individually, both at the start and end of notes. For 
example, you can make notes sound for longer, or start sounding later.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.
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● You have selected the instruments you want to show in the Key Editor.

PROCEDURE

1. In the Key Editor panel toolbar, click Played Durations  to show played note durations.

2. In the piano roll/percussion editor, select the notes whose played duration you want to 
change.

3. Click and drag the start or end of one of the notes to the right/left.

When the mouse pointer is in the correct position, it appears as a split arrow.

RESULT
The played duration of the selected notes is changed.

TIP

You can assign key commands for increasing/decreasing playback start/end offsets in 
Preferences > Key Commands > Note Editing. You can use these commands when Played 
Durations  is selected in the Key Editor panel toolbar.

RELATED LINKS
Selecting items in the Key Editor on page 781
Key Commands page in the Preferences dialog on page 63

Resetting playback overrides
You can remove all changes made to how individual notes play back; for example, if you 
previously changed the played duration of notes and want to revert them to their default start 
position, length, and velocity.

Removing playback overrides also removes any offsets to the start and end position of notes 
imported from MIDI files with preserved note positions.

NOTE

Any note velocities that are set on notes are reflected in playback, including from imported MIDI 
files or MIDI recording. If you want dynamics you input in Write mode to be reflected in playback 
instead, you must remove playback overrides.

PROCEDURE

1. Select the notes whose playback overrides you want to reset.

You can do this in the music area, piano roll editor, percussion editor, or Velocity editor.

2. Choose Play > Reset Playback Overrides.

RESULT
All playback overrides are removed from the selected notes.
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RELATED LINKS
Large selections on page 428
Selecting/Deselecting notes and items individually on page 426
Music area on page 37
Piano roll editor on page 784
Percussion editor on page 785
Resetting note velocity on page 798
MIDI recording on page 263
Importing MIDI on page 89
Opening projects/files on page 75

Playing Techniques editor
The Playing Techniques editor displays where playing techniques are in use for the 
corresponding instrument or voice; for example, as a result of inputting playing techniques, 
slurs, or articulations. It is located in the Key Editor in the lower zone.

● You can hide/show the Playing Techniques editor by clicking Playing Techniques  in the 
Key Editor panel toolbar.

NOTE

You can only show the Playing Techniques editor when a single instrument/voice is shown in 
the Key Editor.

The Playing Techniques editor comprises the following:

1 Editor header

Displays the name of the editor.

2 Playing technique regions

Display the playing technique and note length condition that apply to notes in the region. 
You can hover your mouse pointer over playing technique regions to see the following 
related information:

● Any playback techniques, switches, and other effects in place, such as adjustments for 
articulations

● Expression map used for the region

● Channel in the VST or MIDI instrument used for the region

● VST or MIDI instrument used for the region

NOTE

You cannot change playing techniques in the Playing Techniques editor. You can only change 
them in Write mode.
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RELATED LINKS
Hiding/Showing zones on page 47
Playing techniques on page 1387
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Playback techniques on page 936
Expression maps on page 912
Showing instruments in the Key Editor on page 777
Moving percussion notes between instruments/playing techniques on page 791
Enabling independent voice playback on page 636

Velocity editor
The velocity editor allows you to view and edit the velocity of notes belonging to the instruments/
voices shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the Velocity editor by adding an editor to the Key Editor, then selecting 
Velocity from the editor menu.

Velocity is often used to control the dynamics of non-sustaining instruments.

The Velocity editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Velocity edit scope: Allows you to change the scope of changes you make to velocity 
values. Only available when Draw , Line , or Transform  is selected in the Key 
Editor panel toolbar.

● All notes: Allows you to edit the velocity of all notes shown in the Velocity editor.

● Selection: Allows you to edit the velocity of selected notes only.

● Histogram : Shows the Histogram tool in the editor.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Velocity bars

Velocities appear as vertical bars in the Velocity editor. Every note has its own velocity bar 
and a velocity value. When multiple notes exist at the same rhythmic position, such as in 
chords, the velocities for all notes appear stacked on top of each other, ordered by their 
value.

Velocity bars with higher values appear with bolder colors.

You can select velocity bars directly in the Velocity editor or by selecting their corresponding 
notes, in either the piano roll editor, percussion editor, or music area.
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TIP

● Clicking and dragging velocity bars causes a read-out to appear temporarily, showing 
their value.

● You can use the Histogram and Transform tools to change velocity values.

RELATED LINKS
Key Editor panel on page 773
Key Editor panel toolbar on page 775
Histogram tool on page 813
Transform tool on page 817
Hiding/Showing zones on page 47
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
Inputting notes on page 221
Inputting notes into multiple voices on page 231
Inputting notes in the Key Editor on page 786
Voices on page 1704

Changing the velocity of notes
You can change the velocity of notes individually, including for a single note in a chord, or to 
create a consistent increase/decrease in velocity across a range of notes.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the Velocity editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on how you want to change velocities:

● To change the velocity of selected notes, select Select by pressing Shift-Alt/Opt-1  or 
clicking Select  in the Key Editor panel toolbar.

● To change the velocity using free shapes, select Draw by pressing Shift-Alt/Opt-2  or 
clicking Draw  in the Key Editor panel toolbar.

● To change the velocity using consistent slopes, select Line by clicking Line  in the Key 
Editor panel toolbar.

2. Optional: If you selected Select , select the notes whose velocity you want to change, such 
as individual notes in chords. This also selects their velocity bars.

3. Optional: If you selected either the Draw  tool or Line  tool, choose one of the following 
velocity edit scopes in the Velocity editor header:

● All notes

● Selection

4. In the Velocity editor, change the velocity in one of the following ways:

● If you selected Select , click and drag the top of one of the selected velocity bars 
upwards/downwards.
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● If you selected Draw , click and draw any shape across the required range.

● If you selected Line , click and drag a line across the required range.

RESULT
The velocity of the affected notes is changed. If you selected the Selection velocity edit scope, 
this only applies to selected velocity bars.

TIP

You can also use the Transform and Histogram tools to change velocities on a large scale in 
different ways.

Resetting note velocity
You can remove changes you have made to the velocity of notes and reset them to their default 
velocity. You can do this for all notes belonging to an instrument, all notes in a specific voice, or 
only selected notes.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the Velocity editor to the Key Editor.

PROCEDURE

1. In the Velocity editor header, activate Histogram  to show the Histogram tool.

2. At the top of the Histogram tool, choose one of the following filters:

● All notes

● Voice

● Selection

3. Click Reset.

RESULT
Any changes you have made to the velocity of notes in the selected filter are reset.

NOTE

This also resets the played duration of the selected notes.

RELATED LINKS
Histogram tool on page 813
Selecting items in the Key Editor on page 781
Resetting playback overrides on page 794
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Dynamics editor
The Dynamics editor allows you to view, input, and edit dynamics for the instruments/voices 
shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the Dynamics editor by adding an editor to the Key Editor, then selecting 
Dynamics from the editor menu.

The Dynamics editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Dynamic point

An immediate change in dynamic, input either in Write mode or using the Draw tool in the 
Dynamics editor. Immediate dynamic points are constant by default.

The maximum range of dynamic levels is from 8 to -8, loudest to quietest.

● Dynamic level 3 is equivalent to the dynamic .

● Dynamic level 0 is equivalent to the dynamic .

● Dynamic level -3 is equivalent to the dynamic .

NOTE

● Clicking and dragging dynamic points causes a read-out to appear temporarily, showing 
their dynamic level.

● Only points that are identical for all instruments shown in the Key Editor are editable.

4 Dynamic text

Shows the dynamic level or crescendo/diminuendo symbol of dynamics input in Write mode; 
that is, dynamic points that correspond to notation items.

5 Dynamic region

Blue highlighted regions contain multiple points, input by clicking and dragging in a single 
motion in the Dynamics editor with either the Draw tool or Line tool. By default, dynamic 
points in regions input in the Dynamics editor are linear.

Green highlighted regions represent gradual dynamics and combined/force dynamics, such 
as  and , input in Write mode.

Thin blue bars at the top of the Editor represent dynamic groups.
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NOTE

● Only points that are identical for all instruments shown in the Key Editor are editable.

● Dynamic regions that you input in the Dynamics editor override default playback 
adjustments for dynamics, such as humanization and increased dynamics for notes with 
accents. However, the dynamic curve setting still applies to dynamic regions.

● Default playback adjustments for dynamics, such as humanization and increased 
dynamics for notes with accents, still apply to notes within gradual dynamics that you 
input in Write mode.

● Start and end points for messa di voce regions are linked and always have the same 
value.

● Because the points of combined/force dynamics correspond to parameters of their 
envelopes, they function differently than other dynamic points. Combined dynamics 
have three points, while force dynamics have four points.

For example, if you change the value of the second point of a force dynamic, the third 
point also moves because it controls the duration of the second point; they always have 
the same value. Similarly, you cannot move combined/force dynamic points outside their 
regions.

6 Dynamic value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.

RELATED LINKS
Key Editor panel on page 773
Hiding/Showing zones on page 47
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
Dynamics on page 1104
Groups of dynamics on page 1132
Input methods for dynamics on page 310
Changing dynamic levels on page 1112
Rhythmic grid on page 214

Inputting dynamic points
You can input single dynamic points and dynamic regions in the Dynamics editor. Dynamic points 
that you input in the Dynamics editor do not appear in layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the Dynamics editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the type of dynamic points you want to input:

● To input single dynamic points, or dynamic regions containing multiple dynamic points 
at regular intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the 
Key Editor panel toolbar.
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● To input smooth dynamic regions, select Line by clicking Line  in the Key Editor panel 
toolbar.

2. Input dynamic points in one of the following ways:

● To input single dynamic points, click in the Dynamics editor at each position where you 
want a dynamic point.

● To input a dynamic region containing multiple dynamic points at regular intervals, click 
and drag in a single motion in the Dynamics editor.

● To input smooth dynamic regions, click and drag in the Dynamics editor from where you 
want the region to start to where you want it to end.

RESULT
Dynamic points are input for all instruments shown in the Key Editor.

● If you used the Draw tool, separate dynamic points are input at each position you clicked.

● If you clicked and dragged in a single motion using the Draw tool, dynamic points are input 
at 32nd note intervals in a dynamic region.

● If you used the Line tool, two dynamic points are input in a dynamic region, one at each end 
of the dragged range.

By default, dynamic points input using the Draw tool are constant, while dynamic points in 
dynamic regions are linear.

Dynamic regions appear with highlighted regions in the Dynamics editor.

Dynamic points input in the Dynamics editor affect playback, but are not shown in layouts.

NOTE

● Inputting dynamic points/events at the positions of dynamics input in Write mode overrides 
default playback adjustments for those dynamics. Single dynamic points only override the 
dynamic level. Dynamic regions also override, for example, humanization and increased 
dynamics for notes with accents. However, the dynamic curve setting still applies to dynamic 
regions.

● For sound libraries that use MIDI CC 1 to control dynamics, the MIDI CC editor for CC 1 
displays values from the dynamics you input, including dynamic points, combined with 
humanization.

Moving dynamic points
You can move individual dynamic points, including moving them upwards and downwards to 
change their dynamic level. For example, if you want individual dynamics to take effect slightly 
earlier, or to adjust the volume of specific existing dynamics.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the Dynamics editor to the Key Editor.

PROCEDURE

1. In the Dynamics editor, select the dynamic points you want to move.
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TIP

To move dynamics input in Write mode rhythmically, you can select only their start point, 
including for gradual dynamics and combined/force dynamics that have multiple points.

2. Move the selected dynamic points in any of the following ways:

● Click and drag them in any direction.

NOTE

You can only move dynamics input in Write mode either horizontally or vertically at a 
time.

● To move dynamic points to the right/left only, hold Shift  while dragging them to the 
right/left.

● To move dynamic points upwards/downwards only, hold Shift  while dragging them 
upwards/downwards.

● To move a single dynamic input in Write mode to the next notehead on the staff, press 
Alt/Opt-Right Arrow .

● To move a single dynamic input in Write mode to the previous notehead on the staff, 
press Alt/Opt-Left Arrow .

● To move dynamic points to the right according to the current rhythmic grid resolution, 
press Ctrl/Cmd-Alt/Opt-Right Arrow .

● To move dynamic points to the left according to the current rhythmic grid resolution, 
press Ctrl/Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple dynamics are selected, you can only move them according to the current 
rhythmic grid resolution.

RESULT
The selected dynamic points are moved to new positions. Moving them to the right/left affects 
their rhythmic positions. Moving them upwards/downwards affects their dynamic level.

Moving the end points of gradual dynamics to the right/left lengthens/shortens the 
corresponding gradual dynamics rhythmically. Their notated length is automatically updated in 
all applicable layouts.

NOTE

● Moving dynamic points for linked dynamics affects all linked dynamics.

● You cannot drag dynamics input in Write mode beyond other existing dynamic points during 
the same move. Releasing the mouse causes the moved dynamic points to change the value 
of the existing dynamic point.

RELATED LINKS
Linked dynamics on page 1133
Gradual dynamics on page 1120
Changing dynamic levels on page 1112
Lengthening/Shortening items on page 436
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Copying dynamic points to other instruments
When multiple instruments are shown in the Key Editor, you can copy dynamic points from the 
primary instrument to secondary instruments. You can copy only individual points and regions, 
or all points belonging to the primary instrument in the selected flow.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added the Dynamics editor to the Key Editor.

● Multiple instruments are shown in the Key Editor.

PROCEDURE

1. Optional: If you want to sync individual dynamic points or regions only, click Sync Region 
in the Key Editor panel toolbar to select Sync Region.

2. In the Dynamics editor, do one of the following:

● To copy individual dynamic points or regions, click each dynamic point and region, or 
click and drag across multiple dynamic points and regions.

● To copy all dynamic points in the current flow, click Sync  in the editor header.

RESULT
The corresponding dynamic points are copied from the primary instrument to secondary 
instruments, and become editable for all instruments shown in the Key Editor.

Existing dynamic points in the affected regions belonging to secondary instruments are 
overwritten.

TIP

When multiple instruments are shown in the Key Editor, you can input dynamic points for all 
instruments directly.

EXAMPLE

Dynamic region in primary instrument only Dynamic region copied to secondary instruments

RELATED LINKS
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
Selecting items in the Key Editor on page 781
Switching between flows in the track overview on page 616
Copying and pasting points in the Key Editor on page 782
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MIDI Pitch Bend editor
The MIDI Pitch Bend editor allows you to view, input, and edit MIDI pitch bend controller data for 
the instruments shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the MIDI Pitch Bend editor by adding an editor to the Key Editor, then 
selecting MIDI Pitch Bend from the editor menu.

The MIDI Pitch Bend editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.

● Convert to Constant Point : Makes the selected points constant. Only applies to 
points in regions.

● Convert to Linear Point : Makes the selected points linear. Only applies to points in 
regions.

● Value field: Displays the value of the earliest selected MIDI point. You can change this 
value in the value field, or click and drag the point upwards/downwards in the editor. 
The available range for MIDI pitch bend is -100% to +100%.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 MIDI point

A single change to the MIDI pitch, input using the Draw tool. Individual MIDI points are 
constant by default. Only points that are identical for all instruments shown in the Key Editor 
are editable.

4 MIDI region

A highlighted region that contains multiple points, input by clicking and dragging in a single 
motion with either the Draw tool or Line tool.

By default, MIDI points in regions are linear, and the last point is constant. Only points that 
are identical for all instruments shown in the Key Editor are editable.

5 MIDI value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.
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MIDI CC editor
The MIDI CC editor allows you to view, input, and edit data in any MIDI controller for the 
instruments shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the MIDI CC editor by adding an editor to the Key Editor, then selecting a MIDI 
controller from the editor menu.

TIP

● You can add multiple MIDI CC editors to the Key Editor simultaneously; for example, to copy 
MIDI points between two MIDI controllers.

● Dorico Pro displays generated values as non-editable value lines. For sound libraries that 
use MIDI CC 1 to control dynamics, the MIDI CC editor for CC 1 displays values from the 
dynamics you input, including dynamic points, combined with humanization.

The MIDI CC editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Histogram : Shows the Histogram tool in the editor.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.

● Convert to Constant Point : Makes the selected points constant. Only applies to 
points in regions.

● Convert to Linear Point : Makes the selected points linear. Only applies to points in 
regions.

● Value field: Displays the value of the earliest selected MIDI point. You can change this 
value in the value field, or click and drag the point upwards/downwards in the editor. 
The available range for MIDI CC is 0 to 127.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 MIDI point

A single change to the MIDI value, input using the Draw tool. Individual MIDI points are 
constant by default. Only points that are identical for all instruments shown in the Key Editor 
are editable.

4 MIDI region

A highlighted region that contains multiple points, input by clicking and dragging in a single 
motion with either the Draw tool or Line tool.
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By default, MIDI points in regions are linear, and the last point is constant. Only points that 
are identical for all instruments shown in the Key Editor are editable.

5 MIDI value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.

TIP

● Clicking and dragging MIDI points causes a read-out to appear temporarily, showing their 
value.

● You can use the Histogram and Transform tools to change MIDI CC values.

● MIDI CC data is included when exporting MIDI files.

RELATED LINKS
Key Editor panel on page 773
Histogram tool on page 813
Transform tool on page 817
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
MIDI Pitch Bend editor on page 804
Copying and pasting points in the Key Editor on page 782
Exporting MIDI on page 99
Dynamics on page 1104
Dynamics editor on page 799
Playback Options for dynamics on page 1137
Pedal lines in playback on page 1385
Dynamics in playback on page 1136

Inputting MIDI points
You can input MIDI CC points into any MIDI controller, including pitch bend, in the MIDI CC and 
MIDI Pitch Bend editors.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the MIDI points you want to input:

● To input single MIDI points, or MIDI regions containing multiple points at regular 
intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the Key Editor 
panel toolbar.

● To input smooth MIDI regions, select Line by clicking Line  in the Key Editor panel 
toolbar.

2. Input MIDI points in one of the following ways:

● To input single MIDI points, click in the MIDI CC or MIDI Pitch Bend editor at each 
position where you want a MIDI point.
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● To input a MIDI region containing multiple MIDI points at regular intervals, click and 
drag in a single motion in the MIDI CC or MIDI Pitch Bend editor.

● To input smooth MIDI regions, click and drag in the MIDI CC or MIDI Pitch Bend editor 
from where you want the region to start to where you want it to end.

TIP

The horizontal line in the middle of the MIDI Pitch Bend editor represents the unmodified 
pitch.

RESULT
MIDI points are input for all instruments shown in the Key Editor.

● If you used the Draw tool, separate MIDI points are input at each position you clicked.

● If you clicked and dragged in a single motion using the Draw tool, MIDI points are input at 
small intervals in a MIDI region.

● If you used the Line tool, two MIDI points are input in a MIDI region, one at each end of the 
dragged range.

By default, single MIDI points are constant, MIDI points in regions are linear, and the last MIDI 
point in regions is constant.

MIDI regions appear highlighted with colored backgrounds in the MIDI CC and MIDI Pitch Bend 
editors.

Making MIDI points constant/linear
You can make selected MIDI points in regions constant or linear after they have been input; for 
example, if you want some points in a region to be constant.

By default, MIDI points are constant when you input them separately, and linear when you click 
and drag them as a region. The last MIDI point in a region is constant.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. In the MIDI CC or Pitch Bend editor, select the MIDI points in regions you want to make 
constant/linear.

NOTE

You can only make MIDI points in regions constant/linear.

2. Do one of the following:

● To make the selected points constant, click Convert to Constant Point  in the editor 
header.

● To make the selected points linear, click Convert to Linear Point  in the editor header.
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RESULT
The selected MIDI points become constant or linear.

Value lines always appear horizontal after constant points. Value lines appear angled after linear 
points if the next point has a different value, indicating a smooth transition between the points.

EXAMPLE

Constant points in the MIDI CC editor Linear points in the MIDI CC editor

Moving MIDI points
You can move individual MIDI points in the MIDI CC and MIDI Pitch Bend editors, including 
moving them upwards and downwards to change their values.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. In the MIDI CC or Pitch Bend editor, select the MIDI points you want to move.

NOTE

You can only move MIDI points in a single editor at a time.

2. Move the selected MIDI points in any of the following ways:

● Click and drag them in any direction.

● To move them upwards/downwards only, hold Shift  while dragging them upwards/
downwards.

● To move them to the right/left only, hold Shift  while dragging them to the right/left.

TIP

You can also move MIDI points according to the current rhythmic grid resolution, as 
indicated in the status bar, by pressing Alt/Opt-Right Arrow / Alt/Opt-Left Arrow .
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Copying MIDI points to other instruments
When multiple instruments are shown in the Key Editor, you can copy MIDI points from the 
primary instrument to secondary instruments. You can copy only individual points and regions, 
or all points belonging to the primary instrument in the selected flow.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

● Multiple instruments are shown in the Key Editor.

PROCEDURE

1. Optional: If you want to sync individual MIDI points or regions only, click Sync Region  in 
the Key Editor panel toolbar to select Sync Region.

2. In the MIDI CC or MIDI Pitch Bend editor, do one of the following:

● To copy individual MIDI points or regions, click each MIDI point and region, or click and 
drag across multiple MIDI points and regions.

● To copy all MIDI points in the current flow, click Sync  in the editor header.

RESULT
The corresponding MIDI points are copied from the primary instrument to secondary 
instruments, and become editable for all instruments shown in the Key Editor.

Existing MIDI points in the affected regions belonging to secondary instruments are overwritten.

TIP

When multiple instruments are shown in the Key Editor, you can input MIDI points for all 
instruments directly.

EXAMPLE

MIDI region in primary instrument only MIDI region copied to secondary instruments

RELATED LINKS
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
Selecting items in the Key Editor on page 781
Copying and pasting points in the Key Editor on page 782
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Tempo editor
The Tempo editor allows you to view, input, and edit tempo changes. It is located in the Key 
Editor in the lower zone.

You can show the Tempo editor in any of the following ways:

● Add an editor to the Key Editor, then select Tempo from the editor menu.

● When the Key Editor is unlocked, select either a tempo mark or the Tempo track in Play 
mode.

NOTE

This shows the Tempo editor as the primary editor. To return to showing the piano roll/
percussion editor and/or other editors in the Key Editor, you must select a note/item 
belonging to an instrument in the music area.

The Tempo editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Range max. value field: Allows you to set the maximum metronome mark value in the 
editor.

● Tempo value field: Displays the metronome mark value of the earliest selected tempo 
point, without decimal places. You can change this value in the value field, or click and 
drag the point upwards/downwards in the editor.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Tempo point

An immediate change in tempo, input either in Write mode or using the Draw tool in the 
Tempo editor. Absolute tempo changes comprise a single constant point.

TIP

Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, showing 
the metronome mark value of the mouse pointer position.

4 Tempo mark text

Shows the text of tempo marks input in Write mode; that is, tempo points that correspond to 
notation items.

5 Tempo region

A highlighted region with a linear point at the start and a constant point at the end, input by 
clicking and dragging in a single motion in the Tempo editor with the Line tool.
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Tempo regions can also represent gradual tempo changes input in Write mode, such as 
rallentando.

Tempo points input in the Tempo editor appear as signposts in the music. Signposts are not 
printed by default, so if you want tempo points to appear in layouts as tempo marks, we 
recommend that you show them.

All tempo points input in the Tempo editor are included when exporting MIDI files.

RELATED LINKS
Key Editor panel on page 773
Tempo track on page 625
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
Tempo marks on page 1587
Input methods for tempo marks on page 294

Inputting tempo changes in the Tempo editor
You can input single tempo changes and tempo regions in the Tempo editor. Tempo changes 
input in the Tempo editor do not appear in layouts, but instead are shown as signposts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the type of tempo change you want to input:

● To input single absolute tempo changes, or multiple absolute tempo changes at regular 
intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the Key Editor 
panel toolbar.

● To input tempo regions, select Line by clicking Line  in the Key Editor panel toolbar.

2. Input tempo changes in one of the following ways:

● To input single absolute tempo changes, click in the Tempo editor at each position 
where you want a tempo change.

● To input multiple absolute tempo changes at regular intervals, click and drag in the 
Tempo editor.

● To input tempo regions, click and drag in the Tempo editor from where you want the 
region to start, to where you want it to end.

TIP

Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, showing 
the metronome mark value of the mouse pointer position.

RESULT

● If you used the Draw tool and clicked multiple times, separate tempo changes are input at 
each position you clicked.
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● If you clicked and dragged in a single motion using the Draw tool, tempo changes are input 
at 32nd note intervals.

● If you used the Line tool, two tempo changes are input in a tempo region, one at each end 
of the dragged range.

This affects the speed of playback, but the tempo changes are not shown in layouts. Instead, 
they appear as signposts.

Tempo changes input in the Tempo editor are included when exporting MIDI files.

RELATED LINKS
Key Editor panel toolbar on page 775
Signposts on page 453
Hiding/Showing tempo marks on page 1595

Moving tempo changes in the Tempo editor
You can move tempo changes to new rhythmic positions in the Tempo editor. This affects their 
rhythmic position in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. In the Tempo editor, select the tempo changes you want to move.

2. To move the selected tempo changes without changing their metronome mark value, hold 
Shift  while dragging them to the right/left.

NOTE

You cannot drag tempo regions and single tempo changes input in Write mode beyond 
other existing tempo changes during the same move. Releasing the mouse causes the 
moved tempo change to change the value of the existing tempo change.

RESULT
The selected tempo changes are moved rhythmically. When you move multiple selected absolute 
tempo changes, they maintain their positions relative to each other. This also affects their 
rhythmic positions in any layouts in which they appear.

AFTER COMPLETING THIS TASK
You can also move tempo changes vertically, which changes their metronome mark value.

Changing the tempo in the Tempo editor
You can change the metronome mark value of individual tempo changes in the Tempo editor, 
expressed in beats per minute.

PREREQUISITE

● The lower zone is shown.
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● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. In the Tempo editor, select the tempo changes whose metronome mark values you want to 
change.

2. To change the metronome mark values of the selected tempo changes without moving them 
rhythmically, hold Shift  while dragging them upwards/downwards.

Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, showing 
the metronome mark value of the mouse pointer position.

RESULT
The metronome mark values of the selected tempo changes are changed proportionally. This 
affects the speed of playback, and the displayed metronome mark of any tempo changes also 
shown in layouts.

TIP

You can also change the metronome mark value of selected tempo changes using the Tempo 
value field in the Tempo editor header.

RELATED LINKS
Selecting items in the Key Editor on page 781
Hiding/Showing decimal places for metronome marks on page 1599

Histogram tool
The Histogram tool displays velocity and MIDI CC values as a chart, with values grouped 
according to their frequency distribution. It allows you to change values on a large scale, 
including across entire tracks; for example, increasing all velocity values proportionally.

● You can show the Histogram tool in the Velocity and MIDI CC editors by clicking Histogram 
 in the corresponding editor header.

1 Chart shape

Allows you to change the shape of the Histogram chart.

● Bars : Values are displayed as bars.

● Area : Values are displayed as an area.

2 Histogram filter
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Allows you to filter the values shown in the Histogram tool.

● All/All notes: Shows all values for all instruments currently shown in the Key Editor.

● Voice: Shows only notes in the selected voice. Only available in the Velocity editor.

● Selection: Shows only values for selected items.

3 Histogram chart

Shows values according to the selected filter. The X axis represents numerical values, while 
the Y axis represents the frequency distribution of the corresponding values.

4 Histogram controls

Allow you to change the values currently in view.

5 Reset

Resets all values currently in view.

TIP

If you want to change values on a smaller scale, you can use the Transform tool.

RELATED LINKS
Key Editor panel on page 773
Hiding/Showing zones on page 47
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
Changing the velocity of notes on page 797
Voices on page 1704
Inputting notes into multiple voices on page 231
Changing the voice of existing notes on page 477
Transform tool on page 817
Velocity editor on page 796
MIDI CC editor on page 805

Histogram controls
Histogram controls allow you to change velocity and MIDI CC values on a large scale, in different 
ways.

● You can access Histogram controls when the Histogram tool is shown in the Key Editor.

Delta

Represents the center point of values. Allows you to move all displayed values to the 
right/left. This maintains explicit gaps between values.

Scale

Proportionally scales values. This maintains proportional relationships between values; 
that is, gaps between values widen when you scale multiply to the right, and narrow 
when you scale multiply to the left.

Spread

Spreads out values to both the right and left of the center point.
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Lower Limit

Represents the lowest value. Allows you to raise low values.

Upper Limit

Represents the highest value. Allows you to lower high values.

Randomize

Allows you to randomize values by clicking on the button and dragging upwards/
downwards. The higher your mouse pointer, the wider and more extreme the 
randomization. Randomization uses standard distribution on an approximate bell-
shape.

Changing values using the Histogram tool
You can use the Histogram tool to change velocity and MIDI CC values on a large scale, including 
across entire tracks; for example, increasing all velocity values proportionally.

TIP

If you want to change values on a smaller scale, you can use the Transform tool.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. Optional: Choose the appropriate Histogram tool filter for each editor.

3. Use the available Histogram controls as required.

For example, you can click and drag Scale  to the right to increase the values currently in 
view proportionally.

Changing the Histogram tool filter
You can change the values shown in, and therefore affected by, the Histogram tool using the 
available filters. For example, if you only want the Histogram tool to affect values you have 
already selected.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.
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● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. At the top of each Histogram tool, choose one of the following filters:

● All (MIDI CC editor) or All notes (Velocity editor)

● Voice (Velocity editor only)

● Selection

Changing the Histogram chart shape
You can switch between showing values in the Histogram tool as bars or as an area.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. At the top of each Histogram tool, choose one of the following chart shapes:

● Bars 

● Area 

RESULT
The shape of the Histogram chart in each editor is changed.

EXAMPLE

Bars Area

RELATED LINKS
Hiding/Showing zones on page 47
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777
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Transform tool
The Transform tool allows you to change consecutive velocity and MIDI CC values within 
a selected range in a variety of ways. For example, you can increase all velocity values 
proportionally, but only in two specific bars.

● You can use the Transform tool in the Velocity and MIDI CC editors by clicking Transform 
in the Key Editor panel toolbar, then clicking and dragging in one of those editors to make a 
Transform selection.

Transform selection in the Velocity editor

TIP

If you want to change values on a larger scale, you can use the Histogram tool.

RELATED LINKS
Key Editor panel on page 773
Key Editor panel toolbar on page 775
Histogram tool on page 813
Velocity editor on page 796
MIDI CC editor on page 805

Transform controls
Transform controls allow you to change consecutive velocity and MIDI CC values within a 
Transform selection in different ways.

● You can access Transform controls when you have made a Transform selection in the Key 
Editor.

Tilt Left

Allows you to lower values according to an angled line by clicking on the button and 
dragging downwards. This lowers values on the left more than on the right.

Tilt Right

Allows you to lower values according to an angled line by clicking on the button and 
dragging downwards. This lowers values on the right more than on the left.

Delta

Represents the center point of values. Allows you to move all displayed values to 
upwards/downwards. This maintains explicit value gaps between bars.

Scale
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Proportionally moves values upwards/downwards. This maintains proportional 
relationships between bars; that is, gaps between bars widen when you scale multiply 
upwards and narrow when you scale multiply downwards.

Randomize

Allows you to randomize values by clicking on the button and dragging upwards. 
The higher your mouse pointer, the wider and more extreme the randomization. 
Randomization uses standard distribution on an approximate bell-shape.

RELATED LINKS
Histogram controls on page 814
Changing the velocity of notes on page 797

Changing values using the Transform tool
You can make Transform selections around consecutive velocity and MIDI CC values, then use 
Transform controls to change the selected values in a variety of ways; for example, increasing all 
values proportionally.

TIP

If you want to change values on a larger scale, you can use the Histogram tool.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the Key Editor panel toolbar, click Transform  to select the Transform tool.

2. In the editor in which you want to change values, click and drag across the required range.

3. Use the available Transform controls as required.

For example, you can click and drag Scale  upwards to increase values proportionally.

RELATED LINKS
Hiding/Showing zones on page 47
Key Editor panel toolbar on page 775
Adding/Closing editors in the Key Editor on page 781
Showing instruments in the Key Editor on page 777

Key Editor configurations
Key Editor configurations allow you to open specific combinations of editors simultaneously. This 
can be much quicker than adding/closing the required editors manually.

For example, if you regularly switch between showing the Velocity and Dynamics editors, and 
several MIDI CC editors, you can save Key Editor configurations for these combinations, then 
apply each configuration as required.
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Saving Key Editor configurations
You can save configurations of editors in the Key Editor; for example, if you regularly use the 
Velocity and Dynamics editors together. You can access Key Editor configurations in all projects 
on your computer.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added the editors you want to save in your Key Editor configuration.

PROCEDURE

1. Save the editors currently open in the Key Editor as a Key Editor configuration in one of the 
following ways:

● To save a new Key Editor configuration, click Presets  at the bottom left of the Key 
Editor, then choose Save Configuration.

● To replace an existing Key Editor configuration, click Presets  at the bottom left of the 
Key Editor, choose Replace Configuration, then select the configuration you want to 
replace.

2. If you saved a new Key Editor configuration, enter a name for the configuration in the 
Configuration Name dialog that opens.

3. Click OK to save your changes and close the dialog.

RELATED LINKS
Hiding/Showing zones on page 47
Adding/Closing editors in the Key Editor on page 781

Applying Key Editor configurations
You can apply Key Editor configurations to projects, which adds the editors saved in that 
configuration to the Key Editor and replaces any editors that were already open.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have saved at least one Key Editor configuration on your computer.

PROCEDURE

1. At the bottom left of the Key Editor, click Presets .

2. Select the configuration you want to apply.

Deleting Key Editor configurations
You can delete Key Editor configurations; for example, if you no longer require a specific 
configuration after finishing a project.

PREREQUISITE

● The lower zone is shown.

Key Editor
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● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

1. At the bottom left of the Key Editor, click Presets .

2. Choose Delete Configuration.

3. Select the configuration you want to delete.

Key Editor
Key Editor configurations 
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Mixer

The Mixer allows you to control the volume, panning, and sounds of channels in playback.

You can access the Mixer in the following places:

● In the Mixer panel in the lower zone

● In the Mixer window

RELATED LINKS
Mixer window on page 822
Mixer channels on page 823
Zones and panels on page 40

Mixer panel
The Mixer panel allows you to control the volume and panning of channels in playback. It is 
located in the lower zone at the bottom of the window in Write, Engrave, and Play modes.

When additional channels are available beyond those currently in view, channels at the right/left 
edges of the Mixer appear faded.

● You can show the Mixer panel by showing the lower zone, then clicking Mixer  in the lower 
zone toolbar.

The Mixer panel toolbar contains the following options:

Channel type buttons
Allow you to hide/show channels according to their type, and in any combination.

Deactivate all
Allows you to deactivate all mute  and solo  states by clicking the corresponding 
button. Indicates whether any channels have an active mute or solo state.

Resize Lower Zone

Allows you to change the height of the lower zone.

RELATED LINKS
Mixer channels on page 823
Zones and panels on page 40
Hiding/Showing zones on page 47
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Mixer window
The Mixer allows you to control the volume, panning, and sounds of channels in playback. It 
provides access to channel strips, which are not available in the Mixer panel.

You can hide/show the Mixer window in any of the following ways:

● Press F3 .

● In the toolbar, click Show Mixer .

The Mixer window comprises the following:

1 Channel type buttons

Allow you to hide/show channels according to their type, and in any combination.

2 Deactivate all

Allows you to deactivate all mute  and solo  states by clicking the corresponding button. 
Indicates whether any channels have an active mute or solo state.

3 Channel strips

Allow you to change the sound of the channel; for example, by loading inserts or changing 
its equalization.

4 Channels

Allow you to change the volume and pan position of the corresponding track or aspect of 
playback. There are audio and MIDI channels for each instrument/voice track, and additional 
channels, such as for the click and master output.

TIP

● In order to control the volume levels in your project, we recommend that you first input 
dynamics and adjust the dynamic curve to suit your project before using the track faders.

● When additional channels are available beyond those currently in view, channels at the right/
left edges of the Mixer appear faded.

Any changes you make in the Mixer window are automatically saved and applied to the project.

RELATED LINKS
Toolbar on page 33
Mixer channel strips on page 825
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Muting/Soloing tracks on page 638
Changing the volume of channels on page 827

Hiding/Showing the Mixer window
You can hide and show the Mixer window at any time; for example, if you do not want it in view 
when working on the music in the music area.

PROCEDURE

● Hide/Show the Mixer window in any of the following ways:

● Press F3 .

● In the toolbar, click Show Mixer .

● Choose Window > Mixer.

Mixer channels
Mixer channels allow the source connected to them, such as instrument tracks, to produce 
sound. You can access all channels in the Mixer panel and Mixer window, and individual channels 
in the Track Inspector for the corresponding track.

Each channel in the Mixer panel provides the following controls and displays:

1 Pan control

Allows you to position the sound/MIDI output of the channel on the stereo spectrum for 
stereo playback.

2 Fader value

Displays the current volume as a value, corresponding to the position of the fader.

● Audio channels use dB.

● MIDI channels use MIDI volume, from 0 to 127.

3 Fader

Allows you to control the volume level of the channel.

Mixer
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4 Channel meter

Indicates the output volume of the channel in real time.

5 Mute

Allows you to mute the channel. Indicates whether the channel has an active mute state.

6 Solo

Allows you to solo the channel. Indicates whether the channel has an active solo state.

7 Channel name

Displays the name of the channel.

Instrument channels display the full instrument name set for that instrument in the Edit 
Instrument Names dialog and its instrument number, if applicable.

RELATED LINKS
Track Inspector on page 617
Edit Instrument Names dialog on page 185
Instrument numbering on page 132

Types of Mixer channels
There are different types of channels available in the Mixer. The channel type can affect the 
controls available for the corresponding channel.

Instruments
There is a channel for each instrument/voice track in your project. When instrument 
channels are shown, all applicable channels are included, even if they are spread 
across multiple plug-in instances.

There is an additional instrument channel named “DoricoBeep”, which allows you to 
control the volume of the metronome click.

MIDI
Every VST instrument in your project has its own MIDI channel in addition to its VST 
channel. These MIDI channels allow you to change the MIDI volume and MIDI pan of 
each instrument.

Video
Allows you to control the volume of video audio.

FX
Allows you to control the volume of send effects, such as reverb. By default, this 
channel has REVerence loaded automatically.

TIP

For more information about REVerence, see the separate document Plug-in 
Reference.

Output
Allows you to control the master output volume. The Output channel is always shown.

Mixer
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Mixer channel strips
Each channel in the Mixer has its own channel strip, which contains the channel controls. 
Channel strips are located at the top of the Mixer window.

Each channel strip contains the following types of controls:

Inserts

Each channel has four slots into which you can load an insert. You can select inserts 
from the menu.

The header allows you to expand/collapse the section for all channels.

The indicator can have one of the following states:

● Disabled : No inserts are loaded into the channel.

● Enabled : At least one insert is loaded into the channel, and inserts are enabled.

● Bypassed : At least one insert is loaded into the channel, and all inserts are 
bypassed.

The following controls are available for slots with loaded inserts:

● Enable Insert : Enables/Bypasses the insert slot.

● Edit Insert : Opens the plug-in window for the loaded plug-in, which allows you 
to edit its settings.

● Insert menu : Opens the plug-in menu, which allows you to select a different 
plug-in to load into the insert slot.

TIP

● For more information about the plug-ins included with Dorico Pro, see the 
separate document Plug-in Reference.

● You can access inserts for individual channels in the Track Inspector for the 
corresponding track.

EQ

Each channel has four bands for default EQ.

Mixer
Mixer channels 

825
Dorico Pro 4.3.30



The indicator allows you to enable  and disable  the section. The header allows you 
to expand/collapse the section for all channels.

The following controls are available for each EQ band:

● Enable EQ : Enables/Bypasses the corresponding band.

● Gain: Sets the amount of attenuation/boost for the corresponding band in dB.

● Frequency: Sets the frequency of the corresponding band in Hz.

● Q: Controls the width of the band; that is, how many frequencies above/below it 
also affects, and by how much.

FX

Each channel has a single FX slot. By default, it sends to the FX channel, which has 
reverb loaded on it.

The indicator allows you to enable  and disable  the section. The header allows you 
to expand/collapse the section for all channels.

RELATED LINKS
Loading inserts into channels on page 829
Track Inspector on page 617

Hiding/Showing channels
You can hide/show channels in the Mixer according to their type; for example, you can hide MIDI 
channels while working on instrument channels.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● At the top of the Mixer, activate/deactivate each channel type.

RESULT
Channels are shown in the Mixer when their type button is activated, and hidden when it is 
deactivated.

Scrolling through channels
When many channels are shown in the Mixer, you can scroll through them in order to view 
channels that do not fit in the view.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, scroll through channels in any of the following ways:

Mixer
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● Scroll upwards/downwards on a mouse wheel, or swipe upwards/downwards on a 
touchpad.

● Click and drag, anywhere outside of channel faders, to the right/left.

Changing the height of channels
You can change the vertical space occupied by channels and channel strips in the Mixer window; 
for example, to make channel strips taller when loading inserts or changing EQ settings.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

● In the Mixer, on the line between channel strips and channels, click and drag upwards/
downwards.

When the mouse pointer is in the correct position, it appears as a split arrow.

Changing the volume of channels
You can change and reset the volume of individual channels in the Mixer; for example, to balance 
instruments in an orchestral project.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, change the volume of channels in any of the following ways:

● To increase their volume, drag their faders upwards.

● To decrease their volume, drag their faders downwards.

● To reset their volume to the default value, Ctrl/Cmd -click or double-click their fader 
values.

Mixer
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RESULT
The volume of the corresponding channels is changed.

TIP

You can change the default output level for all future projects on the Play page in Preferences. 
By default, this is set to -6 dB to avoid clipping in projects with large ensembles.

RELATED LINKS
Mixer panel on page 821
Mixer window on page 822
Preferences dialog on page 61

Panning channels
You can change the pan position of individual channels on the stereo spectrum; for example, if 
you want the pan positions of instruments in an orchestral project to match their positions on a 
real-life stage.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, click at the required position in the pan control at the top of each channel.

You can also click and drag to the right/left in the pan control.

Mixer
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Loading inserts into channels
You can load up to four inserts into each channel, excluding MIDI channels. For example, you can 
load specific EQ plug-ins instead of using the default EQ channel strips, and apply amp modeling 
plug-ins to clean guitar channels.

TIP

For more information about the plug-ins included with Dorico Pro, see the separate document 
Plug-in Reference.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. Click an insert slot and select the plug-in you want to load from the menu.

3. Optional: If you want to edit settings for the new plug-in, click Edit Insert  to open its 
plug-in window.

4. Optional: If you loaded EQ plug-ins, deactivate the EQ channel strip in the corresponding 
channels.

RELATED LINKS
Mixer window on page 822
Mixer channel strips on page 825
Changing the sound used for the click on page 625

Enabling/Bypassing inserts
You can enable/bypass individual inserts without affecting their settings; for example, if you want 
to compare how a channel sounds with and without a specific insert.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In each insert slot you want to enable/bypass, do one of the following:

● To enable/bypass individual inserts, click Enable Insert  in the corresponding slots.

● To enable/bypass all inserts for channels, click the Inserts indicator  in the 
corresponding channel strips.

Mixer
Loading inserts into channels 

829
Dorico Pro 4.3.30



RESULT
The corresponding inserts are enabled/bypassed.

● Enabled inserts appear blue.

● Bypassed inserts appear yellow.

Removing inserts
You can remove individual inserts you have loaded into channels.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In the slot whose insert you want to remove, click the insert menu  and select --- from the 
menu.

Changing the reverb plug-in
You can change the plug-in used for reverb on the FX channel; for example, if you want to use a 
specific reverb sound. By default, the reverb plug-in REVerence is loaded into the FX channel.

TIP

For more information about the plug-ins included with Dorico Pro, see the separate document 
Plug-in Reference.

PREREQUISITE

● The Mixer window is shown.

● The FX channel is shown.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In the FX channel strip, click the insert menu  in the REVerence insert slot, and select the 
reverb plug-in you want to use from the menu.

3. Optional: If you want to edit settings for the new plug-in, click Edit Insert  to open its 
plug-in window.

RELATED LINKS
Mixer window on page 822
Mixer channel strips on page 825
Hiding/Showing channels on page 826
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Library

In Dorico Pro, the library is the total compilation of visual items and options that are available 
in all projects on your computer. It combines factory default settings, custom items/options you 
have saved as default, and items/options only available in the current project.

Library Manager
The Library Manager gives you an overview of all visual items and options in the current project, 
and allows you to compare these against another project, your user library, or Dorico’s factory 
library. You can import visual items and options from any of these locations into the current 
project, from all options down to individual options.

● You can open the Library Manager by choosing Library > Library Manager.

The Library Manager comprises the following:

1 Options list

Contains all the available options categories.

2 Collections list

Contains all the available collections categories.

3 This project

Displays the file name and location of the current project.

● When comparing Notation Options, you can select individual flows.

● When comparing Layout Options, you can select individual layouts.
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4 Compare to

Allows you to select the source library against which you want to compare the current 
project.

● When comparing Notation Options, you can select individual flows.

● When comparing Layout Options, you can select individual layouts.

TIP

We recommend comparing similar layouts with each other, such as two full score 
layouts.

You can select one of the following library sources:

● Factory settings: Dorico’s default settings.

● User library: The factory library plus any custom items or options you have saved as 
default.

● Dorico project: The settings inside an individual project.

When Dorico project is chosen, you can open a Dorico project in any of the following ways:

● Click  to open the File Explorer/macOS Finder.

● Drag an external file into the Drop .dorico project file here area, then release the 
mouse.

5 Show

Allows you to filter options in the selected category according to their status.

● All: Shows all options.

● Differences: Shows only options whose settings are different in the source library.

● Not in this project: Shows only items that exist in the source library but not in the 
current project. Only available when comparing collections categories.

6 Search field

Allows you to filter options in the selected category according to your entry.

7 Options comparison

Allows you to compare options in the selected category for the current project against the 
source library. Font styles and paragraph styles show a font preview.

You can expand/collapse each section by clicking its header.

Each library level displays one of the following statuses:

● All options match : All options are the same in both the current project and source library.

● Some options differ : Some or all options are different in the current project compared to 
the source library.

Options that differ appear red with  icons. When the mouse pointer hovers over them, they 
appear as . You can click  icons to import options from the source library into the current 
project.

Imported options appear green with  icons. When the mouse pointer hovers over them, they 
appear as . You can click  icons to undo importing options and revert them to their original 
state.

You can import/revert options at the following library levels:

● At the top of the Options/Collections lists for all options in all categories in each list

Library
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● In the Options/Collections lists for all options in the corresponding category

● In section headers in the options comparison for all options in the section

● In the options comparison for individual options

NOTE

● When comparing two Dorico projects, only custom items and items used in the selected 
projects appear in collections.

● When you import items into the current project, Dorico Pro also imports any items they 
depend on. For example, if you import a playing technique that uses a font style not 
available in your current project, both the playing technique and font style are imported.

If dependent items exist in the current project but have different settings, the dependent 
items in the source library are imported as independent items. They do not overwrite items 
in the current project.

RELATED LINKS
File import and export on page 82
Project templates on page 80
Options dialogs in Dorico Pro on page 30

Importing libraries
You can import visual items and options from a source library into the current project, from all 
options in the source library down to individual options; for example, to reuse a specific project’s 
settings in a new project. The source library can be another project, a .doricolib file, your user 
library, or Dorico’s factory library.

PROCEDURE

1. Choose Library > Library Manager to open the Library Manager.

2. In the Compare to section, choose the source library that you want to import.

● To import Dorico’s default settings, choose Factory settings.

● To import your own default settings, choose User library.

● To import settings from another project or a .doricolib file, choose Dorico project to 
open the File Explorer/macOS Finder, locate and select the project or .doricolib file 
whose settings you want to import, then click Open.

TIP

You can also drag files from the File Explorer/macOS Finder and drop them into the 
Compare to section.

3. Import options from the selected source library as required.

● To import all options in all categories, click  at the top of the Options/Collections lists.

● To import all options in individual categories, click  for the corresponding categories.

● To import all options in individual sections of categories, click  in the corresponding 
section header in the options comparison.

● To import individual options, click  for the corresponding options.

4. Click Apply, then Close.
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RESULT
Visual items and options with  icons are imported and applied to the current project.

Exporting libraries
You can export all visual items and options in the current project as a .doricolib file. You can 
then import the .doricolib file into other projects and share it with other users.

PROCEDURE

1. Choose Library > Export Library to open the File Explorer/macOS Finder.

2. Specify a name and location for the library file.

3. Click Save.

RESULT
All visual items and options in the current project are exported and saved in the selected location 
as a .doricolib file.

● Notation Options settings come from the first flow in the project.

● Layout Options settings for full score and part layouts come from the highest layout of the 
corresponding type in the Layouts panel in Setup mode.

AFTER COMPLETING THIS TASK
You can import the .doricolib file into another project using the Library Manager.

RELATED LINKS
Library Manager on page 831
Project templates on page 80

Layout Options dialog
The Layout Options dialog allows you to change various aspects of each layout independently. 
For example, you can change the physical properties of the layout, such as page size, staff size, 
or margins, and how the music appears and is laid out, such as note spacing or staff labels.

Options in Layout Options affect only the selected layouts but apply to all flows in those layouts.

You can open Layout Options in any of the following ways:

● Press Ctrl/Cmd-Shift-L .

● Choose Library > Layout Options.

● In Setup mode, click Layout Options  in the Layouts panel.
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The Layout Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .
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● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Layouts list

Contains all the layouts in your project. By default, the layout currently open in the music 
area is selected when you open the dialog. You can select multiple layouts in any of the 
following ways:

● Click one of the selection options in the action bar.

● Ctrl/Cmd -click to select multiple layouts.

● Shift -click to select multiple adjacent layouts.

● Click and drag across multiple layouts.

7 Action bar

Contains selection options that allow you to select layouts in the Layouts list according to 
their type.

● Select All: Selects all layouts, regardless of their type.

● Select All Full Score Layouts : Selects all full score layouts only.

● Select All Part Layouts : Selects all part layouts only.

● Select All Custom Score Layouts : Selects all custom score layouts only.

8 Save as Default

Saves all options currently set and applied in the dialog as the default for the selected layout 
type in new projects. For example, you can save new default settings for part layouts without 
affecting the default settings for full score layouts. Only available when a single layout is 
selected.

9 Reset to Saved Defaults

Resets all the options in the dialog for the selected layouts back to your saved defaults, 
according to their layout type.

10 Reset to Factory

Resets all the options in the dialog for the selected layouts back to the default factory 
settings, according to their layout type. This only affects the current project and does not 
delete your saved defaults, meaning future projects still start with your saved defaults.

11 Remove Saved Defaults

Deletes your previous saved defaults for the selected layout type without resetting the 
options in the current project. After removing your saved defaults, all layouts of the selected 
type in future projects start with the default factory settings.

RELATED LINKS
Options dialogs in Dorico Pro on page 30
Layouts on page 169
Staves on page 1549
Page formatting on page 689
Condensing on page 743
Changing your preferred unit of measurement on page 54
Changing values in numeric value fields on page 772
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Notation Options dialog
The Notation Options dialog allows you to change how music is notated by default in each 
flow independently. For example, there are options for beam, note, and rest grouping, voices, 
accidentals, barlines, and condensing.

Options in Notation Options affect only the selected flows but apply to all layouts in which those 
flows appear.

TIP

If you want to change notes and notations individually, you can use properties in the Properties 
panel.

You can open Notation Options in any of the following ways:

● Press Ctrl/Cmd-Shift-N .

● Choose Library > Notation Options.

● In Setup mode, click Notation Options  in the Flows panel.

The Notation Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles
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Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Flows list

Contains all the flows in your project. By default, the flow in which you have selected an item 
in the music area or that is selected in the Flows panel in Setup mode is selected when you 
open the dialog. You can select multiple flows in any of the following ways:

● Click Select All in the action bar to select all flows in the project.

● Ctrl/Cmd -click to select multiple flows.

● Shift -click to select multiple adjacent flows.

● Click and drag across multiple flows.

7 Save as Default

Saves all options currently set and applied in the dialog as the default for new projects. Only 
available when a single flow is selected.

8 Reset to Saved Defaults

Resets all the options in the dialog for the selected flows back to your saved defaults.

9 Reset to Factory

Resets all the options in the dialog for the selected flows back to the default factory settings. 
This only affects the current project and does not delete your saved defaults, meaning future 
projects still start with your saved defaults.

10 Remove Saved Defaults

Deletes your previous saved defaults without resetting the options in the current project. 
After removing your saved defaults, all future projects start with the default factory settings.

RELATED LINKS
Flows on page 166
Options dialogs in Dorico Pro on page 30
Changing your preferred unit of measurement on page 54
Changing values in numeric value fields on page 772
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Note Input Options dialog
The Note Input Options dialog provides multiple options that allow you to determine how 
Dorico Pro interprets the data and MIDI you input by default.

For example, there are options relating to how accidentals and notes are spelled when inputting 
notes using a MIDI keyboard, what you want to include in chord symbols based on what you 
play, and how to consider multiple different aspects of chord diagrams, such as whether or not 
to omit the ninth in 11 and 13 chords.

You can open Note Input Options in any of the following ways:

● Press Ctrl/Cmd-Shift-I  in any mode.

● Choose Library > Note Input Options.

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, its options appear as a page in the main body of the dialog.

3 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

4 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .
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The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

5 Save as Default

Saves all options currently set and applied in the dialog as the default for new projects.

6 Reset to Saved Defaults

Resets all the options in the dialog back to your saved defaults.

7 Reset to Factory

Resets all the options in the dialog back to the default factory settings. This only affects the 
current project and does not delete your saved defaults, meaning future projects still start 
with your saved defaults.

8 Remove Saved Defaults

Deletes your previous saved defaults without resetting the options in the current project. 
After removing your saved defaults, all future projects start with the default factory settings.

RELATED LINKS
Options dialogs in Dorico Pro on page 30
Navigation during chord symbol input on page 325
Accidental selection during MIDI input on page 245
Insert mode scopes on page 455
Musical transformations on page 488
Changing your preferred unit of measurement on page 54
Changing values in numeric value fields on page 772

Engraving Options dialog
The Engraving Options dialog allows you to change the default graphical appearance and 
position of items project-wide, in all flows and layouts. For example, you can change the line 
thickness of notation items, their continuation style, their default staff-relative placement, and 
their minimum distance from the staff and other items.

TIP

If you want to make changes to individual notes and notations, you can use properties in the 
Properties panel.

You can open Engraving Options in any of the following ways:

● Press Ctrl/Cmd-Shift-E .

● Choose Library > Engraving Options.
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The Engraving Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .
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● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Save as Default

Saves all options currently set and applied in the dialog as the default for new projects.

7 Reset to Saved Defaults

Resets all the options in the dialog back to your saved defaults.

8 Reset to Factory

Resets all the options in the dialog back to the default factory settings. This only affects the 
current project and does not delete your saved defaults, meaning future projects still start 
with your saved defaults.

9 Remove Saved Defaults

Deletes your previous saved defaults without resetting the options in the current project. 
After removing your saved defaults, all future projects start with the default factory settings.

RELATED LINKS
Options dialogs in Dorico Pro on page 30
Resetting the appearance of items on page 442
Resetting the position of items on page 443
Changing your preferred unit of measurement on page 54
Changing values in numeric value fields on page 772

Playback Options dialog
The Playback Options dialog allows you to change how the music you have written sounds 
when played back. These options affect playback regardless of expression maps and patches, 
such as how dynamics, pedal lines, and different notations are interpreted during playback.

For example, you can change how much louder notes on the first beat in each bar are compared 
to other notes in the bar, change how long each pedal retake lasts, and how much different 
articulations, such as staccatissimo and tenuto, affect the duration of notes.

You can open Playback Options in any of the following ways:

● Press Ctrl/Cmd-Shift-P .

● Choose Library > Playback Options.

Library
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The Playback Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .
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● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Save as Default

Saves all options currently set and applied in the dialog as the default for new projects.

7 Reset to Saved Defaults

Resets all the options in the dialog back to your saved defaults.

8 Reset to Factory

Resets all the options in the dialog back to the default factory settings. This only affects the 
current project and does not delete your saved defaults, meaning future projects still start 
with your saved defaults.

9 Remove Saved Defaults

Deletes your previous saved defaults without resetting the options in the current project. 
After removing your saved defaults, all future projects start with the default factory settings.

RELATED LINKS
Options dialogs in Dorico Pro on page 30
Expression maps on page 912
Changing your preferred unit of measurement on page 54
Changing values in numeric value fields on page 772

Music Fonts dialog
The Music Fonts dialog allows you to change the font used for notations and glyphs project-
wide. Any font you use for notations and glyphs must be SMuFL-compliant.

● You can open the Music Fonts dialog by choosing Library > Music Fonts.

The Music Fonts dialog contains all available SMuFL fonts you have installed on your computer 
that have the appropriate metadata for Dorico Pro to recognize them. By default, Dorico Pro 
comes with the following SMuFL-compliant fonts:

● Bravura: The default music font, inspired by traditional classical music engraving.

● Petaluma: Handwritten music font style, similar to the traditional style used for jazz music.
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Changing the music font used in the Music Fonts dialog changes the fonts used for notations, 
glyphs, and other items that are not text, such as clefs, dynamics, and bold tuplet numbers/
ratios.

TIP

You can change the fonts used for these items individually by changing the Default Text Font 
style in the Edit Font Styles dialog, and the Default Text paragraph style in the Paragraph 
Styles dialog.

The Music Fonts dialog also contains the following options:

Update text fonts when changing music fonts
Allows you to include/exclude text fonts when changing the music font. For example, 
deactivating this option allows you to change the appearance of notes and notations 
without affecting the appearance of flow titles and staff labels.

● For the Bravura music font, the equivalent text font is Academico.

● For the Petaluma music font, the equivalent text font is Petaluma Script.

Use font’s recommended engraving options
Allows you to import the default settings that come with the font.

NOTE

Certain items that are marked as optional in SMuFL fonts, such as clef changes and non-bold 
tuplet numbers/ratios, are not affected when you change the music font.

Text formatting
Dorico Pro combines different settings for the appearance of text, meaning that you can format 
fonts and texts in different places depending on their function.

● Font styles are used in notations that use text but are not generic text, such as tempo marks 
and dynamics.

● Paragraph styles apply to individual paragraphs in text frames or all text within a single text 
item. They are also used for text that appears in the music but is not a notation, such as bar 
numbers and staff labels. You can use paragraph styles to keep the presentation of different 
types of text consistent across your project.

● Character styles apply to individual letters or words, meaning you can apply different 
character styles to each word within the same text frame.

For example, you can change the font family used for all text notations in your project in the Edit 
Font Styles dialog and all other text in the Paragraph Styles dialog, where you can also make 
specific changes for when that font is used for titles.

If you open a project that contains fonts not installed on your computer, the Missing Fonts 
dialog opens and allows you to select replacement fonts as substitutes.

RELATED LINKS
Paragraph Styles dialog on page 848
Character Styles dialog on page 851
Text editor options in Engrave mode on page 584
Missing Fonts dialog on page 76
Types of text on page 1607
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Text items on page 1606
Text frames on page 575
Entering text in text frames on page 583
Changing the vertical alignment of text in text frames on page 587
Changing the horizontal alignment of text in text frames on page 588
Changing the default font family on page 853

Edit Font Styles dialog
The Edit Font Styles dialog allows you to edit the formatting of fonts used for items that you 
cannot edit using the text editor, such as changing the font size of playing techniques, dynamics, 
or tempo marks.

● You can open the Edit Font Styles dialog by choosing Library > Font Styles.

The Edit Font Styles dialog contains the following sections and options:

1 Search field

Allows you to filter font styles according to your entry.

TIP

If you cannot find a particular font style, it might instead be a paragraph style.

2 Font styles list

Contains all the font styles in the project. If you have previously opened the Edit Font Styles 
dialog in the same session, your previously selected font style is remembered.

The action bar at the bottom of the list contains the following options:

● New : Creates a new font style with default values.

● New from Selection : Creates a copy of an existing font style that you can edit 
separately from the original. The new font style uses the original as its parent by default.

● Save as Default : Saves the selected font style to your user library, allowing you to use 
it in multiple projects. Appears as  for font styles saved as default.
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● Revert to Factory : Removes all your changes to the selected font style, returning it to 
its saved settings.

● Delete : Deletes the selected font style.

NOTE

You cannot delete predefined font styles or any font style that is currently used in your 
project.

3 Name

Allows you to enter a name for new font styles or edit the name of existing font styles.

4 Parent

Allows you to choose a parent font style from which the selected font style inherits settings. 
Activated options override the parent style settings.

5 Font preview

Displays a preview of the selected font style using its current settings.

6 Font appearance options

Allow you to change the following parameters of the selected font style:

● Font family: Sets the overall font style.

● Size: Sets the size of the font. Allows you to choose whether the size of the font changes 
according to the staff size or whether it is always the set size. For example, items with 
staff-relative font sizes appear smaller on smaller staves.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top 
staff in each instrument family group affects the size of system objects if they are shown 
above that bracketed group. Font styles that are set to Absolute are unaffected by staff 
size.

● Style: Sets the style of the font, such as bold or italic.

● Underlined: Allows you to make the font style underlined.

7 Substitutes

Allows you to manage substitute font styles for music font styles. This can be useful when 
using music font styles that do not contain all glyphs in the SMuFL range.

The action bar at the bottom of the list contains the following options:

● Add Substitute : Adds a new substitute to the selected font style. You can change the 
substitute font style by double-clicking substitutes, then either entering the font style 
you want or clicking the arrow  and selecting a font style from the menu.

● Move Up : Moves the selected substitute up the substitutes list, which changes its 
substitution order.

● Move Down : Moves the selected substitute down the substitutes list, which changes 
its substitution order.

● Delete : Deletes the selected substitute.

NOTE

Changes made to font styles apply project-wide, including in part layouts.
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RELATED LINKS
Missing Fonts dialog on page 76
Changing the default font family on page 853
Types of text on page 1607
Staff size on page 716
System objects on page 1563
Brackets according to ensemble type on page 1026

Paragraph Styles dialog
The Paragraph Styles dialog allows you to change existing paragraph styles for text and create 
new styles. You can later apply paragraph styles to individual paragraphs in text frames or all text 
within a single text item by choosing them in the text editor.

For example, you can customize the paragraph style for layout names and then apply your layout 
name paragraph style to the layout name token in every applicable text frame. This allows you to 
keep the presentation of different types of text consistent across your project.

● You can open the Paragraph Styles dialog by choosing Library > Paragraph Styles.

The Paragraph Styles dialog contains the following sections and options:

1 Paragraph styles list

Contains all the paragraph styles in the project. If you had text items selected when you 
opened the dialog, the corresponding paragraph style of the first selected item is selected in 
the paragraph styles list by default.

TIP

If you cannot find a particular paragraph style, it might instead be a font style.
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The action bar at the bottom of the list contains the following options:

● New : Creates a new paragraph style with default values.

● New from Selection : Creates a copy of an existing paragraph style that you can edit 
separately from the original. The new paragraph style uses the original as its parent by 
default.

● Save as Default : Saves the selected paragraph style to your user library, allowing you 
to use it in multiple projects. Appears as  for paragraph styles saved as default.

● Revert to Factory : Removes all your changes to the selected paragraph style, 
returning it to its saved settings.

● Delete : Deletes the selected paragraph style.

NOTE

You cannot delete predefined paragraph styles or any paragraph style that is currently 
used in your project.

2 Name

Allows you to enter a name for new paragraph styles or edit the name of existing paragraph 
styles.

3 Parent

Allows you to choose a parent paragraph style from which the selected paragraph style 
inherits settings. Activated options override the parent style settings.

4 Font preview

Displays a preview of the selected paragraph style using its current settings.

5 Font appearance options

Allow you to change parameters of the appearance of the paragraph style font, such as 
changing the font, making the font bold, changing the size of the font, and changing the 
letter or word spacing. You can also make the font in paragraph styles appear underlined or 
overlined.

6 Border options

Allow you to show borders by default on text that uses the paragraph style and to change 
the border settings, such as border thickness and padding between the border and text.

NOTE

● When Border is deactivated, text items use the default border and padding values set 
on the Text page in Engraving Options.

● We recommend only using paragraph style borders for text frames that contain a single 
paragraph. If you want to show some paragraphs with borders but other paragraphs 
without borders, we recommend using separate text frames.

7 Paragraph layout options

Allow you to change the layout of the paragraph style, such as changing the first line indent, 
line spacing, and text alignment.

8 Color options

Allow you to change the foreground and background colors of the paragraph style.

RELATED LINKS
Text formatting on page 845
Types of text on page 1607
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Edit Font Styles dialog on page 846
Changing the default font family on page 853
Changing the vertical alignment of text in text frames on page 587
Missing Fonts dialog on page 76
Adding borders to text items on page 1614
Changing the style of text item borders on page 1615
Adding borders to text frames on page 585
Hiding/Showing borders on layout names on page 1192
Aligning text items with the start of systems on page 1612
Erasing the background of text items on page 1617
Engraving Options dialog on page 840
Staff size on page 716
System objects on page 1563

Creating paragraph styles
You can create new paragraph styles from scratch and you can duplicate existing paragraph 
styles and edit the settings; for example, to format text consistently in multiple text frames.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. Create a new paragraph style in one of the following ways:

● To create an entirely new paragraph style, click New  in the action bar.

● To create a copy of an existing paragraph style, select it in the paragraph styles list and 
click New from Selection  in the action bar.

3. Enter a name for the style in the Name field.

4. Optional: Select one of the available styles from the Parent menu.

NOTE

If you select a parent style, your paragraph style inherits its settings automatically for all 
options with deactivated sliders. If your paragraph style has activated sliders, which override 
its parent style settings, you can deactivate them to reset those options to follow the parent 
style.

5. Activate and change the options as required.

6. Optional: If you want the paragraph style to be available in all future projects you open on 
your computer, click Save as Default  in the paragraph styles list action bar.

7. Click OK to save your changes and close the dialog.

RESULT
The new paragraph style is created. If you clicked Save as Default  so that it appears as , the 
paragraph style is available in all future projects on your computer.

RELATED LINKS
Inputting text items on page 388
Entering text in text frames on page 583
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Changing the default horizontal alignment of text styles
You can change the default horizontal alignment of the paragraph styles used for different types 
of text. This changes the horizontal alignment of the corresponding text style project-wide.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. In the paragraph styles list, select the paragraph style whose default alignment you want to 
change.

3. Choose the Alignment option you want.

4. Optional: Repeat steps 2 and 3 for other paragraph styles whose horizontal alignment you 
want to change.

5. Click OK to save your changes and close the dialog.

RESULT
The default alignment of the selected text style is changed.

TIP

You can also override the horizontal alignment of text in individual text frames.

RELATED LINKS
Changing the horizontal alignment of text in text frames on page 588

Character Styles dialog
The Character Styles dialog allows you to change character styles and create new styles. You 
can later apply character styles to individual letters or words in different places in your project by 
choosing them in the text editor.

For example, you can create a custom character style with wide letter spacing for specific words 
and then apply that character style to selected words. Unlike paragraph styles, character styles 
do not have to apply to whole text items or paragraphs in text frames.

● You can open the Character Styles dialog by choosing Library > Character Styles.

The Character Styles dialog contains the following sections and options:
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1 Character styles list

Contains all the character styles in the project.

The action bar at the bottom of the list contains the following options:

● New : Creates a new character style with default settings.

● New from Selection : Creates a copy of an existing character style that you can edit 
separately from the original.

● Save as Default : Saves the selected character style to your user library, allowing you 
to use it in multiple projects. Appears as  for character styles saved as default.

● Revert to Factory : Removes all your changes to the selected character style, 
returning it to its saved settings.

● Delete : Deletes the selected character style.

NOTE

You cannot delete predefined character styles or any character style that is currently 
used in your project.

2 Name

Allows you to enter a name for new character styles or edit the name of existing paragraph 
styles.

3 Character style options

Allow you to change parameters of the character style, such as changing the font, making 
the font bold, changing the size of the font, and changing the letter or word spacing. You 
can also make the font in paragraph styles appear underlined or overlined, and change the 
vertical alignment of characters.

4 Color options

Allow you to change the foreground and background colors of the character style.

RELATED LINKS
Text formatting on page 845
Missing Fonts dialog on page 76
Types of text on page 1607
Insert Music Text dialog on page 391

Creating character styles
You can create new character styles from scratch and you can duplicate existing character styles 
and edit the settings.

PROCEDURE

1. Choose Library > Character Styles to open the Character Styles dialog.

2. Create a new character style in one of the following ways:

● To create an entirely new character style, click New  in the action bar.

● To create a copy of an existing character style, select it in the character styles list and 
click New From Selection  in the action bar.

3. Enter a name for the style in the Name field.

4. Activate and change the options as required.
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IMPORTANT

Only activated options have an effect on the text. If you deactivate options, their settings are 
reset.

5. Optional: If you want the character style to be available in all future projects you open on 
your computer, click Save as Default  in the character styles list action bar.

6. Click OK to save your changes and close the dialog.

RESULT
The new character style is created. If you clicked Save as Default  so that it appears as , the 
character style is available in all future projects on your computer.

RELATED LINKS
Inputting text items on page 388
Entering text in text frames on page 583

Changing the default font family
You can change the font family of the default font and paragraph styles, which affect all other 
font and paragraph styles in the project whose font family has not been overridden. For example, 
if you want all text and text-based notations, such as text playing techniques and gradual 
dynamics, to use your preferred font family.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select Default Text Font.

3. Select the font family you want from the Font family menu.

4. Click OK to save your changes and close the dialog.

5. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

6. In the paragraph styles list, select Default Text.

7. Select the font family you want from the Font menu.

8. Click OK to save your changes and close the dialog.

RESULT
The font family used in the selected default font and paragraph styles is changed. This also 
affects the font family used by all other font and paragraph styles in the project whose font 
family has not been overridden.

TIP

You can change the default font family used in all future projects on the General page in 
Preferences.

RELATED LINKS
Edit Font Styles dialog on page 846
Paragraph Styles dialog on page 848
Preferences dialog on page 61
Text items on page 1606
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Edit Chord Diagrams dialog
The Edit Chord Diagrams dialog allows you to design your own chord diagram shapes, either by 
creating a new blank one or by editing any of the available chord diagram shapes.

NOTE

When you edit an existing chord diagram, Dorico Pro saves a duplicate of it with your changes. 
The original chord diagram is always retained.

● You can open the Edit Chord Diagrams dialog by choosing Library > Chord Diagrams.

The Edit Chord Diagrams dialog contains the following options and sections:

1 Category menu

Allows you to select which shapes are available in the chord diagram shapes list by selecting 
the number of instrument strings required.

2 Search field

Allows you to filter chord diagrams according to your entry.

3 Chord diagram shapes list

Contains all the available chord diagram shapes within the currently selected category and 
your search filter, if applicable.

NOTE

Shapes appear in the chord diagram shapes list with the name of their simplest usage or 
their closest position to the nut. Movable chord diagram shapes that can produce many 
different chords only appear once. For example, replacing the open strings in the E, open 
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position shape with a barré and moving the shape up the neck can produce multiple major 
chords. Therefore, chords that use the same shape but at different fret positions, such as F, 
open position, do not appear in the list.

The action bar at the bottom of the list contains the following options:

● New : Adds a new blank chord diagram.

● Save as Default : Saves the selected chord diagram shape to your user library, 
allowing you to use it in multiple projects. Appears as  for chord diagram shapes saved 
as default.

● Delete : Deletes the selected chord diagram shape.

NOTE

You cannot delete predefined chord diagram shapes. You must click Delete twice to 
delete your own chord diagram shapes that you have saved as default.

4 Name

Displays the name of the chord whose chord diagram you are editing in the dialog. 
Optionally includes other relevant identifying information, such as “movable” or “open-g”. 
You cannot change the name of predefined chord diagrams and chord diagrams that you 
have saved as default.

5 Tuning

Displays the fretted instrument and tuning for the current chord diagram. You can select 
other tunings to see what chords the current shape produces in different tunings and on 
different instruments. If you have changed the tuning of fretted instruments in the project 
or imported custom tunings, they are available in this menu. The open and current string 
pitches in the editor update when you select other tunings.

6 Chord may be moved along the neck

Allows you to specify whether or not the shape of the chord diagram can be reused at other 
fret positions; for example, by playing open strings with a barré at higher fret positions.

Because it is not normally possible to reuse chord diagram shapes that have more than 
three stopped strings at other fret positions, Dorico Pro shows a warning icon  when this 
option is activated for chord symbols with four or more stopped strings.

7 Open string pitch

Displays the open pitch of the corresponding string according to the currently selected 
tuning for reference.

8 Current string pitch

Displays the current pitch of the corresponding string if it is open or stopped, according to 
the currently selected tuning. If the pitch of a string is not part of the chord, the string pitch 
appears red.

9 String status

Displays the current usage status of the corresponding string and allows you to switch the 
status of individual strings between open and omitted by clicking in this row.

● O: Open string

● X: Omitted string

● No symbol: Stopped string

10 Chord diagram shape editor
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Displays the current arrangement of stopped frets using dots and allows you to change the 
chord diagram shape. You can move stopped frets by clicking at the required positions. Each 
string can only have a single stopped fret position.

If two or more strings are stopped at the same fret, you can hide/show a barré by clicking 
any of the dots at that fret position.

You can change fingerings by double-clicking them and entering a new number, including 0 
to show no fingering or T for thumb fingerings on the lowest string.

11 Action bar

Contains options that allow you to edit and change the number of frets.

● Starting fret: Changes the fret number of the highest fret in the chord diagram.

● Starting fret number offset: Changes the offset of the starting fret number. For 
example, if you want the starting fret label to appear beside the second fret down the 
chord diagram in order to include a barré.

● Add fret : Adds a fret to the bottom of the chord diagram.

● Remove fret : Removes a fret from the bottom of the chord diagram.

● Reset Chord Diagram : Removes your changes to the chord diagram and resets it to 
its default shape.

12 OK

When you click OK, all your changes in the dialog are saved.

RELATED LINKS
Edit Strings and Tuning dialog on page 142
Changing the open pitches of fretted instrument strings on page 144
Importing fretted instrument tunings on page 145
Hiding/Showing fingerings in chord diagrams on page 1062
Allowing/Disallowing thumb fingerings in chord diagrams on page 1063

Custom chord symbols
You can customize chord symbol components and whole chord symbols, both for all instances of 
specific chord symbols project-wide and for single instances of chord symbols.

TIP

Dorico Pro provides a comprehensive set of chord symbol appearances on the Chord Symbols 
page in Engraving Options. We recommend checking the available options before customizing 
individual chord symbols.

You can customize chord symbols in different ways and in different contexts.

Customizing all instances of chord symbols
You can change the appearance of all instances of specific chord symbols and 
chord symbol components project-wide from the Project Default Chord Symbol 
Appearances dialog. For example, if you want to change the arrangement of 
components in all Gmaj7 chord symbols in the project.

When you open the Edit Chord Symbol Component dialog from inside the Project 
Default Chord Symbol Appearances dialog, the edits you make to the selected 
component affect all chord symbols that use the component project-wide. For 
example, if you want the major seventh triangle component to appear smaller in all 
major seventh chord symbols.

Library
Custom chord symbols 

856
Dorico Pro 4.3.30



Customizing single instances of chord symbols
You can change the appearance of single chord symbol instances in the Edit Chord 
Symbol Appearance dialog, independently of other instances of the same chord 
symbol. For example, if you want the first Gmaj7 chord symbol to appear differently 
than all subsequent Gmaj7 chord symbols.

When you open the Edit Chord Symbol Component dialog from inside the Edit Chord 
Symbol Appearance dialog, the edits you make to the selected component only affect 
the selected chord symbol. For example, editing the “maj” component for a single 
Gmaj7 chord symbol instance does not affect the “maj” component in Fmaj7 chord 
symbols in the project.

Changes to the appearance of single chord symbol instances appear in the Single 
Overrides list of the Project Default Chord Symbol Appearances dialog. You can 
promote overrides to single chord symbol instances to the project default appearance 
for that chord symbol.

RELATED LINKS
Chord symbol appearance presets on page 1038
Chord symbol font styles on page 1039
Project Default Chord Symbol Appearances dialog on page 857
Edit Chord Symbol Appearance dialog on page 859
Edit Chord Symbol Component dialog on page 861
Setting single chord symbol overrides as the project default on page 864
Resetting the appearance of chord symbols with single overrides on page 864

Project Default Chord Symbol Appearances dialog
The Project Default Chord Symbol Appearances dialog allows you to edit the appearance of 
all instances of specific chord symbols project-wide. For example, if you want to change the 
arrangement of components in all Gmaj7 chord symbols in the project, independently of your 
project-wide settings for all other major seventh chord symbols.

You can open the Project Default Chord Symbol Appearances dialog in any of the following 
ways:

● Choose Library > Chord Symbols.

● In Engraving Options > Chord Symbols > Project Default Appearances, click Edit.
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The Project Default Chord Symbol Appearances dialog contains the following sections:

1 Enter a chord symbol

Allows you to enter the chord symbol whose default project-wide appearance you want to 
edit. Click Add Project Default  or press Return  to add the chord symbol to the Project 
Default Appearances list, which allows you to edit the chord symbol in the editor.

2 Project Default Appearances list

Contains the chord symbols whose project default appearance you have edited in the 
project.

You can delete changes to the project default appearance of chord symbols by clicking 
Delete  in the action bar.

3 Single Overrides list

Contains the chord symbols whose appearance you have overridden for single chord symbol 
instances in the project.

You can promote single overrides to be the project default appearance for that chord symbol 
by clicking Promote to Project Default  in the action bar.

You can reset single overrides to the project default appearance for that chord symbol by 
clicking Remove Overrides  in the action bar.

4 Editor

Allows you to arrange and edit the components that make up the chord symbol. You can use 
the controls at the bottom of the dialog, and you can also move individual components in 
any of the following ways after selecting them in the editor:

● Press the standard key commands for moving items. For example, press Alt/
Opt-Right Arrow  to move components to the right, or press Ctrl/Cmd-Alt/Opt-
Right Arrow  to move components to the right by larger increments.
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● Click and drag each component.

NOTE

You cannot move the first component in chord symbols.

In addition to using Scale, you can also change the size of components by clicking and 
dragging the square handle in the top right corner after selecting a component in the editor.

5 Controls

● X offset moves components horizontally. Increasing the value moves components to the 
right, decreasing the value moves components to the left.

● Y offset moves components vertically. Increasing the value moves components 
upwards, decreasing the value moves components downwards.

● Scale changes the size of components. Increasing the value increases the size of 
components proportionally, decreasing the value decreases the size of components 
proportionally.

● Reset X offset resets the horizontal position of the selected component.

● Reset Y offset resets the vertical position of the selected component.

● Reset Scale resets the size of the selected component.

6 Components list

Contains alternative ways of presenting the component selected in the editor.

Allows you to create new components and edit existing components by clicking the 
respective button in the action bar.

● Add Component 

● Edit Component 

Clicking either button opens the Edit Chord Symbol Component dialog, in which you can 
create new chord symbol components and edit existing chord symbol components. Editing 
components from inside the Project Default Chord Symbol Appearances dialog affects all 
chord symbols that use the component project-wide.

RELATED LINKS
Chord symbol appearance presets on page 1038
Edit Chord Symbol Component dialog on page 861
Moving items graphically on page 609
Engraving Options dialog on page 840

Edit Chord Symbol Appearance dialog
The Edit Chord Symbol Appearance dialog allows you to edit the appearance and arrangement 
of single chord symbol instances, without changing the project default appearance of that chord 
symbol. For example, if you want the first Gmaj7 chord symbol to appear differently than all 
subsequent Gmaj7 chord symbols.

● You can open the Edit Chord Symbol Appearance dialog in Engrave mode by selecting 
the chord symbol you want to customize and pressing Return , or double-clicking a chord 
symbol.
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The Edit Chord Symbol Appearance dialog contains the following sections:

1 Editor

Allows you to arrange and edit the components that make up the chord symbol.

As well as using the controls at the bottom of the dialog, you can move individual 
components in any of the following ways after selecting them in the editor:

● Press the standard key commands for moving items. For example, press Alt/
Opt-Right Arrow  to move components to the right, or press Ctrl/Cmd-Alt/Opt-
Right Arrow  to move components to the right by larger increments.

● Click and drag each component.

NOTE

You cannot move the first component in chord symbols.

In addition to using Scale, you can also change the size of components by clicking and 
dragging the square handle in the top right corner after selecting a component in the editor.

2 Controls

Allow you to move individual components and change their size. You can also reset their 
position and size.

● X offset moves components horizontally. Increasing the value moves components to the 
right, decreasing the value moves components to the left.

● Y offset moves components vertically. Increasing the value moves components 
upwards, decreasing the value moves components downwards.
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● Scale changes the size of components. Increasing the value increases the size of 
components proportionally, decreasing the value decreases the size of components 
proportionally.

● Reset X offset resets the horizontal position of the selected component.

● Reset Y offset resets the vertical position of the selected component.

● Reset Scale resets the size of the selected component.

3 Components list

You can create new components and edit existing components by clicking the respective 
button in the action bar.

● Add Component 

● Edit Component 

Clicking either button opens the Edit Chord Symbol Component dialog, in which you can 
create new components and edit existing components. Editing components from inside the 
Edit Chord Symbol Appearance dialog only affects the selected chord symbol.

RELATED LINKS
Chord symbol appearance presets on page 1038
Moving items graphically on page 609

Edit Chord Symbol Component dialog
The Edit Chord Symbol Component dialog allows you to create custom chord symbol 
components and edit existing components, both for all chord symbols that use the component 
project-wide and only for single instances of chord symbols.

You can open the Edit Chord Symbol Component dialog in any of the following ways:

● To edit a component for all chord symbols that use the component project-wide: Open the 
Project Default Chord Symbol Appearances dialog, select the component you want to edit 
in the components list, and click Edit Component  in the components list action bar. You 
can also double-click the component in the components list.

● To create a new component for all instances of a specific chord symbol project-wide: Open 
the Project Default Chord Symbol Appearances dialog, select the component you want to 
duplicate in the components list, and click Add Component  in the components list action 
bar.

● To create a new component only for a single chord symbol instance: Open the Edit Chord 
Symbol Appearance dialog, select the component you want to duplicate in the components 
list, and click Add Component  in the components list action bar.
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The Edit Chord Symbol Component dialog contains the following sections:

1 Name

Contains an automatically generated name for the chord symbol component. You cannot 
change this name.

2 Component selector

Allows you to choose components to add to your chord symbol component. You can add 
different types of components by clicking the respective tab titles.

● Glyph, for example, ♮ or ♯. You can use different styles of glyphs by selecting different 
fonts and font styles/weights from the menus. You can search using SMuFL or Unicode 
ranges. Click Add Glyph to add the selected glyph to the chord symbol component.

NOTE

A full list of the different ranges of glyphs is available on the SMuFL website.

● Text, including numbers and other text. You can use numbers and text from the 
available Preset text list or select any font available from the menu and enter your 
preferred text into the text box at the bottom. Click Add Text to add the selected or 
input text to the chord symbol component.

● Graphic: Allows you to load a new graphics file or select an existing graphic from the 
Select existing list in SVG, PNG, or JPG format. You can see a preview of the graphic 
in the Preview box. Click Add Graphic to add the selected graphic to the chord symbol 
component.

● Composite: Allows you to select a composite from the list. Click Add Composite to add 
the selected composite to the chord symbol component.

3 Editor

Allows you to arrange and edit the components that make up your chord symbol 
component. You can arrange and edit components using the controls at the bottom of the 
dialog.

4 Editor action bar
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Contains selection and view options for the editor.

● Zoom: Allows you to change the zoom level in the editor.

● Select: Allows you to select the next/previous component.

● Delete : Deletes the selected component.

5 Controls

Contains controls that allow you to edit individual components. Controls are divided into 
tabs according to the aspect of the selected component they affect. For chord symbols, the 
Component and Attachments tabs are available.

The Component tab contains the following options:

● Offset: Controls the position of the selected component. X moves it horizontally, Y 
moves it vertically.

● Scale: Controls the size of the selected component. For graphics, X controls its width, Y 
controls its height.

NOTE

Although some components scale their height and width independently, others retain 
their aspect ratio, meaning only one value affects their overall size.

● Z order: Allows you to Bring Forward or Send Backward the selected component in 
relation to other components when they overlap.

● Color: Allows you to change the color of the selected component.

The Attachments tab is only available if the chord symbol component comprises at least two 
separate components. It contains the following options:

● Attachment from: Sets the attachment point on the component to the left of the 
selected component to which the selected component attaches. We recommend that 
you select a right edge attachment point for Attachment from.

● Attachment to: Sets the attachment point on the selected component which attaches to 
the component to its left. We recommend that you select a left edge attachment point 
for Attachment to.

There are eight attachment points for glyphs and graphics, and eleven for text, due to the 
extra space required for letters that extend below the baseline. The example diagram helps you 
visualize how these points relate to components.

The attachment points have the following names in the Edit Chord Symbol Component dialog:

1 Top Left

2 Top Center

3 Top Right

4 Middle Left

5 Middle Right

6 Baseline Left (text only)
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7 Baseline Center (text only)

8 Baseline Right (text only)

9 Bottom Left

10 Bottom Center

11 Bottom Right

RELATED LINKS
Chord symbol appearance presets on page 1038
Project Default Chord Symbol Appearances dialog on page 857
Edit Chord Symbol Appearance dialog on page 859

Setting single chord symbol overrides as the project default
You can set overrides you have made to the appearance of single chord symbol instances as the 
project default appearance for that chord symbol.

PROCEDURE

1. Choose Library > Chord Symbols to open the Project Default Chord Symbol Appearances 
dialog.

2. In the Single Overrides list, select the single override that you want to set as project default.

3. Click Promote to Project Default .

RESULT
The selected single chord symbol override becomes the default appearance for that chord 
symbol.

NOTE

This cannot be undone. If you want to revert your changes, you must delete the chord symbol 
from the Project Default Appearances list.

RELATED LINKS
Custom chord symbols on page 856
Project Default Chord Symbol Appearances dialog on page 857
Edit Chord Symbol Appearance dialog on page 859

Resetting the appearance of chord symbols with single overrides
You can reset the appearance of single chord symbol instances whose appearance you have 
overridden back to the project default appearance for that chord symbol.

PROCEDURE

1. Choose Library > Chord Symbols to open the Project Default Chord Symbol Appearances 
dialog.

2. In the Single Overrides list, select the single override that you want to reset.

3. Click Remove Overrides .
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RESULT
All individual changes to the chord symbol are removed. It now follows the project default 
appearance for that chord symbol.

Music symbols
Music symbols in Dorico Pro is a broad term that covers all the different elements used in 
musical notation, including stem flags, clefs, articulations, and the bold numbers used in multi-
bar rests and time signatures.

In Dorico Pro, some music symbols have specific editor dialogs in which you can edit and create 
custom versions of those symbols. For all other music symbols, you can edit their project-wide 
appearance in the Edit Music Symbol dialog.

RELATED LINKS
Notations input on page 271
Insert Music Text dialog on page 391
Edit Accidental dialog on page 908
Edit Chord Symbol Component dialog on page 861
Edit Notehead dialog on page 871
Edit Playing Technique dialog on page 880
Edit Lines dialog on page 888
Edit Repeatable Symbol dialog on page 900
Edit Line Annotation dialog on page 897
Hiding/Showing arrows on tempo equations on page 1605

Edit Music Symbol dialog
The Edit Music Symbol dialog allows you to edit the appearance of music symbols, such as 
ornaments and articulations.

● You can open the Edit Music Symbol dialog by choosing Library > Music Symbols.

NOTE

● You cannot create new music symbols in the Edit Music Symbol dialog, you can only edit 
existing music symbols. If you want to add custom symbols to your music, you can, for 
example, create custom playing techniques or line annotations.

● Chord symbols, accidentals, noteheads, lines, and playing techniques all have their own 
dedicated editors.

Library
Music symbols 

865
Dorico Pro 4.3.30



The Edit Music Symbol dialog contains the following sections and options:

1 Category menu

Allows you to select which type of music symbol is available in the music symbol list.

2 Search field

Allows you to filter music symbols according to your entry.

3 Music symbol list

Contains all the music symbols in the project within the currently selected category and your 
search filter, if applicable.

The action bar at the bottom of the list contains the following options:

● Save as Default : Saves the currently selected music symbol in its current state as the 
default for all future projects. Appears as  for music symbols saved as default.

● Revert to Factory : Removes all your changes to the selected music symbol, returning 
it to its saved settings and appearance.

4 Name

Displays the default name for the selected music symbol.

5 Component selector

Allows you to choose components to add to the music symbol. You can add different types of 
components by clicking the respective tab titles.

● Glyph, for example, ♮ or ♯. You can use different styles of glyphs by selecting different 
fonts and font styles/weights from the menus. You can search using SMuFL or Unicode 
ranges. Click Add Glyph to add the selected glyph to the music symbol.

NOTE

A full list of the different ranges of glyphs is available on the SMuFL website.

● Text, including numbers and other text. You can use numbers and text from the 
available Preset text list or select any font available from the menu and enter your 
preferred text into the text box at the bottom. Click Add Text to add the selected or 
input text to the music symbol.
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● Graphic: Allows you to load a new graphics file or select an existing graphic from the 
Select existing list in SVG, PNG, or JPG format. You can see a preview of the graphic in 
the Preview box. Click Add Graphic to add the selected graphic to the music symbol.

6 Editor

Allows you to arrange and edit the components that make up the music symbol. You can 
arrange and edit components by clicking and dragging them in the editor and by using the 
controls at the bottom of the dialog. You can also use the handles on each component to 
change their size.

7 Editor action bar

Contains selection and view options for the editor.

● Zoom: Allows you to change the zoom level in the editor.

● Select: Allows you to select the next/previous component.

● Show Attachments : Shows all the attachments on all components in the editor.

● Delete : Deletes the selected component.

8 Controls

Contains controls that allow you to edit individual components. Controls are divided into 
tabs according to the aspect of the selected component they affect. For music symbols, the 
Component and Attachments tabs are available.

The Component tab contains the following options:

● Offset: Controls the position of the selected component. X moves it horizontally, Y 
moves it vertically.

● Scale: Controls the size of the selected component. For graphics, X controls its width, Y 
controls its height.

NOTE

Although some components scale their height and width independently, others retain 
their aspect ratio, meaning only one value affects their overall size.

● Z order: Allows you to Bring Forward or Send Backward the selected component in 
relation to other components when they overlap.

● Color: Allows you to change the color of the selected component.

The Attachments tab is only available if the music symbol comprises at least two separate 
components. It contains the following options:

● Attachment from: Sets the attachment point on the component to the left of the 
selected component to which the selected component attaches. We recommend that 
you select a right edge attachment point for Attachment from.

● Attachment to: Sets the attachment point on the selected component which attaches to 
the component to its left. We recommend that you select a left edge attachment point 
for Attachment to.

There are eight attachment points for glyphs and graphics, and eleven for text, due to the 
extra space required for letters that extend below the baseline. The example diagram helps you 
visualize how these points relate to components.
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The attachment points have the following names in the Edit Music Symbol dialog:

1 Top Left

2 Top Center

3 Top Right

4 Middle Left

5 Middle Right

6 Baseline Left (text only)

7 Baseline Center (text only)

8 Baseline Right (text only)

9 Bottom Left

10 Bottom Center

11 Bottom Right

RELATED LINKS
Notations input on page 271
Insert Music Text dialog on page 391
Custom playing techniques on page 876
Custom lines on page 884
Custom notehead sets on page 868
Custom key signatures on page 910
Custom accidentals on page 907
Custom chord symbols on page 856

Custom notehead sets
You can create and edit custom noteheads and notehead sets; for example, to create noteheads 
with specific shapes that represent extended techniques.

In Dorico Pro, noteheads are grouped into sets, which allow you to customize the noteheads 
used for different durations. For example, the standard notehead set uses different noteheads 
for quarter notes compared to half notes.

● You can create new notehead sets and edit existing ones in the Edit Notehead Sets dialog.

● You can create new and edit existing noteheads within each notehead set in the Edit 
Notehead dialog.

RELATED LINKS
Notehead sets on page 1246
Notehead set designs on page 1247
Edit Notehead dialog on page 871
Creating custom notehead sets on page 874
Creating custom noteheads on page 875
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Edit Notehead Sets dialog
The Edit Notehead Sets dialog allows you to add, edit, and delete custom notehead sets. It 
also allows you to change various settings relating to the appearance and function of noteheads 
within each notehead set.

● You can open the Edit Notehead Sets dialog by choosing Library > Notehead Sets.

The Edit Notehead Sets dialog contains the following sections and options:

1 Category menu

Allows you to filter the list of notehead sets by selecting a category from the menu, such as 
Crosses or Diamonds. This corresponds to where notehead sets are located in the menu; for 
example, Edit > Notations > Notehead > Crosses > X Noteheads.

2 Notehead sets list

Contains all the notehead sets in the project within the currently selected category.

The action bar at the bottom of the list contains the following options:

● New : Adds a new notehead set. By default, new notehead sets are Normal and in the 
Common category.

● New from Selection : Adds a new notehead set that is a duplicate of the notehead set 
currently selected.

NOTE

A single notehead can appear in multiple notehead sets. If you edit a notehead within 
one notehead set, your changes affect the appearance of that notehead in all notehead 
sets that contain it.

● Save as Default : Saves the selected notehead set to your user library, allowing you 
to use it in multiple projects and to assign a key command for it. Appears as  for 
notehead sets saved as default.

● Revert to Factory : Removes all your changes to the selected notehead set, returning 
it to its saved settings.
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● Delete : Deletes the selected notehead set.

NOTE

You cannot delete predefined notehead sets.

3 Notehead Set section

Displays the noteheads in the notehead set currently selected in the notehead set list, and 
contains the following options that apply to the notehead set:

● Name: Allows you to enter a new name or edit the existing name for the selected 
notehead set.

● Category: Allows you to select a category for the notehead set, such as Crosses. This 
corresponds to where notehead sets are located in the menu; for example, Edit > 
Notations > Notehead > Crosses > X Noteheads.

● Type: Displays whether the notehead set is Normal, Pitched, or Scale Degree.

NOTE

You cannot change the Type of notehead sets. If you want a new notehead set of a 
particular Type, you must select an existing notehead set of that type in the notehead 
set list and click New from Selection.

● Default notehead: Allows you to select which notehead within the set Dorico Pro uses 
if there is no notehead in the set that exactly matches the requirements of a note; for 
example, if you input a note longer than a whole note, but there is no notehead defined 
for this duration in the set.

4 Notehead Set action bar

Contains the following options for changing which noteheads are included in the notehead 
set:

● Add Notehead to Set : Adds a new notehead to the notehead set. You can select any 
notehead from the menu.

NOTE

A single notehead can appear in multiple notehead sets. If you edit a notehead within 
one notehead set, your changes affect the appearance of that notehead in all notehead 
sets that contain it.

● Remove Notehead from Set : Deletes the selected notehead from the notehead set.

5 Notehead section

Contains the following options that apply to the notehead currently selected in the 
Notehead Set section:

● Name: Allows you to enter a new name or edit the existing name for the selected 
notehead. This is the identifying name used in the Add Notehead to Set menu.

● Duration: Allows you to select the primary rhythmic duration for which the selected 
notehead is intended. You can then specify whether the selected notehead can also be 
used for shorter/longer notes.

● Use for durations shorter than and equal: Allows you to specify that the selected 
notehead can be used for notes of the selected Duration and shorter notes.

● Use for durations longer than and equal: Allows you to specify that the selected 
notehead can be used for notes of the selected Duration and longer notes.
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● Stem direction: Allows you to specify that the selected notehead should be used for 
up-stem or down-stem notes only. This is particularly important for noteheads with 
shapes; for example, the triangles in triangular noteheads point in different directions 
according to their stem direction.

● Double whole note: Allows you to specify whether the selected notehead is Round 
or Square. This determines which notehead is used for double whole notes (breves) 
according to your project-wide setting for Appearance of double whole note (breve) 
notehead on the Notes page in Engraving Options.

● Pitch: Specifies the note name and accidental for which the selected notehead is used 
(Pitched type noteheads only).

● Degree: Specifies the scale degree for which the selected notehead is used, using 
integer numbers from 1 to 7 (Scale Degree type noteheads only).

6 Notehead action bar

Contains the following options that allow you to edit new and existing noteheads:

● New Notehead : Creates a new Normal notehead, based on the default black 
notehead.

● New from Selection : Creates a new notehead that is a duplicate of the notehead 
currently selected in the Notehead Set section.

● Edit Notehead : Opens the Edit Notehead dialog, where you can edit the appearance 
of the notehead.

● Save as Default : Saves the selected notehead to your user library, allowing you to use 
it in multiple projects. Appears as  for noteheads saved as default.

● Revert to Factory : Removes all your changes to the selected notehead, returning it to 
its saved settings and appearance.

● Delete : Deletes the selected notehead.

NOTE

You cannot delete predefined noteheads or any notehead that is currently used in your 
project.

RELATED LINKS
Notehead sets on page 1246
Key Commands page in the Preferences dialog on page 63
Creating custom notehead sets on page 874
Creating custom noteheads on page 875
Engraving Options dialog on page 840

Edit Notehead dialog
The Edit Notehead dialog allows you to design custom noteheads and edit the appearance and 
arrangement of existing noteheads.

● You can open the Edit Notehead dialog from within the Edit Notehead Sets dialog, by 
selecting the notehead whose design you want to edit from the Notehead Set list and either 
double-clicking it or clicking Edit Notehead in the action bar in the Notehead section.
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The Edit Notehead dialog contains the following sections and options:

1 Name

Contains the saved name for predefined noteheads, or an automatically generated name for 
new noteheads. You cannot change this name.

2 Component selector

Allows you to choose components to add to the notehead. You can add different types of 
components by clicking the respective tab titles.

● Glyph, for example, ♮ or ♯. You can use different styles of glyphs by selecting different 
fonts and font styles/weights from the menus. You can search using SMuFL or Unicode 
ranges. Click Add Glyph to add the selected glyph to the notehead.

NOTE

A full list of the different ranges of glyphs is available on the SMuFL website.

● Text, including numbers and other text. You can use numbers and text from the 
available Preset text list or select any font available from the menu and enter your 
preferred text into the text box at the bottom. Click Add Text to add the selected or 
input text to the notehead.

● Graphic: Allows you to load a new graphics file or select an existing graphic from the 
Select existing list in SVG, PNG, or JPG format. You can see a preview of the graphic in 
the Preview box. Click Add Graphic to add the selected graphic to the notehead.

● Composite: Allows you to select a composite from the list. Click Add Composite to add 
the selected composite to the notehead.

3 Editor

Allows you to arrange and edit the components that make up the notehead. You can arrange 
and edit components by clicking and dragging them in the editor and by using the controls 
at the bottom of the dialog. You can also use the handles on each component to change 
their size.
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We recommend that you position the notehead in the center of the editor so that its left 
edge is aligned with the thicker vertical grid line and its middle is aligned with the thicker 
horizontal grid line.

4 Editor action bar

Contains selection and view options for the editor.

● Zoom: Allows you to change the zoom level in the editor.

● Select: Allows you to select the next/previous component.

● Show Attachments : Shows all the attachments on all components in the editor.

● Delete : Deletes the selected component.

5 Controls

Contains controls that allow you to edit individual components. Controls are divided into 
tabs according to the aspect of the selected component they affect. For noteheads, the 
Component, Stem, and Attachments tabs are available.

The Component tab contains the following options:

● Offset: Controls the position of the selected component. X moves it horizontally, Y 
moves it vertically.

● Scale: Controls the size of the selected component. For graphics, X controls its width, Y 
controls its height.

NOTE

Although some components scale their height and width independently, others retain 
their aspect ratio, meaning only one value affects their overall size.

● Z order: Allows you to Bring Forward or Send Backward the selected component in 
relation to other components when they overlap.

● Color: Allows you to change the color of the selected component.

The Stem tab contains options controlling the position of where stems attach to the 
notehead. Each notehead can have multiple stem attachment points, as stems often attach 
to noteheads in different places when the note is stem up, stem down, and split for altered 
unisons. Stem attachment points include an indication of the stem direction for which the 
attachment is used and the part of the stem that attaches to this position, given as a 
compass direction. For example, Stem up SE is where the bottom right corner of an up stem 
attaches to the notehead.

Each stem attachment point in the Stem tab has the following options:

● X: Moves the attachment point horizontally.

● Y: Moves the attachment point vertically.

● Add : Adds the attachment point to the notehead.

● Delete : Removes the attachment point from the notehead.

The Attachments tab is only available if the notehead comprises at least two separate 
components. It contains the following options:

● Attachment from: Sets the attachment point on the component to the left of the 
selected component to which the selected component attaches. We recommend that 
you select a right edge attachment point for Attachment from.

● Attachment to: Sets the attachment point on the selected component which attaches to 
the component to its left. We recommend that you select a left edge attachment point 
for Attachment to.
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There are eight attachment points for glyphs and graphics, and eleven for text, due to the 
extra space required for letters that extend below the baseline. The example diagram helps you 
visualize how these points relate to components.

The attachment points have the following names in the Edit Notehead dialog:

1 Top Left

2 Top Center

3 Top Right

4 Middle Left

5 Middle Right

6 Baseline Left (text only)

7 Baseline Center (text only)

8 Baseline Right (text only)

9 Bottom Left

10 Bottom Center

11 Bottom Right

RELATED LINKS
Altered unisons on page 948

Creating custom notehead sets
You can create custom notehead sets to which you can add existing noteheads or new custom 
noteheads.

PROCEDURE

1. Choose Library > Notehead Sets to open the Edit Notehead Sets dialog.

2. Optional: If you want to create a copy of an existing notehead set, select the category of that 
notehead set from the Category menu.

3. Create a new notehead set in one of the following ways:

● To create a default new notehead set in the Common category, click New  in the 
notehead sets list action bar.

● To create a notehead set that is a copy of an existing one, select the existing notehead 
set in the notehead sets list and click New from Selection  in the notehead sets list 
action bar.

4. In the Notehead Set section, enter a name for the new notehead set in the Name field.

5. Optional: If you want to change the category of the notehead set, select the category you 
want from the Category menu.

6. Change the noteheads included in the set in any of the following ways:
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● To add an existing notehead, click Add Notehead to Set  in the Notehead Set action 
bar and select the notehead you want from the menu.

● To create a new notehead with default settings, click New Notehead  in the Notehead 
action bar.

● To create a new notehead that is a copy of an existing one, select the existing notehead 
in the Notehead Set section and click New from Selection  in the Notehead action 
bar.

● To edit an existing notehead, select it and click Edit Notehead  in the Notehead 
action bar to open the Edit Notehead dialog.

● To remove a notehead from the set, select it and click Remove Notehead from Set  in 
the Notehead Set action bar

7. Optional: Customize the appearance, name, and settings of noteheads.

For example, you can change the stem direction and note durations for which they are used. 
You can also double-click noteheads to open the Edit Notehead dialog, where you can edit 
the appearance of the notehead.

NOTE

If you edit a notehead that appears in multiple notehead sets, your changes affect its 
appearance in all notehead sets that contain it.

8. Optional: If you want your new custom notehead set to be available in all future projects you 
open on your computer, click Save as Default  in the notehead sets list action bar.

9. Click OK to save your changes and close the dialog.

RESULT
The new custom notehead set is added to the project. If you clicked Save as Default  so that it 
appears as , the custom notehead set is available in all future projects on your computer.

AFTER COMPLETING THIS TASK
You can use your custom notehead sets for individual noteheads or unpitched percussion 
playing technique-specific noteheads.

RELATED LINKS
Notehead sets on page 1246
Edit Notehead Sets dialog on page 869
Edit Notehead dialog on page 871
Changing the notehead design of individual noteheads on page 1252
Playing technique-specific noteheads on page 1683

Creating custom noteheads
You can create custom noteheads; for example, to represent different performance techniques in 
contemporary music.

NOTE

You can also edit existing noteheads. However, if you edit a notehead that appears in multiple 
notehead sets, your changes affect its appearance in all notehead sets that contain it.
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PREREQUISITE
If you want to create custom noteheads in a custom notehead set, you have created that 
notehead set.

PROCEDURE

1. Choose Library > Notehead Sets to open the Edit Notehead Sets dialog.

2. Select the required notehead set category from the Category menu.

3. In the notehead sets list, select the notehead set in which you want to create custom 
noteheads.

4. Create a new notehead in one of the following ways:

● To create a new notehead with default settings, click New Notehead  in the Notehead 
action bar.

● To create a new notehead that is a copy of an existing one, select the existing notehead 
in the Notehead Set section and click New from Selection  in the Notehead action 
bar.

5. In the Notehead Set section, double-click the notehead to open the Edit Notehead dialog, 
in which you can customize its appearance.

For example, you can add glyphs to your notehead using the options on the right, then 
arrange and resize them in the editor.

6. Click OK to save your changes and close the Edit Notehead dialog.

7. In the Notehead section, enter a name for the new notehead in the Name field.

8. Customize the settings for the notehead using the available notehead options.

For example, you can change the stem direction and note durations for which it is used.

9. Optional: If you want your new custom notehead to be available in all future projects you 
open on your computer, click Save as Default  in the Notehead action bar.

10. Optional: Repeat steps 4 to 9 for each custom notehead you want to create in the current 
notehead set.

11. Click OK to save your changes and close the Edit Notehead Sets dialog.

RESULT
The new custom notehead is created in the selected notehead set. If you clicked Save as 
Default   so that it appears as , the custom notehead is available in all future projects on 
your computer.

Custom playing techniques
Custom playing techniques allow you to represent any playing technique in any way you want; 
for example, if the default glyph used for a particular playing technique is not the one to which 
you or the players reading the music are accustomed.

As well as designing the appearance of custom playing techniques using existing glyphs, text, 
and your own graphics, you can define how they should affect playback and whether or not they 
show continuation lines.

You can create and edit custom playing techniques in the Edit Playing Techniques dialog and its 
related dialogs.
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You can find your custom playing techniques in their assigned category in the Playing 
Techniques panel in Write mode. You can also input them using the popover by entering the 
popover text assigned to them.

RELATED LINKS
Creating custom playing techniques on page 882
Playback techniques on page 936
Jazz articulations on page 1348
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Edit Playing Techniques dialog
The Edit Playing Techniques dialog allows you to change various settings relating to the 
appearance and function of all playing techniques in the project and add, edit, and delete custom 
playing techniques.

You can open the Edit Playing Techniques dialog in any of the following ways:

● Choose Library > Playing Techniques.

● In Write mode, in the Playing Techniques panel, click Add Playing Technique  in the action 
bar of any section.

● To open the dialog for a specific playing technique, select that playing technique in the music 
area in Write mode, then click Edit Playing Technique  in any of the Playing Techniques 
panel action bars. You can also double-click playing techniques in Engrave mode.

The Edit Playing Techniques dialog contains the following sections and options:

1 Category menu
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Allows you to filter the list of playing techniques by selecting an instrument or instrument 
family category from the menu, such as String or Choral. This corresponds to the titles of 
sections in the Playing Techniques panel.

2 Playing techniques list

Contains all the playing techniques in the project within the currently selected category.

The action bar at the bottom of the list contains the following options:

● New : Adds a new blank playing technique.

● New from Selection : Creates a copy of an existing playing technique that you can 
edit separately from the original.

● Save as Default : Saves the selected playing technique to your user library, allowing 
you to use it in multiple projects. Appears as  for playing techniques saved as default.

● Revert to Factory : Removes all your changes to the selected playing technique, 
returning it to its saved settings and appearance.

● Delete : Deletes the selected playing technique.

NOTE

You cannot delete predefined playing techniques or any playing technique that is 
currently used in your project.

3 Name

Allows you to enter a new name or edit the existing name for the selected playing technique.

4 Preview

Displays the playing technique in its current form. If the playing technique is set to appear 
the same both above and below the staff, a single preview area is shown. If the playing 
technique is set to appear differently according to its staff-relative placement, the preview is 
split to show both possible appearances.

Clicking Edit Composite  in the action bar below the preview opens the Edit Playing 
Technique dialog, where you can edit the appearance of the playing technique. This button 
is only available for glyph playing techniques.

5 Playing technique options

Contains options relating to the appearance and function of the selected playing technique. 
Options are divided into tabs according to the aspect of the selected playing technique they 
affect.

The General tab contains the following options:

● Category: Allows you to select an instrument family category for the selected playing 
technique; for example, if you duplicated a String technique but want to save your new 
playing technique in the Wind category.

● Type: Allows you to choose whether the playing technique is a Glyph or Text. This 
affects how the technique appears in the preview.

If you select Text, a Text field appears beside the Type menu. You can enter any text 
into the field, and select any font style from the menu beside the field. The playing 
technique appears on the left of the preview.

If you select Glyph, the playing technique appears in the middle of the preview. 
Selecting Glyph also allows you to edit the playing technique in the Edit Playing 
Technique dialog.

● Default placement: Allows you to choose whether the playing technique is placed 
Above or Below the staff by default.
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● Appearance: Allows you to choose whether the playing technique appears the same on 
either side of the staff, or whether it has a different appearance on each side. If you 
choose Different above and below, you can edit each appearance independently.

● Popover text: Allows you to set the text you want to enter into the popover to input the 
playing technique.

● Playback technique: Allows you to choose the playback technique for the playing 
technique; that is, the action/switch that changes the sample sound used. Multiple 
playing techniques can use the same playback technique.

If you need a playback technique not in the list, click Edit to open the Edit Playback 
Techniques dialog, where you can create custom playback techniques.

● Cues: Allows you to choose whether or not the playing technique appears in cues when 
playing techniques are shown in cues.

● Tablature: Allows you to choose whether the playing technique always appears on 
tablature or only appears in layouts with no notation staff shown.

The Continuation tab contains the following options:

● Continuation type: Allows you to choose the default continuation type. When playing 
techniques have duration, they can show duration lines, nothing, or sim.. Glyph playing 
techniques can also repeat the signs for each note within the duration. If you choose 
Line, you can change the duration line style.

NOTE

This only applies to ungrouped playing techniques and the final playing techniques in 
groups.

● Duration line: Allows you to select the default duration line style for the playing 
technique.

Alignment above/Below: Allow you to set the vertical position at which duration lines 
attach to the playing technique above and below the staff independently.

● Transition line: Allows you to select the default transition line style for the playing 
technique.

NOTE

Playing techniques within groups always show transition lines. Only the final playing 
technique in groups can show a duration line.

Alignment above/Below: Allow you to set the vertical position at which transition lines 
attach to the playing technique above and below the staff independently.

RELATED LINKS
Edit Playback Techniques dialog on page 937
Creating custom playing techniques on page 882
Playing Techniques panel on page 372
Playing technique duration on page 1394
Playing technique continuation lines on page 1393
Changing the style of playing technique continuation lines on page 1397
Changing the caps of playing technique continuation lines on page 1398
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Edit Playing Technique dialog
The Edit Playing Technique dialog allows you to design custom playing techniques and edit the 
appearance and arrangement of all playing techniques in the project.

● You can open the Edit Playing Technique dialog from within the Edit Playing Techniques 
dialog by selecting the playing technique whose design you want to edit from the list and 
clicking Edit Composite in the action bar below the preview. Its Type must be set to Glyph in 
order for you to do this.

The Edit Playing Technique dialog contains the following sections and options:

1 Name

Contains the saved name for predefined playing techniques, or an automatically generated 
name for new playing techniques. You cannot change this name.

2 Component selector

Allows you to choose components to add to the playing technique. You can add different 
types of components by clicking the respective tab titles.

● Glyph, for example, ♮ or ♯. You can use different styles of glyphs by selecting different 
fonts and font styles/weights from the menus. You can search using SMuFL or Unicode 
ranges. Click Add Glyph to add the selected glyph to the playing technique.

NOTE

A full list of the different ranges of glyphs is available on the SMuFL website.

● Text, including numbers and other text. You can use numbers and text from the 
available Preset text list or select any font available from the menu and enter your 
preferred text into the text box at the bottom. Click Add Text to add the selected or 
input text to the playing technique.

● Graphic: Allows you to load a new graphics file or select an existing graphic from the 
Select existing list in SVG, PNG, or JPG format. You can see a preview of the graphic 
in the Preview box. Click Add Graphic to add the selected graphic to the playing 
technique.
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● Composite: Allows you to select a composite from the list. Click Add Composite to add 
the selected composite to the playing technique.

3 Editor

Allows you to arrange and edit the components that make up the playing technique. You can 
arrange and edit components by clicking and dragging them in the editor and by using the 
controls at the bottom of the dialog. You can also use the handles on each component to 
change their size.

4 Editor action bar

Contains selection and view options for the editor.

● Zoom: Allows you to change the zoom level in the editor.

● Select: Allows you to select the next/previous component.

● Show Attachments : Shows all the attachments on all components in the editor.

● Delete : Deletes the selected component.

5 Controls

Contains controls that allow you to edit individual components. Controls are divided into tabs 
according to the aspect of the selected component they affect. For playing techniques, the 
Component and Attachments tabs are available.

The Component tab contains the following options:

● Offset: Controls the position of the selected component. X moves it horizontally, Y 
moves it vertically.

● Scale: Controls the size of the selected component. For graphics, X controls its width, Y 
controls its height.

NOTE

Although some components scale their height and width independently, others retain 
their aspect ratio, meaning only one value affects their overall size.

● Z order: Allows you to Bring Forward or Send Backward the selected component in 
relation to other components when they overlap.

● Color: Allows you to change the color of the selected component.

The Attachments tab is only available if the playing technique comprises at least two 
separate components. It contains the following options:

● Attachment from: Sets the attachment point on the component to the left of the 
selected component to which the selected component attaches. We recommend that 
you select a right edge attachment point for Attachment from.

● Attachment to: Sets the attachment point on the selected component which attaches to 
the component to its left. We recommend that you select a left edge attachment point 
for Attachment to.

There are eight attachment points for glyphs and graphics, and eleven for text, due to the 
extra space required for letters that extend below the baseline. The example diagram helps you 
visualize how these points relate to components.
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The attachment points have the following names in the Edit Playing Technique dialog:

1 Top Left

2 Top Center

3 Top Right

4 Middle Left

5 Middle Right

6 Baseline Left (text only)

7 Baseline Center (text only)

8 Baseline Right (text only)

9 Bottom Left

10 Bottom Center

11 Bottom Right

RELATED LINKS
Edit Playing Techniques dialog on page 877

Creating custom playing techniques
You can create custom playing techniques, including choosing their continuation line styles and 
playback techniques; for example, if the default glyph used for a particular playing technique is 
not the one to which you or the players reading the music are accustomed.

PROCEDURE

1. Choose Library > Playing Techniques to open the Edit Playing Techniques dialog.

2. Select the category in which you want to create the custom playing technique from the 
Category menu.

3. Create a new playing technique in one of the following ways:

● To create a blank playing technique, click New  in the playing techniques list action 
bar.

● To create a playing technique that is a copy of an existing one, select the existing playing 
technique in the playing techniques list and click New from Selection  in the playing 
techniques list action bar.

4. Enter a name for the new playing technique in the Name field.

5. On the General tab, select one of the following options from the Type menu:

● Glyph

● Text

6. Customize the appearance of your playing technique in one of the following ways:

● For text playing techniques, change the text in the Text field and/or change the font 
style used.
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● For glyph playing techniques, click Edit Composite  below the appearance you want 
to customize to open the Edit Playing Technique dialog, in which you can customize its 
appearance.

7. Optional: For glyph playing techniques, choose one of the following options for Appearance 
on the General tab:

● Same above and below

● Different above and below

8. Optional: If you chose Different above and below, customize the other appearance.

9. Select the playback technique you want the playing technique to use in playback from the 
Playback technique menu.

10. Optional: If you want to use a playback technique that is not available, click Edit to open the 
Edit Playback Techniques dialog, in which you can add and edit playback techniques.

For example, some sound libraries require you to map specific actions/switches manually, so 
you might create a new playback technique to which you can assign actions/switches in the 
expression map for such a sound library.

11. Change any other options on the General tab as required.

12. Optional: If you want the playing technique to show continuation lines, select Line from the 
Continuation type menu on the Continuation tab.

13. Optional: For playing techniques that show continuation lines, select the style you want to 
use for duration lines and transition lines from the corresponding menus.

14. Optional: Change the alignment positions of duration and transition lines.

15. Click OK to save your changes and close the dialog.

RESULT
The custom playing technique is created. It is available in the current project only.

AFTER COMPLETING THIS TASK

● If you created a new playback technique, add it to the expression maps for all the 
instruments that use the custom playing technique and assign the appropriate action/switch 
for the sound library.

● You can save the custom playing technique as default to make it available in other projects.

● You can input the playing technique so it appears in your music.

RELATED LINKS
Jazz articulations on page 1348
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Saving custom playing techniques as default
By default, custom playing techniques are only available in the project in which you created 
them. You can save them as default to make them available to use in multiple projects.

PROCEDURE

1. Choose Library > Playing Techniques to open the Edit Playing Techniques dialog.

2. In the playing techniques list, select the playing techniques you want to use in multiple 
projects.

Library
Custom playing techniques 

883
Dorico Pro 4.3.30



3. Click Save as Default  in the action bar.

4. Click OK to save your changes and close the dialog.

RESULT
When Save as Default  appears as , playing techniques are available in all future projects on 
your computer.

RELATED LINKS
Custom playing techniques on page 876
Edit Playing Techniques dialog on page 877

Custom lines
Custom lines allow you to design lines that appear any way you want and save them for use in 
multiple projects.

Custom lines comprise the same components as the default lines in Dorico Pro. However, there 
are many possible combinations, and you can create new components and edit existing ones.

● Lines can have custom annotations as caps or as centered annotations, which can appear 
repeated across the duration of lines. Lines can also have hyphenated text across their 
duration.

● Line bodies can comprise single or double lines, wedges, or patterns of repeatable symbols.

You can create and edit lines in the Edit Lines dialog, line bodies in the Edit Line Bodies 
dialog, line annotations in the Edit Line Annotations dialog, and repeatable symbols in the Edit 
Repeatable Symbols dialog.

You can find your custom lines in their assigned category in the Lines panel in Write mode.

RELATED LINKS
Line components on page 1404
Edit Lines dialog on page 888
Edit Line Bodies dialog on page 891
Edit Line Annotations dialog on page 894
Edit Repeatable Symbols dialog on page 899
Creating custom lines on page 884
Creating custom line bodies on page 886
Creating custom line annotations on page 886
Creating custom repeatable symbols on page 887
Input methods for lines on page 384

Creating custom lines
You can create custom lines, including choosing their caps, annotations, and line bodies; for 
example, if you require a specific combination of line components and want to use it multiple 
times. You can save custom lines as default to make them available in multiple projects.

PROCEDURE

1. Choose Library > Lines to open the Edit Lines dialog.

2. Select the type of line you want to create from the Category menu.

3. Create a new line in one of the following ways:

Library
Custom lines 

884
Dorico Pro 4.3.30



● To create a new line with default settings, click New  in the lines list action bar.

● To create a new line that is a copy of an existing one, select the existing line in the lines 
list and click New from Selection  in the action bar.

4. Enter a name for the new line in the Name field.

5. Optional: If you want to use a new line body style or edit an existing one, click Line Body 
Editor  to open the Edit Line Bodies dialog and create a new line body or edit an existing 
one.

6. Select the body style you want to use for the line from the Body style menu.

7. Customize the appearance and default position of the line using the available line options.

For example, you can select a different annotation for each cap and set the minimum 
distances between the line and the staff or other items.

8. Choose one of the following options for Annotation:

● None

● Center Annotation

● Hyphenated Text

9. Optional: If you chose Center Annotation and want to use a new line annotation style or 
edit an existing one, click Line Annotation Editor  to open the Edit Line Annotations 
dialog and create a new line annotation or edit an existing one.

10. Optional: If you chose Center Annotation or Hyphenated Text, customize the annotation in 
one of the following ways:

● For Center Annotation, select the annotation you want to use from the Annotation 
menu. Use the other options to set its default position and repeats as required.

● For Hyphenated Text, enter the text you want in the Syllables field. Use the other 
options to change the font style and the default position of syllables as required.

11. Optional: If you want your new custom line to be available in all future projects you open on 
your computer, click Save as Default  in the lines list action bar.

12. Click OK to save your changes and close the dialog.

RESULT
The new custom line is added to the project and becomes available in the corresponding section 
of the Lines panel. If you clicked Save as Default  so that it appears as , the custom line is 
available in all future projects on your computer.

RELATED LINKS
Line components on page 1404
Custom lines on page 884
Input methods for lines on page 384
Creating custom line annotations on page 886
Creating custom repeatable symbols on page 887
Edit Lines dialog on page 888
Edit Line Bodies dialog on page 891
Edit Line Annotations dialog on page 894
Edit Repeatable Symbols dialog on page 899
Fanned beams on page 1019
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Creating custom line bodies
You can create custom line bodies that you can then use in lines. Line bodies can be horizontal or 
vertical lines, repeating symbols, dash/dot patterns, or wedges.

PROCEDURE

1. Choose Library > Line Bodies to open the Edit Line Bodies dialog.

2. Select the type of line body you want to create from the Category menu.

3. Create a new line body in one of the following ways:

● To create a new line body with default settings, click New  in the line bodies list action 
bar.

● To create a new line body that is a copy of an existing one, select the existing line body in 
the line bodies list and click New from Selection  in the action bar.

4. Enter a name for the new line body in the Name field.

5. Customize the appearance of the line body using the available line body options.

For example, you can change the width of generic lines/wedges and add multiple repeatable 
symbols to repeatable symbol line bodies.

6. Optional: If you chose Repeatable Symbols and want to use new repeatable symbols or edit 
an existing one, click Edit  in the symbol selector editor bar to open the Edit Repeatable 
Symbols dialog and create a new repeatable symbol or edit an existing one.

7. Optional: If you want your new custom line body to be available in all future projects you 
open on your computer, click Save as Default  in the line bodies list action bar.

8. Click OK to save your changes and close the dialog.

RESULT
The new custom line body is added to the project. If you clicked Save as Default  so that it 
appears as , the custom line body is available in all future projects on your computer.

AFTER COMPLETING THIS TASK
You can use your new custom line body in lines, both in the Edit Lines dialog and for individual 
lines.

RELATED LINKS
Edit Line Bodies dialog on page 891
Creating custom repeatable symbols on page 887
Edit Lines dialog on page 888
Edit Repeatable Symbols dialog on page 899
Changing the body style of lines on page 1413

Creating custom line annotations
You can create custom line annotations that you can then use on lines. All types of annotations 
can be used as caps. Music symbol and text annotations can also be used as center annotations 
on line bodies.

PROCEDURE

1. Choose Library > Line Annotations to open the Edit Line Annotations dialog.

2. Select the type of line annotation you want to create from the Category menu.

3. Create a new line annotation in one of the following ways:
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● To create a new blank line annotation or one with default settings, click New  in the 
line annotations list action bar.

● To create a new line annotation that is a copy of an existing one, select the existing line 
annotation in the line annotations list and click New from Selection  in the action bar.

NOTE

Line annotations copied from existing line annotations are linked to the original. Any 
changes you make to line annotations in the Edit Line Annotation dialog affect original 
line annotations and any copies of them.

If you created a new Music Symbol annotation, the Edit Line Annotation dialog opens.

4. Customize the appearance of the line annotation in one of the following ways:

● For Arrowhead, Hook, Terminal Line, and Text annotations, use the available line 
annotation options. For example, you can change the width of arrowheads, hooks, and 
terminal lines, and change the font style and attachments of text.

● For Music Symbol annotations, add and arrange components in the Edit Line 
Annotation dialog and use the available line annotation options in the Edit Line 
Annotations dialog. For example, you can change the attachment points of music 
symbols.

5. Enter a name for the new line annotation in the Name field.

6. Optional: If you want your new custom line annotation to be available in all future projects 
you open on your computer, click Save as Default  in the line annotations list action bar.

7. Click OK to save your changes and close the dialog.

RESULT
The new custom line annotation is added to the project. If you clicked Save as Default  so that 
it appears as , the custom line annotation is available in all future projects on your computer

AFTER COMPLETING THIS TASK
You can use your new custom line annotations on lines, both in the Edit Lines dialog and for 
individual lines.

RELATED LINKS
Edit Line Annotations dialog on page 894
Edit Lines dialog on page 888
Edit Line Annotation dialog on page 897
Changing the caps of lines on page 1414
Adding borders to line text on page 1420

Creating custom repeatable symbols
You can create custom repeatable symbols that you can then add to repeatable symbol line 
bodies.

PROCEDURE

1. Choose Library > Repeatable Symbols to open the Edit Repeatable Symbols dialog.

2. Click New  in the repeatable symbols list action bar to create a new repeatable symbol and 
open the Edit Repeatable Symbol dialog.

3. Customize the appearance of the repeatable symbol.
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For example, you can add glyphs to your repeatable symbol using the options on the right, 
then arrange and resize them in the editor.

4. Click OK to save your changes and close the dialog.

5. Enter a name for the new repeatable symbol in the Name field.

6. Optional: If you want to move the repeat point on the repeatable symbol, change the Repeat 
offset value.

7. Optional: If you want your new custom repeatable symbol to be available in all future 
projects you open on your computer, click Save as Default  in the repeatable symbols 
list action bar.

8. Click OK to save your changes and close the dialog.

RESULT
The new custom repeatable symbol is added to the project. If you clicked Save as Default 
so that it appears as , the custom repeatable symbol is available in all future projects on your 
computer

AFTER COMPLETING THIS TASK
You can add your new custom repeatable symbol to repeatable symbol line bodies.

RELATED LINKS
Edit Repeatable Symbols dialog on page 899
Creating custom line bodies on page 886
Edit Lines dialog on page 888
Edit Repeatable Symbol dialog on page 900
Edit Line Bodies dialog on page 891

Edit Lines dialog
The Edit Lines dialog allows you to change the appearance and default position of all lines in the 
project and add, edit, and delete custom lines.

● You can open the Edit Lines dialog by choosing Library > Lines.
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The Edit Lines dialog contains the following sections and options:

1 Category menu

Allows you to select which lines are available in the lines list by selecting either Horizontal or 
Vertical. This corresponds to the sections in the Lines panel.

2 Search field

Allows you to filter lines in the selected category according to your entry.

3 Lines list

Contains all the lines in the project within the currently selected category and your search 
filter, if applicable.

The action bar at the bottom of the list contains the following options:

● New : Adds a new line with default settings.

● New from Selection : Creates a copy of an existing line that you can edit separately 
from the original.

● Save as Default : Saves the selected line to your user library, allowing you to use it in 
multiple projects. Appears as  for lines saved as default.

● Revert to Factory : Removes all your changes to the selected line, returning it to its 
saved settings and appearance.

● Delete : Deletes the selected line.

NOTE

You cannot delete predefined lines or any line that is currently used in your project.

4 Name

Allows you to enter a new name or edit the existing name for the selected line.

5 Preview
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Displays the line in its current form. If the line is horizontal, the preview appears above the 
options. If the line is vertical, the preview appears to the right of the options.

Clicking Show Crossing Break below the preview for horizontal lines shows the line as two 
segments, as it appears when spanning two systems, so you can see its continuation caps. 
When Show Crossing Break is deactivated, the line appears as a single segment with start 
and end caps only.

6 Line Body Editor

Opens the Edit Line Bodies dialog, which allows you to create new lines bodies and edit 
existing ones.

7 Line Annotation Editor

Opens the Edit Line Annotations dialog, which allows you to create new line annotations 
and edit existing ones.

8 Line options

Contains options that control the appearance of the selected line as a whole.

● Body style: Allows you to select the default line body style for the line.

● Start cap (lines with generic/wedge line bodies only): Allows you to select the annotation 
you want to use for the start cap.

● End cap (lines with generic/wedge line bodies only): Allows you to select the annotation 
you want to use for the end cap.

● Continuation cap (horizontal lines with generic/wedge line bodies only): Allows you to 
select the annotation you want to use for the continuation start cap.

● Continuation end cap (horizontal lines with generic/wedge line bodies only): Allows you 
to select the annotation you want to use for the continuation end cap.

● Distance from staff line (horizontal lines only): Allows you to set the minimum distance 
between the line and the staff. This value applies when the line is placed outside the 
staff. When deactivated, the line follows your settings on the Lines page in Engraving 
Options.

● Distance from item (horizontal lines only): Allows you to set the minimum distance 
between the line and other items. This value applies when the line is placed outside the 
staff. When deactivated, the line follows your settings on the Lines page in Engraving 
Options.

● Hooks follow dash pattern (lines with dashed/dotted line bodies only): Allows you 
to choose whether or not hook or terminal line caps use the line body style pattern, 
provided the hooks/terminal lines are long enough to display the pattern. For line 
patterns with multiple dash-gap values, the first is used. When deactivated, or when 
hooks/terminals cannot display the pattern, they use their set annotations.

● Whole body on each system (horizontal lines with generic/wedge line bodies only): 
Allows you to choose whether lines that continue across multiple systems show the 
whole line body in each segment or if the line body is split proportionally between the 
segments. This also affects annotations/hyphenated text on the line.

● Placement (horizontal lines only): Allows you to choose whether the line is placed 
Above, Below, or Inside staff by default.

9 Line annotation options

Contains options that control the appearance, position, and distribution of the selected line’s 
annotation or hyphenated text, depending on your choice for Annotation.

If you choose Center Annotation, the following options are available:

● Annotation: Allows you to select a music symbol or text annotation to use for the line.
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● Vertical position: Allows you to select the position of the annotation relative to the 
line, such as centered on the line or positioned above. When annotations are positioned 
Inside or Outside, their position relative to the line changes according to the staff-
relative placement of the line.

● Offset: Allows you to set the distance between the annotation and the line. Only applies 
to annotations whose Vertical position is not Centered.

● Repeat: Allows you to choose whether annotations appear once per line/line segment 
or multiple times across the duration of the line. Annotations can repeat at regular 
intervals or varying intervals.

● Repeat distance: Allows you to set the distance between repetitions of the annotation. 
Only applies to repeating annotations.

● Placement: Allows you to select where the annotation appears along the duration of the 
line. For horizontal lines, Start or End shows the annotation only at the corresponding 
end of the whole line. If you choose Center, it appears in all line segments.

● Start/end gap: Allows you to set the gap between the corresponding end of the line and 
the annotation. Only applies to annotations whose Placement is Start or End.

● Always horizontal: Allows you to force the annotation always to remain horizontal; for 
example, if the line is vertical or angled.

If you choose Hyphenated Text, the following options are available:

● Syllables: Allows you to enter the text that you want to appear across the duration of 
the line, with syllables separated with hyphens.

● Font style: Allows you to select the font style for the hyphenated text.

● Starts with text: Allows you to force the first syllable to appear at the start of the line.

● Ends with text: Allows you to force the last syllable to appear at the end of the line.

● Start/end gap: Allows you to set the gap between the corresponding end of the line and 
the annotation. Only applies to annotations whose Placement is Start or End.

● Gap on the left: Allows you to set the gap between each syllable and the line to the left.

● Gap on the right: Allows you to set the gap between each syllable and the line to the 
right.

● Position: Allows you to select the vertical position of text relative to the line body.

RELATED LINKS
Creating custom lines on page 884
Line components on page 1404
Lines panel on page 385
Changing the placement of horizontal lines on page 1408
Edit Font Styles dialog on page 846
Engraving Options dialog on page 840

Edit Line Bodies dialog
The Edit Line Bodies dialog allows you to change the appearance and settings of all line bodies 
in the project and add, edit, and delete custom line bodies.

You can open the Edit Line Bodies dialog in any of the following ways:

● Choose Library > Line Bodies.

● In the Edit Lines dialog, click Line Body Editor .
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The Edit Line Bodies dialog contains the following sections and options:

1 Category menu

Allows you to select which type of line body is available in the line bodies list.

2 Search field

Allows you to filter line bodies in the selected category according to your entry.

3 Line bodies list

Contains all the line bodies in the project within the currently selected category and your 
search filter, if applicable.

The action bar at the bottom of the list contains the following options:

● New : Adds a new line body with default settings.

● New from Selection : Creates a copy of an existing line body that you can edit 
separately from the original.

● Save as Default : Saves the selected line body to your user library, allowing you to use 
it in multiple projects. Appears as  for line bodies saved as default.

● Revert to Factory : Removes all your changes to the selected line body, returning it to 
its saved settings and appearance.

● Delete : Deletes the selected line body.

NOTE

You cannot delete predefined line bodies or any line body that is currently used in your 
project.

4 Name

Allows you to enter a new name or edit the existing name for the selected line body.

5 Preview

Displays the line body in its current form.
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6 Symbols grid (repeatable symbol line bodies only)

Displays the symbols currently included in the selected repeatable symbol line body. Start 
and end symbols appear separated from middle symbols, and show S and E respectively.

The action bar below the grid contains the following options:

● Show Repeat Point: Hides/Shows a vertical line on each symbol at the point where the 
following symbol starts.

● Remove from pattern : Removes the selected symbol from the line body.

7 Line body options

Contains options that control the appearance of the selected line body. The options available 
depend on the category of the current line body.

For Generic line bodies, the following options are available:

● Style: Allows you to select the style of the line body. The style can be Solid, Double line, 
or Dashed or Dotted.

● Line width: Allows you to set the width of the line body.

● Dash-gap pattern (dashed or dotted line bodies only): Allows you to enter pairs of 
values to set the dash or dot pattern for the line body. The first value in each pair 
controls the length of dashes if positive or the diameter of dots if negative, the second 
value controls the gap between dashes/dots. You can enter lengths/diameters using 
integers, fractions, or decimals. You must separate each pair with a semicolon. For 
example, enter 1; 1/2; -1; 1/2 to produce alternating dashes and dots, each one space 
wide, separated by gaps of half a space.

● Line separation (double line bodies only): Allows you to set the distance between the 
two lines of the line body.

For Repeatable Symbols line bodies, the following options are available:

● Repetition: Allows you to select whether the symbols are treated as Individual symbols 
and spread across the duration of the line proportionally, or as a Whole pattern that 
repeats the entire pattern as many times as can fit in the duration of the line.

● When line crosses system break, add ends to each segment: Allows you to show 
start/end symbols on each segment. When deactivated, they only appear at the start 
and end of the whole line.

● Symbol selector: Contains the available repeatable symbols. The action bar contains the 
following options:

● Add to Start: Adds the selected symbol to the line body as the start symbol. Start 
symbols only appear at the start of lines and are not repeated.

● Add to Middle: Adds the selected symbol to the middle of the line body. It is added 
to the right of any existing symbols.

● Add to End: Adds the selected symbol to the line body as the end symbol. End 
symbols only appear at the end of lines and are not repeated.

● Show Repeat Point: Hides/Shows a vertical line on each symbol at the point where 
the following symbol starts.

● Edit : Opens the Edit Repeatable Symbols dialog, where you can add and edit 
individual repeatable symbols.

For Wedge line bodies, the following options are available:

● Wedge type: Allows you to select the wedge shape for the selected line body. Flat 
outside and Flat inside wedges appear different when above/below the staff. Flat top, 
Symmetrical, and Flat bottom wedges always appear as set.
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● Start thickness: Allows you to set the start thickness of the wedge.

● Middle thickness: Allows you to set a change in thickness in the middle of the wedge.

● End thickness: Allows you to set the end thickness of the wedge.

RELATED LINKS
Creating custom line bodies on page 886
Line components on page 1404
Edit Repeatable Symbols dialog on page 899
Creating custom repeatable symbols on page 887

Edit Line Annotations dialog
The Edit Line Annotations dialog allows you to change the appearance and settings of all line 
annotations in the project and add, edit, and delete custom line annotations.

All types of annotations can be used as caps. Music symbol and text annotations can also be used 
as center annotations on line bodies.

You can open the Edit Line Annotations dialog in any of the following ways:

● Choose Library > Line Annotations.

● In the Edit Lines dialog, click Line Annotation Editor .

The Edit Line Annotations dialog contains the following sections and options:

1 Category menu

Allows you to select which type of line annotation is available in the line annotations list.

2 Search field

Allows you to filter line annotations in the selected category according to your entry.

3 Line annotations list

Contains all the line annotations in the project within the currently selected category and 
your search filter, if applicable.

The action bar at the bottom of the list contains the following options:
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● New : Adds a new blank line annotation or one with default settings. For music 
symbols, New opens the Edit Line Annotation dialog, where you can design your new 
music symbol annotation.

● New from Selection : Creates a copy of an existing line annotation that you can edit 
separately from the original.

NOTE

Line annotations copied from existing line annotations are linked to the original. Any 
changes you make to line annotations in the Edit Line Annotation dialog affect original 
line annotations and any copies of them.

● Save as Default : Saves the selected line annotation to your user library, allowing you 
to use it in multiple projects. Appears as  for line annotations saved as default.

● Revert to Factory : Removes all your changes to the selected line annotation, 
returning it to its saved settings and appearance.

● Delete : Deletes the selected line annotation.

NOTE

You cannot delete predefined line annotations or any line annotation that is currently 
used in your project.

4 Name

Allows you to enter a new name or edit the existing name for the selected line annotation.

5 Preview

Displays the line annotation in its current form in all possible positions.

6 Line annotation options

Contains options that control the appearance of the selected line annotation. The options 
available depend on the category of the current line annotation.

For Arrowhead line annotations, the following options are available:

● Arrow style: Allows you to select the style for the arrowhead. Arrowheads can be a 
chevron with a pair of angled lines, an empty triangle, or a filled triangle.

● Width: Allows you to set the width of the arrowhead.

● Height: Allows you to set the height of the arrowhead.

● Line width: Allows you to set the line width of the arrowhead. Only applies to Chevron 
and Empty triangle arrowheads.

For Hook line annotations, the following options are available:

● Length: Allows you to set the length of the hook.

● Line width: Allows you to set the width of the line used for the hook.

● Direction: Allows you to select the direction in which the hook points. Inward and 
Outward hooks always point towards or away from the staff respectively, regardless of 
their staff-relative placement. Up, Down, Left, and Right hooks always appear as set.

● Rotation: Allows you to select whether the hook follows the rotation of the line or is 
always aligned with its axis; that is, pointing in one of the four cardinal directions.

For Music Symbol line annotations, the following options are available:

● Symbol: Clicking Edit opens the Edit Line Annotation dialog, where you can edit the 
appearance of the music symbol.
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● Horizontal attachment: Allows you to select the attachment point of the music symbol 
relative to vertical lines.

● Vertical attachment: Allows you to select the attachment point of the music symbol 
relative to horizontal lines.

● Gap above/Gap below: Allow you to set the gap between the music symbol and line 
bodies above and below respectively.

● Gap on the left/Gap on the right: Allow you to set the gap between the music symbol 
and line bodies to the left and right respectively.

● Rotation: Allows you to select whether the music symbol follows the rotation of the line 
or is always aligned with its axis; that is, one of the four cardinal directions.

For Terminal Line line annotations, the following options are available:

● Length: Allows you to set the length of the terminal line.

● Line width: Allows you to set the width of the line used for the terminal line.

● Rotation: Allows you to select whether the terminal line follows the rotation of the line 
or is always aligned with its axis; that is, pointing in one of the four cardinal directions.

For Text line annotations, the following options are available:

● Text: Allows you to enter the text you want for the text annotation.

● Font style: Allows you to select the font style for the text annotation.

● Horizontal attachment: Allows you to select the attachment point of the text 
annotation relative to vertical lines.

● Vertical attachment: Allows you to select the attachment point of the text annotation 
relative to horizontal lines.

● Gap above/Gap below: Allow you to set the gap between the text annotation and line 
bodies above and below respectively.

● Gap to the left/Gap to the right: Allow you to set the gap between the text annotation 
and line bodies to the left and right respectively.

● Rotation: Allows you to select whether the text annotation follows the rotation of the 
line or is always aligned with its axis; that is, one of the four cardinal directions.

● Ignore font metrics: Allows you to choose whether Dorico Pro uses a tight bounding 
rectangle or the font’s metrics for ascenders/descenders when calculating the position 
of text annotations relative to other items, such as line bodies, and their erased 
backgrounds.

● Erase background: Allows you to set whether or not the text annotation erases its 
background.

● Border: Allows you to show a border around the text annotation and set the border 
thickness.

RELATED LINKS
Creating custom line annotations on page 886
Line components on page 1404
Edit Lines dialog on page 888
Edit Font Styles dialog on page 846
Adding borders to line text on page 1420
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Edit Line Annotation dialog
The Edit Line Annotation dialog allows you to design custom music symbol line annotations and 
edit their appearance and arrangement.

NOTE

Line annotations copied from existing line annotations are linked to the original. Any changes 
you make to line annotations in the Edit Line Annotation dialog affect original line annotations 
and any copies of them.

● You can open the Edit Line Annotation dialog from inside the Edit Line Annotations dialog 
by adding a new music symbol annotation or selecting an existing one and clicking Edit in 
the options.

The Edit Line Annotation dialog contains the following sections and options:

1 Name

Contains an automatically generated name for the new music symbol annotation. You 
cannot change this name.

2 Component selector

Allows you to choose components to add to the music symbol annotation. You can add 
different types of components by clicking the respective tab titles.

● Glyph, for example, ♮ or ♯. You can use different styles of glyphs by selecting different 
fonts and font styles from the menus. You can search using SMuFL or Unicode ranges. 
Click Add Glyph to add the selected glyph to the music symbol annotation.

NOTE

A full list of the different ranges of glyphs is available on the SMuFL website.

● Text, including numbers and other text. You can use numbers and text from the 
available Preset text list or select any font available from the menu and enter your 
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preferred text into the text box at the bottom. Click Add Text to add the selected or 
input text to the music symbol annotation.

● Graphic: Allows you to load a new graphics file or select an existing graphic from the 
Select existing list in SVG, PNG, or JPG format. You can see a preview of the graphic 
in the Preview box. Click Add Graphic to add the selected graphic to the music symbol 
annotation.

3 Editor

Allows you to arrange and edit the components that make up the music symbol annotation. 
You can arrange and edit components by clicking and dragging them in the editor and 
by using the controls at the bottom of the dialog. You can also use the handles on each 
component to change their size.

4 Editor action bar

Contains selection and view options for the editor.

● Zoom: Allows you to change the zoom level in the editor.

● Select: Allows you to select the next/previous component.

● Show Attachments : Shows all the attachments on all components in the editor.

● Delete : Deletes the selected component.

5 Controls

Contains controls that allow you to edit individual components. Controls are divided into 
tabs according to the aspect of the selected component they affect. For music symbol 
annotations, the Component and Attachments tabs are available.

The Component tab contains the following options:

● Offset: Controls the position of the selected component. X moves it horizontally, Y 
moves it vertically.

● Scale: Controls the size of the selected component. For graphics, X controls its width, Y 
controls its height.

NOTE

Although some components scale their height and width independently, others retain 
their aspect ratio, meaning only one value affects their overall size.

● Z order: Allows you to Bring Forward or Send Backward the selected component in 
relation to other components when they overlap.

● Color: Allows you to change the color of the selected component.

The Attachments tab is only available if the music symbol annotation comprises at least two 
separate components. It contains the following options:

● Attachment from: Sets the attachment point on the component to the left of the 
selected component to which the selected component attaches. We recommend that 
you select a right edge attachment point for Attachment from.

● Attachment to: Sets the attachment point on the selected component which attaches to 
the component to its left. We recommend that you select a left edge attachment point 
for Attachment to.
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Edit Repeatable Symbols dialog
The Edit Repeatable Symbols dialog allows you to change the appearance and settings of all 
repeatable symbols in the project and add, edit, and delete custom repeatable symbols.

You can open the Edit Repeatable Symbols dialog in any of the following ways:

● Choose Library > Repeatable Symbols.

● In the Edit Line Bodies dialog, when editing a repeatable symbol line body, click Edit  in 
the symbol selector action bar.

The Edit Repeatable Symbols dialog contains the following sections and options:

1 Search field

Allows you to filter repeatable symbols according to your entry.

2 Repeatable symbols list

Contains all the repeatable symbols in the project.

The action bar at the bottom of the list contains the following options:

● New : Adds a new blank repeatable symbol and opens the Edit Repeatable Symbol 
dialog, where you can design your new repeatable symbol.

● Save as Default : Saves the selected repeatable symbol to your user library, allowing 
you to use it in multiple projects. Appears as  for repeatable symbols saved as default.

● Revert to Factory : Removes all your changes to the selected repeatable symbol, 
returning it to its saved settings and appearance.

● Delete : Deletes the selected repeatable symbol.

NOTE

You cannot delete predefined repeatable symbols or any repeatable symbol that is 
currently used in your project.

3 Name

Allows you to enter a new name or edit the existing name for the selected repeatable 
symbol.

4 Preview
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Displays the repeatable symbol in its current form.

The action bar below the preview contains the following options:

● Show Multiple: Allows you to show the selected repeatable symbol once or multiple 
times, as it might appear in a line body.

● Show Repeat Point: Hides/Shows a vertical line on the repeatable symbol or on each 
repetition at the point where the following symbol starts.

5 Line annotation options

Contains options that control the selected repeatable symbol.

● Symbol: Clicking Edit opens the Edit Repeatable Symbol dialog, where you can edit the 
appearance of the repeatable symbol.

● Repeat offset: Allows you to set the point along the repeatable symbol where the 
following symbol starts, measured in spaces from the left edge of the repeatable 
symbol.

RELATED LINKS
Creating custom repeatable symbols on page 887
Line components on page 1404
Edit Lines dialog on page 888
Edit Line Bodies dialog on page 891

Edit Repeatable Symbol dialog
The Edit Repeatable Symbol dialog allows you to design custom repeatable symbols and edit 
the appearance and arrangement of all repeatable symbols in the project.

● You can open the Edit Repeatable Symbol dialog from inside the Edit Repeatable Symbols 
dialog by adding a new repeatable symbol or selecting an existing one and clicking Edit in 
the options.

The Edit Repeatable Symbol dialog contains the following sections and options:

1 Name
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Contains the saved name for predefined repeatable symbols, or an automatically generated 
name for new repeatable symbols. You cannot change this name.

2 Component selector

Allows you to choose components to add to the repeatable symbol. You can add different 
types of components by clicking the respective tab titles.

● Glyph, for example, ♮ or ♯. You can use different styles of glyphs by selecting different 
fonts and font styles/weights from the menus. You can search using SMuFL or Unicode 
ranges. Click Add Glyph to add the selected glyph to the repeatable symbol.

NOTE

A full list of the different ranges of glyphs is available on the SMuFL website.

● Text, including numbers and other text. You can use numbers and text from the 
available Preset text list or select any font available from the menu and enter your 
preferred text into the text box at the bottom. Click Add Text to add the selected or 
input text to the repeatable symbol.

● Graphic: Allows you to load a new graphics file or select an existing graphic from the 
Select existing list in SVG, PNG, or JPG format. You can see a preview of the graphic 
in the Preview box. Click Add Graphic to add the selected graphic to the repeatable 
symbol.

3 Editor

Allows you to arrange and edit the components that make up the repeatable symbol. You 
can arrange and edit components by clicking and dragging them in the editor and by using 
the controls at the bottom of the dialog. You can also use the handles on each component to 
change their size.

4 Editor action bar

Contains selection and view options for the editor.

● Zoom: Allows you to change the zoom level in the editor.

● Select: Allows you to select the next/previous component.

● Show Attachments : Shows all the attachments on all components in the editor.

● Delete : Deletes the selected component.

5 Controls

Contains controls that allow you to edit individual components. Controls are divided into tabs 
according to the aspect of the selected component they affect. For repeatable symbols, the 
Component and Attachments tabs are available.

The Component tab contains the following options:

● Offset: Controls the position of the selected component. X moves it horizontally, Y 
moves it vertically.

● Scale: Controls the size of the selected component. For graphics, X controls its width, Y 
controls its height.

NOTE

Although some components scale their height and width independently, others retain 
their aspect ratio, meaning only one value affects their overall size.

● Z order: Allows you to Bring Forward or Send Backward the selected component in 
relation to other components when they overlap.

● Color: Allows you to change the color of the selected component.
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The Attachments tab is only available if the repeatable symbol comprises at least two 
separate components. It contains the following options:

● Attachment from: Sets the attachment point on the component to the left of the 
selected component to which the selected component attaches. We recommend that 
you select a right edge attachment point for Attachment from.

● Attachment to: Sets the attachment point on the selected component which attaches to 
the component to its left. We recommend that you select a left edge attachment point 
for Attachment to.

Custom tonality systems
Custom tonality systems allow you to specify a unique number of divisions of the octave for 
your project. This can be useful for music not based on traditional Western harmony. In Dorico 
Pro, you can design your own custom accidentals and combine them into custom key signatures 
within each custom tonality.

You can create custom tonality systems and edit existing tonality systems in the Edit Tonality 
System dialog. You can also export tonality systems; for example, to share them with other 
users. Tonality systems are saved as .doricolib files.

RELATED LINKS
Tonality systems on page 1219
Custom divisions of the octave on page 907
Custom accidentals on page 907
Custom key signatures on page 910

Creating custom tonality systems
You can create custom tonality systems, which can have any number of octave divisions and 
contain as many custom accidentals and custom key signatures as required. Each project can 
contain multiple custom tonality systems.

PROCEDURE

1. In Write mode, click Panels , then Key Signatures, Tonality Systems, and Accidentals 
 in the Notations toolbox to show the Key Signatures, Tonality Systems, and Accidentals 

panel.

2. In the Tonality System section, create a new tonality system and open the Edit Tonality 
System dialog in one of the following ways:

● To create an entirely new tonality system, click New Tonality System  in the action 
bar.

● To create a copy of an existing tonality system, select it from the menu and click 
Duplicate Tonality System  in the action bar.

3. Enter a name for the new custom tonality system in the Name field.

4. In the Divisions section, change the number of octave divisions assigned to each interval.

For example, you might give the intervals A-B, C-D, D-E, F-G and G-A a different number of 
octave divisions than for B-C and E-F.

5. In the Accidentals section, create a new custom accidental or edit an existing accidental.

● To create a new custom accidental, click New Accidental  in the action bar to open the 
Edit Accidental dialog.
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● To create a copy of an existing accidental, select it and click Duplicate Accidental  in 
the action bar to open the Edit Accidental dialog.

● To edit an existing accidental, select it and click Edit Accidental  in the action bar to 
open the Edit Accidental dialog.

6. Customize the appearance, name, and pitch delta of the accidental.

NOTE

● We do not recommend setting pitch deltas that are more than half of the total number 
of octave divisions.

● You cannot change the pitch delta when editing the default accidentals in the default 
12-EDO and 24-EDO tonality systems.

7. Click OK to save your changes and close the Edit Accidental dialog.

8. Optional: Repeat steps 5 to 7 for each accidental you want in your custom tonality system.

9. In the Custom Key Signatures section, add a new custom key signature or edit one of the 
default custom key signatures.

● To edit one of the default custom key signatures, select it and click Edit Key Signature 
 in the action bar to open the Edit Custom Key Signature dialog.

● To create a new custom key signature, click New Key Signature  in the action bar to 
open the Edit Custom Key Signature dialog.

10. Customize the arrangement of the key signature.

11. Click OK to save your changes and close the Edit Custom Key Signature dialog.

12. Optional: Repeat steps 9 to 11 for each custom key signature you want in your custom 
tonality system.

13. Optional: If you want your new custom tonality system to be available in all future projects 
you open on your computer, click Save As Default.

14. Click OK to save your changes and close the Edit Tonality System dialog.

RESULT
The new custom tonality system is added to the project and becomes available in the menu in 
the Tonality System section of the Key Signatures, Tonality Systems, and Accidentals panel. If 
you clicked Save As Default, it is available in all future projects on your computer.

AFTER COMPLETING THIS TASK

● You can change the tonality system; for example, so your new custom tonality system 
applies to a specific section of music.

● You can export custom tonality systems; for example, to share them with other users.

RELATED LINKS
Changing the tonality system on page 1220
Exporting tonality systems on page 1221
Edit Accidental dialog on page 908
Edit Custom Key Signature dialog on page 911
Key Signatures, Tonality Systems, and Accidentals panel on page 280
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Creating/Editing custom accidentals
You can create new and edit existing custom accidentals; for example, if your tonality system 
does not have equal divisions of the octave and so requires specific accidental glyphs to indicate 
the amount by which pitches are raised/lowered.

PREREQUISITE
If you want to create/edit accidentals for a custom tonality system, you have created that custom 
tonality system.

PROCEDURE

1. In Write mode, click Panels , then Key Signatures, Tonality Systems, and Accidentals 
 in the Notations toolbox to show the Key Signatures, Tonality Systems, and Accidentals 

panel.

2. In the Tonality System section, select the tonality system for which you want to create or 
edit custom accidentals from the menu.

3. Click Edit Tonality System  to open the Edit Tonality System dialog.

4. In the Accidentals section, open the Edit Accidental dialog in one of the following ways:

● To create a new custom accidental, click New Accidental  in the action bar.

● To create a copy of an existing accidental, select it and click Duplicate Accidental  in 
the action bar.

● To edit an existing accidental, select it and click Edit Accidental  in the action bar.

5. Optional: Enter a name for the new custom accidental in the Name field. You can also edit 
the name of existing accidentals.

6. Optional: If you created a new custom accidental, change the value in the Pitch delta value 
field to change the number of octave divisions by which it raises/lowers notes.

NOTE

● We do not recommend setting pitch deltas that are more than half of the total number 
of octave divisions.

● You cannot change the pitch delta when editing the default accidentals in the default 
12-EDO and 24-EDO tonality systems.

7. Customize the appearance of the accidental.

For example, you can add glyphs to your accidental using the options on the right, then 
arrange and resize them in the editor.

8. Click OK to save your changes and close the Edit Accidental dialog.

9. Optional: Repeat steps 4 to 8 for each custom accidental you want to create for the current 
tonality system.

10. Click OK to save your changes and close the Edit Tonality System dialog.

AFTER COMPLETING THIS TASK
You can arrange your custom accidentals into a custom key signature.

RELATED LINKS
Edit Accidental dialog on page 908
Custom accidentals on page 907
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Creating/Editing custom key signatures
You can create new and edit existing custom key signatures in any tonality system; for example, 
to show an arrangement of custom accidentals.

PREREQUISITE
If you want to create/edit key signatures for a custom tonality system, you have created that 
custom tonality system.

PROCEDURE

1. In Write mode, click Panels , then Key Signatures, Tonality Systems, and Accidentals 
 in the Notations toolbox to show the Key Signatures, Tonality Systems, and Accidentals 

panel.

2. In the Tonality System section, select the tonality system for which you want to create or 
edit custom key signatures from the menu.

3. Click Edit Tonality System  to open the Edit Tonality System dialog.

4. In the Custom Key Signatures section, open the Edit Custom Key Signature dialog in one 
of the following ways:

● To create a new custom key signature, click New Key Signature  in the action bar.

● To edit an existing custom key signature, select it and click Edit Key Signature  in the 
action bar.

5. Optional: Enter a name for the new custom key signature in the Name field. You can also 
edit the name of existing custom key signatures.

6. Customize the arrangement of the key signature.

For example, you can add accidentals to the key signature and then change the pitch 
and octave to which it applies. You can also select other clefs to see how they affect the 
arrangement of the key signature.

7. Click OK to save your changes and close the Edit Custom Key Signature dialog.

8. Optional: Repeat steps 4 to 7 for each custom key signature you want to create for the 
current tonality system.

9. Click OK to save your changes and close the Edit Tonality System dialog.

RELATED LINKS
Edit Custom Key Signature dialog on page 911
Custom key signatures on page 910

Edit Tonality System dialog
The Edit Tonality System dialog allows you to create custom tonality systems and edit existing 
tonality systems.

You can open the Edit Tonality System dialog in the following ways:

● To create a new tonality system, click New Tonality System  in the Tonality System 
section of the Key Signatures, Tonality Systems, and Accidentals panel.

● To create a copy of an existing tonality system, select it from the menu in the Tonality 
System section of the Key Signatures, Tonality Systems, and Accidentals panel and click 
Duplicate Tonality System .
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● To edit an existing tonality system, select it from the menu in the Tonality System section of 
the Key Signatures, Tonality Systems, and Accidentals panel and click Edit Tonality System 

.

The Edit Tonality System dialog contains the following sections and options:

1 Name

Allows you to enter a name for a new tonality system, or edit the name of an existing custom 
tonality system you created.

2 Divisions

Allows you to specify how many divisions of the octave you want assigned to each interval.

3 Accidentals

Displays the accidentals currently available in the selected tonality system in a list, from 
lowest pitch delta at the top to highest pitch delta at the bottom.

The Search field allows you to filter accidentals according to your entry.

The action bar at the bottom of the section contains the following options:

● New Accidental : Opens the Edit Accidental dialog and allows you to create a new 
accidental.

● Duplicate Accidental : Opens the Edit Accidental dialog and allows you to create a 
new accidental that is a copy of an existing accidental.

● Edit Accidental : Opens the Edit Accidental dialog and allows you to edit the existing 
selected accidental.

● Delete Accidental : Deletes the selected accidental.

NOTE

You cannot delete predefined accidentals in the default tonality systems.

4 Custom Key Signatures

Displays the custom key signatures currently available in the selected tonality system.

The action bar at the bottom of the section contains the following options:
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● New Key Signature : Opens the Edit Custom Key Signature dialog and allows you to 
create a new custom key signature.

● Edit Key Signature : Opens the Edit Custom Key Signature dialog and allows you to 
edit the selected custom key signature.

● Delete Key Signature : Deletes the selected custom key signature.

5 Save As Default

Saves the tonality system, either a new custom one or edits you have made to a default 
tonality system, as a default in your user library, allowing you to use it in all future projects.

RELATED LINKS
Key Signatures, Tonality Systems, and Accidentals panel on page 280
Custom divisions of the octave on page 907
Edit Accidental dialog on page 908
Edit Custom Key Signature dialog on page 911

Custom divisions of the octave
You can change the number of divisions of the octave for an existing tonality system, or create a 
new tonality system with as many divisions of the octave as you like.

In the Divisions section of the Edit Tonality System dialog, you can change the number of 
divisions assigned to each interval. The total number of divisions of an octave, which is shown at 
the top of the section, is updated automatically as you change the number of divisions.

In Equal temperament, or 12-EDO, the total number of divisions is 12. There are 2 divisions 
between A and B, 1 division between B and C, and so on. This follows the standard Western 
pattern which you can also see in the pattern of white and black keys on a keyboard.

Although you can divide the octave into any number of divisions, the number of equal divisions 
in the octave must be divisible by 12 to be able to show a standard Western key signature in 
Dorico Pro.

RELATED LINKS
Creating custom tonality systems on page 902
Custom key signatures on page 910

Custom accidentals
Custom accidentals can contain traditional accidental glyphs but also other musical symbols, 
text, and graphics. This allows you to design accidentals that express specific pitch deltas in your 
custom tonality systems.

● You can find all accidentals available in the current tonality system in the Accidentals section 
of the Edit Tonality System dialog.

You can create new and edit existing custom accidentals in the Edit Accidental dialog. You can 
edit accidentals included in the default tonality systems that come with Dorico Pro. New custom 
tonality systems start with a natural accidental, which you can edit or delete.

RELATED LINKS
Creating custom tonality systems on page 902
Creating/Editing custom accidentals on page 904
Edit Tonality System dialog on page 905
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Edit Accidental dialog
The Edit Accidental dialog allows you to create new and edit existing custom accidentals.

● You can open the Edit Accidental dialog from inside the Edit Tonality System dialog by 
clicking either New Accidental , Duplicate Accidental , or Edit Accidental  in the 
Accidentals section action bar.

The Edit Accidental dialog contains the following sections:

1 Name

Allows you to enter a name for your accidental.

2 Pitch delta

Allows you to set a value for how much the accidental raises/lowers the pitch of notes. For 
example, in 12-EDO, a pitch delta of 1 raises notes by a half-step (semitone).

NOTE

We do not recommend setting pitch deltas that are more than half of the total number of 
octave divisions.

3 Accidental component selector

Allows you to choose components to add to your accidental. You can add different types of 
components by clicking the respective tab titles.

● Glyph, for example, ♮ or ♯. You can use different styles of glyphs by selecting different 
fonts and font styles/weights from the menus. You can search using SMuFL or Unicode 
ranges. Click Add Glyph to add the selected glyph to the accidental.

NOTE

A full list of the different ranges of glyphs is available on the SMuFL website.
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● Text, including numbers and other text. You can use numbers and text from the 
available Preset text list or select any font available from the menu and enter your 
preferred text into the text box at the bottom. Click Add Text to add the selected or 
input text to the accidental.

● Graphic: Allows you to load a new graphics file or select an existing graphic from the 
Select existing list in SVG, PNG, or JPG format. You can see a preview of the graphic in 
the Preview box. Click Add Graphic to add the selected graphic to the accidental.

4 Editor

Allows you to arrange and edit the components that make up your accidental. You can use 
the controls at the bottom of the dialog to edit and arrange accidental components.

5 Editor action bar

Contains selection and view options for the editor.

● Zoom: Allows you to change the zoom level in the editor.

● Select: Allows you to select the next/previous component.

● Delete : Deletes the selected component.

6 Controls

Contains controls that allow you to edit individual components. Controls are divided into 
tabs according to the aspect of the selected component they affect. For accidentals, the 
Component, Attachments, and Cut-outs tabs are available.

The Component tab contains the following options:

● Offset: Controls the position of the selected component. X moves it horizontally, Y 
moves it vertically.

● Scale: Controls the size of the selected component. For graphics, X controls its width, Y 
controls its height.

NOTE

Although some components scale their height and width independently, others retain 
their aspect ratio, meaning only one value affects their overall size.

● Z order: Allows you to Bring Forward or Send Backward the selected component in 
relation to other components when they overlap.

● Color: Allows you to change the color of the selected component.

The Attachments tab is only available if the accidental comprises at least two separate 
components. It contains the following options:

● Attachment from: Sets the attachment point on the component to the left of the 
selected component to which the selected component attaches. We recommend that 
you select a right edge attachment point for Attachment from.

● Attachment to: Sets the attachment point on the selected component which attaches to 
the component to its left. We recommend that you select a left edge attachment point 
for Attachment to.

The Cut-outs tab allows you to mark individual corners within an accidental component 
that can overlap with other accidentals; for example, in order to position accidentals closer 
together in dense chords. It contains the following options for each of the four corners, 
which are labeled according to their compass direction:

● Width: Sets the width of the cut-out area.

● Height: Sets the height of the cut-out area.

● Add : Adds a cut-out to the corresponding corner.
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● Delete : Removes the cut-out from the corresponding corner.

There are eight attachment points for glyphs and graphics, and eleven for text, due to the 
extra space required for letters that extend below the baseline. The example diagram helps you 
visualize how these points relate to components.

The attachment points have the following names in the Edit Accidental dialog:

1 Top Left

2 Top Center

3 Top Right

4 Middle Left

5 Middle Right

6 Baseline Left (text only)

7 Baseline Center (text only)

8 Baseline Right (text only)

9 Bottom Left

10 Bottom Center

11 Bottom Right

RELATED LINKS
Edit Tonality System dialog on page 905
Creating/Editing custom accidentals on page 904

Custom key signatures
Custom key signatures can comprise traditional accidentals in a different order, or custom 
accidentals you have designed in a specific order for your requirements.

● You can find all key signatures available in the current tonality system in the Custom Key 
Signatures section of the Edit Tonality System dialog.

NOTE

If you edit one of the default tonality systems that come with Dorico Pro, no key signatures are 
available to edit in this section. However, you can create new key signatures within one of the 
default tonality systems.

You can create new and edit existing custom key signatures for both new and existing tonality 
systems in the Edit Custom Key Signature dialog. You can then input them from the Custom 
Key Signatures section of the Key Signatures, Tonality Systems, and Accidentals panel.

RELATED LINKS
Creating custom tonality systems on page 902
Creating/Editing custom key signatures on page 905
Edit Tonality System dialog on page 905
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Key Signatures, Tonality Systems, and Accidentals panel on page 280
Inputting key signatures with the panel on page 283

Edit Custom Key Signature dialog
The Edit Custom Key Signature dialog allows you to create new and edit existing custom key 
signatures.

● You can open the Edit Custom Key Signature dialog from inside the Edit Tonality System 
dialog by clicking either New Key Signature  or Edit Key Signature  in the Custom Key 
Signatures section action bar.

The Edit Custom Key Signature dialog contains the following sections:

1 Name

Allows you to enter a name for your key signature.

2 Clef

Shows how your key signature appears in treble clef, bass clef, alto clef, and tenor clef. You 
can edit your key signature in any of these clefs.

3 Root

Allows you to select the base note of your key signature from the menu.

4 Accidentals

Allows you to add accidentals from your tonality system to the key signature, including 
custom accidentals you have created in the Edit Accidental dialog. Click Add Accidental to 
Key Signature to add the selected accidental to the key signature.

5 Editor

Allows you to arrange accidentals in your preferred order using the Order arrow buttons, 
and change their position on the staff using the Note arrow buttons and Octave arrow 
buttons.
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RELATED LINKS
Key Signatures, Tonality Systems, and Accidentals panel on page 280
Edit Tonality System dialog on page 905
Edit Accidental dialog on page 908
Creating/Editing custom key signatures on page 905

Playback of custom tonality systems
Dorico Pro can play back custom tonality systems with any number and distribution of octave 
divisions.

Dorico Pro achieves full microtonal playback by calculating the appropriate pitch delta for every 
note, whether or not it is written with an accidental. Depending on the virtual instruments used 
for playback, Dorico Pro produces microtonal playback in different ways.

● For HALion virtual instruments, Dorico Pro uses VST 3 Note Expression.

● For all other instruments, including NotePerformer, Dorico Pro uses the VST 2 detune 
parameter.

RELATED LINKS
Custom tonality systems on page 902
Changing the playback tuning on page 635

Expression maps
Expression maps tell Dorico Pro how to use appropriately the patches and sounds in the VST 
instruments that you have loaded into your project.

Expressing a range of dynamics on instruments means changing the volume and attack of 
notes. Because the strength of attack changes the character of the start of sounds as well as 
their volume, loud sounds often require stronger attacks and quiet sounds often require softer 
attacks.

Different patches and instruments have different approaches to changing dynamics and volume 
in playback. For example, some patches only change the velocity whereas others use a controller 
in combination with changing the velocity.

Dorico Pro also uses expression maps to specify the playback techniques that are supported 
by each patch in your project. For example, string instruments such as the violin have different 
techniques, because they can play arco, pizzicato, and col legno, and their bow position can be 
anywhere between sul ponticello and sul tasto.

In addition to the HALion Symphonic Orchestra expression maps, there are the following 
expression maps in Dorico Pro:

● CC11 Dynamics: Uses MIDI controller 11 to play dynamics.

NOTE

This only applies to instruments that can change their dynamic while notes are sounding, 
such as violin or flute.

● Default: Uses note velocity to control dynamic volume.

● Modulation Wheel Dynamics: Uses a modulation wheel to control dynamic volume.

● Transpose down 1 octave: Used by some instrument patches that sound an octave higher 
than written so that they can be played without needing a full range keyboard.
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● Transpose up 1 octave: Allows the bottom octave of keyboards to be used for key switches 
instead of notes, but is also used by some bass instrument patches that sound an octave 
lower than written so that they can be played without needing a full range keyboard.

You can edit, create, and import/export expression maps in the Expression Maps dialog. 
Expression maps are saved as .doricolib files.

NOTE

Although Dorico Pro approaches expression maps in a different way to Cubase, Dorico Pro 
correctly imports many switches from expression maps you import from Cubase, such as 
pizzicato, harmonics, and flutter tongue.

RELATED LINKS
Percussion maps on page 930
Types of actions on page 925
Creating new expression maps on page 926

Expression Maps dialog
The Expression Maps dialog allows you to create new expression maps, edit existing expression 
maps, and import/export expression maps. You can also import expression maps made in 
Cubase.

● You can open the Expression Maps dialog by choosing Library > Expression Maps.

The Expression Maps dialog contains the following sections and options:
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Expression maps list

1 Expression maps list: Contains the expression maps currently available in your project.

2 Search field: Allows you to filter expression maps according to your entry.

3 Show only expression maps used in this project: Allows you to filter the expression maps 
list so it only includes expression maps used in the current project.

4 Expression maps list action bar: Contains the following options:

● Add Expression Map : Adds a new expression map that contains no existing settings.

● Duplicate Expression Map : Creates a copy of an existing expression map that you 
can edit separately from the original.

● Delete Expression Map : Deletes the selected expression maps.

NOTE

You can only delete custom expression maps. You cannot delete any default expression 
maps.

Expression Map Data

This section allows you to specify identifying information for the selected expression map.

You can hide/show the Expression Map Data section by clicking the section header.

The Expression Map Data section contains the following options:
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Name
Allows you to set the name of the expression map that appears in the program; for 
example, in the Endpoint Setup dialog.

ID
Allows you to set the unique ID of the expression map. You can enter any content in 
the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name; for example, xmap.user.paulsmith.hso.violinpizz.

Creator
Allows you to name the creator if you are sharing your expression map with other 
users.

Version
Allows you to indicate the expression map version, so you can identify the most recent 
one.

Plug-ins
Allows you to list the names of plug-ins to which the expression map applies, with each 
name separated by a comma. You can leave this field blank.

Allow multiple notes at same pitch
Allows you to set whether or not the plug-in can treat identical pitches in 
multiple voices belonging to the same instrument as multiple separate notes when 
independent voice playback is disabled.

Description
Allows you to add any other information about the expression map.

NOTE

All fields in the Expression Map Data section are locked by the Lock Info  button. You must 
click this button to unlock Lock Info  in order to change the information in the fields.

Base and Add-on Switches

This section allows you to view, edit, and control the switches for playback techniques in the 
selected expression map.

You can hide/show the Base and Add-on Switches section by clicking the section header.
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The Base and Add-on Switches section contains the following:

1 Switches table: Contains the switches in the currently selected expression map. Allows you 
to add new switches and edit existing ones.

2 Name: Allows you to change the name that appears for the currently selected switch in the 
Switches table; for example, so it appears the same as in your sound library.

TIP

You can still see which playback techniques are triggered by switches with custom names by 
hovering the mouse pointer over the corresponding row in the Switches table.

3 Enabled: Allows you to enable/disable the currently selected switch without removing it from 
the expression map.

4 Actions: Contains any actions required to produce the selected playback technique. Allows 
you to add new actions and edit existing ones.

5 Conditions: Contains any conditions that determine the circumstances in which the currently 
selected switch is used. Allows you to add new conditions and edit existing ones. Only 
available for Base switches.

6 Technique controls: Contains controls that affect the switch currently selected in the 
Switches table. Only available for Base switches.

Switches table

Contains the switches in the currently selected expression map.
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The Switches table comprises the following:

1 Type column: Displays the switch type. Switches can be any of the following types:

● Base

● Add-on

● Init

2 Name column: Displays the name of the switch. By default, this is the same as the playback 
technique or playback technique combination it triggers.

In simple cases, each switch triggers an individual playback technique, such as Staccato 
or Accent. However, some plug-ins have separate samples for different combinations of 
playback techniques. For example, Staccato + Accent might require a separate set of key 
switches to Staccato and Accent individually.

3 Switches table action bar: Contains the following options:

● Add Base Switch : Allows you to add a new base switch to the expression map 
by selecting the playback techniques you want the switch to trigger in the Playback 
Technique Combinations dialog that opens.

● Add Technique Add-on Switch : Allows you to add a new add-on switch to the 
expression map by selecting the playback techniques you want the switch to trigger 
in the Playback Technique Combinations dialog that opens.

● Duplicate Technique : Creates a copy of an existing switch that you can edit 
separately from the original.

● Edit Technique : Opens the Playback Technique Combinations dialog, which allows 
you to edit the combination of playback techniques triggered by the selected switch.

You can also edit the playback techniques of existing switches by double-clicking them in 
the Switches table.

● Audition : Plays two notes using the currently selected switch and any corresponding 
actions to demonstrate their effect on playback. Only available for expression maps used 
in the project.

● Transpose Up 1 Octave : Raises the octave of all key switch actions for the selected 
switch.

● Transpose Down 1 Octave : Lowers the octave of all key switch actions for the 
selected switch.
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● Delete Technique : Deletes the selected switch.

Selecting a switch in the Switches table allows you to edit its controls and actions. Different 
options are available in the Base and Add-on Switches section depending on the switch type.

NOTE

● Most instruments have a “natural” playback technique, which is the most common way of 
playing the instrument. Dorico Pro requires every instrument to have a defined natural 
playback technique.

● You can only select one switch at a time in the Switches table.

Actions

Displays in a table any actions required to produce the selected playback technique. Allows you 
to determine how the switch that triggers each playback technique is controlled, either by adding 
new actions or editing existing ones.

NOTE

Depending on your plug-in, multiple types of actions can be required for each switch.

The Actions subsection comprises the following:

1 Middle C (note 60): Allows you to choose the pitch for middle C, as there are different 
conventions for this. We recommend that you consult the documentation for your sound 
libraries to check whether each one considers middle C to be C3, C4, or C5, and change this 
setting accordingly.

2 On events/Off events: Allows you to specify whether actions affect the start or end of notes. 
For example, you might want an event that resets the playback technique back to normal to 
apply only to the end of notes.

On events affects the start of notes. Off events affects the end of notes.

3 Actions table: Contains the following columns:

● First column: Displays the action type. Actions can be a control change, program change, 
or key switch.

● Second column: Controls the first parameter of the MIDI event. For key switches, this 
indicates the pitch. For control changes, this indicates the control change number. For 
program changes, this indicates the program number.

● Third column: Controls the second parameter of the MIDI event. For key switches, this 
indicates the velocity. For control changes, this indicates the amount of control change 
within the range 0 to 127. Program changes do not have a second parameter.
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NOTE

● You can change the values of cells in the Actions table by double-clicking them, or 
selecting them and pressing Return .

● You can only select one action at a time in the Actions table.

4 Actions table action bar: Contains the following options:

● Add Control Change Action : Adds a control change action with default settings.

● Add Program Change Action : Adds a program change action with default settings.

● Add Key Switch Note Action : Adds a key switch action with default settings.

● Add Absolute Channel Change Action: Adds an absolute channel change action with 
default settings.

● Add Relative Channel Change Action: Adds a relative channel change action with 
default settings.

● Duplicate Action : Creates a copy of an existing action that you can edit separately 
from the original.

● Move Action Up : Moves the selected action up the table, which changes its order in 
the message sequence.

● Move Action Down : Moves the selected action down the table, which changes its 
order in the message sequence.

● Delete Action : Deletes the selected action.

Conditions

Displays in a table any conditions that determine the circumstances in which the base switch 
currently selected in the Switches table is used. Allows you to add new conditions and edit 
existing ones. Only available for Base switches.

For example, you can set conditions instructing the expression map to use a different legato 
sound with a quicker attack for short notes than for longer notes automatically.

The Conditions subsection comprises the following:

1 Any of/All of: Allows you to set whether the switch is used when one or more conditions are 
met or only when all conditions are met.

2 Conditions table: Contains the following columns:

● First column: Displays the condition type.

● Second column: Controls how the condition type in the first column relates to the note 
length set in the third column using operators. The following operators are available:

● ==: Equal to
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● !=: Not equal to

● <: Less than

● <=: Less than or equal to

● >: More than

● >=: More than or equal to

● Third column: Controls the note length used by the condition. The following note length 
values are available:

● Very short: A dotted 16th note at 120 bpm, or 0.1875 seconds

● Short: A dotted eighth note at 120 bpm, or 0.375 seconds

● Medium: A dotted quarter note at 120 bpm, or 0.75 seconds

● Long: A dotted half note at 120 bpm, or 1.5 seconds

● Very long: Any longer duration

NOTE

● You can change the values of cells in the Conditions table by double-clicking them, 
or selecting them and pressing Return .

● You can only select one condition at a time in the Conditions table.

3 Conditions action bar: Contains the following options:

● Add Technique : Adds a new technique condition with default settings.

● Duplicate Technique : Creates a copy of an existing technique condition that you can 
edit separately from the original.

● Delete Technique : Deletes the selected technique condition.

Technique controls

Contains controls that affect the base switch currently selected in the Switches table. Only 
available for Base switches.

The following technique controls are available:

● Transpose: Allows you to set the MIDI transposition in half-steps (semitones).

● Length %: Allows you to modify played note durations, which overrides the default value; for 
example, if you want the selected switch to produce short gaps between notes.
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● For notes a quarter note or shorter in duration, the value applies to the entire note.

● For notes longer than a quarter note, the value only applies to the last quarter note of 
their overall duration.

● Volume dynamic: Allows you to choose whether the volume dynamic for the selected switch 
is controlled by its Note velocity or a Control change.

NOTE

If you choose Control change, you must specify the controller by number. You can consult 
the documentation for the VST instrument and/or MIDI controller you are using to find the 
appropriate controller number.

● Volume dynamic Min/Max: Allow you to set the minimum and maximum range for 
dynamics using either note velocity or MIDI CC, depending on the sound library.

● Use Secondary dynamic: Allows you to define an additional volume control for sound 
libraries that use both note velocity and control changes for volume dynamic.

● Secondary dynamic Min/Max: Allow you to set the minimum and maximum range for 
dynamics using either note velocity or MIDI CC, depending on the sound library.

Playback Options Overrides

Allows you to override specific playback options for the selected expression map only. Activating 
a playback option overrides it. The available playback options include the default duration of 
notes with different articulations, unmeasured tremolo notes, and the effect that beat position 
and articulations have on dynamics. By default, the values set match the current settings in 
Playback Options.

You can hide/show the Playback Options Overrides section by clicking the section header.
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Mutual Exclusion Groups

Allows you to define playback techniques that are mutually exclusive; that is, cannot be in use 
concurrently. For example, players cannot play vibrato and non-vibrato at the same time. Putting 
playback techniques into the same exclusion group means only one can be used at a time.

You can allow Dorico Pro to define mutual exclusion groups automatically or define them 
yourself manually.

Mutual exclusion groups apply only to the selected expression map. This allows you to set 
different mutual exclusion groups in each expression map; for example, if one of your sound 
libraries supports a particular playback technique combination for an instrument but another 
sound library does not.

You can hide/show the Mutual Exclusion Groups section by clicking the section header.

The Mutual Exclusion Groups section contains the following options and columns:

1 Auto: Allows Dorico Pro to define mutual exclusion groups automatically.

NOTE

Activating Auto permanently deletes any manual exclusion groups you have created.

2 Mutual Exclusion Groups column: Allows you to add and delete mutual exclusion groups 
manually. The action bar at the bottom of the column contains the following options:

● Add : Opens a dialog that allows you to create a new mutual exclusion group and 
enter a name for it.

● Delete : Deletes the selected mutual exclusion group.

NOTE

You can only select one mutual exclusion group at a time.

3 Has techniques column: Allows you to change the playback techniques included in the 
selected mutual exclusion group. The action bar at the bottom of the column contains the 
following options:

● Add : Opens the Playback Technique Combinations dialog that allows you to select 
playback techniques to add to the selected mutual exclusion group.

● Delete : Deletes the selected playback technique from the mutual exclusion group.

Library
Expression maps 

922
Dorico Pro 4.3.30



NOTE

You can only select one playback technique at a time.

Expression map/Library management options

At the bottom of the Expression Maps dialog, there are the following expression map and library 
management options:

Reset to Library Defaults
Allows you to revert any changes you have made to the expression maps from the 
Default Library.

Import Library
Opens the File Explorer/macOS Finder, where you can select the .doricolib files that 
you want to import as expression maps.

You can also import Dorico and Cubase expression maps by dragging and dropping 
them into the Expression Maps dialog.

Export Library
Opens the File Explorer/macOS Finder, where you can select the location to which you 
want to export the currently selected expression maps as a .doricolib file. You can 
then import the .doricolib file into other projects and share it with other users.

Import Cubase Expression Map
Opens the File Explorer/macOS Finder, where you can select the 
Cubase .expressionmap files you want to import as expression maps.

NOTE

Cubase expression maps that you have imported often require some editing to 
function correctly in Dorico Pro. However, switch data is preserved.

RELATED LINKS
Types of switches on page 925
Types of actions on page 925
Playback techniques on page 936
Endpoint Setup dialog on page 659
Edit Playback Techniques dialog on page 937
Enabling independent voice playback on page 636
Creating new expression maps on page 926
Adding/Editing switches in expression maps on page 927
Adding/Editing mutual exclusion groups in expression maps on page 929
Playback Options dialog on page 842
Playback Options for dynamics on page 1137

Playback Technique Combinations dialog
The Playback Technique Combinations dialog allows you to create combinations of playback 
techniques that you want to apply simultaneously. Playback techniques are used by expression 
maps to assign the correct sounds to the required playing techniques in the music.

You can open the Playback Technique Combinations dialog in the following ways:
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● In the Expression Maps dialog, click Add Technique  in the Switches table action bar.

● In the Expression Maps dialog, select an existing playback technique in the Switches table 
and click Edit Technique  in the Techniques action bar. You can also double-click the 
playback technique.

1 Techniques list

Allows you to select playback techniques to include in a new switch or to change the 
playback techniques in an existing switch.

You can select multiple playback techniques to combine by Ctrl/Cmd -clicking each playback 
technique.

2 Name

Displays the name of the selected playback technique. If you select multiple playback 
techniques, each name is automatically separated by a + symbol.

NOTE

You cannot rename playback techniques or playback technique combinations in the 
Playback Technique Combinations dialog. You can rename the switches that include them 
in the Base and Add-on Switches section of the Expression Maps dialog. You can rename 
individual playback techniques in the Edit Playback Techniques dialog.

RELATED LINKS
Expression Maps dialog on page 913
Edit Playback Techniques dialog on page 937
Adding/Editing switches in expression maps on page 927
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Types of switches
Switches are used in expression maps to trigger the required playback technique or combination 
of playback techniques. Dorico Pro supports multiple types of switches.

Base
A fundamental change to the playing technique or articulation, such as changing from 
arco to pizzicato or unmuted to muted. Base switches are mutually exclusive, meaning 
a new base switch replaces the previous one.

Add-on
A switch that applies in addition to the existing base switch. For example, some sound 
libraries allow you to use the same legato switch in addition to different base switches. 
Add-on switches do not remove or change base switches. Add-on switches can only 
trigger simple key switch notes and controller values.

Init
A switch that sends instructions when playback starts, such as ensuring a MIDI 
controller always starts at a set value. By default, every expression map contains an 
empty init switch. Init switches can only trigger simple key switch notes and controller 
values.

RELATED LINKS
Expression Maps dialog on page 913
Adding/Editing switches in expression maps on page 927
Adding/Editing mutual exclusion groups in expression maps on page 929

Types of actions
Actions are used in expression maps to determine how individual switches are controlled in order 
to trigger the required playback technique or combination of playback techniques. Dorico Pro 
supports multiple types of actions, as different sound libraries require different actions.

Control change actions
Control change actions use MIDI CC events to modulate sounds. They are particularly 
useful when using sound libraries whose sounds can be manipulated incrementally, 
such as increasing/decreasing the string vibrato intensity.

Program change actions
Program change actions use MIDI PC events to switch to different sounds. They are 
particularly useful when using sound libraries, such as General MIDI, that use separate 
programs for each playback technique or combinations of instrument sounds and 
effects presets.

Key switch actions
Key switch actions use MIDI note events to switch to different sounds. They are 
particularly useful when recording MIDI live, as you can press the specified notes on a 
MIDI keyboard to trigger key switch actions while simultaneously playing the notes you 
want to record. Usually, key switch actions are mapped to notes in the lowest octave of 
the MIDI keyboard as they are rarely used for note input.

Key switch actions are also known as “note events”.

Absolute channel change actions
Absolute channel change actions switch to a specific, explicitly numbered channel. 
They are particularly useful for sound libraries that have separate plug-in instances for 
each individual instrument. For example, you might use an absolute channel change 
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action to switch from “natural” on channel 1 to “pizzicato” on channel 2 in your viola 
section plug-in instance.

Relative channel change actions
Relative channel change actions switch to a channel numbered relative to the starting 
channel. They are particularly useful for sound libraries that have multiple instruments 
with separate playback technique channels in the same plug-in instance, as they can 
switch between playback techniques according to their relative channel number rather 
than an absolute number. For example, if you have four trumpet instruments loaded in 
the same plug-in instance, each with three channels for different playback techniques, 
and want to use the same switches for all four trumpets, you might use a relative 
channel change action to switch from the “natural” original channel to “muted” on the 
+1 relative channel.

Relative channel numbers relate to the original channel number of the endpoint for the 
corresponding instrument. A 0 relative channel change switches back to the original 
channel.

TIP

You can add actions to individual switches in the Expression Maps dialog.

Creating new expression maps
You can create new expression maps from scratch, and you can duplicate existing expression 
maps and edit the settings; for example, when using third-party sound libraries or MIDI devices 
that do not provide expression maps.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. Create a new expression map in one of the following ways:

● To create an empty expression map, click Add Expression Map  in the expression 
maps list action bar.

● To create a copy of an existing expression map, select it in the expression maps list and 
click Duplicate Expression Map  in the action bar.

3. In the Expression Map Data section, click Lock Info  to unlock the fields.

4. In the Expression Map Data section, enter information for your expression map in the 
relevant fields.

5. Activate/Deactivate Allow multiple notes at same pitch.

6. Optional: In the Base and Add-on Switches section, add any new switches you require to 
trigger playback techniques or combinations of playback techniques.

7. In the Switches table, select a switch whose actions, conditions, and/or controls you want to 
edit.

8. Change any settings for the selected switch as required.

For example, you can add actions for all switch types or, for base switches only, choose 
whether the volume of a selected base switch is controlled by its Note velocity or a Control 
change.

9. Optional: Repeat steps 7 and 8 for all switches whose settings you want to change.

10. In the Playback Options Overrides section, activate each playback option you want to 
override for the expression map and change their values.
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11. In the Mutual Exclusion Groups section, activate/deactivate Auto.

12. Optional: If you deactivated Auto, add or edit mutual exclusion groups manually.

13. Click OK to save your changes and close the dialog.

RELATED LINKS
Expression Maps dialog on page 913
Endpoint Setup dialog on page 659
Playback Technique Combinations dialog on page 923
Adding/Editing mutual exclusion groups in expression maps on page 929

Adding/Editing switches in expression maps
You can create new and edit existing switches that trigger playback techniques or combinations 
of playback techniques in individual expression maps; for example, to add an add-on switch to an 
existing base switch, or to create a new base switch with note length conditions.

Playback technique combinations are useful for expression maps that require different sets of 
key switches for Staccato + Accent compared to Staccato and Accent individually, for example.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression map to which you want to add switches or 
whose existing switches you want to edit.

3. Optional: In the Switches table in the Base and Add-on Switches section, add a new switch 
to trigger a playback technique or playback technique combination or edit an existing one in 
one of the following ways:

● To add a new base switch, click Add Base Switch .

● To add a new add-on switch, click Add Technique Add-on Switch .

● To create a copy of an existing switch, select it and click Duplicate Technique .

● To change the playing techniques triggered by an existing switch, select it and click Edit 
Technique .

4. Optional: If you added a new base/add-on switch or edited an existing switch, select 
the playback techniques you want the switch to trigger in the Playback Technique 
Combinations dialog.

TIP

You can select a single playback technique or combine multiple playback techniques. To 
select multiple playback techniques, Ctrl/Cmd -click each playback technique.

5. Optional: Click OK to add the selected playback techniques and close the Playback 
Technique Combinations dialog.

6. In the Switches table, select the switch whose actions, conditions, and/or controls you want 
to edit.

7. In the Actions subsection, choose the event type from one of the following options:

● On events

● Off events

8. In the Actions table, add an action of the selected event type for the currently selected 
switch in one of the following ways:
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● Click Add Control Change Action .

● Click Add Program Change Action .

● Click Add Key Switch Note Action .

● Click Add Absolute Channel Change Action.

● Click Add Relative Channel Change Action.

● Select an existing action and click Duplicate Action .

9. Double-click each cell whose value you want to change and change the value.

10. Choose one of the following pitches for Middle C (note 60):

● C3

● C4

● C5

NOTE

Steps 11 to 15 only apply to base switches. For init and add-on switches, you can skip to step 
16.

11. Optional: Repeat steps 6 to 10 for each action you require for the currently selected switch.

12. In the Conditions table, add a condition for the currently selected base switch in one of the 
following ways:

● To create a new condition, click Add Technique  in the action bar.

● To create a copy of an existing condition, select it and click Duplicate Technique  in 
the action bar.

13. Double-click each cell whose value you want to change and select the required option from 
the menu.

14. Optional: Repeat steps 12 and 13 for each condition you want to add to the selected base 
switch.

15. Choose one of the following condition options:

● To use the switch when at least one condition is met, choose Any of.

● To use the switch when all conditions are met, choose All of.

16. Change any of the other settings in the Base and Add-on Switches section as required.

For example, choose whether the volume of the selected base switch is controlled by its 
Note velocity or a Control change.

17. Click OK to save your changes and close the Expression Maps dialog.

RELATED LINKS
Playback techniques on page 936
Expression Maps dialog on page 913
Playback Technique Combinations dialog on page 923
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Adding/Editing mutual exclusion groups in expression maps
By default, Dorico Pro automatically defines mutual exclusion groups. You can create new and 
edit existing mutual exclusion groups in individual expression maps manually.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression map to which you want to add mutual 
exclusion groups or whose existing mutual exclusion groups you want to edit.

3. Optional: If Auto is activated in the Mutual Exclusion Groups section, deactivate Auto.

4. Optional: If you want to add a new mutual exclusion group, click Add  in the Mutual 
Exclusion Groups column action bar.

5. Enter a name for the new mutual exclusion group in the dialog that opens.

6. Click OK to add the group and close the dialog.

7. In the Mutual Exclusion Groups column, select the mutual exclusion groups whose 
playback techniques you want to change.

8. Change the playback techniques in the selected mutual exclusion group in any of the 
following ways:

● To add new playback techniques to the mutual exclusion group, click Add  in the Has 
techniques column action bar to open the Playback Technique Combinations dialog, 
select the playback techniques you want to add, then click OK.

● To remove playback techniques from the mutual exclusion group, select them in the Has 
techniques column, and click Delete  in the action bar.

9. Click OK to save your changes and close the Expression Maps dialog.

Importing expression maps
You can import expression maps into projects, including .expressionmap files exported from 
Cubase. Expression maps exported from Dorico are saved as .doricolib files.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. Click Import Library to open the File Explorer/macOS Finder.

3. Locate and select the expression map file you want to import.

4. Click Open.

RESULT
The selected expression map is imported into your project. It appears in the expression maps list.

NOTE

● You can also import Dorico and Cubase expression maps by dragging and dropping them 
into the Expression Maps dialog.

● Although Dorico Pro approaches expression maps in a different way to Cubase, Dorico Pro 
correctly imports many switches from expression maps you import from Cubase, such as 
pizzicato, harmonics, and flutter tongue.
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Exporting expression maps
You can export expression maps for use in other projects. Expression maps are saved 
as .doricolib files.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression maps you want to export.

3. Click Export Library to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The selected expression maps are exported as a .doricolib file and saved in the selected 
location.

Percussion maps
Unpitched percussion instruments are played back using patches that map unpitched sounds 
onto different MIDI notes. The pitches required to produce different unpitched sounds vary 
by device, sound library, manufacturer, and so on, and have no connection to the position of 
percussion instruments on five-line staves.

The following list contains some examples of unpitched percussion instruments from the General 
MIDI percussion map.

● Bass drum: C2 (MIDI note 36, two octaves below middle C)

● Kick drum: D2 (MIDI note 38)

● Closed hi-hat: F♯2 (MIDI note 42)

● Cowbell: G♯3 (MIDI note 56)

● Open triangle: A5 (MIDI note 81)

Dorico Pro uses percussion maps to connect the written representation of notes and playing 
techniques for percussion instruments to the samples required to play those sounds back.

NOTE

A percussion map describes which unpitched percussion instruments and their playback 
techniques are present in a particular patch, and how to play them back. For example, it 
describes which MIDI note to play, and if another MIDI note is needed as a key switch to trigger 
particular playing techniques.

A set of percussion maps for the unpitched percussion patches that are part of theHALion 
Symphonic Orchestra and HALion Sonic SE factory libraries is provided with Dorico Pro. They are 
automatically chosen when you add percussion instruments to your project.

You can define custom percussion maps for third-party sound libraries or MIDI devices in the 
Percussion Maps dialog, in order to obtain correct playback.

RELATED LINKS
Unpitched percussion on page 1682
Universal Indian Drum Notation on page 1703
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Importing percussion maps on page 935
Exporting percussion maps on page 935

Percussion Maps dialog
In the Percussion Maps dialog, you can define custom percussion maps for third-party sound 
libraries or MIDI devices in order to obtain correct playback.

● You can open the Percussion Maps dialog by choosing Library > Percussion Maps.

The Percussion Maps dialog is divided into the following sections:

1 Percussion maps list

Contains the percussion maps currently available in your project.

You can add and delete percussion maps using the following buttons in the action bar at the 
bottom of the percussion maps list:

● Add Percussion Map : Adds a new percussion map that contains no existing settings.

● Duplicate Percussion Map : Creates a copy of an existing percussion map that you 
can edit separately from the original.

● Delete Percussion Map : Deletes the selected percussion maps.

NOTE

You can only delete custom percussion maps. You cannot delete any default percussion 
maps.

2 Search field
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Allows you to filter percussion maps according to your entry.

3 Show only percussion maps used in this project

Allows you to filter the percussion maps list so it only includes percussion maps used in the 
current project.

4 Percussion Map Data section

Allows you to specify the following identifying information for the selected percussion map:

● Name: Allows you to specify the displayed name for the percussion map that appears in 
the Endpoint Setup dialog.

● ID: Allows you to set the unique ID of the percussion map. You can enter any content in 
the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name; for example, xmap.user.paulsmith.hso.cowbell.

● Version: Allows you to indicate the percussion map version so you can identify the most 
recent one.

● Map defines sounds for: Allows you to choose one of the following options, as 
appropriate for the current percussion map:

● Multiple Instruments: Choose this if the patch for which you are creating a map 
contains many different percussion instruments, such as the General MIDI drum 
map.

● Single Instruments: Choose this if the patch for which you are creating a map 
contains only a single percussion instrument, perhaps with multiple playback 
techniques for that instrument. For example, a snare drumline patch in Virtual 
Drumline or another specialist sound library.

This can also be useful when your VST instrument has several patches that have the 
same playback technique mappings. For example, there are both large and small 
cymbal patches in HALion Symphonic Orchestra which provide natural strike and roll 
sounds. Creating a single individual instrument percussion map allows you to use 
the same mapping for these sounds for multiple patches.

NOTE

● ID and Version are locked by the Lock Info button. You must click this button in order to 
change the information in the fields.

● The Endpoint Setup dialog is where you set which percussion map Dorico Pro uses for 
each channel on your VST instrument or MIDI output device.

5 Drum Kit Note Map section

Contains subsections that allow you to view, edit, and control the drum kit notes in the 
selected percussion map.

6 Drum Kit Note Map table

By default, the table shows the drum kit notes in use by the selected percussion map 
in numerical order. The table also contains the following columns, which display the 
corresponding available data about the selected drum kit note:

● MIDI Note: Shows the MIDI note number, such as “48”.

● Note Name: Shows the pitch and octave of the note, such as “C3”.

● Name: Shows the name of the technique, such as Snare “(long roll)”.

● Instrument: Shows the unpitched percussion instrument, such as “Snare Drum”.

● Key Switch: Shows the number of the key switch that triggers the note, such as “24”.
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● Playback Techniques: Shows the playback techniques triggered by the note, such as 
“Roll”.

At the bottom of the table, there are the following options:

● Show all: Shows all MIDI notes from 0 to 127.

● Show MIDI Notes in Use: Only shows the MIDI notes in use by the selected percussion 
map.

● Add Key Switch Alternative: Duplicates the selected drum kit note.

● Clear: Deletes the selected drum kit note.

You can change the data for the currently selected drum kit note in the Edit Drum Kit Note 
subsection.

7 Edit Drum Kit Note subsection

Allows you to specify data in the following fields for the drum kit note currently selected in 
the Drum Kit Note Map table:

● Name: The displayed name for the specific combination of instrument and playback 
technique. You may choose to input the name used in the manufacturer’s 
documentation for your VST instrument or MIDI output device.

● Instrument: Allows you to select an instrument for the drum kit note selected in the 
Drum Kit Note Map section from a list of all the unpitched percussion instruments you 
can create in Dorico Pro.

● Key switches: Allows you to specify the MIDI note number of the key you want to use as 
a key switch if this sound requires another MIDI note to be played to trigger this specific 
combination of instrument and playback techniques.

NOTE

Key switches are not compulsory.

● Techniques: Allows you to select playback techniques to apply to the instrument 
selected in the Instrument field from a list of the available playback techniques.

8 Reset to Library Defaults

Allows you to revert any changes you have made to the percussion maps from the Default 
Library.

9 Import Library

Opens the File Explorer/macOS Finder, where you can select the .doricolib files that you 
want to import as percussion maps.

10 Export Library

Opens the File Explorer/macOS Finder, where you can select the location to which you want 
to export the currently selected percussion maps as a .doricolib file. You can then import 
the .doricolib file into other projects and share it with other users.

Creating new percussion maps
You can create new percussion maps from scratch and you can duplicate existing percussion 
maps and edit the settings; for example, to obtain correct playback when using third-party sound 
libraries or MIDI devices.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. Create a new percussion map in any of the following ways:
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● To create an empty percussion map, click Add Percussion Map  in the action bar.

● To create a copy of an existing percussion map, select it in the percussion maps list and 
click Duplicate Percussion Map  in the action bar.

3. In the Percussion Map Data section, click Lock Info  to unlock the fields.

4. Enter the display name you want for the percussion map in the Name field.

This name appears in the Endpoint Setup dialog.

5. Enter any unique identification name in the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name, in the identification name for percussion maps; for example, 
xmap.user.paulsmith.hso.cowbell.

6. Choose one of the following options for Map defines sounds for, as appropriate for the 
current percussion map:

● Multiple Instruments

● Single Instruments

7. In the Drum Kit Note Map section, click Show all to show unmapped notes.

8. Select the row corresponding to the MIDI note for which you want to create a new mapping.

9. In the Edit Drum Kit Note subsection, click  beside the Instrument field to open a dialog 
containing a list of percussion instruments.

10. Select the instrument that corresponds to the sound produced by the selected MIDI note.

11. Click OK.

12. In the Edit Drum Kit Note subsection, click  beside the Techniques field to open the 
Playback Technique Combinations dialog.

13. Select the appropriate playback techniques for the sound produced by the selected MIDI 
note.

For example, Ctrl/Cmd -click Buzz roll and Rim.

14. Click OK.

15. In the Edit Drum Kit Note subsection, enter the display name you want for this combination 
of instrument and playing technique in the Name field.

16. Optional: If the key switch for this sound requires a MIDI note number, specify it in the Key 
switches field.

17. Click Apply.

18. Optional: Repeat these steps for each MIDI note until you have created all the required 
mappings for your project.

19. Click OK to save your changes and close the dialog.

RESULT
The new percussion map is created.

AFTER COMPLETING THIS TASK

● You must assign percussion maps to the same endpoints as the VST instruments or MIDI 
devices that provide the corresponding patches.

● You can export the percussion map if you want to use it in other projects.
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RELATED LINKS
Percussion maps on page 930
Assigning expression/percussion maps to endpoints on page 665
Endpoint Setup dialog on page 659

Importing percussion maps
You can import percussion maps into projects. Percussion maps are saved as .doricolib files.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. Click Import Library to open the File Explorer/macOS Finder.

3. Locate and select the percussion map file you want to import.

4. Click Open.

RESULT
The selected percussion map is imported into your project. It appears in the percussion maps list.

Exporting percussion maps
You can export percussion maps so you can use them in other projects. Percussion maps are 
saved as .doricolib files.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. In the percussion maps list, select the percussion maps you want to export.

3. Click Export Library to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The selected percussion maps are exported as a .doricolib file and saved in the selected 
location.

Defining how combinations of articulations and single-note 
tremolos sound in playback

You can define specific playback behaviors for particular combinations of articulations 
and single-note tremolos in playing technique-specific noteheads for unpitched percussion 
instruments.

PROCEDURE

1. In Setup mode, open the Percussion Instrument Playing Techniques dialog in any of the 
following ways:

● For an individual percussion instrument: In the Players panel, click the instrument menu 
 in the instrument label, and choose Edit Percussion Playing Techniques from the 

menu.

Library
Percussion maps 

935
Dorico Pro 4.3.30



● For percussion instruments that are part of percussion kits: In the Players panel, 
click the instrument menu  in the kit instrument label and choose Edit Percussion 
Kit to open the Edit Percussion Kit dialog. In the main editing area, select the 
instrument whose playing techniques you want to edit, then click Edit Percussion 
Playing Techniques.

2. In the list at the top of the dialog, select the playing technique-specific notehead whose 
playback behaviors you want to define.

3. Click Add Technique  in the action bar at the bottom left of the dialog.

4. Click Choose Playing Techniques  beside the Playback playing technique field to open 
the Playback Technique Combinations dialog.

5. Select the playback techniques you want.

TIP

You can select a single playback technique or combine multiple playback techniques. To 
select multiple playback techniques, Ctrl/Cmd -click each playback technique.

6. Click OK to add the selected playback techniques and close the Playback Technique 
Combinations dialog.

7. Choose one of the following options:

● Replace: Allows you to use this playing technique instead of the default playing 
technique defined for this combination of notehead and staff position.

● Add: Allows you to add this playing technique on top of the default playing technique 
defined for this combination of notehead and staff position.

8. Choose any articulations and the tremolo stroke that you want from the available options.

9. Click OK to save your changes and close the dialog.

RESULT
The behavior of the selected playing technique in playback is changed.

RELATED LINKS
Percussion Instrument Playing Techniques dialog on page 1683
Creating new playing technique-specific noteheads on page 1687
Playback Technique Combinations dialog on page 923

Playback techniques
Playback techniques link together the notations you input into your music and techniques/
articulations in sound libraries in order to produce the correct sounds in playback. They are used 
by expression and percussion maps to trigger the appropriate commands, such as key switches 
or control changes.

When you input notations, such as playing techniques, tremolos, jazz articulations, or 
articulations, the corresponding expression maps look for the appropriate playback techniques. 
For example, inputting pizz. playing techniques causes expression maps to use the Pizzicato 
playback technique to switch to the pizzicato sound for playback. If the expression map cannot 
locate the sound, the playback technique applied either remains the same as the previous 
playback technique or reverts to the natural playback technique.

Custom playing techniques that use playback techniques which do not already exist in 
expression maps do not play back automatically. In order for them to play back appropriately, 
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you must add them to the expression maps for each instrument for which you want to use them. 
You must also assign an action for each custom playing technique that determines how the 
switch that triggers the technique is controlled.

You can map playback techniques as required for different sound libraries in the Expression 
Maps dialog, including creating new combinations of existing playback techniques, such as 
Legato and Tremolo, which allows them to be used simultaneously.

You can see which playback techniques are in use at any particular rhythmic position in the 
Playing Techniques editor for the corresponding instrument/voice.

TIP

● If you have input a playing technique but cannot hear a change in the sound, you might 
be using a combination of playback techniques that the expression map does not expect. 
For example, if you input a new playing technique without cancelling an existing playing 
technique, the expression map cannot process the two corresponding playback techniques 
together if the expression map does not have an entry for those two techniques combined.

To avoid playback technique clashes, you can add playback techniques that cannot be in use 
concurrently to the same mutual exclusion group in the corresponding expression maps. 
Alternatively, you can create a combination of those playback techniques in order to use 
them simultaneously.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques, tremolos, jazz articulations, or articulations in different voices 
simultaneously.

RELATED LINKS
Expression maps on page 912
Expression Maps dialog on page 913
Playback Technique Combinations dialog on page 923
Enabling independent voice playback on page 636
Creating new expression maps on page 926
Adding/Editing mutual exclusion groups in expression maps on page 929
Playing Techniques editor on page 795
Playing techniques on page 1387
Tremolos on page 1659
Jazz articulations on page 1348
Articulations on page 954

Edit Playback Techniques dialog
The Edit Playback Techniques dialog allows you to define new playback techniques and edit 
existing ones. Playback techniques are used by expression maps to assign the correct sounds to 
the required notations in the music, such as playing techniques, tremolos, jazz articulations, and 
articulations.

You can open the Edit Playback Techniques dialog in any of the following ways:

● Choose Library > Playback Techniques.

● In the Edit Playing Techniques dialog, on the General tab, click Edit beside Playback 
technique.
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The Edit Playback Techniques dialog contains the following sections and options:

1 Category menu

Allows you to filter the list of playback techniques by selecting a category from the menu, 
such as Techniques or Dynamics.

2 Playback techniques list

Contains all the playback techniques in the project within the currently selected category.

The action bar at the bottom of the list contains the following options:

● New : Adds a new blank playback technique.

● New from Selection : Creates a copy of an existing playback technique that you can 
edit separately from the original.

● Save as Default : Saves the selected playback technique to your user library, allowing 
you to use it in multiple projects. Appears as  for playback techniques saved as default.

● Revert to Factory : Removes all your changes to the selected playback technique, 
returning it to its saved settings.

● Delete : Deletes the selected playback technique.

NOTE

You cannot delete predefined playing techniques or any playing technique that is 
currently used in your project.

3 Name

Allows you to edit or enter the name of the playback technique. This is the name shown in 
lists in the Edit Playing Techniques, Expression Maps, Playback Technique Combinations, 
and Percussion Maps dialogs.

4 Playback options

● Alias for: Allows you to select another playback technique whose sound mapping you 
want to apply to the selected playback technique as well.

● Group: Sets the group in which this playback technique appears.

● Fallback: Allows you to specify another playback technique that can be used if the 
present one is not available.

● Articulation type: Sets the duration over which the playback technique takes effect. 
Attribute applies only to the note at the rhythmic position where the playing technique 
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is found, such as a staccato articulation, while Direction applies to all following notes 
until it is replaced by another playing technique, such as pizzicato.

RELATED LINKS
Edit Playing Techniques dialog on page 877
Expression Maps dialog on page 913
Playback Technique Combinations dialog on page 923
Adding/Editing mutual exclusion groups in expression maps on page 929
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Notation reference



Introduction

This notation reference contains information about the accepted conventions for presenting 
different notations and how to change their appearance and placement in Dorico Pro, both for 
individual items and by changing default settings.

It also contains instructions for inputting more complex notations, such as cross-staff glissando 
lines, which are described in the corresponding chapter.

Tasks in the notation reference outline the default changes you can make to items, which can 
apply per-flow, per-layout or project-wide; for example, changing spacing gaps or the project-
wide appearance of pedal lines are both project-wide changes you can make in Engraving 
Options. Tasks also outline the individual changes you can make to items independently of your 
default settings, which often involve using properties in the Properties panel.

You can find basic input methods for notations in the Write mode chapter.

RELATED LINKS
Write mode on page 196
Engraving Options dialog on page 840
Layout Options dialog on page 834
Properties panel on page 769
Notations input on page 271
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Accidentals

Accidentals are shown beside notes to indicate their pitch, both when notated on a staff and 
written out in text. In music based in Western tonality, they usually show that the pitch of a note 
has been altered so that it does not conform to the prevailing key signature.

In Dorico Pro, each note has its own fixed pitch that is independent of the prevailing key 
signature, and accidentals are automatically hidden and shown as appropriate. For example, 
if you input F♮s and then add a D major key signature before them, they do not turn into F♯s; they 
remain F♮s and show natural accidentals. However, if you input the D major key signature first, 
any Fs you then input without stating an accidental are input as F♯s.

There are different conventions for accidental duration rules, such as not repeating the same 
accidental on subsequent notes of the same pitch in the same bar. In music that has no key 
signatures, some or all notes might require accidentals, depending on the notation convention in 
use.

You can use accidental duration rules to determine when accidentals are shown, and control how 
accidentals are arranged in complex chords.

RELATED LINKS
Accidental duration rules on page 951
Inputting notes on page 221
Inputting accidentals on page 244

Project-wide engraving options for accidentals
You can find options for the project-wide appearance and position of accidentals on the 
Accidentals page in Engraving Options.

The options on the Accidentals page allow you to change the order of accidentals in chords and 
the precise positioning of accidentals relative to noteheads, ledger lines, and parentheses.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
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Deleting accidentals
You can delete accidentals according to their type, and you can delete all accidentals from a 
selection of notes with different accidentals at the same time. This changes the pitch of the 
selected notes.

NOTE

These steps do not apply to cautionary accidentals, such as those shown on natural notes that 
follow the same notes with an accidental but in a different octave. In Dorico Pro, you can hide, 
show, or parenthesize cautionary accidentals in each flow and on individual notes.

PROCEDURE

1. In Write mode, select the notes whose accidentals you want to delete.

2. Delete accidentals in any of the following ways:

● To delete naturals, press 0 .

● To delete flats, press - .

● To delete sharps, press = .

● In the Notes panel, click the accidentals you want to delete.

RESULT
The corresponding accidentals are deleted from the selected notes. This changes their pitch. For 
example, deleting the sharp from a G♯ turns it into G♮.
NOTE

● Depending on the accidental duration rule applied to the flow, deleting accidentals might 
cause accidentals to appear on subsequent notes of the same pitch in the same bar. When 
you select single notes or multiple notes in the same voice at the same rhythmic position, 
their pitches are shown in the status bar and as depressed keys in the Keyboard panel.

● To delete accidentals from a selection of notes with different accidentals, we recommend 
that you revert them all to natural by pressing 0  or clicking Natural in the Notes panel. 
This is because re-inputting an accidental over a selection of notes with different accidentals 
adds that accidental to every note in the selection. For example, two G♯s followed by two G♭s 
become four G♯s if you re-input a sharp. If you click Sharp or press =  twice, all accidentals 
are deleted.

RELATED LINKS
Inputting accidentals on page 244
Changing the pitch of individual notes on page 479
Notes panel on page 201
Status bar on page 42
Keyboard panel on page 207

Hiding/Showing or parenthesizing accidentals
You can hide/show individual accidentals, or show them in round or square brackets, including 
cautionary accidentals shown by default. For example, you can show cautionary accidentals on 
subsequent notes in tie chains that cross system/frame breaks by showing accidentals in round 
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brackets. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose accidentals you want to hide/show or parenthesize. You can do this in 
Write mode and Engrave mode.

NOTE

You can only select individual noteheads within tie chains in Engrave mode.

2. In the Properties panel, activate Accidental in the Notes and Rests group.

3. Select one of the following options from the menu:

● Hide

● Show

● Round brackets

● Square brackets

RESULT
Accidentals on the selected notes are shown, hidden, or shown in round or square brackets. If 
the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

NOTE

● Hiding accidentals does not affect the pitch of notes in playback.

● If you are hiding/showing many accidentals, we recommend that you consider changing the 
accidental duration rule.

● You can assign key commands for different accidental hiding, showing, and parenthesizing 
commands on the Key Commands page in Preferences.

AFTER COMPLETING THIS TASK
You can also hide/show or parenthesize accidentals on artificial harmonics shown using diamond 
noteheads, independently of the normal noteheads that indicate the stopped pitch.

RELATED LINKS
Properties panel on page 769
Hiding/Showing zones on page 47
Engrave toolbox on page 514
Accidental duration rules on page 951
Hiding/Showing cancellation naturals before key signature changes on page 1214
Hiding/Showing or parenthesizing cautionary accidentals on page 952
Hiding/Showing or parenthesizing harmonic accidentals on page 1285
Preferences dialog on page 61
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Ties on page 1620
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the size of accidentals
You can change the size of accidentals individually without changing the size of the noteheads 
to which they apply; for example, to show editorial accidentals at a smaller size than normal 
accidentals. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the accidentals whose size you want to change.

2. In the Properties panel, activate Accidental scale in the Notes and Rests group.

3. Change the value in the value field.

4. Press Return .

RESULT
The scale size of the selected accidentals is changed. For example, changing the value to 50 
scales the selected accidentals to half their normal size. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Stacking of accidentals
If multiple accidentals are required for a chord in a single voice, or for notes in multiple voices at 
the same rhythmic position, they are stacked to the left of the chord in columns.

For chords with multiple accidentals, accidentals are generally stacked as follows:

1. The highest accidental is inserted in the first column immediately to the left of the notes.

2. The lowest accidental is added to the same column, provided that it does not collide with the 
first accidental.

3. The remaining highest and lowest accidentals are alternated in successive columns located 
further left from the chord.

In Dorico Pro, additional rules help to produce a stack of accidentals that uses as few columns as 
possible. The following list contains some of the rules that are applied:

● Columns closer to the notes contain more accidentals than columns further from the notes.

● Accidentals on notes that are an octave apart are stacked in the same column. This also 
applies to accidentals that are a sixth or more apart, depending on the combination of 
accidentals.

● Accidentals in the same column never collide. The minimum interval between accidentals 
that is required to prevent collisions depends on the types of accidentals.
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● Accidentals that are a second apart are arranged in adjacent columns, with the higher 
accidental in the right-hand column.

These rules minimize the amount of extra space that is required between successive notes or 
chords and ensure that accidentals appear as close as possible to the noteheads to which they 
apply. At the same time, they produce a contour that resembles a C-curve on the left-hand side of 
the chord.

Accidental stacking rules for dense chords

Dorico Pro uses special stacking calculations in dense chords with multiple accidentals to ensure 
legibility. Chords are considered dense when they have six or more accidentals within the span of 
an octave.

For dense chords, accidentals are stacked as follows:

1. The highest accidental is inserted in the first column to the left of the notes.

2. The next accidental on a note that is located at least a seventh below the highest note 
is stacked into the same column. This continues with the remaining notes until no more 
accidentals fit into the first column.

3. Steps 1 and 2 are repeated for the following columns until all accidentals are stacked.

4. The columns are grouped, interspersed, and re-stacked. This results in a stack with 
alternating accidentals, reminiscent of the way accidentals are arranged in a key signature.

By default for dense chords, Dorico Pro uses a lattice arrangement of accidentals, rather than 
the usual zig-zag arrangement. In very dense chords, the lattice arrangement can be wider and 
require more columns.

TIP

You can customize the default settings for the stacking of accidentals project-wide in the 
Stacking section of the Accidentals page in Engraving Options. For example, you can allow 
accidentals to be stacked without interspersion, so that accidentals appear in a diagonal line 
sloping downwards to the left.

RELATED LINKS
Engraving Options dialog on page 840
Changing the column of accidentals on page 947
Moving accidentals graphically on page 947

Kerning of accidental columns
Dorico Pro applies kerning to accidental columns to ensure that the columns to the left of a 
chord occupy as little horizontal space as possible.

In typography, kerning adjusts the space between individual characters to increase legibility. In 
Dorico Pro, as well as in music engraving in general, kerning allows accidentals to interlock.

EXAMPLE
If a low note is followed by a high note with an accidental, the accidental can be tucked above the 
low note to prevent the note spacing from being distorted.

Similarly, in the case of multiple columns of accidentals on a chord, the overall width of the stack 
of accidentals is reduced if, for example, a flat in the second column is kerned underneath a 
sharp in the first column belonging to a note a third higher. This also reduces the need to distort 
note spacing to accommodate accidentals.
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Changing the column of accidentals
You can change the column of individual accidentals, independently of your project-wide settings 
for accidental stacking. For example, to show specific accidentals closer to the stem than other 
accidentals in the chord. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the notes or accidentals whose accidental column you want to 
change.

2. In the Properties panel, activate Accidental column in the Notes and Rests group.

3. Change the value in the value field.

RESULT
The column of the selected accidentals is changed. Accidentals with lower Accidental column 
values are placed closer to noteheads, while accidentals with higher values are placed further 
from noteheads. If necessary, Dorico Pro automatically changes the column of other accidentals 
at the same rhythmic position.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can customize the default settings for the stacking of accidentals project-wide in the 
Stacking section of the Accidentals page in Engraving Options.

RELATED LINKS
Properties panel on page 769
Hiding/Showing zones on page 47
Engrave toolbox on page 514
Stacking of accidentals on page 945
Tucking index properties on page 1083
Engraving Options dialog on page 840
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Moving accidentals graphically
You can move individual accidentals graphically to the right or left, independently of your project-
wide settings for accidental spacing. For example, to reduce the horizontal spacing required for 
accidentals in a single dense chord. You can do this for the current layout and frame chain only, 
or for all layouts and frame chains.
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NOTE

You cannot move accidentals rhythmically. If you want to change the notes to which accidentals 
apply, you must delete them from their original notes and input new accidentals on the new 
notes or change the pitch of existing notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the accidentals you want to move. You can also select their 
noteheads.

2. In the Properties panel, activate Accidental X offset in the Notes and Rests group.

3. Move the accidentals in one of the following ways:

● To move them to the right, increase the value in the value field.

● To move them to the left, decrease the value in the value field.

RESULT
The selected accidentals are moved graphically. If necessary, Dorico Pro automatically increases 
note spacing to accommodate the accidentals and avoid collisions.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Inputting accidentals on page 244
Changing the pitch of individual notes on page 479
Adjusting note spacing at individual rhythmic positions on page 604

Altered unisons
Altered unisons occur when two or more notes of the same name in the same octave have 
different accidentals in the same chord, such as D♯ and D♭.
In Dorico Pro, this is notated with a split stem by default. Split stems show the main body of a 
chord with a stem branch coming off the main stem that connects noteheads in altered unisons 
to the chord. This allows all notes to appear with their corresponding accidental directly beside 
them. A split stem is also known as a “cherry stalk” or a “tree”.

You can show individual altered unisons with a single stem, meaning noteheads appear directly 
beside each other, and the two accidentals are shown beside each other to the left of the chord.

You can also change the default appearance of all altered unisons in each flow independently on 
the Accidentals page in Notation Options.
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NOTE

If a chord contains notes a second interval apart and one of those notes has an altered unison, it 
is always shown with a split stem, regardless of your setting. This is to ensure clarity in clusters.

EXAMPLE

A single stem altered unison A split stem altered unison

RELATED LINKS
Inputting chords on page 251
Notation Options dialog on page 837

Changing how altered unisons appear
You can change how individual altered unisons appear, including within chords containing other 
altered unisons, and independently of your per-flow settings. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the altered unison notes whose appearance you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Split stem in the Notes and Rests group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected altered unison notes are shown with split stems when the checkbox is activated, 
and with single stems when the checkbox is deactivated. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

● Split stem applies to individual notes. You can have altered unisons appear differently within 
the same chord by setting their properties independently.

● You can change the default appearance of all altered unisons in each flow independently in 
Notation Options > Accidentals > Altered Unisons.
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RELATED LINKS
Engrave toolbox on page 514
Properties panel on page 769
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Notation Options dialog on page 837

Microtonal accidentals
Microtonal accidentals indicate pitches beyond the standard accepted chromatic scale in Western 
tonality, such as a quarter sharp or quarter flat.

You can use microtonal accidentals when you have selected a tonality system that includes 
microtonal accidentals, such as Equal temperament (24-EDO, Stein-Zimmermann).

The default tonality system is Equal temperament (12-EDO), which you can see in the Tonality 
System section of the Key Signatures, Tonality Systems and Accidentals panel. When this option 
is selected, the accidentals available in the Accidentals section of the panel are only half-step 
(semitone) accidentals, such as sharp, flat, double flat, and so on. Equal temperament (12-EDO) 
does not include microtonal accidentals.

You can change the tonality system for specific passages of music, which changes the microtonal 
accidentals available. You can also define your own tonality systems with custom octave 
divisions, key signatures, and accidentals.

NOTE

Even if you do not want to use a conventional key signature, you must input an open or atonal 
key signature in order to change the tonality system and use microtonal accidentals.

RELATED LINKS
Tonality systems on page 1219
Custom tonality systems on page 902
Custom accidentals on page 907
Playback of custom tonality systems on page 912

Inputting microtonal accidentals
You can input microtonal accidentals, such as a quarter tone flat or three quarter tones sharp, 
into your project.

PREREQUISITE
For the section of your project where you want to input microtonal accidentals, you have 
changed the tonality system to one that allows microtonal accidentals, such as Equal 
temperament (24-EDO, Stein-Zimmermann).

PROCEDURE

1. In Write mode, select the note or notes to which you want to apply a microtonal accidental.

2. In the Key Signatures, Tonality Systems, and Accidentals panel, click the microtonal 
accidental you want in the Accidentals section.

RESULT
The selected microtonal accidental appears beside the selected note or notes.
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RELATED LINKS
Changing the tonality system on page 1220
Input methods for key signatures on page 278

Accidental duration rules
Accidental duration rules determine how long accidentals apply, such as within a bar, at a 
different octave, or just for a single note. Dorico Pro allows you to use different accidental 
duration rules.

● You can find the available accidental duration rules on the Accidentals page in Notation 
Options.

Common practice

In common practice, an accidental affects all notes of the same pitch in the same octave within 
the same bar, unless it is cancelled by another accidental. If it is not cancelled, it is automatically 
cancelled in the following bar.

It is customary to show cautionary accidentals on subsequent notes in certain circumstances. For 
example, in the key of G major, an F♯ in a bar following an F♮ shows a cautionary sharp sign, 
even though the sharp is included in the key signature. Cautionary accidentals are also known as 
“courtesy accidentals”.

When using the common practice accidental duration rule, you can choose to hide, show, or 
parenthesize cautionary accidentals in different circumstances.

In Dorico Pro, common practice is the default accidental duration rule.

Second Viennese School

The Second Viennese School accidental duration rule states that each accidental only applies to a 
single note. All notes show an accidental regardless of key signature, including naturals.

This accidental duration rule was used by Schoenberg and other composers of the Second 
Viennese School.

You can customize the options within the Second Viennese School accidental duration rule when 
changing the accidental duration rule, including choosing whether immediate repetitions of the 
same note within the same bar require a restatement of the accidental.

Modernist

The Modernist accidental duration rule states that only notes that have been altered from the 
key signature show accidentals. Naturals are not shown. However, accidentals that are shown 
only apply to the notes on which they are written, as with the Second Viennese School.

Charles Ives and Robert Crumb used this variation.

You can customize the options within the Modernist accidental duration rule when changing the 
accidental duration rule, including choosing whether or not the same accidental on the same 
pitch is restated later in the bar if the subsequent pitches occur immediately and if subsequent 
pitches occur after other, different notes. Similarly, there are options for accidentals on notes 
in different octaves in the same bar and following bar. There is also an option controlling the 
restatement of accidentals within beam groups.

RELATED LINKS
Notation Options dialog on page 837
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Hiding/Showing cancellation naturals before key signature changes on page 1214

Changing the accidental duration rule
You can change the accidental duration rule in each flow independently; for example, if the 
Modernist accidental duration rule is appropriate for certain flows in your project but common 
practice is appropriate for others. In Dorico Pro, common practice is the default accidental 
duration rule.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to change the accidental duration rule.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Accidentals.

4. In the Basic section, choose one of the following options for Accidental duration rule:

● Common Practice

● Second Viennese School

● Modernist

5. Optional: Customize the options for your chosen accidental duration rule.

TIP

Options in the Basic section can apply to all accidental duration rules.

6. Click Apply, then Close.

Hiding/Showing or parenthesizing cautionary accidentals
You can hide/show cautionary accidentals, or show them in parentheses, in different 
circumstances by default in flows that use the common practice accidental duration rule.

PREREQUISITE
The flows in which you want to hide, show, or parenthesize cautionary accidentals use the 
common practice accidental duration rule.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide, show, or parenthesize cautionary 
accidentals.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Accidentals.

4. In the Cautionary accidentals section, change each option as required.

5. Click Apply, then Close.

Accidentals
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RESULT
Cautionary accidentals are hidden, shown, or parenthesized in the corresponding circumstances 
in the selected flows.

TIP

For flows using the Modernist accidental duration rule, options for cautionary accidentals are 
available in the Modernist Options section of the Accidentals page.

Changing the cancellation of double accidentals
You can change the convention of double accidental cancellation in each flow independently; 
for example, if some flows in your project require archaic cancellation. You can do this in 
combination with any accidental duration rule.

By default, Dorico Pro uses modern cancellation.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to change the double accidental 
cancellation convention.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Accidentals.

4. In the Basic section, choose one of the following options for Single accidentals cancelling 
double accidentals:

● To show naturals immediately before single accidentals that come after double 
accidentals, choose Use archaic cancellation.

● To replace double accidentals with single accidentals without showing naturals, choose 
Use modern cancellation.

5. Click Apply, then Close.

RESULT
The double accidental cancellation convention is changed in the selected flows.

EXAMPLE

Archaic cancellation Modern cancellation
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Articulations

Articulations are markings that are drawn above or below notes and chords. Articulations tell a 
performer how to attack a note or how long to play a note relative to its notated duration.

In Dorico Pro, articulations are defined as something that alters the way a note is played, in 
a way that is consistent across all instruments. Because instructions like bowing directions, 
harmonics, or tonguing apply to different instrument groups, in Dorico Pro such directions are 
defined as playing techniques.

A musical phrase with accent, staccato, and staccatissimo articulations

Articulations are categorized into the following types:

Articulations of force
Indicate a stronger attack at the start of notes, and include articulations such as accent 
and marcato. Marcato is also sometimes known as a “strong accent”. Dorico Pro shows 
these articulations at the start of a note or tie chain by default.

Articulations of duration
Indicate a shorter duration than notated, and include articulations such as 
staccatissimo, staccato, tenuto, and staccato-tenuto. Staccato-tenuto is also sometimes 
known as a “louré”. If a note includes ties, Dorico Pro shows articulations of duration 
above the last note in the chain by default.

Articulations of stress
Indicate notes that should be emphasized or not emphasized where that contradicts 
the prevailing meter, using stressed and unstressed marks. Dorico Pro shows these 
articulations at the start of a note or tie chain by default.

Dorico Pro positions articulations automatically on the notehead or stem side of notes and 
chords, according to the musical context. A note or chord can display one of each type of 
articulation.

RELATED LINKS
Inputting articulations on page 271
Articulations in playback on page 961
Positions of articulations on page 956
Changing the positions of articulations on tie chains on page 957
Changing the horizontal position of staccato marks on page 958
Playback techniques on page 936
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Project-wide engraving options for articulations
You can find options for the appearance and placement of articulations project-wide on the 
Articulations page in Engraving Options.

The options on this page allow you to change the positions of articulations in detail, including 
whether different articulations are shown above the staff or by the notehead, the positions 
of articulations relative to ties and slurs, and the vertical gaps between articulations and notes/
other articulations.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Allowing/Disallowing articulations inside the staff on page 961
Moving items graphically on page 609

Copying and pasting articulations
You can copy an existing phrase and paste only its slurs, articulations, and jazz articulations to 
another phrase, without affecting the pitches of notes.

PROCEDURE

1. In Write mode, make a selection containing the slurs, articulations, and jazz articulations you 
want to copy.

2. Press Ctrl/Cmd-C  to copy the selected phrase.

3. Select the first note to which you want to paste articulations.

4. Choose Edit > Paste Special > Paste Articulations. You can also choose this option from the 
context menu.

RESULT
Slurs, articulations, and jazz articulations included in the selection are pasted to notes from the 
selected note onwards.

RELATED LINKS
Large selections on page 428
Copying and pasting notes/items on page 461
Repitching notes without changing their rhythm on page 483
Arranging tools on page 459

Deleting articulations
Individual articulation markings cannot be selected and deleted separately from their notehead 
in Write mode, so articulations must be deleted by selecting the note or notes to which they are 
attached, and deselecting the articulation.

PROCEDURE

1. In Write mode, select the notes whose articulations you want to delete.

2. Deselect the articulations in any of the following ways:

● Press the key commands of the articulations you want to delete.

Articulations
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● In the Notes panel, click the articulations you want to delete.

RELATED LINKS
Notes panel on page 201
Hiding/Showing zones on page 47
Key commands for articulations on page 272

Positions of articulations
There are established conventions for the position and placement of articulations relative 
to notes, the staff, and staff lines, which ensure articulations are always clearly visible. For 
the smallest articulations, such as staccato marks, correct placement relative to staff lines in 
particular is vital.

Placement of articulations

Articulations are placed on the notehead side by default, with the following exceptions:

● In single-voice contexts, marcato is always placed above the staff, regardless of the stem 
direction of the note or chord on which it is used. In multiple-voice contexts, marcato can 
also be placed below the staff.

● If multiple voices are active, articulations are placed at the end of the stem side of a note 
or chord. This clarifies which articulations belong to the up-stemmed notes and which to the 
down-stemmed notes.

● If a note is placed on the middle staff line or on the space immediately on either side, 
articulations that are less than a space in height are centered in the next unoccupied space. 
This normally only applies to staccato and tenuto. If a note in the middle of the staff has a 
staccato-tenuto articulation, the component parts of the articulation are split up and placed 
in separate spaces.

● If an articulation cannot fit within a staff space, or if the note is placed high or low on the 
staff, the articulation is placed outside the staff.

● If a note or chord is tied and the tie is placed above or below the notehead, articulations that 
are placed on the notehead side of a note or chord are offset by an additional 1/4 space in 
order to avoid the end of the tie.

Articulations on the notehead side are always centered horizontally on the notehead. This 
also applies to articulations on the stem side, except if the only articulation is a staccato or 
staccatissimo. In this case, the articulation is centered on the stem.

Articulations in tie chains

By default, articulations of force and stress are shown on the first note/chord in tie chains, while 
articulations of duration are shown on the last note/chord.

You can change where in tie chains articulations appear individually, and in all tie chains project-
wide.

RELATED LINKS
Project-wide engraving options for articulations on page 955
Changing the default placement of articulations on page 960
Allowing/Disallowing articulations inside the staff on page 961
Moving items graphically on page 609
Changing the placement of articulations relative to notes on page 959

Articulations
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Changing the placement of articulations relative to slurs on page 959

Order of articulations
If there are multiple articulations on the same notes, their vertical position and proximity to 
noteheads/stems depends on their type.

Articulations are positioned in the following order:

1. Articulations of duration are positioned closest to notehead/stems.

2. Articulations of force are positioned outside articulations of duration.

3. Articulations of stress are positioned furthest from noteheads/stems.

Order of articulations in relation to slurs

Articulations of duration are positioned as follows:

● Inside slurs that start/end on a note or chord with an articulation.

● Inside the curvature of a slur.

● Inside tuplet brackets.

Articulations of force are positioned as follows:

● Outside slurs that start/end on a note or chord with an articulation, except if they can be 
positioned within the staff.

● Inside the curvature of a slur if they fit between the slur and the note or stem, to which they 
belong, without colliding.

● Outside tuplet brackets.

Force and stress articulations outside the ends of the 
slur

Duration articulations inside the ends of the slur

Changing the positions of articulations on tie chains
You can change where in tie chains articulations appear individually, independently of your 
project-wide settings. By default, articulations of force and stress are shown on the first note/
chord in tie chains, while articulations of duration are shown on the last note/chord.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tied notes/chords whose articulation position you want to change. You can do this 
in Write mode and Engrave mode.

Articulations
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2. In the Articulations group of the Properties panel, activate Pos. in tie chain under the 
corresponding heading for the articulation whose position you want to change.

For example, activate Pos. in tie chain under the Articulations of force heading to change 
the position of accents.

3. Choose one of the following options:

● First note

● Last note

RESULT
The position of articulations in the selected tie chains is changed.

TIP

You can change the default position of each type of articulation relative to all tie chains project-
wide in Engraving Options > Articulations > Ties.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769

Changing the horizontal position of staccato marks
You can change the default horizontal position of all staccato and staccatissimo articulations 
when they are placed on the stem side of notes project-wide. By default, staccato and 
staccatissimo articulations are centered on the stem when on the stem side.

The horizontal position of most articulations is centered on a stem or a notehead. However, if a 
staccato or staccatissimo is the only articulation, its horizontal position can also be half-centered 
when they are placed on the stem side.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Articulations.

3. In the Horizontal Position section, choose one of the following options for Horizontal 
position of staccato on stem side:

● Center on notehead

● Center on stem

● Half-center

4. Click Apply, then Close.

Articulations
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Changing the placement of articulations relative to notes
You can change whether individual articulations are placed on the notehead side or stem side of 
notes. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/chords whose articulation placement you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Articulations group of the Properties panel, activate Placement under the 
corresponding heading for the articulations whose placement you want to change.

For example, activate Placement under the Articulations of force heading to change the 
placement of accents.

3. Select one of the following options from the menu:

● Notehead side

● Stem side

RESULT
The articulation is placed on the selected side of the notes or chords. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain. If this creates 
a collision with other markings, such as playing techniques, Dorico Pro automatically makes 
adjustments to make sure all markings are clear and legible.

Changing the placement of articulations relative to slurs
You can change whether individual articulations of duration are placed inside or outside slur 
endpoints, independently of your project-wide setting. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to articulations of duration. They do not apply to articulations of force or 
stress.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/chords whose articulation placement you want to change. You can do this in 
Write mode and Engrave mode.
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2. In the Properties panel, activate Inside slur endpoint in the Articulations group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Articulations of duration are placed inside slur endpoints when the checkbox is activated, and 
outside slur endpoints when the checkbox is deactivated. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

When the property is deactivated, articulations follow your project-wide setting for the 
placement of articulations of duration relative to slur endpoints.

TIP

You can change the default placement of all articulations relative to slur endpoints project-wide 
in the Slurs section of the Articulations page in Engraving Options.

RELATED LINKS
Project-wide engraving options for articulations on page 955
Engraving Options dialog on page 840
Slur endpoints relative to articulations on page 1506
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the default placement of articulations
You can change the default placement of all articulations according to their type; for example, if 
you want articulations of stress always to be placed above the staff, but articulations of duration 
to be placed beside noteheads, both above and below the staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Articulations.

3. In the Placement section, choose one of the following options for each articulation type:

● Always above

● Natural placement

4. Click Apply, then Close.

RESULT
The default placement of the corresponding types of articulations is changed project-wide. 
Articulations with Natural placement are placed on the notehead side of notes.

TIP

You can also change the default gaps between noteheads/stems and articulations and between 
stacked articulations in the Vertical Position section of the Articulations page.

Articulations
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Allowing/Disallowing articulations inside the staff
You can choose whether or not each type of articulation is allowed to appear inside the staff 
project-wide; for example, if you want all staccato marks to appear outside the staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Articulations.

3. In the Vertical Position section, click Advanced Options to show the available options.

4. For Position of articulations relative to the staff, choose one of the following options for 
each articulation type:

● Allow inside staff

● Do not allow inside staff

5. Click Apply, then Close.

RESULT
The staff-relative placement of the corresponding articulation types is changed project-wide.

Articulations in playback
Articulations affect how notes sound in playback. Depending on whether your sound library has 
specific samples for different articulations, Dorico Pro changes playback in different ways to 
reflect articulations.

● If your sound library includes samples for articulations, Dorico Pro loads the required 
samples using playback techniques. Additionally, Dorico Pro makes notes with staccatos 
sound shorter and notes with accents sound louder.

● If your sound library does not include samples for articulations, Dorico Pro adjusts notes 
according to the articulation without loading different samples. For example, making notes 
with staccatos sound shorter and notes with accents sound louder.

Because articulations apply to whole notes, samples are triggered at the start of notes, including 
tie chains.

TIP

● You can find options on the Timing page in Playback Options for the default effect of 
articulations of duration. You can find options for articulations of force on the Dynamics 
page.

● You can enable independent voice playback for individual instruments to hear different 
sounds in different voices simultaneously; for example, if you have slurs in one voice and 
staccatos in another voice.

RELATED LINKS
Playback techniques on page 936
Playback Options dialog on page 842
Enabling independent voice playback on page 636

Articulations
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Bars

Bars indicate a usually regular pattern of beats, determined by the prevailing time signature. 
Bars are separated from adjacent bars by vertical barlines, and each bar has a unique bar 
number.

Dorico Pro automatically numbers bars and shows barlines between bars as required for the 
prevailing time signature.

RELATED LINKS
Barlines on page 967
Bar numbers on page 981
Note and rest grouping on page 1021
Time signatures on page 1639
Pick-up bars on page 1643
Input methods for bars, beats, and barlines on page 302
Input methods for time signatures and pick-up bars on page 284

Bar length
Bars usually last the same duration and start and end at the same positions for all players. 
However, some music involves bars of different lengths coinciding, and there are situations 
where some players may have no bars indicated at all.

You can change the duration of a bar by changing its time signature or, in music in open meter, 
by inputting barlines where required. You can hide time signatures you do not want to show in 
the music; for example, if you are writing music with an irregular meter and you require barlines 
only to group material together, but not to imply any sense of meter.

RELATED LINKS
Hiding/Showing time signatures on page 1655

Deleting bars/beats
You can delete whole bars and specific beats of music from your project completely by using the 
bars and barlines popover.

PROCEDURE

1. In Write mode, select one of the following:

● The first bar you want to delete, or the first note or rest in that bar.

● An item at the rhythmic position from which you want to delete beats.

2. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

3. Enter – (minus), followed by the number of bars or beats you want to delete into the 
popover.

962
Dorico Pro 4.3.30



For example, enter –6 to delete six bars, meaning the bar you selected and the subsequent 
five bars, or -2q to delete two quarter note beats, starting from the selected rhythmic 
position.

4. Press Return  to close the popover.

RESULT
The number of bars or beats specified is deleted. Just as when Insert mode is activated, music to 
the right of the selection moves up to fill in the gap.

NOTE

● Any signposts in the selection are also deleted.

● Deleting some, but not all, beats from bars according to the prevailing time signature 
deletes the contents of those beats only. If you want to shorten a bar’s duration, such as at 
the end of flows that start with a pick-up bar, you must instead either input a time signature 
with the required number of beats then hide the time signature, or input a barline and 
delete any excess bars if necessary. You can also use the Global Adjustment of Current Bar 
Insert mode scope and delete notes/rests.

RELATED LINKS
Bars and barlines popover on page 302
Pick-up bars on page 1643
Deleting notes/items on page 459
Deleting rests on page 1493
Insert mode on page 454
Signposts on page 453
Input methods for bars, beats, and barlines on page 302
Input methods for time signatures and pick-up bars on page 284

Deleting bars/beats with the system track
You can delete whole bars and selected beats from your project completely using the system 
track.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In the system track in Write mode, select the region that you want to delete.

2. Click Delete in the system track. It can also appear above the system track if your selection is 
narrow.

Delete button in the system track The system track changes color when you hover 
over the Delete button.

RESULT
The selected region is deleted. Just as when Insert mode is activated, music to the right of the 
selection moves up to fill in the gap.
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NOTE

● Any signposts in the selection are also deleted. This can affect the page formatting; for 
example, by removing ossia staves whose signposts were included in the selection.

● Deleting some, but not all, beats from bars according to the prevailing time signature 
deletes the contents of those beats only. If you want to shorten a bar’s duration, such as at 
the end of flows that start with a pick-up bar, you must instead either input a time signature 
with the required number of beats then hide the time signature, or input a barline and 
delete any excess bars if necessary. You can also use the Global Adjustment of Current Bar 
Insert mode scope and delete notes/rests.

RELATED LINKS
System track on page 430
Insert mode on page 454
Signposts on page 453

Deleting empty bars/beats at the end of flows
You can trim flows by deleting any empty bars or beats left at the end.

PROCEDURE

1. In Write mode, select an item in the flow you want to trim.

2. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

3. Enter trim into the popover.

4. Press Return  to close the popover.

RESULT
Empty bars/beats at the end of the selected flow are deleted.

TIP

You can also trim flows by choosing Write > Trim Flow.

RELATED LINKS
Bars and barlines popover on page 302
Splitting flows on page 506
Input methods for bars, beats, and barlines on page 302
Deleting rests on page 1493

Deleting the contents of bars
You can delete just the contents of bars without deleting barlines or the bars themselves.

PROCEDURE

1. In Write mode, select the bars whose contents you want to delete.
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TIP

Notes, rests, and other objects are highlighted orange when selected.

2. Press Backspace or Delete .

RELATED LINKS
Large selections on page 428
Filters on page 433
Insert mode on page 454

Changing the width of empty bars
You can change the width of empty bars individually in Engrave mode.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a square note spacing handle at the rhythmic position of the barline 
at the end of each empty bar whose width you want to change.

2. Adjust the spacing in any of the following ways:

● To increase the space to the left of the selected handles, press Alt/Opt-Right Arrow .

● To decrease the space to the left of the selected handles, press Alt/Opt-Left Arrow .

NOTE

● To move handles by large increments, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move handles by moderate increments, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Left Arrow .

● To move handles by small increments, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● You cannot move note spacing handles with the mouse, you can only move them 
using the keyboard.

RESULT
The width of the selected empty bars is changed. For example, if you select the handle of the 
barline on the right of a bar and nudge the handle to the left, the bar appears narrower. If you 
select the barline on the right of a bar and nudge the handle to the right, the bar appears wider.

RELATED LINKS
Engrave toolbox on page 514
Note spacing on page 599
Hiding/Showing bar rests in empty bars on page 1494
Hiding/Showing multi-bar rests on page 1496
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Splits in bars
You can split bars rhythmically by changing the number of beats in each bar. You can split bars 
visually across system or frame breaks, which might be required in music with an irregular meter 
or in passages of polymeter.

Splitting bars by inputting new time signatures

You can split bars into two or more bars by changing the time signature at any rhythmic 
position. New time signatures apply until the next existing time signature or the end of the 
flow, whichever comes first.

NOTE

If you change the time signature in the middle of an existing bar, we recommend inputting 
another time signature at the start of the preceding bar reflecting its new rhythmic duration to 
avoid confusion.

Splitting bars by inputting new barlines

You can also split bars by inputting new barlines that are not normal (single) barlines anywhere 
within a bar without affecting the time signature. However, inputting a normal (single) barline 
anywhere within an existing bar resets the prevailing time signature from that point onwards.

For example, selecting the third quarter note (crotchet) in a 4/4 bar and inserting a new barline 
causes a new 4/4 bar to start from the added barline. This leaves the equivalent of a 2/4 bar 
without a time signature to the left of the barline, but the bars to the right of the added 
barline are in 4/4 and continue to be in 4/4 until the next time signature or the end of the flow, 
whichever comes first.

Signposts are shown at the position of each barline, excluding short and tick barlines, that you 
add manually within bars.

Two 4/4 bars with quarter notes Adding a normal barline halfway through the first 
4/4 bar restarts the time signature from that point.

RELATED LINKS
Input methods for bars, beats, and barlines on page 302
Input methods for time signatures and pick-up bars on page 284
Inserting system breaks on page 734
Inserting frame breaks on page 737
Inputting notes in Insert mode on page 237
Insert mode on page 454
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Barlines

Barlines are vertical lines that cross staves in order to show how music is divided into bars, 
according to the time signature. The most commonly used barline is the single barline between 
adjacent bars, but there are different types, such as double or repeat barlines.

The final system in a piece in 12/8 containing a key change with double barline, three normal barlines, and a 
final barline at the end

Dorico Pro automatically shows barlines as required for the prevailing time signature. For 
example, Dorico Pro automatically shows dashed barlines between the different meters in 
aggregate time signatures. If you change the time signature, Dorico Pro moves the barlines 
as required so that subsequent music is barred correctly.

By default, Dorico Pro uses single barlines in flows and final barlines at the end of flows. You 
can change the default barline used in and at the end of each flow independently. You can also 
change the barline shown at key signature changes, which is a double barline by default.

Barlines automatically extend across staff groups that are joined by a bracket or brace.

RELATED LINKS
Types of barlines on page 968
Input methods for bars, beats, and barlines on page 302
Barlines across staff groups on page 976
Custom staff grouping on page 1030
Changing the barline shown at key signature changes on page 972
Changing the default barline type in flows on page 970
Changing the default barline at the end of flows on page 971
Repeats in playback on page 640
Repeat counts on page 1456
Bars on page 962
Bar numbers on page 981
Time signatures on page 1639
Types of time signatures on page 1641
Input methods for time signatures and pick-up bars on page 284
Note and rest grouping on page 1021
Deleting notes/items on page 459

Project-wide engraving options for barlines
You can find options for the project-wide appearance of barlines on the Barlines page in 
Engraving Options.

The options on the Barlines page allow you to change the appearance and thickness of barlines, 
and which barlines are used in different contexts. For example, you can change the default 
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appearance of repeat barlines, changing the default barline shown before codas, and whether 
barlines join vocal staves and ossia staves.

You can also change the gaps before and after barlines, including end repeat barlines, on the 
Spacing Gaps page in Engraving Options.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Barlines across staff groups on page 976
Barlines on ossia staves on page 1560
Changing the barline shown before codas on page 1453

Per-flow notation options for barlines
You can find options for the per-flow the appearance of barlines on the Barlines page in 
Notation Options.

For example, you can change the type of barline used in and shown at the end of each flow by 
default, whether single barlines between staves only appear between staves or extend across 
staves, and whether barlines join all staves at the end of each system and at the end of the final 
system in a flow.

Musical examples demonstrate how each option affects the appearance of your music.

RELATED LINKS
Notation Options dialog on page 837

Types of barlines
There are multiple types of barlines in Dorico Pro, which can all be input, moved, and deleted in 
the same ways.

Normal (Single)
A standard single barline that spans the entire height of the staff. For single-line staves, 
the barline extends one space above and below the staff line by default.

Double
A double barline consists of two lines, both the width of a single barline, positioned half 
a space apart by default. It is often used to denote significant changes in the music, or 
to mark the placement of rehearsal marks, key signature changes, and tempo changes.

Triple
A triple barline consists of three lines, all the width of a single barline, positioned half 
a space apart by default. It is sometimes used in musicological analysis to demarcate 
structural units larger than a single bar.

Barlines
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Final
A final barline consists of two lines: one of normal width, the other thick. It marks 
where the music ends.

Dashed
A dashed barline has the same thickness as a normal barline, but has gaps within it 
to give it a dashed appearance. It is used to subdivide bars to make complex time 
signatures easier to read, and to differentiate editorial barlines from ones originally in 
the manuscript.

Tick
A tick barline is a short line that spans only the top or bottom line of the staff. It is 
useful when notating plainsong, in which context it denotes a breath or short gap 
between phrases, or other music with an unusual metrical structure.

Tick (top) barline Tick (bottom) barline

Short
A short barline spans either the middle of the staff, which on a five-line staff is between 
the second and fourth lines, or the top half of the staff, which on a five-line staff 
is between the first and third lines. On staves with fewer than five lines, the short 
barline is scaled proportionally. It is useful when notating plainsong, in which context it 
denotes a longer gap between phrases than a tick barline.

Short (center) barline Short (top) barline

Thick
A thick barline is half a space wide by default, so it is noticeably thicker than a normal 
barline. This gives it a greater visual impact.

Start repeat
A start repeat line consists of a thick barline, followed by a normal barline, followed by 
one of the following arrangements of dots:
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● Two dots, one each in the middle two spaces of a five-line staff

● Four dots, one each in all four spaces of a five-line staff

It shows the start of a repeated section. It is used alongside end repeat lines, which 
show the end of a repeated section.

End repeat
An end repeat line is the mirror of a start repeat line, so it consists of either two or 
four dots, followed by a normal barline, followed by a thick barline. It shows the end 
of a repeated section. It is used alongside start repeat lines, which show the start of a 
repeated section.

End/Start repeat
This line combines the start repeat and end repeat barlines, with either two single 
barlines with a single shared thick barline in the middle, or two thick barlines and no 
single barlines. On either side, there are either two or four repeat dots. It is used when 
a repeated section is immediately followed by another, separate repeated section.

RELATED LINKS
Input methods for bars, beats, and barlines on page 302
Repeats in playback on page 640
Repeat counts on page 1456
Barlines across staff groups on page 976

Changing the default barline type in flows
By default, Dorico Pro uses single barlines to separate bars in flows. You can change which type 
of barline automatically separates bars in each flow independently. For example, short or tick 
barlines are frequently used for most barlines in chant notation.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows whose default barline type you want to change.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Barlines.

4. Choose one of the following options for Default barline type:
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● Normal

● Double

● Dashed

● Final

● Tick (Top)

● Tick (Bottom)

● Short (Center)

● Short (Top)

● Thick

● Start Repeat

● End Repeat

● End and Start Repeat

5. Click Apply, then Close.

RESULT
The default barline type in the selected flows is changed. This does not override any explicit 
barlines you have input, such as repeat barlines in repeat endings, or the final barlines in the 
selected flows.

RELATED LINKS
Types of barlines on page 968
Repeat endings on page 1440
Input methods for bars, beats, and barlines on page 302

Changing the default barline at the end of flows
By default, Dorico Pro uses final barlines at the end of flows. You can choose which type of 
barline is placed automatically at the end of each flow independently; for example, you might 
show double barlines at the end of flows to indicate there should be no gap before the following 
flow.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows whose default end barline you want to change.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Barlines.

4. Choose one of the following options for Automatic barline at end of flow:

● Final barline

● Double barline

● Normal barline

● Dashed barline

● Thick barline

● No barline
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5. Click Apply, then Close.

RESULT
The default final barline at the end of the selected flows is changed.

NOTE

You can override individual final barlines by inputting a barline of a different type, but you cannot 
delete individual final barlines.

Changing the barline shown at key signature changes
You can change the default barline shown at all key signature changes that occur at barlines 
project-wide. By default, Dorico Pro shows double barlines at key signature changes.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Barlines.

3. In the Key Signatures section, choose one of the following options for Changes of key 
signature at the start of the bar:

● Draw double barline

● Draw single barline

4. Click Apply, then Close.

RELATED LINKS
Engraving Options dialog on page 840
Hiding/Showing cancellation naturals before key signature changes on page 1214

Changing the barline shown before repeat barlines
You can change the barline shown at the end of individual systems that are followed by start 
repeat barlines at the beginning of the next system, independently of your project-wide setting. 
For example, if you want to show normal barlines at the end of some systems following by start 
repeat barlines but double barlines at the end of others.

These steps can also apply to barlines shown before key signature changes that coincide with 
start repeat barlines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the barlines at the end of systems followed by start repeat barlines whose barline type 
you want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Barline at end of system in the Time Signatures group.

3. Select one of the following options from the menu:
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● Normal

● Double

● Final

● Dashed

● Tick (top)

● Short (center)

● Thick

● Triple

● Short (top)

● Tick (bottom)

● None

RESULT
The barline type shown at the selected barlines is changed.

TIP

You can change the default barline shown at the end of all systems followed by start repeat 
barlines project-wide on the Barlines page in Engraving Options.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769
Casting off on page 728
System breaks on page 733

Hiding/Showing systemic barlines on single-staff systems
By default, systemic barlines are shown at the start of systems containing two or more staves 
and hidden on single-staff systems. You can hide/show systemic barlines on single-staff systems 
on the first system and after the first system in each flow independently.

Showing systemic barlines on single-staff systems is a convention used in hand-copied lead 
sheets, usually in combination with hiding clefs and key signatures from the second system 
onwards.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show systemic barlines after the 
first system.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Barlines.

4. In the Systemic Barline subsection, choose one of the following options for Barline at start 
of first system:

● Show for one or more staves
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● Show for two or more staves

5. Choose one of the following options for Barline at start of systems following first system:

● Show for one or more staves

● Show for two or more staves

6. Click Apply, then Close.

RELATED LINKS
Hiding/Showing used chord diagrams grids on page 1060
Hiding/Showing clefs at the start of systems on page 1075
Hiding/Showing key signatures at the start of systems on page 1213

Hiding/Showing wings on repeat barlines
You can hide/show wings on all repeat barlines project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Barlines.

3. In the Repeats section, choose one of the following options for Wings on repeat barlines:

● Show wings

● Do not show wings

4. Click Apply, then Close.

RELATED LINKS
Engraving Options dialog on page 840
Project-wide engraving options for barlines on page 967
Barlines across staff groups on page 976
Brackets according to ensemble type on page 1026
Custom staff grouping on page 1030
Changing the appearance of bracket ends on page 1027

Changing the length of tick barlines
You can change the length of individual tick barlines; for example, to denote the mid-point of 
plainsong chants.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the tick barlines whose length you want to change.

2. In the Properties panel, activate Tick adj. in the Time Signatures group.

3. Change the values in the value fields.
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● Out controls the length of tick barlines outside the staff.

● In controls the length of tick barlines inside the staff.

RESULT
The length of the selected tick barlines is changed. This also affects subsequent tick barlines you 
input after the selected tick barlines, up to the next existing tick barline with a different length 
set, time signature, or the end of the flow, whichever comes first.

RELATED LINKS
Engrave toolbox on page 514
Properties panel on page 769
Hiding/Showing zones on page 47
Input methods for bars, beats, and barlines on page 302

Moving barlines graphically
You can adjust the spacing between barlines and neighboring notes, time signatures, key 
signatures, or rests.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a square note spacing handle at the rhythmic position of each 
barline you want to move.

2. Move the handles in any of the following ways:

● To increase the space to the left of selected handles, press Alt/Opt-Right Arrow .

● To decrease the space to the left selected handles, press Alt/Opt-Left Arrow .

NOTE

● To move handles by large increments, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move handles by moderate increments, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Left Arrow .

● To move handles by small increments, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● You cannot move note spacing handles with the mouse, you can only move them 
using the keyboard.

RESULT
The spacing to the right/left of the selected barlines is increased/decreased.
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EXAMPLE

The new position of the barline after decreasing the space to its left

RELATED LINKS
Engrave toolbox on page 514

Barlines across staff groups
In order to make it easier to find a particular instrument within a score, barlines can extend 
across instrumental and staff groups.

Barlines across default staff groups

When a barline only appears on individual staves, it is much harder to locate individual lines at 
a glance. However, when barlines continue across instrumental groups in the score, instrument 
families are shown as blocks, which makes finding an instrument much easier.

Barlines on individual staves Barlines across instrumental groups

By default, barlines automatically extend across staff groups that are joined by a bracket or 
brace, except for vocal staves, across which barlines never automatically extend. Which staves 
are included in a bracket depends on the instrumentation and context, but usually staves for 
instruments from the same family, such as woodwind or strings, are bracketed together.

Dorico Pro automatically brackets staves according to the ensemble type set for each layout.

Barlines across grand staff instruments

Dorico Pro automatically joins barlines across grand staff instrument staves as they are braced. 
Because staves cannot be bracketed and braced simultaneously, grand staff instruments are 
excluded from brackets and therefore are not joined with barlines to any other staves.
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Barline joins between staves

You can change whether single barlines only appear between staves or extend across the staves 
as well in each flow independently on the Barlines page in Notation Options. Barline joins 
only between staves are known as “Mensurstriche”. They are commonly used when typesetting 
early music to aid readability for modern performers while minimizing the visual impact on the 
originally unmetered notation.

Barlines drawn between staves

Custom barline groups

You can create custom barline joins and bracket groups by manually arranging your players 
into groups. Player groups are bracketed together according to the ensemble type set for each 
layout.

You can also input custom barline joins to determine the staves across which individual barlines 
extend.

RELATED LINKS
Brackets according to ensemble type on page 1026
Custom staff grouping on page 1030
Showing barlines across all staves at time signature changes on page 978
Designating players as soloists on page 128
Adding player groups on page 163
Adding players to groups on page 163
Deleting player groups on page 164
Player group labels on page 1542
Notation Options dialog on page 837

Changing the default barline joins
You can change whether barline joins automatically extend across staff groups that are joined by 
a bracket or brace, or break between each instrument, in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default barline joins.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.
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4. In the Bracketing section, choose one of the following options for Barline joins:

● Follow primary brackets

● Separate at each instrument

5. Click Apply, then Close.

RELATED LINKS
Brackets and braces on page 1023
Brackets according to ensemble type on page 1026
Custom staff grouping on page 1030

Showing barlines across all staves at time signature changes
You can join all staves with a barline at time signature changes in individual layouts, regardless of 
your bracketing style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signature changes where you want to join all staves with a barline. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Barline joins all staves in the Time Signatures group.

RESULT
All staves in the layout currently open in the music area are joined by a barline at the selected 
time signature changes.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769

Inputting custom barline joins
You can input custom barline joins at any position that change which staves are joined with 
barlines.

PREREQUISITE

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item on the top staff you want to join with a barline, at the start 
of the system from which you want this change to apply.

2. Ctrl/Cmd -click an item on the bottom staff you want to join with a barline.
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3. In the Formatting panel, click Change barline joins in the Bracketing group.

RESULT
All staves between and including the staves on which you selected items are joined by a barline 
until the next existing bracket and barline change or the end of the flow, whichever comes first. A 
signpost appears at the start of the system in which you selected items.

If necessary, any existing barline joins are adjusted to accommodate the new barline join.

NOTE

You cannot move bracket and barline change signposts, as they are intended to apply to system 
start positions. However, they can appear partway through systems if, for example, you move 
system breaks. When a bracket and barline change signpost is positioned partway through a 
system, the corresponding change only takes effect from the start of the next system.

EXAMPLE

Divisi cello staves with default staff grouping Divisi cello staves with separate barline joins across 
each instrument

RELATED LINKS
Signposts on page 453
Engrave toolbox on page 514
Formatting panel on page 516
Hiding/Showing zones on page 47
Resetting bracket and barline changes on page 1034
Deleting bracket and barline changes on page 1035

Deleting barline joins
You can delete individual barline joins independently of other barline joins and bracket/brace 
grouping changes at the same rhythmic position, which splits selected barline joins into showing 
separate barlines on each staff.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. In Engrave mode, select the barline joins you want to delete.

2. Press Backspace or Delete .

Lengthening/Shortening custom barline joins
You can lengthen/shorten custom barline joins vertically to change the staves across which they 
span; for example, if you added a new player below a barline join and want to extend the barline 
join to that staff.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a handle at either the top or bottom of each barline join you want to 
lengthen/shorten.

TIP

You only need to select a handle on one barline join for each bracket and barline change, 
as they apply from their signpost until the next existing change or the end of the flow, 
whichever comes first.

2. Move the handles in any of the following ways:

● To move them to the staff above, press Alt/Opt-Up Arrow .

● To move them to the staff below, press Alt/Opt-Down Arrow .

RESULT
The selected barline joins are lengthened/shortened to staves above/below. This affects the 
staves included in the barline joins on all systems to which the corresponding bracket and barline 
changes apply.

NOTE

Only one barline join can exist on each staff, they cannot overlap. If any part of a selected barline 
join collides with another barline join when it is lengthened/shortened, the other barline join is 
shortened to accommodate this.

You can undo this action, which restores the previous length of any shortened barline joins.
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Bar numbers

Bar numbers provide crucial reference points in music and make the chronological sequence 
of music clear. By providing a unique number for each bar, they enable accurate references 
to specific parts of pieces and allow players to co-ordinate themselves easily in rehearsals and 
concerts.

In Dorico Pro, bar numbers appear automatically, following the most common practice of 
showing a bar number at the start of each system in all layouts by default. You can hide and 
show bar numbers in each layout independently, including showing them at a specified regular 
interval or in every bar, which is frequently used in film music scores.

TIP

The majority of options relating to bar numbers are on the Bar Numbers page in Layout 
Options. This is because it is very common to display bar numbers differently in different 
layouts, such as in every bar in full score layouts but only at the start of each system in part 
layouts.

Bar numbers shown every bar in a part layout

RELATED LINKS
Bar number paragraph styles on page 985
Positions of bar numbers on page 986
Bar number changes on page 990
Layout Options dialog on page 834
Bars on page 962
Pick-up bars on page 1643
Barlines on page 967
Track overview on page 615

Project-wide engraving options for bar numbers
You can find options for the project-wide appearance, enclosures, and contents of bar numbers 
on the Bar Numbers page in Engraving Options.

The options on the Bar Numbers page allow you to choose whether repeated sections are 
included in bar numbers or not, change the case of letters in subordinate bar numbers, and 
change the minimum gaps between bar numbers and clefs shown at the start of systems. You 
can also change the line thickness, size, and padding values for bar number enclosures.

RELATED LINKS
Engraving Options dialog on page 840
Hiding/Showing bar number enclosures on page 982
Changing the distance between bar numbers and the staff/other objects on page 988
Bar numbers and repeats on page 994
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Hiding/Showing bar numbers
You can hide/show bar numbers in each layout independently, including showing them at 
different frequencies. For example, you can show bar numbers every bar in full score layouts 
but only at the start of each system in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Frequency subsection, choose one of the following options for Show bar numbers:

● Every system

● Every n bars

● Every bar

● None

5. Optional: If you chose Every n bars, set a custom frequency for bar numbers by changing 
the value for Interval.

6. Click Apply, then Close.

RESULT
Bar numbers are hidden in the selected layouts when you choose None, and shown at the 
corresponding frequency when you choose any other option.

Changing the Interval value changes how frequently bar numbers are shown. For example, 
setting an interval value of 10 means that bar numbers are shown every tenth bar.

TIP

You can also hide individual bar numbers in layouts where bar numbers are shown by selecting 
them and activating Hide bar number in the Time Signatures group of the Properties panel.

RELATED LINKS
Changing the distance between bar numbers and the staff/other objects on page 988
Changing the system-relative placement of bar numbers on page 989
Hiding/Showing bar number ranges on multi-bar rests on page 984
Hiding/Showing bar counts on single bar rests on page 1498
Showing bar numbers above specific staves on page 987
Hiding/Showing guide bar numbers on page 984
Bar number paragraph styles on page 985
Positions of bar numbers on page 986
Numbered bar regions on page 1467

Hiding/Showing bar number enclosures
You can optionally show bar numbers in either a rectangular or circular enclosure in each layout 
independently; for example, if you want bar numbers to appear with rectangle enclosures in the 
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full score layout, so the conductor can easily see them, but with no enclosures in part layouts, 
where pages tend to be less busy.

Bar numbers in enclosures automatically erase their backgrounds.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the bar number enclosure 
type.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Appearance subsection, choose one of the following options for Enclosure type:

● None

● Rectangle

● Circle

5. Click Apply, then Close.

RESULT
The enclosure type of all bar numbers in the selected layouts is changed. The size and shape of 
enclosures depends on their padding values and the bar number font size.

TIP

You can change the line thickness, size, and padding values for all bar number enclosures 
project-wide on the Bar Numbers page in Engraving Options.

EXAMPLE

Bar number with no enclosure Bar number with a rectangle 
enclosure

Bar number with a circle enclosure

RELATED LINKS
Layout Options dialog on page 834
Engraving Options dialog on page 840
Bar number paragraph styles on page 985
Changing the rehearsal mark enclosure type on page 1425
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Hiding/Showing bar number ranges on multi-bar rests
You can hide/show bar number ranges on multi-bar rests; for example, so it is clear in part 
layouts which bars the player does not play. Multi-bar rests can include bar repeat regions, if you 
have chosen to consolidate bar repeat regions as well as empty bars into multi-bar rests.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar number ranges on 
multi-bar rests.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Showing and Hiding subsection, activate/deactivate Show ranges of bar numbers 
under multi-bar rests and consolidated bar repeats.

5. Click Apply, then Close.

RESULT
Bar number ranges are shown beneath multi-bar rests and consolidated bar repeats in the 
selected layouts when the option is activated, and hidden when it is deactivated.

TIP

You can change the bar number range separator and the default distance between bar number 
ranges and the staff in Engraving Options > Rests > Multi-bar Rests.

RELATED LINKS
Hiding/Showing bar numbers on page 982
Hiding/Showing multi-bar rests on page 1496
Engraving Options dialog on page 840
Bar number paragraph styles on page 985
Numbered bar regions on page 1467

Hiding/Showing guide bar numbers
You can hide/show guide bar numbers on every bar and above every system in page view and 
galley view independently; for example, to make it easier to check the bar number in scores with 
many staves. Guide bar numbers are not printed.

PROCEDURE

● Hide/Show guide bar numbers in any of the following ways:

● To hide/show guide bar numbers in page view, choose View > Bar Numbers > Page 
View.

● To hide/show guide bar numbers in galley view, choose View > Bar Numbers > Galley 
View.
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RESULT
Guide bar numbers are hidden/shown for every bar and above every staff in the corresponding 
view type.

EXAMPLE

Guide bar numbers shown in page view

RELATED LINKS
Switching to galley/page view on page 53

Bar number paragraph styles
In Dorico Pro, bar numbers use paragraph styles so that you can use different paragraph styles 
in different layouts. In particular, part layouts often require differently formatted bar numbers 
compared to full score layouts.

By default, there are the following paragraph styles for bar numbers:

● Bar numbers (parts): Used in part layouts

● Bar numbers (score): Used in full score and custom score layouts

Initially, both paragraph styles have the same settings, but you can change the settings of each 
paragraph style independently. For example, you might want to use a bold italic font for bar 
numbers in part layouts but use a plain font with a much larger font size in full score layouts.

You can then change which paragraph style is used in each layout independently.

RELATED LINKS
Paragraph Styles dialog on page 848

Editing the bar number paragraph styles
You can edit the formatting of the paragraph styles used for bar numbers; for example, if you 
want to increase their font size. By default, there is a paragraph style for bar numbers in full 
score layouts and another paragraph style for bar numbers in part layouts.

PREREQUISITE
If you want to use additional bar number paragraph styles to the ones provided by default, you 
have created new paragraph styles.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. In the paragraph styles list, select one of the following bar number paragraph styles:

● Bar numbers (parts)

● Bar numbers (score)
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3. Optional: Select one of the available styles from the Parent menu.

If you select a parent style, an activated switch is shown beside all the options that are 
different in the selected paragraph style, compared to its parent style.

4. Activate and change the options you want for the selected paragraph style.

5. Click OK to save your changes and close the dialog.

RESULT
The selected bar number paragraph style is changed. This affects the appearance of bar 
numbers in all layouts that use the selected style.

TIP

You can also make additional bar number paragraph styles, as each layout can use a different 
paragraph style for bar numbers.

RELATED LINKS
Creating paragraph styles on page 850

Changing the bar number paragraph style used in layouts
You can choose which paragraph style is used for bar numbers in each layout independently. By 
default, full score layouts and part layouts use different paragraph styles for bar numbers.

PREREQUISITE
If you want to use a custom paragraph style for bar numbers in some layouts, you have created it 
in the Paragraph Styles dialog.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the paragraph style used 
for bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Appearance subsection, select a paragraph style from the Paragraph style menu.

5. Click Apply, then Close.

RESULT
The selected paragraph style is used for all bar numbers in the selected layouts.

Positions of bar numbers
Bar numbers are typically shown at the start of each system, above the staff, and aligned with 
the initial barline.

You can change the default positions and frequency of bar numbers in each layout 
independently on the Bar Numbers page in Layout Options, and you can move individual bar 
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numbers in Engrave mode. For example, you might want to show bar numbers every bar in full 
score layouts but only at the start of each system in part layouts.

Changing the horizontal position of bar numbers
You can change the horizontal position of bar numbers in each layout independently. For 
example, you can have bar numbers centered in the middle of bars in full score layouts but 
centered on barlines in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the horizontal position of 
bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Horizontal Position subsection, choose one of the following options for Horizontal 
position:

● To show bar numbers above barlines, at the top left of the bar, choose Centered on 
barline.

● To show bar numbers above the staff, in the middle of the bar, choose Centered on bar.

5. Click Apply, then Close.

RESULT
The horizontal position of bar numbers is changed in the selected layouts.

RELATED LINKS
Showing bar numbers above specific staves on page 987
Moving items graphically on page 609

Showing bar numbers above specific staves
You can change the staves above which bar numbers appear, which allows you to show bar 
numbers at multiple vertical positions in each system. For example, in large orchestral scores, 
you might show bar numbers both at the top of the system and above the string section.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical positions of 
bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Placement subsection, activate the checkbox for each player in the Show above 
specific players list above whose top staff you want to show bar numbers.
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5. Click Apply, then Close.

RESULT
The vertical positions of bar numbers are changed in the selected layouts. For players holding 
multiple instruments, bar numbers appear above their top instrument staff.

NOTE

You can change the distances between bar numbers and the staff/other objects and your vertical 
spacing settings for the gaps between staves in order to accommodate bar numbers shown 
between staves.

RELATED LINKS
Changing the default staff/system spacing on page 694
Per-layout vertical spacing options on page 721
Moving instruments on page 141

Changing the distance between bar numbers and the staff/other 
objects

You can change the minimum distance between bar numbers and the staff, and set a separate 
value for the distance between bar numbers and other objects, in each layout independently. For 
example, you can position bar numbers further from the staff/other objects in full score layouts 
than in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the minimum distance of 
bar numbers from the staff.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. Optional: In the Placement subsection, change the value for Minimum distance from staff.

5. Optional: In the Placement subsection, change the value for Minimum distance from 
other objects.

6. Activate/Deactivate Align bar numbers across width of system.

7. Click Apply, then Close.

RESULT
Increasing the values positions bar numbers further away from the staff and/or other objects, 
either above or below the staff depending on your setting for Placement relative to staff. 
Decreasing the values positions bar numbers closer to the staff and/or other objects.

When Align bar numbers across width of system is activated, bar numbers automatically 
vertically align within systems, with their position determined by the bar number furthest from 
the staff.
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NOTE

● These options affect the minimum distance between bar numbers and the staff and other 
objects, so bar numbers might be positioned further away than this to avoid collisions.

● If you want bar numbers within systems to appear closer to the staff than bar numbers at 
the start of systems, such as in part layouts with treble clefs, we recommend deactivating 
Align bar numbers across width of system. You can change the minimum gaps between 
bar numbers and clefs shown at the start of systems on the Bar Numbers page in 
Engraving Options.

RELATED LINKS
Hiding/Showing bar numbers on page 982
Project-wide engraving options for bar numbers on page 981

Changing the system-relative placement of bar numbers
You can show bar numbers either above or below each system in each layout independently. For 
example, bar numbers can appear below the system in full score layouts but above the system in 
individual part layouts.

NOTE

This does not affect the placement of bar numbers shown above specific staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the bar number 
placement.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Placement subsection, choose one of the following options for Placement relative to 
system:

● Show above top staff of system

● Show below bottom staff of system

5. Click Apply, then Close.

RESULT
The placement of bar numbers relative to the system is changed in the selected layouts.
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Hiding bar numbers at time signatures shown at system object 
positions

You can choose to hide bar numbers at the same rhythmic position as time signatures shown at 
system object positions, as the resulting collision can be difficult to resolve in a visually clear way 
when bar numbers are centered on barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide bar numbers at time 
signatures shown at system object positions.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Showing and Hiding subsection, activate/deactivate Show bar numbers at time 
signatures at system object positions.

5. Click Apply, then Close.

RESULT
Bar numbers are shown at time signatures shown at system object positions when the option is 
activated, and hidden when it is deactivated.

EXAMPLE

Bar numbers shown at time signatures at system 
object positions

Bar numbers hidden at time signatures at system 
object positions

RELATED LINKS
Time signatures on page 1639
Large time signatures on page 1645

Bar number changes
Bar numbers follow a continuous sequence, with each bar having a unique bar number that 
continues from the previous bar number. However, you can make manual changes to the bar 
number sequence, including changing to a subordinate sequence.

In Dorico Pro, you can make the following types of changes to bar number sequences using the 
Insert Bar Number Change dialog:

Primary
Adds a change to the main bar number sequence, which the bars in your project follow 
in a continuous sequence in each flow separately by default.
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Subordinate
Adds a secondary bar number sequence that uses letters rather than numbers to 
indicate the sequence. This can be useful in situations where a new version of a piece 
has been created with more bars inserted, but the original bar numbers are required.

Don’t Include
Excludes the selected bar from the current bar number sequence. If bar numbers are 
shown every bar, no bar number is shown in bars in which you have chosen Don’t 
Include.

Continue Primary
Returns the bar number sequence to the Primary sequence without counting 
intervening bars; for example, after a section of bars following the Subordinate bar 
number sequence.

RELATED LINKS
Subordinate bar numbers on page 992

Adding bar number changes
You can manually add bar number changes to bar number sequences; for example, if you want 
bar numbers in the second flow in your project to appear to continue the sequence from the first 
flow, rather than start again from bar one.

PROCEDURE

1. In Write mode or Engrave mode, select one of the following:

● An item in the bar from the beginning of which you want to change the bar number 
sequence.

● An existing bar number or barline from which you want to change the bar number 
sequence.

2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose one of the following options for Type:

● Primary

● Subordinate

● Don’t Include

● Continue Primary

4. Optional: If you chose Primary or Subordinate, change the bar number where you want 
the bar number sequence change to start by changing the value in the corresponding value 
field.

5. Click OK to save your changes and close the dialog.

RESULT
The bar number sequence changes, starting from the beginning of the bar in which you selected 
an item, or from the position of a selected bar number or barline.

This affects the corresponding bar number sequence from the changed bar number until the 
next bar number change, or until the end of the flow.
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Deleting bar number changes
You can delete any bar number changes you have added.

PROCEDURE

1. In Write mode, select the bar number changes you want to delete.

2. Press Backspace or Delete .

RESULT
The bar number changes are deleted. Subsequent bars follow the previous bar number 
sequence until the next bar number change, or until the end of the flow.

Subordinate bar numbers
Subordinate bar numbers are useful for numbering repeat endings, and for situations when the 
music is being altered, but the original bar numbers cannot be changed.

For example, you can use subordinate bar numbers to show where music has been added if a 
previous, shorter version has already been rehearsed. In this situation, players have likely started 
to associate certain parts of the piece with particular bar numbers, so if four bars need to be 
added after bar 10, they would be numbered 10a to 10d. The bar number of the following bar 
then continues from 11 exactly as it did before the new bars were added.

They might also be useful if you want different bar numbers for a repeat ending.

Subordinate bar numbers are shown with lowercase letters by default, but you can present them 
as either uppercase or lowercase letters.

You can show both primary bar numbers and subordinate letters or only subordinate 
alphabetical letters in subordinate bar number sequences.

Lowercase subordinate bar number Uppercase subordinate bar number

RELATED LINKS
Changing the appearance of subordinate bar numbers on page 994

Adding subordinate bar numbers
You can create a subordinate bar number sequence that is independent of your primary bar 
number sequence. This can be useful if you want to insert new bars without changing the bar 
numbers of existing subsequent bars.

PROCEDURE

1. In Write mode or Engrave mode, select one of the following:

● An item in the bar from the beginning of which you want subordinate bar numbers to 
start.

● An existing bar number or barline from which you want subordinate bar numbers to 
start.
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2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose Subordinate for Type to activate the Subordinate value field.

4. Optional: If you want to change the primary bar number that accompanies subordinate bar 
numbers, activate Primary and change the value in the value field.

For example, if you want the bar number sequence 6, 7a, 7b rather than 6, 7, 7a.

5. Change the first letter in the subordinate bar number sequence by changing the value in the 
Subordinate value field.

The corresponding alphabetical letter is shown to the right of the value field. For example, 
entering 1 into the value field is shown as a, 2 appears as b, and so on.

6. Activate/Deactivate Hide primary bar numbers.

7. Click OK to save your changes and close the dialog.

RESULT
The subordinate bar number sequence starts from the bar in which you selected an item, or from 
the position of a selected bar number or barline.

● If you activated Primary and changed the value, the primary bar number shown alongside 
subordinate bar numbers is changed.

● If you deactivated Hide primary bar numbers, bar numbers in the subordinate sequence 
show both a number and an alphabetical letter. If you activated Hide primary bar numbers, 
they appear only with alphabetical letters.

For example, if you start a subordinate bar number sequence from what was originally bar 5 
without changing the Primary value, the sequence starts from 4a and continues until the next 
specified bar number change, or until the end of the flow.

Returning to the primary bar number sequence
You can specify the point where you want to return to the primary bar number sequence after a 
section of subordinate bar numbers.

PROCEDURE

1. In Write mode or Engrave mode, select one of the following:

● An item in the bar from the beginning of which you want to return to the primary bar 
number sequence.

● An existing bar number or barline from which you want to return to the primary bar 
number sequence.

2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose Continue Primary for Type.

Text indicating the new bar number appears below the value fields for Primary and 
Subordinate. For example, Primary sequence will continue from bar 5.

4. Click OK to save your changes and close the dialog.

RESULT
The primary bar number sequence resumes from the bar in which you selected an item, or from 
the position of a selected bar number or barline.
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TIP

You do not have to add subordinate bar number changes in chronological order. You can enter 
a return to the primary bar number sequence first, before adding the subordinate bar number 
sequence.

Changing the appearance of subordinate bar numbers
You can show all subordinate bar numbers project-wide as either lowercase or uppercase letters.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Bar Numbers.

3. In the Sequence subsection, choose one of the following options for Letter case for 
subordinate bar numbers:

● Lower case

● Upper case

4. Click Apply, then Close.

Bar numbers and repeats
By default in Dorico Pro, repeats are not included in the bar number count. For example, if the 
first ending ends in bar 10, the second ending starts in bar 11, even though the first section is 
repeated and therefore more than ten bars have been played.

Including repeats in the bar number count, so that bar numbers reflect the total number of 
bars played rather than the number of bars written on the page, can make music with multiple 
playthroughs clearer, as you can refer to a specific bar number for each playthrough instead of, 
for example, “bar eight the third time round”.

Bar number for subsequent repeat shown in parentheses beside the initial bar number

In Dorico Pro, you can include repeats in the bar number count automatically when repeats are 
included in playback. This applies to any presentation of multiple playthroughs, including repeat 
endings and repeat markers, such as D.C. al Coda.

Because it is important that all players refer to the same bar numbers, this affects all layouts 
project-wide.

When you include repeats in the bar number count, multiple bar numbers apply to the same 
notated bars. To reflect this, Dorico Pro shows the initial bar number as normal but adds bar 
numbers for subsequent repeats to the right by default. You can change which playthroughs are 
included in bar numbers, and the appearance of bar numbers for subsequent repeats, in each 
layout independently. By default, they are shown in parentheses.
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EXAMPLE

Bar numbers not counting repeats with only initial 
bar numbers shown

Bar numbers counting repeats with bar numbers for 
subsequent repeats shown alongside the initial bar 
numbers

RELATED LINKS
Changing the appearance of bar numbers for subsequent repeats on page 996

Including/Excluding repeats from the bar number count
You can choose to include/exclude repeats from the bar number count in all layouts project-wide. 
By default, repeats are excluded from the bar number count.

PREREQUISITE
Repeats are included in playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Bar Numbers.

3. In the Repeats subsection, choose one of the following options for Bar numbering for 
repeated sections:

● Count repeats

● Do not count repeats

4. Click Apply, then Close.

RESULT
Repeats are included in the bar repeat count when you choose Count repeats, and excluded 
from the bar repeat count when you choose Do not count repeats.

Changing which playthroughs are shown in bar numbers
In projects that contain repeats, you can change which playthroughs are shown in bar numbers 
in each layout independently; for example, if some players want to see bar numbers for all 
playthroughs in their parts, but others only want to see the last repeat.

NOTE

This does not affect the overall bar number count, only which bar numbers are shown.

PREREQUISITE
Repeat sections are included in the bar number count.
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PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change which playthroughs are 
shown in bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Repeats subsection, choose one of the following options for Count repeats:

● All repeats

● First repeat only

● Last repeat only

5. Click Apply, then Close.

RESULT
The playthroughs shown in bar numbers in the selected layouts are changed.

EXAMPLE

Bar numbers with all repeats 
shown

Bar numbers with first repeat only 
shown

Bar numbers with last repeat only 
shown

Changing the appearance of bar numbers for subsequent repeats
When the bar number count includes repeats, bar numbers for subsequent repeats are shown 
beside the initial bar numbers. They are parenthesized by default, but you can change the prefix 
and suffix of bar numbers for subsequent repeats in each layout independently.

PREREQUISITE
Repeat sections are included in the bar number count.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the appearance of bar 
numbers for subsequent repeats.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. Optional: In the Repeats subsection, enter the prefix you want into the Prefix field.
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This field starts with a space by default so there is a gap between the initial bar number and 
the subsequent repeat bar number.

5. Optional: Enter the suffix you want into the Suffix field.

6. Click Apply, then Close.

RESULT
The appearance of bar numbers for subsequent repeats in the select layouts is changed. For 
example, if you want multiple bar numbers for the same bar to be separated by pipes, enter | 
into the Prefix field and nothing into the Suffix field.

EXAMPLE

Bar number for subsequent repeat with parentheses 
for suffix/prefix

Bar number for subsequent repeat with pipe for 
prefix
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Beaming

A beam is a line that connects notes with tails to show rhythmic grouping, which varies according 
to the metrical structure of the prevailing time signature.

This way of grouping notes helps performers calculate quickly exactly how to play their given 
rhythm and helps them follow both their part and, if applicable, the conductor.

If appropriate for the current meter and position in the bar, beams are automatically formed 
in Dorico Pro when you input two or more adjacent notes or chords that are an eighth note 
(quaver) or shorter in duration.

Multiple beam groups in a 6/8 time signature

Dorico Pro has sophisticated underlying rules for producing beam groupings that follow the 
accepted conventions of music theory, including crossing the half-bar in time signatures like 4/4, 
beaming all eighth notes together in 3/4, beam groups that include tuplets, and many other 
situations.

You can control how notes are beamed in multiple ways in Dorico Pro.

● You can set beam grouping defaults in each flow in your project independently on the Beam 
Grouping page in Notation Options.

● You can set beam groups by controlling subdivisions of time signatures.

● You can beam notes together and split beams manually.

There are many different accepted standards for how to present beams, so Dorico Pro offers a 
number of customizing options. You can find these options on the Beams page in Engraving 
Options.

RELATED LINKS
Inputting notes on page 221
Secondary beams on page 1013
Tuplets within beams on page 1016
Rests within beams on page 1016
Engraving Options dialog on page 840

Per-flow notation options for beam grouping
You can find options to control the default beam grouping rules in each flow independently on 
the Beam Grouping page in Notation Options.

The available options include beams crossing the half-bar in time signatures like 4/4, beaming all 
eighth notes together in 3/4, how to handle secondary beam groups, stemlets, and beams over 
rests.
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Musical examples demonstrate how each option affects the appearance of your music.

RELATED LINKS
Notation Options dialog on page 837
Rhythm dot consolidation on page 1258
Beam slants on page 1005

Beam grouping according to meters
According to accepted conventions, notes are beamed differently in different time signatures to 
make the meter clear and easily readable. In Dorico Pro, default beam groupings are determined 
by time signatures.

Dorico Pro has default beaming settings for common time signatures, based on general 
conventions and your chosen settings. For example, although the time signatures of 3/4 and 6/8 
contain the same number of beats, they imply different meters and so are beamed differently. 
In 3/4, phrases of eighth notes are beamed together within each bar and phrases of other 
durations are beamed in quarter notes (crotchets) by default, but in 6/8, phrases are beamed in 
dotted quarter notes.

Default eighth note beam grouping in 3/4 Default eighth note beam grouping in 6/8

Dorico Pro groups and beams notes in irregular time signatures, such as 5/8 or 7/8, according to 
the most common practices for those time signatures.

Default beam grouping in 5/8 Default beam grouping in 7/8

For situations where you want to control the beat grouping in more detail, you can input 
a custom time signature with an explicit rhythmic subdivision. Dorico Pro then automatically 
beams phrases according to this subdivision. For example, entering [7]/8 into the time signatures 
popover means all seven eighth notes (quavers) are beamed together, whereas entering 
[2+2+3]/8 subdivides the seven eighth notes into two, then two, then three.

NOTE

The duration of beam groups in Dorico Pro depends on the beat grouping in the prevailing time 
signature and your per-flow beam grouping settings in Notation Options.

RELATED LINKS
Note and rest grouping on page 1021
Rhythm dot consolidation on page 1258
Creating custom beat groupings for meters on page 1021
Inputting time signatures with the popover on page 288
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Beaming notes together manually
You can beam notes in the same voice together manually, including notes across barlines as 
well as system/frame breaks. For example, if you want to beam a phrase differently to how it is 
usually beamed in the prevailing time signature.

Beams by default stay within bars and systems, so to have beams cross barlines, system breaks, 
and frame breaks, you must force the phrase to beam together.

TIP

● If you want a single beam to span multiple staves, you can create cross-staff beams.

● Inputting time signatures with custom beat groupings is often the quickest and most 
consistent way to control beam grouping.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to beam together. You can do this in Write mode and Engrave 
mode.

2. Choose Edit > Notations > Beaming > Beam Together. You can also choose this option 
from the context menu.

RESULT
Selected notes in the same voice are beamed together, even if they cross barlines or system/
frame breaks.

If there are notes either side of the new beam group that were previously beamed to part or 
all of your selection, they either beam together as separate beams, or appear unbeamed. This 
depends on how many notes are left either side in the bar, and on the beam grouping settings 
for the flow.

NOTE

● Even if part of the beamed group previously had a centered beam, the new beam is not 
centered.

● You can assign a key command for Beam Together on the Key Commands page in 
Preferences.

EXAMPLE

Phrase with default beaming Notes in each bar beamed together

RELATED LINKS
Engrave toolbox on page 514
Creating fanned beams on page 1019
Allowing/Disallowing tuplets to span barlines on page 1672
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Changing the voice of existing notes on page 477
Centered beams on page 1007
Creating cross-staff beams/tremolos on page 1009
Beam grouping according to meters on page 999
Creating custom beat groupings for meters on page 1021
Key Commands page in the Preferences dialog on page 63

Unbeaming notes
You can separate all notes in a beamed group so that each note shows its own tail; for example, 
if you are engraving vocal music that requires syllabic beaming.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to make unbeamed. You can do this in Write mode and Engrave 
mode.

2. Choose Edit > Notations > Beaming > Make Unbeamed. You can also choose this option 
from the context menu.

RESULT
The selected notes are unbeamed and show their own tails.

TIP

You can assign a key command for Make Unbeamed on the Key Commands page in 
Preferences.

EXAMPLE

Phrase with default beaming All notes unbeamed

Splitting beam groups
You can split beams into two beam groups at specific rhythmic positions. You can also split 
secondary beams within beamed groups.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the noteheads to the right of where you want to split beams. You can do this in Write 
mode and Engrave mode.

2. Split the beam or secondary beam in one of the following ways:
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● Choose Edit > Notations > Beaming > Split Beam.

● Choose Edit > Notations > Beaming > Split Secondary Beam.

TIP

You can also choose these options from the context menu.

RESULT
Beams/Secondary beams are split to the left of each selected note, but the notes either side of 
the split remain grouped if there are at least two beamed notes on each side that can be in a 
beam group.

TIP

● To unbeam the entire selection and give all notes in the group individual tails, you can make 
all notes unbeamed.

● You can change how beams and secondary beams are split by default in each flow 
independently on the Beam Grouping page in Notation Options

● You can assign key commands for Split Beam and Split Secondary Beam on the Key 
Commands page in Preferences.

EXAMPLE

Phrase with default beaming Two beams split at the second 16th note

RELATED LINKS
Per-flow notation options for beam grouping on page 998
Beam grouping according to meters on page 999
Engrave toolbox on page 514
Key Commands page in the Preferences dialog on page 63

Resetting beam grouping
You can remove all changes made to the beam grouping of notes and chords. This can also be 
useful if, for example, MusicXML files you have imported have incorrect beaming.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes/chords whose beaming you want to reset. You can do this in Write mode 
and Engrave mode.

2. Choose Edit > Notations > Beaming > Reset Beaming. You can also choose this option 
from the context menu.
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RESULT
Beam grouping is reset to your default settings in Notation Options for the current flow and 
time signature.

Changing the thickness of beams
You can change the thickness of individual beams, which can be useful in certain engraving 
situations. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select all the noteheads in the beams whose thickness you want to 
change.

NOTE

For the best results, we recommend selecting all notes in each beam.

2. In the Properties panel, activate Thickness in the Beaming group.

3. Change the value in the value field.

RESULT
The thickness of all beam lines in the selected beams is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Beam slants on page 1005
Changing the gaps between beam lines on page 1015

Beam placement relative to the staff
The default staff-relative placement of beams is determined by the staff positions of the notes 
within the beamed group and their resulting stem directions.

This means that the note furthest from the middle line of the staff determines the placement of 
the beam, although there are exceptions to this rule and other considerations that can influence 
the staff-relative placement of beams.

Changing the staff-relative placement of beams involves changing the direction of the stems in 
the beam. Therefore, Dorico Pro categorizes changing the staff-relative placement of beams as a 
stem change.
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Changing the staff-relative placement of beams
You can change the side of the staff on which beams appear by forcing the stem direction to 
change. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each of the beamed phrases whose staff-relative placement you 
want to change. You can do this in Write mode and Engrave mode.

2. Force the stem direction of notes in the selected beams in any of the following ways:

● Choose Edit > Notations > Stem > Force Stem Up.

● Choose Edit > Notations > Stem > Force Stem Down.

TIP

● You can also choose these options from the context menu.

● You can also change the staff-relative placement of selected beams by pressing F .

RESULT
The beam appears on the side of the staff that corresponds to its forced stem direction. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Removing beam placement changes
You can undo changes to the staff-relative placement of beams in order to remove the stem 
direction change. This reverts selected beams to their default placement.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select at least one note in each of the beamed phrases whose staff-relative placement 
change you want to remove. You can do this in Write mode and Engrave mode.

2. Choose Edit > Notations > Stem > Remove Forced Stem. You can also choose this option 
from the context menu.

RESULT
The selected beams revert to their default staff-relative placement.
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Beam slants
The slant of a beam controls how steeply the beam deviates from horizontal, according to the 
pitches of the notes within the beamed group.

● When the last note of the phrase is higher than the first, the beam slants upwards.

● When the last note of the phrase is lower than the first, the beam slants downwards.

● If the group makes a concave shape, where inner notes are closer to the beam than the 
outer ones at either end of the beam, then the beaming is horizontal by default.

Beams are also horizontal if all the pitches are the same, or for certain patterns of repeated 
pitches.

When a beam is drawn inside the staff, each end of the beam, meaning the end of the stem of 
the note at either end of the beam, must be snapped to a staff line position. A beam line may 
sit on a staff line, be centered on a staff line, or hang from a staff line. Ted Ross describes these 
three positions as “sit”, “straddle”, and “hang” respectively in “Teach Yourself the Art and Practice 
of Music Engraving”.

A phrase containing multiple different beam slants and directions

The amount by which a beam slants is typically determined by the interval between the first and 
last note in the beamed group, provided the pattern of notes in the beam does not dictate a 
horizontal beam instead. Smaller intervals require a shallower slant and larger intervals require a 
steeper one.

However, the desired amount of slant is not the only factor that must be considered. The 
innermost beam line should not come too close to the innermost notehead, and the beam itself, 
if possible, should be positioned relative to the staff lines such that it does not form a wedge. A 
wedge is a tiny triangle formed by the horizontal staff line, the vertical stem, and the angled line 
of the slanted beam, which can be visually confusing.

Determination of the amount of slant for a beam is therefore a balancing act that must weigh up 
several factors: the desired amount of slant, valid snapping positions for each end of the beam, 
ensuring a minimum distance between the note closest to the beam and the innermost beam 
line, and avoiding wedges where possible.

● You can set ideal beam slants in various contexts on the Beams page in Engraving Options.

● You can specify the minimum stem length for notes of different durations in the Stems 
section of the Notes page in Engraving Options.

● You can change the beam slants of individual beams.

RELATED LINKS
Engraving Options dialog on page 840
Rests within beams on page 1016
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Changing beam slants
You can change the slants, or angles, of individual beams. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the square handles on the beam corners of the beams whose slants 
you want to change.

TIP

You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

You can also select the beams first, and then select the handles.

2. Move the handles in any of the following ways:

● To move beam handles upwards/downwards a standard amount, press Alt/Opt  plus 
the corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move them 
upwards by 1/4 space per press.

● To move beam handles a large amount, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves beam handles by 1 
space per press.

● To move beam handles a moderate amount, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Up Arrow . This moves beam handles by 1/2 
space per press.

● To move beam handles a small amount, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves beam handles 
by 1/32 space per press.

● Click and drag them upwards/downwards.

3. Optional: Repeat steps 1 and 2 to move the other end of the selected beams.

RESULT
The slants of the selected beams are changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

● You can also use Beam direction in the Beaming group of the Properties panel to change 
the slant of beams. The property is available when you select noteheads within the beam 
group, and its options all ensure that beam ends are positioned correctly relative to staff 
lines.

● You can set ideal beam slants for all beams project-wide on the Beams page in Engraving 
Options.
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RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Centered beams
Centered beams are beams that are vertically positioned between notes within the same beamed 
group, with stems for notes above the beam pointing downwards and stems for notes below the 
beam pointing upwards.

Centered beams are also known as “kneed” or “elbowed” beams due to their often angular 
shape.

When a beamed phrase spans a large pitch range, normal beams are often positioned very close 
to some notes in the phrase but very far from other notes in the phrase, making some stems 
very long. Having a centered beam in a phrase that spans a large pitch range can reduce the 
maximum distance between noteheads and the beam, but can also place the beam within the 
staff, which can obscure staff lines.

By default, Dorico Pro allows beams that include notes on both sides of the middle staff line to 
appear centered. You can also create custom centered beams for beams that include notes only 
on one side of the middle staff line.

A phrase with high and low notes with default 
beaming

The same phrase with high and low notes, but with a 
centered beam

TIP

To center beams between the staves of grand staff instruments, you can create cross-staff 
beams.

RELATED LINKS
Changing the staff-relative placement of beams on page 1004
Creating cross-staff beams/tremolos on page 1009
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Creating centered beams
You can center beams between the notes in the beamed group. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

NOTE

As this action requires changing the direction of some stems in order to appear correctly, it is 
located in the Stem submenu rather than the Beaming submenu.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each of the beams you want to center. You can do this in Write 
mode and Engrave mode.

2. Create a centered beam in one of the following ways:

● If the selected beams include notes on both sides of the middle staff line, choose Edit > 
Notations > Stem > Force Centered Beam.

● If the selected beams include notes only on one side of the middle staff line, choose 
Edit > Notations > Stem > Custom Centered Beam to open the Custom Centered 
Beam dialog.

TIP

You can also choose these options from the context menu.

3. Optional: If you created a custom centered beam, change the stem direction of each note in 
the selected beams as required in the Custom Centered Beam dialog, then click OK.

RESULT
Beams are centered between the notes in the selected beam groups. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

If you select notes in multiple beams, each beam is centered separately. If you want to create a 
single centered beam, you can beam the notes in those beam groups together. You can do this 
both before and after centering the beams.

NOTE

● Dorico Pro automatically angles the beam based on the shape of the phrase, but you can 
change the angles or slants of beams manually.

● You can assign a key command for Force Centered Beam on the Key Commands page in 
Preferences.

RELATED LINKS
Beaming notes together manually on page 1000
Changing beam slants on page 1006
Removing stem direction changes on page 1278
Engrave toolbox on page 514
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Removing centered beams
You can remove centered beams and revert beams to their default placements either above or 
below the phrase.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select at least one note in each centered beam that you want to revert to the default 
placement. You can do this in Write mode and Engrave mode.

2. Choose Edit > Notations > Stem > Remove Centered Beam. You can also choose this 
option from the context menu.

RESULT
The centered beams are removed.

TIP

You can assign a key command for Remove Centered Beam on the Key Commands page in 
Preferences.

Creating cross-staff beams/tremolos
Cross-staff beams and cross-staff tremolos work in a similar way to normal beams and tremolos, 
but allow a phrase that covers a wide pitch range to be shown on multiple staves. You can create 
cross-staff beams/tremolos by inputting all notes in the phrase on one staff and crossing some 
notes to appear on another staff.

PREREQUISITE

● You have input a phrase on one staff.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to cross to another staff. You can do this in Write mode and 
Engrave mode.

NOTE

You can only cross notes to other staves held by the same player.

2. Cross the notes to other staves in any of the following ways:

● To cross notes to the staff above, press N .

● To cross notes to the staff below, press M .

● Choose Edit > Notations > Cross Staff > Cross to Staff Above.

● Choose Edit > Notations > Cross Staff > Cross to Staff Below.

TIP

You can also choose these options from the context menu.
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RESULT
The selected notes are shown on a different staff, with a cross-staff beam shown if the notes are 
part of a beam group. This does not change the staff to which the notes belong.

NOTE

● When crossing notes to a staff that already contains notes, the stem direction of the existing 
notes on the staff can change. This is due to how multiple voices at the same rhythmic 
position are handled. Therefore, you may have to change the stem direction of notes 
manually.

● If you want notes to belong to a different staff, you can move them to another staff.

EXAMPLE

Notes shown on their original staves Cross-staff beams created by crossing some notes to 
the other staff

RELATED LINKS
Resetting notes crossed to other staves on page 1012
Moving notes/items to other staves on page 468
Moving notes/items rhythmically on page 465
Notes crossed to staves with existing notes in other voices on page 1710
Note positions in multiple-voice contexts on page 1707
Inputting notes on page 221
Stem direction on page 1274
Hiding/Showing voice colors on page 1705
Tremolos on page 1659
Engrave toolbox on page 514

Changing to optical cross-staff beam spacing
You can make the stems in cross-staff beams, rather than the noteheads, evenly spaced in each 
layout independently. This can make it easier to perceive the evenness of rhythmic spacing in 
cross-staff beams than when noteheads are evenly spaced.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts that you want to change to optical cross-staff beam 
spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.

4. Activate Use optical spacing for beams between staves.

5. Click Apply, then Close.

RESULT
Optical cross-staff beam spacing is enabled in the selected layouts.

EXAMPLE

Default spacing: The distance between noteheads is 
even.

Optical spacing for cross-staff beaming: The distance 
between stems is even.

RELATED LINKS
Note spacing on page 599

Cross-staff beam placement in multiple staves
When instruments have three or more staves, cross-staff beams can be placed in multiple ways. 
For example, the beam can be placed between the top and the middle staves, and also between 
the middle and bottom staves.

If a beam only crosses two staves, the cross-staff beam goes between those two staves.

A cross-staff beam across the upper two staves on 
an instrument with three staves

A cross-staff beam across the lower two staves on an 
instrument with three staves

If a beam group contains notes on all three staves, the placement of the beam depends on the 
stem directions of the notes in each staff.
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1 If all notes in the beam group are stem-up, the beam is placed above the top staff.

2 If all notes in the beam group are stem-down, the beam is placed below the bottom staff.

3 If notes are stem-down on the top staff and stem-up on the bottom two staves, the beam is 
placed between the top and middle staves.

4 If notes are stem-down on the top two staves and stem-up on the bottom staff, the beam is 
placed between the bottom and middle staves.

NOTE

If you have not specified stem directions, Dorico Pro might place the beam above/below the staff 
into which the notes were originally input, even if the stem directions mean it should be placed 
between other staves.

If you want the beam to be placed between specific staves, you can change the stem directions 
of notes in the beam group.

RELATED LINKS
Changing the stem direction of notes on page 1277

Resetting notes crossed to other staves
You can reset notes that have been crossed to other staves so that they appear on their default 
staff. We recommend resetting cross-staff notes before copying and pasting them to other 
staves to avoid unexpected beaming.

PROCEDURE

1. Select the cross-staff notes you want to reset. You can do this in Write mode and Engrave 
mode.

2. Choose Edit > Notations > Cross Staff > Reset to Original Staff. You can also choose this 
option from the context menu.

RESULT
The selected cross-staff notes are reset and appear on their default staff.

TIP

You can assign a key command for this option on the Key Commands page in Preferences.

Beaming
Creating cross-staff beams/tremolos 

1012
Dorico Pro 4.3.30



Beam corners
Beam corners can occur when a change of stem direction within a beam is combined with a 
break in the secondary beam group. This can be at the end of a subdivision or at a change in 
rhythmic speed.

Beam corners do not follow accepted rules regarding the order and rhythmic meaning of 
secondary beams, and can be confusing for the reader.

Dorico Pro avoids beam corners by analyzing the pitches and stems within a phrase, and 
implementing stem directions that avoid a beam corner.

Secondary beams
Secondary beams are the lines that are added between the primary beam and the notehead as 
the rhythmic division gets smaller.

The primary beam is the outermost beam line that joins all of the notes in the beamed group. 
Depending on the durations of the notes in the beamed group, the primary beam may in fact be 
two or more lines; that is, for notes of a 16th or shorter in duration.

Secondary beams are additional beam lines that join only some of the notes in the group, 
creating subdivisions of the beam in order to make the metrical groupings of the beam clearer.

A phrase of 64th notes, with secondary beams subdivided to show 16th and eighth note groups

You can set per-flow options for splitting secondary beams and their appearance on the Beam 
Grouping page in Notation Options.

RELATED LINKS
Rests within beams on page 1016
Notation Options dialog on page 837
Changing the gaps between beam lines on page 1015

Changing the direction of partial beams
Dorico Pro automatically inputs a partial beam if one is required. You can change on which side 
of stems individual partial beams appear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose partial beam direction you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Partial beam direction in the Beaming group.

3. Choose one of the following options:

● Left

● Right

RESULT
The partial beam appears on the corresponding side of the stem.

EXAMPLE

Partial beam direction Left Partial beam direction Right

Changing the number of beam lines in secondary beams
You can change the number of beam lines shown in secondary beams individually, 
independently of your default setting for the current flow.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes to the right of where you want to change the number of secondary beaming 
lines. You can do this in Write mode and Engrave mode.

2. Optional: If any of the notes you selected do not immediately follow existing splits in the 
secondary beam, split the secondary beams in any of the following ways:

● In the Properties panel, activate Split secondary beam in the Beaming group.

NOTE

The Beaming group is only shown in the Properties panel if your selection only contains 
notes.

● Choose Edit > Notations > Beaming > Split Secondary Beam. You can also choose this 
option from the context menu.

3. In the Properties panel, select the note value that corresponds to the number of beam lines 
you want shown from the Split secondary beam menu.
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RESULT
The number of beam lines shown immediately to the left of each selected note is changed.

NOTE

● Deactivating the property returns the selected notes to showing their default number of 
beam lines.

● The number of beam lines shown at a split in the secondary beam cannot be the same or 
greater than the number of beam lines in the secondary beam. For example, if you split a 
secondary beam containing 64th notes, the maximum number of beam lines shown at the 
split in that beam is three, the equivalent of 32nd notes.

● You can change the default number of secondary beam lines shown in each flow 
independently on the Beam Grouping page in Notation Options.

RELATED LINKS
Engrave toolbox on page 514
Notation Options dialog on page 837
Resetting beam grouping on page 1002

Changing the gaps between beam lines
You can change the gaps that separate beam lines in individual beams, which can be useful in 
certain engraving situations. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select all the noteheads in the beams whose beam line gaps you want to 
change.

NOTE

For the best results, we recommend selecting all notes in each beam.

2. In the Properties panel, activate Separation in the Beaming group.

3. Change the value in the value field.

RESULT
The gaps that separate beam lines in the selected beams are changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Hiding/Showing zones on page 47
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Changing the thickness of beams on page 1003
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Beam slants on page 1005

Tuplets within beams
Tuplets that contain notes that produce beams, such as eighth notes, are beamed together. 
However, special beam grouping rules apply to tuplets within beams that also contain non-tuplet 
notes.

The default setting for a tuplet in a beamed group with secondary beams is to split the secondary 
beam and to show the tuplet with a bracket. The primary beam is not split. If necessary, you can 
hide/show tuplet brackets individually.

The default setting for a tuplet in a beamed group with only a primary beam is to separate the 
tuplet entirely. However, you can change this setting on the Beam Grouping page in Notation 
Options.

16th note triplet beamed together with non-tuplet 
16th notes

Eighth note (quaver) triplet beamed separately from 
non-tuplet eighth notes

RELATED LINKS
Tuplets on page 1669
Tuplet brackets on page 1674
Tuplet numbers/ratios on page 1678

Rests within beams
There are different conventions for how beams interact with rests, including whether beams 
should extend over rests or split at rests.

You can control how Dorico Pro handles rests within beams in the following ways:

● You can change how primary and secondary beams interact with rests in each flow 
independently on the Beam Grouping page in Notation Options, including showing 
stemlets on rests within beams.

● You can change the ideal and minimum distance between rests at the start/end of beam 
groups and their closest beam line in Engraving Options > Notes > Stems.

RELATED LINKS
Note and rest grouping on page 1021
Beam slants on page 1005
Notation Options dialog on page 837
Engraving Options dialog on page 840
Changing the direction of partial beams on page 1013
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Stemlets
Stemlets are short stems that extend from beams to rests within beam groups. They can help 
make music easier to read, as they help to maintain a regular pattern of stems within beams.

In the examples, beaming all notes and rests together to show the boundaries of quarter note 
(crotchet) beats makes the syncopation of the notes easier to read. The stemlets on the rests 
help make clear where within the quarter note beats each note occurs.

A syncopated phrase without stemlets The same phrase with stemlets

You can change the default appearance of stemlets in each flow, and you can show stemlets in 
individual beams.

TIP

You can change the default minimum stemlet length and gap between rests and stemlets in the 
Stems section of the Notes page in Engraving Options.

Showing stemlets in beam groups
You can show stemlets on rests in beam groups individually, independently of your default 
setting for showing stemlets in the current flow.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to beam together with stemlets shown on rests. You can do this in 
Write mode and Engrave mode.

For example, to show a stemlet on a rest between two notes, select both notes. To show a 
stemlet on a rest at the end of a beamed phrase, select all notes in the beam and the rest.

2. Choose Edit > Notations > Beaming > Stemlets > Force Stemlet Beam. You can also 
choose this option from the context menu.

RESULT
The selected notes are beamed together with stemlets shown on rests within the beam group. 
Rests within the beam group are automatically turned into explicit rests.

NOTE

● If you later reset the beaming of the selected group, stemlets revert to your default setting 
for the flow.

● You can choose to show stemlets on rests in all beamed groups in each flow independently 
on the Beam Grouping page in Notation Options.
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EXAMPLE

Beam without stemlets Stemlet with notes either side 
selected

Stemlets shown with all notes and 
rests in beam group selected

RELATED LINKS
Engrave toolbox on page 514
Notation Options dialog on page 837
Implicit vs. explicit rests on page 1488
Resetting beam grouping on page 1002

Removing stemlets from beam groups
You can remove stemlets from rests in beam groups individually, independently of your default 
setting for showing stemlets in the current flow.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select at least one note in each of the beam groups from which you want to remove stemlets 
on rests. You can do this in Write mode and Engrave mode.

2. Choose Edit > Notations > Beaming > Stemlets > Suppress Stemlet Beam. You can also 
choose this option from the context menu.

RESULT
Stemlets are removed from all rests in the selected beams. Explicit rests within the beamed 
group remain explicit.

NOTE

● Removing stemlets from beams does not reset the selected beams to your default beam 
grouping for the flow.

● You can choose not to show stemlets on rests in all beam groups in each flow on the Beam 
Grouping page in Notation Options.

EXAMPLE

Beam group showing stemlets Beam group with suppressed stemlets

Beaming
Stemlets 
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Fanned beams
Fanned beams show either an accelerando or rallentando by having multiple beam lines either 
converging on, or diverging from, a single beam line at the other end. Fanned beams are also 
known as “feathered beams”.

A single fanned beam can have multiple changes of direction within it.

The grouping can use either two or three beams, with three beams indicating a greater change 
of speed than two beams. The slowest part of the phrase is where the beams converge, and the 
fastest is where the beams are the most spread out.

EXAMPLE

Fanned beam accelerando with three lines

Fanned beam accelerando with two lines

Fanned beam rallentando with three lines

Fanned beam rallentando with two lines

Creating fanned beams
You can create fanned beams across a group of any notes that can be beamed, such as eighth 
notes (quavers), 16th notes (semiquavers), and 32nd notes.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to include in a fanned beam. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Beaming > Create Fanned Beam > [Direction and number of 
lines].

For example, choose Edit > Notations > Beaming > Create Fanned Beam > Accelerando 
(Three Lines) for an accelerando fanned beam with three lines.

TIP

You can also choose these options from the context menu.

RESULT
The selected notes are joined with a fanned beam with a single slope, whatever their original 
duration.

Beaming
Fanned beams 
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RELATED LINKS
Engrave toolbox on page 514
Custom lines on page 884

Changing the direction within fanned beams
You can change the direction of fanned beams within phrases to indicate tempo changes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the notehead at each rhythmic position where you want to change 
the direction of the fanned beam slope. You can select multiple positions within phrases.

2. In the Properties panel, activate Change fanned beam direction in the Beaming group.

EXAMPLE

Fanned beam with multiple changes of direction

Beaming
Fanned beams 
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Note and rest grouping

There are generally accepted conventions for how notes and rests of different durations are 
notated and grouped in different contexts and meters. In Dorico Pro, notes are automatically 
notated to fit within bars and are grouped according to your per-flow settings.

Depending on the prevailing time signature, there can be many different ways to beam notes 
together. For example, you might want to beam all notes in the bar together in time signatures 
that cannot be divided in half and are often not divided at all, such as 3/4.

A passage containing different meters. Notes are grouped and beamed differently in the different meters, 
and notes that cross beats and barlines are automatically shown as tied notes.

Tied notes are affected by your note and rest grouping settings, as there are different 
conventions for how notes within tie chains should be divided to indicate significant beat 
boundaries within bars, and in which contexts they can cross beat boundaries.

Similar options apply to dotted notes, which are often notated as a single dotted note if they 
start at the beginning of bars, but as a tie chain that shows significant beat boundaries in the bar 
if they start part-way through bars.

TIP

● You can change the default note grouping and beam grouping settings for each flow 
independently on the Note Grouping and Beam Grouping pages in Notation Options.

Musical examples demonstrate how each option affects the appearance of your music.

● You can also specify custom beat groupings within individual time signatures.

RELATED LINKS
Beaming on page 998
Beam grouping according to meters on page 999
Note grouping in slash regions on page 1475
Notation Options dialog on page 837
Rhythm dot consolidation on page 1258
Forcing the duration of notes/rests on page 262
Types of time signatures on page 1641
Numbered bar regions on page 1467
Allowing/Disallowing noteheads in opposing voices to overlap on page 1706

Creating custom beat groupings for meters
If your music requires a different beat grouping for a particular meter than the default setting 
for that time signature, you can specify your preferred beat grouping within the time signature. 
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You can choose whether or not the time signature shows this custom beat grouping. You can 
also input time signatures only on single staves.

NOTE

The duration of beam groups in Dorico Pro depends on the beat grouping in the prevailing time 
signature and your per-flow beam grouping settings in Notation Options. For example, entering 
[1+1+1+1]/4 into the time signatures popover inputs a time signature with four quarter note 
(crotchet) groups. Because this creates a time signature with a half-bar, beam grouping options 
for time signatures with a half-bar apply.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature with 
custom beat grouping. If you want to input a time signature with custom beat grouping 
on a single staff, select an item that belongs to that staff only.

2. Optional: If you want to input a time signature with custom beat grouping onto multiple 
specific staves at once, extend the caret to those staves.

3. Optional: If you want Dorico Pro to add beats at the end of the region affected by the new 
time signature if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the division you want in square brackets into the popover.

For example, to divide a 7/8 time signature into 2+3+2, enter [2+3+2]/8 into the popover. To 
divide a 5/4 time signature into 2+3 rather than 3+2, enter [2+3]/4 into the popover.

6. Input the time signature and close the popover in one of the following ways:

● To input a time signature on all staves, press Return .

● To input a time signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
The time signature specified is input and beam and beat grouping in subsequent bars follows 
the division you specified. The time signature appears either as a single number, such as 7/8, or 
showing the beat groups, such as 2+3+2/8, depending on your setting on the Time Signatures 
page in Engraving Options.

TIP

You can change the appearance of numerators in individual time signatures so that they show a 
single number or beat groups, independently of your project-wide settings.

RELATED LINKS
Time signatures popover on page 285
Time signature styles on page 1647

Note and rest grouping
Creating custom beat groupings for meters 
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Brackets and braces

Brackets and braces are thick straight and curved lines in the left-hand margin that show 
instrument groupings.

Brackets

A bracket is a thick black line, the width of a beam, that groups staves together, most commonly 
according to instrument family. It often has winged ends that point inwards towards the score.

It is always positioned directly to the left of a systemic barline. If secondary brackets are used 
in addition to a bracket, they are positioned further away from the start of the system to allow 
space for the bracket.

An example of a bracket, connecting instruments in the string family. A sub-bracket connects the two violin 
lines.

By default in Dorico Pro, barlines join the same staves that are joined by brackets and braces, 
meaning that bracketed groups of staves and braced pairs of staves appear with barlines 
extending across the group.

Braces

A brace is a wavy or curly line that joins multiple staves belonging to the same instrument, 
usually a grand staff instrument such as the piano or harp. If necessary, a brace can extend to 
three or more staves, although two is most common.

The brace is also sometimes used instead of a sub-bracket to show groupings of identical 
instruments within a family whose staves are joined by a bracket.

It is positioned outside the systemic barline, and if used in place of a sub-bracket, outside of the 
bracket as well.
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A brace connecting two piano staves

NOTE

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves are 
excluded from bracketed groups. They also cannot show sub-brackets or sub-sub-brackets.

● System objects are only shown above instrument families that are bracketed or braced 
together.

● Blank staves can only show brackets/braces when they are shown after final flows. You 
cannot show brackets/braces on blank staves in music frames.

RELATED LINKS
Barlines across staff groups on page 976
Player groups on page 162
Adding player groups on page 163
Brackets according to ensemble type on page 1026
Changing the default barline joins on page 977
Custom staff grouping on page 1030
System objects on page 1563
Staff labels on page 1531
Player group labels on page 1542

Project-wide engraving options for brackets and braces
You can find options for the project-wide appearance of brackets and braces on the Brackets 
and Braces page in Engraving Options.

The options on the Brackets and Braces page allow you to change the design of brackets, 
such as by hiding or showing wings on bracket ends, and the gaps between brackets, braces, 
sub-brackets, and sub-sub-brackets and other items, such as systemic barlines. You can also 
set span thresholds for when you want Dorico Pro to use the different available brace designs, 
including preventing Dorico Pro ever showing flat braces.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840
Changing bracket grouping according to ensemble type on page 1025

Brackets and braces
Project-wide engraving options for brackets and braces 
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Changing bracket grouping according to ensemble type
You can change which staves are included in brackets by changing the ensemble type for each 
layout independently; for example, if a part layout containing all percussion players requires 
different bracketing than used for percussion staves in the full score layout.

The default setting is Orchestral. We recommend that you change this setting for projects 
containing small ensembles.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the ensemble type for 
bracket grouping.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. Choose one of the following options for Ensemble type:

● No brackets

● Orchestral

● Small ensemble

● Wind band

● Big band

● British brass band

5. Click Apply, then Close.

RESULT
The default bracket grouping is changed in the selected layouts.

TIP

● There are further options for bracketing on the Brackets and Braces page, such as hiding/
showing brackets when there is only a single instrument in the bracket group and hiding/
showing braces when only a single staff is shown.

● Player groups and soloists also influence which staves are bracketed together.

● You can also input custom bracket/brace grouping for specific staves, independently of the 
bracket grouping setting in the layout. However, you cannot show or change brackets/braces 
on blank staves.

RELATED LINKS
Barlines across staff groups on page 976
Custom staff grouping on page 1030
Hiding/Showing blank staves after final flows on page 699
Showing blank staves in frames on page 700
Player groups on page 162
Designating players as soloists on page 128
Staff labels on page 1531
Player group labels on page 1542

Brackets and braces
Changing bracket grouping according to ensemble type 
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Brackets according to ensemble type
In Dorico Pro, default staff grouping is determined by the ensemble type chosen for each layout. 
This affects which staves are bracketed together and joined by barlines.

The following ensemble types are available on the Brackets and Braces page in Layout 
Options:

No brackets
All staves appear separately, with no brackets. Grand staff instruments are still shown 
with braces.

This is the default setting for full score layouts in projects started from Solo and small 
Jazz project templates.

Orchestral
Staves are bracketed according to their instrument family. For example, adjacent string 
instruments are bracketed together separately from adjacent woodwind instruments. 
However, vocal staves are not joined by barlines.

This is the default setting for all layouts in new projects and projects started from 
Orchestral, Choral and Vocal, and Concert band project templates, and for custom 
score and part layouts in projects started from all other project templates.

Small ensemble
All staves in the project are bracketed together, regardless of their instrument family, 
excluding braced staves.

This is the default setting for full score layouts in projects started from Chamber and 
Pit band project templates.

Wind band
Staves are bracketed according to their instrument type. For example, Flute 1 and Flute 
2 are bracketed together, but separately from the other woodwind instruments.

Big band
Staves are bracketed according to their instrument family, except for brass 
instruments, which are all bracketed according to their instrument type.

Rhythm section instruments are bracketed together.

Percussion and timpani are bracketed together.

British brass band
Brass instruments are bracketed according to their instrument type, except for horns 
and trumpets, which are bracketed together.

Any other instruments in the score are bracketed according to their instrument family.

Percussion and timpani are bracketed separately.

This is the default setting for full score layouts in projects started from the Big band 
project template.

NOTE

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves, such as 
the piano and other grand staff instruments, are excluded from brackets. They also split 
brackets if they are placed within a bracketed group.

● By default, there must be at least two adjacent instruments to show a bracket. You 
can choose to show brackets on single instruments in each layout independently on the 
Brackets and Braces page in Layout Options.

● Player groups and soloists also influence which staves are bracketed together.

Brackets and braces
Changing bracket grouping according to ensemble type 
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● Vocal staves are never joined by barlines, even when bracketed together.

● System objects are only shown above instrument families that are bracketed or braced 
together.

RELATED LINKS
Layout Options dialog on page 834
Project templates on page 80
System objects on page 1563
Custom staff grouping on page 1030

Changing the appearance of bracket ends
You can change the appearance of all bracket ends project-wide. For example, if you want 
brackets to have nothing at their ends instead of wings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Brackets and Braces.

3. In the Design section, choose one of the following options for Bracket end design:

● Wings (default)

● Horizontal line

● None

RELATED LINKS
Hiding/Showing wings on repeat barlines on page 974

Secondary brackets
Secondary brackets are a second level of staff grouping. They are positioned to the left of 
brackets and allow you to mark groups of staves within a bracketed group. In Dorico Pro, 
secondary brackets can appear as a brace or as a sub-bracket.

By default, secondary brackets appear as sub-brackets: thin lines with square corners that extend 
beyond the bracket. You can change the appearance of secondary brackets and hide/show them 
for adjacent identical instruments in bracketed groups in each layout independently.

Brackets and braces
Changing the appearance of bracket ends 
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Secondary bracket as a sub-bracket Secondary bracket as a brace

NOTE

You cannot show sub-sub-brackets in addition to braces, you can only show sub-sub-brackets in 
addition to sub-brackets.

You can input and delete sub-brackets from selected rhythmic positions using custom bracket/
brace groups.

You can change various aspects of the appearance and position of secondary brackets, such 
as whether sub-brackets reach to the systemic barline or just to the bracket, in Engraving 
Options > Brackets and Braces > Design > Sub-brackets.

RELATED LINKS
Engraving Options dialog on page 840
Custom staff grouping on page 1030

Hiding/Showing secondary brackets
You can hide/show secondary brackets for adjacent identical instruments in bracketed groups 
in each layout independently. You can also choose only to show secondary brackets when sub-
bracketed groups contain at least two staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show secondary brackets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. Choose one of the following options for Instruments of the same kind within a bracketed 
group:

● Use secondary brackets

● No secondary brackets

5. Choose one of the following options for When only one staff of sub-bracketed group is 
shown:

● Draw sub-bracket

Brackets and braces
Secondary brackets 
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● Do not draw sub-bracket

6. Click Apply, then Close.

RESULT
Secondary brackets are shown in the selected layouts when you choose Use secondary 
brackets, and hidden when you choose No secondary brackets.

If you chose Use secondary brackets and Do not draw sub-bracket, secondary brackets are 
only shown when sub-bracketed groups contain at least two staves.

TIP

You can show sub-brackets from selected rhythmic positions onwards using custom bracket/
brace groups, including in layouts where they are hidden by default.

Showing secondary brackets as sub-brackets/braces
Secondary brackets extend beyond brackets, allowing you to mark groups of staves within a 
bracketed group. You can show secondary brackets as either braces positioned outside the 
bracket or as sub-brackets in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the appearance of 
secondary brackets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. Choose one of the following options for Secondary bracket appearance:

● Brace

● Sub-bracket

5. Click Apply, then Close.

RESULT
The appearance of all secondary brackets in the selected layouts is changed. This includes 
secondary brackets in custom bracket/brace groups.

NOTE

Because you cannot show sub-sub-brackets in addition to braces, sub-sub-brackets are not 
shown in layouts where sub-brackets appear as braces.

Sub-sub-brackets
Sub-sub-brackets are a tertiary level of staff grouping with the same design as sub-brackets. They 
are positioned outside of both brackets and sub-brackets, allowing you to mark groups of staves 

Brackets and braces
Sub-sub-brackets 
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within bracketed and sub-bracketed groups. Sub-sub-brackets can only appear as brackets in 
Dorico Pro.

Sub-sub-brackets cannot extend beyond their sub-bracket and cannot be shown on staves with a 
brace as either the primary or secondary group.

You can input and delete sub-sub-brackets from selected rhythmic positions using custom 
bracket/brace groups.

You can change how thick the lines of sub-sub-brackets are, their width, and their design in 
Engraving Options > Brackets and Braces > Design > Sub-sub-brackets.

Custom staff grouping
In Dorico Pro, custom staff grouping allows you to change which staves are joined with brackets, 
braces, sub-brackets, sub-sub-brackets, and barlines if your project requires staff grouping not 
included in the default bracketing settings.

Any changes to the default staff grouping are shown as bracket and barline change signposts, 
which also show the rhythmic position from which the changes apply. They only affect the staff 
grouping in the current layout.

If bracket and barline change signposts are positioned at the start of a system, the 
corresponding staff grouping changes apply from that system onwards. If the signpost is 
positioned partway through a system, the change takes effect from the following system.

Brackets and braces
Custom staff grouping 

1030
Dorico Pro 4.3.30



A bracket and barline change signpost indicating sub-sub-brackets have been added to separate the divisi 
cello parts and barlines only join staves of the same instrument type rather than all strings.

NOTE

● For best results, we recommend that you only input bracket/brace grouping or barline join 
changes after adding extra staves, ossia staves, or additional instruments, and with all staves 
shown in the layout. You can hide empty staves again after inputting the changes.

We also recommend that you input bracket/brace grouping or barline join changes at the 
beginning of the flow, and add any subsequent changes in chronological order. We do not 
recommend starting at the end of the flow.

● You cannot change brackets/braces on blank staves shown after final flows, or show 
brackets/braces on blank staves in music frames.

● Player groups and soloists also influence which staves are bracketed together.

RELATED LINKS
Signposts on page 453
Changing bracket grouping according to ensemble type on page 1025
Inputting custom barline joins on page 978
Barlines across staff groups on page 976
Hiding/Showing empty staves on page 696
Hiding/Showing blank staves after final flows on page 699
Showing blank staves in frames on page 700
Player group labels on page 1542
Player groups on page 162
Designating players as soloists on page 128

Brackets and braces
Custom staff grouping 
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Inputting custom bracket/brace groups
You can input custom bracket/brace grouping changes at any position that change which staves 
are grouped with brackets, sub-brackets, sub-sub-brackets, and braces.

NOTE

You cannot change brackets/braces on blank staves shown after final flows or show brackets/
braces on blank staves in music frames.

PREREQUISITE

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item on the top staff you want to group with a bracket/brace, at 
the start of the system from which you want this change to apply.

2. Ctrl/Cmd -click an item on the bottom staff you want to group with a bracket/brace.

3. In the Formatting panel, click one of the following in the Bracketing group:

● Insert bracket

● Insert sub-bracket

● Insert sub-sub-bracket

● Insert brace

RESULT
All staves in the current layout between and including the staves on which you selected items are 
joined by the bracket or brace you chose until the next existing bracket and barline change or the 
end of the flow, whichever comes first. A signpost appears at the start of the system in which you 
selected items.

Brackets and braces
Custom staff grouping 
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If necessary, any existing bracket or brace groupings are adjusted to accommodate the new 
group as brackets/braces cannot overlap.

NOTE

● You cannot move bracket and barline change signposts, as they are intended to apply to 
system start positions. However, they can appear partway through systems if, for example, 
you move system breaks. When a bracket and barline change signpost is positioned partway 
through a system, the corresponding change only takes effect from the start of the next 
system.

● Sub-brackets can appear as braces, depending on your per-layout setting for the appearance 
of secondary brackets. Because you cannot show sub-sub-brackets in addition to braces, 
sub-sub-brackets are not shown in layouts where sub-brackets appear as braces.

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves are 
excluded from bracketed groups.

EXAMPLE

Divisi cello staves with default staff grouping Divisi staves with sub-sub-brackets added

RELATED LINKS
Engrave toolbox on page 514
Formatting panel on page 516
Hiding/Showing zones on page 47
Showing secondary brackets as sub-brackets/braces on page 1029
Hiding/Showing blank staves after final flows on page 699
Showing blank staves in frames on page 700

Lengthening/Shortening custom brackets/braces
You can lengthen/shorten custom brackets/braces vertically to change the staves across which 
they span; for example, if you added a new player below a bracket group and want to extend the 
bracket to that staff.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

Brackets and braces
Custom staff grouping 
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PROCEDURE

1. In Engrave mode, select a handle at either the top or bottom of each bracket/brace you want 
to lengthen/shorten.

TIP

You only need to select a handle on one bracket/brace for each bracket and barline change, 
as they apply from their signpost until the next existing change or the end of the flow, 
whichever comes first.

2. Move the handles in any of the following ways:

● To move them to the staff above, press Alt/Opt-Up Arrow .

● To move them to the staff below, press Alt/Opt-Down Arrow .

● Click and drag them upwards/downwards to staves above/below.

RESULT
The selected brackets/braces are lengthened/shortened to staves above/below. This affects the 
staves included in the brackets/braces on all systems to which the corresponding bracket and 
barline changes apply.

NOTE

Only one bracket/brace can exist on each staff, they cannot overlap. If any part of a selected 
bracket/brace collides with another bracket/brace when it is lengthened/shortened, the other 
bracket/brace is shortened to accommodate this.

You can undo this action, but the previous length of any shortened brackets/braces is only 
restored if you lengthened/shortened brackets/braces using the keyboard.

Resetting bracket and barline changes
You can reset custom changes to bracket/brace grouping and barline joins after a passage with 
custom grouping/joins to revert subsequent systems to the project-wide staff grouping settings.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item at the rhythmic position where you want to reset staff 
grouping.

2. Choose Engrave > Reset Bracketing.

RESULT
Staff grouping, including both bracket/brace grouping and barline join changes, is reset to the 
project-wide staff grouping sections from the selected rhythmic position until the next existing 
bracket and barline change or the end of the flow, whichever comes first. A signpost appears at 
the rhythmic position of the selected item.

If you selected an item partway through a system, staff grouping is not reset until the start of the 
next system.

Brackets and braces
Custom staff grouping 
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TIP

You can also reset changes to bracket/brace grouping and barline joins independently of each 
other by using the Change bracketing and Change barlines properties in the Bracket and 
Barline Changes group of the Properties panel. When they are set to Auto, the corresponding 
part of the selected changes is reset.

Deleting bracket and barline changes
You can delete custom changes to bracket/brace grouping and barline joins; for example, if you 
change your mind about where you want to reset the bracket/brace grouping.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the bracket and barline change signposts that you want to delete. You can do this in 
Write mode and Engrave mode.

2. Press Backspace or Delete .

RESULT
The selected bracket and barline changes are deleted. Staff grouping on any corresponding 
systems follows either the previous bracket and barline change or the project-wide staff 
grouping settings if there is no previous bracket and barline change.

TIP

● In Engrave mode, you can also select the brackets/braces you want to delete.

● You can also delete individual barline joins independently of other barline joins and bracket/
brace grouping changes at the same rhythmic position.

RELATED LINKS
Brackets according to ensemble type on page 1026
Deleting barline joins on page 979
Engrave toolbox on page 514

Brackets and braces
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Chord symbols

Chord symbols describe the vertical harmony of the music at a specific moment. They 
are frequently used in jazz and pop music, where players often improvise around chord 
progressions.

Chord symbols shown above slashes on the Clarinet and Piano staves to help the players improvise around 
the notated Cornet melody.

You can input chord symbols using the chord symbols popover and you can automatically 
generate chord symbols based on existing music.

In Dorico Pro, chord symbols exist globally at the corresponding rhythmic positions by default. 
This means that you only have to input chord symbols once, but they can appear above multiple 
or no staves as required. However, in some circumstances it is necessary to show different chord 
symbols for different players at the same rhythmic position. In such cases, you can input local 
chord symbols.

Dorico Pro automatically shows the appropriate chord symbols for transposing instruments in 
transposing layouts, including for fretted instruments whose transposition you have changed to 
reflect a capo. You can also define capos for chord symbols and show only main chord symbols, 
only capo chord symbols, or both.

You can hide/show chord symbols project-wide above specific instrument staves, including if 
multiple instruments belong to the same player, and in different layouts. You can also show 
chord symbols only within chord symbol/slash regions and hide/show individual chord symbols.

If you have input chord symbols but no players in the current layout are set to show them, they 
are indicated by signposts.

Depending on the style of music, there are different conventions regarding how to present chord 
names.

Dorico Pro provides a comprehensive set of chord symbol appearance presets that you can 
choose from, including customizing the appearance of each component independently. In 
addition to these, you can customize the appearance of different chord symbols, such as Gmaj7, 
both for all instances of that chord symbol project-wide and for single instances.

RELATED LINKS
Inputting chord symbols on page 318
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Chord symbol appearance presets on page 1038
Custom chord symbols on page 856
Chord symbol font styles on page 1039
Hiding/Showing chord symbols on page 1040
Chord diagrams on page 1056
Capos on page 146
Capo vs. main chords on page 146
Hiding/Showing signposts on page 454
Chords track on page 627
Enabling chord symbol playback on page 628

Chord components
Chord symbols consist of a root and a quality, with intervals, alterations, and an altered bass note 
included if required.

Root
The root note of the chord, expressed either as a note name or as a specific degree of a 
scale.

Quality
Defines the type of chord, such as major, minor, diminished, augmented, half-
diminished, or with added note, such as six or nine.

Interval
Chord symbols can include one or more added intervals, such as a major seventh or 
ninth. Intervals in chord symbols are also known as “extensions”.

Alterations
Define notes in chords that are different to what is normally expected of that chord. 
For example, a sharpened fifth, flattened ninth, suspensions, or omissions.

Altered bass note
A chord symbol has an altered bass note if the lowest pitch of a chord is not its root 
note, such as Cm7♭5/E♭.

Project-wide engraving options for chord symbols
You can find options for the project-wide appearance and position of chord symbols on the 
Chord Symbols page in Engraving Options.

The options on the Chord Symbols page allow you to change the appearance of different 
types of chords and chord components, including the order and arrangement of accidentals 
and alterations, and their default positions.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Inputting chord symbols on page 318
Chord symbols popover on page 320
Hiding/Showing chord symbols on page 1040
Custom chord symbols on page 856
Chord symbol font styles on page 1039
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Chord symbol appearance presets
There are many conventions for the appearance of chord symbols, so Dorico Pro provides a 
choice of preset conventions that you can use and edit.

For example, you can edit default preset chord symbols, you can edit individual chord symbols 
without changing the default appearance for that chord symbol, and you can edit individual 
components within chord symbols.

● You can access chord symbol presets at the top of the Chord Symbols page in Engraving 
Options.

Chord symbol preset example Chord symbol preset name

Default

Boston

Brandt-Roemer

Indiana

New York

Nashville

Jazz Standards

Ross

Japanese

These presets use specific combinations of the options on the Chord Symbols page. You can also 
adjust these options individually to suit your requirements.
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● Default uses a set of symbols intended to be as unambiguous as possible. For example, 
Default avoids the use of symbols for major seventh, augmented, diminished, and half-
diminished. This is the default preset for new projects.

● Custom is automatically selected when you change any of the preset options.

RELATED LINKS
Custom chord symbols on page 856

Chord symbol font styles
There are different font styles for different chord symbol components. You can change different 
aspects of these fonts in the Edit Font Styles dialog, such as changing their font size to make 
accidentals in chord symbols appear larger.

1 Chord Symbols Font: Used for note names in chord symbols, such as “B” or “F”.

2 Chord Symbols Music Text Font: Used for accidentals in chord symbols, such as ♭ and ♯. 
Must be SMuFL-compliant.

3 Chord Symbols Altered Bass Separator Font: Used for text altered bass separators.

TIP

You can change whether altered bass separators appear as slashes, lines, or text in the 
Altered Bass Notes section of the Chord Symbols page in Engraving Options.

RELATED LINKS
Edit Font Styles dialog on page 846
Changing the default font family on page 853

Positions of chord symbols
In layouts where chord symbols are shown, they are positioned either above all instrument 
staves set to show chord symbols or only above the top staff in each system.

By default, chord symbols are left-aligned with noteheads.

Alignment of chord symbols across the system

Chord symbols are aligned at the same vertical position across the width of the system by 
default. You can disable the automatic alignment of chord symbols within systems in Engraving 
Options > Chord Symbols > Position.

RELATED LINKS
Hiding/Showing capo chord symbols on page 151
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Chord symbol regions on page 1044
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Hiding/Showing chord symbols
You can hide/show chord symbols above particular staves or only within chord symbol/slash 
regions project-wide on a per-player basis. By default, chord symbols appear above rhythm 
section instrument staves, such as keyboards, guitars, and bass guitars.

Any player on whose staff you input chord symbols is automatically set to show chord symbols 
for all instruments and in the current layout type.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to hide/show chord 
symbols.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord symbols above all instrument staves held by the player, choose Chord 
Symbols > Show for All Instruments.

● To show chord symbols only above rhythm section instrument staves held by the player, 
choose Chord Symbols > Show for Rhythm Section Instruments.

● To show chord symbols only in chord symbol/slash regions on instrument staves held by 
the player, choose Chord Symbols > Show in Chord Symbol and Slash Regions.

● To hide chord symbols above all instrument staves held by the player, choose Chord 
Symbols > Hide for All Instruments.

RESULT
Chord symbols are hidden/shown above the corresponding instrument staves held by the 
selected player, depending on the layouts in which chord symbols are shown for that player 
in your project.

TIP

● You can also right-click players and choose these options from the context menu.

● You can choose to show chord symbols only once at the top of each system in each layout 
independently.

● You can also hide/show individual chord symbols in layouts where chord symbols are shown 
by selecting them and activating Hidden in the Chord Symbols group of the Properties 
panel. Signposts are shown at the position of each hidden chord symbol. However, signposts 
are not printed by default.

You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Players panel on page 111
Layouts on page 169
Inputting chord symbols on page 318
Chord symbol regions on page 1044
Inputting chord symbol regions on page 326
Inputting slash regions on page 418
Signposts on page 453
Hiding/Showing chord diagrams on page 1058
Showing only chord symbols or chord diagrams on page 1059
Showing chord symbols above one/multiple staves on page 1041
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Changing the staff-relative placement of chord symbols on page 1043
Capo vs. main chords on page 146
Hiding/Showing capo chord symbols on page 151
Key Commands page in the Preferences dialog on page 63
Layout Options dialog on page 834
Chord symbol appearance presets on page 1038

Hiding/Showing chord symbols in layouts
You can hide/show chord symbols in different types of layouts. By default, chord symbols appear 
in all applicable layouts for rhythm section instruments.

NOTE

If chord symbols are hidden for all instruments in the current layout, signposts are shown above 
the top staff.

PROCEDURE

1. In Setup mode, select a player in the Players panel.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord symbols for the selected player in all layouts, choose Chord Symbols > 
Show in Full Score and Parts.

● To show chord symbols for the selected player only in full score/custom score layouts 
and not in part layouts, choose Chord Symbols > Show in Full Score Only.

● To show chord symbols for the selected player only in part layouts and not in full score/
custom score layouts, choose Chord Symbols > Show in Parts Only

TIP

You can also right-click players and choose these options from the context menu.

Showing chord symbols above one/multiple staves
You can choose to show chord symbols above all instrument staves set to show chord symbols or 
only above the top staff in each system in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
chord symbols.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Symbols section, choose one of the following options for Show chord 
symbols:

● Above specific players’ staves

● Above top staff of system
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Positions of chord symbols 

1041
Dorico Pro 4.3.30



5. Click Apply, then Close.

RESULT
The vertical position of chord symbols is changed in the selected layouts.

RELATED LINKS
Inputting chord symbols on page 318
Showing only chord symbols or chord diagrams on page 1059
Capo vs. main chords on page 146
Hiding/Showing capo chord symbols on page 151

Changing the alignment of chord symbols relative to notes
You can change the horizontal alignment of individual chord symbols relative to notes, 
independently of your project-wide setting. For example, you might center-align wide chord 
symbols to avoid collisions with barlines. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose alignment you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Alignment in the Chord Symbols group.

3. Select one of the following alignment options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the selected chord symbols is changed. Note spacing is automatically adjusted 
to avoid collisions with adjacent chord symbols.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can change the default horizontal alignment of all chord symbols project-wide in Engraving 
Options > Chord Symbols > Position.

Chord symbols
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EXAMPLE

Left-aligned G#dim7 chord symbol 
on beat 3

Center-aligned G#dim7 chord 
symbol on beat 3

Right-aligned G#dim7 chord 
symbol on beat 3

Changing the staff-relative placement of chord symbols
You can show individual chord symbols either above or below the staff, independently of your 
project-wide setting. You can do this for the current layout and frame chain only, or for all layouts 
and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose staff-relative placement you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Placement in the Chord Symbols group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of the selected chord symbols is changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

TIP

● You can choose to show chord symbols between the staves of grand staff instruments in 
each layout independently in Layout Options > Chord Symbols and Diagrams > Chord 
Symbols.

● You can change the default placement of all chord symbols project-wide in Engraving 
Options > Chord Symbols > Position.

RELATED LINKS
Engraving Options dialog on page 840
Layout Options dialog on page 834
Erasing the background of chord symbols on page 1049
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Chord symbol regions
Chord symbol regions specify passages where you want to show chord symbols. They are 
particularly useful for players and layouts that do not need chord symbols for most of the project 
but have improvisation sections that require chord symbols to be shown.

Chord symbol regions allow you to show chord symbols only where players require them, instead 
of showing chord symbols throughout the project and manually hiding the ones you do not want 
to show.

When you input chord symbol regions in Dorico Pro, the corresponding players are automatically 
set to show chord symbols in chord symbol/slash regions. This is because it is common to use 
both slashes and chord symbols to aid players in improvisation sections. Any chord symbols 
outside chord symbol/slash regions are automatically hidden and are indicated by signposts.

By default, chord symbol regions are highlighted with a solid colored line above the top staff line 
and a colored background. As you zoom out, the colored backgrounds become more opaque, 
which is especially useful when viewing full score layouts in galley view. These highlights are 
considered annotations, are not printed by default, and you can hide/show them.

Chord symbol region followed by chord symbol signposts after the end of the chord symbol region

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

Handles on a selected chord symbol region

RELATED LINKS
Inputting chord symbol regions on page 326
Slash regions on page 1474
Hiding/Showing chord symbols on page 1040
Hiding/Showing signposts on page 454
Annotations on page 687

Hiding/Showing chord symbol region highlights
You can hide/show colored highlights for chord symbol regions at any time; for example, if you 
want to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight Chord Symbol Regions.
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Transposing chord symbols
You can transpose chord symbols after you have input them, independently of any notes.

TIP

● Dorico Pro automatically shows the appropriate chord symbols for transposing instruments 
in transposing layouts.

● If you want to transpose chord symbols to reflect a capo, you can instead show capo chord 
symbols.

PROCEDURE

1. In Write mode, select the chord symbols you want to transpose.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.

TIP

● We recommend using the Calculate interval section to determine your required 
settings; for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Click OK to save your changes and close the dialog.

RESULT
The selected chord symbols are transposed.

RELATED LINKS
Transpose dialog on page 481
Concert vs. transposed pitch on page 174
Making layouts transposing/concert pitch on page 173
Capos on page 146

Respelling chord symbols
You can change the enharmonic spelling of chord symbols for transposing instruments; for 
example, to choose a simpler enharmonic equivalent spelling. This changes the enharmonic 
spelling of chord symbols in all transposing layouts and for all instruments with the same 
transposition.

PROCEDURE

1. In Write mode, open a layout with the transposition for which you want to respell chord 
symbols.

For example, to respell a chord symbol for all instruments in B♭, open the part layout for an 
instrument in B♭.

2. Select the chord symbol you want to respell.

3. Press Return  to open the chord symbols popover for the selected chord symbol.

The existing entry for the chord symbol is shown inside the popover.
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4. Change the root name of the chord, but leave other details as they were, such as quality, 
interval, or alterations.

For example, change just the root of D♭maj13 from Db to C#.

5. Press Return  to close the popover.

RESULT
The spelling of the chord symbol is changed in transposing layouts for all instruments with the 
same transposition. For example, changing the spelling of a chord symbol for a Clarinet in B♭ also 
changes the spelling of that chord symbol in the part layout for a Trumpet in B♭.

RELATED LINKS
Chord symbols popover on page 320
Respelling notes on page 484
Fretted instrument tuning on page 142
Defining capos for chord symbols/diagrams on page 151
Hiding/Showing capo chord symbols on page 151

Showing chord symbols as modes
You can show individual chord symbols as their modal equivalent if one exists for that chord 
symbol.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the chord symbols you want to show as a mode. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Show as mode in the Chord Symbols group.

3. Select the mode you want from the menu.

RESULT
The selected chord symbols are respelled according to the selected mode. This does not affect 
the notes included in the chord symbols.

RELATED LINKS
Engrave toolbox on page 514

Resetting the enharmonic spelling of chord symbols
You can remove enharmonic spelling overrides for chord symbols you have respelled and 
return them to their default spelling. You can remove overrides for instruments with a single 
transposition only, such as instruments in B♭, or for all instrument transpositions.

PROCEDURE

1. In Write mode, select the chord symbol whose spelling you want to reset.
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● If you want to reset the enharmonic spelling of the chord symbol for a single instrument 
transposition only, select the chord symbol on a staff belonging to an instrument with 
that transposition. For example, select it on the staff of any instrument in B♭ to reset the 
chord symbol for all instruments in B♭.

● If you want to reset the enharmonic spelling of the chord symbol for all instrument 
transpositions, select the chord symbol on any staff that belongs to a transposing 
instrument.

2. Press Return  to open the chord symbols popover for the selected chord symbol.

The existing entry for the chord symbol is shown inside the popover.

3. Reset the enharmonic spelling of the chord symbol in any of the following ways:

● To reset the enharmonic spelling of the chord symbol for instruments only with the 
selected transposition, enter Alt/Opt-S  into the chord symbols popover.

● To reset the enharmonic spelling of the chord symbol for all instrument transpositions, 
enter Shift-Alt/Opt-S  into the popover.

4. Press Return  to close the popover.

RESULT
The enharmonic spelling of the selected chord symbol in transposing layouts is reset, either just 
for instruments with the specified transposition or for all transposing instruments.

Hiding/Showing the root and quality of chord symbols
You can hide the root and quality of chord symbols if they follow another chord symbol with the 
same root and quality, but have a different altered bass note.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the chord symbols whose root and quality you want to hide. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Hide root and quality in the Chord Symbols group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The root and quality of the selected chord symbols are hidden when the checkbox is activated, 
and shown when the checkbox is deactivated.

When the property is deactivated, chord symbols follow your project-wide setting.

TIP

You can choose to show the root and quality of chord symbols always, even if successive chord 
symbols have the same root and quality, in Engraving Options > Chord Symbols > Altered Bass 
Notes.
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RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769

Changing the arrangement of compound chord symbols
You can change the arrangement of individual polychord and altered bass note chord symbols, 
independently of your project-wide settings. For example, if you want to show some polychord 
chord symbols stacked vertically but others in a horizontal row. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the compound chord symbols whose arrangement you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Compound chord arrangement in the Chord Symbols 
group.

3. Select one of the following options from the menu:

● Diagonal arrangement

● Stacked arrangement

● Linear arrangement

RESULT
The arrangement of the selected compound chord symbols is changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default arrangement of all polychord and altered bass note chord symbols 
project-wide and independently of each other on the Chord Symbols page in Engraving 
Options.

EXAMPLE

Diagonal arrangement Stacked arrangement Linear arrangement
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RELATED LINKS
Chord components on page 1037
Engraving Options dialog on page 840
Inputting chord symbols on page 318
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Erasing the background of chord symbols
You can erase the background of individual chord symbols; for example, to ensure chord 
symbols remain legible when crossing barlines. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the chord symbols whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Chord Symbols group.

RESULT
The backgrounds of the selected chord symbols are erased. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns the selected chord symbols to the default non-erased 
background.

EXAMPLE

Chord symbol with non-erased background Chord symbol with erased background

RELATED LINKS
Changing the alignment of chord symbols relative to notes on page 1042
Changing the staff-relative placement of chord symbols on page 1043
Engrave toolbox on page 514
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Changing the erasure padding of chord symbols
You can change the erasure padding of individual chord symbols, including changing the 
padding between chord symbols and each edge of their erased areas independently. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the chord symbols whose erasure padding you want to change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Chord Symbols group.

● L changes the padding between chord symbols and their left edge.

● R changes the padding between chord symbols and their right edge.

● T changes the padding between chord symbols and their top edge.

● B changes the padding between chord symbols and their bottom edge.

3. Change the values in the value fields.

RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

TIP

You can change the default erasure padding of all chord symbols project-wide in Engraving 
Options > Chord Symbols > Design. However, this does not allow you to change the padding of 
each edge independently.

Parenthesized chord symbols
Parentheses around chord symbols are often used to indicate an alternative set of chord changes 
or that chords are optional. In Dorico Pro, you can show parentheses around any chord symbol 
that uses appearance presets.

A phrase containing parenthesized chord symbols

You can add chord symbol parentheses both when inputting chord symbols and by 
parenthesizing existing chord symbols.

By default, parenthesized chord symbols show parentheses on both sides. You can show only a 
single left or right parenthesis on individual parenthesized chord symbols.
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NOTE

● You cannot show parentheses on custom chord symbols; that is, chord symbols whose 
appearance you have overridden.

● You can change the default appearance of chord symbol parentheses project-wide, including 
suppressing parentheses around alterations inside parenthesized chord symbols in different 
circumstances, in Engraving Options > Chord Symbols > Parentheses.

RELATED LINKS
Project-wide engraving options for chord symbols on page 1037
Inputting chord symbols on page 318
Bracketed noteheads on page 1263
Showing single brackets on figured bass on page 1143
Custom chord symbols on page 856

Parenthesizing chord symbols
You can show individual chord symbols in parentheses; for example, to indicate optional chords. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

You cannot show parentheses on custom chord symbols; that is, chord symbols whose 
appearance you have overridden.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols you want to parenthesize. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Parenthesized in the Chord Symbols group.

RESULT
Parentheses are shown around each selected chord symbol. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Parenthesized removes parentheses from the selected chord symbols.

EXAMPLE

Chord symbols without parentheses Chord symbols with parentheses
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Showing single parentheses on chord symbols
You can show only a single left or right parenthesis on individual parenthesized chord symbols; 
for example, to indicate that all chord symbols between two parenthesized chord symbols are 
optional. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the parenthesized chord symbols on which you want to show a single parenthesis. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Parenthesis to show in the Chord Symbols group.

3. Choose one of the following options:

● Start

● End

RESULT
Parentheses are hidden on the corresponding side of the selected chord symbols, leaving a 
single parenthesis on the other side. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

EXAMPLE

Parentheses around all chord symbols Parentheses at the start of the first chord and end of 
the last chord

RELATED LINKS
Showing brackets around one/all noteheads in tie chains on page 1266
Large selections on page 428
Engrave toolbox on page 514
Properties panel on page 769
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Changing the style of chord symbol parentheses
You can change the parenthesis style for individual chord symbols. For example, you might show 
stacked chord symbols with slender/tall parentheses due to their height.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the parenthesized chord symbols whose parenthesis style you want to change. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Parenthesis style in the Chord Symbols group.

3. Select one of the following options from the menu:

● Thick

● Slender

● Slender/tall

RESULT
The parenthesis style of the selected parenthesized chord symbols is changed.

EXAMPLE

Thick Slender Slender/tall

Changing the size of chord symbol parentheses
You can change the size of chord symbol parentheses without changing the size of the chord 
symbols to which they apply; for example, to ensure that parentheses appear the same size on 
adjacent chord symbols with different heights. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the parenthesized chord symbols whose parenthesis size you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Parenthesis scale % in the Chord Symbols group.
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3. Change the value in the value field.

The scale size is expressed as a percentage of the parenthesis glyph rather than the chord 
symbol, allowing you to create a consistent parenthesis size regardless of the chord symbol 
height.

RESULT
The size of parentheses around the selected chord symbols is changed.

TIP

You can change the default height of all chord symbol parentheses project-wide in Engraving 
Options > Chord Symbols > Parentheses.

RELATED LINKS
Chord symbol font styles on page 1039
Large selections on page 428

Moving chord symbol parentheses graphically
You can move individual chord symbol parentheses graphically to the right or left, independently 
of your project-wide setting. For example, to increase the space between specific chord symbols 
and their parentheses. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the parenthesized chord symbols whose parentheses you want to 
move.

2. In the Properties panel, activate the following properties, individually or together, in the 
Chord Symbols group:

● Open parenthesis offset

● Closed parenthesis offset

3. Move the corresponding parentheses in one of the following ways:

● To move them to the right, increase the value in the value field.

● To move them to the left, decrease the value in the value field.

RESULT
The corresponding parentheses for the selected parenthesized chord symbols are moved 
graphically. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.
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TIP

You can change the default gap between all chord symbols and parentheses project-wide in 
Engraving Options > Chord Symbols > Parentheses.

Chord symbols imported from MusicXML
Chord symbols are imported from MusicXML files. However, chords that specify Neapolitan, 
Italian, French, German, Pedal, Tristan, and Other values for the kind of element are ignored 
during import, as there is no information to specify what notes these chord symbols are meant 
to describe.

RELATED LINKS
Generating chord symbols from notes on page 327

Chord symbols
Chord symbols imported from MusicXML 

1055
Dorico Pro 4.3.30



Chord diagrams

Chord diagrams represent the pattern of strings and frets on fretted instruments and use dots 
to indicate the stopped finger positions required to produce the corresponding chord. This 
demonstrates the specific shape of chords in a compact way and is useful if a particular voicing is 
required.

In Dorico Pro, chord diagrams are part of chord symbols, meaning you can show them below 
chord symbols wherever they are shown. For players set to show chord diagrams, you can show 
only the chord symbol or chord diagram for individual chord symbols.

You can show chord diagram shapes for any fretted instrument, including different tunings and 
string arrangements, such as guitar DADGAD tuning. This can be different to the instrument 
above which they appear; for example, if you want to show chord diagram shapes for standard 
guitar tuning above the bass staff.

You can also show chord diagrams for all chord symbols used in a flow in a grid at the start of the 
flow, as is common in lead sheets for pop and rock music. You can show used chord diagrams 
grids independently of showing them alongside chord symbols in the music.

A sequence of chord symbols with chord diagrams for banjo

The positions of stopped frets relative to each other are known as “shapes” in Dorico Pro. Any 
playable shape can be re-used for other chords whose pitches match the shape, including any 
new chord diagram shapes you have created. This includes shapes being available for other 
instruments, other tunings, and other positions along the fretboard, so long as any open strings 
included in the shape can be played with a barré at other fret positions.

A single chord can appear with different chord diagram shapes for different instruments and 
tunings, as their open string pitches and the number of strings they have varies.

RELATED LINKS
Chord symbols on page 1036
Hiding/Showing chord diagrams on page 1058
Showing only chord symbols or chord diagrams on page 1059
Hiding/Showing used chord diagrams grids on page 1060
Hiding/Showing fingerings in chord diagrams on page 1062
Changing the chord diagram shape on page 1064
Creating new chord diagram shapes on page 1065
Capos on page 146
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Chord diagram components
Chord diagrams use a combination of symbols, dots, and lines to convey the information about 
strings, fret positions, and finger positions that performers require to play the corresponding 
chord.

1 Omitted string

Indicates a string that must not sound.

2 Open string

Indicates a string that must sound but must be left open; that is, not stopped.

3 Dots

Indicate the fret positions where strings should be stopped, usually with left-hand fingers.

4 Barré

Indicates that multiple strings must be stopped with the same finger, usually pressed flat 
against the fretboard.

5 Starting fret number

Indicates the number of the highest fret in the chord diagram when this is not the first fret.

6 Nut

Represents the top of the fretboard, or “nut”, and appears in chord diagrams whose highest 
fret is the first fret.

7 Fingerings

Indicate the finger used to stop the string. Fingerings can be positioned inside dots or at the 
ends of strings.

RELATED LINKS
Changing the horizontal position of starting fret numbers on page 1068
Changing the orientation of chord diagrams on page 1069
Edit Chord Diagrams dialog on page 854
Chord diagram font styles on page 1068

Project-wide engraving options for chord diagrams
You can find options for the project-wide appearance and position of chord diagrams on the 
Chord Diagrams page in Engraving Options.

The options on the Chord Diagrams page in Engraving Options allow you to change the 
default number of frets shown in chord diagrams, the scale factor of chord diagrams relative 
to chord symbols, and the precise dimensions of each aspect within chord diagrams, including 
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the thickness of strings and lines and size of dots. You can also change the appearance and 
position of fret numbers, such as showing them as Roman numerals.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840

Project-wide note input options for chord diagrams
You can find options for the project-wide handling of chord diagrams and different components 
within chord diagrams on the Chord Diagrams page in Note Input Options.

The options on the Chord Diagrams page include whether or not to include the root note in 
chord diagrams, as it can be useful to omit root notes in chord diagrams for the guitarist in 
ensembles with a bass player, and whether or not to include particular scale degrees depending 
on the chord symbol, such as omitting the fifth in dominant seventh chords.

RELATED LINKS
Note Input Options dialog on page 839

Hiding/Showing chord diagrams
You can hide/show chord diagrams for any type of fretted instrument alongside all chord 
symbols on a per-player basis. You can also change the fretted instrument or tuning for which 
chord diagrams are shown.

NOTE

You cannot show chord diagrams when chord symbols are hidden entirely. However, you can 
show only the chord symbol or chord diagram for individual chord symbols.

PREREQUISITE

● You have input the chord symbols for which you want to show chord diagrams.

● Chord symbols are shown above the staves where you want to show chord diagrams.

● If you want to show chord diagrams using a custom fretted instrument tuning, you have 
imported the tuning or changed the tuning of a fretted instrument in the project accordingly.

PROCEDURE

1. In Setup mode, in the Players panel, select a player for whom you want to hide/show chord 
diagrams.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord diagrams, choose Chord Diagrams > [Fretted instrument and tuning]. 
For example, to show chord diagrams for a guitar in DADGAD tuning, choose Chord 
Diagrams > DADGAD guitar tuning.

● To hide chord diagrams, choose Chord Diagrams > No Chord Diagrams.

RESULT
Chord diagrams are shown alongside all chord symbols for the selected player, as appropriate 
for the selected fretted instrument and tuning. Dorico Pro shows the simplest shape available for 

Chord diagrams
Project-wide note input options for chord diagrams 

1058
Dorico Pro 4.3.30



each chord; that is, shapes with the most open strings, easy barré positions, or finger positions 
closest to the nut.

If no chord diagram is available for a chord symbol, an empty chord diagram is shown.

TIP

● You can also hide/show chord diagrams by right-clicking players and choosing these options 
from the context menu.

● You can edit empty chord diagrams to save a new chord diagram shape.

EXAMPLE

Chord symbols shown but chord diagrams hidden Chord diagrams shown (standard guitar tuning)

RELATED LINKS
Players panel on page 111
Inputting chord symbols on page 318
Hiding/Showing chord symbols on page 1040
Fretted instrument tuning on page 142

Showing only chord symbols or chord diagrams
You can show only the chord symbol or chord diagram for individual chord symbols on staves set 
to show chord diagrams. For example, if you want to show both the symbol and diagram for the 
first time each chord appears but only show chord symbols for subsequent instances. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● You have shown chord diagrams for the players on whose staves you want to show only 
chord symbols or chord diagrams.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose shown symbols/diagrams you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Show only in the Chord Symbols group.

3. Choose one of the following options:

● Chord Symbol
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● Chord Diagram

RESULT
The selected chord symbols show only symbols or diagrams. In systems containing both chord 
symbols and chord diagrams, chord symbols are aligned further from the staff than chord 
diagrams.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Chord symbols shown Chord diagrams shown (standard guitar tuning)

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Hiding/Showing used chord diagrams grids
You can hide/show grids that contain all chord diagrams used in each flow in each layout 
independently. By default, used chord diagrams grids display standard guitar tuning chord 
diagrams but you can change this to show chord diagrams for any fretted instrument or tuning.

Used chord diagrams grids are commonly used in lead sheets for pop and rock music. They are 
typically shown instead of chord diagrams alongside chord symbols in the music to save vertical 
space and so they can appear at a larger scale size, making the details of each chord diagram 
easier to read.

PREREQUISITE

● If you want to show chord diagrams using a custom fretted instrument tuning, you have 
imported the tuning or changed the tuning of a fretted instrument in the project accordingly.

● We recommend that you have input chord symbols and changed the shape of any chord 
symbols you want to appear with a specific voicing.

NOTE

It is customary not to show chord diagrams alongside chord symbols when showing a 
used chord diagrams grid, and you cannot change the chord diagram shape when chord 
diagrams are hidden.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Chord diagrams
Hiding/Showing used chord diagrams grids 

1060
Dorico Pro 4.3.30



2. In the Layouts list, select the layouts in which you want to hide/show used chord diagrams 
grids at the start of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, activate/deactivate Show chord diagrams used at start of 
flow.

5. Optional: Change the settings for used chord diagrams grids as required.

For example, you can change the fretted instrument tuning for chord diagrams in the grid, 
their scale size, and the distance between chord diagrams and/or rows of chord diagrams.

6. Click Apply, then Close.

RESULT
Chord diagrams for all chord symbols used in the flow are shown in a grid above the start of each 
flow in the selected layouts, and are positioned according to the settings for the selected layouts. 
If flow headings are shown, the used chord diagrams grid appears below them. The order of 
chord diagrams in the grid is determined by the order in which they first appear in the flow. Each 
different voicing appears as a separate chord diagram but each voicing appears only once in the 
grid.

If you input more chord symbols or change the voicing of existing chord diagrams, the used 
chord diagrams grids update automatically to include them.

NOTE

● Even if no chord symbols exist in a flow, vertical space for the used chord diagrams grid is 
added at the start of the flow.

● You cannot select or edit individual chord diagrams in used chord diagrams grids.

EXAMPLE

Used chord diagrams grid at the start of a flow
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AFTER COMPLETING THIS TASK
You can change the margins of pages, music frames, and/or flow headings if required to 
accommodate used chord diagrams grids.

RELATED LINKS
Capos on page 146
Defining capos for used chord diagrams grids on page 153
Hiding/Showing systemic barlines on single-staff systems on page 973
Margins on page 712

Hiding/Showing fingerings in chord diagrams
You can hide/show fingerings in chord diagrams shown alongside chord symbols and in used 
chord diagrams grids independently of each other and in each layout independently. You can 
choose whether fingerings appear inside dots or at the ends of strings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show fingerings in chord 
diagrams.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, activate/deactivate the following options, individually or 
together:

● To hide/show fingerings in chord diagrams shown alongside chord symbols, activate/
deactivate Show fingerings in chord diagrams.

● To hide/show fingerings in used chord diagrams grids, activate/deactivate Show 
fingerings in chord diagrams at start of flow.

5. Choose one of the following options for Fingerings position:

● Inside dot

● At end of string

6. Click Apply, then Close.

RESULT
Fingerings are shown in the corresponding position in chord diagrams in the selected layouts 
when the options are activated, and hidden when they are deactivated. This also affects whether 
fingerings appear in the Edit Chord Diagram and Edit Chord Diagrams dialogs.
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EXAMPLE

Fingerings hidden Fingerings shown inside dots Fingerings shown at the ends of 
strings

AFTER COMPLETING THIS TASK
You can change the fingerings shown in chord diagrams when editing their shape.

RELATED LINKS
Creating new chord diagram shapes on page 1065
Edit Chord Diagram dialog on page 1066
Edit Chord Diagrams dialog on page 854
Chord diagram font styles on page 1068
Fingering on page 1157
Hiding/Showing fingering on page 1165

Allowing/Disallowing thumb fingerings in chord diagrams
You can allow/disallow all chord diagrams project-wide to use thumb fingerings on the lowest 
string; for example, if your project includes chords that are impossible to finger without using 
the thumb.

PROCEDURE

1. Press Ctrl/Cmd-Shift-I  to open Note Input Options.

2. In the category list, click Chord Diagrams.

3. In the Fingering subsection, choose one of the following options for Use of thumb when 
fingering lowest string:

● Allow thumb

● Disallow thumb

4. Activate/Deactivate Update existing chord diagram fingerings when changing use of 
thumb.

RESULT
Thumb fingerings on the lowest string are allowed/disallowed in all chord diagrams project-wide.

If you activated Update existing chord diagram fingerings when changing use of thumb, the 
fingerings and/or shapes of existing chord diagrams are changed where applicable.

RELATED LINKS
Note Input Options dialog on page 839
Edit Chord Diagrams dialog on page 854
Edit Chord Diagram dialog on page 1066
Hiding/Showing fingerings in chord diagrams on page 1062
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Resetting chord diagram fingerings
You can reset changes you have made to fingerings in individual chord diagrams without 
resetting other changes to the shape.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the chord diagrams whose fingerings you want to reset. You can do this in Write mode 
and Engrave mode.

2. Choose Edit > Notations > Chord Symbols and Diagrams > Reset Chord Diagram Finger 
Numbering. You can also choose this option from the context menu.

Changing the chord diagram shape
You can change the chord diagram shape shown at individual rhythmic positions; for example, if 
you require a shape with a different voicing. Many chords have multiple playable shapes.

You can also apply your changes to all other instances of the same chord for instruments with 
compatible tunings.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the chord diagram whose shape you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

You can only change the shape of a single chord diagram at a time.

2. Change the shape in any of the following ways:

● To cycle through all the available shapes for the selected chord, press Alt/Opt-Q .

● To open the Choose Chord Diagram dialog and see all the available shapes for the 
selected chord at once, press Shift-Alt/Opt-Q .

3. Optional: In the Choose Chord Diagram dialog, select the shape you want to use.

TIP

If the shape you require is not available, you can click Edit, which allows you to create a new 
shape.

4. Click OK to save your changes and close the dialog.

5. Optional: To apply the new shape to other instances of the same chord for instruments 
with compatible tunings, choose Edit > Notations > Chord Symbols and Diagrams > Copy 
Shape to Matching Chord Symbols. You can also choose this option from the context 
menu.
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RESULT
The shape shown for the selected chord diagram is changed. This also updates all other chord 
diagrams using the same fretted instrument tuning at the same rhythmic position.

Choose Chord Diagram dialog
The Choose Chord Diagram dialog allows you to view all available chord diagram shapes for the 
selected chord and select the one you want to use.

● You can open the Choose Chord Diagram dialog in Write mode by selecting a chord 
diagram and pressing Shift-Alt/Opt-Q .

The Choose Chord Diagram dialog comprises the following:

1 Available chord diagrams

Displays all the valid chord diagram shapes for the selected chord and allows you to select a 
different shape to show at the selected rhythmic position. Shapes you have created yourself 
appear in a different color.

2 Edit

Opens the Edit Chord Diagram dialog, which allows you to edit the shape of chord 
diagrams, including changing the number of frets shown, stopped fret positions, and the 
starting fret number.

Creating new chord diagram shapes
You can create new chord diagram shapes by editing an existing one; for example, if you want 
an alternative voicing for a chord or to show a barré. Your changes to existing chord diagram 
shapes are saved as a new shape, they do not overwrite the existing one.

TIP

If you want to define multiple new chord shapes at once or start a new shape from scratch, you 
can do so in the Edit Chord Diagrams dialog.

PROCEDURE

1. In Engrave mode, double-click the chord diagram whose shape you want to edit to open the 
Edit Chord Diagram dialog.
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TIP

You can also open the Edit Chord Diagram dialog from inside the Choose Chord Diagram 
dialog.

2. Edit the shape and settings of the chord diagram as required.

For example, you can change open strings to omitted strings, change the stopped fret 
position on strings to change the corresponding string pitch, or change the fingering of 
individual stopped fret positions.

3. Optional: If you want the shape to be available for chords with different start fret positions, 
activate Chord may be moved along the neck.

4. Click Save, then Close.

RESULT
The new shape is saved and is used for the selected chord diagram. The new shape also becomes 
available for any other chord for which it is valid.

Edit Chord Diagram dialog
The Edit Chord Diagram dialog allows you to edit the shape of individual chord diagrams, 
including changing the number of frets shown, stopped fret positions, and the starting fret 
number.

You can open the Edit Chord Diagram dialog in any of the following ways:

● In Write mode by opening the Choose Chord Diagram dialog, selecting the chord diagram 
whose shape you want to edit, and clicking Edit.

● In Engrave mode by double-clicking a chord diagram, or selecting it and pressing Return .
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The Edit Chord Diagram dialog contains the following options and sections:

1 Name

Displays the name of the chord whose chord diagram you are editing in the dialog. You 
cannot change this name.

2 Tuning

Displays the fretted instrument and tuning for the current chord diagram.

3 Chord may be moved along the neck

Allows you to specify whether or not the shape of the chord diagram can be reused at other 
fret positions; for example, by playing open strings with a barré at higher fret positions.

4 Notes not in chord diagram

Displays any pitches that are part of the chord but not currently included in the chord 
diagram.

5 Open string pitch

Displays the open pitch of the corresponding string for reference.

6 Current string pitch

Displays the current pitch of the corresponding string if it is open or stopped. If the pitch of a 
string is not part of the chord, the string pitch appears red.

7 String status

Displays the current usage status of the corresponding string and allows you to switch the 
status of individual strings between open and omitted by clicking in this row.

● O: Open string

● X: Omitted string

● No symbol: Stopped string

8 Chord diagram shape editor

Displays the current arrangement of stopped frets using dots and allows you to change the 
chord diagram shape. You can move stopped frets by clicking at the required positions. Each 
string can only have a single stopped fret position.

If two or more strings are stopped at the same fret, you can hide/show a barré by clicking 
any of the dots at that fret position.

You can change fingerings by double-clicking them and entering a new number, including 0 
to show no fingering or T for thumb fingerings on the lowest string.

9 Action bar

Contains options that allow you to edit and change the number of frets.

● Starting fret: Changes the fret number of the highest fret in the chord diagram.

● Starting fret number offset: Changes the offset of the starting fret number. For 
example, if you want the starting fret label to appear beside the second fret down the 
chord diagram in order to include a barré.

● Add fret : Adds a fret to the bottom of the chord diagram.

● Remove fret : Removes a fret from the bottom of the chord diagram.

● Reset Chord Diagram : Removes your changes to the chord diagram and resets it to 
its default shape.

10 Save

Saves the chord diagram shape and updates the selected chord diagram in the music area. 
The shape also becomes available as an alternative shape for other compatible chords.
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Chord diagram font styles
There are different font styles for fingerings and starting fret numbers in chord diagrams. You 
can change different aspects of these fonts in the Edit Font Styles dialog, such as changing their 
font size to make chord diagram fingerings appear smaller.

The following font styles are used for chord diagrams:

1 Chord Diagram Fingering Font: Used for fingerings in chord diagrams, both inside dots 
and at the ends of strings. However, fingerings inside dots never appear larger than dots, 
regardless of the font size.

2 Chord Diagram Fret Number Font: Used for starting fret numbers in vertical chord 
diagrams.

3 Chord Diagram Horizontal Fret Number Font: Used for starting fret numbers in horizontal 
chord diagrams.

RELATED LINKS
Edit Font Styles dialog on page 846
Hiding/Showing fingerings in chord diagrams on page 1062
Changing the orientation of chord diagrams on page 1069
Changing the chord diagram shape on page 1064
Edit Chord Diagrams dialog on page 854

Changing the horizontal position of starting fret numbers
You can choose whether all starting fret numbers in chord diagrams appear on the right or left of 
the diagram. By default, starting fret numbers appear on the right.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Chord Diagrams.

3. In the Fret Numbers section, choose one of the following options for Horizontal position:

● Left

● Right

4. Click Apply, then Close.

RESULT
The position of starting fret numbers relative to chord diagrams is changed project-wide.
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TIP

There are other options on the Chord Diagrams page to control the appearance and exact 
position of fret numbers.

Changing the size of chord diagrams
You can change the size of all chord diagrams project-wide, expressed as a scale size relative 
to chord symbols. Chord diagrams are automatically scaled proportionally when you change the 
size of individual chord symbols.

NOTE

These steps only apply to chord diagrams shown alongside chord symbols. You can change the 
size of chord diagrams in used chord diagrams grids in Layout Options > Chord Symbols and 
Diagrams > Chord Diagrams.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Chord Diagrams.

3. In the Design section, change the value for Scale factor relative to chord symbol.

4. Click Apply, then Close.

RESULT
The scale size of all chord diagrams project-wide relative to chord symbols is changed.

RELATED LINKS
Changing the size of notes/items on page 440
Hiding/Showing used chord diagrams grids on page 1060

Changing the orientation of chord diagrams
You can change the default orientation of all chord diagrams project-wide; for example, if you 
want them to appear horizontal for educational purposes. By default, chord diagrams appear 
vertical.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Chord Diagrams.

3. In the Design section, choose one of the following options for Orientation:

● Vertical

● Horizontal

4. Click Apply, then Close.
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Clefs

Clefs are the symbol at the start of every system that give the notes on the staff context; that is, 
the clef tells you which note of the scale applies to each line or space of the staff. To minimize 
the number of ledger lines required for notes, different clefs are typically used according to the 
register of instruments.

The common clefs are:

● Treble clef, or G clef, whose spiral shape centers around G, normally the G above middle C.

● The bass clef, or F clef, in which two dots are shown either side of the line corresponding to 
F, normally the F below middle C.

● The C clef, in which the center of the bracket to the right of the clef’s thick vertical line is 
positioned on the line that corresponds to C, normally middle C. When positioned on the 
middle line of the staff, the C clef is known as the alto clef. When positioned on the second 
staff line from the top, the C clef is known as the tenor clef.

The E below middle C 
shown in a treble clef

The E below middle C 
shown in a bass clef

The E below middle C 
shown in a C (alto) clef

The E below middle C 
shown in a C (tenor) clef

In Dorico Pro, notes are automatically positioned on staves according to the prevailing clef.

Initial clefs at the start of flows and systems appear full size, while mid-system clef changes 
are automatically scaled down. You can change the default size of all mid-system clef changes 
project-wide.

Many instruments in Dorico Pro have different types that show alternative clefs by default. You 
can select the appropriate instrument type from the instrument picker when adding or changing 
instruments.

NOTE

● You can only select clefs that you have input. You cannot select initial clefs at the start of 
flows or clefs shown automatically at the start of each system.

● If you do not want to show any clef in any layout, you must input an invisible clef. You can 
also hide/show clefs according to the layout transposition and at the start of single-staff 
systems.

● If clef changes occur at the start of a new system or page, a cautionary clef is shown at 
the end of the previous system. In Dorico Pro, the clefs shown at the end of one system 
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and at the start of the next system are the same item, not separate items. You cannot hide 
cautionary clefs.

● You can change the minimum gaps between objects, including clefs, on the Spacing Gaps 
page in Engraving Options.

RELATED LINKS
Input methods for clefs and octave lines on page 329
Clefs with octave indicators on page 1077
Instrument picker on page 113
Hiding/Showing clefs according to layout transpositions on page 1075
Hiding/Showing clefs at the start of systems on page 1075
Cautionary key signatures on page 1216
Cautionary time signatures on page 1643
Engraving Options dialog on page 840

Showing clefs after grace notes
According to convention, clefs are positioned before grace notes so this is the default in Dorico 
Pro. However, in some circumstances you might want to position clefs between grace notes and 
normal notes.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the clefs you want to show after grace notes. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Clef > After Grace Notes. You can also choose this option from 
the context menu.

RESULT
The selected clefs are positioned between normal notes and grace notes.

NOTE

You can reset the position of clefs relative to grace notes by selecting the clefs whose position 
you want to reset and choosing Edit > Notations > Clef > Reset Clef Position. You can also 
choose this option from the context menu.

Clefs
Showing clefs after grace notes 
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EXAMPLE

Treble clef before grace notes Treble clef after grace notes to align with bass clef

RELATED LINKS
Engrave toolbox on page 514

Moving clefs graphically
You can move individual clefs graphically without affecting the positions of any other items.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the square note spacing handle above the clef you want to move.

A circular handle appears beside the clef.

2. Press Tab  to select the circular handle.

3. Move the handle in any of the following ways:

● To move it a standard amount to the right or left, press Alt/Opt  plus the corresponding 
arrow key. For example, press Alt/Opt-Left Arrow  to move handles to the left.

● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

Clefs
Moving clefs graphically 
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NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.

RESULT
The clef is moved graphically to the right/left without affecting other items at the same rhythmic 
position.

TIP

● You can also change Spacing offset in the Clefs group of the Properties panel to move clefs 
horizontally. However, this also affects global note spacing around the rhythmic position of 
the clef.

The Spacing offset property in the Clefs group of the Properties panel is not available when 
Note Spacing  is activated.

● You can change the default gaps before and after all clefs project-wide on the Spacing Gaps 
page in Engraving Options.

RELATED LINKS
Note spacing on page 599
Engraving Options dialog on page 840

Changing the default size of mid-system clef changes
You can change the default scale factor of all clef changes that occur partway through systems 
project-wide; for example, if you want mid-system clef changes to appear larger.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Clefs.

3. Change the value for Clef change scale factor.

4. Click Apply, then Close.

RESULT
The size of mid-system clef changes is changed project-wide. This does not affect the size of 
initial clefs at the start of flows or clefs shown automatically at the start of each system.

RELATED LINKS
Engraving Options dialog on page 840

Clefs
Changing the default size of mid-system clef changes 
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Setting different clefs for concert/transposed pitch
You can set clef changes to show a different clef in concert pitch layouts compared to transposed 
pitch layouts. For example, if you want a clef change on a Bass Clarinet staff to appear as a treble 
clef in the part layout but as a bass clef in the full score layout.

NOTE

● These steps only apply to clefs you have input, as you cannot select initial clefs or the clefs 
shown automatically at the start of each system.

● Many instruments in Dorico Pro show different clefs in full score/custom score and part 
layouts by default. You can select the appropriate instrument type from the instrument 
picker when adding or changing instruments.

● You can also override the default clef shown in each layout.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the clefs whose concert/transposed pitch versions you want to change. You can do 
this in Write mode and Engrave mode.

2. Choose one of the following options:

● To change the concert pitch version of the selected clefs, choose Edit > Notations > 
Clef > Concert Pitch > [Clef].

● To change the transposed pitch version of the selected clefs, choose Edit > Notations > 
Clef > Transposed Pitch > [Clef].

TIP

You can also choose these options from the context menu.

RESULT
The clefs shown at the selected clef changes in layouts of the corresponding transposition are 
changed up to the next existing clef change or the end of the flow, whichever comes first.

AFTER COMPLETING THIS TASK
If you want to show the clefs in some layouts but hide them in others, you can hide/show clefs in 
layouts according to the layout transposition.

RELATED LINKS
Engrave toolbox on page 514
Adding instruments to players on page 138
Changing instruments on page 140
Instrument picker on page 113
Concert vs. transposed pitch on page 174
Making layouts transposing/concert pitch on page 173
Overriding the default clef for layouts on page 179
Changing the octave of clefs on page 1076

Clefs
Setting different clefs for concert/transposed pitch 
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Hiding/Showing clefs according to layout transpositions
You can show individual clefs only in layouts that are either concert or transposed pitch. For 
example, due to their transpositions, some instruments require clef changes in concert pitch 
scores to avoid excess ledger lines, but do not require those clef changes in their transposed 
pitch parts.

By default, all clefs appear in all layouts.

TIP

Many instruments in Dorico Pro show different clefs in full score/custom score and part layouts 
by default. You can select the appropriate instrument type from the instrument picker when 
adding or changing instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the clefs or signposts of clefs you want to hide/show according to the layout 
transposition. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Show for transposition in the Clefs group.

3. Choose one of the following options:

● Concert Pitch

● Transposing Pitch

RESULT
The selected clefs only appear in layouts with the corresponding transposition. In layouts where 
clefs are hidden, they are indicated by signposts.

Hidden clefs have no effect on note and staff spacing.

RELATED LINKS
Engrave toolbox on page 514
Concert vs. transposed pitch on page 174
Making layouts transposing/concert pitch on page 173
Signposts on page 453
Input methods for clefs and octave lines on page 329
Instrument picker on page 113

Hiding/Showing clefs at the start of systems
By default, clefs are shown at the start of all systems. You can hide/show clefs at the start of 
single-staff systems from the second system onwards in each flow independently.

Hiding clefs on single-staff systems after the first system is a convention used in hand-copied 
lead sheets, usually in combination with hiding key signatures and showing systemic barlines.

Clefs
Hiding/Showing clefs according to layout transpositions 
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PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show clefs after the first system.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Clefs.

4. Choose one of the following options for Clefs at start of systems following first system:

● Show clefs

● Hide clefs

5. Click Apply, then Close.

RESULT
Clefs are hidden or shown at the start of single-staff systems from the second system onwards in 
the selected flows.

NOTE

Clefs are always shown at the start of systems that contain more than one staff.

RELATED LINKS
Hiding/Showing systemic barlines on single-staff systems on page 973
Hiding/Showing key signatures at the start of systems on page 1213

Changing the octave of clefs
You can change the octave shift of individual clefs. For example, to accommodate different horn 
and bass clarinet transposition conventions. You can change the octaves of clefs in concert pitch 
and transposed pitch layouts independently.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have opened a layout with the required transposition in the music area. For example, 
if you want to change the octave of clefs in concert pitch, you have opened a concert pitch 
layout.

● If you want to change the octave of initial clefs, you have input clefs at the start of each flow 
or overridden the default clefs in the required layouts.

PROCEDURE

1. Select the clefs whose octave you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Octave shift in the Clefs group.

3. Change the value in the value field.

Clefs
Changing the octave of clefs 

1076
Dorico Pro 4.3.30



RESULT
The octave of the selected clefs is changed in all layouts with the same transposition. For 
example, 1 shifts clefs up one octave, and -1 shifts clefs down one octave.

The pitches of notes on the staves of the selected clefs are adjusted automatically. For example, 
if you shift a clef up one octave, notes after the clef appear an octave lower than they do without 
the octave shift.

TIP

● You can specify octave shifts when inputting clefs using the clefs and octave lines popover.

● You can also change whether Dorico Pro respects or ignores octave indicators on clefs, such 
as treble G clef, octave above.

RELATED LINKS
Engrave toolbox on page 514
Clefs and octave lines popover on page 330
Layouts with clef/transposition overrides on page 176
Overriding the default clef for layouts on page 179
Concert vs. transposed pitch on page 174
Setting different clefs for concert/transposed pitch on page 1074
Respecting/Ignoring clef octave indicators on page 1078

Clefs with octave indicators
Clefs with octave indicators indicate that notes are played in a different register to the one 
notated. An octave indicator above the clef indicates that notes are played higher than notated, 
while an octave indicator below the clef indicates that notes are played lower than notated.

Of these clefs, only the treble clef 8 below is still commonly used for tenor vocal parts.

Traditionally, clef octave indicators were used as a reminder of transposing instruments; 
however, in more recent music, some composers use clef octave indicators as an alternative 
to octave lines for extended passages. Therefore, Dorico Pro ignores clef octave indicators by 
default. However, transposing instruments are always transposed correctly automatically. For 
example, notes belonging to piccolo instruments are automatically notated an octave lower than 
their pitch in playback, regardless of whether they have a clef with an octave indicator. You can 
change whether Dorico Pro respects or ignores clef octave indicators in each flow independently.

RELATED LINKS
Transposing instruments on page 137
Concert vs. transposed pitch on page 174
Octave lines on page 1079
Layouts with clef/transposition overrides on page 176
Respecting/Ignoring clef octave indicators on page 1078
Changing the octave of clefs on page 1076
Input methods for clefs and octave lines on page 329

Clefs
Clefs with octave indicators 
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Respecting/Ignoring clef octave indicators
Traditionally, clef octave indicators were used as a reminder of transposing instruments; 
however, in more recent music, some composers use clef octave indicators as an alternative 
to octave lines for extended passages. You can change whether Dorico Pro respects or ignores 
clef octave indicators in each flow independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to respect/ignore clef octave indicators.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Clefs.

4. Choose one of the following options for Clefs with octave indicators:

● Ignore octave indicator

● Respect octave indicator

5. Click Apply, then Close.

RESULT
The handling of clefs with octave indicators is changed in the selected flows. When clef octave 
indicators are respected, the pitches of notes on staves with clefs with octave indicators are 
adjusted automatically. For example, notes with treble G clefs, octave above, appear an octave 
lower than they do when clef octave indicators are ignored.

RELATED LINKS
Transposing instruments on page 137
Changing the octave of clefs on page 1076
Hiding/Showing clefs according to layout transpositions on page 1075
Setting different clefs for concert/transposed pitch on page 1074

Clefs
Clefs with octave indicators 
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Octave lines

Octave lines indicate where notes are played higher/lower than they appear in the score or 
part. They are dashed or dotted horizontal lines with an italic numeral at the start. The numeral 
indicates the number of pitches by which the phrase is changed, such as 8 for one octave and 15 
for two octaves.

Octave lines that indicate notes are played higher than notated are placed above the staff, while 
octave lines that indicate notes are played lower than notated are placed below the staff.

A treble clef phrase notated at 
pitch

The treble clef phrase with an 
octave above line

The treble clef phrase with a two 
octaves above line

A bass clef phrase notated at pitch The bass clef phrase with an 
octave below line

The bass clef phrase with a two 
octaves below line

In Dorico Pro, pitches are adjusted automatically when an octave line is present. You do not have 
to change the register of the notes within octave lines.

Octave lines should be horizontal, meaning they can take up significant vertical space, as octave 
lines are usually placed outside all other notations. However, they can be placed within slurs and 
tuplet brackets if the slur or tuplet bracket is longer than the octave line. You can also change the 
angles of octave lines; for example, to fit around angular phrases better.

Octave lines can continue across system and page breaks. It is customary to show the numeral 
again at the start of each system as a reminder. Cautionary octave line numerals are usually 
parenthesized and the suffix is optional.

RELATED LINKS
Input methods for clefs and octave lines on page 329
Clefs with octave indicators on page 1077
Lines on page 1402
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Project-wide engraving options for octave lines
You can find options for the project-wide appearance of octave lines on the Octave Lines page in 
Engraving Options.

The options on this page allow you to change the appearance of continuation lines, continuation 
labels, the numeral at the start of octave lines, the position of octave lines relative to accidentals 
and noteheads, and their staff-relative placement.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Changing the angles of octave lines
You can change the angles of octave lines in multiple places; for example, if you want to add 
corners to allow an octave line to follow the shape of an angular phrase more closely to save 
vertical space.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Write mode or Engrave mode, select one of the following:

● Individual notes/chords within octave lines where you want to add single corners.

NOTE

We do not recommend selecting adjacent notes, as this can distort the dashes in octave 
lines.

● An even number of adjacent notes across which you want to angle the octave line.

2. Change the angles in one of the following ways:

● To add a single corner at the position of each selected note, choose Edit > Notations > 
Octave Line > Add Corner.

● To angle the octave line across the range of selected notes, choose Edit > Notations > 
Octave Line > Make Angled.

TIP

You can also choose these options from the context menu.

RESULT
If you added corners to individual notes, Dorico Pro compares the furthest note from the staff at 
each selected rhythmic position to the height of the previous note/chord and adds a corner with 
a suitable angle.

If you angled the octave line across a range of selected notes, Dorico Pro adjusts the angle of the 
octave line in order to fit around changes in height in the selected range.

Octave lines
Project-wide engraving options for octave lines 
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EXAMPLE

An octave line with multiple corners, allowing it to fit better under the slur

Resetting the angles of octave lines
You can reset the angles and corners of octave lines to return them to a single horizontal line.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes within the octave lines at the positions of the angles/corners you want to 
reset. You can do this in Write mode and Engrave mode.

2. Choose Edit > Notations > Octave Line > Remove Corner/Angle. You can also choose this 
option from the context menu.

RESULT
The angles and corners of octave lines above/below the selected notes are reset. This does not 
affect any other angles in the same octave lines above/below unselected notes.

Positions of octave lines
By default, octave lines that indicate notes are played higher than written are placed above the 
staff, while octave lines that indicate notes are played lower than written are placed below the 
staff.

You can move octave lines to new rhythmic positions in Write mode. They are positioned by 
default according to your settings in Engraving Options.

You can move octave lines graphically in Engrave mode, but this does not change the rhythmic 
positions to which they apply.

You can change the default positions of all octave lines project-wide on the Octave Lines page in 
Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Input methods for clefs and octave lines on page 329
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Tucking index properties on page 1083

Octave lines
Positions of octave lines 
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Changing the alignment of octave line numerals relative to notes
You can change whether the left edge, center, or right edge of individual octave line numerals 
is aligned with the first note to which each octave line applies. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines whose numeral alignment relative to notes you want to change. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate L alignment in the Octave Lines group.

3. Select one of the following options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the numerals of the selected octave lines is changed. For example, if you select 
Right, the right edge of the selected octave line numerals is aligned with the first noteheads to 
which the octave lines apply. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the position of octave line numerals relative to accidentals
You can change whether the numerals at the start of individual octave lines are positioned on 
noteheads or accidentals, independently of your project-wide setting. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines whose numeral alignment relative to accidentals you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate L position in the Octave Lines group.

Octave lines
Positions of octave lines 
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3. Choose one of the following options:

● Notehead

● Accidental

RESULT
The alignment of the numerals of the selected octave lines is changed. For example, if you 
choose Accidental, the octave line numerals are aligned with the accidental on the first 
noteheads to which the octave lines apply. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

TIP

You can change the default alignment of all octave line numerals project-wide in the Horizontal 
Position section of the Octave Lines page in Engraving Options.

Octave lines in Engrave mode
In Engrave mode, each octave line has three square handles. You can use these handles to move 
the start/end of octave lines graphically, and to lengthen/shorten octave line hooks.

An octave line in Engrave mode

● The start handle moves the start of octave lines graphically. You can move this handle to the 
right/left. When using the keyboard, you can also move this handle upwards/downwards to 
move the whole octave line.

● The top end handle moves the end of octave lines graphically. You can move this handle to 
the right/left.

● The bottom end handle changes the length of the hook. You can move this handle upwards/
downwards.

If octave lines cross system and frame breaks, you can move the line segments on each side of 
the break independently.

RELATED LINKS
Moving items graphically on page 609
Lengthening/Shortening items on page 436

Tucking index properties
The tucking index of notations determines their position relative to other notations in the vertical 
stacking order when multiple notations exist at the same rhythmic positions.

In most published music, the order in which items appear relative to each other is consistent. 
Dorico Pro uses established conventions to determine the position and placement of notations 
automatically. For example, where slurs and tuplet brackets exist at the same positions, Dorico 
Pro calculates their placement based on their relative lengths. If the slur is longer than the tuplet 
bracket, the slur is placed outside the tuplet bracket; if the tuplet bracket is longer than the slur, 
the slur is placed inside the tuplet bracket.

Octave lines
Octave lines in Engrave mode 
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However, rules for the order and placement of articulations, slurs, tuplets, and octave lines 
frequently vary, based on their lengths and musical context. Therefore, you can override the 
automatic order and manually change the order in which they appear in specific contexts.

To allow you this flexibility, slurs, octave lines, and tuplets all have Tucking index properties in 
their respective Properties panel groups.

NOTE

● Articulations are considered alongside these notations when calculating the stacking order, 
but do not have a tucking index property.

● Playing techniques have a separate tucking index that allows you to change the vertical 
order of playing techniques relative to each other.

A Tucking index value of 0 positions items closest to notes. The higher the number, the further 
away the item is positioned from notes in the stacking order.

Changing the vertical stacking order of octave lines
You can change the placement of individual octave lines relative to other objects in the vertical 
stack by changing their tucking index value. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

According to general convention, octave lines are placed outside all other objects, but there are 
some instances where they can go inside other objects; for example, inside a slur if that slur is 
longer than the octave line.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the octave lines whose placement in the vertical stack you want to 
change.

2. In the Properties panel, activate Tucking index in the Octave Lines group.

3. Change the value in the value field.

0 positions items closest to notes. The higher the number, the further the item is positioned 
from notes in the stacking order.

RESULT
The placement of the selected octave lines in the vertical stacking order is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Changing the vertical order of playing techniques on page 1393

Octave lines
Tucking index properties 
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Cues

Cues are passages of music shown in instrumental parts that are played by a different player, 
usually to help orientate players before entries or solos following a significant passage of rests.

Cues can also be used to assist with co-ordination or tuning between players, or to indicate 
material that the player might be asked to double.

In Dorico Pro, you can input correctly formatted cues quickly using the cues popover. Cues are 
automatically input into a new voice, with bar rests shown alongside cues to make sure the 
player reading the cue understands that they do not play the cued music. Clefs are automatically 
input in cues as required, including restorative clefs. Notes and notations appear cue-sized.

A cue in a timpani part showing music from the bassoons

Dorico Pro features dynamic cues that are linked to the original source material, meaning cues 
are updated in real time if the source material changes.

The instrument whose music is included in a cue is known as the source instrument. The 
instrument whose part contains a cue from another instrument is known as the destination 
instrument.

Cue labels in Dorico Pro use abbreviated source instrument names.

By default, cues are hidden in full score/custom score layouts and shown in part layouts. In 
layouts where cues are hidden, they are indicated by signposts.

NOTE

● In Write mode, you cannot select anything within cues. In Engrave mode, you can select 
notes and items in cues but you can only edit them graphically.

● Cues show the music of a single staff, such as the top staff of a piano. If you want to show 
the material of multiple staves in cues simultaneously, you must input separate cues for 
each staff so they overlap.

● Cues from pitched source instruments on unpitched percussion instrument staves are input 
as rhythmic cues.

RELATED LINKS
Inputting cues on page 421
Hiding/Showing cues in layouts on page 1089
Cue contents on page 1092
Cue labels on page 1093
Clef changes in cues on page 1099
Notations in cues on page 1095
Overlapping cues on page 1096
Rests in cues on page 1098
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Ties in cues on page 1097
Note spacing on page 599
Viewing options for cues on page 1101
Signposts on page 453

Project-wide engraving options for cues
You can find options for the project-wide appearance, content, and position of cues on the Cues 
page in Engraving Options.

The options on the Cues page allow you to change the size, appearance, placement, and precise 
position of cues. You can also decide which notations are included in all cues, set the default 
spacing of cues, and set the default staff position of rhythmic cues and cues from unpitched 
percussion source instruments.

You can also change the gap after clefs at the start of cues on the Spacing Gaps page in 
Engraving Options.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Note spacing on page 599
Changing existing cues to rhythmic cues on page 1087

Rhythmic cues
Rhythmic cues only show the rhythm of the source instrument, whether it is pitched or 
unpitched, and are positioned above the staff by default.

Rhythmic cues do not show clef changes, accidentals, or ledger lines. They also do not show 
octave transpositions in their cue labels, even when the destination instrument is octave 
transposing. Their default position outside staff lines ensures they can never be misread as 
containing pitched material.

You can change existing cues into rhythmic cues and vice versa. This causes cues that were 
originally from pitched source instruments to show only the rhythm, which can be helpful when 
multiple instruments play the same rhythm together but on different notes, such as in big band 
music with large unison chords. In this context, showing the pitches of a single instrument in the 
group could be misleading as the destination instrument might think this indicates a distinctive 
melody. You can then change the cue label to include information about the instruments playing 
the rhythm in the cue.

By default, cues from unpitched percussion source instruments are input as rhythmic cues. If 
you want to save vertical space, you can change them to cues from unpitched percussion source 
instruments. This positions them on the middle line of the staff by default.

A rhythmic cue A cue from an unpitched percussion source
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You can change the default staff positions for rhythmic cues and cues from unpitched percussion 
source instruments in the Rhythmic Cues and Unpitched Instruments sections of the Cues 
page in Engraving Options.

You can also change the staff position of rhythmic cues and cues from unpitched percussion 
source instruments individually.

RELATED LINKS
Editing cue label text on page 1094
Changing the staff position of cues from unpitched percussion source instruments on page 1088
Engraving Options dialog on page 840

Changing existing cues to rhythmic cues
Cues normally show pitched material played by a specific instrument. However, you can change 
existing cues showing pitched material into rhythmic cues that only show the rhythm of the 
cued music. This can be helpful for passages where many instruments play the same distinctive 
rhythm together.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the labels of the cues you want to change into rhythmic cues. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Rhythmic cue in the Cues group.

RESULT
The selected cues are shown as rhythmic cues. They are automatically positioned above the staff 
according to your setting for Distance from space above staff in the Rhythmic Cues section of 
the Cues page in Engraving Options.

NOTE

Deactivating Rhythmic cue returns the selected cues back to normal cues. This includes cues 
from unpitched percussion instruments that are automatically input as rhythmic cues.

If you deactivate Rhythmic cue for cues from unpitched percussion instruments, the cues are 
positioned on the middle line of the staff by default.

RELATED LINKS
Inputting cues on page 421
Engrave toolbox on page 514
Engraving Options dialog on page 840

Changing the distance between rhythmic cues and the staff
You can change the distance between individual rhythmic cues and the staff, independently of 
your project-wide setting.
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the labels of the rhythmic cues whose distance from the staff you want to change. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Distance in the Cues group.

3. Change the value in the value field.

RESULT
The position of the selected cues is changed according to the new value. For example, entering 
0 positions rhythmic cues in the space immediately above the top line on the staff. Higher values 
increase the distance between rhythmic cues and the staff.

TIP

You can change the default distance between all rhythmic cues and the top line of the staff 
project-wide on the Cues page in Engraving Options.

RELATED LINKS
Project-wide engraving options for cues on page 1086
Engraving Options dialog on page 840
Engrave toolbox on page 514

Changing the staff position of cues from unpitched percussion 
source instruments

You can change the staff position of cues from unpitched percussion source instruments 
individually, independently of your project-wide setting.

By default, cues from unpitched percussion source instruments that are not rhythmic cues are 
positioned on the middle line of staves.

NOTE

These steps do not apply to rhythmic cues.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the labels of the cues from unpitched percussion source instruments whose staff 
position you want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Unpitched notes pos. in the Cues group.
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3. Change the value in the value field.

RESULT
The staff position of the selected cues is changed according to the new value. For example, 0 is 
the middle line of the staff, 4 is the top line of the staff, and -4 is the bottom line of the staff.

TIP

You can change the default staff position of all cues from unpitched percussion source 
instruments project-wide on the Cues page in Engraving Options.

EXAMPLE

Unpitched cue on the middle line of the staff 
(default)

Unpitched cue at a higher staff position

Hiding/Showing cues in layouts
You can input cues in any layout, but by default cues do not appear in full score layouts in page 
view, as cues are normally only shown in instrumental parts. You can hide/show cues in each 
layout independently.

Cues are always shown in galley view.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show cues.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Cues section, activate/deactivate Show cues.

5. Click Apply, then Close.

RESULT
All cues in the selected layouts are shown when the checkbox is activated, and hidden when the 
checkbox is deactivated.

In layouts where cues are hidden, they are indicated by signposts.

NOTE

● You can hide individual cues in layouts where cues are shown, but you cannot show 
individual cues in layouts where cues are hidden.
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● You can hide/show cue signposts by choosing View > Signposts > Cues.

RELATED LINKS
Signposts on page 453

Hiding/Showing cues individually
You can hide/show individual cues in layouts in which cues are shown. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains. However, you cannot 
show individual cues in layouts where cues are hidden.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to hide/show individual cues.

2. Select the labels of the cues you want to hide, or the signposts of cues you want to show. You 
can do this in Write mode and Engrave mode.

3. In the Properties panel, activate/deactivate Hide in the Cues group.

RESULT
The selected cues are hidden when Hide is activated, and shown when it is deactivated. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Signposts are shown at the position of each hidden cue. However, signposts are not printed by 
default.

RELATED LINKS
Annotations on page 687
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the octave of cues
You can change the octave in which cues are shown so the cue fits better on the staff of 
the destination instrument. This can be useful if the source instrument plays in a significantly 
different octave to the destination instrument. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the labels of the cues whose octave you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Octave shift in the Cues group.

3. Change the value in the value field.

RESULT
The octave of the selected cues is changed. For example, 1 shifts cues up one octave, and -1 
shifts cues down one octave. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

If octave transpositions are shown in the cue labels, they are automatically updated.

EXAMPLE

Cue with no octave change Cue shifted an octave down

Hiding/Showing octave transpositions in cue labels
By default, octave transpositions are included in cue labels when you shift the octaves at 
which cues are shown. You can hide/show octave transpositions in cue labels individually, 
independently of your project-wide setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the cue labels in which you want to hide/show octave transpositions. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show octave transposition in the Cues group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Octave transpositions are shown in the selected cue labels when the checkbox is activated, and 
hidden when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Deactivating the property returns cue labels to your project-wide setting.
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TIP

You can show/hide octave transpositions in all cue labels project-wide on the Cues page in 
Engraving Options.

RELATED LINKS
Changing the information included in cue labels project-wide on page 1093
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Cue contents
The content of individual cues can appear differently in each layout, independently of other 
layouts and without changing the source material, if you make changes in a layout that does not 
contain the source instrument.

Music in cues is dynamically linked to the music in the source instrument. Any changes you make 
to the source music are automatically shown in the cue, but you cannot change the pitch or 
duration of notes within the cue. This ensures that cues are an accurate reflection of the notes 
being played by the cued instrument.

You can make graphical changes to the music in cues without affecting the corresponding music 
in the source instrument. For example, you can adjust the placement of slurs and the angles 
of glissando lines, lengthen/shorten stems in cues, and respell accidentals. You can also change 
the note spacing scale factor of cues for whole layouts and from selected rhythmic positions 
onwards in individual layouts.

NOTE

Graphical changes to cues are layout-specific. For example, if you make changes to a cue within 
a full score layout that also contains the source instrument, your changes to the cue affect 
the corresponding material in the source instrument and other instruments with the same cue 
in the layout. However, if you make changes to a cue in a part layout that only contains the 
destination instrument, the corresponding material in the part layout of the source instrument is 
not affected.

It is also possible to change the enharmonic spelling of notes in cues in Engrave mode in the 
same way as changing the enharmonic spelling of normal notes. If you respell notes in cues in 
the part layout of the destination instrument, the spelling of notes in the source instrument 
is not affected. For example, you can change the enharmonic spelling of notes in cues in 
transposing instrument layouts to avoid double accidentals.

IMPORTANT

If you respell notes in cues in a layout that also contains the source instrument, the enharmonic 
spelling is also changed in the source instrument.

RELATED LINKS
Respelling notes on page 484
Slurs in Engrave mode on page 1522
Lengthening/Shortening stems on page 1279
Note spacing on page 599
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Note Spacing Change dialog on page 602
Changing note spacing from rhythmic positions on page 601

Cue labels
Cue labels usually indicate the source instrument from which the music is taken, but can also 
include other information, such as the transposition interval for transposing instruments. This 
information can help performers identify both where the sound is coming from in the ensemble 
and the type of sound to listen for.

By default, cue labels in Dorico Pro use abbreviated instrument names, exclude instrument 
transpositions, include octave transpositions, and do not show an additional label at the end of 
cues to indicate where players enter after cues. Additional labels showing “Play” at the end of 
cues are sometimes used in jazz scores, where it is customary not to show bar rests alongside 
cues. Showing additional labels at the ends of cues can also be useful in film music, where cues 
are often included in parts as an option that the player might be asked to play.

Cue label for an octave-shifted double bass cue, edited to include "(pizz.)"

You can change the information and text shown in cue labels both project-wide and on an 
individual basis in Dorico Pro.

RELATED LINKS
Moving items graphically on page 609
Instrument changes on page 134
Player labels on page 760
Divisi change labels on page 1577
Inputting cues on page 421

Changing the information included in cue labels project-wide
You can change the information included as text in cue labels project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Cues.

3. In the Cue Labels section, change any of the following options:

● Instrument name in label

● Instrument pitch or transposition

● Octave transposition

● Additional label at end of cue

4. Click Apply, then Close.

RESULT
The information included in cue labels is changed project-wide.
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TIP

You can also edit cue labels individually. For example, if two instruments are playing in unison, 
you can edit the cue label that shows the name of one of the instruments to include both 
instrument names.

Editing cue label text
You can override the text shown in cue labels individually. For example, if two instruments are 
playing in unison, you can change the cue label that shows the name of one of the instruments 
to include both instrument names.

You can also show additional labels at the ends of individual cues, even if your project-wide 
setting is to show no additional labels.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the cue labels whose text you want to edit. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Cues group:

● Start text

● End text

3. Enter the text you want to be shown in the corresponding cue labels into each value field.

For example, to indicate that two violinists are playing the same material but an octave 
apart, you might enter Vln.I & Vln.II coll’ottava in the value field for Start text.

4. Press Return .

RESULT
The cue labels of the selected cues are changed to show the text you entered.

Deactivating the properties returns the corresponding cue labels of the selected cues to their 
default text.

NOTE

Deactivating properties permanently deletes any custom text entered.

RELATED LINKS
Engrave toolbox on page 514
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Notations in cues
It is beneficial to include musically significant notations from the source instrument in cues, as 
they can help performers identify the cued music more easily. However, only certain notations 
are included in cues to avoid overloading performers with too much information.

By default, Dorico Pro includes the following notations in cues:

● Articulations

● Slurs

● Playing techniques

● Ornaments

● Lyrics

You can also include dynamics, fermatas, horizontal lines, and text in cues. However, these are 
not included by default as this information is not usually required to help identify the cued 
material.

To be included in cues, notations must exist within the range of the cued material. For example, 
slurs must begin and end within the cued material to be included in cues.

Similarly, pizzicato markings are not shown in cues if they are input before the first cued 
note. However, pizzicato strings sound significantly different to bowed strings, so omitting this 
information could prevent the player reading the cue from identifying it.

NOTE

● Playing techniques that only indicate important information for the source instrument, such 
as bowing marks for string players, are not included in cues.

● If important playing technique information does not exist within the range of cued material, 
we recommend that you include this information in the corresponding cue labels.

Changing the notations included in cues
You can change the notations included in individual cues, such as slurs and playing techniques, 
independently of your project-wide settings.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the labels of the cues whose included notations you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Cues group of the Properties panel, activate the property for each notation that you 
want to include in, or exclude from, the selected cues.

3. Activate/Deactivate the corresponding checkboxes.

RESULT
The corresponding notations are included in cues when the checkboxes are activated, and 
excluded from cues when the checkboxes are deactivated.

Cues
Notations in cues 

1095
Dorico Pro 4.3.30



NOTE

● Playing techniques that only indicate important information for the source instrument, such 
as bowing marks for string players, are not included in cues.

● You can change which notations are included in all cues project-wide on the Cues page in 
Engraving Options.

RELATED LINKS
Project-wide engraving options for cues on page 1086
Engraving Options dialog on page 840
Editing cue label text on page 1094
Engrave toolbox on page 514

Stem direction in cues
Notes in cues normally have the same stem direction, as cues usually highlight lines containing 
only one voice. Cues are shown by default with bar rests alongside them to indicate that the 
player reading the cue does not play those notes.

If cues contain music in multiple voices, the original stem directions of the source music are 
used. For single-voice cues, Dorico Pro determines the default stem direction depending on the 
pitches in the cue. Stems point downwards when most notes in the cue are at positions below 
the middle line of the staff, and upwards when most notes in the cue are at positions above the 
middle line of the staff.

TIP

You can override the stem directions of notes in single-voice cues individually.

Overlapping cues
Sometimes it is helpful to give players multiple consecutive cues so they can follow passages of 
music more easily. Dorico Pro allows cues to overlap in order to give you flexibility over how to 
give useful information in cues to players.

However, the stem directions of cues are not automatically adjusted when they exist at the same 
rhythmic position as other cues. For example, if you want to show a melody passing from Violin 
1 to Violin 2 that requires the two cues to overlap, and both instruments are shown in up-stem 
voices by default, then the two cues appear with up-stem notes.

You can override the default stem directions of cues individually to make overlapping cues easier 
to read.

Default stem directions in two overlapping cues Overridden stem directions in the cue containing 
lower notes so that its notes are down-stem
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NOTE

You cannot input multiple cues at the same rhythmic position. However, you can input cues at 
different rhythmic positions, then move or lengthen/shorten them so they overlap.

RELATED LINKS
Inputting cues on page 421
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436

Changing the stem direction of cues
You can override the default stem directions of individual single-voice cues. For example, if you 
want some cues that by default had down stems to appear with up stems and bar rests below 
cue notes instead.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the labels or signposts of the cues whose stem direction you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Voice direction in the Cues group.

3. Choose one of the following options:

● Force stems up

● Force stems down

RESULT
The stem direction of all notes in the selected cues is changed.

Deactivating Voice direction returns the selected cues back to their default stem direction.

RELATED LINKS
Engrave toolbox on page 514

Ties in cues
If cues begin in the middle of sustained notes, ties are shown joining to the first note in cues. 
Similarly, if cues end in the middle of sustained notes, ties are shown proceeding from the final 
notes in cues.

For monophonic instruments, these ties are normally positioned correctly by default. However, 
in complex cases, such as cues involving chords, the positions of these ties can require some 
adjustment.

You can edit ties that start before/end after cues in the same way as normal ties in Engrave 
mode.
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RELATED LINKS
Changing the shape/angle of ties on page 1632

Rests in cues
If cues start/end partway through bars, they are padded with cue-sized rests up to bar 
boundaries or up to the next played entry, whichever comes first. This ensures it is clear to 
the player how the rhythm of the cue fits within the time signature and how it relates to their 
existing material.

By default, full-sized bar rests also appear throughout cued passages. This makes it clear that the 
performer does not play the cued notes.

Full-sized bar rests are automatically positioned according to the stem direction of the notes 
in the cue. If cues use up-stem notes, bar rests are positioned below cued notes. If cues use 
down-stem notes, bar rests are positioned above the cued notes.

You can choose not to show bar rests alongside cues. For example, this can be appropriate in 
some jazz scores, or in scores where the cues are provided as potential passages for doubling.

TIP

You can adjust the vertical position of full-sized bar rests individually using Rest pos. in the 
Notes and Rests group of the Properties panel.

RELATED LINKS
Moving rests vertically on page 1492

Hiding/Showing padding rests around cues
You can hide/show padding rests before/after individual cues. Padding rests fill up bars when 
cues start/end partway through bars, so that the full duration of each bar is clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the labels/signposts of the cues whose padding rests you want to hide/show. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide rests around cue in the Cues group.

RESULT
Padding rests before/after the selected cues are hidden when Hide rests around cue is 
activated, and shown when it is deactivated.
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EXAMPLE

Padding rests shown before/after the selected cue Padding rests hidden before/after the selected cue

RELATED LINKS
Implicit vs. explicit rests on page 1488
Engrave toolbox on page 514

Hiding/Showing bar rests in cues
You can hide/show bar rests alongside all cues in each flow in your project.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show bar rests.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Rests.

4. In the Rests in Additional Voices section, choose one of the following options for Bar rests 
in cues:

● Show bar rests

● Omit bar rests

5. Click Apply, then Close.

RESULT
Bar rests alongside cues are hidden/shown in all layouts in the selected flows in your project.

Clef changes in cues
If the music for the source instrument is in a different clef from the destination instrument, 
Dorico Pro automatically inputs a clef change at the start of cues to match the clef used by the 
source instrument, and a restorative clef change at the end of cues to match the original clef 
used by the destination instrument.

Clef changes at the start of cues are positioned differently to normal clef changes.

Cues starting at the beginning of bars
Clef changes appear to the right of barlines.

Restorative clef changes at the ends of cues are positioned like normal clef changes.

Cues crossing system breaks
Original clefs of destination parts are shown in their usual positions at the start of new 
systems.
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Clefs required for cues appear immediately before the first note of the new system, to 
the right of key signatures and time signatures.

When there are multiple adjacent cues, clef changes are created as needed:

● If two adjacent cues use the same clef that is different than the clef in the destination 
instrument, a single clef change appears at the start of the first cue, with a restorative clef at 
the end of the second cue.

● If cues overlap, and the second cue requires a different clef than the first, Dorico Pro creates 
a clef change at the start of the second cue.

● If there are two adjacent cues, the first of which uses a different clef than the destination 
instrument, and the clef property for the second cue is set to None, then the clef change that 
restores the destination instrument’s original clef appears at the end of the first cue.

You can override this automatic behavior for individual clefs using either Concert clef or 
Transposed clef in the Cues group of the Properties panel, depending on whether the layout 
currently open in the music area uses concert or transposed pitch.

Dorico Pro can show the following clefs in cues:

● None

● Treble

● Alto

● Tenor

● Bass

NOTE

● If you select None, the clef of the destination instrument is used instead of the clef of the 
source instrument.

● Any clef changes that occur in the source instrument in the middle of cued passages are not 
included in the cue in the destination instrument.

Changing the clef shown in cues
You can change the clef shown in individual cues, independently of your project-wide settings.

You can show different clefs for the same cue in each layout in which it appears. For example, 
you can show a cue with a treble clef in a full score layout but with a bass F clef in the 
corresponding part layout.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In the music area, open the layout in which you want to change the clef shown in cues. You 
can do this in Write mode and Engrave mode.

2. Select the labels of the cues whose clef you want to change.

3. In the Properties panel, activate one of the following properties in the Cues group:

● Concert clef: Shown if the layout uses concert pitch
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● Transposed clef: Shown if the layout uses transposed pitch

4. Select one of the following clefs from the menu:

● None: Uses the clef of the destination instrument instead of the clef of the source 
instrument.

● Treble

● Alto

● Tenor

● Bass

The same clefs are available for each property.

RESULT
The clef shown in the selected cues is changed.

TIP

You can change whether the clef of the source instrument or destination instrument is used in all 
cues project-wide on the Cues page in Engraving Options.

RELATED LINKS
Project-wide engraving options for cues on page 1086
Engraving Options dialog on page 840
Engrave toolbox on page 514

Viewing options for cues
You can highlight cues and/or show cued material in a different color to normal notes in your 
project to help you identify cues more easily as you are working.

NOTE

In layouts where cues are hidden, they are indicated by signposts. You can hide/show cue 
signposts by choosing View > Signposts > Cues.

RELATED LINKS
Hiding/Showing cue suggestion highlights on page 1102
Hiding/Showing cue note colors on page 1103
Signposts on page 453

Hiding/Showing cue highlights
You can hide/show highlights on bars where cues exist, which can help you get an overview of 
where you have already added cues and which instruments are used as the source of cues.

Bars containing cues on destination instrument staves are shown with a translucent yellow 
highlight, and the corresponding bars on the source instrument staves are shown with a 
translucent blue highlight.

As you zoom out, the highlights become more opaque. This is especially useful when viewing full 
score layouts in galley view.

Cues
Viewing options for cues 
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NOTE

In page view, cue highlights only appear in layouts where cues are shown.

PROCEDURE

● Choose View > Highlight Cues.

RESULT
Highlights on bars containing cues are hidden/shown.

EXAMPLE

Cue highlights shown on source staff and destination staff

RELATED LINKS
Hiding/Showing cues in layouts on page 1089

Hiding/Showing cue suggestion highlights
You can hide/show highlights on bars where cues are suggested, which can help you find 
suitable locations for cues.

Cue suggestions are shown with a translucent red highlight. As you zoom out, the highlights 
become more opaque. This is especially useful when viewing full score layouts in galley view.

PROCEDURE

1. In Write mode, click Panels , then Cues  in the Notations toolbox to show the Cues 
panel.

2. In the Suggest Cues section, activate/deactivate Highlight suggestions.

RESULT
Cue suggestion highlights are hidden/shown.

Cues
Viewing options for cues 
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EXAMPLE

Cue suggestion highlights shown

RELATED LINKS
Notations toolbox on page 202
Cues panel on page 423
Cue suggestions on page 423
Inputting cues using cue suggestions on page 425

Hiding/Showing cue note colors
You can show the material in cues, including notes and rests, in gray to help you identify cues. 
Cued material cannot be edited directly.

Cue note colors are considered annotations and are not printed by default.

NOTE

Cue note colors only appear in layouts where cues are shown.

PROCEDURE

● Choose View > Note And Rest Colors > Cues.

RESULT
Cue note colors are hidden/shown.

EXAMPLE

Cue note colors shown

Cues
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Dynamics

Dynamics indicate the loudness of the music and can be combined with expressive text to 
give further clarification about how to perform the music. Dynamics can indicate an immediate 
change in volume or a gradual change over a specified duration.

A phrase with multiple different dynamics

You can add modifiers to dynamics that can give stylistic direction context alongside the 
volume level, such as  espressivo, which indicates that a passage is played loudly but also with 
expressive feeling.

While almost all expressive text is written in italics, dynamics such as  and  use a bold italic 
font.

RELATED LINKS
Input methods for dynamics on page 310
Positions of dynamics on page 1105
Gradual dynamics on page 1120
Messa di voce hairpins on page 1127
Niente markings on page 1129
Dynamic modifiers on page 1116
Voice-specific dynamics on page 1115
Groups of dynamics on page 1132
Linked dynamics on page 1133
Dynamics editor on page 799

Types of dynamics
Dorico Pro categorizes dynamics into different groups according to their function.

Immediate dynamics
Immediate dynamics apply to the note to which they are attached until the next 
dynamic marking, and indicate an immediate change from any previous dynamic. 
Immediate dynamics include dynamic symbols, such as  or , and dynamic 
modifiers, such as subito or molto.

Gradual dynamics and hairpins
Gradual dynamics indicate a change in volume that happens incrementally over the 
specified duration. They usually appear either as hairpins or as text instructions, such 
as cresc. or dim..
Gradual dynamics can also have dynamic modifiers that qualify the change in volume, 
such as poco, molto, poco a poco, and niente.
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In Dorico Pro, a hairpin can be shown as messa di voce, which shows a pair of hairpins. 
In some cases, this is easier than having separate lines for each half of the pair.

Force/Intensity of attack
These dynamics, such as  and , indicate that a note has a stronger attack than is 
usually expected for the dynamic, similar to an accent articulation.

Combined dynamics
Combined dynamics, such as  or –, specify a sudden change of dynamic.

You can create custom combined dynamics in Dorico Pro, and control the intensity of 
each dynamic in the pair, in the Combined Dynamics section of the Dynamics panel. 
For example, you can make dynamics such as , –, and .

NOTE

Combined dynamics must include one  level and one  level.

RELATED LINKS
Gradual dynamics on page 1120
Messa di voce hairpins on page 1127
Niente markings on page 1129
Dynamic modifiers on page 1116
Hiding/Showing immediate dynamics on page 1113
Changing the appearance/position of subito modifiers on page 1118
Changing the appearance of sforzando/rinforzando dynamics on page 1115
Hiding/Showing combined dynamic separators on page 1114

Project-wide engraving options for dynamics
You can find options for the project-wide appearance and position of dynamics on the Dynamics 
page in Engraving Options.

The options on the Dynamics page allow you to change the appearance of dynamics and 
gradual dynamics, and their default positions relative to noteheads, barlines, lyrics, and the ends 
of systems.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Positions of dynamics
By default, dynamics are placed below instrumental staves, where they can be read alongside the 
notes, and above vocal staves. This way, they do not clash with lyrics placed below the staff, and 
are still close enough to the notes to be read simultaneously.

Immediate dynamics, such as  or , are centered on the notehead to which they apply. 
The beginnings of gradual dynamics are centered on the notehead from which they begin, or 
immediately after an immediate dynamic at the same position. The ends of gradual dynamics are 
centered on the notehead at which they end, or immediately before an immediate dynamic at 
the same position.

Dynamics
Project-wide engraving options for dynamics 
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The staff-relative placement of dynamics varies, depending on their function and the type of 
player. For example, dynamics are placed below instrumental staves and above vocal staves by 
default. This ensures dynamics are kept as close to the staff as possible for legibility but are not 
placed between noteheads and lyrics on vocal staves. For grand staff instruments, such as piano 
or harp, dynamics are usually placed between the two staves, but can be placed both above and 
below when each staff requires separate dynamics.

In general, dynamics are not placed within the staff, as hairpins in particular become very hard 
to read. They are also not usually placed within tuplet brackets. Dynamics are placed outside of 
notations such as slurs, which must be kept close to noteheads, but inside pedal lines, which can 
be placed further from noteheads and still be clearly understood.

You can move dynamics to different rhythmic positions in Write mode. They are positioned by 
default according to your settings in Engraving Options.

NOTE

When using the mouse, you can only move and lengthen/shorten dynamics to noteheads. When 
using the keyboard, you can move and lengthen/shorten dynamics according to the current 
rhythmic grid resolution.

You can move dynamics graphically in Engrave mode; however, this does not change the 
rhythmic positions to which they are attached.

You can change the default positions of all dynamics project-wide, and their positions relative to 
beats, barlines, system ends, the staff, and other objects on the Dynamics page in Engraving 
Options.

RELATED LINKS
Engraving Options dialog on page 840
General placement conventions for hairpins relative to barlines on page 1108
Changing the alignment of dynamics relative to noteheads on page 1107
Moving the center of messa di voce hairpins on page 1128
Changing the staff-relative placement of items on page 441
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436
Moving items graphically on page 609
Gradual dynamics in Engrave mode on page 1121
Gradual dynamics on page 1120
Messa di voce hairpins on page 1127
Niente markings on page 1129

Changing the horizontal beat-relative position of dynamics
You can position individual dynamics before or after the beat. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Dynamics
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PROCEDURE

1. Select the dynamics whose position relative to the beat you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Beat-relative position in the Dynamics group.

3. Choose one of the following options:

● Before

● After

RESULT
The beat-relative position of the selected dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

A dynamic positioned before the beat A dynamic positioned after the beat

RELATED LINKS
Erasing the background of dynamics on page 1110
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the alignment of dynamics relative to noteheads
Immediate dynamics, such as  and , are usually horizontally aligned with the optical 
center of noteheads. However, you can change the horizontal alignment of immediate dynamics 
individually, independently of your project-wide setting. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose alignment relative to noteheads you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Text alignment in the Dynamics group.

3. Choose one of the following options:

● Align optical center with notehead 

Dynamics
Positions of dynamics 
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● Left-align with notehead 

● Align optical center with left of notehead 

RESULT
The alignment of the selected immediate dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default alignment of all immediate dynamics relative to noteheads project-
wide in the Horizontal Position section of the Dynamics page in Engraving Options.

Aligning dynamics
You can graphically align individually selected dynamics in a row without grouping/ungrouping 
them; for example, if system breaks in part layouts are different to the full score layout and so 
require parts of different groups of dynamics to be aligned. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the dynamics you want to align.

2. Choose Edit > Notations > Dynamics > Align Dynamics. You can also choose this option 
from the context menu.

RESULT
The selected dynamics are aligned in a row with the dynamic within the selection that was 
furthest from the staff. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

RELATED LINKS
Groups of dynamics on page 1132
Engrave toolbox on page 514

General placement conventions for hairpins relative to barlines
In Dorico Pro, the ends of hairpins align with the left edge of the note to their right. This can 
include hairpins extending across barlines.

Hairpins that end on the first note of a bar extend across the preceding barline in the following 
cases:

● If there is no immediate dynamic on the first note in the next bar.

● If there is a time signature or key signature change at the barline that increases the gap 
between the end of the current bar and the first note in the new bar.

Dorico Pro avoids hairpins overlapping barlines by a small amount, as this is less visually clear. 
However, this means that the same dynamic phrase on different staves can appear differently if 
one of the staves does not have a barline join extending below it.

Dynamics
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The hairpin ends are not aligned because the barline does not extend beyond the bottom staff

You can allow/disallow hairpins across barlines if the hairpin ends on the first note in the 
next bar. Disallowing hairpins across barlines ensures hairpins appear the same length on all 
staves. You can also change the minimum distance before hairpins are allowed to extend beyond 
barlines.

Allowing/Disallowing hairpins across barlines
You can allow/disallow hairpins across barlines when they end on the first note in the next bar; 
for example, so all hairpins appear the same length across multiple staves that do not all have 
barline joins. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins you want to allow/disallow across barlines. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Barline interaction in the Dynamics group.

3. Choose one of the following options:

● Stop before

● Continue

RESULT
The selected hairpins are allowed across barlines when you choose Continue, and disallowed 
when you choose Stop before. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

Deactivating the property returns the selected hairpins to your project-wide setting.

Dynamics
Positions of dynamics 
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TIP

You can allow/disallow all hairpins project-wide to cross barlines in Engraving Options > 
Dynamics > Gradual Dynamics > Hairpins > Advanced Options. You can also change the 
minimum distance before hairpins are allowed to extend beyond barlines in the Horizontal 
Position section.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840

Parenthesizing dynamics
You can show individual dynamics in parentheses; for example, to indicate editorial dynamics 
that were not in the original manuscript. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics you want to parenthesize. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Parenthesized in the Dynamics group.

RESULT
Parentheses are shown around each selected dynamic. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Deactivating Parenthesized removes parentheses from the selected dynamics.

Erasing the background of dynamics
You can erase the background of individual dynamics; for example, to ensure dynamics remain 
legible when crossing barlines. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Dynamics
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PROCEDURE

1. In Engrave mode, select the dynamics whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Dynamics group.

RESULT
The backgrounds of the selected dynamics are erased. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns the selected dynamics to the default non-erased 
background.

NOTE

This does not affect hairpins, including stems crossed by hairpins.

EXAMPLE

Dynamic with non-erased background Dynamic with erased background

AFTER COMPLETING THIS TASK
You can change the padding between dynamics and each edge of their erased areas.

RELATED LINKS
Positions of dynamics on page 1105
Engrave toolbox on page 514
Erasing the background of stems on page 1281
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Dynamic modifiers on page 1116

Changing the erasure padding of dynamics
You can change the erasure padding of individual dynamics, including changing the padding 
between dynamics and each edge of their erased areas independently. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

Erasure padding considers the prefix/suffix separately from immediate dynamics and also takes 
into account ascenders/descenders in the text. This can cause the erasure padding to appear 
larger below the dynamic than above, such as for “espressivo” due to the “p”. In such cases, you 
can change the padding on the affected edge to make the padding appear symmetrical.

PREREQUISITE

● The lower zone is shown.

Dynamics
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● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the dynamics whose erasure padding you want to change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Dynamics group.

● L changes the padding between dynamics and their left edge.

● R changes the padding between dynamics and their right edge.

● T changes the padding between dynamics and their top edge.

● B changes the padding between dynamics and their bottom edge.

3. Change the values in the value fields.

RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. This 
also affects the area considered for collision avoidance. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can change the default erasure padding of all dynamics project-wide in the Appearance 
section of the Dynamics page in Engraving Options. However, this does not allow you to 
change the padding of each edge independently.

Changing dynamic levels
You can change the levels of dynamics without reopening the dynamics popover and for multiple 
different dynamics simultaneously; for example, if you want to increase the dynamic level of all 
dynamics in a phrase.

PROCEDURE

1. In Write mode, select the dynamics whose dynamic level you want to change.

2. Change the dynamic level in one of the following ways:

● To increase the dynamic level, choose Edit > Notations > Dynamics > Increase 
Dynamic Intensity.

● To decrease the dynamic level, choose Edit > Notations > Dynamics > Decrease 
Dynamic Intensity.

TIP

You can also choose these options from the context menu.

RESULT
The dynamic level of the selected dynamics is increased/decreased. For example, increasing the 
dynamic level of a  dynamic changes it to .

Dynamics
Changing dynamic levels 

1112
Dorico Pro 4.3.30



TIP

You can assign key commands for these options on the Key Commands page in Preferences.

RELATED LINKS
Input methods for dynamics on page 310
Dynamics editor on page 799
Changing existing items on page 439
Dynamic modifiers on page 1116
Key Commands page in the Preferences dialog on page 63

Hiding/Showing immediate dynamics
You can hide/show individual immediate dynamics such as  and ; for example, if you 
only want to show the dynamic modifier, such as “sim.”, without its accompanying immediate 
dynamic. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the immediate dynamics you want to hide, or the signposts of immediate dynamics 
you want to show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide intensity marking in the Dynamics group.

RESULT
The selected immediate dynamics are hidden when Hide intensity marking is activated, and 
shown when it is deactivated. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

If no other dynamic exists at their rhythmic position, they are indicated by signposts. However, 
signposts are not printed by default.

RELATED LINKS
Dynamic modifiers on page 1116
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Signposts on page 453
Annotations on page 687
Input methods for dynamics on page 310

Dynamics
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Hiding/Showing combined dynamic separators
You can hide/show different separators in combined dynamics individually, independently of 
your project-wide setting. For example, if you want to separate some  dynamics with slashes. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

By default, only combined dynamics with at least one mezzo dynamic in the pair, such as -, 
show a separator.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the combined dynamics whose separator you want to hide/show. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Separator shown in the Dynamics group.

3. Activate/Deactivate the corresponding checkbox.

4. Optional: If you showed separators, activate Separator and select one of the following 
options from the menu:

● Hyphen

● Colon

● Space

● Slash

RESULT
Separators are shown when the Separator shown checkbox is activated, and hidden when it is 
deactivated. The separator shown follows your selection for Separator. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

When Separator shown and Separator are deactivated, combined dynamic separators follow 
your project-wide settings.

TIP

You can change the default separator for combined dynamics and whether separators are shown 
for all combined dynamics or only mezzo combined dynamics project-wide on the Dynamics 
page in Engraving Options.

RELATED LINKS
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840
Types of dynamics on page 1104
Changing the appearance/position of subito modifiers on page 1118

Dynamics
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Changing the appearance of sforzando/rinforzando 
dynamics

You can change the appearance of individual  and  dynamics, independently of your project-
wide setting. For example, if you want some  dynamics to appear as . You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps do not apply to force/intensity of attack dynamics with other intensities, such as .

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the  and/or  dynamics whose appearance you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate rfz/sfz style in the Dynamics group.

3. Choose one of the following options:

●  
●  

RESULT
The appearance of the selected  and/or  dynamics is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default appearance of all  and  dynamics project-wide on the Dynamics 
page in Engraving Options.

RELATED LINKS
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840
Types of dynamics on page 1104
Changing the appearance/position of subito modifiers on page 1118

Voice-specific dynamics
Voice-specific dynamics only apply to a single voice on a staff, which allows you to specify 
different dynamics for each voice in multiple-voice contexts or for the separate staves of grand 
staff instruments. By default, dynamics apply to all voices on all staves belonging to a single 
instrument, including grand staff instruments.

Inputting voice-specific dynamics allows you to show different dynamics for multiple voices 
on a staff, or to highlight an inner melody voice in a piano part. Similarly, they allow you to 
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give different dynamics to each staff for instruments with extra staves. Voice-specific dynamics 
change the dynamics of each voice in playback independently.

NOTE

● You can only input voice-specific dynamics when the caret is active, such as during note 
input. Voice-specific dynamics apply to the voice indicated by the quarter note symbol beside 
the caret.

● Voice-specific dynamics only affect playback automatically for sounds that use velocity to 
control dynamics. When using playback devices that control dynamics in other ways, such as 
with CC, you must enable independent voice playback to hear different dynamics in different 
voices for the same instrument.

RELATED LINKS
Input methods for dynamics on page 310
Caret on page 215
Enabling independent voice playback on page 636
Dynamics editor on page 799
Extra staves on page 1552

Dynamic modifiers
Modifiers add further detail to dynamics than simply their volume level, and can help guide how 
a player performs a note or phrase. Modifiers include poco a poco, molto and subito. They are also 
known as “expressive text”.

Modifiers accompanying immediate and gradual dynamics

In Dorico Pro, modifiers must accompany either a dynamic level, such as  or , or a gradual 
dynamic.

You can input dynamic modifiers by entering them into the dynamics popover alongside an 
immediate dynamic or by clicking available options in the Dynamics panel. You can also add 
dynamic modifiers to existing dynamics.

You can add modifiers both before and after immediate dynamics. Modifiers can also appear 
either inside hairpins or above/below the start of hairpins.

TIP

● You can hide immediate dynamics if you only want to show the modifier.

● You can change the default appearance and position of modifiers, such as subito and 
possibile, on the Dynamics page in Engraving Options.

RELATED LINKS
Input methods for dynamics on page 310
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840
Hiding/Showing immediate dynamics on page 1113
Adding poco a poco text to gradual dynamics on page 1126

Dynamics
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Changing the appearance/position of subito modifiers on page 1118
Showing modifiers centered inside hairpins on page 1118
Changing the appearance of sforzando/rinforzando dynamics on page 1115
Showing consecutive hairpins as continuous on page 1123

Adding modifiers to existing dynamics
You can add modifiers both before and after dynamics after they have been input; for example, if 
you want to add “sim.” instead of repeating dynamics across multiple phrases.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the dynamics to which you want to add modifiers. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Dynamics group:

● To add modifiers before dynamics, activate Prefix.

● To add modifiers after dynamics, activate Suffix.

3. Enter the text you want to add into the corresponding value field.

4. Press Return .

RESULT
The text you entered is added to the selected dynamics as a modifier. Text entered into the 
Prefix field appears before immediate dynamics, while text entered into the Suffix field appears 
after immediate dynamics.

Modifiers appear below hairpins placed below the staff and above hairpins placed above the 
staff, and are aligned with the start of the hairpin.

Deactivating the properties removes the corresponding modifiers from the selected dynamics.

NOTE

Deactivating properties permanently deletes any custom text entered.

AFTER COMPLETING THIS TASK
If you added modifiers to hairpins, you can show them centered inside the hairpins.

RELATED LINKS
Engrave toolbox on page 514
Niente markings on page 1129
Input methods for dynamics on page 310
Showing modifiers centered inside hairpins on page 1118
Adding poco a poco text to gradual dynamics on page 1126
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Changing the appearance/position of subito modifiers
You can change the appearance and/or position of individual subito modifiers, independently of 
your project-wide settings. For example, if you want to show subito modifiers as sub. on the left of 
dynamics, or  sub. dynamics as . You can do this for the current layout and frame chain only, 
or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose subito modifier appearance and/or position you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Subito style in the Dynamics group and choose one of the 
following options:

● subito

● sub.

3. Optional: If you selected dynamics that include at least one , activate Subito forte style and 
choose one of the following options:

● sub. 
● 

4. Activate Subito position and choose one of the following options:

● Left

● Right

RESULT
The appearance and/or position of the selected subito modifiers is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default appearance of subito modifiers and their position relative to 
dynamics on the Dynamics page in Engraving Options.

RELATED LINKS
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840
Changing the appearance of sforzando/rinforzando dynamics on page 1115
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Showing modifiers centered inside hairpins
You can show modifiers you have added to hairpins, such as poco a poco or molto, centered both 
horizontally and vertically inside hairpins. You can do this for the current layout and frame chain 
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only, or for all layouts and frame chains. By default, modifiers appear at the start of and either 
above or below hairpins.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins whose modifiers you want to show centered inside hairpins. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Modifier position in the Dynamics group.

3. Choose one of the following options:

● Above or Below

● Inside

RESULT
Modifiers on the selected hairpins appear centered inside the hairpins. They automatically erase 
their background so the text does not collide with the hairpin lines. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

TIP

● You can change the default position of all modifiers relative to hairpins in the Gradual 
Dynamics section of the Dynamics page in Engraving Options.

● You can change the erasure padding of modifiers centered inside hairpins, both individually 
and by changing your default settings.

EXAMPLE

Modifier (molto) below a hairpin Modifier (molto) centered inside hairpin

RELATED LINKS
Adding modifiers to existing dynamics on page 1117
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840
Changing the erasure padding of dynamics on page 1111
Showing consecutive hairpins as continuous on page 1123
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Gradual dynamics
Gradual dynamics indicate a change in volume that happens incrementally over the specified 
duration. They usually appear either as hairpins or as text instructions, such as cresc. or dim..

The change in volume indicated by individual hairpins is shown in the distance between the two 
diverging lines at their apertures.

Hairpins typically have a closed end and an open end. If the hairpin crosses a system or frame 
break, the closed end appears with a small gap so that the hairpin is not misread as two separate 
hairpins.

A pair of hairpins without an immediate dynamic in the middle is known as a messa di voce.

A phrase containing multiple gradual dynamics

In Dorico Pro, gradual dynamics appear as hairpins by default. You can change the appearance 
of individual gradual dynamics and their default appearance project-wide. For example, if you 
want to show a particularly long crescendo using cresc. text rather than a hairpin.

You can show gradual dynamic text in the following ways:

● cresc. or dim.: Abbreviated text with no continuation line

● cresc... or dim...: Abbreviated text with a dotted continuation line

● cre-scen-do or di-mi-nuen-do: The full word spread out across the duration of the gradual 
dynamic

You can also show two or more consecutive hairpins of the same direction that are separated by 
immediate dynamics as a single, continuous hairpin.

In Write mode, ungrouped gradual dynamics each have start and end handles that show their 
duration.

NOTE

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can find options for the default appearance and position of all gradual dynamics project-
wide on the Dynamics page in Engraving Options.
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RELATED LINKS
Input methods for dynamics on page 310
Types of dynamics on page 1104
Messa di voce hairpins on page 1127
Niente markings on page 1129
Groups of dynamics on page 1132
Gradual dynamics in Engrave mode on page 1121
Changing the appearance of gradual dynamics on page 1122
Engraving Options dialog on page 840
Moving items graphically on page 609
General placement conventions for hairpins relative to barlines on page 1108
Showing consecutive hairpins as continuous on page 1123
Moving the center of messa di voce hairpins on page 1128
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436

Gradual dynamics in Engrave mode
In Engrave mode, each hairpin has multiple handles that you can move to adjust their graphical 
position, length, angle, and aperture.

● The middle handles at the start/end of hairpins change their start/end offset positions. 
Moving one middle handle changes the angle of the hairpin.

● The pair of outer handles at the start/end of hairpins, and in the center of messa di voce 
hairpins, adjusts the corresponding aperture. These handles are linked and mirror each 
other: moving one handle also moves the other handle by the same amount, but in the 
opposite direction. This ensures that hairpins remain symmetrical.

A hairpin with the start middle handle selected in 
Engrave mode

A messa di voce hairpin with a center aperture handle 
selected in Engrave mode

NOTE

● You can also change the aperture of individual hairpins by activating Hairpin open aperture 
and/or Hairpin closed aperture in the Dynamics group of the Properties panel.

Increasing the value makes the corresponding aperture wider. Decreasing the value makes 
the corresponding aperture narrower.

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

You can move separate hairpins independently; for example, if you want to adjust the 
graphical peak of a pair of hairpins. You cannot move the graphical peak of messa di voce 
hairpins, except by adjusting the note spacing.
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EXAMPLE

A diminuendo that goes across a system break: 
aperture at the start is open, aperture at the end 
is closed. It appears slightly open to indicate the 
diminuendo continues after the system break.

The diminuendo continues onto a new system: 
aperture at the start is open, aperture at the end is 
closed.

RELATED LINKS
Input methods for dynamics on page 310
Groups of dynamics on page 1132
Niente markings on page 1129
Messa di voce hairpins on page 1127
Moving items graphically on page 609
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436
Note spacing on page 599
Adjusting note spacing at individual rhythmic positions on page 604

Changing the appearance of gradual dynamics
You can change the appearance of individual gradual dynamics; for example, to show a 
particularly long crescendo using “cresc.” text rather than a hairpin. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the gradual dynamics whose appearance you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Gradual style in the Dynamics group.

3. Select one of the following options from the menu:

● Hairpin

● cresc./dim.

● cresc...

● cre - scen - do

4. Optional: Customize the appearance of the selected gradual dynamics in one of the following 
ways, depending on their Gradual style:

● If you selected Hairpin, activate Hairpin line style and choose one of the available 
options.
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● If you selected cresc./dim., cresc..., or cre - scen - do, activate Diminuendo style and 
select one of the available options from the menu.

● If you selected cresc..., activate Continuation line style and choose one of the available 
options.

RESULT
The appearance of the selected gradual dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default appearance of all gradual dynamics project-wide on the Dynamics 
page in Engraving Options.

EXAMPLE

Hairpin cresc./dim. cresc…. cre - scen - do

RELATED LINKS
Showing modifiers centered inside hairpins on page 1118
Turning existing gradual dynamics into messa di voce hairpins on page 1129
Adding niente markings to existing gradual dynamics on page 1130

Showing consecutive hairpins as continuous
You can show two or more consecutive hairpins of the same direction that are separated by 
immediate dynamics as a single hairpin that continues through any immediate dynamics; for 
example, to indicate that you want a single smooth change in dynamic rather than multiple 
separate ones. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The hairpins are grouped together.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select at least one of the hairpins in each group that you want to show as 
continuous.

2. In the Properties panel, activate Hairpin shown as continuation in the Dynamics group.

3. Activate the corresponding checkbox.
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RESULT
Consecutive hairpins of the same direction in the selected groups appear as a single continuous 
hairpin. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

TIP

You can change whether or not all consecutive hairpins of the same direction separated by 
immediate dynamics appear as continuous by default in Engraving Options > Dynamics > 
Gradual Dynamics > Hairpins.

EXAMPLE

Hairpin not shown as continuation Hairpin shown as continuation

RELATED LINKS
Project-wide engraving options for dynamics on page 1105
Grouping dynamics together on page 1133
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Hiding/Showing flared ends on hairpins
Flared ends are usually shown at the end of crescendo hairpins and indicate a sudden burst in 
volume at the end of the crescendo. You can hide/show flared ends on any hairpin.

NOTE

You can only show flared ends on hairpins with solid lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the hairpins on which you want to hide/show flared ends. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate/deactivate Flared end in the Dynamics group.

RESULT
A flared end is shown on the selected dynamics when Flared end is activated, and hidden when 
it is deactivated.
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EXAMPLE

Crescendo hairpin with flared end hidden Crescendo hairpin with flared end shown

RELATED LINKS
Engrave toolbox on page 514

Changing the size of flared ends on hairpins
You can change the height and width of flared ends on individual hairpins. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the flared hairpins whose flare size you want to change.

2. In the Properties panel, activate Flare size in the Dynamics group.

3. Change the flare size of the selected hairpins in any of the following ways:

● To change the width of the flared ends, change the value for W.

● To change the height of the flared ends, change the value for H.

RESULT
The size of the flared ends on the selected hairpins is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

● Increasing the W value makes the selected flared ends wider by starting their angle earlier in 
the hairpin, decreasing the value makes the selected flared ends narrower.

● Increasing the H value makes the selected flared ends taller, decreasing the value makes 
them shorter.

● Changing the values independently of each other changes the angle of the flared ends. For 
example, increasing the W value without changing the H value makes the angle shallower.

TIP

You can change the default design and size of all flared hairpins project-wide in the Gradual 
Dynamics section of the Dynamics page in Engraving Options.

RELATED LINKS
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840
Moving items graphically on page 609
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Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Adding poco a poco text to gradual dynamics
You can add poco a poco text to individual gradual dynamics after they have been input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual dynamics to which you want to add poco a poco. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Poco a poco (little by little) in the Dynamics group.

RESULT
Poco a poco is shown immediately after gradual dynamic text, below hairpins placed below the 
staff, and above hairpins placed above the staff.

Deactivating Poco a poco (little by little) removes poco a poco text from the selected gradual 
dynamics.

EXAMPLE

Text gradual dynamic with poco a poco Hairpin gradual dynamic with poco a poco

AFTER COMPLETING THIS TASK
You can show poco a poco text centered inside hairpins.

RELATED LINKS
Dynamic modifiers on page 1116
Showing modifiers centered inside hairpins on page 1118
Engrave toolbox on page 514

Gradual dynamic spacing
Dorico Pro ensures that hairpins can always be clearly distinguished by giving hairpins a 
minimum default length. However, this can affect note spacing.

The default minimum hairpin length is three spaces. When hairpins are shorter than this, they 
can sometimes be confused with the accent articulation mark. Therefore, if you add a hairpin 
to a note which would make the hairpin less than three spaces long, the spacing of the note is 
changed to ensure the hairpin meets the minimum length.
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You can change the minimum length of all hairpins project-wide in Engraving Options > 
Dynamics > Gradual Dynamics > Hairpins > Advanced Options.

RELATED LINKS
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840
Gradual dynamics in Engrave mode on page 1121
Moving the center of messa di voce hairpins on page 1128

Gradual dynamics truncated by immediate dynamics
A hairpin is automatically truncated if an immediate dynamic is positioned within its range, either 
before or after the hairpin is input.

The hairpin remains tied to its originally designated rhythmic positions, even if graphically it 
appears shorter. This means that if the immediate dynamic that truncated it is ever deleted, the 
hairpin extends up to its end or the next immediate dynamic within its range.

The examples demonstrate a crescendo hairpin that is truncated by two dynamics, but the 
hairpin extends to its total length as they are deleted. The dotted attachment line shows the link 
between the hairpin and the rhythmic position to which its end is attached.

A long hairpin truncated by a  After deleting the , the hairpin is 
now truncated by the 

Deleting both immediate 
dynamics allows the hairpin to 
extend to its full length

RELATED LINKS
Showing consecutive hairpins as continuous on page 1123
Lengthening/Shortening items on page 436

Messa di voce hairpins
Messa di voce hairpins are single gradual dynamic items that appear as a pair of hairpins without 
an immediate dynamic in the middle. They indicate that within their duration, the volume either 
increases then decreases, or decreases then increases.

A phrase containing two messa di voce hairpins

In Write mode, messa di voce hairpins have three handles: one at the start, one at the end, and 
one in the center. This is different to separate, ungrouped hairpins, which each have a handle at 
the start and end.
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In Engrave mode, messa di voce hairpins have center handles that control their center aperture 
only. You cannot move the graphical peak of messa di voce hairpins, except by adjusting the note 
spacing.

RELATED LINKS
Input methods for dynamics on page 310
Groups of dynamics on page 1132
Gradual dynamics in Engrave mode on page 1121
Note spacing on page 599

Moving the center of messa di voce hairpins
You can move the center of individual messa di voce hairpins rhythmically; for example, if you 
want them to peak on different notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the messa di voce hairpins whose center you want to move. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Messa di voce inflection in the Dynamics group.

3. Move the center of the selected messa di voce hairpins in any of the following ways:

● To move them to the right, increase the value in the left value field.

● To move them to the left, decrease the value in the left value field.

● To move them to the left to grace notes at the rhythmic position set by the left value 
field, decrease the value in the right value field.

TIP

1 represents a quarter note.

RESULT
The centers of the selected messa di voce hairpins are moved rhythmically.

TIP

In Write mode, you can also click and drag messa di voce hairpin center handles to noteheads to 
the right/left.

EXAMPLE
For example, entering 1 1/2 into the left value field and -1/2 into the right value field moves 
messa di voce hairpin centers a dotted quarter note to the right of their start position, and to the 
first of two sixteenth grace notes at that rhythmic position.
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RELATED LINKS
Hiding/Showing zones on page 47
Properties panel on page 769
Grace notes on page 1193
Showing grace notes before/after barlines on page 1196
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436

Turning existing gradual dynamics into messa di voce hairpins
You can turn existing gradual dynamics into messa di voce hairpins; for example, if you change 
your mind about the dynamic phrasing in some bars.

PROCEDURE

1. Select the gradual dynamics that you want to turn into messa di voce hairpins. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, choose Messa di voce for Type in the Dynamics group.

RESULT
The selected gradual dynamics are turned into messa di voce hairpins. The first direction follows 
the previous overall direction of the selected gradual dynamics.

TIP

You can also turn existing gradual dynamics into messa di voce hairpins by selecting them and 
clicking the corresponding buttons in the Gradual Dynamics section of the Dynamics panel.

You can also press Shift-Alt/Opt-,  for a crescendo/diminuendo messa di voce hairpin, or Shift-
Alt/Opt-.  for a diminuendo/crescendo messa di voce hairpin.

RELATED LINKS
Hiding/Showing zones on page 47
Properties panel on page 769
Dynamics panel on page 313
Inputting dynamics with the popover on page 314
Inputting dynamics with the panel on page 316
Grace notes on page 1193

Niente markings
Niente markings at the start/end of gradual dynamics indicate that the dynamic either increases 
from, or decreases to, silence.

This effect works very well on strings and singers with vowels, but it cannot always be played 
literally. For example, singers with words beginning with consonants cannot begin from silence, 
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nor can reed and brass instruments, as they have to achieve a certain air pressure before a note 
sounds.

Niente markings can be shown in the following ways, depending on the gradual dynamic style:

● For hairpins, niente markings can be shown as either a circle, or the letter “n”.

● For text gradual dynamics, niente markings appear as “dal niente” for crescendos, and as “al 
niente” for diminuendos.

You can input gradual dynamics with niente markings in the same ways as inputting other 
dynamics. You can also add niente markings to existing gradual dynamics.

EXAMPLE

Circle niente marking Letter niente marking Niente marking alongside a text 
gradual dynamic

RELATED LINKS
Input methods for dynamics on page 310
Changing the appearance of niente hairpins on page 1131
Gradual dynamics in Engrave mode on page 1121
Lengthening/Shortening items on page 436
Showing consecutive hairpins as continuous on page 1123

Adding niente markings to existing gradual dynamics
You can add niente markings to, and remove them from, existing gradual dynamics; for example, 
if you change your mind about which diminuendos should decrease to silence.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual dynamics to which you want to add niente markings. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Niente in the Dynamics group.

RESULT
Niente markings are added to the selected gradual dynamics.

TIP

● Deactivating the property removes niente markings from the selected gradual dynamics.
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● You can also add niente markings to, and remove them from, existing gradual dynamics by 
selecting them and clicking niente in the Gradual Dynamics section of the Dynamics panel.

AFTER COMPLETING THIS TASK
You can change the appearance of individual niente hairpins; for example, if you want to show 
some niente hairpins with a circle but others with text.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769
Dynamics panel on page 313

Changing the appearance of niente hairpins
You can show niente hairpins in two ways in Dorico Pro, and you can change how they appear 
individually, independently of your project-wide setting. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins whose niente style you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Niente style in the Dynamics group.

3. Choose one of the following options:

● Circle on hairpin 

● Text 

RESULT
The niente style of the selected hairpins is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

You can change how all niente hairpins appear project-wide in the Gradual Dynamics section of 
the Dynamics page in Engraving Options.

EXAMPLE

A niente shown as Circle on hairpin A niente shown as Text
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RELATED LINKS
Project-wide engraving options for dynamics on page 1105
Engraving Options dialog on page 840
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Groups of dynamics
Groups of dynamics are automatically aligned in a row and can be moved and edited as a group. 
When you move immediate dynamics within a group, the length of the hairpins on either side 
automatically adjust to compensate.

A group of dynamics The same group of dynamics adjusts to compensate 
when the middle dynamic moves rhythmically.

A single dynamic, either immediate or gradual, is considered a group on its own.

Two or more dynamics are automatically grouped together if they immediately follow each 
other horizontally on the staff, were input together or in sequence, and have gradual dynamics 
between the immediate dynamics.

All of the dynamics in a group are highlighted when any of the dynamics in the group are 
selected.

NOTE

● Groups of dynamics apply project-wide, meaning you cannot have dynamics grouped one 
way in some layouts but differently in other layouts. However, you can graphically align 
selected dynamics independently of their groups.

● As well as horizontal groups of dynamics, you can also link groups of dynamics vertically if 
you want the same dynamics to appear on multiple staves. This can be useful when multiple 
instruments play the same dynamics simultaneously and you want to make the same change 
in all staves; for example, moving the peak of a crescendo to a later beat, or changing a  to 
a .

RELATED LINKS
Linked dynamics on page 1133
Aligning dynamics on page 1108
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Grouping dynamics together
You can manually group dynamics together that were not automatically grouped when they were 
input. Grouped dynamics are automatically aligned in a row and can be moved and edited as a 
group.

PROCEDURE

1. In Write mode, select the dynamics you want to group together.

2. Choose Edit > Notations > Dynamics > Group Dynamics. You can also choose this option 
from the context menu.

RESULT
The selected dynamics are grouped together. If the first dynamic in the group is linked to other 
staves, all dynamics in the group are added to those staves. This applies to all layouts in which 
the dynamics appear.

RELATED LINKS
Linked dynamics on page 1133

Ungrouping dynamics and removing dynamics from groups
You can ungroup dynamics so that all dynamics in the group become ungrouped. You can also 
remove only selected dynamics from groups while leaving other dynamics in the group.

This applies to all layouts in which the dynamics appear.

PROCEDURE

1. In Write mode, select the dynamics you want to ungroup or remove from groups.

2. Do one of the following:

● To ungroup all dynamics in the selected groups, choose Edit > Notations > Dynamics > 
Ungroup Dynamics.

● To remove only the selected dynamics from their groups, choose Edit > Notations > 
Dynamics > Remove from Group.

TIP

You can also choose these options from the context menu.

Linked dynamics
Identical dynamics at the same rhythmic position on multiple staves can be linked together. This 
happens automatically when you copy and paste dynamics between staves.

If you select one dynamic in a linked group, all other dynamics in the linked group appear 
highlighted. If one linked dynamic is moved to a new rhythmic position, all linked dynamics 
move.
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Two linked dynamics with only the top dynamic 
selected

Moving just the top dynamic of the linked group 
automatically moves the other to match its new 
position.

Similarly, if you change one linked dynamic, for example, from  to , all dynamics linked to the 
changed dynamic are also changed. If you group other dynamics to one of the linked dynamics, 
such as a hairpin, the hairpin is added at the same position in all linked staves.

If one staff has another immediate dynamic before the end of a hairpin, the hairpin is truncated 
automatically. If you delete such a dynamic, the hairpin extends automatically up to the next 
immediate dynamic or to its full length, whichever comes first.

Two staves with linked dynamics, but the lower staff 
has another immediate dynamic that truncates the 
hairpin.

Deleting the mf at the end of the first bar in the 
second staff causes the hairpin to extend to match 
the range of the top staff.

NOTE

● If you delete only some dynamics from a group that is linked to other staves, those dynamics 
are also deleted from the linked staves. If you delete a whole dynamic group from one staff, 
this does not affect linked dynamics on other staves.

● As well as vertically linked dynamics, you can also group dynamics horizontally. This 
automatically aligns the dynamics in a row and allows them to be moved and edited as a 
group.

● Linking or unlinking dynamics applies project-wide, meaning you cannot have dynamics 
linked one way in some layouts but differently in other layouts.

RELATED LINKS
Groups of dynamics on page 1132
Linked slurs on page 1519
Disabling automatic linking of dynamics and slurs when pasting on page 464
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Linking dynamics together
When you copy and paste identical dynamics to the same rhythmic position on other staves, 
those dynamics are linked together automatically. You can also manually link dynamics and 
groups of dynamics together that are not automatically linked to allow simultaneous editing.

NOTE

Groups of dynamics must be the same in order to link them together. For example, you can link 
two  dynamics together if neither is part of a group, but you cannot link them together if one is 
grouped with a hairpin.

PROCEDURE

1. In Write mode, select the dynamics you want to link together.

2. Choose Edit > Notations > Dynamics > Link. You can also choose this option from the 
context menu.

RESULT
The selected dynamics are linked together. If you later change one of the linked dynamics, all 
linked dynamics are changed to match. This applies to all layouts in which the dynamics appear.

RELATED LINKS
Groups of dynamics on page 1132
Copying and pasting notes/items on page 461

Unlinking dynamics
You can unlink dynamics, including dynamics that were linked automatically. For example, if you 
want to lengthen/shorten gradual dynamics independently of each other.

PROCEDURE

1. In Write mode, select a dynamic in each linked group that you want to unlink.

2. Choose Edit > Notations > Dynamics > Unlink. You can also choose this option from the 
context menu.

RESULT
All dynamics in the linked groups are unlinked. This applies to all layouts in which the dynamics 
appear.

RELATED LINKS
Disabling automatic linking of dynamics and slurs when pasting on page 464

Dynamics
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Dynamics font styles
There are different font styles for different types of dynamics. You can change different aspects 
of these fonts in the Edit Font Styles dialog, such as changing their font size to make dynamics 
appear larger.

The following font styles are used for dynamics:

1 Dynamic Music Text Font: Used for dynamic glyphs, such as  and . Must be SMuFL-
compliant.

2 Dynamic Text Font: Used for dynamic modifiers, such as poco a poco and molto, and gradual 
dynamics shown as text.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 846
Types of dynamics on page 1104
Dynamic modifiers on page 1116
Changing the default font family on page 853
Input methods for dynamics on page 310

Dynamics in playback
The volume settings for sustaining instruments and non-sustaining instruments vary in terms of 
their control of gradual dynamics.

Sustaining instruments
Sustaining instruments include string, wind, and brass instruments, because they can 
hold a note while being in control of its volume throughout.

Dorico Pro applies gradual dynamics to these instruments in playback.

Non-sustaining instruments
Non-sustaining instruments, such as piano, harp, marimba, and most percussion 
instruments, have no further control of the dynamic of notes after they have been 
struck. For this reason, non-sustaining software instruments often use note velocity for 
dynamics, because this is set at the start of the note.

TIP

You can control settings for each software instrument in the Expression Maps dialog.

RELATED LINKS
Expression Maps dialog on page 913

Dynamics
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Dynamics editor on page 799
MIDI CC editor on page 805

Playback Options for dynamics
You can change settings for how dynamics are interpreted in playback by making adjustments to 
the scale of the graphical curve on the Dynamics page in Playback Options.

Dynamic Curve

The graph at the top of the Dynamics page in Playback Options maps a continuous curve. This 
curve determines how the volume of dynamics increases across the range  to .

A dynamic curve power of 1 creates a straight line, producing a steady dynamic increase. The 
difference between  and  is the same as between  and .

A dynamic curve power higher than 2 creates a curved line, producing a faster dynamic increase 
in the middle of the range. The difference between  and  is much smaller than the 
difference between  and .

The higher the dynamic curve power, the greater the contrast between dynamics in the middle of 
the range, and the smaller the contrast between dynamics at the ends of the range.

If your project uses a wide range of dynamics, including dynamics such as  and , you 
might want a lower curve power with larger differences between the extremes of the range.

If your project has a smaller range of dynamics, such as a minimum of  to a maximum of , 
you might prefer a higher curve power, so the differences between the dynamics in the middle of 
the range are more discernible.

NOTE

Changing the dynamic curve affects the playback of all instruments in the project.

Note Dynamics

In the Note Dynamics section of the Dynamics page, you can set how much the volume of notes 
in playback is affected by stresses and articulation marks.

Humanize

Humanize allows dynamics to vary randomly by the degree you set to mimic the natural 
fluctuations in a live performance.

For sound libraries that use MIDI CC 1 to control dynamics, you can see the effect humanization 
has on dynamics in the MIDI CC 1 editor.

RELATED LINKS
Playback Options dialog on page 842
MIDI CC editor on page 805
Dynamics editor on page 799
Changing dynamic levels on page 1112
Playback techniques on page 936
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VST Expression Maps for volume types
If you are using a third-party sound library, you may need to change or edit the expression map 
to make instruments respond to gradual dynamics. Otherwise, the sound library uses velocity by 
default.

The setup of the expression map for dynamics depends on how the instrument is configured. 
Consult the documentation for the sound library for further information.

Dorico Pro provides the following default expression maps:

● CC11 Dynamics for dynamics produced by changing MIDI channel expression

● Modulation Wheel Dynamics for dynamics produced by changing MIDI controller 1

TIP

You can edit expression maps in the Expression Maps dialog.

Dynamics
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Figured bass

Figured bass is a shorthand that uses figures to specify the harmony above the notated bass 
notes. It is particularly common in Baroque and early Classical music and in the parts of 
accompanying instruments, such as harpsichords and viols.

Figured bass informs performers about the intended harmony but allows room for 
interpretation, such as improvised arpeggiated phrases using notes from the chord.

Figures use a combination of Arabic numbers, accidentals, and horizontal hold lines to specify 
both the intervals above the bass note that make up the chord and its duration. For example, 
they show where suspensions resolve or when the bass note changes but the chord remains the 
same.

Tasto solo indications inform performers that sections should be played without harmony.

A basso continuo part with figured bass below the staff

In Dorico Pro, figured bass exists globally at the corresponding rhythmic positions by default 
because most music that includes figured bass is tonal, meaning players perform notes from the 
same chord. Therefore, you only have to input figures once, but they can appear above multiple 
or no staves as required and the figures automatically update according to the notes on each 
staff. However, in some circumstances it is necessary to specify different chords for different 
players at the same rhythmic position. In such cases, you can input local figured bass.

Dorico Pro calculates and saves the pitches implied by the figures you enter in relation to the 
lowest note at that rhythmic position. This semantic understanding of the harmony implied by 
figures allows Dorico Pro to update the displayed figures on different staves and if you transpose 
or change the pitch of notes.

When you transpose music that includes figured bass, Dorico Pro also transposes the figures 
accordingly.

Figured bass in Dorico Pro uses a bold roman font by default. You can change the font used for 
figured bass project-wide and edit the formatting of figured bass font styles. You can also edit 
the Figured Bass Tasto Solo paragraph style, which is used for tasto solo indications.

You can hide or show figured bass in each layout independently and only above the staves of 
specific players. You can also change whether figured bass appears above or below staves by 
default in each layout independently. Figures appear as signposts if Dorico Pro either does not 
normally show them, such as third intervals, or cannot identify the bass note for them, such as 
on a rest.

NOTE

Figured bass does not yet include notations commonly used for harmonic analysis, such as 
Roman numerals. This is planned for future versions.
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RELATED LINKS
Inputting figured bass on page 395
Figured bass hold lines on page 1144
Showing figured bass on rests on page 1142
Showing single brackets on figured bass on page 1143
Changing the staff-relative placement of figured bass on page 1149
Appearance of figured bass on page 1151

Project-wide engraving options for figured bass
You can find options for the project-wide appearance and position of figured bass on the Figured 
Bass page in Engraving Options.

The options on the Figured Bass page allow you to change the default appearance and position 
of figured bass in different circumstances, including for avoiding collisions. For example, you can 
set the default combination of figures and alterations you want to show for different intervals, 
whether to notate raised and lowered figures with accidentals or slashed figures, and whether 
accidentals appear before or after figures.

You can change the appearance of tasto solo indications and figured bass brackets, including 
their thickness and whether they are round or square.

You can also set the circumstances in which you want to show hold lines, how many hold lines 
you want to show, and where to position them.

Your settings in the Figures section are used when your figured bass input setting is Follow 
Engraving Options.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Changing the figured bass input setting on page 401
Changing figured bass accidental collision avoidance on page 1151
Changing figured bass bracket styles on page 1143
Engraving Options dialog on page 840

Project-wide note input options for figured bass
You can find options for the project-wide handling of figured bass during input on the Figured 
Bass page in Note Input Options.

The options on the Figured Bass page include whether to use your entries in the figured bass 
popover literally or to apply the current engraving options to them, and how to interpret specific 
intervals and popover entries.

RELATED LINKS
Note Input Options dialog on page 839

Figured bass
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Hiding/Showing figured bass in layouts
You can hide/show figured bass in each layout independently and only above the staves of 
specific players. For example, you can show figured bass in the full score and bass part layouts 
but hide figured bass in the other part layouts.

Any player on whose staff you input figured bass is automatically set to show figured bass in the 
current layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show figured bass.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Figured Bass section, activate/deactivate each player above/below which you want to 
show figured bass.

5. Click Apply, then Close.

RESULT
Figured bass is shown above/below all instruments belonging to the corresponding players in 
the selected layouts when their checkboxes are activated, and hidden when their checkboxes are 
deactivated. Figured bass is hidden completely when no checkboxes are activated.

AFTER COMPLETING THIS TASK

● You can change the staff-relative placement of figured bass.

● You can hide figured bass figures individually in layouts where figured bass is shown.

RELATED LINKS
Inputting figured bass on page 395
Changing the staff-relative placement of figured bass on page 1149
Figured bass hold lines on page 1144

Hiding/Showing figured bass figures individually
You can hide/show individual figured bass figures in layouts in which figured bass is shown. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains. 
However, you cannot show individual figures in layouts where figured bass is hidden.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the figured bass figures you want to hide, or the signposts of figures you want to 
show. You can do this in Write mode and Engrave mode.

Figured bass
Hiding/Showing figured bass in layouts 
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2. In the Properties panel, activate/deactivate Hidden in the Figured Bass group.

RESULT
The selected figured bass figures are hidden when Hidden is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden figure. However, signposts are not printed by 
default.

TIP

● You can hide/show figured bass signposts by choosing View > Signposts > Figured Bass.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Signposts on page 453
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Key Commands page in the Preferences dialog on page 63
Annotations on page 687

Showing figured bass on rests
By default, figured bass is hidden on rests because figures typically indicate harmony in relation 
to a bass note. You can show figured bass on individual rests; for example, if the harmony 
changes while the bass is resting. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

PREREQUISITE

● You have input figured bass at the positions of the rests.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the rests on which you want to show figured bass. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Show figured bass in the Notes and Rests group.

RESULT
Figured bass is shown on the selected rests. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Deactivating Show figured bass hides figured bass on selected rests again.

Figured bass
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Showing single brackets on figured bass
You can show only a single left or right bracket on individual bracketed figured bass figures. For 
example, if you want to indicate that all figures between two bracketed figures are optional. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● You have input figured bass figures with brackets.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the bracketed figures on which you want to show a single bracket. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Hide single bracket in the Figured Bass group.

3. Choose one of the following options:

● Start

● End

RESULT
Brackets are hidden on the corresponding side of the selected figures, leaving a single bracket 
on the other side. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

EXAMPLE

Brackets shown on both sides of all figures Brackets shown at the start of the first figure and the 
end of the last figure only

RELATED LINKS
Inputting figured bass on page 395
Showing brackets on figured bass hold lines on page 1147
Bracketed noteheads on page 1263

Changing figured bass bracket styles
You can change whether all bracketed figures and hold/suspension lines project-wide have 
round or square brackets, independently of each other.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

Figured bass
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2. In the category list, click Figured Bass.

3. In the Design section, choose one of the following options for Bracket style in the Brackets 
subsection:

● Round brackets

● Square brackets

4. Choose one of the following options for Bracket style for hold and suspension lines:

● Round brackets

● Square brackets

5. Click Apply, then Close.

Figured bass hold lines
Figured bass hold lines indicate that chords remain the same over changing notes in the bass.

By default, Dorico Pro shows hold lines for figures that have duration, but hides lines between 
suspensions and resolutions or after resolutions. You can hide/show hold and suspension lines 
for individual suspension figures. You can also change the circumstances in which Dorico Pro 
automatically shows hold lines, and their position and number, project-wide on the Figured Bass 
page in Engraving Options.

Figure (selected) with no duration Figure (selected) with duration and hold line

TIP

You can move figures graphically in Engrave mode, including changing the graphical length of 
hold lines.

RELATED LINKS
Engraving Options dialog on page 840
Figured bass in Engrave mode on page 1148
Moving items graphically on page 609
Grace notes on page 1193

Hiding/Showing figured bass hold/suspension lines
You can hide/show suspension lines between suspension and resolution figures and hold lines 
after resolution figures, independently of each other and your project-wide settings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Figured bass
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PROCEDURE

1. Select the figured bass suspensions whose hold/suspension lines you want to hide/show. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Figured Bass group:

● Line between susp. and resolution

● Continue line after resolution

3. Activate/Deactivate the corresponding checkboxes.

RESULT
Hold lines are shown between suspension and resolution figures and/or after resolutions in 
the selected figured bass suspensions when the corresponding checkboxes are activated, and 
hidden when the checkboxes are deactivated.

When the properties are deactivated, hold/suspension lines follow your project-wide settings for 
hiding/showing hold lines.

TIP

You can hide/show figured bass hold/suspension lines by default in different circumstances 
project-wide, including changing their default end positions, in Engraving Options > Figured 
Bass > Design.

EXAMPLE

Suspension and hold lines both 
hidden

Suspension line between 
suspension and resolution shown

Suspension line between 
suspension and resolution and 
hold line after resolution both 
shown

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769
Showing figured bass on rests on page 1142
Moving figured bass resolutions on page 1150

Lengthening/Shortening figured bass hold lines
You can change the duration of figured bass figures after they have been input, which changes 
the length of their hold lines. Lengthening a figure that was input without duration gives it 
duration and shows a hold line. You can also change the end positions of figured bass hold lines 
relative to notes.

PREREQUISITE

● The lower zone is shown.

Figured bass
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass figures you want to lengthen/shorten. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Duration in the Figured Bass group.

3. Lengthen/Shorten the selected figured bass figures in any of the following ways:

● To lengthen them, increase the value in the left value field.

● To shorten them, decrease the value in the left value field.

● To move their end to the left to a grace note at the rhythmic position set by the left value 
field, decrease the value in the right value field.

TIP

1 represents a quarter note.

4. Do one of the following:

● To position the end of hold lines to the right of noteheads and across grace notes, 
activate Draw line through figures at end.

● To position the ends of hold lines to the left of noteheads and before grace notes, 
deactivate Draw line through figures at end.

RESULT
The duration of the selected figured bass figures, and the length of their hold lines, is changed.

TIP

You can also lengthen/shorten figured bass figures in the same ways as for other items.

EXAMPLE
These examples all have an overall duration of a half note; that is, 2 entered into the left value 
field.

Draw line through figures at end 
deactivated

Draw line through figures at end 
activated

-1 1/4 entered into the right 
value field and Draw line through 
figures at end activated

RELATED LINKS
Figured bass in Engrave mode on page 1148
Lengthening/Shortening items on page 436
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Figured bass hold lines 

1146
Dorico Pro 4.3.30



Showing brackets on figured bass hold lines
You can show brackets on individual figured bass hold and suspension lines; for example, to 
indicate editorial hold lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass hold/suspension lines on which you want to show brackets. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together as 
appropriate for your selection, in the Figured Bass group:

● Bracket sus. lines

● Bracket hold lines

3. Select one of the following options from each menu:

● Both ends

● Start

● End

RESULT
Brackets are shown at the corresponding ends of the selected figured bass hold/suspension 
lines.

EXAMPLE

Both ends brackets on hold lines Start bracket on suspension lines and End bracket 
on hold lines

AFTER COMPLETING THIS TASK
You can change the style of figured bass hold/suspension line brackets; for example, to show 
round brackets.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769
Inputting figured bass on page 395
Changing figured bass bracket styles on page 1143
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Positions of figured bass
Figured bass is automatically organized into rows according to the number of rows required in 
each system independently. By default, rows are aligned at the top when below the staff and at 
the bottom when above the staff to minimize the gap between figured bass and the staff.

The vertical position of figured bass is determined by the staves above which they are set to 
appear and your per-layout setting for their staff-relative placement.

You can move individual figured bass figures to different rhythmic positions in Write mode. 
They are positioned by default according to your settings in Engraving Options. This includes 
Dorico Pro’s kerning, which applies across whole systems to ensure all figures and alterations are 
legible.

You can move figures and hold lines graphically in Engrave mode, but this does not change the 
rhythmic positions to which they apply.

You can change the default positions of all figures project-wide, and set values for the minimum 
gaps between rows of figures, figures and the staff, and figures and other items, on the Figured 
Bass page in Engraving Options.

RELATED LINKS
Hiding/Showing figured bass in layouts on page 1141
Hiding/Showing figured bass hold/suspension lines on page 1144
Lengthening/Shortening figured bass hold lines on page 1145
Moving figured bass resolutions on page 1150
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Engraving Options dialog on page 840

Figured bass in Engrave mode
In Engrave mode, each figured bass hold line has two square handles, one at the start and one at 
the end. You can move these handles to adjust the graphical position and length of figured bass 
hold lines.

You can also move whole figured bass hold lines graphically.

Handles on a hold line in Engrave mode

Moving figures with hold lines moves them both together. Moving hold lines or hold line handles 
moves the hold lines independently of the figure. Dorico Pro automatically lengthens hold lines 
between suspensions and resolutions when you move resolution figures.

NOTE

● A single figure includes all numbers at that position. For example, you cannot select and 
move the 6 in a 6,4 figure independently of the 4.

● If you want to move handles at the start/end of figured bass hold lines because you want 
to change their length, we recommend that you lengthen/shorten them rhythmically first 
before refining their graphical length.

Figured bass
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● Multiple different properties in the Figured Bass group of the Properties panel are activated 
automatically when you move the corresponding figure, hold line, or hold line handle.

● Main figure offset moves figures. X moves them horizontally, Y moves them vertically.

● Resolution offset moves the resolution figure in suspensions. X moves them 
horizontally, Y moves them vertically.

● Line [n] offset moves the start and end handles of hold lines in the corresponding 
figured bass row horizontally. L moves start (left) handles, R moves end (right) handles.

● Line [n] Y offset moves whole hold lines in the corresponding figured bass row 
vertically.

Changing the staff-relative placement of figured bass
You can change the default staff-relative placement of all figured bass figures in each layout 
independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff-relative 
placement of figured bass.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Figured Bass section, choose one of the following options for Default placement:

● Above staff

● Below staff

5. Click Apply, then Close.

RESULT
The default staff-relative placement of all figured bass figures in the selected layouts is changed.

TIP

You can also change the staff-relative placement of individual figured bass figures by selecting 
them and pressing F . If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

EXAMPLE

Figured bass below the staff Figured bass above the staff
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RELATED LINKS
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Moving figured bass resolutions
You can move resolution figures rhythmically, without affecting the position of the suspension 
figure or the overall duration of the figured bass suspension; for example, if you want a 
suspension to resolve on a different note.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the resolution figures you want to move. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Resolution pos. in the Figured Bass group.

3. Move the selected resolution figures in any of the following ways:

● To move them to the right, increase the value in the left value field.

● To move them to the left, decrease the value in the left value field.

● To move them to the left to grace notes at the rhythmic position set by the left value 
field, decrease the value in the right value field.

TIP

1 represents a quarter note.

RESULT
The selected resolution figures are moved rhythmically.

TIP

In Write mode, you can also click and drag resolution figure handles to the right/left according to 
the current rhythmic grid resolution.

EXAMPLE
For example, entering 1 into the left value field and -1/2 into the right value field moves 
resolution figures a quarter note to the right of suspension figures, and to the first of two 
sixteenth grace notes at that rhythmic position.

Figured bass
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RELATED LINKS
Figured bass hold lines on page 1144
Figured bass in Engrave mode on page 1148
Moving notes/items rhythmically on page 465
Changing the rhythmic grid resolution on page 214
Inputting figured bass on page 395

Changing figured bass accidental collision avoidance
You can change the default setting for how Dorico Pro resolves collisions between individual 
figures in multiple rows of figured bass project-wide. For example, in some published music, 
figured bass accidentals are offset horizontally to avoid increasing the vertical gap between rows.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Figured Bass.

3. In the Vertical Position section, choose one of the following options for Collision avoidance 
approach:

● Separate rows vertically

● Move accidentals

4. Optional: Click Advanced Options to show further collision avoidance options and change 
their values as required.

5. Click Apply, then Close.

RESULT
The figured bass collision avoidance approach is changed project-wide.

Appearance of figured bass
The appearance of individual figures is determined either by your current engraving options or 
your popover entry, depending on the figured bass input setting when you input them.

When inputting figured bass, you can change whether you want Dorico Pro to interpret your 
entries and apply the current engraving options for the appearance of figured bass to them or 
to follow your entries exactly; for example, if you are reproducing a piece of music and know in 
advance exactly how you want figures to appear.

You can reset individual figures that you input with the figured bass input setting Follow input 
literally so they follow the default settings, and you can fix the current appearance of individual 
figures.

Figured bass in Dorico Pro uses a bold roman font by default. You can change the font used for 
figured bass project-wide and edit the formatting of figured bass font styles. You can also edit 
the Figured Bass Tasto Solo paragraph style, which is used for tasto solo indications.

Figures appear as signposts if Dorico Pro either does not normally show them, such as third 
intervals, or cannot identify the bass note for them, such as on a rest.

Figured bass
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TIP

You can find many options for the default project-wide appearance of figures on the Figured 
Bass page in Engraving Options. For example, where to position the stroke on raised fifth and 
sixth intervals.

RELATED LINKS
Inputting figured bass on page 395
Changing the figured bass input setting on page 401
Figured bass hold lines on page 1144
Showing figured bass on rests on page 1142
Showing single brackets on figured bass on page 1143
Engraving Options dialog on page 840

Changing the font used for figured bass project-wide
By default, figured bass is drawn in a bold, Arabic font that is similar in appearance to the 
numbers in time signatures. You can change the font used for all figured bass figures project-
wide; for example, if you prefer to show figured bass in a plain font.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Figured Bass.

3. In the Design section, choose one of the following options for Figured bass appearance:

● Bold font

● Plain font

4. Optional: If you chose Plain font, choose Always use accidentals for Appearance of raised 
or lowered figures in the Accidentals section.

The plain figured bass font can only show raised/lowered figures using accidentals as it does 
not contain glyphs for the alternative appearances of figured bass accidentals.

5. Click Apply, then Close.

RESULT
The font style used for figured bass project-wide is changed.

TIP

● You can edit different aspects of the font styles used for figured bass in the Edit Font Styles 
dialog.

● Bold figured bass figures use Figured Bass Font.

● Plain figured bass figures use Figured Bass Text Font.

● Tasto solo indications use the Figured Bass Tasto Solo paragraph style.

● You can edit the appearance of individual bold figures in the Edit Music Symbol dialog.

RELATED LINKS
Edit Music Symbol dialog on page 865
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Editing the figured bass font styles
You can edit the formatting of the font styles used for all figured bass figures project-wide; for 
example, if you want them to appear larger by default.

NOTE

These steps do not apply to tasto solo indications, which use the Figured Bass Tasto Solo 
paragraph style.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select one of the following font styles:

● Figured Bass Font: Used for bold figured bass figures

● Figured Bass Text Font: Used for plain figured bass figures

3. Activate the following options, individually or together, to change the corresponding aspect 
of the font:

● Font family

● Size

● Style

● Underlined

NOTE

You must choose a SMuFL-compliant font family for the Figured Bass Font font style.

4. Optional: If you selected Figured Bass Font, activate Substitutes and change its substitute 
fonts as required.

5. Click OK to save your changes and close the dialog.

RESULT
The formatting of the selected figured bass font style is changed project-wide.

RELATED LINKS
Edit Font Styles dialog on page 846
Paragraph Styles dialog on page 848
Changing the default font family on page 853

Hiding/Showing cautionary figured bass alterations
You can hide/show cautionary alterations and cautionary accidentals on figured bass project-
wide in either just the same bar as the alteration or in the same and following bars; for example, 
to avoid ambiguity.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Figured Bass.

3. In the Accidentals section, choose one of the following options for Cautionary alterations:

● Do Not Show
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● Show in Same Bar

● Show in Same and Following Bar

4. Click Apply, then Close.

RESULT
Cautionary figured bass alterations are hidden when you choose Do Not Show, and shown 
project-wide in the corresponding places when you choose either Show in Same Bar or Show in 
Same and Following Bar.

Simplifying figured bass compound intervals
You can simplify compound intervals in individual figured bass figures; that is, figures 9 and 
above. Some editions prefer to simplify compound intervals so figures reflect the first octave and 
appear out of order in the stack.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the compound figured bass figures you want to simplify. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Show compound intervals as simple in the Figured Bass 
group.

RESULT
The selected compound figures are simplified. Deactivating the property returns the selected 
figures to their default octave.

EXAMPLE

Figure with compound intervals Figure with simplified compound intervals

RELATED LINKS
Engrave toolbox on page 514
Properties panel on page 769
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Fixing the current appearance of figured bass
You can fix the current appearance of individual figured bass figures; for example, if you 
input them with the input setting Follow Engraving Options but want to keep their current 
appearance, regardless of future changes you make to figured bass engraving options.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass figures whose current appearance you want to fix. You can do this in 
Write mode and Engrave mode.

2. Choose Edit > Notations > Figured Bass > Force Current Appearance.

RESULT
The current appearance of the selected figures is fixed, meaning they are not affected by any 
future changes to figured bass engraving options.

TIP

You can assign a key command for Force Current Appearance on the Key Commands page in 
Preferences.

Resetting figured bass
You can reset individual figured bass figures; for example, if they were input with the figured 
bass input setting Follow input literally. Reset figures follow your settings in Engraving 
Options and update if you change them.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass figures you want to reset. You can do this in Write mode and Engrave 
mode.

2. Choose Edit > Notations > Figured Bass > Reset Figured Bass.

RESULT
The selected figured bass figures are reset to follow your current settings on the Figured Bass 
page in Engraving Options. This can affect their appearance and suspension duration.

TIP

You can assign a key command for Reset Figured Bass on the Key Commands page in 
Preferences.

RELATED LINKS
Engrave toolbox on page 514
Engraving Options dialog on page 840
Inputting figured bass on page 395
Changing the figured bass input setting on page 401
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Key Commands page in the Preferences dialog on page 63
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Fingering

Fingerings use numbers and letters to recommend which fingers players should use for notes. 
This can be useful for music aimed at players learning the instrument and for difficult musical 
passages where certain fingering patterns make the notes much easier to play.

Fingerings are often used in keyboard music, as players can use all ten fingers to play notes, and 
in guitar music, where fingerings are often used alongside fret positions. However, fingerings 
can also be useful for other instruments; for example, to indicate that string players should 
change the finger used to stop the string while holding the note, or to instruct wind players to 
use uncommon fingerings for particular notes in order to create a special sonic effect.

Piano music containing multiple fingerings, including a substitution fingering and alternative fingerings

Dorico Pro also provides fingerings for brass and fretted instruments. For example, you can 
specify which valves players should depress for instruments such as trumpet and horn, and you 
can specify the horn branch you want players to use for double horns. For fretted instruments, 
you can input fingerings for both hands.

Fingerings in Dorico Pro use a bold roman font by default, following accepted conventions for 
the appearance of fingerings. You can change the font used for fingerings project-wide and edit 
the formatting of fingering font styles.

RELATED LINKS
Inputting fingerings on page 274
Fingerings popover on page 276
Fingerings for fretted instruments on page 1169
Fingerings for valved brass instruments on page 1179
Fingering slides on page 1176
Fingering font styles on page 1166
Hiding/Showing fingering on page 1165
String indicators on page 1183
Hiding/Showing fingerings in chord diagrams on page 1062
Allowing/Disallowing thumb fingerings in chord diagrams on page 1063
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General placement conventions for fingering
Fingerings are placed as close as possible to the notes to which they apply, so the performer can 
read them easily and clearly.

In music for grand staff instruments, such as the piano and harp, it is accepted to place 
fingerings for the right hand above the top staff, and fingerings for the left hand below the 
bottom staff. However, in dense contrapuntal music for these instruments, fingerings can be 
placed between the staves to follow the direction of the voices to which they apply.

Different conventions apply to fingerings for fretted instruments, as they require fingerings for 
both the right and left hands.

Right-hand fingering placement

By default, all right-hand fingerings are placed outside the staff and on the notehead side of 
notes, which can be above or below the staff depending on the stem direction. When shown 
beside notes inside the staff, Dorico Pro automatically joins adjacent notes with the same right-
hand fingering with a bracket.

Left-hand fingering placement

Left-hand fingerings are usually positioned inside the staff and to the left of the notes to which 
they apply. However, they also must not collide with other items, such as accidentals and rhythm 
dots. Dorico Pro automatically calculates the most appropriate positions for left-hand fingerings 
and erases their backgrounds by default, which improves their readability when placed on staff 
lines.

RELATED LINKS
Fingerings for fretted instruments on page 1169

Project-wide engraving options for fingerings
You can find options for the project-wide appearance and position of fingerings on the Fingering 
page in Engraving Options.

The options on the Fingering page allow you to change the font, size, appearance, placement, 
and precise position of fingerings on standard notes, cross-staff chords, and grace notes, 
including fine adjustments for the different instrument groups, such as brass instruments 
and fretted instruments, and the design of enclosures around fingerings and lines beneath 
fingerings. There are separate options controlling the position of fingerings shown inside the 
staff, and you can also change the position of fingerings relative to slurs, octave lines, and 
tuplets.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
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Changing fingerings to substitution fingerings
Substitution fingerings indicate where players should change the finger used for the note. You 
can change existing fingerings to substitution fingerings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the fingerings you want to change to substitution fingerings. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Substitution in the Fingering and Positions group.

3. Enter the fingering you want for the substitution into the value field.

4. Press Return .

RESULT
The selected fingerings are now shown as substitution fingerings. The deferred position of the 
substitution is the same as the original fingering by default, but you can change the rhythmic 
position of substitution fingerings.

RELATED LINKS
Engrave toolbox on page 514
Inputting fingerings on page 274
Fingerings popover on page 276

Changing the rhythmic position of substitution fingerings
Substitution fingerings are shown as immediate by default, meaning that the substitution 
takes place on the same note, but you can change the rhythmic position at which individual 
substitutions take place.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the substitution fingering whose deferred rhythmic position you want to change. You 
can do this in Write mode and Engrave mode.

2. Change the rhythmic position of the substitution fingering in any of the following ways:

● In Write mode, click and drag the circular handle to the right/left.

● In Write mode and Engrave mode, activate Substitution offset in the Fingering and 
Positions group of the Properties panel.

Change the rhythmic position of substitutions as fractions of a quarter note (crotchet) by 
entering a value into the left value field, or by clicking the arrows beside the value field. 
Increasing the value moves substitutions to later positions, decreasing the value moves 
them to earlier positions.
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NOTE

The right value field is for the grace note position at which substitutions occur, if 
applicable.

RESULT
The rhythmic position of the substitution fingering is changed.

Dorico Pro automatically arranges deferred substitutions so they are ordered appropriately 
alongside any fingerings that coincide with the substitution.

NOTE

You can only change the position of single substitution fingerings when dragging their handles 
with the mouse. However, you can change the positions of multiple substitution fingerings with 
Substitution offset in the Fingering and Positions group of the Properties panel.

Deferred substitutions are always shown with horizontal lines, even if you have chosen to show 
immediate substitutions with slurs.

Changing existing fingerings
You can change fingerings after you have input them; for example, if you decide a different 
fingering would be better.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the fingerings you want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, enter the new fingering you want into the Finger or position value 
field in the Fingering and Positions group.

3. Press Return .

RESULT
The selected fingerings are changed.

TIP

You can also change existing fingerings in Write mode by opening the fingerings popover. Any 
existing fingerings on the selected note are shown in the popover.

RELATED LINKS
Inputting fingerings on page 274
Fingerings popover on page 276
Engrave toolbox on page 514
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Changing the staff-relative placement of fingerings
Dorico Pro automatically follows conventions for fingering placement, but you can show 
individual fingerings belonging to non-fretted instruments either above or below the staff, 
independently of your project-wide setting. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

According to convention, keyboard instrument fingering is positioned above the right-hand staff, 
and below the left-hand staff. String and brass instrument fingering is always positioned above 
the staff.

NOTE

These steps only apply to non-fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the fingerings whose staff-relative placement you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Staff-relative position in the Fingering and Positions 
group.

3. Choose one of the following options:

● Above

● Below

RESULT
The selected fingerings appear above/below the staff. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

● You can also change the staff-relative placement of fingerings by selecting them in Engrave 
mode and pressing F .

● You can change the staff-relative placement of all fingerings project-wide to follow voice 
directions on the Fingering page in Engraving Options.

This can be useful in complex contrapuntal music where fingering may not be clear if it is 
only placed above the top staff and below the bottom staff.

RELATED LINKS
Fingerings for fretted instruments on page 1169
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Showing fingerings inside the staff
You can show individual fingerings belonging to non-fretted instruments beside noteheads 
inside the staff.

NOTE

● These steps only apply to non-fretted instruments. Left-hand fingerings for fretted 
instruments are shown inside the staff by default.

● These steps do not apply to substitution fingerings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Do one of the following:

● In Write mode, select the notes whose fingerings you want to show inside the staff.

● In Engrave mode, select the fingerings you want to show inside the staff.

2. In the Properties panel, activate Position left of notehead in the Fingering and Positions 
group.

RESULT
Fingerings belonging to the selected notes are shown inside the staff, directly beside the 
noteheads. By default, if they belong to a note on a staff line, they erase part of the staff line to 
ensure legibility.

TIP

You can change the erasure padding and size of all fingerings shown inside the staff project-wide 
in Engraving Options > Fingering > Design > Advanced Options. You can also change how 
fingerings shown to the left of notes avoid collisions in the Position section.

EXAMPLE

Changing the position of individual fingerings relative to slurs, 
octave lines, and tuplet brackets

By default, fingerings are positioned inside the arcs of slurs, but outside the start/end of slurs. 
You can change the position of individual fingerings relative to slurs, independently of your 
project-wide settings. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the fingerings whose position relative to slurs you want to change.

2. In the Properties panel, activate Slur-relative position in the Fingering and Positions 
group.

3. Choose one of the following options:

● Inside

● Outside

RESULT
The position of the selected fingerings relative to slurs, octave lines, and tuplet brackets is 
changed. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

NOTE

● If fingerings also coincide with the first note or last note of slurs, fingerings are positioned 
outside all of these notations.

● You can change the position of all fingerings relative to slurs, octave lines, and tuplet 
brackets project-wide on the Fingering page in Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the size of fingerings
You can change the size of fingerings individually without changing the size of the noteheads to 
which they apply. You can do this for the current layout and frame chain only, or for all layouts 
and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the fingerings whose size you want to change.

2. In the Properties panel, activate Scale in the Fingering and Positions group.

3. Change the value in the value field.
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4. Press Return .

RESULT
The scale size of the selected fingerings is changed. For example, changing the value to 50 scales 
the selected fingerings to half their normal size. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

● You can change the default size of all fingerings project-wide by changing the size of the 
Fingering Font in the Edit Font Styles dialog.

● You can change the size of fingerings on grace notes in Engraving Options > Fingering > 
Design.

RELATED LINKS
Edit Font Styles dialog on page 846
Fingering font styles on page 1166

Showing enclosures/underlines on fingerings
You can show individual fingerings belonging to non-fretted instruments with either a circle 
enclosure or an underline.

NOTE

These steps only apply to non-fretted instruments. For fretted instruments, you can instead show 
string indicators inside the staff, which are shown in a circle enclosure.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the fingerings on which you want to show an enclosure/underline.

2. In the Properties panel, activate Decoration in the Fingering and Positions group.

3. Choose one of the following options:

● Circle

● Underline

RESULT
The selected fingerings are shown with the chosen decoration.

TIP

You can find options that determine the default design of all fingering decorations project-wide, 
such as their line thickness, in Engraving Options > Fingering > Design > Advanced Options.
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EXAMPLE

Fingering with circle Fingering with underline

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
String indicators on page 1183

Hiding/Showing fingering
You can hide/show fingering in each layout independently. For example, you can show fingering 
in part layouts but hide fingering in full score layouts as conductors rarely require fingering 
information.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show fingering.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fingering section, activate/deactivate Show fingering.

5. Click Apply, then Close.

RESULT
All fingerings are shown in the selected layouts when the checkbox is activated, and hidden when 
the checkbox is deactivated.

RELATED LINKS
Changing the appearance of cautionary fingerings on page 1168
Hiding/Showing fingerings in chord diagrams on page 1062

Deleting fingerings
You can remove fingerings from notes after you have input them. However, because fingerings 
are properties of notes rather than separate items in Dorico Pro, you cannot select and delete 
them as you would for other items.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the notes from which you want to remove fingerings. You can do this in Write mode 
and Engrave mode.

2. Choose Edit > Notations > Fingering > Reset Fingering.

RESULT
All fingerings are removed from the selected notes.

TIP

You can assign a key command for Reset Fingering on the Key Commands page in 
Preferences.

RELATED LINKS
Large selections on page 428
Assigning key commands on page 66
Engrave toolbox on page 514

Fingering font styles
There are different font styles for different types of fingerings. You can change different aspects 
of these fonts in the Edit Font Styles dialog, such as changing their font size to make fingerings 
appear larger.

The following font styles are used for fingering:

1 Fingering Font: Used for bold fingerings, including bold italic fingerings. Must be SMuFL-
compliant.

2 Fingering Text Font: Used for plain fingerings.

3 Fingering Text Italic Font: Used for italic fingerings.

4 Fingering Horn Branch Text Font: Used for note names in horn branch indicators.

5 Fingering Horn Branch Accidental Font: Used for accidentals in horn branch indicators. 
Must be SMuFL-compliant.

6 Fingering Horn Branch Alto Text Font: Used for the alto abbreviation in triple horn branch 
indicators.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 846
Changing the size of fingerings on page 1163
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String indicators on page 1183
Changing the appearance of open string indicators on page 1185
Changing the default font family on page 853

Changing the font used for fingerings project-wide
By default, fingerings are drawn in a bold, Arabic font that is similar in appearance to the digits 
in time signatures. You can change the font used for all fingerings project-wide, which affects the 
appearance of fingering numbers, parentheses, brackets, and open string indicators that appear 
as zero fingerings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Fingering.

3. In the Design section, choose one of the following options for Fingering appearance:

● Bold font

● Plain font

4. Click Apply, then Close.

RESULT
The font style used for fingerings and open string indicators that appear as zero fingerings 
project-wide is changed.

NOTE

● The font used for thumb indicator, substitution lines and slurs, and brass valve separators is 
not changed.

● You can edit different aspects of the font styles used for fingerings in the Edit Font Styles 
dialog.

● Bold fingerings use Fingering Font.

● Plain fingerings use Fingering Text Font.

Showing individual fingerings in italics
Fingerings are normally shown in a bold, non-italic font, but you can show individual fingerings in 
italics.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the fingerings you want to show in italics.

2. In the Properties panel, activate Italic in the Fingering and Positions group.
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RESULT
The selected fingerings are shown in a bold italic font if your project-wide setting for fingerings is 
a bold font, and in a plain italic font if your project-wide setting for fingerings is a plain font.

NOTE

Bold italic fingerings look very similar to tuplet numbers, which can be confusing.

RELATED LINKS
Engrave toolbox on page 514

Cautionary fingerings
Cautionary fingerings remind players that fingerings specified at previous rhythmic positions 
continue to apply to notes that are still sounding. Dorico Pro automatically shows cautionary 
fingerings when you add other fingerings at rhythmic positions where notes with existing 
fingerings are still sounding.

By default, cautionary fingerings are shown enclosed in parentheses. You can choose to show 
cautionary fingerings without parentheses or not to show cautionary fingerings at all project-
wide, and you can change the appearance of cautionary fingerings individually; for example, 
if you want to show cautionary fingerings manually on tied notes that cross system or frame 
breaks.

Cautionary fingering shown in parentheses (default)

RELATED LINKS
Inputting fingerings on page 274
Fingerings popover on page 276

Changing the appearance of cautionary fingerings
You can change the appearance of cautionary fingerings individually and independently of 
your project-wide setting; for example, if you want particular fingerings to appear without 
parentheses or to hide specific cautionary fingerings. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to cautionary fingerings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. In Engrave mode, select the noteheads whose cautionary fingering appearance you want to 
change.

NOTE

You must select the specific noteheads to which the cautionary fingerings apply, not the 
fingerings themselves.

2. In the Properties panel, activate Cautionary in the Fingering and Positions group.

3. Select one of the following options from the menu:

● Default

● With parentheses

● Without parentheses

● Suppress

RESULT
The appearance of cautionary fingerings on the selected notes is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default appearance of all cautionary fingerings project-wide in the 
Alternative, Editorial and Cautionary section of the Fingering page in Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Fingerings for fretted instruments
Fretted instruments, such as the classical guitar, require additional fingering instructions for 
both hands and engraving options due to the complex nature of the music.

Fingerings for fretted instruments use the same fonts as normal fingerings.

A passage for guitar with right-hand and left-hand fingerings

Right-hand fingering
Right-hand fingerings tell the performer which finger to use to pluck the string, which 
is usually the right hand. By default, all right-hand fingerings are placed outside the 
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staff, on the notehead side of notes, and follow the stem directions of voices in 
multiple-voice contexts. When the same finger plays multiple notes in a chord, you 
can show a single fingering with a bracket for the notes plucked by that finger.

By default, Dorico Pro shows “p” for right-hand thumb fingerings and “e” for right-hand 
fingerings for the pinky finger, but there are different conventions for these letters. 
You can change these default settings for all fingerings project-wide.

NOTE

In Dorico Pro, we use “pinky” to refer to the smallest finger, but it can also be called 
“little” or “fifth digit”.

Left-hand fingering
Left-hand fingerings tell the performer which finger to use to stop the string, which is 
usually the left hand. In Dorico Pro, left-hand fingerings are placed inside the staff and 
to the left of the notes to which they apply.

When shown inside the staff next to notes, left-hand fingering appears smaller than 
fingering shown outside the staff. The default scale factor for left-hand fingering inside 
the staff is 95%. You can change this in Engraving Options > Fingering > Design > 
Advanced Options.

RELATED LINKS
Inputting fingerings on page 274
Fingerings popover on page 276
Fingering font styles on page 1166
Changing the letters shown for fretted instrument fingerings on page 1175
Adding fingerings to arpeggio signs on page 1174
Fingering slides on page 1176
String indicators on page 1183
Tapping on page 1340
Hammer-ons and pull-offs on page 1342
Engraving Options dialog on page 840

Hiding/Showing brackets for right-hand fingerings
When multiple notes in the same chord are plucked by the same right-hand finger, you can show 
the same fingering multiple times, once for each note, or show a single fingering for all notes 
with a bracket spanning the notes plucked by that finger. When showing a separate fingering for 
each note, you can also choose to place each fingering either above or below the staff. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

Fingering
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NOTE

These steps only apply to right-hand fingerings belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select all the notes for which you want to hide/show brackets for right-hand fingerings. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Vertical position in the Plucked Fingering group.

3. Select one of the following options from the menu:

● To hide brackets and show a separate fingering for each selected note, select Above 
staff or Below staff.

● To show brackets and a single fingering for all notes in each bracket, select Next to 
note.

RESULT
Brackets on the selected right-hand fingerings are hidden/shown. If you selected Above staff or 
Below staff, their staff-relative placement is changed accordingly. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default staff-relative placement of all right-hand fingerings in the Position 
section of the Fingering page in Engraving Options.

EXAMPLE

Right-hand fingerings shown next 
to notes with a bracket

Right-hand fingerings shown 
above the staff

Right-hand fingerings shown 
below the staff

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771

Fingering
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Copying property settings to other layouts/frame chains on page 768

Changing the position of left-hand fingerings
You can change the position of individual left-hand fingerings. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains. By default, they are positioned 
inside the staff and to the left of the notes to which they apply.

NOTE

These steps only apply to left-hand fingerings belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the left-hand fingerings whose position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Stopping finger position in the Fingering and Positions 
group.

3. Select one of the following options from the menu:

● Outside staff

● Left of note

● Right of note

RESULT
The position of the selected left-hand fingerings is changed. When shown outside the staff, they 
are placed above the staff by default. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

TIP

You can change how all fingerings shown to the left of notes project-wide avoid collisions in 
Engraving Options > Fingering > Position.

EXAMPLE

Outside staff Left of note Right of note

RELATED LINKS
General placement conventions for fingering on page 1158

Fingering
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Engraving Options dialog on page 840
Inputting fingerings on page 274

Erasing the background of left-hand fingerings inside the staff
By default in Dorico Pro, left-hand fingerings have erased backgrounds because they are often 
placed in the staff on staff lines. You can change whether individual left-hand fingerings have 
erased backgrounds or not. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

NOTE

These steps only apply to left-hand fingerings belonging to fretted instruments positioned inside 
the staff.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the left-hand fingerings whose background erasure you want to 
change.

2. In the Properties panel, activate Erase background in the Fingering and Positions group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The backgrounds of the selected left-hand fingerings are erased when the checkbox is activated, 
and not erased when the checkbox is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

When the property is deactivated, left-hand fingerings follow your project-wide setting for erased 
backgrounds.

TIP

You can change the default setting for erasing the backgrounds of all left-hand fingerings 
project-wide in Engraving Options > Fingering > Design > Advanced Options > Fingerings 
inside the staff.

Fingering
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EXAMPLE

Left-hand fingerings with erased backgrounds Left-hand fingerings without erased backgrounds

Adding fingerings to arpeggio signs
You can add fingerings to arpeggio signs to indicate which right-hand finger should be used to 
strum a chord. By default, fingerings are placed at the bottom of arpeggio signs.

NOTE

These steps only apply to arpeggio signs belonging to fretted instruments.

PREREQUISITE

● You have input the arpeggio signs to which you want to add fingerings.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs belonging to fretted instruments to which you to add fingerings. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Finger in the Plucked Fingering group.

3. Enter the fingering you want into the value field.

For example, for the thumb, enter p.

RESULT
The specified fingering is added to the selected arpeggio signs. It is positioned at the bottom of 
the arpeggio signs by default.

TIP

You can find options relating to arpeggio sign fingerings on the Fingering page in Engraving 
Options. For example, you can find the option for their default scale factor for them relative to 
normal fingerings by clicking Advanced Options in the Design section.

Fingering
Fingerings for fretted instruments 

1174
Dorico Pro 4.3.30



EXAMPLE

Arpeggio signs played with the thumb

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Engraving Options dialog on page 840
Engrave toolbox on page 514

Allowing/Disallowing arpeggio sign fingerings in the staff
By default, arpeggio sign fingerings are always shown outside the staff. You can choose to allow 
them to be shown in the staff when their arpeggio signs end inside the staff.

NOTE

These steps only apply to arpeggio signs belonging to fretted instruments.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Fingering.

3. In the Position section, choose one of the following options for Vertical position for 
arpeggio sign fingering in the Vertical Position subsection:

● Force outside staff

● Allow in staff

4. Click Apply, then Close.

Changing the letters shown for fretted instrument fingerings
You can change which letters are shown for fingerings indicating the thumb and pinky finger. By 
default, Dorico Pro shows “p” for the thumb and “e” for the pinky finger.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Fingering.

3. In the Design section, choose one of the following options for Thumb indicator in the 
Right-hand Plucked Fingering subsection:

● P (Pulgar)

● T (Thumb)

4. Choose one of the following options for Pinky finger indicator:

● E

Fingering
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● Q

● C

● S

● O

● X

5. Click Apply, then Close.

RESULT
The letters used for thumb and pinky finger fingerings are changed project-wide.

RELATED LINKS
Fingerings popover on page 276

Fingering slides
Fingering slides indicate that the performer should slide their finger up/down the neck of the 
instrument. They are notated as an angled line between fingerings.

The note at the start of a fingering slide is known as a source note. The note at the end of a 
fingering slide is known as the destination note.

A passage with fingering slides

When the source and destination notes are sufficiently close horizontally, fingering slides are 
shown between the fingerings, joining them directly in their existing positions without moving 
them. When the source and destination notes are far apart horizontally, fingering slides appear 
with a fixed length to the left of the destination note. You can change the length of individual 
fingering slides.

Fingering slides automatically avoid obstructions, such as noteheads, accidentals, and other 
fingerings.

NOTE

● Dorico Pro automatically adjusts the length/angle of fingering slides when you move the 
fingerings at the start/end.

● In Dorico Pro, you can only show fingering slides on staves belonging to fretted instruments. 
You can show string fingering shift indicators on staves belonging to other string 
instruments.

RELATED LINKS
Hiding/Showing string fingering shift indicators on page 1181
Glissando lines on page 1317
Jazz articulations on page 1348

Fingering
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Fingering slides in Engrave mode
In Engrave mode, each join fingering slide has two square handles, one at the start and one at 
the end. You can move these handles to adjust the graphical position, length, and angle of join 
fingering slides.

Handles on a slide joining two notes in Engrave mode

NOTE

● If you want to change the length of fingering slides, we recommend that you do so by first 
changing their Slide type property or by moving the fingerings. Dorico Pro automatically 
adjusts the length/angle of fingering slides when you move the fingerings at the start/end.

● You cannot move fingering slides rhythmically. If you want to change the notes to which 
fingering slides apply, you must hide them between their original notes and show new 
fingering slides between the new notes.

● Fingering slides shown only before the destination note have a fixed length, and so do not 
have handles at the start/end.

● You cannot move whole fingering slides that join notes. You can only move their handles.

Hiding/Showing fingering slides
You can hide/show slides between notes played by the same left-hand finger on the same string 
on fretted instruments.

NOTE

These steps only apply to fingerings belonging to fretted instruments.

PREREQUISITE

● You have input the same left-hand fingering for the notes at the start and end of the slides.

● You have specified the same string for the notes at the start and end of the slides.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the destination notes before which you want to hide/show fingering slides. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Slide in in the Fingering and Positions group.

RESULT
Fingering slides are shown before the selected notes when Slide in is activated, and hidden 
when it is deactivated. If the gap between the source and destination notes is small enough, 
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fingering slides appear as an angled line joining the fingerings. If the gap is large, fingering 
slides appear as a fixed length angled line to the left of the destination notes.

TIP

If you want to adjust the placement or angle of the slide, you can move either the fingerings or 
the slide itself graphically in Engrave mode. Dorico Pro automatically adjusts the length/angle of 
fingering slides when you move the fingerings at the start/end.

RELATED LINKS
Engrave toolbox on page 514
Inputting fingerings on page 274
Changing existing fingerings on page 1160
Assigning notes to strings on page 1255
Moving items graphically on page 609

Changing the length of fingering slides
You can change the length of individual fingering slides and show them either joining the source 
and destination fingerings or with a fixed length before the destination note, independently of 
your project-wide maximum distance threshold. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

These steps only apply to fingerings belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the fingering slides whose length you want to change.

2. In the Properties panel, activate Slide type in the Fingering and Positions group.

3. Choose one of the following options:

● To show fingering slides between the fingerings at the start/end, choose Join.

● To show fixed length fingering slides before the destination fingerings, choose 
Destination only.

RESULT
The length of the selected fingering slides is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can change the default threshold above which all fingering slides are only shown before 
the destination note rather than joining the fingerings at their start/end in the Fingering Slides 
section of the Fingering page in Engraving Options.

Fingering
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EXAMPLE

Join Destination only

RELATED LINKS
Fingerings for fretted instruments on page 1169
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Engraving Options dialog on page 840

Fingerings for valved brass instruments
For instruments like trumpet and horn, fingering is used to show which valves must be 
depressed to produce a specific note.

You can enter fingerings for valved brass instruments into the fingerings popover as numbers 
without any separation. For example, enter 12 for a C♯ on a trumpet to indicate that the first two 
valves must be depressed.

By default, Dorico Pro automatically stacks fingerings added to notes on brass instrument staves 
vertically. They are shown with no separator by default.

You can change the appearance of fingerings for valved brass instruments in the Brass section 
of the Fingering page in Engraving Options. For example, you can show fingerings for valved 
brass instruments in a single row or stacked vertically. You can also change the appearance of 
the separator or show no separator.

You can also edit the formatting of the fonts used for the different parts of fingerings for valved 
brass instruments.

RELATED LINKS
Fingering font styles on page 1166
Inputting fingerings on page 274
Fingerings popover on page 276
Engraving Options dialog on page 840

Showing horn branch indicators
You can indicate the branch on which notes are played for double horns and triple horns by 
adding branch indicators as prefixes to horn fingerings. Some publications simply indicate “T” for 
thumb, while others more explicitly indicate which branch is to be used by specifying its pitch.

NOTE

You can only add branch indicators to notes belonging to horns in F.
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the horn fingerings to which you want to add branch indicators. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Horn branch in the Fingering and Positions group.

3. Select one of the following horn branches from the menu:

● F

● B flat

● F alto

● E flat alto

● Thumb trigger

RESULT
Branch indicators are added to the selected fingerings.

TIP

You can change the appearance of branch indicators in the Brass section of the Fingering page 
in Engraving Options.

Changing the appearance of slide positions for brass instruments
You can use Arabic or Roman numerals to indicate slide positions for slide brass instruments, 
such as trombones. By default, Dorico Pro uses Arabic numerals for slide positions.

NOTE

You must enter slide positions using Arabic numerals into the fingerings popover, even if you 
have chosen to show slide positions with Roman numerals in your project.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Fingering.

3. In the Brass section, choose one of the following options for Slide position appearance in 
the Slide brass instruments subsection:

● Arabic numerals

● Roman numerals

4. Click Apply, then Close.

RESULT
The numeral style used for slide positions on slide brass instruments is changed project-wide.
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Hiding/Showing string fingering shift indicators
You can hide/show shift indicators after individual fingerings belonging to string instruments. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

Shift indicators are angled lines that indicate the direction of movement when string players 
must shift their finger position on the fingerboard to play a higher/lower note with the same 
finger as the previous note.

NOTE

These steps do not apply to fingerings belonging to fretted instruments, which can show 
fingering slides instead.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes or fingerings on string instrument staves from which you want to indicate a 
fingering shift. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Indicate shift to next note in the Fingering and 
Positions group.

RESULT
Shift indicators are shown when the property is activated, even if neither of the notes at each 
end have explicit fingerings, and hidden when the property is deactivated. They are positioned 
between the selected notes and the notes that immediately follow them. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

● You can specify that fingerings should show shift indicators when inputting fingerings for 
string instruments.

● You can change the length, thickness, angle, and placement of shift indicators in the String 
Fingering Shifts section of the Fingering page in Engraving Options.

EXAMPLE

RELATED LINKS
Inputting fingerings on page 274
Fingering slides on page 1176
Assigning notes to strings on page 1255
Engraving Options dialog on page 840
Engrave toolbox on page 514
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Changing the property scope on page 771

Changing the direction of string fingering shift indicators
You can change the direction of individual string fingering shift indicators if they do not point in 
the direction required.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the shift indicators whose direction you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Shift direction in the Fingering and Positions group.

3. Choose one of the following options:

● Up

● Down

RESULT
The selected shift indicators are angled up/down.

NOTE

You can also affect the direction of string shift indicators by specifying the strings on which notes 
are played.

Fingerings imported from MusicXML files
Dorico Pro imports fingerings that are specified using the fingering element in MusicXML files.

MusicXML files exported from Finale typically represent fingerings in the correct way. However, 
because Sibelius does not use the fingering element, Dorico Pro cannot import fingerings from 
MusicXML files exported by Sibelius.
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String indicators

String indicators are commonly used in guitar music to tell performers the string on which they 
should play a note, particularly for pitches that are possible on multiple strings.

String indicators show the string number inside a circle enclosure, optionally with a dashed line 
to indicate they apply to a range of notes. Open pitches commonly appear as a zero without an 
enclosure.

In Dorico Pro, string indicators inside the staff for stopped pitches appear in a plain font while 
string indicators inside the staff for open strings use the fingering font when they appear as 
zero fingerings. If you want to edit the appearance of string indicators, you can do so in the Edit 
Playing Techniques dialog.

A phrase with string indicators and left-hand fingerings

There are two types of string indicators in Dorico Pro, which you input in different ways.

String indicators outside the staff
String indicators outside the staff always appear inside circle enclosures. They 
automatically show dashed duration lines when they have duration to indicate that 
multiple notes are played on that string.

In Dorico Pro, string indicators outside the staff are considered playing techniques. You 
can select and delete them independently of the notes to which they apply. You can 
also change the duration line style of string indicators outside the staff in the same 
ways as for playing technique continuation lines.

String indicator outside the staff with duration line

String indicators inside the staff
String indicators inside the staff appear inside circle enclosures, except when they 
show open strings, which appear as a bold number zero without an enclosure. They 
automatically erase their backgrounds so they do not collide with staff lines. They 
appear to the left of noteheads by default but automatically appear to the right if 
left-hand fingerings are present.

The string number shown in string indicators inside the staff is calculated 
automatically, but you can also specify the string manually.

String indicators inside the staff for stopped pitches are scaled-down versions of string 
indicators outside the staff. Therefore, changing the appearance of string indicators 
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in the Edit Playing Techniques dialog also affects the appearance of string indicators 
inside the staff for stopped pitches.

In Dorico Pro, string indicators inside the staff are considered properties of the 
corresponding notes. You can only select them independently of their corresponding 
notes in Engrave mode.

NOTE

You can only show string indicators inside the staff on notes belonging to fretted 
instruments.

String indicators inside the staff, with the last one for an open string

RELATED LINKS
Fingerings for fretted instruments on page 1169
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Playing techniques on page 1387
Playing technique duration on page 1394
Playing technique continuation lines on page 1393
Lengthening/Shortening items on page 436
Edit Playing Techniques dialog on page 877
Fingering font styles on page 1166
Assigning notes to strings on page 1255

Project-wide engraving options for string indicators
You can find options for the project-wide appearance and position of string indicators on the 
String Indicators page in Engraving Options.

The options on the String Indicators page allow you to change the appearance of open string 
indicators, the size of string indicators inside the staff, whether their notehead-relative position 
should change if left-hand fingerings are present, and the exact positions of string indicators 
relative to each other and other items.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840

String indicators
Project-wide engraving options for string indicators 
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Changing the appearance of open string indicators
You can change the appearance of all string indicators for open strings project-wide. By default, 
string indicators inside the staff for open strings appear as a bold number zero without a circle 
enclosure, similar to left-hand fingerings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click String Indicators.

3. In the Design section, choose one of the following options for Open string appearance:

● Zero fingering

● String number as indicator

● Zero as indicator

4. Click Apply, then Close.

RESULT
The appearance of all open string indicators inside the staff is changed project-wide. When open 
string indicators appear as Zero fingering, they use the fingering font style set for the project. 
This does not affect the appearance of string indicators outside the staff.

TIP

If you want to edit the appearance of all string indicators, you can do so in the Edit Playing 
Techniques dialog.

Changing the size of string indicators
You can change the size of all string indicators inside the staff project-wide; for example, if you 
want them to appear closer in size to string indicators outside the staff. You can also change 
whether or not they appear smaller on grace notes.

By default, string indicators inside the staff are scaled down to reduce their impact on note 
spacing and general readability, and are proportionally scaled down further on grace notes.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click String Indicators.

3. In the Design section, change the value for Scale factor for string indicators inside the 
staff.

4. Activate/Deactivate Scale string indicators on grace notes.

5. Click Apply, then Close.

RESULT
The size of string indicators inside the staff is changed project-wide. They appear smaller on 
grace notes when Scale string indicators on grace notes is activated, and always the same size 
when it is deactivated.

String indicators
Changing the appearance of open string indicators 
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Deleting string indicators
You can remove string indicators inside the staff from notes after you have input them. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains. However, 
because string indicators inside the staff are properties of notes rather than separate items, you 
cannot select and delete them as you would for other items.

NOTE

These steps only apply to string indicators inside the staff. You can delete string indicators 
outside the staff in the same ways as for other items.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes from which you want to remove string indicators inside the staff. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, deactivate Show in the String Indicators group.

RESULT
String indicators inside the staff are removed from the selected notes. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Deleting notes/items on page 459
Inputting string indicators inside the staff on page 383
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Positions of string indicators
String indicators outside the staff are placed above it by default. In multiple-voice contexts, 
string indicators for the up-stem voices are placed above the staff and string indicators for the 
down-stem voices are placed below the staff.

String indicators inside the staff automatically erase their backgrounds so they do not collide 
with staff lines. They appear to the left of noteheads by default but automatically appear to the 
right if left-hand fingerings are present. You can change the notehead-relative position of string 
indicators individually.

You can move string indicators outside the staff to different rhythmic positions in Write mode. 
They are positioned by default according to your settings in Engraving Options. You can also 
change the staff-relative placement of string indicators outside the staff individually, in the same 
ways as for playing techniques.

You can move string indicators graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

String indicators
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You can change the default positions of all string indicators project-wide on the String 
Indicators page in Engraving Options.

RELATED LINKS
Playing technique continuation lines on page 1393
Lengthening/Shortening items on page 436
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Changing the staff-relative placement of items on page 441

Changing the notehead-relative position of string indicators
By default, string indicators inside the staff appear to the left of noteheads when there are no 
left-hand fingerings and to the right of noteheads when there are left-hand fingerings. You can 
change the position of string indicators inside the staff relative to noteheads, independently of 
your project-wide settings. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the string indicators inside the staff whose notehead-relative position you want to 
change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Notehead-relative pos. in the String Indicators group.

3. Choose one of the following options:

● Left

● Right

RESULT
The notehead-relative position of the selected string indicators is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default notehead-relative positions of all string indicators inside the staff 
project-wide on the String Indicators page in Engraving Options. The available options include 
automatically changing the notehead-relative position if left-hand fingerings are present.

EXAMPLE

String indicators to the left of noteheads String indicators to the right of noteheads

String indicators
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Front matter

Front matter in Dorico Pro is a broad term that covers all information included before the first 
bar of music in scores.

Front matter includes musical information often added on pages before the first pages of scores, 
such as a title page, instrumentation list, program note, and performance instructions.

Front matter also includes information above the music on the first page of scores and parts, 
such as the dedication, title, subtitle, composer, and lyricist.

All information in your project that is independent of the music must be added within frames, 
which you can input and edit in Engrave mode. You can do this on individual pages in layouts 
or on page templates, which allow you to apply the same formatting to multiple pages in all the 
layouts that use the same page template set; for example, if you want the music frame for the 
last page in all part layouts to be smaller because it only contains a few systems.

TIP

An efficient way of keeping information consistent across all layouts is to use tokens that refer to 
fields in the Project Info dialog. The default page templates in Dorico Pro contain tokens for the 
project title, lyricist, and composer on the first pages in layouts, and the flow title (score layouts) 
or layout name (part layouts) at the top of subsequent pages. Part layouts also automatically 
show the layout name in the top left of the first page.

RELATED LINKS
Project Info dialog on page 78
Flow names and flow titles on page 188
Tokens on page 576
Page templates on page 527
Page template sets on page 529
Types of page templates on page 532
Creating page templates on page 535
Customizing page templates on page 541
Paragraph Styles dialog on page 848
Frames on page 560
Page formatting on page 689
Hiding/Showing flow headings on page 707
Editing layout transposition text on page 1191

Adding dedications in page templates
You can show dedications in multiple layouts by adding them to page templates. Dedications are 
usually shown above titles in scores, use a smaller font size than titles, and are shown in italics.

PREREQUISITE

● The right zone is shown.

● You have entered a dedication in one of the Dedication fields in the Project Info dialog. You 
can enter different dedications for the whole project and individual flows.
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● If you want to use a new paragraph style for dedications, you have created a new paragraph 
style.

PROCEDURE

1. In Engrave mode, open a layout in the music area that uses the page template set containing 
the page template to which you want to add a dedication.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Page Templates section of the Pages panel, double-click the page template to which 
you want to add a dedication to open the page template editor.

3. Double-click the title text frame to open the text editor.

TIP

When Frames  is selected in the Engrave toolbox, you can also select text frames and 
press Return .

4. Position the cursor at the start of the title token.

5. Press Return  to input a new line above the title token.

6. Enter one of the following tokens in the new line above the title token:

● {@flowDedication@} shows the dedication for the flow.

● {@projectDedication@} shows the dedication for the whole project.

7. Optional: Change the appearance of the dedication text using the text editor options.

8. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
A dedication is shown above the title of all pages that use the selected page template, provided 
you have entered a dedication into the appropriate field in the Project Info dialog.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Project Info dialog on page 78
Tokens on page 576
Paragraph Styles dialog on page 848
Text editor options in Engrave mode on page 584
Applying page template sets to layouts on page 692
Assigning page templates to pages on page 549

Front matter
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Adding player lists
You can add the player list token to any layout or page template. It automatically displays the 
names of all players in the layout, and includes all instruments held by each player.

PREREQUISITE

● If you want to add a player list to a page template, you have opened the page template in 
the page template editor.

● If you want to add a player list into a new text frame, you have input the text frame where 
you want the player list to appear.

PROCEDURE

1. Double-click the text frame to which you want to add a player list to open the text editor.

TIP

When Frames  is selected in the Engrave toolbox, you can also select text frames and 
press Return .

2. Enter {@playerlist@}.

3. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
The player list token is added. It is populated with a list of all players in the layout. If you added 
it to a page template, the text frame and token are automatically added to all pages in all layouts 
that use that page template.

NOTE

Pages with overrides are not updated if you edit the page template.

EXAMPLE

Player list token in a text frame Player list token populated with players in the layout

RELATED LINKS
Inputting frames on page 562
Page format changes on page 542
Page templates on page 527
Creating page templates on page 535

Editing running headers in page templates
The Default Part page template set shows the part name at the top left of the first pages in 
flows, and shows the part name centered at the top of subsequent pages as a running header. 
You can change the text shown in running headers; for example, if you want to include the flow 
title in part running headers, or remove the flow title from full score running headers.

Front matter
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PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open a layout in the music area that uses the page template set containing 
the page template whose running header you want to edit.

NOTE

You can also select the page template set from the Current set menu in the Page 
Templates section of the Pages panel when any layout is open in the music area; however, 
this changes the page template set applied to the layout.

2. In the Page Templates section of the Pages panel, double-click the page template whose 
running header text you want to change to open the page template editor.

3. Double-click the header text frame to open the text editor.

4. Change or delete the header text.

For example, to show both the part name and the flow title in the header text separated by a 
dash, enter  - {@flowTitle@} after the part name token in the text frame.

5. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
The running header text is changed for all layouts that use the selected page template.

EXAMPLE

Tokens added to a text frame Tokens populated in a part layout

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Page templates on page 527
Types of page templates on page 532
Page template editor on page 540
Changing the vertical alignment of text in text frames on page 587
Changing the horizontal alignment of text in text frames on page 588
Changing the paragraph style of text on page 1611
Hiding/Showing flow headings on page 707

Editing layout transposition text
You can override layout transposition token text in each layout independently; for example, if you 
want some layouts to display “Concert Pitch” but others to display “Full Score in C”.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Front matter
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2. In the Layouts list, select the layouts whose layout transposition text you want to edit.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Text Tokens section, activate the following options, individually or together:

● Custom text for concert layout

● Custom text for transposed layout

5. Enter the text you want into the corresponding value fields.

6. Click Apply, then Close.

RELATED LINKS
Tokens on page 576
Text frames on page 575
Entering text in text frames on page 583
Layouts on page 169
Concert vs. transposed pitch on page 174
Making layouts transposing/concert pitch on page 173

Hiding/Showing borders on layout names
You can hide/show borders on all layout names project-wide. By default, layout names appear 
with borders at the top of pages in part layouts that use the First page template.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. In the paragraph styles list, select Layout name.

3. Activate/Deactivate the checkbox for Border.

4. Optional: If you activated the checkbox, activate and change the available border options as 
required.

For example, you can change the border style and border thickness.

5. Click OK to save your changes and close the dialog.

RELATED LINKS
Paragraph Styles dialog on page 848
Player, layout, and instrument names on page 181
Renaming layouts on page 184
Tokens on page 576
Types of page templates on page 532
Adding borders to text frames on page 585
Adding borders to text items on page 1614
Changing the style of text item borders on page 1615

Front matter
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Grace notes

Grace notes are notes without a fixed duration, which are intended to be played quickly. They 
are scaled-down versions of normal notes, and are commonly shown with a slash through their 
stem.

Grace notes with slashed stems are known as “acciaccaturas” and are often played very fast. 
Grace notes without slashed stems are known as “appoggiaturas” and are often played slower 
than acciaccaturas. In Baroque music, appoggiaturas are often understood to last for a specific 
duration, based on the prevailing meter and the rhythmic value of the notehead to which they 
are attached. Therefore in Dorico Pro, slashed and unslashed grace notes are handled differently 
in playback.

Grace notes do not take up space rhythmically, as they are intended to be fitted into the space 
before the note to which they are attached, which is the note immediately to their right.

There can be multiple grace notes before a notehead. If there are two or more grace notes 
attached to the same notehead, and they have a rhythmic value that shows a flag on the stem, 
such as eighth notes (quavers) and 16th notes (semiquavers), they are automatically beamed 
together.

Multiple grace notes before notes

In Dorico Pro, grace notes are scaled to 3/5 the size of a normal notehead by default and are 
affected by your note spacing settings. There is a separate option specifically for grace note 
spacing.

You can add notations, such as slurs and articulations, to grace notes in the same ways as to 
normal notes, and you can transpose grace notes after they have been input.

RELATED LINKS
Inputting grace notes on page 250
Turning existing notes into grace notes on page 1195
Grace note slashes on page 1197
Grace notes in playback on page 1201
Slur placement relative to grace notes on page 1504
Changing the pitch of individual notes on page 479
Inputting articulations on page 271
Inputting slurs on page 273
Note spacing on page 599
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General placement conventions for grace notes
Grace notes function like normal notes in many ways, but there are some specific conventions 
about their stem direction, position relative to noteheads, and the placement of stem slashes.

Grace notes are always positioned before a notehead, even if they are intended to be played on 
the beat rather than before the beat. They are normally placed after a barline, so they can be 
positioned directly before the notehead to which they are attached. You can show grace notes 
before barlines instead; for example, if you have a group of three or more grace notes and want 
to reduce the gap between the barline and the first beat in the bar.

Grace note stem slashes appear at the beginning of grace note beams. If there is a single grace 
note, the slash appears across its stem and flag, if applicable, and extends either side of the 
stem.

Adding accidentals causes their spacing to readjust so that the accidentals are clearly legible, 
similar to normal notes.

Articulations can be added to grace notes wherever they are most clearly legible, which is most 
likely outside the staff. Dorico Pro automatically places articulations on the stem-side of grace 
notes, and outside the staff if the stem or beam is within the staff.

Grace notes in multiple-voice contexts

According to accepted notation convention, grace notes appear stem up by default when there is 
only one voice on a staff, even if the notehead to which they are attached is stem down.

However, when there are multiple voices on the staff, all notes in the upper voices appear stem 
up and all notes in the lower voices appear stem down, including grace notes. This also affects 
the curvature direction of slurs.

This adjustment happens automatically in Dorico Pro, but you can also change the stem direction 
of grace notes manually.

Slurs relative to grace notes

By default, slurs starting on grace notes and ending on tie chains end on the first note of the 
tie chain. You can change the position of individual slurs relative to tie chains, including those 
starting from grace notes.

You can change the default position of all slurs relative to grace notes, including in multiple-voice 
contexts, in Engraving Options > Slurs > Grace Notes.

In the Tied Notes section, you can change the default position of slurs relative to tie chains when 
slurs start on grace notes.

Grace notes
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TIP

● You can change the note spacing scale factor for grace notes in each layout independently 
on the Note Spacing page in Layout Options.

● You can change the default distance between grace notes and the noteheads to which they 
apply in Engraving Options > Notes > Grace Notes.

RELATED LINKS
Showing grace notes before/after barlines on page 1196
Slur placement relative to grace notes on page 1504
Slur position relative to tie chains on page 1503
Changing the stem direction of notes on page 1277
Layout Options dialog on page 834
Engraving Options dialog on page 840

Turning existing notes into grace notes
You can turn any existing notes into grace notes; for example, if you want to edit music you input 
using MIDI recording.

PROCEDURE

1. In Write mode, select the notes that you want to turn into grace notes.

2. Optional: Change the grace note type to slashed/unslashed in any of the following ways:

● Press Alt/Opt-/ .

● In the Notes toolbox, click and hold Grace Notes , then click Unslashed Grace Notes 
 or Slashed Grace Notes .

3. Do one of the following:

● Press / .

● In the Notes toolbox, click Grace Notes .

RESULT
The selected notes are turned into grace notes with the same notated duration. However, any 
rhythm dots are removed.

By default, slashed grace notes attach to the rhythmic position following the last selected note in 
each range, while unslashed grace notes attach to the rhythmic position of the first selected note 
in each range.

TIP

You can change the default direction when turning existing notes into grace notes in 
Preferences > Note Input and Editing > Editing.

AFTER COMPLETING THIS TASK
You can change the duration of grace notes.

RELATED LINKS
Notes toolbox on page 197
Inputting grace notes on page 250
Changing the duration of notes on page 259

Grace notes
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Changing the type of grace notes on page 1197
Turning existing notes into tuplets on page 1671
Preferences dialog on page 61

Turning grace notes into normal notes
You can turn any existing grace notes into normal notes starting from their original rhythmic 
position; for example, if you want to turn a run of grace notes at the start of a flow into standard 
notes in a pick-up bar.

PROCEDURE

1. In Write mode, select the grace notes you want to turn into normal notes.

2. Optional: If you want the selected grace notes to push subsequent notes to later rhythmic 
positions if required, press I  to activate Insert mode.

3. Optional: If you activated Insert mode, choose the appropriate Insert mode scope.

4. Do one of the following:

● Press / .

● In the Notes toolbox, click Grace Notes .

RESULT
The selected grace notes are turned into normal notes with the same notated duration. For 
example, an eighth grace note becomes a standard eighth note.

If Insert mode was activated, subsequent existing notes are pushed to later rhythmic positions to 
accommodate the extra rhythmic durations if required. If Insert mode was deactivated, the grace 
notes expand and overwrite subsequent notes.

RELATED LINKS
Turning tuplets into normal notes on page 1672
Pick-up bars on page 1643
Insert mode on page 454
Insert mode scopes on page 455

Showing grace notes before/after barlines
By default, grace notes are positioned after barlines and directly before the notehead to which 
they apply, including for the first note in a bar. You can position individual grace notes before 
barlines; for example, so the first normal note in the bar is not pushed too far from the barline, 
or to indicate that grace notes are played before the beat.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the grace notes whose position relative to barlines you want to change. You can do 
this in Write mode and Engrave mode.

Grace notes
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2. In the Properties panel, activate/deactivate Grace note before barline in the Grace Notes 
group.

RESULT
Grace notes at the selected rhythmic positions are positioned before barlines when the property 
is activated, and after barlines when the property is deactivated.

NOTE

This affects all grace notes at the selected rhythmic positions.

RELATED LINKS
Engrave toolbox on page 514
Barlines on page 967
Inputting grace notes on page 250

Grace note size
Grace notes are smaller versions of normal notes, and are scaled down by a ratio that is set by 
default to 3/5 of a normal note.

You can find the ratio that controls the default size of all grace notes project-wide in the Grace 
Notes section of the Notes page in Engraving Options.

You can also change the size of grace notes individually in the same way as for normal notes.

RELATED LINKS
Engraving Options dialog on page 840
Changing the size of notes/items on page 440

Grace note slashes
Slashes shown diagonally across grace note stems are often used to distinguish different types 
of grace notes. Grace notes with slashed stems are known as acciaccaturas and are often played 
very fast. Grace notes without slashed stems are known as appoggiaturas and are often played 
slower than acciaccaturas.

In Dorico Pro, grace notes appear with slashed stems by default. You can change whether grace 
notes are slashed or unslashed during note input as well as by changing the type of existing 
grace notes.

TIP

You can change the default thickness, length, and position of all grace note stem slashes project-
wide in Engraving Options > Notes > Grace Notes.

Changing the type of grace notes
You can change the type of individual grace notes after they have been input. Grace notes have 
slashed stems by default, but you can change them to have unslashed stems.

PREREQUISITE

● The lower zone is shown.

Grace notes
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the grace notes whose type you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, choose one of the following options for Grace note type in the 
Grace Notes group:

● Slashed stem 

● Unslashed stem 

RESULT
The selected grace notes are shown with slashed/unslashed stems.

TIP

You can also change the type of selected grace notes by pressing Alt/Opt-/  or clicking and 
holding Grace Notes  in the Notes toolbox, then clicking Unslashed Grace Notes  or 
Slashed Grace Notes .

Moving slashes on grace note stems
You can change the vertical position of individual grace note slashes, independently of your 
project-wide settings. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the grace notes whose slash positions you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Grace Notes group:

● Slash inset from stem tip

● Slash offset to right

3. Change the values in the value fields.

RESULT
Increasing Slash inset from stem tip moves grace note slashes further from the tips of stems 
and closer to the noteheads. Decreasing the value moves them closer to the tips of stems and 
further from the noteheads.

Increasing Slash offset to right moves grace note slashes to the right, decreasing the value 
moves them to the left.

Grace notes
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If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can change the default position of all grace note slashes project-wide in the Grace Notes 
section of the Notes page in Engraving Options.

RELATED LINKS
Inputting grace notes on page 250
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the length of grace note slashes
You can change the length of slashes on grace note stems individually, independently of your 
project-wide setting. You can do this for the current layout and frame chain only, or for all layouts 
and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the grace notes whose slash length you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Grace Notes group:

● Slash length

● Slash protrusion from beam (beamed grace notes only)

NOTE

Grace note slashes seem to disappear when you activate Slash length because activating 
the property resets the value to 0.

3. Change the length and/or protrusion of the selected slashes by changing the values in the 
corresponding value fields.

RESULT
Increasing Slash length lengthens grace note slashes on both single grace notes and grace note 
beams, decreasing the value shortens grace note slashes.

Increasing Slash protrusion from beam increases how far slashes extend beyond grace note 
beams, decreasing the value decreases how far slashes extend beyond grace note beams.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Grace notes
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TIP

You can change the default appearance of all grace note slashes project-wide in the Grace Notes 
section of the Notes page in Engraving Options.

Grace note stems
Grace notes are scaled-down notes, so the length of grace note stems is determined by your 
project-wide settings for the stem length of all notes.

You can change the default lengths of all stems project-wide in the Stems section of the Notes 
page in Engraving Options.

Following accepted conventions, grace notes in Dorico Pro are stem up by default in any clef, 
regardless of the stem direction of the note to which they apply. The stem directions of grace 
notes are changed automatically when there are multiple voices on a staff, but you can change 
the stem direction of individual grace notes manually. You can also lengthen/shorten grace note 
stems in the same ways as for normal stems.

RELATED LINKS
Stems on page 1273
Changing the stem direction of notes on page 1277
Lengthening/Shortening stems on page 1279
Hiding/Showing stems on page 1280

Grace note beams
Dorico Pro automatically beams multiple adjacent grace notes together if they are an eighth note 
(quaver) or shorter in duration.

Like all beams, grace note beams ideally follow the accepted standards for beam placement 
relative to staff lines, in order to avoid wedges. However, because grace notes are smaller than 
normal notes, this can lead to extreme slants in grace note beams.

You can adjust the slants of individual grace note beams in the same ways as for normal beams. 
You can also change how all grace note beam slants are positioned project-wide in the Vertical 
Position section of the Beams page in Engraving Options.

Beam slants in two-note groups of beamed grace notes

If two adjacent grace notes covering a wide pitch range are joined by a beam at the same 
rhythmic position, the angle of the beam can appear very steep.

You can choose whether the beam slant in such cases is left unchanged, or whether shallower 
slants are used, in Engraving Options > Beams > Slants > Grace Notes.

RELATED LINKS
Engraving Options dialog on page 840
Beaming on page 998
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Grace notes in playback
Slashed and unslashed grace notes are handled differently in playback.

Slashed grace notes of any note duration, and unslashed grace notes a 16th note or shorter, play 
back before the beat with a single default sounding duration.

Unslashed grace notes an eighth note or longer play back on the beat. Their sounding duration 
is half the note duration of the note to which they are attached. For example, if an unslashed 
eighth note grace note is attached to a quarter note, both notes play back as if they were eighth 
notes.

You can change whether single unslashed grace notes play on or before the beat, the maximum 
note duration for unslashed grace notes to play back as short appoggiaturas, and the default 
sounding duration of grace notes in the Grace Notes section of the Timing page in Playback 
Options.

RELATED LINKS
Playback Options dialog on page 842
Inputting grace notes on page 250
Grace note slashes on page 1197

Grace notes
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Holds and pauses

Different notations are used to show where the established rhythmic flow of the music is 
interrupted, either with a moment of repose or a short silence, before continuing. The most 
subtle effect is produced by a tenuto mark, with more significant effects denoted with holds and 
pauses.

The duration of the break in the music intended by the hold or pause does not need to be 
specified. This leaves significant room for interpretation, even though the different styles of 
holds and pauses normally indicate larger or smaller breaks.

In Dorico Pro, there are the following types of holds and pauses:

Fermatas
Fermatas indicate that a note is held for longer than its notated length, which applies 
to the whole ensemble. In Dorico Pro, fermatas exist globally at the corresponding 
rhythmic positions, meaning they are automatically shown on all staves and voices.

They are also known as “pauses” and informally sometimes called “birds’ eyes”.

Breath marks
Breath marks show suitable places for players to breathe, or suggest how the music is 
phrased to create a similar effect.

Caesuras
Caesuras indicate that a note is sustained for its full value and is followed by a break 
in sound before continuing. In Dorico Pro, caesuras exist globally at the corresponding 
rhythmic positions, meaning they are automatically shown on all staves.
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NOTE

Holds and pauses do not currently have an effect in playback, but this is planned for future 
versions.

RELATED LINKS
Input methods for holds and pauses on page 337
Types of fermatas on page 1203
Types of breath marks on page 1204
Types of caesuras on page 1204

Project-wide engraving options for holds and pauses
You can find options for the project-wide positions of holds and pauses on the Holds and Pauses 
page in Engraving Options.

The options on the Holds and Pauses page allow you to change the default positions and 
placement of holds and pauses, including the placement of fermatas in multiple-voice contexts.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840

Types of fermatas
There are different types of fermatas available in Dorico Pro. Each fermata indicates a suggested 
pause duration whilst leaving room for interpretation.

Fermata Description

Very short fermata Indicates that a note is held only a fraction 
longer than the rhythm indicates.

Short fermata Indicates that a note is held a little bit longer 
than the rhythm indicates.

Short fermata (Henze) Indicates that a note is held a little bit longer 
than the rhythm indicates, as used by Hans 
Werner Henze.

Fermata Indicates that a note is held for longer than the 
rhythm indicates.

Long fermata Indicates that a note is held quite a lot longer 
than the rhythm indicates.

Long fermata (Henze) Indicates that a note is held quite a lot longer 
than the rhythm indicates, as used by Hans 
Werner Henze.

Holds and pauses
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Fermata Description

Very long fermata Indicates that a note is held for much longer 
than the rhythm indicates.

Curlew (Britten) Indicates that a note or rest is held until the 
next synchronization point in asynchronous 
music, as used by Benjamin Britten.

Fermatas can be divided into two styles. Because their meanings overlap, it can be confusing for 
players if both styles are used in a single project.

Style Very short 
fermata

Short 
fermata

Fermata Long fermata Very long 
fermata

Standard

Henze N/A N/A

RELATED LINKS
Input methods for holds and pauses on page 337
Changing existing items on page 439
Changing the vertical position of breath marks on page 1208

Types of breath marks
There are different types of breath marks available in Dorico Pro. Breath marks indicate a 
suitable place for a player to take a breath, or create a musical effect like a breath.

Comma-like Tick-like Upbow-like Salzedo

Types of caesuras
There are different types of caesuras available in Dorico Pro. All caesuras indicate a break in 
sound, but different types are often needed for different styles of musical scores.

Caesura Thick caesura Short caesura Curved caesura Single-stroke 
caesura

Two diagonal 
slashes

Two thick diagonal 
slashes

Two straight, 
vertical slashes

Two curved 
diagonal slashes

One straight, 
vertical slash

Holds and pauses
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If you intend to communicate a specific length of hold or gap with each type of caesura, we 
recommend that you consider adding a legend, as different players may interpret these symbols 
differently.

RELATED LINKS
Input methods for holds and pauses on page 337
Changing existing items on page 439

Positions of holds and pauses
Holds and pauses are placed above the staff by default in single-voice contexts, and are shown 
on all staves at the closest rhythmic position available; for example, if a single staff has a fermata 
on the last beat in the bar, it is shown above the bar rests on the other empty staves. For staves 
with multiple voices, fermatas are also shown inverted below the staff.

You can move holds and pauses to different rhythmic positions in Write mode. They are 
positioned by default according to your settings in Engraving Options.

You can move holds and pauses graphically in Engrave mode; however, this does not change the 
rhythmic positions to which they are attached.

You can change the default positions of all holds and pauses project-wide, and values for the 
minimum gaps around holds and pauses, on the Holds and Pauses page in Engraving Options.

Fermatas

Fermatas are positioned horizontally so that they are centered on front noteheads in the first 
voice column, regardless of the stem direction of notes.

Fermatas affect the overall tempo of the piece, so all players must be able to see where 
they occur. Therefore, fermatas are shown on all staves at the same rhythmic position, or the 
rhythmic position of the note, chord, or rest that corresponds with the end of the fermata, 
including over a bar rest if a staff has no notes in that bar.

Breath marks

Breath marks are placed above the top line of the staff by default, at the end of the note to which 
they apply; that is, they appear just before the following note.

Holds and pauses
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Breath marks apply only to the staff to which they were added, as they do not affect the overall 
tempo, but instead only indicate to a single player or group of players a suitable place to break 
their line in order to breathe.

Caesuras

Caesuras are positioned at the top of the staff, with the top staff line passing through the 
middle of the caesura and the bottom of the caesura resting on the second staff line. They are 
commonly placed at the end of a bar, before the barline.

Caesuras are automatically added to all staves at the same rhythmic position, immediately to the 
left of the notehead or barline to which they were input. They are not linked to noteheads, and 
adjust note spacing to create a clear gap.

RELATED LINKS
Engraving Options dialog on page 840
Input methods for holds and pauses on page 337
Moving notes/items rhythmically on page 465
Moving items graphically on page 609

Multiple holds and pauses at the same rhythmic position
Because fermatas apply to all staves, only one type of fermata can exist at the same rhythmic 
position. For example, you cannot have a short fermata on one staff and a long fermata at the 
same rhythmic position on another staff.

A Britten curlew can be used at the same rhythmic position as another kind of fermata, but it 
cannot exist simultaneously with any breath mark. This is the only exception in Dorico Pro.

Caesuras can co-exist with any type of breath mark, but you cannot have a caesura and a fermata 
at the same rhythmic position.

RELATED LINKS
Input methods for holds and pauses on page 337
Moving notes/items rhythmically on page 465
Rhythmic position on page 27

Changes to fermatas on single staves
Changing the type of fermata or caesura on one staff automatically changes the type on all 
staves at that rhythmic position, as a pause at one particular rhythmic position can only be of 
one duration.

However, if you override a particular fermata on one staff, for example, by changing it to a 
Britten curlew or a breath mark, changing the existing fermata on another staff does not change 
the marking on the overridden staff. Deleting the marking on the overridden staff reverts that 
marking to match the fermata on the other staves.

For example, changing a fermata to a breath mark changes the marking for only that staff. That 
note is not affected when the type of fermata on the other staves at that rhythmic position is 
changed.

Holds and pauses
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The bottom staff is overridden to 
show a breath mark instead of a 
fermata.

The fermata is changed to a 
very short fermata, but the 
bottom staff is exempt as it was 
overridden to show a breath mark.

Deleting the breath mark from the 
bottom staff returns it to showing 
the fermata currently chosen for 
that rhythmic position.

Changing the number of fermatas per staff
You can change the maximum number of fermatas that appear on each staff at individual 
positions when there are multiple voices on a staff.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the fermatas whose maximum number per staff you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Max. fermatas per staff in the Holds and Pauses group.

3. Select one of the following options from the menu:

● One per voice

● One per each side of staff

● One per staff

RESULT
The number of fermatas shown at the selected positions is changed.

TIP

You can change the maximum number of fermatas that can appear on a single staff project-wide 
on the Holds and Pauses page in Engraving Options.

RELATED LINKS
Project-wide engraving options for holds and pauses on page 1203
Engraving Options dialog on page 840
Engrave toolbox on page 514

Holds and pauses
Positions of holds and pauses 
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Positioning fermatas on barlines
You can position individual fermatas over a barline instead of over a note to indicate a gap 
before the start of the following bar.

NOTE

Fermatas cannot be positioned on barlines if Max. fermatas per staff is also activated.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the fermatas you want to position over barlines. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Attach to barline in the Holds and Pauses group.

RESULT
The selected fermatas are positioned above the barline at the end of the bars they were in 
originally, appearing only above staves that are not joined by the barline. Depending on the 
instrumentation, this may mean they only appear at the top of the system.

Deactivating Attach to barline returns the selected fermatas to their default positions.

EXAMPLE

Fermata input on last quarter note in the bar Fermata positioned on barline

Changing the vertical position of breath marks
You can change the default vertical position of all breath marks project-wide; for example, if you 
want to place all breath marks immediately above the staff. By default, breath marks are placed 
halfway between the noteheads on either side.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Holds and Pauses.

3. In the Vertical Position section, choose one of the following options for Vertical position of 
breath mark:

Holds and pauses
Positions of holds and pauses 
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● Outside outermost staff line

● Above notehead

● Halfway between noteheads

4. Click Apply, then Close.

RESULT
The default vertical position of all breath marks project-wide is changed.

EXAMPLE

Breath mark positioned outside 
outermost staff line

Breath mark positioned above 
notehead

Breath mark positioned halfway 
between noteheads

RELATED LINKS
Engraving Options dialog on page 840
Types of fermatas on page 1203
Types of breath marks on page 1204
Types of caesuras on page 1204
Positions of holds and pauses on page 1205
Input methods for holds and pauses on page 337
Moving items graphically on page 609

Holds and pauses
Positions of holds and pauses 
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Key signatures

Key signatures are the markings that show the current key of music by indicating which notes in 
the scale for that key are sharpened or flattened. They are shown at the start of each system on 
every applicable staff.

Traditionally, accidentals are organized following the pattern of the circle of fifths, which is 
different for sharp keys and flat keys.

Using key signatures saves space, as by indicating which notes are generally going to be sharp or 
flat in the music in one group at the start of each system, these notes do not need an accidental 
beside them every time they occur.

Once you have input a key signature, all notes you subsequently input follow the key signature; 
for example, if you input an F  after inputting a G major key signature, an F♯ is input 
automatically.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

Instruments that do not usually have key signatures, such as timpani or horn, have a No key 
sig version in Dorico Pro which never show key signatures. You can select the appropriate 
instrument type from the instrument picker when adding or changing instruments.

Flows without any key signatures are treated as if there were an open/atonal key signature 
rather than A minor or C major.

By default, key signatures apply to all staves. However, there are certain situations, such as in 
polytonal music, where some parts require their own key signature, independently of the rest of 
the ensemble. You can input key signatures that apply to all staves or only apply to single staves 
in Dorico Pro.

In Dorico Pro, key signatures exist within the overarching tonality system for your project. The 
two tonality systems that come as standard in Dorico Pro are 12-EDO and 24-EDO.

Once you have selected or created a tonality system for your project, you can create custom key 
signatures and custom accidentals within that tonality system.

NOTE

● You cannot hide key signatures as they provide crucial information about the pitch of notes. 
If you do not want to see a key signature, you can input an open key signature or delete all 
key signatures from the flow or project.

● You do not have to input multiple simultaneous key signatures if you have transposing 
instruments in your score. Dorico Pro handles instrument transpositions automatically.
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RELATED LINKS
Input methods for key signatures on page 278
Types of key signatures on page 1212
Tonality systems on page 1219
Custom tonality systems on page 902
Instrument picker on page 113
Note input on page 220
Deleting notes/items on page 459
Transposing instruments on page 137
Concert vs. transposed pitch on page 174
MIDI Import Options dialog on page 90

Project-wide engraving options for key signatures
You can find options for the project-wide appearance and spacing of key signatures in Engraving 
Options.

The options on the Key Signatures page allow you to change the key signature cancellation style 
and the spacing gaps between accidentals in key signatures.

On the Spacing Gaps page, there are options that affect spacing around key signatures, such as 
between barlines and clefs, key signatures, and time signatures.

TIP

If you want to change the barline shown at key signature changes, you can find this option on 
the Barlines page in Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Changing the barline shown at key signature changes on page 972

Key signature arrangements
Dorico Pro automatically follows conventions for the placement and appearance of key 
signatures, such as showing accidentals in the accepted circle of fifths order and positioning 
key signatures between clefs and time signatures.

The order in which accidentals are shown in key signatures is different for sharp keys and flat 
keys.

● For sharps: F♯, C♯, G♯, D♯, A♯, E♯, B♯
● For flats: B♭, E♭, A♭, D♭, G♭, C♭, F♭
Accidentals are arranged automatically in these orders in Dorico Pro for all standard Western key 
signatures. There is an accepted pattern for the placement of accidentals in a key signature, so 
that they fit inside the staff according to the current clef. The pattern of accidentals is the same 
in all clefs, apart from the tenor clef, which requires sharp key signatures to follow a different, 
ascending pattern to ensure the accidentals fit on the staff.

Key signatures
Project-wide engraving options for key signatures 
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Clef Arrangement of sharps Arrangement of flats

Treble

Bass

Alto

Tenor

NOTE

For custom, non-standard key signatures, you can determine the order in which accidentals 
appear in the Edit Custom Key Signature dialog.

RELATED LINKS
Custom key signatures on page 910
Changing the barline shown at key signature changes on page 972
Positions of key signatures on page 1214

Types of key signatures
There are multiple types of key signatures in Dorico Pro, which can all be input, moved, and 
deleted in the same ways.

Major and minor key signatures

The key signature for a major key appears the same as the key signature for its relative minor, 
and vice versa. For example, B♭ major has two flats in its key signature. This is the same number 
of flats as for G minor, which is the relative minor key to B♭ major. The difference is that music 
in G minor usually has sharpened Fs, as the seventh degree of the scale is raised in minor keys. 
Therefore, if you input an F♯/G♭ after a G minor key signature, Dorico Pro prefers to spell it as F♯ in 
most cases, in order to follow the convention of harmonic minor keys.

A B flat major scale following a B flat major key 
signature

A G minor scale following a G minor key signature

Key signatures
Types of key signatures 

1212
Dorico Pro 4.3.30



Open key signature

Although open, or atonal, key signatures appear the same as C major or A minor key signatures 
because none shows any accidentals, open key signatures behave differently.

In an open key signature, the spelling of accidentals is based on the current direction of the 
music. If the music is rising, sharps are preferred, whereas if the music is falling, flats are 
preferred. There is no hierarchy of pitches in an open key signature, so the same pitch might be 
spelled differently each time it appears depending on its context, even within a few bars.

In a C major or A minor key signature, accidentals are spelled based on the context of the major 
or minor tonality implied. For example, in C major, sharps in general are preferred, whether the 
music is going up or going down. Similarly, in A minor, G♯ in particular is preferred, whether the 
music is going up or going down, as G♯ is the leading note in A minor.

No key signature

Some instruments are accustomed to seeing no key signatures in their parts, no matter the 
overall key of the piece. These instruments include timpani, percussion, horn, trumpet, and 
sometimes the harp. If you have added the No key sig version of these instruments, then no 
key signature is shown in their parts, even if they are a transposing instrument, such as horn or 
trumpet.

Any pitch can be input into these instruments, and they show accidentals if needed.

RELATED LINKS
Input methods for key signatures on page 278
Instrument picker on page 113
Adding instruments to players on page 138

Hiding/Showing key signatures at the start of systems
By default, key signatures are shown at the start of all systems. You can hide/show key 
signatures at the start of single-staff systems from the second system onwards in each flow 
independently.

Hiding key signatures on single-staff systems after the first system is a convention used in 
hand-copied lead sheets, usually in combination with hiding clefs and showing systemic barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show key signatures after the 
first system.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Key Signatures.

4. Choose one of the following options for Key signatures at start of systems following first 
system:

● Show key signatures

● Hide key signatures

5. Click Apply, then Close.

Key signatures
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RESULT
Key signatures are hidden or shown at the start of single-staff systems from the second system 
onwards in the selected flows.

NOTE

● Key signature changes that occur at system breaks after the first system are always shown.

● Key signatures are always shown at the start of systems that contain more than one staff.

RELATED LINKS
Hiding/Showing systemic barlines on single-staff systems on page 973
Hiding/Showing clefs at the start of systems on page 1075

Hiding/Showing cancellation naturals before key signature 
changes

You can hide/show cancellation naturals before all key signature changes project-wide. When 
showing cancellation naturals, you can choose to show them before or after barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Key Signatures.

3. Choose one of the following options for Cancellation naturals at changes of key 
signature:

● Common practice

● Traditional

● Russian

4. Click Apply, then Close.

RELATED LINKS
Engraving Options dialog on page 840
Accidental duration rules on page 951
Changing the cancellation of double accidentals on page 953
Changing the barline shown at key signature changes on page 972

Positions of key signatures
Key signatures are positioned between clefs and time signatures by default, and are shown 
on every staff that requires a key signature. They are not shown on staves for unpitched 
instruments.

Key signatures are shown at the start of a piece and at the start of subsequent movements, 
even if the music carries straight on and in the same key. Unlike time signatures, key signatures 
appear at the start of every system, even if the key signature has not changed. They apply until 
the end of the flow or until the next key signature change, whichever comes first.

Key signatures
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The correct position for key signatures is between clefs and time signatures.

If a key signature change occurs during a piece or movement, it should be placed immediately 
after a barline. It is customary to have a double barline where a key signature change takes 
place, which is the default setting in Dorico Pro. However, you can change the default barline 
shown at key signature changes.

Examples of key signatures positioned after double barlines

You can move key signatures to new rhythmic positions in Write mode. They are positioned 
according to your settings on the Key Signatures and Spacing Gaps pages in Engraving 
Options.

If you find you need to move individual key signatures graphically, you can do this in Engrave 
mode, but this does not change their rhythmic positions.

If you want to adjust the default position of key signatures relative to notes or barlines, you 
must change the project-wide values for spacing gaps on the Spacing Gaps page in Engraving 
Options.

RELATED LINKS
Cautionary key signatures on page 1216
Key signature arrangements on page 1211
Engraving Options dialog on page 840
Moving notes/items rhythmically on page 465
Moving key signatures graphically on page 1215
Changing the barline shown at key signature changes on page 972

Moving key signatures graphically
You can make individual changes to the graphical position of key signatures without affecting the 
positions of any other items.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the square note spacing handle above the key signature you want to 
move.

A smaller circular handle appears beside the key signature.

2. Press Tab  to select the circular handle.

Key signatures
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3. Move the handle in any of the following ways:

● To move it a standard amount to the right or left, press Alt/Opt  plus the corresponding 
arrow key. For example, press Alt/Opt-Left Arrow  to move handles to the left.

● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.

RESULT
The key signature is moved graphically to the right/left.

TIP

When Graphic Editing  is selected in the Engrave toolbox, you can also change Spacing 
offset in the Key Signatures group of the Properties panel to move key signatures horizontally. 
However, this also affects global note spacing at the rhythmic position of the key signature, 
including moving cancellation naturals.

You can also move cancellation naturals graphically, independently of the subsequent key 
signature and without affecting the spacing of any other item using the Cancellation naturals X 
offset property.

RELATED LINKS
Engrave toolbox on page 514
Note spacing on page 599

Cautionary key signatures
When a key signature change occurs at a system break, either in the score or in a part, the new 
key signature is shown at the end of the first system as well as at the start of the new system.

This is sometimes considered a “cautionary key signature”, as players become used to seeing the 
key signature at the start of the system and therefore may miss a change of key signature if it is 
not conspicuously shown at the end of systems.

In Dorico Pro, the key signatures shown at the end of one system and at the start of the next 
system are the same item, not separate items. You cannot hide cautionary key signatures.

If the music is separate enough that you do not want to see a key signature at the end of a 
system and you cannot change where the system break occurs, you can separate the music by 
creating a new flow at the point of the system break.

Key signatures
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RELATED LINKS
Flows on page 166
Splitting flows on page 506
Hiding/Showing key signatures at the start of systems on page 1213
Hiding/Showing cancellation naturals before key signature changes on page 1214
System breaks on page 733
Cautionary time signatures on page 1643
Clefs on page 1070

Enharmonic equivalent key signatures
Enharmonic equivalent key signatures are keys with different names that include the same 
pitches, such as C♯ major and D♭ major. Dorico Pro follows the convention for transposing to keys 
with the same type of accidental as the previous key, except where the enharmonic equivalent 
key signature has fewer accidentals.

When transposing selections of notes, Dorico Pro prefers keys with the same type of accidental 
as the previous key signature. When choosing key signatures for transposing instruments, Dorico 
Pro prefers key signatures with the same type of accidental as the current concert pitch key.

However, there are some instances where you might prefer to transpose to a key with a different 
type of accidental as it has fewer accidentals than the enharmonic equivalent key. For example, 
C♯ major has seven sharps, whereas the enharmonic equivalent key of D♭ major only has five 
flats. This means the player has to remember the accidentals for fewer notes.

Transposing to an enharmonic equivalent key with fewer accidentals can have the added benefit 
of improving readability by avoiding double sharps or double flats. For example, transposing 
music from F♯ to G♯ requires the leading note to be spelled as an F, but transposing to A♭ instead 
means the leading note is G♮.

G♯ major requires a double sharp leading note A♭ major, the enharmonic equivalent to G♯, does not 
require a double sharp leading note

By default, Dorico Pro selects an enharmonic equivalent key signature if it has fewer accidentals. 
You can change this setting in each flow independently.

How key signatures affect transposing instruments

If there is a key signature in the full score, it is transposed for a transposing instrument by the 
same degree as the transposing interval for the instrument. For example, in a project in E major, 
a B♭ clarinet part has a key of F♯ major, as a B♭ clarinet sounds a whole step (tone) below its 
notated pitch.

Instruments that do not show a key signature

Some instruments are accustomed to seeing no key signatures in their parts, no matter the 
overall key of the piece. These instruments include timpani, percussion, horn, trumpet, and 
sometimes the harp. If you have input the No key sig version of these instruments, then no 
key signature is shown in their parts, even if they are a transposing instrument, such as horn or 
trumpet.

Key signatures
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You can still transpose music in the staves of these instruments, but they show accidentals as 
necessary, instead of showing a key signature.

RELATED LINKS
Notation Options dialog on page 837
Transpose dialog on page 481
Transposing selections on page 480
Respelling notes on page 484
Adding instruments to players on page 138
Concert vs. transposed pitch on page 174
Transposing instruments on page 137

Allowing/Disallowing enharmonic equivalent key signatures
By default, Dorico Pro selects enharmonic equivalent key signatures if they have fewer 
accidentals when transposing selections that include a key signature and in transposing layouts. 
You can change this setting in each flow independently; for example, if you want all layouts to 
have flats in their key signatures, regardless of the number of accidentals.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to allow/disallow enharmonic equivalent 
key signatures.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Accidentals.

4. In the Transposition section, activate/deactivate Prefer enharmonic equivalent key 
signatures with fewer accidentals.

5. Click Apply, then Close.

RESULT
Enharmonic equivalent key signatures with fewer accidentals are allowed when the option is 
activated, and disallowed when the option is deactivated. This affects resulting key signatures 
when transposing selections that include a key signature and in transposing layouts.

Key signatures
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Tonality systems

The term “tonality system” is used in Dorico Pro to encompass three crucial elements that 
together make up the concept of tonality.

The three elements that make up tonality systems are:

● A number of equal divisions of the octave, or EDO. For example, standard Western scales 
with half-step (semitone) steps have 12-EDO.

● A set of accidentals. This allows you to notate how much a note is raised or lowered. This can 
be a traditional or a custom set of accidentals, either selected from the wide variety available 
or of your own design.

● A key signature. This can be a traditional Western key signature, or a custom key signature of 
your own design.

Dorico Pro provides the following tonality systems in each project by default:

● Equal temperament (12-EDO): Contains twelve half-step (semitone) steps

● Equal temperament (24-EDO, Gould arrows): Contains 24 quarter tone steps and uses 
Gould arrow quarter tone accidentals

● Equal temperament (24-EDO, Stein-Zimmermann): Contains 24 quarter tone steps and 
uses Stein-Zimmermann quarter tone accidentals

You can find existing tonality systems in your project in the Tonality System section of the Key 
Signatures, Tonality Systems, and Accidentals panel.

RELATED LINKS
Custom tonality systems on page 902
Changing the tonality system on page 1220
Playback of custom tonality systems on page 912
Key Signatures, Tonality Systems, and Accidentals panel on page 280
Edit Tonality System dialog on page 905

Equal Division of the Octave (EDO)
EDO stands for Equal Division of the Octave: the number of equal pieces, or intervals, into which 
an octave is divided. In Dorico Pro, you can create any number of divisions of an octave and 
design custom key signatures and custom accidentals for each tonality system.

Traditional Western harmony is based on equal temperament, another method used to describe 
tonality systems, or 12-EDO, as the traditional scale from C-C is made up of twelve steps spread 
across the seven notes in the scale.

When you edit the 12-EDO tonality system in the Edit Tonality System dialog, you can see how 
these steps are divided across each interval in the scale. For example, between the notes A and 
B there are two steps, but between B and C there is one step. This is because in 12-EDO, each 
step represents a half-step (semitone), and there are two half-steps between A and B according 
to standard equal temperament, but only one half-step between B and C.

To have the smallest step in the tonality system be a quarter tone rather than a half-step 
(semitone), the octave must be divided into twice as many equal divisions as 12-EDO. Therefore, 
to be able to use quarter tone accidentals, you must change to a 24-EDO tonality system.
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Although you can divide the octave into any number of divisions, to be able to show a standard 
Western key signature, the number of equal divisions in the octave must be divisible by 12.

EDO also allows you to map non-conventional Western pitches on to the seven note names A-G, 
and create a coherent notation to express that, because there is no limit to how you can divide 
the octave. For example, Turkish music is traditionally divided in 53-EDO, the division of which 
is usually spread across the notes A-A with the following number of divisions for each interval: 
9-4-9-9-9-4-9.

Changing the tonality system
You can change the tonality system used in your project at key signature changes, including 
changing to a custom tonality system you have created.

PREREQUISITE
You have created or imported any custom tonality systems you want to use.

PROCEDURE

1. In Write mode, click Panels , then Key Signatures, Tonality Systems, and Accidentals 
 in the Notations toolbox to show the Key Signatures, Tonality Systems, and Accidentals 

panel.

2. In the music area, select an item at the position from which you want to change the tonality 
system.

3. Without deselecting the item, select the tonality system you want from the menu in the 
Tonality System section of the Key Signatures, Tonality Systems, and Accidentals panel.

4. Input a new key signature.

NOTE

● If you do not want to show a key signature, you can input an atonal key signature.

● Key signatures in the Used in This Flow section of the Key Signatures, Tonality Systems, 
and Accidentals panel retain their original tonality system. We recommend inputting a 
new key signature from scratch when changing the tonality system, such as by using 
the popover or the Key Signatures section of the Key Signatures, Tonality Systems, and 
Accidentals panel.

RESULT
The tonality system is changed from the key signature you input until the next key signature with 
a tonality system change or the end of the flow.

If you selected a tonality system that allows microtonal accidentals, such as Equal temperament 
(24-EDO, Stein-Zimmermann), microtonal accidentals become available in the Accidentals 
section of the Key Signatures, Tonality Systems, and Accidentals panel.

RELATED LINKS
Custom tonality systems on page 902
Input methods for key signatures on page 278
Key Signatures, Tonality Systems, and Accidentals panel on page 280
Inputting accidentals on page 244
Inputting microtonal accidentals on page 950

Tonality systems
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Importing tonality systems
You can import tonality systems into projects; for example, if you want to use a custom tonality 
system you created on a different computer. Tonality systems are saved as .doricolib files.

PROCEDURE

1. In Write mode, click Panels , then Key Signatures, Tonality Systems, and Accidentals 
 in the Notations toolbox to show the Key Signatures, Tonality Systems, and Accidentals 

panel.

2. In the Tonality System section, click Import Tonality System  to open the File Explorer/
macOS Finder.

3. Locate and select the tonality system file you want to import.

4. Click Open.

RESULT
The selected tonality system is imported. It becomes available in the current project only.

TIP

If you want to make tonality systems available in all future projects you open on your computer, 
you can save them as default in the Edit Tonality System dialog.

Exporting tonality systems
You can export tonality systems so you can send them to other users or use them in other 
projects. By default, any tonality systems you create are available in the current project only.

PROCEDURE

1. In Write mode, click Panels , then Key Signatures, Tonality Systems, and Accidentals 
 in the Notations toolbox to show the Key Signatures, Tonality Systems, and Accidentals 

panel.

2. In the Tonality System section, select the tonality system you want to export from the 
menu.

3. Click Export Tonality System  to open the File Explorer/macOS Finder.

4. Specify a name and location for the tonality system file.

5. Click Save.

RESULT
The selected tonality system is exported and saved in the selected location as a .doricolib file.

TIP

If you want to make tonality systems available in all future projects you open on your computer, 
you can save them as default in the Edit Tonality System dialog.

Tonality systems
Importing tonality systems 
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Lyrics

In Dorico Pro, the term “lyrics” is used for all text that is sung by singers.

Lyrics for a soprano duet with basso continuo accompaniment

Lyrics are organized into lyric lines to ensure consistent horizontal alignment and to make 
showing verse numbers simple and accurate. There are different types of lyric lines for lyrics 
with different purposes, and the appearance of lyrics changes depending on their line type. For 
example, lyrics in chorus and translation lines are shown in an italic font by default.

In Dorico Pro, lyrics were designed so that it is simple to make changes to existing lyrics without 
having to re-input new lyrics each time. For example, you can change the syllable type of lyrics so 
that they are either followed or not followed by a hyphen.

When inputting lyrics, you can use key commands to switch between lyric lines, to change on 
which side of the staff lyrics are input, and to switch the lyric style between normal lyrics, chorus 
lyrics, and translation lyrics. You can also change the type of lyrics after they have been input.

You can input multiple lines of lyrics, chorus lyrics, and translations, both above or below staves. 
You can filter existing lyrics according to their type and lyric line.

RELATED LINKS
Inputting lyrics on page 392
Positions of lyrics on page 1229
Lyric line numbers on page 1241
Filters for lyrics on page 1227
Lyric hyphens and lyric extender lines on page 1240
Changing the default font family on page 853
Lyrics paragraph styles on page 1235
Exporting lyrics on page 1227

Project-wide engraving options for lyrics
You can find options for the project-wide appearance and placement of lyrics on the Lyrics page 
in Engraving Options.

The options on the Lyrics page allow you to change the default appearance, spacing, and 
position of lyrics, and the appearance and position of lyric hyphens and lyric extender lines.
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There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Types of lyrics
Lyrics are divided into different lyric types in Dorico Pro.

Lyric lines
Lyric lines contain normal lyrics and can be shown with verse numbers. They can be 
both below and above the staff.

Chorus lines
Chorus lines contain lyrics in an italic font and are placed between lyric lines. For 
example, if there are two lyric lines, the chorus line appears between Line 1 and Line 2.

Chorus lines do not have verse numbers.

Lyric line translations
Lyric line translations show the text in lyric lines or chorus lines in different languages. 
They are placed directly below the lyric line or chorus line of which they are a 
translation. They are shown in an italic font.

Each lyric line can have its own lyric line translation, including chorus lines.

Lyric line translations do not have verse numbers, as they are part of the line of which 
they are a translation.

You can input all types of lyrics using the lyrics popover. The icon shown on the left-hand side of 
the popover indicates the type of lyric currently being input.

RELATED LINKS
Lyric line numbers on page 1241
Inputting lyrics on page 392
Lyrics popover on page 393

Changing the type of individual lyrics
You can change the type of individual lyrics after they have been input. For example, you can 
change lyrics into chorus lyrics or translation lyrics.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the individual lyrics whose type you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate/deactivate the following properties, individually or together, 
in the Lyrics group:

● Chorus

Lyrics
Types of lyrics 
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● Is translation

RESULT

● Activating Chorus changes the selected individual lyrics to chorus lyrics.

● Activating Is translation changes the selected lyrics to translation lyrics of the same lyric line 
number. For example, selecting lyrics in Line 2 and activating Is translation turns them into 
translation lyrics for Line 2.

● Activating both properties changes the selected lyrics to translation lyrics of the chorus.

● Deactivating both properties changes the selected lyrics to normal lyrics. Their line number 
is indicated by the number in Line number in the Lyrics group of the Properties panel.

NOTE

If other chorus lines exist at the same position on the side of the staff where you want to change 
your current selection to chorus lines, the two lines collide. To avoid this, change the type of the 
whole lyric line, which automatically avoids collisions.

RELATED LINKS
Showing lyrics in italics on page 1236
Engrave toolbox on page 514

Types of syllables in lyrics
There are different types of syllables in lyrics, depending on their position in words. The key you 
press to advance the popover indicates the syllable type for each lyric.

Dorico Pro defines lyrics as different syllables depending on how you advance the popover when 
inputting lyrics.

Whole word
Lyrics are considered a whole word if the lyric comes after a gap and is followed by a 
gap or a period.

No hyphens are shown either side of whole word lyrics. Extender lines can be shown 
after lyrics.

Start
Lyrics are considered the start syllable in a multi-syllabic word if the lyric comes after a 
gap, but is followed by a hyphen.

Hyphens are shown after start lyrics, which can be continuation hyphens depending on 
the distance before the next lyric in the same lyric line.

Middle
Lyrics are considered the middle syllable in a multi-syllabic word if the lyric comes after 
a hyphen, and is followed by a hyphen.

Hyphens are shown after middle lyrics, which can be continuation hyphens depending 
on the distance before the next lyric in the same lyric line.

End
Lyrics are considered the end syllable in a multi-syllabic word if the lyric comes after a 
hyphen but is followed by a gap or a period.

Extender lines can be shown after end lyrics.

Lyrics
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RELATED LINKS
Inputting lyrics on page 392
Lyric hyphens and lyric extender lines on page 1240
Positions of lyrics on page 1229
Changing the alignment of lyrics relative to notes on page 1230

Changing the syllable type of existing lyrics
You can change the syllable type of lyrics after they have been input.

For example, if you advanced the lyrics popover to the next note by pressing Space  but you later 
want it to be followed by a hyphen, you can change its syllable type.

NOTE

Changing the syllable type changes whether a hyphen is shown after the selected lyrics, not 
before them. Therefore, if you want to show a hyphen before lyrics, you must change the syllable 
type of the lyrics immediately preceding them.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lyrics whose syllable type you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, select one of the following options from the Syllable type menu in 
the Lyrics group:

● Whole word

● Start

● Middle

● End

RESULT
Lyrics with a syllable type of Whole word or End are followed by a space.

Lyrics with a syllable type of Start or Middle are followed by a hyphen.

RELATED LINKS
Engrave toolbox on page 514

Copying and pasting lyrics
You can copy and paste lyrics from both existing lyric lines in Dorico Pro and from external text 
editors; for example, if you want to copy a lyric line to a player who has different rhythms to the 
source but uses the same lyrics.

When copying text from outside Dorico Pro, you must format the text so it is suitably separated 
into syllables; for example, by adding hyphens in multi-syllabic words. This ensures Dorico Pro 
can correctly identify the characters required for each word/syllable and therefore format the 
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resulting lyrics appropriately. There are automatic hyphenation tools that you can use, but 
results from these are not always reliable. Dorico Pro checks text you have copied to your 
clipboard to make sure it contains only single spaces and single hyphens for correct syllable 
input.

NOTE

You cannot currently copy and paste lyrics containing Chinese, Japanese, or Korean characters. 
This is planned for future versions.

PROCEDURE

1. Select the lyrics/text you want to copy. You can do this within Dorico Pro or externally.

NOTE

● If you are copying existing lyrics/text in Dorico Pro, you must be in Write mode.

● If you want to select many existing lyrics in Dorico Pro, you can use filters for lyric lines 
or you can select a single lyric and press Ctrl/Cmd-Shift-A  multiple times to select the 
rest of the lyrics in the lyric line.

2. Press Ctrl/Cmd-C  to copy the selected lyrics/text.

3. In Write mode, select the first note in the voice to which you want to copy lyrics.

4. Open the lyrics popover in any of the following ways:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

5. Optional: Change the lyric type into which you will paste lyrics in one of the following ways:

● To change the lyric line number, press Down Arrow .

● To change to a lyric line above the staff, press Shift - Up Arrow .

● To change to a chorus line, press Up Arrow .

● To change to a translation lyric line, press Alt/Opt - Down Arrow .

6. Press Ctrl/Cmd-V  to paste the first word/syllable of the copied lyrics/text.

The lyrics popover automatically advances to the next note in the selected voice according 
to the source text. For example, for syllables followed by hyphens in the source, the popover 
advances as if you had pressed -  (hyphen), which automatically shows hyphens after those 
syllables.

7. Optional: For words/syllables that you want to apply to two or more notes, you must advance 
the popover manually in one of the following ways:

● After complete words or the final syllable in multi-syllabic words, press Space .

● After syllables that are not the final syllable in multi-syllabic words, press -  (hyphen).

● After syllables that you do not want to be followed by an extension line or hyphen, press 
Right Arrow .

8. Continue pressing Ctrl/Cmd-V  for each word/syllable you want to paste.

RESULT
The selected lyrics/text is pasted into the selected lyric line belonging to the voice in which you 
selected a note.
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NOTE

Words/syllables are removed from your clipboard as you paste them. If you want to paste the 
same lyrics/text into another lyric line or staff, you must copy the source again.

RELATED LINKS
Edit Lyrics dialog on page 1238
Lyric line numbers on page 1241
Large selections on page 428
Inputting lyrics on page 392
Lyrics popover on page 393
Copying and pasting notes/items on page 461

Exporting lyrics
You can export all lyrics from all flows in the project to a plain text file; for example, if you want to 
create a libretto of all the text sung in a project.

PROCEDURE

1. Choose File > Export > Lyrics to open the File Explorer/macOS Finder.

2. Specify a name and location for the text file.

3. Click Save.

RESULT
All lyrics from all flows in the project are exported to a plain text file, which opens automatically 
in your default text editor.

Dorico Pro automatically removes hyphens between syllables, and adds contextual information 
for lyrics, such as their line number and the instrument to which they belong.

RELATED LINKS
File import and export on page 82
Lyric hyphens and lyric extender lines on page 1240
Types of lyrics on page 1223
Positions of lyrics on page 1229
Exporting comments on page 511

Filters for lyrics
In Dorico Pro, lyrics filters allow you to select all lyrics of a specified type across your project or 
across a specific selection.

The following lyrics filters are available:

All Lyrics
Selects all types of lyrics in the current selection, with any lyric line number and 
placement above/below the staff.

Line 1
Selects only Line 1 lyrics and translation lyrics for Line 1 in the current selection, 
including Line 1 below the staff and Line 1 above the staff.
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Line 2
Selects only Line 2 lyrics and translation lyrics for Line 2 in the current selection, 
including Line 2 below the staff and Line 2 above the staff.

Line 3
Selects only Line 3 lyrics and translation lyrics for Line 3 in the current selection, 
including Line 3 below the staff and Line 3 above the staff.

Line 4
Selects only Line 4 lyrics and translation lyrics for Line 4 in the current selection, 
including Line 4 below the staff and Line 4 above the staff.

Line 5
Selects only Line 5 lyrics and translation lyrics for Line 5 in the current selection, 
including Line 5 below the staff and Line 5 above the staff.

Above Staff
Selects all lyrics above the staff in the current selection. You can use this filter in 
addition to the other filters. For example, you can filter first by line number, and then 
filter again by staff-relative placement.

Below Staff
Selects all lyrics below the staff in the current selection. You can use this filter in 
addition to the other filters. For example, you can filter first by line number, and then 
filter again by staff-relative placement.

Chorus
Selects all chorus lyrics in the current selection.

Translations
Selects all translation lyrics in the current selection.

RELATED LINKS
Filters on page 433
Changing filters to select/deselect on page 435
Large selections on page 428

Selecting lyrics using filters
You can use lyric filters to select all lyrics of a specified type across your project or across a 
specific selection.

PREREQUISITE
You filter setting is set to Select Only.

PROCEDURE

1. In the music area, make a selection that includes all the lyrics you want to select.

For example, press Ctrl/Cmd-A  to select the whole flow.

2. Choose Edit > Filter > Lyrics > [Lyrics type].

RESULT
All lyrics of the selected type in your selection are selected. For example, if you choose Edit > 
Filter > Lyrics > Chorus, all chorus lyrics in your selection are selected.
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Positions of lyrics
Dorico Pro automatically positions lyrics and makes adjustments to accommodate variations in 
the length of lyrics, including adjusting the horizontal alignment of lyrics in melismatic music. 
However, you can also move lyrics manually and change their default positions project-wide.

You can move lyrics to different rhythmic positions in Write mode. They are positioned by default 
according to your settings in Engraving Options.

You can move individual lyrics graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

You can change the default positions of lyrics project-wide on the Lyrics page in Engraving 
Options.

The default settings for lyrics are optimized for scores with comfortable spacing. If your project 
requires note spacing to be narrower, with less room for each note, change these settings to 
achieve a clearly legible result without the need for lots of editing in Engrave mode.

For scores that have less horizontal space, the following changes often improve the appearance 
of lyrics and rhythmic space:

● Make minimum gaps smaller, such as the minimum gap between lyrics and hyphens, in 
Engraving Options > Lyrics > Hyphens.

● Increase the amount that lyrics can be adjusted by in Engraving Options > Lyrics > Spacing.

Positions of syllables

Lyrics typically coincide with notes. The number of notes sung on syllables or words determines 
the alignment of lyrics relative to notes:

● Single syllables, which are whole words or parts of longer words that are sung on only one 
note, are centered on their corresponding note.

● Melismata, which are syllables or words that are sung on more than one note, are left-
aligned with the left side of the first note to which they apply.

The horizontal spacing of lyrics must be wide enough so that words or syllables do not overlap 
with the words or syllables on either side. For this reason, note spacing must sometimes be 
adjusted to accommodate lyrics.

To reduce how severely the note spacing is changed to accommodate lyrics, which can distort the 
appearance of rhythms, Dorico Pro allows the alignment of some lyrics to be adjusted relative 
to their corresponding notes. For example, if a long, single-syllable word on a long note follows 
another long, single-syllable word on a short note, the second word is moved a little to the right 
to give both words enough space.

In this musical phrase, the lyric "breeze" has been moved to the right to accommodate the lyric "spring" on 
the previous note.

NOTE

Moving lyrics graphically in Engrave mode overrides the automatic spacing for the selected 
lyrics. If you move a lyric whose position was automatically readjusted, the note spacing at that 
rhythmic position might change.
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You can prevent Dorico Pro from considering lyrics in note spacing calculations using the Make 
space for lyrics option on the Note Spacing page in Layout Options and in the Note Spacing 
Change dialog; however, we recommend using this option with caution.

Placement of lyric lines

Lyrics are generally placed below the staff to which they apply and relative to other lyric lines 
according to their line number. For example, lyrics in Line 1 are placed at the top, including when 
there are multiple lyric lines above the staff.

If a line of lyrics is missing across the width of a whole system, no additional gap is left between 
the remaining lines of lyrics.

You can also move individual lyric lines vertically. In Engrave mode, when you select any lyric in a 
lyric line, a square handle appears on the bottom left of the first lyric in the line on that system. 
This allows you to adjust the vertical position of lyric lines independently of other lyric lines.

Square handle selected at the start of a lyric line in Engrave mode

EXAMPLE
You have three lines of lyrics, but one system does not have a second line of lyrics. On this 
system, the third line of lyrics is moved upwards, closer to the first line of lyrics.

If a subsequent system does not have a first line, but does have the second and third lines, then 
the second and third lines of lyrics are moved upwards. The second line of lyrics takes the place 
of the first line.

RELATED LINKS
Project-wide engraving options for lyrics on page 1222
Engraving Options dialog on page 840
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Moving lyric lines vertically on page 1233
Changing the line number and type of lyric lines on page 1241
Changing the staff-relative placement of lyric lines on page 1232
Layout Options dialog on page 834
Per-layout note spacing options on page 600
Note Spacing Change dialog on page 602

Changing the alignment of lyrics relative to notes
You can change the horizontal alignment of individual lyrics relative to notes; for example, if you 
want to force lyrics at the same position on multiple staves with different default alignments to 
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have the same alignment. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

There is no default setting for the alignment of lyrics relative to notes, as Dorico Pro 
automatically adjusts the horizontal position of lyrics to minimize note spacing changes. By 
default, lyrics on single noteheads are center-aligned, and lyrics spanning multiple noteheads are 
left-aligned.

NOTE

Changing the alignment of lyrics manually overrides Dorico Pro’s automatic spacing for the 
selected lyrics, meaning that note spacing at the affected rhythmic positions might change.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics whose alignment you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Lyric text alignment in the Lyrics group.

3. Select one of the following alignment options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the selected lyrics is changed. Note spacing is automatically adjusted to avoid 
collisions with adjacent lyrics.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

● You can change whether Dorico Pro considers punctuation at the start/end of lyrics when 
calculating their alignment in Engraving Options > Lyrics > Spacing.

● You can change the default alignment of all lyrics project-wide according to their syllable 
type in Engraving Options > Lyrics > Alignment.

EXAMPLE

Left-aligned lyric "l’aube" Center-aligned lyric "l’aube" Right-aligned lyric "l’aube"
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RELATED LINKS
Types of syllables in lyrics on page 1224
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the staff-relative placement of lyric lines
You can show whole lyric lines either above or below the staff after they have been input.

PROCEDURE

1. In Write mode, select a lyric in each line whose staff-relative placement you want to change.

TIP

You can also make a selection and use the lyric filters to select different lyric lines according 
to their line numbers and staff-relative placement.

2. Choose one of the following staff-relative placements:

● Choose Edit > Notations > Lyrics > Placement > Above.

● Choose Edit > Notations > Lyrics > Placement > Below.

TIP

You can also choose these options from the context menu.

RESULT
The staff-relative placement of the whole lyric lines in which you selected lyrics is changed.

NOTE

If other lyric lines with the same lyric line number exist at the same position on the side of 
the staff to which you want to change your current selection, the two lines switch sides. For 
example, if there is already a Line 2 above the staff at the position where you want to change the 
placement of Line 2 below the staff, then the existing Line 2 above the staff is placed below the 
staff to accommodate your most recent preference.

RELATED LINKS
Lyric line numbers on page 1241
Filters for lyrics on page 1227

Changing the staff-relative placement of individual lyrics
You can show individual lyrics either above or below the staff, independently of the staff-relative 
placement of their lyric line. For example, to clarify the lyrics for each part when two voices on 
the same staff have different rhythms.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Lyrics
Positions of lyrics 

1232
Dorico Pro 4.3.30



PROCEDURE

1. Select the lyrics whose staff-relative placement you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, choose one of the following options for Line placement in the 
Lyrics group:

● Above

● Below

RESULT
The staff-relative placement of the selected lyrics is changed.

NOTE

If other lyric lines with the same lyric line number already exist at the same position on the same 
side of the staff, the two lines collide. To avoid this, you can change the lyric line number of one 
of the lyric lines, for example.

Moving lyric lines vertically
You can move lyric lines graphically upwards/downwards on a per-system basis, independently 
of other layouts and your project-wide settings. For example, if the shapes of phrases on certain 
systems make lyric lines appear unevenly centered between staves.

NOTE

● You cannot move individual lyrics upwards/downwards; instead, you can change their lyric 
line number or staff-relative placement.

● We recommend that you add extra pages and finish laying out your pages before moving 
individual lyric lines vertically, as lyric line offsets are automatically deleted if the frame in 
which they occur changes. For example, if you move lyric lines individually and then add a 
blank page at the start of the layout, all of the individual lyric line offsets in the layout are 
deleted.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select any of the following in each system where you want to move lyric 
lines vertically:

● Any lyric in each lyric line you want to move vertically.

● The handles on the bottom left of the first lyric on each lyric line you want to move 
vertically.

NOTE

When using the mouse, you must only select handles at the start of each lyric line.

2. Move the selected lyric lines upwards/downwards in any of the following ways:

● To move them a standard amount, press Alt/Opt-Up Arrow / Alt/Opt-Down Arrow . 
This moves lyric lines by 1/4 space per press.
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● To move them a large amount, press Ctrl/Cmd-Alt/Opt-Up Arrow / Ctrl/Cmd-Alt/Opt-
Down Arrow . This moves lyric lines by 1 space per press.

● To move them a moderate amount, press Shift-Alt/Opt-Up Arrow / Shift-Alt/Opt-
Down Arrow . This moves lyric lines by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd-Shift-Alt/Opt-Up Arrow / Ctrl/Cmd-
Shift-Alt/Opt-Down Arrow . This moves lyric lines by 1/32 space per press.

● Click and drag the handles upwards/downwards.

RESULT
The selected lyric lines are moved upwards/downwards on the selected systems. This does not 
affect the vertical offset of any other lyric lines on those systems or the same lyric lines in other 
layouts.

TIP

You can change the default position of lyrics relative to the staff, other lyric lines, and to other 
objects project-wide in the Vertical Position section of the Lyrics page in Engraving Options.

EXAMPLE
Because of the shape of the music in this example, the default vertical alignment of the chorus in 
the middle of the three lyric lines for the verses in the previous bar causes the chorus to appear 
much closer to notes on the top staff than the bottom staff. Moving the chorus line downwards 
makes it appear more evenly distributed between the staves.

Default chorus placement Chorus line moved downwards

RELATED LINKS
Changing the line number of individual lyrics on page 1242
Engrave toolbox on page 514
Changing the type of individual lyrics on page 1223

Removing lyric line vertical offsets
You can remove changes you have made to the vertical offsets of individual lyric lines and reset 
them to their default positions.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

Lyrics
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PROCEDURE

1. In Engrave mode, select one of the following:

● To remove offsets from specific lyric lines in specific systems, select any lyric in each lyric 
line and in each system.

● To remove offsets from all lyric lines in specific frames, select any lyric in each frame.

● To remove offsets from all lyric lines in the layout, select any lyric in any frame.

2. Remove lyric line offsets in one of the following ways:

● To remove offsets from all lyric lines in the current layout, choose Engrave > Lyric 
Offsets > Reset Layout.

● To remove offsets from all lyric lines in the selected frames, choose Engrave > Lyric 
Offsets > Reset Selected Frames.

● To remove offsets from only the selected lyric lines in the selected systems, choose 
Engrave > Lyric Offsets > Reset Selected Systems.

Lyrics paragraph styles
There are different paragraph styles for different types of lyrics. You can change different aspects 
of these paragraph styles in the Paragraph Styles dialog, such as changing their font size to 
make lyrics appear larger.

The following paragraph styles are used for lyrics:

1 Lyrics: Used for lyric lines

2 Lyrics (Translation): Used for lyric line translations

3 Lyrics (Verse Numbers): Used for verse numbers

4 Lyrics (Chorus): Used for chorus lines

5 Lyrics (Chorus Translation): Used for chorus line translations

RELATED LINKS
Paragraph Styles dialog on page 848
Types of lyrics on page 1223
Inputting lyrics on page 392

Lyrics
Lyrics paragraph styles 
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Showing lyrics in italics
You can show individual lyrics in an italic font without changing their paragraph style, lyric type, 
or staff-relative placement. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

TIP

● If you want to show lyrics in an italic font because they are intended to be either chorus lyrics 
or translation lyrics, you can change their lyric type instead.

● You can use the Edit Lyric dialog to show individual characters in lyrics in italics.

● If you want all normal lyric lines to appear in an italic font project-wide, you can change the 
Lyrics paragraph style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics you want to show in an italic font. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Italic in the Lyrics group.

RESULT
The selected lyrics are shown in an italic font. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Types of lyrics on page 1223
Lyric line numbers on page 1241
Lyric hyphens and lyric extender lines on page 1240
Edit Lyric dialog on page 1239
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the paragraph style used for lyrics
You can change the paragraph style used for individual lyrics; for example, if you want to use 
narrower paragraph styles for lyrics on tightly spaced systems. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Lyrics
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PROCEDURE

1. Select the lyrics whose paragraph style you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Paragraph style in the Lyrics group.

3. Select a paragraph style from the menu.

RESULT
The paragraph style used for the selected lyrics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

You can edit the formatting of the paragraph styles used for lyrics in the Paragraph Styles 
dialog.

RELATED LINKS
Lyrics paragraph styles on page 1235
Types of lyrics on page 1223
Lyric line numbers on page 1241
Lyric hyphens and lyric extender lines on page 1240

Lyric text editing
Proofreading lyrics can be challenging, because lyrics are spaced more widely than regular text 
and individual words are often split up over large horizontal distances. In Dorico Pro, you can 
change the text and formatting of individual lyrics, including viewing entire lyric lines in a single 
dialog.

Changing the text of existing lyrics
You can change the text of lyrics after they have been input; for example, to correct misspellings.

NOTE

● You can only change one lyric at a time when following these steps. To edit multiple lyrics at 
once, you can use the Edit Lyrics dialog.

● If you want to edit the formatting of individual lyrics, you can use the Edit Lyric dialog. 
However, any edits you have made to the formatting of individual lyrics are removed when 
you change their text using the popover.

PROCEDURE

1. In Write mode, select the lyric whose text you want to change.

2. Press Return  or Shift-L  to open the lyrics popover.

3. Change the existing text in the lyrics popover.

4. Optional: If you want to change other existing lyrics, advance the popover in one of the 
following ways:

● To advance the popover to the next note if you entered a complete word, or the final 
syllable in a multi-syllabic word, press Space .

Existing lyrics are automatically selected in the popover when you press Space .

Lyrics
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● To advance the popover to the next note if you entered one syllable of a multi-syllabic 
word, press - .

● To move the cursor one character to the right, press Right Arrow .

● To move the cursor one character to the left, press Left Arrow .

The cursor automatically moves to the next/previous lyric/note if you keep pressing the 
arrow keys.

5. Press Return  or Esc  to close the popover when you have finished changing lyrics.

The popover closes automatically when you reach the last note on the staff.

Edit Lyrics dialog
The Edit Lyrics dialog allows you to view and edit entire lyric lines in one place and with the 
text displayed with consistent spacing. This is more convenient than changing each word/syllable 
individually alongside the music, where lyrics can be split up over large horizontal distances.

● You can open the Edit Lyrics dialog by selecting at least one lyric and choosing Edit > 
Notations > Lyrics > Edit Line of Lyrics. You can also choose this option from the context 
menu.

The dialog shows all lyrics in the same lyric line as the selected lyric and allows you to edit the 
lyrics, such as fixing misspellings, adding commas, or changing where in a word the hyphen is 
placed. If you selected multiple lyrics to open the dialog, Dorico Pro populates the dialog with the 
lyric line of the earliest lyric on the highest staff you selected.

The Edit Lyrics dialog comprises the following:

1 Text editor

Allows you to edit all the lyrics in the selected lyric line in the current flow, with hyphens and 
spaces as appropriate. For example, you can add a comma after the final syllable in a line for 
a poem setting or replace a hyphen with a space.

NOTE

You cannot add, delete, or change the duration/rhythmic position of lyrics, such as the 
number of notes to which each lyric applies.

2 Zoom controls

Allow you to increase/decrease the size of text in the dialog.

3 Current number of lyrics

Lyrics
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Displays the number of lyrics currently shown in the text editor and the target number of 
lyrics in the lyric line. The target number is the number of lyrics that already exists in the 
selected lyric line in the flow.

The current number of lyrics updates automatically as you work in the dialog. Dorico Pro 
requires the current number and target number of lyrics to match before you can confirm 
the dialog.

4 OK button

Allows you to confirm your changes and close the dialog. You can only confirm the dialog 
when the current number and target number of lyrics match.

Edit Lyric dialog
The Edit Lyric dialog allows you to edit the formatting of individual lyrics, such as making single 
characters underlined.

● You can open the Edit Lyric dialog by selecting a lyric and choosing Edit > Notations > 
Lyrics > Edit Single Lyric. You can also choose this option from the context menu.

The Edit Lyric dialog comprises the following:

1 Text editor options

Allows you to customize the font, size, and formatting of the selected part of the lyric.

2 Text editing area

Shows the current text for the lyric. You can select any part of the lyric and edit 
it independently of other parts; for example, if you want some characters to appear 
underlined.

RELATED LINKS
Lyrics paragraph styles on page 1235
Text editor options in Write mode on page 389
Changing the paragraph style used for lyrics on page 1236
Resetting the appearance of items on page 442
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Lyric hyphens and lyric extender lines
Lyric hyphens indicate that individual lyrics are syllables within multi-syllabic words; for example, 
“Hal-le-lu-jah”. Lyric extender lines indicate that individual lyrics, either whole words or the last 
syllables in multi-syllabic words, extend across multiple notes.

A phrase containing hyphens and an extender line

Dorico Pro automatically shows lyric hyphens when you advance the lyrics popover by pressing 
-  between syllables, and lyric extender lines when you advance the lyrics popover by pressing 
Space  multiple times after an entry, provided there is sufficient horizontal space between the 
end of the lyric and the end position of the extender line. Lyric extender lines end at the right 
edge of the last notehead to which they apply.

In Engrave mode, lyric hyphens and lyric extender lines have two square handles, one at the 
start and one at the end. You can move whole lyric hyphens and lyric extenders lines, and you 
can also move their handles independently of each other. This allows you to lengthen/shorten 
lyric hyphens and extender lines. For lyric hyphens, this increases/decreases the space in which 
lyric hyphens are shown and can result in more/fewer hyphens appearing, depending on your 
settings for the size of gaps relating to hyphens in Engraving Options > Lyrics > Hyphens.

Lyric extender line with handles shown Lyric hyphen with handles shown

The start handles of lyric extender lines are attached to the lyrics from which they extend, and 
the start handles and end handles of lyric hyphens are attached to the lyrics on each side. If you 
move either of those lyrics, the corresponding lyric extender line or hyphen handles also move.

NOTE

● You cannot move lyric extender lines or hyphens upwards/downwards, as their vertical 
position is determined by their lyric line number, the vertical position of their lyric line, and 
your project-wide settings in Engraving Options.

● You can change the position of lyric extender lines and hyphens relative to lyrics, to the ends 
of systems, and to other extender lines and hyphens for all lyric extender lines and hyphens 
project-wide in the Extender Lines and Hyphens sections of the Lyrics page in Engraving 
Options. You can also change the default lyric hyphen in the Hyphens section.

RELATED LINKS
Inputting lyrics on page 392
Navigation during lyric input on page 394
Engraving Options dialog on page 840
Moving items graphically on page 609
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Lyric line numbers
Lyric line numbers are used to organize lyrics when a single musical passage can have different 
lyrics sung to it, such as music that contains multiple verses. In Dorico Pro, you can specify the 
line number of lyrics as you input them and by changing the line number of existing lyrics.

For example, if you input lyrics in Line 3 but later want to change those lyrics to Line 4 because 
you want to input different lyrics as Line 3, you can change your current Line 3 into Line 4, and 
then input a new line of lyrics as Line 3. The spacing is automatically adjusted to show lyric lines 
in the correct order.

The start of a choral piece with three lyric lines for its three verses

In Dorico Pro, you can have multiple lines of lyrics both above and below the same staff. Turning 
lyric lines into chorus lyric lines or lyric line translations changes both their placement and 
appearance as chorus lyrics generally use an italic font.

RELATED LINKS
Verse numbers on page 1243
Filters for lyrics on page 1227
Positions of lyrics on page 1229
Showing lyrics in italics on page 1236

Changing the line number and type of lyric lines
You can change the lyric line number of whole lyric lines after they have been input. You can also 
change whole lyric lines to chorus lines and lyric line translations.

For example, you can change the existing Line 1 into a lyric translation of Line 4, or change Line 2 
into a chorus line.

TIP

To identify which line you are working on, select a syllable in the line of lyrics and check the 
number in the Line number value field in the Lyrics group of the Properties panel. Alternatively, 
you can activate verse numbers on the Lyrics page in Engraving Options.

PROCEDURE

1. In Write mode, select a lyric in the line whose lyric line type you want to change. The lyric line 
can be above or below the staff.

Lyrics
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TIP

You can also make a selection and use the lyric filters to select different lyric lines according 
to their line numbers.

2. Change the line number and/or type of the selected lyric line in one of the following ways:

● Choose Edit > Notations > Lyrics > Line > [Line number].

● Choose Edit > Notations > Lyrics > Line > Chorus.

● Choose Edit > Notations > Lyrics > Translations > [Line number Translation].

● Choose Edit > Notations > Lyrics > Translations > Chorus Translation.

TIP

You can also choose these options from the context menu.

RESULT
The line number or type of the whole lyric line of the selected lyric is changed.

NOTE

The position of the selected lyric line relative to other lyric lines at the same position might be 
changed. For example, if there were two lyric lines and you changed Line 1 to Line 3, it now 
appears below Line 2.

If a lyric line with the same number already exists at the same position on the same side of the 
staff, the two lines switch. For example, if there is already a Line 1 at the rhythmic position where 
you want to change Line 2 to Line 1, then the existing Line 1 becomes Line 2 to accommodate 
your most recent preference. The same applies to chorus lines and lyric line translations.

RELATED LINKS
Types of lyrics on page 1223
Filters for lyrics on page 1227
Engraving Options dialog on page 840

Changing the line number of individual lyrics
You can change the lyric line number of individually selected lyrics after they have been input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the individual lyrics whose line number you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, change the value for Lyric number in the Lyrics group.

RESULT
The line number of the selected lyrics is changed to match the value in the value field.

Lyrics
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NOTE

The position of the selected lyrics relative to other lyric lines might be changed. For example, if 
there were two lyric lines and you changed lyrics in Line 1 to Line 3, they now appear below Line 
2.

Verse numbers
Verse numbers indicate the order in which lyrics are sung when multiple lines of lyrics share the 
same musical passage. They are commonly used in hymns and song sheets.

Depending on the type of music you are writing, verse numbers might not be appropriate. 
Therefore, hiding/showing verse numbers in Dorico Pro is optional. By default, verse numbers 
are not shown. You can hide/show verse numbers on all lines of lyrics project-wide and on 
individually selected lyrics.

When verse numbers are shown on all lyric lines project-wide, they only appear before the 
first lyric in the line by default, they are not repeated on subsequent systems automatically. 
Therefore, if you want to show verse numbers at the start of subsequent systems, you must 
show verse numbers on those individual lyrics.

NOTE

Lyric line translations are part of the lyric line of which they are a translation so do not have their 
own verse number.

Hiding/Showing verse numbers
You can hide/show verse numbers on individual lyrics, independently of your project-wide 
setting; for example, if you want to show the verse number at the start of every system.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lyrics before which you want to hide/show verse numbers. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show verse number in the Lyrics group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Verse numbers are shown before the selected lyrics when the checkbox is activated, and hidden 
when the checkbox is deactivated.

When the property is deactivated, lyrics follow your project-wide setting for hiding/showing verse 
numbers.

TIP

You can hide or show verse numbers project-wide on the Lyrics page in Engraving Options.

Lyrics
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RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Engraving Options dialog on page 840

Changing the punctuation of verse numbers
You can show all verse numbers project-wide with or without a period.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Lyrics.

3. In the Verse Numbers section, choose one of the following options for Punctuation for 
verse numbers:

● Append period (full stop)

● Do not append period (full stop)

4. Click Apply, then Close.

Elision slurs
Elision slurs are used to show that two or more syllables or characters are part of the same lyric. 
Elision slurs are also sometimes used to tell singers not to breathe between the joined lyrics.

A soprano part containing multiple elision slurs

Dorico Pro automatically shows elision slurs in lyrics that contain the underscore character.

TIP

You can change the gap between elided syllables, and the corresponding size of elision slurs, in 
Engraving Options > Lyrics > Spacing.

RELATED LINKS
Inputting lyrics on page 392
Navigation during lyric input on page 394
Slurs on page 1502

Hiding/Showing East Asian elision slurs
You can hide/show East Asian elision slurs for individual lyrics, independently of your project-
wide setting. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics on which you want to show East Asian elision slurs. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show East Asian elision slur in the Lyrics group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
East Asian elision slurs are shown on the selected lyrics when the checkbox is activated, and 
hidden when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

When the property is deactivated, lyrics follow your project-wide setting.

TIP

You can choose to hide/show East Asian elision slurs on all applicable lyrics project-wide on the 
Lyrics page in Engraving Options.

EXAMPLE

East Asian elision slur shown East Asian elision slur hidden

Lyrics
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Notes

Notes are shapes that are positioned on staves to indicate musical pitches. Notes are most 
commonly shown with oval-shaped, round noteheads that are either filled or void depending on 
their duration, but there are many different designs of noteheads that you can use.

Depending on their duration, notes can have stems that help indicate their duration.

In Dorico Pro, a sequence of adjacent notes joined with ties is considered a single note of 
the total duration of the tie chain, rather than separate notes. Note grouping is automatically 
adjusted according to the prevailing beat grouping, which is normally set by the time signature.

RELATED LINKS
Inputting notes on page 221
Note spacing on page 599
Stems on page 1273
Notehead sets on page 1246
Custom notehead sets on page 868
Changing the notehead design of individual noteheads on page 1252
Note tools popover on page 498
Adding notes above/below existing notes on page 258
Bracketed noteheads on page 1263
Ties on page 1620
Note and rest grouping on page 1021
Beam grouping according to meters on page 999

Project-wide engraving options for notes
There are a number of options for the appearance of notes and noteheads project-wide that you 
can choose from on the Notes page in Engraving Options.

The options on this page allow you to change the design, appearance, and position of noteheads, 
ledger lines, stem flags, and rhythm dots. You can also change the appearance of double whole 
notes (breves) and the size of grace notes relative to normal notes.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Notehead sets
A notehead set is a collection of related noteheads that together allow you to represent all the 
different noteheads required for the different durations used in music notation.

A typical notehead set contains at least four noteheads:

● A black notehead for quarter notes (crotchets) and shorter

● A white notehead for half notes (minims)
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● A wider white notehead for whole notes (semibreves)

● A wider white notehead with one or two vertical strokes on either side, or a square white 
notehead, for double whole notes (breves)

Pitch-dependent notehead sets contain noteheads that vary according to the pitch of notes 
rather than their duration.

● In pitched notehead sets, there are different noteheads for different pitches.

For example, the Pitch Names notehead set shows the letter name and any applicable 
accidental of each note within its notehead.

● In scale degree notehead sets, there is a different notehead for each scale degree, relative to 
the current key signature.

For example, the Aikin 7-shape notehead set uses a different notehead shape for each pitch.

NOTE

● A single notehead can appear in multiple notehead sets. If you edit a notehead within one 
notehead set, your changes affect the appearance of that notehead in all notehead sets that 
contain it.

● Notehead sets can only contain noteheads of the same type. For example, you cannot use a 
normal notehead in a pitched notehead set.

● You cannot change the type of an existing notehead set or an existing notehead.

RELATED LINKS
Pitch-dependent notehead set designs on page 1251
Custom notehead sets on page 868
Creating custom notehead sets on page 874
Creating custom noteheads on page 875

Notehead set designs
There are a number of different notehead set designs that you can use for individual noteheads 
in Dorico Pro.

● You can find the available notehead designs by selecting at least one note and choosing 
Edit > Notations > Notehead > [Notehead type or design] > [Notehead design]. You can 
also choose these options from the context menu.

NOTE

Dorico Pro does not offer stemless noteheads. Instead, you can hide the stems of notes with any 
notehead design.

General noteheads

Notehead set design Notehead set name

Larger Noteheads

Notes
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Notehead set design Notehead set name

Default Noteheads

Large Circled Noteheads

Circled Noteheads

Slashed Noteheads (Bottom Left to Top Right)

Slashed Noteheads (Top Left to Bottom Right)

Cross noteheads

Notehead set design Notehead set name

Circle X Noteheads

Large X and Diamond Noteheads

Ornate X Noteheads

Plus Noteheads

With X Noteheads

Notes
Notehead sets 
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Notehead set design Notehead set name

X Noteheads

X and Circle X Noteheads

X and Diamond Noteheads

Triangular noteheads

Notehead set design Notehead set name

Large Arrow Down Noteheads

Large Arrow Up Noteheads

Triangle Down Noteheads

Triangle Left Noteheads

Triangle Right Noteheads

Triangle Up Noteheads

Notes
Notehead sets 
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Diamond noteheads

Notehead set design Notehead set name

Diamond Noteheads

Old-Style Diamond Noteheads

White Diamond Noteheads

Wide Diamond Noteheads

Slash noteheads

Notehead set design Notehead set name

Muted Slash Noteheads

Oversized Slash Noteheads

Slash Noteheads

Small Slash Noteheads

Round and square noteheads

Notehead set design Notehead set name

Moon Noteheads

Notes
Notehead sets 
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Notehead set design Notehead set name

Rectangular Noteheads

Round White with Dot Noteheads

RELATED LINKS
Changing the notehead design of individual noteheads on page 1252
Hiding/Showing stems on page 1280
Hiding/Showing noteheads on page 1257
Custom notehead sets on page 868
Creating custom notehead sets on page 874
Creating custom noteheads on page 875

Pitch-dependent notehead set designs
Pitch-dependent notehead sets use different notehead designs or different notehead colors 
depending on the pitch of notes. There are a number of different pitch-dependent notehead sets 
available in Dorico Pro.

● You can find the available notehead designs by selecting at least one note and choosing 
Edit > Notations > Notehead > [Notehead type or design] > [Notehead design]. You can 
also choose these options from the context menu.

TIP

You can choose to use a pitch-dependent notehead design for all noteheads project-wide on the 
Notes page in Engraving Options.

Scale degree noteheads

Notehead set design Notehead set name

Aikin 7-shape Noteheads

Funk 7-shape Noteheads

Walker 4-shape Noteheads

Notes
Notehead sets 
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Notehead set design Notehead set name

Walker 7-shape Noteheads

Pitched noteheads

Notehead set design Notehead set name

Figurenotes© Noteheads

Pitch Name Noteheads

RELATED LINKS
Notehead sets on page 1246
Changing the notehead design of individual noteheads on page 1252
Hiding/Showing stems on page 1280
Hiding/Showing noteheads on page 1257
Showing differently shaped noteheads for each scale degree project-wide on page 1254
Showing note names in noteheads project-wide on page 1254
Engraving Options dialog on page 840
Custom notehead sets on page 868

Changing the notehead design of individual noteheads
You can change the notehead design of individual noteheads, including trill auxiliary notes. For 
example, cross noteheads might be used to indicate where players should produce pitchless 
sounds, such as air sounds on wind instruments.

NOTE

● These steps do not apply to notes in slash voices.

● If you want to change the notehead design to represent different playing techniques for 
notes belonging to unpitched percussion instruments, you can instead change their playing 
technique.

● If you want to change the notehead design to represent harmonics or rhythm slashes, you 
can instead turn notes into harmonics or change them to a slash voice. You can also input 
slash regions.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the noteheads whose design you want to change. You can do this in Write mode and 
Engrave mode.

Notes
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2. Choose Edit > Notations > Notehead > [Notehead type] > [Notehead design].

For example, to change the notehead design of the selected notes to X noteheads, choose 
Edit > Notations > Notehead > Crosses > X Noteheads.

TIP

You can also choose these options from the context menu.

RESULT
The notehead design of the selected notes is changed.

TIP

● You can also change the notehead design for all noteheads project-wide.

● You can assign a key command for each factory default notehead design and custom 
notehead designs that you have saved as default on the Key Commands page in 
Preferences.

RELATED LINKS
Engrave toolbox on page 514
Project-wide engraving options for rhythm slashes on page 1473
Rhythm slashes on page 1473
Slash voices on page 1483
Slash regions on page 1474
Changing the voice of existing notes on page 477
Harmonics on page 1282
Turning notes into harmonics on page 1283
Playing technique-specific noteheads on page 1683
Changing playing technique-specific noteheads on page 1686
Hiding/Showing stems on page 1280
Hiding/Showing noteheads on page 1257
Custom notehead sets on page 868
Key Commands page in the Preferences dialog on page 63
Changing the size of accidentals on page 945

Changing the notehead design project-wide
You can change the notehead design of all noteheads project-wide; for example, if you are 
working on an educational project and want to show the note name in every notehead.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Notes.

3. In the Noteheads section, choose one of the following options for Notehead design:

● Default size noteheads (smaller than Larger noteheads)

● Larger noteheads (Default)

● Note names

● Figurenotes© colors

4. Click Apply, then Close.
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RESULT
The notehead design of all notes is changed project-wide.

NOTE

This does not change the notehead design of noteheads whose design you have changed 
individually; for example, if you changed selected notes to have diamond noteheads.

Showing differently shaped noteheads for each scale degree project-
wide

You can show each degree of the scale with a different notehead design project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Notes.

3. In the Noteheads section, choose one of the following options for Shaped noteheads 
based on scale degree:

● Walker 4-shape

● Walker 7-shape

● Funk 7-shape

● Aikin 7-shape

RESULT
The notehead design of all noteheads project-wide is changed to show a different notehead 
design for each degree of the scale, depending on your selection.

NOTE

This does not change the notehead design of noteheads whose design you have changed 
individually; for example, if you changed selected notes to have diamond noteheads.

RELATED LINKS
Pitch-dependent notehead set designs on page 1251
Changing the notehead design of individual noteheads on page 1252

Showing note names in noteheads project-wide
You can show the note name as a letter in all noteheads project-wide; for example, if you are 
preparing educational worksheets.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Notes.

3. In the Noteheads section, choose Note names for Notehead design.

4. Click Apply, then Close.
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RESULT
The notehead design of all noteheads not overridden individually is changed to show the note 
name inside noteheads.

TIP

To ensure the note names are easy to read, you can increase the staff size of layouts in your 
project.

RELATED LINKS
Changing the notehead design of individual noteheads on page 1252
Staff size on page 716
Changing the default staff size on page 693

Assigning notes to strings
You can change the string on which individual notes belonging to string instruments are played; 
for example, to allow you to specify the correct harmonic. Many notes can be played on multiple 
strings, depending on where along its length the string is stopped.

Assigning notes to strings can be useful for glissando lines or fingering shifts, as the string 
and finger position required to play the note affects the direction of these changes. However, 
the string number is not shown in the music. You can instead input string indicators and/or 
fingerings, which can help string players understand the string on which they should play.

NOTE

You can only change the assigned string of notes belonging to string instruments, such as violin, 
cello, or guitar.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose assigned string you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

If selecting multiple notes at once, select notes only in staves of the same instrument type. 
For example, select multiple Cs in Violin 1 and Violin 2 staves.

2. In the Properties panel, activate String in the Notes and Rests group.

3. Select the string you want from the menu.

The string number for the instrument is shown, followed by the fundamental pitch and 
the octave number of that string in parentheses. For example, the lowest cello string is 
expressed as 4 (C2).
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NOTE

The options available in the menu depend on the selected pitches and the instrument type.

RESULT
The string to which the selected notes are assigned is changed.

NOTE

If you subsequently change the pitches of notes, String is automatically deactivated for all notes 
that can no longer be played on their assigned string.

RELATED LINKS
Engrave toolbox on page 514
Glissando lines on page 1317
Changing the direction of string fingering shift indicators on page 1182
Fingerings for fretted instruments on page 1169
String indicators on page 1183
Inputting string indicators inside the staff on page 383
Turning notes into harmonics on page 1283
Changing the harmonic partial on page 1284

Changing the width of ledger lines
You can change the width of ledger lines on individual notes; for example, to allow notes with 
short durations to be spaced more tightly and still be legible. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the noteheads whose ledger line width you want to change.

2. In the Properties panel, activate Ledger line in the Notes and Rests group.

3. Change the values for L and R.

RESULT
Increasing Ledger line L makes the left side of ledger lines longer, decreasing the value makes 
the left side of ledger lines shorter.

Increasing Ledger line R makes the right side of ledger lines longer, decreasing the value makes 
the right side of ledger lines shorter.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.
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TIP

You can change the width of all ledger lines project-wide on the Notes page in Engraving 
Options.

RELATED LINKS
Project-wide engraving options for notes on page 1246
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Hiding/Showing ledger lines
You can hide/show ledger lines on individual notes; for example, if you want to indicate 
approximate pitches using the relative vertical positions of notes. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the noteheads whose ledger lines you want to hide/show.

NOTE

If you want to hide ledger lines, you must also select all other noteheads in the same voice 
and voice column index.

2. In the Properties panel, activate/deactivate Hide ledger lines in the Notes and Rests group 
of the Properties panel.

RESULT
Ledger lines are hidden/shown for the selected notes. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

If you deactivated Hide ledger lines for only some notes in a chord, ledger lines are also shown 
on all notes between the selected notes and the staff in the same voice and voice column index.

RELATED LINKS
Voice column index on page 1708

Hiding/Showing noteheads
You can hide/show the noteheads of individual notes with any notehead design; for example, if 
you want to indicate the exact durations of glissando lines using stems without noteheads.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the notes whose noteheads you want to hide.

2. In the Properties panel, activate/deactivate Hide notehead in the Notes and Rests group.

RESULT
The selected noteheads are hidden when Hide notehead is activated, and shown when it is 
deactivated.

This also hides rhythm dots, provided all noteheads represented by consolidated rhythm dots are 
hidden, but does not affect the visibility of accidentals or ledger lines.

Hidden noteheads are included in note spacing calculations as if they were shown.

EXAMPLE

Noteheads shown Middle noteheads hidden

RELATED LINKS
Properties panel on page 769
Hiding/Showing zones on page 47
Hiding/Showing hidden noteheads on page 1262
Hiding/Showing ledger lines on page 1257
Hiding/Showing stems on page 1280
Hiding/Showing or parenthesizing accidentals on page 943
Note spacing on page 599

Rhythm dot consolidation
Rhythm dot consolidation controls how many rhythm dots appear at the same rhythmic position 
in multiple-voice contexts. Depending on the number of notes and voices present, and their 
positions on the staff, different numbers of rhythm dots can be required to appear, and in 
different positions. This can also impact note spacing.

In the Rhythm Dots section of the Notes page in Engraving Options, you can choose how 
rhythm dots in multiple voices are consolidated project-wide. There are separate options for the 
consolidation of rhythm dots generally and on unison notes in particular.
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Rhythm dot consolidation

Notes of any duration have 
rhythm dots consolidated

Only notes of the same duration 
have rhythm dots consolidated

No rhythm dot consolidation

Rhythm dot consolidation on unison notes

One rhythm dot shown per 
notehead in unisons

Rhythm dots shown for each 
notehead for unisons on lines, but 
only one shown per unison in 
spaces

Only one rhythm dot shown per 
unison

TIP

You can also change how rhythm dots in multiple voices are consolidated individually.

RELATED LINKS
Engraving Options dialog on page 840
Note and rest grouping on page 1021
Beam grouping according to meters on page 999
Note positions in multiple-voice contexts on page 1707
Voice column index on page 1708

Changing the consolidation of rhythm dots
You can change how rhythm dots in multiple voices are consolidated at individual rhythmic 
positions, independently of your project-wide setting. For example, if you want to show fewer 
rhythm dots for a very dense chord. You can do this for the current layout and frame chain only, 
or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the notes whose rhythm dot consolidation you want to change.

2. In the Properties panel, activate Rhythm dot consolidation in the Notes and Rests group.

3. Activate/Deactivate the corresponding checkbox.
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RESULT
Rhythm dots for notes of any duration are consolidated when the checkbox is activated, and no 
rhythm dots are consolidated when the checkbox is deactivated. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

When the property is deactivated, rhythm dots follow your project-wide setting for consolidation 
according to note durations.

TIP

You can change how all rhythm dots in multiple voices are consolidated project-wide on the 
Notes page in Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Note positions in multiple-voice contexts on page 1707
Voice column index on page 1708
Allowing/Disallowing noteheads in opposing voices to overlap on page 1706

Moving rhythm dots
You can move rhythm dots horizontally. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. However, you cannot move an individual rhythm dot 
independently of other rhythm dots at the same rhythmic position.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select a notehead at each rhythmic position where you want to move 
rhythm dots.

2. In the Properties panel, activate Rhythm dot X in the Notes and Rests group.

3. Change the value in the value field.

RESULT
Increasing the Rhythm dot X value moves all rhythm dots at the selected rhythmic positions to 
the right, decreasing the value moves them to the left. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.
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Viewing options for notes and rests
You can show notes and rests in different colors in various contexts, which can help you identify 
them more easily as you are working. For example, showing voice colors makes notes and rests 
appear in different colors according to their voice.

RELATED LINKS
Color setup on page 54
Hiding/Showing cue note colors on page 1103
Hiding/Showing rest colors on page 1491
Hiding/Showing voice colors on page 1705
Hiding/Showing condensed music colors on page 764
Hiding/Showing unison range colors on page 1573
Hiding/Showing colors for muted notes/items on page 639

Hiding/Showing colors for notes out of range
You can show colors for notes that are considered out of range, such as notes too high/low for 
the instrument to play or the voice type to sing, or pitches that do not fit with the current harp 
pedal settings. When colors for notes out of range are hidden, all notes appear black by default.

Colors for notes out of range are considered annotations and are not printed by default.

NOTE

You cannot show colors for voices and notes out of range simultaneously.

PROCEDURE

● Do one of the following:

● To show colors for notes out of range, choose View > Note And Rest Colors > Notes 
Out Of Range.

● To hide colors for notes out of range, choose View > Note And Rest Colors > None.

RESULT
Colors for notes out of range are hidden/shown.

Notes that are considered challenging are shown in a darker red, while notes that are impossible 
or virtually impossible are shown in a bright red.

NOTE

Notes out of the fret range of the corresponding string on tablature are always shown as 
question marks, even if you do not show colors for notes out of range.

EXAMPLE

Colors for notes out of range shown. Three notes in the middle of the phrase are bright red, while the rest 
are the darker red.
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AFTER COMPLETING THIS TASK
If showing colors for notes out of range reveals some notes do not fit with the current harp pedal 
settings, you can input a new pedal diagram for that passage or calculate a suitable harp pedal 
diagram.

RELATED LINKS
Changing music area colors on page 57
Inputting harp pedal diagrams on page 380
Calculating harp pedal diagrams based on existing music on page 381
Hiding/Showing voice colors on page 1705
Annotations on page 687

Hiding/Showing hidden noteheads
You can show hidden noteheads in translucent gray, so you can identify and select them more 
easily.

PROCEDURE

● Choose View > Note And Rest Colors > Hidden Noteheads.

RESULT
Hidden noteheads are hidden/shown.

EXAMPLE

Hidden noteheads shown Hidden noteheads hidden

RELATED LINKS
Hiding/Showing noteheads on page 1257
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Bracketed noteheads

Bracketed noteheads are often used to indicate that notes are optional, editorial, not played in all 
playthroughs in music with repeats, or pressed down but not fully struck on the piano. In Dorico 
Pro, you can show brackets on any notehead.

Notehead brackets extend slightly above and below noteheads so it is clear which notes are 
included in each bracket.

A phrase containing round and square notehead brackets

You can also show brackets on noteheads on notation staves and tablature independently of 
each other.

By default, bracketed notes have reduced velocity, causing them to sound quieter in playback 
than normal notes.

The following types of notehead brackets are available in Dorico Pro:

Round notehead brackets
Round notehead brackets have a similar appearance to slurs, but vertical.

By default, round brackets on single noteheads use the font glyph on notation staves 
and the drawn curve on tablature. In Engrave mode, round notehead brackets that use 
the drawn curve have handles that allow you to change their shape. Round notehead 
brackets that use the font glyph do not have handles in Engrave mode.

NOTE

On tablature, round brackets are automatically shown around the second note/chord 
and all subsequent notes/chords in tie chains. If you show brackets around all 
noteheads in tie chains on tablature, these automatic notehead brackets are included.

Round brackets on 
single noteheads on 
a notation staff

Round bracket on a 
chord on a notation 
staff

Round brackets on 
single noteheads on 
tablature

Round bracket on a 
chord on tablature
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Square notehead brackets
Square notehead brackets comprise a straight vertical line with horizontal hooks at 
the top and bottom. Dorico Pro automatically adjusts the length of square brackets to 
ensure they do not end on staff lines and their hooks remain visible.

Square brackets on 
single noteheads on 
a notation staff

Square bracket on a 
chord on a notation 
staff

Square brackets on 
single noteheads on 
tablature

Square bracket on a 
chord on tablature

RELATED LINKS
Showing brackets around one/all noteheads in tie chains on page 1266
Notehead brackets in Engrave mode on page 1269
Showing notes as dead notes on page 1344
Inputting notes on page 221
Ties on page 1620
Changing the appearance of round brackets on single noteheads on page 1269
Guitar bends on page 1323
Guitar pre-bends and pre-dives on page 1326
Vibrato bar dives and returns on page 1328
Parenthesized chord symbols on page 1050

Project-wide engraving options for bracketed noteheads
You can find options for the project-wide appearance and position of notehead brackets on the 
Bracketed Noteheads page in Engraving Options.

The options on the Bracketed Noteheads page allow you to change the default gaps between 
round and square notehead brackets and noteheads, the thickness and shape of notehead 
brackets, and the appearance of round brackets on both notation staves and tablature.

NOTE

Round brackets on single noteheads that use the font glyph do not show handles in Engrave 
mode, meaning you cannot lengthen/shorten them or change their shape/width.

You can also change the maximum interval within chords for which you want to allow Dorico 
Pro to use a single bracket and whether adjacent strings in tablature show a single bracket or 
separate brackets.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
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Showing brackets on noteheads
You can show round or square brackets on individual noteheads, on single notes within chords, 
and on whole chords. For example, if you want to indicate that specific notes are optional or 
an editorial change, or to show notes belonging to unpitched percussion instruments as ghost 
notes.

NOTE

If you want to show brackets on noteheads to represent dead notes, you can instead show notes 
belonging to fretted instruments as dead notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the noteheads on which you want to show brackets. You can do this in Write mode 
and Engrave mode.

NOTE

● If you want to show brackets on individual noteheads in tie chains that are not the first 
notehead, you must select them in Engrave mode.

● If you want to show brackets on whole chords, you must select all notes in those chords.

● If you want to show brackets on both notation staves and tablature, you must select 
notes on both.

2. In the Properties panel, activate Bracket style in the Bracketed Noteheads group.

3. Choose one of the following options:

● Round

● Square

RESULT
The corresponding type of notehead brackets is shown on the selected notes. If you only 
selected notes on tablature, brackets are not shown on the corresponding notes on the notation 
staff, and vice versa.

In Write mode, only the first noteheads in tie chains are bracketed. In Engrave mode, only the 
selected noteheads are bracketed, including in tie chains.

If you selected all notes in chords, Dorico Pro shows a single bracket for each chord unless they 
contain very large gaps, in which case Dorico Pro automatically splits brackets. If you selected 
individual notes within chords, they are each shown with separate brackets.

By default, bracketed notes have reduced velocity, causing them to sound quieter in playback 
than normal notes.

TIP

● Deactivating Bracket style hides brackets on the selected notes.

Bracketed noteheads
Showing brackets on noteheads 
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● You can also hide/show brackets on noteheads by choosing Edit > Notations > Notehead > 
Toggle Round Brackets or Edit > Notations > Notehead > Toggle Square Brackets. You 
can also choose these options from the context menu.

You can assign key commands for these options on the Key Commands page in 
Preferences.

● You can change the volume reduction of bracketed unpitched percussion notes in playback 
in Playback Options > Dynamics > Note Dynamics.

EXAMPLE

Round brackets on single 
noteheads on a notation staff

Round bracket on a chord on a 
notation staff

Split round bracket on a chord on 
a notation staff

Round brackets on single 
noteheads on tablature

Round bracket on a chord on 
tablature

Split round bracket on a chord on 
tablature

RELATED LINKS
Engrave toolbox on page 514
Showing notes as dead notes on page 1344
Notehead brackets in Engrave mode on page 1269
Inputting notes on page 221
Velocity editor on page 796
Playback Options dialog on page 842

Showing brackets around one/all noteheads in tie chains
You can change whether brackets appear only on the first notehead in tie chains or span the 
entire duration of the tie chain; that is, with the left bracket on the first notehead and the 
right bracket on the last notehead in the tie chain. By default, brackets appear only on the first 
notehead in tie chains.

PREREQUISITE

● You have shown brackets on the required notes.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Bracketed noteheads
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PROCEDURE

1. Select the notes whose notehead bracket positions relative to tie chains you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Bracket until end of tie chain in the Bracketed 
Noteheads group.

RESULT
Brackets appear at the start and end of the selected tie chains when Bracket until end of tie 
chain is activated, and only around the first note/chord when it is deactivated.

If you activated Bracket until end of tie chain for a single note in a bracketed chord, the bracket 
on the first chord is not split but an additional bracket appears at the end of the tie chain for 
the selected note only. If you deactivated Bracket until end of tie chain for a single note in a 
bracketed chord whose other notes are bracketed to the end of the tie chain, the bracket at the 
end of the tie chain is split.

If you selected notes on tablature, the automatic brackets shown around the second note/chord 
and all subsequent notes/chords in tie chains are updated to follow your property setting.

EXAMPLE

Brackets around only the first chords in tie chains on 
a notation staff

Brackets at the start and end of whole tie chains on a 
notation staff

Brackets around only the first chord in a tie chain, 
with automatic brackets shown on the second chord 
on tablature

Brackets around the start and end of the whole tie 
chain on tablature

RELATED LINKS
Ties on page 1620
Showing single brackets on figured bass on page 1143
Engrave toolbox on page 514
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Splitting brackets on chords
You can split brackets on any notehead within a chord. By default, Dorico Pro automatically 
shows a single bracket for all notes in a chord unless it contains very large gaps, in which case 
Dorico Pro automatically splits brackets.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the individual notes in chords immediately above where you want to split brackets. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Break bracket in the Bracketed Noteheads group.

RESULT
Brackets are split immediately below the selected notes.

TIP

You can change the default interval between notes above which Dorico Pro automatically 
splits brackets on chords in the Vertical Extent section of the Bracketed Noteheads page in 
Engraving Options.

EXAMPLE

Chord with single round bracket Chord with split round bracket

RELATED LINKS
Inputting chords on page 251
Engraving Options dialog on page 840
Engrave toolbox on page 514
Parenthesized chord symbols on page 1050
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Changing the appearance of round brackets on single 
noteheads

You can change whether round brackets on single noteheads are drawn using the font glyph or 
drawn curve. Only round notehead brackets that use the drawn curve have handles in Engrave 
mode that allow you to change their shape.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Bracketed Noteheads.

3. In the Design section, choose one of the following options for Round bracket appearance 
for single noteheads:

● Use font glyph

● Use drawn curve

4. Click Apply, then Close.

RESULT
The appearance of round brackets on all single noteheads is changed project-wide.

AFTER COMPLETING THIS TASK
You can change the length and shape of individual round notehead brackets that use the drawn 
curve.

RELATED LINKS
Changing the shape of round notehead brackets on page 1270

Notehead brackets in Engrave mode
In Engrave mode, each round notehead bracket has multiple handles that you can move 
independently to adjust their graphical position, length, and shape.

Round notehead brackets that use the drawn curve have three square handles that you can 
move independently. When you move either of the top/bottom handles, the middle handle also 
moves to retain its position relative to the start/end handles.

NOTE

Round brackets on single noteheads that use the font glyph do not show handles in Engrave 
mode, meaning you cannot lengthen/shorten them or change their shape/width.

Square notehead brackets have two handles, one at the top and one at the bottom.

Round notehead bracket handles in Engrave mode Square notehead bracket handles in Engrave mode

Bracketed noteheads
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● Top and bottom handles move the corresponding end of the notehead bracket, controlling 
its graphical length.

● Middle handles control the shape of round notehead brackets. Moving them vertically 
adjusts their curve by changing the angle at which notehead bracket endpoints approach 
noteheads, while moving them horizontally changes the width of round notehead brackets.

You can move these handles to change the graphical length of notehead brackets and the 
shape of round notehead brackets. If necessary, other nearby items, such as ties and slurs, 
automatically move to avoid collisions.

TIP

● The following properties in the Bracketed Noteheads group of the Properties panel are 
activated automatically when you move the corresponding notehead bracket or handle:

● L bracket body moves left notehead brackets. X moves them horizontally, Y moves 
them vertically.

● R bracket body moves right notehead brackets. X moves them horizontally, Y moves 
them vertically.

● L bracket extents controls the height of left notehead brackets. T moves their top 
handles, B moves their bottom handles.

● R bracket extents controls the height of right notehead brackets. T moves their top 
handles, B moves their bottom handles.

● You can change the default positions of all notehead brackets, including the gaps between 
them and other items, and how far notehead brackets extend beyond notes on the 
Bracketed Noteheads page in Engraving Options.

RELATED LINKS
Showing brackets on noteheads on page 1265
Moving items graphically on page 609
Engraving Options dialog on page 840

Changing the shape of round notehead brackets
You can change the shape of individual round notehead brackets; for example, if you want 
some notehead brackets to appear wider or to change their curvature, so that their endpoints 
approach noteheads at a sharper angle. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

NOTE

You can only change the shape of round notehead brackets on single noteheads if they use the 
drawn curve, rather than the font glyph.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the middle handles of each round notehead bracket whose shape 
you want to change.

Bracketed noteheads
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TIP

You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

2. Change the shape of the selected round notehead brackets in any of the following ways:

● To widen right notehead brackets or narrow left notehead brackets, press Alt/Opt-
Right Arrow .

● To narrow right notehead brackets or widen left notehead brackets, press Alt/Opt-
Left Arrow .

● To increase the angle of notehead bracket endpoints, press Alt/Opt-Up Arrow .

● To decrease the angle of notehead bracket endpoints, press Alt/Opt-Down Arrow .

TIP

● To move handles by large increments, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move handles by moderate increments, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Left Arrow .

● To move handles by small increments, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● You can also click and drag middle handles in the corresponding directions.

RESULT
The shape of the selected notehead brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

If necessary, other nearby items, such as ties and slurs, automatically move to avoid collisions. 
This might affect note spacing and casting off.

TIP

The following properties in the Bracketed Noteheads group of the Properties panel are 
activated automatically when you move the middle handle of notehead brackets.

● L round br. middle moves left notehead bracket middle handles. X moves them horizontally, 
changing the width of notehead brackets, and Y moves them vertically, changing the 
curvature of notehead brackets.

● R round br. middle moves right notehead bracket middle handles. X moves them 
horizontally, changing the width of notehead brackets, and Y moves them vertically, 
changing the curvature of notehead brackets.

You can also use these properties to change the width and shape of round notehead brackets by 
changing the values in the value fields.

Deactivating the properties resets the selected notehead brackets to their default shape.

Bracketed noteheads
Notehead brackets in Engrave mode 

1271
Dorico Pro 4.3.30



EXAMPLE

Widened round notehead 
bracket

Narrowed round 
notehead bracket

Endpoint angle increased Endpoint angle 
decreased

RELATED LINKS
Slur shoulder offset on page 1528
Moving items graphically on page 609
Changing the appearance of round brackets on single noteheads on page 1269
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Bracketed noteheads
Notehead brackets in Engrave mode 
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Stems

Stems are vertical lines that extend from noteheads that are a half note or shorter in duration. In 
combination with notehead design, they allow the duration of each note to be clearly identified.

For example, quarter notes (crotchets) and eighth notes (quavers) both have solid black 
noteheads and stems, but eighth notes also have flags on their stems. 16th notes have two 
flags, 32nd notes have three flags, and so on. The length of stems is determined by default in 
Dorico Pro, so stems automatically adjust their length to accommodate more/fewer flags.

The stems of notes and chords can point upwards/downwards, depending on the conventions of 
music engraving and the context of the music. For example, in choral music on two staves, stems 
in the soprano and tenor lines point up, and stems in the alto and bass lines point down.

RELATED LINKS
Note and rest grouping on page 1021
Altered unisons on page 948
Voices on page 1704
Inputting notes on page 221

Project-wide engraving options for stems
You can find options for the project-wide appearance of stems on the Notes page in Engraving 
Options.

The options on the Notes page allow you to change the design, collision avoidance, length, and 
thickness of stems. You can also set when stems are stem up or stem down, when stems are 
shortened in various contexts, and change their default stem direction when on the middle line 
of the staff.

Default flag design Straight flag design

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

NOTE

Stems with tremolo strokes have specific options, which you can find on the Tremolos page in 
Engraving Options. For example, you can change the default distance between tremolo strokes 
and the tips of stems/different stem flags.
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RELATED LINKS
Engraving Options dialog on page 840
Project-wide engraving options for tremolos on page 1660

Stem direction
In Dorico Pro, the stem direction of notes and chords follows rules that are based on the 
conventions of music engraving.

Stem direction is determined automatically, but you can manually change the stem direction of 
individual notes, chords, or of an entire voice. The rules that are applied depend on the following:

● How many voices are active on the staff.

● Whether notes, chords, or beamed groups of notes are affected.

● Whether notes in the same chord or notes in the same beamed group are split between 
staves.

Single notes in single voices

On a five-line staff with only a single voice active, the default stem direction of a single note is 
determined by its staff position.

● If the note is above the middle line, its stem points downwards.

● If the note is below the middle line, its stem points upwards.

● If the note is on the middle line of the staff, its stem direction is determined by the stem 
directions of any adjacent notes, beam groups, or chords. If they both have the same 
stem direction, the note matches them. If the adjacent notes, beam groups, or chords have 
different stem directions, or if there are no adjacent notes, beam groups, or chords, the note 
follows the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

TIP

You can change the default stem direction for notes and beam groups on the middle lines of 
staves, and equally balanced chords, in the Stems section of the Notes page in Engraving 
Options. You can also choose whether they follow your default stem direction or change 
according to the musical context.

Notes on the middle line are stem up because the 
fourth note is stem up

Notes on the middle line are stem down because the 
fourth note is stem down

By default, notes are first input into an up-stem voice, and Dorico Pro treats notes as the only 
voice on the staff until you input more voices.

Single notes in multiple voices

When there are multiple voices on a staff and all voices contain notes, the stem direction of notes 
is determined by the stem direction of their voice. Notes in up-stem voices have up stems, and 

Stems
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notes in down-stem voices have down stems. This applies even when the stems of notes would 
normally point in the other direction, based on their position on the staff.

NOTE

The order in which notes appear between different up-stem voices and different down-stem 
voices depends on their pitch and your settings on the Voices page in Notation Options. You 
can also change the voice column index of notes individually.

When there are only notes in one voice for at least a whole bar, Dorico Pro automatically changes 
the directions of stems so they point in the default direction for their pitch. For example, if a 
staff contains a single up-stem voice and a single down-stem voice but only the down-stem voice 
contains notes or rests, then the stems of notes in the down-stem voice may point upwards, 
depending on the position of the notes on the staff. However, showing rests or implicit rests in 
empty voices forces the stem direction of notes to follow the stem direction of their voice.

Notes in an up-stem voice shown in 
blue.

Notes in a down-stem voice 
shown in orange.

When notes in up-stem and down-
stem voices are in the same bar, 
the stem direction is automatically 
changed.

Chords in single voices

The stem direction for a chord in a single voice is determined by the balance of notes above/
below the middle line of the staff.

● If the note furthest from the middle line is above the middle line, the stem of the chord 
points downwards.

● If the note furthest from the middle line is below the middle line, the stem of the chord 
points upwards.

● If the chord is equally balanced on either side of the middle line of the staff, the stem 
direction is determined by the stem directions of any adjacent notes, beam groups, or 
chords. If they both have the same stem direction, the chord matches them. If the adjacent 
notes, beam groups, or chords have different stem directions, equally balanced chords 
follow the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

TIP

You can change the default stem direction for notes and beam groups on the middle lines of 
staves, and equally balanced chords, in the Stems section of the Notes page in Engraving 
Options. You can also choose whether they follow your default stem direction or change 
according to the musical context.

Beam groups in single voices

The stem direction within beam groups is determined by the balance of notes within the beam 
group that are above/below the middle line of the staff.

Stems
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● If the majority of notes in the beam group are above the middle line, stems in the beam 
group point downwards.

● If the majority of notes in the beam group are below the middle line, stems in the beam 
group point upwards.

● If the beam group contains an equal number of notes either side of the middle line of the 
staff, the stem direction is determined by the stem directions of any adjacent notes, beam 
groups, or chords. If they both have the same stem direction, the beam group matches 
them. If the adjacent notes, beam groups, or chords have different stem directions, equally 
balanced beam groups follow the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

TIP

You can change the default stem direction for notes and beam groups on the middle lines of 
staves, and equally balanced chords, in the Stems section of the Notes page in Engraving 
Options. You can also choose whether they follow your default stem direction or change 
according to the musical context.

RELATED LINKS
Per-flow notation options for voices on page 1705
Notation Options dialog on page 837
Voice column index on page 1708
Implicit rests in multiple-voice contexts on page 1489
Hiding/Showing voice colors on page 1705
Altered unisons on page 948

Changing the default stem direction of notes on the middle staff line
The stems of notes on the middle lines of staves can point upwards/downwards. You can 
change their default direction, and choose whether the stem direction is determined by the stem 
directions of any adjacent notes, beam groups, or chords, or always uses the default direction.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Notes.

3. In the Stems section, choose one of the following options for Stem direction for notes on 
the middle line of the staff in the Stem Directions subsection:

● Determine by context

● Use default direction

4. Optional: Choose one of the following options for Default stem direction for notes on the 
middle line of the staff:

● Up

● Down

5. Click Apply, then Close.

Stems
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Changing the stem direction of notes
You can manually change the stem direction of any note. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose stem direction you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

● In Write mode, you can only select whole tie chains. In Engrave mode, you can select 
individual notes within tie chains.

● Changing the stem direction in Write mode only affects the first note in the tie chain.

2. Change the stem direction in one of the following ways:

● Choose Edit > Notations > Stem > Force Stem Up.

● Choose Edit > Notations > Stem > Force Stem Down.

TIP

You can also choose these options from the context menu.

RESULT
The stem direction of the selected notes is changed. The selected notes follow this stem 
direction, even if you later change their pitch to one that usually requires a different stem 
direction. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

NOTE

● This does not change the voice to which notes belong.

● You can also change the stem direction of notes by selecting them and pressing F .

EXAMPLE

Stems pointing in the same direction but in different 
voices

Stems in the same direction and in the same voice

RELATED LINKS
Changing the voice of existing notes on page 477

Stems
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Changing the staff-relative placement of items on page 441
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the default stem direction of voices
You can change the default stem direction of voices after they have been input, including slash 
voices.

NOTE

This changes the implicit stem direction of the voice, but may not change the stem direction of 
all notes in single-voice contexts. Stem directions are automatically changed in Dorico Pro when 
only one voice contains notes.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select a note or chord in the voice whose stem direction you want to change. You can do this 
in Write mode and Engrave mode.

2. Change the default stem direction of the selected voice in one of the following ways:

● Choose Edit > Notations > Voices > Default Stems Up.

● Choose Edit > Notations > Voices > Default Stems Down.

TIP

You can also choose these options from the context menu.

Removing stem direction changes
You can remove changes to the directions of stems and revert stems to their default directions.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose stem direction changes you want to remove. You can do this in Write 
mode and Engrave mode.

2. Choose Edit > Notations > Stem > Remove Forced Stem. You can also choose this option 
from the context menu.

RESULT
All stem direction changes are removed from the selected notes. The stems of the selected notes 
revert to their default directions.

Stems
Stem direction 

1278
Dorico Pro 4.3.30



NOTE

Alternatively, you can change the stem direction to the opposite direction. However, notes with 
forced stems do not change automatically if, for example, you later change their pitch.

Stem length
The length of stems is determined by default in Dorico Pro, according to accepted standards for 
the appearance of stems of notes at different positions on staves.

You can change the default settings for the length of all stems project-wide and you can 
lengthen/shorten individual stems in Engrave mode.

Lengthening/Shortening stems
You can lengthen/shorten the stems of individual notes, independently of your project-wide 
settings. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the stems you want to lengthen/shorten.

2. Lengthen/Shorten the stems by moving the selected stem handles in any of the following 
ways:

● To move them upwards/downwards a standard amount, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move handles 
upwards. This moves handles by 1/8 space per press.

● To move them upwards/downwards a large amount, press Ctrl/Cmd  plus the standard 
key command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves handles by 1 
space per press.

● To move them upwards/downwards a moderate amount, press Shift  plus the standard 
key command; for example, Shift-Alt/Opt-Up Arrow . This moves handles by 1/2 space 
per press.

● To move them upwards/downwards a small amount, press Ctrl/Cmd - Shift  plus the 
standard key command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves 
handles by 1/32 space per press.

● Click and drag them upwards/downwards.

RESULT
The selected stems are lengthened/shortened. For example, moving the end of downwards-
pointing stem upwards shortens the stem. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

TIP

● Stem adj. in the Notes and Rests group of the Properties panel is activated when you 
lengthen/shorten stems.
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You can also use this property to lengthen/shorten stems by changing the value in the value 
field. However, the Notes and Rests group is only available when the notehead is selected 
rather than the stem.

Deactivating the property resets the selected stems to their default length.

● You can change the default length of all stems project-wide in the Stems section of the 
Notes page in Engraving Options. There are different options for stems in different 
contexts.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Hiding/Showing stems
You can hide/show the stems on notes with any notehead design. For example, you might hide 
stems if you do not want to show exact rhythms in an unmeasured passage.

Dorico Pro allows you to hide stems rather than using a stemless notehead design as this allows 
you to hide the stem of any notehead design.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the notes whose stems you want to hide.

2. In the Properties panel, activate/deactivate Hide stem in the Notes and Rests group.

RESULT
The stems and any applicable flags of the selected notes are hidden when Hide stem is 
activated, and shown when it is deactivated.

NOTE

● Beams are only hidden when you hide the stems of all notes in beamed groups.

● You can assign a key command for Toggle Hide Stem on the Key Commands page in 
Preferences.

EXAMPLE

Stems shown Stems hidden

Stems
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RELATED LINKS
Notehead set designs on page 1247
Inputting notes on page 221
Hiding/Showing noteheads on page 1257
Preferences dialog on page 61

Erasing the background of stems
You can erase the backgrounds of all stems project-wide; for example, to ensure hairpins remain 
legible when appearing close to the staff in tightly spaced scores.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Notes.

3. In the Stems section, activate/deactivate Erase background behind stems with erasure of 
width [n] spaces.

4. Optional: Change the value in the value field.

5. Click Apply, then Close.

RESULT
The backgrounds of all stems project-wide are erased when the option is activated, and not 
erased when the option is deactivated. The erasure padding follows your set value.

EXAMPLE

Stems crossed by hairpin with non-erased 
backgrounds

Stems crossed by hairpin with erased backgrounds

RELATED LINKS
Erasing the background of dynamics on page 1110
Erasing the background of text playing techniques on page 1389
Erasing the background of text items on page 1617

Stems
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Harmonics

Harmonics are pitches produced by touching resonating strings at specific positions along their 
length, allowing the corresponding harmonic partial to sound. Harmonics often have a high pitch 
with a glassy, purer sound than stopped pitches. There are two different types of harmonics: 
natural and artificial.

Harmonic partials are numbered according to their order in the harmonic series, which also 
correlates to the node on the string which produces them. For example, the second partial in the 
harmonic series is produced by the node halfway along a string; that is, the node that divides the 
string into two equal parts. The third partial is produced by the node that divides the string into 
thirds, and so on.

Natural harmonics
Natural harmonics are produced by touching an open string at one of its nodes and 
then bowing or plucking the string. The sounding pitch of the resulting harmonic 
varies according to the node and its corresponding partial in the harmonic series. For 
example, touching the node halfway along a string produces the second partial, which 
sounds an octave above the open string pitch.

Artificial harmonics
Artificial harmonics are produced by stopping a string fully (as if playing a normal note) 
and then touching the string at one of the nodes of its stopped length. The sounding 
pitch of the resulting harmonic varies according to the node and its corresponding 
partial in the harmonic series. For example, touching the node that is the equivalent of 
a fourth higher than the stopped pitch produces the fourth partial, which sounds two 
octaves above the stopped pitch.

To produce artificial harmonics, players must both fully stop the string and touch 
the string at the correct node. This can be more difficult to produce than natural 
harmonics.

A passage for violin alternating between artificial 
and natural harmonics on the A string

The sounding pitches of the same passage

Dorico Pro supports multiple conventions for the notation of harmonics on stringed and 
fretted instruments, including for both natural and artificial harmonics. For artificial harmonics 
shown using two noteheads, one normal and one diamond, Dorico Pro automatically calculates 
the correct pitch for the touched pitch diamond notehead for the second to sixth harmonic 
partials. These pitches are reflected in playback, using dedicated sounds for harmonics if the 
corresponding playback device includes them.
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Turning notes into harmonics
You can turn existing notes into artificial and natural harmonics. Harmonics can represent the 
sounding, touched, or stopped pitch.

PREREQUISITE

● You have input the notes you want to turn into harmonics. However, the pitch you should 
input depends on the harmonic type you want to use.

● For natural harmonics, we recommend that you input the desired sounding pitch.

● For artificial harmonics, we recommend that you input the stopped pitch.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to turn into harmonics. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Type in the Harmonics group.

3. Choose one of the following options:

● Artificial

● Natural

RESULT
The selected notes are turned into harmonics of the corresponding type. If the corresponding 
playback device has dedicated sounds for harmonics, the selected notes automatically use those 
sounds. The sounding pitch of artificial harmonics in playback is also changed accordingly.

● Artificial harmonics represent the second partial by default. They are shown with a diamond 
notehead indicating the touched pitch an octave above the selected notes. On tablature, the 
stopped fret is shown on the left and the touched fret is shown on the right in parentheses.

● Natural harmonics represent the sounding pitch by default. They are shown with a circle 
symbol above the selected notes. On fretted instrument notation staves, natural harmonics 
appear as black diamond noteheads. On tablature, the fret of the touched pitch is shown, if it 
can be calculated; if it cannot be calculated, a pink question mark is shown.

EXAMPLE
The following examples show the default appearances of natural and artificial harmonics on 
different staves.

Harmonics
Turning notes into harmonics 
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Artificial 
harmonic on 
notation staff 
(any instrument)

Artificial 
harmonic on 
tablature

Natural 
harmonic on 
non-fretted 
instrument staff

Natural 
harmonic on 
fretted 
instrument 
notation staff

Natural 
harmonic on 
tablature

Natural 
harmonic on 
tablature that 
cannot be 
calculated

AFTER COMPLETING THIS TASK
You can change the partial for harmonics. You can also change the appearance of natural 
harmonics and the style of artificial harmonics.

If you want to turn harmonics back into normal notes, deactivate Type in the Harmonics group.

RELATED LINKS
Inputting notes on page 221
Engrave toolbox on page 514
Appearances/Styles of harmonics on page 1286
Changing music area colors on page 57
Assigning notes to strings on page 1255
Tablature on page 1580

Changing the harmonic partial
By default, harmonics indicate the second partial in the harmonic series, which is an octave 
above the fundamental. You can change the partial for individual harmonics; for example, if you 
want a higher partial instead.

NOTE

Dorico Pro can only correctly calculate artificial harmonic partials for nodes two to six.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the harmonics whose partial you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Partial in the Harmonics group.

3. Change the value in the value field to the node at which the string should be touched to 
produce the partial you want.

Harmonics
Changing the harmonic partial 
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RESULT
The partial of the selected harmonics is changed. For artificial harmonics using the Normal type, 
the pitch of the white diamond notehead/parenthesized fret number is updated automatically. 
The sounding pitch of artificial harmonics in playback is also changed accordingly.

EXAMPLE

Artificial harmonic with default partial

(notation and tablature)

Partial changed to the fifth

(notation and tablature)

Hiding/Showing or parenthesizing harmonic accidentals
You can hide/show individual harmonic accidentals, or show them in round or square brackets, 
independently of hiding/showing or parenthesizing accidentals of stopped pitch notes. For 
example, you can show cautionary accidentals on subsequent notes in tie chains that cross 
system/frame breaks by showing accidentals in round brackets. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the harmonics whose accidentals you want to hide/show or parenthesize. You can do 
this in Write mode and Engrave mode.

NOTE

You can only select individual noteheads within tie chains in Engrave mode.

2. In the Properties panel, activate Accidental in the Harmonics group.

3. Select one of the following options from the menu:

● Hide

● Show

● Round brackets

Harmonics
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● Square brackets

RESULT
Accidentals on the selected harmonics are hidden, shown, or shown in round or square brackets. 
If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

NOTE

● Hiding accidentals does not affect the pitch of notes in playback.

● If you are hiding/showing many accidentals, we recommend that you consider changing the 
accidental duration rule.

● You can assign key commands for Hide Accidental, Show Accidental, Show Accidental in 
Round Brackets, and Show Accidental in Square Brackets on the Key Commands page in 
Preferences.

AFTER COMPLETING THIS TASK
You can also hide/show or parenthesize accidentals on the normal noteheads that indicate the 
stopped pitch for artificial harmonics shown using diamond noteheads.

RELATED LINKS
Hiding/Showing or parenthesizing accidentals on page 943
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Appearances/Styles of harmonics
Both artificial and natural harmonics can be notated in different ways. In Dorico Pro, it is possible 
to indicate the desired sounding pitch, either the stopped or touched pitch, or both stopped and 
touched pitches for individual harmonics.

In this documentation we refer to “styles” of artificial harmonics, because one artificial harmonic 
style indicates the use of a different performance technique, and “appearances” of natural 
harmonics, as their different appearances do not indicate different performance techniques.

Natural harmonics

Circle above
Shows a harmonic circle symbol on the notehead side of notes. Usually indicates the 
desired sounding pitch of the harmonic. Used for natural harmonics on staves that do 
not belong to fretted instruments by default, such as violin.

Diamond notehead
Changes the notehead of notes to a diamond notehead. The diamond notehead 
appears black/filled when the note is a quarter note or shorter, and white/unfilled 
when the note is a half note or longer. Usually indicates the touched pitch required. 
Used for natural harmonics on fretted instrument notation staves by default.

Harmonics
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White diamond notehead
Changes the notehead of notes to a diamond notehead that is always unfilled, 
regardless of the duration of notes. Usually indicates the touched pitch required.

On tablature, the touched fret is always shown for natural harmonics, regardless of the selected 
appearance. If the touched fret cannot be calculated, a pink question mark is shown.

Artificial harmonics

Normal
Shows two noteheads: one indicating the stopped pitch, the other the touched pitch. 
The touched pitch is automatically calculated based on the partial; the default partial is 
the second partial. On tablature, the stopped fret is shown on the left and the touched 
fret is shown on the right in parentheses. This is the default appearance of artificial 
harmonics on all staves.

Normal artificial harmonic on notation staff Normal artificial harmonic on tablature

Pinch
Shows two noteheads: one indicating the stopped pitch, the other the sounding pitch. 
The sounding pitch is automatically calculated based on the partial; the default partial 
is the second partial. On tablature, only the stopped fret is shown.

NOTE

Intended for fretted instruments only. A pinch is produced by the performer catching 
a resonating string at a node near the pick-ups, producing a high-pitched squeal. Also 
known as a “false harmonic” or “squeal”.

Harmonics
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Pinch harmonic on notation staff Pinch harmonic on tablature

Single notehead (sounding)
Shows a single notehead indicating the sounding pitch. On tablature, the stopped fret 
is shown on the left and the sounding pitch is shown on the right in parentheses.

Single notehead (sounding) artificial 
harmonic on notation staff

Single notehead (sounding) artificial 
harmonic on tablature

Single notehead (stopped)
Shows a single notehead indicating the stopped pitch. On tablature, the stopped fret is 
shown on the left and the touched fret is shown on the right in parentheses.

Single notehead (stopped) artificial 
harmonic on notation staff

Single notehead (stopped) artificial 
harmonic on tablature

RELATED LINKS
Edit Notehead Sets dialog on page 869
Changing music area colors on page 57

Changing the appearance of natural harmonics
By default, natural harmonics appear as normal noteheads with a circle shown above, which 
indicates the desired sounding pitch. You can change the appearance of natural harmonics 
individually; for example, to show them as a white diamond notehead to indicate the touched 
pitch.

NOTE

These steps only apply to harmonics with the Natural type.

PREREQUISITE

● The lower zone is shown.

Harmonics
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the natural harmonics whose appearance you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Style in the Harmonics group.

3. Select one of the following options from the menu:

● Circle above

● Diamond notehead

● White diamond notehead

RESULT
The appearance of the selected natural harmonics is changed, including on fretted instrument 
notation staves. The touched pitch shown on tablature is not changed automatically.

NOTE

● Changing the appearance of natural harmonics does not automatically change their notated 
pitch. For example, if you want to change a sounding pitch Circle above harmonic to a 
touched pitch White diamond notehead harmonic, you must also change the pitch of the 
note.

● Dorico Pro automatically assigns natural harmonics with the White diamond notehead style 
to the lowest possible string for that harmonic. You can specify different strings if necessary.

● You can change the staff-relative placement of harmonic circle symbols by activating 
Placement in the Harmonics group of the Properties panel and choosing the option you 
want.

RELATED LINKS
Turning notes into harmonics on page 1283
Changing the pitch of individual notes on page 479
Assigning notes to strings on page 1255
Engrave toolbox on page 514
Tablature on page 1580

Changing the style of artificial harmonics
By default, artificial harmonics appear as two noteheads: one normal, which indicates the 
stopped pitch, and one diamond, which indicates the touched pitch. You can change the style 
of artificial harmonics individually; for example, to indicate pinch harmonics.

NOTE

These steps only apply to harmonics with the Artificial type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Harmonics
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PROCEDURE

1. Select the artificial harmonics whose style you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Style in the Harmonics group.

3. Select one of the following options from the menu:

● Normal

● Pinch

● Single notehead (sounding)

● Single notehead (stopped)

RESULT
The style of the selected artificial harmonics is changed.

NOTE

Pinch indicates the use of a different technique to produce the harmonic.

Harmonics
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Ornaments

Ornaments are markings that indicate multiple notes are played in addition to the notated pitch. 
They are used to decorate music, such as in Baroque music, which is highly decorated with trills 
and other ornaments.

Over time, specific ways of notating how performers should play notes have developed 
and different ornament symbols indicate different patterns of decorative notes. Nonetheless, 
ornaments give some freedom to performers to embellish music in their own way.

In Dorico Pro, the term “ornaments” refers to ornament symbols, including mordents and turns, 
and trill marks.

A phrase containing a turn, short trills, and a trill with extension line

NOTE

Only trills are currently reflected in playback. Playback of other ornaments is planned for future 
versions.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Grace notes on page 1193
Positions of ornaments on page 1293
Trills on page 1295
Trills in playback on page 1306

Project-wide engraving options for ornaments
You can find options for the project-wide appearance and position of ornaments and trills on the 
Ornaments page in Engraving Options.

The options on the Ornaments page allow you to change the position of trills relative to 
accidentals, noteheads, trill extension lines. You can also change the default appearance of trill 
marks on subsequent systems, the appearance and restatement of trill intervals, and set the 
minimum distance between ornaments and the staff and noteheads.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
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Changing ornament intervals
You can change the intervals of ornaments, both above and below the notated pitch, to 
indicate which pitches are played in the ornament. The intervals of ornaments are indicated 
by accidentals.

For some ornaments, you can only change the interval in one direction. For example, you can 
only change the interval above short trills and below mordents.

NOTE

These steps do not apply to trills.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the ornaments whose interval you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Ornaments group, as appropriate for the selected ornaments:

● Interval above

● Interval below

3. Change the values in the value fields to the intervals you want.

● 0 or 4 and above shows no accidental.

● 1 shows a flat.

● 2 shows a natural.

● 3 shows a sharp.

RESULT
The intervals of the selected ornaments are changed.

NOTE

● Some ornaments do not show accidentals either above or below, depending on their type.

● You can change the position of ornament accidentals relative to all trills project-wide on the 
Ornaments page in Engraving Options.

EXAMPLE

No accidentals Flats above and below Naturals above and 
below

Sharps above and below

Ornaments
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RELATED LINKS
Engrave toolbox on page 514
Trill intervals on page 1298
Changing vibrato bar dip intervals on page 1344

Positions of ornaments
Ornaments, including trills, are placed above the notes to which they apply. They are only placed 
below the staff for down-stem voices in multiple-voice contexts.

Ornaments and trills are positioned outside of slurs by default. Similarly, they are positioned 
further from noteheads than articulations.

The center of ornaments aligns with the center of the notehead to which they apply. Trills are 
aligned differently, as the left side of trill marks aligns with the left edge of the notehead to which 
the trill applies.

Dorico Pro automatically positions ornaments correctly according to their type, and attaches 
them to their notehead.

You can move ornaments to different rhythmic positions in Write mode. They are positioned by 
default according to your settings in Engraving Options.

You can move ornaments graphically in Engrave mode, but this does not change the rhythmic 
positions to which they are attached.

You can change the default positions of all ornaments and trills project-wide on the Ornaments 
page in Engraving Options.

RELATED LINKS
Trills on page 1295
Hiding/Showing trill marks on page 1295
Moving notes/items rhythmically on page 465
Moving items graphically on page 609

Changing the position of ornaments relative to slurs
Ornaments are positioned outside of slurs by default. You can change the position of ornaments 
relative to slurs individually. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the ornaments whose slur-relative position you want to change.

2. In the Properties panel, activate Slur-relative position in the corresponding group for the 
selected ornaments:

● Ornaments

● Trills

Ornaments
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3. Choose one of the following options:

● Inside

● Outside

RESULT
The selected ornaments are positioned either inside or outside of slurs. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

Changing the start position of trills
You can change whether the start position of individual trills is aligned with the notehead or with 
its accidental, independently of your project-wide setting. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trills whose start position you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Start position in the Trills group.

3. Choose one of the following options:

● Notehead

● Accidental

RESULT
The start position of the selected trills is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

You can change the start position of all trills project-wide on the Ornaments page in Engraving 
Options.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Hiding/Showing trill extension lines on page 1297
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Trills

Trills are fast alternations between two notes, similar to a tremolo, that were a common 
decoration in Baroque, Classical, and Romantic music. Trill marks are usually added to a single 
note, to indicate the performed notes are the notated pitch and the note either a half-step or 
whole step above, and can have extension lines to show the duration of the trill.

A phrase containing multiple trills with extension lines

Because of their legacy as an ornament, many performers interpret trills differently to tremolos: 
some players add more emphasis to the notated pitch in a trill and less on the trilled-to note but 
play both notes equally in tremolos.

The most common trills are to notes a major or minor second above, but it is also possible to 
specify other trill intervals.

In Dorico Pro, you can specify any trill interval, change their appearance on notation staves, and 
hear them in playback.

On tablature, the trilled-to pitch always appears as a parenthesized fret number.

Trills on a notation staff and tablature

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Trill intervals on page 1298
Changing the start position of trills on page 1294
Trills in playback on page 1306
Tablature on page 1580
MIDI Import Options dialog on page 90

Hiding/Showing trill marks
You can hide/show trill marks at the start of individual trills. This also hides/shows trill marks on 
all systems on which the trills extend.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose trill marks you want to hide/show. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Show trill mark in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Trill marks are shown when the checkbox is activated, and hidden when the checkbox is 
deactivated.

When the property is deactivated, trill marks follow your project-wide setting.

RELATED LINKS
Trill interval appearance on page 1303
Hiding/Showing trill interval accidentals on page 1299
Hiding/Showing speed changes in trill extension lines on page 1297
Hiding/Showing trill extension lines on page 1297
Engrave toolbox on page 514

Changing the speed of trills
You can indicate different speeds for trills, including indicating a change of speed within a single 
trill, by changing the height and frequency of wiggles in their extension lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose speed you want to change. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Trills group:

● Start speed

● End speed

3. Select one of the following options from each property menu:

● Slow

● Normal

● Fast

RESULT
The speed of the selected trills is changed. This affects both the frequency of wiggles in their 
extension lines and their playback speed.

Trills
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If only Start speed is activated, the speed of the whole trill extension line is changed. If only End 
speed is activated, the speed of the end half of the trill extension line is changed.

EXAMPLE

A trill extension line starting slow and ending fast Trill with normal speed throughout

AFTER COMPLETING THIS TASK
You can customize the playback speed of trills individually.

RELATED LINKS
Changing the playback speeds of trills on page 1308
Engrave toolbox on page 514

Hiding/Showing speed changes in trill extension lines
You can hide/show speed changes in the extension lines for individual trills; for example, if you 
want to hear different speeds in playback but show extension lines with consistent wiggles.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose speed changes you want to hide/show. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate/deactivate Suppress drawing speed changes in the Trills 
group.

RESULT
Speed changes are hidden when the property is activated, and shown when it is deactivated.

Hiding/Showing trill extension lines
You can hide/show the extension lines of individual trills. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Trills
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PROCEDURE

1. Select the trills whose extension lines you want to hide/show. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate/deactivate Has trill line in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Trill extension lines are shown when the checkbox is activated, and hidden when the checkbox is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

When the property is deactivated, trills follow your project-wide setting.

TIP

You can hide/show trill extension lines on all trills project-wide on the Ornaments page in 
Engraving Options.

You can also change the end position of trill extension lines relative to final noteheads in tie 
chains.

RELATED LINKS
Changing the start position of trills on page 1294
Changing the speed of trills on page 1296
Changing the playback speeds of trills on page 1308
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Trill intervals
Trill intervals tell performers which notes to play and also affect the pitches used in playback in 
Dorico Pro. For example, a trill with a sharp accidental on an E indicates that the performer trills 
between E and F♯, rather than between E and F.

The different accidentals on these trills indicate changes in the trilled-to note.

If you do not specify an interval when inputting a trill, Dorico Pro calculates an appropriate 
interval based on the top note in the voice to which the trill belongs, the current key signature, 
and any accidentals earlier in the bar. For example, inputting a trill on an E♮ in C major produces 
a half-step/minor second trill interval to F♮. If there were a sharp accidental on the F earlier in the 
bar, the trill interval produced is a whole step/major second between the E♮ and F♯.
In open/atonal key signatures, Dorico Pro produces whole step/major second trill intervals by 
default.

Trills
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You can specify trill intervals when inputting them with the popover, including at different 
noteheads in the same trill, and you can change individual trill intervals after they have been 
input. In 12-EDO, you can describe trill intervals based on their quality, such as major or minor.

When trill intervals do not require a trill interval indicator, they are indicated by signposts. 
However, trill interval signposts are hidden by default.

Trills and accidentals

If required, Dorico Pro shows accidentals to clarify trill intervals. Dorico Pro also automatically 
shows accidentals on other notes in the bar if they have different accidentals to any upper notes 
of trills.

By default, trill marks themselves show intervals, unless the upper note is modified by an 
accidental in the key signature. If the upper note has been modified by an accidental earlier in 
the bar, trills always show the interval. If trills modify pitches modified by an accidental in the key 
signature, any subsequent notes of that pitch show the appropriate accidental automatically. Any 
cautionary accidentals required in the current and following bars are also shown automatically.

Microtonal trill intervals

When using other tonality systems than 12-EDO, such as 24-EDO, you must specify trill intervals 
as an interval degree, expressed as the number of staff position steps, and total number of 
octave divisions from the notated pitch. This is because specifying only the interval quality is 
insufficient in such cases.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Trill interval appearance on page 1303
Inputting ornaments/trills with the popover on page 347
Ornaments popover on page 342
Signposts on page 453
Changing ornament intervals on page 1292
Changing vibrato bar dip intervals on page 1344

Hiding/Showing trill interval accidentals
You can hide/show accidentals for individual trill intervals; for example, if you want to show the 
accidental for the first note of a trill but hide the accidentals for subsequent notes. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

● In order to show trill interval accidentals, trills must have intervals that require accidentals.

● These steps only hide the accidentals shown in trill intervals, they do not hide auxiliary notes 
or Hollywood-style markings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Trills
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PROCEDURE

1. Select the trill intervals, or trill interval signposts whose accidentals you want to hide/show. 
You can do this in Write mode and Engrave mode.

NOTE

For trills that span multiple notes and have multiple trill interval accidentals, you must select 
each accidental or signpost individually. If you select the whole trill, only the first trill interval 
accidental is changed.

2. In the Properties panel, activate Accidental in the Trills group.

3. Choose one of the following options:

● Hide

● Show

RESULT
Accidentals in the selected trill intervals are hidden when you choose Hide, and shown when 
you choose Show. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

Signposts are shown at the position of each hidden trill interval accidental. However, trill interval 
signposts are hidden by default.

TIP

You can choose to repeat or hide all Hollywood-style trill intervals on successive notes in the Trill 
Intervals section of the Ornaments page in Engraving Options.

RELATED LINKS
Changing the appearance of trill intervals on page 1304
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Annotations on page 687
Hiding/Showing signposts on page 454
Engraving Options dialog on page 840

Changing trill intervals
The default trill interval is a second, either major or minor depending on the context. In addition 
to specifying the interval when inputting trills with the ornaments popover, you can change the 
intervals of trills and existing trill intervals within their duration individually after they have been 
input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Trills
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PROCEDURE

1. Select the trills, trill intervals, or trill interval signposts whose interval you want to change. 
You can do this in Write mode and Engrave mode, but in Engrave mode you must select the 
trill intervals/trill interval signposts.

NOTE

For trills that span multiple notes and have multiple interval changes, you must select each 
trill interval you want to change individually. If you select the trill mark/extension line, only 
the first trill interval is changed.

2. In the Properties panel, activate Interval in the Trills group.

3. Change the interval degree, expressed as the number of staff position steps, by changing 
the value in the value field.

4. Change the interval quality or total number of octave divisions from the trilled note in one of 
the following ways:

● For trills in 12-EDO, select an interval quality from the menu.

● For trills in other tonality systems, select a total number of octave divisions from the 
menu.

Together, the interval degree and either interval quality or total number of octave divisions 
specify the desired note name and accidental for the trilled-to note.

RESULT
The interval of the selected trill intervals is changed. This applies from the selected trill intervals 
until the next interval change in the trill or the end of the trill, whichever comes first. For 
example, if you selected a trill with no interval changes within its duration, the interval is 
changed for the whole trill.

By default, trill intervals appear as accidentals when the interval is a second and as auxiliary 
notes for all other intervals. Signposts are shown at the position of each trill interval that does 
not require an accidental or auxiliary note. However, trill interval signposts are hidden by default.

RELATED LINKS
Resetting trill intervals on page 1302
Ornaments popover on page 342

Changing trill intervals partway through trills
You can change the intervals of existing trills at any notehead within their duration; for example, 
if you want a trill to change seamlessly from a minor second in one bar to a major second in the 
next.

PROCEDURE

1. In Write mode, select one of the following:

● The note whose trill interval you want to change.

● An item or rest on the staff where you want to specify trill intervals.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

Trills
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3. Press Right Arrow / Left Arrow  to move the caret according to the current rhythmic grid 
resolution to the notehead where you want to change the trill interval.

NOTE

You can only change trill intervals at noteheads.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the trill interval you want into the popover. For example, enter m3 for a minor third.

6. Press Return  to close the popover.

7. Optional: Repeat steps 3 to 6 to change the trill interval at other noteheads in the trill.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The trill interval is changed at the corresponding noteheads. By default, all trill intervals in the 
trill appear as accidentals when the intervals are all seconds and as auxiliary notes when the trill 
contains at least one trill interval with a different interval.

Signposts are shown at the position of each trill interval that does not require an accidental or 
auxiliary note. However, trill interval signposts are hidden by default.

EXAMPLE

Trill with interval changes shown as accidentals Trill with interval changes shown as auxiliary notes

RELATED LINKS
Changing the appearance of trill intervals on page 1304
Ornaments popover on page 342
Signposts on page 453
Hiding/Showing signposts on page 454
Notes toolbox on page 197
Rhythmic grid on page 214

Resetting trill intervals
You can reset trill intervals to the default trill interval of a second, either major or minor 
depending on the context, including resetting individual trill intervals within a single trill 
independently.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills, trill intervals, or trill interval signposts whose interval you want to reset. You 
can do this in Write mode and Engrave mode, but in Engrave mode you must select the trill 
intervals/trill interval signposts.

NOTE

For trills that span multiple notes and have multiple interval changes, you must select each 
trill interval you want to reset individually. If you select the trill mark/extension line, only the 
first trill interval change is reset.

2. In the Properties panel, deactivate Interval in the Trills group.

RESULT
The interval of the selected trill intervals is reset. This applies from the selected trill intervals until 
the next interval change in the trill or the end of the trill, whichever comes first. For example, if 
you selected a trill with no interval changes within its duration, the interval is reset for the whole 
trill.

By default, trill intervals appear as accidentals when the interval is a second and as auxiliary 
notes for all other intervals. Signposts are shown at the position of each trill interval that does 
not require an accidental or auxiliary note. However, trill interval signposts are hidden by default.

RELATED LINKS
Properties panel on page 769
Signposts on page 453
Hiding/Showing signposts on page 454

Trill interval appearance
There are different accepted ways to present trill intervals on notation staves, including 
accidental symbols and the Hollywood convention of showing “H.T.” for a half-step (semitone) 
and “W.T.” for a whole step (tone).

In Dorico Pro, trill intervals can appear in the following ways on notation staves:

Accidental
Indicates the trill interval using accidentals positioned above, below, or beside the tr 
mark. This is the default trill interval appearance in Dorico Pro for major or minor 
second trills.

Hollywood-style
Indicates the trill interval using text.

● H.T. for half-step/minor second trills

● W.T. for whole step/major second trills

Trills
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Auxiliary note
Indicates the trill interval using a small, parenthesized, stemless notehead shown in 
the staff immediately to the right of the first note to which the trill applies, and at the 
correct staff position for the trilled-to pitch. Auxiliary notes are used for all trill intervals 
that are not a major or minor second, but are automatically hidden for unison trills if 
the notehead design of the auxiliary note has not been overridden.

NOTE

● On tablature, the trilled-to pitch always appears as a parenthesized fret number.

● You can find options for the default appearance, position, and restatement of trill intervals 
on the Ornaments page in Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341

Changing the appearance of trill intervals
You can change the appearance of trills with a second interval on notation staves individually, 
independently of your project-wide setting; for example, if you want to show auxiliary notes on 
some trills to clarify a change in the trilled-to pitch.

NOTE

You can only change the trill interval appearance of trills with a major/minor second interval.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose trill interval appearance you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Appearance in the Trills group.

3. Select one of the following options from the menu:

● Accidental

● Hollywood style
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● Auxiliary note

RESULT
The appearance of the selected trill intervals on notation staves is changed. This does not affect 
their appearance on tablature.

TIP

You can change the default appearance of all trills with a second interval project-wide in the Trill 
Intervals section of the Ornaments page in Engraving Options.

AFTER COMPLETING THIS TASK
You can change the notehead design of individual auxiliary notes; for example, to show that the 
trilled-to note is a harmonic.

RELATED LINKS
Project-wide engraving options for ornaments on page 1291
Engraving Options dialog on page 840
Changing the notehead design of individual noteheads on page 1252
Engrave toolbox on page 514

Changing the position of trill interval indicators
You can change where trill interval indicators, such as an accidental or W.T. marking, are 
positioned relative to individual trill marks, independently of your project-wide setting. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

This does not affect the position of trill interval accidentals on subsequent notes over which trills 
extend.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trills whose interval indicator position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Interval position in the Trills group.

3. Select one of the following options from the menu:

● Above

● Below

● On the right

● Superscript
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RESULT
The position of interval indicators relative to the selected trill marks is changed. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default position of interval indicators relative to all trill marks project-wide in 
the Trill Intervals section of the Ornaments page in Engraving Options.

EXAMPLE

Above Below On the right Superscript

RELATED LINKS
Trill intervals on page 1298
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Trills in playback
Dorico Pro plays back trills by using a combination of sampled trills, when available, and 
triggering multiple notes.

● You can find options for trill playback on the Trills page in Playback Options.

Dorico Pro can play back sampled half-step (semitone) and whole step (tone) trills automatically if 
these playing techniques are defined in the VST expression map, which is the case for a number 
of instruments in HALion Symphonic Orchestra. For sound libraries that do not provide sampled 
trills, or for intervals beyond a whole step, Dorico Pro generates trills. If your project contains 
some trill intervals that can only be generated, you can disable sampled trills and use generated 
trills throughout to produce a more consistent result.

When playing generated trills, Dorico Pro incorporates grace notes immediately before and after 
trills. A single unslashed grace note on the initial trill note produces an appoggiatura, while 
multiple grace notes on the initial trill note are included in the trill pattern. Grace notes on the 
note immediately following a trill are also included in the trill pattern.

A trill with grace notes at both the start and end

Variable speeds within trills are included in playback. You can determine the default playback 
speeds of slow, normal, and fast trills on the Trills page in Playback Options, and you can 
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change the playback speed of individual trills. Additionally, you can hide trill speed changes in trill 
extension lines whilst retaining the speed changes in playback.

In contemporary performance practice, trills are usually performed starting on the written note, 
while in the historical performance practice of the Baroque and Classical eras, trills are usually 
performed starting on the upper (trilled-to) note. You can change the default starting pitch for 
trills individually and by changing the default setting.

Another common performance practice, in particular for Romantic piano music, is to perform all 
trills with an acceleration, starting slowly and getting faster during the trill. You can choose this 
setting on the Trills page in Playback Options. It applies to all trills whose speed has not been 
changed.

RELATED LINKS
Playback Options dialog on page 842
Changing the speed of trills on page 1296
Hiding/Showing speed changes in trill extension lines on page 1297
Changing the starting pitch of trills on page 1309
Playback techniques on page 936
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341

Sampled vs. generated trills
Sampled trills are recorded, looped samples, whereas generated trills are produced by manually 
triggering separate notes.

Because they use fixed sounds, sampled trills typically offer no parameters that allow any kind 
of variation in the trill interpretation, such as different trill speeds or incorporating grace notes 
and termination notes into the pattern of trilled notes. By contrast, generated trills can provide 
greater flexibility but produce a less natural and realistic sound.

If your project contains some trill intervals that can only be generated, you can disable sampled 
trills and use generated trills throughout to produce a more consistent result.

Enabling/Disabling trill samples in playback
You can enable/disable the use of sampled trills in your project. This can be useful if your project 
contains some trill intervals that can only be generated and you want to use only generated trills 
throughout, or if you want to incorporate grace notes immediately before/after trills.

NOTE

If you are using NotePerformer for playback, we recommend that you disable sampled trills to 
allow Dorico Pro to send the correct notes and controllers for NotePerformer to produce its most 
realistic trill playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Trills.

3. Choose one of the following options for Playback approach for trills:

● Generated trills only

● Use samples if possible

Trills
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4. Click Apply, then Close.

RESULT
Sampled trills are enabled when you choose Use samples if possible, and disabled when you 
choose Generated trills only.

Changing the playback speeds of trills
In addition to changing the speed of trills, which changes both the frequency of wiggles in their 
extension lines and their playback speed, you can also change the playback speed of each speed 
variant in individual trills; for example, if you want to make the fastest part of an individual trill 
faster than your default setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose playback speeds you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate any of the following properties, as appropriate for your 
selected trills:

● Slow trill speed

● Normal trill speed

● Fast trill speed

3. Change the values in the value fields.

RESULT
The playback speed of the selected trills is changed. The values in the value fields correspond to 
the number of notes sounding per second.

TIP

You can change the default speeds for each level on the Trills page in Playback Options.

RELATED LINKS
Changing the speed of trills on page 1296
Hiding/Showing speed changes in trill extension lines on page 1297
Engrave toolbox on page 514
Playback Options dialog on page 842
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Changing the starting pitch of trills
By default in Dorico Pro, trills start on the lower note, which is usually the written note. However, 
the accepted practice in Baroque and Classical music is to start trills on the upper note. You can 
change the starting pitch of trills individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose starting note you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Start on upper note in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected trills start on the upper note when the checkbox is activated, and on the lower note 
when the checkbox is deactivated.

When the property is deactivated, trills follow your project-wide setting for the starting pitch of 
trills.

TIP

You can change the default starting pitch of all trills project-wide on the Trills page in Playback 
Options.

RELATED LINKS
Playback Options dialog on page 842
Engrave toolbox on page 514
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Arpeggio signs

Arpeggio signs are vertical lines that indicate chords are to be played arpeggiated, or “spread”, 
so that the notes in the chord are played very quickly one after another. Arpeggio signs are 
normally shown as vertical wavy lines.

Arpeggiated chords can be played in two directions:

● Upwards, starting from the bottom note in the chord.

● Downwards, starting from the top note in the chord.

It is most common for up arpeggio signs to have nothing at the top end, because chords are 
usually arpeggiated upwards, and for down arpeggio signs to have an arrow at the bottom, so 
these are the defaults in Dorico Pro. However, it is also accepted practice to show up arpeggio 
signs with an arrow at the top if down arpeggio signs are also used in the same piece of music.

Arpeggio signs in Dorico Pro automatically span the range of all notes in the voices/staves to 
which they apply.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Glissando lines on page 1317
Jazz articulations on page 1348
Lines on page 1402

Project-wide engraving options for arpeggio signs
You can find options for the project-wide appearance and position of arpeggio signs on the 
Arpeggio Signs page in Engraving Options.

The options on this page allow you to change the design, appearance, and precise position of 
arpeggio signs, including whether they can be shown on notes in slash voices.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
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Types of arpeggio signs
There are different types of arpeggio signs to convey the different arpeggiation directions and 
techniques.

Up arpeggio

A vertical wavy line that indicates chords are to be arpeggiated from the bottom note 
upwards.

Down arpeggio

A vertical wavy line that indicates chords are to be arpeggiated from the top note 
downwards.

Non arpeggio

A bracket with straight lines that indicates all notes in the chord are to be played 
together, not arpeggiated.

Curved arpeggio

A curved line, similar to a slur but vertical, that some composers use to indicate gentle 
or partial arpeggiation.

You can show both up and down arpeggio signs with one of the following ends in Dorico Pro:

● Nothing

● Arrow

● Swash

Up arpeggio sign with nothing at 
the end

Up arpeggio sign with an arrow at 
the end

Up arpeggio sign with a swash at 
the end

Arpeggio signs
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Changing the type of arpeggio signs
You can change the type of arpeggio signs after they have been input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs whose type you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, select one of the following options from the Arpeggio type menu in 
the Arpeggios group:

● Non arpeggio

● Up arpeggio

● Down arpeggio

● Up arpeggio (curve)

RESULT
The type of the selected arpeggio signs is changed.

TIP

You can also change the arpeggio type by opening the ornaments popover and changing the 
entry.

Changing the end appearance of arpeggio signs
Down arpeggio signs have an arrowhead at the bottom of the line by default, but up arpeggio 
signs have no arrowhead by default. You can change the appearance of the ends of arpeggio 
signs individually, independently of your project-wide settings.

NOTE

These steps only apply to up and down arpeggio signs. They do not apply to curved or non 
arpeggio signs.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs of any direction whose ends you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Sign end in the Arpeggios group.

3. Select the end you want from the menu:

Arpeggio signs
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● Nothing

● Arrow

● Swash

RESULT
The appearance of the ends of the selected arpeggio signs is changed.

TIP

You can change the default appearance of the ends of all arpeggio signs project-wide on the 
Arpeggio Signs page in Engraving Options.

EXAMPLE

Up arpeggio sign with nothing at 
the end

Up arpeggio sign with an arrow at 
the end

Up arpeggio sign with a swash at 
the end

Length of arpeggio signs
The length of arpeggio signs is determined by the pitch range of notes in the voices/staves to 
which the arpeggio sign applies. Dorico Pro automatically adjusts the length of arpeggio signs if 
pitches change or you add notes to, or delete notes from, chords.

In Engrave mode, each arpeggio sign has two square handles, one at the top and one at the 
bottom. You can move these handles to adjust the graphical position and length of arpeggio 
signs. For example, you might lengthen an arpeggio sign on a chord with a small pitch range so 
the arpeggio sign is more clearly visible.

You can change how far arpeggio signs extend beyond the outer notes in all chords project-wide 
on the Arpeggio Signs page in Engraving Options. You can set different values for when notes 
are on staff lines and in staff spaces.

RELATED LINKS
Moving items graphically on page 609
Moving notes/items rhythmically on page 465

General placement conventions for arpeggio signs
Arpeggio signs are positioned to the left of the notes, including any applicable accidentals, to 
which they apply, but are positioned between grace notes and normal notes. They should appear 
within the same bar as the notes to which they apply, and not on the other side of the barline.

Dorico Pro makes automatic adjustments to note spacing and staff spacing to accommodate 
arpeggio signs and ensure they are positioned correctly.

Arpeggio signs should cover the whole vertical range of all notes in the chord to which they 
apply, and protrude slightly at each end. However, they do not need to cover the stems of notes. 
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Dorico Pro automatically creates the lengths of arpeggio signs to cover the notes in chords, and 
adjusts their lengths if the notes in chords change or are deleted.

If an arpeggiated chord spans two staves, such as in a piano part, its arpeggio sign can extend 
across both staves.

You can move arpeggio signs to different rhythmic positions in Write mode. They are positioned 
by default according to your settings in Engraving Options.

You can move arpeggio signs graphically in Engrave mode; however, this does not change the 
rhythmic positions to which they are attached.

You can change the default position of all arpeggio signs project-wide on the Arpeggio Signs 
page in Engraving Options.

Showing arpeggio signs before/after grace notes
You can show arpeggio signs before/after grace notes individually. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains. By default, arpeggio 
signs are positioned immediately to the left of the notes to which they apply, and so are 
positioned between normal notes and grace notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the arpeggio signs you want to show before grace notes. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate/deactivate Arpeggio before grace notes in the Arpeggios 
group.

RESULT
The selected arpeggio signs are shown before grace notes when the property is activated, and 
after grace notes when the property is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771

Arpeggios in playback
You can find options to control the playback of all arpeggios project-wide in the Arpeggio Signs 
section of the Timing page in Playback Options.

For example, you can control the speed of arpeggiation and whether arpeggiation starts on the 
beat or ends on the beat.

You can set a default arpeggio length for wiggly arpeggio signs and curved arpeggio signs 
separately, expressed as a fraction of a quarter note (crotchet) at 120 bpm. It can be helpful to 
set arpeggio lengths using this measurement instead of defining arpeggios as a fraction of their 
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notated rhythm, as otherwise arpeggios in very slow music would play back much slower than 
most people intend.

As well as setting a default length for arpeggios, you can also set minimum and maximum values 
for the length of arpeggios, expressed as a fraction of the notated value of the arpeggio. This is 
to ensure all notes with arpeggio signs can be heard within their notated duration.

TIP

You can also use properties in the Arpeggios Playback group of the Properties panel to override 
the default playback options for individual arpeggio signs.

Changing arpeggio playback relative to the beat
You can change whether individual arpeggios are played before their notated position or after 
their notated position, independently of your project-wide settings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs whose playback relative to the beat you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Playback position in the Arpeggios Playback group.

3. Choose one of the following options:

● Start on beat

● End on beat

RESULT
The beat-relative position of the selected arpeggios in playback is changed.

TIP

You can change the playback of all arpeggios relative to the beat project-wide on the Timing 
page in Playback Options.

EXAMPLE

Arpeggio starting on the beat Arpeggio ending on the beat

Arpeggio signs
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RELATED LINKS
Playback Options dialog on page 842

Changing the playback duration of arpeggios
You can change the duration of individual arpeggios in playback, independently of your project-
wide settings.

The duration of arpeggios is expressed as a fraction of the notated rhythm of chords. For 
example, an arpeggio on a quarter note (crotchet) chord with a note offset value of 1/2 lasts an 
eighth note (quaver), whereas with a note offset value of 1/8 it lasts a 32nd note.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs whose playback duration you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Note offset in the Arpeggios Playback group.

3. Change the playback duration of the selected arpeggio signs by changing the value in the 
value field.

4. Press Return .

RESULT
The playback duration of the selected arpeggios is changed. This overrides your project-wide 
settings for the duration of arpeggios for the selected arpeggios.

EXAMPLE

Arpeggiated chord with a note offset value of 1/8 Arpeggiated chord with a note offset value of 1/2

Arpeggio signs
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Glissando lines

Glissando lines indicate a continuous transition between two notes, which can be smooth or 
in chromatic steps. They can have straight lines or wiggly lines, and can be shown with a text 
indication or as a line without text.

Because glissando lines are positioned between noteheads, the steepness of their angle reflects 
the interval between the notes: the steeper the angle, the greater the interval.

There are different conventions regarding the playing techniques for glissando and portamento. 
Some people understand glissando lines to indicate a chromatic scale between the two notes, 
either rising or falling in a series of half-steps (semitones), and portamento lines to indicate a 
smooth, continuous glide between the two notes. However, the terms glissando and portamento 
can be used interchangeably in other cases.

You can input both glissando lines and portamento lines in Dorico Pro, and you can easily change 
their style after they have been input.

Glissando lines in Dorico Pro automatically follow the notes at each end, meaning if you 
change the pitch of either note, the glissando line end positions move accordingly. Dorico Pro 
automatically positions glissando lines so they do not collide with accidentals.

An example glissando line with text shown and a 
wiggly line

An example portamento line with text shown and a 
straight line

Glissando lines can cross system breaks and page breaks. If text is shown for glissando lines that 
span system or page breaks, then that text is shown on every glissando line segment. By default, 
the start and end positions of each segment match the original start and end points of the whole 
glissando line.

In Dorico Pro, you can make detailed adjustments to the default positions of glissando lines on 
the Glissando Lines page in Engraving Options. You can also move the start/end positions of 
individual glissando lines in Engrave mode.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Changing the style of glissando lines on page 1318
Glissando lines in Engrave mode on page 1321
Arpeggio signs on page 1310
Jazz articulations on page 1348
Fingering slides on page 1176
Playing technique continuation lines on page 1393
Lines on page 1402
Changing the pitch of individual notes on page 479
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Project-wide engraving options for glissando lines
You can find options for the project-wide appearance and position of glissando lines on the 
Glissando Lines page in Engraving Options.

The options on the Glissando Lines page allow you to change the style, appearance, and 
thickness of glissando lines. You can also set precise positions for the endpoints of glissando 
lines relative to noteheads.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Glissando lines across empty bars
In Dorico Pro, you can input glissando lines between any two notes, even if there are rests 
or other notes between them, and including between notes in different voices and notes on 
different staves.

For very long glissando lines that extend across multiple bars, you might not want to show 
pitches at the start of each bar; for example, to indicate that performers do not emphasize 
pitches during the course of the glissando, or that performers can play the glissando at their own 
speed. By default, Dorico Pro shows notes or rests in every bar.

Once you have input a glissando line between the selected notes, you can delete any rests 
between them.

EXAMPLE

A glissando line across multiple bars with no rests shown between the two notes

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Hiding/Showing bar rests in empty bars on page 1494
Deleting rests on page 1493
Turning explicit rests into implicit rests on page 1490

Changing the style of glissando lines
Glissando lines can be shown as straight lines or wiggly lines. You can change the glissando line 
style of glissando lines individually, independently of your project-wide setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Glissando lines
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PROCEDURE

1. Select the glissando lines whose style you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Glissando style in the Glissando Lines group.

3. Choose one of the following options:

● Straight line 

● Wiggly line 

RESULT
The glissando line style is changed for the selected glissando lines.

TIP

● Deactivating Glissando style returns the selected glissando lines to the default style.

● You can also change the glissando style by opening the ornaments popover and changing 
the entry.

● You can change the default style for all glissando lines project-wide on the Glissando Lines 
page in Engraving Options.

RELATED LINKS
Project-wide engraving options for glissando lines on page 1318
Engraving Options dialog on page 840
Engrave toolbox on page 514
Ornaments popover on page 342
Changing existing items on page 439

Changing glissando line text
You can show individual glissando lines with “gliss.” text, “port.” text, or without text, 
independently of your project-wide setting. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the glissando lines whose text you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Glissando text in the Glissando Lines group.

3. Select one of the following options from the menu:

● Gliss.

● Port.

Glissando lines
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● No text

RESULT
The text shown on the selected glissando lines is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the text shown on all glissando lines project-wide on the Glissando Lines page 
in Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341

Changing when glissando line text is shown
By default, glissando text is not shown when glissando lines are too short to accommodate the 
text. You can choose to show text on individual glissando lines always, or only if there is sufficient 
space. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the glissando lines whose setting for when text is shown you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Glissando text shown in the Glissando Lines group.

3. Choose one of the following options:

● Show if sufficient space

● Always show

RESULT
When Show if sufficient space is chosen, glissando line text is not shown if the glissando line is 
too short.

Glissando lines
Changing glissando line text 
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When Always show is chosen, glissando line text is always shown, even if the glissando line 
is short. However, this can cause the glissando line text to collide with other items, such as 
noteheads and stems.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can increase the default gaps between noteheads by changing the default note spacing, 
and between individual noteheads by adjusting note spacing at individual rhythmic positions in 
Engrave mode.

RELATED LINKS
Note spacing on page 599
Changing the default note spacing on page 599

Glissando lines in Engrave mode
In Engrave mode, each glissando line has two square handles, one at the start and one at the 
end. You can move these handles to adjust the graphical position, length, and angle of glissando 
lines.

You can also move whole individual glissando lines graphically. If glissando lines cross system 
and frame breaks, you can move the glissando line segments on each side of the break 
independently.

Handles on a glissando line in Engrave mode

NOTE

● You cannot move glissando lines rhythmically. If you want to change the rhythmic positions 
of glissando lines, you must delete them from their original positions and input new 
glissando lines at the new positions.

● When glissando lines cover a small pitch range, the angle of the line can be quite shallow. 
You can change the values for the minimum spans of glissando lines covering a small pitch 
range in different contexts project-wide in the Vertical Position section of the Glissando 
Lines page in Engraving Options.

RELATED LINKS
Project-wide engraving options for glissando lines on page 1318
Engraving Options dialog on page 840
Moving items graphically on page 609

Glissando lines
Glissando lines in Engrave mode 
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Glissando lines in playback
Glissando lines are reflected in playback using a sequence of notes, all a small interval apart, 
between the start and end notes for each glissando.

Glissandos belonging to harps consider the current harp pedaling when determining the pitches 
to use in playback. Glissandos for all other instruments use the 12-EDO chromatic scale, 
regardless of the current tonality system.

When glissando lines start or end on tie chains, their playback starts on the last note in tie chains 
and ends on the first note in tie chains.

By default in playback, glissandos sound across their full duration, but you can delay the start of 
glissandos in playback individually.

NOTE

Playing back glissando lines as a continuous, smooth slide is not yet supported. This is planned 
for future versions.

RELATED LINKS
Harp pedaling on page 1358

Delaying the start of glissandos in playback
You can delay the start of glissandos in playback so that they start partway through their 
duration. By default, glissandos sound for their full duration in playback.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the glissando lines whose playback start you want to delay. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Delayed start in the Glissando Lines group.

3. Optional: If you want to specify exactly how far through the glissando lines playback starts, 
activate Delay and change the value in the value field.

The value represents fractions of a quarter note. For example, 1/2 delays the start of 
glissandos by an eighth note.

RESULT
If you activated Delayed start only, playback of the selected glissando lines starts halfway 
through their duration.

If you also activated Delay, playback of the selected glissando lines follows your set value.

RELATED LINKS
Engrave toolbox on page 514

Glissando lines
Glissando lines in playback 
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Guitar bends

The guitar bend is a technique commonly performed on electric guitars, where the performer 
pushes strings out of their normal alignment after notes start to sound. Bending strings tightens 
them, which produces the characteristic pitch fluctuation.

Performing a guitar bend often also involves sustaining the bent pitch before allowing the string 
to return to its natural position and un-bent pitch. In Dorico Pro, these actions are called a “guitar 
bend hold” and “release” respectively.

A phrase containing guitar bends, a guitar bend hold, guitar pre-bends, and releases, shown on both a 
notation staff and tablature

Guitar bends and releases with bend intervals of up to a whole step (tone) are reflected in 
playback.

Guitar bends
Guitar bends indicate that the performer should bend the string after playing a note, 
so that the pitch increases while the note sounds. In Dorico Pro, each guitar bend joins 
two notes: the start pitch and the pitch at the peak of the bend.

On notation staves, guitar bends are notated using an angled line between the 
noteheads at the start and end. On tablature, guitar bends are notated using an 
upwards-pointing curved line with an arrowhead at the top and a bend interval above 
the arrowhead. The fret number of the end note is hidden automatically.

Guitar bend on notation staff Guitar bend on tablature

If you input guitar bends on multiple notes in chords, their arrowheads are 
automatically aligned on tablature.

1323
Dorico Pro 4.3.30



Guitar bends on chord on notation staff Guitar bends on chord on tablature

Sequences of consecutive guitar bends are notated as bend runs on tablature. In 
Engrave mode, guitar bend runs function as a group.

Guitar bend runs on tablature

Guitar bend holds
Guitar bend holds indicate that the performer should maintain the pitch at the peak of 
a guitar bend. They are usually shown on tied notes.

On tablature, guitar bend holds are notated using a horizontal line. They are not 
notated on notation staves.

Guitar bend hold on tablature

Releases
Releases indicate that the performer should allow a bent string to return to its natural 
position, which decreases the pitch. In Dorico Pro, each release joins two notes: the 
pitch at the peak of the bend and the end pitch.

On notation staves, releases are notated using an angled line between the noteheads 
at the start and end. On tablature, releases are notated using a downwards-pointing 
curved line with an arrowhead at the bottom and parenthesized fret numbers below 
the arrowhead to indicate the end pitches. The fret number of the start note is hidden 
automatically.

Release on notation staff Release on tablature

Guitar bends
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If you input releases on multiple notes in chords, they are notated with a single 
downwards-pointing curved line on tablature. If the bend intervals are the same for 
all notes, the end pitches are parenthesized together.

Releases on chord on notation staff Releases on chord on tablature

NOTE

● In addition to guitar bends, Dorico Pro supports guitar pre-bends/pre-dives, guitar post-
bends, vibrato bar dives and returns, and other guitar techniques.

● Because you input releases in the same way as you input guitar bends, in this 
documentation, “guitar bends” refers to both guitar bend and release items in projects.

● You can change the default appearance of guitar bend holds and the fret numbers of 
releases on the Guitar Bends page in Engraving Options.

● By default, stems, stem flags, and beaming appear stem-up on tablature in single-voice 
contexts, which means they can collide with guitar bends, pre-bends/pre-dives, and dives 
and returns. Therefore, in projects where you want to show both these notations and 
rhythms on tablature, we recommend that you change the Default stem direction to Down 
on the Tablature page in Engraving Options.

RELATED LINKS
Bend intervals on page 1329
Guitar bends in Engrave mode on page 1333
Guitar techniques on page 1339
Input methods for guitar bends and guitar techniques on page 354
Tablature on page 1580
Hiding/Showing notation staves and tablature on page 1582
Bracketed noteheads on page 1263
String indicators on page 1183
Lines on page 1402

Guitar bends
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Guitar pre-bends and pre-dives
Guitar pre-bends and pre-dives are techniques commonly performed on electric guitars, where 
the performer changes the initial sounding pitch of strings before playing notes, either by 
bending strings to tighten them or using the vibrato bar to loosen them.

A phrase containing a guitar pre-bend with release and multiple guitar pre-dives with release

In Dorico Pro, guitar pre-bends and pre-dives are properties of notes belonging to fretted 
instruments, meaning they only apply to single notes.

Guitar pre-bends
Guitar pre-bends indicate that the performer should bend the string before playing the 
note to raise the pitch; for example, to repeat a note that was at the end of a previous 
guitar bend. The pitch can then be lowered after starting to sound.

On notation staves, guitar pre-bends are notated using an angled line between the 
noteheads at the start and end. However, unlike guitar bends, the parenthesized 
auxiliary notehead at the start is shown automatically as part of the pre-bend. On 
tablature, guitar pre-bends are notated using a solid vertical line with an arrowhead at 
the top, a bend interval above the arrowhead, and a small fret number below the line 
to indicate the start pitch.

Guitar pre-bend on notation staff Guitar pre-bend on tablature

Guitar pre-dives
Guitar pre-dives indicate that the performer should use the vibrato bar to lower the 
pitch before playing the note. The pitch can then be raised after starting to sound.

On notation staves, guitar pre-dives appear the same as guitar pre-bends. On 
tablature, guitar pre-dives are notated using a dashed vertical line with an arrowhead 
at the top, a bend interval above the arrowhead, and a small fret number below the 
line to indicate the start pitch.

Guitar bends
Guitar pre-bends and pre-dives 
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Guitar pre-dive on notation staff Guitar pre-dive on tablature

NOTE

● You can change the appearance of multiple consecutive guitar pre-bends/pre-dives on the 
Guitar Bends page in Engraving Options. Subsequent notes with guitar pre-bends/pre-
dives are known as “re-strikes”.

● By default, stems, stem flags, and beaming appear stem-up on tablature in single-voice 
contexts, which means they can collide with guitar bends, pre-bends/pre-dives, and dives 
and returns. Therefore, in projects where you want to show both these notations and 
rhythms on tablature, we recommend that you change the Default stem direction to Down 
on the Tablature page in Engraving Options.

RELATED LINKS
Guitar pre-bends/pre-dives in Engrave mode on page 1335
Inputting guitar pre-bends/pre-dives on page 357
Tablature on page 1580
Engraving Options dialog on page 840

Guitar post-bends
The guitar post-bend is a technique commonly performed on electric guitars, where the 
performer pushes strings out of their normal alignment after notes start to sound. Bending 
strings tightens them, which produces the characteristic pitch fluctuation. Microtonal post-bends 
are particularly idiomatic in Blues music.

In Dorico Pro, guitar post-bends are properties of notes belonging to fretted instruments, 
meaning they only apply to single notes. They are notated the same on notation staves and 
tablature, using an upwards-pointing curved line with an arrowhead at the top and a bend 
interval above the arrowhead.

Guitar post-bend on notation staff Guitar post-bend on tablature

Guitar bends
Guitar post-bends 
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Microtonal post-bend on notation staff Microtonal post-bend on tablature

If you input guitar post-bends on multiple notes in chords, their arrowheads are automatically 
aligned. On notation staves, the appropriate number of curved lines is shown according to the 
staff positions of notes in chords.

Guitar post-bends on chord on notation staff Guitar post-bends on chord on tablature

NOTE

Guitar post-bends are not currently reflected in playback. This is planned for future versions.

RELATED LINKS
Guitar post-bends in Engrave mode on page 1336
Inputting guitar post-bends on page 357

Vibrato bar dives and returns
The vibrato bar dive and return is a technique performed on electric guitars with a vibrato bar, 
where the performer uses the vibrato bar to loosen then tighten strings after notes start to 
sound. This produces the characteristic downwards-then-upwards pitch fluctuation.

In Dorico Pro, each vibrato bar dive and return comprises two vibrato bar bend items, where the 
first vibrato bar bend ends on the same note that the second vibrato bar bend starts on. Vibrato 
bar bends each join two notes.

Vibrato bar dives and returns with bend intervals of up to a whole step (tone) are reflected in 
playback.

On notation staves, vibrato bar dives and returns are notated using an angled line between the 
noteheads at the start and end, meaning they appear the same as guitar bends. On tablature, 
vibrato bar dives and returns are notated using two straight lines that form a V and a bend 
interval shown at the point. The fret number of the middle note is hidden and the fret number of 
the end note is parenthesized automatically.

Guitar bends
Vibrato bar dives and returns 
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Vibrato bar dive and return on notation staff Vibrato bar dive and return on tablature

Sequences of consecutive vibrato bar bends on notes with the same pitch direction, such as 
E-D-C, are notated on tablature with an additional line protrusion beyond the staff and bend 
interval for each vibrato bar bend.

Consecutive vibrato bar bends on notation staff Consecutive vibrato bar bends on tablature

If you input vibrato bar dives and returns on multiple notes in chords, a single V appears on 
tablature as long as the bend intervals are the same for all notes.

Vibrato bar dive and return on chords on notation 
staff

Vibrato bar dive and return on chords on tablature

RELATED LINKS
Inputting vibrato bar dives and returns with the popover on page 359
Inputting vibrato bar dives and returns with the panel on page 360
Vibrato bar dives and returns in Engrave mode on page 1337
Vibrato bar techniques on page 1339
Bracketed noteheads on page 1263
Tablature on page 1580

Bend intervals
Bend intervals indicate the amount guitar bends, pre-bends, pre-dives, post-dives, and dives and 
returns change the pitch, expressed in relation to whole steps using text or numbers/fractions. 
Bend intervals appear only on tablature for most types of bends, except for guitar post-bends, 
whose bend intervals also appear on notation staves.

For example, full indicates a whole step guitar bend, pre-bend, or post-bend, 1/2 a half-step, and 
1 1/2 a minor third.

Guitar bends
Bend intervals 
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Bend intervals for guitar pre-dives and vibrato bar dives and returns always appear as numbers/
fractions, such as 1 for a whole step vibrato bar dive and return.

Microtonal bend intervals appear as fractions according to the prevailing tonality system, such as 
3/4. Bend intervals for microtonal post-bends appear as 1/4.

EXAMPLE

Guitar bend with whole step 
interval, displayed as full

Guitar pre-bend with 
minor third interval, 
displayed as 1 1/2

Vibrato bar dive and return 
with whole step interval, 
displayed as -1

Guitar post-bend with 
microtonal interval, 
displayed as 1/4

Bend intervals for guitar bends, pre-bends, pre-dives, and post-dives are positioned above the 
arrowhead/line for the corresponding notation. For dives and returns, bend intervals appear at 
the point of the V, either above or below the staff according to the pitch direction of notes in the 
dive and return.

Bend intervals appear only on tablature for guitar bends, pre-bends, pre-dives, and dives and 
returns. They appear on both notation staves and tablature for guitar post-bends.

TIP

You can change the default appearance of guitar bend intervals, including hiding microtonal 
post-bend intervals, on the Guitar Bends page in Engraving Options.

RELATED LINKS
Tablature on page 1580
Engraving Options dialog on page 840
Changing vibrato bar dip intervals on page 1344
Input methods for guitar bends and guitar techniques on page 354

Project-wide engraving options for guitar bends, pre-bends, 
post-bends, and vibrato bar dives and returns

You can find options for the project-wide appearance and position of guitar bends, pre-bends, 
post-bends, and vibrato bar dives and returns on the Guitar Bends page in Engraving Options.

The options on the Guitar Bends page allow you to change the height, minimum horizontal 
spacing requirements, and thickness of guitar bends, pre-bends, and post-bends, both on 
notation staves and tablature. There are multiple options for the appearance of bend intervals, 
releases, and hold lines on tablature. You can also set precise positions for the endpoints of 
guitar bends, pre-bends, post-bends, and vibrato bar dives and returns relative to noteheads, 
beams, and staff lines.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

Guitar bends
Project-wide engraving options for guitar bends, pre-bends, post-bends, and vibrato bar dives and returns 
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RELATED LINKS
Engraving Options dialog on page 840
Guitar techniques on page 1339

Hiding/Showing guitar bend hold lines
Guitar bend hold lines indicate that the bend should be held for the duration of the note, which is 
usually a tied note. You can hide/show hold lines on guitar bends on tablature.

NOTE

These steps only apply to guitar bends. You cannot show hold lines on pre-bends or releases.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the guitar bends on which you want to hide/show hold lines. You can do this on 
notation staves and tablature in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show hold in the Guitar Bends group.

RESULT
Hold lines are shown on the selected bends on tablature when Show hold is activated, and 
hidden when it is deactivated.

TIP

Guitar bends can have solid or dashed hold lines. You can change the line type for all guitar bend 
holds in the Design section of the Guitar Bends page in Engraving Options.

EXAMPLE

Hold line hidden Hold line shown

Changing the direction of guitar pre-bends/pre-dives
You can change the direction of guitar pre-bends/pre-dives individually. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains. By default, guitar 

Guitar bends
Hiding/Showing guitar bend hold lines 
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pre-bends/pre-dives are positioned on the notehead-side of notes in single-voice contexts. In 
multiple-voice contexts, they are positioned on the stem-side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the guitar pre-bends/pre-dives whose direction you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Pre-bend direction in the Guitar Pre-bends group.

3. Choose one of the following options:

● Up

● Down

RESULT
The direction of the selected guitar pre-bends/pre-dives is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the direction of guitar bends on notation staves by selecting them and pressing 
F . However, you cannot use this key command for guitar pre-bends/pre-dives.

RELATED LINKS
Changing the staff-relative placement of items on page 441
Changing vibrato bar dip intervals on page 1344
Changing the staff-relative placement of guitar techniques on page 1346
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Hiding/Showing accidentals on guitar pre-bends/pre-dives
You can hide/show accidentals on guitar pre-bends/pre-dives individually; for example, to save 
horizontal space in a layout that also shows the interval clearly on tablature. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Guitar bends
Hiding/Showing accidentals on guitar pre-bends/pre-dives 
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PROCEDURE

1. Select the guitar pre-bends/pre-dives whose accidentals you want to hide/show. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Pre-bend accidental in the Guitar Pre-bends group.

3. Choose one of the following options:

● Hide

● Show

RESULT
Accidentals on the selected guitar pre-bends are hidden when you choose Hide, and shown 
when you choose Show. This does not affect the interval shown for the selected guitar pre-bends 
on tablature. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Deleting guitar pre-bends, pre-dives, and post-bends
You can remove guitar pre-bends, pre-dives, and post-bends from notes after you have input 
them. However, because guitar pre-bends, pre-dives, and post-bends are properties of notes 
rather than separate items in Dorico Pro, you must select and delete them differently from other 
items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove guitar pre-bends, pre-dives, 
and/or post-bends.

2. Do one of the following:

● To remove guitar pre-bends/pre-dives, deactivate Pre-bend interval in the Guitar Pre-
bends group of the Properties panel.

● To remove guitar post-bends, deactivate Post-bend interval in the Guitar Post-bends 
group of the Properties panel.

RESULT
Guitar pre-bends, pre-dives, and/or post-bends are removed from the selected notes.

RELATED LINKS
Inputting guitar pre-bends/pre-dives on page 357
Inputting guitar post-bends on page 357

Guitar bends in Engrave mode
In Engrave mode, each guitar bend, release, and hold has multiple handles that you can move 
independently to adjust their graphical position and shape on notation staves and tablature 
independently.

On notation staves, guitar bends and releases have three square handles. When you move either 
of the start/end handles, the middle handle also moves to retain its position relative to the 
start/end handles.

Guitar bends
Deleting guitar pre-bends, pre-dives, and post-bends 
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Guitar bend handles on notation staff in Engrave mode

Guitar bends and holds

On tablature, guitar bends and holds have the following handles:

1 Guitar bend start handle

2 Guitar bend middle handle

3 Guitar bend end handle

4 Bend interval handle

5 Hold start handle

6 Hold end handle

Releases

On tablature, releases have the following handles:

1 Release start handle

2 Release middle handle

3 Release end handle

You can move these handles to change the shape of guitar bends and releases, change the 
graphical length and angle of guitar bend holds, and move bend intervals. When you move 
guitar bend end handles, the bend interval also moves to retain its position relative to the end 
handle.

Guitar bends
Guitar bends in Engrave mode 
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If guitar bends cross system and frame breaks, you can move the guitar bend segment on each 
side of the break independently.

NOTE

● Adjoining guitar bends, such as guitar bend runs or a guitar bend that ends on the same 
note that a return starts on, function as a group. When using the mouse, moving any guitar 
bend in the group upwards/downwards moves all the others. When you move individual 
handles within the group using the mouse, adjacent guitar bends automatically adjust to 
compensate.

When you move individual guitar bends in a group or individual handles using the keyboard, 
this does not affect adjacent guitar bends.

● You cannot move whole holds, you must move their handles.

● The following properties in the Guitar Bends group of the Properties panel are activated 
automatically when you move the corresponding guitar bend handle:

● Start offset moves start guitar bend and release handles. X moves them horizontally, Y 
moves them vertically.

● Mid offset moves middle guitar bend and release handles. X moves them horizontally, Y 
moves them vertically.

● End offset moves end guitar bend and release handles. X moves them horizontally, Y 
moves them vertically.

● Interval offset moves guitar bend interval handles. X moves them horizontally, Y moves 
them vertically.

● Hold start offset moves start guitar bend hold handles. X moves them horizontally, Y 
moves them vertically.

● Hold end offset moves end guitar bend hold handles. X moves them horizontally, Y 
moves them vertically.

RELATED LINKS
Moving items graphically on page 609
Bend intervals on page 1329
System breaks on page 733
Frame breaks on page 736
Input methods for guitar bends and guitar techniques on page 354

Guitar pre-bends/pre-dives in Engrave mode
In Engrave mode, each guitar pre-bend/pre-dive has multiple handles that you can move 
independently to adjust their graphical position and shape on notation staves and tablature 
independently.

On notation staves, guitar pre-bends/pre-dives have three square handles. When you move 
either of the start/end handles, the middle handle also moves to retain its position relative to the 
start/end handles.

Guitar pre-bend/pre-dive handles on notation staff in Engrave mode

Guitar bends
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On tablature, guitar pre-bends/pre-dives have the following handles:

Guitar pre-bend handles Guitar pre-dive handles

1 Bend interval handle

2 Guitar pre-bend/pre-dive end handle

3 Guitar pre-bend/pre-dive start handle

You can move these handles to change the shape of guitar pre-bends/pre-dives on notation 
staves, change the graphical length and angle of guitar pre-bends/pre-dives on tablature, and 
move bend intervals. When you move guitar pre-bend/pre-dive end handles, the bend interval 
also moves to retain its position relative to the end handle.

NOTE

● You cannot move whole guitar pre-bends/pre-dives, you must move their handles.

● The following properties in the Guitar Pre-bends group of the Properties panel are activated 
automatically when you move the corresponding guitar pre-bend/pre-dive handle:

● Start offset moves guitar pre-bend/pre-dive start handles. X moves them horizontally, Y 
moves them vertically.

● Mid offset moves guitar pre-bend/pre-dive middle handles. X moves them horizontally, 
Y moves them vertically.

● End offset moves guitar pre-bend/pre-dive end handles. X moves them horizontally, Y 
moves them vertically.

● Interval offset moves guitar pre-bend/pre-dive interval handles. X moves them 
horizontally, Y moves them vertically.

RELATED LINKS
Inputting guitar pre-bends/pre-dives on page 357

Guitar post-bends in Engrave mode
In Engrave mode, each guitar post-bend has multiple handles that you can move independently 
to adjust their graphical position and shape on notation staves and tablature independently.

On both notation staves and tablature, guitar post-bends have the following handles:

Guitar bends
Guitar bends in Engrave mode 
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1 Guitar post-bend start handle

2 Guitar post-bend middle handle

3 Guitar post-bend end handle

4 Bend interval handle

You can move these handles to change the shape of guitar post-bends and move bend intervals. 
When you move guitar post-bend end handles, the bend interval also moves to retain its position 
relative to the end handle.

NOTE

The following properties in the Guitar Post-bends group of the Properties panel are activated 
automatically when you move the corresponding guitar post-bend handle:

● Start offset moves guitar post-bend start handles. X moves them horizontally, Y moves 
them vertically.

● Mid offset moves guitar post-bend middle handles. X moves them horizontally, Y moves 
them vertically.

● End offset moves guitar post-bend end handles. X moves them horizontally, Y moves them 
vertically.

● Interval offset moves guitar post-bend interval handles. X moves them horizontally, Y 
moves them vertically.

RELATED LINKS
Moving items graphically on page 609
Inputting guitar post-bends on page 357

Vibrato bar dives and returns in Engrave mode
In Engrave mode, each vibrato bar dive and return has multiple handles that you can move 
independently to adjust their graphical position and shape.

On notation staves, each vibrato bar dive and vibrato bar return has three square handles that 
you can move independently. When you move either of the start/end handles, the middle handle 
also moves to retain its position relative to the start/end handles.

Vibrato bar dive and return handles on notation staff in Engrave mode

On tablature, vibrato bar dives and returns have the following handles:

Guitar bends
Guitar bends in Engrave mode 
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1 Vibrato bar dive start handle

2 Vibrato bar dive end handle/Vibrato bar return start handle

3 Vibrato bar return end handle

4 Bend interval handle

You can move these handles to change the shape or angle of vibrato bar dives and returns 
and move bend intervals. When you move the vibrato bar dive end handle/vibrato bar return 
start handle with the mouse, both handles move together. When you move the handle using 
the keyboard, by default only the vibrato bar dive end handle moves. The same is true for 
consecutive vibrato bar bends with the same pitch direction.

When you move the vibrato bar dive end handle, the bend interval also moves to retain its 
position relative to the end handle.

If vibrato bar dives and returns cross system and frame breaks, you can move the vibrato bar 
dive and return segment on each side of the break independently.

NOTE

The following properties in the Guitar Bends group of the Properties panel are activated 
automatically when you move the corresponding vibrato bar dive/return handle:

● Start offset moves vibrato bar dive/return start handles. X moves them horizontally, Y 
moves them vertically.

● Mid offset moves vibrato bar dive/return middle handles. X moves them horizontally, Y 
moves them vertically.

● End offset moves vibrato bar dive/return end handles. X moves them horizontally, Y moves 
them vertically.

● Interval offset moves vibrato bar dive/return interval handles. X moves them horizontally, Y 
moves them vertically.

RELATED LINKS
Vibrato bar techniques on page 1339
Input methods for guitar bends and guitar techniques on page 354
System breaks on page 733
Frame breaks on page 736

Guitar bends
Guitar bends in Engrave mode 
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Guitar techniques

The term “guitar techniques” covers a range of techniques typically associated with guitar music, 
such as hammer-ons, pull-offs, and pitch alterations that use the vibrato bar on electric guitars.

RELATED LINKS
Input methods for guitar bends and guitar techniques on page 354
Guitar bends on page 1323
Guitar pre-bends and pre-dives on page 1326
Guitar post-bends on page 1327
Vibrato bar dives and returns on page 1328
Bend intervals on page 1329

Vibrato bar techniques
There are a number of different techniques that can be performed using the vibrato bar on 
electric fretted instruments, typically guitars. In Dorico Pro, the available vibrato bar techniques 
are categorized differently.

Vibrato bar dives
Vibrato bar dives indicate that the performer should use the vibrato bar to lower 
the pitch after playing the note, so that the pitch falls after starting to sound. This 
technique is also known as a “dive bomb”.

In Dorico Pro, you can notate vibrato bar dives using jazz articulations to show falling 
lines to the right of noteheads in combination with a vibrato bar indication.

Vibrato bar scoops
Vibrato bar scoops indicate that the performer should depress the vibrato bar just 
before playing the note and then release the vibrato bar quickly, so that the pitch rises 
after starting to sound.

In Dorico Pro, vibrato bar scoops are properties of notes, meaning they only apply to 
single notes. By default, vibrato bar scoops only appear on notation staves and are 
placed to the left of noteheads on the staff. You can hide/show guitar techniques, 
including vibrato bar scoops, on notation staves only, tablature only, or both.

Vibrato bar dips
Vibrato bar dips indicate that the performer should use the vibrato bar to lower and 
then raise the pitch by the specified interval after playing the note.

In Dorico Pro, vibrato bar dips are considered ornaments. You can select and delete 
them independently of the notes to which they apply. Vibrato bar dips appear on both 
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notation staves and tablature and are placed above the staff. You can change the 
staff-relative placement of individual vibrato bar dips.

Vibrato bar indications/lines
Vibrato bar indications are text instructions that indicate that the performer should use 
the vibrato bar. When they apply to a range of notes, they typically show dashed lines.

In Dorico Pro, vibrato bar indications/lines are considered playing techniques. They 
show lines when they have duration. You can select and delete them independently of 
the notes to which they apply. You can also change the duration line style of vibrato bar 
lines in the same ways as for playing technique continuation lines.

NOTE

Vibrato bar techniques are not currently reflected in playback. This is planned for future versions.

RELATED LINKS
Input methods for guitar bends and guitar techniques on page 354
Inputting guitar pre-bends/pre-dives on page 357
Guitar pre-bends and pre-dives on page 1326
Vibrato bar dives and returns on page 1328
Jazz articulations on page 1348
Ornaments on page 1291
Playing techniques on page 1387
Playing technique continuation lines on page 1393
Playing technique duration on page 1394
Lengthening/Shortening items on page 436
Changing the style of playing technique continuation lines on page 1397
Changing the staff-relative placement of items on page 441
Changing the staff-relative placement of guitar techniques on page 1346
Hiding/Showing guitar techniques on notation staves and tablature on page 1345
Project-wide engraving options for guitar techniques on page 1343

Tapping
Tapping involves performers pressing the strings of fretted instruments strongly enough that the 
corresponding pitch sounds without additional striking. Tapping indications can specify whether 
the performer should use their right or left hand for individual notes. They typically appear as the 
letter T, a plus sign, or a dot.

According to convention, tapping indications for the same hand and for consecutive notes on the 
same string with different pitches are notated alongside slurs that span the tapped phrase. This 
is similar to hammer-ons and pull-offs, except tapping indications appear on every note whereas 
hammer-on and pull-off indications typically appear centered on slurs.

Guitar techniques
Tapping 
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A phrase containing right-hand and left-hand tapping

By default, tapping indications only appear on notation staves and are placed above the staff. 
You can change the staff-relative placement of individual tapping indications. You can also hide/
show guitar techniques, including tapping indications, on notation staves only, tablature only, or 
both.

In Dorico Pro, tapping indications are considered properties of notes. There are the following 
types of tapping indications:

Right-hand tapping
Right-hand tapping indications specify that the performer should tap the string at 
the specified pitch with their right hand. In Dorico Pro, right-hand tapping indications 
appear as the letter T by default.

Right-hand tapping on notation staff

Right-hand tapping on tablature

TIP

You can change the default appearance of right-hand tapping indications on the 
Guitar Techniques page in Engraving Options.

Left-hand tapping
Left-hand tapping indications specify that the performer should tap the string at the 
specified pitch with their left hand. In Dorico Pro, left-hand tapping indications appear 
as a dot.

Left-hand tapping on notation staff

Left-hand tapping on tablature

RELATED LINKS
Inputting tapping on page 367
Project-wide engraving options for guitar techniques on page 1343
Engraving Options dialog on page 840
Changing the staff-relative placement of guitar techniques on page 1346

Guitar techniques
Tapping 
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Moving items graphically on page 609
Fingerings for fretted instruments on page 1169

Hammer-ons and pull-offs
Hammer-ons and pull-offs involve performers tapping or plucking the strings of fretted 
instruments with their left hand strongly enough that the corresponding pitch sounds without 
additional striking, producing a legato effect. Ligados are a combination of at least one hammer-
on and one pull-off in a single phrase.

Hammer-ons and pull-offs are notated as the letters H or P, respectively, combined with a 
slur spanning the corresponding notes. Dorico Pro automatically centers hammer-on/pull-off 
indications on slurs. For ligados, each hammer-on/pull-off indication is centered over the range 
of notes in the corresponding direction. You can choose to show hammer-on/pull-off indications 
on each note on the Guitar Techniques page in Engraving Options.

A phrase containing hammer-ons, a pull-off, and a ligado

By default, hammer-ons/pull-offs appear on both notation staves and tablature and are placed 
above the staff. You can change the staff-relative placement of individual hammer-on/pull-off 
indications. You can also hide/show guitar techniques, including hammer-ons/pull-offs, on 
notation staves only, tablature only, or both.

In Dorico Pro, hammer-on/pull-off indications are considered properties of notes.

Hammer-ons
Hammer-ons specify that the performer should tap the string at the specified pitch 
with their left hand without restriking the string. Hammer-ons require at least two 
notes on the same string with an ascending pitch direction, such as C-D. In Dorico Pro, 
hammer-ons appear as a letter H.

Hammer-ons on notation staff
Hammer-ons on tablature

Pull-offs
Pull-offs specify that the performer should pluck the string at the specified pitch with 
their left hand without restriking the string. Pull-offs require at least two notes on the 
same string with a descending pitch direction, such as D-C. In Dorico Pro, pull-offs 
appear as a letter P.

Guitar techniques
Hammer-ons and pull-offs 
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Pull-off on notation staff

Pull-off on tablature

Ligados
Ligados specify that the performer should both hammer on and pull off notes within a 
single phrase. Ligados require at least three notes on the same string with alternating 
pitch directions, such as C-D-C. In Dorico Pro, ligados comprise at least one hammer-on 
and pull-off.

Ligado on notation staff
Ligado on tablature

RELATED LINKS
Inputting hammer-ons/pull-offs on page 366
Changing the staff-relative placement of guitar techniques on page 1346
Moving items graphically on page 609
Fingerings for fretted instruments on page 1169
Engraving Options dialog on page 840

Project-wide engraving options for guitar techniques
You can find options for the project-wide appearance and position of vibrato bar dips, vibrato 
bar scoops, and tapping, hammer-on, and pull-off indications on the Guitar Techniques page in 
Engraving Options.

The options on the Guitar Techniques page allow you to change the appearance and default 
placement of tapping, hammer-on, and pull-off indications, the positions of vibrato bar dips 
and vibrato bar scoops, and whether each guitar technique appears on notation staves only, 
tablature only, or both.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840
Hiding/Showing guitar techniques on notation staves and tablature on page 1345

Guitar techniques
Project-wide engraving options for guitar techniques 
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Showing notes as dead notes
You can show individual notes belonging to fretted instruments as dead notes. Dead notes are 
notated with cross noteheads on notation staves and with an X on tablature.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes belonging to fretted instruments that you want to show as dead notes. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Dead note in the Notes and Rests group.

RESULT
The selected notes are shown as dead notes.

NOTE

This does not currently affect their sound in playback; this is planned for future versions.

EXAMPLE

Normal notes Dead notes

RELATED LINKS
Engrave toolbox on page 514
Inputting notes on tablature on page 242
Bracketed noteheads on page 1263
Tablature on page 1580

Changing vibrato bar dip intervals
You can change the intervals of individual vibrato bar dips. By default, vibrato bar dips have half 
step intervals.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Guitar techniques
Showing notes as dead notes 
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vibrato bar dips whose interval you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, change the value for Interval above in the Ornaments group.

For example, enter 1 for a half step interval, 2 for a whole step interval, or 3 for a minor third 
interval.

RESULT
The interval of the selected vibrato bar dips is changed.

EXAMPLE

Vibrato bar dip with half step 
interval

Vibrato bar dip with whole step 
interval

Vibrato bar dip with minor third 
interval

RELATED LINKS
Inputting vibrato bar dips with the popover on page 363
Inputting vibrato bar dips with the panel on page 364
Changing ornament intervals on page 1292
Trill intervals on page 1298

Hiding/Showing guitar techniques on notation staves and 
tablature

You can show different guitar techniques on notation staves only, tablature only, or both project-
wide. For example, you might want to show tapping, hammer-on, and pull-off indications on 
both but vibrato bar scoops and dips only on notation staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Guitar Techniques.

3. In the Hammer-on and Pull-offs section, hide/show tapping, hammer-on, and pull-off 
indications by choosing one of the following options for Show guitar techniques:

● Notation only

● Notation and tablature

● Tablature only

4. In the Vibrato Bar section, choose one of the following options for Show vibrato bar 
scoops:

● Notation only

Guitar techniques
Hiding/Showing guitar techniques on notation staves and tablature 
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● Notation and tablature

● Tablature only

5. Choose one of the following options for Show vibrato bar dips:

● Notation only

● Notation and tablature

● Tablature only

6. Click Apply, then Close.

RESULT
The corresponding guitar techniques are hidden/shown on all corresponding staves project-
wide.

RELATED LINKS
Engraving Options dialog on page 840
Input methods for guitar bends and guitar techniques on page 354
Tapping on page 1340
Hammer-ons and pull-offs on page 1342
Vibrato bar techniques on page 1339
Tablature on page 1580

Changing the staff-relative placement of guitar techniques
You can show individual tapping, hammer-on, and pull-off indications either above or below the 
staff, independently of your project-wide settings. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose guitar technique staff-relative placement you want to change. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Technique placement in the Guitar Techniques group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of tapping, hammer-on, and pull-off indications on the selected 
notes is changed. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

Guitar techniques
Changing the staff-relative placement of guitar techniques 
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TIP

● You can change the staff-relative placement of vibrato bar dips and indications/lines, and the 
direction of guitar bends on notation staves, by selecting them and pressing F .

● You can change the default placement of hammer-on and pull-off indications on notation 
staves and tablature independently on the Guitar Techniques page in Engraving Options.

RELATED LINKS
Changing the direction of guitar pre-bends/pre-dives on page 1331
Moving items graphically on page 609
Changing the staff-relative placement of items on page 441
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Deleting guitar techniques
You can remove vibrato bar scoops and tapping, hammer-on, and pull-off indications from notes 
after you have input them. However, because these guitar techniques are properties of notes 
rather than separate items in Dorico Pro, you must select and delete them differently from other 
items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove guitar techniques.

2. Remove guitar techniques in any of the following ways:

● To remove tapping, hammer-on, and pull-off indications, deactivate Technique in the 
Guitar Techniques group of the Properties panel.

● To remove guitar vibrato bar scoops, deactivate Vibrato bar scoop in the Guitar 
Techniques group of the Properties panel.

RESULT
Tapping, hammer-on, and pull-off indications and/or vibrato bar scoops are removed from the 
selected notes.

Guitar techniques
Deleting guitar techniques 
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Jazz articulations

Jazz articulations in Dorico Pro cover a range of note ornamentations that are idiomatic to jazz 
music, and brass instruments in particular.

Although they are often known as jazz “articulations”, these techniques function more like 
ornaments than articulations because they change the pitch rather than the duration or attack 
of notes. For this reason, they are considered ornaments in Dorico Pro. They are found in the 
Ornaments panel, and you can also input them using the ornaments popover.

Jazz articulations can be shown as a curved line similar to a slur, which is called a “bend” in Dorico 
Pro, and as a straight line, which can be solid, dashed, or wiggly, which is called “smooth” in 
Dorico Pro.

Each note can have a single jazz articulation on each side of it, one before the note and one after. 
Jazz articulations after notes can have different lengths.

The following jazz articulations can be shown before notes:

Plop
An approach into the note from above.

Plop (bend) Plop (smooth)

Scoop/Lift
An approach into the note from below. A bend approach is a scoop, a smooth approach 
is a lift.

Scoop Lift (straight)

The following jazz articulations can be shown after notes:

Doit
A rise in pitch after the note.

Doit (bend) Doit (smooth)

Fall
A lowering of pitch after the note.
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Fall (bend) Fall (smooth)

Additionally, there are other jazz ornaments commonly used by brass instruments that you can 
add to notes in the same ways as inputting jazz articulations.

If your sound library includes samples for jazz articulations, Dorico Pro loads the required 
samples using playback techniques.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Playback techniques on page 936
Glissando lines on page 1317
Arpeggio signs on page 1310
Fingering slides on page 1176
Lines on page 1402

Jazz ornaments
Jazz ornaments are notations that are commonly used in jazz music and by brass instruments, 
such as flips and smears, that are positioned outside of the staff rather than beside noteheads 
like jazz articulations.

Jazz ornaments behave more like other ornaments than jazz articulations, in that they are items 
separate from notes, and so can be selected independently of notes in Write mode and added 
to notes in addition to jazz articulations. Because they are so commonly used alongside jazz 
articulations, in Dorico Pro they are also included in the Jazz section of the Ornaments panel.

You can input jazz ornaments in the same ways as inputting other ornaments rather than jazz 
articulations.

The following ornaments are considered jazz ornaments in Dorico Pro:

Flip

Smear

Jazz turn/Shake

Bend

NOTE

Jazz articulations are not currently reflected in playback.

RELATED LINKS
Ornaments on page 1291
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341

Jazz articulations
Jazz ornaments 
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Project-wide engraving options for jazz articulations
You can find options for the project-wide appearance and position of ornaments on the Jazz 
Articulations page in Engraving Options.

The options on the Jazz Articulations page allow you to change the default length of bends 
and the default line style, design, and angle of smooth jazz articulations. You can also change 
the default positions of jazz articulations relative to noteheads, staff lines, rhythm dots, and jazz 
articulations belonging to other notes at the same rhythmic position.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Positions of jazz articulations
In Dorico Pro, jazz articulations are automatically positioned relative to the noteheads to which 
they apply, with any other notations on those notes, such as rhythm dots, accidentals, and back 
notes, automatically considered.

When multiple notes in a chord have a jazz articulation, Dorico Pro considers the best way to 
align them based on how close to the noteheads they can be positioned and how many jazz 
articulations to show in total. Dorico Pro allows a maximum of one jazz articulation per space, 
meaning fewer jazz articulations than noteheads are sometimes shown on cluster chords.

They are positioned by default according to your settings in Engraving Options. You can change 
the default positions of all jazz articulations project-wide relative to other jazz articulations and to 
noteheads on the Jazz Articulations page in Engraving Options.

In Engrave mode, each smooth jazz articulation has two square handles, one at the start and one 
at the end. You can move these handles to adjust the graphical position, length, and angle of jazz 
articulations. You can also move whole individual jazz articulations graphically.

Handles on a smooth doit in Engrave mode

NOTE

● You cannot move jazz articulations rhythmically. If you want to change the notes to which 
jazz articulations apply, you must delete them from their original notes and input new jazz 
articulations on the new notes.

● The following properties in the Jazz Articulations group of the Properties panel are 
activated automatically when you move the corresponding smooth jazz articulation handle:

● In far offset moves the start handle of jazz articulations shown before notes; that is, the 
handle further from the note. X moves them horizontally, Y moves them vertically.

● In offset moves the end handle of jazz articulations shown before notes; that is, the 
handle closer to the note. X moves them horizontally, Y moves them vertically.

● Out offset moves the start handle of jazz articulations shown after notes; that is, the 
handle closer to the note. X moves them horizontally, Y moves them vertically.

Jazz articulations
Project-wide engraving options for jazz articulations 
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● Out far offset moves the end handle of jazz articulations shown after notes; that is, the 
handle further from the note. X moves them horizontally, Y moves them vertically.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 341
Moving items graphically on page 609
Deleting jazz articulations on page 1352

Changing the type/length of existing jazz articulations
You can change the type and length of jazz articulations after you have input them; for example, 
if you want to change a smooth doit to a long bend doit. You can specify the type/length of jazz 
articulations when using the Ornaments panel but not when using the ornaments popover.

PROCEDURE

1. In Write mode, select the notes whose jazz articulation you want to change.

2. In the Ornaments panel, click the jazz articulation you want in the Jazz section.

RESULT
The jazz articulation shown on the selected notes is changed.

TIP

You can also change the type/duration of jazz articulations using the In and Out properties in the 
Jazz Articulations group of the Properties panel.

EXAMPLE

Short bend doit Medium bend doit Long bend doit

Changing the line style of smooth jazz articulations
You can change the line style of smooth jazz articulations individually, independently of your 
project-wide settings. For example, if you want selected smooth falls to have straight lines 
instead of wavy lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes with smooth jazz articulations whose line style you want to change. You can 
do this in Write mode and Engrave mode.

Jazz articulations
Changing the type/length of existing jazz articulations 
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NOTE

You must select notes with smooth jazz articulations on the same side; for example, only 
select notes with smooth jazz articulations before them.

2. In the Properties panel, select one of the following line styles from the In line style menu 
and/or Out line style menu in the Jazz Articulations group:

● Straight

● Wavy

● Dashed

NOTE

In line style is available when you select notes with smooth jazz articulations before them, 
and Out line style is available when you select notes with smooth jazz articulations after 
them. Both are available when you select notes with smooth jazz articulations on both sides.

RESULT
The line style of the selected smooth jazz articulations is changed.

TIP

● You can reset jazz articulations back to their default line style by selecting them and 
choosing Edit > Reset Appearance.

● You can change the default line style of each smooth jazz articulation independently on the 
Jazz Articulations page in Engraving Options.

EXAMPLE

Doit smooth with straight line Doit smooth with wavy line Doit smooth with dashed line

Deleting jazz articulations
You can remove jazz articulations from notes after you have input them. However, because jazz 
articulations are properties of notes rather than separate items in Dorico Pro, you must select 
and delete them differently from other items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove jazz articulations.

2. In the Ornaments panel, click Remove in the Jazz section.

RESULT
All jazz articulations are removed from the selected notes.

Jazz articulations
Deleting jazz articulations 
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Page numbers

Page numbers are used to give each page a unique number, and indicate its position relative to 
other pages. Just as in newspapers and books, musical scores and parts use page numbers to 
make sure the music stays in the correct order.

Because you can have multiple flows in a single project in Dorico Pro, you do not need to change 
page numbers manually in most cases. However, if you have separate files that together make 
up a single piece, page number changes are necessary to make sure the page numbers continue 
seamlessly from movement to movement.

In such cases, you can change the default page numbers. For example, if you want to have four 
pages of front matter before the first page of music in the score, but you want the first page of 
music in the score to be shown as page 1, you can insert a page number change on the first page 
of music.

Page numbers are layout-specific in Dorico Pro, meaning you can change the page numbers in 
each layout independently. For example, you can change the page numbers in the score but 
show the default page numbers in the parts.

Page numbers in Dorico Pro use a token to ensure the number is correct.

NOTE

You must have a text frame containing the page number token on every page on which you want 
page numbers to be shown.

Default page templates contain text frames with page number tokens. You can change the 
position of page number text frames in the page template editor, which changes the position of 
page numbers on all pages that use that page template. You can also move page number text 
frames on individual pages.

You can also change the type of number used to show page numbers in each layout. For 
example, if you want the front matter to use Roman numerals but the music pages to use Arabic 
numerals, you can change the type of number together with the page number.

RELATED LINKS
Page templates on page 527
Types of page templates on page 532
Page Number Change dialog on page 547
Inserting page number changes on page 545
Page format changes on page 542
Removing page number changes on page 548
Inputting frames on page 562
Moving frames on page 563
Tokens on page 576
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Page number paragraph styles
The paragraph style for page numbers controls all aspects of their appearance, including their 
font, size, and horizontal alignment. You can edit the existing page number paragraph style, and 
create additional page number paragraph styles, in the Paragraph Styles dialog.

● You can open the Paragraph Styles dialog by choosing Library > Paragraph Styles.

Dorico Pro offers a single paragraph style for page numbers by default, but you can create other 
paragraph styles for page numbers. For example, if you want page numbers to appear bold and 
centered at the tops of pages in full score layouts but appear italic and on the outer edges of 
pages in part layouts, you can create a new paragraph style based on the existing Page Number 
paragraph style, but rename it and change the settings.

RELATED LINKS
Paragraph Styles dialog on page 848
Text editor options in Engrave mode on page 584
Changing the paragraph style of text on page 1611
Creating paragraph styles on page 850

Changing the page number numeral style
Page numbers can appear as Arabic or Roman numerals. You can change the numeral style of 
page numbers in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose page number numeral style you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Numbers section, select one of the following options from the Use menu:

● Number

● Roman numeral

5. Click Apply, then Close.

RESULT
The page number numeral style is changed in the selected layouts.

Changing the page number numeral style for individual pages
Page numbers can appear as Arabic or Roman numerals. You can change the numeral style for 
individual page numbers.

PREREQUISITE
The right zone is shown.

Page numbers
Page number paragraph styles 
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PROCEDURE

1. In Engrave mode, open the layout whose page number numeral style you want to change.

2. In the Pages section of the Pages panel, select a page.

3. Open the Page Number Change dialog in any of the following ways:

● Right-click in the Pages section and choose Insert Page Number Change from the 
context menu.

● Click Insert Page Number Change .

4. In the Page Number Change dialog, enter the number of the page from which you want to 
change the page number numeral style in the From page field.

5. Select the numeral style you want from the following options for Sequence type:

● Number

● Roman numeral

6. Click OK to save your changes and close the dialog.

RESULT
The page number numeral style is changed until the next page number change or the end of the 
project, whichever comes first.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Inserting page number changes on page 545

Hiding/Showing page numbers
You can hide/show page numbers in each layout independently, including specifying whether to 
hide/show a page number on the first page. For example, you can show page numbers on every 
page in the score but hide page numbers on the first page in the parts.

NOTE

To show page numbers, there must be a text frame containing the page number token on the 
page. The First page templates in the default page template sets do not contain text frames 
containing page number tokens, so you must add these if you want to show page numbers on 
pages that use these page templates.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show page numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Numbers section, select one of the following options from the Visibility menu:

● Always shown

Page numbers
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● Always hidden

● Not on first page

5. Click Apply, then Close.

RESULT

● If you select Always shown, page numbers are shown on all pages that have a text frame 
containing the page number token in the selected layouts.

● If you select Always hidden, page numbers are hidden on all pages in the selected layouts, 
including on pages that have a text frame containing the page number token.

● If you select Not on first page, page numbers are hidden on the first page in the selected 
layouts, but shown on all other pages that have a text frame containing the page number 
token.

NOTE

Your per-layout setting for whether page numbers are hidden/shown above flow headings 
affects whether page numbers are shown on pages where they are higher on the page than 
flow headings.

RELATED LINKS
Page Number Change dialog on page 547
Inserting page number changes on page 545
Inputting frames on page 562
Moving frames on page 563
Tokens on page 576
Flow headings on page 554
Hiding/Showing information in running headers above flow headings on page 708

Hiding/Showing page numbers on individual pages
You can change when page numbers are shown on individual pages, independently of your 
settings for showing page numbers in each layout.

NOTE

To show page numbers, there must be a text frame containing the page number token on the 
page. The First page templates in the default page template sets do not contain text frames 
containing page number tokens, so you must add these if you want to show page numbers on 
pages that use these page templates.

PREREQUISITE
The right zone is shown.

PROCEDURE

1. In Engrave mode, open the layout in which you want to hide/show page numbers.

2. In the Pages section of the Pages panel, select a page.

3. Open the Page Number Change dialog in any of the following ways:

● Right-click in the Pages section and choose Insert Page Number Change from the 
context menu.

● Click Insert Page Number Change .

Page numbers
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4. In the From page field, enter the number of the page from which you want to hide/show 
page numbers.

5. Optional: Change the value for First page number.

First page number is 1 by default. If you do not want to change the page number together 
with changing the visibility of page numbers, enter the existing page number in this field.

6. Select one of the following options from the Visibility menu:

● Always shown

● Always hidden

● Not on first page

7. Click OK to save your changes and close the dialog.

RESULT
The visibility of page numbers is changed in the layout currently open in the music area, from the 
page number specified until the next page number change with a different setting or the end of 
the project, whichever comes first.

EXAMPLE
If you want to see page numbers up to page 3 but hide page numbers from page 4, enter 4 for 
From page, enter 4 for First page number, and select Always hidden for Visibility.

RELATED LINKS
Pages panel on page 522
Hiding/Showing zones on page 47
Switching between layouts on page 46
Inserting page number changes on page 545
Inputting frames on page 562
Hiding/Showing information in running headers above flow headings on page 708

Page numbers
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Harp pedaling

Harp pedaling is a broad term that covers the specific requirements for notating music for harps. 
This primarily involves harp pedal diagrams, which are often necessary due to the way in which 
modern concert harps change their tuning.

A passage with a full harp pedal diagram at the start and two subsequent partial pedal changes

Harps have seven strings in each octave, one for each diatonic pitch C-B, unlike pianos, which 
have twelve keys in each octave, one for each half-step (semitone) degree between C-B. 
Therefore, harps have a mechanical action to change their tuning that includes seven pedals, 
with each pedal controlling the pitch of the corresponding note in all octaves. These pedals are 
organized into two groups, one for each foot: three pedals for the left foot and four pedals for 
the right foot.

Each harp pedal has three possible positions:

1. Flat or highest position: lowers the pitch of the corresponding note by a half-step

2. Natural or middle position

3. Sharp or lowest position: raises the pitch of the corresponding note by a half-step

NOTE

The lowest two harp strings, C and D, are not affected by the C and D pedal positions.

There are different ways to notate the pedal settings required for a piece of music or a passage 
within a piece. In Dorico Pro, you can show harp pedaling in the following ways:

Diagram

Indicates the physical positions of the seven pedals. The vertical line represents the 
split between left-foot and right-foot pedals and the horizontal line represents the 
natural position.

● Pedals below the horizontal line indicate sharpened notes.

● Pedals above the horizontal line indicate flattened notes.
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Note Names

Indicates the required accidentals for the seven diatonic pitches, arranged in two lines. 
Right-foot pedals are shown on top and left-foot pedals are shown below.

Any pitches that you input that do not fit with the current harp pedal diagram are considered out 
of range, and appear red when colors are shown for notes that are out of range. If you do not 
input any harp pedaling, Dorico Pro assumes all harp pedals are in their natural setting, as they 
would be for C major.

In Dorico Pro, you can input harp pedal diagrams using the playing techniques popover and 
you can automatically generate accurate harp pedal diagrams based on an entire flow or a 
specific passage of music. However, you can only input and show harp pedal diagrams on staves 
belonging to harp instruments; if you copy material from harp staves to other instruments, harp 
pedaling is automatically removed.

By default, harp pedaling is hidden in full score/custom score layouts and shown in part layouts. 
In layouts where harp pedaling is hidden, harp pedal diagrams are indicated by signposts. 
You can hide/show harp pedaling in each layout independently and hide individual harp pedal 
diagrams in layouts where harp pedaling is shown. You can also determine when to show partial 
harp pedaling, such as when only a single pedal must be changed at one time.

Harp pedal diagrams in Dorico Pro affect the pitches played back in glissando lines.

RELATED LINKS
Partial harp pedaling on page 1365
Inputting harp pedal diagrams on page 380
Hiding/Showing harp pedaling in layouts on page 1361
Calculating harp pedal diagrams based on existing music on page 381
Hiding/Showing colors for notes out of range on page 1261
Glissando lines in playback on page 1322

Project-wide engraving options for harp pedaling
You can find options for the project-wide appearance and position of harp pedal diagrams on the 
Harp Pedaling page in Engraving Options.

The options on the Harp Pedaling page allow you to change the size of lines, pedal indicators, 
and gaps in harp pedal diagrams, the order of left-side pedals when using note names, and the 
maximum number of pedal changes below which partial pedal diagrams can be shown. You can 
also change the default position of harp pedal diagrams, including setting precise values for the 
gaps between harp pedal diagrams and the staff or other objects.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840

Harp pedaling
Project-wide engraving options for harp pedaling 
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Changing the appearance of harp pedal diagrams
Harp pedaling can be shown as a diagram or using note names. You can change the appearance 
of harp pedal diagrams individually, independently of your project-wide setting. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the harp pedal diagrams whose appearance you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Appearance in the Harp Pedals group.

3. Choose one of the following options:

● Diagram

● Note Names

RESULT
The appearance of the selected harp pedal diagrams is changed in the current layout. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

TIP

You can change the default appearance of harp pedaling in each layout independently in the 
Harp Pedaling section of the Players page in Layout Options.

EXAMPLE

Harp pedaling shown as a diagram

Harp pedaling shown using note names

RELATED LINKS
Layout Options dialog on page 834
Partial harp pedaling on page 1365
Inputting harp pedal diagrams on page 380
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Harp pedaling
Changing the appearance of harp pedal diagrams 
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Hiding/Showing harp pedaling in layouts
You can input and calculate harp pedaling in any layout, but by default harp pedaling is not 
shown in full score layouts, as they are usually only useful for the performer. You can hide/show 
harp pedaling in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show harp pedaling.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Harp Pedaling section, activate/deactivate Show harp pedaling.

5. Click Apply, then Close.

RESULT
Harp pedaling is shown in the selected layouts when the checkbox is activated, and hidden when 
the checkbox is deactivated.

In layouts where harp pedaling is hidden, harp pedal diagrams are indicated by signposts.

NOTE

● You can hide individual harp pedal diagrams in layouts where harp pedaling is shown, but 
you cannot show individual harp pedal diagrams in layouts where harp pedaling is hidden.

● You can hide/show harp pedaling signposts by choosing View > Signposts > Harp Pedals.

Hiding/Showing harp pedal diagrams individually
You can hide/show individual harp pedal diagrams in layouts in which harp pedaling is shown. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to hide/show individual harp pedal 
diagrams. You can do this in Write mode and Engrave mode.

2. Select the harp pedal diagrams you want to hide, or the signposts of harp pedal diagrams 
you want to show.

3. In the Properties panel, activate/deactivate Hide in the Harp Pedals group.

Harp pedaling
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RESULT
The selected harp pedal diagrams are hidden when Hide is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden harp pedal diagram. However, signposts are 
not printed by default.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Signposts on page 453
Annotations on page 687

Hiding/Showing borders on harp pedal diagrams
You can hide/show borders on individual note name harp pedal diagrams, independently of your 
project-wide setting. For example, on systems with very tight vertical spacing, hiding borders on 
harp pedal diagrams can give you a little extra space.

NOTE

These steps only apply to harp pedal diagrams using note names.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the note name harp pedal diagrams on which you want to hide/show borders. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Border in the Harp Pedals group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Borders are shown on the selected note name harp pedal diagrams when the checkbox is 
activated, and hidden when the checkbox is deactivated.

When the property is deactivated, the selected harp pedal diagrams follow your project-wide 
setting for hiding/showing borders.

TIP

You can hide/show borders on all note name harp pedal diagrams project-wide in Engraving 
Options > Harp Pedals > Note Names.

Harp pedaling
Hiding/Showing borders on harp pedal diagrams 

1362
Dorico Pro 4.3.30



EXAMPLE

Note name harp pedal diagram with border hidden Note name harp pedal diagram with border shown

Changing the thickness of harp pedal diagram borders
You can change the thickness of borders on individual note name harp pedal diagrams, 
independently of your project-wide setting.

NOTE

These steps only apply to harp pedal diagrams using note names.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the note name harp pedal diagrams whose border thickness you 
want to change.

2. In the Properties panel, activate Border thickness in the Harp Pedals group.

3. Change the value in the value field.

RESULT
The thickness of borders on the selected harp pedal diagrams is changed.

TIP

You can change the default border thickness for all harp pedal diagrams project-wide in 
Engraving Options > Harp Pedals > Note Names.

Changing the padding around harp pedal diagrams
You can change the padding around harp pedal diagrams individually, and for each edge 
independently. This affects the distance between harp pedal diagrams and erased backgrounds 

Harp pedaling
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and borders. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the harp pedal diagrams whose padding you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Harp Pedals group:

● Left padding

● Right padding

● Top padding

● Bottom padding

3. Change the values in the value fields.

RESULT
The padding around the selected harp pedal diagrams is changed. Increasing the values 
increases the padding, decreasing the values decreases the padding. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default padding around all harp pedal diagrams project-wide in Engraving 
Options > Harp Pedals > Note Names. However, this does not allow you to change the padding 
of each edge independently.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Positions of harp pedal diagrams
By default, harp pedal diagrams are centered vertically between the two staves usually shown for 
harps.

You can move harp pedal diagrams to different rhythmic positions in Write mode. They are 
positioned by default according to your settings in Engraving Options.

You can move harp pedal diagrams graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

You can change the default positions of all harp pedal diagrams project-wide on the Harp 
Pedaling page in Engraving Options.

Harp pedaling
Positions of harp pedal diagrams 
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RELATED LINKS
Project-wide engraving options for harp pedaling on page 1359
Engraving Options dialog on page 840
Moving notes/items rhythmically on page 465
Moving items graphically on page 609

Partial harp pedaling
Partial harp pedal diagrams only show the notes whose pedal setting must change at that 
position, rather than showing the required settings for all pedals. This can make those changes 
immediately clear to the performer, as they have fewer pedals to read.

Partial pedal diagrams for a sequence containing several quick pedal changes

You can allow partial harp pedaling for individual harp pedal diagrams and you can set a 
maximum threshold of pedal changes at a single position, above which all harp pedal diagrams 
must show all pedals. This is because performers are used to the pattern of note names in 
complete harp pedal diagrams, and if there are many changes in a partial harp pedal diagram, 
this can be harder to read than a complete one.

By default, Dorico Pro shows notes in partial harp pedal diagrams on two lines with right-foot 
pedals on top and left-foot pedals below.

NOTE

Only harp pedal diagrams using note names can be shown as partial.

Allowing/Disallowing partial harp pedaling
You can allow/disallow partial harp pedaling for individual note name harp pedal diagrams, 
independently of your project-wide settings. For example, if your default setting is to allow 
partial harp pedaling for up to two pedal changes, but you want to show one harp pedal diagram 
with three pedal changes as partial. You can do this for the current layout and frame chain only, 
or for all layouts and frame chains.

NOTE

● These steps only apply to harp pedal diagrams using note names.

● Harp pedal diagrams positioned at the very beginning of a flow can only appear as full harp 
pedal diagrams.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Harp pedaling
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the note name harp pedal diagrams for which you want to allow/disallow partial harp 
pedaling. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Partial pedaling in the Harp Pedals group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Partial harp pedaling is allowed for the selected note name harp pedal diagrams when the 
checkbox is activated, and disallowed when the checkbox is deactivated. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

When the property is deactivated, the selected harp pedal diagrams follow your project-wide 
settings for partial harp pedaling.

TIP

You can allow/disallow partial pedal diagrams project-wide, and change the default pedal change 
threshold below which partial harp pedal diagrams are allowed, in Engraving Options > Harp 
Pedals > Note Names.

EXAMPLE

Harp pedal diagram showing all pedals Partial harp pedal diagram

RELATED LINKS
Hiding/Showing harp pedaling in layouts on page 1361
Inputting harp pedal diagrams on page 380
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Pedal lines

Pedal lines indicate to performers which piano pedals to use, and can also give performance 
instructions, such as how far down to depress the pedals and when to lift the pedal to clear the 
resonance.

Most pianos have either two or three pedals. These pedals are:

Sustain pedal
The sustain pedal controls the dampers on the piano strings, which is why it is also 
known as the “damper pedal”. It is also the most commonly used pedal. Depressing the 
sustain pedal removes the dampers, allowing the strings to resonate longer. Sustain 
pedals are usually on the right.

Sostenuto pedal
The sostenuto pedal only allows the strings of the notes currently depressed on the 
keyboard to resonate. It is also known as the “middle pedal” as it is usually in the 
middle of the other pedals.

Una corda pedal
The una corda pedal shifts the action inside the piano so that the hammers hit fewer 
strings than normal. Historically, this caused hammers only to hit one string, not the 
usual three, which is where the name comes from. Because this reduces the volume 
and impact of the sound, it is also known as the “soft pedal”.
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Dorico Pro offers comprehensive notational and playback support for piano pedal lines. You 
can create pedaling for the sustain, sostenuto, and una corda pedals, with support for modern 
sustain pedaling techniques, including changing the pedal level over the course of a single pedal 
instruction.

You can change the appearance of pedal lines, including changing their start sign and 
continuation type. For example, if you want to show some pedal lines with a continuation line 
and some only with a sign at the end.

In Dorico Pro, pedal lines are considered playing techniques because they alter the sound 
produced by the instrument. Therefore, pedal lines are included in the Playing Techniques panel 
in Write mode and you can input them using the playing techniques popover. However, pedal 
lines have additional, unique requirements that do not apply to other playing techniques, such as 
retakes, pedal level changes, start signs, end signs, and continuation lines.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Pedal line start signs, hooks, and continuation lines on page 1377
Text pedal line signs on page 1383
Pedal lines in playback on page 1385
Playing technique continuation lines on page 1393
Lines on page 1402
MIDI Import Options dialog on page 90

Project-wide engraving options for pedal lines
You can find options for the project-wide appearance and position of pedal lines on the Pedal 
Lines page in Engraving Options.

The options on the Pedal Lines page allow you to change the symbol shown at the start of each 
type of pedal line, the appearance of pedal line symbols on subsequent systems, the appearance 
of pedal continuation lines, and the width of retake notches. You can also set precise values for 
the gaps between pedal lines and the staff or other objects and change the default position of 
pedal lines, start signs, retakes, and pedal line ends relative to noteheads and grace notes.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Sustain pedal retakes and pedal level changes
Pedal retakes indicate where a player should lift the sustain pedal, which dampens the piano’s 
strings and clears the resonance, before depressing the pedal again. Pedal level changes indicate 
a change to how far the pedal is depressed.

Dorico Pro provides clear representations of pedal retakes and level changes for pedal lines with 
the line continuation type.

NOTE

You can only add pedal retakes and level changes to sustain pedal lines.

Pedal lines
Project-wide engraving options for pedal lines 
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EXAMPLE

1 Ped. glyph

2 Retake

3 One quarter depressed

4 Half depressed

5 Three quarters depressed

6 Fully depressed

7 Line end hook

RELATED LINKS
Changing the pedal line continuation type on page 1380
Positions of pedal lines on page 1374
Changing pedal line levels on page 1372
Removing retakes and pedal level changes on page 1373
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Sustain pedal lines in Engrave mode
When you select sustain pedal lines in Engrave mode, handles appear at the start/end of each 
pedal line, and on any retakes or pedal level changes on the line. These handles allow you to 
move each part of the pedal line independently, and to change the pedal levels at the start, end, 
and at each retake or pedal level change.

A sustain pedal with a retake in Engrave mode

There are two handles for the start of the pedal line, three for retakes and pedal level changes, 
and three for the end of the pedal line.

NOTE

● Pedal levels cannot be lower than 0 or higher than 1, as shown in properties in either the 
Pedal Lines group or the Pedal Line Retakes group of the Properties panel.

● 1 is fully depressed.

● 0 is not depressed.

● Sostenuto and una corda pedal lines only have a single handle at their start/end, which allows 
you to move their start/end positions graphically, but only horizontally.

Pedal lines
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Start of sustain pedal lines

There are two handles at the start of pedal lines.

● The left handle moves the start point of the pedal line. You can move this handle to the 
right/left.

● The right handle changes the start pedal level of the pedal line. You can move this handle 
upwards/downwards. This changes the angle of the pedal continuation line in relation to the 
next retake or pedal level change, or the end of the pedal line.

Pedal level changes and retakes

● The left handle changes the pedal level before the retake or pedal level change. You can 
move this handle upwards/downwards.

● The right handle changes the pedal level after the retake or pedal level change. You can 
move this handle upwards/downwards.

● The bottom handle corresponds to the position of the retake or pedal level change. You can 
move this handle to the right/left.

End of sustain pedal lines

● The top handle changes the hook length. You can move this handle upwards/downwards.

● The right handle changes the pedal level at the end of the pedal line. You can move this 
handle upwards/downwards.

● The bottom handle moves the end point of the pedal line. You can move this handle to the 
right/left.

RELATED LINKS
Pedal line start signs, hooks, and continuation lines on page 1377
Moving items graphically on page 609

Changing the type of pedal line retakes
You can change existing retakes on sustain pedal lines to pedal level changes and vice versa.

For example, if you do not want the pedal to be released completely between the old and new 
levels, change the type to Change Level instead of Retake.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Pedal lines
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● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the retake or pedal level change whose type you want to change.

2. In the Properties panel, activate Retake type in the Pedal Line Retakes group.

3. Choose the type you want from the following options:

● Retake

● Change Level

RESULT
The type of pedal line retake is changed.

NOTE

The appearance of the new type of pedal line retake depends on the pedal levels already set on 
each side. For example, a retake notch is only shown on one side of the retake if the pedal level 
on the other side is set to 0.

Changing the global level for pedal lines
You can change the global level for individual sustain pedal lines and show the level as a prefix 
before the pedal line start sign, such as “1/2 Ped.”. For example, to indicate a pianist should only 
half depress the sustain pedal throughout a piece.

By default, the global level of sustain pedal lines is fully depressed.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the pedal lines whose global level you want to change.

2. In the Properties panel, activate Global level in the Pedal Lines group.

3. Select one of the following options from the menu:

● 1/8

● 1/4

● 1/2

● 3/4

RESULT
The global level for the selected pedal lines is changed and the selected level appears as a prefix 
before their start signs.

NOTE

Level prefixes do not appear for pedal lines with hook start signs.

Pedal lines
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EXAMPLE

Pedal line with default fully depressed pedal level Pedal line with half depressed pedal level

RELATED LINKS
Pedal line start signs, hooks, and continuation lines on page 1377
Changing the start sign appearance of pedal lines on page 1378

Changing pedal line levels
You can change the level at the start and end of individual sustain pedal lines, and at each retake 
or pedal level change. For example, if you want to specify how far to depress the pedal at specific 
rhythmic positions.

NOTE

You can only change the level of pedal lines with the line continuation type.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select any of the following handles on each pedal line whose pedal line 
levels you want to change:

● To change the start pedal level, select the right handles on start signs.

● To change the pedal level immediately before retakes/level changes, select the left 
handle of retakes/level changes.

● To change the pedal level immediately after retakes/level changes, select the right 
handle of retakes/level changes.

● To change the end pedal level, select the right handles on end hooks.

TIP

You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

2. Move the handles in any of the following ways:

● To move them upwards, press Alt/Opt-Up Arrow .

● To move them downwards, press Alt/Opt-Down Arrow .

● To snap the level to 0 (not depressed), press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To snap the level to 1 (fully depressed), press Ctrl/Cmd-Alt/Opt-Down Arrow .
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● Click and drag the handles upwards/downwards to the level you want.

RESULT
The pedal levels at the selected positions on the corresponding pedal lines are changed.

TIP

The following properties in the Pedal Lines group of the Properties panel are activated when you 
change the corresponding pedal line level:

● Start level

● Start level at retake

● End level at retake

● End level

You can also use these properties to change the pedal line level at the corresponding positions 
by changing the values in the value fields. For example, 1 is fully depressed and 0 is not 
depressed.

Deactivating the properties resets the selected pedal lines to their default pedal line levels.

RELATED LINKS
Engrave toolbox on page 514
Changing the pedal line continuation type on page 1380

Removing retakes and pedal level changes
You can remove pedal retakes and level changes without deleting the sustain pedal line or 
changing its rhythmic position.

PROCEDURE

1. In Write mode, select an item on each staff and at each rhythmic position where you want to 
remove retakes or pedal level changes.

2. Remove the retakes or pedal level changes in any of the following ways:

● Open the playing techniques popover, enter nonotch into the popover, then press 
Return .

NOTE

nonotch must be spelled as one word, without a space.

● Choose Edit > Notations > Pedal Lines > Remove Retake. You can also choose this 
option from the context menu.

RESULT
The retakes or pedal level changes at each selected rhythmic position on each selected staff are 
removed. The corresponding sustain pedal lines return to their previous levels as set by either 
the start of the pedal line, or the retake or pedal level change immediately preceding the ones 
you removed.

RELATED LINKS
Playing techniques popover on page 369
Adding retakes and pedal level changes with the popover on page 377
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Adding retakes and pedal level changes with the panel on page 379

Positions of pedal lines
The default placement of pedal lines is below the bottom staff, even if there are only notes in the 
upper staff for the right hand. They are placed outside all other notations, including octave lines, 
slurs, and articulations.

If one pedal is used, it is placed as close to the bottom of the staff as possible, while remaining 
outside of all other notations.

If multiple pedals are used simultaneously, they are organized below the bottom of the staff as 
follows:

1. Sustain pedal: closest to the staff

2. Sostenuto pedal: below the sustain pedal line

3. Una corda pedal: furthest from the staff

The beginning of the glyph/text that indicates the start position of pedal lines aligns with the 
note to which it applies. If you are using a line end hook to indicate the end of pedal lines, the 
hook aligns with the note or rhythmic position to which it applies.

You can move pedal lines to different rhythmic positions in Write mode. They are positioned by 
default according to your settings in Engraving Options.

NOTE

You cannot move retakes or pedal level changes rhythmically. You must remove them and input 
a new retake or pedal level change at the position you want.

You can move pedal lines graphically in Engrave mode. However, this does not change the 
rhythmic positions to which they are attached. You can move multiple pedal lines together, but 
only upwards/downwards. Similarly, you can move handles on multiple pedal lines together, but 
only to the right/left.

You can change the default positions of all pedal lines project-wide on the Pedal Lines page in 
Engraving Options. For example, you can change values for the minimum distances between 
pedal lines and staves, pedal lines and other pedal lines, and the position of pedal lines relative 
to noteheads and grace notes.

RELATED LINKS
Engraving Options dialog on page 840
Text pedal line signs on page 1383
Pedal line start signs, hooks, and continuation lines on page 1377
Sustain pedal retakes and pedal level changes on page 1368
Moving items graphically on page 609
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Changing the position of pedal lines relative to grace notes
You can change the start/end positions of individual pedal lines relative to grace notes, 
independently of your project-wide settings.

Pedal lines
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose position relative to grace notes you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate any of the following properties in the Pedal Lines group:

● Starts before grace notes

● Ends before grace notes

3. Activate/Deactivate the corresponding checkboxes.

RESULT
When the checkboxes are activated, the corresponding parts of the selected pedal lines are 
positioned before grace notes.

When the checkboxes are deactivated, the corresponding parts of the selected pedal lines are 
positioned after grace notes.

TIP

● You can adjust the precise position of pedal lines in further detail in Engrave mode.

● You can change the position of all pedal lines relative to grace notes project-wide on the 
Pedal Lines page in Engraving Options.

EXAMPLE

Pedal line starting/ending before grace notes Pedal line starting/ending after grace notes

Splitting pedal lines
You can split sustain pedal lines at any rhythmic position with an existing item along their length 
into two separate pedal lines.

NOTE

These steps only apply to sustain pedal lines.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Pedal lines
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PROCEDURE

1. Select an item on the staff and at the rhythmic position where you want to split the sustain 
pedal line. You can do this in Write mode and Engrave mode.

NOTE

You can only split one pedal line at a time.

2. Choose Edit > Notations > Pedal Lines > Split Pedal Line. You can also choose this option 
from the context menu.

RESULT
The pedal line on the selected staff is split at the selected rhythmic position.

EXAMPLE

A single pedal line The pedal line after being split into two

AFTER COMPLETING THIS TASK
You can move, lengthen/shorten, and edit both pedal lines independently.

RELATED LINKS
Engrave toolbox on page 514
Moving notes/items rhythmically on page 465
Selecting/Deselecting notes and items individually on page 426
Pedal line start signs, hooks, and continuation lines on page 1377
Changing the pedal line continuation type on page 1380
Text pedal line signs on page 1383
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Merging pedal lines
You can merge existing sustain pedal lines together; for example, if you want to fill in a gap 
between two sustain pedal lines.

NOTE

These steps only apply to sustain pedal lines.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the sustain pedal lines on the same staff that you want to merge together. You can do 
this in Write mode and Engrave mode.

NOTE

You can only merge pedal lines on one staff at a time.

2. Choose Edit > Notations > Pedal Lines > Merge Pedal Lines. You can also choose this 
option from the context menu.

RESULT
The selected pedal lines are merged together into a single pedal line. If there were gaps between 
them, a continuation line is automatically shown across them.

AFTER COMPLETING THIS TASK
You can input retakes and pedal level changes; for example, if you want to show a retake at the 
position where previously one of the pedal lines started.

Pedal line start signs, hooks, and continuation lines
Pedal lines normally comprise a start sign, a continuation line, and an end hook. This indicates 
clearly to performers where to depress each type of pedal, how long to keep it depressed, and 
where to lift it.

1 Start sign

2 Continuation line

3 End hook

In Dorico Pro, you can change the appearance of each part of pedal lines both individually and 
for all pedal lines project-wide. For example, you can show all pedal lines with a glyph as their 
start sign, but change the start sign of an individual pedal line to show text instead.

You can select whole pedal lines in Write mode and change most aspects of their appearance 
according to the type of pedal line, such as their continuation line or start sign.

For sustain pedals only, you can select each segment of a sustain pedal independently in Engrave 
mode, and set different properties for each segment. Sustain pedal lines have independent 
segments on each separate system on which they appear.

TIP

If you are changing the appearance of many pedal lines, it might be easier to change the 
corresponding project-wide settings on the Pedal Lines page in Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Sustain pedal lines in Engrave mode on page 1369
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Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Changing the start sign appearance of pedal lines
You can change the appearance of the start of pedal lines individually, independently of your 
project-wide settings. Pedal line start signs can be shown as variations of the traditional pedal 
line glyph, other symbols, or text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose start sign appearance you want to change. You can do this in 
Write mode and Engrave mode.

NOTE

The pedal lines you select must be the same type; for example, only sustain pedal lines.

2. In the Properties panel, activate Sign appearance in the Pedal Lines group.

3. Select one of the options from the menu.

The options are different according to the type of pedal line selected.

RESULT
The start sign appearance of the selected pedal lines is changed.

TIP

● The end signs of una corda pedal lines automatically match their start signs.

● Deactivating Sign appearance returns the selected pedal lines to your default setting for 
start sign appearance.

● You can change the default start sign appearance of all pedal lines project-wide on the Pedal 
Lines page in Engraving Options.

EXAMPLE

Sustain 
pedal lines

Ped. Glyph Ped Glyph P Glyph Symbol Ped. Text Hook

Sostenuto 
pedal lines

Sost. Glyph S Glyph Symbol Sost. text Sostenuto 
text
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Una corda 
pedal lines

Symbol u. c. una corda

AFTER COMPLETING THIS TASK
If you selected a text sign appearance, you can edit the text shown.

RELATED LINKS
Editing pedal line start text on page 1384

Changing the type of hook at the start/end of pedal lines
You can change the type of hook shown at the start/end of pedal lines individually.

NOTE

You can only change the start hook type of pedal lines that have a hook as their start sign, and 
you can only change the end hook type of pedal lines that have a continuation line.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose hook type you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Pedal Lines group:

● Line start hook

● Line end hook

3. Select one of the following options from each menu:

● No Hook

● Vertical Hook

● Slant Hook

● Inverse Hook

RESULT
The hook type at the start/end of the selected pedal lines is changed.

TIP

You can change the default appearance of all pedal lines project-wide on the Pedal Lines page in 
Engraving Options.

Pedal lines
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EXAMPLE

No Hook line end Vertical Hook line end Slant Hook line end Inverse Hook line end

Changing the pedal line continuation type
You can change the continuation type used for individual pedal lines, independently of your 
project-wide settings. For example, if you want some pedal lines to show a dashed line and a sign 
at the end, but others to show a line and end hook.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose continuation type you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Continuation type in the Pedal Lines group.

3. Select one of the following continuation types from the menu:

● Line

● Sign at End

● Sign at End and Dashed Line

● None

RESULT
The continuation type of the selected pedal lines is changed.

TIP

You can change the continuation type for all pedal lines project-wide on the Pedal Lines page 
in Engraving Options. You can choose different continuation types for each pedal type; for 
example, you can have a line for sustain pedal lines and just a sign at the end for una corda pedal 
lines.

EXAMPLE

Line Sign at End Sign at End and Dashed Line None
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RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Properties panel on page 769
Sustain pedal retakes and pedal level changes on page 1368
Changing pedal line levels on page 1372
Inputting pedal lines with the popover on page 376
Editing una corda pedal line restorative text on page 1385

Lengthening/Shortening gaps and dashes in pedal continuation 
lines

You can change the length of dashes and the gaps between dashes in individual dashed pedal 
continuation lines, independently of your project-wide settings. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to pedal lines with dashed continuation lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the pedal lines whose dashes you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Pedal Lines group:

● Dash length

● Dash gap length

3. Change the values in the value fields.

RESULT
Increasing Dash length makes dashes in pedal continuation lines longer, decreasing the value 
makes dashes shorter.

Increasing Dash gap length makes gaps between dashes in pedal continuation lines longer, 
decreasing the value makes gaps shorter.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can change the default dash length and default gap length for all dashed pedal continuation 
lines project-wide in Engraving Options > Pedal Lines > Design > Advanced Options.

RELATED LINKS
Changing the property scope on page 771
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Copying property settings to other layouts/frame chains on page 768

Changing the line width of pedal lines
You can change the thickness of continuation lines individually, independently of your project-
wide settings. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the pedal lines whose continuation line thickness you want to 
change.

2. In the Properties panel, activate Line width in the Pedal Lines group.

The value resets to 0 automatically when you first activate the property.

3. Change the value in the value field.

RESULT
Increasing Line width makes pedal continuation lines thicker, decreasing the value makes pedal 
continuation lines thinner. If the property scope was set to Locally, this change only takes effect 
in the current layout and frame chain.

TIP

You can change the default thickness for all pedal continuation lines project-wide in the Design 
section of the Pedal Lines page in Engraving Options.

Parenthesizing pedal line continuation signs
You can show individual pedal line continuation signs with/without parentheses, independently 
of your project-wide setting. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

Pedal line continuation signs are shown by default at the start of new systems when pedal lines 
continue across system/frame breaks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the pedal lines whose continuation sign appearance you want to change. You can do 
this in Write mode and Engrave mode.
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2. In the Properties panel, activate Show continuation sign in parentheses in the Pedal Lines 
group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Continuation signs are shown with parentheses when the checkbox is activated, and without 
parentheses when the checkbox is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

When the property is deactivated, pedal lines follow your project-wide setting.

TIP

You can change the default appearance of all pedal line continuation signs project-wide in the 
Design section of the Pedal Lines page in Engraving Options.

Text pedal line signs
All types of pedal lines can have text as their start signs, instead of glyphs or hooks. You can 
override the text shown at the start of pedal lines that have text start signs, you can change the 
continuation text shown at the start of new systems, and you can override the restorative text 
shown at the end of una corda pedal lines.

You can change the design of all pedal lines project-wide according to their type in the Design 
section of the Pedal Lines page in Engraving Options, and you can change the appearance of 
individual pedal lines, independently of your project-wide settings.

Pedal lines that use a text indication rather than a symbol

For pedal lines such as una corda or sustain that have text for their start sign, such as Ped. Text, 
rather than the more ornate symbol, you can override the text shown at the start of the pedal 
line and replace it with your preferred performance direction.

Continuation sign/text

When pedal lines continue onto subsequent systems, a continuation sign/text is shown in 
parentheses by default. If the pedal line is using text for their start sign, such as Ped. Text, 
rather than a symbol, you can change the text shown at the start of a new system and replace it 
with your preferred performance direction.

Una corda pedal lines

The equivalent to the final pedal lift for the una corda pedal marking is the indication to return to 
tre corde. You can override the tre corde text shown at the end of the pedal line and replace it with 
your preferred performance direction.

RELATED LINKS
Changing the start sign appearance of pedal lines on page 1378
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
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Editing pedal line start text
You can change the text shown at the start of individual pedal lines that use text as their start 
sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose start text you want to edit. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown at the start of the selected pedal lines is changed.

Deactivating Text restores the default start text for the selected pedal lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

RELATED LINKS
Engrave toolbox on page 514

Editing pedal line continuation text
You can change the text shown at the start of subsequent systems when pedal lines continue 
across system/frame breaks.

NOTE

These steps only apply to pedal lines that use text as their start sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose continuation text you want to edit. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Continuation text in the Pedal Lines group.

3. Enter the text you want into the value field.
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4. Press Return .

RESULT
The continuation text shown at the start of subsequent systems for the selected pedal lines is 
changed.

Deactivating Continuation text restores the default continuation text for the selected pedal 
lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

Editing una corda pedal line restorative text
The equivalent to the final pedal lift for una corda pedal lines is the indication to return to tre 
corde. You can change the tre corde text shown at the end of individual una corda pedal lines.

NOTE

These steps only apply to una corda pedal lines that use text as their start sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the una corda pedal lines whose restorative text you want to edit. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Restorative text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The restorative text shown at the ends of the selected una corda pedal lines is changed.

Deactivating Restorative text restores the default restorative text for the selected pedal lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

Pedal lines in playback
Pedal lines are automatically played back in Dorico Pro.

The three piano pedals send MIDI controllers as follows:

● Sustain pedal lines send MIDI controller 64 (Sustain).

● Sostenuto pedal lines send MIDI controller 66 (Sostenuto).
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● Una corda pedal lines send MIDI controller 67 (Soft Pedal).

Some piano VST instruments, such as Pianoteq and Garritan CFX Concert Grand, support 
partial depression of the sustain pedal. Consult the manufacturer’s documentation for more 
information.

Playback Options

You can find options for how Dorico Pro plays back pedaling on the Pedal Lines page in 
Playback Options.

You can control the following parameters of pedal line playback:

● The length of the initial pedal depression

● The length of a retake in the middle of a pedal line

● The length of the final pedal release

● Whether initial depressions and retakes are played before or after the onset of the notes or 
chords at their rhythmic positions

RELATED LINKS
Playback Options dialog on page 842
MIDI CC editor on page 805

Pedal lines imported from MusicXML files
Sustain pedal lines can be imported from MusicXML files. MusicXML can only describe the sustain 
pedal, and it cannot describe changes in pedal depression level.
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Playing techniques

The term “playing techniques” covers a wide range of instructions intended to tell performers to 
modify the sound of the notes they are playing; for example, by changing their embouchure or 
changing the position of their bow, or by modifying their instrument, such as adding a mute or 
depressing a pedal.

In Dorico Pro, there are the following types of playing techniques:

Glyph playing techniques
Playing techniques that display symbols, such as up bow  or down bow  markings.

Text playing techniques
Playing techniques that display text, such as pizz. or con sordino.

You can find all available playing techniques in the Playing Techniques panel in Write mode, 
organized by instrument family. For example, you can find pedal lines in the Keyboard section of 
the Playing Techniques panel.

NOTE

Because pedal lines have additional, unique requirements that do not apply to other playing 
techniques, such as retakes, start signs, and continuation lines, they are documented separately. 
Pedal lines also have their own group of the Properties panel that is separate from the Playing 
Techniques group.

Musical phrase with glyph and text playing techniques, including grouped text playing techniques with a 
continuation line

Playing techniques can change how instruments play back. For example, inputting a pizz. playing 
technique on a violin staff activates a key switch that changes the sound produced by the VST 
instrument. Dorico Pro uses playback techniques to produce the required sounds in playback 
for the playing techniques you input, provided your sound library includes the corresponding 
samples.

Many playing techniques that only appear once in the music nonetheless imply that the playing 
technique continues. For example, pizzicato usually appears once but applies until the next 
playing technique, such as arco. In Dorico Pro, you can show continuation lines after and 
between playing techniques to convey clearly to performers the notes to which you want them to 
apply. You can also group multiple playing techniques together.

Playing technique texts use a plain font, neither bold nor italic, so they are not confused with 
dynamics and expressive text.
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TIP

● You can create custom playing techniques using existing glyphs, text, and your own 
graphics, including defining how they should affect playback and whether or not they show 
continuation lines.

● You can change different aspects of the Playing Technique Font font style in the Edit Font 
Styles dialog. Pedal lines use a separate font style to other playing techniques.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Playback techniques on page 936
Custom playing techniques on page 876
Pedal lines on page 1367
String indicators on page 1183
Playing technique continuation lines on page 1393
Groups of playing techniques on page 1399
Positions of playing techniques on page 1392
Edit Font Styles dialog on page 846
Changing the default font family on page 853
MIDI Import Options dialog on page 90

Project-wide engraving options for playing techniques
You can find options for the project-wide appearance and position of playing techniques on the 
Playing Techniques page in Engraving Options.

The options on the Playing Techniques page allow you to change the distance between playing 
techniques and the staff, the arrangement of multiple text playing techniques at the same 
rhythmic position, the default horizontal offset of text playing techniques, and playing technique 
continuation styles. You can also change whether playing techniques on grace notes appear 
smaller.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Custom playing techniques on page 876

Adding text to playing techniques
You can add text to playing techniques after they have been input; for example, to clarify the 
intention of the playing technique. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

NOTE

These steps do not apply to pedal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the playing techniques to which you want to add text. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Suffix in the Playing Techniques group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered is added to the selected playing techniques and appears after them. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

EXAMPLE

Playing techniques without suffixes Suffixes added to playing techniques

RELATED LINKS
Text pedal line signs on page 1383
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Custom playing techniques on page 876
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Erasing the background of text playing techniques
You can erase the background of individual text playing techniques; for example, to ensure they 
remain legible when crossing barlines. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the playing techniques whose backgrounds you want to erase.

Playing techniques
Erasing the background of text playing techniques 
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2. In the Properties panel, activate Erase background in the Playing Techniques group.

RESULT
The backgrounds of the selected playing techniques are erased. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns the selected playing techniques to the default non-
erased background.

EXAMPLE

Text playing technique with non-erased background Text playing technique with erased background

AFTER COMPLETING THIS TASK
You can change the padding between playing techniques and each edge of their erased areas.

RELATED LINKS
Engrave toolbox on page 514

Changing the erasure padding of text playing techniques
You can change the erasure padding of individual playing techniques, including changing the 
padding between playing techniques and each edge of their erased areas independently. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the text playing techniques whose erasure padding you want to 
change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Playing Techniques group.

● L changes the padding between playing techniques and their left edge.

● R changes the padding between playing techniques and their right edge.

● T changes the padding between playing techniques and their top edge.

● B changes the padding between playing techniques and their bottom edge.

3. Change the values in the value fields.

Playing techniques
Erasing the background of text playing techniques 
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RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

TIP

You can change the default erasure padding of all playing techniques project-wide in the Design 
section of the Playing Techniques page in Engraving Options. However, this does not allow you 
to change the padding of each edge independently.

Hiding/Showing playing techniques
You can hide/show playing techniques individually; for example, if your expression map requires 
you to input a playing technique to trigger the correct playback but you do not want that 
technique to appear in the music.You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the playing techniques you want to hide, or the signposts of playing techniques you 
want to show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hidden in the Playing Techniques group.

RESULT
The selected playing techniques are hidden when Hidden is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden playing technique. However, signposts are 
not printed by default.

TIP

● You can hide/show playing technique signposts by choosing View > Signposts > Playing 
Techniques.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Expression maps on page 912
Signposts on page 453
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Changing the property scope on page 771

Playing techniques
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Copying property settings to other layouts/frame chains on page 768
Key Commands page in the Preferences dialog on page 63
Annotations on page 687

Positions of playing techniques
Playing techniques, both as text and symbols, are placed above the staff by default. On vocal 
staves, they are placed above the staff and below dynamics. In multiple-voice contexts, playing 
techniques for the up-stem voices are placed above the staff and playing techniques for the 
down-stem voices are automatically placed below the staff.

Glyph playing techniques are center-aligned on noteheads. Text playing techniques are left-
aligned with noteheads.

Placement of playing techniques with two voices on the same staff

You can move playing techniques to different rhythmic positions in Write mode. They are 
positioned by default according to your settings in Engraving Options.

You can move playing techniques graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

In Engrave mode, each playing technique continuation line has two square handles, one at the 
start and one at the end. You can move these handles to adjust the graphical position, length, 
and angle of playing technique continuation lines.

If playing technique continuation lines cross system and frame breaks, you can move the line 
segments on each side of the break independently.

Moving playing techniques with continuation lines moves them both together, including any 
adjacent playing techniques and continuation lines in the same group. Moving continuation 
lines or continuation line handles moves the continuation lines independently of the playing 
technique.

You can change the default positions of all playing techniques project-wide on the Playing 
Techniques page in Engraving Options.

RELATED LINKS
Playing techniques on page 1387
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Text pedal line signs on page 1383
Project-wide engraving options for playing techniques on page 1388
Engraving Options dialog on page 840
Playing technique continuation lines on page 1393
Playing technique continuation line components on page 1395
Groups of playing techniques on page 1399

Playing techniques
Positions of playing techniques 
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Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Changing the staff-relative placement of items on page 441

Changing the vertical order of playing techniques
You can change the vertical order of playing techniques when multiple playing techniques exist 
at the same rhythmic position. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains. By default, glyph playing techniques are placed closer to the staff 
than text playing techniques, and playing techniques without lines are placed closer to the staff 
than playing techniques with lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the playing techniques whose vertical order you want to change.

2. In the Properties panel, activate Tucking index in the Playing Techniques group.

3. Change the value in the value field.

RESULT
The order of the selected playing techniques relative to any other playing techniques at the same 
rhythmic position, or along their duration, is changed. This also affects other playing techniques 
in the same groups. Playing techniques with higher Tucking index values are placed further 
from the staff, while playing techniques with lower values are placed closer.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Tucking index properties on page 1083

Playing technique continuation lines
Playing technique continuation lines convey exactly the notes to which playing techniques apply, 
and can also indicate a gradual transition between playing techniques.

A phrase with multiple playing technique continuation lines

In Dorico Pro, there are the following types of playing technique continuation lines:

Playing techniques
Playing technique continuation lines 
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Duration line

Indicates a specific duration to which the playing technique applies. The duration line 
for most playing techniques is a solid line with a hook cap at the end.

Playing techniques show duration lines when the following conditions are met:

● The playing technique has duration.

● The continuation type for the playing technique is set to show lines.

● The playing technique is ungrouped or is the final playing technique in a group.

Transition line

Indicates that the playing technique at the start must gradually turn into the playing 
technique at the end over the duration specified by the line. The transition line for 
most playing techniques is a solid line with an arrow cap at the end.

Transition lines are automatically shown between playing techniques in groups.

You can change the continuation type and specify the default duration line and transition line 
types for each playing technique in the Edit Playing Techniques dialog.

NOTE

Playing technique continuation lines do not affect playback. The sounds produced in playback 
rely on the playback technique associated with the playing technique, the expression map 
settings, and the sound libraries loaded in the project.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Positions of playing techniques on page 1392
Groups of playing techniques on page 1399
Playing technique continuation line components on page 1395
Edit Playing Techniques dialog on page 877
Lengthening/Shortening items on page 436
Custom playing techniques on page 876
Creating custom playing techniques on page 882
Moving items graphically on page 609
Lines on page 1402
Line components on page 1404

Playing technique duration
In Dorico Pro, playing techniques have an explicit duration when they apply to a specific range, 
rather than from a single rhythmic position onwards. Playing techniques with duration only 
affect playback within their duration and can show continuation lines.

In Write mode, playing techniques with duration have start and end handles that show their 
duration.

Playing techniques
Playing technique continuation lines 
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Start and end handles on a playing technique with duration

You can give duration to any playing technique in any of the following ways:

● Group playing techniques together

● Input playing techniques with an open end during note input and extend them

● Add playing techniques to a range of notes

● Lengthen playing techniques

String indicator (selected) with no duration String indicator (selected) with duration and duration 
line

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Lengthening/Shortening items on page 436
Hiding/Showing playing technique duration lines on page 1396
Grouping playing techniques together on page 1400
Vibrato bar techniques on page 1339
String indicators on page 1183

Playing technique continuation line components
In Dorico Pro, playing technique continuation lines consist of multiple components that together 
function as a single item. The duration line and transition line for the same playing technique can 
have different default components.

Playing techniques
Playing technique continuation lines 
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1 Playing technique

Controls the default appearance of the following line.

2 Start cap

Symbol shown at the start of playing technique continuation lines.

3 Line body

Horizontal line, pattern, or wedge that makes up the main part of a playing technique 
continuation line and extends across its entire length.

4 Continuation end cap

Symbol shown at the end of segments of playing technique continuation lines that continue 
across multiple systems.

5 Playing technique continuation sign

Parenthesized reminder of the current playing technique shown at the start of subsequent 
segments of playing technique continuation lines that continue across multiple systems. You 
cannot hide playing technique continuation signs independently of the playing technique.

6 Continuation cap

Symbol shown at the start of subsequent segments of playing technique continuation lines 
that continue across multiple systems.

7 End cap

Symbol shown at the end of playing technique continuation lines.

RELATED LINKS
Changing the style of playing technique continuation lines on page 1397
Changing the caps of playing technique continuation lines on page 1398
Custom playing techniques on page 876
Lines on page 1402

Hiding/Showing playing technique duration lines
You can hide/show duration lines for individual playing techniques. When hiding duration lines, 
you can show nothing or sim.. When showing duration lines, you can show a line or repeat the 
signs of glyph playing techniques. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

NOTE

These steps only apply to playing technique duration lines. They do not apply to playing 
technique transition lines. Instead, you can change the style of transition lines.

PREREQUISITE

● The playing techniques whose duration lines you want to hide/show have duration.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Write mode, select the playing techniques whose duration lines you want to hide/show.

2. In the Properties panel, activate Continuation type in the Playing Techniques group.

3. Select one of the following options from the menu:

Playing techniques
Playing technique continuation lines 
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● None

● sim.

● Line

● Repeat the signs (glyph playing techniques only)

RESULT
Duration lines are hidden after the selected playing techniques when you select None. When 
you select sim., duration lines are hidden and sim. is shown once after each selected playing 
technique.

Duration lines are shown after the selected playing techniques when you select Line.

For glyph playing techniques, the playing technique is repeated for each note within the duration 
automatically when you select Repeat the signs.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can change the default continuation type for each playing technique in the Edit Playing 
Techniques dialog.

EXAMPLE

Duration line shown Duration line hidden Duration line hidden but 
sim. shown

Signs repeated on each 
note

AFTER COMPLETING THIS TASK
You can change the style of the duration lines.

RELATED LINKS
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the style of playing technique continuation lines
You can change the style of individual playing technique duration lines and transition lines; for 
example, if you want to show a single duration line as a wiggly line. You can change the whole 
line style, including the caps, or only the body style, which does not affect the caps.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

Playing techniques
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PROCEDURE

1. In Engrave mode, select the playing technique continuation lines whose style you want to 
change.

2. In the Properties panel, activate one of the following properties in the Playing Techniques 
group:

● To change the whole line style, including caps, activate Line style.

● To change only the body style, excluding caps, activate Line body style.

3. Select the style you want from the menu.

RESULT
The corresponding style of the selected playing technique continuation lines is changed.

TIP

You can change the default duration line and transition line types for each playing technique in 
the Edit Playing Techniques dialog. However, this only changes the whole line style.

AFTER COMPLETING THIS TASK
You can change the caps of individual playing technique continuation lines.

RELATED LINKS
Engrave toolbox on page 514
Edit Playing Techniques dialog on page 877
Playing technique continuation line components on page 1395
Changing the body style of lines on page 1413

Changing the caps of playing technique continuation lines
You can change the caps of individual playing technique continuation lines independently of 
their line body styles. You can also change the caps of individual segments of playing technique 
continuation lines that continue across multiple systems.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the playing technique continuation lines whose caps you want to 
change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Playing Techniques group:

● To change the cap at the start of the selected lines, activate Start cap.

● To change the cap at the end of the selected lines, activate End cap.

● To change the cap at the start of segments of the selected lines on subsequent systems, 
activate Continuation cap.

● To change the cap at the end of segments of the selected lines on subsequent systems, 
activate Continuation end cap.

Playing techniques
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3. Select the style you want from each menu.

RESULT
The corresponding caps of the selected playing technique continuation lines are changed.

TIP

You can change the default caps for the duration and transition lines for each playing technique 
in the Edit Playing Techniques dialog.

AFTER COMPLETING THIS TASK
You can change the style of individual playing technique continuation lines.

RELATED LINKS
Changing the caps of lines on page 1414

Groups of playing techniques
Groups of playing techniques are automatically aligned in a row and can be moved and edited 
as a group. When you move individual playing techniques within a group, the lengths of any 
continuation lines on either side automatically adjust to compensate.

A group of playing techniques The same group of playing techniques with adjusted 
transition lines after the middle playing technique 
moved rhythmically

Two or more playing techniques are automatically grouped together if they are adjoining with 
duration between them and were added to existing music together or input in sequence during 
note input.

Transition lines are automatically shown between playing techniques in groups. The final playing 
technique in playing technique groups can show a duration line if it has duration.

All of the playing techniques in a group are highlighted when any of the playing techniques in 
the group are selected.

In Engrave mode, you can move each playing technique and continuation line within a group 
individually. Playing techniques in groups are attached to continuation lines, meaning that if you 
move a playing technique, any adjacent continuation lines automatically move with it. Groups of 
playing techniques have a handle at the start of the group, which controls the vertical position of 
the whole group.

Playing techniques
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NOTE

● You cannot group a playing technique group to another playing technique group, you can 
only group single playing techniques together or single playing techniques to an existing 
group.

● Groups of playing techniques apply project-wide, meaning you cannot have playing 
techniques grouped one way in some layouts but differently in other layouts. However, you 
can move playing techniques graphically in each layout independently and independently of 
their groups.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Playing technique continuation lines on page 1393
Playing technique duration on page 1394
Lengthening/Shortening items on page 436
Moving notes/items rhythmically on page 465
Moving items graphically on page 609

Grouping playing techniques together
You can manually group playing techniques together that were not automatically grouped when 
they were input. Grouped playing techniques are automatically aligned in a row, show transition 
lines between them, and can be moved and edited as a group.

NOTE

You cannot group a playing technique group to another playing technique group, you can only 
group single playing techniques together or single playing techniques to an existing group.

If you want to group a playing technique group to another playing technique group, you must 
first ungroup them.

PROCEDURE

1. In Write mode, select the playing techniques you want to group together.

2. Choose Edit > Notations > Playing Techniques > Group Playing Techniques. You can also 
choose this option from the context menu.

RESULT
The selected playing techniques are grouped together. Their durations are extended to reach the 
next playing technique in the group, and transition lines are shown between playing techniques 
in the group. Each transition line in the group uses the appropriate line type defined for the 
playing technique at the start of the line in the Edit Playing Techniques dialog.

RELATED LINKS
Edit Playing Techniques dialog on page 877
Playing technique continuation lines on page 1393

Playing techniques
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Ungrouping playing techniques and removing playing techniques 
from groups

You can ungroup playing techniques so that all playing techniques in the group become 
ungrouped. You can also remove only selected playing techniques from groups while leaving 
other playing techniques in the group.

This applies to all layouts in which the playing techniques appear.

PROCEDURE

1. In Write mode, select the playing techniques you want to ungroup or remove from groups.

2. Do one of the following:

● To ungroup all playing techniques in the selected groups, choose Edit > Notations > 
Playing Techniques > Ungroup Playing Techniques.

● To remove only the selected playing techniques from their groups, choose Edit > 
Notations > Playing Techniques > Remove Playing Technique from Group.

TIP

You can also choose these options from the context menu.

RESULT
The selected playing techniques or all playing techniques are removed from the selected groups. 
Playing techniques that previously had transition lines now appear with duration lines, as defined 
for the playing technique in the Edit Playing Techniques dialog.

Playing techniques
Groups of playing techniques 

1401
Dorico Pro 4.3.30



Lines

Lines can convey a variety of meanings in music, such as indicating which hand to use in piano 
music or a gradual change in bow pressure. In Dorico Pro, lines can be vertical, horizontal, or 
angled between notes and have different styles and appearances.

A phrase containing horizontal and vertical lines that convey a range of meanings

NOTE

Due to their generic designs, such as a dashed line with arrow end cap, lines in Dorico Pro have 
no definitive musical meaning and function primarily graphically, meaning they do not affect 
playback. Dorico Pro includes dedicated features for specific notations that affect playback if 
applicable, such as dynamics, arpeggios, glissandi, and trills.

The following types of lines are available in Dorico Pro:

Horizontal lines
Horizontal lines span a specified duration; that is, they start at one rhythmic position 
and end at a later rhythmic position. They might indicate a change over time, such 
as a wedge that represents bow pressure, or suggest a link between notes, such as a 
bracket spanning the theme in a fugue or a straight line between notes showing where 
a melody moves to a different staff.

By default, horizontal lines only apply to single staves. However, there are certain 
situations where you require a horizontal line to appear in all part layouts but only 
at system object positions in the full score layout. You can input horizontal lines that 
apply to all staves or only apply to single staves in Dorico Pro.

Attachment types control the positions of horizontal lines and certain aspects of their 
functionality. Horizontal lines can have different attachment types at their start and 
end.

NOTE

You cannot change the attachment type of horizontal lines after they have been input.

In Dorico Pro, each end of horizontal lines can have the following attachment types:

● Notehead-attached

Attached to an individual note independently of its rhythmic position, meaning 
that the ends of notehead-attached lines move with notes if you change their 
pitch or move them rhythmically. Notehead-attached lines can be both angled 
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or horizontal, as their end positions and resulting angles are determined by the 
interval between the start and end notes.

A phrase containing two notehead-attached lines, showing where the melody moves 
between piano staves

● Barline-attached

Attached to a rhythmic position and aligned with barlines, if their rhythmic 
positions coincide with barline positions. Barline-attached lines are always 
horizontal.

A barline-attached line spanning two full bars

● Rhythmic position-attached

Attached to a rhythmic position and positioned relative to notes, chords, or rests at 
those rhythmic positions.

Rhythmic position-attached lines are horizontal and placed above the staff by 
default. Their endpoints start to the left and end to the right of notes, chords, 
or rests at the corresponding rhythmic positions.

A rhythmic position-attached line spanning two full bars

Vertical lines
Vertical lines exist at a single rhythmic position and are positioned relative to notes or 
chords at that position. They might convey details about a specific moment, such as 
indicating which hand to use for specific notes in piano music.

Vertical lines indicating which notes to play with the right hand

Lines
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RELATED LINKS
Input methods for lines on page 384
Lines panel on page 385
Custom lines on page 884
Adding text to lines on page 1415
Changing the placement of horizontal lines on page 1408
Arpeggio signs on page 1310
Glissando lines on page 1317
Jazz articulations on page 1348
Octave lines on page 1079
Trills on page 1295
Playing technique continuation lines on page 1393
Pedal lines on page 1367
Repeat endings on page 1440
Guitar bends on page 1323
Tuplet brackets on page 1674

Line components
In Dorico Pro, lines consist of multiple components that together function as a single item.

1 Start cap

Symbol shown at the start of lines. Caps can be arrowheads, hooks, terminal lines, music 
symbols, or text.

2 Line body

Horizontal or vertical line, repeating symbols, dash/dot pattern, or wedge that makes up the 
main part of a line and extends across its entire length or height.

3 Annotation

Text or music symbol shown in addition to caps. Annotations can appear centered in the 
middle of each line segment, only at the start or end of lines, or as repeating symbols/
hyphenated text spread across the duration of lines. On vertical lines, text reads upwards by 
default.

4 Continuation end cap

Symbol shown at the end of segments of lines that continue across multiple systems. Caps 
can be arrowheads, hooks, terminal lines, music symbols, or text.

5 Continuation cap

Lines
Line components 
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Symbol shown at the start of subsequent segments of lines that continue across multiple 
systems. Caps can be arrowheads, hooks, terminal lines, music symbols, or text.

6 End cap

Symbol shown at the end of lines. Caps can be arrowheads, hooks, terminal lines, music 
symbols, or text.

RELATED LINKS
Input methods for lines on page 384
Custom lines on page 884
Changing the body style of lines on page 1413
Changing the caps of lines on page 1414
Adding text to lines on page 1415
Changing the position of text relative to horizontal lines on page 1417
Changing the position of text relative to vertical lines on page 1418
Playing technique continuation lines on page 1393
Edit Lines dialog on page 888
Edit Line Bodies dialog on page 891
Edit Line Annotations dialog on page 894
Edit Repeatable Symbols dialog on page 899

Project-wide engraving options for lines
You can find options for the default gaps at the start and end of horizontal lines, and between 
horizontal lines and other items, on the Lines page in Engraving Options.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840
Length of lines on page 1410

Positions of lines
The position of lines relative to notes and staves depends on the line type and, for horizontal 
lines, their attachment type.

Notehead-attached horizontal lines
Notehead-attached lines are positioned in relation to the corresponding noteheads; 
that is, starting to the right of the start note and ending to the left of the end note. 
They automatically follow the notes at each end, meaning if you change the pitch 
of either note or move them rhythmically, the line end positions move accordingly. 
Because their positions depend on the pitches of notes, they can appear both inside 
and outside the staff. If they are only attached to noteheads at one end, they remain 
horizontal but follow the staff position of the note to which they are attached.

Barline-attached horizontal lines
Barline-attached horizontal lines are placed above the staff by default. Their endpoints 
align with barlines if their duration coincides with barline positions. If their endpoints 
do not coincide with barlines, they are positioned like rhythmic position-attached lines.

Lines
Project-wide engraving options for lines 
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Rhythmic position-attached horizontal lines
Rhythmic position-attached lines are placed above the staff by default. Their endpoints 
start to the left and end to the right of notes, chords, or rests at the corresponding 
rhythmic positions.

Vertical lines
Vertical lines are positioned to the left of the notes to which they apply, including 
any applicable accidentals, but are positioned between grace notes and normal notes. 
If multiple vertical lines exist at the same rhythmic position, the most recent line is 
positioned furthest to the right; that is, directly to the left of notes or chords.

You can change the position/placement of lines in a variety of ways, such as showing vertical 
lines on the right of notes or changing the placement of horizontal lines to show them inside the 
staff.

RELATED LINKS
Changing the horizontal order of vertical lines on page 1407
Showing vertical lines before grace notes on page 1407
Changing the placement of horizontal lines on page 1408
Moving items graphically on page 609
Custom lines on page 884
Input methods for lines on page 384

Showing vertical lines on the right/left of notes
You can change the side of notes on which vertical lines appear; for example, to show selected 
vertical lines on the right side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vertical lines whose horizontal position you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Side in the Vertical Lines group.

3. Choose one of the following options:

● Left

● Right

RESULT
The selected lines appear on the corresponding side of notes.

Lines
Positions of lines 
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EXAMPLE

Vertical line on the left of notes Vertical line on the right of notes

AFTER COMPLETING THIS TASK
You can change the order of vertical lines when multiple vertical lines exist at the same rhythmic 
position and on the same side of notes.

Changing the horizontal order of vertical lines
You can change the horizontal order of vertical lines when multiple vertical lines exist at the 
same rhythmic position and on the same side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vertical lines whose order you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Column in the Vertical Lines group.

3. Change the value in the value field.

RESULT
The order of the selected vertical lines relative to any other vertical lines at the same rhythmic 
positions is changed. Lines with higher Column values are placed further to the left, while lines 
with lower values are placed further to the right.

Showing vertical lines before grace notes
You can position individual vertical lines so they appear to the left of grace notes. By default, 
vertical lines are positioned after grace notes; that is, between grace notes and normal notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the vertical lines you want to show before grace notes. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Line before grace notes in the Vertical Lines group.

RESULT
The selected vertical lines are positioned before grace notes.

Deactivating Line before grace notes shows the selected vertical lines after grace notes again.

EXAMPLE

Vertical line after grace notes Vertical line before grace notes

Changing the placement of horizontal lines
You can show individual horizontal lines above, below, or inside the staff. By default, horizontal 
lines are placed above the staff.

NOTE

These steps only apply to barline-/rhythmic position-attached horizontal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the horizontal lines whose placement you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Placement in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Above

● Below

● Inside staff

Lines
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RESULT
The placement of the selected horizontal lines is changed. Horizontal lines inside the staff are 
centered on the middle staff line by default.

TIP

You can also cycle through the different placement options for selected horizontal lines by 
pressing F .

AFTER COMPLETING THIS TASK

● You can change the staff position of lines shown inside the staff.

● You can erase the background of text on lines shown inside the staff.

RELATED LINKS
Engrave toolbox on page 514
Moving items graphically on page 609
Changing the staff-relative placement of items on page 441

Changing the staff position of horizontal lines inside the staff
You can change the staff position of horizontal lines shown inside the staff, including changing 
the staff position of the start/end of lines independently of each other; for example, if you want 
lines to appear angled.

PREREQUISITE

● The horizontal lines whose staff position you want to change are placed inside the staff and 
have at least one barline-/rhythmic position-attached end.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the horizontal lines placed inside the staff whose staff position you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Horizontal Lines group:

● Start position

● End position

3. Change the values in the value fields.

RESULT
The staff positions of the corresponding ends of the selected lines are changed according to the 
new values. For example, 0 is the middle line of the staff, 4 is the top line of the staff, and -4 is the 
bottom line of the staff.

Lines
Positions of lines 

1409
Dorico Pro 4.3.30



EXAMPLE

Horizontal lines inside the staff with different staff positions at their start/end

Length of lines
Dorico Pro automatically calculates the appropriate length for both horizontal and vertical lines.

● The length of horizontal lines is determined by the rhythmic duration of the line. Horizontal 
lines with different attachment types are positioned differently, which can affect their 
graphical length. For example, barline-attached lines can appear longer than rhythmic 
position-attached lines with the same duration.

● The length of vertical lines is determined by the pitch range of notes in the voices/staves to 
which the line applies. Dorico Pro automatically adjusts the length of vertical lines if pitches 
change or you add notes to, or delete notes from, chords.

You can lengthen/shorten both horizontal and vertical lines; for example, if you want an 
individual vertical line to extend above the top note in a chord.

You can change the default gaps at the start and end of horizontal lines, and between horizontal 
lines and other items, on the Lines page in Engraving Options.

Lengthening/Shortening horizontal lines
You can lengthen/shorten horizontal lines rhythmically after they have been input.

NOTE

These steps only apply to barline-/rhythmic position-attached horizontal lines. You cannot 
lengthen/shorten notehead-attached horizontal lines, except by lengthening/shortening the 
notes to which they are attached.

PROCEDURE

1. In Write mode, select the horizontal lines you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one line at a time.

2. Lengthen/Shorten the lines in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

Lines
Length of lines 

1410
Dorico Pro 4.3.30



● To snap the end of a single line to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Right Arrow .

● To snap the end of a single line to the previous notehead, press Ctrl/Cmd-Shift-Alt/
Opt-Left Arrow .

NOTE

● When multiple lines are selected, you can only lengthen/shorten them according to 
the current rhythmic grid resolution.

● When using the keyboard, lengthening/shortening lines only moves their end. You 
can move the start of lines by moving lines rhythmically, or by clicking and dragging 
the start handle of a single line.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
Single lines are lengthened/shortened according to the current rhythmic grid resolution or to the 
next/previous notehead, whichever is closer.

Multiple lines are lengthened/shortened according to the current rhythmic grid resolution.

TIP

You can move lines graphically in Engrave mode, including changing their graphical length.

RELATED LINKS
Inputting horizontal lines on page 385
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Rhythmic grid on page 214

Lengthening/Shortening vertical lines
You can lengthen/shorten individual vertical lines to different staff positions. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains. By default, vertical 
lines automatically span the pitch range of notes in the voices to which they apply.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the vertical lines you want to lengthen/shorten. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Vertical Lines group:

● Top position

● Bottom position
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3. Change the values in the value fields.

RESULT
The vertical length of the selected lines is changed. Increasing the values moves the 
corresponding end up by staff positions, decreasing the values moves the corresponding end 
down by staff positions. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

TIP

You can move lines graphically in Engrave mode, including changing their graphical length.

RELATED LINKS
Moving items graphically on page 609
Inputting vertical lines on page 387
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the start/end positions of horizontal lines
By default, rhythmic position-attached horizontal lines start before notes/accidentals and end 
immediately after the last note, chord, or rest at their end rhythmic position. You can change the 
start and end positions of individual rhythmic position-attached horizontal lines independently; 
for example, if you want them to start before noteheads rather than accidentals and end 
immediately before the following note, chord, or rest.

NOTE

These steps only apply to rhythmic position-attached horizontal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rhythmic position-attached horizontal lines whose start and/or end position you 
want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Horizontal start position in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Notehead

● Notehead center

● Accidental

4. Activate Horizontal end position in the Horizontal Lines group.

5. Select one of the following options from the menu:

● End at right-hand side of final note

● End on center of final note

Lines
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● End immediately before following note

RESULT
The start and/or end position of the selected rhythmic position-attached horizontal lines is 
changed.

EXAMPLE

Horizontal line starting before the 
notehead

Horizontal line starting centered 
on the notehead

Horizontal line starting before the 
accidental

Horizontal line ending after final 
note

Horizontal line ending centered on 
the final notehead

Horizontal line ending before 
following note

Changing the body style of lines
You can change the body style of individual lines without changing their caps.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose body style you want to change. You can do this in Write mode and 
Engrave mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Line body style in either the Horizontal Lines or Vertical 
Lines group.

3. Select the style you want from the menu.

RESULT
The body style of the selected lines is changed.

NOTE

● This does not affect the caps of the selected lines.

Lines
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● You can also create custom lines with the line bodies, caps, and annotations you want by 
default.

RELATED LINKS
Line components on page 1404
Custom lines on page 884
Lines panel on page 385
Input methods for lines on page 384
Engrave toolbox on page 514

Changing the caps of lines
You can change the caps of individual lines without changing their body style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose caps you want to change. You can do this in Write mode and Engrave 
mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate the following properties, individually or together, in either 
the Horizontal Lines or Vertical Lines group:

● To change the cap at the start/bottom of the selected lines, activate Start cap.

● To change the cap at the end/top of the selected lines, activate End cap.

● To change the segment start cap of the selected horizontal lines on subsequent systems, 
activate Continuation cap.

● To change the segment end cap of the selected horizontal lines on previous systems to 
where the lines end, activate Continuation end cap.

3. Select the style you want from each menu.

RESULT
The corresponding caps of the selected lines are changed.

NOTE

● This does not affect the body style of the selected lines.

● You can also create custom lines with the line bodies, caps, and annotations you want by 
default.
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Changing the direction of lines
You can change the direction of both horizontal and vertical lines; for example, to make a 
horizontal line with an arrow end cap point to the left, or to make a vertical line with text appear 
upside-down with its text reading downwards.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose direction you want to change. You can do this in Write mode and 
Engrave mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Reverse in either the Horizontal Lines or Vertical Lines 
group.

RESULT
The direction of the selected lines is change. Text on vertical lines now reads downwards.

Deactivating Reverse returns the selected lines to their default direction.

EXAMPLE

Horizontal and vertical lines with default directions Reversed horizontal and vertical lines

Adding text to lines
You can add text to both horizontal and vertical lines; for example, to clarify the intention of the 
line.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the lines to which you want to add text. You can do this in Write mode and Engrave 
mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Text in either the Horizontal Lines or Vertical Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered into the value field is shown centered in the middle of the selected lines. On 
vertical lines, it reads upwards.

TIP

You can also create custom lines with the line bodies, caps, and annotations you want by default, 
including changing where annotations appear.

EXAMPLE

Text on a horizontal line

Text on a vertical line

AFTER COMPLETING THIS TASK

● If you want text on vertical lines to read downwards, you can reverse the lines.

● You can erase the backgrounds of text on lines.

RELATED LINKS
Engrave toolbox on page 514
Line components on page 1404
Custom lines on page 884
Input methods for lines on page 384

Lines
Adding text to lines 

1416
Dorico Pro 4.3.30



Line text font styles
There are different font styles for line text according to the line type. You can change different 
aspects of these fonts in the Edit Font Styles dialog, such as changing the font size to make line 
text appear larger.

The following font styles are used for line text:

● Horizontal Line Font: Used for text on horizontal lines.

● Vertical Line Font: Used for text on vertical lines.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 846
Changing the default font family on page 853

Changing the position of text relative to horizontal lines
You can change the position of text relative to horizontal lines individually; for example, to show 
text above horizontal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the horizontal lines whose text position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Text position in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Above

● Centered

● Below

● Inside

● Outside

RESULT
The position of text relative to the selected horizontal lines is changed. When annotations are 
positioned Inside or Outside, their position relative to the line changes according to the staff-
relative placement of the line.

TIP

You can change the default position of text relative to lines in the Edit Lines dialog.

Lines
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EXAMPLE

Text Above Text Centered Text Below

RELATED LINKS
Engrave toolbox on page 514
Changing the placement of text relative to lines on page 1419
Creating custom playing techniques on page 882
Edit Lines dialog on page 888

Changing the position of text relative to vertical lines
You can change the position of text relative to vertical lines individually; for example, to show text 
on the left of vertical lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vertical lines whose text position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Text position in the Vertical Lines group.

3. Select one of the following options from the menu:

● Left

● Centered

● Right

RESULT
The position of text relative to the selected vertical lines is changed.

TIP

You can change the default position of text relative to lines in the Edit Lines dialog.

Lines
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EXAMPLE

Text Left Text Centered Text Right

Changing the placement of text relative to lines
You can change the placement of text relative to lines individually; for example, to show text at 
the start of horizontal lines or the top of vertical lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose text placement you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Text placement in either the Horizontal Lines or Vertical 
Lines group.

3. Select one of the following options from the menu:

● Start

● Center

● End

4. Optional: If you chose Start or End and want to change the offset from the corresponding 
end of the line, activate Start/end gap in either the Horizontal Lines or Vertical Lines 
group and change the value in the value field.

RESULT
The placement of text relative to the selected lines is changed. For vertical lines, Start places text 
at the bottom of the line, End places text at the top.

If you also activated Start/end gap, the gap between text on the selected lines and the 
corresponding end is changed.
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TIP

You can change the default placement of text relative to lines in the Edit Lines dialog, including 
showing text repeated or hyphenated across the duration of lines.

RELATED LINKS
Engrave toolbox on page 514
Changing the direction of lines on page 1415
Custom lines on page 884
Edit Lines dialog on page 888

Forcing line text to be horizontal
You can force the text of individual lines always to appear horizontal; for example, to make text 
on vertical lines easier to read.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose text you want to keep horizontal. You can do this in Write mode and 
Engrave mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Keep text horizontal in either the Horizontal Lines or 
Vertical Lines group.

RESULT
Text on the selected lines always appears horizontal, even if the line is angled or vertical.

TIP

You can force text to be horizontal by default for each line independently in the Edit Lines dialog.

Adding borders to line text
You can add borders to text shown on individual lines and change the border thickness; for 
example, if you want to make the boundary of the text relative to the line clear. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. In Engrave mode, select the lines whose text you want to add borders to.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Border thickness in either the Horizontal Lines or Vertical 
Lines group.

3. Change the value in the value field.

RESULT
Borders with the corresponding thickness are added to text on the selected lines. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can add borders to text annotations by default in the Edit Line Annotations dialog.

RELATED LINKS
Custom lines on page 884
Edit Line Annotations dialog on page 894
Changing the placement of text relative to lines on page 1419
Adding borders to text items on page 1614
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Erasing the background of line text
You can erase the background of text shown on individual lines; for example, to ensure they 
remain legible if they appear inside the staff. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the lines whose text backgrounds you want to erase.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Erase background in either the Horizontal Lines or 
Vertical Lines group.
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RESULT
The backgrounds of text on the selected lines are erased. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns text on the selected lines to the default non-erased 
background.

EXAMPLE

Line text with non-erased background Line text with erased background

Changing the erasure padding of line text
You can change the erasure padding of text on individual lines, including changing the padding 
between line text and each edge of their erased areas independently. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the lines whose text erasure padding you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
either the Horizontal Lines or Vertical Lines group.

● L changes the padding between line text and their left edge.

● R changes the padding between line text and their right edge.

● T changes the padding between line text and their top edge.

● B changes the padding between line text and their bottom edge.

3. Change the values in the value fields.

Lines
Adding text to lines 

1422
Dorico Pro 4.3.30



RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Lines in Engrave mode
In Engrave mode, each line has two square handles, one at the start and one at the end of 
horizontal lines, and one at the top and one at the bottom of vertical lines. You can move these 
handles to adjust the graphical position, length, and angle of lines.

You can also move whole individual lines graphically. If horizontal lines cross system and frame 
breaks, you can move the line segments on each side of the break independently.

Handles on a vertical line and horizontal line in Engrave mode

RELATED LINKS
Line components on page 1404
Custom lines on page 884
Positions of lines on page 1405
Lengthening/Shortening horizontal lines on page 1410
Lengthening/Shortening vertical lines on page 1411
Showing vertical lines on the right/left of notes on page 1406
Changing the horizontal order of vertical lines on page 1407
Changing the placement of horizontal lines on page 1408
Changing the staff position of horizontal lines inside the staff on page 1409
Moving items graphically on page 609
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Rehearsal marks

Rehearsal marks are ordered sequences of letters or numbers that provide useful reference 
points, such as indicating significant changes in the music. They allow performers to co-ordinate 
easily in rehearsals and make the chronological sequence of the music clear.

In Dorico Pro, rehearsal marks follow an automatic sequence where each rehearsal mark has a 
unique index, ensuring there are never duplicate rehearsal marks.

A rehearsal mark, showing the letter G

By default, rehearsal marks in Dorico Pro appear as letters, but you can change the sequence 
type to show letters, numbers, or bar numbers. You can use all three available rehearsal mark 
sequences simultaneously.

In order to ensure they are easily noticeable, and cannot be confused with bar numbers when 
using numbers for rehearsal marks, rehearsal marks are shown in a rectangular enclosure. You 
can change the shape and size of all rehearsal mark enclosures project-wide.

In Dorico Pro, rehearsal marks are categorized as system objects. Therefore, rehearsal marks 
follow your per-layout settings for the visibility and positioning of system objects.

RELATED LINKS
Inputting rehearsal marks on page 401
Changing the index of rehearsal marks on page 1426
Changing the rehearsal mark sequence type on page 1427
Changing the rehearsal mark enclosure type on page 1425
Going to rehearsal marks on page 447
Layout Options dialog on page 834
System objects on page 1563
Changing the positions of system objects on page 1564
Tempo marks on page 1587
Bar numbers on page 981

Project-wide engraving options for rehearsal marks
You can find options for the project-wide appearance and position of rehearsal marks on the 
Rehearsal Marks page in Engraving Options.

For example, you can change the sequence type of rehearsal marks, whether they are shown in 
enclosures, and their default positions relative to barlines, the start of systems, and other items. 
You can also change the line thickness, size, and padding values for rehearsal mark enclosures.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.
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RELATED LINKS
Engraving Options dialog on page 840

Changing the rehearsal mark enclosure type
Rehearsal marks are usually shown in an enclosure, which can be a rectangle, rounded rectangle 
or a circle. You can change the enclosure type of all rehearsal marks project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Rehearsal Marks.

3. In the Enclosure section, choose one of the following options for Enclosure type:

● Rectangle

● Rounded rectangle

● Circle

● No enclosure

4. Click Apply, then Close.

RESULT
The enclosure type of all rehearsal marks project-wide is changed. The size and shape of 
enclosures depends on their padding values and the rehearsal mark font size.

TIP

You can change the line thickness, size, and padding values for all rehearsal mark enclosures 
project-wide on the Rehearsal Marks page in Engraving Options.

EXAMPLE

Rehearsal mark with a 
rectangle enclosure

Rehearsal mark with 
a rounded rectangle 
enclosure

Rehearsal mark with a 
circle enclosure

Rehearsal mark with no 
enclosure

RELATED LINKS
Inputting rehearsal marks on page 401
Editing the rehearsal mark paragraph style on page 1429

Positions of rehearsal marks
Rehearsal marks are placed outside the music, above the staff, and at the same positions as 
other system objects so they can be seen easily.

By default, rehearsal marks are positioned above barlines and to the right of clefs or key 
signatures at the start of systems. Although you can input rehearsal marks at rhythmic positions 
within a bar in Dorico Pro, this is not common practice.

Rehearsal marks
Changing the rehearsal mark enclosure type 
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When rehearsal marks coincide with tempo changes, Dorico Pro automatically positions tempo 
marks to the right of rehearsal marks. Dorico Pro automatically adjusts staff spacing to ensure 
rehearsal marks are correctly positioned.

You can move rehearsal marks to different rhythmic positions in Write mode. They are positioned 
by default according to your settings in Engraving Options.

The vertical spacing between the top two staves is increased to allow room for the rehearsal mark and the 
tempo marks.

You can move rehearsal marks graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

You can change the default positions of all rehearsal marks project-wide, and set values for the 
minimum distances between rehearsal marks and staves, and rehearsal marks and other items, 
on the Rehearsal Marks page in Engraving Options. For example, you can change the default 
alignment between rehearsal marks and tempo marks to the right or the positions of rehearsal 
marks relative to barlines and the start of systems.

Rehearsal marks are categorized as system objects in Dorico Pro, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently; for example, if you want rehearsal marks to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Inputting rehearsal marks on page 401
Input methods for bars, beats, and barlines on page 302
Project-wide engraving options for rehearsal marks on page 1424
Engraving Options dialog on page 840
Moving items graphically on page 609
Changing the rehearsal mark enclosure type on page 1425
Changing the positions of system objects on page 1564

Changing the index of rehearsal marks
By default, the rehearsal mark sequence resets at the start of each flow. If you want the 
rehearsal mark sequence to continue across flows, for example, to avoid having multiple 
rehearsal marks with the same letter in the same project, you can change the index position 
of individual rehearsal marks.

Changing the index position changes the shown number or letter. For example, index position 1 
appears as rehearsal mark A or 1, position 2 appears as B or 2, and so on.

You can also change the index position of a rehearsal mark to avoid showing a letter that could 
easily be confused with another letter or another number, such as I or O.

Rehearsal marks
Changing the index of rehearsal marks 
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NOTE

These steps do not apply to rehearsal marks using the bar number sequence type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rehearsal mark whose index position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Index in the Rehearsal Marks group.

3. Change the value in the value field.

RESULT
The selected rehearsal mark changes according to the Index value and its sequence type.

Any subsequent rehearsal marks without index changes in the same sequence follow the new 
index automatically. For example, if you changed a rehearsal mark from A to P, the next 
rehearsal mark changes from B to Q.

TIP

You can also change the sequence type of rehearsal marks; for example, if you want rehearsal 
mark C to appear as rehearsal mark 3.

Changing the rehearsal mark sequence type
Rehearsal marks can be letters, numbers, or bar numbers. You can change the sequence type of 
individual rehearsal marks, and create secondary rehearsal mark sequences.

In Dorico Pro, you can use all three available rehearsal mark sequences simultaneously. For 
example, you can have the main sequence of rehearsal marks showing letters, but also have a 
secondary sequence of numbers to mark different moments, perhaps entry points for a solo line, 
and also highlight prominent bar numbers within those sections.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rehearsal mark whose sequence type you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Sequence type in the Rehearsal Marks group.

3. Select one of the following options from the menu:

● Letters

● Numbers

Rehearsal marks
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● Bar numbers

RESULT
The selected rehearsal mark now displays a letter, a number, or the current bar number.

If it is the first rehearsal mark in either the letters sequence or the numbers sequence in the flow, 
it shows either A or 1. If there are already rehearsal marks in either the letters sequence or the 
numbers sequence in the flow, it shows the next letter or number according to the index.

NOTE

● You can change the sequence type used for all rehearsal marks project-wide on the 
Rehearsal Marks page in Engraving Options.

● You can change the index of a rehearsal mark sequence independently of other rehearsal 
mark sequences. However, you cannot change the index of rehearsal marks using the bar 
number sequence type.

RELATED LINKS
Project-wide engraving options for rehearsal marks on page 1424
Inputting rehearsal marks on page 401
Adding bar number changes on page 991
Engrave toolbox on page 514

Adding prefixes/suffixes to rehearsal marks
You can add both prefixes and suffixes to individual rehearsal marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rehearsal marks to which you want to add a prefix or suffix. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Rehearsal Marks group:

● Prefix

● Suffix

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered into the value field is added to the selected rehearsal marks as a prefix or a 
suffix.

Rehearsal marks
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TIP

You can add a custom prefix/suffix to all rehearsal marks project-wide on the Rehearsal Marks 
page in Engraving Options.

Editing the rehearsal mark paragraph style
You can edit the formatting of the paragraph style used for rehearsal marks; for example, if you 
want to change the size of rehearsal marks in full score layouts without affecting their size in part 
layouts.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. In the paragraph styles list, select Rehearsal Marks.

3. Optional: Select one of the available styles from the Parent menu.

If you select a parent style, an activated switch is shown beside all the options that are 
different in the selected paragraph style, compared to its parent style.

4. Activate and change the available options as required.

5. Click OK to save your changes and close the dialog.

RESULT
The formatting of the rehearsal mark paragraph style is changed.

RELATED LINKS
Paragraph Styles dialog on page 848
Project-wide engraving options for rehearsal marks on page 1424

Rehearsal marks
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Markers

Markers are labels locked to a particular position in time, most commonly in relation to a video. 
They typically indicate an important moment that requires musical prominence, and composers 
often use them to help shape the writing process.

Markers on a timecode staff showing custom text and timecodes

By default, markers in Dorico Pro show the default text “Marker” and also include the timecode of 
their fixed position in time.

In Dorico Pro, you can use markers in any project. However, because they are most commonly 
used in conjunction with video, markers are included in the Video panel in Write mode. There is 
also a Markers track in Play mode that displays markers, and allows you to input new ones.

You can use markers to help find suitable tempos for your project, as Dorico Pro can calculate 
possible tempos between important markers so that the markers occur on strong beats in the 
time signature.

You can show markers above/below the start of each system or below the timecode staff, if there 
is one, in each layout independently. You can also hide/show timecodes in markers.

Any markers you input are automatically included when you export MIDI.

RELATED LINKS
Inputting markers/timecodes on page 402
Editing marker text on page 1432
Video panel on page 403
Changing the timecodes of markers on page 1433
Defining markers as important on page 1434
Timecodes on page 1435
Markers track on page 626

Project-wide engraving options for markers
You can find options for the project-wide design, position, and appearance of markers on the 
Markers page in Engraving Options.

For example, you can change whether markers include the timecode of their position, whether 
markers are shown above or below timecodes, the thickness of the enclosure line, and the 
default vertical position of markers.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.
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RELATED LINKS
Engraving Options dialog on page 840

Hiding/Showing markers
By default, markers are shown in full score layouts and hidden in part layouts. You can hide 
and show markers in each layout independently; for example, if markers are helpful for the 
conductor to see but not for the players.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show markers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. Activate/Deactivate Show markers.

5. Click Apply, then Close.

RESULT
Markers are hidden/shown in the selected layouts.

Changing the vertical position of markers
You can show markers above the system, below the system, or on a separate single-line 
timecode staff above a selected bracketed instrument family group, which can make them 
clearer in the score. When markers are shown on a timecode staff, timecodes are also 
automatically shown below the timecode staff.

NOTE

You cannot show multiple timecode staves in a system.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
markers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. In the Markers subsection, choose one of the following options for Vertical position:

● Above system

● Below system

● Timecode staff

Markers
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5. Optional: If you chose Timecode staff, select the bracketed instrument family above which 
you want to show the timecode staff from the Position timecode staff above bracket 
menu.

6. Click Apply, then Close.

RESULT
The vertical position of markers is changed in the selected layouts.

NOTE

● If you show markers on a timecode staff, timecodes are also shown on the staff by default. 
If you only want to show markers on a separate staff and exclude timecodes, you must then 
change Timecode frequency on timecode staff to Never.

You can also change the vertical position of timecodes so they appear above/below the start 
of systems rather than on the timecode staff.

● You can change the default distance between the timecode staff and other staves on the 
Vertical Spacing page in Layout Options.

AFTER COMPLETING THIS TASK

● You can edit the font used for markers and timecodes shown on a timecode staff.

● You can change the frequency of timecodes on the timecode staff.

RELATED LINKS
Inputting markers/timecodes on page 402
Changing the vertical position of timecodes on page 1436
Changing the timecode frequency on page 1438
Hiding/Showing timecodes in markers on page 1437
Layout Options dialog on page 834

Editing marker text
The default text shown in new markers is “Marker”. You can change the text shown in each 
marker individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the markers whose text you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Marker text in the Markers group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected markers is changed. It uses the Marker Text Font font style.

Markers
Editing marker text 
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TIP

You can also enter custom text for markers when inputting them using the Add Marker dialog, 
and change marker text in the Markers section of the Video panel in Write mode.

RELATED LINKS
Add Marker dialog on page 403
Engrave toolbox on page 514

Editing the marker/timecode font styles
You can edit the formatting of the font styles used for all markers and timecodes project-wide; 
for example, if you want markers to appear bold and italic. Markers and timecodes use different 
fonts, meaning you can change them independently of each other.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select one of the following font styles:

● Marker Text Font: Used for markers

● Marker Timecode Font: Used for timecodes shown in markers

● Timecode Font: Used for timecodes shown on a timecode staff

3. Activate the following options, individually or together, to change the corresponding aspect 
of the font:

● Font family

● Size

● Style

● Underlined

4. Optional: If required, repeat steps 2 and 3 to change the other font.

5. Click OK to save your changes and close the dialog.

RESULT
The formatting of the selected font styles is changed project-wide.

RELATED LINKS
Edit Font Styles dialog on page 846

Changing the timecodes of markers
You can change the timecodes of individual markers after they have been input; for example, if 
the video has been edited and the marker now occurs ten seconds later.

NOTE

Because this changes where markers occur in the project, this also moves markers relative to the 
notated music.

Markers
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PROCEDURE

1. In Write mode, select an item in the flow containing the markers whose timecodes you want 
to change.

2. In the Notations toolbox, click Panels , then Video  to show the Video panel.

3. In the Markers section, double-click the timecode you want to change.

4. Enter the new timecode you want into the value field.

5. Press Return .

RESULT
The timecode of the marker is changed. The marker automatically moves relative to the music to 
reflect its new time position.

RELATED LINKS
Video panel on page 403
Changing the initial timecode value on page 1436

Defining markers as important
You can define individual markers as important, which allows them to be considered when 
finding suitable tempos in the Find Tempo dialog.

PROCEDURE

1. In Write mode, click Video in the Notations toolbox to show the Video panel.

2. In the Markers section, activate the checkbox in the Imp. column for each marker you want 
to define as important.

RESULT
Markers with activated checkboxes are defined as important. The Find Tempo button at the 
bottom of the Markers section becomes available.

RELATED LINKS
Find Tempo dialog on page 404

Markers
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Timecodes

Timecodes indicate an exact position in time, usually in the context of a video. They allow precise 
synchronization between multiple elements, such as music and moving images, and can be used 
as a reference tool.

Timecodes are displayed in the format hh:mm:ss:ff, which is two-digit hours, minutes, seconds, 
and frames.

A timecode on a timecode staff

In Dorico Pro, you can specify the type of timecode from the following types:

Non-drop frame timecodes
Each frame is numbered sequentially from the preceding one without skipping any 
frame numbers.

Non-drop frame timecodes are shown with the suffix fps and use a colon separator 
between seconds and frames; for example, 00:00:01:05.

Drop frame timecodes
Some frame numbers are skipped in order to accommodate the difference in frame 
rate between 29.97 fps and 30 fps. In every minute except every tenth minute, two 
timecode numbers are dropped from the frame count.

Drop frame timecodes are shown with the suffix dfps and use a semicolon separator 
between the seconds and frames; for example, 00:00:01;05.

Timecodes in Dorico Pro are flow-specific, meaning you can set timecodes for each flow that are 
completely independent of the timecodes for other flows. You can set timecodes in the Video 
Properties dialog, including for flows without a video.

NOTE

The timecodes shown in flow cards in the Flows panel in Setup mode reflect the timecode at the 
start of the flow, which can be different to the timecode you set in the Video Properties dialog. 
For example, if you set the Timecode start to 02:00:00:00 but also set the Flow attachment 
position to 8 quarter note beats, and the tempo is 60 bpm, the timecode shown in the flow card 
is 01:59:52:00.

By default, timecodes appear in markers. You can show markers above/below the start of each 
system or below the timecode staff, if there is one, in each layout independently. You can also 
hide/show timecodes in markers.

Additionally, you can change the time displayed in the Transport window to be the timecode 
rather than elapsed time, which is shown by default.
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RELATED LINKS
Inputting markers/timecodes on page 402
Frame rates on page 195
Video Properties dialog on page 191
Editing the marker/timecode font styles on page 1433
Changing the timecode frequency on page 1438
Changing the content shown in the transport display on page 651
Markers on page 1430
Hiding/Showing markers on page 1431
Changing the vertical position of markers on page 1431
Changing the vertical position of timecodes on page 1436
Hiding/Showing timecodes in markers on page 1437

Changing the initial timecode value
You can change the timecode at which each flow in your project starts; for example, if you are 
using a separate project for the second reel of a film. You can also change the initial timecode in 
projects without videos.

PROCEDURE

1. In Write mode, select an item in the flow whose initial timecode value you want to change.

2. In the Notations toolbox, click Panels , then Video  to show the Video panel.

3. In the Video panel, click Properties to open the Video Properties dialog.

4. Change the value for Timecode start.

5. Click OK to save your changes and close the dialog.

RESULT
The initial timecode for the flow in which you selected an item is changed.

RELATED LINKS
Video panel on page 403
Changing the start position of videos on page 193
Changing the timecodes of markers on page 1433

Changing the vertical position of timecodes
You can show timecodes either above/below the start of systems or on a separate single-line 
staff in each layout independently. For example, you can show timecodes and markers on a 
separate timecode staff in full score layouts but show only timecodes above the start of systems 
in part layouts.

NOTE

You cannot show timecodes on multiple staves in a system.

PREREQUISITE
If you want to show timecodes on a separate staff, you have changed the vertical position of 
markers so they appear on a separate staff.

Timecodes
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PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
timecodes.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. In the Timecode subsection, choose one of the following options for Show timecode:

● Above or below start of system

● Below timecode staff

5. Optional: If you chose Above or below start of system, choose one of the following options 
for Timecode position relative to system:

● Above system

● Below system

6. Optional: If you chose Above or below start of system and want to change the gap 
between timecodes and the staff, change the values in the Offset at start of system value 
fields.

7. Click Apply, then Close.

RESULT
The vertical position of timecodes is changed in the selected layouts.

NOTE

Your setting for Timecode frequency on timecode staff also applies when timecodes are shown 
above/below the start of systems.

RELATED LINKS
Changing the vertical position of markers on page 1431
Changing the timecode frequency on page 1438

Hiding/Showing timecodes in markers
You can hide/show timecodes within all markers project-wide and show them above/below the 
marker text; for example, to ensure the precise positions of key moments are clearly labeled. This 
is in addition to your per-layout settings for showing timecodes on a separate staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Markers.

3. Choose one of the following options for Timecode in markers:

● Show timecode

● Do not show timecode

Timecodes
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4. Optional: Choose one of the following options for Order of information, if timecode 
shown:

● Text above timecode

● Timecode above text

5. Click Apply, then Close.

RELATED LINKS
Markers on page 1430
Changing the vertical position of timecodes on page 1436
Changing the vertical position of markers on page 1431
Inputting markers/timecodes on page 402
Editing marker text on page 1432

Changing the timecode frequency
You can show timecodes at different intervals in layouts in which timecodes are shown on a 
separate staff. For example, you can show timecodes every bar in full score layouts but only at 
the start of each system in part layouts.

NOTE

We do not recommend that you show timecodes every bar in layouts with multi-bar rests, as 
the result is illegible overlapping timecodes. If you want to show timecodes in part layouts with 
multi-bar rests, we recommend either showing timecodes only at the start of each system or not 
showing multi-bar rests in the layout.

PREREQUISITE
Markers are shown in the selected layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the timecode frequency.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. Optional: If the selected layouts do not show timecodes on a separate staff, choose 
Timecode staff for Vertical position.

5. Choose one of the following options for Timecode frequency on timecode staff:

● Start of system

● Every bar

● Never

6. Click Apply, then Close.

RELATED LINKS
Hiding/Showing markers on page 1431

Timecodes
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Hiding/Showing multi-bar rests on page 1496

Timecodes
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Repeat endings

For music with repeated passages, repeat endings show which bars are played at the end of each 
repetition, with different endings each time if required. They are also known as “volta lines”, or as 
“first and second endings”, but in this documentation, we refer to them as “repeat endings”.

Repeat endings comprise two or more segments, where each segment contains a different 
possible ending. When you input repeat endings, Dorico Pro automatically inputs an end repeat 
barline at the end of the first segment. Segments in repeat endings are clearly marked with solid 
lines above and numbers that indicate the playthroughs in which the segment is used.

A repeat ending with three playthroughs divided across two endings

Dorico Pro allows you to create repeat endings containing any number of segments, and allows 
you to control which segments are used for each playthrough. For example, you might want a 
repeat ending with two segments but four total playthroughs, where the first two playthroughs 
use the first repeat ending segment and the final two playthroughs use the second repeat 
ending segment.

In Dorico Pro, repeat endings are categorized as system objects. Therefore, repeat endings 
follow your per-layout settings for the visibility and positioning of system objects.

RELATED LINKS
Input methods for repeats and tremolos on page 406
Layout Options dialog on page 834
System objects on page 1563
Repeats in playback on page 640
Changing the number of playthroughs at repeat barlines on page 641
Types of barlines on page 968
Lines on page 1402

Project-wide engraving options for repeat endings
You can find options for the project-wide design, position, and appearance of repeat ending 
segments on the Repeat Endings page in Engraving Options.

The options on the Repeat Endings page allow you to change the ends of repeat ending lines, 
the appearance of numbers and hooks, and the default position of repeat endings.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
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Changing the total number of playthroughs in repeat 
endings

By default, each segment in repeat endings is played once, so each segment shows a single 
digit that indicates the playthrough for which it is used. You can increase the total number of 
playthroughs for repeat endings individually so that segments are played more than once.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat endings whose total number of playthroughs you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate No. times played in the Repeat Endings group.

3. Change the value in the value field.

NOTE

You cannot have fewer playthroughs than the number of segments.

RESULT
The total number of playthroughs in the selected repeat endings is changed. Dorico Pro adds 
additional playthroughs to the last closed segment in the repeat ending.

AFTER COMPLETING THIS TASK
Once you have set the total number of playthroughs, you can then change which segment is 
used for each playthrough.

RELATED LINKS
Repeats in playback on page 640
Changing the number of playthroughs at repeat barlines on page 641
Engrave toolbox on page 514
Input methods for repeats and tremolos on page 406

Dividing playthroughs across repeat ending segments
You can control how the total number of playthroughs is divided across the different segments in 
individual repeat endings. For example, if in a repeat ending with six playthroughs, you want to 
include playthroughs 1 to 3 in the first ending and playthroughs 4 to 6 in the second ending.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an individual segment in the repeat ending structure whose 
included playthroughs you want to change.

Repeat endings
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2. In the Properties panel, activate Times played for segment in the Repeat Endings group.

3. Enter the number of each playthrough that you want to include in the selected segment, 
with each playthrough separated by a comma.

For example, for a repeat ending with six playthroughs, enter 4,5,6 to include the 4th, 5th, 
and 6th playthroughs in the second segment.

RESULT
The playthroughs included in the selected segment are changed.

EXAMPLE

Default distribution of playthroughs Customized distribution of playthroughs

Lengthening/Shortening segments in repeat endings
You can increase/decrease the number of bars included in each segment of repeat endings by 
lengthening/shortening each segment independently.

PROCEDURE

1. In Write mode, select the repeat ending you want to lengthen/shorten.

NOTE

You can only lengthen/shorten one repeat ending segment at a time.

2. Select the circular handle at the end of the segment you want to lengthen/shorten.

The selected handle in the middle has a thicker line.

3. Click and drag the handle to the right/left to snap it to the next/previous barline.

NOTE

Segments must contain at least one bar.

4. Optional: Repeat steps 1 to 3 for each segment in the repeat ending.

RESULT
The selected segment is lengthened/shortened.

NOTE

● This does not automatically input or move repeat barlines. You must input and delete repeat 
barlines as appropriate manually.

Repeat endings
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● You can also lengthen/shorten the final segment in a single repeat ending by selecting the 
repeat ending and using the following key commands:

● To lengthen the final segment, press Shift-Alt/Opt-Right Arrow .

● To shorten the final segment, press Shift-Alt/Opt-Left Arrow .

RELATED LINKS
Input methods for bars, beats, and barlines on page 302
Deleting notes/items on page 459
Moving items graphically on page 609

Positions of repeat endings
Repeat endings are placed above the staff at the same positions as other system objects, and 
their hooks align with barlines. They are commonly positioned outside of other notations, but 
some long items, such as gradual tempo changes, can be placed above repeat endings.

You can move repeat endings to different rhythmic positions in Write mode. They are positioned 
by default according to your settings in Engraving Options.

You can move each repeat ending segment graphically in Engrave mode and independently of 
other segments in the repeat ending; however, this does not change the rhythmic positions to 
which they are attached.

In Engrave mode, each repeat ending segment has two square handles, one at the start and one 
at the end.

If repeat ending segments cross system and frame breaks, you can move the segments on each 
side of the break independently.

You can change the default appearance and position of all repeat endings project-wide on the 
Repeat Endings page in Engraving Options.

Repeat endings are categorized as system objects in Dorico Pro, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently; for example, if you want repeat endings to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Engraving Options dialog on page 840
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
System objects on page 1563
Input methods for repeats and tremolos on page 406

Editing repeat ending text
You can replace the text shown in individual segments in repeat endings with custom text. By 
default, it shows the playthrough numbers for the segment.

PREREQUISITE

● The lower zone is shown.

Repeat endings
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● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the repeat ending segments whose text you want to change.

2. In the Properties panel, activate Custom text in the Repeat Endings group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected segments is changed.

Deactivating Custom text restores the default text for the selected repeat ending segments.

NOTE

● Deactivating properties permanently deletes any custom text entered.

● You can edit the formatting of the Repeat Endings Font in the Edit Font Styles dialog. For 
example, if you want all repeat ending text project-wide to appear in italics.

RELATED LINKS
Engrave toolbox on page 514
Edit Font Styles dialog on page 846
Changing the total number of playthroughs in repeat endings on page 1441
Dividing playthroughs across repeat ending segments on page 1441

Changing the appearance of individual final repeat ending 
segments

You can change the appearance of the line ends in the final segments of individual repeat 
endings, independently of your project-wide settings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat endings whose final segment appearance you want to change. You can do 
this in Write mode and Engrave mode.

NOTE

In Engrave mode, you can select any segment in the repeat ending.

2. In the Properties panel, activate End of line in the Repeat Endings group.

3. Select one of the following options from the menu:

● Open, short

● Open, full length
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● Closed

RESULT
The end of the line of the final segment in the selected repeat endings is changed.

TIP

You can change the appearance of final segments in all repeat endings project-wide in the 
Segments section of the Repeat Endings page in Engraving Options.

Lengthening/Shortening repeat ending hooks
You can lengthen/shorten the hooks in repeat endings individually, independently of your 
project-wide settings. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

NOTE

You cannot change the hook length of an individual segment in a repeat ending. Changing the 
hook length affects the whole repeat ending.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the repeat endings whose hooks you want to lengthen/shorten.

2. In the Properties panel, activate Hook length in the Repeat Endings group.

3. Change the value in the value field.

RESULT
Increasing the value makes repeat ending hooks longer. Decreasing the value makes repeat 
ending hooks shorter. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

TIP

You can change the default length of all repeat ending hooks project-wide on the Repeat 
Endings page in Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Repeat endings in MusicXML files
All aspects of repeat endings can be imported from and exported in MusicXML files.

However, while MusicXML can represent this, segments in the middle of sets of endings cannot 
have an open right-hand end in Dorico Pro.

Repeat endings
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Repeat markers

Repeat markers show that musical material is to be repeated, but unlike repeat endings, repeat 
markers often involve jumping to different positions and sections in the music instead of moving 
through the music consecutively.

A mid-system coda section

In Dorico Pro, repeat markers are divided into the following types:

Repeat jumps
Specify the position from which players or playback must jump, such as D.C. al Coda or 
D.S. al Fine.

Repeat jumps are right-aligned with their rhythmic position, meaning their text or 
symbol ends at that rhythmic position and extends to the left.

Repeat sections
Specify the destinations for jumps, such as segno or coda, or where the music should 
end, such as Fine. In Dorico Pro, coda sections that start mid-system are automatically 
separated from the preceding music with a gap. Coda sections at the start of systems 
are indented by the same amount.

Repeat markers are left-aligned with their rhythmic position, meaning their text or 
symbol starts at that rhythmic position and extends to the right.

By default, repeat markers are shown on a single line, but you can show them on two 
lines individually to reduce their horizontal length if necessary. You can also customize their 
paragraph styles, including changing their font size, in the Paragraph Styles dialog, and you 
can use the options on the Repeat Markers page in Engraving Options to customize their 
appearance.

RELATED LINKS
Input methods for repeats and tremolos on page 406
Showing repeat markers on one/two lines on page 1451
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Hiding/Showing repeat markers on page 1453
Changing the index for repeat markers on page 1450
Paragraph Styles dialog on page 848
Repeats in playback on page 640
Repeat counts on page 1456
Changing the gap before codas on page 1455
Types of barlines on page 968
Engraving Options dialog on page 840

Project-wide engraving options for repeat markers
You can find options for the project-wide design, position, and appearance of repeat markers on 
the Repeat Markers page in Engraving Options.

The options on the Repeat Markers page allow you to change the appearance, design, and 
length of repeat markers, the default gap before coda sections, and their default position. You 
can also change the order of symbols and text in repeat markers, the scale size of symbols 
compared to text, and the letter case for repeat marker text.

The following appearance presets are provided in the Repeat Markers Preset section:

● Standard: Based on the most commonly-used conventions in current rock/pop sheet music 
publishing, which produce shorter, more abbreviated instructions.

● Gould: Based on the recommendations made in Elaine Gould’s book “Behind Bars”, which is 
better suited for classical and concert music as it produces longer, more explicit instructions.

NOTE

Gould also recommends placing repeat markers below the staff instead of above it.

● Custom: A mixture of settings according to your preference. This preset is automatically 
selected when you override an appearance preset by changing individual options.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Changing the staff-relative placement of repeat markers on page 1454
Changing the gap before codas on page 1455

Repeat marker paragraph styles
Repeat markers use paragraph styles to format their fonts, including their size, spacing, 
alignment, and other formatting options. Because the different types of repeat markers require 
different formatting, they each have a separate paragraph style by default.

Dorico Pro provides the following default paragraph styles for repeat markers:

● Repeat Marker Jumps: The default paragraph style used for repeat jumps, such as D.C. al 
Coda or D.S. al Fine.

● Repeat Marker Sections: The default paragraph style used for repeat sections, such as coda 
or Fine.

Repeat markers
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By default, the formatting of these paragraph styles is the same but you can edit paragraph 
styles independently of each other in the Paragraph Styles dialog; for example, if you want to 
decrease the size of repeat jumps but leave repeat sections with their default size.

NOTE

The Repeat Marker Jumps paragraph style inherits settings from the Repeat Marker Sections 
style. If you change the Repeat Marker Sections paragraph style, this also affects any 
corresponding options for the Repeat Marker Jumps paragraph style that have not been 
overridden.

RELATED LINKS
Paragraph Styles dialog on page 848
Editing repeat marker text on page 1451
Showing repeat markers on one/two lines on page 1451

Changing the size of coda/segno symbols
You can change the default size of all coda and segno symbols project-wide and independently of 
each other. This does not affect the size of text in repeat markers.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Repeat Markers.

3. In the Design section, change the value for Scale factor for coda symbols.

4. Change the value for Scale factor for segno symbols.

5. Click Apply, then Close.

RESULT
The size of coda and segno symbols relative to repeat marker text is changed project-wide.

Hiding/Showing symbols in repeat markers
You can choose to show only coda/segno symbols, only text, or both text and symbols in 
different types of repeat markers. If you show both text and symbols in repeat markers, you 
can also change their order and alignment.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Repeat Markers.

3. In the Repeat Jumps section, choose one of the available appearances for the following 
options:

● Appearance of ‘To coda’ repeat jumps

● Appearance of dal segno repeat jumps

● Appearance of coda in repeat jumps

4. In the Repeat Sections section, choose one of the available appearances for Appearance of 
coda repeat sections.
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5. Click Apply, then Close.

RESULT
Coda/Segno symbols are hidden/shown in the corresponding repeat markers project-wide. 
Depending on your choices, other aspects of the corresponding markers’ appearance might also 
be changed, such as the order or alignment of text and symbol.

RELATED LINKS
Engraving Options dialog on page 840

Changing the index for repeat markers
You can change the index of individual repeat markers; for example, if a flow requires two 
different codas with different symbols so players can tell them apart.

By default, all repeat markers of the same type have the same appearance, even when there are 
multiple repeat markers in the flow.

NOTE

You cannot change the index of Fine or D.C. repeat markers.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat marker whose index you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together as 
appropriate for your selection, in the Repeat Markers group:

● Marker index

● ‘Jump to’ index

3. Change the values in the value fields.

NOTE

You can only enter values between 1 and 3.

RESULT
Marker index changes the order of the selected repeat marker relative to other repeat markers 
of the same type.

‘Jump to’ index changes the destination of the selected repeat marker.

TIP

You can change the default appearance of all multiple repeat markers project-wide in the Repeat 
Sections section of the Repeat Markers page in Engraving Options.
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EXAMPLE
If you have two codas in a flow with two different D.S. al Coda markers, you might set Marker 
index to 1 for the first coda and 2 for the second, then set ‘Jump to’ index to 1 for the first D.S. al 
Coda marker and 2 for the second.

D.S. al Coda marker with default indexes D.S. al Coda marker with both indexes set to 2

RELATED LINKS
Engraving Options dialog on page 840
Repeats in playback on page 640
Engrave toolbox on page 514
Input methods for repeats and tremolos on page 406

Editing repeat marker text
You can change the text shown in individual repeat markers; for example, if you are typesetting a 
score with an unusual repeat marker instruction.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat markers whose text you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Custom text in the Repeat Markers group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected repeat markers is changed. Segno symbols and coda symbols in 
D.C./D.S. repeat jumps are removed and replaced with your custom text.

RELATED LINKS
Project-wide engraving options for repeat markers on page 1448
Engrave toolbox on page 514

Showing repeat markers on one/two lines
You can show individual repeat markers either on a single line or spread across two lines, 
independently of your per-layout settings; for example, if a single long repeat marker extends 
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beyond the page margins in one part layout. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

You can only change the word wrapping of repeat jumps, such as D.C. al Fine and D.S. al Coda, 
that do not have custom text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the repeat markers whose word wrapping you want to change.

2. In the Properties panel, activate Word wrap in the Repeat Markers group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected repeat markers are shown on two lines when the checkbox is activated, and on one 
line when the checkbox is deactivated. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

When the property is deactivated, repeat markers follow your per-layout setting for word 
wrapping.

TIP

● You can show all repeat markers on two lines in each layout independently in Layout 
Options > Staves and Systems > Repeat Markers. For example, you can show them on 
one line in the full score but on two lines in part layouts.

● You can change the arrangement of text and symbol in all repeat markers project-wide, 
including showing symbols below text, on the Repeat Markers page in Engraving Options.

EXAMPLE

Repeat marker without word wrapping Repeat marker with word wrapping

RELATED LINKS
Layout Options dialog on page 834
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Hiding/Showing repeat markers
You can hide/show repeat markers individually; for example, if you want a separated coda 
section without showing the coda symbol and text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat markers you want to hide, or the signposts of repeat markers you want to 
show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide in the Repeat Markers group.

RESULT
The selected repeat markers are hidden when Hide is activated, and shown when it is 
deactivated.

Signposts are shown at the position of each hidden repeat marker. However, signposts are not 
printed by default.

TIP

You can hide/show repeat marker signposts by choosing View > Signposts > Repeat Markers.

RELATED LINKS
Signposts on page 453
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Annotations on page 687
Input methods for repeats and tremolos on page 406

Changing the barline shown before codas
You can change the default barline shown before all codas project-wide that are preceded by a 
repeat jump; for example, if you want to show double barlines in such cases instead of normal 
barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Barlines.

3. In the Repeats section, choose one of the following options for Barline coinciding with 
repeat jump before Coda:

● Double barline

● Single barline

4. Click Apply, then Close.
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RESULT
The barline shown automatically before codas immediately preceded by a repeat jump is 
changed project-wide.

Positions of repeat markers
Repeat markers are placed above the staff by default, and at the same positions as other system 
objects. Coda sections are separated from the preceding music by a gap in the system.

You can move repeat markers to different rhythmic positions in Write mode. They are positioned 
by default according to your settings in Engraving Options.

You can move repeat markers graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached. You can adjust the size of individual mid-system 
gaps before codas by adjusting the note spacing at their rhythmic positions in Engrave mode.

You can change the default positions of all repeat markers project-wide, set values for the 
minimum distances between repeat markers and staves and other items, and set the default gap 
preceding coda sections on the Repeat Markers page in Engraving Options. Dorico Pro uses 
the same gap size before the start of codas whether they occur partway through systems or at 
the start of a new system.

You can change the default staff-relative placement of repeat markers in each layout 
independently in the Repeat Markers section of the Staves and Systems page in Layout 
Options.

Repeat markers are categorized as system objects in Dorico Pro, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently; for example, if you want repeat markers to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Input methods for repeats and tremolos on page 406
Project-wide engraving options for repeat endings on page 1440
Engraving Options dialog on page 840
Layout Options dialog on page 834
Changing the positions of system objects on page 1564
Changing the gap before codas on page 1455
Changing the staff-relative placement of repeat markers on page 1454
Moving notes/items rhythmically on page 465
Moving items graphically on page 609
Adjusting note spacing at individual rhythmic positions on page 604
Repeats in playback on page 640

Changing the staff-relative placement of repeat markers
You can show repeat markers either above, below, or both above and below the staff in each 
layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff-placement of 
repeat markers.
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By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Repeat Markers section, choose one of the following options for Default placement 
for repeat jumps and ‘Fine’:

● Above staff

● Below staff

● Above and below bottom staff

5. Click Apply, then Close.

RESULT
The staff-relative placement of all repeat markers is changed in the selected layouts.

Changing the gap before codas
You can change the default gap preceding all coda sections project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Repeat Markers.

3. In the Repeat Sections section, change the value for Default gap before mid-system coda 
section.

4. Click Apply, then Close.

RESULT
The gap preceding all coda sections project-wide is changed. Dorico Pro uses the same gap size 
before the start of codas whether they occur partway through systems or at the start of a new 
system.

NOTE

You cannot move the start of systems that start with codas further to the left than the gap set for 
Default gap before mid-system coda section.

RELATED LINKS
Moving the start/end of systems on page 608
Changing the first system indent on page 1566
Changing note spacing from rhythmic positions on page 601
Input methods for repeats and tremolos on page 406
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Repeat counts
Repeat counts at end repeat barlines tell performers how many times to play through sections of 
music. This is particularly helpful for sections played through three or more times, as end repeat 
barlines typically indicate that the preceding music is played through twice.

By default, Dorico Pro shows repeat counts at system object positions for end repeat barlines set 
to have three or more playthroughs, when repeats are included in playback.

Repeat count at the end of a section, indicating it should be played four times

Repeat counts are right-aligned with their end repeat barline by default. You can change the 
location of repeat counts; for example, if you want to show repeat counts at both the start and 
end of repeated sections, or hide repeat counts entirely. Repeat counts shown at the start of 
repeated sections are left-aligned with start repeat barlines.

You can also change the language used for repeat markers.

TIP

● You can change the appearance, content, and position of repeat counts in Engraving 
Options > Repeat Markers > Repeat Count. For example, if you want to use custom text or 
show repeat counts at the start of repeated sections.

● Repeat counts use the Repeat Counts paragraph style, which you can edit in the Paragraph 
Styles dialog.

RELATED LINKS
Changing the number of playthroughs at repeat barlines on page 641
Repeats in playback on page 640
Including/Excluding repeats in playback on page 640
Input methods for bars, beats, and barlines on page 302
System objects on page 1563
Changing the application language on page 59
Engraving Options dialog on page 840
Paragraph Styles dialog on page 848
Bar repeat counts on page 1461
Slash region counts on page 1480
Numbered bar region counts on page 1468

Changing the location of repeat counts
You can change the location of individual repeat counts relative to the repeated section, 
independently of your project-wide setting. For example, if you want to show some repeat counts 
at the start of repeated sections or hide some repeat counts entirely. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.
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PREREQUISITE

● Repeats are included in playback.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the end repeat barlines or repeat counts whose count location you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Count location in the Time Signatures group.

3. Select one of the following options from the menu:

● Start

● End

● Neither

● Both

RESULT
The location of the selected repeat counts is changed. Repeat counts shown at the start of 
repeated sections are left-aligned with the start repeat barlines that correspond to the selected 
end repeat barlines.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can change the default location of all repeat counts project-wide in Engraving Options > 
Repeat Markers > Repeat Count.

EXAMPLE

Both Neither

RELATED LINKS
Repeats in playback on page 640
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Moving items graphically on page 609
Engraving Options dialog on page 840
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Changing the language for repeat counts
You can change the language used for all repeat counts project-wide; for example, if you are 
writing for an ensemble that prefers German repeat counts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Language.

3. Select the language you want to use from the Repeat count language menu.

4. Click Apply, then Close.

RELATED LINKS
Engraving Options dialog on page 840
Language setup on page 59
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Bar repeats

Bar repeats indicate that the musical material in preceding bars must be repeated exactly, but 
without notating that material again. Bar repeats can comprise groups of one, two, or four bars.

For example, a one-bar repeat indicates that the material in one bar is repeated, meaning every 
bar in the region repeats the same material. A four-bar repeat indicates that the material in the 
previous four bars is repeated.

One-bar repeat region Two-bar repeat region

Four-bar repeat region

This notation short-hand can make repetitive music easier to read, as performers must only read 
the repeated phrase once and then simply count how many times they repeat it. Bar repeats can 
also save horizontal space, as bar repeat symbols are usually narrower than the equivalent fully 
written-out bars.

In Dorico Pro, bar repeat regions are used to display bar repeats, meaning as many bar repeat 
symbols as necessary to fill the region are shown automatically.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, bar repeat regions are highlighted with a colored background. As you zoom out, the 
highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

You can also show adjacent bar repeat regions; for example, if you want to use a two-bar repeat 
in the first iteration of a phrase, and then a four-bar repeat to indicate the whole phrase is 
repeated. When two different bar repeat regions are adjacent, they alternate highlight colors to 
ensure the separate regions are always identifiable.

Phrase containing two adjacent bar repeat regions
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RELATED LINKS
Inputting bar repeats on page 419
Repeats popover on page 407
Bar repeat counts on page 1461
Bar repeat grouping on page 1465
Numbered bar regions on page 1467
Slash regions on page 1474
Repeat counts on page 1456
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436
Hiding/Showing multi-bar rests on page 1496
Types of barlines on page 968
Changing the number of playthroughs at repeat barlines on page 641
Annotations on page 687

Project-wide engraving options for bar repeats
You can find options for the project-wide design and appearance of bar repeats on the Bar 
Repeats page in Engraving Options.

The options in the Bar Repeats section allow you to change the frequency of bar repeat counts, 
the appearance of bar repeat counts, and how bar repeats are grouped when a four-bar phrase 
contains a single bar followed by a three-bar repeat.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840

Changing the length of the repeated phrase in bar repeat 
regions

You can change the number of bars that make up the repeated phrase in individual bar repeats 
after you have input them; for example, if you want the region to repeat the previous two bars 
rather than the previous four bars.

NOTE

You cannot repeat more bars than exist before the bar repeat region. For example, if a bar 
repeat region follows the first notated bar in a flow, you cannot increase the number of bars in 
the repeated phrase.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the bar repeat regions whose phrase length you want to change. You can do this in 
Write mode and Engrave mode.
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2. In the Properties panel, select one of the following options from the No. bars menu in the 
Bar Repeat Regions group:

● One bar

● Two bars

● Four bars

RESULT
The number of bars that make up the repeated phrase in the selected bar repeat regions is 
changed. This is also reflected in playback.

TIP

● Any dynamics you add within bar repeat regions affect the playback of the repeated music.

● You can also change the length of the repeated phrase by opening the repeats popover and 
changing the entry.

RELATED LINKS
Bar repeat grouping on page 1465
Inputting bar repeats on page 419
Repeats popover on page 407
Changing existing items on page 439
Engrave toolbox on page 514

Hiding/Showing region highlights
You can hide/show colored highlights for bar repeat and numbered bar regions at any time; 
for example, if you want to show the highlights when inputting music but hide them when 
engraving.

PROCEDURE

● Choose View > Highlight Bar Repeat Regions.

RELATED LINKS
Numbered bar regions on page 1467

Bar repeat counts
Bar repeat counts are numbers shown at regular intervals either above or below bar repeats, to 
help performers keep track of how many bars have passed. The intervals are usually based on 
typical musical phrases, such as every four or eight bars.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

Because bar repeats must start with a fully notated phrase of at least one bar, the bar repeat 
count starts from the notated bar rather than the first bar in the bar repeat region. For example, 
the third bar in a bar repeat region shows the count number 4, as that bar is the fourth time the 
original notated bar is played. Each bar repeat region has its own separate count.
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Bar repeat region with counts shown every four bars

In Dorico Pro, you can change the start count of each bar repeat region, how frequently counts 
are shown, and whether counts are shown with parentheses, without parentheses, or hidden. 
You can also customize the count font style.

NOTE

Bar repeat, slash, and numbered bar region counts use the same font style.

RELATED LINKS
Editing the count font style on page 1465
Repeats popover on page 407
Inputting bar repeats on page 419
Bar repeat grouping on page 1465
Hiding/Showing bar number ranges on multi-bar rests on page 984
Hiding/Showing multi-bar rests on page 1496
Repeat counts on page 1456
Slash region counts on page 1480
Numbered bar region counts on page 1468

Changing the start count of bar repeats
You can change the number from which individual bar repeats start; for example, if you want to 
notate the first bar in a repeated phrase at the start of each system, but show a continuous count 
across multiple bar repeats.

NOTE

● The start count applies to the first bar in the bar repeat, which is the notated bar. For 
example, changing the start count of a one-bar repeat region lasting three bars to 5, with 
bar repeat counts shown every four bars, causes the count at the end of the bar repeat 
region to show the number 8.

● Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the one-bar repeat regions whose start count you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Count from in the Bar Repeat Regions group.

3. Change the value in the value field.
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RESULT
The start count of the selected bar repeat regions is changed. If the count frequency is every two 
bars or more, counts appear on different bars. For example, changing the start count from 1 to 
2, with counts shown every four bars, causes the count to appear on the second bar in the bar 
repeat region instead of the third.

EXAMPLE

Separate bar repeats on multiple systems in the 
same part layout with the default count

Separate bar repeats on multiple systems in the 
same part layout with their counts changed to imply 
a continuous region

Changing the bar repeat count frequency
You can change how often counts are shown on individual one-bar repeat regions, 
independently of your project-wide setting; for example, if you want to show the count after 
eight bars on a single bar repeat region.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the one-bar repeats whose count frequency you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Count frequency in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected bar repeat regions.

TIP

You can also change the default count frequency for all bar repeat regions project-wide in 
Engraving Options > Bar Repeats > Bar Repeats.

Bar repeats
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RELATED LINKS
Bar repeat counts on page 1461
Engraving Options dialog on page 840
Engrave toolbox on page 514
Hiding/Showing bar number ranges on multi-bar rests on page 984

Hiding/Showing or parenthesizing bar repeat counts
You can hide counts or show counts with or without parentheses for individual bar repeat 
regions, independently of your project-wide setting. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the one-bar repeats whose counts you want to hide/show or parenthesize. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Count appearance in the Bar Repeat Regions group.

3. Select one of the following options from the menu:

● With parentheses

● Without parentheses

● Do not show

RESULT
Counts in the selected bar repeat regions are shown with parentheses, without parentheses, or 
hidden. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

TIP

You can also change the default appearance of all bar repeat counts project-wide in Engraving 
Options > Bar Repeats > Bar Repeats.

RELATED LINKS
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Editing the count font style
You can edit the formatting of the font style used for all bar repeat, slash, and numbered bar 
region counts project-wide; for example, if you want counts to appear bold and italic.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select Bar Repeat Count.

3. Activate the following options, individually or together, to change the corresponding aspect 
of the font:

● Font family

● Size

● Style

● Underlined

4. Click OK to save your changes and close the dialog.

RESULT
The formatting of the font style used for counts in bar repeat, slash, and numbered bar regions 
is changed project-wide.

RELATED LINKS
Edit Font Styles dialog on page 846
Slash region counts on page 1480
Numbered bar region counts on page 1468

Bar repeat grouping
Bar repeat grouping allows you to consolidate longer bar repeat regions, which can be helpful in 
very regular music as it can simplify the overall phrasing.

The symbols shown on the staff are different for the different groupings, and two-bar and 
four-bar repeats also show a number to indicate how many bars are included in the group.

One-bar repeat symbol Two-bar repeat symbol Three-bar repeat symbol Four-bar repeat symbol

You can specify the grouping when inputting bar repeats, and you can change the grouping of 
bar repeats after they have been input. Depending on where the bar repeat region starts and 
ends relative to the written material, Dorico Pro automatically adjusts the displayed symbols 
to achieve an accurate result. For example, an eight-bar phrase containing a single notated 
bar followed by seven one-bar repeats grouped every four bars is automatically shown with a 
one-bar repeat, two-bar repeat, then four-bar repeat to fill the seven bars.

Bar repeats
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Eight-bar phrase with seven one-bar repeats grouped every four bars

TIP

● When showing multi-bar rests, you can also choose to consolidate one-bar repeat regions.

● You can also choose to show a three-bar repeat to complete a four-bar phrase on the 
Bar Repeats page in Engraving Options; however, this is less commonly used than a 
combination of one-bar and two-bar repeats.

RELATED LINKS
Repeats popover on page 407
Inputting bar repeats on page 419
Hiding/Showing multi-bar rests on page 1496
Engraving Options dialog on page 840

Changing bar repeat grouping
You can change how bar repeats are grouped after they have been input; for example, if you 
want to group a region of one-bar repeats every two bars.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the bar repeat regions whose grouping you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, select one of the following options from the Group every menu in 
the Bar Repeat Regions group:

● One bar

● Two bars

● Four bars

NOTE

The options available depend on the minimum length of the selected bar repeat regions. For 
example, if you select bar repeat regions that last three bars, only One bar and Two bars are 
available in the menu.

RESULT
The grouping in the selected bar repeat regions is changed. Dorico Pro automatically calculates 
the clearest way to group the region. For example, an eight-bar phrase containing a single 
notated bar followed by seven one-bar repeats grouped every four bars is automatically shown 
with a one-bar repeat, two-bar repeat, then four-bar repeat to fill the seven bars.
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Numbered bar regions

Numbered bar regions allow you to show bar counts in specific regions without additional 
notations. This can help performers keep track of how many bars have passed when playing 
repetitive music.

Numbered bar region spanning six bars

By default, numbered bar regions are hidden in full score/custom score layouts and shown in 
part layouts. You can hide/show numbered bar regions in each layout independently.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, numbered bar regions are highlighted with a colored background. As you zoom out, 
the highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

When two different numbered bar regions are adjacent, they alternate highlight colors to ensure 
the separate regions are always identifiable.

Phrase containing two adjacent numbered bar regions

RELATED LINKS
Inputting numbered bar regions on page 420
Hiding/Showing region highlights on page 1461
Lengthening/Shortening items on page 436
Bar repeats on page 1459
Slash regions on page 1474
Repeat counts on page 1456
Bar numbers on page 981
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Project-wide engraving options for numbered bar regions
You can find options for the project-wide design and appearance of numbered bar regions on 
the Bar Repeats page in Engraving Options.

The options in the Numbered Bar Regions section allow you to change the default staff-relative 
placement, alignment, frequency, and appearance of numbered bar region counts, including 
ranges on the first bar in each region and counts on the last bar in each system. You can also 
change the minimum number of bars required to show ranges.

The options are accompanied by diagrams to help you visualize how they affect the appearance 
of your music.

RELATED LINKS
Engraving Options dialog on page 840

Hiding/Showing numbered bar regions
You can input numbered bar regions in any layout, but by default they do not appear in full 
score layouts, as they are normally most useful in part layouts. You can hide/show numbered bar 
regions in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show numbered bar regions.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Numbered Bar Regions section, activate/deactivate Show bar count in numbered 
bar regions.

5. Click Apply, then Close.

RESULT
Numbered bar regions are shown in the selected layouts when the checkbox is activated, and 
hidden when the checkbox is deactivated.

Numbered bar region counts
Numbered bar region counts are numbers shown at regular intervals either above or below the 
staff, to help performers keep track of how many bars have passed.

By default, bar counts are shown on every bar in numbered bar regions. They are also shown on 
the last bar in each system and on the first and last bars in each region, regardless of the count 
frequency.

When numbered bar regions last four or more bars, Dorico Pro adds the total range in 
parentheses to the count on the first bar, such as showing “1 (-8)” on the first bar in a numbered 
bar region lasting eight bars.

Numbered bar regions
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Numbered bar region with counts shown every three bars, count and range shown at the start, and 
parenthesized count shown at the end of the system

In Dorico Pro, you can change the start count of each numbered bar region, how frequently 
counts are shown, their staff-relative placement, and whether counts and ranges are shown with 
parentheses, without parentheses, or hidden. You can also customize the count font style.

NOTE

Bar repeat, slash, and numbered bar region counts use the same font style.

RELATED LINKS
Inputting numbered bar regions on page 420
Editing the count font style on page 1465
Repeat counts on page 1456
Bar repeat counts on page 1461
Slash region counts on page 1480

Changing the start count of numbered bar regions
You can change the number from which individual numbered bar regions start; for example, if 
you want to show a continuous count across multiple numbered bar regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the numbered bar regions whose start count you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Count from in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The start count of the selected numbered bar regions is changed. If the count frequency is every 
two bars or more, counts appear on different bars. For example, changing the start count from 
1 to 2, with counts shown every four bars, causes the count to appear on the third bar in the 
region instead of the fourth.

Changing the numbered bar region count frequency
You can change how frequently counts are shown in individual numbered bar regions, 
independently of your project-wide setting; for example, if you want to show the count after 
eight bars in a single numbered bar region.

Numbered bar regions
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the numbered bar regions whose count frequency you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Count frequency in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected numbered bar regions.

TIP

You can also change the default count frequency for all numbered bar regions project-wide in 
Engraving Options > Bar Repeats > Numbered Bar Regions.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Hiding/Showing bar number ranges on multi-bar rests on page 984

Hiding/Showing or parenthesizing numbered bar region counts
You can show counts with or without parentheses for individual numbered bar regions, 
independently of your project-wide setting. You can also hide/show or parenthesize counts at 
the ends of systems and on the first and last bars in each region independently of each other. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the numbered bar regions whose counts you want to hide/show or parenthesize. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Count appearance in the Bar Repeat Regions group.

3. Select one of the following options from the menu:

● Without parentheses

● With parentheses

4. Activate Range appearance and select one of the following options from the menu:

● With parentheses

● Without parentheses

Numbered bar regions
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● No range

5. Activate the following properties, individually or together, to change the appearance of the 
corresponding count:

● Show in first bar

● Show in final bar

● Show at ends of systems

6. Select one of the following options from each menu:

● With parentheses

● Without parentheses

● Do not show

RESULT
The corresponding counts and ranges in the selected numbered bar regions are shown with 
parentheses, without parentheses, or hidden. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

You can also change the default appearance of all numbered bar region counts project-wide, 
including the minimum number of bars required to show ranges, in Engraving Options > Bar 
Repeats > Numbered Bar Regions.

EXAMPLE

Counts and range shown without parentheses Range hidden and counts shown with parentheses

RELATED LINKS
Numbered bar region counts on page 1468
Inputting numbered bar regions on page 420
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the staff-relative placement of numbered bar region 
counts

You can show the counts in individual numbered bar regions either above or below the staff, 
independently of your project-wide setting. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

Changing the staff-relative placement of counts affects all counts in the region. You cannot 
change the placement of a single count independently of other counts in the region.

Numbered bar regions
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the numbered bar regions whose count staff-relative placement you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Staff-relative position in the Bar Repeat Regions group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of all counts in the selected numbered bar regions is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

TIP

You can change the default placement of all numbered bar region counts project-wide in 
Engraving Options > Bar Repeats > Numbered Bar Regions.

Aligning counts in numbered bar regions
By default, counts in numbered bar regions are not aligned across systems to allow individual 
counts to be positioned as close to the staff as possible. You can align all numbered bar region 
counts project-wide vertically within each system, with their position determined by the count 
furthest from the staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Bar Repeats.

3. In the Numbered Bar Regions section, activate Align bar counts across width of system.

4. Click Apply, then Close.

RELATED LINKS
Changing the distance between bar numbers and the staff/other objects on page 988
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Rhythm slashes

Rhythm slashes are diagonal lines positioned on staves that are used to indicate that performers 
should play something, but without specifying the exact rhythms and pitches. They are often 
accompanied by chord symbols to indicate the set of notes the performer should use.

There are two different types of rhythm slashes:

Slashes with stems

Slashes with stems usually indicate the rhythm to be played, but not the pitches. Also 
known as “rhythmic notation”.

Slashes without stems

Slashes without stems do not usually indicate either rhythms or pitches. Also known as 
“slash notation”

In Dorico Pro, you can present both types of rhythm slashes simultaneously by using a 
combination of slash regions and slash voices.

RELATED LINKS
Slash voices on page 1483
Inputting notes into slash voices on page 233
Chord symbols on page 1036
Hiding/Showing chord symbols on page 1040
Including/Excluding slash voices in playback on page 1485

Project-wide engraving options for rhythm slashes
You can find options for the project-wide design and appearance of rhythm slashes in the 
Rhythmic Slashes section of the Notes page in Engraving Options. These options affect both 
slash voices and slash regions.

The options in the Rhythmic Slashes section of the Notes page allow you to change the 
design of slashes, both with and without stems, whether slashes are shown with rhythm dots in 
compound time signatures, and the frequency, appearance, and position of slash region counts. 
For example, you can choose to show slash region bar counts on every bar.

Musical examples demonstrate how each option affects the appearance of your music.

RELATED LINKS
Engraving Options dialog on page 840
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Slash regions
Slash regions automatically display rhythm slashes as appropriate for the meter throughout their 
duration; for example, they show four slashes per bar in 4/4 and two slashes per bar in 6/8 by 
default. A single slash region can extend across multiple different meters.

A single slash region covering multiple different meters

Multiple slash regions can exist at the same rhythmic position. When slash regions overlap, 
Dorico Pro treats this as a multiple-voice context and changes the staff position of slashes 
automatically.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, slash regions are highlighted with a colored background. As you zoom out, the 
highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

When two different slash regions are adjacent, they alternate highlight colors to ensure the 
separate regions are always identifiable.

Two adjacent slash regions with different highlight colors

You can use slash regions and slash voices in the same project and at the same rhythmic 
positions; for example, you can input a slash region where you do not want to be specific about 
the rhythm, then input notes in a slash voice for a single bar where you want to specify an exact 
rhythm.

TIP

Because rhythm slashes are often accompanied by chord symbols to indicate the set of notes 
the performer should use, you can hide/show chord symbols in slash/chord symbol regions on 
instrument staves where chord symbols are hidden.

RELATED LINKS
Inputting slash regions on page 418
Slash voices on page 1483
Slash region counts on page 1480
Slashes in multiple-voice contexts on page 1475
Moving notes/items rhythmically on page 465
Lengthening/Shortening items on page 436
Hiding/Showing notes alongside slash regions on page 1477
Hiding/Showing chord symbols on page 1040
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Chord symbol regions on page 1044
Numbered bar regions on page 1467
Bar repeats on page 1459
Repeat counts on page 1456
Annotations on page 687

Note grouping in slash regions
You can find options to control the grouping and duration of rhythm slashes in slash regions in 
each flow independently in Notation Options > Note Grouping > Rhythmic Slashes.

The available options include changing whether rhythm slashes follow the beat grouping or 
the time signature denominator, and set the duration for rhythm slashes in open meter. For 
example, you can show six slashes in 6/8 instead of two dotted slashes.

Musical examples demonstrate how each option affects the appearance of your music.

Rhythm slashes following beat grouping Rhythm slashes following time signature denominator

RELATED LINKS
Notation Options dialog on page 837
Note and rest grouping on page 1021
Time signatures on page 1639

Hiding/Showing slash region highlights
You can hide/show the colored highlights for slash regions at any time; for example, if you want 
to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight Slash Regions.

Slashes in multiple-voice contexts
Multiple slash regions and slash voices can exist at the same rhythmic positions. In multiple-voice 
contexts for slash voices and when slash regions overlap, Dorico Pro automatically changes their 
staff position and offset to accommodate all slashes as legibly as possible.

Single slash region Two slash regions, one up-stem and one down-stem

You can set default per-flow settings for the position and offset of slashes relative to other 
slashes at the same rhythmic positions on the Voices page in Notation Options.

Rhythm slashes
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NOTE

These options affect all rhythm slashes, including notes in slash voices as well as slash regions.

You can also control the positions of rhythm slashes relative to each other manually by changing 
their stem/voice direction and by changing their staff position.

RELATED LINKS
Notation Options dialog on page 837
Note positions in multiple-voice contexts on page 1707
Changing the voice of existing notes on page 477

Changing the voice direction of slash regions
You can change the voice direction of slash regions individually. When multiple slash regions 
overlap, this affects their stem directions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select any part of each slash region whose voice direction you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Voice direction in the Slash Regions group.

3. Choose one of the following options:

● Up

● Down

RESULT
The voice direction, and therefore stem direction, of the selected slash regions is changed.

NOTE

This only affects the direction of stems in slash regions on the middle line of the staff and when 
multiple slash regions exist at the same rhythmic position. For example, if you change the voice 
direction of a slash region on the bottom line of the staff to Down, its stem direction does not 
change if it does not overlap with another slash region.

RELATED LINKS
Stem direction on page 1274
Engrave toolbox on page 514
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Changing the staff position of rhythm slashes
You can change the staff position of rhythm slashes in both slash voices and slash regions; for 
example, to accommodate other notes at the same rhythmic positions better. By default, rhythm 
slashes are positioned on the middle line of the staff.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rhythm slashes whose staff position you want to change. You can do this in Write 
mode and Engrave mode.

● For notes in slash voices, you must select every note whose staff position you want to 
change.

● For slash regions, you can select any part of each region whose staff position you want 
to change.

2. In the Properties panel, activate Slash pos. in the corresponding group for the type of 
rhythm slash whose staff position you want to change:

● Notes and Rests for notes in slash voices

● Slash Regions for slash regions

3. Change the value in the value field.

RESULT
The staff position of the selected rhythm slashes is changed. For example, changing the Slash 
pos. value to 4 positions rhythm slashes on the top line of a five-line staff, while -4 positions them 
on the bottom line.

If any of the rhythm slashes have stems, their stem direction is adjusted automatically.

Hiding/Showing notes alongside slash regions
You can hide/show notes at the same rhythmic positions as slash regions; for example, if you 
want to input notes to hear in playback but only want to show the slash region, or if you want to 
notate suggested notes in addition to the slash region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select any part of each slash region alongside which you want to hide/show other notes. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show other voices in the Slash Regions group.
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RESULT
All notes in other voices present alongside the selected slash regions are shown when Show 
other voices is activated, and hidden when it is deactivated.

EXAMPLE

Notes hidden alongside a slash region Notes shown alongside a slash region

RELATED LINKS
Slash regions on page 1474
Slash voices on page 1483
Hiding/Showing slash region highlights on page 1475
Inputting slash regions on page 418

Hiding/Showing padding rests before/after slash regions
You can hide/show padding rests before/after slash regions that start partway through bars 
individually; for example, if you have other notes at those positions and the rests would be 
misleading. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

By default, Dorico Pro automatically shows implicit padding rests around slash regions that 
start/end partway through bars, so that the full duration of each bar is clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose padding rests you want to hide/show. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slash Regions group:

● Hide rests before start

● Hide rests after end

RESULT
Padding rests are hidden on the corresponding side of the selected slash regions. For example, 
activating both properties hides padding rests both before and after the selected slash regions. 
If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.
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RELATED LINKS
Implicit vs. explicit rests on page 1488
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Splitting slash regions
You can split slash regions after they have been input; for example, if you later want to input 
more precise notation in the middle of an existing slash region.

PROCEDURE

1. In Write mode, select a slash in each slash region you want to split, immediately to the right 
of where you want to split them.

2. Split the slash regions in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

RESULT
The slash regions are split immediately to the left of the selected slashes. Each part now has its 
own start/end handles, which you can use to lengthen/shorten each part independently.

RELATED LINKS
Notes toolbox on page 197
Slash regions on page 1474
Changing the slash region count frequency on page 1481
Lengthening/Shortening items on page 436
Moving notes/items rhythmically on page 465

Hiding/Showing stems in slash regions
You can hide/show stems and beams, where applicable, on slashes in individual slash regions. By 
default, slashes in slash regions are shown without stems.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select any part of each slash region in which you want to hide/show stems. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Slash type in the Slash Regions group.

3. Choose one of the following options:

● With stems

● Without stems

Rhythm slashes
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RESULT
Stems are hidden in the selected slash regions when you choose Without stems, and shown 
when you choose With stems. If appropriate for the prevailing meter, such as 3/8, beams are 
shown in addition to stems.

Slash region counts
Slash region counts are numbers shown at regular intervals, either above or below slash regions, 
to help performers keep track of how many bars have passed. The intervals are usually based on 
typical musical phrases, such as every four or eight bars.

By default, slash region counts are shown in parentheses every four bars and are placed below 
the staff. Each slash region has its own separate count.

Slash region with counts shown every two bars

In Dorico Pro, you can change the start count of each slash region, how frequently counts are 
shown, their staff-relative placement, and whether counts are shown with parentheses, without 
parentheses, or hidden. You can also customize the count font style.

NOTE

Bar repeat, slash, and numbered bar region counts use the same font style.

RELATED LINKS
Slash regions on page 1474
Editing the count font style on page 1465
Repeat counts on page 1456
Bar repeat counts on page 1461
Numbered bar region counts on page 1468

Changing the start count of slash regions
You can change the number from which individual slash region counts start; for example, if you 
want to input more precise notation between two slash regions but want the count to appear to 
continue across the regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select any part of each slash region whose start count you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Count from in the Slash Regions group.

3. Change the value in the value field.

Rhythm slashes
Slash region counts 

1480
Dorico Pro 4.3.30



RESULT
The start count of the selected slash regions is changed. If the count frequency is every two bars 
or more, counts appear on different bars. For example, changing the start count from 1 to 2, with 
counts shown every four bars, causes the count to appear on the third bar in the region instead 
of the fourth.

EXAMPLE

Two separate slash regions, where the start count in the second region has been changed so it appears to 
continue on from the first region.

Changing the slash region count frequency
You can change how frequently counts are shown on individual slash regions, independently of 
your project-wide setting; for example, if you want to show the count after eight bars on a single 
slash region. By default, slash region counts are shown every four bars.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select any part of each slash region whose count frequency you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Count frequency in the Slash Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected slash regions.

TIP

You can also change the default count frequency for all slash regions project-wide in Engraving 
Options > Notes > Rhythmic Slashes.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Splitting slash regions on page 1479
Hiding/Showing bar number ranges on multi-bar rests on page 984
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Hiding/Showing or parenthesizing slash region counts
You can hide counts or show counts with or without parentheses for individual slash regions, 
independently of your project-wide setting. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose counts you want to hide/show or parenthesize. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Count appearance in the Slash Regions group.

3. Select one of the following options from the menu:

● With parentheses

● Without parentheses

● Do not show

RESULT
Counts in the selected slash regions are shown with parentheses, without parentheses, or 
hidden. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

TIP

You can also change the default appearance of all slash region counts project-wide in Engraving 
Options > Notes > Rhythmic Slashes.

RELATED LINKS
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the staff-relative placement of slash region counts
You can show the counts in individual slash regions either above or below the staff, 
independently of your project-wide setting. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

Changing the staff-relative placement of counts affects all counts in the region. You cannot 
change the placement of a single count independently of other counts in the region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose count staff-relative placement you want to 
change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Count position in the Slash Regions group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of all counts in the selected slash regions is changed. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default placement of all slash region counts project-wide in Engraving 
Options > Notes > Rhythmic Slashes.

RELATED LINKS
Engraving Options dialog on page 840
Moving items graphically on page 609

Slash voices
Slash voices allow you to notate specific rhythms for rhythm slashes. They behave similarly to 
normal voices as you must input notes and rhythms manually, but all notes in slash voices are 
positioned by default on the middle line of the staff, regardless of the pitches you input.

If you later change the time signature, such as from 3/4 to 6/8, Dorico Pro only changes the note 
grouping to fit the meter just like for other notes; it does not change the presentation of rhythm 
in slash voices like it does for slash regions.

NOTE

● Because you can change notes in slash voices to normal voices and vice versa, the pitches 
you input are retained.

● By default, notes in slash voices are not played back.

You can have multiple slash voices active at the same time. To accommodate all slash voices in 
multiple-voice contexts, Dorico Pro changes their staff position automatically. However, you can 
also change the staff position of rhythm slashes manually.

You can use slash regions and slash voices in the same project and at the same rhythmic 
positions; for example, you can input a slash region where you do not want to be specific about 
the rhythm, then input notes in a slash voice for a single bar where you want to specify an exact 
rhythm.

RELATED LINKS
Rhythm slashes on page 1473
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Slash regions on page 1474
Slashes in multiple-voice contexts on page 1475
Implicit rests in multiple-voice contexts on page 1489
Inputting notes into slash voices on page 233
Changing the voice of existing notes on page 477
Including/Excluding slash voices in playback on page 1485
Copying and pasting notes into different voices on page 462

Changing the slash voice type
You can change the voice type of slash voices; for example, if you want to change a slash voice 
from having stems to being stemless. You can also change the type to normal notes, which 
restores the original pitches you input, and change normal notes to rhythm slashes.

NOTE

This affects all notes in the same voice. If you only want to change the slash voice type of some 
notes, you must change the voice of those notes instead.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select a note in the voice whose slash type you want to change. You can do this in Write 
mode and Engrave mode.

2. Choose Edit > Notations > Voices > Rhythmic Slashes > [Voice type].

For example, to change a whole normal voice to a stemless slash voice, choose Edit > 
Notations > Voices > Rhythmic Slashes > Slashes without Stems.

TIP

You can also choose these options from the context menu.

RESULT
The slash voice type of all notes in the same voice and flow as the selected note is changed.

If you change normal notes to a slash voice, they are all automatically positioned on a single staff 
line. By default in single-voice contexts, this is the middle line of the staff.

If you change rhythm slashes to normal notes, their original pitches are restored, meaning their 
staff positions reflect their pitches.

RELATED LINKS
Inputting notes into slash voices on page 233
Changing the voice of existing notes on page 477
Engrave toolbox on page 514
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Adding slash voices to percussion kits
You can add slash voices to percussion kits; for example, to show the desired rhythm for a 
passage without specifying the instruments to be played. You can add multiple slash voices to 
the same kit, including slash voices with and without stems.

NOTE

Rhythm slashes in percussion kits only appear when the five-line staff presentation is used. They 
do not appear in grid or single-line instrument presentations.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the percussion kit 
to which you want to add slash voices.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. In the action bar below the five-line staff editor, click the button that corresponds to the type 
of slash voice you want to add.

● Slashes with stems 

● Slashes without stems 

RESULT
The corresponding type of slash voice is added to the kit. It is positioned on the middle line of the 
staff by default.

During note input, you can move the caret to slash voices just like moving it to other instruments 
in the kit, and input notes into slash voices just like inputting notes in percussion kit instruments.

AFTER COMPLETING THIS TASK
You can change the staff position of slash voices in the kit.

RELATED LINKS
Percussion kit presentation types on page 1694
Voices in percussion kits on page 1701
Players panel on page 111
Edit Percussion Kit dialog on page 155
Inputting notes for unpitched percussion on page 238
Changing the positions of instruments within percussion kits on page 160

Including/Excluding slash voices in playback
By default, notes in slash voices are not played back. You can include/exclude all notes in slash 
voices project-wide in playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Repeats.

3. In the Rhythm Slashes section, activate/deactivate Play slash voices.

4. Click Apply, then Close.
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RESULT
All notes in slash voices project-wide are included in playback when Play slash voices is 
activated, and excluded when it is deactivated. When slash voices are included in playback, notes 
in slash voices play back with their input pitch.

RELATED LINKS
Playback Options dialog on page 842
Repeats in playback on page 640
Inputting notes into slash voices on page 233
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Rests

Rests are markings with a rhythmic value that indicate no note is played for that duration. Each 
note duration has an equivalent rest; for example, a quarter note rest is different to a sixteenth 
note rest.

All notes and rests within a bar must add up to the duration of the bar, according to the 
prevailing time signature. Dorico Pro automatically fills the gaps between notes with implicit 
rests of the appropriate duration. Therefore, it is usually not necessary to input rests in Dorico 
Pro.

The table shows some examples of notes and the rests with the equivalent rhythmic value.

Duration Note Rest

Half

Quarter

Eighth

Sixteenth

RELATED LINKS
Inputting rests on page 246
Deleting rests on page 1493
Inputting notes on page 221
Rests within beams on page 1016
Note and rest grouping on page 1021
Implicit rests in multiple-voice contexts on page 1489
Showing figured bass on rests on page 1142

General placement conventions for rests
Rests are positioned at the rhythmic position at the start of their duration, and not in the middle 
of beats as this can cause confusion over when the rest begins and ends. Rests are aligned with 
other items at the same rhythmic position.

The only exception is whole bar rests, which are positioned at the visual center of bars. This way, 
they are clearly distinguishable from half note and whole note rests that are followed by notes in 
the same bar.
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Rests stay within the staff wherever possible. They do not move above or below the staff when 
the notes around them are very high or very low.

However, on staves with multiple voices, rests are placed higher on the staff, or above the staff, 
for up-stem voices and lower on the staff, or below the staff, for down-stem voices.

Example rest positions in a multiple-voice context

Rests in multiple voices must not overlap. You can consolidate rests so that only one is shown 
when multiple voices have a rest of the same duration at the same rhythmic position.

The precise vertical positioning of rests is limited, as their detailed shapes require specific 
positions relative to staff lines and staff spaces.

RELATED LINKS
Voices on page 1704
Inputting notes into multiple voices on page 231
Creating cross-staff beams/tremolos on page 1009

Implicit vs. explicit rests
Implicit rests are automatically shown between the notes you input, and their duration 
automatically follows the time signature and their position in the bar. Explicit rests are rests that 
are explicitly entered during note input by forcing their duration, or rests that were imported 
from a MusicXML file.

Dorico Pro notates implicit rests according to the prevailing time signature; for example, 
different implicit rests are shown in 6/8 compared to 4/4. This also applies if you later change the 
time signature for existing notes and rests.

Therefore, it is not necessary to input rests in Dorico Pro, as implicit rests are automatically 
shown around the notes that you input. You can turn implicit rests into explicit rests by forcing 
their duration to be fixed.

A quarter note input at the fourth eighth note of 
the bar in a 6/8 time signature has a dotted quarter 
implicit rest at the start of the bar.

A quarter note input at the fourth eighth note of the 
bar in a 4/4 time signature has two implicit rests, a 
quarter and an eighth, at the start of the bar.

Explicit rests cannot be suppressed when using the Starts voice and Ends voice properties to 
hide rests before the first note in voices and after the last note in voices.

You can show rest colors to see which rests are implicit and which are explicit in your project.

Rests
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RELATED LINKS
Inputting rests on page 246
Inputting notes on page 221
Deleting rests on page 1493
Forcing the duration of notes/rests on page 262
Turning explicit rests into implicit rests on page 1490
Hiding/Showing rest colors on page 1491

Implicit rests in multiple-voice contexts
In Dorico Pro, implicit rests are shown automatically to fill in rhythmic positions around notes, 
including when there are multiple voices on the staff. However, in these contexts you might want 
more control over when and where rests are shown.

Usually, rests or notes are shown for whole bars when voices contain at least one note in the bar. 
This helps make the rhythmic position of every note in all voices in the bar immediately clear.

When there are multiple voices on a staff, implicit rests are shown in every bar in which there are 
notes of any duration in more than one voice. Bar rests are always shown for the first voice on a 
staff, including in bars that only contain notes in a slash voice.

However, there might be circumstances in which you do not want to show rests either before the 
first note in a voice or after the last note in a voice when there are multiple voices on the staff. 
For example, it can be useful to hide rests when a voice is being used to show passing notes 
within a bar that otherwise contains a single melodic line.

A second voice used to notate passing notes

You can choose when rests are shown in a number of different multiple-voice contexts in each 
flow independently on the Rests page in Notation Options.

You can also delete rests from selected passages.

TIP

By default, Dorico Pro consolidates rests when multiple voices have rests of the same duration at 
the same rhythmic position.

You can show multiple rests at individual rhythmic positions by changing the vertical position of 
rests. You can also change your per-flow settings for the consolidation of rests in multiple-voice 
contexts on the Rests page in Notation Options.
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A phrase with multiple voices showing implicit rests. The same phrase without implicit rests.

RELATED LINKS
Notation Options dialog on page 837
Per-flow notation options for rests on page 1490
Moving rests vertically on page 1492
Deleting rests on page 1493
Slash voices on page 1483

Turning explicit rests into implicit rests
Implicit rests and explicit rests behave differently. For example, you can hide implicit rests using 
the Properties panel, but you cannot hide explicit rests or rests with forced durations.

NOTE

You can only hide implicit rests using Starts voice and Ends voice in the Notes and Rests group 
of the Properties panel.

PROCEDURE

1. In Write mode, select the explicit rests you want to turn into implicit rests.

2. Press Backspace or Delete .

RESULT
The selected explicit rests are now implicit rests. You can check this by showing rest colors.

RELATED LINKS
Hiding/Showing rest colors on page 1491
Deleting rests on page 1493

Per-flow notation options for rests
You can find per-flow options controlling how rests are positioned and notated, and when rests 
are shown, on the Rests page in Notation Options.

For example, you can change whether bar rests are shown in additional voices, when dotted 
rests are permitted, and the default positions of rests in different contexts. You can also change 
whether rests of the same duration and at the same rhythmic position in different voices are 
consolidated into a single rest.

Musical examples demonstrate how each option affects the appearance of your music.
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RELATED LINKS
Notation Options dialog on page 837
Voices on page 1704
Per-flow notation options for voices on page 1705
Stem direction on page 1274

Project-wide engraving options for rests
You can find options for the project-wide appearance of rests on the Rests page in Engraving 
Options.

The options on the Rests page allow you to change the style, appearance, width, and precise 
position of rests. You can also change the appearance and design of multi-bar rests, such as 
choosing to hide or show H-bars and bar counts on single bar rests and how to display multi-bar 
rests at the end of flows. For example, the default appearance of multi-bar rests at the end of 
flows is to show “tacet al fine”, but you can show the total bar count instead.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Hiding/Showing rest colors
You can hide/show rest colors, which causes implicit rests and explicit rests to appear with 
different colors.

When rest colors are shown, implicit rests appear gray and explicit rests appear black. For 
example, this can help diagnose why rests do not disappear when you activate Starts voice and 
Ends voice, as these properties only hide implicit rests.

PROCEDURE

● Choose View > Note And Rest Colors > Implicit Rests.

RESULT
Rest colors are hidden/shown.

EXAMPLE

Rest colors hidden Rest colors shown

AFTER COMPLETING THIS TASK
You can delete rests that you have identified as explicit rests. The implicit rests that replace them 
now respect the Starts voice and Ends voice properties.
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Moving rests vertically
You can change the vertical position of rests individually; for example, if you want to change 
the staff line from which a whole bar rest hangs, or you want to show rests for all voices at a 
particular rhythmic position. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

Moving rests vertically shows multiple rests at that rhythmic position if more than one voice on 
the staff has a rest of the same duration. By default, Dorico Pro consolidates coincident rests of 
the same duration in multiple-voice contexts and automatically positions rests in multiple-voice 
contexts to avoid collisions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the rests whose vertical positions you want to change, or rests at the rhythmic 
positions where you want to see rests for every voice. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Rest pos. in the Notes and Rests group.

3. Change the value in the value field.

RESULT
Increasing the value moves rests upwards, decreasing the value moves rests downwards. 
Position 0 is the middle line of the staff. If there are multiple voices on the staff with rests of 
the same duration at the same rhythmic position, multiple rests are now shown.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

● Deactivating Rest pos. returns the selected rests to their default positions.

● You can choose to show coincident rests of the same duration in every voice or only show 
one rest for all voices in the Rest positioning section of the Rests page in Notation 
Options.

● You can change the horizontal position of rests, and the spacing around them, in Engrave 
mode when Note Spacing  is activated, in the same ways as changing the position of 
notes.

RELATED LINKS
Notation Options dialog on page 837
Note spacing on page 599
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Deleting rests
You can delete both implicit rests and explicit rests; for example, if you want to hide rests before/
after notes in another voice used to show passing notes.

TIP

● If you want to delete rests because you want to remove the corresponding duration from the 
flow, you can instead delete bars/beats.

● If you want to delete rests because you do not want to show bar rests in empty bars, you can 
instead hide bar rests.

● If you want to delete rests because multiple rests of the same duration appear at the same 
position in multiple-voice contexts, you can choose to consolidate these rests in Notation 
Options > Rests > Rest Positioning.

PROCEDURE

1. In Write mode, select the rests you want to delete.

TIP

You can select rests individually, or make a larger selection that contains the rests you want 
to delete.

2. Choose Edit > Remove Rests.

RESULT
All rests in the selection are deleted. This is done by automatically activating Starts voice 
and Ends voice in the Notes and Rests group of the Properties panel on the notes or rests 
immediately to the right/left of deleted rests, so that no rests are shown in the selected regions.

NOTE

● You can show rests again later by selecting the notes or rests immediately to the right/left of 
deleted rests, then deactivating the corresponding Starts voice or Ends voice properties in 
the Notes and Rests group of the Properties panel.

● You can assign a key command for Remove Rests on the Key Commands page in 
Preferences.

● In layouts where no other notes, rests, or items with duration exist at rhythmic positions 
where you have deleted rests, Dorico Pro has nothing to use to calculate horizontal spacing. 
Therefore, such empty bars/beats can appear narrower.

Rests
Deleting rests 

1493
Dorico Pro 4.3.30



EXAMPLE

A phrase with multiple voices showing implicit rests. The same phrase after deleting the rests.

RELATED LINKS
Notation Options dialog on page 837
Implicit vs. explicit rests on page 1488
Large selections on page 428
Deleting bars/beats on page 962
Changing the width of empty bars on page 965
Note spacing on page 599
Changing the horizontal justification of final systems on page 709
Rests in cues on page 1098

Hiding/Showing bar rests in empty bars
You can hide/show bar rests in empty bars in each layout independently. For example, you can 
hide bar rests in full score layouts but show bar rests in part layouts.

Bar rests are usually shown in empty bars in music to indicate to performers that they have 
nothing to play. However, there are contexts in which it is preferable to hide bar rests in empty 
bars, and instead leave the bar completely empty.

For example, hiding bar rests in empty bars is sometimes the preferred visual aesthetic in large 
scores, so that it is quicker to identify bars containing music. You can also hide bar rests in 
layouts where you want to include other instructions, such as verbal indications for performers 
to do something other than play notated pitches.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar rests in empty 
bars.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Bar Rests and Multi-bar Rests section, activate/deactivate Show bar rests in empty 
bars.

5. Click Apply, then Close.
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RESULT
All bar rests in empty bars in the selected layouts are shown when the checkbox is activated, and 
hidden when the checkbox is deactivated.

RELATED LINKS
Hiding/Showing multi-bar rests on page 1496
Hiding/Showing bar rests in cues on page 1099

Hiding/Showing bar rests in additional voices
You can hide/show bar rests between notes or explicit rests in additional voices on a per-flow 
basis; for example, you might show bar rests in contrapuntal music to ensure each voice can be 
easily followed.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show bar rests in additional 
voices.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Rests.

4. In the Rests in Additional Voices section, choose one of the following options for Bar rests 
in additional voices:

● Show bar rests

● Omit bar rests

5. Optional: To show bar rests for each voice in empty bars, in the Rest Positioning section, 
choose Show every rest in each voice for Coincident rests of the same duration in 
opposing voices.

6. Click Apply, then Close.

RESULT
Bar rests are shown between notes and explicit rests in all voices in the selected flows when you 
choose Show bar rests, and hidden when you choose Omit bar rests.

NOTE

Show bar rests does not automatically show bar rests in empty bars before the first note or 
explicit rest in additional voices. For additional voices that do not start in the first bar, you must 
input a bar rest in the first bar manually.

RELATED LINKS
Per-flow notation options for rests on page 1490
Implicit vs. explicit rests on page 1488
Inputting notes into multiple voices on page 231
Inputting bar rests into specific voices on page 247
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Multi-bar rests
Multi-bar rests group two or more consecutive empty bars together into a single unit, commonly 
shown with a thick horizontal line positioned on the middle staff line, known as an “H-bar”. They 
can reduce the horizontal space required by multiple empty bars and make it easier for players 
to find their place in the music.

A multi-bar rest representing four empty bars

NOTE

Multi-bar rests are automatically split by items positioned within their range, such as system-
attached text, rehearsal marks, and holds and pauses. However, if items are positioned at the 
start of the first bar in a multi-bar rest, that bar remains part of the subsequent multi-bar rest.

You can hide/show multi-bar rests in each layout independently in Dorico Pro, and you can hide/
show bar number ranges below them.

By default, the multi-bar rest bar counts only appear once between the staves of grand staff 
instruments.

You can find options for the project-wide appearance, design, width, and content of multi-bar 
rests on the Rests page in Engraving Options.

RELATED LINKS
Hiding/Showing bar number ranges on multi-bar rests on page 984
Splitting multi-bar rests on page 1500
Engraving Options dialog on page 840

Hiding/Showing multi-bar rests
You can hide/show multi-bar rests in each layout independently, and choose whether or not to 
consolidate one-bar repeats. For example, you can hide multi-bar rests in full score layouts but 
show multi-bar rests in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show multi-bar rests.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Bar Rests and Multi-bar rests section, choose one of the following options for 
Consolidate:

● None

● Multi-bar Rests

● Multi-bar Rests and Bar Repeats
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5. Click Apply, then Close.

RESULT

● When you choose None, no multi-bar rests are shown in the selected layouts. Each empty 
bar is shown separately.

● When you choose Multi-bar Rests, any adjacent empty bars are consolidated into multi-bar 
rests in the selected layouts. However, bar repeats prevent the consolidation of multi-bar 
rests, even if there are no other notes in those bars.

● When you choose Multi-bar Rests and Bar Repeats, any adjacent empty bars or bars that 
only contain one-bar repeats are consolidated into multi-bar rests in the selected layouts. 
Multi-bar rest counts are also shown above consolidated one-bar repeats.

TIP

You can also hide/show H-bars and bar counts on all single bar rests project-wide in the Multi-
bar Rests section of the Rests page in Engraving Options.

RELATED LINKS
Bar repeats on page 1459
Hiding/Showing bar number ranges on multi-bar rests on page 984
Engraving Options dialog on page 840

Hiding/Showing tacet al fine on multi-bar rests at the end of flows
You can change the appearance of multi-bar rests that extend to the end of flows in all layouts 
project-wide. By default, multi-bar rests that extend to the end of flows show “tacet al fine” above 
the staff instead of the total bar count.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Rests.

3. In the Multi-bar Rests section, choose one of the following options for Multi-bar rests that 
extend to the end of the flow in the Appearance subsection:

● Show tacet al fine

● Show bar count

4. Optional: Change the value for Minimum number of bars’ rest at the end of flow to show 
‘tacet al fine’.

5. Click Apply, then Close.

RESULT
The appearance of all multi-bar rests at the end of flows is changed project-wide. Changing the 
value for Minimum number of bars’ rest at the end of flow to show ‘tacet al fine’ changes 
when “tacet al fine” is shown to only multi-bar rests containing the set number of bars or more.

RELATED LINKS
Engraving Options dialog on page 840
Tacets on page 739
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Hiding/Showing bar counts on single bar rests
By default, Dorico Pro shows a bar count on single bar rests in the same style as for multi-bar 
rests. You can hide/show bar counts on all single bar rests project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Rests.

3. In the Multi-bar Rests section, choose one of the following options for Bar count for single 
bar rests in the Appearance subsection:

● Show bar count

● No bar count

4. Click Apply, then Close.

Changing the width of multi-bar rest H-bars
You can change the width of individual multi-bar rest H-bars, independently of your project-wide 
settings. This allows you to control the exact positions of multi-bar rests; for example, when there 
are clef changes at the end of multi-bar rests.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the multi-bar rests whose width you want to change.

2. In the Properties panel, activate H-bar width delta in the Multi-bar Rests group.

3. Change the value in the value field.

RESULT
The width of the selected H-bars is changed. Increasing the value increases their width, 
decreasing the value decreases their width.

TIP

You can change the default width of all H-bars project-wide, including changing whether H-bars 
are inset from barlines or use a fixed width regardless of the width of bars, in Engraving 
Options > Rests > Multi-bar Rests > Design.

RELATED LINKS
Engrave toolbox on page 514
Properties panel on page 769
Casting off on page 728
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Moving multi-bar rest H-bars
You can move individual multi-bar rest H-bars horizontally, independently of your project-wide 
settings. This allows you to control the exact positions of multi-bar rests; for example, when there 
are clef changes at the end of multi-bar rests.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the multi-bar rests you want to move.

2. In the Properties panel, activate H-bar X offset in the Multi-bar Rests group.

3. Change the value in the value field.

RESULT
The selected H-bars are moved horizontally. Increasing the value moves H-bars to the right, 
decreasing the value moves H-bars to the left.

TIP

You can change the default width and position of all H-bars project-wide, including changing 
whether items at the start/end of multi-bar rests affect their horizontal position, in Engraving 
Options > Rests > Multi-bar Rests.

Changing the placement of multi-bar rest bar counts
You change the placement of bar counts on multi-bar rests to be either above or below the staff. 
For grand staff instruments, you can also choose to show bar counts only once between the 
staves or above/below each staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Rests.

3. In the Multi-bar Rests section, choose one of the following options for Placement for bar 
count on single staff instruments in the Appearance subsection:

● Above

● Below

4. Choose one of the following options for Bar count on grand staff instruments:

● Show between staves

● Show above or below each staff

5. Click Apply, then Close.
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Changing the font used for multi-bar rest bar counts
By default, bar counts on multi-bar rests use a bold, Arabic font that is similar in appearance 
to the digits in time signatures. You can change the font used for bar counts on multi-bar rests 
project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Rests.

3. In the Multi-bar Rests section, choose one of the following options for Bar count 
appearance in the Design subsection:

● Music font

● Plain font

4. Click Apply, then Close.

RESULT
The font style used for bar counts on multi-bar rests is changed project-wide.

TIP

You can edit different aspects of the font styles used for multi-bar rest bar counts in the Edit 
Font Styles dialog; for example, if you want to make the font italic or change the font size.

● Music font bar counts use Multi-bar Rest Bar Count Font, which must be SMuFL-compliant.

● Plain font bar counts use Multi-bar Rest Bar Count Plain Font.

RELATED LINKS
Edit Font Styles dialog on page 846

Splitting multi-bar rests
You can manually split multi-bar rests without showing any extra notation in the music. Splitting 
multi-bar rests affects all layouts in the project, including full scores and parts.

NOTE

Multi-bar rests are automatically split by items positioned within their range, such as system-
attached text, rehearsal marks, and holds and pauses.

PREREQUISITE

● You have opened a layout in the music area that either has items in the bars where you want 
to split multi-bar rests or in which multi-bar rests are hidden. You cannot select rhythmic 
positions within multi-bar rests.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item at the rhythmic position where you want to split multi-bar 
rests.

2. Choose Engrave > Split Multi-bar Rest.
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RESULT
All multi-bar rests in all layouts are split at the selected position. A signpost is shown at the 
position of the multi-bar rest split.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing signposts on page 454
Hiding/Showing multi-bar rests on page 1496
Switching between layouts on page 46
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Slurs

Slurs are tapered, curved lines that join notes to indicate legato articulation and phrasing.

Depending on the context and the instrument to which they apply, slurs can have additional 
meanings to simply marking phrases. For example, for wind players, a slur indicates that all the 
notes in the phrase are played in the same breath and without re-tonguing or re-articulating any 
notes. For string players, a slur indicates that all the notes in the phrase are played legato and 
under one bow. For singers, slurs indicate that more than one note is sung to the same syllable.

Slurs both above and below the staff, including a cross-staff slur

Dorico Pro automatically determines the appropriate endpoint position and curvature direction 
for slurs based on the notes within their ranges, but you can change this manually.

You can input any number of nested slurs.

NOTE

Slurs must not be confused with ties, which look superficially similar, but instead join notes of 
the same pitch to indicate that they are played as a single note. In that sense, ties are part of 
rhythmic notation, while slurs are considered articulation.

RELATED LINKS
Inputting slurs on page 273
Inputting nested slurs on page 1517
Ties vs. slurs on page 1622
Cross-staff and cross-voice slurs on page 1516
Elision slurs on page 1244
Slurs in playback on page 1530
Slur endpoint positions on page 1505
Slur curvature direction on page 1514
Changing the position of slurs relative to tie chains on page 1503
Project-wide engraving options for articulations on page 955
MIDI Import Options dialog on page 90
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Project-wide engraving options for slurs
You can find options for the project-wide appearance, position, and placement of slurs on the 
Slurs page in Engraving Options.

The options on the Slurs page allow you to change the direction, style, height, and thickness of 
slurs. You can also set precise values for the positions of slurs relative to noteheads, stems, stem 
flags, grace notes, and ties, and change the collision avoidance behavior of cross-staff slurs.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

General placement conventions for slurs
There are different conventions for the placement, endpoint position, shape, and curvature 
direction of slurs in various contexts.

RELATED LINKS
Slur endpoint positions on page 1505
Short slurs that cover large pitch ranges on page 1509
Slurs over system and frame breaks on page 1507
Slur curvature direction on page 1514

Slur position relative to tie chains
There are different conventions for the position of slurs relative to tie chains in music for modern 
use and historical editions.

Modern practice is for slurs to start on the first note in tie chains, and end on the last note in tie 
chains. This makes the full length of the phrase visually clear to the performer, which helps their 
performance, and is the default in Dorico Pro.

However, in historical editions, slurs might end on the first note in a tie chain, and start on the 
last note in a tie chain. Both of these changes save vertical space, as shorter slurs do not extend 
as far above or below a staff.

Slur starting on the first note and ending on the last 
note in tie chains

Slur starting on the last note and ending on the first 
note in tie chains

Changing the position of slurs relative to tie chains
You can change the position of individual slurs relative to tie chains, including slurs starting on 
grace notes. For example, slurs that start on the last note in tie chains and end on the first note 
in tie chains are shorter and require less vertical space.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the slurs whose position relative to tie chains you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slurs group:

● Start pos. in tie chain

● End pos. in tie chain

3. Choose one of the following options for each property:

● First note

● Last note

RESULT
The position of the selected slurs relative to tie chains is changed.

TIP

You can change the default position of all slurs relative to tie chains project-wide on the Slurs 
page in Engraving Options. There are different options for slurs between normal notes and 
slurs starting on grace notes.

Slur placement relative to grace notes
There are specific placement rules that affect slurs when they start from a grace note and end on 
a normal note immediately following the grace note.

These rules are:

● Slurs connect noteheads rather than stems.

● Slurs are scaled to match the proportions of grace notes.

● Slurs must not obscure ledger lines.

● Slurs are placed above notes if they would collide with the accidental of a standard note 
when placed below the notes.

You can adjust the values for the different parameters of the special placement rules. For 
example, you can change the vertical and horizontal offsets for the right-hand end of a grace 
note slur relative to the standard, full-sized notehead to which it is attached in the Grace Notes 
section of the Slurs page in Engraving Options.

NOTE

These rules do not apply when slurs attach to a standard note at any rhythmic position beyond 
the note immediately following the grace note.

Due to the general placement conventions of grace notes, slurs in Dorico Pro appear below grace 
notes and curve downwards by default. Slurs starting from grace notes only appear above notes 
and curve upwards in up-stem voices in multiple-voice contexts.

Slurs
General placement conventions for slurs 

1504
Dorico Pro 4.3.30



Slur curvature direction on grace notes in a single-
voice context

Slur curvature direction on grace notes in a multiple-
voice context

You can change the automatic placement of grace note slurs by changing the stem direction of 
a grace note, changing the direction of a slur, and using the slur handles in Engrave mode to 
adjust the position of a slur in finer detail.

RELATED LINKS
Changing the curvature direction of slurs on page 1515
Changing the stem direction of notes on page 1277
General placement conventions for grace notes on page 1194
Slurs in Engrave mode on page 1522
Changing the shape/angle of slurs on page 1524

Slur position relative to staff lines
Slur endpoints must not touch staff lines, and the high point of the arcs of slurs should not stop 
on staff lines.

This is the convention because a slur whose arc peaks on a staff line can create the appearance 
of a triangular wedge between the staff line and the curve of the slur. If a slur peaks on a staff 
line, you can adjust its height so that it peaks either above/below the staff.

NOTE

Although Dorico Pro automatically ensures slur endpoints do not touch staff lines, manual 
adjustments might be necessary to position the arcs of slurs correctly.

You can set a value for the minimum distance between slur endpoints and staff lines in the 
Avoiding Collisions section of the Slurs page in Engraving Options. The default position of slur 
endpoints relative to staff lines is 1/4 space above/below, to ensure the start/end points do not 
touch the staff line.

RELATED LINKS
Engraving Options dialog on page 840
Changing the height of slurs on page 1527

Slur endpoint positions
In order to avoid collisions, the default positions of slur endpoints vary depending on whether 
slurs are placed on the notehead side or stem side of notes, their position relative to staff lines, 
and whether articulations, ties, and other slurs exist at the same rhythmic position.

Slur endpoints relative to noteheads and stems

The default position of slur endpoints relative to noteheads is 1/2 space above a notehead in a 
space on the staff, and 1/4 space above a notehead on a line on the staff.

Slurs appear between the stems of unbeamed notes when placed on their stem side, and the 
default setting is for their endpoints to attach a short distance from the end of the stem.
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Slurs between the stems of unbeamed notes

You can change the vertical and horizontal offsets for the endpoints of all slurs project-wide in 
the Endpoint Positioning section of the Slurs page in Engraving Options. However, you might 
also need to reduce the value for Minimum gap inside slur curvature to avoid collisions in the 
Avoiding Collisions section, as endpoints cannot be closer to noteheads than this value.

Slur endpoints relative to notes with different stem directions

For slurs between notes with different stem directions, Dorico Pro positions their endpoints close 
to the notehead by default so that the shape and curvature direction of slurs reflects the rising or 
descending pitch contour of phrases, including when they span multiple staves.

Slur endpoints near noteheads Slur endpoints near stem ends

You can change whether Dorico Pro positions slur endpoints near noteheads or stem ends in the 
Endpoint Positioning section of the Slurs page in Engraving Options.

Slur endpoints relative to articulations

By default, articulations of force and stress are placed outside slur endpoints, and articulations of 
duration are placed inside slur endpoints, which automatically raises the endpoints. For example, 
accents and stress marks are placed outside the ends of slurs but staccato and tenuto marks are 
placed inside the ends of slurs.

Slurs are placed outside articulations on notes in the middle of slurs.

TIP

● You can position slur endpoints closer to all articulations project-wide by reducing the value 
for Minimum gap inside slur curvature to avoid collisions in the Avoiding Collisions 
section of the Slurs page in Engraving Options. You can also move individual slur endpoints 
in Engrave mode.

● You can change the default placement of all articulations relative to slur endpoints project-
wide in the Slurs section of the Articulations page in Engraving Options.

Slur endpoints relative to ties and other slurs

The default position of slur endpoints is 1/4 space above an existing slur that starts/ends on the 
same note.

You can change this by increasing/decreasing the value for Minimum vertical gap between two 
slurs starting or ending on the same note in the Avoiding Collisions section of the Slurs page 
in Engraving Options.

To make slurs appear closer to tied notes, you can adjust the values for slur endpoint position 
relative to noteheads.
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RELATED LINKS
Engraving Options dialog on page 840
Slurs in Engrave mode on page 1522
Changing the shape/angle of slurs on page 1524
Cross-staff and cross-voice slurs on page 1516
Nested slurs on page 1517
Stem direction on page 1274
Articulations on page 954
Changing the placement of articulations relative to slurs on page 959

Slurs over system and frame breaks
Slurs automatically cross system breaks and frame breaks, appearing in two parts on either side 
of the break.

By default, the endpoints of slurs that cross system/frame breaks are positioned at least 1/2 
space outside the outer staff line and at a suitable position based on the pitch contour of the 
phrase before/after the break; that is, indicating whether the phrase rises or falls after the break.

If multiple slurs cross the same system break or frame break, such as if a phrase split by a break 
contains nested slurs, the ends of the slurs are stacked automatically and spaced a minimum of 
1/2 space apart vertically.

The end of a system showing the first slur part; the 
end on the right indicates a continuation to the next 
system.

The start of the next system showing the second 
slur part; the end on the left indicates a continuation 
from the previous system.

You can determine whether or not Dorico Pro adjusts the vertical endpoint positions of slurs 
based on phrase contours in the Endpoint Positioning section of the Slurs page in Engraving 
Options.

In Engrave mode, you can move and edit each slur part separately. This allows you to adjust the 
start/end height of each slur part independently on each system.

Slur collision avoidance
By default, Dorico Pro automatically adjusts the shape and position of slurs to avoid collisions 
with items under their arc.

This means that if a notehead under a slur is either higher than the others under a slur curving 
upwards, or lower than the others under a slur curving downwards, the curvature of the slur is 
adjusted to avoid the collision and keep the notehead under the slur. You can manually disable 
collision avoidance for individual slurs.

In Engraving Options > Slurs > Avoiding Collisions, you can change how slurs are adjusted to 
avoid collisions, such as choosing a balance between changing the shape of slurs to compensate 
or moving the endpoints of a slur, and how asymmetrical slurs are allowed to be.
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Slur with collision avoidance activated (default) Slur with collision avoidance deactivated

Collision avoidance for cross-staff slurs

You can activate/deactivate collision avoidance for cross-staff slurs in Engraving Options > 
Slurs > Avoiding Collisions. When cross-staff slur collision avoidance is activated, you can allow/
disallow Dorico Pro to use the point at which notes cross to the other staff to determine the 
curvature of cross-staff slurs, which produces better shapes in most cases.

NOTE

● Due to the increased complexity in positioning slurs across staves, further manual 
adjustment in Engrave mode might be required.

● These settings does not apply to S-shaped slurs between staves, which do not have any 
collision avoidance.

Slurs bisecting flat accidentals

According to conventions in published music, slurs can bisect the stems of flat accidentals, but 
not sharps or naturals, to save vertical space.

You can choose not to allow slurs to bisect flat signs, or alter the maximum amount of the stems 
of flat signs that can protrude above slurs, on the Slurs page in Engraving Options.

RELATED LINKS
Cross-staff and cross-voice slurs on page 1516
Accidentals on page 942

Enabling/Disabling slur collision avoidance
You can allow or prevent individual slurs from automatically adjusting to avoid collisions, 
independently of your project-wide settings. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the slurs whose collision avoidance you want to enable/disable.

2. In the Properties panel, activate/deactivate Avoid collisions in the Slurs group.

Slurs
General placement conventions for slurs 

1508
Dorico Pro 4.3.30



3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected slurs avoid collisions when the checkbox is activated, and do not avoid collisions 
when the checkbox is deactivated. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

When the property is deactivated, slurs follow your project-wide setting for slur collision 
avoidance.

TIP

You can enable/disable slur collision avoidance for all cross-staff slurs project-wide in Engraving 
Options > Slurs > Avoiding Collisions.

You can also customize the default settings for the shape and endpoint positions of slurs that are 
avoiding collisions in this section.

RELATED LINKS
Engraving Options dialog on page 840
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Short slurs that cover large pitch ranges
When short slurs span large pitch ranges, they are significantly rotated to compensate. This can 
make the ends of short slurs appear too angular.

You can move the control point handles of slurs to improve their curves.

Of the three examples, the middle slur has the smoothest curve. The handles on the slur on the 
right have been moved poorly, making the curve far too angular.

In the bottom row, the positions of the handles are shown to indicate how each curve above was 
created.

Short slur spanning a large pitch 
range, without adjustment

The same slur with some shape 
adjustment, making the curve 
smoother

The same slur again with poor 
adjustment, making the curve too 
angular

Default slur handle placement Slur handle placement to create 
the corresponding slur

Slur handle placement to create 
the corresponding slur

TIP

When adjusting slur ends, you can achieve the best results using the following guidelines:
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● The control point at the lower end of the slur does not extend outside the width of the slur, 
as marked by its neighboring endpoint.

● The control point at the higher end of the slur does not form an angle greater than 90 
degrees relative to the endpoints. You can use the dashed lines to help you judge this.

You can adjust the shape of short slur ends in different ways:

● Project-wide, by increasing the value for Offset shoulders by fraction of half length of 
short slur in Engraving Options > Slurs > Design > Advanced Options.

● Individually, by activating Start handle offset and End handle offset in the Properties panel 
in Engrave mode, and changing their X values.

● Individually, by moving the handles of slurs in Engrave mode.

RELATED LINKS
Slurs in Engrave mode on page 1522
Slur shoulder offset on page 1528
Changing the shape/angle of slurs on page 1524

Slur styles
There are different styles of slurs available in Dorico Pro, which indicate different meanings and 
have different use cases.

The following options for slur style are available when you activate Style in the Slurs group of the 
Properties panel:

Solid
This is the default style for slurs. Slurs appear as tapered solid lines: thinner at the ends 
and thicker in the middle.

Dashed
Slurs appear as tapered dashed lines. Can be used to indicate an optional slur; for 
example, to recommend breathing/bowing patterns.

Dotted
Slurs appear as dotted lines. The dots are the same size and the same distance apart 
over the whole length of the slur.

Half-dashed start
The first halves of slurs appear as dashed lines, the second halves as solid lines. Used 
to denote that a slur was written incompletely in the source in critical editions.

Half-dashed end
The first halves of slurs appear as solid lines, the second halves as dashed lines. Used 
to denote that a slur was written incompletely in the source in critical editions.
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Editorial
Slurs appear as solid black lines, but with a smaller vertical line intersecting them 
exactly halfway along their length, perpendicular to the curve of the slur. Used to show 
that a slur was added by the editor and was not present in the original source.

TIP

You can set the precise parameters of each of these options project-wide on the Slurs page in 
Engraving Options. For example, you can change the length and width of the stroke in Editorial 
slurs, the diameter of dots and length of dashes, and the sizes of the gaps between dots and 
dashes.

Changing the style of slurs
You can change the style of individual slurs after they have been input. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose style you want to change. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Style in the Slurs group.

3. Select one of the following options from the menu:

● Solid

● Dashed

● Dotted

● Half-dashed start

● Half-dashed end

● Editorial

RESULT
The style of the selected slurs is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Changing the size of dashes/dots in slurs
You can change the length of dashes and the size of dots in dashed/dotted slurs individually, 
independently of your project-wide settings. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

These steps only apply to dashed/dotted slurs.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the dashed/dotted slurs whose dash length/dot size you want to 
change.

2. In the Properties panel, activate one of the following properties in the Slurs group:

● For dashed slurs, activate Dash length.

● For dotted slurs, activate Dot size.

3. Change the value in the value field.

RESULT
Increasing the value makes dashes longer and dots bigger, decreasing the value makes dashes 
shorter and dots smaller. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

TIP

You can change the default size of dashes/dots in all dashed/dotted slurs project-wide in 
Engraving Options > Slurs > Design > Advanced Options.

RELATED LINKS
Engraving Options dialog on page 840

Changing the size of gaps in dashed/dotted slurs
You can change the length of gaps in dashed/dotted slurs individually, independently of your 
project-wide settings. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. In Engrave mode, select the dashed/dotted slurs whose gap length you want to change.

2. In the Properties panel, activate one of the following properties in the Slurs group:

● For dashed slurs, activate Dash gap length.

● For dotted slurs, activate Dot gap length.

3. Change the values in the value fields.

RESULT
Increasing the values makes the gaps between dashes/dots larger. Decreasing the values makes 
the gaps between dashes/dots smaller. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

TIP

You can change the default length of the gaps between dashes/dots in all dashed/dotted slurs 
project-wide in Engraving Options > Slurs > Design > Advanced Options.

Changing individual slurs to flat slurs
Although they are not often used as standard, some publishers use flat slurs in order to reduce 
the vertical space occupied by slurs. You can change individual slurs to flat slurs, independently 
of your project-wide setting. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

NOTE

Short slurs, that is, slurs between only a few notes, can look odd as flat slurs, so it may not be 
appropriate to select the flat curvature style project-wide. However, it would also be unusual only 
to use flat slurs once or twice in a project. Therefore, we recommend that you avoid changing the 
curvature style for only one or two slurs in a project.

It can be more effective to modify them rather than changing their curvature style; for example, 
by making an individual slur thicker/thinner, adjusting the shoulder offset of slurs, or adjusting 
their height using their slur height handles in Engrave mode.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose curvature style you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Curvature type in the Slurs group.

3. Choose one of the following options:

● Normal (curved)

● Flat
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RESULT
The curvature style of the selected slurs is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

You can change the curvature style of all slurs project-wide in the Design section of the Slurs 
page in Engraving Options.

RELATED LINKS
Changing the thickness of slurs on page 1526
Changing the height of slurs on page 1527
Changing the shoulder offset of slurs on page 1529
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Slur curvature direction
Slurs can curve upwards, downwards, or have a multi-segment S-shape. Dorico Pro automatically 
determines the appropriate curvature direction for slurs based on the notes within their ranges, 
but you can change the curvature direction of slurs manually.

A slur on a single staff always curves upwards and is placed above the notes, unless all of the 
notes under the slur are up-stem, in which case it curves downwards and is placed below the 
notes. If a slur applies to a mixture of up-stem and down-stem notes, it is placed above the staff 
and curves upwards.

Examples of the slur direction changing according to the stem direction

The following options for slur curvature direction are available when you activate Direction in 
the Slurs group of the Properties panel:

Up

Forces slurs to curve upwards, and appear above notes.

Down

Forces slurs to curve downwards, and appear below notes.

Up/Down

Forces slurs to comprise two segments: the first curves upwards, the second curves 
downwards to create a mirrored S-shape. It is typically used when phrases start in the 
lower staff and end in the upper staff; for example, in piano parts.
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Down/Up

Forces slurs to comprise two segments: the first curves downwards, the second curves 
upwards to create an S-shape. It is typically used when phrases start in the upper staff 
and end in the lower staff; for example, in piano parts.

TIP

● You can set your preference for whether slurs follow the stem direction, or always appear 
above notes, on the Slurs page in Engraving Options.

● You can adjust the precise shapes of individual slurs, and each slur segment, in Engrave 
mode using the square handles on each slur.

● In jazz scores, slurs are sometimes treated as an articulation, so positioning all slurs above 
the staff is preferred.

RELATED LINKS
Engraving Options dialog on page 840
Slurs over system and frame breaks on page 1507
Cross-staff and cross-voice slurs on page 1516
Slurs in Engrave mode on page 1522

Changing the curvature direction of slurs
You can change the curvature direction of individual slurs so that they curve upwards, 
downwards, or have a multi-segment S-shape, independently of your project-wide settings. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose curvature direction you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Direction in the Slurs group.

3. Choose one of the following options:

● Up 

● Down 

● Up/Down  (mirrored S-shape)

● Down/Up  (S-shape)

RESULT
The curvature direction of the selected slurs is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.
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TIP

● You can adjust the precise shapes of slurs, and each slur segment, in Engrave mode using 
the handles on each slur.

● You can change the default curvature direction behavior of all slurs project-wide on the Slurs 
page in Engraving Options.

RELATED LINKS
Slurs in Engrave mode on page 1522
Changing the shape/angle of slurs on page 1524
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Cross-staff and cross-voice slurs
Cross-staff slurs start on one staff and end on another staff, and cross-voice slurs start in one 
voice and end in another voice.

Cross-staff slurs between two piano staves

Dorico Pro positions cross-staff and cross-voice slurs in the same way as it positions standard 
slurs. You can move and lengthen/shorten cross-staff and cross-voice slurs in the same ways as 
standard slurs; however, they do not behave in the same way. For example, you cannot move 
cross-voice slurs to notes on the same staff in other voices, and you cannot lengthen cross-voice 
slurs to notes on the same staff in other voices. You also cannot lengthen/shorten cross-voice 
slurs to notes in different voices to those in which the slur started/ended.

You can only move and lengthen/shorten cross-staff slurs to notes on the same staff as the 
corresponding endpoint. For example, if a cross-staff slur covers a phrase that starts on the 
bottom staff and ends on the upper staff, you can only shorten the cross-staff slur to the first 
note on the upper staff, you cannot shorten it to any notes on the bottom staff.

The different voices can be on the same staff, or on different staves.

By default, Dorico Pro adjusts cross-staff slurs to avoid collisions. You can change the collision 
avoidance of cross-staff slurs in the Avoiding Collisions section of the Slurs page in Engraving 
Options.

RELATED LINKS
Inputting slurs on page 273
Lengthening/Shortening items on page 436
Slur collision avoidance on page 1507
Slur endpoint positions on page 1505
Moving notes/items rhythmically on page 465
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Nested slurs
Nested slurs are two or more slurs used simultaneously, where the overarching slur shows the 
structure of the phrase and the inner slurs show the articulation within the phrase. They are also 
known as “slurs within slurs”.

Depending on the stem directions within the overarching outer slur and your settings on the 
Slurs page in Engraving Options, inner slurs may appear on the opposite side of the staff to the 
outer slur.

A phrase with nested slurs

If you want to change the default distance between the endpoints of nested slurs, you 
can increase/decrease the project-wide value for Minimum vertical gap between two slurs 
starting or ending on the same note in the Avoiding Collisions section of the Slurs page in 
Engraving Options.

You can input nested slurs in the same ways as inputting standard slurs. By default, Dorico Pro 
makes automatic adjustments to their positioning to avoid collisions.

RELATED LINKS
Slur collision avoidance on page 1507
Engraving Options dialog on page 840

Inputting nested slurs
You can input nested slurs, both during note input and by adding them to existing notes. You 
can also add nested slurs to existing notes on multiple staves at the same time and to notes 
in different voices or on different staves belonging to the same instrument; for example, when 
phrases span both staves of grand staff instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes you want to include in the outer slur.

TIP

● If you only select a single note, the slur connects that note to the next note in the 
same voice on the staff. To input slurs between notes in different voices, you must 
select both notes; for example, by selecting the first note then Ctrl/Cmd -clicking 
the second note.

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff slurs. However, you cannot create 
cross-staff slurs between different instruments.
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● You can select notes on multiple staves to input slurs on those staves 
simultaneously.

2. Optional: If you want to input slurs onto multiple staves at once, extend the caret to those 
staves.

3. Input or start the outer slur in any of the following ways:

● Press S .

● In the Notes panel, click Slur .

● In the Keyboard panel toolbar, click Slur .

4. Input the inner slur in one of the following ways:

● When adding nested slurs to existing notes: Select the notes within the outer slur that 
you want to place under an inner slur and press S  or click Slur  in the Notes panel.

● To start the inner slur on the same note as the outer slur during note input, press S  or 
click Slur  in the Notes panel.

● To start the inner slur on a later note during note input, input notes or advance the caret 
manually to where you want the inner slur to start, then press S  or click Slur  in the 
Notes panel.

NOTE

If you added nested slurs to existing notes, stop here.

5. During note input, input the notes you want to include in the inner slur.

The slurs extend automatically as you continue inputting notes, even if there are rests 
between the notes you input.

6. End the inner slur on the currently selected note in any of the following ways:

● Press Shift-S .

● In the Keyboard panel toolbar, click Slur .

7. Continue inputting notes.

8. Optional: Start/End other inner slurs.

9. End the outer slur on the currently selected note in any of the following ways:

● Press Shift-S .

● In the Keyboard panel toolbar, click Slur .

RESULT
During note input, slurs begin from the currently selected note on all staves across which the 
caret extends, not from the caret position. Slurs extend automatically as you input notes, and 
end on the currently selected note.

When adding slurs to existing notes, the selected notes are connected by slurs. For example, if 
you select two notes belonging to one instrument and two notes belonging to another, two slurs 
are input connecting the notes on each selected staff. If you selected notes on different staves 
belonging to the same instrument, a cross-staff slur is input.

Slurs are placed either above or below the notes, depending on the stem direction of the notes 
within the selection. Inner slurs can have different curvature directions to outer slurs. By default, 
Dorico Pro makes automatic adjustments to their positioning to avoid collisions.
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TIP

You can input the outer slur and inner slurs in any order as Dorico Pro automatically adjusts slurs 
so that shorter slurs are positioned within longer slurs, and ensures they do not collide.

RELATED LINKS
Inputting slurs on page 273
Changing the curvature direction of slurs on page 1515

Linked slurs
Slurs of the same duration at the same rhythmic position on multiple staves can be linked 
together. This happens automatically when you copy and paste slurs or material including slurs 
between staves, or enter them simultaneously.

If slurs are linked, moving one slur in the linked group moves any slurs linked to it in the same 
way. Similarly, lengthening or shortening a slur in a linked group lengthens or shortens any slurs 
linked to it in the same way. However, deleting one slur in a linked group only deletes the slur 
selected, not the whole group.

Linked slurs appear highlighted when any slur in the linked group is selected.

Linked slurs with the top slurs selected

You can also manually link and unlink slurs.

RELATED LINKS
Inputting slurs on page 273
Linked dynamics on page 1133
Disabling automatic linking of dynamics and slurs when pasting on page 464

Linking slurs together
Dorico Pro automatically links slurs of the same duration at the same rhythmic positions 
together when you copy and paste slurs or material including slurs between staves, or enter 
them simultaneously. However, you can also link slurs together manually.

PROCEDURE

1. In Write mode, select the slurs you want to link together.
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NOTE

Only slurs that have the same duration and start at the same position can be linked together.

2. Choose Edit > Notations > Slurs > Link. You can also choose this option from the context 
menu.

RESULT
The selected slurs are linked together.

Unlinking slurs
You can unlink slurs, including slurs that were linked automatically. For example, if you want to 
lengthen/shorten slurs independently of each other.

PROCEDURE

1. In Write mode, select a slur in each linked group that you want to unlink.

2. Choose Edit > Notations > Slurs > Unlink. You can also choose this option from the context 
menu.

RESULT
All slurs in the linked groups are unlinked. This applies to all layouts in which the slurs appear.

Slur segments
A standard slur consists of one segment. You can make more elaborate shapes with slurs with 
multiple segments; for example, to allow you to create more complex slur shapes than are 
possible with a single curved segment.

Adding more segments to a slur by default creates evenly spaced waves within its length. 
Therefore, having more segments makes each wave shorter.

Slur with eight segments

In Engrave mode, you can move each segment graphically as each segment has its own set of 
five square handles. These allow you to form slurs into unusual and complicated shapes.

NOTE

● You may find that you need more segments than there are curves in your planned shape, as 
in many cases you need a segment for each significant change of angle. In Dorico Pro, you 
can increase/decrease the number of segments in existing slurs.

● Handles on multi-segment slurs are connected between adjacent segments. Moving a 
connected control point causes the control point at the start/end of the next/previous 
segment to move the same amount in the opposite direction.
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An unusual slur shape created using five segments. The same slur, showing the positions of the handles 
of all five segments.

Changing the number of segments in individual slurs
You can change the number of segments in individual slurs; for example, to allow you to create 
slurs with unusual shapes. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the slurs whose number of segments you want to change.

2. In the Properties panel, activate Number of segments in the Slurs group.

3. Change the value in the value field.

RESULT
Increasing the value increases the number of slur segments. Decreasing the value decreases the 
number of slur segments. If the property scope was set to Locally, this change only takes effect 
in the current layout and frame chain.

AFTER COMPLETING THIS TASK
You can adjust the shape of slur segments in more detail using their handles.

NOTE

Handles on multi-segment slurs are connected to the corresponding type of handle on adjacent 
segments. Moving handles causes any connected handles to move the same amount in the 
opposite direction.

RELATED LINKS
Changing the shape/angle of slurs on page 1524
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Slurs in Engrave mode
In Engrave mode, each slur has five square handles that you can move independently. Some 
handles are connected to others, meaning moving one can affect the position of neighboring 
handles.

Slurs have the following handles in Engrave mode:

1 Left endpoint

2 Left control point

3 Slur height

4 Right control point

5 Right endpoint

For example, moving the left endpoint moves both the start of a slur and the other handles apart 
from the right endpoint. However, moving the right control point only causes the slur height 
handle to move as well. This gives you fine control over the shape of slurs, while ensuring the 
end result remains curved and smooth.

NOTE

Multi-segment slurs have additional links between control point handles that affect how they 
move in relation to other handles moving.

You can move these handles to change the shape of slurs with the keyboard, with the mouse, 
and by using properties in the Slurs group of the Properties panel. You can also change the 
angle of slurs without changing their overall shape.

RELATED LINKS
Slur height on page 1527
Slur shoulder offset on page 1528

Multi-segment slurs in Engrave mode
In Engrave mode, each segment in multi-segment slurs, such as S-shaped slurs, has handles just 
like standard slurs. This allows you to edit each segment of multi-segment slurs independently as 
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if they were separate slurs, but in order to maintain a consistent shape, moving certain handles 
causes other handles to move simultaneously.

Multi-segment slurs have the following handles in Engrave mode:

1 Left endpoint

2 Left control point

3 Slur height

4 Right control point

5 Center control point

6 Left control point

7 Slur height

8 Right control point

9 Right endpoint

You can select and move each handle in the same ways as for standard slurs; however, handles 
on multi-segment slurs are connected between adjacent segments. Moving a connected control 
point causes the control point at the start/end of the next/previous segment to move the same 
amount in the opposite direction. This avoids tight corners, ensuring that multi-segment slurs 
are always as smoothly and symmetrically curved as possible.

In multi-segment slurs, right control points are connected to the left control point in the adjacent 
segment. If there is no adjacent segment, the right/left control points next to the right/left 
endpoints can be moved independently. For example, in the labeled diagram, control point 4 is 
connected to control point 6, but control points 2 and 8 are not connected to another control 
point.

Similarly, moving the slur height handle causes the slur height handle on any adjacent segments 
to move the same amount in the opposite direction. For example, if you move the slur height 
handle on the middle segment of a slur with three segments, all three slur height handles are 
moved.
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EXAMPLE

The left control point is selected. Moving the selected left control point upwards and 
to the left causes the right control point on the 
adjacent segment to move downwards and to the 
right.

Changing the shape/angle of slurs
You can move slurs and slur handles graphically, allowing you to change the shape and/or angle 
of individual slurs; for example, to adjust an endpoint relative to an individual notehead. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

Changing the angle of slurs is useful, for example, if you want one end of a slur to start higher 
after a system break than its default position, as you can change the rotation of the slur while 
keeping all slur handles on the slur in the same positions relative to each other.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the whole slurs or individual slur handles you want to move in any 
of the following ways:

● Ctrl/Cmd -click multiple slurs.

● Ctrl/Cmd -click individual handles on multiple slurs.

● Select a whole slur and press Tab  to cycle through the handles until the one you want to 
move is selected.

● Click the handle you want to move.

NOTE

● To change the angle of slurs, select slur endpoints only.

● You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

● You cannot move whole slurs to the right/left, you can only move them upwards/
downwards.

2. Move the slurs or handles in any of the following ways:

● To move them a standard amount to the right, left, up, or down, press Alt/Opt  plus 
the corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move slurs/
handles to the left. This moves slurs/handles by 1/8 space per press.
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● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves slurs/handles by 1 space per press.

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves slurs/handles by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves slurs/handles by 1/32 
space per press.

● Click and drag whole slurs upwards/downwards.

● Click and drag handles in any direction.

RESULT
The selected slurs or slur handles are moved. Depending on the handles you selected and the 
directions in which you moved them, this can change the shape, angle, and/or proportional size 
of the corresponding slurs. If the property scope was set to Locally, this change only takes effect 
in the current layout and frame chain.

TIP

The following properties in the Slurs group of the Properties panel are activated automatically 
when you move the corresponding slur handles:

● Start offset moves the left endpoints of slurs. X moves them horizontally, Y moves them 
vertically.

● End offset moves the right endpoints of slurs. X moves them horizontally, Y moves them 
vertically.

● Start handle offset moves the left control points of slurs. X moves them horizontally, Y 
moves them vertically.

● End handle offset moves the right control points of slurs. X moves them horizontally, Y 
moves them vertically.

For example, if you move a whole slur upwards and to the right, all of its handles are moved so 
all properties are activated. You can also use these properties to change the shape of individual 
slurs by changing the values in the value fields.

Deactivating the properties resets the corresponding handles on the selected slurs to their 
default positions.

EXAMPLE

Slur with default angle and right endpoint selected Slur with changed angle after moving the right 
endpoint downwards

RELATED LINKS
Inputting slurs on page 273
Slur shoulder offset on page 1528
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Slurs over system and frame breaks on page 1507
Lengthening/Shortening items on page 436
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the thickness of slurs
You can change the thickness of individual slurs, including changing the thickness of the middle 
of slurs independently of the ends of slurs, independently of your project-wide settings. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the slurs whose thickness you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slurs group:

● End thickness

● Middle thickness

3. Change the values in the value fields.

RESULT
Increasing the values makes the corresponding part of the selected slurs thicker, decreasing the 
values makes the corresponding part of the selected slurs thinner. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

TIP

● Deactivating the properties returns the corresponding part of the selected slurs to their 
default thickness.

● You can change the default thickness of all slurs project-wide on the Slurs page in Engraving 
Options.

RELATED LINKS
Project-wide engraving options for slurs on page 1503
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Slur height
The height of slurs determines how far above/below notes slurs extend vertically.

Increasing the height of slurs makes them extend further from the staff. This gives them a 
rounder shape, which takes up more vertical space. Where vertical space is limited, there should 
be a balance between how curved slurs are, which can help readability for players, and ensuring 
staves do not overlap.

A long slur with default height A long slur with increased height

A long flat slur with default height A long flat slur with increased height

TIP

You can change the default height of all slurs project-wide in Engraving Options > Slurs > 
Design > Advanced Options. There are separate settings for short slurs and long slurs.

You can change the height of individual slurs in Engrave mode.

RELATED LINKS
Slurs over system and frame breaks on page 1507
Engraving Options dialog on page 840

Changing the height of slurs
You can change the height of individual slurs independently of your project-wide settings; for 
example, to reduce the height of a particularly long slur. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the slur height (middle) handle of the slurs whose height you want 
to change.

TIP

You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

2. Move the handles in any of the following ways:
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● To move them upwards/downwards a standard amount, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move handles 
upwards. This moves handles by 1/8 space per press.

● To move them upwards/downwards a large amount, press Ctrl/Cmd  plus the standard 
key command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves handles by 1 
space per press.

● To move them upwards/downwards a moderate amount, press Shift  plus the standard 
key command; for example, Shift-Alt/Opt-Up Arrow . This moves handles by 1/2 space 
per press.

● To move them upwards/downwards a small amount, press Ctrl/Cmd - Shift  plus the 
standard key command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves 
handles by 1/32 space per press.

● Click and drag them upwards/downwards.

RESULT
The height of the selected slurs is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

NOTE

● To maintain a visually pleasing and symmetrical curve when changing the height of slurs 
manually, you may need to move slur height handles to the right/left by a small amount, as 
well as upwards/downwards.

● Moving slur height handles to the right/left affects the shape of the whole slur.

● You can change the default height of all slurs project-wide in Engraving Options > Slurs > 
Design > Advanced Options. There are separate settings for short slurs and long slurs.

RELATED LINKS
Changing the shape/angle of slurs on page 1524
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Slur shoulder offset
Slur shoulders affect the angles of the curves of slurs as they taper towards an endpoint, because 
the tapered ends often approach noteheads at a steeper angle than that of a slur’s arch.

Increasing the shoulder offset makes the onset of the curve shallower, whereas decreasing the 
shoulder offset makes the onset steeper. The shoulder offset must therefore be balanced with 
the height of the slur in order to achieve the ideal curved shape.

A long slur with default shoulder 
offset of 1/3

A long slur with increased 
shoulder offset of 1.5

A long slur with decreased 
shoulder offset of -1/2

You can change the default shoulder offset of all slurs project-wide in Engraving Options > 
Slurs > Design > Advanced Options. There are separate settings for short, long, and flat slurs.

Slurs
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You can adjust the shoulders of individual slurs in Engrave mode.

Changing the shoulder offset of slurs
You can adjust the shoulders of individual slurs, independently of your project-wide settings, by 
moving their control point handles. You can move each control point independently. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select one of the control point handles on each of the slurs whose 
shoulders you want to adjust in any of the following ways:

● Select a whole slur and press Tab  to cycle through the handles until the one you want to 
move is selected.

● Click the handle you want to move.

● Ctrl/Cmd -click individual handles on multiple slurs.

TIP

You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

2. Move the handles in any of the following ways:

● To move them a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left. This moves handles by 1/8 space per press.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves handles by 1 space per press.

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves handles by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves handles by 1/32 space per 
press.

● Click and drag them in any direction.

3. Optional: Repeat steps 1 and 2 for the other control point handle on the slurs whose 
shoulders you want to adjust.

RESULT
The shoulder offset of the selected slurs is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

● The following properties in the Slurs group of the Properties panel are activated 
automatically when you move the corresponding slur handles:

● Start handle offset moves the left control points of slurs. X moves them horizontally, Y 
moves them vertically.

Slurs
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● End handle offset moves the right control points of slurs. X moves them horizontally, Y 
moves them vertically.

You can also use these properties to change the shoulder offset of individual slurs by 
changing the values in the value fields.

Deactivating the properties resets the corresponding handles on the selected slurs to their 
default positions.

● You can change the default shoulder offset of all slurs project-wide in Engraving Options > 
Slurs > Design > Advanced Options. There are separate settings for short, long, and flat 
slurs.

RELATED LINKS
Engraving Options dialog on page 840
Slurs in Engrave mode on page 1522

Slurs in playback
Slurs trigger the legato playing technique in playback. By default, this increases the length of the 
MIDI notes without affecting the notation of the music.

Slurred notes sound for 105% of the length indicated by their notated rhythm, as opposed to 
non-slurred notes which sound for 95% of their notated rhythm.

The final note of a slur sounds for 95% of its notated rhythm, as there is no slur after it and the 
legato technique is no longer required.

TIP

● You can change the default values for the sounding duration of slurred notes on the Timing 
page in Playback Options.

● You can enable independent voice playback for individual instruments to hear different 
sounds in different voices simultaneously; for example, if you have slurs in one voice and 
staccatos in another voice.

The example shows how MIDI note length, indicated by the filled, light-colored rectangles, is 
increased when slurs are used. The thin, darker rod shows the notated duration of each note. 
The first three notes are non-slurred, so the MIDI length rectangle is shorter than the line of the 
notated rhythm. The last four notes are slurred together, so the MIDI length is longer than the 
notated length in order to create the legato, slurred sound. However, the last note of the slurred 
group is not longer, as the last note of a slurred phrase is treated like a normal, non-slurred note.

A phrase in an instrument staff The same phrase in the piano roll editor

RELATED LINKS
Playback Options dialog on page 842
Played vs. notated note durations on page 793
Piano roll editor on page 784
Enabling independent voice playback on page 636
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Staff labels

Staff labels are used to identify the instruments playing the music on the corresponding staves, 
and are positioned to the left of systems, before the initial barline of each system. Staff labels are 
typically used in music containing multiple players.

It is usual to show instrument names in full in the staff labels for the first systems in each flow, 
and abbreviated instrument names in the staff labels of subsequent systems. Using abbreviated 
instrument names saves horizontal space, allowing you to include more music in each system.

Examples of staff labels on the first system in a flow

By default in Dorico Pro, staff labels show the instrument names set for each instrument. You 
can show player names in staff labels instead for each player in each layout independently; for 
example, for percussionists who play multiple instruments.

For players holding multiple instruments and showing instrument names in staff labels, the staff 
label shows the instrument they are currently playing. If the player changes instrument partway 
through a system, the name of the new instrument is shown above the staff at its first note and 
the staff label is updated at the start of the next system.

Dorico Pro includes the instrument transposition, or instrument pitch, in staff labels for 
transposing instruments by default. Transposing instruments are instruments whose sounding 
pitch is different to the notated pitch.

Part layouts by default do not show staff labels, as most parts only contain a single staff whose 
identity is clear from the context and the layout name. The layout name is shown at the top left 
of the first page in part layouts by default.

You can change when instrument transpositions, or instrument pitches, are shown in staff 
labels. You can also change whether the instrument transposition is shown before or after the 
instrument name in staff labels.

NOTE

● You do not need to number instruments in staff labels manually, as Dorico Pro automatically 
numbers instruments when there are multiple players of the same type holding instruments 
with identical names.

● Layout names are different to the instrument names used for staff labels.
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● Staff labels do not show all instruments held by players; for example, in the staff label for 
the first system. You should include a comprehensive instrumentation list that shows any 
doubling at the front of your score.

Staff labels imported from MusicXML files

When exporting MusicXML files from Cubase and importing them into Dorico Pro, you can 
improve the accuracy of the automatic instrument selection by changing the instrument names 
in the Cubase Score Editor to the same English instrument names that Dorico Pro uses before 
exporting the file.

RELATED LINKS
Player, layout, and instrument names on page 181
Transposing instruments on page 137
Instrument numbering on page 132
Changing instrument names on page 184
Renaming players on page 182
Divisi staff labels on page 1574
Staff labels on condensed staves on page 1546

Project-wide engraving options for staff labels
You can find options for the project-wide appearance and position of staff labels on the Staff 
Labels page in Engraving Options.

For example, you can change the distance between staff labels and the systemic barline and 
whether instruments are numbered using Arabic or Roman numerals. You can also determine 
whether one instrument name for identical adjacent instruments is grouped and shown justified 
between their staves or shown on each staff, and whether vocal staff labels use uppercase or title 
case letters. There are also options specifically for ossia staff labels and staff labels on condensed 
staves.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

TIP

You can change the length of staff labels shown on systems for each layout independently on the 
Staves and Systems page in Layout Options.

RELATED LINKS
Engraving Options dialog on page 840
Layout Options dialog on page 834

Hiding/Showing staff labels
You can show full or abbreviated instrument names in staff labels, or hide all staff labels entirely, 
in each layout independently. The first system in each flow and all subsequent systems can have 
different staff label lengths.

By default, full staff labels are shown on the first system of each flow and abbreviated staff labels 
are shown on subsequent systems in full score layouts. In part layouts, staff labels are not shown 
on any systems.

Staff labels
Project-wide engraving options for staff labels 
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PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show staff labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, choose one of the following options for Staff labels on first 
system:

● Full

● Abbreviated

● None

5. Choose one of the following options for Staff labels on subsequent systems:

● Full

● Abbreviated

● None

6. Click Apply, then Close.

RESULT
Staff labels are hidden/shown on the corresponding staves in the selected layouts.

● None hides staff labels.

● Full and Abbreviated show staff labels using the corresponding instrument name length.

TIP

These settings apply to each flow in the layout, not the project as a whole. If, for example, you 
want to show full staff labels on the first system in the first flow in your project, but want to show 
abbreviated staff labels on the first systems of all subsequent flows, we recommend choosing 
the setting appropriate for the most flows in the layout, then changing the length of staff labels 
at other positions as required.

AFTER COMPLETING THIS TASK

● You can change the full and short names for each instrument.

● You can change whether staff labels show instrument or player names for each player in 
each layout independently.

RELATED LINKS
Staff label contents on page 1535
Changing instrument names on page 184
Player, layout, and instrument names on page 181
Hiding/Showing divisi section numbers in staff labels on page 1576
Divisi staff labels on page 1574
Staff labels on condensed staves on page 1546
Staff labels for percussion kits on page 1545

Staff labels
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Changing the minimum indent for systems with staff labels
You can change the minimum indent for all systems that show staff labels to optimize horizontal 
space in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose minimum indent for systems with staff labels 
you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, change the value for Minimum indent for systems with staff 
labels.

5. Click Apply, then Close.

RESULT
The minimum indent on all systems that show staff labels is changed in the selected layouts.

RELATED LINKS
Changing the first system indent on page 1566
Moving the start/end of systems on page 608

Hiding/Showing staff labels at system/frame breaks
You can change whether staff labels at individual system/frame breaks show full, abbreviated, or 
no instrument names, independently of your per-layout settings. For example, if you want full 
staff labels at the start of the first flow but abbreviated staff labels at the start of subsequent 
flows, or if you want to show staff labels in choral music only on systems that contain more 
complicated parts, solo lines, or divisi lines.

PREREQUISITE

● You have inserted system/frame breaks at the positions from which you want to change the 
length of instrument names in staff labels.

● Signposts are shown for system/frame breaks.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the system/frame break signposts at the positions where you want 
to hide/show staff labels.

2. In the Properties panel, activate Staff labels in the Format group.

3. Select one of the following options from the menu:

● Full

● Abbreviated

Staff labels
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● None

RESULT
Staff labels are hidden/shown on the corresponding systems to the selected system/frame 
breaks. Horizontal spacing is automatically adjusted so the system fills the width of the music 
frame.

● None hides staff labels.

● Full and Abbreviated show staff labels using the corresponding instrument name length.

Deactivating the property returns any selected system break signposts to your per-layout 
settings.

EXAMPLE

Full staff labels shown No staff labels shown

RELATED LINKS
Engrave toolbox on page 514
Inserting system breaks on page 734
Inserting frame breaks on page 737
Hiding/Showing system break signposts on page 736
Hiding/Showing frame break signposts on page 739

Staff label contents
Staff labels can show the instrument names set for each instrument or the player name of the 
corresponding player. Staff labels can show full or short names.

Instrument numbers are automatically shown in both full and abbreviated staff labels that use 
instrument names.

● Full staff labels use full instrument/player names.

● Abbreviated staff labels use short instrument/player names.

● None shows no staff labels.

NOTE

● You can change the full and short names for each instrument and player.

● Renaming instruments and players does not change the name shown at the top of each part 
layout if you have already renamed the layout. You can rename layouts separately.

● You can choose to show periods after all abbreviated names in staff labels in Engraving 
Options > Staff Labels > Case. Traditionally, only abbreviations that do not end with the 
final letter of instrument names are followed by a period.

Staff labels
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RELATED LINKS
Player, layout, and instrument names on page 181
Instrument numbering on page 132
Changing instrument names on page 184
Renaming players on page 182
Renaming layouts on page 184
Instrument changes on page 134
Layout Options dialog on page 834
Engraving Options dialog on page 840

Showing instrument/player names in staff labels
You can change whether staff labels show instrument or player names for each player in each 
layout independently. For example, you can show the player names for percussionists in full 
score layouts and instrument names in percussion part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the contents of staff 
labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, in the Show player name instead of instrument names list, 
activate the checkbox for each player whose player name you want to show in staff labels.

5. Click Apply, then Close.

RESULT
Player names are shown for players when their checkbox is activated. Instrument names are 
shown for players when their checkbox is deactivated.

Full and short player names are used according to your staff label settings.

AFTER COMPLETING THIS TASK
You can change the full and short names for each instrument and player.

RELATED LINKS
Percussion kit presentation types on page 1694
Renaming groups in grid presentation percussion kits on page 159
Staff label paragraph styles on page 1544

Instrument transpositions in staff labels
Instrument transpositions indicate the interval between the note an instrument plays and the 
sounding note produced. Transposing instruments, such as Horn in F and Clarinet in B♭, are 
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commonly shown with their transposition, also known as their “instrument pitch”, as part of their 
instrument name or layout name.

Depending on the options set for Show transposition in the Edit Instrument Names dialog 
for each transposing instrument, they might show transpositions in staff labels even if you have 
hidden transpositions in staff labels in their layout.

Dorico Pro sets common transposing instruments, such as Clarinet in B♭ and Trumpet in B♭, to 
follow your per-layout settings for hiding/showing instrument transpositions in staff labels.

To reduce the risk of confusion, uncommon transposing instruments, such as Clarinet in A or 
Trumpet in E, are set to show their transposition in staff labels always, even if you have hidden 
instrument transpositions in the layout.

RELATED LINKS
Transposing instruments on page 137
Player, layout, and instrument names on page 181
Changing instrument names on page 184
Changing the language for instrument names on page 60
Hiding/Showing staff labels on page 1532

Hiding/Showing instrument transpositions in staff labels
You can hide/show instrument transpositions in staff labels in each layout independently. For 
example, you can hide instrument transpositions in staff labels in full score layouts but show 
them in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument 
transpositions in staff labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, activate/deactivate the following options for Instrument pitch 
or transposition:

● Show in full staff labels

● Show in abbreviated staff labels

5. Click Apply, then Close.

RESULT
Instrument transpositions are shown in staff labels of the corresponding length in the selected 
layouts when the corresponding checkbox is activated, and hidden when the corresponding 
checkbox is deactivated.

NOTE

Depending on the options set for Show transposition in the Edit Instrument Names dialog 
for each transposing instrument, they might show transpositions in staff labels even if you have 
hidden transpositions in staff labels in their layout.
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Changing the appearance/position of instrument transpositions in 
staff labels

You can change the appearance and position of instrument transpositions in staff labels in each 
layout independently. For example, if you want to show instrument transpositions on a separate 
line in part layouts, but on the same line and parenthesized in full score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose instrument transposition appearance/position 
you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, choose one of the following options for Position of instrument 
pitch in full staff labels:

● Start

● End

5. Optional: If you chose Start, enter the characters you want to appear as separators into the 
Separator between instrument pitch at start and name field.

6. Optional: If you chose End, activate/deactivate the following options:

● Show on separate line

● Show in parentheses

● Show instrument number before transposition

7. Click Apply, then Close.

RESULT
The appearance and position of instrument transpositions in staff labels is changed in the 
selected layouts.

EXAMPLE

Instrument transposition 
shown at start, with 
hyphen separator

Instrument transposition 
shown at end, on 
separate line

Instrument transposition 
shown at end, in 
parentheses

Instrument transposition 
shown at end, after 
instrument number
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RELATED LINKS
Changing the language for instrument names on page 60
Instrument numbering on page 132

Numbering instruments with different transpositions separately/
together

You can change whether instruments are numbered separately or together in all staff 
labels project-wide when you have multiple instruments of the same type but with different 
transpositions, such as two Horns in F and two Horns in D. By default, Dorico Pro numbers 
instruments with different transpositions separately.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staff Labels.

3. In the Numbering section, choose one of the following options for Numbering for similar 
instruments with different transpositions:

● Number separately

● Number together

4. Click Apply, then Close.

Hiding/Showing instrument change labels at the start of 
flows

You can hide/show instrument change labels at the start of each flow in each layout 
independently. These labels can be useful for players holding multiple instruments as a way of 
clarifying the instrument required in their part layouts, which do not normally show staff labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument change 
labels at the start of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, activate/deactivate Show instrument change label at 
start of flow.

5. Click Apply, then Close.

RESULT
Instrument change labels are shown in the first bar of each flow in the selected layouts when 
Show instrument change label at start of flow is activated, and hidden when it is deactivated.

RELATED LINKS
Instrument changes on page 134
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Grouping the staff labels of adjacent identical instruments
When multiple adjacent players hold the same instrument, you can group them so that there 
is only one instrument name for all staves with the instrument number shown beside each 
individual staff. You can group the instrument names of single players independently of section 
players.

By default, every staff is shown with its own staff label, including the appropriate instrument 
name.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staff Labels.

3. In the Numbering section, choose Group between staves for the following options, 
individually or together:

● Staff labels for identical adjacent instruments held by single players

● Staff labels for identical adjacent instruments held by section players

4. Choose one of the following options for Position of instrument names for grouped staff 
labels:

● Center instrument name vertically

● Align instrument name with first staff

5. Click Apply, then Close.

RESULT
One instrument name is shown for all identical adjacent instruments held by the corresponding 
type of players in all layouts project-wide. It appears either justified between the staves or 
aligned with the first staff.

EXAMPLE

Two violin staves shown with 
separate staff labels

Instrument name grouped 
between the two violin staves

Instrument name grouped and 
aligned with the first violin staff

Changing the staff label numbering style
You can change the staff label numbering style of single and section players independently; for 
example, if you want single players to use Arabic numerals, such as “2”, and section players to 
use Roman numerals, such as “II”.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.
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2. In the category list, click Staff Labels.

3. In the Numbering section, choose one of the following options for Numbering style for 
single players:

● Arabic numerals

● Roman numerals

4. Choose one of the following options for Numbering style for section players:

● Arabic numerals

● Roman numerals

5. Click Apply, then Close.

RESULT
Instruments held by single and section players use the selected numbering style in all layouts 
project-wide.

RELATED LINKS
Instrument numbering on page 132
Staff labels on condensed staves on page 1546
Condensing on page 743

Showing vocal staff labels in uppercase/title case
You can show the staff labels on vocal staves in uppercase letters or in title case. Many European 
publishers prefer vocal staves to have staff labels with capital letters, but this is not true of all 
publishers.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staff Labels.

3. In the Case section, choose one of the following options for Labels for vocal staves:

● Shown in uppercase

● Shown in title case

4. Click Apply, then Close.

RESULT
Staff labels on all vocal staves project-wide use either uppercase letters or title case.

Staff labels
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Player group labels
Player group labels show the names of player groups as vertical text on vertical brackets to the 
left of staff labels. They allow you to identify groups of staves and are typically used in large-scale 
works, such as for orchestra and double choir.

Player group labels to the left of staff labels, showing sections in an orchestra

Player group labels show full player group names by default. Short player group names are used 
when the full player group name is longer than the bracket.

You can show player group labels in each layout independently.

TIP

● You can change the appearance and position of brackets on player group labels in 
Engraving Options > Staff Labels > Player Group Labels.

● Player group labels use the Player Group Labels paragraph style, which you can edit in the 
Paragraph Styles dialog.

RELATED LINKS
Player groups on page 162
Renaming player groups on page 164
Brackets and braces on page 1023
Staff label paragraph styles on page 1544
Paragraph Styles dialog on page 848
Engraving Options dialog on page 840
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Hiding/Showing player group labels
You can hide/show player group labels in each layout independently. For example, if you want 
to show player group labels for choirs in the full score layout but hide them in the vocal score 
layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show player group labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, activate/deactivate Show player group names.

5. Click Apply, then Close.

RESULT
Player group labels are shown in the selected layouts when Show player group names is 
activated, and hidden when it is deactivated.

Hiding/Showing brackets for player group labels
You can hide/show brackets for all player group labels project-wide; for example, if you want to 
show player group labels without brackets.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staff Labels.

3. In the Player Group Labels section, choose one of the following options for Appearance of 
player group labels:

● Show bracket

● Do not show bracket

4. Click Apply, then Close.

Changing the position of player group names relative to brackets
You can change the position of player group names relative to brackets when player group labels 
are shown. Player group names can appear superimposed on brackets or inside brackets; that is, 
to the right of the bracket.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staff Labels.

3. In the Player Group Labels section, choose one of the following options for Position of 
player group label relative to bracket:

● Superimpose on bracket

Staff labels
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● Inside bracket

4. Click Apply, then Close.

RELATED LINKS
Lines on page 1402
Changing the placement of text relative to lines on page 1419
Engraving Options dialog on page 840

Staff label paragraph styles
Staff labels use paragraph styles to format their fonts, including their size, spacing, alignment, 
and other formatting options. When staff labels contain multiple separate parts, such as when 
the instrument name and instrument number have different vertical positions, you can format 
each part separately.

The following paragraph styles are used for staff labels:

1 Player Group Labels: Used for player group labels.

2 Staff Labels: The default style used for staff labels that have the instrument/player name 
and number aligned and next to each other. It is also used for the group labels on 
divisi staves, groups in grid presentation percussion kits, and for instrument/player names 
grouped between multiple identical instruments or between player numbers in staff labels 
on condensed staves.

3 Staff Labels (Inner): Used for individual staves within divisi groups, instrument numbers 
when instrument names are aligned between multiple identical instruments, and player 
numbers in staff labels on condensed staves.

4 Staff Labels (Percussion Grid): Used for individual instruments in grid presentation 
percussion kits.

You can edit each paragraph style independently of each other in the Paragraph Styles dialog; 
for example, if you want outer staff labels to be left-aligned but inner staff labels to be right-
aligned.

TIP

You can make further changes to the appearance and alignment of staff labels on divisi staves at 
each individual divisi change.
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RELATED LINKS
Paragraph Styles dialog on page 848
Staff labels on condensed staves on page 1546
Divisi staff labels on page 1574
Divisi change labels on page 1577
Player labels on page 760
Player group labels on page 1542

Staff labels for percussion kits
The staff labels shown for percussion kit staves depend on how kits are presented in your 
project. Kits can be presented as five-line staves, grids, and as single-line instruments.

Percussion kit presentation 
type

Staff label Example

5-line staff Single instrument name using 
the instrument name of the 
percussion kit.

Grid Multiple instrument names: 
one for each kit instrument, 
positioned at the staff 
position of the corresponding 
instrument.

Group names are centered 
between instruments in each 
group.

Staff labels for individual 
instruments in grids use a 
smaller font and a different 
paragraph style than used 
for standard instrument staff 
labels. Groups in grids use the 
standard staff label paragraph 
style.

Single-line instruments Multiple instrument names: 
one for each kit instrument, 
positioned beside the 
corresponding single-line 
staff.

Staff labels for single-line 
instruments use the same font 
and paragraph style as used 
for standard instrument staff 
labels.
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You can change the player names, layout names, and instrument names of percussion kits in 
the same ways as for other players and instruments. However, to change the staff labels for 
percussion kits, you must change kit instrument names in different ways for percussion kits, 
depending on your percussion kit presentation type:

● 5-line staff: Open the Edit Instrument Names dialog from the Players panel in Setup mode, 
or use the Name field in the Edit Percussion Kit dialog, to change the name of the kit.

● Grid/Single-line instruments: Open the Edit Instrument Names dialog from inside the Edit 
Percussion Kit dialog in Setup mode to change the names of individual instruments.

The same instrument name fields and options are available for kit instruments as for standard 
pitched instruments.

NOTE

Smaller staff labels for each line in grid presentations use the Staff Labels (Percussion Grid) 
paragraph style. You can edit this paragraph style in the Paragraph Styles dialog.

RELATED LINKS
Edit Instrument Names dialog on page 185
Player, layout, and instrument names on page 181
Renaming groups in grid presentation percussion kits on page 159
Edit Percussion Kit dialog on page 155
Creating groups of instruments within grid presentation percussion kits on page 158
Unpitched percussion on page 1682
Percussion kit presentation types on page 1694

Staff labels on condensed staves
Staff labels on condensed staves must reflect all the players included on the staff. Dorico Pro 
automatically consolidates identical instrument names in staff labels on condensed staves but 
always shows all the required player numbers.

On condensed staves containing different types of instruments or instruments with different 
names, all required instrument names are shown.
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Staff labels on condensed brass staves

Because condensing can change frequently, staff labels on condensed staves can vary from one 
system to another. The staff labels for condensed divisi staves reflect the divisions at the start of 
the system and show instrument names. You can choose to show divisi group names instead of 
instrument names and change how player numbers are stacked in staff labels on all condensed 
staves project-wide.

Dorico Pro also shows player labels above/below condensed staves to identify the players to 
which notes on condensed staves belong, as condensing can change within a single system. 
For condensed divisi staves, Dorico Pro shows the player labels “div.”, with any required 
qualifications, and your set unison indication where each division starts and ends respectively.

NOTE

Your setting for the grouping of staff labels of adjacent identical instruments applies to adjacent 
condensed staves with the same instruments and condensed divisi staves, such as if you have a 
condensed staff for Flutes 1-2 and a separate staff for Flute 3.

Your settings for staff label numbering styles also apply to condensed staves.

RELATED LINKS
Hiding/Showing staff labels on page 1532
Player labels on page 760
Divisi change labels on page 1577
Condensing on page 743
Enabling/Disabling condensing on page 710
Changing the staff label numbering style on page 1540
Showing divisi group/instrument names in condensed staff labels on page 1548
Grouping the staff labels of adjacent identical instruments on page 1540
Changing the default to/unison indications on page 762
Player, layout, and instrument names on page 181
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Changing number stacking in condensed staff labels
You can change how player numbers on condensed staves are stacked; for example, if you 
always want them stacked vertically, including on systems where players are condensed into a 
single voice.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staff Labels.

3. In the Numbering section, choose one of the following options for Player numbers for 
condensed players:

● Stack vertically

● Stack horizontally

4. Optional: If you chose Stack vertically, choose one of the following options for When 
stacking player numbers for condensed players vertically:

● Consider stem allocation

● Ignore stem allocation

5. Click Apply, then Close.

RESULT
The stacking of player numbers in all staff labels on condensed staves is changed project-wide.

Showing divisi group/instrument names in condensed staff labels
By default, staff labels for condensed divisi staves show instrument names. You can show divisi 
group names in all condensed staff labels project-wide where divisi groups exist instead; for 
example, if your divisi group names describe the players included in the condensed staff better.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staff Labels.

3. In the Numbering section, choose one of the following options for Staff labels for 
condensed divisi sections:

● Use group names if available

● Use instrument name

4. Click Apply, then Close.

RESULT
The name shown in staff labels on condensed divisi staves is changed project-wide.

RELATED LINKS
Condensing on page 743
Staff labels on condensed staves on page 1546
Divisi on page 1567
Divisi staff labels on page 1574
Inputting divisi changes on page 1570
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Staves

A staff is a line or group of lines on which musical notes are notated to indicate the pitch 
and rhythm of music. Pitched instruments use the traditional five-line staff and unpitched 
instruments often use a single-line staff.

Notes are positioned on the lines and in the spaces on five-line staves, and can also use ledger 
lines above/below the staff to represent pitches that cannot fit on the staff.

A phrase on a five-line staff The same phrase on a single-line staff

The pitch and register of notes on five-line staves are determined by clefs, which can also be 
combined with octave lines to indicate what pitches performers play.

On five-line staves for unpitched percussion instruments, the different staff positions correspond 
to different percussion instruments.

Because it is often necessary to have different staff sizes in different layouts depending on their 
type, such as having smaller staves in full score layouts than in part layouts, in Dorico Pro you 
can change various aspects of staves in Layout Options.

RELATED LINKS
Page formatting on page 689
Layout Options dialog on page 834
Clefs on page 1070
Octave lines on page 1079
Percussion kit presentation types on page 1694
Hiding/Showing empty staves on page 696
Hiding/Showing blank staves after final flows on page 699
Extra staves on page 1552
Ossia staves on page 1556
Adding extra staves on page 1553
Deleting staves on page 1551
Adding players on page 125
Adding instruments to players on page 138
Condensing on page 743
Divisi on page 1567
System dividers on page 1562
System objects on page 1563
System indents on page 1565

1549
Dorico Pro 4.3.30



Per-layout options for staves
You can change settings that affect the staves in each layout independently.

You can change the size of staves in each layout in the Space Size section of the Page Setup 
page in Layout Options.

You can change other aspects of staves on the Staves and Systems page in Layout Options. 
For example, you can change which staff labels are shown on systems, indent the first system of 
each flow, and fix the number of bars included in each system. You can also select above which 
staves system objects appear, according to their instrument families.

NOTE

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

● System objects are only shown above bracketed groups in your project. If you have no 
brackets, system objects only appear at the top of systems.

RELATED LINKS
Page formatting on page 689
Layout Options dialog on page 834
Staff size on page 716
System objects on page 1563
Hiding/Showing empty staves on page 696
Hiding/Showing system dividers on page 1562
Edit Font Styles dialog on page 846
Brackets and braces on page 1023

Changing the thickness of staff lines
You can change the thickness of staff lines project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staves.

3. In the Staff Lines section, change the value for Staff line thickness.

4. Click Apply, then Close.

RESULT
The thickness of staff lines project-wide is changed. Increasing the value for Staff line thickness 
makes staff lines thicker, decreasing the value makes staff lines thinner.
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Deleting staves
You can delete staves from any rhythmic position so they are no longer shown in any layout; for 
example, to end a passage with an extra staff and return to the standard number of staves.

PROCEDURE

1. In Write mode, select an item on the staff you want to delete, at the rhythmic position from 
which you want to delete it.

NOTE

You can only delete one staff at a time.

2. Choose Edit > Notations > Staff > Remove Staff. You can also choose this option from the 
context menu.

RESULT
The selected staff is deleted from the selected rhythmic position, and a signpost appears 
indicating the staff change. The staff is deleted until the next staff change signpost that applies 
to that staff or the end of the flow, whichever comes first.

NOTE

● If you delete staves without deleting the music on them, that music still exists and is 
included in playback. If you later add staves at the same position, the music reappears.

● You cannot delete all staves of an instrument as at least one must always appear. If you 
do not want to see any staves for a particular instrument in a layout, you can instead hide 
empty staves in that layout.

EXAMPLE

A three-staff piano with the bottom staff deleted in the second bar

RELATED LINKS
Extra staves on page 1552
Adding extra staves on page 1553
Hiding/Showing empty staves on page 696
Condensing on page 743
Divisi on page 1567
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Deleting extra/ossia staves
You can delete extra and ossia staves so they are no longer shown in any layout, but without 
automatically deleting the music on them. For example, if you had previously added extra staves 
for a passage but no longer want them.

PROCEDURE

1. In Write mode, select the signposts at the start/end of the extra/ossia staves you want to 
delete.

2. Press Backspace or Delete .

RESULT
The selected extra/ossia staves are removed and no longer appear in any layouts in which that 
player appears.

NOTE

If you delete staves without deleting the music on them, that music still exists and is included in 
playback. If you later add staves at the same position, the music reappears.

RELATED LINKS
Adding extra staves on page 1553
Ossia staves on page 1556
Adding ossia staves on page 1557
Hiding/Showing ossia staves on page 1559

Extra staves
In Dorico Pro, you can add extra staves to any instrument; for example, to make complex 
contrapuntal music easier to read because it is spread out across more staves than usual for that 
instrument.

An extract of Debussy's piano prelude "Feuilles mortes" with three staves

When you add extra staves, they exist for the whole flow. However, you can control exactly 
where they appear, as often extra staves are only needed for short sections. Extra staves can end 
immediately, and so are followed by white space until the end of the system, or can fill the width 
of the system, even if they do not contain music for part of the system.
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Signposts are automatically added when you add or remove extra staves, indicating the number 
of staves added or removed at that position. If multiple staff changes happen at the same 
rhythmic position, they are all shown in the same signpost.

An extract of Debussy's piano prelude "Feuilles mortes" with three staff change signposts

You can use these signposts to change the start/end positions of extra staves; for example, if you 
want to lengthen or shorten the region where an extra staff is shown. You can also use these 
signposts to delete extra staves.

Dorico Pro also allows you to change the number of staves in different ways according to the 
intended purpose of the staves, with dedicated features for each type.

● Extra staves are full-sized staves belonging to a single player.

● Ossia staves are small staves belonging to any type of player.

● Divisi staves are full-sized staves belonging to a section player.

NOTE

Extra staves prevent instruments from condensing in the systems where extra staves exist.

RELATED LINKS
Showing extra staves across whole systems on page 1555
Ossia staves on page 1556
Divisi on page 1567
Condensing on page 743
Voice-specific dynamics on page 1115
Hiding/Showing empty staves on page 696
Signposts on page 453

Adding extra staves
You can add extra staves both above and below instruments that belong to single players, and 
show them for both limited sections or for the entire flow. For example, some complex piano 
music requires three staves rather than two to display the music clearly.

NOTE

● If you want to add extra staves to notate a divisi passage or to show an alternative 
interpretation, you can use the dedicated divisi and ossia staff features instead.

● You can add as many staves above/below instruments as you like, but only one at a time. You 
must also select an item on one of the original staves of the instrument to add additional 
staves, not on any existing extra staves you have added.
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● You can only add extra staves to instruments held by single players. You cannot add extra 
staves to instruments that belong to section players or percussion kits.

● Extra staves prevent instruments from condensing in the systems where extra staves exist.

PROCEDURE

1. In Write mode, select an item on one of the instrument’s original staves and at the rhythmic 
position where you want to add an extra staff.

2. Add an extra staff in one of the following ways:

● Choose Edit > Notations > Staff > Add Staff Above.

● Choose Edit > Notations > Staff > Add Staff Below.

TIP

You can also choose these options from the context menu.

3. Optional: Repeat steps 1 and 2 as many times as you like.

RESULT
An extra full-sized staff is added either above or below the selected staff, starting at the earliest 
rhythmic position you selected and lasting until the end of the flow. A signpost appears at its 
start position, indicating the number of staves that have been added.

TIP

By default, extra staves do not extend to the start/end of systems, meaning they start/stop in the 
middle of systems.

If you want extra staves to extend to the start/end of systems automatically regardless of their 
rhythmic start/end positions, you can show extra staves across whole systems in each layout 
independently.

EXAMPLE

Piano with an extra staff added above the top staff in the second bar

RELATED LINKS
Ossia staves on page 1556
Hiding/Showing blank staves after final flows on page 699
Showing blank staves in frames on page 700
Deleting staves on page 1551
Deleting extra/ossia staves on page 1552
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Showing extra staves across whole systems
By default, extra staves are only shown from where they begin and until where they end. You 
can change this setting so that extra staves fill the full width of any system on which they appear 
instead, in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to show extra staves across the full 
width of systems.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Ossias and Extra Staves section, activate Show extra staves across full system 
when starting or stopping.

5. Click Apply, then Close.

RESULT
Extra staves in the selected layouts always fill the full width of any system on which they appear.

Deactivating the option returns layouts to showing extra staves only for the duration specified by 
their signposts.

EXAMPLE

Extra staff not shown across the full width of the 
system

Extra staff shown across the full width of the system

RELATED LINKS
Moving notes/items rhythmically on page 465
Hiding/Showing empty staves on page 696
Signposts on page 453
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Ossia staves
Ossia staves are smaller staves shown above/below the main staff of an instrument. They are 
used to show alternative phrases that can be played instead of the original phrase, such as 
suggestions for ornaments, alternative notations from other sources, or an easier version.

An ossia staff below the left-hand piano staff shows an easier alternative

In Dorico Pro, you can add ossia staves both above and below instrumental staves for specific 
durations only, and their formatting is handled automatically. Vertical spacing is adjusted around 
ossia staves automatically.

Signposts are automatically added when you add or remove ossia staves, indicating the number 
of staves added or removed at that position. If multiple staff changes happen at the same 
rhythmic position, they are all shown in the same signpost.

An ossia staff with signposts shown

By default, ossia staves are scaled to two thirds the size of a regular staff. Because this is a scale 
factor rather than a fixed staff size, ossia staves automatically adjust according to the staff size, 
which you can set per layout, per section, and per player.

NOTE

● Music on ossia staves is not played back.

● Ossia staves prevent instruments from condensing in the systems where ossia staves exist.

RELATED LINKS
Extra staves on page 1552
Deleting extra/ossia staves on page 1552
Changing the size of ossia staves on page 1557
Ossia staff labels on page 1560
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Hiding/Showing ossia staves in the preamble on page 1558
Hiding/Showing ossia staves on page 1559
Changing the placement of system objects relative to ossia staves on page 1565
Condensing on page 743

Adding ossia staves
You can add ossia staves for single and section players, both above and below existing staves. 
For grand staff instruments, you can add ossias with up to two staves.

NOTE

● You cannot add ossia staves to percussion kit instruments.

● Although instruments can show ossias both above and below staves, only one ossia can exist 
on each side of the staff at a time.

● Ossia staves prevent instruments from condensing in the systems where ossia staves exist.

PROCEDURE

1. In Write mode, select items on the staff that span the duration above/below which you want 
to add an ossia staff.

NOTE

If you want to add a two-staff ossia, you must select items on both instrumental staves.

2. Add an ossia staff in any of the following ways:

● Choose Edit > Notations > Staff > Create Ossia Above.

● Choose Edit > Notations > Staff > Create Ossia Below.

TIP

You can also choose these options from the context menu.

RESULT
An ossia is added above/below the selected staff that lasts for the selected range. One signpost 
appears at the start of the ossia passage, and another appears where the ossia staff ends.

TIP

You can select these signposts and move them to change the start/end positions of ossia staves.

Changing the size of ossia staves
By default, ossia staves are scaled to two thirds the size of a regular staff. You can change the 
scale factor of all ossia staves project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staves.

3. In the Ossias section, change the value for Ossia scale factor.
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4. Click Apply, then Close.

RESULT
The scale factor of ossia staves relative to the prevailing staff size is changed in all layouts 
project-wide.

RELATED LINKS
Staff size on page 716

Changing the padding on ossias that start/end mid-bar
You can change how far staff lines extend beyond the left/right of ossia staves that begin/end in 
the middle of bars. Padding such ossia staves ensures that notes, accidentals, rhythm dots, and 
other items are always shown on staff lines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Staves.

3. In the Ossias section, change the values for the following options, individually or together:

● Extend staff lines at start of ossia

● Extend staff lines at end of ossia

4. Click Apply, then Close.

RESULT
The padding before and/or after ossia staves that start/end mid-bar is changed project-wide.

EXAMPLE

Ossia staff with no padding Ossia staff with padding set to 3 both at the start 
and end

Hiding/Showing ossia staves in the preamble
You can include ossia staves in, or exclude them from, the preamble when they cross system/
frame breaks in each layout independently.

Showing ossia staves in the fixed preamble means their clefs and time signatures appear 
alongside all the regular staves at the start of each system. As this can suggest the ossia staff is 
an additional instrument, it is common to exclude ossia staves from the fixed preamble.
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PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show ossia staves in the 
preamble.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Ossias and Extra Staves section, choose one of the following options for Ossias 
crossing a system break:

● Include in preamble

● Exclude from preamble

5. Click Apply, then Close.

RESULT
Preamble notations for ossia staves are hidden in the main preamble in the selected layouts 
when you choose Exclude from preamble, and shown when you choose Include in preamble.

EXAMPLE

Ossia included in the preamble Ossia excluded from the preamble

Hiding/Showing ossia staves
By default, ossia staves appear in all layouts. You can change the layouts in which ossia staves 
are shown; for example, if you want ossia staves to appear in the part layout but not in the full 
score.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show ossia staves.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.
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4. In the Ossias and Extra Staves section, activate/deactivate Show ossias.

5. Click Apply, then Close.

RESULT
Ossias are shown in the selected layouts when Show ossias is activated, and hidden when it is 
deactivated.

Barlines on ossia staves
There are different conventions for whether ossias are connected to their corresponding staves 
with barlines, and if so, which type of barline should be used.

If an ossia both starts and ends at barlines, the following accepted conventions exist among 
different publishers:

● Barlines join the ossia to the main staff at both its start and end

● A barline joins the ossia to the main staff only at its end

● The ossia does not join to the main staff at all

When an ossia is joined to the main staff, some publishers use the same kind of barline as used 
for the other staves, which is typically a single barline, whereas other publishers use a dashed 
barline.

Dorico Pro provides options to accommodate all of these conventions in the Ossias section of the 
Barlines page in Engraving Options.

NOTE

When an ossia appears between the main staves of an instrument, for example, below the 
right-hand staff of a piano, then the ossia is joined with the same barline as the main staves, 
regardless of your chosen settings on the Barlines page in Engraving Options.

RELATED LINKS
Barlines on page 967
Project-wide engraving options for barlines on page 967
Engraving Options dialog on page 840

Ossia staff labels
Ossias can show staff labels like normal staves, the only difference being that staff labels on ossia 
staves are typically drawn within the system to the left of where the ossia starts, even if this is in 
the middle of a system, rather than behind the initial barline.

Ossia staff labels use the Ossia Staff Label font style, which you can edit in the Edit Font Styles 
dialog.
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An ossia staff with the default staff label

Ossia staff labels are positioned according to the distances set in the Ossias section of the 
Staves page in Engraving Options. There are separate options for labels before single ossias 
and braced two-staff ossias.

RELATED LINKS
Edit Font Styles dialog on page 846
Engraving Options dialog on page 840

Hiding/Showing staff labels on ossia staves
You can hide/show staff labels on ossia staves in each layout independently, and you can show 
the default staff label or enter a custom ossia label.

The default staff label on ossia staves is “ossia”.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show staff labels on ossia 
staves.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Ossias and Extra Staves section, activate/deactivate Show label before ossia.

5. Optional: If you activated Show label before ossia, choose one of the following staff label 
options:

● Default

● Custom

6. Optional: If you chose Custom, enter the staff label you want into the Custom ossia label 
field.

7. Click Apply, then Close.

RESULT
Staff labels are hidden/shown in the selected layouts.
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RELATED LINKS
Ossia staff labels on page 1560

System dividers
System dividers are used to clarify the separation of different systems when they appear on the 
same page. They are usually shown as two thick, parallel angled lines positioned to the left of 
initial barlines.

In Dorico Pro, the outer edges of system dividers are aligned with the corresponding edges of 
music frames.

A system divider between two systems in a string quartet score

You can show system dividers in different circumstances and change their appearance in each 
layout independently. You can also change their default insets in all layouts project-wide on the 
System Dividers page in Engraving Options.

Hiding/Showing system dividers
You can change the circumstances in which system dividers are shown, including specifying the 
minimum number of players required to show them, in each layout independently. For example, 
if you only want to show system dividers between systems that contain different numbers of 
staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show system dividers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Dividers section, activate/deactivate Show system dividers.

5. If you activated Show system dividers, choose one of the following options:

● To show system dividers only between systems containing more than a set number of 
staves, choose When min. staves exceeded.

● To show system dividers between all systems in flows that contain more than a set 
number of players, choose When min. players exceeded.

● To show system dividers only between systems containing different numbers of staves, 
When number of staves differs.
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6. Optional: Do one of the following:

● If you chose When min. staves exceeded, change the value for Minimum number of 
staves in system.

● If you chose When min. players exceeded, change the value for Minimum number of 
players.

7. Click Apply, then Close.

RESULT

● If you deactivated Show system dividers, system dividers are hidden in the selected layouts.

● If you activated Show system dividers, system dividers are shown in the corresponding 
circumstances in the selected layouts.

RELATED LINKS
Hiding/Showing empty staves on page 696

Changing the length of system dividers
You can change the length of system dividers in each layout independently; for example, if you 
want to show longer system dividers in layouts that show full staff labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to show system dividers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Dividers section, choose one of the following options for Appearance:

● Default

● Long

● Extra long

5. Click Apply, then Close.

System objects
System objects are items that apply to all staves in the system and appear in all layouts, but 
are not necessary to show on every staff in full score layouts. For example, tempo marks and 
rehearsal marks are important for all players to see in their parts, but would cause an orchestral 
full score to appear very cluttered if they were shown on every staff.

In Dorico Pro, the following items are considered system objects:

● Rehearsal marks

● Repeat endings

● Repeat markers

● System-attached text
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● Tempo marks

● Time signatures shown above the staff

● Horizontal lines that apply to all staves

System objects automatically appear at least once in all layouts. You can show system objects 
at multiple positions in each system by showing them above multiple instrument families. For 
example, you might show them above the woodwind, brass, percussion, and string families. In 
an orchestral full score, this would ensure system objects are spread out evenly across the page, 
meaning no staff is very far from these important markings. You can also show rehearsal marks 
and repeat endings additionally below the bottom staff.

NOTE

● System objects are only shown above instrument families that are bracketed or braced 
together. You can change bracket grouping in each layout independently. You can also 
bracket or brace specific staves together using custom bracket/brace grouping.

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

RELATED LINKS
Changing bracket grouping according to ensemble type on page 1025
Custom staff grouping on page 1030
Edit Font Styles dialog on page 846
Brackets and braces on page 1023
Rehearsal marks on page 1424
Tempo marks on page 1587
Repeat endings on page 1440
Large time signatures on page 1645
Inputting text items on page 388

Changing the positions of system objects
You can show system objects above different instrument families in each layout independently. 
Multiple items are categorized as system objects, including system-attached text, rehearsal 
marks, tempo marks, repeat markers, and repeat endings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the instrument families 
above which system objects appear.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Objects section, activate the checkboxes for the instrument families above 
which you want system objects to appear.

5. Activate/Deactivate the following options for Also show below bottom staff:

● Repeat endings

● Rehearsal marks
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6. Click Apply, then Close.

RESULT
System objects appear above the top staff in each bracketed group you select, provided a 
bracketed group for that instrument family is included in the selected layouts. If you activated 
options for Also show below bottom staff, the corresponding notations additionally appear 
below the bottom staff.

NOTE

System objects are only shown above instrument families that are bracketed or braced together. 
You can change bracket grouping in each layout independently. You can also bracket or brace 
specific staves together using custom bracket/brace grouping.

RELATED LINKS
System objects on page 1563

Changing the placement of system objects relative to ossia staves
You can change whether system objects are placed between main staves and their ossia staves 
or above ossia staves in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the placement of system 
objects relative to ossia staves.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Ossias and Extra Staves section, choose one of the following options for Position of 
system objects relative to ossia above staff:

● Inside ossia

● Outside ossia

5. Click Apply, then Close.

System indents
System indents control the distance between the left page margin and the start of systems of 
music. According to tradition, the first system in part layouts is indented, but in modern use this 
is not always necessary.

According to convention, coda sections at the start of new systems are also indented. Dorico Pro 
uses the same gap size before the start of codas whether they occur partway through systems or 
at the start of a new system.
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A violin part with the first system indented

In Dorico Pro, system indents automatically adjust to accommodate staff labels. For example, if a 
system contains a staff label that is significantly longer than the minimum system indent, Dorico 
Pro increases the indent on that system to ensure the staff label remains legible and is not cut off 
on the left edge or collides with the music.

You can change both the minimum indent on systems with staff labels and the first system 
indent in each layout independently. You can also adjust the system indent at both the start and 
end of individual systems, independently of your per-layout settings.

RELATED LINKS
Changing the minimum indent for systems with staff labels on page 1534
Changing the gap before codas on page 1455
Hiding/Showing staff labels on page 1532
Moving the start/end of systems on page 608
Changing the horizontal justification of final systems on page 709

Changing the first system indent
By default in Dorico Pro, the first system of each flow is indented in part layouts. You can change 
the indent for the first system of all flows in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose first system indent you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, change the value for Indent first system of flow by.

5. Click Apply, then Close.

RESULT
The indent of the first system of all flows is changed in the selected layouts.
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Divisi

Divisi is when players split, or “divide”, in order to play multiple lines of music, commonly for a 
limited passage, before returning to play together, or “tutti”. Divisi passages can be notated with 
all lines on a single staff or across multiple staves.

Divisi is a technique most commonly used in orchestral string writing, as the string section 
typically contains a large number of players compared to the number of staves. For example, 
large orchestras commonly have twelve first violins all playing the same part most of the time. 
Dividing those players into multiple parts allows composers to write more complex contrapuntal 
music.

An example divisi change in a Violin I part, splitting it into two sections and a solo line

If the division is relatively simple, it is possible to write all parts on the same staff and label the 
section, with an indication of how many players are required for each line if necessary. If the 
parts have different rhythms at times, you can input them into separate voices on the same staff.

However, when a section is divided into multiple parts that are too different to be clearly written 
on a single staff, it is necessary to divide them onto multiple staves. In Dorico Pro, you can create 
divisi changes for specific regions. This allows you not only to divide sections into any number of 
parts with any number of staves, but also to include solo lines and group staves as required. You 
can input divisi changes on any staff belonging to a section player.

NOTE

● You cannot input divisi changes on staves belonging to single players. If you want to notate 
music for a single player across multiple staves, you can add extra staves instead.

● The number of staves in a system is defined by the first divisi change in the system, including 
prevailing divisi changes from previous systems. If you input a new divisi change partway 
through a system with an existing divisi change active at its start, the number of staves is not 
changed to reflect the new divisi change until the next system.

When divisi passages start/end partway through systems, Dorico Pro automatically extends the 
extra staves to the start or end of the system, and duplicates the regions where the section is 
tutti automatically using unison ranges.

Divisi changes apply to all layouts, but you can condense divisi staves differently in each layout.
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TIP

If you want to show the parts for multiple single players on the same staff, you can use 
condensing.

RELATED LINKS
Unison ranges on page 1572
Divisi staff labels on page 1574
Divisi change labels on page 1577
Extra staves on page 1552
Inputting notes into multiple voices on page 231
Condensing on page 743
Enabling/Disabling condensing on page 710

Change Divisi dialog
The Change Divisi dialog allows you to change how section players are divided and change the 
appearance and grouping of staff labels.

● You can open the Change Divisi dialog by selecting an item on a section player’s staff and 
choosing Edit > Notations > Staff > Change Divisi.

The Change Divisi dialog contains the following sections and options:
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1 Divisions section

Shows the current divisions and groups for the selected section player at the selected 
rhythmic position.

2 Groups

Shows any groups of divisions you have created. Grouping sections together gives you more 
flexibility in how the staves are labelled.

3 Divisions

Shows each current individual division. Each division corresponds to a separate staff.

4 Action bar

Contains options that allow you to change the number and arrangement of divisions.

● Add Solo Division : Adds a solo staff. Dorico Pro automatically adds solo staves above 
section staves.

● Add Section Division : Adds a section division. Dorico Pro automatically adds new 
section divisions below existing sections.

● Add Group : Groups the selected solo or section divisions together.

● Delete Division or Group : Deletes the selected section divisions or groups.

NOTE

If you delete a divisi change without deleting any music on it, that music is no longer 
shown but still exists. If you later recreate a division of the same type at the same 
position, the music reappears.

5 Staff labels section

Displays the current staff label for the selected division or group and allows you to edit it, 
independently of your default staff label paragraph style settings.

6 Editing

For groups only, this option allows you to switch between editing the Full Name and Short 
Name of the selected group.

Full Name is used for Full staff labels, Short Name is used for Abbreviated staff labels.

7 Text editor options

Allows you to customize the font, size, and formatting of the staff label of the selected 
division or group, independently of the formatting of the corresponding paragraph style.

8 Text editing area

Shows the current staff label for the selected division or group. You can select any part of the 
staff label and edit it independently of other parts; for example, if you want the numbers to 
use a different font to the instrument name.

Divisi staff labels are right-aligned by default, so appear at the right edge of the text editing 
area.

9 Staff label visibility options

Allow you to customize when the different parts of divisi staff labels are shown, 
independently of your per-layout settings for hiding/showing staff labels and divisi section 
numbers in staff labels.

● Follow Options: The corresponding part of divisi staff labels follows your per-layout 
settings for staff labels.

● Show: The corresponding part of divisi staff labels is always shown, regardless of your 
per-layout settings.
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● Hide: The corresponding part of divisi staff labels is always hidden, regardless of your 
per-layout settings.

RELATED LINKS
Staff label paragraph styles on page 1544
Divisi staff labels on page 1574
Hiding/Showing staff labels on page 1532
Hiding/Showing divisi section numbers in staff labels on page 1576
Text editor options in Write mode on page 389

Inputting divisi changes
You can input divisi changes on any section player staff. Divisi changes can last for any duration 
and include any number of staves.

NOTE

● You cannot input divisi changes on staves belonging to single players. If you want to notate 
music for a single player across multiple staves, you can add extra staves instead.

● Divisi changes apply in all applicable layouts. However, you can condense divisi changes in 
each layout independently.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position from which you want to divide.

2. Choose Edit > Notations > Staff > Change Divisi to open the Change Divisi dialog. You can 
also choose this option from the context menu.

3. In the Change Divisi dialog, create the divisi you want.

For example, if you want to divide the player into two sections, click Add Section Division.

4. Optional: Edit the staff labels.

5. Click OK.

RESULT
The selected staff is divided into the number and types of staves specified in the Change Divisi 
dialog, either from the caret position during note input or from the selected item outside of note 
input. A signpost is shown at the position of the divisi change.

The divisi change applies from the selected item until the next existing divisi change or the end 
of the flow, whichever comes first. It appears in all applicable layouts.

If the divisi change occurs partway through a system, any extra staves are automatically shown 
across the whole system. A unison range is created automatically to replicate any tutti material 
onto all staves added by the divisi change.

Divisi changes start new phrases for condensing from their rhythmic position.

NOTE

The number of staves in a system is defined by the first divisi change in the system, including 
prevailing divisi changes from previous systems. If you input a new divisi change partway 
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through a system with an existing divisi change active at its start, the number of staves is not 
changed to reflect the new divisi change until the next system.

AFTER COMPLETING THIS TASK

● You can input further divisi changes at any position or end the divisi passage.

● You can enable condensing for selected layouts, including condensing divisi staves.

RELATED LINKS
Divisi staff labels on page 1574
Ending divisi passages on page 1572
Enabling/Disabling condensing on page 710
Condensing calculations and considerations on page 747
Staff labels on condensed staves on page 1546

Editing existing divisi changes
You can edit divisi changes after you have input them; for example, if you want to add a solo line 
in addition to an existing section division.

PROCEDURE

1. In Write mode, double-click the signpost of the existing divisi change you want to edit to 
open the Change Divisi dialog.

2. In the Change Divisi dialog, edit the divisi change.

3. Optional: Edit the staff labels.

4. Click OK.

RESULT
The selected divisi change is updated.

If you added extra divisions to the divisi change, those staves are added to the region to which 
the divisi change applies.

If you removed divisions from the divisi change, those staves are removed from the region to 
which the divisi change applies.

NOTE

Removing divisi sections does not automatically delete music previously on the staff. Even 
though removed staves no longer appear, any notes left on them still play back. If you later 
restore the staff, the notes are also restored.

If you do not want to hear notes on divisi staves you have removed, we recommend deleting all 
music from the staves first.

RELATED LINKS
Change Divisi dialog on page 1568
Divisi staff labels on page 1574
Large selections on page 428
Staff labels on condensed staves on page 1546
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Ending divisi passages
You can end divisi passages and return to a unison section on a single staff at any position, 
including partway through systems.

PROCEDURE

1. In Write mode, select an item on a divisi staff at the rhythmic position where you want the 
divisi passage to end.

2. Choose Edit > Notations > Staff > Restore Unison. You can also choose this option from the 
context menu.

RESULT
A default divisi change with a single unison section is input at the selected position, which ends 
the previous divisi passage. A signpost is shown at the position of the unison restoration.

The unison restoration applies from the selected item until the next existing divisi change or the 
end of the flow, whichever comes first. It appears in all applicable layouts.

If the unison restoration occurs partway through a system, all staves from the previous 
divisi change automatically continue until the end of the system. A unison range is created 
automatically to replicate any unison material onto all staves from the divisi change.

NOTE

The number of staves in a system is defined by the first divisi change in the system, including 
prevailing divisi changes from previous systems. If you input a new divisi change partway 
through a system with an existing divisi change active at its start, the number of staves is not 
changed to reflect the new divisi change until the next system.

Unison ranges
Unison ranges are passages of tutti music that are replicated automatically onto all staves when 
divisi passages start/end partway through systems; that is, when you change from unison to 
divisi, or vice versa. This ensures there is no ambiguity about what players are expected to play at 
any point.

To replicate music, Dorico Pro uses the top staff in the section as a source staff, and replicates all 
notes and notations on that staff onto all staves in the section.

You cannot edit notes in unison ranges independently on each staff. When you select a note or 
item on a unison range staff, that note or item is selected on all staves in the section. Therefore, 
editing notes or items in unison ranges simultaneously edits those notes or items on all staves in 
the section. Similarly, when you input notes onto a staff in a unison range, Dorico Pro also inputs 
them on all staves in the section.

A note and slur selected simultaneously on all staves in the unison range, with unison range colors shown
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NOTE

Replicating music from the source staff to other staves in the section is complex, and there are 
limitations to what Dorico Pro can calculate, particularly notations that start before divisi changes 
or end after divisi changes. For example, slurs that start before a divisi change and continue into 
the divisi change are not replicated in unison ranges. In such cases, we recommend that you 
move the divisi change to before/after the slur and manually copy unison material if required.

If staves in divisions use different clefs to the main staff at the position of the tutti restoration, 
Dorico Pro automatically inputs the appropriate clefs.

NOTE

The default spacing of clef changes at the end of divisions can be small, positioning the clef 
tightly beside the previous notes. In such cases, we recommend that you adjust note spacing at 
that position.

RELATED LINKS
Adjusting note spacing at individual rhythmic positions on page 604

Hiding/Showing unison range colors
You can show unison ranges in a different color so you can identify those passages more easily.

When unison range colors are shown, notes in unison ranges appear gray. Notes on the top staff 
remain black, as Dorico Pro notates real notes in tutti sections on the top staff in the section by 
default.

PROCEDURE

● Choose View > Note And Rest Colors > Divisi Unison Ranges.

RESULT
Unison range colors are hidden/shown.

EXAMPLE

A tutti passage with unison range colors not shown The same tutti passage with unison range colors 
shown

RELATED LINKS
Viewing options for notes and rests on page 1261
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Divisi on vocal staves
When vocal staves divide to show different lines on separate staves, it is common to show arrows 
at the end of the system to emphasize the change, and again at the end of the division to show 
the staves are rejoining.

Divide arrows indicating the staff splits into two on 
the next system

Divide arrows indicating two staves rejoin into one 
on the next system

Arrows at the start and end of divisi passages on vocal staves are known in Dorico Pro as divide 
arrows. Dorico Pro shows these arrows on vocal staves by default, but you can also hide them on 
all staves project-wide.

Hiding/Showing divide arrows on vocal staves
You can hide/show divide arrows on all vocal staves project-wide.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Divisi.

3. Choose one of the following options for Indicate divisi at end of system on vocal staves:

● Show divide arrows

● Do not show divide arrows

4. Click Apply, then Close.

Divisi staff labels
Staff labels on divisi staves often require further detail than normal staff labels. Therefore, Dorico 
Pro allows you extra control over the appearance and formatting of staff labels on divisi staves.

By default, staff labels on divisi staves use the same paragraph styles for the formatting of 
their text as normal staves, and options for staff labels also apply to divisi staves. However, you 
can also edit each individual staff label in divisi changes independently of these settings in the 
Change Divisi dialog, including changing the font, style, and alignment. You can also hide and 
show player/group names and section numbers on the staves belonging to that specific divisi 
change independently of your per-layout settings for hiding/showing staff labels.

Creating custom groups of staves in divisi changes allows you to edit the group staff label 
independently of each staff label. You can edit both the full and abbreviated group staff labels.
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NOTE

● Editing individual divisi staff labels overrides your paragraph style settings. If you later 
change the staff label paragraph styles, the edited divisi staff label is not updated.

● You can also show divisi change labels above divisi staves in each layout independently.

RELATED LINKS
Change Divisi dialog on page 1568
Staff labels on page 1531
Staff labels on condensed staves on page 1546
Staff label paragraph styles on page 1544
Divisi change labels on page 1577

Editing divisi staff labels
You can change the text shown in the staff labels shown at each divisi change individually; for 
example, if a single division in your project is significantly different to others and needs further 
clarification. When editing divisi staff labels individually, you can also customize the font of each 
label in the divisi change.

NOTE

Changes made to staff labels in the Change Divisi dialog apply to all layouts. They also affect 
the text shown in any corresponding divisi change labels above staves, even if you had already 
changed the text shown in those labels.

PROCEDURE

1. Open the Change Divisi dialog in any of the following ways:

● Double-click the signpost of an existing divisi change whose staff labels you want to 
change.

● Input a new divisi change.

2. In the Divisions section, select the group or section whose staff label you want to edit.

3. Optional: If you selected a group, choose one of the following staff labels to edit:

● Full Name

● Short Name

4. In the Staff labels section, edit the selected staff label.

5. Choose one of the following options for Show player or group name and Show section 
numbers:

● Follow Options

● Show

● Hide

NOTE

Show and Hide both override your per-layout settings for staff labels in all layouts.

6. Optional: Repeat steps 2 to 5 for other sections or groups in the divisi change.

7. Click OK.
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RESULT
The appearance, length, and behavior of the staff labels in the divisi change are changed in all 
applicable layouts.

RELATED LINKS
Change Divisi dialog on page 1568
Editing existing divisi changes on page 1571
Divisi change labels on page 1577
Hiding/Showing staff labels on page 1532
Showing divisi group/instrument names in condensed staff labels on page 1548

Hiding/Showing divisi section numbers in staff labels
You can hide/show divisi section numbers in staff labels before initial barlines in each layout 
independently. For example, you can show divisi section numbers in staff labels in part layouts 
but hide them in full score layouts.

NOTE

● These steps only apply to divisi changes whose section numbers are set to Follow Options in 
the Change Divisi dialog.

● These steps do not apply to divisi group or instrument names, which follow either your 
per-layout settings for showing staff labels or your setting in the Change Divisi dialog.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show divisi section numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, activate/deactivate the following options:

● Show section names on first system

● Show section names on subsequent systems

5. Click Apply, then Close.

RESULT
Divisi section numbers are shown before the initial barline in the first system of each divisi 
passage when Show section names on first system is activated, and hidden when it is 
deactivated.

Divisi section numbers are shown before the initial barlines on all subsequent systems in divisi 
passages when Show section names on subsequent systems is activated, and hidden when it 
is deactivated.
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EXAMPLE

Divisi section numbers and staff labels both shown Divisi section numbers hidden but staff labels shown

RELATED LINKS
Divisi staff labels on page 1574
Change Divisi dialog on page 1568
Hiding/Showing staff labels on page 1532

Divisi change labels
Divisi change labels identify the divisions on each divisi staff. They are particularly useful when 
divisi changes occur partway through systems and the precise division of the section would 
otherwise be ambiguous.

Divisi change labels (circled) indicating a divisi change comprising two sections followed by a unison 
restoration

By default, divisi change labels display the same information as divisi staff labels, are positioned 
above each staff, and are aligned with the position of the divisi change.

Divisi change labels that indicate an end of a divisi passage show a unison indication; for 
example, “unis.”.

You can hide or show divisi change labels above divisi staves in each layout independently. You 
can change the default unison indication for both divisi change and player labels, and also edit 
individual divisi change labels.
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TIP

Divisi change labels use the Player Labels paragraph style, which you can edit in the Paragraph 
Styles dialog.

RELATED LINKS
Paragraph Styles dialog on page 848
Divisi staff labels on page 1574
Player labels on page 760
Staff labels on condensed staves on page 1546
Changing the default to/unison indications on page 762

Editing divisi change labels
You can show custom text in individual divisi change labels shown above staves. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains. This does not 
affect the content of staff labels on divisi staves.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the divisi change labels you want to edit.

2. In the Properties panel, activate Custom text in the Divisi group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected divisi change labels is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default unison indication for both divisi change and player labels on the 
Condensing page in Engraving Options.

RELATED LINKS
Changing the default to/unison indications on page 762
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Hiding/Showing divisi change labels above staves
You can hide/show section numbers above staves in divisi sections in each layout independently; 
for example, to clarify which staves correspond to sections in the divisi when divisi changes occur 
partway through systems, or to show a change in weighting between staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show divisi change labels 
above staves.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, activate/deactivate Show divisi change labels above staves.

5. Click Apply, then Close.

RESULT
Section numbers are shown above staves in the division when Show divisi change labels above 
staves is activated, and hidden when it is deactivated.

NOTE

This does not affect whether divisi section numbers are shown in staff labels before the initial 
barline on each system.

EXAMPLE

Divisi section names shown above each staff Divisi section names hidden above each staff

Divisi in playback
All notes on divisi staves play back, regardless of the number of staves. By default, because divisi 
staves belong to a single section player, all staves are played back through the same channel.

If you want to hear different sounds for different divisi staves in playback, you can enable 
independent voice playback. For example, if one staff is pizzicato and another is arco.

RELATED LINKS
Enabling independent voice playback on page 636
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Tablature

Tablature is an alternative notation to the five-line staff, and is used for fretted instruments. On 
tablature, pitches are indicated by fret numbers positioned on lines, each of which represents a 
string on the instrument. As tablature is commonly used for guitars, it usually shows six lines.

An extract of guitar music shown on both a notation staff and tablature

In Dorico Pro, you can show music for fretted instruments, such as the guitar or bass, on a 
regular notation staff and tablature together or only show one or the other. Notes and notations 
are linked between both presentations, meaning any changes you make to one, including 
inputting notes, automatically update the other.

On tablature, ties are automatically notated as round brackets around the second note/chord 
and all subsequent notes/chords in tie chains.

Any notes beyond the range of the instrument or impossible to calculate, such as below the nut 
on the lowest string or a natural harmonic without a suitable node, are shown on tablature as 
pink question marks. If two notes are allocated to the same string at the same rhythmic position, 
both notes appear beside each other and are colored green.

Note on tablature that cannot be calculated

The appropriate tablature is automatically shown for instruments according to their strings and 
tuning settings. There are default tunings stored for each instrument type in Dorico Pro, which 
you can customize in the Edit Strings and Tuning dialog.

RELATED LINKS
Hiding/Showing notation staves and tablature on page 1582
Fretted instrument tuning on page 142
Edit Strings and Tuning dialog on page 142
Inputting notes on tablature on page 242
Changing music area colors on page 57
Harmonics on page 1282
Guitar bends on page 1323
Guitar techniques on page 1339
Ties on page 1620
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Trills on page 1295

Project-wide engraving options for tablature
You can find options for the project-wide design of tablature notation on the Tablature and 
Staves pages in Engraving Options.

The options on the Tablature page allow you to change the default direction, position, and 
alignment of stems, the position of rhythm dots, and the enclosures for chords on tablature. 
Many options are informed by the conventions established by different publishers.

On the Staves page, you can change the scale factor that controls the distance between 
tablature string lines.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840

Rhythms on tablature
When notation staves and tablature are both shown, it is customary only to notate rhythms on 
the notation staff. However, when only tablature is shown, it is necessary to show rhythms on 
tablature.

The following items are shown to indicate rhythms on tablature:

● Time signatures

● Stems, stem flags, and beaming

● Rhythm dots

You can change how these items appear on tablature on the Tablature page in Engraving 
Options.

Rhythms shown on tablature

NOTE

By default, stems, stem flags, and beaming appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends, pre-bends/pre-dives, and dives and returns. 
Therefore, in projects where you want to show both these notations and rhythms on tablature, 
we recommend that you change the Default stem direction to Down on the Tablature page in 
Engraving Options.

RELATED LINKS
Inputting notes on tablature on page 242
Changing the placement of rhythm dots on tablature on page 1586

Tablature
Project-wide engraving options for tablature 

1581
Dorico Pro 4.3.30



Hiding/Showing notation staves and tablature
You can show notation staves only, tablature only, or both in each layout independently and for 
each player holding at least one fretted instrument independently. For example, you can show 
only notation staves in the full score layout, but the notation staff and tablature in a guitar part 
layout.

When tablature is shown, it can appear with or without rhythms.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show tablature.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fretted Instruments section, choose one of the following options for each player 
holding at least one fretted instrument in your project:

● To show only notation staves and hide tablature, choose Notation only.

● To show both notation staves and tablature, choose Notation and tablature.

● To show only tablature and hide notation staves, choose Tablature only.

5. Optional: If you chose Notation and tablature or Tablature only, activate/deactivate Show 
rhythms in tablature.

6. Click Apply, then Close.

RESULT
Notation staves and tablature are hidden/shown for the corresponding players in the selected 
layouts.

If tablature is shown, it appears with rhythms when Show rhythms in tablature is activated, and 
without rhythms when it is deactivated.

EXAMPLE

Notation only Notation and 
tablature with 
rhythms

Notation and 
tablature without 
rhythms

Tablature only with 
rhythms

Tablature only 
without rhythms

RELATED LINKS
Players on page 124
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Fretted instrument tuning on page 142
Inputting notes on tablature on page 242
Guitar bends on page 1323
Guitar techniques on page 1339
Hiding/Showing guitar techniques on notation staves and tablature on page 1345
Hiding/Showing empty staves on page 696
Changing instruments on page 140

Changing the allocated string for notes on tablature
You can change the string to which individual notes are allocated on tablature manually; for 
example, if you input the notes on the notation staff and want to change their default string 
allocation.

NOTE

You cannot allocate notes to a string on which they are impossible, such as if the note is lower 
than the open pitch of the string.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. On tablature, select the fret numbers of notes whose allocated string you want to change. 
You can do this in Write mode and Engrave mode.

NOTE

You must select fret numbers on tablature, you cannot select the notes on notation staves.

2. Change their allocated string in any of the following ways:

● To move them up a string, press N .

● To move them down a string, press M .

● In the Properties panel, select a string from the String menu in the Notes and Rests 
group.

RESULT
The string to which the selected notes are allocated is changed. Using the key commands 
changes the string of the selected notes proportionally, whereas selecting a string from the 
String menu allocates all selected notes to the selected string.

NOTE

● If they are now allocated to the same string as another note at that rhythmic position, both 
notes appear beside each other and are colored green.

● Deactivating the property resets the selected notes to their default string.

Tablature
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EXAMPLE

Notes allocated to the same string After changing the strings for some notes to reduce 
the distance between frets

RELATED LINKS
Inputting notes on tablature on page 242
Engrave toolbox on page 514

Hiding/Showing enclosures around notes on tablature
You can hide/show enclosures around all chords on tablature that are a half note or longer; that 
is, durations shown with hollow noteheads on notation staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Tablature.

3. In the Enclosures section, choose one of the following options for Enclosures for notes and 
chords longer than a quarter note (crotchet):

● None

● Ellipse

● Rounded rectangle

4. Click Apply, then Close.

RESULT
Enclosures are hidden around notes a half note or longer when you choose None, and shown 
using the corresponding shape when you choose Ellipse or Rounded rectangle.

Tablature
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EXAMPLE

None Ellipse Rounded rectangle

RELATED LINKS
Showing notes as dead notes on page 1344
Hiding/Showing guitar techniques on notation staves and tablature on page 1345

Changing the shape of enclosures on single notes on tablature
Single notes on tablature require different enclosure shapes to chords as their overall 
dimensions can be very different, such as double-digit fret numbers often being wider than their 
height. You can show either all single notes in circle enclosures or show single-digit fret numbers 
in ellipse enclosures.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Tablature.

3. In the Enclosures section, choose one of the following options for Enclosure shape for 
single notes:

● Prefer circle

● Allow ellipse

4. Click Apply, then Close.

RESULT
Prefer circle shows all single notes, with both single-digit and double-digit fret numbers, in circle 
enclosures.

Allow ellipse shows single-digit fret numbers in ellipse enclosures but double-digit fret numbers 
in circle enclosures.

EXAMPLE

Prefer circle Allow ellipse
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Changing the placement of rhythm dots on tablature
By default, rhythm dots shown on tablature appear once per chord and are placed above the top 
string line. You can change their placement and show multiple rhythm dots next to notes.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Tablature.

3. In the Rhythm Dots section, choose one of the following options for Position of rhythm 
dots:

● Next to notes

● Outside staff

4. Click Apply, then Close.

RELATED LINKS
Rhythms on tablature on page 1581

Editing the tablature numbers font style
You can edit the formatting of the font used for all numbers on tablature project-wide; for 
example, if you want them to appear larger by default.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select Tablature Numbers Font.

3. Activate the following options, individually or together, to change the corresponding aspect 
of the font:

● Font family

● Size

● Style

● Underlined

4. Click OK to save your changes and close the dialog.

RESULT
The formatting of the font used for numbers on tablature is changed project-wide.

RELATED LINKS
Edit Font Styles dialog on page 846
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Tempo marks

Tempo marks indicate how fast music is played, often with a combination of text instructions and 
metronome marks. They are also known as “tempo changes”, “tempo indications”, and “tempo 
markings”.

A tempo mark can show text instructions, a metronome mark, or a combination of the two.

Tempo mark containing text instruction in French and metronome mark

Text instructions are traditionally expressed in Italian, such as largo or allegretto, but other 
languages, such as English, French, and German, have become widely accepted. The text 
instruction can express simply how fast the music is played, but can also suggest its character. 
For example, grave means slow but also solemn and sad, and vivo means fast but also lively and 
sprightly.

Metronome marks show the speed of the music, indicated in beats per minute, or “bpm”. 
Metronome marks can show a fixed bpm or indicate a range of possible or acceptable values.

Gradual tempo changes indicate a change in tempo over a defined period of time. They can 
appear differently; for example, with/without a continuation line or with the text split into 
syllables and spread across their duration.

Tempo marks use a bold font with a large point size, so they are clearly noticeable on the page. 
They do not usually use an italic font. You can edit the formatting of the fonts used for tempo 
marks, such as by changing their font size to make tempo marks appear larger.

In Dorico Pro, tempo marks are categorized as system objects. Therefore, tempo marks follow 
your per-layout settings for the visibility and positioning of system objects.

By default, the tempo marks you input set the tempo for playback and MIDI recording, but 
you can change the tempo mode if, for example, you want to use a single fixed tempo when 
recording MIDI. Gradual tempo changes also affect the playback tempo, and you can change the 
final tempo at the end of gradual tempo changes; for example, if you want to reach a specific 
bpm at the end. If you do not input any tempo marks into your project, the default playback 
tempo is 120 bpm.

RELATED LINKS
Metronome marks on page 1596
Gradual tempo changes on page 1600
Tempo mark components on page 1589
Tempo mark font styles on page 1594
Tempo track on page 625
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Tempo editor on page 810
Input methods for tempo marks on page 294
Positions of tempo marks on page 1591
System objects on page 1563
Changing the positions of system objects on page 1564
Changing the tempo mode on page 634
Layout Options dialog on page 834

Project-wide engraving options for tempo marks
You can find options for the project-wide appearance of tempo marks on the Tempo page in 
Engraving Options.

The options on the Tempo page allow you to change the appearance of tempo marks, including 
how many decimal places to show for metronome marks, and their position relative to the staff, 
time signature changes, and other items. You can also change the appearance, thickness, and 
position of continuation lines relative to barlines for gradual tempo changes.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Hiding/Showing decimal places for metronome marks on page 1599

Types of tempo marks
Dorico Pro groups tempo marks into different types according to their function and effect on the 
music.

In Dorico Pro, there are the following types of tempo marks:

Absolute Tempo Change
Indicates a defined change in tempo, and is often shown with a metronome mark. For 
example, “Adagio =76”.

Gradual Tempo Change
Indicates a change in tempo over a defined period of time, such as rallentando (slowing 
down) or accelerando (speeding up).

Relative Tempo Change
Indicates a change in tempo that is relative to the previous tempo, such as mosso 
(movement).

Relative tempo changes often include modifiers that qualify the change, such as poco 
meno mosso (a little less movement), and are not defined by a metronome mark. 
You can, however, set a relative metronome mark change as a percentage of the 
previous metronome mark that updates automatically if the previous metronome mark 
changes.

Reset Tempo
Returns the tempo to the previous tempo, such as A tempo, or a previously defined 
tempo, such as Tempo primo (return to the first tempo of the piece).

Tempo Equation
Indicates a change in the beat unit on which metronome marks are based. For 
example, if the time signature changes from 3/4 to 6/8, a tempo equation of = 
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indicates the same metronome mark value that applied to the quarter note beat unit in 
3/4 now applies to the dotted quarter note beat unit in 6/8.

RELATED LINKS
Metronome marks on page 1596
Gradual tempo changes on page 1600
Tempo equations on page 1604
Input methods for tempo marks on page 294
Tempo panel on page 297
Tempo popover on page 294
Tempo mark font styles on page 1594
Changing the relative tempo mark value on page 1598

Tempo mark components
Tempo mark components include text, metronome marks, parentheses, and approximate 
indications. Tempo marks can include different components in different combinations, 
depending on your preference or the requirements for different projects.

You can activate properties that correspond to the different components in the Tempo group of 
the Properties panel. You can activate one or more of the following tempo mark properties in any 
combination for individual absolute tempo changes:

Text shown
Shows tempo text when activated, and no tempo text when deactivated.

Metronome mark shown
Shows metronome marks when activated, and no metronome marks when 
deactivated.

Parenthesized
Shows metronome marks in parentheses when activated, and without parentheses 
when deactivated. This also applies to approximate metronome marks.

Is approximate
Shows metronome marks as approximate when activated, and absolute when 
deactivated.

Approximate appearance
Allows you to choose how approximate metronome marks appear; for example, c. or 
circa.

NOTE

This property applies specifically to approximate tempo marks, and is only available 
when Is approximate is activated.

Show equals sign
An equals sign is shown when the property and its corresponding checkbox are both 
activated. No equals sign is shown when the checkbox is deactivated.

NOTE

This property applies specifically to approximate tempo marks, and is only available 
when Is approximate is activated.
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Components for gradual tempo changes

The following components only apply to gradual tempo changes, such as rallentando:

Poco a poco
Poco a poco text is shown immediately after gradual tempo change text when the 
checkbox beside the property is activated.

RELATED LINKS
Changing the order of metronome marks on page 1599
Changing tempo text on page 1593
Hiding/Showing tempo marks on page 1595
Tempo mark font styles on page 1594
Tempo track on page 625
Tempo editor on page 810

Changing the type and appearance of absolute tempo changes
You can change which components are included in individual absolute tempo changes, and how 
they appear. For example, if you want to show only parenthesized metronome marks in some 
tempo marks and only text in other tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the absolute tempo marks whose components you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate any of the following properties in the Tempo group:

● Text shown

● Metronome mark shown

● Parenthesized

● Is approximate

● Approximate appearance (only available when Is approximate is activated)

● Show equals sign (only available when Is approximate is activated)

RESULT
The selected tempo marks are changed to include the corresponding components.

When all properties are deactivated, tempo marks are hidden and indicated by signposts.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Tempo mark components on page 1589
Signposts on page 453

Tempo marks
Tempo mark components 

1590
Dorico Pro 4.3.30



Adding poco a poco text to gradual tempo changes
You can add poco a poco text immediately after individual gradual tempo changes.

NOTE

You can also enter poco a poco directly into the tempo popover. However, this means the entry 
is treated as a tempo mark rather than a gradual tempo change, which changes the properties 
you can use on it.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual tempo changes to which you want to add poco a poco text. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Poco a poco in the Tempo group.

RESULT
Poco a poco text is shown immediately after the text in the selected gradual tempo changes.

Deactivating Poco a poco (little by little) removes poco a poco text from the selected gradual 
tempo changes.

EXAMPLE

Rallentando with poco a poco text

Positions of tempo marks
Tempo marks are placed above the staff and at the same positions as other system objects, 
because they usually apply to all staves. They are placed above notations such as slurs, ties, and 
octave lines, and are often aligned with rehearsal marks to ensure clear readability.

By default in Dorico Pro, tempo marks align with either a time signature or the notehead/rest at 
the rhythmic position to which they apply. For example, if there is a notehead with an accidental 
at the rhythmic position of a tempo mark, it is convention to align the tempo mark with the 
accidental.

If a repeat mark occurs mid-system and is not treated as a barline, tempo marks are aligned with 
the repeat mark.

When a tempo mark includes both text and a metronome mark, the text appears first, followed 
by the metronome mark.

You can move tempo marks to different rhythmic positions in Write mode. They are positioned 
by default according to your settings in Engraving Options.
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You can move tempo marks graphically in Engrave mode, but this does not change the rhythmic 
positions to which they are attached.

In Engrave mode, each gradual tempo change has two square handles, one at the start and one 
at the end. You can move these handles to adjust the graphical position and length of gradual 
tempo changes. You cannot change the angle of gradual tempo changes.

If gradual tempo changes cross system and frame breaks, you can move the line segments on 
each side of the break independently.

You can change the default positions and appearance of tempo marks project-wide on the 
Tempo page in Engraving Options.

Tempo marks are categorized as system objects in Dorico Pro, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently; for example, if you want tempo marks to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Project-wide engraving options for tempo marks on page 1588
Engraving Options dialog on page 840
Input methods for tempo marks on page 294
Changing the order of metronome marks on page 1599
System objects on page 1563
Changing the positions of system objects on page 1564
Moving notes/items rhythmically on page 465
Moving items graphically on page 609

Changing the end position of gradual tempo changes relative to 
barlines

You can change how the ends of individual gradual tempo change continuations are positioned 
relative to barlines, independently of your project-wide setting. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

NOTE

This does not affect the appearance of gradual tempo changes with the text-only style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the gradual tempo changes whose end position relative to barlines 
you want to change.

2. In the Properties panel, activate Barline interaction in the Tempo group.

3. Choose one of the following options:

● Stop before
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● Continue

RESULT
The end position of the selected gradual tempo changes is changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default position of all gradual tempo change ends project-wide in the 
Horizontal Position section of the Tempo page in Engraving Options.

RELATED LINKS
Project-wide engraving options for tempo marks on page 1588
Engraving Options dialog on page 840
Changing the style of gradual tempo changes on page 1601
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing tempo text
You can change the text of existing tempo marks individually. For example, if you want to add “al 
fine” to a ritardando at the end of a flow.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tempo marks whose tempo text you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, enter the tempo text you want into the Text field in the Tempo 
group.

3. Press Return .

RESULT
The tempo text for the selected tempo marks is changed.

TIP

You can also change the tempo text by opening the tempo popover and changing the entry.

RELATED LINKS
Engrave toolbox on page 514
Properties panel on page 769
Input methods for tempo marks on page 294
Tempo popover on page 294
Changing existing items on page 439
Tempo mark components on page 1589
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Changing the order of metronome marks on page 1599

Showing abbreviated tempo text
You can show individual tempo marks with custom abbreviated text in some layouts; for 
example, if a long tempo mark extends beyond the page boundary in some part layouts but 
the abbreviated version fits within the boundary.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to show abbreviated tempo text. You 
can do this in Write mode and Engrave mode.

2. Select the tempo marks you want to show with abbreviated text.

3. In the Properties panel, activate Abbreviation in the Tempo group.

4. Enter the text you want into the value field.

5. Activate Abbreviate in the Tempo group.

6. Activate the corresponding checkbox.

RESULT
The selected tempo marks appear with abbreviated text when Abbreviation is activated and 
Abbreviate is deactivated, or when Abbreviation and both Abbreviate and its corresponding 
checkbox are all activated. This allows you to switch between showing abbreviated/full text in 
different layouts without deleting your abbreviated text from the Abbreviation value field.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Tempo mark font styles
There are different font styles for different types of tempo marks and tempo mark components. 
You can change different aspects of these fonts in the Edit Font Styles dialog, such as changing 
their font size to make tempo marks appear larger.

The following font styles are used for tempo marks:
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1 Gradual Tempo Text Font: Used for gradual tempo changes, such as "rallentando".

2 Immediate Tempo Text Font: Used for absolute tempo changes, such as “Adagio”.

3 Metronome Music Text Font: Used for note value glyphs in metronome marks, such as "". 
Must be SMuFL-compliant.

4 Metronome Text Font: Used for equal signs and numbers in metronome marks, such as 
“=76”.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 846
Changing the default font family on page 853

Hiding/Showing tempo marks
You can hide/show the different components in individual tempo marks without changing the 
speed of playback. This affects their appearance in all layouts.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tempo marks you want to hide, or the signposts of tempo marks you want to 
show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate the following properties in the Tempo group:

● Text shown

● Metronome mark shown

RESULT
When at least one of the properties is activated, the selected tempo marks are shown. They 
display components according to the properties that are activated.

When neither property is activated, the selected tempo marks are hidden. Signposts are shown 
at the position of each hidden tempo mark as they still affect the speed of playback.

RELATED LINKS
Changing the type and appearance of absolute tempo changes on page 1590
Signposts on page 453
Engrave toolbox on page 514
Changing the tempo mode on page 634
Muting notes/items individually on page 639

Tempo marks
Hiding/Showing tempo marks 
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Metronome marks
Tempo marks often include a metronome mark value. Metronome marks show the speed of the 
music, indicated in beats per minute, or “bpm”. For example, a bpm of 60 means one beat per 
second. The more beats per minute, the faster the music.

A metronome mark shown as a range

Metronome marks can be precise, such as  = 176, or can indicate an acceptable range, such as 
 = 152-176. They can also be shown in parentheses, which is useful if the metronome mark is 
intended as a guide rather than a fixed value.

By default, metronome marks appear as integers and do not show decimal places. If you input 
a metronome mark with a decimal place, it is rounded to the nearest integer. Metronome marks 
that you input in the Tempo editor appear as signposts by default.

The beat unit used in metronome marks commonly relates to the meter; for example, the 
metronome mark beat unit is often a quarter note in 4/4 but a dotted quarter note in 6/8.

In Dorico Pro, metronome marks can appear as an individual value or as a range. Depending on 
the type and appearance of metronome marks, the bpm value can indicate a fixed tempo or an 
approximate tempo.

RELATED LINKS
Input methods for tempo marks on page 294
Changing the order of metronome marks on page 1599
Hiding/Showing decimal places for metronome marks on page 1599
Changing the type and appearance of absolute tempo changes on page 1590
Tempo mark components on page 1589
Tempo mark font styles on page 1594
Tempo equations on page 1604
Tempo track on page 625
Tempo editor on page 810

Changing the metronome mark value
You can change the metronome mark value of individual absolute tempo marks after they have 
been input, including changing the beat unit.

NOTE

These steps do not apply to gradual tempo changes or reset/relative tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the absolute tempo marks whose metronome mark values you want to change. You 
can do this in Write mode and Engrave mode.

Tempo marks
Metronome marks 

1596
Dorico Pro 4.3.30



2. In the Properties panel, change the value for Tempo (bpm) in the Tempo group.

3. Press Return .

4. Choose the appropriate note duration and rhythm dot, if applicable, for Beat unit.

RESULT
The metronome mark value and beat unit is changed for the selected absolute tempo marks. 
This affects the tempo of playback, even if no metronome mark component is shown for those 
tempo marks.

NOTE

● By default, any decimals you enter are hidden and the displayed metronome mark value 
appears as the nearest integer. However, metronome marks always reflect their exact values 
in playback.

● You can also change the metronome mark value by opening the tempo popover and 
changing the entry.

RELATED LINKS
Tempo popover on page 294
Changing existing items on page 439
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769

Showing the metronome mark value as a range
You can show the metronome mark value of individual absolute tempo marks as a range. 
For example, you can use this to indicate that any speed within the given range is musically 
appropriate for the piece.

NOTE

These steps do not apply to gradual tempo changes or reset/relative tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the absolute tempo marks whose metronome mark values you want to show as a 
range. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Tempo range (bpm) in the Tempo group.

3. Change the value in the value field.

RESULT
The tempo range, expressed as beats per minute, is changed for the selected tempo marks. By 
default, metronome mark ranges use a dash separator.

Tempo marks
Metronome marks 
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NOTE

● Depending on the values set for each property, both Tempo (bpm) and Tempo range (bpm) 
can be the minimum/maximum tempo in the range, as Dorico Pro automatically arranges 
metronome mark ranges with the lower value first. However, the metronome mark used for 
playback is always Tempo (bpm), regardless of whether that is the higher/lower value in the 
range.

● You can change the default separator used for metronome mark ranges in the Absolute 
Changes section of the Tempo page in Engraving Options.

Changing the relative tempo mark value
You can change the tempo of individual relative tempo marks, expressed as a percentage of the 
previous tempo mark.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the relative tempo marks whose value you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, change the value for Relative % in the Tempo group.

3. Press Return .

RESULT
The tempo at the relative tempo mark is changed. For example, if the previous tempo was 
100 bpm, and you change a relative tempo mark to 90, the new tempo is 90% of 100 bpm, which 
is 90 bpm.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769

Changing the final tempo at the end of gradual tempo changes
You can change how significantly gradual tempo changes affect the tempo in playback, 
expressed as a percentage of the tempo at the start of the gradual tempo change.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual tempo changes whose final tempo you want to change. You can do this in 
Write mode and Engrave mode.

Tempo marks
Metronome marks 
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2. In the Properties panel, change the value for Final tempo % in the Tempo group.

3. Press Return .

RESULT
The final tempo at the end of the selected gradual tempo changes is changed.

For example, if you change the value to 20 on a gradual tempo change that started at 100 bpm, 
the final tempo is 20% of 100 bpm, which is 20 bpm. If you change the value to 120 on a gradual 
tempo change that started at 100 bpm, the final tempo is 120% of 100 bpm, which is 120 bpm.

Hiding/Showing decimal places for metronome marks
You can change the maximum number of decimal places you want to show for all metronome 
marks project-wide; for example, if you require very precise metronome mark values when 
writing music to film but only want to show one decimal place for metronome marks in the 
music.

By default, decimal places are hidden for metronome marks and are rounded to the nearest 
integer. However, metronome marks always reflect their exact values in playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Tempo.

3. In the Absolute Changes section, change the value for Number of decimal places to show 
tempo.

4. Click Apply, then Close.

Changing the order of metronome marks
You can change the order of metronome marks relative to tempo text for individual tempo 
marks, independently of your project-wide setting. For example, if you want to show metronome 
marks before tempo text in some tempo marks but after tempo text in others.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tempo marks whose metronome mark order you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Metronome mark order in the Tempo group.

3. Choose one of the following options:

● Before

● After

RESULT
The order of metronome marks relative to tempo text in the selected tempo marks is changed.

Tempo marks
Metronome marks 
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TIP

You can change the default order of metronome marks relative to tempo text in all tempo marks 
project-wide on the Tempo page in Engraving Options.

EXAMPLE

Metronome mark before tempo text Metronome mark after tempo text

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769
Types of tempo marks on page 1588
Metronome marks on page 1596
Tempo mark components on page 1589
Positions of tempo marks on page 1591
Hiding/Showing tempo marks on page 1595

Gradual tempo changes
Gradual tempo changes indicate a change in tempo over a defined period of time, such as 
rallentando, which indicates slowing down, and accelerando, which indicates speeding up.

Rallentando with dashed line

Gradual tempo changes are considered a type of tempo mark in Dorico Pro, meaning you can 
input them in the same ways as for tempo marks.

Because gradual tempo changes have a different metronome mark value at the start/end, you 
can change the final tempo at the end of individual gradual tempo changes.

In Dorico Pro, you can show gradual tempo changes with different styles, such as with a 
continuation line or with syllables spread across their duration. You can also show gradual tempo 
changes with different line styles, such as dotted or dashed.

NOTE

You cannot change the angle of gradual tempo changes.

RELATED LINKS
Input methods for tempo marks on page 294

Tempo marks
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Project-wide engraving options for tempo marks on page 1588
Lengthening/Shortening items on page 436
Changing the line style of gradual tempo changes on page 1602
Changing the final tempo at the end of gradual tempo changes on page 1598
Tempo mark font styles on page 1594

Changing the style of gradual tempo changes
You can change the style of individual gradual tempo changes, independently of your project-
wide setting. Gradual tempo changes can appear as text only with no continuation line, text with 
a continuation line, or with the word spread across their duration.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual tempo changes whose style you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Gradual style in the Tempo group.

3. Select one of the following options from the menu:

● rit.

● rit...

● rit-e-nu-to

RESULT
The style of the selected gradual tempo changes is changed.

NOTE

● Only gradual tempo changes with valid full text appear separated into syllables; for example, 
ritenuto or accelerando. Gradual tempo changes automatically have valid full text when you 
input them using the panel or select a suggested entry from the menu when using the 
popover. You can also change the text of existing gradual tempo changes, including adding 
hyphens manually to control how they are separated into syllables.

● You can change the style of all gradual tempo changes project-wide on the Tempo page in 
Engraving Options.

EXAMPLE

rit.: Text only rit...: Text with a continuation line rit-e-nu-to: Syllables in the text 
spread across the duration of the 
gradual tempo change

RELATED LINKS
Project-wide engraving options for tempo marks on page 1588

Tempo marks
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Engraving Options dialog on page 840
Changing tempo text on page 1593
Engrave toolbox on page 514

Changing the line style of gradual tempo changes
You can change the line style of individual gradual tempo changes whose style includes a 
continuation line, independently of your project-wide settings.

NOTE

This does not affect the appearance of gradual tempo changes with the text-only style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual tempo changes whose line style you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Line style in the Tempo group.

3. Select one of the following options from the menu:

● Solid

● Dotted

● Dashed

RESULT
The line style of the selected gradual tempo changes is changed.

TIP

You can change the default line style of all gradual tempo changes project-wide on the Tempo 
page in Engraving Options.

Lengthening/Shortening gaps and dashes in gradual tempo changes
You can change the length of dashes and the gaps between dashes in individual gradual tempo 
changes, independently of your project-wide settings. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to gradual tempo changes with dashed lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

Tempo marks
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● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the gradual tempo changes with dashed lines whose dash length 
you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Tempo group:

● Line dash length

● Line dash gap

3. Change the values in the value fields.

RESULT
Increasing Line dash length makes dashes in gradual tempo changes longer, decreasing the 
value makes dashes shorter.

Increasing Line dash gap makes gaps between dashes in gradual tempo change lines longer, 
decreasing the value makes gaps shorter.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can change the default dash length for all dashed gradual tempo changes project-wide in 
Engraving Options > Tempo > Gradual Changes > Advanced Options.

For example, you can change the default dash length for dashed lines following text and dashed 
lines between hyphenated text separately.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the line thickness of gradual tempo changes
You can change the thickness of dashed and solid lines in individual gradual tempo changes, 
independently of your project-wide settings. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

These steps only apply to gradual tempo changes with dashed and solid lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Tempo marks
Gradual tempo changes 
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PROCEDURE

1. In Engrave mode, select the gradual tempo changes whose thickness you want to change.

2. In the Properties panel, activate Line thickness in the Tempo group.

3. Change the value in the value field.

RESULT
Increasing the value makes dashed and solid lines thicker, decreasing the value makes dashed 
and solid lines thinner. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

TIP

You can change the thickness of all dashed and solid gradual tempo change lines project-wide on 
the Tempo page in Engraving Options.

RELATED LINKS
Changing the line style of gradual tempo changes on page 1602
Changing the property scope on page 771

Tempo equations
Tempo equations indicate a change in the beat unit on which metronome marks are based. They 
are often used to maintain a consistent pulse across multiple different meters.

For example, if the time signature changes from 6/8 to 3/4, a tempo equation of  = indicates the 
same metronome mark value that applied to the dotted quarter note beat unit in 6/8 now applies 
to the quarter note beat unit in 3/4.

Tempo equations are considered a type of tempo mark in Dorico Pro, meaning you can input 
them in the same ways as for tempo marks.

NOTE

Tempo equations do not yet include tuplet durations. This is planned for future versions.

RELATED LINKS
Input methods for tempo marks on page 294

Tempo marks
Tempo equations 
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Hiding/Showing arrows on tempo equations
You can hide/show arrows either side of all tempo equations project-wide; for example, to make 
tempo equations appear more visually different than metronome marks.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Tempo.

3. In the Absolute Changes section, choose one of the following options for Tempo 
equations:

● Show arrows

● Omit arrows

4. Click Apply, then Close.

EXAMPLE

Show arrows Omit arrows

RELATED LINKS
Engraving Options dialog on page 840

Tempo marks
Tempo equations 
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Text items

Text items exist at rhythmic positions within flows and allow you to display generic text in the 
music.

You can customize the formatting of text in text items using the available text editor options, 
such as by applying different paragraph styles to each line of text and different character styles 
to each character.

A text item below a piano staff

In Dorico Pro, there are the following types of text items:

Staff-attached text
Text items that apply to individual staves and only appear on those staves.

System-attached text
Text items that apply to all staves and appear in all applicable layouts. In Dorico Pro, 
system-attached text is categorized as a system object. Therefore, system-attached text 
follows your per-layout settings for the visibility and positioning of system objects.

NOTE

● You can only use tokens in text frames. You cannot use tokens in text items.

● There are dedicated features for other types of text that often appear in musical scores, such 
as tempo marks and dynamics.

RELATED LINKS
Text frames on page 575
Tokens on page 576
Inputting text items on page 388
Text editor options in Write mode on page 389
Adding borders to text items on page 1614
Hiding/Showing text items on page 1618
Aligning text items with the start of systems on page 1612
System objects on page 1563
Changing the positions of system objects on page 1564
Changing the default font family on page 853
Paragraph Styles dialog on page 848
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Types of text
Generic text in Dorico Pro can exist as text items, either staff-attached or system-attached, or in 
text frames, which are fixed to the page rather than the music. There are dedicated features for 
other types of text that often appear in musical scores, such as tempo marks and dynamics.

In Dorico Pro, there are the following types of text:

Text items
Text items exist at rhythmic positions within flows. They can display any text you enter, 
apart from tokens. You can customize the formatting of text in text items using the 
available text editor options, such as by applying different paragraph styles to each line 
of text and different character styles to each character.

Text items can apply either to individual staves, which is known as “staff-attached text”, 
or to all staves, which is known as “system-attached text”.

A text item below a piano staff

Text in text frames
Text frames exist on pages independently of rhythmic positions within flows. They can 
display any text you enter, including tokens. You can customize the formatting of text 
in text frames using the available text editor options, such as by applying different 
paragraph styles to each line of text and different character styles to each character.

Text frames on the first page in a piano part layout, with the project title frame selected

Tempo marks
Tempo marks indicate how fast music is played, often with a combination of text 
instructions and metronome marks.

For example, A tempo, Larghetto, ritardando, and accelerando are all tempo marks.

Text items
Types of text 
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Tempo mark containing text instruction in French and metronome mark

Rehearsal marks
Rehearsal marks are ordered sequences of letters or numbers that provide useful 
reference points. They are often shown in a rectangular enclosure.

A rehearsal mark, showing the letter G

Playing techniques
The term “playing techniques” covers a wide range of instructions intended to tell 
performers to modify the sound of the notes they are playing; for example, by 
changing their embouchure or changing the position of their bow, or by modifying 
their instrument, such as adding a mute or depressing a pedal.

For example, pizzicato, flutter-tongue, con sordino, and “snares on” are all playing 
techniques.

Dynamics
Dynamics indicate the loudness of the music and can be combined with expressive text 
to give further clarification about how to perform the music. Dynamics can indicate an 
immediate change in volume or a gradual change over a specified duration.

For example, , , and “crescendo” are all dynamics.

A phrase with multiple different dynamics

Lyrics
In Dorico Pro, the term “lyrics” is used for all text that is sung by singers. Lyrics are 
organized into lyric lines, with different types of lyric lines available for lyrics with 

Text items
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different purposes. For example, lyrics in a chorus line are shown in an italic font by 
default.

Lyrics for a soprano duet with basso continuo accompaniment

Fingering
Fingerings use numbers and letters to recommend which fingers players should use 
for notes.

Piano music containing multiple fingerings, including a substitution fingering and alternative 
fingerings

Figured bass
Figured bass is a shorthand that uses figures to specify the harmony above the notated 
bass notes. Figures use a combination of Arabic numbers, accidentals, and horizontal 
hold lines to specify both the intervals above the bass note that make up the chord and 
its duration.

A basso continuo part with figured bass below the staff

Chord symbols
Chord symbols describe the vertical harmony of the music at a specific moment. They 
are frequently used in jazz and pop music, where players often improvise around chord 
progressions.

For example, “Gm7”, “Dsus4”, and “C6/9” are all chord symbols.

Text items
Types of text 
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Chord symbols shown above slashes on the Clarinet and Piano staves to help the players 
improvise around the notated Cornet melody.

Repeat markers
Repeat markers show that musical material is to be repeated. They often involve 
jumping to different positions and sections in the music instead of moving through 
the music consecutively.

For example, D.C. al Coda, D.S., and Fine are all repeat markers.

A mid-system coda section

Comments
Comments are notes or instructions added at precise positions in a project without 
affecting the music. They are considered annotations in Dorico Pro, meaning they are 
not printed by default.

A passage with comments and replies

RELATED LINKS
Tokens on page 576
Text formatting on page 845
Editing text in text items on page 392
Entering text in text frames on page 583
Text editor options in Write mode on page 389
Text editor options in Engrave mode on page 584

Text items
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Hiding/Showing text items on page 1618
Changing the default font family on page 853
Text items on page 1606
Text frames on page 575
Flow headings on page 554
Page numbers on page 1353
Tacets on page 739
Tempo marks on page 1587
Rehearsal marks on page 1424
Playing techniques on page 1387
Dynamics on page 1104
Lyrics on page 1222
Fingering on page 1157
Figured bass on page 1139
Chord symbols on page 1036
Repeat markers on page 1447
Comments on page 506

Changing the paragraph style of text
You can change the paragraph style that is applied to individual text items and within individual 
text frames, including on page templates. For example, if you want to use one paragraph style 
for page numbers in full score layouts and another for page numbers in part layouts.

PREREQUISITE

● You have created any custom paragraph styles that you want to use.

● If you want to change the paragraph style of text on a page template, you have opened the 
page template in the page template editor.

PROCEDURE

1. Double-click the text item or text frame whose paragraph style you want to change to open 
the text editor.

NOTE

● To open the text editor for text items, you must be in Write mode. For text frames, you 
can be in Write mode or Engrave mode.

● When Frames  is selected in the Engrave toolbox, you can also select text frames and 
press Return .

2. In text frames, select the text whose paragraph style you want to change.

TIP

Each paragraph in the same text frame can have a different paragraph style.

3. Select a paragraph style from the paragraph style menu in the text editor.

4. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
The paragraph style of the selected text item or paragraphs in a text frame is changed. For 
example, if you select a single word in a text frame, the whole paragraph containing that word is 
changed.

Text items
Changing the paragraph style of text 
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NOTE

If you override the paragraph style of text in an individual text item or text frame, such as by 
making text bold, any changes you later make to corresponding parameters of the paragraph 
style are not applied to the overridden text. However, font size overrides are combined with the 
font size in the paragraph style.

RELATED LINKS
Paragraph Styles dialog on page 848
Page template editor on page 540
Creating page templates on page 535
Changing the default font family on page 853
Removing page template overrides on page 545

Aligning text items with the start of systems
You can align individual text items whose rhythmic position is at the start of systems with the 
systemic barline rather than the first note/rest, independently of the system alignment setting 
for their paragraph style. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items you want to align with the start of systems. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Align with system start in the Text group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected text items are aligned with the start of systems when the checkbox is activated, 
and aligned with the first note/rest in systems when the checkbox is deactivated. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

When the property is deactivated, text items follow the system alignment setting of their 
paragraph style.

TIP

You can change the default alignment of each paragraph style relative to the start of systems in 
the Paragraph Styles dialog.

Text items
Aligning text items with the start of systems 

1612
Dorico Pro 4.3.30



EXAMPLE

Text aligned with the first note in the system Text aligned with the start of the system

RELATED LINKS
Inputting text items on page 388
Moving items graphically on page 609
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Enabling/Disabling text collision avoidance
You can change whether individual text items automatically move to avoid collisions, 
independently of your project-wide setting. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

Text items with collision avoidance disabled do not contribute to automatic staff spacing 
calculations.

NOTE

These steps do not apply to text in text frames.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the text items whose collision avoidance you want to enable/disable.

2. In the Properties panel, activate Avoid collisions in the Text group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected text items avoid collisions when the checkbox is activated, and do not avoid 
collisions when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Text items
Enabling/Disabling text collision avoidance 
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When the property is deactivated, text items follow your project-wide setting for text collision 
avoidance.

TIP

You can enable/disable text collision avoidance for all text items project-wide on the Text page in 
Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840

Adding borders to text items
You can add borders to individual text items; for example, if you want to make the boundaries of 
text items clear. You can show borders on text items in addition to erasing their backgrounds.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the text items to which you want to add borders. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Border in the Text group.

RESULT
Borders are added to the selected text items.

TIP

● Deactivating Border removes borders from the selected text items.

● You can show borders on text items automatically by using paragraph styles set to show 
borders by default.

EXAMPLE

Text with no border Text with border shown

AFTER COMPLETING THIS TASK
You can change the padding between text items and each edge of their borders.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769

Text items
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Paragraph Styles dialog on page 848
Erasing the background of text items on page 1617
Adding borders to text frames on page 585
Hiding/Showing borders on layout names on page 1192

Changing the style of text item borders
You can change the style of borders shown on individual text items; for example, if you want to 
show rectangle borders on some text items but capsule borders on others. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items whose border style you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Border style in the Text group.

3. Select one of the following options from the menu:

● Rectangle

● Rounded rectangle

● Capsule

● Angled ends rectangle

RESULT
The border style of the selected text items is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can change the border style used by each paragraph style by default in the Paragraph 
Styles dialog.

EXAMPLE

Rectangle Rounded rectangle Capsule Angled ends rectangle

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769

Text items
Adding borders to text items 
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Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Paragraph Styles dialog on page 848
Changing the padding around text items on page 1616

Changing the thickness of text item borders
You can change the thickness of borders around individual text items, independently of your 
project-wide setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the text items whose border thickness you want to change.

2. In the Properties panel, activate Border thickness in the Text group.

3. Change the value in the value field.

RESULT
The thickness of borders around the selected text items is changed.

TIP

You can change the default thickness of all text item borders project-wide on the Text page in 
Engraving Options.

RELATED LINKS
Engraving Options dialog on page 840
Changing the thickness of text frame borders on page 586

Changing the padding around text items
You can change the padding around text items individually, and for each edge independently. 
This affects the distance between text and erased backgrounds and borders. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the text items whose padding you want to change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Text group.

● L changes the padding between text items and their left edge.

Text items
Adding borders to text items 
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● R changes the padding between text items and their right edge.

● T changes the padding between text items and their top edge.

● B changes the padding between text items and their bottom edge.

3. Change the values in the value fields for the edges whose padding you want to change.

RESULT
The padding around the selected text items is changed. Increasing the values increases the 
padding, decreasing the values decreases the padding. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can change the default padding of all text items project-wide on the Text page in Engraving 
Options. However, this does not allow you to change the padding of each edge independently.

You can change the default padding between text and each border edge for individual paragraph 
styles in the Paragraph Styles dialog. However, paragraph style border padding settings are 
only used when Border is activated for the corresponding paragraph style.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Paragraph Styles dialog on page 848

Erasing the background of text items
You can erase the background of individual text items; for example, to ensure the text remains 
legible when crossing barlines. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the text items whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Text group.

RESULT
The backgrounds of the selected text items are erased. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

● You can show borders on text items in addition to erasing their backgrounds.

Text items
Erasing the background of text items 
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● Deactivating Erase background returns the selected text items to the default non-erased 
background.

EXAMPLE

Text with non-erased background Text with erased background

AFTER COMPLETING THIS TASK
You can change the padding between text items and each edge of their erased areas.

RELATED LINKS
Adding borders to text items on page 1614
Erasing the background of stems on page 1281

Hiding/Showing text items
You can hide/show individual text items. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. For example, you can show specific text items in part 
layouts but hide them in full score layouts.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items you want to hide, or the signposts of text items you want to show. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide in the Text group.

RESULT
The text items are hidden when Hide is activated, and shown when it is deactivated. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Signposts are shown at the position of each hidden text item. However, signposts are not printed 
by default.

TIP

● You can hide/show text signposts by choosing View > Signposts > Text.

Text items
Hiding/Showing text items 
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● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Signposts on page 453
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Key Commands page in the Preferences dialog on page 63
Annotations on page 687

Text items
Hiding/Showing text items 
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Ties

A tie is a curved line that joins two notes of the same pitch. When notes are longer than the 
maximum duration of a bar in the prevailing time signature, they automatically appear in Dorico 
Pro as tie chains; that is, a sequence of adjacent notes joined with ties.

Each sequence of ties, whether they join two notes or ten notes together, represents a single 
note with the duration of all the tied notes combined. A performer plays the notes as one note, 
without re-striking, re-blowing, or re-bowing the note at any point within the rhythmic duration 
of the tie chain.

A tie chain across several bars on the bottom piano staff

On tablature, ties are automatically notated as round brackets around notes/chords in 
subsequent bars. When tablature is shown with rhythms, ties within the same bar are indicated 
with stems rather than bracketed noteheads.

A phrase on tablature with some ties within bars and 
a chord tied across two bars

The same phrase on a notation staff

In Dorico Pro, most ties are created automatically. Rhythms are notated according to the 
prevailing beat grouping, which is normally set by the time signature. Therefore, notes that 
cannot be notated using a single duration are automatically drawn as tie chains. For example, 
if you input a dotted whole note at the start of a bar in a 4/4 time signature, it is automatically 
notated as a whole note tied to a half note in the next bar. If the time signature changes, tie 
chains are automatically adjusted to remain correct in the new meter.

Dorico Pro automatically determines the appropriate endpoint position and curvature direction 
for ties to avoid collisions, according to the context and your project-wide settings.

NOTE

● Slurs must not be confused with ties, which look superficially similar, but instead join notes 
of the same pitch to indicate that they are played as a single note. In that sense, ties are part 
of rhythmic notation, while slurs are considered articulation.

● In Write mode, you can only select whole tie chains because Dorico Pro considers each tie 
chain to be a single note. Any edits you make to tie chains in Write mode affect all notes in 
them, such as changing the pitch, but only affect the first tie in the chain, such as changing 
the tie style to dashed. However, you can still input notations, such as dynamics, in the 
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middle of tie chains by activating the caret and moving it to the required rhythmic position 
within the tie chain.

In Engrave mode, you can select individual notes and ties within tie chains and edit them 
independently.

● When you tie existing notes together, they might be consolidated into fewer or more notes 
within a tie chain, depending on the musical context, the time signature, and the position of 
the start of the note in the bar.

● Articulations can only appear once on each tie chain, either at the start or the end, 
depending on the type of articulation. For example, staccato marks appear at the end 
whereas accents appear at the start. You can change the positions of articulations relative to 
tie chains project-wide and for individual tie chains.

RELATED LINKS
Note and rest grouping on page 1021
Beam grouping according to meters on page 999
Inputting notes on page 221
Forcing the duration of notes/rests on page 262
Inputting ties on page 248
Splitting tie chains on page 1631
Tie curvature direction on page 1626
Time signatures on page 1639
Notes on page 1246
Bracketed noteheads on page 1263
Positions of articulations on page 956
Changing the positions of articulations on tie chains on page 957
Hiding/Showing or parenthesizing accidentals on page 943
Tablature on page 1580
Caret on page 215
Input methods for dynamics on page 310
Numbered bar regions on page 1467

Project-wide engraving options for ties
You can find options for the project-wide appearance, position, and placement of ties on the Ties 
page in Engraving Options.

The options on the Ties page allow you to change the default curvature direction, shape, and 
appearance of ties, their minimum length, and the position of ties relative to noteheads and 
other ties in tie chains.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Tie curvature direction on page 1626
Tie height on page 1635
Tie shoulder offset on page 1637

Ties
Project-wide engraving options for ties 

1621
Dorico Pro 4.3.30



Ties vs. slurs
Ties and slurs look superficially similar but differ in meaning.

Ties indicate that a note should not be re-struck. They are used to join notes of the same pitch 
together. For example, ties can be used to extend notes across multiple bars. Although multiple 
notes can be included in a single tie chain, each tie in the chain only joins one notehead to the 
next notehead on the staff.

Articulations on tied notes only affect the attack at the start of the tie chain and the release at the 
end of the tie chain.

Two long notes tied together Two phrases with slurs

Slurs indicate articulation, such as bowing or breathing, and normally group notes of different 
pitches together. Slurs can join two noteheads together with any number of pitches in between. 
They often indicate the shaping of phrases.

Slurs can also be used in conjunction with articulation. Unlike ties, articulation within slurs can 
affect the sound throughout the phrase. For example, staccato articulations on repeated notes of 
the same pitch within a slur indicate that notes should be played on a stringed instrument using 
the same bow direction, but stopping the bow between each note.

RELATED LINKS
Slurs on page 1502
Inputting ties on page 248
Inputting slurs on page 273

Tie styles
There are different styles of ties available in Dorico Pro, which you can use to indicate different 
meanings.

Solid
This is the default style for ties. Ties appear as tapered solid lines: thinner at the ends 
and thicker in the middle.

Dashed
Ties appear as tapered dashed lines. Can be used to denote optional or suggested ties; 
for example, in vocal music where some verses have more syllables than others and 
therefore require more notes.

Dotted
Ties appear as dotted lines. The dots are the same size and the same distance apart 
over the whole length of the tie. Can also be used to denote optional or suggested ties.

Ties
Ties vs. slurs 
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Half-dashed start
The first halves of ties appear as dashed lines, the second halves as solid lines. Used to 
denote that a tie was written incompletely in the source in critical editions.

Half-dashed end
The first halves of ties appear as solid lines, the second halves as dashed lines. Used to 
denote that a tie was written incompletely in the source in critical editions.

Editorial
Ties appear as solid black lines, but with a smaller vertical line intersecting them 
exactly halfway along their length. Used to show that ties were added by the editor and 
were not present in the source.

RELATED LINKS
Erasing the background of time signatures on page 1657

Changing the style of ties
You can change the style of individual ties. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. By default, all ties are solid.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the ties whose style you want to change. You can do this in Write mode and Engrave 
mode.

NOTE

● In Write mode, you can only select whole tie chains. In Engrave mode, you can select 
individual ties within tie chains.

● Any changes to tie chains in Write mode only affect the first tie in the chain.

2. In the Properties panel, activate Style in the Ties group.

3. Select one of the following options from the menu:

● Solid

● Dashed

● Dotted

● Half-dashed start

Ties
Tie styles 
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● Half-dashed end

● Editorial

RESULT
The style of the selected ties is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

TIP

You can set the precise parameters of each of these options project-wide on the Ties page in 
Engraving Options. For example, you can change the length and width of the stroke in Editorial 
ties, the diameter of dots and length of dashes, and the sizes of the gaps between dots and 
dashes.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the size of dashes/dots in ties
You can change the size of the dashes/dots in dashed/dotted ties individually, independently of 
your project-wide settings. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

NOTE

These steps only apply to dashed/dotted ties.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dashed/dotted ties whose dash/dot size you want to change. You can do this in 
Write mode and Engrave mode.

NOTE

● In Write mode, you can only select whole tie chains. In Engrave mode, you can select 
individual ties within tie chains.

● Any changes to tie chains in Write mode only affect the first tie in the chain.

2. In the Properties panel, activate Dash/dot in the Ties group.

3. Change the value in the value field.

Ties
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RESULT
Increasing the value makes dashes/dots bigger, decreasing the value makes dashes/dots 
smaller. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

TIP

You can change the default size of dashes/dots in all dashed/dotted ties project-wide Engraving 
Options > Ties > Design > Advanced Options.

You can also change the thickness of all tie styles on this page. However, you cannot change the 
thickness of ties individually.

RELATED LINKS
Project-wide engraving options for ties on page 1621
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the size of gaps in dashed/dotted ties
You can change the size of the gaps in dashed/dotted ties individually, independently of your 
project-wide settings. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the individual dashed/dotted ties whose gap size you want to 
change.

2. In the Properties panel, activate Gap in the Ties group.

3. Change the value in the value field.

RESULT
Increasing the value makes the gaps between dashes/dots larger. Decreasing the value makes 
the gaps between dashes/dots smaller. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

TIP

You can change the default size of the gaps between dashes/dots in all dashed/dotted ties 
project-wide Engraving Options > Ties > Design > Advanced Options.

RELATED LINKS
Engraving Options dialog on page 840
Engrave toolbox on page 514

Ties
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Erasing the background of time signatures on page 1657

Tie curvature direction
The direction of tie curvatures is determined by the stem direction of the notes/chords at each 
end of the tie, the number of notes in chords at each end, and the number of voices on the staff.

Tied single notes in single-voice contexts

If a single voice is active and a tie joins two single notes, tie curvature direction is determined by 
the stem directions of the notes at either end of the tie.

● If the stem directions match, the tie curves away from the notes and is positioned on the 
notehead side.

● If the stem directions differ, the tie curves upwards by default.

Tied chords in single-voice contexts

If a tie joins two chords, the direction of the ties is determined by the number of tied notes in the 
chords.

● For an even number, the ties are equally split between curving towards the notehead end 
and curving towards the stem end.

● For an uneven number, the majority of ties curve towards the notehead end.

Tied notes in multiple-voice contexts

Ties are positioned on the stem side and are curved as follows:

● For up-stem voices, ties curve upwards.

● For down-stem voices, ties curve downwards.

● For overlapping/interlocking pitches in multiple voices, the rules for tied chords in single-
voice contexts apply. All notes in all voices are treated as if they belong to a single voice.

TIP

You can change the default tie curvature direction of ties between notes with different stem 
directions on the Ties page in Engraving Options.

You can also change the curvature direction of ties individually.

RELATED LINKS
Tie height on page 1635
Tie shoulder offset on page 1637
Erasing the background of stems on page 1281

Changing the curvature direction of ties
You can change the curvature direction of ties individually, including individual ties within tie 
chains. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

Ties
Tie curvature direction 

1626
Dorico Pro 4.3.30



● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the ties whose curvature direction you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

● In Write mode, you can only select whole tie chains. In Engrave mode, you can select 
individual ties within tie chains.

● Any changes to tie chains in Write mode only affect the first tie in the chain.

2. In the Properties panel, activate Direction in the Ties group.

3. Choose one of the following options:

● Up 

● Down 

RESULT
The curvature direction of the selected ties is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can adjust the precise shapes of tie chains, and of each tie within tie chains, in Engrave mode 
using the square handles on each tie.

RELATED LINKS
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Changing the shape/angle of ties on page 1632

Non-standard ties
Usually, ties join two notes of the same pitch in the same staff. However, ties can also cross 
system breaks and frame breaks, clef changes, or time signature changes. These types of ties are 
all positioned automatically in Dorico Pro.

Ties can also join non-adjacent notes, notes in different voices, or notes in different staves 
together. In Dorico Pro, you must input these types of ties manually.

Ties across system/frame breaks

The ends of ties that cross system/frame breaks are automatically positioned in Dorico Pro.

Their vertical position remains the same, as both ends are centered on the noteheads to which 
they are attached. Their behavior also remains the same, as selecting one note in a tie chain that 
crosses a system/frame break in Write mode selects all notes in the tie chain.

Ties
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The horizontal space for the parts of ties shown to the left of notes at the start of new systems/
frames may not be sufficient to show an ideal tie curve. In such cases, you can use Note Spacing 

 in Engrave mode to adjust the spacing of individual notes at the start of systems/frames to 
give ties more space.

The start of a tie chain before a system break The end of the same tie chain after a system break

Tied notes with accidentals across system/frame breaks

The ends of ties for tied notes with accidentals across system/frame breaks are also 
automatically positioned.

As tied notes in Dorico Pro are treated as one note notated to fit in time signatures, cautionary 
accidentals at the start of new systems/frames are not shown by default. If you choose to show 
accidentals beside notes in tie chains at the start of new systems/frames, the position of the 
notes is changed to accommodate accidentals. However, this automatic position might not leave 
sufficient room for the part of the tie to the left of the notes to be shown with an ideal curve.

The start of a tie chain before a 
system break

The end of the same tie chain, 
with a cautionary accidental in 
parentheses

The end of the same tie chain 
after adjusting note spacing to 
give the tie beside the accidental 
more space

Ties across time signature changes

Ties are automatically positioned between notes that span a time signature change. If ties 
crossing a time signature change are joining notes in the middle of a staff, the top or bottom of 
the time signature change is partially obscured by the ties. However, as ties are curved, the time 
signature is unlikely to be completely obscured.

Ties across clef changes

Ties are automatically positioned between notes that span a change of clef. Ties across clef 
changes are not horizontal, as the same pitch is positioned differently in each clef.

The result of cross-clef ties is likely to be visually and musically confusing, as they can be misread 
as slurs. In this case, consider moving the change of clef to before/after the tied note.

Ties between non-adjacent notes

You can input ties between notes of the same pitch that are not directly beside each other and 
between grace notes and normal notes. This can be useful when inputting ties between multiple 
notes before a chord, for example.

Ties
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Tied notes building up a chord Notes tied to the following chord Multiple grace notes tied to 
the following chord

Ties between different voices

You can input ties between notes of the same pitch in different voices belonging to the same 
instrument.

Ties between notes on different staves

You can input ties between notes of the same pitch in different staves belonging to the same 
instrument, such as the two staves of a piano.

Laissez vibrer ties

Laissez vibrer ties are short ties that indicate a note should be left to ring, and should not be 
stopped. They extend a small amount to the right of the note to which they apply, but do not 
connect to another note.

You can add laissez vibrer ties to any note. You can edit laissez vibrer ties in Engrave mode like any 
other tie.

RELATED LINKS
Inputting ties on page 248
Hiding/Showing or parenthesizing accidentals on page 943
System breaks on page 733
Frame breaks on page 736
Note spacing on page 599
Adjusting note spacing at individual rhythmic positions on page 604

Hiding/Showing laissez vibrer ties
You can add laissez vibrer ties to any note; for example, to specify which notes must not be 
stopped after being played but instead left to ring.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes on which you want to add a laissez vibrer tie. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate/deactivate Laissez vibrer tie in the Notes and Rests group.

Ties
Hiding/Showing laissez vibrer ties 
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RESULT
Laissez vibrer ties are added to the selected notes when the property is activated, and are 
removed when the property is deactivated. Laissez vibrer ties are positioned automatically.

TIP

● You can edit the length and shape of laissez vibrer ties individually like any other tie in 
Engrave mode. You can also change the default minimum length of all laissez vibrer ties 
project-wide in the Length section of the Ties page in Engraving Options.

● You can assign a key command for Toggle Laissez Vibrer Tie on the Key Commands page 
in Preferences.

EXAMPLE

Phrase without laissez vibrer ties Phrase with laissez vibrer ties

RELATED LINKS
Changing the shape/angle of ties on page 1632
Engraving Options dialog on page 840
Engrave toolbox on page 514

Deleting ties
You can delete ties without deleting the notes to which they are attached.

NOTE

Deleting ties from tie chains removes all ties in the tie chain. If you want to remove single ties 
from longer tie chains, you can split the tie chain.

PROCEDURE

1. In Write mode, select the tie chains from which you want to delete all ties.

2. Delete all ties in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

RESULT
All ties in the selected tie chains are deleted. Notes previously in the tie chain remain at their 
rhythmic positions.

RELATED LINKS
Notes toolbox on page 197

Ties
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Changing the duration of notes on page 259

Splitting tie chains
You can split tie chains at specified positions; for example, if you want to change the pitch 
halfway through a tie chain or delete individual ties within tie chains. This does not remove any 
other ties in the tie chain.

NOTE

If you want to split ties because Dorico Pro notated notes differently than you expected, you can 
change the default note and rest grouping settings according to different meters. You can also 
set custom beat groupings for individual time signatures.

PROCEDURE

1. In Write mode, double-click the staff where you want to split a tie chain to start note input at 
that position.

2. Optional: Move the caret to where you want to split the tie chain.

● To move the caret according to the current rhythmic grid resolution, press 
Right Arrow / Left Arrow .

● To advance the caret according to the note value currently selected, press Space  or click 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

3. Split the tie chain in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

4. Optional: If you want to split the same tie chain in multiple places, move the caret to the next 
rhythmic position where you want to split the tie chain and repeat step 3.

5. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The tie chain is split at the caret position.

RELATED LINKS
Note and rest grouping on page 1021
Beam grouping according to meters on page 999
Creating custom beat groupings for meters on page 1021
Splitting notes by duration on page 261
Notes toolbox on page 197
Caret on page 215
Moving the caret manually on page 220
Rhythmic grid on page 214
Erasing the background of time signatures on page 1657
Keyboard panel on page 207
Fretboard panel on page 209

Ties
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Drum Pads panel on page 210

Ties in Engrave mode
In Engrave mode, each tie has five square handles that you can move independently. Some 
handles are connected to others, meaning moving one can affect the position of neighboring 
handles.

Ties have the following handles in Engrave mode:

1 Left endpoint

2 Left control point

3 Tie height

4 Right control point

5 Right endpoint

For example, moving the left endpoint moves both the start of a tie and the other handles apart 
from the right endpoint. However, moving the right control point only causes the tie height 
handle to move as well. This gives you fine control over the shape of ties, while ensuring the end 
result remains curved and smooth.

You can move these handles to change the shape/angle of ties with the keyboard, with the 
mouse, and by using properties in the Ties group of the Properties panel.

RELATED LINKS
Tie height on page 1635
Tie shoulder offset on page 1637

Changing the shape/angle of ties
You can change move ties and tie handles graphically, allowing you to change the shape and/or 
angle of individual ties; for example, to adjust an endpoint relative to an individual notehead. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the whole ties or individual tie handles you want to move in any of 
the following ways:

● Ctrl/Cmd -click multiple ties.

● Ctrl/Cmd -click individual handles on multiple ties.

● Select a whole tie and press Tab  to cycle through its handles until the one you want to 
move is selected.

● Click the handle you want to move.

Ties
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NOTE

● To change the angle of ties, select tie endpoints only.

● You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

● You cannot move whole ties to the right/left, you can only move them upwards/
downwards.

2. Move the ties or handles in any of the following ways:

● To move them a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left. This moves ties/handles by 1/8 space per press.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves handles by 1 space per press.

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves handles by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves handles by 1/32 space per 
press.

● Click and drag whole ties upwards/downwards.

● Click and drag them in any direction.

RESULT
The selected ties or tie handles are moved. Depending on the handles you selected and the 
directions in which you moved them, this can change the shape, angle, and/or proportional size 
of the corresponding ties. If the property scope was set to Locally, this change only takes effect 
in the current layout and frame chain.

TIP

The following properties in the Ties group of the Properties panel are activated automatically 
when you move the corresponding tie handles:

● Start offset moves the left endpoints of ties. X moves them horizontally, Y moves them 
vertically.

● End offset moves the right endpoints of ties. X moves them horizontally, Y moves them 
vertically.

● Start handle offset moves the left control points of ties. X moves them horizontally, Y 
moves them vertically.

● End handle offset moves the right control points of ties. X moves them horizontally, Y 
moves them vertically.

You can also use these properties to change the shape of individual ties by changing the values 
in the value fields.

Deactivating the properties resets the corresponding handles on the selected ties to their default 
positions.

Ties
Ties in Engrave mode 
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EXAMPLE
Moving the left endpoint moves both the start of a tie and the other handles apart from the right 
endpoint. This allows you to change the angle and/or width of the tie without changing its overall 
shape.

Moving the left control point causes the tie height handle to move but does not affect the 
position of the left and right endpoints or right control point. This gives you fine control over the 
shape of ties while ensuring that the end result remains curved and smooth.

RELATED LINKS
Project-wide engraving options for ties on page 1621
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the thickness of ties
You can change the thickness of individual ties, including changing the thickness of the middle 
of ties independently of the ends of ties, independently of your project-wide settings. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the ties whose thickness you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the Ties 
group:

● End thickness

● Middle thickness

3. Change the values in the value fields.

RESULT
Increasing the values makes the corresponding part of the selected ties thicker, decreasing the 
values makes the corresponding part of the selected ties thinner. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

● Deactivating the properties returns the corresponding part of the selected ties to their 
default thickness.

● You can change the default thickness of all ties project-wide on the Ties page in Engraving 
Options.

RELATED LINKS
Project-wide engraving options for ties on page 1621
Engraving Options dialog on page 840

Ties
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Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Tie height
The height of ties determines how far above/below their endpoints ties extend vertically.

To avoid the end points or curve apexes of ties starting or ending on staff lines, Dorico Pro 
automatically makes small changes to the curvature shape, height, and vertical position of ties. 
These changes are small, but the placement of ties is subtly different depending on the position 
of notes relative to staff lines.

A tie outside noteheads When transposed one note down, the tie appears 
with a steeper curve to avoid reaching its apex on 
the staff line.

A tie between noteheads, with the ends slightly 
above the vertical center of the noteheads to avoid 
the tie appearing too close to the staff line at its 
ends or apex.

When transposed up, the ends of the tie are now 
positioned at the vertical center of the notehead, as 
there is no staff line with which it could collide.

You can change the default height of all ties project-wide in Engraving Options > Ties > 
Design > Advanced Options. There are separate settings for short ties and long ties.

You can change the height of individual ties in Engrave mode.

Increasing the height of ties makes them extend further from the vertical position of their 
endpoints, which gives them a rounder shape and means they take up more vertical space. Ties 
generally do not need to be as curved as slurs, as they join notes of the same pitch instead of 
arching over or above a range of pitches.

Where vertical space is tight, a balance must be found between how curved ties are and ensuring 
staves do not overlap.

A long tie with default height A long tie with increased height

Ties
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Changing the height of ties
You can change the height of individual ties independently of your project-wide settings; for 
example, to save vertical space on tightly-spaced pages. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the tie height (middle) handle of the ties whose height you want to 
change.

TIP

You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

2. Move the handles in any of the following ways:

● To move them upwards/downwards a standard amount, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move handles 
upwards. This moves handles by 1/8 space per press.

● To move them upwards/downwards a large amount, press Ctrl/Cmd  plus the standard 
key command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves handles by 1 
space per press.

● To move them upwards/downwards a moderate amount, press Shift  plus the standard 
key command; for example, Shift-Alt/Opt-Up Arrow . This moves handles by 1/2 space 
per press.

● To move them upwards/downwards a small amount, press Ctrl/Cmd - Shift  plus the 
standard key command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves 
handles by 1/32 space per press.

● Click and drag them upwards/downwards.

RESULT
The height of the selected ties is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

NOTE

● To maintain a visually pleasing and symmetrical curve when changing the height of ties 
manually, you may need to move tie height handles to the right/left by a small amount, as 
well as upwards/downwards.

● Moving tie height handles to the right/left affects the shape of the whole tie.

● You can change the default height of all ties project-wide in Engraving Options > Ties > 
Design > Advanced Options. There are separate settings for short ties and long ties.

RELATED LINKS
Project-wide engraving options for ties on page 1621
Engraving Options dialog on page 840
Engrave toolbox on page 514

Ties
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Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Tie shoulder offset
Tie shoulders affect the angles of the curves of ties as they taper towards an endpoint, as the 
tapered ends often approach noteheads at a steeper angle than that of a tie’s arch.

Increasing the shoulder offset makes the onset of the curve shallower, whereas decreasing the 
shoulder offset makes the onset steeper.

You can change the default shoulder offset of all ties project-wide in Engraving Options > Ties > 
Design > Advanced Options. There are separate settings for short ties and long ties.

A long tie with default shoulder offset A long tie with increased shoulder offset

You can also change the shoulder offset of ties individually by moving their control point handles 
in Engrave mode.

Changing the shoulder offset of ties
You can change the shoulder offset of individual ties, independently of your project-wide 
settings. For example, you might want to change the shoulder offset of a few very short or 
very long ties in your project to improve their shape. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select one of the control point handles on each of the ties whose 
shoulders you want to adjust in any of the following ways:

● Select a whole tie and press Tab  to cycle through the handles until the one you want to 
move is selected.

● Click the handle you want to move.

● Ctrl/Cmd -click individual handles on multiple ties.

TIP

You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

2. Move the handles in any of the following ways:

● To move them a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left. This moves handles by 1/8 space per press.

Ties
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● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves handles by 1 space per press.

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves handles by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves handles by 1/32 space per 
press.

● Click and drag them in any direction.

3. Optional: Repeat steps 1 and 2 for the other control point handle on the ties whose 
shoulders you want to adjust.

RESULT
Moving tie offset handles further apart reduces the shoulder offset, while moving them closer 
together increases the shoulder offset. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

TIP

● The following properties in the Ties group of the Properties panel are activated 
automatically when you move the corresponding tie handles:

● Start handle offset moves the left control points of ties. X moves them horizontally, Y 
moves them vertically.

● End handle offset moves the right control points of ties. X moves them horizontally, Y 
moves them vertically.

You can also use these properties to change the shoulder offset of individual ties by 
changing the values in the value fields.

Deactivating the properties resets the corresponding handles on the selected ties to their 
default positions.

● You can change the default shoulder offset of all ties project-wide in Engraving Options > 
Ties > Design > Advanced Options. There are separate settings for short ties and long ties.

RELATED LINKS
Project-wide engraving options for ties on page 1621
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
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Time signatures

Time signatures indicate the meter of music, and apply to all bars from where they first appear 
until a subsequent change of time signature. Meter describes the rhythmic pulse of music, and 
its division into beats and bars.

A time signature is made up of two parts: numerator on top, and denominator underneath. 
These are the same mathematical terms as are used for fractions due to their similar 
arrangement. Depending on your project-wide settings for time signature style, numerators and 
denominators can have different appearances.

1 Numerator

Specifies the number of beats in each bar for the time signature. The duration of beats is 
specified by the denominator.

2 Denominator

Specifies the beat duration for the time signature. The denominator doubles for every 
halving of the beat duration: 1 is a whole note (breve), 2 is a half note (minim), 4 is a quarter 
note (crotchet), 8 is an eighth note (quaver), and so on.

For example, a 4/4 time signature tells you the bar is made up of four beats, and each of those 
beats is a quarter note in length. A time signature of 4/2 contains four half notes in each bar, and 
4/8 contains four eighth notes (quavers) in each bar. Both 3/4 and 6/8 contain six eighth notes, 
but it is understood that a 3/4 bar contains three quarter note beats, whereas a 6/8 bar contains 
two dotted quarter note beats.

Bars are rhythmic groups, divided according to the time signature, and they make following the 
music much more practical and easier to read. Notes are beamed differently in different time 
signatures for the same reasons.

By default, time signatures apply to all staves. However, there are certain situations, such as in 
polymetric music, where some parts require their own time signature, independently of the rest 
of the ensemble. You can input time signatures that apply to all staves or only apply to single 
staves in Dorico Pro.

Time signatures apply until the next time signature change or the end of the flow, whichever 
comes first.

Time signatures traditionally use a unique, heavy font that ensures they stand out against staff 
lines, and fill the height of a single staff. For some types of music, particularly film music, it is 
typical to use large time signatures that span several staves.

NOTE

● You can input notes without inputting a time signature.

● Beat lengths are fixed across all staves in your project, regardless of the time signature. For 
example, if you have a 2/4 time signature on one staff and a 6/8 time signature on another 
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staff, then one quarter note in the 2/4 time signature equals one quarter note in the 6/8 time 
signature, meaning their barlines do not match.

● Dorico Pro does not automatically add beats to fill bars when you input time signatures 
unless Insert mode is activated.

A 5/8 time signature input before an existing 4/4 time signature without Insert mode activated, leaving 
only three eighth note beats in the second 5/8 bar.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 284
Types of time signatures on page 1641
Time signature styles on page 1647
Pick-up bars on page 1643
Large time signatures on page 1645
Time signature font styles on page 1656
Beam grouping according to meters on page 999
Note and rest grouping on page 1021
Time Signatures (Meter) panel on page 287
Creating custom beat groupings for meters on page 1021
Bars on page 962
Insert mode on page 454
Inputting notes on page 221

Project-wide engraving options for time signatures
You can find options for the project-wide appearance of time signatures, including large time 
signatures, on the Time Signatures page in Engraving Options.

The options on this page allow you to change the appearance of all numerators 
and denominators project-wide, the appearance of meterless time signatures, and how 
interchangeable time signatures are separated.

You can also change the default gaps in time signatures; for example, the gap between 
interchangeable time signatures and their separator.

Separate sections control the appearance and position of large time signatures when shown 
once per bracketed group and when shown at system object positions, including how collisions 
with other items at the same position as time signatures shown at system object positions are 
avoided.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
Time signatures on page 1639
Large time signatures on page 1645
Positions of time signatures on page 1652

Time signatures
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Types of time signatures
There are different types of time signatures, which can indicate various and complex meters.

NOTE

Dorico Pro uses the definitions for meters commonly used in American English. These 
definitions, such as which meters are considered simple and compound, might be different in 
other languages.

Simple
In simple time signatures, each beat is divided by two into equal groups of notes. 
Simple time signatures can be simple duple, such as 2/4, simple triple, such as 3/4, or 
simple quadruple, such as 4/4.

Compound
In compound time signatures, each beat is divided by three into equal groups of 
dotted notes, such as 6/8, which contains two dotted quarter note beats, or 9/4, which 
contains three dotted half note beats.

Irregular
Irregular time signatures, such as 5/4 or 7/8, cannot be subdivided into equal beat 
groups. Because the numerator is odd, these time signatures must be divided into 
unequal beat groups. For example, 5/4 usually contains a half note beat and a dotted 
half note beat.

Additive
Additive time signatures show how bars are subdivided into beat groups. You can show 
beat group numerators for any type of time signature. For example, instead of 7/8, you 
could show an additive time signature of 2+3+2/8.

Alternating
An alternating time signature indicates a regular pattern that switches every bar 
between two or more time signatures, in the indicated order. For example, for a phrase 
with twelve eighth notes that needs to be emphasized 3+3+2+2+2, an alternating time 
signature of 6/8+3/4 might allow the two meters to be read more clearly.

Interchangeable
An interchangeable time signature indicates a set of time signatures at the start of 
the piece that can be used during the piece, such as 3/4–2/4. Unlike alternating time 
signatures, interchangeable time signatures do not require a fixed pattern; any bar in 
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the piece can follow any of the time signatures in the set without having to restate the 
time signature.

NOTE

You must manually input the appropriate time signatures where you want them, 
as unlike alternating time signatures, there is no fixed pattern for them. Any time 
signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

They can have different separator styles in Dorico Pro, which you can set project-wide 
and also change individually.

Aggregate
An aggregate time signature shows two or more meters within the same bar, such as 
2/4+3/8+5/4. Dorico Pro automatically shows dashed barlines to indicate the divisions 
between the different meters, but you can also specify that you do not want to show 
dashed barlines when you input aggregate time signatures with the popover.

Open
An open time signature has no restrictions on meter, beaming, or beats. Any number 
of notes can be added, with any beaming. For example, open time signatures might be 
used for cadenza passages.

NOTE

In open meters, you must input barlines and add beats manually. You can also extend 
open meter bars by inputting notes with Insert mode activated and set to a global 
scope.

Non-power of two
A non-power of two time signature is one such as 5/6, which indicates five sextuplet 
quarter notes (crotchets) where the sextuplet overall equals a whole note (semibreve). 
Examples of time signatures like this can be found in the music of Adès.

NOTE

Some composers, such as Boulez, have written fractional time signatures. Dorico Pro does not 
currently support fractional time signatures.

RELATED LINKS
Time signature styles on page 1647
Large time signatures on page 1645
Note and rest grouping on page 1021
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Input methods for time signatures and pick-up bars on page 284
Input methods for bars, beats, and barlines on page 302
Ending interchangeable time signatures on page 1655
Insert mode on page 454

Cautionary time signatures
When a time signature change occurs at a system break, either in the score or in a part, the new 
time signature is shown at the end of the first system as well as at the start of the new system.

This is sometimes considered a “cautionary time signature”, because it warns performers of an 
upcoming change of time signature before it takes effect.

In Dorico Pro, the time signatures shown at the end of one system and at the start of the next 
system are the same item, not separate items. You cannot hide cautionary time signatures.

If the music is separate enough that you do not want to see a time signature at the end of a 
system and you cannot change where the system break occurs, you can separate the music by 
creating a new flow at the point of the system break.

RELATED LINKS
Flows on page 166
Adding flows on page 166
Splitting flows on page 506
System breaks on page 733
Inserting system breaks on page 734
Cautionary key signatures on page 1216
Clefs on page 1070

Pick-up bars
Pick-up bars allow you to include music before the first full bar. They are also known as an 
“upbeat” or “anacrusis”. Often, pick-up bars only comprise a few beats whose main purpose is to 
lead in to the start of the piece.

Pick-up bar of four eighth notes at the start of a piece in 9/8

Pieces that start with a pick-up bar have time signatures that are positioned at the start of the 
system as normal. However, the first full bar of the time signature occurs after the first barline 
and not before. Therefore, pick-up bars do not contribute to the bar number count. Bar numbers 
are counted from the first full bar in the flow.

Because pick-up bars are linked to the number of notes/rests in the music, in Dorico Pro they are 
linked to time signatures. However, you can hide time signatures you do not want to show in the 
music.

Time signatures
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TIP

You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten the 
last bar in flows that start with a pick-up bar.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 284
Hiding/Showing time signatures on page 1655
Insert mode scopes on page 455
Deleting notes/items on page 459
Bars on page 962
Bar numbers on page 981
Track overview on page 615
Turning existing notes into grace notes on page 1195
Turning grace notes into normal notes on page 1196

Defining partial bars as pick-up bars or irregular bars
You can change whether explicit irregular bars at the start of time signatures are defined as 
pick-up bars. This affects how notes in the bars are beamed and grouped.

Notes in irregular bars defined as pick-up bars are beamed/grouped backwards from the end of 
the bar, while notes in irregular bars not defined as pick-up bars are beamed/grouped forwards 
from the start of the bar.

NOTE

You must input explicit irregular bars and pick-up bars as part of a time signature, such as by 
entering 4/4,1.5 into the time signatures popover to input a 4/4 time signature with a pick-up bar 
containing 1.5 quarter note beats, or three eighth notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signatures or the signposts of time signatures starting with an explicit 
irregular bar whose pick-up definition you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Group first bar as pick-up in the Time Signatures group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Irregular bars at the start of the selected time signatures are defined as pick-up bars when 
Group first bar as pick-up and its corresponding checkbox are both activated, and defined as 
normal irregular bars when the corresponding checkbox is deactivated.

When the property is deactivated, Dorico Pro uses internal heuristics to define them as either 
pick-up bars or normal irregular bars automatically.

Time signatures
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EXAMPLE

Irregular bar defined as pick-up into common time Irregular bar defined as normal irregular bar, not a 
pick-up

Large time signatures
Large time signatures are scaled-up time signatures that appear much larger than normal 
relative to the staff size. They can be helpful in orchestral scores, as the smaller staff size in 
such scores means standard time signatures are small and harder for conductors to read.

Large time signatures are also very commonly used in film scores, as conductors rarely have 
much time to prepare the scores before recording sessions. Having large time signatures makes 
changes in meter more visually clear on the page, especially when music contains multiple 
changes in meter.

In Dorico Pro, you can show large time signatures at the following positions:

● Once per bracketed group

● Above the staff and at system object positions

Time signatures shown once per bracketed group

Instead of showing a time signature on every staff that is the same height as the staff, you can 
instead show a single large time signature on each bracketed group of staves. When shown once 
per bracketed group, time signatures are scaled up in size according to the number of staves in 
the bracketed group. The largest time signatures are shown on bracketed groups containing four 
or more staves. When shown on single staves, they extend a small amount above and below the 
staff, which is commonly used for parts for film music recording sessions.

Narrow, serif time signatures shown once per bracketed group

You can change the size of time signatures on different sizes of bracketed groups on the Time 
Signatures page in Engraving Options. You can also change whether all the staves between 
the brass and string brackets, which often include percussion, harp, and piano, are treated as a 
single bracket or separately for the purposes of showing large time signatures.

Large time signatures shown on bracketed groups occupy horizontal space, which can be a 
significant amount when they are especially large and use the standard time signature design. 
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Therefore, we recommend that you use one of the narrow designs in layouts that show large 
time signatures on bracketed groups.

Time signatures shown at system object positions

Similar to showing large time signatures once per bracketed group, you can also show time 
signatures only at system object positions and above the staff. Therefore, their positions in each 
system are controlled by the same options that control the positions of other system objects, 
such as rehearsal marks and tempo marks.

Normal time signatures shown at system object positions

Time signatures shown at system object positions do not occupy horizontal space, meaning it 
is less important to use a narrow font style. This also reduces the horizontal distance between 
notes either side of time signatures. Because of this reduced disruption to note spacing, this 
placement of time signatures has become popular in contemporary art music since the 20th 
Century.

When using the note denominator style for time signatures shown at system object positions, 
the note is shown to the right of the numerator rather than below.

By default, time signatures at system object positions are twice the size of normal time 
signatures and force other items at the same position to appear to the right. You can change 
their scale factor and the default position of other items at the same position on the Time 
Signatures page in Engraving Options. You can also change their alignment relative to barlines.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 284
Time signature font styles on page 1656
Changing the design of time signatures on page 1656
Changing the position of time signatures on bracketed groups on page 1654
System objects on page 1563
Changing the positions of system objects on page 1564
Hiding bar numbers at time signatures shown at system object positions on page 990
Engraving Options dialog on page 840

Changing the size and position of time signatures
You can change the size of time signatures in each layout independently, including changing 
their vertical position. For example, you can show large time signatures centered on each bracket 
in full score layouts but standard-sized time signatures on each staff in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the size of time 
signatures.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Time Signatures.

4. Choose one of the following options for Time signature position and size:

● Show on every staff

● Show once per bracket

● Show at system object positions

5. Click Apply, then Close.

RESULT
The size and position of time signatures in the selected layouts is changed.

Showing large time signatures above the staff at system object positions means they do not 
occupy any rhythmic or horizontal space, whereas the other options do cause time signatures to 
occupy horizontal space.

AFTER COMPLETING THIS TASK
You can change whether large time signatures are placed vertically in the middle or on the top of 
bracketed groups on the Time Signatures page in Engraving Options.

RELATED LINKS
Large time signatures on page 1645
Positions of time signatures on page 1652
Changing the design of time signatures on page 1656
Hiding bar numbers at time signatures shown at system object positions on page 990
Erasing the background of time signatures on page 1657
Project-wide engraving options for time signatures on page 1640
Engraving Options dialog on page 840

Time signature styles
Dorico Pro allows you to show time signatures in a variety of styles. For example, you can show 
denominators as a number or as a note value.

Numerator styles
The numerator is always one or more numbers, and can either show the total number 
of beats in the bar as a single number, or show how the total duration of the bar is 
subdivided into beat groups.

Number numerator Beat group numerator

Denominator styles
The denominator can appear as a number, as a note indicating the equivalent 
duration, or not appear at all.

If shown as a notehead, the denominator can either show the length of each beat 
in the bar, or the note duration for the bar. When showing the beat length, the 
numerator can change; for example, the numerator 6 in a 6/8 time signature becomes 
a 2 to reflect the two dotted quarter note beats that make up a 6/8 bar.
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Number 
denominator

Note denominator 
(beat length)

Note denominator 
(note duration)

None denominator

Open meter styles
Open time signatures can be shown as an X, Penderecki’s symbol, or be hidden with no 
symbol. Open time signatures with no symbol are indicated by signposts.

X open style Penderecki’s symbol open 
style

No symbol open style

Interchangeable time signature separator styles
Interchangeable time signatures can have different separator styles. You can specify 
the separator style when inputting interchangeable time signatures using the popover 
and for individual interchangeable time signatures after they have been input.

Parentheses separator Brackets separator Equals sign separator

Slash separator Space separator Hyphen separator

You can change the style of all time signatures project-wide according to their type on the 
Time Signatures page in Engraving Options, and you can change the style of individual time 
signatures independently of your project-wide settings.

RELATED LINKS
Project-wide engraving options for time signatures on page 1640
Engraving Options dialog on page 840
Types of time signatures on page 1641
Inputting time signatures with the popover on page 288
Time signatures popover on page 285
Changing the design of time signatures on page 1656
Changing the open meter style of time signatures on page 1650
Changing the separator style of interchangeable time signatures on page 1651
Changing the appearance of common/cut common time signatures on page 1652
Signposts on page 453
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Changing the numerator style of time signatures
You can choose whether the numerators of individual time signatures show the total number of 
beats in each bar, or the subdivision of beats in each bar, independently of your project-wide 
setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signatures whose numerator style you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Numerator style in the Time Signatures group.

3. Choose one of the following options:

● Number

● Beat group

RESULT
The numerator style of the selected time signatures is changed.

TIP

You can change the default numerator style of all time signatures project-wide on the Time 
Signatures page in Engraving Options.

RELATED LINKS
Project-wide engraving options for time signatures on page 1640
Engraving Options dialog on page 840
Engrave toolbox on page 514

Changing the denominator style of time signatures
You can change the denominator style of individual time signatures, independently of your 
project-wide settings; for example, if you want to show the denominator as a note instead of a 
number.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signatures whose denominator style you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Denominator style in the Time Signatures group.

3. Choose one of the following options:
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● Number

● Note

● None

RESULT
The denominator style of the selected time signatures is changed.

TIP

You can change the denominator style of all time signatures project-wide on the Time 
Signatures page in Engraving Options, including changing whether Note denominators show 
the beat length or note duration.

Changing the open meter style of time signatures
You can change the open meter style of individual time signatures, independently of your 
project-wide setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the open meter time signatures whose style you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, choose one of the following options for Open style in the Time 
Signatures group:

● No symbol 

● X 

● Penderecki’s symbol 

RESULT
The open meter style of the selected time signatures is changed. No symbol open time 
signatures are indicated by signposts.

TIP

You can change the style of all open meter time signatures project-wide on the Time Signatures 
page in Engraving Options.

RELATED LINKS
Time signature styles on page 1647
Input methods for time signatures and pick-up bars on page 284
Project-wide engraving options for time signatures on page 1640
Engraving Options dialog on page 840
Engrave toolbox on page 514
Signposts on page 453
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Changing the separator style of interchangeable time signatures
You can change the separator shown in interchangeable time signatures individually, 
independently of your project-wide setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the interchangeable time signatures whose separator you want to change. You can do 
this in Write mode and Engrave mode.

NOTE

In the Properties panel, Separator in the Time Signatures group is automatically activated 
for interchangeable time signatures.

2. Select one of the following options from the Separator menu:

● Parentheses 

● Brackets 

● Equals sign 

● Slash 

● Space 

● Hyphen 

RESULT
The separator style of the selected interchangeable time signatures is changed.

TIP

● You can specify the separator style when inputting interchangeable time signatures using 
the popover.

● You can change the default separator of all interchangeable time signatures project-wide on 
the Time Signatures page in Engraving Options.

● Although they might look similar to interchangeable time signatures, aggregate time 
signatures behave differently. Aggregate time signatures are separated by a + sign, whereas 
interchangeable time signatures can be shown with six different separators but not a + sign.

Therefore, although you can activate Separator and choose from the available options for 
aggregate time signatures, the property only affects the appearance of interchangeable time 
signature separators.

RELATED LINKS
Time signature styles on page 1647
Inputting time signatures with the popover on page 288
Time signatures popover on page 285
Project-wide engraving options for time signatures on page 1640
Engraving Options dialog on page 840
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Engrave toolbox on page 514

Changing the appearance of common/cut common time signatures
You can show individual common/cut common time signatures with either common/cut common 
symbols or with a numerator and denominator, such as 2/2 or 4/4.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the common/cut common time signatures whose appearance you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Common/Cut common in the Time Signatures 
group.

RESULT
The selected time signatures appear with common/cut common symbols when Common/Cut 
common is activated, and with a numerator and denominator when it is deactivated.

EXAMPLE

Common time signature 
symbol

Cut common time 
signature symbol

Common time signature, 
appearing as 4/4

Cut common time 
signature, appearing as 
2/2

RELATED LINKS
Input methods for time signatures and pick-up bars on page 284

Positions of time signatures
Standard time signatures are positioned on staves with the middle staff line, or only staff line for 
single-line staves, passing through their center. Large time signatures can be positioned in the 
middle or at the top of bracket groups, or above staves at system object positions.

Dorico Pro automatically positions time signatures after clefs, key signatures, and barlines.

You can move time signatures to different rhythmic positions in Write mode. They are positioned 
by default according to your settings in Engraving Options.

You can move individual time signatures graphically in Engrave mode; however, this does not 
change the rhythmic positions to which they are attached.

You can change the default positions of all time signatures project-wide, including both their 
horizontal and vertical positions, on the Spacing Gaps and Time Signatures pages in Engraving 
Options. You can change the default alignment of all time signatures shown at system object 

Time signatures
Positions of time signatures 

1652
Dorico Pro 4.3.30



positions in the Time Signatures at System Object Positions section of the Time Signatures 
page.

You can also change the position of time signatures in each layout independently; for example, if 
you want to show time signatures above the staff and at system object positions in some layouts 
but only once per bracket in other layouts.

RELATED LINKS
System objects on page 1563
Cautionary time signatures on page 1643
Large time signatures on page 1645
Changing the positions of system objects on page 1564
Moving items graphically on page 609
Erasing the background of time signatures on page 1657
Project-wide engraving options for time signatures on page 1640
Engraving Options dialog on page 840
Input methods for time signatures and pick-up bars on page 284

Moving time signatures graphically
You can move individual time signatures to new graphical positions without affecting the 
positions of any other items.

NOTE

● These steps do not apply to time signatures shown at system object positions, which you can 
move when Graphic Editing  is selected in the Notes toolbox.

● You cannot move time signatures shown at the start of systems. You can only move time 
signature changes that occur partway through systems or at the end of systems.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a square note spacing handle at the rhythmic position of the time 
signature you want to move.

A circular handle appears beside the time signature.

2. Press Tab  to select the circular handle.

3. Move the handle in any of the following ways:

● To move it a standard amount to the right or left, press Alt/Opt  plus the corresponding 
arrow key. For example, press Alt/Opt-Left Arrow  to move handles to the left.

● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .
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● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.

RESULT
The time signature is moved graphically to the right/left.

TIP

You can also change the value for Spacing offset in the Time Signatures group of the Properties 
panel to move time signatures horizontally. However, this also affects global note spacing 
around the rhythmic position of the time signature.

The Spacing offset value is independent of note spacing changes.

RELATED LINKS
Engrave toolbox on page 514
Note spacing on page 599
Moving items graphically on page 609

Changing the position of time signatures on bracketed groups
By default, time signatures shown once per bracket are centered on each bracketed group. You 
can change their vertical position on bracketed groups for all layouts project-wide; for example, 
it is common in film scores to show the top of large time signatures aligned with the top of each 
bracketed group.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Time Signatures.

3. In the Time Signatures Centered on Brackets section, choose one of the following options 
for Vertical alignment relative to bracket:

● Top

● Middle

4. Click Apply, then Close.

RESULT
The vertical alignment of large time signatures relative to bracketed groups is changed in all 
layouts project-wide.

RELATED LINKS
Positions of time signatures on page 1652
Large time signatures on page 1645
Changing the size and position of time signatures on page 1646
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Hiding/Showing time signatures
You can hide/show time signatures without deleting them from your project. This hides/shows 
them in all layouts, not just the one currently open in the music area.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signatures you want to hide, or the signposts of time signatures you want to 
show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide time signature in the Time Signatures 
group.

RESULT
The selected time signatures are hidden in all layouts when Hide time signature is activated, 
and shown when it is deactivated.

Signposts are shown at the position of each hidden time signature. However, signposts are not 
printed by default.

NOTE

● Hidden time signatures do not take up any horizontal space, so hiding/showing time 
signatures affects note spacing.

● You can hide/show time signature signposts by choosing View > Signposts > Time 
Signatures.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Note spacing on page 599
Signposts on page 453
Engrave toolbox on page 514
Input methods for time signatures and pick-up bars on page 284
Annotations on page 687

Ending interchangeable time signatures
Any time signatures you input after an interchangeable time signature that are specified in 
it are hidden automatically. You can end interchangeable time signatures from selected time 
signatures, which shows them.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the barlines or signposts of time signature from which you want to end 
interchangeable time signatures. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate End interchangeable in the Time Signatures group.

RESULT
Interchangeable time signatures are ended at the selected time signatures. The selected time 
signatures and all subsequent time signatures specified in the prevailing interchangeable time 
signature are shown until the next existing interchangeable time signature or the end of the 
flow, whichever comes first.

Changing the design of time signatures
You can change the design of time signatures in each layout independently, including changing 
the font style used for them; for example, if you want to use a plain font for time signatures in 
full score layouts but the standard time signature font in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the design of time 
signatures.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Time Signatures.

4. Choose one of the following options for Time signature design:

● Normal

● Narrow, serif

● Narrow, sans serif

● Plain font

5. Click Apply, then Close.

RESULT
The design of time signatures in the selected layouts is changed. If you choose Plain font, time 
signatures use a different font style than the one used for the other options.

RELATED LINKS
Large time signatures on page 1645

Time signature font styles
Different time signature designs use different font styles. You can edit the formatting of fonts 
used for time signatures in the Edit Font Styles dialog.

The following font styles are used for time signatures:
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● Time Signature Font: Used for standard time signatures and large time signatures that 
use the Normal, Narrow, serif, or Narrow, sans serif design types. Must use a SMuFL-
compliant font family.

● Time Signature Plain Font: Used for time signatures using the Plain font design type. Can 
use any font family, but we recommend that you use narrow fonts for large time signatures.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 846
Large time signatures on page 1645
Changing the default font family on page 853

Erasing the background of time signatures
You can erase the background of all time signatures on single staves project-wide that are 
spanned by ties. This can improve the readability of time signatures in such circumstances.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Time Signatures.

3. In the Design section, activate/deactivate Erase background behind time signature inside 
staff with erasure of width [n] spaces.

4. Optional: Change the value in the value field.

5. Click Apply, then Close.

RESULT
The backgrounds of all time signatures on single staves project-wide that are spanned by ties are 
erased when the option is activated, and not erased when the option is deactivated. The erasure 
padding follows your set value.

EXAMPLE

Time signatures with non-erased backgrounds Time signatures with erased backgrounds

RELATED LINKS
Ties on page 1620
Types of time signatures on page 1641
Large time signatures on page 1645
Erasing the background of dynamics on page 1110
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Erasing the background of text playing techniques on page 1389
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Tremolos

Tremolos are thick, slanted lines that cross individual stems or are positioned between multiple 
stems. They are used to indicate that notes are repeated, either individually or in sequences of 
multiple notes.

Using tremolo strokes instead of notating each notehead can save horizontal space and make 
fast passages easier to read.

The number of tremolo strokes indicates both how many times notes are repeated and how fast 
they are. In measured tremolos, for example, one tremolo stroke on the stem of a quarter note 
(crotchet) indicates two eighth notes (quavers) are played, whereas three tremolo strokes on the 
stem of a quarter note indicates eight 32nd notes are played.

Quarter note with a one-stroke single-note tremolo 
and its equivalent notation

Quarter note with a three-stroke single-note tremolo 
and its equivalent notation

There are different types of tremolos:

Single-note tremolos
Individual notes are repeated. Single-note tremolos are positioned on note stems.

Two-stroke single-note tremolos added to four quarter notes

Multi-note tremolos
Multiple notes, usually two, are played in sequence, similar to a trill. However, trills 
usually indicate a fast alternation between two adjacent notes, such as G and A, 
whereas multi-note tremolos can be between any notes, limited only by the capabilities 
of the instrument.

All notes in multi-note tremolos indicate the total duration of the tremolo. For example, 
two quarter notes joined by a multi-note tremolo both appear as half notes.

Multi-note tremolos are positioned between the stems of two or more notes.
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Four quarter notes without tremolos Multi-note tremolos input between those 
quarter notes, in two pairs

Tuplet tremolos
Multiple notes in tuplets are repeated in the notated sequence. Tuplet tremolos are 
positioned between all the notes in the tuplet.

Quarter notes in two different tuplets 
without tremolos

Multi-note tuplet tremolos input across 
those tuplets

Depending on the musical context, tremolos can be either measured or unmeasured. There is 
no visual difference between measured/unmeasured tremolos, so composers/arrangers often 
specify how they want tremolos to be played, such as an indication in the front matter of the 
score or as a text instruction in the score.

Measured tremolos
The number of tremolo strokes corresponds to a precise rhythm in the prevailing 
tempo and meter.

Unmeasured tremolos
There is no link between the number of strokes and rhythm. Instead, unmeasured 
tremolos are played as fast as possible, whatever the tempo.

Unmeasured tremolos often use three or more tremolo strokes, and can also be 
accompanied by a “trem.” text indication.

RELATED LINKS
Input methods for repeats and tremolos on page 406
Deleting tremolos on page 1664
Tremolos in tie chains on page 1661
Changing the speed of tremolos on page 1663
Tremolos in playback on page 1667
MIDI Import Options dialog on page 90

Project-wide engraving options for tremolos
You can find options for the project-wide appearance and position of tremolos on the Tremolos 
page in Engraving Options.

The options on the Tremolos page allow you to change the appearance of tremolo strokes, and 
their positions relative to the ends of stems, stem flags, noteheads, and beams.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.
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RELATED LINKS
Engraving Options dialog on page 840
Project-wide engraving options for stems on page 1273

General placement conventions for tremolos
Single-note tremolos are positioned on note stems, whereas multi-note tremolos are positioned 
between the stems of two or more notes. When multi-note tremolos cross three or more notes, 
the tremolo strokes are positioned between all the notes.

Tremolo strokes are slightly thinner than beams, so that the gaps between strokes are large 
enough and the number of strokes can be instantly recognized.

Dorico Pro automatically avoids collisions between tremolo strokes and ledger lines or stem 
flags.

Tremolo strokes within the staff are positioned so that they are at least one staff space clear of 
noteheads, and at valid positions relative to staff lines and staff spaces. This means that tremolo 
strokes might not move every time you change the pitch of notes.

The positions of the tremolo strokes on the first two notes and the last two notes are the same, although the 
pitches are all different.

In Dorico Pro, the angle of single-note tremolo strokes is always the same, no matter the 
direction of the phrase. The angles of multi-note tremolo strokes are determined by the height 
of the stems to which the multi-note tremolos apply. You can change the angles of multi-note 
tremolo strokes individually by lengthening/shortening the stems at the start/end of the tremolo.

You can change the default positions of all tremolo strokes project-wide on the Tremolos page in 
Engraving Options.

Tremolos in tie chains
By default, single-note tremolos appear either on all notes in tie chains, or on all notes apart 
from the first or last note. Deleting tremolo strokes from tied notes removes tremolo strokes 
from all notes in tie chains.

In Dorico Pro, we use “tremolo with attack” and “tremolo with release” to refer to single-note 
tremolos that appear on all notes in tie chains apart from the first and last note, respectively.

Single-note tremolo added to tie chain Tremolo with release added to tie chain

In Dorico Pro, tremolos are considered measured by default, so the number of tremolo strokes 
shown is automatically adjusted on subsequent notes in tie chains as required. For example, if 
an eighth note with two tremolo strokes is tied to a quarter note, the quarter note has three 
tremolo strokes. This is because tremolo strokes function like beams, so two tremolo strokes and 
an eighth note stem flag is the equivalent of three tremolo strokes.
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The default number of tremolo strokes in a tie chain 
where the second note is longer than the first.

The number of tremolo strokes on the second note 
has been changed to match the first.

However, there might be circumstances in which you want all notes to have the same number of 
tremolo strokes, whatever their duration. You can also start tremolos partway through tie chains, 
or stop tremolos partway through tie chains.

You can change the number of tremolo strokes shown on individual notes independently in 
Engrave mode.

RELATED LINKS
Ties on page 1620
Inputting tremolos with the popover on page 415
Inputting tremolos with the panel on page 417
Deleting tremolos on page 1664

Changing the number of tremolo strokes on individual notes in tie 
chains

Dorico Pro automatically changes the number of tremolo strokes on subsequent notes in tie 
chains according to their duration, but you can manually change the number of single-note 
tremolo strokes shown on each note in tie chains individually to represent your intended rhythm. 
For example, if you want all notes in a tie chain to have the same number of tremolo strokes, 
whatever their duration.

TIP

If you want to remove tremolo strokes from the first or last notes in tie chains, you can input 
tremolos with an attack or release, respectively.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the noteheads of the notes whose number of tremolo strokes you 
want to change.

2. In the Properties panel, activate Single stem tremolo in the Notes and Rests group.

3. Select one of the following options from the menu:

● None

● One stroke

● Two strokes

● Three strokes

● Four strokes
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● Buzz roll

RESULT
The number of tremolo strokes shown on the selected notes is changed.

EXAMPLE

The default number of tremolo strokes in a tie chain 
where the second note is longer than the first.

The number of tremolo strokes on the second note 
has been changed to match the first.

RELATED LINKS
Engrave toolbox on page 514
Changing the speed of tremolos on page 1663
Input methods for repeats and tremolos on page 406

Changing the speed of tremolos
You can change the speed of tremolos after they have been input by changing the number of 
strokes.

PROCEDURE

1. In Write mode, select the notes with tremolos whose speed you want to change.

The buttons with the number of tremolo strokes corresponding to your selection are 
highlighted in the Tremolos section of the Repeat Structures panel.

NOTE

Select single-note tremolos and multi-note tremolos separately.

2. Click the button with the number of tremolo strokes you want in the Tremolos section of the 
Repeat Structures panel.

For example, click Two Strokes Single-note Tremolo  to input single-note tremolos with 
two strokes, or click Three Strokes Multi-note Tremolo  to input multi-note tremolos with 
three strokes.

RESULT
The number of tremolo strokes on the selected notes is changed, which changes the speed of 
the tremolos.

RELATED LINKS
Tremolos in playback on page 1667
Changing the number of tremolo strokes on individual notes in tie chains on page 1662
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Changing the appearance of multi-note half note tremolos
There are multiple accepted ways of notating multi-note half note tremolos. You can change 
how all multi-note half note tremolos are notated project-wide; for example, if you want them to 
appear with lines joining stems.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Tremolos.

3. In the Multi-note Tremolos section, choose one of the following options for Appearance of 
half note (minim) tremolos:

● All lines join stems

● Outermost line joins stems

● No lines join stems

4. Click Apply, then Close.

RESULT
The appearance of all multi-note half note tremolos project-wide is changed.

EXAMPLE

All lines join stems Outermost line joins stems No lines join stems

Deleting tremolos
You can remove single-note tremolos and multi-note tremolos from notes separately without 
affecting the notes to which they applied.

PROCEDURE

1. In Write mode, select the notes whose tremolo strokes you want to delete.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Tremolos section, click one or both of the following buttons, depending on the types 
of tremolos selected:

● Remove Single-note Tremolo 

● Remove Multi-note Tremolo 

RESULT
The corresponding types of tremolo strokes are deleted.
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TIP

You can also delete tremolos by entering 0 or clear into the repeats popover.

RELATED LINKS
Notations toolbox on page 202
Repeat Structures panel on page 410
Repeats popover on page 407
Changing the number of tremolo strokes on individual notes in tie chains on page 1662

Rhythmic positions of notes with tremolos
You can move notes with single-note tremolos and multi-note tremolos to new rhythmic 
positions in the same ways as normal notes. However, if you move multi-note tremolos across 
barlines, the tremolo strokes are deleted automatically.

You can move single-note tremolos to new rhythmic positions and across barlines without 
affecting their tremolo strokes. The notes are automatically respelled as tie chains if required 
by their new rhythmic positions and time signature, in the same ways as normal notes.

NOTE

If tie chains with single-note tremolos contain notes of different durations, the number of 
tremolo strokes on each note in the tie chain is different. You can change the number of tremolo 
strokes shown on each note in tie chains individually.

RELATED LINKS
Moving notes/items rhythmically on page 465

Moving tremolo strokes
You can move tremolo strokes upwards/downwards graphically. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

NOTE

● You cannot move tremolo strokes to the right/left.

● You cannot move tremolo strokes rhythmically, as they apply to specific notes, but you can 
move notes with tremolos to different rhythmic positions. Notes with single-note tremolos 
can cross barlines; however, multi-note tremolo strokes are deleted automatically when their 
notes cross barlines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the tremolo strokes you want to move.

2. Move the tremolo strokes in any of the following ways:
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● To move them upwards/downwards a standard amount, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move tremolo 
strokes upwards. This moves tremolo strokes by 1/8 space per press.

● To move them upwards/downwards a large amount, press Ctrl/Cmd  plus the standard 
key command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves tremolo strokes 
by 1 space per press.

● To move them upwards/downwards a moderate amount, press Shift  plus the standard 
key command; for example, Shift-Alt/Opt-Up Arrow . This moves tremolo strokes by 1/2 
space per press.

● To move them upwards/downwards a small amount, press Ctrl/Cmd - Shift  plus the 
standard key command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves 
tremolo strokes by 1/32 space per press.

● Click and drag them upwards/downwards.

RESULT
The selected tremolo strokes are moved upwards/downwards. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

NOTE

● Moving multi-note tremolo strokes also changes the length of the stems to which they 
are attached. You can change the angles of multi-note tremolo strokes individually by 
lengthening/shortening the stems at the start/end of the tremolo.

● When you first move tremolo strokes graphically, they may appear to move in the wrong 
direction or by a larger increment than you expected. This is because their positions are 
reset when you override those positions by moving them.

● The following properties in the Beaming group of the Properties panel are activated 
automatically when you move the start/end of multi-note tremolo strokes:

● Start Y offset moves the start of multi-note tremolo strokes vertically by moving the end 
of the corresponding stem.

● End Y offset moves the end of multi-note tremolo strokes vertically by moving the end 
of the corresponding stem.

Tremolo Y in the Notes and Rests group of the Properties panel is activated automatically 
when you move single-note tremolo strokes. It moves single-note tremolo strokes vertically.

For example, if you move a whole multi-note tremolo stroke upwards, both stem handles are 
moved so both properties are activated. You can also use these properties to move tremolo 
strokes by changing the values in the value fields. However, you must select the noteheads 
rather than the tremolo strokes in order to see the relevant groups in the Properties panel.

Deactivating the properties resets the selected stem handles, and therefore tremolo strokes, 
to their default positions.

RELATED LINKS
Project-wide engraving options for tremolos on page 1660
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Input methods for repeats and tremolos on page 406
Deleting tremolos on page 1664
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Tremolos in playback
You can control the playback of unmeasured tremolos by specifying the minimum number of 
tremolo strokes that are interpreted as unmeasured tremolos. This considers both the number of 
tremolo strokes and the number of beam lines that would be used for the note.

● You can do this on the Timing page in Playback Options.

For example, if the option is set to require three tremolo strokes, an eighth note with two 
tremolo strokes is played as unmeasured, because the single beam of the eighth note is included 
in the calculation.

You can also specify the default length of notes in unmeasured tremolos. You express the 
duration of notes as a fraction of the length of a quarter note played at 120 quarters per minute 
in the Tremolos section.

The number of tremolo strokes determines the note value of the repeated notes. For example, 
one stroke indicates an eighth note, two strokes indicate a 16th note, and so on.

If your sound library includes samples for unmeasured tremolo playback, Dorico Pro loads 
the required samples using playback techniques. For sound libraries that do not provide 
unmeasured tremolo samples, Dorico Pro generates tremolos.

TIP

You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have tremolos in one voice and slurs in 
another voice.

RELATED LINKS
Playback techniques on page 936
Playback Options dialog on page 842
Enabling independent voice playback on page 636

Changing the duration of tremolos in playback
You can change both the default length of each note in unmeasured tremolos in playback, and 
the minimum number of tremolo strokes required to indicate tremolos should be unmeasured in 
playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Timing.

3. Optional: In the Tremolos section, change the value for Minimum number of strokes for 
playback of unmeasured tremolos.

4. Change the value for Default unmeasured tremolo length.

For example, to set the default length of unmeasured tremolo notes to 0.5 seconds, change 
the value to 1.

TIP

If you hover over either of the arrows beside the value field, a small box appears that 
displays the current fraction as a decimal.
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5. Click Apply, then Close.

RESULT
The sounding duration of each note in unmeasured tremolos in playback is changed project-
wide.

Changing the value for Minimum number of strokes for playback of unmeasured tremolos 
changes the minimum number of tremolo strokes required for tremolos to be unmeasured in 
playback.
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Tuplets

Tuplets indicate where a beat is divided into a different number of subdivisions than is usually 
expected according to the current meter. They can be used to fit more notes or fewer notes in a 
beat than usually exist in a beat, according to the usual pattern of subdivision.

Because these subdivisions are not standard but tuplet notes use the same rhythmic notation as 
normal notes, tuplets must be clearly marked to show that their rhythmic duration is different. 
Tuplet numbers/ratios indicate the number of notes in the tuplet, and tuplet brackets show the 
duration of tuplets that are not joined by beams.

In Dorico Pro, tuplets function like containers into which you can input notes of any duration, 
such as inputting a quarter note at the start of an eighth note triplet.

When tuplets extend across barlines, Dorico Pro automatically notates them correctly, such as a 
sextuplet appearing as two triplets. You can also allow tuplets to span barlines without division.

During tuplet input, tuplets are sticky when you input notes with the keyboard, meaning that 
Dorico Pro continues inputting notes as the specified tuplet until you stop tuplet input or note 
input.

You can show tuplets with different combinations of tuplet brackets and tuplet numbers/ratios. 
You can also show note symbols indicating the note value of the tuplet alongside tuplet 
numbers/ratios.

RELATED LINKS
Inputting tuplets on page 254
Tuplet brackets on page 1674
Tuplet numbers/ratios on page 1678
Allowing/Disallowing tuplets to span barlines on page 1672
Moving notes/items rhythmically on page 465

Project-wide engraving options for tuplets
You can find options for the project-wide appearance of tuplets, tuplet brackets, and tuplet 
numbers/ratios on the Tuplets page in Engraving Options.

The options on the Tuplets page allow you to change the appearance and angles of tuplet 
brackets, and the position of tuplet brackets, tuplet numbers/ratios relative to the staff and 
noteheads.

There are musical examples for many options to demonstrate how they affect the appearance of 
your music.

RELATED LINKS
Engraving Options dialog on page 840
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Nested tuplets
Nested tuplets are tuplets within larger tuplets that are often used to create complex rhythms. In 
Dorico Pro, there is no limit to the number of levels you can have in nested tuplets.

EXAMPLE

Nested tuplets

Inputting nested tuplets
You can input nested tuplets on empty staves and select existing tuplets and input nested tuplets 
within them.

PROCEDURE

1. In Write mode, start note input.

2. Open the tuplets popover in any of the following ways:

● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

When inputting tuplets with the keyboard, Dorico Pro automatically continues inputting 
notes as the specified tuplet.

NOTE

You can skip steps 3 and 4 if you are inputting nested tuplets into existing tuplets.

3. Optional: If inputting nested tuplets on an empty staff, enter the ratio for the outer tuplet 
into the popover.

For example, enter 3:2q to input quarter note triplets.

4. Optional: Press Return  to close the popover and input the outer tuplet.

5. Press ;  to open the tuplets popover again.

6. Enter the ratio for the inner tuplet into the popover.

For example, enter 5:4e to input eighth note quintuplets.

7. Press Return  to close the popover and input the inner tuplet.

8. Input the notes you want.

When inputting tuplets with the keyboard, Dorico Pro automatically continues inputting 
notes as the specified tuplet.

9. Stop inputting nested tuplets in one of the following ways:

● To stop the inner tuplet and continue inputting the outer tuplet, press :  once.

● To stop both tuplets and return to inputting normal notes, press :  twice or move the 
caret with the arrow keys.

● To stop note input completely, press Esc .
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RESULT
Notes are input as nested tuplets, starting from the caret position.

If multiples of the inner tuplet fit exactly inside the outer tuplet, you can continue inputting notes 
as the specified nested tuplet until you stop the tuplets manually.

If multiples of the inner tuplet do not fit exactly inside the outer tuplet, the inner tuplet stops 
automatically at the end of the last tuplet that fits in the outer tuplet. After that, the outer tuplet 
continues until you stop it manually.

NOTE

You can also input nested tuplets by clicking and holding Tuplets  in the Notes toolbox, then 
clicking the tuplet you want. However, the inner tuplet you click must fit inside the outer tuplet, 
based on the currently selected note duration.

RELATED LINKS
Tuplets popover on page 256
Notes toolbox on page 197
Inputting notes on page 221
Selecting note/rest durations on page 259

Turning existing notes into tuplets
You can turn any existing notes into tuplets; for example, if you need to fit extra notes into an 
existing duration.

PROCEDURE

1. In Write mode, select the notes on a single staff that you want to turn into tuplets.

2. Open the tuplets popover in any of the following ways:

● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

The popover is automatically populated with a suggested ratio based on your selection.

3. Optional: Change the ratio in the popover. For example, enter 3:2 to input triplets.

4. Press Return  to close the popover.

RESULT
The selected notes are turned into tuplets according to the ratio in the popover. For example, 
if you select five eighth notes and enter 5:4 into the popover, the selected notes become 
quintuplet eighth notes.

If the selected notes fit into a single tuplet of the specified ratio, only a single tuplet is created. 
If the selected notes do not fit into a single tuplet, as many tuplets as required are created 
automatically.

TIP

You can also turn existing notes into tuplets by clicking and holding Tuplets  in the Notes 
toolbox, then clicking the tuplet you want.

RELATED LINKS
Tuplets popover on page 256
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Inputting tuplets on page 254
Notes toolbox on page 197
Turning existing notes into grace notes on page 1195

Turning tuplets into normal notes
You can turn any existing tuplet notes into normal notes; for example, if you want to turn tuplet 
eighth notes into standard eighth notes.

PROCEDURE

1. In Write mode, select just the brackets, numbers/ratios, or signposts of the tuplets you want 
to turn into normal notes.

NOTE

You must not select any of the noteheads in the tuplets.

2. Optional: If you want the selected tuplets to push subsequent notes to later rhythmic 
positions if required, press I  to activate Insert mode.

3. Optional: If you activated Insert mode, choose the appropriate Insert mode scope.

4. Press Backspace or Delete .

RESULT
The selected tuplets are deleted. All notes previously in the tuplets are unscaled and appear as 
normal notes with the same notated duration; for example, a tuplet quarter note becomes a 
standard quarter note.

When Insert mode is activated, all notes in the tuplets are retained and any subsequent existing 
notes are pushed to later rhythmic positions to accommodate the extra rhythmic durations 
required. When Insert mode is deactivated, the earliest selected tuplets expand and overwrite 
subsequent notes and tuplets.

RELATED LINKS
Tuplet numbers/ratios on page 1678
Tuplet brackets on page 1674
Inputting notes on page 221
Turning grace notes into normal notes on page 1196
Insert mode on page 454
Insert mode scopes on page 455

Allowing/Disallowing tuplets to span barlines
You can allow tuplets to span barlines; for example, in Renaissance music, you might want 
tuplets to span tick barlines without affecting their notation. By default, Dorico Pro automatically 
splits tuplets over barlines so that both the durations of bars and the divisions in tuplets are 
clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the tuplet brackets or tuplet numbers/ratios of the tuplets you want to allow/disallow 
to span barlines. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Spans barline in the Tuplets group.

RESULT
The selected tuplets span barlines when Spans barline is activated, and are automatically split at 
barlines when it is deactivated.

EXAMPLE

A 16th note sextuplet across a barline, notated as 
two triplets

The same sextuplet allowed to span the barline

AFTER COMPLETING THIS TASK
You can beam notes in the selected tuplets together.

RELATED LINKS
Barlines on page 967
Beaming notes together manually on page 1000
Tuplet brackets on page 1674
Tuplet numbers/ratios on page 1678
Engrave toolbox on page 514

Tuplet beams
Tuplet beams join notes in tuplets that can be joined with beams just like non-tuplet beams. You 
can make the same changes to tuplet beams that you can make to any other beam.

For example, duplet eighth notes do not need a bracket as they can be joined by a beam and 
notated using only a tuplet number/ratio.

A 6/8 bar with the standard subdivision of six eighth 
notes

A 6/8 bar with a subdivision of four duplet eighth 
notes in the space of six regular eighth notes

RELATED LINKS
Beaming on page 998
Tuplets within beams on page 1016
Beaming notes together manually on page 1000
Unbeaming notes on page 1001
Splitting beam groups on page 1001
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Changing the direction of partial beams on page 1013
Changing beam slants on page 1006

Tuplet brackets
Tuplet brackets show the duration of tuplets that are not joined by beams, such as triplet quarter 
notes, by showing the notes within the tuplet under a bracket.

EXAMPLE

A 4/4 bar with the standard subdivision of four 
quarter notes

A 4/4 bar with a subdivision of six triplet quarter 
notes in the space of four regular quarter notes

You can change the precise positions and shapes of tuplet brackets individually in Engrave mode.

Each tuplet bracket has four handles that can be moved graphically.

● The two upper handles set the position of the start/end of the tuplet bracket. These handles 
can be moved independently of each other to create angled tuplet brackets, even if you have 
set tuplet brackets to be Always horizontal on the Tuplets page in Engraving Options.

● The two lower handles set the length of the tuplet bracket hooks. Moving either of these 
handles changes the length of both hooks.

You can change the default position of all tuplet brackets project-wide in the Horizontal Position 
section of the Tuplets page in Engraving Options.

NOTE

You can use properties in the Tuplets group of the Properties panel to edit individual tuplet 
brackets; however, the Tuplets group is only shown if you select tuplet numbers/ratios or 
brackets. It is not shown if you select notes within the tuplet, or notes within the tuplet and 
the tuplet number/ratio or bracket.

RELATED LINKS
Project-wide engraving options for tuplets on page 1669
Engraving Options dialog on page 840
Moving items graphically on page 609
Lines on page 1402
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Hiding/Showing tuplet brackets
You can hide/show tuplet brackets for individual tuplets, and independently of tuplet numbers/
ratios. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets you want to hide, or the signposts of tuplets whose brackets you 
want to show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Bracket in the Tuplets group.

3. Choose one of the following options:

● Hidden 

● Shown 

RESULT
Brackets on the selected tuplets are hidden/shown. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Signposts are shown at the position of each hidden tuplet; that is, tuplets with no numbers/ratios 
or brackets shown.

AFTER COMPLETING THIS TASK
If you want to hide indications of tuplets entirely, you might also need to hide the tuplet 
numbers/ratios.

RELATED LINKS
Signposts on page 453
Hiding/Showing tuplet numbers/ratios on page 1678
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the staff-relative placement of tuplet brackets
You can show individual tuplet brackets and tuplet numbers/ratios above or below the staff or 
between staves. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the tuplet brackets and tuplet numbers/ratios whose staff-relative placement you 
want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Placement in the Tuplets group.

3. Choose one of the following options:

● Above 

● Below 

● Cross-staff above 

● Cross-staff below 

RESULT
The placement of the selected tuplet brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

● Deactivating Placement returns the selected tuplets to their default placement.

● You can also switch selected tuplets between being above/below the staff or cross-staff 
above/cross-staff below by pressing F .

● You can change the placement of all tuplet brackets relative to vocal staves project-wide in 
the Placement section of the Tuplets page in Engraving Options.

RELATED LINKS
Tucking index properties on page 1083
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the rhythmic end position of tuplet brackets
You can change the rhythmic end position of tuplet brackets relative to individual notes 
individually. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose end position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate End position in the Tuplets group.

3. Choose one of the following options:

● End at right-hand side of final note 
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● End immediately before following note 

● End at position of final tuplet division 

RESULT
The end position for the selected tuplet brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

● Deactivating the property returns the selected tuplets to your default settings.

● You can change the horizontal position of tuplet numbers/ratios on all tuplets project-wide in 
the Horizontal Position section of the Tuplets page in Engraving Options.

RELATED LINKS
Project-wide engraving options for tuplets on page 1669
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768
Moving items graphically on page 609

Forcing tuplet brackets to be horizontal
You can change the angle of individual tuplet brackets so that they appear horizontal, 
independently of your project-wide setting. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose angle you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Force horizontal in the Tuplets group.

RESULT
The selected tuplet brackets appear horizontal when the property is activated. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

When the property is deactivated, the selected tuplet brackets follow your project-wide setting 
for angled tuplet brackets.

TIP

You can change whether all tuplet brackets can appear angled or always appear horizontal 
project-wide in the Brackets section of the Tuplets page in Engraving Options.
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Tuplet numbers/ratios
Tuplet numbers and ratios are very similar: both indicate the number of equal notes included in 
the tuplet, such as 3 for triplets, but tuplet ratios also include the number of normal notes into 
whose duration the tuplet fits, such as 3:2 for triplets.

Additionally, tuplet ratios can include a note glyph that indicates the duration of notes in the 
tuplet.

A triplet with a ratio and note value indication

Tuplet numbers/ratios help performers quickly identify the type of tuplet and how they must fit 
the number of notes indicated into the prevailing tempo and meter.

In Dorico Pro, you can change the appearance of all tuplet numbers/ratios project-wide on the 
Tuplets page in Engraving Options, such as changing the font used for them, and for individual 
tuplets independently of this setting.

NOTE

You can use properties in the Tuplets group of the Properties panel to edit individual tuplet 
numbers/ratios; however, the Tuplets group is only shown if you select tuplet numbers/ratios or 
brackets. It is not shown if you select notes within the tuplet, or notes within the tuplet and the 
tuplet number/ratio or bracket.

Hiding/Showing tuplet numbers/ratios
You can hide/show tuplet numbers/ratios for individual tuplets, and independently of tuplet 
brackets. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains. When showing tuplet numbers/ratios, you can choose a different type for each tuplet 
individually, independently of your project-wide setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose numbers/ratios you want to hide/change, or the signposts 
of tuplets whose numbers/ratios you want to show. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Number in the Tuplets group.

3. Choose one of the following options:

● None 

● Number 

● Ratio 
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● Ratio+note 

RESULT
The tuplet number/ratio shown for the selected tuplets is changed. If you selected None, the 
tuplet numbers/ratios for the selected tuplets are hidden. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Signposts are shown at the position of each hidden tuplet; that is, tuplets with no numbers/ratios 
or brackets shown.

TIP

● Deactivating Number returns the selected tuplets to the default setting.

● You can change which tuplet number/ratio appears on all tuplets project-wide in the 
Number and Ratio section of the Tuplets page in Engraving Options.

AFTER COMPLETING THIS TASK
If you want to hide indications of tuplets entirely, you might also need to hide the tuplet brackets.

RELATED LINKS
Hiding/Showing tuplet brackets on page 1675
Engraving Options dialog on page 840
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the position of tuplet numbers/ratios
You can show individual tuplet numbers/ratios at either the visual or rhythmic horizontal center 
of tuplets, independently of your project-wide setting. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplets or the signposts of tuplets whose tuplet number/ratio horizontal position 
you want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Center in the Tuplets group.

3. Choose one of the following options:

● Visual

● Rhythmic

RESULT
The horizontal position of tuplet numbers/ratios on the selected tuplets is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.
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● Visual positions tuplet numbers/ratios at the visual center of the tuplet.

● Rhythmic positions tuplet numbers/ratios at the rhythmic center of the tuplet, which might 
be visually off-center.

TIP

● Deactivating the property returns tuplets to your project-wide setting.

● You can change the horizontal position of tuplet numbers/ratios on all tuplets project-wide in 
the Number and Ratio section of the Tuplets page in Engraving Options.

EXAMPLE

Visual center Rhythmic center

RELATED LINKS
Tuplet brackets on page 1674
Moving items graphically on page 609
Signposts on page 453

Changing the font used for tuplet numbers/ratios
By default, tuplet numbers/ratios are drawn in a bold, italic, Arabic font that is similar in 
appearance to fingerings. You can change the font used for all tuplet numbers/ratios project-
wide. This also affects the appearance of note value indications.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Tuplets.

3. In the Number and Ratio section, choose one of the following options for Tuplet digit 
style:

● Bold weight

● Regular weight

● Plain font

4. Click Apply, then Close.

RESULT
The font used for tuplet numbers/ratios project-wide is changed.

TIP

You can edit different aspects of the font styles used for tuplets, such as their font size, in the 
Edit Font Styles dialog.

● Bold weight and Regular weight are both based on the Tuplet Font style, which must be 
SMuFL-compliant.
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● Plain font uses the Tuplet Plain Font style, which can be any text font.

RELATED LINKS
Edit Font Styles dialog on page 846
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Unpitched percussion

The term “unpitched percussion” covers all percussion instruments that are not tuned to specific 
pitches. This includes instruments such as bass drum, guiro, maracas, cymbals, and shakers.

Dorico Pro provides comprehensive support for unpitched percussion notation, with flexible 
options for combining music for multiple instruments into percussion kits that can then be 
displayed differently in different layouts. You can also define percussion kits as drum sets, which 
changes the default stem directions of notes.

You can also customize and create new playing technique-specific noteheads for unpitched 
percussion. This allows you to indicate how notes are played by using different noteheads for 
different playing techniques on each instrument in percussion kits.

RELATED LINKS
Percussion kits and drum sets on page 1690
Percussion kit presentation types on page 1694
Staff labels for percussion kits on page 1545
Defining percussion kits as drum sets on page 158
Inputting notes for unpitched percussion on page 238
Playing techniques for unpitched percussion instruments on page 1682
Playing technique-specific noteheads on page 1683
Showing brackets on noteheads on page 1265
Percussion editor on page 785

Playing techniques for unpitched percussion instruments
Playing techniques for unpitched percussion instruments, both as individual instruments and 
within percussion kits, can be notated in different ways, including using different notehead 
designs and positions.

You can indicate playing techniques for unpitched percussion instruments in any of the following 
ways:

● Use playing technique-specific noteheads, including positioning notes above/below their 
normal staff line

● Add articulations or single-note tremolos

● Add playing techniques in the same ways as for pitched instruments

For example, you can add open and closed techniques for hi-hats as playing techniques and use 
playing technique-specific cross noteheads for side stick notes for the snare drum.

You can select playing technique-specific noteheads for unpitched percussion instruments when 
inputting notes and change the playing technique-specific noteheads of existing notes. You can 
input playing techniques during note input and by adding them to existing music.

RELATED LINKS
Playing techniques on page 1387
Articulations on page 954
Tremolos on page 1659
Edit Percussion Kit dialog on page 155

1682
Dorico Pro 4.3.30



Inputting notes for unpitched percussion on page 238
Changing playing technique-specific noteheads on page 1686
Changing the distance above/below single-line percussion staves on page 1689
Defining how combinations of articulations and single-note tremolos sound in playback on page 
935
Exporting percussion kits on page 1691
Importing percussion kits on page 1691
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368

Playing technique-specific noteheads
Playing technique-specific noteheads use the design and position of noteheads to indicate 
different playing techniques for unpitched percussion instruments, both as individual 
instruments and within percussion kits.

For example, side stick notes on the snare drum notes are typically notated using cross 
noteheads. Other techniques might use the staff positions above or below the single-line staff to 
indicate different playing techniques.

Multiple different playing technique-specific noteheads for snare drum

You can edit the set of playing technique-specific noteheads and staff positions defined for each 
unpitched percussion instrument in the Percussion Instrument Playing Techniques dialog.

You can select playing technique-specific noteheads for unpitched percussion instruments when 
inputting notes and change the playing technique-specific noteheads of existing notes.

RELATED LINKS
Creating new playing technique-specific noteheads on page 1687
Changing playing technique-specific noteheads on page 1686
Inputting notes for unpitched percussion on page 238

Percussion Instrument Playing Techniques dialog
The Percussion Instrument Playing Techniques dialog allows you to edit the set of playing 
technique-specific noteheads defined for each unpitched percussion instrument.

You can open the Percussion Instrument Playing Techniques dialog in Setup mode in the 
following ways:

● For an individual percussion instrument: In the Players panel, click the instrument menu 
in the instrument label, and choose Edit Percussion Playing Techniques from the menu.

● For percussion instruments that are part of percussion kits: In the Players panel, click the 
instrument menu  in the kit instrument label and choose Edit Percussion Kit to open the 
Edit Percussion Kit dialog. In the main editing area, select the instrument whose playing 
techniques you want to edit, then click Edit Percussion Playing Techniques.
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1 Playing technique-specific noteheads list

Contains the main playing technique-specific noteheads currently defined for the selected 
percussion instrument, showing the notehead set and the staff position corresponding to 
the playing technique as applicable.

You can add new playing technique-specific noteheads for unpitched percussion 
instruments. Normally, percussion instruments define at least the Natural playing 
technique, which is usually shown using the default notehead set.

2 Playback of Articulations and Tremolos

Allows you to define how combinations of articulations and tremolo strokes affect or 
override the playback of playing techniques.

For example, you can define an entirely different playing technique for a playing technique-
specific notehead for when an accent is added to it.

3 Overrides of articulations and tremolos list

Displays any overrides of articulations and tremolos you define.

EXAMPLE

Three different snare drum playing technique-specific noteheads followed by two clash cymbal playing 
technique-specific noteheads

All of these settings are saved in the percussion instrument within your project, and you can 
export them from one project and import them into others.
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NOTE

Overrides for articulations and tremolos are not currently reflected in playback, but this is 
planned for future versions.

RELATED LINKS
Changing playing technique-specific noteheads on page 1686
Creating new playing technique-specific noteheads on page 1687
Overriding the appearance of playing technique-specific noteheads on page 1688
Defining how combinations of articulations and single-note tremolos sound in playback on page 
935
Inputting notes for unpitched percussion on page 238
Exporting percussion kits on page 1691
Importing percussion kits on page 1691

Override Percussion Noteheads dialog
The Override Percussion Noteheads dialog lists the playing technique-specific noteheads 
defined for the selected instrument in the Percussion Instrument Playing Techniques dialog, 
shows the notehead type mapped for each technique, and allows you to override those 
noteheads for five-line staff kit presentations only.

For example, the same notehead can indicate different playing techniques for different 
instruments. When those instruments are presented on the same five-line staff, this can cause 
confusion, so you can use the Override Percussion Noteheads dialog to disambiguate the 
notes for one instrument from another in five-line staff kit presentations only.

● You can open the Override Percussion Noteheads dialog by selecting an instrument in the 
Edit Percussion Kit dialog and clicking Edit Noteheads.

The Override Percussion Noteheads dialog comprises the following:

1 Instrument name

Displays the name of the percussion instrument whose noteheads are listed in the dialog.

2 Playing techniques table

Contains the noteheads for the selected percussion instrument, arranged into the following 
columns:

● Playing Technique: Displays the playing technique associated with the notehead in the 
corresponding row of the table.
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● Default Notehead: Displays the notehead used by default for the playing technique in 
the corresponding row of the table.

● Notehead Override: Displays the notehead override used in five-line staff presentations 
for the playing technique in the corresponding row of the table. You can change the 
notehead override by clicking it and selecting another notehead from the menu.

RELATED LINKS
Overriding the appearance of playing technique-specific noteheads on page 1688
Changing playing technique-specific noteheads on page 1686
Inputting notes for unpitched percussion on page 238
Percussion kit presentation types on page 1694

Changing playing technique-specific noteheads
You can change the playing technique-specific noteheads of notes belonging to unpitched 
percussion instruments after they have been input; for example, to switch selected snare drum 
notes to the side stick technique and corresponding notehead.

PREREQUISITE
The unpitched percussion instruments whose playing techniques you want to change have at 
least two playing technique-specific noteheads defined in the Percussion Instrument Playing 
Techniques dialog.

PROCEDURE

1. In Write mode, select the notes whose playing technique-specific notehead you want to 
change.

TIP

If you select a single note in percussion kits using five-line staff or grid presentations, the 
current playing technique is shown above the rhythmic grid.

2. Cycle through the available playing techniques for the selected unpitched percussion 
instruments in any of the following ways:

● To cycle upwards, press Shift-Alt/Opt-Up Arrow .

● To cycle downwards, press Shift-Alt/Opt-Down Arrow .

RESULT
The playing techniques of the selected unpitched percussion notes are changed. Their notehead 
design and/or staff position might be changed.

RELATED LINKS
Playing technique-specific noteheads on page 1683
Playing techniques for unpitched percussion instruments on page 1682
Percussion Instrument Playing Techniques dialog on page 1683
Inputting notes for unpitched percussion on page 238
Moving notes to different instruments in percussion kits on page 1692
Percussion editor on page 785
Inputting notes using the Drumstick tool on page 787
Moving percussion notes between instruments/playing techniques on page 791
Defining how combinations of articulations and single-note tremolos sound in playback on page 
935
Playing techniques on page 1387
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Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Showing brackets on noteheads on page 1265
Changing the notehead design of individual noteheads on page 1252
Changing the distance above/below single-line percussion staves on page 1689

Creating new playing technique-specific noteheads
You can define new playing technique-specific noteheads for unpitched percussion instruments, 
which are saved for that type of percussion instrument in your project. You can also export 
playing technique-specific noteheads from your project and import them into other projects.

PREREQUISITE
If you want to use a custom notehead set, you have created that notehead set.

PROCEDURE

1. In Setup mode, open the Percussion Instrument Playing Techniques dialog in one of the 
following ways:

● For an individual percussion instrument: In the Players panel, click the instrument menu 
 in the instrument label, and choose Edit Percussion Playing Techniques from the 

menu.

● For percussion instruments that are part of percussion kits: In the Players panel, 
click the instrument menu  in the kit instrument label and choose Edit Percussion 
Kit to open the Edit Percussion Kit dialog. In the main editing area, select the 
instrument whose playing techniques you want to edit, then click Edit Percussion 
Playing Techniques.

2. In the playing technique-specific noteheads list, click Add Playing Technique .

3. Select the playback technique you want to use in the dialog that opens.

4. Click OK to add the selected playback technique as a new playing technique-specific 
notehead.

5. From the Notehead set menu, select the notehead you want for the playing technique-
specific notehead.

NOTE

To use the default notehead set as defined on the Notes page in Engraving Options, leave 
Notehead set as (Unset).

6. Choose one of the following options for Staff position:

● Below

● Line

● Above

RESULT
A new playing technique-specific notehead is added to the selected unpitched percussion 
instrument.

RELATED LINKS
Defining how combinations of articulations and single-note tremolos sound in playback on page 
935

Unpitched percussion
Playing techniques for unpitched percussion instruments 

1687
Dorico Pro 4.3.30



Creating custom notehead sets on page 874
Engraving Options dialog on page 840
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Changing the distance above/below single-line percussion staves on page 1689

Overriding the appearance of playing technique-specific noteheads
It might be necessary to override the appearance of playing technique-specific noteheads in 
order to disambiguate the notes for one instrument from another if they share a staff position in 
five-line staff kit presentations.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
playing technique-specific noteheads you want to override.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Select the instrument whose noteheads you want to override in the main editing area of the 
dialog.

4. Click Edit Noteheads to open the Override Percussion Noteheads dialog.

5. Click in the Notehead Override column for the appropriate playing technique and select a 
new notehead type from the menu to override its notehead.

6. Click OK to save your changes and close the dialog.

RESULT
The playing technique-specific notehead is overridden for the selected instrument in five-line 
staff kit presentations.

NOTE

This does not affect the appearance of playing technique-specific noteheads in grid and single-
line instrument kit presentation types.

RELATED LINKS
Players panel on page 111
Override Percussion Noteheads dialog on page 1685

Single-line percussion staves
Notes belonging to unpitched percussion instruments, both individual instruments and in kits, 
can appear on single-line percussion staves.

By default, notes are positioned on the staff line, but you can position notes above/below the 
staff line by using playing technique-specific noteheads.

RELATED LINKS
Percussion kit presentation types on page 1694
Playing technique-specific noteheads on page 1683
Edit Percussion Kit dialog on page 155
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Changing the distance above/below single-line percussion staves
You can change the distance between playing technique-specific noteheads positioned above/
below single-line percussion staves and the staff line. Larger distances make the difference 
between notes on the line and notes above/below the line more noticeable.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Percussion.

3. In the Single-line Percussion section, change the value for Distance of above/below notes 
from line.

4. Click Apply, then Close.

RELATED LINKS
Engraving Options dialog on page 840
Playing techniques for unpitched percussion instruments on page 1682
Creating new playing technique-specific noteheads on page 1687

Changing the default stem direction of notes on single-line 
percussion staves

You can change the default stem direction of all notes on single-line percussion staves project-
wide, including grace notes.

PROCEDURE

1. Press Ctrl/Cmd-Shift-E  to open Engraving Options.

2. In the category list, click Percussion.

3. In the Single-line Percussion section, choose one of the following options for Default stem 
direction:

● Up

● Down

4. Activate/Deactivate Grace notes follow default stem direction.

5. Click Apply, then Close.

RELATED LINKS
Engraving Options dialog on page 840
Stem direction on page 1274
Changing the default stem direction of notes on the middle staff line on page 1276
Grace notes on page 1193

Percussion kits vs. individual percussion instruments
Percussion kits allow you to show multiple unpitched percussion instruments held by a single 
player at the same time in different ways. Multiple percussion instruments not combined into kits 
are shown on a single line that only shows the instrument currently being played by default.

One common type of percussion kit is a drum set. A drum set consists of a number of separate 
instruments mounted together on a frame, and is typically written on a regular five-line staff. 
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Each instrument has its own position on the staff, and sometimes its own notehead type. 
Similarly, a pair of bongos is a percussion kit by default in Dorico Pro, consisting of the two 
bongo drums, typically written on a grid with two lines: the smaller drum shown on the top line, 
and the larger drum shown on the bottom line.

Showing individual percussion instruments separately can be appropriate if a player only has one 
or two percussion instruments. However, combining percussion instruments into a kit gives you 
more flexibility over the presentation of music, which you can vary in each layout independently. 
Kits also give you greater control over the labeling of instruments.

If instrument changes are enabled on the Players page in Layout Options, Dorico Pro changes 
from one instrument to the next, just as it does for pitched instruments.

NOTE

Kit instruments in player cards in the Players panel in Setup mode are colored green, whereas 
individual percussion instruments not part of percussion kits are colored the same light blue as 
all other instruments.

Per-flow notation options for unpitched percussion
You can find options for how notes in percussion kits are notated in each flow independently on 
the Percussion page in Notation Options.

For example, you can choose to notate all notes in a percussion kit in a single voice rather than in 
multiple voices.

RELATED LINKS
Notation Options dialog on page 837

Percussion kits and drum sets
A percussion kit is a collection of unpitched percussion instruments that are played by a single 
player. Drum sets are a particular type of percussion kit that are often used in pop and rock 
music.

NOTE

In this documentation, we use “percussion kit” to refer to both percussion kits and drum sets.

In Dorico Pro, you can present percussion kits in different ways, including as a five-line staff and 
as a grid. If you want percussion kits to behave as drum sets, you can define them as drum sets. 
For example, there are options on the Percussion page in Notation Options for handling voices 
that only apply to drum sets.

You can create percussion kits in Setup mode. You can combine existing unpitched percussion 
instruments into kits and add empty kits to players, to which you can then add unpitched 
percussion instruments. You can also import existing kits you have previously exported and 
saved.

You can move percussion instruments between players without affecting any music already 
added to that instrument.
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NOTE

If the instrument you want to move is combined into a percussion kit, you must first remove the 
instrument from the kit before you can move it to another player.

You can change individual percussion instruments like any other instrument. However, you can 
only change unpitched percussion instruments to other unpitched percussion instruments, and 
you can only change the percussion instruments in kits within the Edit Percussion Kit dialog.

RELATED LINKS
Note input setup for percussion kits on page 240
Percussion kit presentation types on page 1694
Staff labels for percussion kits on page 1545
Universal Indian Drum Notation on page 1703
Edit Percussion Kit dialog on page 155
Combining individual percussion instruments into kits on page 139
Defining percussion kits as drum sets on page 158
Adding instruments to percussion kits on page 157
Removing individual instruments from percussion kits on page 162
Moving instruments on page 141
Inputting notes for unpitched percussion on page 238
Per-flow notation options for unpitched percussion on page 1690

Exporting percussion kits
You can export percussion kits as .doricolib files. This allows you to use kits again without 
having to create them from scratch.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player whose percussion kit you 
want to export.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Export Kit at the bottom of the dialog to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The kit is exported and saved as a .doricolib file.

TIP

You can later import the .doricolib file into other projects to reuse the percussion kit.

Importing percussion kits
You can import .doricolib files containing percussion kits, which allows you to use kits again 
without having to create them from scratch.

PREREQUISITE
Your project contains at least one single player or empty-handed section player.
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PROCEDURE

1. In Setup mode, in the Players panel, open the instrument picker for the player to which you 
want to assign the imported percussion kit in any of the following ways:

● Select the player and press Shift-I .

● Click the plus symbol  in the player card.

● Select the player, then click Player Settings  in the action bar and choose Add 
Instrument to Player. You can also right-click players and choose this option from the 
context menu.

2. Click Import Kit in the instrument picker to open the File Explorer/macOS Finder.

3. Locate and select the percussion kit .doricolib file you want to import.

4. Click Open.

RESULT
The selected .doricolib file is imported as a percussion kit. It is assigned to the player from 
whose card you opened the instrument picker.

RELATED LINKS
Players panel on page 111
Adding players on page 125

Moving notes to different instruments in percussion kits
You can move notes to different instruments in the same percussion kit after they have been 
input.

NOTE

These steps do not apply in layouts using the single-line instruments kit presentation type. In 
such layouts, you can cross or move notes to other staves.

PROCEDURE

1. In Write mode, select the notes you want to move to a different instrument in the percussion 
kit.

2. Move the notes to another instrument in any of the following ways:

● To move them to the instrument above, press Alt/Opt-Up Arrow .

● To move them to the instrument below, press Alt/Opt-Down Arrow .

RESULT
The notes are moved to another instrument in the kit.

AFTER COMPLETING THIS TASK
You can change the position of each instrument in the kit.

RELATED LINKS
Edit Percussion Kit dialog on page 155
Changing the positions of instruments within percussion kits on page 160
Changing playing technique-specific noteheads on page 1686
Percussion kit presentation types on page 1694
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Changing the percussion kit presentation type on page 1695
Creating cross-staff beams/tremolos on page 1009
Moving notes/items to other staves on page 468

Notations on notes in percussion kits
You can add notations to notes and use different rhythms in percussion kits in the same ways as 
for normal notes; however, they can behave differently.

Articulations

You can add articulations to percussion instruments in all kit presentation types in the same ways 
as for other instruments.

However, in grid and five-line staff presentations, any articulations you add apply to all 
instruments in the same voice that have notes at that rhythmic position. For example, if both 
a snare drum and tom-tom note are at the same rhythmic position, and you add an accent, the 
accent is added to both instruments because they are both shown in the same down-stem voice 
by default.

You can see the accent applied to each note if you switch to the single-line instruments 
presentation type.

Tuplets

When working in the grid and five-line staff kit presentation types, tuplets are added to all 
instruments in the same voice.

You can switch to the single-line instruments presentation type to input cross-rhythms on each 
instrument separately. When you switch back to the grid or five-line staff kit presentation types, 
Dorico Pro attempts to resolve the rhythmic conflicts.

● Conflicting tuplets: One tuplet is moved into an extra voice for the duration of the conflict.

● Tuplet notes in one instrument and non-tuplet notes in another instrument starting at the 
same rhythmic position: The non-tuplet note is displayed as if it were part of the tuplet. This 
is because the note onset is at the same position as the start of the tuplet, so it sounds the 
same as the original notation.

● Tuplet notes in one instrument and non-tuplet notes in another instrument that do not start 
at the same rhythmic position, or other non-tuplet notes that start part-way through the 
tuplet: Non-tuplet notes are moved into an extra voice for the duration of the conflict.

NOTE

Deleting a tuplet from grid and five-line staff kit presentation types deletes the tuplet from 
all instruments whose notes contribute to the same shared voice.

Playing techniques

You can input playing techniques, such as + for closed and o for open hi-hat, during note input 
and add them later to existing music in the same ways as for other instruments.

Playing techniques are only added to the instrument to which the note you select belongs, even 
if there are other instruments in the same voice.
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Percussion stickings

Dorico Pro does not yet have a dedicated feature for percussion stickings. However, you can use 
lyrics to represent percussion stickings in all kit presentation types:

● Grid/Five-line staff presentation types: Select a note in the instrument in which you want to 
show stickings.

● Single-line instruments presentation type: Input lyrics directly into instruments in which you 
want to show stickings.

RELATED LINKS
Inputting articulations on page 271
Inputting tuplets on page 254
Changing the pitch of individual notes on page 479
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 368
Inputting lyrics on page 392

Dynamics in percussion kits
Unlike other items, dynamics are not shared between the grid/five-line staff presentation types 
and the single-line instruments presentation type. Any dynamics added to instruments in the 
single-line instruments presentation type do not appear when you switch to grid/five-line 
presentations.

This is due to the complexity of combining a large number of different dynamics at the same 
rhythmic position, as allowed in the single-line instruments presentation, into the single position 
required for both the grid and five-line staff presentations. Therefore, you can add dynamics 
in the grid and five-line staff presentation types independently of the single-line instruments 
presentation type.

RELATED LINKS
Input methods for dynamics on page 310

Percussion kit presentation types
You can show percussion kits in three different presentation types, which can be different in each 
layout in your project.

NOTE

Dynamics are not shared between the grid/five-line staff presentation types and the single-
line instruments presentation type. Any dynamics added to instruments in the single-line 
instruments presentation type do not appear when you switch to grid/five-line presentations.

You can edit the appearance/structure of each presentation type independently in the Edit 
Percussion Kit dialog. For example, changing the order of instruments in the five-line staff 
presentation does not affect the order of instruments in the grid presentation of the same 
percussion kit.

5-line staff
Kit instruments are shown on a five-line staff. You can determine which instruments 
are shown on each line and in each space of the staff. A single staff label containing the 
name of the kit is shown.
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The numbers down the left-hand side of the editing area in the Edit Percussion Kit 
dialog correspond to staff positions. For example, position 0 is the middle line of the 
five-line staff, position 1 is the space immediately above the middle staff line, position 
-2 is the line below the middle staff line, and so on.

Bold black lines show the five staff lines, while gray lines above and below the staff 
show nominal staff line positions. Each instrument is shown on its staff position.

Grid
Kit instruments are shown on a grid, with each instrument on its own line. You can 
customize the size of the gaps between each line. Staff labels are shown for each 
instrument in a smaller font than normal staff labels.

The numbers down the right-hand side of the editing area in the Edit Percussion Kit 
dialog correspond to the number of staff spaces between each instrument line. By 
default, all instruments in a grid are two spaces apart.

The order in which the instruments are listed matches the order in which they appear 
in the score.

Each instrument in a grid shows its own staff label by default, aligned vertically with its 
own line, but you can group adjacent instruments together and show a single label for 
each group.

Single-line instruments
Kit instruments are shown as individual instruments with their own lines. Normal-sized 
staff labels are shown for each instrument.

The editing area in the Edit Percussion Kit dialog lists all of the instruments in the 
order in which they appear in the score.

RELATED LINKS
Percussion kits and drum sets on page 1690
Edit Percussion Kit dialog on page 155
Staff labels for percussion kits on page 1545
Overriding the appearance of playing technique-specific noteheads on page 1688
Override Percussion Noteheads dialog on page 1685
Layout Options dialog on page 834

Changing the percussion kit presentation type
You can change the presentation type of percussion kits in each layout independently and 
independently of each other. For example, you can use a five-line staff in the full score layout 
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but a grid in the percussion part layout, and have two percussion kits with different presentation 
types in the same full score layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the percussion kit 
presentation type.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Percussion section, choose one of the following options for each percussion kit in 
your project:

● 5-line Staff

● Grid

● Single-line Instruments

5. Click Apply, then Close.

RESULT
The presentation type is changed for the selected percussion kits in the selected layouts.

Percussion legends
Percussion legends list the percussion instruments in use when using the five-line presentation 
type. Percussion legends can include all instruments that are represented on the staff, or only 
show sounding instruments in a set range to remind players which instruments to play at certain 
points.

Two sounding instrument percussion legends

By default, percussion legends appear above the staff. You can change the staff-relative 
placement of percussion legends individually. You can also change the default distances between 
percussion legends and other items project-wide on the Percussion page in Engraving Options.

You can change various aspects of the paragraph style for percussion legends, such as the font 
size and style, in the Paragraph Styles dialog.

Percussion legends appear as signposts if there are no instruments sounding at their position, 
or when the layout uses the grid presentation type. Percussion legends do not appear at all in 
layouts using the single-line instrument presentation type.
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NOTE

● Percussion legends only appear in the layout in which they were added. If you want to show 
percussion legends in multiple layouts, you must add them in each layout.

● You can hide/show percussion legend signposts by choosing View > Signposts > Percussion 
Legends. Percussion legend signposts are shown when a tick is shown beside Percussion 
Legends in the menu, and hidden when no tick is shown.

RELATED LINKS
Changing the staff-relative placement of items on page 441
Engraving Options dialog on page 840
Paragraph Styles dialog on page 848
Per-flow notation options for unpitched percussion on page 1690
Edit Percussion Kit dialog on page 155
Percussion kit presentation types on page 1694
Hiding/Showing instrument change labels at the start of flows on page 1539
Staff labels for percussion kits on page 1545

Adding percussion legends to five-line staff kit presentations
You can add percussion legends at specific rhythmic positions to indicate the instruments in the 
kit. Percussion legends can show all instruments in the kit or only instruments sounding within 
the specified range.

NOTE

Percussion legends only appear when kits use the five-line staff percussion kit presentation type 
and in the layout in which they were added. If you want to show percussion legends in multiple 
layouts, you must add them in each layout.

PROCEDURE

1. In Write mode, select one of the following:

● An item on the staff at the rhythmic position where you want to add a percussion legend 
for all instruments.

● The range of notes/items for which you want to show a percussion legend for sounding 
instruments.

2. Add a percussion legend in one of the following ways:

● Choose Edit > Notations > Percussion > Legend for All Instruments.

● Choose Edit > Notations > Percussion > Legend for Sounding Instruments.

TIP

You can also choose these options from the context menu.

RESULT
A percussion legend is added to the kit. It appears above the staff when the kit uses the five-line 
staff presentation. It lists instruments, either all instruments or just instruments with notes 
within the selected range, in the order in which they appear in the five-line staff, from highest 
down to lowest.
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RELATED LINKS
Percussion kit presentation types on page 1694
Editing percussion legend text on page 1700

Changing the percussion legend type
You can change the type of percussion legends so they show all instruments or only sounding 
instruments in five-line staff presentations.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the percussion legends whose type you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Legend type in the Percussion Legends group.

NOTE

The property is already activated for sounding instrument percussion legends.

3. Choose one of the following options:

● Legend

● Sounding instruments

RESULT
The legend type of the selected legends is changed.

RELATED LINKS
Percussion legends on page 1696
Percussion kit presentation types on page 1694
Adding percussion legends to five-line staff kit presentations on page 1697
Engrave toolbox on page 514

Changing the sounding instrument percussion legend range
You can change the rhythmic range of sounding instrument percussion legends to include more/
fewer instruments in the legend, as they only show the instruments playing at the rhythmic 
positions included in the range.

PROCEDURE

1. In Write mode, select the sounding instrument percussion legend whose range you want to 
change.

2. Change the range in any of the following ways, according to the current rhythmic grid 
resolution:

● To move the whole range to the right, press Alt/Opt-Right Arrow .

● To move the whole range to the left, press Alt/Opt-Left Arrow .

● To lengthen the range, press Shift-Alt/Opt-Right Arrow .
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● To shorten the range, press Shift-Alt/Opt-Left Arrow .

NOTE

Key commands lengthen/shorten items by moving their end only.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
The rhythmic range covered by the selected sounding instrument percussion legend is changed 
according to the current rhythmic grid resolution.

The instruments included in the percussion legend are automatically updated to reflect the 
instruments playing within the range.

RELATED LINKS
Rhythmic grid on page 214

Showing short instrument names in percussion legends
Percussion legends use full instrument names by default, but you can choose to use short names 
to save space.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the percussion legends whose instrument name lengths you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Use short names in the Percussion Legends group.

RESULT
Short instrument names are shown in the selected percussion legends.

Deactivating Use short names returns the selected percussion legends to showing full 
instrument names.

RELATED LINKS
Staff labels for percussion kits on page 1545
Percussion legends on page 1696
Percussion kit presentation types on page 1694
Adding percussion legends to five-line staff kit presentations on page 1697
Engrave toolbox on page 514
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Editing percussion legend text
By default, percussion legends show the instrument names of percussion instruments in five-line 
staff presentations, stacked vertically. You can change the text shown in percussion legends to 
show custom text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the percussion legends you want to edit. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Custom text in the Percussion Legends group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected percussion legends is changed.

RELATED LINKS
Engrave toolbox on page 514
Hiding/Showing zones on page 47
Properties panel on page 769

Erasing the background of percussion legends
You can erase the background of individual percussion legends; for example, to ensure they 
remain legible when crossing barlines. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the percussion legends whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Percussion Legends group.

RESULT
The backgrounds of the selected percussion legends are erased. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns the selected percussion legends to the default non-
erased background.
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AFTER COMPLETING THIS TASK
You can change the padding between percussion legends and each edge of their erased areas.

RELATED LINKS
Engrave toolbox on page 514
Properties panel on page 769
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the erasure padding of percussion legends
You can change the erasure padding of individual percussion legends, including changing the 
padding between percussion legends and each edge of their erased areas independently. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the percussion legends whose erasure padding you want to change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Percussion Legends group.

● L changes the padding between percussion legends and their left edge.

● R changes the padding between percussion legends and their right edge.

● T changes the padding between percussion legends and their top edge.

● B changes the padding between percussion legends and their bottom edge.

3. Change the values in the value fields.

RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Voices in percussion kits
Dorico Pro automatically combines music into a smaller number of voices when multiple 
percussion instruments are presented in a five-line staff or as a grid, even if they contain 
different rhythms. By default, music is combined into one up-stem voice and one down-stem 
voice.

Alternatively, you can choose to notate all notes in a percussion kit in a single voice when the kit 
is defined as a drum set on the Percussion page in Notation Options. This convention is used 
less frequently for orchestral percussion.

You can also override this option for individual notes and whole instruments in individual 
percussion kits.
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Notes in the same voice cannot be notated using different durations and are notated using ties 
by default instead. You can eliminate the use of ties by choosing to truncate longer notes so that 
only their onsets appear on the Percussion page in Notation Options.

If one of the instruments in a percussion kit has a tuplet rhythm, other instruments can share the 
voice if their notation is compatible, such as if the tuplet structure is the same, or if they have a 
single note that coincides with the start of the tuplet. In this case, the single non-tuplet note is 
notated as the same duration of the first note of the tuplet.

If the music of the different instruments in the same voice is incompatible, Dorico Pro 
dynamically creates another voice and notates the remaining music in that voice until the music 
is compatible again.

RELATED LINKS
Edit Percussion Kit dialog on page 155
Notations on notes in percussion kits on page 1693
Defining percussion kits as drum sets on page 158
Adding slash voices to percussion kits on page 1485

Specifying the stem direction/voice of instruments in percussion kits
You can specify the stem direction for each instrument in individual percussion kits. You can also 
set which voice they are in, allowing you to control which instruments share voices in percussion 
kits.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
instrument stem directions and voices you want to specify.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. In the dialog, select an instrument whose stem direction and voice you want to specify.

4. Choose one of the following stem directions for Stem direction and voice:

● Up-stem 

● Down-stem 

5. Specify a voice by changing the value for Stem direction and voice.

NOTE

You do not have to change the voice number if you are switching between up- and down-
stem voices as the number corresponds to the voice number for each stem direction.

6. Click Apply, then Close.

RESULT
The default stem direction and voice of the selected instrument is changed.

RELATED LINKS
Players panel on page 111
Edit Percussion Kit dialog on page 155
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Changing the voice of individual notes in percussion kits
You can override the default voice for individual notes in percussion kits, including drum sets.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose voice you want to override. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Percussion > Change Voice > [Voice].

For example, to change notes to the second down-stem voice, choose Edit > Notations > 
Percussion > Change Voice > Down-stem Voice 2. You can also choose this option from the 
context menu.

RESULT
The voice of the selected notes is changed, independently of the default voice for their 
instrument and independently of your setting for voices in drum sets.

TIP

You can reset the voice of individual notes by selecting them and choosing Edit > Notations > 
Percussion > Change Voice > Reset Note Destination Voice. You can also choose this option 
from the context menu.

RELATED LINKS
Engrave toolbox on page 514

Universal Indian Drum Notation
Dorico Pro supports the Universal Indian Drum Notation system developed by Keda Music Ltd.

Universal Indian Drum Notation has been designed primarily for tabla, but can also be applied to 
other Indian drums with two heads, such as nagara, dhol, dholak, mridangam, and pakhawaj.

Indian drum clefs are automatically shown on the staves of tabla instruments and tabla 
percussion kits, but you can also input Indian drum clefs manually.

RELATED LINKS
Adding players on page 125
Adding instruments to players on page 138
Inputting clefs with the panel on page 334
Percussion kits and drum sets on page 1690
Percussion maps on page 930
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Voices

For many instruments, such as flute or trombone, each staff usually contains a single musical line 
in a single voice that is read from left to right along the staff. When multiple, independent lines 
must be shown in a single staff, each line can be a separate voice.

An excerpt of piano music with two voices active on each staff

One common use for showing multiple voices in a single staff is in vocal music, when the 
soprano and alto lines share a single staff and the tenor and bass lines share another staff. 
Showing each vocal line in its own voice helps to separate the lines, making the music easier to 
read and making the shape of each melodic line clear.

In Dorico Pro, notes belong to voices. You can create as many voices as you like on each pitched 
instrument staff. Each voice has its own color, which you can see if you show voice colors. This 
can help you to keep track of which notes are in which voices if there are multiple overlapping 
musical lines in your project.

Voices in Dorico Pro are divided into up-stem voices and down-stem voices. Stems of notes 
in up-stem voices point upwards, while stems of notes in down-stem voices point downwards. 
However, in bars where only one voice contains notes, stem directions are automatically changed 
to the directions they would have if there were only one voice on the staff. By default, the first 
voice on the staff is up-stem.

Following most notation conventions, rests are shown in bars for all voices that have notes in 
the bar. If two or more voices have a rest of the same rhythmic duration at the same rhythmic 
position, that rest is consolidated by default: instead of showing two identical rests, only one is 
shown.

RELATED LINKS
Inputting notes into multiple voices on page 231
Changing the voice of existing notes on page 477
Swapping the contents of voices on page 478
Voices in percussion kits on page 1701
Slash voices on page 1483
Adding notes above/below existing notes on page 258
Stem direction on page 1274
Voice column index on page 1708
Unused voices on page 1710
Implicit rests in multiple-voice contexts on page 1489
Moving rests vertically on page 1492
Deleting rests on page 1493
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Per-flow notation options for voices
You can find options controlling how notes in multiple voices are positioned in each flow 
independently on the Voices page in Notation Options.

The options on this page allow you to change the position and order of notes in multiple-voice 
contexts, and choose when noteheads in different voices can overlap.

Musical examples demonstrate how each option affects the appearance of your music.

RELATED LINKS
Notation Options dialog on page 837
Per-flow notation options for rests on page 1490

Hiding/Showing voice colors
You can show notes in different colors according to their voice; for example, to check which notes 
are in which voice. When voice colors are hidden, all notes appear black by default.

Voice colors are considered annotations and are not printed by default.

NOTE

You cannot show colors for voices and notes out of range simultaneously.

PROCEDURE

● Do one of the following:

● To show voice colors, choose View > Note And Rest Colors > Voice Colors.

● To hide voice colors, choose View > Note And Rest Colors > None.

RESULT
Voice colors are hidden/shown. The first eight voices on each staff use the colors set in 
Preferences > Colors > Voice Colors. Voice colors are automatically assigned to subsequent 
voices.

TIP

You can also identify voices by selecting individual notes and looking at the display in the status 
bar.

EXAMPLE

Voice colors shown

Voices
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AFTER COMPLETING THIS TASK
If showing voice colors reveals some notes are not in the voice you want, you can change their 
voice.

RELATED LINKS
Preferences dialog on page 61
Changing music area colors on page 57
Changing the voice of existing notes on page 477
Stem direction on page 1274
Viewing options for notes and rests on page 1261
Hiding/Showing colors for notes out of range on page 1261
Annotations on page 687
Status bar on page 42

Allowing/Disallowing noteheads in opposing voices to 
overlap

You can allow/disallow the noteheads of unison notes in opposing voices to overlap in different 
contexts in each flow independently. For example, if you want to allow notes with and without 
rhythm dots to overlap but disallow half notes to overlap with shorter notes.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the category list, click Voices.

3. In the Ordering Multiple Voices section, choose one of the following options for Unison 
half notes (minims) and shorter notes in opposing voices:

● Allow noteheads to overlap

● Do not allow noteheads to overlap

4. Choose one of the following options for Unison dotted and undotted notes in opposing 
voices:

● Allow noteheads to overlap

● Do not allow noteheads to overlap

5. Click Apply, then Close.

RELATED LINKS
Notation Options dialog on page 837
Swapping the order of voices on page 1708
Changing the voice column of notes on page 1709
Inputting notes into multiple voices on page 231
Note and rest grouping on page 1021
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Note positions in multiple-voice contexts
Notes are usually placed directly above each other and at the same horizontal position, so that 
it is immediately clear which notes are played together. However, the horizontal alignment of 
notes can be different in multiple-voice contexts.

There are circumstances when some notes must be positioned slightly to one side in a different 
voice column to ensure the division of notes across the voices is clear. For example, when there 
are three or more voices in a single staff, or when notes in two voices are a second interval apart.

A phrase with multiple voice columns for some beats on the top staff

Interlocking notes in different voices can be positioned in two ways:

1. Notehead to notehead, which allows noteheads to overlap partially. This voice order often 
takes up less horizontal space than positioning notes stem to stem, as notes can overlap.

2. Stem to stem, which does not allow noteheads to overlap. This voice order keeps notes in 
different voices separate.

Dorico Pro positions notes by default with the noteheads partially overlapping, in order to 
minimize the horizontal space they occupy and to maintain the clarity of the rhythm. The order 
and position of notes in different voices is also automatically adjusted so that each rhythmic 
position uses as little horizontal space as possible, while remaining clear and legible.

● You can change the default order of notes in multiple voices project-wide on the Voices page 
in Notation Options.

● You can also change the minimum gaps between notes in different voices in the Voices 
section of the Notes page in Engraving Options.

● You can manually swap the order in which opposing voices are positioned horizontally and 
change the voice column of individual notes.

● You can move notes graphically in Engrave mode by changing the note spacing. You can 
move notes individually and independently of all other items at that rhythmic position, or 
move everything at the same rhythmic position.

RELATED LINKS
Stem direction on page 1274
Slashes in multiple-voice contexts on page 1475
Implicit rests in multiple-voice contexts on page 1489
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Rhythm dot consolidation on page 1258
Per-flow notation options for voices on page 1705
Notation Options dialog on page 837
Engraving Options dialog on page 840
Note spacing on page 599

Voice column index
The voice column index is used to determine the positions of notes when multiple columns are 
needed; for example, when notes in two voices are a second interval apart and therefore cannot 
be placed directly above each other vertically, instead they must partially overlap.

Dorico Pro automatically changes the voice column of voices according to the number of active 
voices and the pitch of notes. Dorico Pro prefers showing voices with the widest pitch range 
between them on the left of the rhythmic position and voices with narrower pitch ranges to the 
right, as this produces the most balanced result, especially when there are multiple accidentals.

One voice Two voices 
horizontally aligned 
in the same voice 
column

Three voices all still 
horizontally aligned

Four voices with 
two voice columns

Five voices with two 
voice columns

RELATED LINKS
Rhythm dot consolidation on page 1258

Swapping the order of voices
Dorico Pro automatically positions notes with the noteheads partially overlapping, in order to 
minimize the horizontal space they occupy and maintain the clarity of the rhythm. You can 
manually swap the order in which opposing voices are positioned horizontally. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose order you want to change. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Voices > Swap Voice Order. You can also choose this option 
from the context menu.

RESULT
The voice order of the selected notes is changed by changing their voice column index. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.
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NOTE

If you want to revert voices to their default voice order, we recommend that you reset their voice 
column by deactivating Voice column index in the Notes and Rests group of the Properties 
panel instead of swapping their voice order again.

EXAMPLE

Interlocking notes in opposing voices positioned 
notehead to notehead.

Interlocking notes in opposing voices positioned 
stem to stem.

RELATED LINKS
Stem direction on page 1274
Implicit rests in multiple-voice contexts on page 1489
Swapping the contents of voices on page 478
Changing the voice of existing notes on page 477
Engrave toolbox on page 514
Changing the property scope on page 771
Copying property settings to other layouts/frame chains on page 768

Changing the voice column of notes
You can change the voice column, and therefore the horizontal order, of all notes in selected 
voices at individual rhythmic positions, independently of your per-flow settings. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select at least one note in each voice whose voice column you want to 
change.

2. In the Properties panel, activate Voice column index in the Notes and Rests group.

3. Change the value in the value field.

RESULT
The voice column of the selected voices is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Deactivating the property returns the selected voice to their default order according to your 
per-flow settings.
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TIP

The Voice column index property in the Notes and Rests group of the Properties panel is 
automatically activated when you swap the order of voices manually.

Unused voices
An unused voice is one that contains no notes anywhere in the project. Any unused voices are 
automatically deleted when you close a project, but you cannot manually delete voices once they 
have been created. You can create as many voices as you want in each staff.

NOTE

Deleting all notes in a voice does not delete the voice immediately.

If you later want to input notes in a voice that was automatically deleted when you last closed the 
project, you can create a new voice at any rhythmic position.

Notes crossed to staves with existing notes in other voices
When you create cross-staff beams by crossing notes to staves that already contain notes, the 
stem direction of the existing notes may change. This is due to how multiple voices at the same 
rhythmic position are handled in Dorico Pro.

For example, if a piano part contains notes in up-stem voices on both staves, the stem direction 
of notes in both voices can change if notes from the upper staff are crossed to the lower staff. 
In this situation, the notes from the two staves are not combined, but are instead treated as two 
up-stem voices in a multiple-voice context.

Two piano staves, each with notes in a single up-
stem voice.

When the notes in the upper staff are crossed to the 
lower staff, the stem direction of the notes already in 
the lower staff changes so they point upwards.

You can change the stem direction of the notes originally in the lower staff in any of the following 
ways:

● Select the notes originally in the lower staff and change their voice to another voice, such as 
a down-stem voice.

● Select the notes originally in the lower staff and change their stem direction.

Alternatively, you can move the notes in the upper staff permanently to the lower staff.

RELATED LINKS
Creating cross-staff beams/tremolos on page 1009
Moving notes/items to other staves on page 468
Inputting notes into multiple voices on page 231
Changing the voice of existing notes on page 477
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Stem direction on page 1274
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Glossary

A
action (expression maps)
A control in expression maps that determines how individual switches are controlled in order to 
trigger the required playback technique or combination of playback techniques.

action (harps)
The mechanism that raises or lowers the pitch of harp strings, as controlled by the position of 
each pedal.

action (pianos)
The mechanism that allows piano hammers to strike the strings with different forces, depending 
on the strength with which the player depresses the corresponding key. It allows pianos to use a 
greater dynamic range, hence their full name “pianoforte”.

alignment relative to noteheads
When calculating the horizontal alignment of items relative to noteheads, Dorico Pro uses the 
front notehead in the first voice column at the corresponding rhythmic position. The front 
notehead is the notehead on the correct side of the stem; that is, on the left of up-stems and 
on the right of down-stems. Items that can be aligned relative to noteheads include lyrics, chord 
symbols, and playing techniques.

anacrusis
See pick-up bar.

articulation (music notation)
A symbol that indicates how a note should be played, typically affecting its onset (attack), release, 
or duration. For example, staccato marks and accents.

articulation (sound libraries)
A term that refers to playing techniques generally.

attachment
The rhythmic position at which an item occurs, or to which an item applies, in the music. In 
Engrave mode in Dorico Pro, an attachment line is shown between a selected item and its 
rhythmic position.

B
bar
A span of music comprising a specific number of beats, as defined by the prevailing time 
signature, whose boundaries are indicated by bar lines. Also known as a “measure”, but this 
documentation uses “bar”.

C
cancellation natural
A natural accidental positioned on the staff immediately before a change in key signature or 
a single note. It indicates that the previous accidental no longer applies and can be followed 
immediately by a new accidental if applicable. Showing cancellation naturals before single 
accidentals that follow double accidentals is also known as “archaic cancellation”. Cancellation 
naturals before a change in key signature are known as “traditional” when positioned after the 
barline and “Russian” when positioned before the barline.

1712
Dorico Pro 4.3.30



caret
Shown during note input, the caret is the vertical line that extends above and below the staff and 
indicates the rhythmic position at which items are input. Also known as an “insertion point”. In 
Dorico Pro, the caret, cursor, and mouse pointer are related but serve different purposes. See 
also rhythmic grid, note input, cursor, mouse pointer.

casting off
The act of fixing the layout of pages of music, such as defining a set number of systems per page 
or the number of bars per system.

cautionary accidental
A restatement of an earlier accidental to eliminate ambiguities, such as when a tied note with an 
accidental continues onto another page. Also known as a “courtesy accidental”.

CC
Short for “continuous controller” or “control change”, it is a MIDI message that combines a 
controller number and a value. The value for an individual controller can change over time, 
allowing incremental manipulation of the corresponding sound or effect, such as increasing/
decreasing the string vibrato intensity. You can specify the sound or effect that each CC switches 
to and controls in each sound library using expression maps. In Dorico Pro, each instrument 
track has 127 available MIDI CCs, each with a value range from 0 to 127. Because MIDI CC does 
not use notes on a MIDI keyboard, it allows you to use the full range of MIDI keyboard notes for 
note input. However, it is therefore harder to trigger MIDI CC whilst recording notes. See also 
MIDI, PC.

channel
In MIDI, a channel determines which note, controller, or other data is played by which sound 
on which device. In Dorico Pro, notes on a single staff may be played by different channels, 
depending on which playing techniques are provided by the patch assigned to each channel. See 
also MIDI, patch.

chord
Two or more notes of the same duration that start at the same rhythmic position and share a 
stem.

chord input
A variation of note input where notes are stacked on top of each other to create chords, rather 
than being input after the previous note in sequence. Notes are input at the caret position, which 
does not advance automatically. See also caret, note input, Insert mode.

collision avoidance
Automatic adjustments made by Dorico Pro to ensure multiple items at the same position do not 
overlap and that all remain clearly legible. Includes changing the shape of items, such as slurs, 
and changing the vertical and/or horizontal position of items, such as accidentals in chords.

column
A vertical line representing the same horizontal position across all staves in the system. Used 
to determine the position of notes and chords for the purposes of spacing music accurately. 
Multiple columns can be used for the same rhythmic position to accommodate multiple voices, 
with notes or chords in some voices being offset horizontally from notes or chords in other 
voices.

concert pitch
All notes are written as they sound. Full scores are often notated in concert pitch, so that 
harmonies and themes are easier to identify. Also known as “sounding pitch”. See also 
transposed pitch, instrument transposition.

condensing
The process of showing the music for multiple players on fewer staves than is normal, usually 
by allowing multiple instruments of the same type to share a staff, such as Flutes 1-2 or Horns 
1-4. Most commonly used for large orchestral scores, as when there are fewer staves on a page 
it is possible to use a larger staff size, which is easier for conductors to read. See also divisi, pitch 
crossing, reducing.
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constant point
A change in value in the Key Editor that sets a fixed value until the next point. See also point (Key 
Editor), linear point, value line.

context menu
A menu that you can access by right-clicking on a mouse or double-tapping on a touchpad. Its 
options vary by the location of the mouse pointer and what is selected when you access it, but it 
most commonly contains options also found on the Edit menu.

cursor
The vertical blinking line that appears when entering or editing text. See also caret, mouse 
pointer.

D
dead note
A note played on a fretted instrument whose sound is muted to produce a sound that is more 
percussive than pitched. Usually produced by gently resting one hand on the string. Also known 
as a “muted”, “muffled”, “ghost”, or “silenced” note. In Dorico Pro, only notes belonging to fretted 
instruments, such as the guitar or banjo, can be dead notes.

disclosure arrow
A small arrow that is shown on all edges of the main window in Dorico Pro. It allows you to 
hide/show the toolbar and panels individually.

divisi
Italian for “divide” or “divided”, divisi is when players split in order to play multiple lines of music. 
This commonly involves a section, such as Violin I, dividing and using two staves rather than one 
for a limited passage. Divisi passages can be notated all on the same staff, using multiple voices 
if required, or across multiple staves. See also tutti, condensing, exploding, reducing.

drum set
A particular type of percussion kit that is often used in pop and rock music. Drum sets often 
use a different arrangement of voices than percussion kits. In this documentation, references to 
“percussion kits” also apply to drum sets, as drum sets are a type of percussion kit.

E
EDO
An abbreviation for Equal Division of the Octave, it is a unit used to describe how an octave 
can be divided into equal parts, often for the purpose of defining a microtonal scale or tonality 
system. Traditional Western European music uses 12-EDO; that is, each octave is divided into 12 
equal half-steps (semitones). Music that uses equal quarter tones uses 24-EDO. See also pitch 
delta.

endpoint
The unique combination of inputs and outputs that together allow the correct sounds to be 
played for each instrument.

Engrave mode
A mode in Dorico where you can manipulate and modify every item in your project, but without 
deleting them, moving them rhythmically, or changing the pitch of notes. You can also determine 
how the pages in each layout of your project are formatted for printing or exporting. See also 
modes.

engraving options
Options that affect the graphical appearance of the notation, including choice of symbols, line 
thicknesses, and distances. These options apply to the whole project, including all flows and 
layouts, and can be set in the Engraving Options dialog.
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enharmonic equivalent
An alternative spelling of a note that uses a different scale degree and accidental but produces 
the same sounding pitch, such as G♯ and A♭.
ensemble
A predefined collection of players, each holding instruments that are often used together, such 
as string quartet, wind quintet, brass quintet, string ensemble, and double woodwinds.

envelope
A change in sound over time that comprises multiple stages, such as attack, sustain, and decay. 
In the Dynamics editor, envelopes are represented by highlighted regions and multiple separate 
points, each controlling a different parameter of the overall envelope. See also point (Key Editor), 
constant point, linear point, value line.

explicit rest
A rest that was deliberately input during rest input or imported from a MusicXML file. Explicit 
rests cannot be suppressed between notes in a particular voice. See also rest, implicit rest.

exploding
The process of assigning music to more instruments than it was written for originally. Exploding 
music is often a key step in arranging and orchestrating music, such as when a piano piece is 
arranged for string quartet. See also reducing, divisi.

F
family
Instruments of a similar kind that are typically bracketed together in a score, such as woodwind, 
brass, percussion, and strings.

fermata
A notation that indicates all notes at that position are held for longer than their notated length. 
It is most commonly shown as a curved line with a dot under the curve, but it can also be shown 
with a pointed arch or square shape. Also known as a “pause” or a “birds’ eye”.

flow
A self-contained span of music of any scope, such as a movement in a symphony, a song in 
an album, a number in a musical, or a short exercise in a music theory worksheet. A flow can 
contain the same players as other flows in the project or separate players just for that flow. See 
also player.

formatting
The act of determining the number of bars in a system, the number of systems on a page, and 
the distances between staves and systems.

fps
A unit of measurement, short for “frames per second”, that refers to the number of video frames 
occurring each second.

fragment
Part of a notation item. For example, fragments of a note include its notehead, rhythm dots, 
accidentals, the tip of its stem, and beam. In Write mode, selecting any part of an item also 
selects all of its fragments, so any changes you make affect the whole item. In Engrave mode, 
you can select each fragment individually to tweak its position or appearance. See also item, 
segment.

frame
A rectangular container for music, text, or graphics on a page.

fretted instrument
A type of instrument that in most cases has multiple strings, a neck with marked frets, and 
is played by stopping the strings at fret positions on the neck with one hand, usually the left, 
and plucking the corresponding strings with the other hand, usually the right. Common fretted 
instruments include the guitar, ukulele, and banjo.
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full score
A score comprising all of the music for all of the players and their instruments, typically laid 
out in a specific order. The order used varies according to the ensemble for which the music 
is written. In full scores for orchestra, the players are typically ordered from the highest wind 
instrument at the top of the page, such as piccolo, to the lowest string instrument at the bottom 
of the page, such as contrabass, with brass, keyboards, voices, and percussion in between.

G
galley view
A viewing option that shows music laid out as a single, infinitely wide system.

grace note
A small note, often used to show an ornament or embellishment, that is not counted towards the 
number of beats in the bar; instead, it steals from the duration of either the preceding or the 
following rhythmic notes. Also known as an “arhythmic” or “crushed” note. In common practice, a 
grace note with a slashed stem is an “acciaccatura”, which is to be played as quickly as possible, 
either immediately before or at the rhythmic position of the note or chord that follows it. A grace 
note with an unslashed stem is an “appoggiatura”, which is played as half of the written duration 
of the note or chord that follows it.

grand staff instrument
An instrument that normally uses two or more staves joined by a brace to display their notes. 
Common grand staff instruments include the piano, organ, and harp. Upper staves usually 
indicate higher notes and use the treble clef, while lower staves usually indicate lower notes and 
use the bass clef.

H
hairpin
A notation for dynamics that uses a pair of angled lines, diverging from or converging on a 
single point, to show a gradual increase or reduction in the dynamic level; that is, a crescendo or 
diminuendo.

half-bar
The rhythmic position that divides bars into two equal sections when the prevailing time 
signatures can be divided into four equal beats. In Dorico Pro, specific beam grouping and note 
grouping settings apply to bars with a half-bar. Time signatures that have a half-bar include 4/4 
and 12/8.

handle
A selectable item that marks the ends of lines, the corners of frames, and other moveable 
positions, such as pedal line retakes and slur control points. In Write mode, handles are 
circular and mark rhythmic positions. In Engrave mode, handles are square and mark graphical 
positions.

harmonic series
A naturally-occurring set of frequencies that are all related to a single pitch, known as the 
“fundamental”. When a fundamental pitch is played, the note produced contains many different 
notes within the harmonic series. These additional notes are known as “partials” or “overtones”. 
It is also possible to bring out the sound of individual partials by playing them as harmonics. 
There is a consistent pattern of intervals between partials within the harmonic series, and 
these intervals become progressively smaller the further up the harmonic series they occur. 
For example, the interval between the first and second partials is an octave whereas the interval 
between the seventh and eighth partials is only approximately a major second. At the top end of 
the harmonic series, most partials are microtones. See also partial.

hook
A short line that extends from other lines, most commonly at a right angle, that helps to clarify 
the end position of lines. In Dorico Pro, hooks can be used at the end of pedal lines, octave lines, 
repeat endings, and tuplet brackets.

Glossary
 

1716
Dorico Pro 4.3.30



horizontal justification
The alignment of musical content to the left and right edges of the frame. To ensure that all 
staves in a system occupy the same width, any remaining space that is left over after the music 
is spaced is distributed evenly between all of the columns in the system. Sometimes the final 
system of a flow is not fully justified and is allowed to end partway across the width of the frame. 
See also frame, justification.

I
implicit rest
A rest that is automatically shown around the notes you input. Its notated duration automatically 
adjusts according to the time signature and its position in the bar. Implicit rests can be 
suppressed between notes in a particular voice, which hides them. See also rest, explicit rest, 
padding rest, multi-bar rest.

Insert mode
A way of changing how notes are input. When Insert mode is activated, new notes push all 
subsequent notes in the same voice along by the input duration instead of overwriting existing 
notes. Similarly, reducing the duration of notes with Insert mode activated pulls them closer 
together without leaving rests between the notes. This also affects edits you make outside of 
note input, such as deleting notes, changing the duration of notes, or inputting time signatures. 
See also note input, chord input.

instrument
Anything that requires at least one staff to represent the sounds or music it produces. Common 
instruments include the violin, flute, tuba, and bass drum. However, human voices, computer 
triggering samples, and tape recordings can also be instruments.

instrument transposition
The interval difference between the pitch the instrument plays and the resulting sounding pitch, 
often included as part of the instrument name. For example, when a Clarinet in B♭ plays a C, the 
pitch produced is a concert B♭. Instrument transposition is also known as “instrument pitch”. See 
also concert pitch, transposed pitch.

item
Generic term for any note, rest, chord, notation, or other selectable object that appears in the 
score in Dorico Pro. See also fragment, segment.

J
justification
The alignment of musical content to the edges of the frame, both horizontally and vertically. See 
also frame, horizontal justification, vertical justification.

K
key command
A set of keys that perform a defined task when pressed together. Also known as a “keyboard 
shortcut” or “hotkey”.

L
layout
A page-based presentation of the music for one or more players in one or more flows; for 
example, a full score that contains all players or an instrumental part that contains only a single 
player. See also flow, player.
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layout options
Options that affect the setup of an individual layout, such as page and staff size. These options 
can be set in each layout independently in the Layout Options dialog. See also layout.

linear point
A change in value in the Key Editor that acts as a point on a curve, setting a value for its position 
only and allowing for a smooth change in value from that position until the next point. See also 
point (Key Editor), constant point, value line.

lock duration
Functionality that allows you to change the pitches of existing music while retaining existing 
rhythms.

lyric
Any text that is intended to be sung or spoken by an individual singer or group of singers. A lyric 
can be a whole word or an individual syllable in a multi-syllabic word. Lyrics are shown at each 
rhythmic position where a new word or syllable begins. Typically, lyrics are found below the staff, 
but are sometimes placed above the staff; for example, in the case of a short score.

M
measure
See bar.

MIDI
An abbreviation for Musical Instrument Digital Interface, a standard for how electronic musical 
instruments, computers, and virtual instruments can connect to and communicate with each 
other. In Dorico Pro, MIDI data can be sent to one of 16 channels, which allow either a specific 
instrument, or a specific patch on a specific instrument, to receive and respond to the data. See 
also channel, patch, CC, PC.

minor key
A key signature based on a minor scale, which has a different pattern of intervals to a major 
scale. See also minor scale.

minor scale
A sequence of notes containing the pitches of a minor key. There are three types of minor scales: 
natural, harmonic, and melodic. Natural minor scales follow the interval pattern of the Aeolian 
mode, which on a keyboard is all the white notes from A-A. Harmonic minor scales also follow 
the Aeolian mode interval pattern but the seventh degree of the scale is sharpened; for example, 
G♯ in A harmonic minor. Melodic minor scales follow different interval patterns when they are 
rising/falling: when rising, melodic minor scales have sharpened sixth and seventh degrees, but 
when falling, the sixth and seventh degrees are both natural. See also minor key.

modes
Selectable workspaces in the project window that represent different phases in the workflow of 
preparing a score. See also Setup mode, Write mode, Engrave mode, Play mode, Print mode.

mouse pointer
The icon on the screen that allows you to interact with items and the user interface, usually by 
clicking. Its position is typically controlled by an external mouse or touchpad. Its appearance 
varies depending on the context, such as appearing as a hand when it hovers over a hyperlink, 
but it most commonly appears as an arrow pointing towards the top left corner of the screen. 
Also known as a “mouse arrow”, “cursor”, or simply a “pointer” or “mouse” In this documentation, 
we use the term “mouse pointer” to differentiate from the cursor and caret. See also cursor, 
caret, touchpad.

multi-bar rest
A consolidation of multiple adjacent empty bars into a smaller unit, typically shown as a single 
bar with the total number of bars' rest written above the staff. A multi-bar rest normally shows 
an H-bar symbol, which is a thick horizontal line with vertical lines at each end. In some older 
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published scores, a multi-bar rest of up to nine bars in length is shown using a combination of 
double whole and whole rests. Also known as a “multirest”.

music area
The main part of the window in Setup, Write, and Engrave modes where you input and edit your 
music.

MusicXML
A file format designed to allow the interchange and archiving of music notation data in an open 
and non-proprietary way. It is useful for exchanging scores between different music applications.

N
node
A position along the length of a string that marks an equal division of the string, such as a 
quarter of the way along a string. Touching, but not fully stopping, a string at a node produces a 
harmonic partial. See also partial, harmonic series.

notation options
Options that affect the way the music is notated, particularly concerning how notes and rests are 
grouped according to meter, rules for the extent of accidentals, and options for transposition. 
These options can be set independently for each flow in the Notation Options dialog.

note input
The standard method of adding notes to staves in sequence that is possible when the caret is 
active. The caret automatically advances to the next rhythmic position after each note is input. 
During note input, it is also possible to input other items at the caret position. Also known as 
“step input” because notes are input step-by-step. See also caret, chord input, Insert mode.

O
octave division
A single step within an octave whose interval depends on the total number of divisions in the 
octave. For example, in 12-EDO, there are twelve octave divisions, each a half-step (semitone) 
apart. See also EDO, pitch delta.

overtone
See partial. See also harmonic series, node.

P
padding
The minimum distance/gap between two items, such as text and its enclosure. Padding values 
can be independent of other set values, such as minimum height or width.

padding rest
A rest that fills the extra rhythmic space before or after cues that start or end partway through 
bars. This shows clearly how the rhythm of the cue fits within the time signature and how it 
relates to the player’s existing material. See also implicit rest.

page break
The forced termination of a page of music at a particular rhythmic position, typically at a barline. 
Often used to ensure a convenient page turn in a part. In Dorico Pro, page breaks can be 
achieved using frame breaks, which are indicated using signposts. See also system break.

page view
A viewing option that shows music laid out on a page with a fixed width and height, as it appears 
when printed. See also galley view.
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panel
Wide palettes of tools on the left, right, and bottom edges of the program window that are 
available in all modes, but their content varies in each mode.

part
The music belonging to the instruments played by one or more players, shown on its own rather 
than in a full score. Performers who do not need to see the music belonging to the whole 
ensemble play from parts so they only have to read the music they play themselves. See also full 
score, layout.

partial
A single pitch or frequency in the harmonic series, which varies in pitch according to the pitch 
of the fundamental but is always a consistent interval above the fundamental according to 
its number in the harmonic series. For example, the second partial is an octave above the 
fundamental, the third partial is an octave and a fifth above the fundamental, and the fourth 
partial is two octaves above the fundamental. Also known as simply a “harmonic” or “overtone”, 
although when described as an overtone it has a different number, as the first overtone is the 
same as the second partial. See also harmonic series.

patch
An older term for a discrete sound on a MIDI device or virtual instrument. See also channel, 
MIDI, PC.

pause (holds)
A notation that shows where the established rhythmic flow of the music is interrupted, either 
with a moment of repose or a short silence, before continuing. Also known as a “hold”, “fermata”, 
“breath mark”, and “caesura”. See also fermata.

pause (rest)
A marking with a rhythmic value that indicates no note is played for that duration. In this 
documentation, we refer to this as a “rest”. See also rest.

PC
Short for “program change” or “patch change”, it is a MIDI message that allows you to access 
different sounds by switching to the corresponding programs. Because programs can also 
include effects presets, they allow you to change to specific sounds quickly, which is particularly 
useful in live performances. You can specify the programs that each PC switches to in each sound 
library using expression maps. See also MIDI, CC, patch.

pedal level change
A change to how far a piano sustain pedal is depressed, between 1 (fully depressed) and 0 (not 
depressed). It is notated as a change to the height of a pedal line. Also known as a “pedal lift”.

pick-up bar
A note or notes played before the first full bar of a piece. Also known as an “upbeat” or 
“anacrusis”. Pick-up bars often only comprise one or two beats whose main purpose is to lead in 
to the start of the piece.

pitch crossing
A possible situation on staves containing multiple voices or parts, such as condensed staves, 
where notes in down-stem voices have higher pitches than notes in up-stem voices. See also 
condensing.

pitch delta
The number of octave divisions by which accidentals raise or lower the pitch of notes. For 
example, in 12-EDO, a pitch delta of 1 raises notes by a half-step (semitone) and is commonly 
notated using the sharp accidental (♯). See also EDO.

player
A musician who plays one or more instruments. Players are defined as either single players or 
section players and are assigned to flows and layouts. See also single player, section player, flow, 
layout.
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player group
A collection of players that comprises either a subset of the main ensemble, such as a choir 
within an orchestra, or a separate group, such as an off-stage brass group or second orchestra. 
Each group of players is labeled separately in the full score and is grouped and numbered 
together in the instrument order. See also player.

playhead
A vertical line that moves alongside music during playback and when recording, showing the 
current rhythmic position. Also known as a “playback line”.

Play mode
A mode in Dorico where you can change how your music sounds in playback, including by 
changing the playback template and assigning VST instruments, inputting automation, adjusting 
the mix, and changing the sounding duration of notes in playback without affecting their notated 
duration. See also modes.

playthrough
A single time playing from the beginning of the piece to the end. Music that contains multiple 
possible endings, such as music with repeat endings or codas, requires multiple playthroughs.

plug-in
A software program that can operate within another software program. Dorico Pro supports VST 
instruments and effects and script plug-ins written in Lua.

point (Key Editor)
A change in value in the Key Editor. Points appear as squares that you can select and edit, such 
as by dragging them. Points can be constant or linear. See also constant point, linear point, value 
line.

point (size)
A unit of measurement in typography that describes the size of fonts.

pointer
See mouse pointer.

polymeter
Music containing multiple simultaneous meters; for example, one instrument in the ensemble 
plays in 6/8 and another plays in 7/4.

popover
A temporary value field that is evoked using a key command and allows you to input items using 
text entries. You can open popovers in Write mode during note input or when items are selected 
in the music area. There are dedicated popovers for different types of items.

preamble
The notations typically drawn before the first note or rest on each system of music. The preamble 
usually includes clefs, key signatures, and time signatures. In Dorico Pro, the preamble is drawn 
automatically, so you cannot select any items included in it.

Print mode
A mode in Dorico that allows you to print and export the layouts in your project. See also modes.

print preview area
The main part of the window in Print mode where you can see a preview of what is going to be 
printed or exported as a graphic. See also Print mode.

project
A Dorico Pro file that can contain multiple flows and layouts. See also flow and layout.

properties
The characteristics of individual items and fragments of items in your project that can be edited 
via the Properties panel. There are two types of properties: local and global. Local properties are 
layout- and frame chain-specific, meaning that by default, changing local properties for an item 
in one layout does not affect the same item in other layouts or other frame chains.
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Q
quantization
In music, the act of adjusting the positions and durations of notes so they align with the nearest 
defined beat. This process eliminates small variations in rhythm and duration produced naturally 
by live performers, and can be useful when importing/exporting MIDI data as quantized music 
produces neater notation.

R
rastral size
The size of a full five-line staff, measured from the bottom line to the top line. The term comes 
from the rastra engravers historically used to draw five-line staves on blank paper. Because the 
rastrum is a fixed object, people became used to their set sizes and Dorico Pro continues this 
tradition by offering users a selection of rastral staff sizes.

reducing
The process of taking music for more than one instrument and assigning it to fewer instruments, 
such as a keyboard reduction of a choral piece. A piece of music that has been reduced is known 
as a “reduction”. See also exploding, condensing, divisi.

rest
A marking with a rhythmic value that indicates no note is played for that duration. Also known 
as a “silence” or “pause”, but in this documentation, we refer to them as “rests”. See also implicit 
rest, explicit rest, padding rest, multi-bar rest, pause (holds).

rhythmic grid
A unit of rhythmic duration whose value affects certain aspects of inputting and editing, such as 
the amount by which items move. Its current value is shown by the note value in the status bar, 
and by ruler markings indicating beat divisions and subdivisions above the staff on which the 
caret is active. See also caret.

S
score
See full score, part, layout, project.

section player
Multiple musicians who all play the same instrument and read from the same part layout; for 
example, Violin I. Section players may not play multiple different instruments, but can divide. See 
also player, single player.

segment
Part of a notation item that functions autonomously in Engrave mode. Segments can exist 
regardless of their position, such as individual ending brackets within a repeat ending, or only 
when a single item is split across a system or frame break, such as glissando lines. See also item, 
fragment.

Setup mode
A mode in Dorico where you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how they 
interact with each other; for example, by changing the players assigned to layouts. See also 
modes.

single player
An individual musician who can play one or more instruments; for example, a flute doubling 
piccolo. See also player, section player.

SMuFL
Short for “Standard Music Font Layout”, it is a font specification that maps all the different 
symbols required for music notation onto a standard layout. Dorico Pro requires SMuFL-
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compliant fonts for certain areas of the program, such as clefs and dynamic glyphs, to ensure it 
can locate the correct symbol. SMuFL-compliant fonts include Bravura, Petaluma, and November 
2.0.

space
A unit of measurement in music engraving based on the distance between the center of two 
adjacent staff lines. Practically all notation items are scaled in proportion to the size of a space; 
for example, a notehead is normally one space tall.

spacing
The act of determining the horizontal distance between successive columns in order to format 
the music. Horizontal spacing in Dorico Pro considers the graphical shape and size of notes and 
other items, such as rhythm dots and accidentals, and the note spacing values set. Full systems 
are automatically horizontally justified.

spelling
The way in which a note of a given pitch is specified by a letter name plus an accidental. For 
example, assuming the conventional 12-EDO pitch system, MIDI note 61 can be spelled as C♯, D♭, 
and B. The same pitch is normally spelled a certain way in a given key; for example, MIDI note 61 
is normally spelled as C♯ in D major, but is spelled as D♭ in A♭ major. See also EDO, MIDI.

split stem
A way of presenting altered unisons that keeps each accidental directly beside the notehead to 
which it applies. Also known as a “cherry stalk” or “tree”.

staff-relative placement
The vertical position of items relative to musical staves; that is, either above or below.

staff spacing handle
The square handle on the bottom left corner of each staff when Staff Spacing  is activated in 
Engrave mode. Staff spacing handles only change the vertical position of a single staff. See also 
system spacing handle.

string shift indicator
An angled line that indicates the direction of movement when string players have to shift 
position on the fingerboard to play a higher/lower note with the same finger as the previous 
note.

stroke
The short line that bisects editorial slurs and ties. Also known as a “notch”.

SVG
SVG stands for Scalable Vector Graphics, which is an XML-based way of displaying and modifying 
graphics. Due to the way it is coded, it allows you to modify graphics very flexibly compared to 
other formats.

system
A horizontal span of music that is played together. Most printed music displays systems 
spanning the full width of pages. A system can contain any number of staves. For example, 
in orchestral full scores, systems typically contain staves for all instruments in the orchestra, 
meaning a single system often occupies the full height of the page. In part layouts, each system 
only contains the staves required for that player, which is often a single staff and means multiple 
systems can fit on each page. See also system break, page break, casting off.

system break
The forced termination of a system of music at a particular rhythmic position, typically at a 
barline. Indicated in Dorico Pro with signposts. See also page break.

system formatting
The distribution of bars into systems and systems into frames. When copying part formatting 
between layouts, Dorico Pro considers the positions of system breaks, frame breaks, and note 
spacing changes to be aspects of system formatting.
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1723
Dorico Pro 4.3.30



system object
An item that applies to all staves in the system, but is not necessary to show on every staff, such 
as tempo marks and rehearsal marks. In Dorico Pro, you can show system objects at multiple 
positions in each system by showing them above multiple instrument families.

system spacing handle
The square handle on the top left corner of each system when Staff Spacing  is activated in 
Engrave mode. System spacing handles change the vertical position of the top staff in systems, 
which also moves all staves in the system accordingly. See also staff spacing handle.

T
tempo track
The timing-related information included in MIDI data that affects tempo, SMPTE offsets, time 
signatures, timecodes, and markers, which can be imported independently of the rest of the data 
in MIDI files.

token
A code used in a text string that is automatically replaced by a piece of information from 
elsewhere in the project, such as the title of the current flow, the name of the player, or the 
page number. Also known as a “wildcard” or “text code”.

touchpad
Any flat device with a tactile sensor that functions as an alternative to the traditional computer 
mouse. Commonly built into laptop computers but can also be separate appliances connected 
wirelessly or via a cable.

transport
Encompasses all options related to playback and recording.

transposed pitch
In transposed pitch, the pitches notated are the pitches that the instrument plays, rather than 
the desired sounding pitch. Instrumental parts are always in transposed pitch so that players can 
simply play the written notes, which is especially important for transposing instruments. See also 
concert pitch, instrument transposition.

tuplet
A rhythm that is performed at a fraction of its normal written duration. For example, a triplet is 
three notes of a given note value played in the time it would normally take to play two notes of 
that note value. Also known as an “irrational rhythm” or a “countermetric rhythm”.

tutti
Italian for “everyone”, tutti indicates that a passage of music is to be played by all players reading 
from that part or staff. It is most commonly used to indicate the end of a divisi passage, or for 
clarification when a staff can indicate both solos and tutti passages at different times. See also 
divisi.

U
upbeat
See pick-up bar.

V
value line
A visual representation of value over time. In Dorico Pro, you typically find value lines in the Key 
Editor. Fully horizontal value lines indicate a constant value, while angled value lines indicate a 
smooth change in value within a given duration, usually between two points. See also point (Key 
Editor), constant point, linear point.
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vertical justification
The spreading out of staves and systems across the full height of frames with as even a 
distribution of space as possible. If the music in the frame requires less vertical space than 
is available, the remaining space is distributed evenly between the systems, and between the 
staves of the systems. See also frame, justification.

vibrato bar
A device on electric fretted instruments, typically guitars, that allows the performer to add 
vibrato to notes and to adjust the pitch of notes, similar to a guitar bend. Also known as a 
“whammy bar”, “tremolo bar”, “tremolo arm”, or “vibrato arm”.

voice
In Dorico Pro, a series of notes, chords, rests, and other notations that make up a single musical 
line and are normally played by the same instrument. Assigning notes and items to different 
voices allows multiple lines of music to be presented on the same staff as clearly as possible, 
such as in vocal music where the soprano line uses an up-stem voice and the alto line uses a 
down-stem voice. Dorico Pro allows as many voices as are needed to be input onto a single staff, 
and lays them out and spaces them automatically. See also instrument.

VST instrument
Short for “Virtual Studio Technology instrument”, it is a digital plug-in that converts MIDI data 
into audio output. It can emulate an existing piece of studio hardware or can be an entirely new 
creation.

W
Write mode
A mode in Dorico where you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. See also modes.
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Index

A
a2. See player labels
abbreviated

dates 580
dynamics 1104, 1118
instrument names 181, 184, 185, 760, 1535
player labels 760
repeat markers 1448
staff labels 155, 1532, 1534, 1535, 1568
tempo text 1594

absolute channel change actions 925
absolute font size 846, 848
absolute tempo changes 1588

components 1589
Academico font 844
accelerando. See gradual tempo changes. See also 
tempo marks
accents. See articulations
acciaccaturas. See grace notes
accidental duration rules 951

changing 952
common practice 951
Modernist 951
Second Viennese School 951

accidental spelling 245
changing 484, 485, 487
disabling respelling 246, 839
resetting 487

accidentals 942
altered unisons. See altered unisons
appearance 943, 952
arrows 908, 1219, 1220
attachment points 908
barlines 1214
brackets 943, 952, 1285
cancellation 951, 953, 1214
cautionary 951, 952, 1153, 1214
changing 244
chord symbols 146, 151, 153, 320, 1037–1039, 
1045, 1046
chords 945
collision avoidance 945, 947
components 908
custom 902, 904, 907, 908. See also custom 
tonality systems
default settings 942
deleting 943
duration rules. See accidental duration rules
engraving options 942
enharmonic equivalents 246, 484, 485, 487
figured bass 399, 1140
filters 433, 434, 905
gaps 1211
glissando lines 1317
Gould arrows 1219, 1220

accidentals (continued)
guitar pre-bends 1332
harmonics 1285
harp pedaling. See harp pedaling
hiding 942, 943, 952, 953, 1214, 1285, 1299
horn branch indicators 1166
inputting 228, 244, 950
instrument names 60
intervals 343, 498, 1300
kerning 946
key signatures 942, 1210, 1211, 1214, 1217
layout names 184
ledger lines 942
lines 1412
microtonal 950, 1220
MIDI input 245
moving 947
none 279, 943, 1213, 1214, 1285
octave divisions 1219
order 942
ornaments 1292, 1305
panel 201, 283
parentheses 943, 952, 1285
part names 184
piano roll editor 784, 786
pitch before duration 228
position 942
quarter tones 950, 1219, 1220
respelling 246, 484, 485, 487
restating 951, 952
showing 942, 943, 952, 1214, 1285, 1299
signposts 453
size 945, 1039
slurs 1508
spacing 946
stacking order 945, 947
staff labels 60
Stein-Zimmermann 1219, 1220
text 388, 391, 577, 583
ties across breaks 943, 1628
titles 577
tokens 577
tonality systems 902
transposing 481, 1217, 1218
trills 1298–1300, 1303, 1305

accolades. See braces
accordion registers 876
actions 918, 925
activating 66, 219

caret 219
channel effects 825, 829
chord input 197, 251
dotted notes 197
EQ 825
force duration 197
frames 514
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activating (continued)
grace note input 197
graphic editing 514
graphic slices 514
independent voice playback 636
Insert mode 197, 237
inserts 829
instrument filters 452
lock to duration 197
mouse input 197, 229
note input 219, 221, 224
note spacing 514, 604
pitch before duration 197
playback 33, 632, 651, 656
player sorting 127
plug-ins 636
rest input 197
scissors 197
staff spacing 514, 723
system track 431
tuplet input 197
VST instruments 636

adagio. See tempo marks
add intervals popover. See note tools popover
Add Marker dialog 403
add-on switches 916, 925
added notes

chord symbols 322
adding. See inputting
additional

endings 411, 413, 1441
voices 231, 1495, 1704

additive time signatures. See time signatures
advanced options

hiding 45
showing 45

advancing
caret 220
chord symbols popover 325
figured bass popover 400
hairpins 436
lyrics popover 394
slurs 436

aeolian
chord symbols 323, 1046
scales 495, 496, 503

aggregate time signatures 285, 1641
dashed barlines 285, 1641
inputting 285, 287, 288, 290

aikin noteheads 1251, 1252
air sounds. See playing techniques. See also diamond 
noteheads
aliases

jump bar 70, 71
alignment 840

arpeggio signs 1313
bar numbers 987, 988, 1472
barlines 967, 976
bars 709, 967, 976, 1566
breath marks 1208
chord symbols 1037–1039, 1042
counts 1456, 1472
crosshairs 612

alignment (continued)
dynamics 1105–1108, 1132, 1133, 1135
fermatas 1205, 1207, 1208
figured bass 1140
fingerings 1158
frames 563
gradual dynamics 1108
instrument names 185, 1540
items 612
lines 1405, 1412
lyrics 1229, 1230
measures 709, 1566
notes 1258, 1706–1709. See also voice column 
index
octave line numerals 1082
ornaments 1293
page numbers 1354
pedal lines 1368, 1374
playing techniques 1392, 1400
rehearsal marks 1424
repeat counts 1456
repeat endings 1443
repeat markers 1448, 1449
rests 1487
rhythm dots 1258, 1259, 1708
staff labels 185, 1534, 1540, 1544
staves 695, 709, 715, 721, 1534, 1566
symbols 1449
systems 695, 709, 721, 1534, 1566
tempo marks 1591
text 389, 584, 587, 588, 848, 851, 1612
time signatures 1652
trills 1294
voices 1258, 1706–1709. See also voice column 
index

allegretto. See tempo marks
allowing. See activating. See also enabling
alpha channel 596, 676, 686
alterations

chord diagrams 1058
chord symbols 322, 1037, 1038, 1050
figured bass 1140
jazz ornaments 346

altered bass notes 322, 326, 1037, 1047
arrangement 1037, 1048
inputting 318, 322
separator 1037–1039, 1048

altered unisons 948
appearance 949
articulations 955
formatting 949
split stems 948

alternating time signatures. See time signatures
alto abbreviation

horn fingerings 1166
alto clef. See clefs
amp modeling 825, 829
AmpSimulator 825, 829
anacrusis. See pick-up bars
angles

beams 1005, 1006, 1019, 1020
borders 848, 1615
fanned beams 1019, 1020
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angles (continued)
fingering slides 1176
glissando lines 609, 1317, 1318, 1321
hairpins 609, 1121
jazz articulations 1350
lines 385, 609, 1402, 1409, 1423
octave lines 1080, 1081
pedal lines 1368, 1369, 1372, 1374
slurs 1507, 1524
string shift indicators 1158, 1181
ties 1632
tremolos 1661
tuplet brackets 609, 1674

annotations 215, 506, 687, 1404
colors 897
comments 506
editing 894, 897
highlights 1044, 1101, 1102, 1459, 1461, 1474, 
1475
lines 884, 886, 894, 897, 1404
note/rest colors 57, 58, 639, 764, 1103, 1261, 1491, 
1705
ornaments. See ornaments
signposts 453
voice colors 57, 1705

aperture
hairpins 1120, 1121, 1127, 1128
messa di voce 1121, 1127, 1128

apostrophes 579
appearance

default settings 834, 837, 840
items 769
resetting 442

appending
flows 82
player numbers 761
subito 1118
verse numbers 1244

applying. See assigning. See also activating
appoggiaturas. See grace notes
Arabic numerals

chord diagrams 1057
fingerings 1180
fret numbers 1057
page numbers 547, 1354
staff labels 1540

archaic accidental cancellation 953
arco. See playing techniques
areas

editing 40, 155, 1694
graphs 816
music 37
print preview 39
project start 37
selecting 428, 430–432, 781, 818
tools 40, 769

arhythmic notes. See grace notes
arms

vibrato. See vibrato bar
arpeggio signs 1310, 1313, 1402

alignment 1313
appearance 1310–1312
beat-relative playback 1315

arpeggio signs (continued)
brackets 1311
changing 439
cross-staff 349, 350
crosshairs 612
curved 344
default settings 1310
deleting 459
direction 1311
duration 1314, 1316
ends 1312
engraving options 1310
filter 433
fingerings 1158, 1174, 1175
formatting 865, 1312
grace notes 1314
handles 1313
inputting 341, 344, 349, 350
length 349, 350, 609, 1313
moving 465, 468, 609
muting in playback 639
panel 346, 350
playback 1314–1316
popover 344, 349
position 1310, 1313, 1314
rhythm slashes 1310
spacing 1313
swash 1311
symbols 865
ties 248
types 344, 1312
voices 349, 350

arrangements
accidentals in key signatures 1211
chord symbols 1037, 1038, 1048
flows 166
movements 166
pages 44, 53

arranger 78
adding 78, 541
tokens 578

arranging 459, 461
changing instruments 140
chord symbols 327, 471, 472, 476
condensing. See condensing
copying 461–463
exploding 470–472, 476
filters 433–435, 449
MIDI import 90
pasting 463
reducing 469, 743
swapping staves 469
tools 459, 488
transforming notes. See transformations
transposing. See transposing
voices 462, 468, 477, 478

arrows 1402
accidentals 908, 1219
arpeggio signs 1311
caps 1398, 1414
custom 886, 894
design 1397
disclosure 45
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arrows (continued)
dividers 1574
lines 886, 894, 1404
noteheads 1249, 1252
panels 42, 47, 110
tempo equations 1605
vocal staves 1574
zones 42, 47, 110

articulations 954, 1387
altered unisons 955
changing 271
collision avoidance 959
copying 955
cues 1095
default settings 955
deleting 955
duration 954, 961
engraving options 955
formatting 865
gaps 960
hiding 1095
inputting 207, 228, 271, 272
inverting 959, 960
jazz. See jazz articulations
key commands 272
kits 1693
MIDI import 93
moving 609, 957–960
notes 957
order 957
outside the staff 961
overlapping 959
panel 201
percussion 935, 960, 1682, 1683, 1693
pitch before duration 228
placement 957, 959–961
playback 636, 637, 842, 913, 935–937, 961
playing technique-specific noteheads 935
position 609, 955–958, 961
showing 1095
slurs 957, 959, 1506
spacing 609
split stems 955
staves 961
stems 957
symbols 865
ties 957, 961, 1620
tremolos 935
tuplets 271
types 954
vertical position 960

artificial harmonics 1282
accidentals 1285
changing 1289
hiding 1283
partials 1284
pitch 1284
playback 1282–1284
showing 1283
styles 1286, 1289

assigning 66
expression maps to endpoints 665
flows to frame chains 573

assigning (continued)
flows to layouts 122, 172
frames to frame chains 571
instruments to endpoints 664
key commands 66
MIDI commands 66
notehead designs 1252, 1253
notes to strings 1255
page templates 549, 692
percussion maps to endpoints 665
players to flows 122, 167
players to frame chains 574
players to layouts 122, 171
voices to endpoints 664

atonal key signatures 1213
note spelling 481, 484

attacca 635, 971
attachment lines 27, 465, 609

caesuras 341
crosshairs 612
dynamics 1127
hiding 444
playing techniques 1392, 1394, 1399
text 1607

attachment points
accidental components 908
chord symbol components 861
items 465, 609
line annotations 897
lines 385, 387, 1402, 1405
music symbols 897
noteheads 869, 871
playing techniques 880
stems 871
symbols 900

attack
articulations 954, 1622
dynamics 313, 1104
playback 912
tremolos 408, 415, 417, 1661

attribute playback techniques 937
audio

buffer size 268, 270
device setup 61
dialog 104
exporting 103, 104
mixer 821, 822
outputs in mixer 659
panning 828
playback 651, 656
repeats 640
videos 194
volume 194, 821, 822, 827
warning 42

auditioning
chords 436
MIDI devices 263
notes 263, 435, 436

augmented 498
accidentals 951
chord symbols 321, 476, 1037, 1038
figured bass 1140
intervals 343, 481, 498, 951, 1140, 1300, 1301
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augmented (continued)
scales 495, 496, 503
trills 343, 1300, 1301

author name 506
changing 511

auto-save 106, 107
date and time 107
deleting projects 106
disabling 108
interval 108
recovering projects 107

automation lanes. See MIDI CC editor. See also Key 
Editor
AutoPan 825, 829
auxiliary notes 1303

notehead design 1252
position 1305
showing 1304

B
backgrounds 55

chord symbols 1049
colors 55, 56, 848, 851
dynamics 1110
erasing 763, 1049, 1110, 1173, 1183, 1281, 1389, 
1421, 1617, 1700
fingerings 1173
gradients 56
hairpins 1281
lines 1421
pages 55
percussion legends 1700
player labels 763
playing techniques 1389
stems 1281
text 1421, 1617
ties 1657
time signatures 1657

backups 108
auto-save. See auto-save
location 109
number 108

backwards 444
moving bars 733, 736
navigation 325, 394, 400, 445
pitches 489, 490, 501, 502
rhythms 489, 490, 501, 502

balalaika. See fretted instruments
balance

mix. See mixer
bands 80

adding 74, 115
EQ 825
player order 111, 127
staff grouping 1026
templates 74, 80

banjo. See fretted instruments
bar counts

font style 1500
multi-bar rests 984, 1500

bar graphs 816

bar numbers 981
alignment 988
alternative 994
appearance 982, 985, 994–996
barlines 987
brackets 994, 996
changing 991, 992
clefs 981, 988
colors 58
comments 506, 507, 509
counts 1468
default settings 981
deleting 992
enclosures 982
engraving options 981
erased backgrounds 982
excluding repeats 995
font 985, 986, 994
frequency 982
galley view 43
gaps 981, 988
guide 984
hiding 982, 984, 990, 992
including repeats 995
layout options 981
moving 609, 987, 988
multi-bar rests 984, 1500
multiple positions 987
paragraph styles 985, 986
parentheses 994, 996
part layouts 985
pick-up bars 1643
position 986–988, 1471
prefixes 996
ranges 984, 1467. See also numbered bar regions
rehearsal marks 1427
repeat sections 994, 995
returning to primary sequence 993
sequence changes 990
showing 982, 984, 992
signposts 453
size 982, 985
staff-relative placement 987, 1471
subordinate 992, 994
subsequent repeats 994–996
suffixes 996
system-relative placement 989
time signatures 990
total. See counts

bar repeats 1459, 1659
bar numbers 984
brackets 1461, 1464
casting off 729
changing 439, 1460
changing number 1462
colors 58
consolidating 1496
counts 1460–1465
default settings 1460
deleting 459
dynamics 1460
engraving options 1460
erased backgrounds 1459
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bar repeats (continued)
filter 433
font style 1461, 1465
formatting 865
frame breaks 737
frequency 1460, 1463
gaps 1460
grouping 1460, 1465, 1466
handles 436
highlights 1459, 1461
inputting 409, 410, 419
length 436
moving 465, 468
moving counts 609
multi-bar rests 1496
panel 410
parentheses 1461, 1464
phrase length 439, 1460
playback 439, 1460
popover 409
regions 1459
symbols 865, 1465
system breaks 734
types 409
viewing options 1461

bar rests 1494
counts 1496
cues 837, 1085, 1098, 1099, 1490
deleting 1489, 1493
hiding 1099, 1489, 1490, 1493–1495
inputting 247, 302
moving 1492
multi-bar rests 1496
showing 1099, 1490, 1494, 1495
slashes 1489
voices 1489, 1490, 1495

barbershop quartet. See project templates
barline joins 976–978, 1026, 1030

default 977
deleting 979
inputting 517, 978
length 980
resetting 1034
splitting 979
vocal staves 967

barline-attached lines. See lines
barlines 967

accidentals 1214
across staves 517, 976–978
alignment 967, 976
appearance 967
bar numbers 987
brackets 974
caesuras 341
changing 308, 309, 968, 970–972
chord symbols 1042, 1049
clefs 967
coda 1453
connected. See barline joins
copying 167
counts. See repeat counts
custom joins 976, 978, 1034
dashed 968, 970, 972

barlines (continued)
default 970, 971
default settings 967, 968
deleting 459, 977–980
double 968, 970, 972, 1453
dynamics 1107–1110
end barlines 971, 972
engraving options 967
fermatas 1208
final. See final barlines
formatting 517, 865
frame breaks 732
gaps 1049, 1110, 1211, 1389, 1421, 1617, 1700
grace notes 1196
gradual tempo changes 1592
grand staff instruments 976, 977
hiding 285, 971, 972, 1049, 1110, 1389, 1421, 
1617, 1641, 1700
hymnal-style 967
initial. See systemic barlines
inputting 302, 304, 305, 308, 309, 966
joins. See barline joins
key signatures 967, 972, 1214
length 967, 974, 976–978, 980
moving 459, 975
multi-bar rests 308
none 285, 971, 972, 1641
notation options 968
open meter 1641
ossia staves 1560
panel 305, 309
popover 302, 304, 308
rehearsal marks 1425
repeat. See repeat barlines
resetting 1034
scale size 968, 970
short 968, 970, 972
signposts 308, 309, 453, 459
single 968, 970, 972
spacing 967, 1211
staff grouping 517, 976–978, 1026, 1030
symbols 865
system breaks 732, 972
systemic 973
thickness 967, 968, 970, 972
tick 968, 970, 972
time signatures 967, 978, 1652
triple 304
tuplets 1672
types 304, 968
vocal staves 967, 976, 977
wings 974

Baroque
appoggiaturas 1193, 1201
figured bass. See figured bass
ornaments 346, 1291
trills 1306, 1309
tuning 635

barré 1387
adding 1065
appearance 1057
chord diagrams 854, 1057, 1066
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barré (continued)
hiding 1391
inputting 369, 373, 375

bars 17, 962
alignment 709, 967, 976, 1566
bar rests. See bar rests
beam grouping 27, 1021
cautionary accidentals 1153
chord symbols 1044
combining 459
count-in 268
deleting 302, 455, 962–964
deleting contents 964
display 649, 651
divisions 966
duration 962
expanding 305, 307, 455, 456
fixing number 729, 734, 738
frame breaks 732, 736
gaps 1455, 1566
glissando lines 1318
going to 447
graphs 816
grouping. See bar repeats. See also multi-bar rests
half-bar 837, 1021
height 693–695, 721
inputting 302, 305–307, 454
Insert mode 454
length 455, 962
moving 730, 732–734, 736, 737
multi-bar rests 1496
navigation 447
note grouping 27, 1021, 1475
numbers 982
panel 305, 306
pick-up bars 1643, 1644
playback 632, 649
popover 302, 305
red 457, 458
repeat 1440, 1447, 1459
rests. See bar rests
rhythm slashes 1474, 1475
selecting 426, 428, 431
size 454, 455, 599, 693, 694, 709, 721, 962, 1566
spacing 599, 601, 604, 965, 1493
splitting 732–734, 736, 737, 966
system breaks 732, 733
timecodes 1438
tuplets 1672
upbeats. See pick-up bars
vibrato. See vibrato bar. See also guitar
width 599, 601, 604, 709, 965, 1493, 1566

Bars and Barlines panel 305, 306, 309
Bartók pizzicato. See playing techniques
base switches 916, 925
based on

flow headings 557
page templates 535, 536, 541

baseline
attachment points 861, 865, 871, 880, 900, 908
chord symbols 1037, 1038
divisi 1568
instrument names 185

baseline (continued)
lyrics 1233, 1234, 1239
staff labels 185, 1568
text 389, 584, 851

bass clef. See clefs
bass drum. See unpitched percussion
bass guitar. See fretted instruments
bass notes

altered 318, 322
figured bass 1139, 1140
notes from chord symbols 474

bassoon. See instruments
beam corners 1013
beam groups 26, 998, 999, 1021

creating 1000
default settings 837, 998
defining 998, 1021
half-bar 998
notation options 998
pick-up bars 1644
resetting 1002
selecting 426
stem directions 1275
time signatures 999

beam lines
direction 1013
gaps 1015
number 1014
thickness 1003

beam slants 1005
changing 1006
grace notes 1200

beaming 998, 1000, 1019
accidentals 951
angles 1005, 1006, 1019, 1020
centered beams 1007, 1008
corners 1013
cross-staff. See cross-staff beams
default settings 998
direction 1003–1006, 1013, 1020
fanned 1019, 1020
gaps 1005, 1015
grace notes 1200
grouping 998, 1000, 1021. See also beat groups
half-bar 998, 1021
handles 1006
hiding 1280
inverting 1003, 1004
large pitch ranges 1200
lyrics 1001
meter 1021
multiple staves. See cross-staff beams
notation options 998
notes 1000
optical cross-staff spacing 1010
partial 1013
placement 1003, 1005, 1009, 1012
primary beams 1013
resetting 1002, 1004, 1009, 1012
restating accidentals 951
rests 998, 1000, 1016, 1017
secondary beams 1013, 1014
slants 1005, 1006, 1200
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beaming (continued)
slashes 1479
spacing 1010
splitting 837, 998, 1001, 1021
staff-relative placement 1003, 1004
stem direction 1003, 1008, 1009, 1011
stemlets. See stemlets
tablature 1582
thickness 1003
ties 248
time signatures 999, 1021
tremolos 1664
tuplets 998, 1016, 1021, 1673
unbeaming 1001
vocal staves 1001

beat groups 26, 998, 1021
defining 1021
numerators 1647
rhythm slashes 1475
specifying 285
ties 1620
time signatures 1647, 1649

beat units 1596
deleting beats 303
inputting beats 303
metronome marks 439, 1596
setting 297
tempo marks 296
tuplets 257

beats
deleting 303, 455, 962–964
display 649, 651
generating notes 472
inputting 303, 305, 307, 454, 455
Insert mode 454, 455
per minute 1596
pick-up. See pick-up bars
popover 303
recording latency 268, 269
relative position 443
selecting 432

beep. See click
bend intervals 1329

appearance 1330
handles 1333, 1335–1337
hiding 1329, 1330
microtonal 1329
showing 1330

bends
guitar. See guitar bends. See also dives
jazz. See jazz articulations. See also jazz ornaments
vibrato. See vibrato bar

big band. See bands. See also jazz
bindings. See ties. See also laissez vibrer ties
birds eyes. See fermatas
bit depths 103, 104
black and white 686
black noteheads 1246, 1247
blank areas. See erased backgrounds
blank pages 542

deleting 545
inserting 702, 703
staff spacing changes 723

blank staves 696, 700
adding 125, 130, 138, 701
after flows 699
frames 570, 700, 701
hiding 696, 699
showing 696, 699, 700

blending 474
blog 72
blue selections 1133, 1519
Blues guitar post-bends 1327
body

changing 1413
lines 886, 888, 891, 1402, 1404, 1413
playing technique continuation lines 1395, 1397

bold text 389, 584, 845, 846, 848, 851, 1607
chord symbols 1039
figured bass 1152, 1153
fingerings 1158, 1166, 1167
rehearsal marks 1429
repeat endings 1443
tasto solo 1152, 1153
tempo marks 1594
tuplets 1680

bomb
dive. See dives

bongos. See unpitched percussion
booklets 681

duplex printing 682
printing 680, 681

borders 687, 1614
bar numbers 982
chord symbols 1050
exporting 675
fingerings 1164
harp pedaling 1362, 1363
instrument change labels 848
layout names 1192
line annotations 894
lines 1420
padding 848, 1050, 1363, 1616
part names 848
printing 671
shape 848, 982, 1615
style 848, 1615
tacets 739, 848
text 585, 848, 894, 1420, 1614, 1615
thickness 586, 1363, 1420, 1616

Boston chord symbols 1038
bottom zone. See lower zone
bowing. See playing techniques. See also slurs
boxes. See borders. See also frames
bpm 1596

changing 812, 1596
swing playback 647

braces 1023
appearance 1024
custom grouping 1030, 1032
deleting 1034, 1035
design 1024
formatting 517, 865
grouping 1030
hiding 1028
inputting 1032
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braces (continued)
length 1033
resetting 1034, 1035
secondary brackets 1027, 1029
showing 1028
signposts 453, 1032
splitting 1032
staff spacing 694, 695, 721
symbols 865

bracketed noteheads 1263, 1265, 1344
appearance 1269
changing type 1265
chords 1263, 1265, 1268
curve 1270
default settings 1264
drawn curve 1264, 1269
engraving options 1264
font glyph 1264, 1269
formatting 1270
gaps 1264
ghost notes 1265
guitar bends 1323, 1326
handles 1269
hiding 1265
inputting 1265
length 609, 1269
moving 609, 1269, 1270
percussion 1265
playback 1265
shape 1269, 1270
showing 1265
slurs 1269
splitting 1268
tablature 1263–1265, 1323, 1328
tie chains 1266
ties 1269
ties on tablature 1266, 1620
trills 1303
vibrato bar dives and returns 1328
width 1270

brackets 1023
accidentals 943, 952, 1285
appearance 1024, 1027
arpeggio signs 1311
bar numbers 994, 996
bar repeats 1461, 1464, 1468, 1470
barlines 974, 976, 977
capo chord symbols 146, 1037, 1038
chord symbols. See parenthesized chord symbols
counts 1464, 1470, 1482
custom grouping 1030, 1032
deleting 1034, 1035
design 1024
divisi 1025, 1026, 1028, 1029, 1402, 1567
dynamics 1110
ends 1027
ensemble types 80, 1026
figured bass 397, 1140, 1143, 1147
fingerings 274, 276, 1158, 1168, 1170
formatting 517, 865
grouping 162, 517, 1025, 1026, 1030, 1542
guitar bends 1323, 1326
harmonics 1286

brackets (continued)
hiding 1025, 1028, 1030, 1032–1035, 1543
hold lines 1143, 1147
horizontal. See lines
inputting 1032
instrument transpositions 1538
layouts 1025
length 1033
metronome marks 1589, 1590
moving 1054, 1269
noteheads. See bracketed noteheads
numbered bar regions 1468, 1470
pedal lines 1382, 1383
player groups 162, 977, 1542, 1543
playing techniques 1395
project templates 80
repeat barlines 974
resetting 1034, 1035
secondary 1027, 1029
showing 1025, 1028, 1030, 1032–1035, 1543
signposts 453, 1032
size 1053
slash regions 1482
splitting 1032
staff labels 1538
staff spacing 694, 721
staves 1025, 1026, 1542
sub-brackets 517, 1027, 1029
sub-sub-brackets 1029
symbols 865
tablature 1286, 1323, 1326, 1328
templates 80
tempo marks 1589, 1590
thickness 1053
time signatures 285, 1645–1647, 1651, 1654
tuplets 1675
vibrato bar dives and returns 1328
wings 1027

Brandt-Roemer chord symbols 1038
brass band. See bands. See also project templates
brass instruments 131

adding 113, 115, 125, 130, 138
brackets 1026, 1542
chord symbols 1040
fingerings 1157, 1158, 1166, 1179
groups 162
horn branch indicators 1166, 1179
parts 176
player order 111, 127
playing techniques 372
project templates 80
slide positions 1180
system objects 1564
transposition 113, 137, 176

Bravura music font 844
breaking

multi-bar rests 1496, 1500
notes 261
tie chains 261, 1631

breaks
frame 736
page 736
system 733

Index
 

1734
Dorico Pro 4.3.30



breath marks 1202, 1204
appearance 439
colors 58
condensing 747
deleting 459
inputting 338–340
moving 465, 468, 609, 1208
multiple at same position 1206
placement 1205
position 1205
types 439, 1204
vertical position 1208

breves. See double whole notes
Brickwall Limiter 825, 829
Britten fermata. See fermatas
Broadcast WAVE format 104
broken beams 1013
buffer

audio 268, 270
building ensembles 115, 130
bypassing 825, 829. See also muting

C
C clef. See clefs
cadenzas 285, 305, 307, 455, 456, 962, 1641

system dividers 1562
caesuras 1202, 1204

appearance 439
colors 58
deleting 459
gaps 1206
inputting 338–341
moving 465, 609
multiple at same position 1206
placement 1206
position 341, 1206
types 439, 1204

calando. See gradual tempo changes. See also tempo 
marks
calculating

chord symbols 327, 471, 472, 476
harp pedaling 381

cancellation
accidentals 951, 953, 1214
double accidentals 953
key signatures 1214, 1215
naturals 1214, 1215

candidate menus
cues popover 422
playing techniques popover 369
tempo popover 294

cantabile. See dynamic modifiers
capitals

staff labels 1541
Capo Chord Symbol Definition dialog 151
Capo Definition dialog 148
capos 146

adding 147, 148
chord symbols 146, 150–152, 154, 1037, 1038
defining 147–151, 153
deleting 149, 151
gaps 146, 1037, 1038

capos (continued)
hiding 151, 152, 154
italics 146, 1037, 1038
notation staves 149, 150
parentheses 146, 1037, 1038
partial 147, 148
tablature 146–149

caps 1393, 1404
arrows 1398, 1414
changing 886, 1398, 1414
continuation 888, 1404
design 894
editing 894
lines 884, 886, 888, 894, 897, 1404
playing technique continuation lines 1395, 1398

cards
disclosure arrows 45
flows 121
layouts 118
players 111
timecodes 121

caret 215
activating 197, 219
advancing 220
chords 215, 251
color 57
deactivating 197, 219
extending 219, 235
grace notes 215, 250
inputting vs. editing 212
Insert mode 215, 237
lock to duration 215
moving 214, 220, 1670
multiple staves 219, 235
percussion kits 238
rhythmic grid 214
slash voices 215
slashes 233
tablature 215
types 215
voice indicator 215, 231, 1115

casting off 601, 602, 728
bars per system 729, 734
condensing 747
copying to other layouts 765
flows 506, 601, 602, 706
locking 729, 731
moving bars 730
note spacing 599–602
resetting 732
staff spacing 694, 720, 721
systems per frame 729, 738

categories
ensembles 115, 118, 130
lines 385, 884, 886–888, 891, 894, 899, 1402
noteheads 869, 874, 1247, 1251
playing techniques 877, 882
templates 74, 80, 1026

cautionary accidentals 951, 952
common practice 952
figured bass 1153
hiding 943, 952, 1214, 1285
Modernist 951
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cautionary accidentals (continued)
parentheses 951, 952
showing 943, 952, 1214, 1285
tie chains 943, 1285, 1628
trills 1299

cautionary clefs 1070
cautionary fingering 1168

appearance 1158
hiding 1168
parentheses 1158, 1168
showing 1168

cautionary key signatures 1216
cancellation naturals 1214

cautionary time signatures 1643
CC64

pedal lines 96, 268, 270
cello. See instruments
centered beams 1007

creating 1008
removing 1009

centered text
bar numbers 987
frames 587, 588
hairpins 1118

centimeters
staff spacing 723
unit of measurement 54

chains
frames 569
ties 1620

Change Divisi dialog 1568
change labels

condensing. See player labels
divisi 1577
instruments 134–136

channel change actions 659, 665, 925
channels 821, 823, 824

bypassing inserts 829
changing 664
controls 823, 825
endpoints 659
expression maps 659, 665, 925. See also channel 
change actions
height 827
hiding 826
importing 96
inserts 825, 829, 830
instruments 664, 823, 824
meter 823
MIDI 96, 823, 824
mixer 821–825
muting 638
panning 828
percussion maps 659, 665
playback 659
plug-ins 659
reverb 830
scrolling 826
setup 659
showing 826
soloing 638
strips 825
volume 827

character styles 845, 851
creating 852
deleting 851
dialog 851
missing fonts 76
saving as default 851

Character Styles dialog 851
cherry stalks. See split stems
choir templates 74, 80

staff grouping 1026
Choose Chord Diagram dialog 1065
choral

divider arrows 1574
lyrics 1222
playing techniques 372
verse numbers 1243

chord brackets. See bracketed noteheads. See also 
parenthesized chord symbols
chord diagrams 1036, 1056

barré 854, 1057, 1066
changing 1064, 1065
colors 854, 1065, 1066
components 1057
copying shapes 1064
custom 1065
default settings 1057, 1058
dots 854, 1057, 1065, 1066
editing 1065
engraving options 1057
fingerings 854, 1057, 1062–1066
font styles 1068
formatting 854, 1065, 1066
fret numbers 854, 1062–1066, 1068
gaps 1060
generating notes 476
grid 1060, 1062
hiding 1058–1060
horizontal 1069
input options 1058
inputting 1058, 1059
lines 1057
nut 1057
omitted notes 839
omitted strings 854, 1057, 1066
open strings 854, 1057, 1066
orientation 1069
resetting 854, 1064, 1066
rows 1060, 1062, 1064
shapes 476, 854, 1063–1066
showing 1058–1060
size 1060, 1069
symbols. See chord symbols
thumb 854, 1062–1064, 1066
tuning 142, 144, 854, 1060, 1064
vertical 1069

chord input 254
activating 197, 251
arpeggio signs 349
caret 215
exploding 235
multiple staves 235
register selection 224
tablature 242, 251
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chord symbol components 1037
appearance 1037, 1038
attachment points 861
custom 856, 861
handles 857, 859, 861
inputting 320
popover 320
types 1037, 1038

chord symbol regions 1044
handles 436, 1044
hiding 1040, 1041
highlights 1044
inputting 324, 326
length 436
moving 465, 468
popover 324
showing 1040, 1041

chord symbols 251, 1036
accidentals 146, 151, 153, 320, 1037–1039, 1045
added notes 322
alignment 1037–1039, 1042
alterations 1037, 1038
altered bass notes 318, 1039
appearance 856, 857, 859, 861, 1037, 1038
backgrounds 1049
barlines 1042, 1049
brackets. See parenthesized chord symbols
capos 146, 151, 152, 154, 1038
changing 439, 1037, 1038
colors 58, 861
components. See chord symbol components
copying 430, 1039–1041
crosshairs 612
custom 856, 857, 859, 861, 864
default settings 839, 1037, 1038
deleting 459, 1040
diagrams. See chord diagrams
dialog 856, 857, 859, 861
engraving options 1037, 1038
enharmonic spelling 146, 151–154, 839, 1037, 
1038, 1045, 1046
erased backgrounds 1037, 1038, 1049, 1050
exploding 471, 472, 476
exporting 831
figured bass 395, 397
filter 433
fonts 1039
gaps 146, 1037, 1038
generating 327, 471, 472, 476
global 1036
hiding 326, 1040, 1041, 1044, 1047, 1059
highlights 1044
importing 831
inputting 318, 320, 325–327, 839, 1040
instruments 318, 1040, 1041
intervals 322, 476
inversions 318, 326
italics 146, 1037–1039
layouts 1041
local 1036
main 146
MIDI input 318, 326
MIDI navigation 66, 839

chord symbols (continued)
modal 323, 1046
moving 465, 609, 1042, 1043
MusicXML import 1055
navigation during input 325
no chord 323
note spacing 1042
omissions 322
padding 1037, 1038, 1050, 1054
parentheses. See parenthesized chord symbols
pitch 173
placement 1043
playback 617, 627–629
players 318, 1040, 1041
polychords 318, 323
popover 320, 839
position 1037–1039, 1042
quality 318, 1037, 1038, 1047
regions. See chord symbol regions
resetting appearance 864
roots 318, 321, 1037, 1038, 1047
saving as default 864
selecting 426, 430–432
separators 1039
showing 318, 326, 1040, 1041, 1044, 1047, 1059
signposts 453, 1036, 1044
size 440, 1039, 1053, 1069
slash regions 1040, 1044, 1474
spacing 1042
spelling 146, 151–154, 839, 1037, 1038, 1045, 1046
staff-relative placement 1043
staves 318, 1040, 1041
suspensions 322
systems 1041
track. See chords track
transposing 146, 149–154, 173, 480, 481, 1036, 
1045
transposing instruments 146, 173, 1045, 1046
types 320, 1037, 1038
viewing options 1044
voicing 318, 474, 476, 629

chords 251
accidentals 945, 947
arpeggio signs 1313
auditioning 436
bracketed noteheads 1263, 1265, 1268
brackets 1050
building 258, 499
caret 215, 220, 251
collision avoidance 945, 947
dense 946
enclosures 1584
exploding 235, 470, 471
figured bass 395, 397, 1139, 1154
fingerings 1174
guitar bends 1323, 1327
inputting 197, 235, 251, 258, 499
inverting 489
lines 235, 349–351, 385, 387, 469–471
moving 489, 491
parentheses 1050
pitch mappings 493
playback 627, 628, 632, 636, 639
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chords (continued)
post-bends 1327
register selection 224
reversing 489. See also retrograde
rolled. See arpeggio signs
rotating 491
scale mapping 495
selecting 426
stem directions 1275. See also voices
tablature 224, 242, 1581
ties 248, 1626
track. See chords track
transformations 488
velocity 797. See also Velocity editor
vibrato bar dives and returns 1328
voices 231, 474, 476, 1704

chords track 627
hiding 629
showing 629

Chorus 825, 829
chorus lyrics 1223

changing lines to 1241
changing lyrics to 1223
font styles 1235
popover 393

chromatic glissando 1317
playback 1322

circle
bar number enclosures 982
chord symbols 1037, 1038
fingerings 1164
hairpins. See niente
harmonics 1286, 1288
note enclosures 1585
noteheads 1247, 1252, 1683, 1686, 1687
pitches 491, 492, 502
playing techniques 372, 876, 1387
rehearsal mark enclosures 1425
rhythms 491, 492, 502
string indicators 1183, 1185
symbols 876, 894, 899
tapping 1340, 1343

clarinet. See instruments
clash cymbals. See unpitched percussion
Classical

ornaments 346
trills 1306, 1309

classical guitar. See fretted instruments
Clef and Transposition Overrides dialog 177
clefs 1070

bar numbers 981, 988
barlines 967
cautionary 1070
changing 177
colors 58
cues 1086, 1099, 1100
deleting 459
filter 433
formatting 865
gaps 1070, 1072, 1211
grace notes 1071
hiding 333, 334, 1075
Indian drum 334, 1703

clefs (continued)
inputting 329, 330, 332–334
instruments 113
key signatures 1214
layouts 176, 177, 179, 1074, 1075
moving 465, 468, 1071, 1072
multi-bar rests 1498, 1499
octave indicators 331, 1076–1078
panel 334
popover 330, 333
position 1071
restorative 333, 334, 1085, 1099
reverting 181
showing 1075
signposts 453, 1075
size 1073
spacing 1072
spacing gaps 1070
staves 177, 179
symbols 865
ties 1628
tokens 577
transposing instruments 113
transposition 331, 1074–1078
types 330

Clefs panel 332, 334
click 267, 649

count-in 268
disabling 632
enabling 632
MIDI recording 264
mixer 821, 822
playback 267, 625, 632
settings 267
sound 267, 625
volume 827

clipping 827
closing. See opening
CMYK processing 686
coda 1447

appearance 1448
barlines 1453
font 1448
gap 608, 1454, 1455, 1565
hiding 1449, 1453
indent 608, 1454, 1455, 1565
inputting 414, 415
mid-system gap 1447, 1454, 1455
multiple 1448, 1450
sections 1447
showing 1449, 1453
size 1448, 1449

codec 190
codes 576

time 1435
col legno. See playing techniques
collision avoidance

accidentals 945–947
articulations 959
bar numbers 981, 988, 1472
barlines 1049, 1110
bracketed noteheads 1264
chord symbols 1049
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collision avoidance (continued)
clefs 981, 988
counts 1472
dynamics 1105, 1107, 1110
figured bass 1140, 1151
fingerings 1158
flow headings 712
galley view 723
margins 712
notehead brackets 1269
playing techniques 1393
slurs 1507, 1508, 1517
staves 694, 695, 721, 723
text 1613
ties 1620, 1621, 1635, 1657
time signatures 1657
titles 712

colon
dynamics 311, 1114
tuplets 1678

colored regions 624, 1044, 1101, 1102, 1461, 1474, 
1475

Dynamics editor 799
exporting 687
hiding 444
MIDI CC editor 805
MIDI Pitch Bend editor 804
percussion editor 785
piano roll editor 784
Playing Techniques editor 795
printing 687
Tempo editor 810, 811
tempo track 625
Transform tool 817

colors 54
background 56, 57
bar numbers 58
bar repeats 58, 1461
breath marks 58
caesuras 58
caret 57
chord diagrams 1065, 1066
chord symbols 58, 856, 861, 1044
clefs 58
comments 58
condensed music 764
cues 1101–1103
dark theme 55
dynamics 58
edges 542
exporting 596, 676
fermatas 58
graphics 596, 676, 686
holds 58
instrument names 185, 1544
instruments 624, 784, 785
inverting 57
light theme 55
lines 58, 897, 900
lyrics 58, 1235
markers 58
monochrome 686
music symbols 865

colors (continued)
muted 639
note ranges 57, 1261
noteheads 58, 871, 1251
notes 57, 58, 639, 1101, 1103, 1705
ornaments 58
pages 55, 57, 542
pedal lines 58
piano roll editor 784, 785
Play mode 624
playhead 57
playing techniques 58, 880
rehearsal marks 58, 1429
resetting 55–58
rests 58, 1491
rhythmic grid 57
slash regions 1474, 1475
slurs 58
staff labels 185, 1544
tablature 57, 58, 1261, 1580, 1583
tempo marks 58
text 58, 389, 584, 848, 851
tracks 624, 784, 785
trills 58
tuplets 58
unison ranges 1573
voices 57, 624, 784, 785, 1704, 1705
windows 55

columns
accidentals 945, 947
clefs 177
figured bass 1139
lines 1407
markers 403
missing fonts 76
transposition 177
videos 403
voices 1706–1708

combinations
part layouts 171
playback techniques 923, 927, 935
tremolos 935

combined dynamics. See dynamics
combining. See consolidation
comma

breath marks. See breath marks
lyrics 1230
player labels 761

commands
jump bar 68, 70
key commands 63, 66
MIDI 63, 66

Comment dialog 507
comments 453, 506, 1263

adding 509, 510
authors 506, 511
bar numbers 507, 509
changing 511
colors 58
deleting 459, 507
dialog 507
exporting 507, 511, 675, 687
hiding 512
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comments (continued)
initials 506, 511
instruments 507
list 507
panel 507
printing 511, 671, 687
replying 510
showing 512

common practice
accidental duration rule 951
cancellation naturals 1214

common practice accidental duration rule 952
common time. See time signatures
components

accidentals 908
articulations 956
chord diagrams 1057
chord symbols 320, 856, 861, 1037
line annotations 897
lines 1404
music symbols 897
noteheads 869, 871
playing technique continuation lines 1395
playing techniques 880
tempo marks 1589, 1594

composer 72, 78
adding 78
first pages 532, 1188
flow headings 554, 555, 558
fonts 848
tokens 578

compound figured bass intervals 395, 397, 1154
compound time signatures 1641

beam grouping 998, 1475
inputting 285, 287, 288, 290
note grouping 1021, 1475
rhythm slashes 1473, 1475

compressed MusicXML 88
Compressor 825, 829
con sordino. See playing techniques
concave beams 1005
concert band. See bands. See also project templates
concert pitch 174

clefs 331, 1074–1076, 1099
cues 1099
exporting 675
filters 434
input pitch 228
instrument transpositions 1536
layouts 169, 173, 577, 671, 675, 1191
printing 671
staff labels 1531, 1536
status display 42
tokens 577, 1191
viewing 173

concertina dragging 726
concertos

cadenzas 455, 456, 1641
movements. See flows
soloists 128

condensing 469, 694–696, 743, 744, 753, 1567
breath marks 747
calculations 747, 750

condensing (continued)
changing 744, 752, 753, 755, 757, 758
colors 764
default settings 744, 750, 759
deleting changes 759
dialog 755
disabling 710
divisi 710, 757, 1546
enabling 710
erased backgrounds 763
excluding groups 753
extra staves 747, 1552
filter 433
fonts 760, 848, 1544, 1546
groups. See condensing groups
hiding player labels 761
including groups 753
labels. See player labels
lines 744
manual 757
ossia staves 747, 1556
paragraph styles 760, 1544, 1546
percussion. See percussion kits
periods 761
phrases 747, 750, 753, 755
player labels. See player labels
resetting 755, 758
rests 744, 747, 755
results 750, 753
selecting signposts 433
signposts 453
staff labels 744, 755, 1540, 1544, 1546, 1548
to indications 762
trills 744, 755
unisons 750, 760, 762
voices 747, 750

Condensing Change dialog 755
condensing groups 751

calculations 747
changing settings 753, 755, 757
creating 752
default settings 744
excluding 753
including 753
manual condensing 757

conditions
expression maps 919, 927

conductor score. See condensing. See also layouts
configurations

accidentals 947, 951, 1211
endpoints 659, 661–663
Key Editor 781, 818, 819
key signatures 1211
playback 61, 651

connecting. See linking
consolidation 743

bar repeats 1496
bars 459
flows 82
notes 254, 477, 1706
part layouts 171
players 163, 171, 743
rests 837, 1489, 1490, 1495, 1496
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consolidation (continued)
rhythm dots 1258, 1259
staff labels 158, 159, 1532, 1539, 1540, 1545, 1546
staves. See condensing
stems 155, 1701–1704
voices 155, 477, 743, 1258, 1701–1704, 1706–1709

constant points 807, 810
inputting 800, 806, 811

constraints
defining 591
flow headings 555
frames 590

contents
bars 964
cues 1092, 1093, 1095
front matter 1188
lines 1395, 1404
playing techniques 1395
repeat markers 1448, 1449
table 1188
tempo marks 1589, 1593, 1595, 1599

continuation caps 1404
editing 894

continuation lines 884, 888, 1393, 1402
angles 1369
appearance 877
caps 1398
custom playing techniques 882
default settings 877
duration 1394
dynamics 1104, 1109, 1120, 1122, 1123
figured bass 1144
hiding 1601
inputting 369, 373, 375
octave lines 1080
pedal lines 1367, 1369, 1377, 1380–1382, 1384, 
1385
playing techniques 1393, 1396–1400
slurs across breaks 1507
tempo marks 1592, 1600–1602
thickness 1382, 1603

continuation signs 1383
lines 1404
parentheses 1382
playing technique continuation lines 1395
text 1384

continuous
bar counts 1462, 1469
beams across staves 1009
controller 925
hairpins 1123
rehearsal marks 1426
view 43, 53, 773, 784, 785

contrabass. See instruments
contracting. See expanding
contrapuntal. See counterpoint
contrary motion 476
control change actions 918, 925
control points

handles 1509, 1529, 1637
slurs 1522
ties 1632, 1637

controllers
expression maps 912
MIDI. See MIDI controllers

conventions
accidentals 942, 951, 1211, 1219
arpeggio signs 1313
breath marks 1205
caesuras 1206
cues 1085
dynamics 1105
ensembles 80
fermatas 1205
fingerings 1158
grace notes 1194
harp pedaling 1364
key signatures 1211, 1214
lyrics 1229
ornaments 1293
pauses 1205
pedal lines 1374
playing techniques 1392
rehearsal marks 1425
rests 1487
tempo marks 1591
tremolos 1661
trills 1293
voices 1707

converting
grace notes into normal notes 1196
layouts to graphics files 675
notes into grace notes 1195
notes into tuplets 1671
PDF 675
tuplets into normal notes 1672

copies
printing multiple 671

Copy Staff Spacing dialog 728
copying 459, 461–463

articulations 955
barlines 167
beams 1012
chord diagram shapes 1064
Chord mode 254
chord symbols 430, 1039–1041
divisi 1572
dynamics 461, 464, 782, 803, 1133
exploding 470–472, 476
flows 82, 167
frames 527, 530, 532, 537, 541, 549, 566
Insert mode 454
instruments 126
layouts 174
lyrics 1225
MIDI 464, 782, 809
notes 461–463, 791, 955, 1012
notes into voices 462
page formatting 541, 766
page templates 527, 530, 532, 537, 541, 549
part formatting 765
pitches 493, 502
players 126
playing techniques 1396
points 782
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copying (continued)
properties 768
reducing 469
slurs 464, 955
staff spacing 727
staves 1572
system objects 430, 1564
tempo marks 461, 782
tremolos 1012

copyright 78
adding 78
first pages 532
fonts 848
tokens 578

cor anglais. See instruments
corners

accidental cut-outs 908
beaming 1013
crop marks 687
octave lines 1080, 1081

count-in
duration 268
metronome click 268

counterpart layout 46
counterpoint 247

bar rests 247, 1495
MIDI import 93
MIDI recording 263, 264
voices 231, 1704

counts 1461
alignment 1472
bar numbers 984, 994, 995, 1643
bar repeats 1460–1464
barlines 1456
bars 420, 1461, 1467, 1468, 1470, 1480, 1497, 1498
frames 1435
gaps 1460, 1468, 1472, 1473
hiding 1456, 1464, 1470, 1482
language 1458
lyrics 1238
moving 609, 1456, 1471, 1482
multi-bar rests 1496–1498, 1500
numbered bar regions 420, 1468–1470
page numbers 580
pick-up bars 1643
placement 1471, 1482
ranges 984, 1468, 1470
repeats 641, 994, 1441, 1456
rests 1497, 1498
rhythm slashes 1473, 1480–1482
staff-relative placement 1471, 1482
tacet al fine 1497
timecodes 1435

couplers 876
courtesy accidentals. See cautionary accidentals
cowbell. See unpitched percussion. See also playing 
technique-specific noteheads
crash cymbals. See unpitched percussion
creating. See inputting
crescendo. See gradual dynamics
crop marks 687

exporting 675
printing 671

cross noteheads 1248, 1252
dead notes 1344
percussion 1683, 1686, 1687

cross stick. See unpitched percussion. See also playing 
technique-specific noteheads
cross-staff

arpeggio signs 349, 350
beams 1009–1012
fingerings 1158
lines 385, 387
resetting 1012
slurs 273, 436, 465, 468, 1508, 1516
spacing 1010
stems 1009, 1012
ties 248, 1629
tremolos 1009, 1012

cross-voice
arpeggio signs 349, 350
lines 385, 387
slurs 273, 436, 465, 468, 1516
ties 248, 1629

crosshairs 612
crossing pitches 744. See also condensing
crotchets. See quarter notes
crushed notes. See grace notes
Cubase

expression maps 912, 929
instrument names 1532
staff labels 1532

cue labels 1093
changing 1094
contents 1093
moving 609
octave transpositions 1086, 1091
staff-relative placement 441
text 1093

cues 1085
appearance 1092
articulations 1095
bar rests 837, 1099, 1490
changing to rhythmic cues 1087
clefs 1086, 1099, 1100
contents 1092
default settings 1086
deleting 459
dynamics 1095
engraving options 1086
fermatas 1095
filter 433
galley view 1089
hiding 1089, 1090
highlights 1101–1103
inputting 421, 423, 425
instrument names 1093
instrument transpositions 1093
instruments 422
labels. See cue labels
length 436
lines 1095
lyrics 1095
moving 465, 468, 609, 1087, 1088
multiple 1096
notations included 1095
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cues (continued)
octave lines 1090
ornaments 1095
overlapping 1096
page view 1089
panel 423, 425, 1102
placement 1092
playing techniques 1095
popover 421, 422
position 1087, 1088
register 1090
respelling notes 1092
rests 837, 1098
rhythmic. See rhythmic cues
showing 1089, 1090
signposts 453, 1085, 1089, 1101–1103
size 1086
slurs 1095
spacing 599, 602
staff position 1088
staves 718
stem direction 1096, 1097
suggestions 423, 1102
text 1095
ties 1097
transposing 1093
unpitched instruments 1086
vertical position 1086, 1087
viewing options 1101–1103
voices 1096

Cues panel 423, 1102
cup mute. See playing techniques
curlew fermata. See fermatas
curly quotes 579
cursor

caret 215
chord symbols 325
figured bass 400
fingerings 274
lyrics 394, 1237
text 576, 583

curvature direction
grace notes 1504
guitar bends 441
guitar pre-bends 1331
notehead brackets 1269, 1270
slurs 1503, 1504, 1514, 1515, 1528
ties 1621, 1626, 1635

curve
dynamics 1137

curved arpeggio signs 1311
duration 1314, 1316
inputting 344
playback 1314–1316
popover 344

custom
accidentals 902, 904, 907
barline joins 977–979
brace grouping 1030
bracket grouping 1030
chord diagrams 1065
chord symbols 856, 857, 859, 861, 864, 1038
condensing 751, 752, 755, 757

custom (continued)
endpoint configurations 661, 662
ensembles 115, 130
flow headings 556, 557
key commands 63, 66, 70
key signatures 902, 905, 910, 911
layouts 122
lines. See custom lines
markers 402, 1432
note sizes 440
noteheads. See custom notehead sets
octave divisions 907
page size 683
page templates 532, 535, 536
paper size 683
percussion techniques 1683, 1685–1687
playback templates 651, 654, 657
player order 127
playing techniques. See custom playing techniques
project templates 81
repeat endings 1443
repeat markers 1451
rhythmic feels 646, 647
score layouts. See layouts
staff grouping 1030
staff order 127
staff size 719
symbols 865
tempo text 1593
tonality systems. See custom tonality systems
trill speeds 1308
tuning 142, 144, 145, 854, 1058, 1060

Custom Centered Beam dialog 1008
custom lines 884

annotations 886, 894, 897
bodies 891
creating 884, 886, 887
editing 888, 900
inputting 385, 387
repeatable symbols 887, 899, 900
saving as default 884, 888

custom notehead sets 868
appearance 871
creating 874, 875
design 869, 871
editing 869, 871
exporting 831, 869
importing 831, 869
percussion 1683, 1685–1687

custom playing techniques 876, 877
creating 882
design 880
editing 880
exporting 831, 883
importing 831, 883
inputting 373, 375
percussion 1683, 1685–1687
playback 936
saving as default 883

custom score layouts. See layouts
Custom Staff Size dialog 719
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custom text 1606
condensing 762
divisi 1578
dynamics 1116
instrument changes 136
markers 403, 1432
percussion legends 1700
player labels 762
repeat endings 1443
repeat markers 1451
repeats 1456

custom tonality systems 902, 904, 907, 908
accidentals 904, 907, 908
creating 902
editing 902, 905
exporting 831, 1221
importing 831, 1221
key signatures 905, 910, 911
octave divisions 907
panel 280
playback 912

cut common time. See time signatures
cutting

bars 962–964
beats 455, 962
notes 261
selections 461, 506, 962–964
slash regions 1479
tie chains 261, 1631

D
da capo

al coda 1447
al fine 1447
al segno 1447
font 1448
hiding 1453
inputting 414, 415
showing 1453
size 1448
word wrapping 1451

dal segno 1447
hiding 1453
showing 1453

damping. See playing techniques
dangling ties. See laissez vibrer ties
dark theme 55, 57
dashed

barlines 285, 304, 308, 309, 968, 970–972, 1560, 
1641. See also aggregate time signatures
figured bass 1144
guitar bend hold lines 1330, 1331
hairpins 1122
jazz articulations 1351
lines. See dashed lines
lyrics 392, 394, 1240
octave lines 1079
pedal continuation lines 1381
pedal lines 1380
slurs 1510, 1512
staff labels 1538
string indicator lines 1183, 1394

dashed (continued)
tempo marks 1600, 1602
ties 1622, 1624, 1625
vibrato bar lines 364, 365, 1339

dashed lines 609
attachment 465, 609
between staves 449
crosshairs 612
lines 385, 886, 888, 891, 1402
octave lines 1079
tempo marks 1600, 1602

data
expression maps 913
library 831

date and time 
annotations 687
auto-saved projects 107
comments 506
exporting 675
language 61
printing 671
tokens 61, 580

deactivating
caret 219
chord input 251
chord symbol input 326
Insert mode 237
MIDI devices 326
mouse input 229
muted tracks 639, 821, 822
note input 221, 224
note respelling 246
player sorting 127
soloed tracks 639, 821, 822

dead notes 1344
decimal places

metronome marks 299, 301, 1596, 1599
decorations. See ornaments
decrescendo. See gradual dynamics
dedications 78, 1188

tokens 578
default flow headings 529, 554

replacing 556, 557
default page templates 529, 532

composer 1188
customizing 536, 541
lyricist 1188
replacing 535
title 1188
tokens 1188

default playback templates 652
default settings 21, 30, 61, 769, 831, 834, 837, 839, 
840, 842

accidentals 228, 942
articulations 228
barlines 970, 971
beam grouping 837, 1002
chord diagrams 1057, 1058
chord symbols 1037–1039
condensing 744, 755
dialogs 30
dynamics 464
exporting 81, 831, 834
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default settings (continued)
figured bass 401, 1140
file names 678
flow headings 554
flows 837
font styles 853
hand tool 43
importing 831, 833
instrument names 60, 184, 185, 188
jazz articulations 1350
key commands 29, 63, 66
layouts 176, 732, 834
library 831
lines 888
marquee tool 43
MIDI 464
mouse input 213
note grouping 837
note input options 228, 839
note spacing 599, 600
noteheads 1253
overlapping notes 837
playback 651, 656, 827, 842
player labels 761
playing techniques 1393
project templates 80, 81
repeat counts 1458
resetting 831, 834, 837, 839, 840, 842
rhythm dots 228
selection tools 43
sharing 831
slurs 464
staff grouping 1026
staff labels 60, 184, 185, 188
staff spacing 694, 721
swing playback 647
tablature strings 221, 224
text 851, 853, 1613
voice order 837
volume 827

delay
glissando line playback 1322
inserts 825, 829

deleting 459, 513
accidentals 943, 1214
articulations 955
auto-saved projects 106, 107
bar number changes 992
barline joins 979
barlines 977–980
bars 302, 455, 962–964
beams 1001
beats 303, 455, 962, 964
borders 585, 848, 1192, 1614
braces 1030, 1034, 1035
brackets 943, 952, 1030, 1034, 1035, 1051, 1052, 
1110, 1143, 1147, 1265
capos 149, 151
centered beams 1009
chord symbols 1040
clef overrides 181
comments 507
condensing changes 759

deleting (continued)
counts 1456, 1498
duplicate notes 469
dynamics 783
editors 781
effects 830
empty pages 28
endpoints 661, 663
extra staves 1552
fermatas 1207
files 72
fingering slides 1177
fingerings 1165
flow heading changes 553
flow headings 541, 550, 560, 707
flow numbers 555, 558
flows 169, 172
frame breaks 732, 739
frames 550, 567, 707
gaps between notes 259
grace notes 1196
graphic slices 598
groups from percussion kits 160
guitar post-bends 1333
guitar pre-bends 1333
guitar techniques 1347
indents 1566
Insert mode 454
inserts 830
instrument filters 453
instrument names 1532
instrument transpositions 185, 1537
instruments 129, 141, 162
jazz articulations 1352
jump bar aliases 71
key commands 67, 68
Key Editor configurations 819
layouts 176
markers 403
MIDI points 783
multi-bar rest counts 1498
niente markings 1130
note spacing changes 604, 607
notehead brackets 1265
notes 455, 792, 962, 1257, 1262
ossia staves 1552
overlapping notes 259
page number changes 548
page template changes 550
page template overrides 545
page template sets 532
page templates 540
pages 545, 704
parentheses 943, 952, 1051, 1052, 1110, 1143, 
1147, 1265
pedal level changes 1373
pedal lines 1373
pick-up bars 455
pitch mappings 494
playback overrides 794
playback techniques 929, 937
players 129, 164, 165, 167, 171
project templates 82
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deleting (continued)
projects 72
reducing 469
rests 259, 962, 1493, 1494
retakes 1373
rhythm dots 1257–1259, 1262
rhythmic feel change 646
running header 541
scoops 1347
staff labels 1532
staff spacing changes 726
staves 696, 697, 1551, 1552, 1555
stem direction changes 1278
stemlets 1018
stop positions 458
string indicators 1186
strings 142
system breaks 732, 736
system indents 1566
tapping 1347
templates 82, 540, 819
tempo marks 783
ties 1021, 1630, 1631
time 454, 455, 962–964
titles 541, 550, 707
transposition overrides 181
tre corde 1385
tremolos 1664
trill intervals 1302
tuplets 1672
unison notes 469
velocity changes 798
videos 194
voices 1710

delta 814, 815, 817
demo projects 72
denominators

styles 1647, 1649
time signatures 1639, 1640

dense chords
accidental stacking 946

depressed keys 207
depth

audio 828
nested slurs 1517
nested tuplets 1670

deselecting. See selecting
design

arrows 886, 891, 894, 1397, 1398, 1402, 1414
fingerings 865, 1164
grace note slashes 1197
guitar bends 1330
line annotations 894, 897
lines 877, 884, 886–888, 891, 899, 900, 1397, 1398, 
1402, 1413, 1414
music symbols 865, 897
noteheads 868, 869, 871, 874, 875, 1247, 
1251–1253
playing techniques 877, 880
rhythm slashes 1473
slurs 1510, 1513
stem flags 865, 1273
symbols 887, 899, 900

design (continued)
time signatures 1656
wedges 891

designation
strings. See string indicators

destination
exporting files 597, 677
instruments 1085
notes 493–496, 503, 1176

détaché. See playing techniques. See also articulations
detecting

grace notes 98
inversions 327
strings 383
tuplets 98

detuned fretted instruments 146, 149, 150
devices

audio 61, 268–270, 635
diagonal

accidental stacking 945
chord symbols 1037, 1038, 1048
lines 385, 1019, 1317, 1348

diagrams
chords. See chord diagrams
harp pedaling. See harp pedaling. See also harp 
pedal diagrams

dialogs 30
diamond noteheads 1248, 1250, 1252, 1387

accidentals 1285
harmonics 1283, 1286, 1288, 1289
percussion 1683, 1686, 1687

diddle 221, 259, 1659, 1669
playback 1667

dimensions
page size 683
paper size 683

diminished. See augmented. See also intervals
diminuendo. See gradual dynamics
dips 1339

gaps 1343
hiding 1345
inputting 363, 364
intervals 1344
moving 609
popover 344
position 1343
showing 1345
tablature 1345

direction
arpeggio signs 1311, 1312
audio. See panning
beams 1003, 1004, 1013
fanned beams 1019, 1020
glissando lines 1255
grace notes 1195
gradual dynamics 1120, 1127–1129
guitar bends 441
guitar pre-bends 1331
hairpins 1120, 1127–1129
lines 1415
notes on middle line 1276
notes on single line 1689
panning 828
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direction (continued)
paper orientation 683
partial beams 1013
playback techniques 937
rhythm slashes 1476
slur curvature 1514, 1515
stems 1274, 1276–1278, 1689
string shift indicators 1182, 1255
tie curvature 1621, 1626
transposing 480, 481

disabling. See enabling. See also deactivating
disclosure arrows 45

Expression Maps dialog 913
Properties panel 42

disconnecting. See unlinking
display options 32, 43

date 580
frames 540, 555, 569, 689
image resolution 685
Key Editor 773
language 59
layouts 36
music area 37, 44, 53
pages 689
panels 40, 47
percussion editor 785
piano roll 773, 784
playback 651
print preview 39
project window 36
tabs 48
time 35, 580, 651
transport 35
zones 40

distance
bar numbers 988, 1472
beams 1005, 1016, 1017
braces 1027
brackets 1027, 1029
breath marks 1205
chord diagrams 1060
counts 1472
cues 1087
fermatas 1205
flow headings 713
guitar techniques 1343
margins 692, 712, 713, 715
noteheads 1010
page edges 692, 715
percussion 1689
rehearsal mark enclosures 1425
staff labels 1532, 1534
staves. See staff spacing
stems 1010
system indents 1534, 1566
text borders 587, 848, 1616

Distortion 825, 829
distribution

bars per system 729
beats in bars 1021
divisions per octave 907
dynamics 1122
staves per frame 695

distribution (continued)
systems per frame 729
values 813
velocity 813

dives 1323, 1328, 1339
handles 1335, 1337
inputting 357–360
moving 609
popover 344
pre-dives. See guitar pre-bends
vibrato bar. See vibrato bar. See also guitar bends

divide arrows 1562, 1574
dividers. See system dividers
dividing. See splitting
divisi 743, 1567

arrows 1574
brackets 1025, 1026, 1028, 1029, 1402, 1567
change labels 1577–1579
changing 1568
colors 1573
condensing 710, 743, 757, 1546, 1548, 1567
cues 421
dialog 1568
editing 1571
ending 1572
fonts 1544, 1574, 1575, 1577
groups 1548, 1570, 1571, 1575
hiding empty staves 696–698
hiding labels 1576, 1579
hiding staff labels 1532
inputting 1568, 1570
inputting notes 1572
lengthening 465, 468
moving 465, 468
paragraph styles 1544, 1574, 1577
playback 636, 637, 664, 1579
shortening 465, 468
signposts 453
staff labels 1532, 1546, 1548, 1568, 1574–1576, 
1579
staff size 718
staff spacing 695
staves 696–698, 1570, 1572
text 1578
tutti 1572
unison labels 762, 1577
unison ranges 1572, 1573
vocal staves 1574

divisions of the octave. See octave divisions. See also 
EDO
DJ-EQ 825, 829
djembe. See unpitched percussion
do

French staff labels 60
doits. See jazz articulations
dolce. See dynamic modifiers
dorian

chord symbols 323, 503, 1046
scales 495, 496

DoricoBeep 267, 617, 625
sound 625

Index
 

1747
Dorico Pro 4.3.30



dots
accordion registers 876
barlines. See repeat barlines
chord diagrams 854, 1056, 1057, 1065, 1066
guitar tapping 1340, 1343
Keyboard panel 207
rhythm. See rhythm dots. See also dotted notes
staff labels 1535

dotted
beat units 297
dynamics 1104
hairpins 1122
lines. See dotted lines
noteheads 1250
notes. See dotted notes
octave lines 1079
rests 197, 837
slurs 1510, 1512
tempo marks 1600, 1602
ties 1622, 1624, 1625
tremolos 415, 417

dotted lines 609
attachment 465, 609
crosshairs 612
lines 1402
octave lines 1079
stop positions 458
tempo marks 1600, 1602

dotted notes 229, 1021
consolidation 1258, 1259, 1706
double 229
forcing 262
inputting 197, 229
moving dots 1260
note grouping 26, 1021, 1475
rhythm slashes 1475
swing playback 643
tempo equations 1604
tremolos 415, 417
triple 229
voices 1706

double 772
accidentals 326, 481, 484, 485, 487, 953
barlines 304, 308, 309, 967, 968, 970–972, 1453
cadence. See ornaments
dotted notes 26, 229, 1021
lines 891
note durations 259
octaves 476, 498
pitches 476
slashes 1562, 1659
stems 948, 1704. See also voices
values 772
whole notes 17, 201, 221, 224, 231, 235, 237, 238, 
242, 251, 259, 261

doubling instruments 124
adding 138
inputting notes 221, 224
instrument changes 134–136
labels 1539
moving 141
showing staves 53

down arpeggio signs. See arpeggio signs

down bow. See playing techniques
down-stem voices. See voices
downloads 72
dpi 685
draft staves. See sketch staves
dragging 43, 447, 781. See also drawing
drags. See grace notes
drawing 43, 447, 775, 781

crosshairs 612
dynamics 800
marquee selections 781, 818
MIDI 806
notes 786. See also note input
tempo 625, 810
velocity 797

drop frame timecodes 1435
drops. See jazz articulations
drum editor. See percussion editor
drum kits. See percussion kits. See also drum sets
Drum Pads panel 210

key commands 47
drum rolls. See tremolos
drum sets 155, 1682, 1690

caret 238
defining kits as 158
exporting 1691
filtering instruments 155
importing 1691
inputting notes 238, 787
laissez vibrer ties 1629
naming 155
note input 240
setting up 155, 240
stem direction 158
voices 158, 1701

dry
reverb 830

DualFilter 825, 829
duplets. See tuplets
duplex printing 671, 682

booklets 681
duplicating

character styles 852
copying. See copying
dynamics 461, 803
exploding 470
expression maps 926
flow headings 530, 531
flows 167
frames 566
items 461–463
layouts 174
MIDI 782, 809
noteheads 874, 875
notes 461–463, 791
page templates 529–531, 535, 537
paragraph styles 850
percussion maps 933
pitches 493, 502
playback templates 657
players 126
playing techniques 877, 882, 1396
points 782, 803, 809
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duplicating (continued)
rehearsal marks 1564
repeat endings 1564
switches 927
tempo marks 461, 782, 1564

duration 17, 436, 1394, 1487
accidentals 951, 952
arpeggio signs 1314, 1316
articulations 954, 961
audio 103, 104
bars 27, 455, 962
changing 259, 262, 436
count-in for MIDI recording 268
fermatas 439
figured bass 436, 1144, 1145, 1150
flows 579, 635, 962–964
forcing 262
grace notes 1201
horizontal lines 1410
jazz articulations 1351
lines. See duration lines
locking 483
notated 793
notes 27, 201, 259, 261, 786, 787, 789, 793
pedal lines 1385
percussion 787
played 793
playing techniques 369, 373, 375, 436, 1394, 1400
pre-roll 635
repeat endings 1442
rests 259, 262, 1487
slurs 1530
terminology 17
tremolos 1667
vibrato bar lines 1339

duration before pitch note input 221
duration lines 1393, 1402

appearance 877, 1397
default settings 877
figured bass 1144, 1145, 1150
handles 1392, 1394
hiding 436, 1394, 1396, 1397
inputting 369, 373, 375
playing techniques 882, 1394, 1399
showing 436, 1394, 1396, 1397
string indicators 381, 382, 1183, 1393

dyads. See chords. See also chord symbols
dynamic curve 1137
dynamic glyphs 1104

font styles 1136
dynamic levels 310, 311, 313, 314, 316, 1112, 1137

changing 801, 1112
decreasing 1112
increasing 1112
playback 799, 1137

dynamic modifiers 1104, 1116, 1587, 1600
appearance 1105, 1118
centered 1118
font styles 1136
hairpins 1118
inputting 311, 313, 314, 316, 1117
poco a poco 1126

dynamic modifiers (continued)
showing 1113
subito 1118

dynamics 1104
alignment 1105–1108, 1132, 1133, 1135
appearance 1105, 1115
backgrounds 1110, 1281
bar repeats 1460
barlines 1107–1110
brackets 1110
changing 439, 801, 1112
colors 58
combined 1104
continuation lines 1104, 1120
continuous hairpins 1123
conventions 1105
copying 461, 464, 782, 803, 1133
crescendo. See gradual dynamics
crosshairs 612
cues 1095
default settings 1105
deleting 459
diminuendo. See gradual dynamics
dynamic curve 1137
editing 1112
editor. See Dynamics editor. See also Velocity 
editor
endpoint positions 1108
engraving options 1105
erased backgrounds 1110, 1111, 1281
expression maps 920
expressive text. See dynamic modifiers
filters 433
flared hairpins 1124, 1125
font styles 1136
force 1104
formatting 865
gradual. See gradual dynamics
grand staff instruments 314, 316, 1115
grouping 1132, 1133
hairpins. See gradual dynamics
handles 436, 1120, 1121, 1127, 1128
hiding 1095, 1113–1115, 1118
humanize 799, 1137
hyphens 311, 1114, 1122
immediate 1104
inputting 310, 311, 313, 314, 316, 800, 803
intensity 439, 801, 1112
length 436, 609, 801, 1121
levels. See dynamic levels
linking 464, 1133, 1135
lyrics 1105
messa di voce. See messa di voce
modifiers. See dynamic modifiers
moving 465, 468, 489, 491, 609, 801, 1105, 1108, 
1118, 1121, 1128, 1132, 1133, 1135
muting in playback 435, 639
niente. See niente
non-sustaining instruments 1136
overriding 800, 803
padding 1111, 1281
panel 316
parentheses 1110
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dynamics (continued)
percussion kits 1694
placement 1105
playback 435, 636, 637, 640, 799, 805, 920, 936, 
937, 1115, 1136, 1137
poco a poco 1118, 1126
popover 311, 314
position 1105, 1106
repeats 640
reversing 489. See also retrograde
rfz 1115
rotating 491
selecting 427, 433
separators 311, 1114
sfz 1115
showing 1095, 1113
signposts 453, 1113
size 440, 1136
spacing 1126
staff-relative placement 441
subito 1118
sustaining instruments 1136
swells. See messa di voce
symbols 865
tempo marks 1593
text 1122, 1136
ties 314, 316, 465, 1105
tracks. See Dynamics editor. See also Velocity 
editor
types 311, 1104
ungrouping 1133
unlinking 464, 1135
velocity 796, 797, 1112, 1137
voice-specific 314, 316, 799, 800, 1115
volume 1112, 1136, 1137

Dynamics editor 310, 796, 799, 1104, 1133
adding 781
closing 781
copying points 782
deleting points 783
height 779
hiding 799
inputting points 800
moving points 801
selecting points 781
showing 799

dynamics lanes. See Dynamics editor
Dynamics panel 313, 316

E
East Asian elision slurs 1244
edges

colors. See page format changes
frames 554, 560, 564, 565, 585, 590
margins 712
pages 542, 712

Edit Accidental dialog 908
Edit Chord Diagram dialog 1066
Edit Chord Diagrams dialog 854
Edit Chord Symbol Appearance dialog 859
Edit Chord Symbol Component dialog 861
Edit Custom Condensing Group dialog 752

Edit Custom Key Signature dialog 911
Edit Endpoint Configurations dialog 663
Edit Font Styles dialog 846
Edit Instrument Names dialog 185
Edit Line Annotation dialog 897
Edit Line Annotations dialog 894
Edit Line Bodies dialog 891
Edit Lines dialog 888
Edit Music Symbol dialog 865
Edit Notehead dialog 871
Edit Notehead Sets dialog 869
Edit Percussion Kit dialog 155
Edit Playback Techniques dialog 937
Edit Playing Technique dialog 880
Edit Playing Techniques dialog 877
Edit Repeatable Symbol dialog 900
Edit Tonality System dialog 905
editing 212, 436, 439

area 155, 1694
flow headings 558
handles 611
inputting vs. editing 212
items 439, 611, 769
lyric text 1237–1239
mouse input 213
moving. See moving
note durations 259, 436
notes 197
page templates 541
rhythmic grid 214

editorial
accidentals 945
chord symbols 1050–1052
dynamics 1110
figured bass 1143, 1147
fingerings 1158
notes 1263, 1265
slurs 1510
ties 1622

editors 773
adding 781, 819
closing 781
configurations 818, 819
drum. See percussion editor
dynamics. See Dynamics editor
flow headings 555
histogram. See Histogram tool
Key Editor. See Key Editor
MIDI CC. See MIDI CC editor. See also MIDI Pitch 
Bend editor
page templates 540
percussion. See percussion editor
piano roll. See piano roll editor
pitch bends. See MIDI Pitch Bend editor. See also 
MIDI CC editor
playing techniques. See Playing Techniques editor
saving 818, 819
scrolling 780
templates 818, 819
tempo. See Tempo editor
text 389, 584
velocity. See Velocity editor

EDO 907, 1219
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effects channels 823–825
mixer 821, 822
reverb 830
volume 827

eighth notes 17, 201, 221, 224, 235, 237, 259
beaming 999
beats 303
chords 251
grace notes 250
metronome marks 296
percussion 238, 787
playback 842, 920
rests 246, 1487
splitting notes 261
swing playback 297, 643, 646, 647
tablature 242
tempo equations 1604
tremolos 415, 417, 1659
tuplets 254, 257
voices 231

elbowed beams. See centered beams
electric guitar. See fretted instruments
elision slurs 1244

inputting 392, 394
size 1222, 1244
width 1229

ellipse
chord enclosures 1584
note enclosures 1584, 1585

empty bars
cues 1098
deleting 964
inputting 305, 306
multi-bar rests 1496
rests. See bar rests
showing 1496
width 965

empty pages 704
deleting 28, 545, 704, 1607
inserting 702, 703
staff spacing changes 723

empty staves 696
after flows 699
frames 570, 700, 701
hiding 696–698, 721, 1555
showing 696–698, 721, 1555
system dividers 1562
tacets 739

empty voices 1710
enabling 219

auto-save 108
channel effects 825, 829
chord symbol input 326
chord symbol playback 627, 628
click during playback 632
condensing 710, 753
dynamics linking 464
EQ 825
independent voice playback 636, 637
inserts 829
instrument changes 134
instrument filters 452
MIDI copying 464

enabling (continued)
MIDI devices 271, 326
MIDI import 92
MIDI thru 263
partial harp pedaling 1365
player labels 761
plug-ins 636
sampled trills in playback 1307
slur collision avoidance 1508
slurs linking 464
swing playback 297, 644–646
system track 431
text collision avoidance 1613
tracks 92
VST instruments 636

enclosures
bar numbers 982
fingerings 1164
layout names 1192
line annotations 894
line thickness 982, 1425
lines 1420
padding values 982, 1425
rehearsal marks 1424, 1425
string indicators 1185
tablature 1581, 1584, 1585
text 848, 894, 1420, 1614–1616

end barlines 971, 972
end repeat barlines 304, 968, 970

counts. See repeat counts
inputting 302, 305, 308, 309
playthroughs 640, 641, 1456
repeat endings 1440

endings
additional 411, 413
arpeggio signs 1311, 1312
playthroughs 1441
repeat. See repeat endings

endpoint positions
arpeggio signs 1313
dynamics 1108
lines 1405, 1410, 1412
octave lines 1082
pedal lines 1374
repeat endings 1444
slurs 959, 1503, 1505, 1507, 1522, 1524
staff lines 1505
ties 1621, 1632, 1635
trills 1294, 1297
tuplet brackets 1676

Endpoint Setup dialog 659
endpoints 659

changing 664, 665
configurations 661, 662
custom 663
deleting 663
expression maps 659, 665
glissando lines 1317, 1318, 1321
instruments 664
moving 436, 465, 609
notehead brackets 1270
percussion maps 659, 665
plug-ins 651
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endpoints (continued)
renaming 663
saving 663
setup 659
voices 664

Engrave mode 22, 513
casting off 728
Engraving Options dialog 840
frame breaks 736
frame chains 569
frames 560
graphics frames 589
make into frame 738
make into system 734
moving items 609
music frames 568
note spacing 599
page breaks. See frame breaks
page formatting 689
panels 40, 513, 516, 519, 522, 769
playhead 632
selecting items 514
signposts 453
staff spacing 720
switching 513
system breaks 733
text editor 584
text frames 575
toolbox 514

engraving options 30, 840
accidentals 942
advanced options 45
arpeggio signs 1310
articulations 955
bar numbers 981
bar repeats 1460
barlines 967, 1560
bracketed noteheads 1264
breath marks 1203
caesuras 1203
chord symbols 1037, 1038
cues 1086
dialog 840
dynamics 1105
exporting 80, 81, 831
fermatas 1203
figured bass 1140
fingerings 1158
glissando lines 1318
guitar bends 1330
holds 1203
jazz articulations 1350
key signatures 1211
ledger lines 1246
lines 1405
lyrics 1222
markers 1430, 1437
music fonts 844
notes 1246, 1273
numbered bar regions 1468
octave lines 1080
ornaments 1291
ossia staves 1560

engraving options (continued)
pauses 1203
pedal lines 1368
percussion 1696
playing techniques 1388
project templates 80, 81
rehearsal marks 1424
repeat endings 1440
repeat markers 1448
rests 1491
rhythm slashes 1473
saving as default 840
searching 840
slurs 1503
staff labels 1532
stems 1246, 1273, 1581
tablature 1581
tempo marks 1588
text 388
ties 1621
time signatures 1640
timecodes 1437
tremolos 1660
trills 1291
tuplets 1669

Engraving Options dialog 840
engraving tools. See properties. See also default 
settings
enharmonic spelling

accidentals 245, 246, 484, 485, 487
chord symbols 146, 1037, 1038, 1045, 1046
key signatures 1217, 1218
MIDI 89, 246, 263
modes 1046
notes 245, 246, 484, 485, 487
pitch mappings 493, 494, 503
respelling 207, 246, 484, 485, 487

ensemble picker 115
ensembles 111, 129

adding 115, 130
brackets 1025, 1026, 1542
custom 115, 118, 130
divisi 1567, 1568
filters 450
groups. See player groups
language 115
saving 118, 130
staff grouping 1026, 1542
templates 74, 80

envelopes
dynamics 799, 801

EnvelopeShaper 825, 829
equal division of the octave 1219
equalization 825

changing 829
equations

tempo marks 297, 1604
erased backgrounds 1617

bar numbers 982
bar repeats 1459
chord symbols 1037, 1038, 1049, 1050
dynamics 1110, 1111
fingerings 1173
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erased backgrounds (continued)
hairpins 1281
harp pedaling 1363
lines 888, 894, 1421, 1422
padding 848, 1050, 1111, 1281, 1363, 1390, 1422, 
1616, 1701
percussion legends 1700, 1701
player labels 763
playing techniques 1389, 1390
staff lines 763, 1049, 1110, 1162, 1173, 1389, 1421, 
1617, 1700
stems 1281
string indicators 1183
text 848, 1422, 1616, 1617
ties 1657
time signatures 1657

erasing. See deleting
espressivo. See dynamic modifiers
even staff spacing 695
event display. See track overview
events

markers 626, 627
exchanging. See switching
excluding 122

condensing groups 753
flows from layouts 122, 172
playback 639
players 167
players from flows 122
players from layouts 122, 171
playthroughs from bar numbers 995
repeats from playback 640
tempo changes from playback 634

exclusion groups
expression maps 913

exercises. See flows
expanding 436

barlines 967, 974, 976–978, 980
bars 305, 307, 455, 456
caret 219, 235
duration 259, 436
editors 779
flow headings 712, 713
grace notes 1195, 1196
items 436
Key Editor 779
margins 692, 712, 713, 715
menus 45
notes 259, 470, 1195, 1196, 1671, 1672
options 45
pages 691
percussion grids 161
ranges 142
selections 427, 428
slurs 1503
spacing 694, 695, 712
staves 161, 694, 695, 723, 1694
strings 142
systems 694, 695, 709, 723
tick barlines 974
tuplets 1671, 1672

explicit rests 1487, 1488
colors 1491
deleting 1493
hiding 1493
implicit rests 1490
showing 1493

exploding 219, 235, 470
chord symbols 471, 472, 476
chords 235, 470, 471
Insert mode 254, 454
MIDI import 93
note input 219, 235

exponential hairpins. See flared hairpins
Export Audio dialog 104
Export File Names dialog 678
Export Flows dialog 85
Export MIDI dialog 99
Export MusicXML dialog 88
Export Tempo Track dialog 102
exporting 82, 831

annotations 687
arrangements 680
audio 103, 104
borders 687
chord symbols 831
color graphics 686
comments 507, 511, 687
crop marks 687
date 687
ensembles 80, 81, 118
expression maps 930
file names 596, 678
FLAC files 103, 104
flow headings 531
flows 84, 85, 673, 674
font styles 831, 834, 846
fretted instrument tunings 145
key commands 63
Key Editor configurations 819
layouts 675
libraries 834
lines 831, 888
lyrics 1227
MIDI 99
monochrome graphics 686
MP3 files 103, 104
MusicXML files 88, 1446
note colors 687
noteheads 831, 869
options 520, 668, 831, 834
output format 675
page ranges 673, 674, 680
page template sets 531
page templates 831, 834
paragraph styles 831, 834, 848
path 597, 677
PDF 596, 598, 675, 676
percussion kits 1691
percussion maps 935
playback templates 658
players 84
playing techniques 831, 883
PNG 596, 598, 675, 676
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exporting (continued)
project templates 81
repeats 640
settings 831, 834
signposts 687
stems 103, 104
SVG 596, 598, 675, 676
tempo tracks 102
TIFF 596, 598, 675, 676
time 687
tonality systems 831, 1221
voice colors 687
watermarks 687
WAV files 103, 104

expression maps 912, 913
actions 918, 927
conditions 919, 927
creating 926, 927, 929
dialog 913, 923
dynamics 920
endpoints 659, 661, 662, 665
exporting 930
file format 912, 930
filters 913
hiding playing techniques 1391
importing 929
MIDI 1138
mutual exclusion groups 922, 926, 929
order 913
pitch 913, 926
playback techniques 913, 923, 927
playing techniques 936, 1391
resetting 923
switches 916, 925, 927
transpose 914, 916, 920
trills 1306
volume 1138

Expression Maps dialog 913
expressive text. See dynamic modifiers
extended techniques

noteheads 868, 1247
playing techniques 876
symbols 876

extending. See expanding
extension lines

lyrics 394, 1224, 1240
trills 1295–1297

extra staves 1552
adding 1553
condensing 747, 1552
cues 421
deleting 1551, 1552
divisi. See divisi
hiding 696–698, 1555
moving 465, 468
ossia staves. See ossia staves
showing 696–698, 1555
signposts 453, 1552
ties 248
width 1555

extracts. See flows. See also graphic slices

F
F clef. See clefs
factory default playback templates 652
faders 821–823

moving 827
resetting 827

fallback
music font styles 846
playback techniques 937
playback templates 654

falls. See jazz articulations
false harmonic. See pinch harmonics
families

fonts 76, 853
instruments 92, 113, 654, 877, 1387

fanned beams 1019
angles 1020
creating 1019
direction 1019, 1020

fast-forwarding 631, 649
feathered beams. See fanned beams
feedback

comments. See comments
fermatas 1202, 1203

appearance 439
barlines 1208
changing 1206
colors 58
crosshairs 612
cues 1095
deleting 459, 1207
duration 439
hiding 1095, 1207
inputting 337, 339, 340
moving 465, 609, 1208
multiple at same position 1206
number per staff 1207
placement 1205
position 1205
showing 1095, 1207
single staves 1206
staff-relative placement 441
stems 1205
types 439, 1203, 1206
voices 1207

fifth chord diagrams 839
figured bass 1139, 1144

accidentals 399, 1140
alignment 1140
appearance 1140, 1151, 1152, 1155
brackets 397, 1140, 1143, 1147
cautionary accidentals 1153
collision avoidance 1140, 1151
crosshairs 612
default settings 1140
deleting 459
duration 436, 1144, 1145, 1150
engraving options 1140
fixing 401, 1155
font 1151–1153
gaps 1140
global 395
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figured bass (continued)
grace notes 1145, 1150
handles 436, 1144, 1148, 1150
hiding 1141
hold lines 1140, 1144
input options 401, 1140, 1155
inputting 395, 397, 400, 401
instruments 395
inverting 1149
kerning 1151
length 436, 609, 1144, 1145, 1148, 1150
local 395, 1139
moving 465, 609, 1144, 1145, 1148, 1150
navigation during input 400
octaves 1154
parentheses 397, 1140, 1143, 1147
pitches 479
placement 1148, 1149
players 395, 1141
popover 397
position 1148
resetting 1155
resolutions 395, 397, 1144, 1150
rests 395, 1139, 1142, 1151
rows 1140, 1148
showing 395, 1141
signposts 395, 453, 1139, 1141, 1151
simplifying 1154
size 1153
slashes 397, 1140
staff-relative placement 1149
staves 395
strokes 1140
suspensions 397, 1140, 1144
transposing 480, 482
vertical position 1141

file formats 685
audio 103, 104
backups 108
expression maps 912, 930
frames 589
graphic slices 592
graphics files 685
MIDI 89
MusicXML 86
PDF 685
percussion maps 935
playback templates 651
tonality systems 902
videos 190

file names 678
graphic slices 596
ingredients 678
recipes 678
setting 678
tokens 576

files 82
different Dorico versions 76
exporting 82, 596–598, 675–677
importing 82
loading into frames 589
missing fonts 76

files (continued)
opening 75
videos 192

filled noteheads 1247
films. See videos
filters 433, 449

accidentals 433, 434, 905
deselect 435
drums 155
dynamics 433
effects 825, 829, 830
ensembles 115, 130
equalization 825, 829, 830
expression maps 913
flows 573
frame chains 573, 574
frequencies 825, 829, 830
harp pedaling 433
Histogram tool 815
inserts 825, 829, 830
instruments 113, 115, 449. See also instrument 
filters
Key Editor 815
key switches 96
lyrics 433, 1227, 1228
mixer 825, 826, 829, 830
music frames 570
notes 433, 434
options 834, 837, 839, 840, 842
percussion 155
percussion maps 931
pitch 433, 434
players 574
properties 769
select 435
staves. See instrument filters
stem direction 433
tempo marks 433
voices 433, 775, 815

final barlines 304, 968, 970, 971
end of systems 972
inputting 302, 305, 308, 309, 971
number of times played 641
repeat barlines 972

final tempo 1598
Find Tempo dialog 404

important markers 1434
finding. See searching
fine

barlines 972
d.c. al 1447
font 1448
hiding 1453
inputting 414, 415
sections 1447
showing 1453
size 1448
tacet al 1497

finger tapping. See tapping
fingering 1157

alignment 1158
appearance 1068, 1158, 1164, 1166–1168
arpeggio signs 1174, 1175
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fingering (continued)
backgrounds 1173
borders 1164
brackets 274, 276, 1158, 1168, 1170
cautionary 1168
changing 854, 1064, 1066, 1160
chord diagrams 854, 1056, 1057, 1062–1066
circles 1164
collision avoidance 1158
cross-staff chords 1158
default settings 1158
deleting 1165
design 1164
enclosures 1164
engraving options 1158
erased backgrounds 1173
font 1068, 1166, 1167
font styles 1168
formatting 865
fretted instruments 1169. See also tapping
gaps 1158
grace notes 1158, 1163
hammer-ons. See hammer-ons
handles 1159
hiding 1062, 1165, 1168
horn branch indicators 1179
inputting 274, 276
inside the staff 1162
inverting 1161
italics 1167
letters 1175
moving 609, 1062, 1172
MusicXML import 1182
numeral style 1180
octave lines 1158
parentheses 274, 276, 1158, 1168
pinky letter 1175
placement 1158, 1162, 1170, 1172
popover 274, 276
position 1062, 1158
pull-offs. See hammer-ons
resetting 443
separators 1179
showing 1165, 1168
size 1068, 1158, 1163, 1166
slide positions 1180
slides. See fingering slides
slurs 1158, 1162
staff-relative placement 1161
string indicators 1184, 1187
string shift indicators 1181, 1182
strings 1255
substitution 1159
symbols 865
tapping. See tapping
thumb letter 854, 1062–1064, 1066, 1175
tuplets 1158
types 276, 1179
underlines 1164
valved brass instruments 1179

fingering slides 1176
deleting 1177
handles 1176, 1177

fingering slides (continued)
hiding 1177
length 1178
moving 609, 1177
resetting 1177
showing 1177

finials. See caret. See also annotations
first and second endings. See repeat endings
first page templates 532

assigning to pages 549, 706
customizing 541
formatting 532, 541
page numbers 1355
replacing 535, 536

first systems
indents 1566
page numbers 1355
staff labels 1532

fit to paper 684. See also staff size
five-line staff 1549

noteheads 1685, 1688
percussion kits 155, 1694, 1695
percussion legends 1697

fixed tempo mode 634
fixing

bars 729, 738
figured bass 401, 1155
frames 738
layouts 731
multi-bar rest width 1498
note durations 248, 259, 262
pages 729, 738
systems 729, 734

FLAC files
exporting 103, 104

flageolet. See harmonics
flags

above staves. See signposts
design 1273
formatting 865
hiding 1280
markers. See markers
notes 1273
stems 1273
symbols 865

flams. See grace notes. See also playing technique-
specific noteheads
Flanger 825, 829
flared hairpins 1124

size 1125
flat

accidentals. See accidentals
beams 1005, 1006
braces 1024
slurs 1513

flipping 441, 1515
flips. See jazz ornaments
floor tom. See unpitched percussion
flow cards 122
flow heading editor 555, 558
flow headings 78, 527, 529, 532, 554, 558

adding new 556, 557
arrangements 558
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flow headings (continued)
based on 557
changing 550, 551, 558
constraints 555
custom 555–557
default 554, 556, 557
deleting 560
editing 555, 558
exporting 531
flow titles 708
frames 554
gaps 712, 713, 1060
hiding 72, 550, 707
importing 530
inserting 551
links 557
margins 712, 713, 1060
moving 702, 713, 723
naming 559
page numbers 708, 1355
page templates 706
panel 522
removing changes 553
removing overrides 545
resetting 558, 831
showing 72, 550, 707
text alignment 587, 588
titles 708

Flow Import Options dialog 83
flow numbers 168

changing 78, 168
deleting 558
flow headings 554, 555, 558
hiding 558
tokens 579

flows 23, 122, 166
accidental duration rules 951, 952
adding 166, 167, 506
adding players 167
adding to layouts 172
attacca 635
audio 103, 104
cards 121
casting off 601, 602. See also casting off
condensing options 744, 755
copying 82, 167
default settings 837
deleting 169
deleting empty bars 964
duplicating 167
duration 579, 962–964
end barlines 971
exporting 84, 85, 673, 674
frame chains 570, 573
gaps 635
going to 446
headings. See flow headings
hiding 172, 573
importing 82, 83, 86, 89, 90
indents 608, 1565, 1566
instrument change labels 1539
justification 709
key signatures 1210

flows (continued)
layouts 122
merging 82, 89, 90, 706
MIDI import 89, 90
moving 737, 738
multiple on pages 706
MusicXML files 88
names 188, 189
navigation 446
notation options 837
note spacing 601, 602
numbers. See flow numbers
opening 616
order 78, 168
page numbers 579, 580, 708
page templates 706
panel 121
playback 635, 664
players 122, 167
pre-roll 635
printing 673, 674
project templates 80, 81
rehearsal marks 1426
removing from layouts 172
removing players 167
running headers 1190
selecting 428
showing 172
sorting 168
splitting 506, 706
staff labels 1532
staff size 718
switching 616
system dividers 1562
systems 709
tacets 739, 741
tempo tracks 100
timecodes 121
titles 188, 189, 708
tokens 578, 579
transposing 480, 481
trimming 302, 308, 309, 964
videos 121, 190, 192, 193
voices 664

Flows panel 110, 121
flute. See instruments
flutter-tongue. See playing techniques
flz. See playing techniques
folders

backups 108, 109
export path 597, 677

follow tempo mode 634
font styles 845, 846, 848, 1607

bar numbers. See paragraph styles
bar repeats 1461, 1465
borders 848
changing 846, 853
character styles 851
chord diagrams 1068
chord symbols 1039
condensing 760, 848, 1544, 1546
dedications 1188
default 853
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font styles (continued)
dialog 846
divisi 1544, 1577
divisi staff labels 1575
dynamics 1136
exporting 831, 846
family 853
figured bass 1151–1153
fingerings 1068, 1166, 1167
glyphs 844, 1136
importing 831, 846
instrument names 1544
line text 1417
lyrics 1223, 1235, 1236, 1239
markers 1433
missing fonts 76
multi-bar rests 1500
music 844
notations 844
notes 844
numbered bar regions 1465, 1468
ossia staff labels 1560
page numbers 1354
paragraph styles. See paragraph styles
PDF files 686
player group labels 1542, 1544
player labels 760, 1577
playing techniques 1392
rehearsal marks. See paragraph styles
repeat markers 1448
resetting 831, 846, 848
rhythm slashes 1465, 1480
size 846, 848
staff labels 1544
string indicators 877, 1166, 1167, 1183
substitutes 846
SVG files 686
tablature 1586
tasto solo 1152, 1153
tempo marks 1594
time signatures 1656
timecodes 1433
tuplets 1680

force
articulations 954
dynamics 1104
figured bass appearance 401, 1155
frames 738
horizontal 1420, 1677
staff visibility 697
systems 734

force duration 197, 262
activating 197
inputting notes with 262
inputting rests with 262

foreground colors 848, 851
formats. See file formats
formatting

altered unisons 949
arpeggio signs 1312
bar numbers 982, 985, 986
bar repeats 1465
barlines 517, 972

formatting (continued)
braces 517
brackets 517, 1027
caps 1398, 1414
chord diagram fonts 1068
chord diagram shapes 854
chord diagrams 1065
chord symbols 856, 857, 859, 861
cue labels 1094
divisi changes 1571
divisi staff labels 1575, 1576, 1579
dynamics 1122
dynamics fonts 1136
file names 678
flow headings 555, 558
fonts 846
frame constraints 590
frames 517, 519, 765
front matter 1188
glissando lines 1318
grace notes 1196
gradual dynamics 1122
hairpins 1122
handles 611
instrument change labels 135, 136
layouts 692, 765, 766
lines 884, 888, 891, 899, 900, 1397, 1398, 1413, 
1414
lyrics 1235, 1236, 1239
markers 402, 1432, 1433
music symbols 865
niente hairpins 1131
notehead brackets 1269, 1270
noteheads 868, 869, 871, 1252
overrides 542
page formatting 529, 542, 728
page templates 527, 540, 541
pages 689, 765, 766, 1188
pedal lines 1378–1380, 1382
player group labels 1542, 1544
player labels 762
playing techniques 876, 880
repeat markers 1448
rhythm slashes 1473
slurs 1511–1513, 1524, 1526
staff labels 1532, 1544
symbols 865, 899, 900
systems 516, 765
tablature font 1586
tacets 739, 741
tempo marks 1601–1603
text 389, 392, 584, 845, 848, 850–852, 1607, 1611
ties 1623–1625, 1632, 1634
time signatures 1656
timecodes 1433
tremolos 1664
tuplets 1672, 1678

Formatting panel 513, 516
forte. See dynamics
forum 72
forwards. See backwards
forzando. See dynamics
fps 195
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fractions
arpeggio signs 1314, 1316
chord symbols 1037, 1038
figured bass 397
fingerings 1159
glissando lines 1322
guitar bends 1329
lines 891
tempo marks 299, 301, 404, 1596, 1599
time signatures 285, 1639, 1641
tremolos 1667

frame breaks 517, 689, 728, 736
bar repeats 737
barlines 732
clefs 1070
condensing 747
copying to other layouts 765, 766
deleting 732, 739
divisi 1567
filter 433
first page on the left 705
glissando lines 1321
hiding staves 697
inserting 730, 731, 737
key signatures 1216
lines 1423
moving 732
octave lines 1083
playing techniques 1392
repeat endings 1443
signposts 453, 739
slurs 1507
staff labels 1534
staff size 717
staff spacing 694
staff visibility 697
ties 1627
time signatures 1643

frame chains
blank staves 700
flows 573
frames 571
layouts 570
linking 571
music. See music frame chains
note spacing 601, 603
order 573
page templates 569
players 574
properties 768–771
resetting note spacing 603
unlinking 572

frame fullness indicator 526
frame rates 195

changing 191, 195
dialog 191
drop frame timecodes 1435
non-drop frame timecodes 1435
transport window 649, 651

frames 560, 1614
blank staves 570, 700, 701
borders 585
breaks 689, 736

frames (continued)
constraints 590, 591, 712
copying 527, 530, 532, 537, 541, 549, 558, 566
dashed 554
deleting 567
edges 590
editing 514, 542
exporting. See graphic slices
flow heading editor 555
flow headings 554, 708, 712, 713
formatting 519
fullness 526
gaps 563, 590, 712, 713, 715
graphics. See graphics frames
handles 565, 575, 595
height 590
hiding 444
inputting 562
making from selection 738
margins 712, 715
moving 563, 564, 590, 591, 712, 713
music. See music frames
music symbols 391
order 573
padding 587, 689, 715
page template editor 540
resetting 545
running headers 708
selecting 514
shape 564, 591
size 564, 590, 591
staves 695, 709
systems 695, 709, 729
text. See text frames
tokens 576
width 590

Frames panel 519
French

repeat counts 1458
staff labels 60

frequency
auto-save 108
bar numbers 982, 1469
bar repeat counts 1460, 1463
harmonics 1282
numbered bar region counts 1468, 1469
pitches in playback 635
slash region counts 1481
timecodes 1438
trills 1296

Fretboard panel 209
key commands 47

frets 142, 1580
adding 142, 242, 854, 1066
brackets. See bracketed noteheads
capos. See capos
changing 1583
chord diagrams. See chord diagrams
deleting 142, 854, 1066
font styles 1068, 1586
generating notes 476
intervals 142
note input 209, 242
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frets (continued)
notes out of range 1583
numbers 1068
parentheses. See bracketed noteheads
position 142, 1068
size 1068, 1586
spacing 142
starting number 854, 1057, 1065, 1066, 1068
string number 1255

fretted instruments 142
adding 113, 138
arpeggio fingering 1174, 1175
capos. See capos
changing tuning 113, 140, 142, 144
chord diagrams 854, 1056, 1058
chord symbols 146, 149, 1045
detuned 146, 149, 150
exporting tunings 145
fingerings 274, 1158, 1169
frets 142
generating notes 472
guitar bends 1323
guitar techniques. See guitar techniques
harmonics 1282–1284, 1286
importing tunings 145
note input 209
open pitches 144
pinch harmonics 1289
popover 278
slides 1176, 1177
string indicators. See string indicators
strings 142, 144, 146, 1255
tablature. See tablature
thumbs 854, 1062–1064, 1066
transposition 137, 142, 147–150
tuning 140, 142, 146, 149, 150, 1045

front matter 1188
composer 532
copyright 532
dedications 1188
lyricist 532
page templates 527, 532, 535
performance instructions 527, 532, 535
player list 576
running headers 1190
title 527, 532, 535

full score layouts. See layouts
full screen 52
full stop. See period
fullness

frames 526
pages 526, 693, 695, 709, 716, 717
systems 526

fullness threshold
horizontal justification 709
vertical justification 695, 721

functions
key commands 65
removing key commands 67

fundamental
harmonics 1282
string pitches 142

funk noteheads 1251, 1252

FX channels 823–825
reverb 830

G
G clef. See clefs
galley view 43, 53

bar numbers 43, 984
cues 1089
dragging pages 447
flows 506
instrument changes 134
instrument filters 450
instrument labels 53
staff labels 43
staff spacing 721, 723

gaps 609, 712, 840
accidentals 1211
around items. See erased backgrounds
articulations 956, 959–961
bar numbers 981, 988, 1472
barlines 1049, 1110, 1211, 1389, 1390, 1421, 1617, 
1700, 1701
bars 1455, 1566
beams 1005, 1015, 1016
braces 1024
bracketed noteheads 1264
brackets 1024
caesuras 1206
capos 142, 146, 147, 149, 151, 153, 1037, 1038
chord diagrams 1060
chord symbols 1037, 1038, 1049, 1050, 1054
clefs 1070, 1072, 1211
codas 608, 1448, 1454, 1455, 1565
counts 1460, 1468, 1472, 1473
cues 1087, 1088
dynamics 1105, 1111, 1114
elision slurs 1222, 1244
erased backgrounds. See erased backgrounds
extender lines 1229, 1240
figured bass 1140
fingering slides 1176
fingerings 1158
flow headings 551, 712, 713
frames 563, 590, 712, 713, 715
galley view 723
guitar bends 1330
guitar techniques 1343
H-bars 1498, 1499
hairpins 1121, 1281
harp pedaling 1359
hyphens 1229, 1240
key signatures 1211
lines 888, 891, 894, 1405, 1419
lyrics 1222, 1229, 1240
margins 712
messa di voce 1105
multi-bar rests 1498, 1499
notes. See note spacing
ossia staves 694, 721
paragraphs 848, 850
parentheses 1054
pedal lines 1375, 1376
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gaps (continued)
percussion 1689
percussion legends 1700, 1701
playback 635
playing techniques 1388–1390
quantization 98
removing 259
repeat barlines 1211
rests 1016
slurs 1503, 1505, 1507, 1512
staff labels 1532, 1534
staves 161, 608, 694, 695, 720, 721, 1447, 1566, 
1689
stemlets 1017
stems 1010, 1281
string indicators 1184
system indents 1534, 1565, 1566
systems 695, 1447
tablature 1581
tacets 742
tempo marks 1602
text 848, 850, 851, 1419, 1616
text collision avoidance 1613
ties 1625, 1657
time signatures 1640, 1652, 1657
tuplets 1669

Gate 825, 829
General MIDI 90, 96, 912, 925
Generate Chord Symbols From Selection dialog 327
generated trills 1306, 1307

playback 1307
generating

chord symbols 327
harp pedaling 381
notes from chord symbols 471, 472, 476

German
repeat counts 1458
staff labels 60

ghost notes 1263, 1265
guitar. See dead notes. See also bracketed 
noteheads

gli altri. See divisi
glissando lines 1317, 1348, 1402

accidentals 1317
angles 1317, 1318, 1321
appearance 1318
changing 439
default settings 1318
deleting 459
direction 1255
endpoints 1317, 1318, 1321
engraving options 1318
filter 433
formatting 1318
frame breaks 1321
guitar bends. See guitar bends
handles 1321
harp pedaling 1322, 1358
hiding 1320
inputting 341, 344, 350, 351, 1318
length 609, 1321
line styles 1318
moving 609, 1321

glissando lines (continued)
one note 1348
panel 346, 351
placement 1318
playback 1322, 1358
popover 344, 350
position 1318
segments 1321
showing 1320
styles 1318
system breaks 1321
text 1319, 1320
thickness 1318
tie chains 1322
types 344

global
chord symbols 318, 1036
fermatas 1202
figured bass 395, 1139
key commands 64
note spacing 599, 601, 604
options 30
pedal level 1371
properties 768–771

glockenspiel. See instruments
glyphs

accidentals 484, 485, 487, 908
bracketed noteheads 1264, 1269
chord symbols 856, 861
custom 876, 880, 894, 899
dynamics 1136
fonts 844, 846, 1136
formatting 865
lines 897, 900
music symbols 388, 391, 577, 583, 865
noteheads 869, 871, 874, 875
pedal lines 1377
playing techniques 876, 877, 880, 882, 1387
repeatable symbols 900
substitute fonts 846
text 388, 391, 577, 583
trills 1291, 1293

go to. See navigation
Go To Bar dialog 447
Go To Page dialog 446
Go To Rehearsal Mark dialog 447
gongs. See unpitched percussion
Gould

accidentals 280, 908, 1219, 1220
repeat markers 1448

grace notes 1193
appearance 1200
arpeggio signs 1314
barlines 1196
beams 1200
caret 215, 250
clefs 1071
default settings 1194
deleting 459, 1196
duration 250, 1201
figured bass 1145, 1150
fingerings 1158, 1163
glissando lines 350, 351
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grace notes (continued)
guitar bends 355, 356
hairpins 1128
inputting 98, 197, 250, 1195
inverting 489, 1194
lines 1407
messa di voce 1128
moving 465, 468, 489, 491, 1195, 1196
pedal lines 1368, 1374
percussion 1689
pitch 479
pitch mappings 493
placement 1194
playback 635, 1201
playing techniques 1388
position 1194, 1196
quantization 98
register 479
retakes 1368
reversing 489. See also retrograde
rotating 491
scale mapping 495
size 440, 1197
slashes 1194, 1197–1199
slurs 273, 1194, 1503, 1504
spacing 599, 602, 1194
speed 1201
stems 1194, 1197, 1200, 1689
string indicators 1185
ties 248, 1628
transformations 488, 1195, 1196
transposing 480
trills 1306
types 1197
unscaling 1196
voices 1194

gradient background 56
gradual dynamics 1104, 1120

alignment 1108, 1132, 1133, 1135
angles 609, 1121
aperture 1121
appearance 1122
backgrounds 1281
barlines 1108, 1109
centered text 1118
continuation lines 1122
continuous hairpins 1123
dashed 1122
dotted 1122
end position 1108, 1121
flared hairpins 1124, 1125
font styles 1136
grace notes 1128
grouping 1132, 1133
handles 436, 1121
hyphens 1122
inputting 311, 313, 314, 316
length 436
line style 1122
linking 1133, 1135
messa di voce 1127, 1128
moving 465, 1105, 1108, 1121, 1127, 1128, 1132, 
1133

gradual dynamics (continued)
niente. See niente
playback 1136
poco a poco 1118, 1126
position 1127
rotating 609, 1121
spacing 1126
start position 1121
syllables 1122
system breaks 1121
tempo marks 1593
ties 314, 316, 465
truncated 1127
ungrouping 1133
unlinking 1135
volume 1136
width 1121

gradual tempo changes 1306, 1588, 1600
barlines 1592
components 1590
continuation lines 1600–1602
dashes 1602
drawing 810
final tempo 1598
formatting 1601–1603
gaps 1602
hyphens 1601
inputting 294, 297, 299, 301, 811
length 436, 609
lines 1600–1602
moving 609
Play mode 625, 810
popover 294
position 1592
style 1601, 1603
syllables 1601
Tempo editor 810
text 1593
thickness 1603

grand staff instruments
barlines 976, 977
braces 1023
brackets 1026
centered beams 1007
chord symbols 1040, 1043
cross-staff beams 1009, 1011, 1012
cues popover 422
dynamics 314, 316, 1105, 1115
hiding staves 696–698, 721
MIDI import 96
MIDI recording 264
multi-bar rests 1496, 1499
slurs 273
split point 96
staff grouping 1026
staves 976
swing playback 645
ties 248
vertical justification 721
voices 215, 231, 1704

graphic slices 166, 560, 592
color mode 596
deleting 598
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graphic slices (continued)
exporting 597, 598
file formats 592
file names 596
handles 594
image resolution 596
inputting 593
moving 593, 594
renaming 596
shape 594
showing 592
size 594

Graphic Slices panel 520
graphical adjustments 609
graphics

accidentals 908
chord symbols 856, 861
files. See graphics files
lines 897, 900
noteheads 869, 871
playing techniques 880
symbols 900

graphics files 675, 685
colors 686
exporting 596–598, 675–677
file names 678
fonts 686
formats 589, 592, 685
image resolution 685
monochrome 686

graphics frames 589
file formats 589
inputting 562
loading images 589
page templates 540, 589
selecting 565

graphs 816
green notes

Dynamics editor 799
tablature 1583

grids
chord diagrams 1060, 1062
gaps 161
groups 159
Hub 72
percussion kits 158, 159, 161, 1545, 1694, 1695
rhythmic 214
staff labels 1532, 1536
staves 1545, 1694

groups
bar repeats 1460, 1465, 1466
beams. See beam groups
braces 1023, 1030
brackets 1023, 1030
condensing 747, 751
divisi 1548, 1570, 1571, 1575
dynamics 1132, 1133
guitar bends 1323, 1333
instruments. See instrument groups
notes. See note grouping
percussion kits 155, 158–160, 1545
players. See player groups
playing techniques 1393, 1394, 1399, 1400

groups (continued)
rests. See note grouping
staff labels 1532, 1540, 1546
staff spacing 694, 721
staves 976–980, 1030, 1032–1035
tabs 51

guide bar numbers 53, 984
hiding 444

guide instrument labels 53, 182, 183
guitar 1330, 1339

amp modeling 825, 829, 830
bends. See guitar bends
capos. See capos
changing string for notes 1583
chord diagrams. See chord diagrams
chord symbols. See chord symbols
dead notes 1344
dips 363, 364, 1339
dives 358–360, 1328, 1335, 1337, 1339
fingerings 1169
hammer-ons 366, 1342
harmonics 1282, 1284, 1286
lines 364, 365, 1323, 1328, 1333, 1335–1337, 1339
note input 242
notes out of range 1261
open pitches 144
playback 628, 1323, 1328, 1339, 1344
pre-bends. See guitar pre-bends
pre-dives. See guitar pre-bends
pull-offs 366, 1342
scoops 361, 362, 1339
slides 1176
string indicators. See string indicators
strings 144
strumming 1174
tablature. See tablature
tapping 367, 1340
techniques. See guitar techniques
tuning 113, 142, 144
vibrato bar. See vibrato bar

guitar bends 1323, 1328
appearance 1330
chords 1323, 1327
crosshairs 612
default settings 1330
deleting 459
direction 441
dives 1328
engraving options 1330
groups 1323, 1333
handles 1333, 1337
height 1330
hold lines 1331
holds 1323, 1330, 1331, 1333, 1337
inputting 344, 354–356
intervals. See bend intervals
length 609
lines 1330
microtonal 357, 1327, 1329
moving 609
parentheses 1323
playback 1323
popover 344, 355, 356
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guitar bends (continued)
position 1330
post-bends 357, 1327
pre-bends 1326
releases 1323, 1330
runs 1323, 1333
segments 1333, 1337
shape 1333, 1337
spacing 1330
tablature 1581
thickness 1330

guitar post-bends 1327
bend intervals 1329, 1330
chords 1327
deleting 1333
handles 1336
inputting 357
microtonal 357, 1327
moving 609, 1336
shape 1336

guitar pre-bends 1326
accidentals 1332
bend intervals 1329
deleting 1333
direction 1331
handles 1335
inputting 357
length 609, 1335
moving 609, 1335
shape 1335

guitar pre-dives. See guitar pre-bends
guitar techniques 1339, 1340, 1342

dead notes 1344
default settings 1343
deleting 1347
gaps 1343
hiding 1345
inputting 344, 354, 358–367
intervals 1344
moving 609, 1346
panel 346
popover 344
position 1343
showing 1345
staff-relative placement 1346
tablature 1345

H
H-bars. See multi-bar rests
hairpins. See gradual dynamics
half depressed pedal lines 1368, 1369, 1371, 1372
half notes 17, 201, 221, 224, 235, 237, 259

beats 303
chords 251
metronome marks 296
percussion 238, 787
rests 246, 1487
splitting notes 261
tablature 242
tempo equations 1604
tremolos 415, 417, 1659

half notes (continued)
tuplets 254, 257
voices 231

half-bar
beam grouping 998, 1021
note grouping 837, 1021
ties 837, 1021

half-diminished. See scales. See also intervals
half-step trills 1298, 1306

appearance 1303
hiding 1295, 1299
inputting 343, 347, 348
position 1305
showing 1295, 1299

half-steps 17, 942
accidentals 244, 942
bend intervals 1329, 1344
figured bass 399
glissando lines 1317
harp pedaling 1358
pitch bends 804
string pitches 142
tonality systems 1219
trills. See half-step trills

half-whole diminished
chord symbols 323
scales 495, 496, 503

HALion Sonic SE
endpoints 664
independent voice playback 636
playback template 651, 652

HALion Symphonic Orchestra
endpoints 664
independent voice playback 636
playback template 651, 652

halving. See double
hammer-ons 1342

deleting 1347
hiding 1345
inputting 366
moving 609, 1346
popover 344
position 1343
showing 1345
slurs 1342
staff-relative placement 1346
tablature 1345

hand tool 43
dragging pages 447

handles
arpeggio signs 1313
beams 1006
bend intervals 1333, 1335–1337
brackets 1269
chord symbols 857, 859, 861, 1044
duration 436
dynamics 1120, 1121, 1127, 1128
figured bass 1144, 1148, 1150
fingerings 1159, 1177
frames 564, 565, 570, 575, 590
glissando lines 1321
graphic slices 594, 595
guitar bends 1333, 1335–1337
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handles (continued)
hairpins 1121, 1127, 1128
jazz articulations 1350
length 436
lines 1423
lyrics 1230, 1233, 1240
moving 564, 609, 1128
note spacing 604, 606
notehead brackets 1269
numbered bar regions 1467
octave lines 1083
pedal lines 1369
percussion legends 1698
playing techniques 1392, 1394, 1399
releases 1333, 1337
repeat endings 1442, 1443
selecting 606, 611
slurs 1509, 1520, 1522
staff spacing 723
stems 1279, 1665
string indicators 1392
system spacing 723
tempo marks 1591
ties 1632, 1635–1637
tuplet brackets 1674

harmonic analysis. See figured bass
harmonic minor. See scales. See also key signatures
harmonics 1282

accidentals 1285
appearance 1286, 1288, 1289
artificial 1282
hiding 1283
inputting 1283
natural 1282
noteheads 869, 1252, 1283, 1286
partials 1284
pitch 1284
playback 1282–1284
question marks 1283
showing 1283
string number 1255, 1583
styles 1286, 1289
tablature 1283, 1286

harp pedal diagrams 1358, 1360
placement 1364
position 1364
showing 1360

harp pedaling 1358
appearance 1358–1360
borders 1362, 1363
calculating 381
crosshairs 612
default settings 1359
diagrams. See harp pedal diagrams
engraving options 1359
erased backgrounds 1363
filter 433
glissando lines 1322, 1358
hiding 1361
inputting 371, 380, 381
moving 465, 468, 609
note names 1359, 1360
notes out of range 1261

harp pedaling (continued)
padding 1363
partial 1365
playback 1358
popover 371
showing 1361
signposts 453, 1358, 1361

headers
Dynamics editor 799
editors 781
flows 554
frame constraints 590
Key Editor 773
MIDI CC editor 805
MIDI Pitch Bend editor 804
percussion editor 785
piano roll editor 777, 784
running headers 1190
Tempo editor 810
tracks 615, 617, 624–627
Velocity editor 796

heavy swing 643, 647
height

bars 693–695, 721
braces 1024
brackets 1024–1026, 1030, 1032, 1033, 1053, 1542
breath marks 1208
channels 827
chord diagrams 1069
chord symbols 1053
drum pads 210
editors 779
enclosures 982, 1425
flared hairpins 1125
frames 564, 590
graphic slices 594
guitar bends 1330
hairpins 1121, 1125
handles 1522, 1527, 1632
Key Editor 775, 779
keyboard 207
lines 1411
mixer 821, 827
notehead brackets 1269
parentheses 1053
pedal lines 1369, 1372
percussion editor 779
piano roll editor 779
slurs 1527
staves 693–695, 712, 715, 716, 721
systems 694, 695, 721
ties 1635–1637
tracks 630, 779

hemiola
forcing note durations 262
independent time signatures 288, 290–292

Henze fermatas. See fermatas
hi-hat. See unpitched percussion
hiding 47, 454, 459, 817, 1618

accidentals 942, 943, 952, 953, 1214, 1285, 1299, 
1332
arpeggio signs 1310
arrows 1605
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hiding (continued)
articulations 1095
audio outputs in mixer 659
backgrounds 1049, 1110, 1281, 1389, 1421, 1617, 
1700
bar numbers 982, 984, 990, 992, 1498
bar repeat counts 1464
bar rests 1099, 1489, 1490, 1493–1495
barlines 285, 967, 971–973, 1049, 1110, 1389, 
1421, 1617, 1641, 1700
beams 1280, 1479
bend intervals 1329, 1330
borders 444, 585, 848, 982, 1192, 1362, 1420, 
1425, 1614
braces 1025, 1028, 1030, 1032–1035
brackets 943, 952, 1025, 1028, 1030, 1032–1035, 
1051, 1052, 1110, 1143, 1147, 1265, 1543
brackets on noteheads 1265
capos 151, 152, 154
caps 1398
caret 219
cautionary accidentals 943, 952, 1153, 1214, 1285
channels 826
chord diagram fingering 854, 1062, 1066
chord diagrams 1058–1060
chord symbol parentheses 1051, 1052
chord symbols 326, 1040, 1041, 1044, 1047, 1059
circles 982, 1130, 1425
clefs 333, 334, 1075
coda 1449, 1453
colors 639, 764, 1101–1103, 1261, 1461, 1475, 
1491, 1573, 1705
comments 512
condensing colors 444, 764
continuation lines 1396, 1397
counts 984, 1456, 1464, 1470, 1482, 1498
cue colors 1103
cues 1089, 1090
da capo 1453
dal segno 1453
dead notes 1344
decimal places 1599
divider arrows 1574
divisi colors 444, 1573
divisi labels 1532, 1568, 1576, 1579
divisi staves 696–698
dynamics 1095, 1113–1115, 1118
Dynamics editor 781, 799
elision slurs 1244
empty staves 696
fermatas 1095, 1207
figured bass 397, 1140–1142, 1144
figured bass brackets 1143, 1147
fine 1453
fingering slides 1177
fingerings 1062, 1165, 1168
flared hairpins 1124
flow headings 72, 550, 707
flow numbers 558
flow page numbers 708
flow titles 708, 1190
flows 172, 573, 739
Flows panel 121

hiding (continued)
glissando line text 1320
graphic slices 592
guitar bend hold lines 1331
guitar bend intervals 1330
guitar pre-bend accidentals 1332
guitar techniques 1345
harmonics 1283
harp pedaling 1361, 1365
highlights 444
Histogram tool 813
hold lines 1144, 1331
hyphens 1114
initial page numbers 1355
instrument change labels 1539
instrument changes 134, 136
instrument names 1532, 1534, 1536, 1540
instrument transpositions 185, 1537
interchangeable time signatures 1641
jump bar 70
key signatures 113, 140, 279, 281, 283, 1210, 1213, 
1216
laissez vibrer ties 1629
ledger lines 1257
lines 436, 444, 1144, 1396, 1397, 1543, 1601
lyrics 1095
margins 444
markers 1431
metronome marks 1599
MIDI CC editor 781, 805
MIDI Pitch Bend editor 781
mixer 821–823, 826
multi-bar rests 1496
niente 1130
note colors 444, 687, 1261
notes 874, 1257, 1262, 1477
numbered bar regions 1468, 1470
octave transpositions in cue labels 1091
ornaments 1095
ossia staves 1558, 1559
padding rests 1098, 1478
page numbers 547, 708, 1355, 1356
panels 34, 42, 45, 47, 111, 118
parentheses 943, 952, 1051, 1052, 1110, 1143, 
1147, 1265
partial harp pedaling 1365
pedal lines 1378–1380
percussion legend signposts 1696
player group labels 1543
player labels 761
players 167, 171
playhead 632
playing techniques 1095, 1391, 1396
Playing Techniques editor 795
prefixes 136
quality in chord symbols 1047
rectangles 982, 1425
repeat counts 1456
repeat markers 1453
rest colors 1491
rests 1098, 1099, 1489, 1493–1496
rhythm dots 1257–1259, 1262
root in chord symbols 1037, 1038, 1047
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hiding (continued)
running headers 708
secondary brackets 1028
segno 1449, 1453
separators 1114
signposts 444, 454, 736, 739
slash region counts 1482
staff labels 1532, 1534, 1568, 1575, 1576, 1579
staff lines 763, 1049, 1110, 1173, 1389, 1421, 1617, 
1700
staves 122, 167, 171, 172, 449, 452, 696–698, 1551, 
1555, 1582
stems 1280, 1281, 1479
string indicators 383, 436
sub-brackets 1028
symbols 1391, 1449
system dividers 1562
system track 431, 444
systemic barlines 973
tablature 1582
tabs 34
tacets 741
Tempo editor 781
tempo marks 1595, 1601
text 1095, 1618
text borders 585, 848, 1192, 1420, 1614
text on lines 1415
ties 1657
time signatures 455, 1655
timecodes 1437, 1438
to indications 761
toolbar 33
tracks 629, 777
transport window 649
tre corde 1385
trill extension lines 1297
trill intervals 1299
trill marks 1291, 1295
tuplets 1669, 1675, 1678
Velocity editor 781, 796
verse numbers 1243
vibrato bar lines 436
video window 193
voice colors 444, 687, 1705
VST instruments 620
wings 1027
zones 34, 47

highlights
bar repeats 1459, 1461
chord symbol regions 1044
comments 512
cues 1101–1103
dynamics 799, 800, 803
exporting 687
flags. See signposts
hiding 444
MIDI 804–806, 809
music frames 513, 723
numbered bar regions 1461
printing 687
search matches 61, 834, 837, 839, 840, 842
slash regions 1474, 1475
stop positions 457

highlights (continued)
tempo changes 625, 810, 811
tracks 615, 625

histogram editor
changing values 797

Histogram tool 813, 814, 817
area graph 816
bar graph 816
changing values 815
controls 814, 815
filter 815
graph type 816
hiding 813
showing 813

hold lines 1323, 1331
appearance 1330
brackets 1143, 1147
dashed 1330
figured bass 436, 1140, 1144, 1145, 1148, 1150
guitar bends 1330, 1333
handles 1148, 1333
hiding 1144, 1331
length 1144, 1145, 1150, 1330, 1333
moving 609, 1333
position 1330
showing 1144, 1331

holds
colors 58

Holds and Pauses panel 340
Hollywood-style trills 1303

intervals 1305
position 1305
showing 1304

hooks
length 1445
lines 886, 894
octave lines 1083
pedal lines 1368, 1369, 1372, 1377, 1379
playing techniques 1393, 1396
repeat endings 1445
thickness 894
tuplets 1674

horizontal alignment
chord symbols 1048
crosshairs 612
dynamics 1108, 1132, 1133
fingerings 1158
instrument names 185
items 612
lyrics 1229, 1230
ornaments 1293
staff labels 185
staves 709
systems 709
text 588, 848, 851, 1612

horizontal chord diagrams 1069
horizontal justification

staves 709
systems 709
text 588, 848

horizontal lines. See lines. See also glissando lines
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horizontal position 609, 840
accidentals 945–947
arpeggio signs 1313
articulations 958
bar numbers 987
barlines 967
chord diagrams 1068
chord symbols 1039, 1042
clefs 1071, 1072
cues 1086
dynamics 1105, 1106, 1118
figured bass 1140, 1151
fingerings 1158
frames 563
fret numbers 1068
H-bars 1498, 1499
instrument names 185
lines 465, 468, 1406, 1407, 1412, 1423
lyrics 1229, 1230
modifiers 1118
multi-bar rests 1498, 1499
notes 526, 599, 1258, 1259, 1706–1709
ornaments 1293
player group labels 1543
playing techniques 1388
poco a poco 1118
rehearsal marks 1425
rests 1487, 1493, 1498, 1499
rhythm dots 1260
staccato 958
staff labels 185
staves 709, 1555
string indicators 1187
systems 608, 709
tempo marks 1591
text 848, 1543, 1612
ties 1621
time signatures 1652
trills 1293
tuplet brackets 1676
tuplets 1679

horns 131
branch indicators 1166, 1179
clefs 113, 140, 331, 1076
fingerings 1166, 1179
key signatures 113, 140
transposition 113, 137, 140

hotkeys. See key commands
hours 35, 649, 1435
house styles. See libraries
HTML files

comments 511
Hub 72

opening projects 75, 76
starting projects 74
video tutorials 72

humanize
dynamics 799, 1137

hymnals
lyrics 600, 1235
note spacing 600
repeat barlines 967
tick barlines 967, 970, 974

hyphens
dynamics 311, 1114
lyrics 392, 394, 1224, 1240
staff labels 1538
tempo marks 1601
time signatures 1647, 1651

Hz
playback tuning 635

I
illustrations

exporting 596, 598, 675, 676
frames 589

images
exporting 596, 598, 675, 676
frames 589
inputting 589
resolution 596, 675, 676, 685
videos 190

immediate dynamics. See dynamics
implicit rests 26, 1487, 1488

colors 1491
deleting 1493
explicit rests 1490
hiding 1489, 1493
showing 1493
voices 1489

imploding. See reducing
Import Page Template dialog 538
Import Tempo Track dialog 101
important markers 404, 1434
importing 82, 831

chord symbols 831
Cubase data 912, 929
expression maps 912, 929
flow headings 530
flows 82, 83, 89, 90
font styles 831, 833, 846
fretted instrument tunings 145
house styles. See libraries
Key Editor configurations 819
libraries 833
lines 831, 888
MIDI files 89, 90
MusicXML files 86, 87, 1446
noteheads 831, 869
options 831, 833
page templates 530, 537, 538, 831, 833
paragraph styles 831, 833, 848
pedal lines 89, 96, 270
percussion kits 1691
percussion maps 935
playback templates 658
playing techniques 92, 96, 831, 883
settings 831, 833
tempo tracks 100, 101
tonality systems 831, 1221
tracks 89, 90
unpitched percussion 87, 90

inches
staff spacing 723
unit of measurement 54
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including. See excluding
indents 1565, 1566

codas 608, 1454, 1455, 1565
final systems 709
first systems 1566
removing 1566
staff labels 1534
systems 608, 709, 1532, 1534, 1566
text 848

independent voice playback 617, 636
changing endpoints 664
disabling 637
enabling 636
inputting notes 786
piano roll editor 784
playing techniques 373, 375

index
rehearsal marks 1426
tokens 576
vertical stacking 1083, 1393
voice columns. See voice column index

Indian drum notation 1070, 1703
Indiana chord symbols 1038
indicators

audio engine 42
caret 1115
clefs 1077, 1078
condensing 760
divisi 1577
fingerings 276, 1179
frame fullness 526
horn branches 1179
MIDI input 42
octaves 1077, 1078
players 760
string fingerings 1181, 1182, 1255
system fullness 526
tempo. See tempo marks
thumbs 276
trill intervals 1298, 1305
unisons 762
voices 1115

information. See project information
ingredients 678
init switches 916, 925
initial pages

left-hand page 705
page numbers 705, 1355

initial trill notes 1306
initials

comments 506, 511
input pitch 228
inputting 212

accidentals 228, 244, 942
additional repeat endings 411, 413
altered bass note chord symbols 318
annotations 886
arpeggio signs 341, 344, 349
articulations 228, 271, 272
bar number changes 991, 992
bar number counts 409, 420
bar repeats 409, 410, 419
bar rests 247, 302

inputting (continued)
barline joins 978
barlines 302, 304, 305, 308, 309, 978
bars 302, 305–307
beams 221, 1000
beats 303, 305, 307
braces 1032
bracketed noteheads 1265
brackets 1032. See also parentheses
breath marks 337–340
caesuras 337–340
capos 147, 148
caret 215, 219
centered beams 1008
character styles 852
chord diagram shapes 1065
chord diagrams 1040, 1058, 1059
chord symbol parentheses 318, 324, 1051
chord symbol regions 324
chord symbols 318, 320, 325–327, 839
chords 197, 251, 258, 499
clefs 329, 330, 332–334
comments 507, 509, 510
condensing groups 752
cues 421–423, 425
custom accidentals 244, 902, 904
custom annotations 886
custom key signatures 283, 902, 905
custom lines 884, 886, 887
custom music symbols 886
custom noteheads 874, 875
custom playing techniques 373, 375, 882
custom tonality systems 902
dips 363, 364
dives 357–360
divisi 1570, 1572
dynamic modifiers 311, 313, 314, 316, 1117
dynamics 310, 311, 313, 314, 316, 800, 803, 1117
editors 781, 819
elision slurs 392, 394
empty pages 702, 703
ensembles 115, 130
expression maps 926, 927, 929
fanned beams 1019
fermatas 337, 339, 340
figured bass 395, 397, 400, 401, 1140
figured bass hold lines 395, 397, 436, 1144, 1145
fingerings 274
flow heading changes 550, 551
flow headings 556, 557
flows 82, 166–168, 506
font styles 850, 852
frame breaks 731, 737, 738
frames 562
glissando lines 341, 344, 350, 351, 1318
grace notes 98, 250, 1195
gradual dynamics 311, 313, 314, 316
gradual tempo changes 294, 297, 299, 301, 811
graphic slices 593
guitar bend hold lines 1331
guitar bends 344, 354–356
guitar dips 344, 363, 364
guitar dives 344, 358–360
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inputting (continued)
guitar lines 344, 364, 365
guitar post-bends 357
guitar pre-bends 357
guitar pre-dives 357
guitar scoops 344, 361, 362
guitar tapping 344, 367
hammer-ons 344, 366
harmonics 1283
harp pedaling 371, 380, 381
hold lines 436, 1144, 1145
inputting vs. editing 212
Insert mode 237
instrument changes 221, 224
instrument filters 453
instruments 113, 125, 138
instruments in percussion kits 157
intervals 498
jazz articulations 341, 343, 352, 354
jazz ornaments 343, 347, 348
key commands 66
Key Editor 777, 781, 786, 800, 806, 811, 819
key signatures 278, 280, 281, 283, 942
layouts 171, 174, 176
left-hand fingerings 278
level changes 376, 377, 379
line text 1415
lines 369, 373, 375, 384, 385, 387
lyrics 392, 394
markers 402, 403, 627
messa di voce 311, 313, 314, 316, 1128, 1129
metronome marks 294, 299, 301
microtonal accidentals 950
MIDI 89, 90, 263, 264, 271, 622, 651, 652, 656
MIDI points 806, 809
mouse input 213, 229
music symbols 882, 886, 887
mutual exclusion groups 929
nested slurs 1517
nested tuplets 1670
niente 311, 313, 314, 316, 1130
notehead brackets 1265
noteheads 791, 874, 875, 1686, 1687
notes 220, 221, 224, 228, 235, 237, 242, 258, 262, 
264, 471, 472, 476, 499, 786, 787
notes in multiple voices 231
notes in percussion kits 238, 240, 787
notes on divisi staves 1572
numbered bar regions 409, 420
octave lines 329, 332, 335, 336
octaves 498
ornaments 341, 342, 347, 348
ossia staves 1557
page number changes 545
page template changes 549
page template sets 529
page templates 535, 536
pages 702, 703
panels 202
paragraph styles 850
parentheses 318, 324, 395, 397, 943, 1051, 1110, 
1143, 1147, 1265, 1285
pauses 337, 339, 340

inputting (continued)
pedal lines 368, 371, 376–379
percussion kits 139, 238, 786, 787, 791, 1686, 1687
percussion legends 1697
pick-up bars 284, 286, 291, 292, 455
pitch mappings 493, 494, 503
playback techniques 927, 937
playback templates 657, 658
player groups 163
player lists 1190
players 115, 125, 130
playing techniques 368, 369, 373, 375, 786, 787, 
791, 1686, 1687
popovers 25, 202
position 212
post-bends 357
project templates 81
pull-offs 344, 366
register selection 224
rehearsal marks 401
repeat endings 407, 410–413
repeat markers 407, 410, 414, 415
rests 197, 207, 221, 246, 262
retakes 376, 377, 379
rhythm dots 221, 224, 228, 229
rhythm slashes 409, 410, 418
rhythmic feels 294, 645, 646
rhythmic grid 214
right-hand fingerings 278
scoops 361, 362
settings 213, 228
slash regions 409, 418
slash voices 233, 1485
slurs 273, 366, 1517
soloists 128
staves 125, 130, 138, 700, 701, 1553, 1557, 1567, 
1568, 1570
stem direction 242
stemlets 1017
stems 231, 1704. See also voices
string indicator lines 436
string indicators 371, 381–383
strings 142
sub-brackets 1032
sub-sub-brackets 1032
swing playback 297
switches 927
symbols 886
system breaks 731, 734
system-attached text 388
tablature 242, 1582
tapping 344, 367
tempo equations 294, 297, 299, 301
tempo marks 294, 297, 299, 301, 811
text 388, 583, 1415
ties 197, 248
time signatures 284, 285, 288, 290
timecodes 402, 1431, 1436
tokens 576, 583
tonality systems 902, 1220
tremolos 408, 410, 415, 417
trill intervals 1301
trills 343, 347, 348
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inputting (continued)
tuplets 98, 254, 1670, 1671
unpitched percussion 786, 787
upbeats. See pick-up bars
velocity 797
vibrato bar 354, 357, 358
vibrato bar dips 363, 364
vibrato bar dives 359, 360
vibrato bar lines 364, 365, 436
vibrato bar scoops 361, 362
videos 192
voices 231, 233
VST instruments 622, 651, 652, 656

Insert Bar Number Change dialog 990
Insert Flow Heading Change dialog 551
Insert mode 197, 212, 454

activating 197, 237
caret 215, 237
deactivating 237
inputting notes 237
scope 455, 456, 839
stop positions 454, 457, 458
time signatures 288, 290–292, 455, 839, 1639
tuplets 459

Insert Music Text dialog 391
Insert Pages dialog 703
inserting. See inputting. See also Insert mode
insertion point 215
inserts 825

changing 829, 830
loading 829
removing 830

inspector. See Track Inspector. See also properties
instances

adding 622
chord symbols 856, 1036
plug-ins 617, 620

instrument change labels 131, 134
borders 134, 848
editing 135, 136
font style 134, 848
hiding 1539
prefixes 135
showing 1539
suffixes 135

instrument changes 134
allowing 134
disallowing 134
inputting 138, 221, 224
labels. See instrument change labels
language 60, 134, 1458

instrument channels 821–824
instrument colors 624

Dynamics editor 799, 803
MIDI CC editor 805, 809
MIDI Pitch Bend editor 804, 809
percussion editor 785
piano roll editor 784
Playing Techniques editor 795
Velocity editor 796

instrument filters 113, 115, 449, 450
activating 452
adding 453

instrument filters (continued)
deactivating 452
deleting 453
instruments 450, 453
key commands 449, 450
order 450

instrument groups 158, 162
deleting 160
filters 450
labels 1542, 1543
naming 159
percussion kits 158, 1545

instrument labels
percussion kits 159

instrument names 181, 1531
abbreviated 184, 185, 760, 1535
alignment 185, 1544
baseline shift 185
borders 1192
changing 184
colors 185, 1544
cues. See cue labels
Endpoint Setup dialog 659
fonts 1544
hiding 1532, 1534, 1536, 1540
length 185, 1532
mixer 821, 822
numbering 132, 1535, 1539
overline 185
Play mode 624, 659, 822
player labels 760
resetting 185, 188
saving as default 185
showing 1532
size 1544
solo 128
staff labels 185, 577, 1532, 1535, 1536
stretch 185
subscript 185
superscript 185
tokens 577
tracks 624. See also instrument tracks
underline 185

instrument numbering 132, 1538, 1539
instrument picker 113
instrument pitches. See instrument transpositions
instrument tracks 623, 624

automation. See MIDI CC editor
dynamics. See Dynamics editor
MIDI. See MIDI CC editor
piano roll editor 784
velocity. See Velocity editor

instrument transpositions 137, 176, 1536
changing 113, 140, 177, 180
clefs 179, 1075
cue labels. See cue labels
hiding 185, 1537
layout names 184
layouts 176, 179, 180, 184
numbering 1539
order 1538
parentheses 1538
reverting 181

Index
 

1771
Dorico Pro 4.3.30



instrument transpositions (continued)
showing 185, 1537
staff labels 185, 1536–1538

instrumental parts. See layouts
instrumentation lists 577, 1188

adding 1190
page templates 527, 532, 535

instruments 24, 131
adding 113, 115, 130, 138
adding staves 1553
adding to flows 167
adding to parts 171
adding to percussion kits 157
arranging tools 459
assigning to endpoints 664
automatic numbering 132
barline joins. See barline joins
brackets 1025, 1026
changes. See instrument changes
changing existing 140, 157
changing transposition 140, 180
channels 821–824
chord symbols 318, 1040
clefs 113, 140, 177, 179, 181, 1074
colors 624, 784, 785
combining into kits 139
comments 506, 507
copying 126
cues popover 422
deleting 129, 141
deleting staves 1551, 1552
divisi 1567, 1568, 1570
doubling 53, 138
dynamics 799, 1115, 1133, 1136. See also 
Dynamics editor
empty staves 696
endpoints 659, 664
ensembles 129
expression maps 659, 913
figured bass 395
filters. See instrument filters
fretted 142
fretted fingerings 1169
groups. See instrument groups
hiding 167, 171, 449
importing 90
inputting notes 221, 224
key signatures 1212, 1213, 1217, 1218
labels 53, 134–136, 182, 183
language 60, 113, 115, 188, 1458
loading 622
MIDI 617, 621, 622
MIDI import 90
MIDI recording 263
mixer 821–824, 827
moving 141, 165
muting 638, 639, 821
names. See instrument names
non-sustaining 1136
numbering 132, 1539
order 127, 128, 141, 160, 162
panning 828
part layouts. See layouts

instruments (continued)
percussion 160, 930, 1694
percussion legends 1696, 1698
percussion maps 659
pitch. See instrument transpositions
Play mode 624
playback 636, 637, 651, 652, 654, 656, 659, 664, 
912, 930
players 124
Players panel 111
plucked fingerings 1169
ranges 1261
removing from kits 162
removing from parts 167, 171
searching 113, 115
showing 167, 171, 449
showing staves 53
soloing 638, 639, 821
staff grouping 1026
staff labels 185, 1532, 1535, 1536, 1538, 1540
staff size 718
staves 53, 697, 698, 1115, 1551–1553, 1555, 1694
strings 142
sustaining 1136
swing playback 645
tablature 1580, 1582
templates 74, 115, 118
tracks. See instrument tracks
transposing 137, 173. See also instrument 
transpositions
tuning 113, 142
velocity 796. See also Velocity editor
volume 827, 1115
VST 617, 620, 622

integers
metronome marks 1599

intensity
dynamics 314, 316, 439, 799, 1104, 1112, 1113, 
1137

interactive key commands map 64
interchangeable time signatures 1641

ending 1655
inputting 285, 287, 288, 290

interface 32
interspersion

accidentals 945
intervals

accidentals 343, 498, 1300
adding 251, 258, 499
auto-save 108
chord symbols 322, 475, 476, 1037
dips 1344
figured bass 1140, 1154
fretted instruments 142
generating notes 475, 476
glissando lines 1317
guitar bends. See bend intervals
handles 1333, 1335–1337
harmonics 1282–1284, 1286, 1289
microtonal 498
note input 224
octave divisions 1219
ornaments 1292
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intervals (continued)
pitch mappings 493, 494, 503
popover 498
simplifying 1154
size 475, 476
transposing 480, 481, 500
trills 343, 347, 1298–1301, 1305
vibrato bar dives and returns 1328

inversions
chord symbols 318, 326, 629
figured bass 395, 397, 1139, 1140
pitches 489, 490, 500
playback 629

Invert Pitches dialog 490
inverting 489, 490, 1515

articulations 959, 960
beaming 1003, 1004
colors 57
figured bass 1149
fingerings 1161
grace note stems 1194
pitches 489, 490, 500
slurs 1504, 1514, 1515
ties 1626
tuplets 1675

invisible. See hiding
ionian

chord symbols 323, 1046
scales 495, 496, 503

irrational time signatures. See time signatures
irregular

bars as pick-up bars 1644
time signatures 1641

italics
chord diagrams 1068
chord symbols 146, 1037–1039
dynamics 1104
figured bass 1152, 1153
fingerings 1068, 1166, 1167
instrument names 1544
lyrics 1236, 1239
player group labels 1542, 1544
rehearsal marks 1429
repeat endings 1443
staff labels 185, 848, 1544
tasto solo 1152, 1153
tempo marks 1594
text 389, 584, 848, 851
tuplets 1680

items 212, 426
behind other items 426
changing 439
copying 461
deselecting 435
editing 769
resetting 442, 443
selecting 212, 426–428, 435, 445
settings. See properties

J
Japanese

chord symbols 1038
coda 1448
segno 1448

jazz
articulations. See jazz articulations
band templates 74, 80
chord symbols 1038
glyphs 844
music font 844
staff grouping 1026, 1540

jazz articulations 1348, 1349
appearance 1350, 1351
bend 1348
changing 1351
copying 955
default settings 1350
deleting 1352
duration 1351
engraving options 1350
handles 1350
inputting 341, 343, 352, 354
length 609, 1350, 1351
line styles 1351
moving 609, 1350
ornaments. See jazz ornaments
panel 346, 354
playback 936, 937, 1348
popover 343, 352
position 1350
smooth 1348
types 343, 1348, 1351

jazz ornaments 1348, 1349
inputting 343, 347, 348
popover 343
types 343

Jazz Standards chord symbols 1038
jeté. See playing techniques
job types 668, 680

page ranges 673, 674
printing 680
selecting 680

joins
barlines 967, 976, 978–980, 1026, 1034, 1560
beams 1000, 1001, 1009, 1012
ossia staves 1560
pedal lines 1376
staves with barlines 978
stems 1009, 1012

JPEG files
graphics frames 589

jump bar 68
aliases 70, 71
Commands 68, 70
entries 68
Go To 69, 70
showing 70

jumps
hiding 1453
inputting 414, 415
playback 641
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jumps (continued)
rehearsal marks 447, 1426
repeat 1447
showing 1453

justification
staves 695, 709, 721, 1555, 1566
systems 608, 695, 709, 721, 1566
text 587, 588
vertical 695, 721

K
kerning

accidentals 946
figured bass 1148, 1151

key clicks. See playing techniques
key commands 20, 29, 63, 68

articulations 272
assigning 66, 70
defining 61
finding 65, 68
galley view 53
instrument filters 449, 450
Key Editor 777
keyboard layouts 67
languages 67
lower zone 47
maps 64
MIDI 66
mouse input 197
muting 638, 639
navigation 39, 446, 447
notehead sets 1252
page view 53
panels 47
playback 632
played duration 793
removing 67
resetting 68
searching 64, 65
soloing 638, 639
text formatting 389, 584

Key Editor 773, 775, 805
configurations 781, 818, 819
controls 813, 814, 817
copying 782, 791
deleting notes 792
dynamics. See Dynamics editor
height 779
histogram. See Histogram tool. See also Transform 
tool
inputting notes 786
instruments 777
key commands 47, 777, 779
locking 777
MIDI CC. See MIDI CC editor
moving notes 788
note duration 786, 787, 789, 793
panel 773, 775
percussion. See percussion editor
piano roll. See piano roll editor
pitch bends. See MIDI Pitch Bend editor
playing techniques. See Playing Techniques editor

Key Editor (continued)
rhythmic grid 775, 780
scrolling 773, 780
selecting 781
selecting velocity bars 818
slurred notes 1530
tempo 810
toolbar 775
Transform tool. See Transform tool. See also 
Histogram tool
transposing notes 790, 791
tuplets 784
velocity. See Velocity editor
voices 636, 775, 777
zoom 773, 779

key signatures 1210, 1219
accidentals 907, 908, 942, 1211, 1214
appearance 1211
atonal 1213
barlines 967, 972, 1214
cancellation style 1214
cautionary 1216
changes 972, 1211, 1214
changing 281, 283, 439
clefs 1214
custom 902, 905, 907, 910, 911
default settings 1211
deleting 459
dialog 905, 908, 911
engraving options 1211
enharmonic equivalent 1217, 1218
filter 433
gaps 1211
hiding 113, 140, 279, 281, 283, 1210, 1213
inputting 278, 280, 281, 283
instruments without 113, 140, 1210, 1217
major 1212
MIDI import 96
minor 1212
moving 465, 468, 1215
multi-bar rests 1498, 1499
multiple 1210
naturals 1214
none 1213
octave divisions 907, 1219
open 1213
panel 280, 283
placement 1214
playback 912
polytonality 281, 283, 1210
popover 279, 281
position 281, 1214
respelling 1218
scales 1212
selecting 426, 430–432
showing 1213
signposts 281, 283, 453, 1210
spacing 1211
start repeat barlines 972
tonality systems 902, 905, 1219, 1220
transposing 180, 480, 481, 1218
transposing instruments 174, 837, 1217
types 279, 1212
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Key Signatures, Tonality Systems, and Accidentals 
panel 280, 283
key switches 925

expression maps 912, 918
MIDI import 96
percussion maps 931

Keyboard panel 207
key commands 47

keyboard shortcuts. See key commands
keyboards

inputting chord symbols 839
inputting notes 220
key command maps 64
layouts 67
MIDI 839

keys
major 1212
minor 1212
signatures. See key signatures
transposing 480, 481

kick drum. See unpitched percussion
kits. See percussion kits
kneed beams. See centered beams

L
l.v. ties. See laissez vibrer ties
labels

brackets 1542
condensing. See player labels
cues. See cue labels
divisi 1574, 1577–1579
instrument changes 134–136
instruments 185, 1531
markers 1430
ossia staves 1560
percussion kits 1545, 1694
player groups 1542, 1543
staves. See staff labels

laissez vibrer ties 1387, 1620, 1629
angle 1632
shape 1632
width 1629, 1632

landscape orientation 683, 684, 691
lanes. See editors. See also tracks
languages 59

application 59
date and time 61
ensembles 115
instruments 60, 113, 115, 134, 185, 188
key commands 29, 64, 67
repeat counts 1458
staff labels 60
tokens 61

large
noteheads 1250
selections 428
time signatures. See large time signatures

large time signatures 1645, 1646
bar numbers 990
vertical position 1654

largo. See tempo marks

latency
changing value 269
MIDI recording 263, 268

lattice arrangement
accidentals 945

layers. See voices
layout cards 118, 122

disclosure arrows 45
numbers 118. See also layout numbers
opening 118

layout frame chains 570
layout names 181, 184

accidentals 184
borders 1192
changing 184
first pages 532
resetting 184
tokens 577

layout numbers 118
changing 175
order 175

layout options 30, 834
bar numbers 981, 982, 984, 986
copying to other layouts 765
dialog 834
saving as default 834
searching 834

Layout Options dialog 834
layout selector 34

order of layouts 175
switching layouts 46

layouts 27, 118, 122, 169, 743
accidentals 484, 487
adding flows 172
adding pages 702, 703
adding players 171
bar numbers 981, 984–986, 995
blank staves 699
borders 1192. See also margins
braces 1025, 1026, 1028, 1030. See also staff 
grouping
brackets 1025, 1026, 1028, 1030. See also staff 
grouping
cards. See layout cards
casting off 728, 729, 731, 732
chord symbols 1041
clefs 176, 177, 179, 181, 331, 1074–1076
color mode 676
comparing 51
concert pitch 174, 577, 1191
condensing 710, 743
condensing labels. See player labels
copies 671
copying formatting 174, 765, 766
copying frames 566
copying properties 768
creating 96, 171, 174, 176
cues 421, 1085
custom scores 169
deleting 176
deleting pages 704
divisi 1567, 1568
divisi staff labels 1576, 1579
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layouts (continued)
duplicating 174
dynamics 1108
editing 542
empty pages 702, 703
empty staves 696, 699
enharmonic spelling 484, 487
exporting 675, 680
exporting audio 103
exporting MIDI 99
figured bass 1141
file names 678
fingering 1165
fit to paper 684
fixing 729, 731
flow headings 550, 554, 555, 558, 707, 708
flow ranges 673, 674
flows 122, 172, 573, 706
font size 846, 848
formatting 765
frame breaks 736
frame chains. See music frame chains
frame order 573
frames 566, 568
front matter 1188
full scores 169
graphics files 675, 685
harp pedaling 1361
headers 1190
hiding ossia staves 1559
hiding staves 696–698
image resolution 676
indents 1565, 1566
instrument change labels 1539
instrument filters. See instrument filters
justification 695, 709, 721
keyboard 64, 67
large time signatures 1645, 1646
Layouts panel 118
left pages 705
locking 729, 731
margins 692, 712, 715
markers 1431
MIDI import 96
multi-bar rests 984, 1496, 1497, 1500
multiple windows 52
music frames 568
MusicXML files 88
naming 184. See also layout names
navigation 444–447
note spacing 599
note spelling 484, 487
numbered bar regions 1468
numbers. See layout numbers
opening 36, 46
opening multiple 48, 51
orchestral order 127, 128, 162, 1542, 1543
order 175
orientation 683, 684, 691
ossia staves 1559, 1561
page numbers 1353
page ranges 673, 674, 680
page size 683, 691

layouts (continued)
page template sets 529, 692
page templates 527, 540, 549
page turns 736
panel in Print mode 667
panel in Setup mode 118, 169
paper sizes 683
parts 169, 171, 765
percussion kit presentation 1695
percussion legends 1696
player labels 760
player lists 1190
player order 127, 128, 162, 1542, 1543
players 122, 171, 574
playthroughs 995
printing 671, 680, 684
propagating parts 765, 766
properties 768–771
rehearsal marks 1425, 1429, 1564
removing flows 172
removing page overrides 545
removing players 171
renumbering 175
repeat marker text 1451
restoring 176
running headers 708, 1190
scale size 684
selecting 34
settings 834
sorting 175
staff filters. See instrument filters
staff grouping 1030
staff labels 577, 1532, 1576, 1579
staff size 693
staff spacing 694, 695, 721, 1613
staves 696–698
switching 46
system dividers 1562
system formatting 694, 709, 721, 733, 765
system objects 1563–1565
tabs 36, 48
tacet al fine 1497
tacets 739, 741, 742
text 388, 532, 1606, 1613, 1618
time signatures 1645, 1646, 1656
timecodes 1431, 1436, 1438
titles 527, 532, 554
tokens 577, 1191
transposing 137, 169, 173, 174, 176, 177, 180, 181, 
577, 1191
vertical justification 695
view types 43
zoom 448

Layouts panel
Print mode 666, 667
Setup mode 110, 118

lead sheets
barlines 973
bars per system 729
capo chord symbols 151–154
chord diagrams grid 1060, 1062
chord symbols 1036
clefs 1075
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lead sheets (continued)
key signatures 1213
project template 80
systems per frame 729

leading 848, 850, 1611
learning materials 72
ledger lines 1246, 1256

accidentals 942
hiding 1257
width 1256

left hand hooks. See lines
left pages

formatting 540
starting from 705

left zone 40, 41
Engrave mode 515, 516, 519, 520
hiding 47
Print mode 667
Setup mode 111
showing 47
Write mode 201

left-foot pedals. See harp pedaling. See also pedal lines
left-hand fingering 1169

default settings 1158
engraving options 1158
erased backgrounds 1173
hammer-ons. See hammer-ons
inputting 274, 278
letters 1175
placement 1158
popover 278
position 1172
pull-offs. See hammer-ons
size 1169
slides 1176, 1177
string indicators 1185
tapping. See tapping

left-hand guitar tapping. See tapping
legato

note durations 259
playback 842, 920, 1530
playing technique. See playing techniques. See also 
playback techniques
slurs 1502, 1530

legends
percussion. See percussion legends

leggiero. See dynamic modifiers
length 436, 609

arpeggio signs 349, 350, 1313
audio 104
bar repeat phrases 439, 1460
barlines 967, 974, 976–978, 980
bars 455, 962
braces 1033
brackets 1033, 1269
chord symbol parentheses 1053
continuation lines 1392, 1393, 1399
divisi passages 465, 468
dynamics 436, 801, 1121
figured bass 1144, 1145, 1148, 1150
fingering slides 1178
glissando lines 1321
grace note slashes 1199

length (continued)
guitar bends 1333, 1335, 1337
H-bars 1498
hairpins 1105, 1109, 1126
hold lines 1144, 1145, 1148, 1150, 1330, 1333
hooks 609, 1369, 1445
instrument names 135, 136, 184, 1532
jazz articulations 1350, 1351
laissez vibrer ties 1629
lines 385, 387, 436, 1392–1394, 1399, 1410–1412, 
1423
lyric extender lines 1240
lyric hyphens 1240
messa di voce 1105, 1126
multi-bar rests 1498
notated duration of notes 793
notehead brackets 1269
notes 259, 787, 789, 793
octave lines 436, 1083
pedal lines 1369, 1374, 1376, 1381
percussion legends 1698, 1699
played duration of notes 793
player group names 164
player names 182
playing techniques 1392, 1393, 1399
repeat endings 1442, 1445
reverb tail 104
slurs 1503, 1516
staff labels 1532, 1535, 1575, 1576
stemlets 1017
stems 1005, 1273, 1279
string indicators 1392, 1393
system dividers 1563
systems 608, 709
tempo marks 1591, 1602
tick barlines 974
ties 1621
tuplet brackets 1674

lentando. See gradual tempo changes. See also tempo 
marks
lento. See tempo marks
let ring. See laissez vibrer ties
letter paper sizes 683
letters

rehearsal marks 1427
right-hand fingering 1175

levels
channels 821, 822, 827
dynamics. See dynamic levels
nested tuplets 1670
pedal lines 1368, 1369, 1371, 1372. See also pedal 
level changes

libraries 831
chord diagrams 854
dialog 831
exporting 834
fretted instrument tunings 145
importing 831, 833
percussion 930
project templates 80, 81
sound 617, 620, 636, 651, 912, 913, 930
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libretto
exporting 1227
librettist 78, 578

lifts
jazz articulations. See jazz articulations
pedal lines. See pedal retakes

ligado. See hammer-ons
light swing 643, 647
light theme 55
Limiter 825, 829
limits 814, 815, 817

histogram controls 814, 815, 817
Lin One Dither 825, 829
line breaks

player labels 763
repeat markers 1451
staff labels 185, 1538
text 388, 583

line spacing 693, 848, 850, 1611. See also staff spacing
linear points 807, 810

inputting 800, 806, 811
lines 1317, 1387, 1393, 1402, 1404

accidentals 1412
alignment 612, 1412
angled 385, 1402, 1409
annotations 884, 886, 888, 894, 897, 1404
appearance 877, 884, 886, 887, 1397, 1413, 1414
arpeggio signs. See arpeggio signs
attachments 385, 1402, 1405
backgrounds 1421
bar numbers 986–988
barlines. See barlines
beams. See beaming
bodies 886–888, 899
brackets 1023, 1027, 1029, 1542
caesuras. See caesuras
caps 884, 886, 888, 894, 897, 1398, 1404, 1414
changing 1397, 1413, 1414
chord diagrams 1057
chords 235, 349–351, 385, 387, 469–471
colors 58, 897, 900
columns 1407
components 1404
condensing 744
cross-staff 387
crosshairs 612
cues 1095
custom 884, 886–888, 891, 899, 900
default settings 888, 1405
deleting 459
diagonal 385
divider arrows 1574
drawing 811
duration 1410, 1411
dynamics 799, 800, 803
enclosures 982, 1425
end position 1412
ends 894, 897, 1404
engraving options 1405
erased backgrounds 1421, 1422
figured bass. See figured bass
fingerings 1181
fonts 1417

lines (continued)
frame breaks 1423
gaps 888, 891, 894, 1405
glissando. See glissando lines
grace notes 1197, 1407
gradual tempo changes 1603
groups 1542
guitar bends. See guitar bends. See also vibrato bar
handles 1423
harp pedaling 1358, 1365
hiding 436, 1095, 1144, 1396
holds. See hold lines
hooks 894
horizontal 385, 1402, 1405–1407
horizontal text 1420
importing 831
inputting 384, 385, 387
Insert mode 457, 458
jazz articulations 1348, 1351
joining notes. See beams
ledger 1256
length 609, 1410–1412, 1423
lyrics 392–394, 1222, 1240, 1241. See also lyric 
extender lines
markers 1431
MIDI 805, 806, 809
moving 465, 468, 609, 1406, 1407, 1423
noteheads 1247, 1412, 1683
notes. See stems. See also beaming
octave lines. See octave lines
order 1393, 1407
padding 1422
pauses. See caesuras. See also pauses
pedal. See pedal lines
placement 1406, 1408, 1409
playback. See playhead
player groups. See player group labels
player labels 763
playing techniques. See playing technique lines
position 1405
repeat endings. See repeat endings
repeat marker text 1451
repeatable symbols 886, 887, 891, 899, 900
resetting 888, 891, 894, 899
reversing 1415
secondary beams 1014
secondary brackets 1027, 1029
segments 1423
showing 436, 1095, 1144, 1396
size 1410, 1417
slurs 1502, 1512
staff-relative placement 1408, 1409
start position 1412
staves 1549, 1550
stemlets. See stemlets
stop position 457, 458
string indicators 381, 382, 436
string shift indicators 1182
symbols 894, 897
system breaks 1404, 1423
system dividers. See system dividers
tablature 1580, 1581
tempo marks 625, 810, 1600, 1602
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lines (continued)
terminal lines 894
text 848, 894, 1404, 1415, 1417–1422, 1543, 1614
thickness 840, 891, 1037, 1038
through noteheads 1247, 1683
ties 1622, 1624
timecodes 1431
trills 1296, 1297
tuplet brackets. See tuplet brackets
types 1397, 1402, 1405
velocity 797
vertical 387, 1402, 1405
vertical position 1393, 1405, 1408
vibrato bar. See vibrato bar
wedge 884, 886, 888, 891
width 709, 891
wiggly 1296, 1310

linking 1133
dynamics 464, 1133, 1135
flow headings 557
flow names 188
flow titles 188
groups of dynamics 1132, 1133
Key Editor 777
MIDI 464, 809
music to frames 571, 572
page templates 535, 536, 541
percussion maps to VST/MIDI 665
slurs 464, 1519, 1520
staves. See brackets. See also braces
tracks 777

lists
comments 507
Hub 72
players 181, 577, 1190

little finger. See pinky finger
loading

MIDI instruments 622
playback templates 656
sounds 622, 656
video files 192
VST instruments 622

local
chord symbols 318, 1036
figured bass 395, 1139
properties 768–771

locations
backups folder 109

lock
duration. See lock to duration
frames 517, 590, 591, 731, 732
Key Editor 777
layouts 731, 732
systems 516, 731, 732, 734

lock to duration 197, 483
loco. See octave lines
locrian

chord symbols 323, 1046
scales 495, 496, 503

lower case
bar numbers 994
chord symbols 1037, 1038
flow titles 579

lower case (continued)
repeat marker text 1448
Roman numerals 579
staff labels 60

lower limits. See limits
lower notes

percussion 238, 1683, 1686
trills 1309

lower zone 33, 40, 206
Engrave mode 769, 821
hiding 47
key commands 47
Key Editor. See Key Editor
Mixer panel. See Mixer panel
Play mode 773, 821
Properties panel. See Properties panel
Setup mode 121
showing 47
Write mode 769, 773, 821

lute. See fretted instruments
lv ties. See laissez vibrer ties
lydian

chord symbols 323, 1046
scales 495, 496, 503

lyric extender lines 392–394, 1222–1224, 1240, 1241
extending 392
handles 1240
inputting 392, 394
moving 609, 1240

lyric hyphens 1224, 1240
extending 392
handles 1240
inputting 392
moving 609, 1240

lyric lines 393, 1222, 1223, 1241
adding 392, 393
changing 1223, 1241, 1242
copying 1225
deleting 459
moving 1233
navigation 394
numbers 1241, 1242
offsets 1233, 1234
placement 1230
position 1230, 1233
resetting 1234

lyricist 78
first pages 532, 1188
fonts 848
tokens 578

lyrics 1222, 1607
alignment 1229, 1230
appearance 1222
beaming 1001
changing 1223, 1237–1239, 1241
chorus 393, 1223, 1241
colors 58, 1235
commas 1230
copying 1225
counts 1238
crosshairs 612
cues 1095
default settings 1222
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lyrics (continued)
deleting 459
dynamics 1105
East Asian elision slurs 1244
editing 1237–1239
elision slurs 392, 394, 1244
engraving options 1222
exporting 1227
extender lines. See lyric extender lines
filters 433, 1227, 1228
font styles 1235, 1236, 1239
gaps 1222, 1229
handles 1230, 1233, 1240
hiding 1095
hyphens. See lyric hyphens
inputting 392, 394
italics 1236, 1239
lines. See lyric lines. See also lyric extender lines
melismatic 392, 394, 1229, 1240
moving 465, 468, 609, 1105, 1230, 1232, 1233, 
1241, 1242
note spacing 600, 602, 1229, 1230
offsets 1233, 1234
paragraph styles 1235, 1236
periods 1230
placement 1229
popover 392–394
position 1222, 1229
printing 1227
punctuation 1230
resetting 1234
saving 1227
selecting 427, 433, 1228
showing 1095
size 1235, 1236, 1239
spacing 600, 602, 1229, 1230, 1233, 1235, 1236, 
1239
staff-relative placement 1232
syllable types 394, 1224, 1225
text 1237–1239
translations 393, 1223, 1241
types 393, 1223, 1224
verse numbers 1243, 1244
vertical position 1105, 1223, 1232, 1241, 1242
zoom 1238

M
macOS

printing 674
main chord symbols 146, 151, 152, 154

transposing 150
major

chord symbols 321, 322, 1037, 1038
intervals 480–482, 498
keys 1212
scales 495, 496, 503, 1212

make into
frame 517, 738
system 516, 734

Manage Instrument Filters dialog 450
mandolin. See fretted instruments
manual staff visibility 697, 698

manuscript paper 699–701
Map Pitches dialog 494
Map Scale dialog 496
maps

expression. See expression maps
key commands 64
percussion. See percussion maps
pitches. See pitch mapping
scales. See scale mapping

marcato. See articulations
margins 712, 1192

changing 608, 692
chord diagrams 1060
flow headings 550, 551, 713
hiding 444
instrument names. See staff labels
music frames 712, 715, 723
MusicXML files 86
pages 689, 692, 712
staves 608, 709, 712, 715, 1532, 1534, 1566
tacets 742

mark-up. See comments. See also annotations
markers 1430, 1435

appearance 1430
colors 58
comments. See comments
default settings 1430
deleting 403, 459
dialog 403
engraving options 1430
exporting 99, 104
filter 433
flags. See signposts
font style 1433
hiding 1431, 1453
important 404, 1434
importing 101
inputting 402, 403, 627
moving 465, 1433
panel 403
position 1430
repeats 407, 1447
showing 1431, 1453
signposts. See signposts
staff 1431
staff spacing 694, 721
text 101, 402, 403, 1432
timecodes 403, 1433, 1437
track 626, 629
vertical position 694, 721, 1430, 1431

marks
rehearsal. See rehearsal marks
tempo. See tempo marks
trills 1291, 1293, 1295, 1305

marquee tool 43
Key Editor 781
using 428, 781, 818

martelé. See articulations
masking. See hiding
master output volume 821–824, 827
master pages. See page templates
matches

options search 61, 834, 837, 839, 840, 842
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Maximizer 825, 829
measured tremolos. See tremolos
measurement

units 54
measures. See bars
medium swing 643, 647
melismatic lyrics 392, 394, 1229, 1240
melodic minor. See scales. See also key signatures
meno. See tempo marks. See also dynamic modifiers
Mensurstriche 977
merging

flows 82, 89, 90, 706
notes 96, 251, 254, 469, 743
pedal lines 1376
players 82, 83, 86, 89, 90, 93, 96
projects 82, 831
settings 831
staves 469, 743. See also condensing
voices 93, 96, 469, 743

messa di voce 1127
aperture 1121
gaps 1105, 1126
grace notes 1128
handles 1121, 1127, 1128
inputting 311, 313, 314, 316, 1129
length 1105, 1126
moving 465, 1105, 1121, 1127, 1128
showing 1129
ties 314, 316, 465

meter 1639
beam grouping 999, 1021
changing 439
channel levels 821, 822
irregular 962, 966
meterless time signatures 1640
note grouping 999, 1021, 1475
open 1641, 1647, 1650
rest grouping 999, 1021
rhythm slashes 1475
time signatures. See time signatures
tremolos 1659
tuplets 1669

metric modulation
tuplets 1672

metronome click. See click
metronome marks 1587, 1596

appearance 1589, 1590
beat units 296, 439, 1596
brackets 1589, 1590
changing 439, 812, 1596, 1598
click 267, 625
components 1589, 1590
decimal places 299, 301, 1596, 1599
equations 297, 1604
fonts 1594
hiding 1595
inputting 294, 299, 301, 811
moving 465, 609, 1599
multiple positions 1563
order 1599
parentheses 1589, 1590
playback 267, 625, 649, 1597, 1599
popover 294

metronome marks (continued)
range 1597
relative tempo changes 1598
selecting 427
showing 1588, 1595
size 1594
values 439, 812, 1596
vertical positions 1563

mezzo
dynamics. See dynamics
soprano clef. See clefs

microtones 902, 950
accidentals 907
custom tonality systems 902
EDO 1219
guitar bends 357, 1327, 1329
inputting 950
intervals 498, 499
key signatures 910
octave divisions 907
playback 912
transposing 500
trills 1299–1301

mid-system gaps
codas 1447, 1454, 1455

middle C
clefs 177, 179, 1070
expression maps 918
fretted instruments 142
layouts 177
percussion maps 931
playback 635, 918, 931

middle line
stem direction 1274, 1276

MIDI
accidental spelling 245
channels 617, 659, 821–824
commands 63, 66
controllers. See MIDI controllers
copying 464, 782, 809
deleting 783
devices. See MIDI devices
dialog 90, 98, 99
editor. See MIDI CC editor. See also MIDI Pitch 
Bend editor
endpoints 659, 661, 662, 664
exporting 102
expression maps 912, 913, 926, 927
fader 822
files. See MIDI files
Histogram tool 813, 815
importing 89, 90, 98
inputting 806, 809
instruments 617, 621, 624. See also MIDI 
instruments
Key Editor 805
linking 464
loading instruments 622
markers 626
mixer 821–824
navigation 66
note input 220, 235, 245, 246
note range 131
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MIDI (continued)
opening 75
order 918
overlapping notes 259
overriding 809
pan 822, 823, 828
pedal lines 1385
percussion maps 665, 930, 931, 933
piano roll editor 784
pitch bend 805
playback 624, 659, 930
ports 617, 659
quantization 98
range 131
recording. See MIDI recording
respelling 246
slurs 1530
tempo 625, 634, 810
Tempo editor 810
tempo track 625
tempo tracks 100–102
thru 263
unlinking 464
values 808, 813, 814, 817
volume 1138

MIDI CC editor 804, 805
adding 781, 805
closing 781, 805
constant points 807
copying points 782
deleting points 783
filter 815
height 779
Histogram controls 814
inputting points 806
linear points 807
moving points 808
pedal lines 1385
selecting points 781
Transform controls 817
transformations. See Transform tool. See also 
Histogram tool
values 808, 813, 815, 817, 818
zoom 779

MIDI channels 821–824
MIDI controllers 805, 1138

copying 464, 782, 809
dynamics 1138
editor. See MIDI CC editor. See also MIDI Pitch 
Bend editor
inputting 781, 806, 809
pedal lines 1385
Transform tool 817
transformations. See Transform tool. See also 
Histogram tool
values 808, 813–815, 817, 818

MIDI devices 271
activity 42
chord symbols 318, 326, 617, 627, 628, 839
disabling 271, 326
enabling 271, 326
expression maps 912, 926, 927
navigation 839

MIDI devices (continued)
note input setup 240
note spelling 839
percussion kits 240
percussion maps 930, 933
playback templates 651, 652
polychords 318
settings 839
warning 42

MIDI files 89
dialog 90, 99
exporting 99
grace notes 98
importing 89, 90
key signatures 96
opening 75
pedal lines 89, 96, 270
percussion maps 93
playback overrides 794
playing techniques 96
quantization 89, 98
repeats 640
requantizing 266
slurs 96
sustain pedal controllers 270
tremolos 96
trills 96
tuplets 98
unpitched percussion 90

MIDI Import Options dialog 90
MIDI instruments 617, 621

endpoints 661, 662
instances 621
loading 622
numbering 621
panel 620

MIDI Pitch Bend editor 804, 805
adding 781
closing 781
copying points 782
deleting points 783
height 779
moving points 808
selecting points 781
transformations. See Transform tool. See also 
Histogram tool
values 808, 815, 818
zoom 779

MIDI points
copying 464
linking 464
unlinking 464

MIDI Quantize Options dialog 98
MIDI recording 263, 264

audio buffer size 268, 270
click settings 267, 625
count-in 268
devices 271. See also MIDI devices
dialog 98
grace notes 98, 1195
input pitch 228
latency 269
optimization 268
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MIDI recording (continued)
overlapping notes 259
pedal lines 268, 270
pitch 228
quantization 98, 264
repeats 266
requantizing 266
retrospective recording 266
setup 268
slurs 268
starting 264
stopping 264
sustain pedal controllers 270
tempo mode 634
time signatures 264
transport window 649
tremolos 268
trills 268
voices 263, 264

MIDI thru 263
millimeters

staff spacing 723
unit of measurement 54

milliseconds 35, 649
mini transport 33, 35
minims. See half notes
minor

chord symbols 321, 322, 1037, 1038
intervals 480–482, 498
keys 1212
scales 495, 496, 503, 1212

minutes 35, 649, 1435
duration tokens 579

Missing Fonts dialog 76
missing sounds

loading 656
mixer 821, 822

channel strips 825
channels 821–824, 826
filters 825, 826
height 827
hiding 821–823
hiding audio outputs 659
muting tracks 638, 639, 821, 822
panning 823, 828
ports 821, 822
resetting 639, 821, 827
scrolling 826
showing 821–823
soloing tracks 638, 639, 821, 822
soundtracks 194
videos 194
volume 827

Mixer panel 821
key commands 47

mixolydian
chord symbols 323, 1046
scales 495, 496, 503

mock-ups
exporting 103

modal
chord symbols 323, 1046
scales 495, 496, 503
tonality systems 902

moderato. See tempo marks
modern accidental cancellation 953
Modernist accidental duration rule 951, 952
modes 22, 33

chords 215, 1046
Engrave 513
Insert 215, 237, 254, 454
jump bar 68, 70
Play 614
Print 666
scale mapping 495, 496, 503
Setup 110
tempo 634
transposing 495, 496, 503
Write 196

modifier keys
key commands 64
searching 64

modifiers. See dynamic modifiers
modulation wheel dynamics 1138
molto

centered 1118
dynamics 311, 313, 1116, 1118
font style 1136
marcato. See articulations
tempo marks 294, 297

monochrome graphics 686
MonoDelay 825, 829
monophony. See polyphony
MonoToStereo 825, 829
moon noteheads 1250, 1252
mordents. See ornaments
morendo. See gradual tempo changes. See also 
dynamic modifiers
MorphFilter 825, 829
mosso. See tempo marks
motors. See playing techniques
mouse input 212

activating 197, 229
deactivating 197, 229
settings 213

movements 23, 166
adding 166
exporting 84, 85
flow headings 554
importing 82, 83
multiple on pages 706
splitting 506
tacets 739

movies. See videos
moving 444, 465, 468, 609, 840

accents 957
accidentals 947
arpeggio signs 1313
articulations 957–960
bar numbers 987, 988, 1472
bar rests 1492
barlines 459, 975
bars 730, 734, 736, 737
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moving (continued)
braces 1025, 1026, 1030, 1032–1035
brackets 1025, 1026, 1030, 1032–1035, 1052, 1054, 
1269
breath marks 1205, 1208
caesuras 1206
cancellation naturals 1215
caret 220, 254
channels 826, 827
chord diagrams 1062, 1068
chord symbols 1042, 1043, 1052, 1054
clefs 465, 468, 1071, 1072
counts 1456, 1471, 1472, 1482
crosshairs 612
cues 1087
cursor 274, 325, 394, 400
dives 1335, 1337
dynamics 465, 801, 1105, 1108, 1118, 1121, 1128, 
1132, 1133, 1135
fermatas 1205, 1208
figured bass 1144, 1148, 1150
fingerings 1062, 1172, 1177, 1178
flow headings 713, 723
flows 168, 737, 738
frame breaks 732
frames 563, 564, 712, 713
fret numbers 1068
glissando lines 1321
grace notes 1195, 1196, 1198
gradual dynamics 465, 1105, 1121
graphic slices 593, 594
guitar bends 1333, 1335–1337
H-bars 1499
hairpins 465, 1105, 1121, 1127, 1128
hammer-ons 1346
hold lines 1333
instruments 134, 141, 165
jazz articulations 1350
Key Editor 780
key signatures 1215
layouts 175
lines 1406, 1407, 1423
lyric extender lines 1240
lyric hyphens 1240
lyrics 1105, 1230, 1232, 1233, 1241, 1242
marcato 957
markers 1433
messa di voce 465, 1121, 1127, 1128
MIDI points 808
multi-bar rests 1499
navigating. See navigation
notehead brackets 1269, 1270
notes 465, 477, 479, 599, 788, 790, 791, 1258, 
1259, 1689, 1706, 1708, 1709
notes to other staves 468, 790, 791, 1009, 1012, 
1692
notes to other strings 1583
numbered bar region counts 1471
octave lines 1083
ornaments 1293
page format changes 553
page numbers 563
pages 447, 702

moving (continued)
panning 828
parentheses 1052, 1054
pedal lines 96, 1369, 1374
percussion 1689
piano roll 780
players 127, 128, 165
playhead 447, 631
playing techniques 1392, 1393
pull-offs 1346
repeat counts 1456
resolutions 1150
rests 599, 1492
rhythm dots 1258–1260, 1708
rhythm slashes 1477
selection. See navigation
slash region counts 1482
slashes 1198
slurs 1516, 1524
staccato 957
staves 127, 128, 608, 693, 694, 712, 715, 723
stop positions 457
stress marks 957
string indicators 1187, 1392, 1393
subito 1118
system breaks 732, 734
systems 723, 726, 734, 737, 738
tablature notes 1583
tabs 51
tacets 742
tapping 1346
tempo marks 812
tenuto 957
text 587, 588, 609, 840, 1612
text on lines 1417–1419, 1543
time signatures 1652, 1653
tremolos 1665
tuplets 468, 1669, 1679
vibrato bar 1337, 1392
view 446, 447, 780, 826

mp. See dynamics
MP3 files

exporting 103, 104
muffed notes. See dead notes
multi-bar rests 739, 1459, 1496

appearance 1491, 1497, 1498
bar count font 1500
bar numbers 984
barlines 308
clefs 1498, 1499
end of flows 1497
formatting 865
hiding 1496
key signatures 1498, 1499
moving 1499
numbers 865
placement 1499
showing 1496
signposts 453, 1500
single bars 1496, 1498
splitting 1500
staves 1499
symbols 865
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multi-bar rests (continued)
tacet al fine 1497
tacets 739, 741
time signatures 1498, 1499
width 1498

multi-note tremolos. See tremolos
multi-pasting 462, 463
multi-rests. See multi-bar rests
multi-segment slurs 1520–1522
multi-staff instruments 1552

adding staves 1553
cross-staff beams 1009–1012
cues popover 422
deleting staves 1551, 1552
hiding staves 696–698, 721
slurs 273
width 1555

multiple
bar numbers per system 987
bounce roll. See tremolos
codas 1448, 1450
cues 1096
flows on pages 706
movements 166
segnos 1448, 1450
staff input 219, 235

multiple-voice contexts 1704
articulations 956
cues 1096
dynamics 441, 1115
fermatas 1205, 1207
grace notes 1194, 1504
guitar pre-bends 1331
inputting notes 231
note alignment 1707
notes 1710
ornaments 441, 1293
rests 1487, 1489
rhythm dot consolidation 1258, 1259
slashes 1475, 1477
slurs 1504
stem direction 1194, 1274, 1710
ties 1626
voice column index 1708

music
arranging. See arranging
assigning to frames 571
condensing. See condensing
deleting 129, 141, 169, 455, 459, 962–964
editing 212
extracts. See flows. See also graphic slices
fixing into frames 738
fixing into systems 734
symbols. See music symbols
transforming. See transformations

music area 37
flow heading editor 555
making selections 428
moving music 446, 447
multiple windows 52
navigation. See navigation
opening flows 616
opening layouts 36, 46, 50

music area (continued)
page arrangements 44, 53
page template editor 540
panels 47
Play mode. See track overview
view options 43, 44, 53
zoom options 45, 448

music fonts 72
substitutes 846

Music Fonts dialog 844
music frame chains 569

assigning to frames 571
blank staves 700
flows 573
imported page templates 537
layout 568, 570
page templates 537, 568, 569
players 574
propagating part formatting 765
selectors 570
unlinking frames 572

music frames 560, 568
deleting 567
flows 573
frame chains 569, 571, 572
fullness 526
highlights 513, 723
inputting 562
layouts 568
margins 712, 715, 723
order 573
overrides 568
padding 526, 712, 715, 723
page templates 568
players 574
selecting 565
selectors 570
vertical justification 721

music symbols 865
character styles 851
custom 897
dialog 865
editing 865
inputting 388, 391, 577, 583, 886, 887
lines 886, 887, 894, 897, 899, 900
text 388, 391, 577, 583
tokens 577

MusicXML
chord symbols 1055
dialog 88
exporting 88
importing 86
opening 75
pedal lines 1386
percussion 87
repeat endings 1446
resetting beaming 1002
staff labels 1532

muted
colors 639
notes. See dead notes

mutes. See playing techniques
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muting
channels 638, 823, 829
colors 639
deactivating 639, 821, 822
effects 829
inserts 829
instruments 638
items 639
notes 435, 639
slash notes 477, 1483, 1485
tracks 638, 821, 822
voices 638

mutual exclusion groups 922
editing 929

N
names

drum sets 155
flow headings 554–557, 559
flows 188, 189
graphic slices 596
groups 159, 1575
instrument filters 450
instruments. See instrument names
layouts 181, 184
mixer 823
noteheads 1251, 1254
page template sets 531
page templates 536, 539
percussion kits 155, 159
player groups 162, 164, 1542, 1543
players 181–184, 577, 1535, 1536
staff labels. See staff labels. See also instrument 
names
tokens 576

naming schemes
file names 678

narrow time signatures 1656
Nashville

chord symbols 321, 1037, 1038
numbers 320

natural harmonics 1282
appearance 1286, 1288
hiding 1283
showing 1283

natural minor. See scales. See also key signatures
naturale. See playing techniques
naturals

hiding 943, 952, 953, 1214, 1285
inputting 244
key signatures 1214
parentheses 943, 952, 1285
showing 943, 952, 953, 1214, 1285

navigation 68, 444, 445
bars 447
caret 220
chord symbols popover 325
figured bass popover 400
fingerings popover 274
flows 446
frames 565
graphic slices 595

navigation (continued)
handles 565, 595, 606, 611, 723
items 445
jump bar 68–70
Key Editor 779, 780
layouts 46, 50
lyrics popover 394
mixer 826
music area 445
note input 221, 224, 242
notes 445
pages 446, 447
part layouts 46, 50, 616
percussion editor 779, 780
piano roll 779, 780
print preview area 39, 666
rehearsal marks 447
rhythmic grid 214
strings 142
Write mode 445

nested
slurs 1506, 1517
tuplets 1670

New Flow Heading dialog 557
New Page Template dialog 536
new projects 74
New York chord symbols 1038
niente 1129

circle 1129, 1131
deleting 1130
inputting 311, 313, 314, 316, 1130
moving 1105, 1121
styles 1131
text 1129, 1131

ninth chord diagrams 839
no chord symbols 323
nodes 1282

changing 1284
non-arpeggio signs. See arpeggio signs
non-drop frame timecodes 1435
non-power of two time signatures. See time signatures
non-sustaining instruments 1136

velocity 796. See also Velocity editor
non-transposing layouts 173
nonuplets. See tuplets
notated duration 793

played duration 793
requantizing 266
tool 775

notation options 30, 837
barlines 968, 971
beaming 998
condensing 744, 755
dialog 837
percussion kits 1690
rests 1490
saving as default 837
searching 837
voices 1705

Notation Options dialog 837
notation reference 941
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notation staves 1580
hiding 1582
showing 1582

notations
appearance 769, 840
changing 439
copying 461–463
cues 1086, 1095
editing 769
inputting 25, 271
panels 196
percussion kits 1693
popovers 25
position 769, 840
properties 769
selecting 427, 428
settings 834, 837, 840
stacking order 1083
tucking index 1083
zoom options 45, 448

Notations toolbox 202
notches

octave lines 1080
pedal lines. See pedal retakes
slurs 1510
ties 1622

note and rest colors 58, 1261, 1491
changing 57, 58
condensed music 764
cues 1103
exporting 675, 687
hiding 444, 639, 1261, 1705
inverting 57
muted 639
notehead sets 1251
notes out of range 57, 1261, 1580
printing 671, 687
rests 1491
tablature 1580
unison ranges 1573
voices 57, 1705

note brackets. See bracketed noteheads
note durations 17, 201, 259, 793

changing 259, 789
chords 251
different 231
expression maps 913, 927
forcing 262
hiding 201
inputting 221, 224, 259, 262
inputting beats 303
Key Editor 787, 789
metronome marks 296
notated 793
percussion 238, 787, 789
playback 842, 920
played 793
quantization 98
rhythm dot consolidation 1259
selecting 259, 261
showing 201
slash regions 1475
splitting 261

note durations (continued)
tablature 242
tempo equations 296
transformations 488
tuplets 254, 257
voices 231

note event actions. See key switches
note grouping 26, 1021

beaming 998–1002, 1021
changing 262
hemiola 262
meter 999, 1021
note input 26, 27
pick-up bars 1644
rests 26
rhythm slashes 1475
ties 248
time signatures 27

note input 220, 221, 224, 786
adding notes 258, 499
caret 215, 220
chords 215, 251, 471, 472, 476
Drum Pads panel 210
Fretboard panel 209
fretted instruments 209
grace notes 250
input pitch 228
inputting vs. editing 212
Insert mode 215
Keyboard panel 207
lock to duration 483
MIDI 263, 264, 266, 268
mouse input 229
multiple staves 219, 235
muting notes 435
options 30
percussion 238, 240, 242, 787
piano keyboard 207
pitch 228
playing notes back 435
register selection 224
repitching notes 483
rests 1488
retrospective recording 266
rhythmic grid 214
starting 219
stem direction 242
strings 209
tablature 224, 242
ties 248
tuplets 254
voices 231

Note Input Options dialog 839
chord diagrams 1058
chord symbols 326
figured bass 1140

note names 503
case 60
chord symbols 321–323, 856, 1039
harp pedaling 1358, 1360, 1365
horn branch indicators 1166
inversion 500
language 60
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note names (continued)
noteheads 1251, 1253, 1254
pitch mapping 503

note spacing 514, 599, 600, 602, 793, 1010, 1492, 1499, 
1707

accidentals 947
activating 514
barlines 975
changing 599, 601, 604, 1493, 1708
chord symbols 1042
copying to other layouts 765
cross-staff beams 1010
default 599
deleting changes 604
dialog 602
filter 433
flows 601
fullness 526
galley view 43
grace notes 1194
guitar bends 1330
handles 604, 606
individual notes 604, 606
justification 526, 709
layout options 600, 834
layouts 599
lyrics 600, 602, 1229, 1230
resetting 603, 604
rests 1493
reverting 607
rhythm dots 1258, 1708
signposts 453, 601
stems 1010
systems 526, 709
voices 1258, 1708

Note Spacing Change dialog 602
note spelling 484, 485

adding notes 499
automatic 485
disabling respelling 839
layouts 487
resetting 487
transposing 500

note tools popover 498
adding notes 258
transposing notes 482

note values. See note durations
note velocities

MIDI import 96, 268
notehead sets 868, 871, 1246, 1247, 1251, 1254

colors 1251
creating 874
custom 869, 874
designs 1247, 1251
dialog 869
duplicating 874
importing 831
ledger lines 1257
pitch-dependent 1251
resetting 831, 869
scale degree 1251
types 1246

notehead-attached lines. See lines

noteheads 1247
aikin 1251
arrows 1249
articulations 959–961
attachment points 869, 871
brackets. See bracketed noteheads
changing 1252–1254
circular 1247
colors 58, 1251
creating 874, 875
crosses 1248
cues. See cues
custom 868, 871, 874, 875
default design 1253
designs 868, 869, 871, 1247, 1251, 1252
dialog 869, 871
diamond 869, 1248, 1250, 1283, 1286
dotted 1250
duplicating 874, 875
editing 871
fermatas 1205
five-line staff 1685
funk 1251
harmonics 869, 1283, 1286
hiding 874, 1257, 1262
importing 831
large 1250
ledger lines 1257
lines 1412
moon 1250
muted 1250
note names 1251, 1254
overlapping 1706
parentheses. See bracketed noteheads
percussion 238, 787, 791, 1683, 1685, 1686, 1688
pitch-dependent 1251
playing techniques 791, 1683, 1685–1687
rectangular 1250
resetting 869
sets. See notehead sets
shapes 868, 871, 1247, 1251, 1254. See also 
notehead sets
showing 1257, 1262
size 440, 869, 871, 874, 875, 1085, 1086, 1247
slashes 1250, 1473, 1483, 1683
square 1250
staccato position 958
stemless 1280
time signatures 1649
triangular 1249
types 1247
unpitched percussion 1683, 1685
walker 1251
wedges 1249

NotePerformer
microtonal playback 912
trills 1307

notes 26, 1246
above staves 258, 479, 1009, 1036, 1079, 1086, 
1257, 1556, 1557
accidentals 201, 244, 942
adding to existing notes 258
alignment 1107
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notes (continued)
appearance 769, 1246, 1581
arpeggio signs. See arpeggio signs
articulations 201, 955, 957
auditioning 435, 436
auxiliary 1303
beaming 998, 1000
below staves 258, 479, 1009, 1036, 1079, 1086, 
1257, 1556, 1557
brackets. See bracketed noteheads
brass fingerings 1179
changing pitch 479, 483
chord diagrams 1057
chord symbol alignment 1042
chords 251, 254, 327, 471, 472, 476
colors 57, 58, 639, 764, 1251, 1261, 1705
condensing. See condensing
copying 461–463, 791, 955
crossing to other staves 468, 1009, 1012
cues. See cues
custom scale size 440
dead notes 1344
default settings 1246, 1581
deleting 455, 459, 792, 962, 1664
deselecting 435
dotted 229, 999, 1021
durations 201, 259, 261, 787, 789, 793
dynamics 310, 796, 799, 1104. See also Dynamics 
editor
dynamics alignment 1106, 1107
editing 197, 769
editorial. See bracketed noteheads. See also 
comments
enclosures 1584, 1585
engraving options 1246, 1581
enharmonic spelling 246, 484, 485, 487
exploding 470–472, 476
filters 433, 434
fixing duration 262
flags 865
fonts 844
formatting 865
generating from chord symbols 471, 472, 476
ghost notes 1265
glissando lines. See glissando lines
grace notes 250, 1193, 1195
grouping 999, 1021
guitar bends 355, 356, 1323
guitar post-bends 357, 1327
guitar pre-bends 357, 1326
hammer-ons 1343
harmonics. See harmonics
harp pedaling 1358–1360
hiding 1257, 1262, 1477
hiding ledger lines 1257
hiding stems 1280
horizontal spacing. See note spacing
horn branch indicators 1179
inputting 220, 221, 224, 228, 229, 237, 238, 251, 
262, 471, 472, 476, 786, 787
Insert mode 237, 454
inverting 489, 490, 500
jazz articulations. See jazz articulations

notes (continued)
Key Editor 773, 784
laissez vibrer ties 1629
ledger lines 1256, 1257
length 259, 787, 789
lines. See lines. See also glissando lines
lock to duration 483
lyric alignment 1230
middle line 1276
moving 489, 491, 1258, 1259, 1683, 1686, 1706, 
1708
moving graphically. See note spacing
moving rhythmically 465, 788
moving to other instruments 791, 1692
moving to other staves 468, 469, 791, 1009, 1012
moving to other strings 1583
multiple-voice contexts 1706, 1710
muting 638, 639, 1344, 1387
navigation 445
notated duration 27, 793
note spacing 599, 601
notehead designs 868, 869, 871, 1247
notehead sets 1246
order 1708, 1709
out of range 57, 1261, 1583
overlapping 259, 1705, 1706, 1708
overrides 793, 794
parentheses 1263, 1265
partials 1282
pasting into voices 462
pedal lines 1368, 1374
percussion editor 781, 785–789, 791
percussion kits 238, 787, 1683, 1689, 1690, 1694, 
1701, 1702
percussion maps 931
piano roll editor 773, 781, 784, 786, 788–790
pitch 479, 483
pitch mappings 493
pitch-dependent noteheads 1251
Play mode 786
playback 632, 636, 638, 639, 912
played duration 793, 794
popover 498
properties 769
ranges 57, 1261
register 224, 479, 483
removing stem direction changes 1278
repitching 483
requantizing 266
resetting 794
rests 1488
retakes 1368, 1374
reversing 489. See also retrograde
rhythm dots 229, 1258–1260, 1708
rhythm slashes 1484
rhythmic grid 214
rolls. See tremolos
rotating 491
scale mapping 495
scale size 440
secondary beams 1013
selecting 426–428, 435, 445, 781
showing 1257, 1262, 1477
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notes (continued)
single line 1689
size 440, 1085, 1086
slash regions 1477
slashes 1473, 1483
slurs 201, 955, 1505
spacing. See note spacing
speed 259, 261, 1019, 1587
spelling 246, 484, 485, 487
splitting 197, 261, 1631
staff spacing 694
stem direction 477, 1274, 1277, 1278, 1702
stem length 1279
stemlets 1017
stems. See stems
string fingerings 1181, 1182, 1255
string indicators. See string indicators
strings 1583
swapping 469
symbols 865
tablature 1581, 1583
terminology 17
ties 27, 248, 957, 1628
time signatures 1649
transforming 488
transposing 479–482, 500, 790
tremolos. See tremolos
trill intervals 1300, 1301
trills 1295
tuplets 1669, 1671
types 201
unbeaming 1001
undamped 1629
unisons 1706
unscaling 1196, 1672
velocity 796. See also Velocity editor
voices 231, 477, 478

Notes panel 196, 201
Notes toolbox 197
November music font 844
nudging. See moving
numbered bar regions 984, 1467

alignment 1472
changing number 1469
counts 1468–1470
default settings 1468
engraving options 1468
font style 1465, 1468
frequency 1468, 1469
gaps 1468, 1472
handles 436, 1467
hiding 1468
highlights 1461
inputting 420
length 436
moving 465, 1472
panel 410
parentheses 1468, 1470
placement 1471
popover 409
position 1472
showing 1468

numbered bar regions (continued)
staff-relative placement 1471
systems 1468

numbers
backups 108
bar repeats 1461, 1462
barlines 641
bars. See bar numbers
bars per system 729
beam lines 1014
chord diagrams 854, 1062, 1064–1066
condensing 760, 1546, 1548
figured bass. See figured bass
fingerings 1180
flows. See flow numbers
frets. See frets. See also tablature
instruments 128, 132, 760, 1538, 1539
layouts 175
lyric lines 1241, 1242
moving 609
multi-bar rests 1496–1500
notes per chord 472
numbered bar regions 1467–1469
pages 547, 1353, 1354
player labels 760
plug-in instances 617, 620, 621
rehearsal marks 1426, 1427
repeats 641
rhythm slashes 1480
slash region counts 1480
slur segments 1521
staff labels 1532, 1538–1540, 1546, 1548
staff lines 699, 700, 1694, 1695
staves 696, 701, 1552, 1553, 1556, 1557
strings. See string indicators
systems per frame 729
tablature. See tablature
time signatures 1649
tuplets 1678
value fields 772
verses 1243, 1244

numerators
styles 1647, 1649
time signatures 1639, 1640

numeric value fields 772
nut

chord diagrams 1057
fretted instruments 142
tablature 146, 147, 1580

O
oboe. See instruments
octatonic

chord symbols 323
scales 495, 496

octave divisions 907, 1219
changing 902, 907
custom 907
EDO 1219
playback 912
tonality systems 902, 907
transposing 480, 481
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octave lines 1079
alignment 1082
angles 1080, 1081
appearance 1080
crosshairs 612
cues 1090
default settings 1080
deleting 459
Engrave mode 1083
engraving options 1080
filter 433
fingerings 1158
formatting 865
frame breaks 1083
handles 1083
hooks 1083
inputting 329, 332, 335, 336
length 436, 609, 1083
moving 465, 468, 609
panel 336
placement 1083
popover 330, 332, 335
position 1080–1083
selecting 427
size 440
stacking order 1084
staff-relative placement 441
symbols 865
system breaks 1083
tucking index 1083
types 332, 1079

octave transpositions 479–481
clefs 330, 331, 1076–1078
cues 1086, 1090, 1091
figured bass 1154
inversions 489, 490, 500
octave lines 332, 1079
pitch mapping 493, 494, 503
scale mapping 495, 496, 503

Octaver 825, 829
octuplets. See tuplets
odd-numbered layouts

booklets 681
printing 671, 681

offsets 609, 772
accidentals 947
bar numbers 986–992
chord symbols 1043, 1054
cues 1087, 1088
frames 563, 564
fret numbers 854, 1065, 1066
lyric lines 1233, 1234
multi-bar rests 1498, 1499
played duration 793, 794
player labels 760
playing techniques 1388
rehearsal marks 1426
resetting 443
rhythm dots 1258, 1708
timecodes 191, 1436
tuplets 1679
videos 191
voice columns 1258, 1708, 1709

omissions
chord diagrams 839, 1057, 1058, 1066
chord symbols 322, 326

opacity 453, 596, 676, 686
open

key signatures 1213
meter 285, 288, 290, 1641, 1647, 1650
strings. See open strings
time signatures 285, 288, 290, 1641, 1647, 1650

open strings 1282
appearance 1185
chord diagrams 854, 1057, 1066
harmonics 1282
pitches 142, 144
string indicators 1185

opening 75
auto-saved files 107
documentation 72
editors 781, 819
files 75, 107
flow heading editor 558
flows 616
Key Editor 773, 781, 819
layouts 46
MIDI files 75, 90
mixer 821–823
MusicXML files 75
page template editor 541
panels 47
projects 74–76, 107
tabs 48, 49
templates 74
transport window 649
video tutorials 72
video window 193
windows 52
zones 47

optical spacing
cross-staff beams 1010

optimized staves 694–696. See also condensing
optional notes. See bracketed noteheads. See also 
parenthesized chord symbols
options 30, 769

engraving 840
items 769
layout 834
notation 769, 837
note input 839
page sizes 684
playback 842
preferences 61
properties 769
searching 61, 834, 837, 839, 840, 842
text formatting 389, 584
toolbar 33
transport 33, 35
workspaces 33, 34
zoom 42, 45, 448

orchestral
cues. See cues
instrument filters. See instrument filters
order 127, 141, 162, 175, 1542, 1543
panning 828
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orchestral (continued)
shorthand 115
staff grouping 1026, 1542
templates 74, 80, 115

orchestrating. See arranging
order

accidentals 945, 947, 1211
actions 918
articulations 957
band 127
chord symbols 1048
dynamics 1105
expression maps 913
flows 78, 168
frame chains 569, 571, 573
instrument filters 450
instruments 128, 132, 141, 160, 182, 183, 1538
key signatures 1211
layouts 175
lines 1407
lyrics 1105
metronome marks 1599
MIDI messages 918
names 141, 182, 183
notes 1708, 1709
orchestral 127, 128, 141, 162, 1542, 1543
pages 44, 53
player group labels 1543
players 127, 128, 162, 1542, 1543
playing techniques 1393
rehearsal marks 1426
repeat markers 1449, 1450
rhythm dots 1258, 1259, 1708
score 127, 128, 162, 1542, 1543
staff labels 1538
string indicators 1393
tabs 50
tempo marks 1599
voices 837, 1258, 1705, 1708

orientation
changing 691
chord diagrams 1069
exporting 684
landscape 683, 684
portrait 683, 684
printing 671, 684

ornaments 1291
acciaccaturas. See grace notes
accidentals 1292, 1305
alignment 1293
appoggiaturas. See grace notes
changing 439
colors 58
crosshairs 612
cues 1095
default settings 1291
deleting 459
engraving options 1291
filter 433
formatting 865
hiding 1095
inputting 341, 342, 347, 348
intervals 1292

ornaments (continued)
jazz 1349. See also jazz articulations
length 436
moving 465, 468, 489, 491, 609, 1293
pages 542
panel 346, 348
placement 1293
popover 342, 347
position 1291, 1293
reversing 489. See also retrograde
rotating 491
selecting 427
showing 1095
size 865
slurs 1293
staff-relative placement 441
symbols 865
trills. See trills
types 342

Ornaments panel 348, 350, 351
ossia staves 1556

adding 1557
barlines 1560
condensing 747, 1556
cues 421
deleting 1552
hiding 1559
moving 465, 468
padding 1558
playback 1556
preamble 1558
showing 1559
signposts 453, 1556
size 1557
staff labels 1560, 1561
staff spacing 694, 721
system objects 1565
vertical spacing 694, 720, 721

ottava lines. See octave lines
outcomes. See results
outputs

audio export 61
mixer 659, 821, 822
plug-ins 659
volume 827

overdubbing
MIDI recording 266

overlapping
accidentals 945, 947
articulations 959
barlines 980, 1108
braces 1032, 1033
brackets 1032, 1033
cues 1096
dynamics 1108
notes 254, 259, 453, 723, 1258, 1259, 1705, 1706, 
1708
slash regions 1475
slurs 1507
staves 691, 693, 694, 716, 723
text 453, 723, 1613
voices 1258, 1259, 1705, 1706, 1708
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overline text 389, 584, 848, 851
instrument names 185
staff labels 185

Override Percussion Noteheads dialog 1685
overrides

barlines 308, 309, 453, 972
chord symbols 856, 857, 864
clefs 176, 177, 179, 181, 331, 1074–1076
condensing 753
dynamics 800, 803
endpoints 661
flow headings 545, 554
layouts 176, 177, 179–181
MIDI points 809
music frames 568
note duration 793, 794
page templates. See page template overrides
paragraph styles 588, 1611
placement 441
playback templates 651, 652, 654, 656, 661, 662
played duration 794
removing 181, 588, 794
swapping 553
text 575, 588, 1611
transposition 176, 177, 180, 181, 331, 1074–1076
velocity 794

overscroll 447
overtones. See partials

P
padding

accidentals 1211
bar numbers 982
barlines 967
chord diagrams 1060
chord symbols 1037, 1038, 1050, 1054
clefs 1072
cues 1086
dynamics 1111
enclosures 982, 1425
frames 587, 689
hairpins 1281
harp pedaling 1363
key signatures 1211
lines 1422
music frames 526, 712, 715
ossia staves 1558
percussion legends 1701
player labels 763
playing techniques 1390
rehearsal marks 1425
rests. See padding rests
silence 104
stems 1281
text 587, 848, 1422, 1616
ties 1657
time signatures 1652, 1657

padding rests 1098, 1487
cues 1098
hiding 1098, 1478
slash regions 1478

page arrangements 43, 44, 53

page breaks. See frame breaks
page format changes 542, 553
page formatting 689

bars per system 729
blank staves 699–701
casting off 728
copying 727
dedications 1188
divisi 1567, 1568
empty staves 696, 699
fixing 728, 729, 731, 738, 765, 766, 768
flow headings 550, 553, 554, 689
formatting 529, 542
frame constraints 590
left pages 705
locking 731
make into frame 738
make into system 734
manuscript paper 700, 701
moving systems 726
multi-bar rests 1500
multiple flows 706
page size 691
page templates 527, 529, 532, 540, 541, 550, 692
resetting 545, 550, 553, 732
staff size 716
staff spacing 694, 720, 727, 1613
staves 697, 698
systems 608, 694, 729
tacets 741
text 844–846, 848, 851, 853, 1613
titles 527, 554

page margins 689, 712
changing 692, 715
frames 562
graphic slices 593
hiding 444

Page Number Change dialog 547
page numbers 533, 1353

appearance 1354
changing 545, 547
count 580
flow headings 708, 1355
flows 579
font styles 1354
hiding 547, 708, 1355, 1356
horizontal alignment 1354
initial 705, 1355
moving 563, 702
numeral style 547, 1354
page templates 533
paragraph styles 1354
position on page 563
removing changes 548
sequence changes 545, 547
showing 708, 1356
size 1354
tokens 579, 580
total 580

page ranges
exporting 673, 674
flows 673, 674
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page ranges (continued)
printing 673, 674
selecting 680

page size 683, 684
changing 691
graphics files 675
layout options 834
MusicXML files 86

page template editor 540
opening 541

page template overrides 542, 1607
deleting pages 704
moving 702
removing 545
text 575

page template sets 529
applying 692
creating 529
deleting 532
exporting 531
flow headings 529, 554, 556, 557
importing 530
layouts 692
naming 531

page templates 28, 527, 532, 540
adding 535, 536
assigning to pages 549, 706
based on 535, 536, 541
composer 532
copying 527, 530, 532, 537, 549
copying layouts 541
custom 532, 535, 536
dedications 1188
default 532
deleting 540
editing 540, 541
exporting 81, 531, 831, 834
first 532, 706
flow headings. See flow headings
frame chains 537, 569, 571, 572
frame constraints 590
frames 562–564
graphics frames 540, 589
importing 537, 538, 831, 833
links 535, 536, 541
moving 702
music frame padding 715
music frames 568
naming 539
overriding. See page template overrides
page numbers 533, 563, 1353
panel 522
project templates 80
removing changes 550
removing flow heading changes 553
resetting 831
running headers 1190
saving 81, 531
sets. See page template sets
text alignment 587, 588
titles 532
types 532

page turns. See frame breaks

page view 43, 53
arrangements 44, 53
cues 1089
flows 506
navigation 446, 447

pages
adding 702, 703
arrangements 44, 53
assigning flow headings 550
assigning page templates 549
background color 56, 57
breaks. See frame breaks
changing view 53
color 55, 57
copying 527, 530, 532, 537, 549
deleting 545, 704
dragging 447
edges. See page margins
editing 542, 545
exporting 598, 673–675, 680
extracts. See graphic slices
flow headings 555
formatting 542, 1188
frames. See frames
fullness 526, 693, 695, 716, 717
going to 446
graphic slices 592, 593
hiding empty staves 697
layouts 527, 540, 689, 728, 729
locking 731
making from selection 738
margins 689, 692, 712, 713, 715
moving 553, 702
multiple flows 706
navigation 446, 447
numbers. See page numbers
order 573
orientation 691
page templates 527, 540, 549, 689
panel 522
printing 673, 674, 680, 684
ranges 680
rectangles. See frames. See also graphic slices
resetting 704
setup 684
size. See page size
staff spacing 727
swapping 553
templates 527, 540, 555
tokens 580
total number 580
turns. See frame breaks
view options 42

Pages panel 513, 522
palettes. See panels
panels 40, 202

accidentals 283
arpeggio signs 346, 350
bar repeats 410
barlines 305, 309
bars 305, 306
clefs 332, 334, 336
cues 423, 425, 1102
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panels (continued)
drum pads 210
dynamics 313, 316
Engrave mode 513, 769
flows 110, 121
formatting 516
frames 519
fretboard 209
glissando lines 346, 351
graphic slices 520
guitar techniques 346, 356, 360, 362, 364, 365
hiding 34, 45, 47
holds 340
jazz articulations 346, 354
Key Editor 773
key signatures 280, 283
keyboard 207
layouts 110, 118, 667
MIDI instruments. See track inspector
mixer 821
notations 205
notes 201
octave lines 336
ornaments 346, 348, 350, 351, 354
pages 522
pauses 340
pedal lines 372, 378
Play mode 614
players 110, 111
playing techniques 372, 375, 378
Print mode 666
print options 668
properties 769
repeat endings 410
repeat markers 410
rhythm slashes 410
Setup mode 110
showing 34, 45, 47, 206, 515
tempo 297, 301
time signatures 287, 290, 292
tonality systems 283
tremolos 410, 417
VST instruments. See track inspector
Write mode 196, 201, 205, 769

panning 822, 823, 828
paper

color 55
duplex printing 682
orientation 683, 684
size 683, 684, 691

paradiddle 221, 259, 1669
paragraph styles 845, 848, 985, 1429

bar numbers 985, 986, 994
borders 848
changing 850, 851, 853, 1611
condensing 760, 1544
creating 850
default 853
deleting 848
dialog 848
divisi 1544, 1574, 1577
exporting 831, 848
horizontal alignment 851

paragraph styles (continued)
importing 831, 848
inputting text 388
instrument names 1544
lyrics 1235, 1236
missing fonts 76
overrides 588, 1611
page numbers 1354
player group labels 1542, 1544
player labels 760, 1577
rehearsal marks 1429
repeat markers 1448
resetting 831, 1611
saving as default 848
staff labels 1544
tacets 739
text frames 1611

Paragraph Styles dialog 848
parallel

chords 472, 476
intervals 472, 476
lines 998, 1013, 1204, 1317, 1393, 1562
motion 472, 476

parent styles
paragraph styles 848, 850

parentheses 1032, 1460
accidentals 943, 952, 1285
bar numbers 994, 996
bar repeats 1461, 1464
capo chord symbols 146, 1037, 1038
chord symbols. See parenthesized chord symbols
counts 1464, 1468, 1470, 1480, 1482
dynamics 1110
figured bass 397, 1140, 1143, 1147
fingerings 274, 276, 1158, 1168
fret numbers 1323, 1328
ghost notes. See bracketed noteheads
guitar bend releases 1330
guitar bends 1323, 1326
harmonics 1285
hiding 1052
inputting 318, 324, 395, 397, 943, 1051, 1110, 
1143, 1147, 1265, 1285
instrument transpositions 1538
metronome marks 1589, 1590
moving 1054, 1269
noteheads. See bracketed noteheads
numbered bar regions 1468, 1470
octave line numerals 1079
padding 1054
pedal continuation signs 1382, 1383
percussion notes. See bracketed noteheads
playing techniques 1395
shape 1053, 1143, 1147, 1265
showing 1052
size 1053
slash regions 1480, 1482
staff labels 1538
string shift indicators 1255
style 1053
tablature 1286, 1323, 1326, 1328
tempo marks 1589, 1590
thickness 1053
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parentheses (continued)
tie chains 1266
time signatures 285, 288, 1647, 1651
trills 1291, 1303
vibrato bar dives and returns 1328

parenthesized chord symbols 1050, 1263
capos 146, 1037, 1038
moving 1054
padding 1054
showing 1051
single 1052
size 1053
style 1053

part formatting 765, 766
system formatting 765

part layouts. See layouts
part names 181, 184
partial

beams 1013
capos 147–149
harp pedaling 1365
hiding. See erased backgrounds

partial bars. See pick-up bars
partials 1282, 1284
parts. See layouts
pasting. See copying
pataflafla. See grace notes. See also sixteenth notes
patches

endpoints 659
playback 659, 912, 930

path
export 84, 88, 99, 102, 103, 597, 677

patterns
chord diagrams 854, 1056, 1064–1066
inversion 489, 490
mapping 493–496, 503
pitches 493, 502
repeating 461, 493, 502
retrograde 489, 490
rotating 491, 492
scales 495, 496, 503

pauses 1202, 1204
appearance 439
barlines 1208
breath marks. See breath marks
caesuras. See caesuras
changing 1206
condensing 744, 747
crosshairs 612
default settings 1203, 1205
deleting 459, 1493
duration 439
engraving options 1203
fermatas 1203, 1207
filter 433
formatting 865
hiding 1493
inputting 337, 339, 340
linked 1206
moving 465, 609, 1208
multiple at same position 1206
panel 340
playback 1202

pauses (continued)
popover 337, 339
position 1203, 1205
rests. See rests
selecting 427
single staves 1206
staff-relative placement 441, 1205
symbols 865
types 337, 1202

PDF files 685
color 686
exporting 596, 598, 675, 676
fonts 686
graphic slices 596, 598
key commands 63
layout numbers 175
layouts 675, 676
page size 675
project preview 78

peaking 827
pedal level changes 1368, 1369, 1371, 1372

end level 1372
handles 1369
inputting 371, 376–379, 1371
removing 1373
start level 1371, 1372

pedal lines 1358, 1367
alignment 1368, 1374
appearance 1377, 1378, 1380, 1384, 1385
brackets 1382, 1383
changing 439
colors 58
continuation lines 1367, 1377, 1380–1382
crosshairs 612
dashed 1380
dashes 1381
default settings 1368
deleting 459
duration 1385
end signs 1379, 1380
Engrave mode 1369
engraving options 1368
filter 433
formatting 865, 1378–1380, 1382
gaps 1381
grace notes 1368, 1374
handles 1369
harp pedaling. See harp pedaling
hiding 1378–1380
hooks 1369, 1377, 1379
inputting 368, 371, 376, 378
length 436, 609, 1369, 1374, 1376
levels. See pedal level changes
lifts 1368
merging 1376
MIDI controllers 1385
MIDI import 89, 96, 270
MIDI recording 268, 270
moving 96, 465, 609, 1369, 1374
MusicXML import 1386
muting in playback 639
notes 1374
order 1374
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pedal lines (continued)
panel 372, 378
parentheses 1382, 1383
percussion 1387
playback 1385
popover 371, 376
position 1368, 1374
releases 1377
removing retakes 1373
retakes. See pedal retakes
signposts 453
splitting 1375
staff-relative placement 1374
start signs 1368, 1377, 1378, 1383
symbols 865
text 1383–1385
thickness 1382
types 371, 1367

pedal retakes 1368
alignment 1368
grace notes 1368
handles 1369
inputting 371, 376–379
notes 1368, 1374
pedal level 1372
position 1368
removing 1373
types 1370

pedals
harp pedaling. See harp pedaling
piano. See pedal lines

percentages
horizontal spacing 526, 600, 709
note duration 920, 1530
scale size 440, 671, 684, 1053, 1169
tempo marks 1588, 1598
vertical spacing 526, 695, 721

percussion
adding 113, 115, 125, 138, 139
articulations 960, 1683
drum sets. See drum sets
groups 162, 1542
instrument changes 134, 138
kits. See percussion kits
laissez vibrer ties 1629
legends. See percussion legends
note input 238, 240, 242, 786, 787
noteheads 791, 1683, 1685–1687
part names 181, 184
pictograms 876
pitched percussion. See instruments
playing techniques 935
rudiments 221, 259, 1193, 1659, 1667, 1669, 1689
staff labels 1536, 1542, 1545
staff position 1689
stem direction 1689
system objects 1564
tremolos 935, 1683
unpitched percussion. See unpitched percussion

percussion editor 785
copying notes 791
deleting notes 792
height 779

percussion editor (continued)
inputting notes 786
moving notes 788, 791
navigation 780
note duration 787, 789, 793
played vs. notated durations 793
playing techniques 785
scrolling 780
selecting notes 781
tools 775
tracks 623
zoom 779

Percussion Instrument Playing Techniques dialog 1683
percussion kits 1682, 1690

adding instruments 157
caret 238
changing instruments 157
creating 139, 157
drum sets. See drum sets
dynamics 1694
editing area 155, 1694
exporting 1691
filtering instruments 155
five-line staff 1549, 1694
gap sizes 161
grids 158–161, 1694
groups 158–160
importing 1691
individual instruments vs. kits 1689
inputting notes 238, 787
instrument order 160
legends 1696
moving notes 1692
naming 155, 158, 159
notation options 1690
notations 1693
note input 240, 242, 786
noteheads 791, 1683, 1685, 1686
playing techniques 791, 1682, 1683, 1686
presentation types 155, 1689, 1694, 1695
removing instruments 162
rests 837
rhythm slashes 1485
setting up 155, 240
single-line instruments 1694
spacing 161
staff labels 155, 158, 159, 1532, 1545, 1694
staff position 160, 240, 1683
staff-relative legend placement 441
staves 155, 1689, 1694, 1695
stem direction 155, 242, 837, 1701, 1702
stickings 1694
voices 155, 837, 1701, 1703

percussion legends 1696
adding 1697
backgrounds 1700
changing 1698
crosshairs 612
erased backgrounds 1700, 1701
handles 1698
instrument names 1699
layouts 1696
length 1698, 1699
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percussion legends (continued)
padding 1701
position 1696
ranges 1696, 1698
signposts 453, 1696
sounding instruments 1698
staff-relative placement 441
text 1700
types 1696, 1698

percussion maps 930
creating 933
custom 933
dialog 931
endpoints 659, 665
exporting 935
file format 935
filters 931
importing 935
linking 665
MIDI import 93
note input 240
playback techniques 931
resetting 931

Percussion Maps dialog 931
percussion stickings 1694
perfect intervals 480–482, 498
performance instructions 527, 532, 1188, 1607

adding 388, 535
musical extracts 592
parts 388
playing techniques. See playing techniques

period 17
dynamics 1118
lyrics 1224, 1230, 1244
player labels 761
repeat markers 1448
resting 423
rhythm dots 197, 229
staff labels 1535
subito 1118
verse numbers 1244

Petaluma music font 844
Phaser 825, 829
phrases 747, 750

bar repeats 439, 1460
breath marks 1208
chord symbol regions 1044
condensing 747, 750, 755
slurs 1502
splitting 753, 755

phrygian
chord symbols 323, 1046
scales 495, 496, 503

piano 131
chord symbol playback 628
depressed notes. See bracketed noteheads
dynamics. See dynamics
hand marks. See lines
level changes 1368, 1373
pedal lines. See pedal lines
playback 1385
reduction. See reducing. See also condensing
retakes 1368, 1373

piano (continued)
slurs 273
substitution fingering 1159

piano roll editor 784
copying notes 791
deleting notes 792
height 779
independent voice playback 784
inputting notes 786
moving notes 788
navigation 780
note duration 786, 789, 793
pitch 784, 786, 790
played vs. notated durations 793
scrolling 780
selecting notes 781
tools 775
tracks 623
transposing notes 790
tuplets 784
zoom 779

piccolo. See instruments
pick-up bars 1641, 1643

deleting beats 303, 455, 962, 963
inputting 284, 286, 291, 292, 455
turning bars into 455, 1644

pictures
frames 589
inputting 589
videos 190

pincé. See ornaments
pinch harmonics 1286, 1289
PingPongDelay 825, 829
pinky finger 1169

inputting 278
letter 1175
popover 278

pit band. See bands. See also project templates
pitch

accidentals 244, 942
bends. See pitch bends
changing 144, 479, 481–483, 790
changing string 1583
chord diagrams 854, 1065, 1066
clefs 176, 177, 179, 333, 334, 1070
click 267, 625
concert 174
crossing 744, 755
cues 1093
dips 1344
expression maps 913, 926
filters 433, 434
fretted instrument strings 144
guitar strings 144
guitar techniques 1344
harmonics 1282–1284
input 228
instruments 137, 140, 176, 177, 179, 180
inverting 489, 490, 500
jazz articulations 1348
key signatures 1210
mapping 493, 495
metronome click 267, 625
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pitch (continued)
microtonal 498, 950, 1219
note input 224, 244
noteheads 1246, 1251, 1254
octave lines 335, 336, 1079
open strings 142, 144
ornaments 1292
partials 1282, 1284
piano roll editor 784, 790
playback 635
popover 498
ranges 1261
repeating 493, 502
reversing 489, 490. See also retrograde
rhythm slashes 233, 1485
rotating 491, 492, 502
strings 142, 144, 854, 1065, 1066, 1255
transposed 137, 174, 176, 177, 180
transposing. See transposing. See also transposed 
pitch
trills 1298, 1300, 1301, 1304, 1306, 1309

pitch before duration 224
accidentals 228
activating 197
articulations 228
rhythm dots 228

pitch bends 1317, 1323
guitar. See guitar bends
MIDI controllers 804, 806

pitch delta 908
accidentals 904
changing 904
microtonal playback 912
tonality systems 905

pitch mapping 493, 494, 503
più. See tempo marks. See also dynamic modifiers
pizzicato. See playing techniques
placement

articulations 959, 960
breath marks 1205
caesuras 1206
changing 441
chord symbols 1043
dynamics 1105
fermatas 1205
fingerings 1158, 1162
glissando lines 1318
grace notes 1194
harp pedal diagrams 1364
lines 1406, 1408, 1409
lyrics 1229
octave lines 1084
order 1083
ornaments 1293
pauses 1205
pedal lines 1374
playing techniques 441, 1392
rehearsal marks 1425
rests 1487
rhythm dots 1586
slurs 1503, 1505, 1514
tempo marks 1591
ties 1621, 1626, 1635

placement (continued)
tremolos 1661
tucking index 1083, 1084
voices 1707

plain font 845, 846, 848, 1607
bar numbers 985
chord symbols 1039
figured bass 1152, 1153
fingerings 1068, 1166, 1167
multi-bar rests 1500
playing techniques 1387
rehearsal marks 1429
string indicators 1183
tablature 1586
tasto solo 1152, 1153
tempo marks 1594
time signatures 1656
tuplets 1680

Play mode 22, 614
channels. See channels. See also tracks
deleting notes 792
Endpoint Setup dialog 659
exporting expression maps 930
expression maps 912, 923
inputting notes 786
loading sounds 622, 636
MIDI instruments 617, 621, 622
mixer. See mixer
moving notes 788
note durations 787, 789, 793
overrides 794
panels 40, 614, 617
percussion editor 785
percussion maps 930
piano roll editor 784
playback 632, 842
playhead. See playhead
switching 614
toolboxes 614
track overview 615
tracks 623
transport 35, 649
VST and MIDI panel 620
VST instruments 617, 620, 622, 636
window elements 614
zooming 630, 779

playback 632, 936, 1567
accents 961
accidentals 912
activating 33, 632
arpeggio signs 1314–1316
articulations 636, 637, 842, 913, 961
audio buffer size 268, 270
bar repeats 1460
bracketed noteheads 1265
bypassing inserts 829
changing sound libraries 657
channels. See channels. See also tracks
chord symbols 617, 627–629
chords 436
click 267, 625, 632, 649, 810
custom tonality systems 912
dead notes 1344
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playback (continued)
default settings 656
default tempo 459, 1587
divisi 1579
dynamic curve 1137
dynamics 435, 636, 637, 799, 920, 1115, 1136, 
1137
elapsed time 649, 651
endpoints 659, 661, 662, 664, 665
excluding items 639
exporting audio 103, 104
expression maps 912, 913
faders 821, 822, 827
fast-forwarding 631
fixed tempo 634
flows 664
follow tempo 634
gap between flows 635
ghost notes 1265
glissando lines 1322, 1358
grace notes 1201
guitar bends 1323
harmonics 1282–1284
hidden staves 1551
hiding notes 1477
instruments 636, 637, 912, 930
jazz articulations 936, 1348
Keyboard panel 207
legato 842, 920, 1530
line 630
marcato 961
metronome 649, 1599
metronome click 625
microtones 912
MIDI controllers 805
mixer. See mixer
multiple windows 52
muting 638, 639, 821
mutual exclusion groups 929
note durations 793, 842, 920
note velocity 796
notes 435, 436, 636, 637
number of times played 641
options. See playback options
ornaments 1291
ossia staves 1556
overrides 794
panning 828
patches 659
pauses 1202
pedal lines 1385
percussion 665, 785, 791, 930, 931, 1682, 1683, 
1685, 1686
pitch 635
playhead. See playhead
playing techniques 636, 637, 927, 936, 937
playthroughs 641
plug-ins 822
pre-roll 635
preferences 61
recording notes 266
repeats 640, 641
resetting volume 827

playback (continued)
reverb 823, 824, 830
rewinding 631
rhythmic feel 646, 647
selections 632
silence playback template 651, 652
slashes 477, 1477, 1483, 1485
slurs 273, 636, 637, 842, 1530
soloing 638, 639, 821
staccato 961
starting 632
swing 643–647
templates. See playback templates
tempo 625, 649, 810, 1596–1599
tempo equations 1604
tenuto 961
timecode 649, 651, 1430, 1435
transport 649, 651
tremolos 636, 637, 935, 1667
trills 1306–1308
tuning 635
velocity 796
vibrato bar dives and returns 1328
voices 636, 637, 664
volume 435, 821, 822, 827

playback options 30, 842
dialog 842
dynamics 1137
pedal lines 1385
repeats 640
saving as default 842
searching 842
slurs 1530
swing playback 644
timing 961, 1314
tremolos 1667
trills 1306

Playback Options dialog 842
Playback Technique Combinations dialog 923
playback techniques 659, 927, 936, 937, 954, 1387

attribute 937
combinations 923, 927
creating 937
deleting 929, 937
direction 937
editing 937
endpoints 659
expression maps 912, 913
fallback 937
mutual exclusion groups 929
percussion 935
percussion maps 931
playback templates 651
resetting 937

playback templates 651, 652
changing 656
creating 657
custom 651, 654, 657
dialog 652, 654
endpoint configurations 620, 659, 661, 662
exporting 658
factory default 652
fallback 654
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playback templates (continued)
file format 651
importing 658
metronome click 267, 625
overriding 651
resetting 656
track inspector 617

played duration 793, 1201, 1667
changing 793, 794
key commands 793
notated duration 793
overrides 793, 794
resetting 794
slurs 1530
tool 775

player cards 111, 122
disclosure arrows 45

player group labels 1531, 1542
brackets 1543
fonts 1542, 1544
hiding 1543
showing 1543
text position 1543

player groups 111, 162
adding players 163
bracket grouping 977
creating 96, 163
deleting 164
ensembles 115
filters 450
labels. See player group labels
MIDI import 96
moving players 165
naming 164
removing players 165

player labels 760, 761
backgrounds 763
changing 761, 762
default settings 761
engraving options 761
erased backgrounds 763
font 760, 1577
hiding 761, 1539, 1543
lines 763
moving 609
paragraph style 760, 1577
periods 761
position 760
separators 761
showing 761, 1539, 1543
signposts 761
staff labels 1531, 1536, 1542, 1546, 1548
to indications 762
unisons 760, 762
word wrapping 763

player names 181
changing 182
groups. See player group labels
instrument tracks 624
resetting 182, 183
staff labels 1535, 1536
tokens 577

player numbers. See player labels

players 24, 122, 124
adding 113, 115, 125, 130, 138, 163
adding ossia staves 1557
adding staves 1553
adding to flows 167
brackets 1025, 1026, 1542
cards 111
changing transposition 140, 180
chord symbols 318, 1040
clefs 176, 179, 1074, 1075
colors 624, 784, 785
combined parts 171
condensing 710, 743, 751, 752
copying 126
deleting 129, 141, 164
deleting staves 1551, 1552
divisi 1567, 1568, 1570
duplicating 126
editing divisi changes 1571
empty staves 696
ensembles 111, 129
exporting 84
exporting audio 103
exporting MIDI 99
extra staves 1552
figured bass 395, 1141
filters 574
flows 122, 167
frame chains 570, 574
groups. See player groups
hiding 167, 171
importing 82, 83
instrument change labels 1539
instrument order 141
instruments 24, 53, 131, 138, 140
layouts 122, 171, 184
lists 181, 535, 577, 1190
merging 82, 83, 86, 89, 90, 93, 96
MIDI import 90
moving 127, 165
moving between groups 165
moving instruments between 141
multiple instruments 53, 138, 182, 183, 1536
muting 638, 639, 821
naming 181–184, 1535, 1536
numbering instruments 132
ossia staves 1556
panel 110, 111
panning 828
part layouts. See layouts
percussion kits 139
pitch 137, 176, 177, 179, 180
player names 182, 183
position in score 127
removing from flows 167
removing from groups 165
saving 118
section players 111, 124, 125
showing 167, 171
single players 111, 124, 125
soloing 638, 639, 821
soloists 128
sorting 127
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players (continued)
staff labels 1535, 1536
staff size 718
staves 697, 698, 1551, 1553
swing playback 645, 646
system dividers 1562
tablature 1580, 1582
tokens 577
transposition 137, 176, 177, 180
unison ranges 1572, 1573
volume 827, 1115

Players panel 110, 111
playhead 630

color 57
fast-forwarding 631
hiding 632
moving 447, 631
playback 632, 649
position 632
repeats 640
rewinding 631
showing 632
transport 649, 651
zooming 630, 779

playing technique lines 1393, 1399
appearance 1396, 1397
caps 1398
changing 1397, 1401
components 1395
default settings 1393
duration 436, 1394, 1396
hiding 1396, 1397
showing 1396, 1397, 1400
system breaks 1395

playing technique-specific noteheads 1193, 1387, 
1682, 1683, 1685

appearance 1688
articulations 935
changing 791, 1686
creating 1687
inputting 238, 787
playback 935

playing techniques 1387
adding text 1388
attachment points 880
backgrounds 1389
brackets 1395
changing 439, 791, 1686
collision avoidance 1393
colors 58, 880
combinations 923, 927, 935
continuation lines 1388, 1393, 1397–1400
creating 882, 1687
crosshairs 612
cues 1095
custom 876, 877, 882, 883
default settings 1388
deleting 459
design 877, 880
dialog 880, 937
divisi 1567
duplicating 877, 882, 1396
duration 436, 1394, 1396, 1400

playing techniques (continued)
editing 880
editor. See Playing Techniques editor
endpoint configurations 662
engraving options 1388
erased backgrounds 1389, 1390
expression maps 912, 913, 936
filter 433
font 1387
frame breaks 1392
grace notes 1388
grouping 1393, 1399, 1400
guitar. See guitar techniques. See also vibrato bar
handles 1392, 1394, 1399
harmonics. See harmonics
hiding 1095, 1391
horizontal offset 1388
importing 831
inputting 368, 369, 373, 375
length 436, 609, 1392, 1393
lines. See playing technique lines
MIDI import 92, 93, 96
moving 465, 468, 489, 491, 609, 1392, 1393
muting 639
noteheads 791, 874, 875, 935, 1683, 1685–1688
order 1393
padding 1390
panel 372, 375
parentheses 1395
percussion 935, 1682, 1683, 1685, 1693
placement 1392
playback 636, 637, 912, 913, 936, 937
popover 369, 373
position 1388, 1392
repeating 877, 1396
resetting 877
reversing 489. See also retrograde
rotating 491
selecting 427
showing 1095, 1391
signposts 453, 1391
size 440, 1388
staff-relative placement 441
system breaks 1392
text 1387, 1388
ties 373, 375
tracks. See Playing Techniques editor
types 369, 1387
ungrouping 1401
vertical position 1393
voices 373, 375, 636, 637

Playing Techniques editor 795
hiding 795
showing 795

playing techniques lanes. See Playing Techniques 
editor
Playing Techniques panel 375, 378
playthroughs 1440

bar numbers 994–996
changing 641
dividing 1441
MIDI recording 266
optional notes. See bracketed noteheads
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playthroughs (continued)
repeats 641, 1441
total number 1441

plops. See jazz articulations
plucked instruments

arpeggio fingering 1174, 1175
fingerings 274, 1158, 1169
popover 278
slides 1176, 1177
string indicators. See string indicators
strings 1255
tablature. See tablature
tuning 142

plug-ins 651
allowing 636
blocking 636
changing 651, 830
configurations 654, 659, 661–664
endpoints 651, 659, 664, 665
expression maps 665, 913
instances 617, 620
loading 622
mixer 659, 822, 825
percussion maps 665
playback 617, 620, 651, 822
reverb 830
saving 661–663

plus sign
caret 215
chord symbols 1037, 1038
mutes. See playing techniques
rim shots. See playing techniques. See also playing 
technique-specific noteheads
tapping 1340, 1343
time signatures 285, 1641

PNG files 685
color 686
exporting 596, 598, 675, 676
graphic slices 596, 598
graphics frames 589
layout numbers 175
layouts 675, 676
project preview 78
resolution 685

poco a poco
centered 1118
dynamics 311, 313, 1116, 1118, 1126
font style 1136
tempo marks 1589, 1591

points
constant 807
copying 782, 803, 809
deleting 783
dynamics 799–801
linear 807
MIDI 805–808
selecting 781
staff spacing 723
tempo changes 810, 811
unit of measurement 54

polychord chord symbols 323, 1036
arrangement 1037, 1048
inputting 318

polymeter 288, 290, 1639
polyphony 1704

adding voices 231
changing voices 477
condensing. See condensing
exploding 470
MIDI import 93
MIDI recording 263, 264
reducing 469

polytonality 281, 283, 1210
popovers 25, 202

add intervals. See note tools popover
arpeggio signs 344, 349
bar repeats 409, 419
barlines 302, 304, 305, 308, 309
bars 302, 305
beats 303
changing items 439
chord symbols 320, 325, 839
clefs 330, 333
commands. See jump bar
cues 421, 422
dynamics 311, 314
ensembles. See ensemble picker
figured bass 397, 400
fingerings 274, 276
glissando lines 344, 350
guitar techniques 344, 355, 358, 359, 361, 363, 
364, 366, 367
harp pedaling 371
holds 337, 339
instrument filters 450
instruments. See instrument picker
jazz articulations 343, 352
key signatures 279, 281
lyrics 392–394
metronome marks 294
note tools 258, 482, 498
numbered bar regions 409
octave lines 330, 332, 335
ornaments 342, 347, 349, 350, 352
pauses 337, 339
pedal lines 371, 376
playing techniques 369, 373, 376
repeat endings 407
repeat markers 407
repeats 407, 415, 419
rhythm slashes 409
string indicators 371
tempo 294, 299
time signatures 285, 288, 291
transpose 500
tremolos 408, 415
trills 343, 1301
tuplets 254, 256

port de voix. See ornaments
portamento. See glissando lines
portrait orientation 683, 684, 691
ports 617, 625, 659, 810

changing 664
chords track 617
expression maps 659, 665
instruments 664
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ports (continued)
mixer 822
percussion maps 659, 665
setup 659
Tempo editor 810
tempo track 625

position
arpeggio signs 1313, 1314
articulations 955–958, 961
cues 1087, 1088
dynamics 1105
figured bass 1148
fingerings 1158
fret numbers 1068
glissando lines 1318
grace notes 1194
gradual dynamics 1127
hairpins 1127
inputting 212
Insert mode 454, 457, 458
instruments in percussion kits 160
items 443, 769
jazz articulations 1350
key signatures 1214
lines 1405
new items 212
notes in multiple-voice contexts 1707
octave lines 1081, 1082
order 1083
pauses 1205
pedal lines 1374
resetting 443
rhythm dots 1586
rhythmic 27
slurs 1503, 1505, 1514
staccato 958
stop 454, 457, 458
string indicators 1186
trill intervals 1305
tucking index 1083
vertical order 1083
videos 193

possibile. See dynamic modifiers
post-bends. See guitar post-bends
pre-bends. See guitar pre-bends
pre-dives. See guitar pre-bends
pre-roll 635

duration 635
flows 635

preamble 1188
barlines 973
clefs 1075
key signatures 1213
ossia staves 1558
page templates 527

precipitando. See gradual tempo changes. See also 
tempo marks
preferences

colors 54
key commands 63, 66
MIDI 270
missing fonts 76
mouse input 213

preferences (continued)
note input 224, 228, 839
pedal lines 270
selection tools 43
sustain pedal controllers 270
theme 55

Preferences dialog 61
prefixes

bar numbers 996
chord diagrams 1057
dynamics 1116, 1117
fingerings 1179
fret numbers 1057
hiding 136
instrument change labels 60, 135, 136
rehearsal marks 1428

presentation types 155
changing 1695
dynamics 1694
editing area 155, 1694
percussion kits 1689, 1694

presets
background color 56
chord symbols 1038
effects 925
instrument filters 450
repeat markers 1448
staff size 716
zoom 45

pressure. See playing techniques. See also lines
presto. See tempo marks
preview

color 55, 56
file names 678
font styles 846, 848
images 78, 106
lines 888, 894, 899
note spacing 600, 602
playing techniques 877
print preview 39, 666
projects 78, 106

previous versions 76
primary

beams 1013
instruments 777, 803, 806, 809

primary bar number sequence 990
changing 991, 992
returning to 993

primes 579
Print mode 22, 666

landscape orientation 680
page setup 684
panels 40, 666–668
portrait orientation 680
printers 679
switching 666

Print Options panel 666, 668
print preview area 39

navigation 39, 666
printers 679

selecting 671

Index
 

1804
Dorico Pro 4.3.30



printing 666, 671
annotations 687
arrangements 680
booklets 681
borders 687
comments 511, 687
copies 671
crop marks 687
date 687
duplex 671, 682
flows 673, 674
job types 680
key commands 63
landscape 680, 683
layouts 671
lyrics 1227
macOS options 674
note colors 687
options 668
orientation 683
page sizes 683, 684
paper sizes 683
PDF files 675
portrait 680, 683
preview 39, 444
ranges 671, 673, 674
scale size 671
signposts 687
spreads 680
time 687
voice colors 687
watermarks 687

program change actions 912, 918, 925
Project Default Chord Symbol Appearances dialog 857
Project Info dialog 78
project information 78

exporting 80, 81
flow titles 188
page templates 532, 1188
project templates 80, 81
tokens 78, 188, 578

project templates 74, 80
categories 80
deleting 82
Hub 72
MIDI import 90
saving 81
starting projects 74

project window 32
dark 55, 57
Engrave mode 513
light 55
opening multiple 52
Play mode 614
Print mode 666
Setup mode 110
splitting 51
theme 55
Write mode 196

projects 22, 78, 82
adding images 589
audio 103
auto-save 106, 107

projects (continued)
backup location 109
backups 108
default font styles 853
different Dorico versions 76
exporting 88, 99, 102
exporting flows 84, 85
flows 82–85, 166, 189, 506
font styles 853
frame rates 195
full screen mode 52
Hub 72
importing flows 82, 83, 86
layouts. See layouts
merging 82, 831
MIDI files 99
missing fonts 76
movements 166
multiple windows 52
MusicXML files 88
opening 52, 75, 76, 107
PDF files 675, 685
preview 78
recent 76
recovering 107
settings 30, 831, 834, 837, 839, 840, 842
splitting flows 506
start area 37
starting 74
tabs 51
templates. See project templates
titles 189
tokens 576, 578
videos 190, 192
window 32
workspaces 45

Propagate Part Formatting dialog 766
propagating

part formatting 765
properties 768

properties 769
copying to other layouts 768
global 770, 771
local 770, 771
notations 769
notes 769
scope 769–771
searching 769
selected items 769
values 772
videos 191

Properties panel 769
disclosure arrow 42
key commands 47
Write mode 196

pulgar. See thumbs
pull-offs. See hammer-ons
punctuation

duration 579
lyrics 1230
timecodes 1435
verse numbers 1244
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Q
qualifiers 311, 313
quality

chord symbols 318, 321, 1037, 1038, 1047
intervals 498, 499
transposing 480, 481, 500

quantization 98
changing 266
grace notes 98
MIDI import 89, 96, 98
MIDI recording 98, 264, 268
requantizing 266
splitting notes 261
tuplets 98

quarter depressed pedal lines 1368, 1369, 1371, 1372
quarter notes 17, 201, 221, 224, 235, 237, 259

beats 303
chords 251
grace notes 250
metronome marks 296
percussion 238, 787
playback 842, 920
rests 246, 1487
splitting notes 261
swing playback 643
tablature 242
tempo equations 1604
tremolos 415, 417, 1659
tuplets 254, 257
voices 231

quarter tones 902, 950, 1219
accidentals 907, 950, 1219, 1220
guitar bends 357, 1327, 1329
key signatures 910
octave divisions 907, 1219, 1220
tonality systems 1219, 1220
transposing 500

quartet templates 74, 80
staff grouping 1026

quavers. See eighth notes
question marks

harmonics 1283
tablature 479, 1580

quick tool selector 775
quintet templates 74, 80

staff grouping 1026
quintuplets. See tuplets
quotation marks 579

R
rack. See VST and MIDI panel
rallentando. See gradual tempo changes. See also 
tempo marks
randomization 814, 815, 817
ranges

arpeggio signs 349, 350, 1313
bar numbers 984, 1468–1470
colors 57, 58, 1261
copying notes 463
counts 1468–1470
cues 1085

ranges (continued)
dynamics in playback 1137
flow heading changes 551
flows 673, 674
glissando lines 1321
instruments 131, 142
keys 207
lines 387, 1313, 1410
metronome marks 1596, 1597
notes 142, 1261
numbered bar regions 1468–1470
page number changes 547
page template changes 549
pages 671, 673, 674
percussion legends 1698
selecting 428
slurs 1509
strings 142
swapping 469
unison 1572, 1573

rasterizing. See staff size
rastral size 716
ratamacue. See grace notes. See also tuplets
rates

frames 195
ratios

grace notes 1197
note spacing 600, 602
swing playback 643
tuplets 1678–1680

re-strikes. See guitar pre-bends
recent projects 72, 76
recipes 678
recording

audio 103
click settings 267, 625
count-in 268
devices 271
input pitch 228
MIDI. See MIDI recording
pedal lines 268
playing techniques 268
retrospective recording 266, 649
tempo 634

Recover Auto-saved Projects dialog 107
recovering 266

backups 108
files 106–108
notes 266

rectangle
above systems. See system track
bar number enclosures 982
borders 848, 1615
chord enclosures 1584
colored. See signposts
music. See music frames. See also frames
note enclosures 1584
noteheads 1250
notes 784, 785, 793
rehearsal mark enclosures 1425
text enclosures 848, 1192, 1614, 1615. See also text 
frames

redo 33
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reducing 169, 469, 477, 716
condensing. See condensing
note durations 259, 261
notes into chord symbols 327

reeds 169
adding 113, 115, 125, 138
instrument changes 134
part names 181, 184
staff labels 1536
transposition 137, 176, 180

regions
bar repeats. See bar repeats
bars. See numbered bar regions
chord symbols. See chord symbol regions
counts 1461, 1468, 1480
cues 423, 425, 1101, 1102
dynamics 799
Play mode. See colored regions
slashes 1474, 1479. See also rhythm slashes

register
accordion 876
changing 479, 481, 482
clefs 333, 334, 1070, 1077, 1078
cues 1090, 1093
note input 224
octave lines 335, 336, 1079
plug-ins 636
transposing 482, 1077, 1078

rehearsal marks 1424
alignment 1424
barlines 1425
colors 58, 1429
crosshairs 612
cues 423
default settings 1424
deleting 459
enclosures 1424, 1425
engraving options 1424
filter 433
font 1429
going to 447
index 1426
inputting 401
moving 465, 609
multiple positions 1425, 1563, 1564
navigation 447
order 1426
padding values 1425
placement 1425
position 1425
prefixes 1428
selecting 426, 430–432
sequences 1426, 1427
size 440, 1429
staff-relative placement 1425
starting number 1426
suffixes 1428
tempo marks 1425
types 1427
vertical positions 1563

relative channel change actions 925
relative tempo changes 1588, 1598

releases
guitar bends 1323, 1330
handles 1333, 1337
tremolos 408, 415, 417, 1661

reloading
video files 192

removing. See deleting
Rename Player dialog 182
Rename Player Group dialog 164
renaming

divisi 1548, 1575, 1578
drum sets 155
endpoints 663
files 72
flow headings 559
flows 188
graphic slices 596
groups 159, 1575
instrument filters 450
instruments 181, 184
layouts 181, 184
page template sets 531
page templates 539
percussion kits 155, 159
player groups 164
players 181–183
staves 181, 184
titles 188

renumbering
bars 990–992
flows 168
instrument filters 450
layouts 175
pages 545, 547, 548

repeat barlines 968, 970, 1447
appearance 967
brackets 974
counts. See repeat counts
dots 967
end of systems 972
exporting 640
gaps 1211
inputting 302, 304, 305, 308, 309
MIDI recording 266
number of times played 641
panel 305, 309
playback 640
playthroughs 641
popover 302, 304, 308
spacing 967
start of systems 972
text. See repeat counts
wings 974

repeat counts 1456
changing 641
hiding 1456
language 1458
location 1456
moving 1456
showing 1456

repeat endings 1440
additional endings 411, 413
alignment 1443
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repeat endings (continued)
appearance 1440, 1444
bar numbers 994–996
crosshairs 612
default settings 1440
deleting 459
engraving options 1440
exporting 640
filter 433
final segments 1444
font style 1443
frame breaks 1443
handles 1442, 1443
hooks 1445
inputting 407, 410–413
length 609, 1442
MIDI recording 266
moving 465, 609, 1442
multiple positions 1443, 1563, 1564
MusicXML files 1446
number of playthroughs 1441
optional notes. See bracketed noteheads
panel 410, 412, 413
playback 640
playthroughs 1441
popover 407, 410, 411
position 1440, 1443
segments 1440, 1443
selecting 426, 430–432
size 1442, 1443
system breaks 1443
text 1443
types 407
vertical positions 1563

repeat jumps. See repeat markers
repeat markers 1447

abbreviation 1448
appearance 1448
bar numbers 994–996
barlines 972, 1453
changing 439
coda symbols 1449
crosshairs 612
default settings 1448
deleting 459
engraving options 1448
exporting 640
filter 433
fonts 1448
hiding 1453
index 1450
inputting 407, 410, 414, 415
lines 1451
lower case 1448
MIDI recording 266
moving 465, 609
multiple 1450
multiple positions 1454, 1563, 1564
number of times played 641
optional notes. See bracketed noteheads
order 1450
panel 410, 415
paragraph styles 1448

repeat markers (continued)
playback 640, 641
popover 407, 414
position 1448, 1454
segno symbols 1449
showing 1453
size 1448, 1449
staff-relative placement 1454
text 1451
types 407
upper case 1448
vertical positions 1563
word wrapping 1451

Repeat Pitches dialog 493
repeat sections. See repeat markers
Repeat Structures panel 410
repeatable symbols 887, 899, 900

colors 900
line bodies 884, 886, 888, 891

repeating. See copying. See also repeats
repeats

barlines. See repeat barlines
bars 1459, 1467
counts 641, 1461, 1468
dynamics 640
endings. See repeat endings
engraving options 967, 1440, 1448, 1460
export 640
font style 1465
frequency 1463, 1469
grouping 1465, 1466
length 439, 1460
markers. See repeat markers
moving counts 609
notes. See tremolos. See also bar repeats
numbers 641, 1450, 1461, 1468, 1480
optional notes. See bracketed noteheads
playback 640, 641
playing techniques 1396
tempo marks 640
wings 974

repeats popover 407
repitching notes 483
replacing 439

flow headings 556, 557
fonts 76, 846
Key Editor configurations 819
page templates 535, 536

replying
comments 506, 507, 510

requantizing notes 266
resetting 459

accidentals 943
appearance 442
background color 56
bar numbers 992, 993
barlines 1034
beaming 1002, 1004, 1009, 1012, 1014, 1018
braces 1034, 1035
brackets 1034, 1035
capos 149–151
casting off 732
character styles 851
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resetting (continued)
chord diagrams 854, 1064, 1066
chord symbol voicing 629
chord symbols 864, 1046
clefs 181
colors 57, 58
condensing 755, 758, 759
cross-staff beaming 1009, 1012
dynamics 783
expression maps 923
figured bass 1155
fingering slides 1177
fingerings 1064, 1172
flow headings 553, 558, 831
font styles 846, 848
instrument names 185, 188
items 442, 443
key commands 68
layout names 184
layouts 176, 732
lines 888, 891, 894, 899
lyric lines 1234
music symbols 865
mute states 639, 821
note spacing 603, 604, 607
note velocity 798
noteheads 869
octave line angles 1081
options 61, 831, 834, 837, 839, 840, 842
page color 55
page numbers 548
page templates 550, 706, 831
pages 550, 704
paragraph styles 848, 1611
part layouts 176
percussion maps 931
playback overrides 794
playback techniques 937
playback templates 656
played duration 794
player names 182, 183
playing techniques 877
position 443, 1083
preferences 61
rests 1493
rhythmic feel 647
secondary beams 1014
solo states 639, 821
staff grouping 1035
staff labels 188
staff spacing 726
staves 697, 698, 723, 732
stemlets 1018
stems 1278
swing playback 647
systems 723, 732
tempo 1588
text 1611
transposition 181
trill intervals 1302
velocity 798
vertical spacing 726
voice order 1709

resetting (continued)
voicing 629
volume 827

resolution
changing 596, 676
chord symbols 476
figured bass 395, 397, 1144, 1150
generating notes 476
images 685
rhythmic grid 42, 214, 780

respelling
accidentals 207, 246, 484, 485, 487
chord symbols 146, 1045, 1046
key signatures 1218
notes 207, 246, 484, 485, 487, 493–496, 503
notes in cues 1092

rest grouping. See note grouping
restating

accidentals 951, 952
trill intervals 1291

restorative
clefs 333, 334, 1085, 1099
pedal lines 1383, 1385
text 1383, 1385

restoring. See resetting. See also hiding
rests 26, 1487

alignment 1487
bar count font 1500
bar rests. See bar rests
beaming 998, 1000, 1016, 1017
changing type 1490
colors 58, 1491. See also note and rest colors
condensing 744, 747, 755
consolidation 837, 1489, 1496
counts 1498
cues 1098, 1099
default settings 1491
deleting 259, 455, 962–964, 1493, 1494
dotted 837
durations 259
empty bars 1494
engraving options 1491
explicit 1487, 1488, 1490
figured bass 395, 1139, 1142, 1151
filling in 259
forcing duration 262
formatting 865
grouping. See note grouping
H-bars. See multi-bar rests
hiding 1098, 1099, 1478, 1493–1496
implicit 1487, 1488, 1490
inputting 197, 207, 221, 246, 247, 262
moving 599, 1492, 1499. See also note spacing
multi-bar rests. See multi-bar rests
notation options 1490
padding 1098, 1478
percussion kits 837
placement 1487
position 1487
restoring 1493
showing 1098, 1099, 1493–1496
spacing. See note spacing
stemlets. See stemlets
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rests (continued)
symbols 865
tacet al fine 1497
voices 1487, 1489, 1492, 1495
width 1498

results 750
condensing 750, 755

retakes. See pedal retakes
reticles. See crosshairs
retrieving. See recovering. See also retrospective 
recording
retrograde 489, 490, 501
retrospective recording 266, 649
reverb 823–825

changing 830
hiding 826
showing 826
tail 104

reverb channels
mixer 822

REVerence 825, 829, 830
reverse

lines 1415
pitches 489, 490, 501
printing 681, 682
rhythms 489, 490, 501
stems 1007–1009, 1012, 1274, 1276–1278

Reverse and Invert Pitches dialog 490
Reverse Rhythms dialog 490
reverting. See resetting
reviewing

comments 506
print preview 39, 444, 666

rewinding 631, 649
rfz. See dynamics
rhythm

chord symbols 327, 471, 472, 476
generating notes 471, 472, 476
locking 483
requantizing 266
reversing 489, 490, 501. See also retrograde
rotating 491, 492, 502
slashes. See rhythm slashes
tablature 1581, 1582

rhythm dots 229, 1021
Chord mode 254
compound time signatures 1473, 1475
consolidation 1258, 1259
deleting 1257, 1262
hiding 1257–1259, 1262
inputting 221, 224, 228, 229, 259
Insert mode 454
jazz articulations 1350
moving 1258–1260, 1708
number 229, 259
pitch before duration 228
placement 1586
rhythm slashes 1473, 1475
showing 1258, 1259
splitting notes 261
tablature 1581, 1586
tremolos 415, 417
voices 1258, 1259, 1706, 1708

rhythm section
brackets 1026, 1542
chord symbols 1040, 1041
staff grouping 1026, 1542

rhythm slashes 1473, 1474, 1483
appearance 1473, 1475
arpeggio signs 1310
bar rests 1489
beaming 1479
caret 215, 233
changing number 1480
counts 1480, 1482
default settings 1473
deleting 459
designs 1473
engraving options 1473
filter 433
font style 1465, 1480
frequency 1481
hiding rests 1478
highlights 1474, 1475
inputting 233, 410, 418
moving 465, 468, 1477
moving counts 609
note grouping 1021, 1475
panel 410
parentheses 1482
pasting notes into 462
percussion kits 155, 160, 238, 1485
pitch 233, 1485
placement 1482
playback 1485
popover 409, 418
regions 1473, 1474, 1480
rests 1478, 1489
rhythm dots 1473, 1475
splitting 1479
staff position 160, 1477
staff-relative placement 1482
stem direction 1278, 1476
stemless 215, 233
stems 1479
type 1484
vertical position 1477
viewing options 1475
voices 233, 477, 1476, 1483, 1484

rhythmic cues 1086
changing cues into 1087
moving 1087
position 1086, 1087
staff position 1088

rhythmic feel 643
changing 645
default settings 643
deleting changes 646
popover 297
signposts 453, 645, 646

Rhythmic Feel dialog 647
rhythmic grid 42, 214

changing 214
color 57
key commands 63, 66
Key Editor 775, 780
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rhythmic grid (continued)
resolution 42, 214
selecting music 432

rhythmic notation 27, 1473
rhythmic position 27

playback 630
rhythmic position-attached lines. See lines
rich black 686
ride bell. See unpitched percussion. See also playing 
technique-specific noteheads
right hand hooks. See lines
right pages

formatting 540
starting from 705

right zone 40, 41
Engrave mode 522
hiding 47
Print mode 668
Setup mode 118
showing 47
Write mode 205

right-foot pedals. See harp pedaling. See also pedal 
lines
right-hand fingering 1169

arpeggio signs 1174, 1175
brackets 1170
default settings 1158
engraving options 1158
inputting 274
letters 1175
placement 1158
popover 278
tapping. See tapping

right-hand guitar tapping. See tapping
rim shots. See playing techniques. See also playing 
technique-specific noteheads
rinforzando. See dynamics
rips. See jazz articulations. See also glissando lines
ritardando. See gradual tempo changes. See also 
tempo marks
ritenuto. See gradual tempo changes. See also tempo 
marks
rolled chords. See arpeggio signs
rolls. See tremolos. See also tuplets
Roman numerals

fingerings 1180
flow numbers 579
harmonic analysis 1139
page numbers 547, 1354
staff labels 1540
tokens 579

Romantic
trills 1306

RoomWorks SE 825, 829
roots

chord diagrams 1058
chord symbols 318, 321, 322, 326, 1037, 1038, 
1047

Ross chord symbols 1038
Rotary 825, 829
rotating 491

hairpins 609, 1121
pitches 491, 492, 502

rotating (continued)
rhythms 491, 492, 502
slurs 1524
text 1542
ties 1632

round
chord symbol parentheses 1050, 1053
figured bass brackets 1140, 1143, 1147
notehead brackets 1263, 1265

rounded rectangle
borders 848, 1615
rehearsal marks 1425
text enclosures 848, 1615

rows
bar numbers 988, 1472
buttons. See toolbar. See also lower zone
chord diagrams 1060, 1062
chord symbols 146, 151, 152, 154, 1037, 1038
counts 1472
dynamics 1108, 1132, 1133
figured bass 1140, 1148

rubato
expressive text 311, 1116, 1117
system-attached text 388, 848
tempo marks 294, 1587
text 388, 848

rudimental drumming. See unpitched percussion
ruffs. See grace notes
rulers

crosshairs 612
Play mode 615
rhythmic grid 214

running headers 532, 1190
flow headings 708
fonts 848
hiding 708
page templates 533

runs
guitar bends 1323, 1333

Russian
cancellation naturals 1214
instrument names 60
repeat counts 1458

S
salzedo breath marks. See breath marks
sample libraries. See sound libraries
sample rate 42, 268, 270
sampled trills 1306, 1307

disabling 1307
enabling 1307

Save As Project Template dialog 81
Save Endpoint Configuration dialog 663
saving 72, 106

audio 99, 103, 104
auto-save. See auto-save
backups 108
character styles as default 851
chord diagram shapes 1065
chord symbols as default 864
comments 511
custom ensembles 118
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saving (continued)
custom lines 884
custom noteheads 874, 875
custom playing techniques 882
editors 818, 819
endpoint configurations 661–663
engraving options as default 840
ensembles 118
expression maps 930
folder location 109
font styles as default 846
graphics files 597, 598, 675, 677
import settings 90
instrument names as default 185
Key Editor configurations 819
layout options as default 834
libraries 834
lines as default 884, 888, 891
lyrics 1227
MIDI files 90, 99
MusicXML files 88
notation options as default 837
note input options as default 839
page template sets 531
paragraph styles as default 848
PDF files 675
percussion kits 1691
percussion maps 935
playback options as default 842
playback templates 658
played notes 266
players 118
playing techniques 883
plug-in instances 661, 662
PNG files 675
project templates 81, 90
settings as default 81, 90, 834, 837, 839, 840, 842, 
846, 848
SVG files 675
TIFF files 675
tonality systems 902, 905, 1221

saxophone. See instruments
scale degrees

chord diagrams 1058
chord symbols 320, 1037, 1038
mapping 495, 496
Nashville numbers 321
noteheads 1251, 1254
popover 498
trills 1298, 1300, 1301

scale mapping 495, 496, 503
scale multiplication 814, 815, 817
scale size

accidentals 945
barlines 968, 970, 972
chord diagrams 1060, 1069
chord symbol components 856, 857, 859, 861
clef changes 1073
cues 599, 600, 602, 1086
fingerings 1158, 1163, 1169
grace notes 599, 600, 602, 1193, 1197
note spacing 599–602
notes 440

scale size (continued)
ossia staves 1557
printing 671, 683, 684
staves 716, 718, 719, 721
string indicators 1185
tablature 1581

scales 1219
degrees 476, 1037, 1251, 1254
EDO 1219
exercises. See flows
key signatures 1210, 1212
major 495, 496, 503, 1212
mapping 495, 496, 503
minor 495, 496, 503, 1212
modal 495, 496, 503
octave divisions 1219
transposing 481, 495, 496, 503
values. See scale multiplication. See also Histogram 
tool

scissors 197
activating 197
slashes 1479
ties 1631

scoops
deleting 1347
inputting 352, 354, 361, 362
jazz. See jazz articulations
popover 343, 344
vibrato bar 1339, 1343, 1345

scope
crosshairs 612
Insert mode 455, 456
jump bar 68
properties 770, 771

scordatura 142, 144
scores. See layouts
scrapes. See playing techniques
scroll view. See galley view
scrolling 447

Key Editor 773, 780
mixer 826
percussion editor 780
piano roll editor 780

searching 61
engraving options 840
ensembles 115
instruments 113
key commands 63–65
layout options 834
notation options 837
note input options 839
notes 433, 434
playback options 842
preferences 61
properties 769

Second Viennese School accidental duration rule 951, 
952
second voices

adding 231
bar rests 247, 1495

secondary beams 1013
changing 1014
direction 1013
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secondary beams (continued)
lines 1014
resetting 1014
rests 1016
splitting 1001

secondary brackets 1027, 1029
appearance 1024
braces 1029
custom grouping 1030, 1032
default settings 1024
deleting 1034, 1035
design 1024
formatting 517
hiding 1028
inputting 1032
length 1033
resetting 1034, 1035
showing 1028
signposts 1032
sub-brackets 1029
sub-sub-brackets 1029

secondary instruments 777, 803, 806, 809
seconds 35, 649, 1435

duration tokens 579
section players 124

adding 125, 130
condensing 710, 751
divisi 1567, 1568, 1570
editing divisi changes 1571
empty staves 696
ensembles 115, 129, 130
MIDI import 90
ossia staves 1556, 1557
staff labels 1531
staves 697, 698
unison ranges 1572, 1573

sections
coda 1447
fine 1447
hiding 45, 1453
repeat 1447
showing 45, 1453

segments
caps 1414
final 1444
glissando lines 1321
guitar bends 1333, 1337
hairpins 1105, 1121
lines 1423
messa di voce 1105
moving 609
playing technique continuation lines 1398
playthroughs 1441
repeat endings 411, 413, 1441–1443
slurs 1520, 1521
tuplets 1672

segno 1447
font 1448
hiding 1449, 1453
inputting 414, 415
multiple 1448, 1450
sections 1447

segno (continued)
showing 1449, 1453
size 1448

selecting 43, 426, 428, 435, 444
bars 426, 430, 431
beats 432
blue 1133, 1519
changing the selection. See navigation
chord symbols 430–432
chords 436
dynamics 427, 433
everything 428, 430–432
extending selection 427, 428
filters 433, 435
flows 428
frame handles 565
graphic slice handles 595
handles 611
items 212, 426, 428, 445, 514, 781
items behind other items 426
Key Editor 781
key signatures 430–432
lyrics 427, 433, 1228
marquee 43, 428, 781, 818
more 427, 428
notations 43, 428, 445
note spacing handles 606
notes 43, 426, 428, 433, 435, 436, 445, 781
panels 202, 205, 206, 515
playback 632, 649
points 781
rehearsal marks 430–432
repeat endings 430–432
staff spacing handles 723
status display 42
staves 428
system objects 430–432
system spacing handles 723
system track 430
system-attached text 430–432
tempo marks 430–432
time signatures 430–432
tools 42, 43, 197, 775
tracks 92
transposing selections 480
velocity bars 818
voices 427, 433, 477, 777, 781
Write mode 197

selectors
layouts 33, 34
music frames 570
panels 202, 205, 206, 515

semibreves. See whole notes
semiquavers. See sixteenth notes
semitones. See half-steps
sends 825

loading 829
mixer 821, 822
removing 830

sentence case
repeat marker text 1448
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separators
bar numbers 984
beams 1015, 1021
chord symbols 1039, 1048
condensing 761
duration tokens 579
dynamics 311, 1114
fingerings 1179
player numbers 761
ranges 984
staff labels 1538
systems. See system dividers
time signatures 1640, 1647, 1651
timecodes 1435
tokens 579

septuplets. See tuplets
sequences

bar numbers 990–992
page numbers 545, 547, 705
rehearsal marks 1426
staff labels 132, 1539
subordinate 992
types 1427

sets
drum sets. See drum sets
page templates. See page template sets

setting up
audio devices 61, 268, 270
drum sets 155
duplex printing 671
key commands 66
MIDI recording 268
percussion kit note input 240
percussion kits 155
tonality systems 902, 1220
windows 45
workspaces 45

settings 30, 831
audio 61
copying properties 768
default 61, 834, 837, 839, 840, 842
exporting 831, 834
flow-specific 837
harp pedals 1358
importing 831, 833
individual items. See properties
layout-specific 834
MIDI import 90
mouse input 213
note input 224, 228, 839
preferences 61
project-wide 840
properties 769–771
resetting 831
sharing 831
videos 191

Setup mode 22, 110
adding players 130
ensembles 129
flows. See flows
instruments. See instruments
layouts. See layouts
panels 40, 110, 111, 118, 121

Setup mode (continued)
percussion 155
player groups 162
players. See players
signposts 453
switching 110

sextuplets. See tuplets
sfz. See dynamics
shadow notes 212

color 57
shakes. See jazz ornaments
shallow beam slants 1005
shape

bar number enclosures 982
beaming 1003, 1005, 1007–1009, 1012, 1013, 
1015, 1019
borders 848, 982, 1425, 1615
chord diagrams 473, 854, 1056, 1063–1066
figured bass brackets 1140, 1143, 1147
frames 564
graphic slices 594
guitar bends 1333, 1335–1337
multi-segment slurs 1522
notehead brackets 1265, 1269, 1270
noteheads 868, 1247, 1251
parentheses 1053, 1143, 1147, 1265
rehearsal mark enclosures 1425
slurs 1507, 1509, 1520, 1522, 1524, 1528, 1529
text enclosures 848, 1615
ties 1632
tuplet brackets 1674, 1675, 1677

sharing staves. See condensing. See also divisi
sharps. See accidentals
shifts

clefs 331, 1076
cues 1090
octaves 331, 479–482, 488, 1076, 1090
pitches. See rotating
rhythms. See rotating

short
barlines 304, 308, 309, 968, 970, 972
notes 98, 221, 224, 231, 235, 237, 238, 242, 250, 
251, 254, 259, 261, 600, 602, 787, 919, 1193, 1201
scores. See condensing. See also layouts
stemlets 1017

shortcuts. See key commands
shoulder offset

notehead brackets 1270
slurs 1528, 1529
ties 1637

showing. See hiding
shrinking. See size
side stick. See unpitched percussion. See also playing 
technique-specific noteheads
signatures

annotations 687
key signatures. See key signatures
printing 687
time signatures. See time signatures

signposts 453
barlines 308, 309, 459, 966, 1030, 1655
bars 966
bracket and barline changes 1030, 1032
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signposts (continued)
chord symbols 1036, 1040, 1044
clefs 1075
condensing changes 753
cues 1085, 1089, 1101–1103
dynamics 1113
exporting 675, 687
extra staves 1552
figured bass 395, 1139, 1141, 1151
frame breaks 739
harp pedaling 1358, 1361
hiding 444, 454
key signatures 281, 283, 1210
multi-bar rests 1500
note spacing changes 601
ossia staves 465, 468, 1556
percussion legends 1696
player labels 761
playing techniques 1391
printing 671, 687
showing 454
staff changes 1552
staves 465, 468
sub-brackets 1032
system breaks 733, 736
tempo marks 1590, 1595, 1596
text 1618
time signatures 966, 1647, 1650, 1655
trills 1298–1301
tuplets 1675, 1678

silence
hairpins. See niente
leading. See pre-roll
missing sounds 656
muting items 639
notes 1344
playback template 651, 652, 656
rests. See rests

simile
dynamics 311, 313, 1116
hiding 1396
playing techniques 1396
showing 1396

simple time signatures. See time signatures
simplifying accidentals 485
single bar rests

bar counts 1496
H-bars 1496
hiding 1494
showing 1494

single barlines 308, 309, 968, 970, 972
single players 124, 128

adding 125, 130
adding staves 1553
condensing 710, 751
empty staves 696
ensembles 115, 129, 130
extra staves 1552, 1553
MIDI import 90
ossia staves 1556, 1557
staff labels 1531, 1532
staff size 718
staves 697, 698

single-digit numbers
tablature 1585

single-line
percussion kits 1694, 1695
staves 1549, 1689
stem direction 1689

single-note tremolos. See tremolos
single-sided printing 671
single-stroke caesuras 338, 1204
single-voice contexts 1704

articulations 956
grace notes 1194
guitar pre-bends 1331
stem direction 1194, 1274
tie curvature direction 1626

six-line staff
tablature. See tablature

sixteenth notes 17, 201, 221, 224, 235, 237, 259, 1193
beats 303
chords 251
grace notes 250
metronome marks 296
percussion 238, 787
rests 246, 1487
splitting notes 261
swing playback 297, 643, 646, 647
tablature 242
tremolos 415, 417, 1659
tuplets 254, 257
voices 231

size 716
absolute 846, 848
accidentals 945, 1039
arpeggio sign fingerings 1174
audio buffer 268, 270
bar numbers 982, 985
barlines 974, 976, 977
bars 454, 455, 599, 693, 694, 709, 721, 962, 1566
beams 1003, 1005, 1015
brackets 1024–1026, 1030, 1032, 1033, 1053, 1542
channels 827
chord diagrams 1060, 1068, 1069
chord symbols 440, 1039, 1053, 1069
clef changes 1073
coda symbols 1449
cues 1085, 1086
dynamics 440, 1136
elision slurs 1222, 1229, 1244
figured bass 1153
fingerings 1068, 1158, 1163, 1166, 1174, 1586
flared hairpins 1125
font styles 389, 584, 846, 848, 1611
frames 564, 590
fret numbers 1068
gaps 161, 1512, 1625
grace notes 440, 1193, 1197
graphic slices 594
H-bars 1498
hairpins 1105
instrument names 1544
Key Editor 779
laissez vibrer ties 1629
left-hand fingering 1169
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size (continued)
line text 1417
lyrics 1235, 1236, 1238, 1239
measures 709, 1566
messa di voce 1105
metronome marks 1594
mixer 827
multi-bar rests 1498
music symbols 865
noteheads 869, 871, 874, 875, 1085, 1086, 1247
notes 440, 1085, 1086
octave lines 440
ornaments 865
ossia staves 1557
page numbers 1354
pages 683, 691, 834
paper 683, 684
paragraph styles 848
parentheses 1053
percussion editor 779
piano roll editor 779
player group labels 1542, 1544
playing techniques 440, 1388
rastral 716
rehearsal marks 440, 1425, 1429
repeat endings 1442, 1443
repeat markers 1448
segno symbols 1449
slurs 1524
space 716
staff labels 1544
staff-relative 846, 848
staves 693, 716–718, 834
string indicators 1184, 1185
system objects 693, 717, 718
systems 709
tablature 1586
tasto solo 1153
tempo marks 1594
text 389, 584, 846, 848, 1611
tick barlines 974
ties 1632
time signatures 1645, 1646, 1656
tracks 630, 779
tuplets 1669, 1680
unit of measurement 54
video window 194

sketch staves 113, 115
slants

beams 1005, 1200
octave lines 1080, 1081
pedal line hooks 1379

slap tongue. See playing techniques
slash notation 1473
slash regions 1474

beaming 1479
beat grouping 1475
chord symbols 1040, 1044, 1474
compound time signatures 1475
counts 1480, 1482
default settings 1473, 1475
deleting 459
engraving options 1473

slash regions (continued)
filter 433
font style 1465
handles 436
hiding other notes 1477
hiding rests 1478
highlights 1474, 1475
inputting 418
length 436
moving 465, 468, 1477
moving counts 609
multiple 1475
note grouping 1021, 1475
overlapping 1475
parentheses 1482
placement 1482
popover 409, 418
rests 1478
showing other notes 1477
staff position 1477
staff-relative placement 1482
stem direction 1476
stems 1479
vertical position 1477
viewing options 1475
voices 1476, 1483

slash voices 1483, 1659
bar rests 1489
caret 215, 233
changing 477, 1484
default settings 1473
engraving options 1473
hiding stems 1280
inputting 233
moving 1477
multiple-voice contexts 1475
percussion kits 155, 238, 1485
playback 1483, 1485
popover 409
rests 1489
staff position 1477
stem direction 1278
stemless 215, 233
vertical position 1477

slashes 1473
arpeggio signs 1310
bar rests 1489
caesuras. See caesuras
chord symbols 1037, 1038, 1047
double 1562, 1659
dynamics 311, 1114
figured bass 397, 1140
fingerings 1158
grace notes 1193, 1194, 1197–1199, 1201
noteheads 1247, 1250, 1473, 1483, 1683
notes. See slash voices. See also tremolo strokes
pauses. See caesuras
percussion 1683
regions. See slash regions
rests 1489
stemless 1484
stems. See tremolo strokes
systems. See system dividers
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slashes (continued)
time signatures 1647, 1651
tremolos. See tremolo strokes
triple 1659
voices. See slash voices

slides
fingerings. See fingering slides
jazz. See jazz articulations
Key Editor 773
pitch. See glissando lines. See also pitch bends
tempo 35
zoom 773

slight bends. See guitar bends
slots 617, 825
slur segments 1520, 1522

number 1521
slurs 1387, 1502, 1622

accidentals 1508
angles 1507, 1524
arpeggio signs. See curved arpeggio signs
articulations 957, 959, 1506
collision avoidance 1507, 1508, 1517
colors 58
control points 1522
copying 461, 464, 955
cross-staff 273, 1508, 1516
cross-voice 273, 1516
crosshairs 612
cues 1095
curvature 1503, 1504, 1513–1515, 1528
dashed 1510, 1512
default settings 1503
deleting 459
dotted 1510, 1512
duration 1530
East Asian elision 1244
editorial 1510
elision 1244
endpoints 1505, 1507, 1522, 1524
Engrave mode 1522
engraving options 1503
filter 433
fingerings 1158, 1162
flat slurs 1513
formatting 1511–1513, 1524, 1526
frame breaks 1507
gap size 1512
gaps 1503, 1507
grace notes 273, 1194, 1503, 1504
guitar techniques 366
hammer-ons 366, 1342, 1343
handles 1509, 1520, 1522
height 1527
hiding 1095
inputting 207, 273, 366, 1517
inverting 1504, 1514, 1515
large pitch ranges 1509
length 436, 1503
linking 464, 1519
MIDI import 96
MIDI recording 268
moving 465, 468, 1524
multi-segment 1522

slurs (continued)
muting 639
nested 1506
nested slurs 1517
notehead brackets 1269
ornaments 1293
overlapping 1507, 1508
panel 201
placement 1083, 1503–1505, 1507, 1514, 1515
playback 273, 636, 637, 842, 1530
position 1083, 1503, 1505, 1507, 1514
pull-offs 366, 1342, 1343
ranges 1509
rotating 1524
segments. See slur segments
selecting 427, 445
shape 1507, 1509, 1520–1522, 1524, 1528, 1529
short 1509
shoulder offset 1528, 1529
showing 1095
staff lines 1505
stem direction 1506, 1514
stem flags 1503
styles 1510, 1511
system breaks 1507
thickness 1503, 1526
ties 1503, 1506
ties vs. slurs 1622
tucking index 1083
unlinking 464, 1520
within slurs 1517

small notes 440
cues. See cues
grace notes. See grace notes
harmonics. See harmonics
staves. See staff size
trills. See trills
tuplets 1669. See also tuplet numbers

smart quotes 579
smears. See jazz ornaments
smooth

glissando lines 1317
jazz articulations 1348
MIDI 807
slur shapes 1522
tie shapes 1632

smorzando. See gradual tempo changes. See also 
tempo marks
SMPTE. See timecodes. See also markers
SMuFL 844

accidentals 391, 908
chord symbols 1039
dynamics 1136
figured bass 1153
fingerings 1166
lines 897, 900
metronome marks 1594
multi-bar rests 1500
music symbols 391, 865
noteheads 391, 871
playing techniques 880
tempo marks 1594
time signatures 1656
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SMuFL (continued)
tokens 577
tuplets 1680

snap pizzicato. See playing techniques
snapping pitches

pitches 493, 494, 503
scales 495, 496, 503

snare drum. See unpitched percussion
snare rolls. See tremolos
solfège chord symbols 321, 1037, 1038
solid

slurs 1510
tempo marks 1602
ties 1622

solo
indication 388, 882
players. See soloists. See also single players
staff labels 128

soloing 821, 822
channels 638, 823
deactivating 639, 821, 822
instruments 638
playback 636, 637
tracks 638
voices 638

soloists 128
sonata. See flows
songs. See flows
soprano clef. See clefs
sordino. See playing techniques
sorting

flows 168
layouts 175
players 127, 128

sostenuto pedal 1367
MIDI controller 1385
start signs 1378
text 1383, 1384

sound libraries 651, 930
changing 656, 657
expression maps 913
loading sounds 622, 651, 656
missing sounds 656
percussion maps 933
playback 912, 930
trills 1306

sounding
duration 793, 1201, 1667. See also played duration
percussion legend ranges 1696, 1698
pitch. See sounding pitch. See also concert pitch

sounding pitch 174, 1282
harmonics 1286
input pitch 228
layouts 173
playback 635

sounds. See playback
soundtracks

audio 194
volume 194

source instruments 1085
cue labels 1093
generating notes 472

source notes 1176
pitch mapping 493, 494, 503
scale mapping 495, 496, 503

space size 693, 716–718
spacing 599, 694, 720, 721, 840

accidentals 945–947, 1211
arpeggio signs 1313
articulations 955
barlines 967
bars 599, 601, 604, 965, 1493
bracketed noteheads 1264
caesuras 341
capos 146, 1037, 1038
chord diagrams 1057, 1060
chord symbols 1037, 1038, 1042, 1048–1050, 1054
clefs 1070, 1072
condensing 710, 743
cross-staff beams 1010
cues 599, 1086
flow headings 713
frame fullness 526
frets 142
galley view 43
gaps 599
grace notes 599
gradual dynamics 1126
guitar bends 1330
key signatures 1211
layout options 834
lyrics 600, 602, 1229, 1230, 1233–1236, 1239
mixer 827
notes. See note spacing
percussion 155, 161, 1695
punctuation 1230
rehearsal marks 1425
repeat barlines 967
rests. See note spacing
rhythm dots 1258, 1708
staff lines 155, 161, 1695
staves. See staff spacing
stems 1010
systems. See system spacing. See also staff spacing
tablature 1581
tacets 742
text 848, 851, 1611
time signatures 1652
voice columns 1258, 1708, 1709

speech bubbles
comments. See comments

speed
arpeggio signs 1314, 1316
beaming. See fanned beams
bpm 1596
changing 299, 301, 634, 811, 812, 1596, 1598
frame rates 195
grace notes 1201
playback 634, 1587
swing playback 643, 646, 647
tempo marks 1587, 1596, 1598, 1600
tremolos 1663
trills 1296, 1306, 1308
videos 195
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spelling
accidentals 245, 484, 485, 487
chord symbols 146, 1036, 1045
notes 245, 484, 485, 487

spiccato. See playing techniques
spin boxes 772
split point 96
split stems 948

appearance 949
articulations 955

splitting 261
barline joins 977–979
bars 732–734, 736, 737, 966
beams 837, 998, 1001, 1013, 1016, 1021
braces 1032
brackets 1032, 1268
flows 506
multi-bar rests 1496, 1500
notehead brackets 1268
notes 197, 261, 262, 837, 1021, 1475, 1631
pedal lines 1375
phrases 477, 753, 755, 1567, 1570
player labels 763
project window 51
repeat marker text 1451
rests 262
slash regions 1479
staves 414, 415, 733, 734, 736, 737, 743, 1447, 
1567, 1570
ties 261, 262, 837, 1021, 1631
tuplets 1672

spreads
histogram controls 814, 815, 817
page arrangement 44, 53, 680

square
accidental brackets 943, 1285
bracketed noteheads 1263–1265, 1269
brackets 1027, 1029, 1402
figured bass brackets 1140, 1143, 1147
noteheads 1250

squeal. See pinch harmonics
squeezes. See jazz ornaments
staccatissimo. See articulations
staccato. See articulations. See also playback 
techniques
stacking order 1083

accidentals 945, 947
changing 1084
chord symbols 151, 152, 154, 1037, 1038, 1048
lines 1407
numbers in staff labels 1548
octave lines 1083
playing techniques 1393
repeat markers 1449
signposts 453
slurs 1083
string indicators 1184, 1393
tuplets 1083

staff grouping 162, 1025, 1026, 1030
barline joins 976–980, 1030
braces 1030, 1032, 1033
brackets 1030, 1032, 1033
changing 1025

staff grouping (continued)
custom 1030
default settings 80, 1025, 1026
ensemble types 1025, 1026
player groups 162
resetting 1034, 1035

staff labels 181, 1531
alignment 185, 1534
baseline shift 185
brackets 1542, 1543
changing 184, 1535–1538, 1540, 1541, 1548
changing first system indent 1566
colors 185, 1544
condensed staves 744, 755, 760, 1540, 1544, 1546, 
1548
Cubase 1532
default settings 80, 1532
divisi 1546, 1548, 1568, 1574–1577, 1579
engraving options 1532
fonts 848, 1544
formatting 1532
galley view 43
gaps 1532
grouping 158, 159, 1540, 1542, 1545, 1546
hiding 1532, 1534
indents 1534, 1565
instrument change labels 1539
instrument names 60, 158, 159, 181, 184, 185, 188, 
577, 1532, 1535, 1536, 1548
italics 185, 848
language 60
length 1532, 1534, 1535
line breaks 1538
MusicXML import 1532
numbering 132, 1532, 1535, 1539, 1540, 1546, 
1548
ossia staves 1560, 1561
overline 185
paragraph styles 848, 1544
parentheses 1538
percussion 155, 158, 159, 1536, 1545, 1694, 1699
period 1535
player groups. See player group labels
player labels 760
player names 182, 1535, 1536
project templates 80
resetting 188
separators 1538
showing 1532, 1534
size 1544
solo 128
stretch 185
subscript 185
superscript 185
systems 1534
tokens 577
transposing instruments 1531, 1536–1539
underline 185
uppercase 1541

staff lines
erasing 763, 1049, 1110, 1162, 1173, 1183, 1389, 
1421, 1617, 1700
fingerings 1173
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staff lines (continued)
number 155, 699, 700, 1694, 1695
ossia staves 1558
percussion 155, 161, 1695
player labels 763
slurs 1505
spacing 155, 161, 1695
stem direction 1276, 1689
string indicators 1183
tablature 142, 1580
text 1421, 1617
thickness 1550
ties 1635

staff position
cues 1086, 1088
lines 1313, 1409–1411
note input 240
percussion 791, 1682, 1683, 1686, 1687, 1689
percussion kits 160, 240

staff size 684, 693, 716
changing 693, 717–719
custom 719
dialog 719
individual staves 718
layouts 1550
MusicXML files 86
ossia staves 1557
rastral size 716
space size 716

staff spacing 514, 693, 720
activating 514
changing 694, 695, 720, 723
condensing 710, 743
copying 727, 728
default settings 694, 721
divisi 695
final systems 709
flow headings 713
fullness 526
galley view 721, 723
handles 723
hiding staves 696–698
horizontal 526, 709
justification 526, 695, 709, 721
layout options 834
layouts 694
moving systems 726
rehearsal marks 1425
reverting 726
system fullness 526
systems 526
text collision avoidance 1613

staff text. See staff-attached text
staff-attached text 1606, 1607

alignment 848, 1612
backgrounds 1617
borders 848, 1614
erased backgrounds 1617
formatting 389, 392, 848, 1611
hiding 1618
inputting 388
moving 489, 491, 609, 1612
padding 848, 1616

staff-attached text (continued)
paragraph styles 1611
reversing 489. See also retrograde
rotating 491
selecting 426
showing 1618
signposts 453
staff-relative placement 441

staff-relative font size 846, 848
staff-relative placement

articulations 959–961
bar numbers 989
beaming 1003, 1004
changing 441
cue labels 441
dynamics 441, 1105
fermatas 441
figured bass 1149
fingering 1170
fingerings 1158, 1161, 1162, 1175
guitar bends 441
guitar pre-bends 1331
hammer-ons 1346
harmonics 1288
left-hand fingerings 1172
lines 1408, 1409
lyrics 1232
multi-bar rests 1499
numbered bar region counts 1471
octave lines 441, 1081
ornaments 441
pedal lines 1374
percussion legends 441
player labels 760
playing techniques 441
pull-offs 1346
rehearsal marks 1425
repeat markers 1454
resetting 443
slash region counts 1482
slurs 1515
string indicators 381–383, 1183, 1186
tapping 1346
text 441
trills 441
tuplet brackets 1675

stars
pedal lines 1367, 1380

start area 37
start position

frames 728, 736
lines 1412
pages 728, 736
playback 631
systems 728, 733
trills 1294
videos 193

start repeat barlines 304, 968, 970
counts. See repeat counts
inputting 302, 305, 308, 309
key signatures 972
playthroughs 640, 1456
system breaks 972
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start signs
lines 894, 1395, 1404
pedal lines 1377, 1378, 1383, 1384

starting 219
area 37
Hub 72
interchangeable time signatures 285, 288, 290, 
1641, 1655
MIDI recording 264
note input 219, 221, 224
playback 632
players 37
projects 37, 74
timecode values 1436
workspaces 45

status bar 42
selection tools 43
view types 43

status display 42
staves 17, 1549

adding 125, 130, 138, 700, 701, 1552, 1553, 1567, 
1568, 1570
adding ossias 1557
arranging tools 459
articulations 961
bar numbers 984, 986, 987
bar rests. See bar rests
barlines 517, 976–978, 1560
beaming 1009–1012
blank. See blank staves
braces 1032, 1033
brackets 80, 1025, 1026, 1032, 1033, 1542
breath marks 1208
casting off 728–731
chord symbols 173, 318, 1039–1041, 1043, 1044
clefs 177, 179, 1077, 1078
collision avoidance 694, 695, 721, 723
color 57
comments 506, 507
condensing. See condensing
copying 1572
copying items 461, 462
crossing notes 1009, 1012
cues 1086, 1088
deleting 1551, 1552
dialog 719
divider arrows 1574
dividers. See system dividers. See also divide 
arrows
divisi 1567, 1568, 1570–1572, 1574, 1577, 1579
divisi labels 1579
dynamics 314, 316, 441, 1115
dynamics linking 464, 1133
empty. See empty staves. See also blank staves
ending divisi 1572
exploding 470–472, 476
extra 700, 701, 1552
fermatas 1207
figured bass 395, 1139
filtering. See instrument filters. See also filters
fingerings 1162, 1173, 1175
five-line 1545, 1549, 1694
fixing 728–731

staves (continued)
galley view 53
gaps 608, 695, 1447, 1448, 1566
glissando lines 350, 351
grids 1545, 1694
groups 162, 977, 1026. See also staff grouping
height 693–695, 712, 715, 716
hiding 122, 167, 171, 172, 449, 450, 452, 453, 
696–699, 1551, 1555, 1582
indents 608, 709, 1532, 1534, 1550, 1565, 1566
inputting on multiple 219, 235
instrument change labels 1539
instrument changes 134–136
key signatures 281, 283, 1210
labels. See staff labels
language 60
large time signatures 1646
layout options 1550
line thickness 1550. See also staff lines
manuscript paper. See blank staves
margins 709, 712, 715, 1532, 1534, 1566
markers 1431
moving 608, 693, 694, 712, 715, 723
multi-bar rests 1499
multiple voices 231, 743
names. See staff labels. See also instrument names
notation 1580, 1582
note input 219, 235
notes 468
number 696, 699, 701, 1552, 1553, 1556, 1557
order 127, 128
ossia staves. See ossia staves
page view 53
pauses 1205
percussion 1694, 1695
pick-up bars. See pick-up bars
playback 632
player labels. See player labels
preamble 1558
rasterizing. See staff size
reducing 469, 743
rehearsal marks 1563, 1564
renaming 184
repeat endings 1563, 1564
repeat markers 1454
resetting barline joins 1034
resetting bracket/brace grouping 1034, 1035
selecting 428
showing 53, 167, 171, 449, 450, 452, 453, 696–701, 
1555
single-line 1431, 1436, 1438, 1545, 1549, 1694
size. See staff size
slurs 1516, 1519
slurs linking 464
spacing. See staff spacing
splitting 414, 415, 1447
staff labels. See staff labels
stem direction 1276, 1689
stem length 1279
string indicators. See string indicators
swapping contents 469
swing playback 645
system breaks 733
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staves (continued)
system dividers 1562
system objects 1563–1565
tablature 1580, 1582
tacets 739
tempo marks 1563
text 388, 1563
ties 248, 1629, 1635
time signatures 288, 290–292, 1563, 1639, 1645, 
1646, 1652, 1654
timecodes 1431, 1436, 1438
transposing instruments 137, 176, 177, 180
tremolos 1009, 1012
unison ranges 1572, 1573
uppercase staff labels 1541
vertical spacing. See staff spacing
vocal 1574
voices 231
white 57
width 709, 1555

Stein-Zimmermann accidentals 280, 1219, 1220
stem direction 1274

beam groups 1275
beam placement 1003, 1011
centered beams 1008
changing 477, 1097, 1277, 1278, 1476
chords 1275
condensing 744, 755, 757
cross-staff beams 1009
cues 1096, 1097
default settings 1276, 1689
drum sets 158
filters 433
grace notes 1194, 1200, 1689
guitar pre-bends 1331
middle line 1274, 1276
multiple-voice contexts 1274
notes crossed to other staves 1009, 1012, 1710
notes on middle line of staff 1274, 1276
percussion 1689
percussion kits 155, 158, 242, 837, 1701–1703
pitch crossing 744, 755
resetting 1004, 1278
rhythm slashes 1278, 1476
single line 1689
single-voice contexts 1274, 1278
slurs 1506, 1514
staff-relative placement 1004
tablature 1581
ties 1277
voices 477, 1274, 1278, 1704

stemless
noteheads 1280
rhythm slashes 215, 233, 1484

stemlets 1017
gaps 1017
length 1017
removing 1018
showing 1017

stems 998, 1273
altered unisons 948
articulations 959, 960
attachment points 871

stems (continued)
audio 103, 104
backgrounds 1281
beam placement 1011
beaming 1001, 1005, 1010
combining. See voices
cross-staff 1009, 1012
cues 1096
custom noteheads 871
default settings 1273
deleting tremolos 1664
direction. See stem direction
double 231, 948, 1704. See also voices
durations 201, 221, 259, 261
engraving options 1273
erased backgrounds 1281
fermatas 1205
flag design 1273
flags 865, 1273
formatting 865
gaps 1010. See also note spacing
grace notes 1197, 1200
handles 1279, 1665
hiding 1280, 1281
inputting 231, 1704. See also voices
length 1005, 1200, 1273, 1279
middle line direction 1276
multi-note tremolos 1664
noteheads 871
padding 1281
percussion kits 155, 158, 242, 837, 1701–1703
removing direction changes 1278
reverse 1007–1009, 1012, 1274, 1276–1278
rhythm slashes 1476, 1479, 1484
showing 1280
single line direction 1689
slashes 1659
slurs 1503, 1505
split stems 948, 949
staccato position 958
stemlets. See stemlets
symbols 865
tablature 1581, 1582
thickness 1273
ties 1277, 1281
tremolos 1659, 1662, 1665
unbeaming 1001
voices 1274, 1278, 1708, 1709

step input. See note input
step-wise movement 476
stereo pan 822, 823

changing 828
StereoEnhancer 825, 829
stickings 1694
stop positions 454

adding 457
deleting 458
moving 457

stopped pitch 1282
Fretboard panel 209
harmonics 1286

stopping. See starting
stopping finger. See left-hand fingering
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straight lines 1402
duration 579
glissando lines 1317
guitar bends 1323
jazz articulations 1351
pedal lines 1367
quotes 579

straight playback. See swing playback
stress marks. See articulations
stretch

chord diagrams 476
instrument names 185
lyrics 1235, 1236, 1239
note spacing 599
pages 695, 721
staff labels 185
systems 526, 695, 709, 721
text 389, 584, 848, 851

strikethrough text 389, 584, 848, 851
string designation. See string indicators
string indicators 1169, 1183, 1255

appearance 877, 1167
default settings 1184
deleting 1186
duration 436, 1393, 1394
engraving options 1184
fingering 1184, 1187
font 877, 1166, 1167, 1183
grace notes 1185
handles 1392
horizontal position 1187
inputting 369, 371, 381–383
inside staff 383, 1183, 1186
length 1392, 1393
lines 381, 382, 436, 1393, 1394
moving 465, 468, 609, 1187, 1392, 1393
open 1185
order 1393
outside staff 381, 382, 1183
panel 372, 382
placement 1186
popover 369, 371, 381
position 1186
size 1184, 1185
string number 1255

string instruments 131, 142
adding 113, 115, 125, 130, 138
brackets 1026, 1542
chord symbols 1040
fingering shifts 1181
groups 162
player order 111, 127
playing techniques. See playing techniques
string number 1255
substitution fingering 1159
system objects 1564

string pitches
changing 144, 1255
fretted instruments 144

string shift indicators 1181
angles 1158, 1181
direction 1182, 1255

string shift indicators (continued)
inputting 274, 276, 1181
thickness 1158, 1181

stringendo. See gradual tempo changes. See also 
tempo marks
strings

adding 142
assigning notes to 1255
bends. See guitar bends
capos. See capos
changing 1255, 1583
changing pitch 142
chord diagrams 854, 1057, 1063, 1066
color 57
deleting 142
fingering 1169, 1255. See also string indicators
fretted instruments 113, 142
hammer-ons. See hammer-ons
harmonics 1282
indicators. See string indicators
notes out of range 1261, 1583
numbers. See string indicators
pitches 142, 1255
pull-offs. See hammer-ons
ranges 142
resetting 1583
slurs. See hammer-ons
tapping. See tapping
tuning 113, 142, 635, 1255

strokes
figured bass 397, 1140
slurs 1510
ties 1622
tremolos 1659, 1661–1663, 1665

structures
documentation 18
meters 285, 998, 1021, 1475, 1639, 1641
repeat 410, 640, 1440, 1447, 1459

strumming
arpeggios. See arpeggio signs
fingering 1174

styles
appearance 442
breath marks 1204
caesuras 1204
fermatas 1203
fonts 845, 846
glissando lines 1317, 1318
jazz articulations 1351
margins 689
niente hairpins 1131
numbering 1540
page numbers 1354
parentheses 1053, 1143, 1147, 1265
resetting 442
slurs 1510, 1511
tempo marks 1588, 1600
text 845, 848, 851
ties 1622, 1623
time signatures 1647, 1649, 1652

sub-brackets. See secondary brackets
sub-sub-brackets. See secondary brackets
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subdivision
bars 1021, 1475
slash regions 1475
tempo equations 1604
time signatures 285, 1021, 1647, 1649

subito. See dynamic modifiers
subordinate bar numbers 992

adding 992
appearance 994
changing 992

subordinate page numbers 547
numeral style 545, 547

subscript
chord symbols 1037, 1038
instrument names 185
staff labels 185
text 389, 584, 851

subsequent repeats
bar numbers 994, 996

substitution fingering 1159
appearance 1158
handles 1159
lines 1158
position 1159

substitution font styles 846
subtitles 78, 527, 532, 554, 558. See also flow headings
suffixes

bar numbers 996
chord diagrams 1057
dynamics 1116, 1117
fret numbers 1057
instrument changes 60, 135
playing techniques 1388
rehearsal marks 1428
timecodes 1435

suggestions
cues 423, 1102

sul ponticello. See playing techniques
sul tasto. See playing techniques
super locrian scales 495, 496, 503
superscript

chord symbols 1037, 1038
instrument names 185
staff labels 185
text 389, 584, 851
trill intervals 1305

SuperVision 825, 829
suppressing playback 639
suspensions

brackets 1143, 1147
chord symbols 322, 326
figured bass 395, 397, 1140, 1144, 1148, 1150

sustain pedal 1367
continuation lines 1380
Engrave mode 1369
handles 1369
inputting 371, 376, 378
level changes 377, 379, 1368, 1371
merging 1376
MIDI controller 270, 1385
MusicXML import 1386
popover 371, 376
removing retakes/level changes 1373

sustain pedal (continued)
retakes 377, 379, 1368, 1370
splitting 1375
start signs 1378
text 1383, 1384

sustaining instruments 1136
SVG files 685

color 686
exporting 596, 598, 675, 676
fonts 686
graphic slices 596, 598
graphics frames 589
layout numbers 175
layouts 675, 676

swapping. See switching
swash arpeggio signs 1311, 1312
swells. See messa di voce
swing playback 643

custom rhythmic feel 646
disabling 646
editing 647
enabling 297, 644, 645
popover 297
ratios 643
resetting 647
rhythmic feel 646, 647
tempo 647
triplets 643
units 647

Swiss army triplet. See grace notes. See also tuplets
switches 916, 925

creating 926, 927
properties 769

switching 478
flows 446, 447, 616
galley view 53
graphic slice handles 595
handles 565, 606, 611
instruments. See instrument changes
layouts 33, 46, 50
note order 1709
notes 469, 606, 1692, 1708
page view 53
pages 553
rehearsal marks 1426
selection 426, 445, 565, 606
staff spacing handles 723
staves 469
tabs 50
view type 53
voices 478

syllables
beaming 1001
dynamics 1122
lyrics 1224, 1229, 1230
position 1229
tempo marks 1601
types 1225

symbols
accordion registers 876
annotations 886, 894, 897
bar repeats 1459, 1465, 1466
bar rests 1492
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symbols (continued)
caret 215
chords. See chord symbols. See also chord 
diagrams
coda 1449, 1451
custom 876, 880, 894, 897, 899
dialog 865
editing 865
inputting 886, 887
lines 886, 887, 894, 897, 899, 900
music 865
ornaments 1291
pedal lines 1368, 1377, 1380, 1383
playing techniques 876, 880, 1387
repeating 886, 887, 899, 900
repeats. See repeat markers. See also repeat 
barlines
segno 1449, 1451
speech bubbles. See comments
text 388, 391, 583
vibrato bar 1339

symphony. See flows
syncing

dynamics 803
instruments 775, 803, 809
Key Editor 775
MIDI 809
tracks 775
videos to music 193

syncopation
beat grouping 1021
chord symbols 475
generating notes 475
stemlets 1017

system breaks 516, 689, 733
automatic 729, 731
bar repeats 729, 734
barlines 732, 972
clefs 1070
condensing 747
copying to other layouts 765, 766
deleting 732, 736
divisi 1567
dynamics 1121
filter 433
glissando lines 1321
hairpins 1121
hiding staves 697
inserting 730, 731, 734
key signatures 1216
lines 1404, 1423
make into system 734
moving 732
octave lines 1083
playing technique lines 1395
playing techniques 1392
repeat endings 1443
signposts 453, 733, 736
slurs 1507
staff labels 1534
staff size 717
staff spacing 694
staff visibility 697

system breaks (continued)
ties 1627
time signatures 1643

system dividers 1562
formatting 865
hiding 1562
showing 1562
symbols 865
width 1563

system formatting 689
casting off. See casting off
condensing. See condensing
copying to other layouts 765
frame breaks. See frame breaks
indents 1532, 1565, 1566
note spacing. See note spacing
staff labels 1532
system breaks. See system breaks
system dividers. See system dividers
system objects. See system objects

system fullness indicator 526
system objects 1563

copying 430
layouts 1563
lines 385, 1402
positions 1564, 1565
rehearsal marks 1424, 1425
repeat counts 1456
repeat endings 1440, 1443
repeat markers 1454
selecting 426, 430–432
size 693, 717, 718, 1550
tempo marks 1587, 1591
text 388
time signatures 1646, 1652

system spacing 514, 694, 720
changing 694, 695, 723
default settings 694, 721
handles 606, 723
justification 695, 721

system text. See staff-attached text
system track 430

deleting music 963
hiding 431, 444
inputting bars 307
inputting beats 307
selecting music 431, 432
stop positions 457, 458

system-attached text 1563, 1606, 1607
alignment 848, 1612
backgrounds 1617
borders 848, 1614
copying 430
erased backgrounds 1617
formatting 389, 392, 848, 1611
hiding 1618
inputting 388
markers 101
moving 609, 1612
multiple positions 1564
padding 848, 1616
paragraph styles 1611
selecting 426, 430–432
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system-attached text (continued)
showing 1618
signposts 453
staff-relative placement 441, 1565
stave positions 1563
tempo tracks 101

systemic barlines 973
braces 1023, 1024
brackets 1023, 1024
hiding 973
secondary brackets 1027, 1029
showing 973
sub-brackets 1027, 1029
sub-sub-brackets 1029
text alignment 848, 1612

systems
alignment 695, 709
bar numbers 982, 987, 989, 1468
barlines 972, 973
breaks. See system breaks
casting off 728–732
changing indents 1566
chord symbols 1041
clefs 1073, 1075
coda gap 1454, 1455
condensed staves. See condensing
dividers. See system dividers
divisi 1567, 1570
end position 608
fixing 728–731
formatting 516
fullness. See system fullness indicator
gaps 694, 695, 1447, 1566
height 693–695
indents 608, 709, 1532, 1534, 1550, 1565, 1566
justification 695, 709
key signatures 1213
length 608, 709
lyrics 1230, 1233, 1241, 1243
make into system 734
margins 709, 1532, 1534, 1566
moving 723, 726, 734, 737
numbered bar regions 1468
player labels. See player labels
preamble 1558
rehearsal marks 1425
repeat barlines 972
resetting 732
sections 1447
selecting 427, 428
spacing. See system spacing
splitting 1447
staff labels 1532, 1534, 1546, 1566
staff size 717
start position 608
text. See system-attached text
timecodes 1436, 1438
tonality 1219
track. See system track
trill marks 1295
vertical position. See system spacing
width 608, 709

T
tabla notation 1703
tablature 1580

appearance 1586
beaming 1582
bend intervals 1329
bends. See guitar bends
bracketed noteheads 1263–1265, 1323, 1328
capos 146–149
caret 215
changing string for notes 1583
chords 224, 242, 1581
clefs 1070
color 57
colors 58
dead notes 1344
default notation 221, 224
dives 1328, 1337
enclosures 1581, 1584, 1585
font style 1586
frets 142, 147–149
gaps 1581
green notes 1580, 1583
guitar bends 1323, 1581
hammer-ons 1343, 1345
harmonics 1283, 1286
hiding 1582
hold lines 1323, 1331
intervals 1329
lines 1581
moving notes to other strings 1583
note input 224, 242
notes out of range 479, 1261, 1580, 1583
numbers 1580, 1583, 1586
open pitches 144
parenthesized fret numbers 1323, 1328
post-bends. See guitar post-bends
pre-bends. See guitar pre-bends
pull-offs 1343, 1345
question marks 479, 1580
resetting strings 1583
rhythm dots 1581, 1586
rhythms 1581, 1582
scoops 1343, 1345
showing 1582
size 1586
spacing 1581
stems 1581, 1582
strings 142, 144, 221, 224, 1583
ties 1620
trills 1295
tuning 142, 145, 147–149

tables
actions 918
clef and transposition overrides 177
comments 511
conditions 919
contents. See front matter
cues 423
endpoint setup 659
fonts 76
graphic slices 520
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tables (continued)
markers 403
MIDI import 92
percussion maps 931
switches 916
tracks 92

tabs
bar 36
closing 49
groups 51
hiding 34
layouts 46, 48, 50
moving 51
opening 48
order 50
showing 34
showing multiple 51
switching 50
view options 48

tacet al fine 1491, 1497
tacets 23, 739

borders 848
exporting 84
formatting 739
hiding 741, 1496
margins 742
moving 742
paragraph style 739
removing players from flows 167
showing 741, 1496
text 741
thickness 848

tags. See signposts. See also comments
tails. See stems
tambourine. See unpitched percussion
tanto. See tempo marks
tap tempo 297
tapping 1169, 1340

appearance 1343
deleting 1347
dot 1343
gaps 1343
hiding 1345
inputting 367
moving 609, 1346
percussion. See grace notes. See also tuplets
plus sign 1343
popover 344
showing 1345
staff-relative placement 1346
tablature 1345

tasto solo 395, 397, 848, 1139, 1140, 1152, 1153
techniques 1387

combinations 923, 927
endpoint configurations 662
exclusion groups 922
expression maps 913
guitar 1339
percussion 931, 935, 1683, 1685
playback 923, 927, 936, 937

templates
brackets 80
categories 74

templates (continued)
deleting 82, 540, 819
ensembles 115, 118, 129, 130
flow headings 554, 555
Key Editor 781, 818, 819
libraries 831, 833, 834
new projects 72
pages. See page templates
playback 620, 651
players 115, 118, 129, 130
projects. See project templates
staff grouping 1026
staves 80, 115, 130, 1026
titles 554

tempo 1587
bpm 1596
changing 812
click settings 267, 625
default 459, 1587
deleting changes 783
drawing 810
equations. See tempo equations
finding 404, 1434
fixed tempo 634, 649
follow tempo 634, 649
inputting 811
marks. See tempo marks
metronome marks 1596
MIDI recording 634
muting in playback 639
Play mode 625, 810
range 1597
recording 634
swing playback 647
tracks. See tempo tracks

tempo changes. See tempo marks
Tempo editor 625, 810

adding 777, 781
changing tempo 812
closing 777, 781
copying points 782
deleting points 783
height 779
inputting tempo changes 811
moving tempo changes 812
selecting points 781
zoom 779

tempo equations 1604
arrows 1605
inputting 296, 297, 299, 301
panel 297
popover 296

tempo marks 810, 1587, 1600
abbreviated 1594
absolute tempo changes 297, 1588
alignment 1591
appearance 1588, 1590
arrows 1605
barlines 1592
beat units 296, 439, 1596
brackets 1589, 1590
changing 439, 1590, 1593, 1594, 1596, 1598
colors 58
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tempo marks (continued)
components 1589, 1590, 1594, 1599
continuation lines 1587, 1600–1602
copying 461, 782
crosshairs 612
dashes 1602
decimal places 299, 301, 1596, 1599
default settings 1588
deleting 459
engraving options 1588
equations. See tempo equations
filters 433
finding 404, 1434
fonts 1594
formatting 865, 1601–1603
gaps 1602
gradual tempo changes 297, 1588, 1598, 1600
handles 436, 1591
hiding 1595
hyphens 1601
inputting 294, 297, 299, 301
integers 299, 301, 1599
length 436, 609, 1591
lines 1600–1602
metronome marks. See metronome marks
moving 465, 609, 812, 1599
multiple positions 1563, 1564, 1591
muting in playback 639
order 1599
panel 297
parentheses 1589, 1590
placement 1591
playback 459, 640, 1587, 1597–1599
poco a poco 1591
popover 294
position 1588, 1591
rehearsal marks 1425
relative tempo changes 297, 1588, 1598
repeats 640
reset tempo 297, 1588
selecting 426, 427, 430–432
showing 1595
signposts 453, 1590, 1595, 1596
size 1594
style 1601, 1603
symbols 865
text 439, 1588, 1593, 1594
types 294, 297, 1588
vertical positions 1563

Tempo panel 297
tempo track 625, 810

editing. See Tempo editor
editor. See Tempo editor
hiding 629, 781, 810
showing 629, 781, 810

tempo tracks 100–102, 810
dialog 101, 102
exporting 102
importing 100, 101
Play mode. See tempo track. See also Tempo editor

tenor clef. See clefs
tenuto. See articulations
terminal lines 886, 894, 1404

terminology
British vs. American English 17
note durations 17

text 845, 1606, 1607
abbreviated tempo text 1594
accidentals 388, 391, 583
alignment 389, 584, 588, 848, 851, 1612
annotations 894, 1404
appearance 389, 584, 846, 848, 851
backgrounds 1617
bar numbers. See bar numbers
baseline shift 389, 584
borders 585, 586, 848, 1192, 1420, 1614–1616
character styles 851, 852
codes. See tokens
collision avoidance 1613
color 58, 848
colors 389, 584
comments 506, 511
crosshairs 612
cue labels 1093, 1094
cues 1095
dedications 1188
default settings 388, 853, 1613
distance from staff 609
divisi 1574, 1575, 1577, 1578
dynamics 1116, 1117, 1122
Edit Font Styles dialog 846
editing 392, 583, 1593, 1607
editor. See text editor
engraving options 388
erased backgrounds 1422, 1617
expressive 1104, 1116
filter 433
fingerings 1167
flow titles 189
formatting 72, 389, 584, 845, 846, 848, 853, 1611
frames. See text frames
glissando lines 1319, 1320
glyphs 388, 391, 577, 583
hiding 1095, 1456, 1618
horizontal 1420
horizontal alignment 588, 848, 1612
inputting 388, 562, 583, 1415
layout names 1192
leading 848, 850, 1611
lines 894, 1404, 1415, 1417–1422, 1543
lyrics 1224, 1237–1239
markers 101, 402, 403, 1430, 1432
missing fonts 76
moving 465, 587, 588, 609, 840, 1612
multiple positions 1563, 1564
music fonts 844
music symbols 388, 391, 577, 583
overlapping 1613
overline 389, 584, 848
padding 587, 848, 1422, 1616
paragraph styles 848, 850, 1611
pedal lines 1383–1385
percussion legends 1700
player labels 760, 762, 763
playing techniques 1387, 1388
rehearsal marks 1424
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text (continued)
repeat endings 1443
repeat markers 1448, 1451
resetting 1611, 1613
restorative 1383, 1385
showing 1095, 1456, 1618
signposts 453, 1618
spacing 389, 584, 848, 851, 1611
staff labels. See staff labels. See also player group 
labels
staff-relative placement 441
stretch 389, 584, 848
strikethrough 389, 584
styles 845
subscript 389, 584
superscript 389, 584
system-attached text 388, 1563
tacet. See tacets. See also multi-bar rests
tacets 741
tempo marks 439, 1587, 1589, 1593–1595, 1600
timecodes 1432, 1437
tokens. See tokens
types 1607
underline 389, 584, 848
uppercase staff labels 1541
vertical. See player group labels
vertical alignment 587
word wrapping 763, 1451

text editor 389, 392
comments 507
Engrave mode 584
lyrics 1238, 1239
opening 583
text frames 583
Write mode 389

text frames 575, 848, 1192, 1607, 1614, 1615
accidentals 391
alignment 587, 588
borders 585
changing text 583
entering text 583
flow headings 708
glyphs 391
horizontal alignment 588
identifying 1607
inputting 562
music symbols 391
overrides 575
padding 587
paragraph styles 1611
running headers 708
selecting 565
tokens 576
vertical alignment 587

text items 1606, 1607
colors 58, 389, 584, 848
crosshairs 612
editing 392
hiding 1618
identifying 1607
inputting 388
moving 465

text items (continued)
showing 1618
signposts 1618

text styles 845
text tokens. See tokens
theme 55
theorbo. See fretted instruments
thick barlines 304, 968, 970–972

inputting 302, 305, 308, 309
thickness

bar numbers 982, 985
barlines 967
beams 1003, 1015
borders 586, 848, 1363, 1420, 1616
brackets 1024, 1027, 1053
chord diagrams 1057
chord symbols 1037, 1038, 1053
figured bass brackets 1140
glissando lines 1318
grace note slashes 1197
gradual tempo changes 1603
guitar bends 1330
hooks 894
line borders 1420
lines 840, 891, 1037, 1038
notehead brackets 1264
parentheses 1053
pedal lines 1382
rehearsal marks 1425, 1429
slurs 1503, 1512, 1526
staff lines 1550
stems 1273
string shift indicators 1181
tacets 848
text borders 586, 1420, 1616
ties 1621, 1624, 1634

three quarters depressed pedal lines 1368, 1369, 1371, 
1372
thru

MIDI 263
thumbs 1169

chord diagrams 854, 1062–1064, 1066
fingerings 1169, 1175
inputting 278
popover 276, 278

tick
barlines 302, 304, 305, 308, 309, 967, 968, 970, 
972, 974
breath marks. See breath marks
played duration 793, 794

tie chains 1620
accents 957
articulations 957, 1620
bracketed noteheads 1266
deleting 1630
glissando lines 1322
numbering bars. See numbered bar regions
selecting 1620
slurs 1503
splitting 261, 1631
staccato 957
stem direction 1277
tablature 1620
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tie chains (continued)
tenuto 957
tremolos 1661, 1662

ties 26, 1021, 1620, 1622, 1627
accents 957
accidentals 1628
appearance 1622
articulations 957, 961, 1620
bracketed noteheads 1266
breaking 1631
cautionary accidentals 943, 1285
chains. See tie chains
chords 1626
clef changes 1628
collision avoidance 1620, 1621, 1635
control points 1632
cross-staff 248, 1629
cross-voice 248, 1629
cues 1097
curvature direction 1621, 1626
dashed 1622, 1624, 1625
default settings 1621
deleting 1021, 1630, 1631
dotted 1622, 1624, 1625
dynamics 314, 316, 465, 1105, 1128
editorial 1622
endpoints 1632
Engrave mode 1632
engraving options 1621
erased backgrounds 1281, 1657
forcing 262
formatting 1623–1625, 1632, 1634
frame breaks 1627
gap size 1625
grace notes 248, 1628
guitar bends 1331
hairpins 314, 316, 465, 1105
half-bar 837, 1021
half-dashed 1622
handles 1632, 1635–1637
height 1635, 1636
hiding 1657
inputting 197, 248
inverting 1626
laissez vibrer 1629
length 1621
messa di voce 1128
non-adjacent notes 248, 1628
non-standard types 1627
note grouping 262
notehead brackets 1269
numbering bars. See numbered bar regions
parentheses 1266
pedal lines 377
placement 1626
playing techniques 373, 375
position 1503, 1621, 1632, 1635
rotating 1632
shape 1632
shoulder offset 1637
slurs 1503, 1506
slurs vs. ties 1622
solid 1622

ties (continued)
splitting 261, 262, 1021, 1631
staccato 957
staff lines 1621, 1635
stems 1277, 1281
style 1622, 1623
system breaks 1627
tablature 1620
tenuto 957
thickness 1634
tie chains. See tie chains
time signatures 1620, 1628, 1657
tremolos 1661, 1662
voices 248, 1626, 1709
width 1632

TIFF files 685
color 686
exporting 596, 598, 675, 676
graphic slices 596, 598
layout numbers 175
layouts 675, 676
resolution 685

time
deleting 454, 455, 962–964
display 649, 651
inserting 237, 305–307, 454, 455
language 61
latency 263, 268, 269
markers 1430
rhythmic position 27
signatures. See time signatures
tokens 580. See also date and time
track. See tempo track. See also Tempo editor
transport window 649, 651
videos 193

time and date. See date and time
time bars. See repeat endings
time signatures 1639, 1641

above staff 1646
additive 1641
aggregate 1641
alternating 1641
appearance 1640, 1656
bar numbers 990
barlines 967, 978, 1652
beam grouping 27, 837, 999, 1021
beat groups 27, 837, 1649
bracketed groups 1645
brackets 285, 1647, 1651
cautionary 1643
changing 237, 439, 454–456, 966
click 264
common 285, 287, 1652
compound 1641
custom 1641
cut common 285, 287, 1652
default settings 1640
deleting 459
denominators 1639, 1640, 1647, 1649
design 1656
engraving options 1640
erased backgrounds 1657
filter 433
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time signatures (continued)
font styles 1656
formatting 865
hiding 455, 1655
inputting 284, 285, 288, 290
Insert mode 237, 454–456, 839
interchangeable 1641, 1655
irregular 1641
large 1645
MIDI recording 264
moving 465, 468, 609, 1652–1654
multi-bar rests 1498, 1499
multiple positions 1563, 1564
non-power of two 1641
note grouping 27, 999, 1021, 1475
noteheads 1649
numerators 1639, 1640, 1647, 1649
open 1641, 1647, 1650
panel 287
parentheses 285, 288, 1647, 1651
pick-up bars 286, 291, 292, 1641, 1643, 1644
polymeter 288, 290–292, 1639
popover 285
position 288, 290, 1646, 1652, 1654
rest grouping 999, 1021
rhythm slashes 1473, 1475
selecting 426, 430–432
separators 1640, 1647, 1651
showing 1655
signposts 453, 966, 1647, 1650, 1655
simple 1641
size 1646, 1656
spacing gaps 1652
staves 1645, 1646
styles 1647, 1651
symbols 865
system objects 1646
ties 1620, 1628, 1657
types 285, 1641
upbeats. See pick-up bars
vertical position 1563, 1564, 1645, 1646, 1654

Time Signatures (Meter) panel 287
timecodes 1435

changing 191, 1433, 1436
dialog 191
drop frame 1435
exporting 104
flows 121
font style 1433
frequency 1438
hiding 1437
inputting 402
markers 403, 404, 1437
non-drop frame 1435
offset 1436
panel 403
showing 1437
staff 1431, 1436
staff spacing 694, 721
start values 1436
tempo 404
text 1432, 1437

timecodes (continued)
transport window 649, 651
vertical position 1436

times played 1456
changing 641
language 1458

timpani 131
key signatures 113
laissez vibrer ties 1629
rolls. See tremolos. See also trills

title case
repeat marker text 1448
staff labels 1541

title pages 527, 532, 1188
adding 535, 549, 702, 703
editing 541
exporting 531
importing 530, 537
tokens 576

titles 78, 188
accidentals 577
adding 72, 78
changing 78, 189
first pages 532, 541, 1188
flow headings 554, 555, 558, 708
flows 188, 189, 554
fonts 848
hiding 72, 550, 707, 708
movements 554
page templates 532
projects 188
running headers 532, 541, 708
showing 72, 550, 707, 708
templates 554
tokens 576

to indications. See player labels
tokens 576, 1607

accidentals 577
clefs 577
date 580
file names 576, 678
first pages 532
flows 188, 554, 555, 558, 578, 579
inputting 576, 583
language 61
music symbols 577
page numbers 580
page templates 532, 1188
project information 78, 188, 578
Roman numerals 579
running headers 532
SMuFL 577
staff labels 577
time 580
titles 188

tom-tom. See unpitched percussion
tonality systems 1219

accidentals 904, 907, 908
changing 1220
creating 902
custom. See custom tonality systems
exporting 831, 1221
importing 831, 1221
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tonality systems (continued)
key signatures 905, 910, 911
octave divisions 907, 1219
panel 280, 283
playback 912
scale mapping 495, 496, 503

ToneBooster 825, 829
tones

intervals. See whole steps. See also pitch
microtones. See microtones. See also quarter tones
playback. See click

tongue clicks. See playing techniques
toolbar 33

hiding 33
Key Editor 775
transport options 33, 35
workspace options 33, 34

toolboxes 41
Engrave 514
Key Editor 775
Notations 196, 202
Notes 196, 197

tools 41
arranging. See arranging
editing. See properties. See also default settings
selecting 42, 43
timecodes 1435

touched pitch 1282
harmonics 1286

Track Inspector 614, 617, 769
track overview 615

automation. See MIDI CC editor
chords track 627
dynamics. See Dynamics editor
markers track 626
MIDI CC. See MIDI CC editor
MIDI pitch bend. See MIDI Pitch Bend editor. See 
also MIDI CC editor
pitch bends. See MIDI Pitch Bend editor. See also 
MIDI CC editor
Tempo editor 810
tempo track 625. See also Tempo editor

tracks 623, 773, 821
adding 781
automation. See MIDI CC editor
chords. See chords track
colors 624, 784, 785
dynamics. See Dynamics editor
height 630, 779
hiding 629, 777, 781
importing 90
independent voice playback 636, 637, 664
inputting notes 786
inserts 821, 822, 825, 829, 830
instruments. See instrument tracks
Key Editor 773
locking 777
markers 626, 627
MIDI. See MIDI CC editor
MIDI import 90
muting 638
names 90
percussion. See percussion editor

tracks (continued)
piano roll. See piano roll editor
playing techniques. See Playing Techniques editor
selecting 92
showing 629, 777, 781
soloing 638
system. See system track
tempo. See tempo tracks
time. See tempo track. See also Tempo editor
types 623
unlocking 777
velocity. See Velocity editor
voices 624, 636, 637
volume 827
width 630, 779
zoom 630, 779

traditional
cancellation naturals 1214
music fonts 844
rastral size 716
tonality systems 1219

transcribing
MIDI import 93, 96
MIDI recording 263, 264, 268
voices 263, 264

Transform tool 813, 817
hiding 818
showing 818

transformations 488
inversion 489
Key Editor 813, 814, 817
MIDI CC 814
pitch mapping 493
popover 498
repetition 493
retrograde 489
rotation 491
scale mapping 495
selections 818
velocity 813, 814, 817

transition lines 1393, 1402
appearance 877, 1397
default settings 877
duration 1394
hiding 1397
inputting 369, 373, 375
MIDI 807
playing techniques 882, 1399
showing 1397, 1400
tempo 810, 811

translation lyrics 1223
changing lines to 1241
changing lyrics to 1223
font styles 1235
popover 393

transport 649
basic options 33, 35
hiding 649
playhead 631
playhead position 649, 651
repeats 640
showing 649
window 649

Index
 

1832
Dorico Pro 4.3.30



Transpose dialog 480, 481
transposed pitch 174, 479

changing 180
chord symbols 146, 173, 1045, 1046
clefs 176, 179, 331, 1074–1076
exporting 675
filters 434
input pitch 228
instrument numbering 1539
instrument transpositions 1536
layouts 173, 176, 177, 180, 577, 1191
MIDI import 93
note input 228
part layouts 169, 173, 671, 675
printing 671
score layouts 671, 675
showing 173
staff labels 1531, 1536
status display 42
tokens 577, 1191
viewing 173

transposing 479, 481
accidentals 481, 1217, 1218
chord symbols 146, 149–151, 153, 154, 173, 480, 
481, 1036, 1045
clefs 113, 176, 177, 179, 1077, 1099
cues 1093, 1099
dialog 481
expression maps 912, 914, 916, 920
figured bass 480, 482
flows 480, 481
fretted instruments 142, 144–146
instruments. See transposing instruments
key signatures 180, 480, 481, 1210, 1217, 1218
layouts 169, 174, 177, 180, 184, 577, 1191
MIDI import 93
notes 479–483, 493–496, 500, 503, 790, 791
octaves 479
pitch. See transposed pitch
popover 500
scales 495, 496, 503
selections 480
staff labels 1537
strings 146
tokens 577, 1191

transposing instruments 137, 173, 1531
chord symbols 146, 1045, 1046
clefs 113, 1074, 1075, 1078
concert pitch 173, 174
cues 1090
fretted instruments 137, 149, 150
instrument numbering 1539
instrument transpositions 1536–1538
key signatures 174, 837, 1210, 1212, 1217
layout names 184
layouts 173, 174
register in cues 1090
staff labels 1531, 1536–1538
transposed pitch 173, 174

tre corde. See una corda pedal. See also pedal lines
treble clef. See clefs
trees. See split stems
tremblements. See ornaments

tremolo arm. See vibrato bar
Tremolo plug-in 825, 829
tremolo strokes 1483, 1659, 1663

changing number 1662, 1663
formatting 865
moving 1665
symbols 865

tremolos 1659
angles 1661
appearance 1660, 1664
articulations 935
attack 408, 415, 417, 1661
beams 1664
cross-staff 1009, 1012
default settings 1660
deleting 1664
duration 1667
engraving options 1660
formatting 865, 1664
inputting 408, 410, 415, 417
measured 1659
MIDI import 93, 96
MIDI recording 268
moving strokes 1665
multi-note 408, 1659, 1664
number of strokes 1662
panel 410, 417
percussion 1682, 1683
placement 1661
playback 636, 637, 935–937, 1667
popover 408, 415
position 1660, 1661, 1665
release 408, 415, 417, 1661
single-note 408, 1659
speed 1663
strokes. See tremolo strokes
symbols 865
tie chains 1661
tuplets 1659
types 408, 1659
unmeasured 1659
voices 1667

triads. See chords. See also chord symbols
triangles

beams 1005
chord symbols 1037, 1038
line annotations 894
noteheads 1249, 1252, 1683, 1686, 1687
pages 542
percussion. See unpitched percussion
playback 930

trill intervals 1298, 1299, 1305
accidentals 1300, 1303
appearance 1291, 1303, 1304
auxiliary notes 1303
changing 1300, 1301
condensing 744, 755
deleting 1302
hiding 1299
Hollywood-style 1303
indicators 1298
inputting 347
microtonal 1299–1301
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trill intervals (continued)
position 1305
resetting 1302
restatement 1291
showing 1299
signposts 453, 1299

trill lines 1296, 1297
hiding 1297
length 436, 609
showing 1297
speed 1296, 1297

trills 1291, 1295, 1303, 1306, 1659
accidentals 1300, 1303, 1305
alignment 1294, 1297
appearance 1303, 1304
auxiliary notes 1303
colors 58
condensing 744, 755
crosshairs 612
deleting 459
deleting intervals 1302
end position 1297
extension lines. See trill lines
filter 433
generated 1307
grace notes 1306
handles 436
hiding marks 1295
Hollywood-style 1303
inputting 343, 347, 348
intervals 343, 1298–1301, 1303, 1305
length 436
lines. See trill lines
MIDI import 93, 96
MIDI recording 268
moving 465, 468, 609, 1293
NotePerformer 1307
panel 346, 348
parentheses 1291
pitch 1300, 1301, 1309
placement 1293
playback 936, 937, 1306–1308
popover 343
position 1293, 1294, 1297
resetting 1302
sampled 1307
signposts 453, 1298–1301
speed 1296, 1306, 1308
staff-relative placement 441
start position 1294
starting pitch 1309
tablature 1295

trimming flows 302, 964
triple accidentals

respelling 484, 485, 487
transposing 481

triple barlines 304, 968, 970, 972
inputting 302, 305, 308, 309

triple-dotted notes 229
triplets 1669

inputting 197, 254, 256
swing playback 643

trombone. See instruments

troppo. See tempo marks
true black 686
trumpet. See instruments
tuba. See instruments
Tube Compressor 825, 829
tucking index 1083

changing 1084, 1393, 1407
chord symbols 151, 152, 154
dynamics 1105
lines 1407
lyrics 1105
playing techniques 1393
string indicators 1393

tuning
capos. See capos
changing 113, 142, 144, 177
chord diagrams 1060, 1064, 1065
custom 142, 144, 145, 854, 1058, 1060
dialog 142
exporting 145
fretted instruments 113, 142, 146
guitar 113, 142, 146
importing 145
open pitches 144
playback 635
strings 144
systems. See tonality systems

tuplet brackets 1674
angle 609, 1674
end position 1676
handles 1674
hiding 1669, 1675
hooks 1674
horizontal 1677
length 609, 1674
moving 609
showing 1669, 1675

tuplet numbers 1669, 1678
appearance 1678, 1680
font 1680
hiding 1669, 1678
horizontal position 1679
showing 1669
size 1680

tuplet ratios. See tuplet numbers
tuplets 1193, 1659, 1669

accidentals 244
appearance 1669, 1675, 1678
articulations 271, 957
barlines 1672
beams 998, 1016, 1021, 1673
beat units 257
brackets. See tuplet brackets
colors 58
default settings 1669
deleting 1672
end position 1676
engraving options 1669
filter 433
fingerings 1158
font styles 1680
formatting 865, 1678
gaps 1669
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tuplets (continued)
handles 1674
hiding 1669, 1675, 1678
hooks 1674
horizontal brackets 1677
inputting 98, 254, 1670, 1671
inverting 1675
Key Editor 784
moving 465, 468, 489, 491, 609, 1669, 1679
nested tuplets 1670
notes 1671
numbers. See tuplet numbers
percussion kits 1693
piano roll editor 784
placement 1083
popover 254, 256
position 1083, 1669
quantization 98
ratios. See tuplet numbers
reversing 489. See also retrograde
rotating 491
showing 1678
signposts 453, 1675, 1678
size 1669
slurs 273
staff-relative placement 1675
swing playback 643
symbols 865
transformations 488, 1671, 1672
tremolos 1659
tucking index 1083
types 256, 1669
unscaling 1672

Turkish music
octave divisions 1219

turn off. See hiding. See also deactivating
turns 1291

intervals 1292
jazz. See jazz ornaments
pages. See frame breaks

tutorials 72
tutti 1567, 1572

restoring 1572
two-up page arrangement 680
types

appearance 442
arpeggio signs 344
articulations 1349
bar repeats 409
barlines 968
breath marks 338, 1204
caesuras 338, 1204
caret 215
chord symbols 320, 1037, 1038
clefs 330
dynamics 311, 1104
enclosures 982, 1425
fermatas 337, 1203
fingerings 276, 1179
glissando lines 344
grace notes 1197
holds 337, 1202
jazz articulations 343, 1348, 1349, 1351

types (continued)
key signatures 279
lines 1402, 1404
lyrics 393, 1223
notehead sets 1246
noteheads 868, 1247, 1251
notes 201
octave lines 332, 1079
ornaments 342, 1349
page templates 532
pauses 337, 1202
pedal lines 371, 1367
percussion legends 1698
players 90, 124, 128
playing technique lines 1395, 1397
playing techniques 369, 1387
rehearsal marks 1427
repeat endings 407
repeat markers 407
resetting 442
rhythm slashes 1484
syllables 1224, 1225
templates 80
tempo marks 294, 297, 1588
text 1607
ties 1622
time signatures 285, 1641, 1647, 1651
tracks 623
tremolos 408, 1659
tuplets 256, 1669

U
ukulele. See fretted instruments
una corda pedal 1367, 1383

appearance 1385
hiding 1385
MIDI controller 1385
start signs 1378
text 1384, 1385

unassigned instruments
loading sounds 656

uncompressed MusicXML 88
undamped. See playing techniques. See also laissez 
vibrer ties
underlines

fingerings 1164
instrument names 185
lyrics 1239
staff labels 185
text 389, 584, 846, 848, 851

undo 33
ungrouping

dynamics 1133
playing techniques 1401

Unicode
accidentals 908
lines 897, 900
music symbols 865
noteheads 871
playing techniques 880

unison ranges 1572
colors 1573

Index
 

1835
Dorico Pro 4.3.30



unisons 1567
altered. See altered unisons
arranging 469
condensing 750, 760, 762
deleting 469
divisi 1572, 1577, 1578
player labels 760, 762, 1578
restoring 1572
rhythm dots 1258
stems 231
voices 231, 1258, 1705, 1706, 1708

units
beats 191, 297, 404, 439, 1596
measurement 54
metronome marks 439, 1596
quantization 98
rhythmic grid 214
swing 647
swing playback 643
system track 430
tempo 297, 404
time 191, 649
tuplets 256
video 191

Universal Indian Drum Notation 1703
unlinking 1133

dynamics 1135
Key Editor 777
music frames 572
slurs 1520
tracks 777

unmeasured tremolos. See tremolos
unpitched percussion 1682

articulations 935, 960, 1683, 1693
cues 1086, 1087
drags. See grace notes
drum sets. See drum sets
dynamics in kits 1694
exporting kits 1691
flams. See grace notes
ghost notes. See bracketed noteheads
grid kit presentation 158–161, 1545
groups 158, 1545
importing kits 1691
Indian drum notation 1703
individual instruments 1689
instrument order 160
Key Editor. See percussion editor
kits. See percussion kits
laissez vibrer ties 1629
legends 1696–1698, 1700
MIDI import 90
moving notes 1692
MusicXML files 87
naming groups 159
notation options 1690
notations 1693
note input 238, 240, 242, 786, 787
noteheads 1683, 1687
parentheses. See bracketed noteheads
percussion maps 665, 930, 931
Play mode. See percussion editor
playback 665, 930, 931, 935, 1682

unpitched percussion (continued)
playing techniques 791, 935, 1682, 1683, 1685, 
1686, 1693
presentation types 155, 1689, 1694, 1695
rhythm slashes 155, 1485
rudiments 221, 259, 1193, 1659, 1667, 1669, 1689
scrapes. See playing techniques
staff labels 158, 159, 1545
staff position 791, 1683, 1686, 1687, 1689
staves 155, 1694, 1695
stem direction 155, 242, 1689, 1701, 1702
stickings 1694
techniques. See playing techniques
tremolos 935, 1683
tuplets 1693
voices in kits 1701, 1703

unscaling
grace notes 1196
tuplets 1672

up arpeggio signs. See arpeggio signs
up bow. See playing techniques
up-bow breath marks. See breath marks
up-stem voices. See voices
upbeats. See pick-up bars
upper case

bar numbers 994
chord symbols 1037, 1038
flow numbers 579
repeat marker text 1448
Roman numerals 579
staff labels 60, 1541

upper limits. See limits
upper notes

percussion 238, 1683, 1686
trills 1309

used chord diagrams 1060
capos 153, 154
fingerings 1062

user interface 32
colors 54–57
language 59, 67
transport options 35
windows 32

user name
comments 506, 511

ut
French staff labels 60

V
value fields 772
value line

dynamics 799
MIDI 805, 807
tempo 625, 810

values
faders 823, 827
frame rates 191
gradual tempo changes 1598
histogram controls 815
latency compensation 269
metronome marks 439, 1596–1599
MIDI CC 808, 813–815, 817, 818
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values (continued)
notes. See note durations
properties 772
relative tempo changes 1598
rhythmic grid 42, 214, 786
timecodes 191, 1436
velocity 796–798, 813–815, 817

valves
fingerings 1179

vamping 327
velocity

bracketed noteheads 1265
changing 797, 798, 813–815, 817
controls 797, 813–815, 817
editor. See Velocity editor
expression maps 920
Histogram tool 813, 814
MIDI import 96
MIDI recording 268
resetting 798
selecting 818
Transform tool 817

Velocity editor 796, 797, 799
adding 781, 796
changing velocity 797, 813–815, 817
closing 781, 796
filter 815
height 779
Histogram controls 814
resetting velocity 798
Transform controls 817
zoom 779

velocity lanes. See Velocity editor
verse numbers 1243

exporting 1227
font styles 1235
hiding 1243
lyric line numbers 1241
punctuation 1244
showing 1243

versions
files 76

vertical alignment
crosshairs 612
dynamics 1108, 1132, 1133, 1135
fingerings 1158
items 612
lines 1399
playing techniques 1399
text 587

vertical chord diagrams 1069
vertical justification

staves 695, 721
systems 695, 721
text 587

vertical lines. See lines. See also arpeggio signs
vertical position 609, 840

articulations 955, 957, 959, 960
bar numbers 987–989, 1471, 1472
breath marks 1205, 1208
caesuras 1206
changing 441
chord symbols 1037–1039, 1041, 1043, 1048, 1059

vertical position (continued)
counts 1471, 1472, 1482
cues 1086–1088
dynamics 1105, 1118
fermatas 1205
figured bass 1140, 1141, 1149, 1151
fingerings 1158, 1170, 1172, 1174, 1175
flipping items 441
flow headings 554, 708, 712, 713
frames 563
harp pedal diagrams 1364
instruments 127, 128
layouts 175
lines 1393, 1405, 1408, 1409, 1411, 1423
lyrics 1105, 1223, 1229, 1232–1234, 1241, 1242
markers 1430, 1431
modifiers 1118
numbers in staff labels 1548
ornaments 1293
pauses 1205
pedal lines 1374
players 127, 128
playing techniques 441, 1392, 1393
poco a poco 1118
rehearsal marks 1425, 1563–1565
repeat endings 1443, 1563–1565
repeat markers 1454, 1564, 1565
rests 1487
rhythm slashes 1477
slurs 1507, 1514
stacking order. See stacking order
staves 127, 128, 694, 695, 721, 723
string indicators 1184, 1393
system objects 1564, 1565
systems 694, 695, 721
tacets 742
tempo marks 1563–1565, 1591
text 441, 587, 1563–1565, 1613
ties 1621, 1626, 1635
time signatures 1563, 1645, 1646, 1652, 1654
timecodes 1430, 1431, 1436
tremolos 1661
trills 1293

vertical spacing
articulations 955
bracketed noteheads 1264, 1265, 1268
chord diagrams 1060
frame fullness indicator 526
lyrics 1233, 1234
ossia staves 1556
percussion kits 161
staves. See staff spacing
systems. See system spacing
tacets 742
text 848, 850

vertical stacking order. See stacking order
vibrato. See playing techniques
vibrato bar 1323, 1328, 1339

appearance 1330
chords 1328
deleting 459, 1347
dips 363, 364, 1339, 1344
dives 1328, 1337, 1339
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vibrato bar (continued)
duration 436, 1394
handles 1335, 1337
inputting 357–360, 364, 365
intervals 1329, 1344
length 436
lines 364, 365, 436, 1339, 1394
moving 609, 1335, 1337
playback 1328
position 1330
pre-dives. See guitar pre-bends
returns 1328, 1337, 1339
scoops 1339

Vibrato plug-in 825, 829
Video Properties dialog 191
videos 72, 190

adding 192
audio 194, 821–823, 826
channel 821–823, 826
dialog 191
flows 121
formats 190
frame rates 195
hiding 193
locating 192
markers 626, 1430
mixer 821–823, 826
panel 403
reloading 192
removing 194
size 194
start position 193
syncing 193
timecodes 1435, 1436
tutorials 72
volume 194
window 193, 194

Viennese accidental duration rule 951
view options 43, 687

background color 56
bar numbers 984
bar repeats 1461
changing 42, 816
chord diagrams 1058–1060
chord symbols 151, 152, 154, 1040, 1041, 1043, 
1044, 1059
colors 54–58
comments 506, 512
condensing 764
cues 1101–1103
divisi 1573
exporting 687
figured bass 1151
flows 616
frame break signposts 739
full screen mode 52
galley view 43, 53
graphic slices 592
harp pedaling 1261
hiding 444
histogram editor 816
Hub 72
Key Editor 773, 777, 779–781, 816

view options (continued)
language 59, 67
layouts 36, 46, 50
mixer 821, 823, 826
moving music 446, 447
music area 37, 44, 53
notes 639, 764, 1261, 1705
notes out of range 57, 1261
numbered bar regions 1461
page arrangements 42, 44, 53
page color 55
page view 43, 53
panels 40, 47
percussion legends 1696
piano roll 773, 777, 779–781, 784
playhead 632, 651
print preview 444, 666
printing 687
recent projects 72
rests 1261, 1491
signposts 454
slash regions 1475
system break signposts 736
system track 431
tabs 36, 46, 48, 50
time signature signposts 1655
timecode 651
tracks 630, 779
transport 651
types 43
unison ranges 1573
video window 193
voices 1704, 1705
windows 52
zoom 45, 448, 630, 779

VintageCompressor 825, 829
violin. See instruments
vivace. See tempo marks
vocal scores. See layouts
vocal staves 80, 113, 115

barlines 967, 976, 977
brackets 1026, 1542
divider arrows 1574
groups 162
staff grouping 1026, 1542
staff labels 1532, 1541
syllabic beaming 1001
title case 1541
uppercase 1541

voice colors
changing 57
exporting 687
hiding 444, 1705
printing 687
showing 1705

voice column index 1258, 1706–1709
default settings 837
ledger lines 1257
note spacing 606
order 1708, 1709
resetting 1709
rhythm dots 1258, 1259, 1708
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voices 231, 948, 1704
accidental stacking order 945, 947
adding 231
alignment 1706–1709
articulations 956
bar rests 247, 1490, 1495
beaming 1275
caret 215, 231
changing 462, 477, 478, 1484
chord symbol playback 318, 628, 629
chords 251, 474, 476
colors 57, 624, 784, 785, 1704, 1705
column index 1708
condensed staves 744, 747, 750, 755, 757, 1548
copying 462, 791
creating new 231
cues 1085, 1096, 1097
deleting 1710
direction 1476
divider arrows 1574
divisi. See divisi. See also condensing
drum sets 158, 1690, 1701–1703
dynamics 314, 316, 799, 1115
endpoints 664
fermatas 1205, 1207
filters 433, 775, 815
flows 664
generating notes 474, 476
glissando lines 350, 351
grace notes 1194
hiding 1477
Histogram tool 813, 815
identifying 42, 1705
inputting 231, 251, 786
Insert mode 237, 454
Key Editor 636, 777, 786
ledger lines 1257
merging 469
MIDI CC editor 805
MIDI import 93, 96
MIDI recording 263, 264, 266, 268
mixer 821, 822, 827
moving notes 468
muting 638
notation options 1705
note spacing 606
octave lines 335, 336
order 837, 1258, 1708, 1709
overlapping 1258, 1706, 1708
panning 828, 1115
parallel motion 474, 476
parts. See layouts
pasting notes into 462, 791
percussion kits 155, 158, 1690, 1701–1703
piano roll editor 777, 784, 786
pitch crossing 744, 755
placement 1707
playback 636, 637, 664
playing techniques 373, 375, 795
position 1707
rests 1487, 1489, 1492
rhythm dots 1258, 1259, 1708
rhythm slashes 233, 1476

voices (continued)
selecting 426–428, 433, 477, 777, 781, 786
showing 1477
slash regions 1477
slashes 233, 477, 1475, 1483, 1484
slurs 1505, 1514, 1516
soloing 638
spacing. See note spacing
status bar 42
stem direction 1274, 1278, 1701, 1702, 1704, 1710
stems 1708, 1709
swapping contents 478
swapping order 1708
switching between 231
ties 248, 1626, 1629
tracks 617, 624, 636
tremolos 1667
velocity 796–798, 813, 815
volume 827

voicing
chord diagrams 1056, 1060, 1064, 1065
chord symbols 318, 474, 476, 628, 629
notes 231, 251, 469, 474
percussion kits 155, 158
reducing 469

volta lines. See repeat endings
volume

bracketed noteheads 1265
channel meters 821, 822, 827
click 827
dynamics 801, 1104, 1112, 1129, 1136, 1137
metronome click 267
MIDI 1138
mixer 821, 822, 827
playback 827, 920, 1137
resetting 827
silence playback template 651, 652
swells. See messa di voce
tracks 821, 822, 827
velocity 796–798, 813, 817, 920
video audio 194

VST Amp Rack 825, 829
VST and MIDI panel 614, 620
VST Bass Amp 825, 829
VST instruments 617, 620

allowing 636
blocking 636
chord symbols 628
click 625
editing 620
endpoints 659, 661, 662
expression maps 913
instances 620
loading 622, 636
microtonal playback 912
names 659
numbering 620
panel 620
percussion maps 665
playback 651, 652, 659, 912, 930
ports 617, 659

VSTDynamics 825, 829
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W
w/ bar. See vibrato bar
WahWah 825, 829
walker noteheads 1251, 1252
warnings

audio engine 42
deleting players 111, 129
different Dorico versions 76
exporting 675
MIDI input 42
missing fonts 76
printing 671
transposition 671, 675

watermarks 687
exporting 675
font style 846
printing 671

WAV files
exporting 103, 104

wavy lines. See wiggly lines. See also lines
wedge lines 385, 1402

custom 884, 886, 888, 891
hiding 1396
inputting 385
showing 1394, 1396, 1397, 1413

wedge noteheads 1249, 1252
weight

fonts 856, 861, 865, 871, 880, 900, 908
time signatures 1656
tuplet numbers/ratios 1680

Western tonality
key signatures 1211
octave divisions 1219

whammy bar. See vibrato bar
whistle tones. See playing techniques. See also 
diamond noteheads
white

noteheads 1246, 1247, 1252
pages 55, 57
staves 57

whole notes 17, 201, 221, 224, 235, 237, 259
beats 303
chords 251
metronome marks 296
percussion 238, 787
rests 246, 1487
splitting notes 261
tablature 242
tremolos 415, 417, 1659
tuplets 254, 257
voices 231

whole step trills 1298, 1306
appearance 1303
hiding 1295, 1299
inputting 343, 348
position 1305
showing 1295, 1299

whole steps 942
bend intervals 1329, 1344
pitch bends 804
string pitches 142
tonality systems 1219

whole steps (continued)
transposing instruments 137, 1217
trills. See whole step trills

whole tone
chord symbols 323
scales 495, 496, 503

whole-half diminished. See scales. See also intervals
width

accidentals 946
barlines 968
bars 599, 604, 709, 965, 1493, 1566
beams 1003, 1015
braces 1024, 1027
brackets 1024, 1027, 1029
chord diagrams 1069
columns 76
elision slurs 1222, 1229, 1244
empty bars 965, 1493
enclosures 982, 1425
extra staves 1555
flared hairpins 1125
frames 564, 590
graphic slices 594
graphics 861, 865, 880, 908
guitar bends 1330
H-bars 1496, 1498
hairpins 1105, 1109, 1121, 1126
Key Editor 779
keys 207
laissez vibrer ties 1629
ledger lines 942, 1256
line borders 1420
lines 709, 891
measures 709
messa di voce 1105, 1126
multi-bar rests 1498
note durations 599, 793. See also note spacing
notehead brackets 1264, 1270
noteheads 1250
notes 779
ossia staves 1558
percussion editor 779
piano roll editor 779
system dividers 1563
systems 608, 709, 1566
text borders 586, 1420, 1616
ties 1621, 1632
time signatures 1656
tracks 630, 779

wiggly lines 1317, 1348, 1402
custom 884, 888, 891
glissando lines 1317, 1318
hiding 1396
inputting 349–352, 354, 385
jazz articulations 343, 346, 352, 354, 1348, 1351
playing techniques 1397
showing 1394, 1396, 1413
trills 1296, 1297

wildcards. See tokens
wind band. See bands. See also project templates
wind instruments. See woodwind instruments
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windows
full screen 52
MIDI instruments 617
mixer 822, 823
moving tabs 51
multiple 48, 51, 52
opening 52
playback 52
project 32
splitting 51
tabs 51
transport 649
video 193, 194
VST instruments 617, 620
workspaces 45

wings
barlines 974
brackets 1027

wizard. See hub
wood blocks 1682, 1689, 1690

adding 125, 138
click 267, 625

woodwind instruments 131
adding 113, 115, 125, 130, 138
brackets 1026, 1542
chord symbols 1040
groups 162
player order 111, 127
playing techniques 372
transposition 113, 137, 176

word spacing 389, 584, 848, 851
instrument names 185
lyrics 1235, 1236, 1239
staff labels 185

words. See lyrics. See also text
workflow

comments 506
worksheets

blank staves 700, 701
colors 58, 1251
extracts. See flows. See also graphic slices
note name noteheads 1251, 1254
text alignment 1612

workspaces 22
key commands 29, 66
options 33, 34
preferences 61
setting up 45, 59

wrapping text
player labels 763
repeat markers 1451

Write mode 22, 196
caret 219
inputting notations 271
inputting notes 220
inputting vs. editing 212
navigation. See navigation
notation options 837
note input options 839
panels 40, 196, 201, 205, 769
playhead 632
popovers 25
selecting 426–428, 431, 432

Write mode (continued)
selecting notes 445
signposts 453
spacing 723
switching 196
system track 430
text editor 389
toolboxes 41, 196, 197, 202
Transpose dialog 481

written tempo 299, 301, 634, 1587, 1596

X
X-noteheads 1248, 1252

dead notes 1344
percussion 238, 787, 1683, 1685–1687

xylophone. See instruments

Z
zero

bar numbers 1643
chord diagrams 854, 1056, 1066
fingerings 1166, 1167, 1185
string indicators 383, 1183, 1185

zig-zag
accidentals 945
lines. See lines

zones 32, 40
Engrave mode 513, 515, 522, 769
hiding 47
lower 769
Play mode 614, 773, 821
Print mode 666–668
Setup mode 110, 111, 118, 121
showing 47
Write mode 196, 201, 205–207, 209, 210, 769, 773, 
821

zoom 42
bar repeats 1461
changing 448
chord symbols 1044
cues 1101–1103
Key Editor 773, 779
lyrics 1238
numbered bar regions 1461
options 42, 45, 448
percussion editor 779, 780
piano roll editor 779, 780
slash regions 1474, 1475
tracks 630, 779
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